Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company and product names may be trademarks of the respective companies with which they are associated.

Please read the ServiceNow® Website Terms of Use at www.servicenow.com/terms-of-use.html
# Table of Contents

**Now Intelligence** ........................................................................................................... 1

- Automation Discovery ........................................................................................................ 5
  - Install Automation Discovery ............................................................................................ 10
  - Create an Automation Discovery report ........................................................................ 12

**Performance Analytics** .................................................................................................... 14

- Understanding Performance Analytics ............................................................................... 15
- Activating your Performance Analytics subscription ....................................................... 26
- Performance Analytics fundamentals ............................................................................... 29
- Performance Analytics advanced topics ........................................................................ 416

**Reporting** ......................................................................................................................... 559

- Getting started with reports .............................................................................................. 560
- Distribute reports ................................................................................................................ 573
- Creating reports .................................................................................................................. 586
- Analytics accessibility options ............................................................................................ 830
- Aggregation in reporting ..................................................................................................... 834
- Value formatting in reports ................................................................................................. 838
- Advanced reporting .............................................................................................................. 842
- Administering reports ......................................................................................................... 911
- Interactive Analysis ............................................................................................................ 976
- Interactive Filters ............................................................................................................... 988

**Analytics and Reporting Solutions** .................................................................................. 1022

- Available Analytics and Reporting Solutions .................................................................... 1022
- ServiceNow Store applications with Performance Analytics content ............................ 1028
- Activate a Solution using guided setup ............................................................................... 1029
- Install a dashboard ............................................................................................................. 1031
- Configure Analytics and Reporting Solutions .................................................................... 1035
- Collect data for Analytics and Reporting Solutions ......................................................... 1043
- Installed Performance Analytics indicators ......................................................................... 1051

**Performance Analytics and Reporting for Workspace** ..................................................... 1128
Create an NLU model................................................................. 1482
Create an NLU intent............................................................... 1485
Using NLU vocabulary................................................................ 1493
Annotating entities................................................................... 1513
Import common entities............................................................ 1541
Promote an entity to NLU model availability............................ 1547
Clone an NLU model................................................................. 1550
Train and test your NLU model.................................................. 1553
Compare draft and published versions of your NLU model......... 1554
Publish your NLU model............................................................ 1557
Virtual Agent and NLU Workbench integration......................... 1558
NLU Workbench - Advanced Features....................................... 1558
Intent Discovery....................................................................... 1594
Natural Language Query............................................................ 1606
Using Natural Language Query.................................................. 1608
Predictive Intelligence............................................................... 1616
Get started with Predictive Intelligence..................................... 1622
Create and train a classification solution................................. 1630
Create a word corpus............................................................... 1647
Create and train a similarity solution........................................ 1650
Create and train a clustering solution....................................... 1655
Create and train a regression solution....................................... 1667
View solution training progress................................................. 1673
Reviewing your ML solution training jobs................................. 1677
Activate solution version.......................................................... 1679
Review classification prediction results over time...................... 1679
Test a classification solution prediction.................................... 1680
Test a similarity solution prediction.......................................... 1684
Database View support for Predictive Intelligence...................... 1688
Configuring advanced settings for your ML solutions................ 1691
Use Predictive Intelligence in Flow Designer with ML actions..... 1711
Using Machine Learning APIs.................................................... 1723
Index

Using ML Solution Factory scriptable objects ............................................ 1731
Preserve ML solutions during a system clone ........................................... 1732
Configuration tips for Predictive Intelligence ......................................... 1733
Quick start tests for Predictive Intelligence ............................................. 1736
Domain separation and Predictive Intelligence ....................................... 1737
ServiceNow® apps and features that use Predictive Intelligence ........... 1738
Virtual Agent ............................................................................................ 1740
   Exploring Virtual Agent ........................................................................ 1746
   Configuring Virtual Agent .................................................................... 1787
   Using Virtual Agent .............................................................................. 1898
   Integrating Virtual Agent with other applications ............................. 2195
Analytics and Reporting Solution for Virtual Agent ............................. 2398
Process Optimization ................................................................................. 2464
   Explore Process Optimization ............................................................ 2472
   Set up Process Optimization .............................................................. 2491
   Use Process Optimization ................................................................... 2516
   Process Optimization key terms ........................................................ 2576
Now Intelligence

Optimize processes and increase productivity with Performance Analytics, virtual agents, and machine learning.

The Analytics, Intelligence, and Reporting products help provide many different kinds of data to many different kinds of users. Listen to the Story of the Four Stakeholders, which describes the kinds of data different people in your organization might want to see.

Four types of stakeholders and their needs for analytics, intelligence, and reporting data

Get the insights you need

The Now Intelligence products can help you to lower costs and increase productivity through process improvement, self-service, and automation. Service owners can deliver and refine AI capabilities quickly, gaining greater insight into real-time patterns and trends for service delivery teams. This information enables you to make better, faster decisions—without the need for data science expertise.

View and download the full infocard for a highlight of Now Intelligence features.

<table>
<thead>
<tr>
<th>Make smarter decisions with embedded intelligent analytics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Performance Analytics to establish a foundation of metrics and visualizations to drive greater visibility, alignment, and continuous improvement across your business.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Identify and rank records of interest based on multiple weighted criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Spotlight to define weighted criteria to identify and rank records that require attention, such as when triaging incidents or performing lead scoring.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quickly take action through self-service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Agent is a chatbot that simulates the conversations or messaging interactions a human agent would typically have with a user. With a virtual agent in place, customers, partners and employees making requests and inquiries receive automated responses from a bot instead of from a person.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable the system to learn and respond to human-expressed intent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Natural Language Understanding enables the Virtual Agent chatbot to understand the intent of what people are looking for and provide them with more relevant answers</td>
</tr>
</tbody>
</table>
Improve the interactions between processes and human service agents

Use Predictive Intelligence in combination with Virtual Agent to deflect tickets, reduce call volumes, and automate common requests to deliver great service experiences.

### Automation Discovery

![Automation Discovery](image)

Automation Discovery identifies opportunities from your data that can be automated by ServiceNow products like Virtual Agent, and Predictive Intelligence. The app helps you find candidates for automation that can contribute to deflections and improve incident resolution times.

### Performance Analytics

A sample business scenario and how Performance Analytics supports it

Performance Analytics enables businesses to set, track, and analyze progress against goals. The products helps you improve performance and accelerate continual service improvement by:

- Tracking critical process metrics and trends.
- Measuring process health and behavior against organizational targets.
- Identifying process patterns and potential bottlenecks before they occur.
- Continually visualizing the health of processes through both historical and real-time statistics in role-based dashboards, so you and your business can make informed decisions.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Spotlight
Video describing Spotlight criteria, criteria weights, and incident ranking

Spotlight illuminates records that otherwise you might overlook due to evaluating only one aspect of given records. You can define weighted criteria to identify and rank records that require attention, such as when triaging incidents or performing lead scoring. You can rank records based on multiple dimensions, instead of by a single field value such as priority. While most organizations address high-priority items in a timely manner, lower priority items sometimes are not addressed for an extended period of time. Spotlight helps you focus on items based on business need.

Virtual Agent
Video explaining Virtual Agent and introducing the Virtual Agent Designer

Implementing a virtual agent to handle common requests and tasks enables your users to get immediate help, day or night. Providing your virtual agent on channels familiar to your users, such as third-party messaging apps, to offer a convenient way for them to contact you. A virtual agent can also offer personalized customer experiences by applying and remembering user information during the conversation.

Natural Language Understanding

Natural Language Understanding (NLU) provides an NLU model builder and an NLU inference service that enable the system to learn and respond to human-expressed intent. By entering natural language examples into the system, you help it evaluate word meanings and contexts so it can infer user or system actions.
Predictive Intelligence uses machine learning to shorten triage and categorization time, contributing to higher customer satisfaction. Pinpoint issues and deliver actionable insights to get service owners and agents to faster resolutions.

Get started

- Attend the "Getting Started with Performance Analytics" webinar to learn how you can improve performance by visualizing critical metrics and trends. Discover how you can use Performance Analytics to get real-time insight into influential factors in each stage of your service to help you meet and exceed your business goals. Sign up for the webinar at the Customer Success Center.

- For information about free classes, office hours, and other Performance Analytics resources, see this post on the Now Community.

- Pre-packaged Analytics and Reporting Solutions are available to integrate Now Intelligence tools with your ITSM, CSM, or HR ServiceNow products. For information about activating and configuring the Analytics and Reporting Solution for you, and initiating data collection, see Analytics and Reporting Solutions.

Applications and features

- Automation Discovery
- Performance Analytics
- Reporting
- Analytics and Reporting Solutions
- Performance Analytics and Reporting for Workspace

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Automation Discovery

ServiceNow® Automation Discovery helps you identify automation opportunities for your workflows. Use the discovery reports to implement or improve automation solutions like Virtual Agent (VA), and Agent assist.

Summary usage

Automation Discovery analyzes your records to help you identify opportunities for automation.

With the app, you can run discovery reports that analyze a specified dataset of records against a pre-built taxonomy. The model identifies over 180 possible opportunities for automation from your records. Think of the opportunities as intents that the system can respond to your users’ queries automatically.

The report groups records by the predicted opportunity for automation. For uncategorized records, the report groups the records together in related clusters.

For applications such as Virtual Agent, Automation Discovery helps you implement automation opportunities that can lead to deflections and faster incident resolutions.

Installation

Automation Discovery is available from the ServiceNow Store. For more information, see Install Automation Discovery.

Language support

Automation Discovery supports English, Spanish, French, German, and Japanese instances.
The Automation Discovery Reports page lists your created reports. For each report, the page lists the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name given to the report during creation.</td>
</tr>
<tr>
<td>Data Source</td>
<td>Source of the records analyzed.</td>
</tr>
<tr>
<td>Automation</td>
<td>Number of different pre-built intents that match with your records.</td>
</tr>
<tr>
<td>Opportunities</td>
<td></td>
</tr>
<tr>
<td>Not Categorized</td>
<td>Number of clustered groups that contain utterances that do not match the pre-built topics.</td>
</tr>
<tr>
<td>Total Records</td>
<td>Number of records analyzed in the report.</td>
</tr>
<tr>
<td>Run Date</td>
<td>Time and date of the most recent run.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Number of times to run the report.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the report.</td>
</tr>
</tbody>
</table>

To create a new report, see Create an Automation Discovery report. For results, click the name of the report.
Report breakdown

For each successful report, the report page shows information about automation opportunities. The example shows analysis for incident records from 2014 through 2021.

The report groups matching records together by opportunity. In this example, Automation Discovery found 84 opportunities for automation from the thousands of incidents analyzed. Several records group to the same opportunities because the incidents match the same intents.

*Deflections* refer to incidents that could have been immediately resolved through automation. Automation Discovery adds up all the records that match an automation opportunity to get the **Possible Deflections** number. Some opportunities have matching pre-built VA topics, marked as **Virtual Agent Ready**.

*MTTR* or *mean time to resolve* refers to the average amount of time it takes to resolve incidents. The report multiplies the number of matching records by the MTTR to get the **Estimated Time Savings** for the top 10 opportunities.
The Automation Opportunities tab lists the automation opportunities that match your data. Click the list icon on each row to see more information about the records for that opportunity.

The Not Categorized tab shows the clusters of records that do not match pre-built intents. The report attempts to group uncategorized records into clusters based on similarities. Click the list icon on each row to see more information about the records in that cluster.

Adding opportunities to Topic Recommendations

Virtual Agent Topic Recommendations helps you improve the automation for Virtual Agent. You can add automation opportunities from your Automation Discovery reports to Topic Recommendations.

The Actions You Can Take card shows what you can do with the automation opportunities from your reports. For opportunities that are VA Ready, click Open Topic Recommendations to add the opportunity to Topic Recommendations.

In Topic Recommendations, you can add topics to your Natural Language Understanding (NLU) models and to Virtual Agent. If you add an opportunity to a model, the Action Take shows the corresponding intent or model.

To learn more see Virtual Agent Topic Recommendations and NLU models.

You can also create custom topics for opportunities that are not VA ready. For more information about creating custom topics, see Creating Virtual Agent Topics on the ServiceNow Developer Site.
**Sharing and flagging**

You can share your discovery reports with other members on your team. On a report page, click **Share Report** to open the report sharing pop-up.

**Choose how you would like to share this report.**

Note: Users must have nlu_admin/nlu_user role in order to view Automation Discovery reports.

https://automationdiscoveryquebec0318.service-now.com/  

Select...  

Message

Hey, take a look at this report.

Include Flagged Items

You can share the report with the provided link or by sending the report via email.

**Note:** User must have the nlu_admin or nlu_user role to view Automation Discovery reports.

You can also flag specific automation opportunities that you want to highlight. To flag an opportunity, click the flag icon. To include flagged items when you share the report, select the **Include Flagged Items** check box.
The Automation Discovery Properties page lets you control the settings for the discovery reports.

Setting a minimum and maximum number of records helps you control the amount of data that you want to analyze. You can also set the number of unique unmatched records for clustering to work on your report.

Enabling sampling of data before clustering is run can help speed up the report generation. However, the report clusters a smaller amount of the unmatched records.

Related information
- Natural Language Understanding
- Virtual Agent

Install Automation Discovery

You can install the Automation Discovery application (sn_auto_discovery) if you have the admin role. The application installs related ServiceNow Store plugins if they are not already installed.

Before you begin
- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin
About this task
The following items are installed with Automation Discovery: plugins and tables.
For more information, see Components installed with Automation Discovery.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Automation Discovery application (sn_auto_discovery) using the filter criteria and search bar.
You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.
Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Automation Discovery.
4. Click Install.

What to do next
For best results, install the VA Conversations for ITSM (sn_itsm_va) and the NLU model builder (com.snc.nlu_studio) plugins. For more information, see Additional plugins for Virtual Agent and Activate the NLU Workbench.

Components installed with Automation Discovery
Several tables are installed with activation of the Automation Discovery plugin.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Discovery Message</td>
<td>References to the original data source records (ex: incidents). Does not include duplicated records.</td>
</tr>
<tr>
<td>[sn_auto_discovery_processed_message]</td>
<td></td>
</tr>
<tr>
<td>Automation Discovery Intent</td>
<td>Opportunities for automation in the report. Referenced by the processed message and report trace.</td>
</tr>
<tr>
<td>[sn_auto_discovery_intent]</td>
<td></td>
</tr>
<tr>
<td>Automation Discovery Message Content</td>
<td>References to the original data source records (ex. incidents). Includes duplicated records.</td>
</tr>
<tr>
<td>[sn_auto_discovery_message_content]</td>
<td></td>
</tr>
<tr>
<td>Automation Discovery Report</td>
<td>Reports previously created using Automation Discovery.</td>
</tr>
<tr>
<td>[sn_auto_discovery_report]</td>
<td></td>
</tr>
<tr>
<td>Automation Discovery Job</td>
<td>Table that manages the execution of Automation Discovery reporting jobs.</td>
</tr>
<tr>
<td>[sn_auto_discovery_job]</td>
<td></td>
</tr>
<tr>
<td>Automation Discovery Report Trace</td>
<td>History of the Natural Language Understanding (NLU) intents added due to the report’s intents or clusters.</td>
</tr>
<tr>
<td>[sn_auto_discovery_report_trace]</td>
<td></td>
</tr>
<tr>
<td>Automation Discovery Report Definition</td>
<td>Table defining how a report runs and the report status. Multiple reports can run from a single report definition.</td>
</tr>
<tr>
<td>[sn_auto_discovery_report_definition]</td>
<td></td>
</tr>
<tr>
<td>Automation Discovery Cluster</td>
<td>Uncategorized clusters of records from the report. Referenced by the processed message and report trace.</td>
</tr>
<tr>
<td>[sn_auto_discovery_cluster]</td>
<td></td>
</tr>
</tbody>
</table>

Create an Automation Discovery report

Create an Automation Discovery report to analyze your records for automation opportunities.

**Before you begin**

Role required: admin or nlu_admin
Procedure

1. Navigate to Automation Discovery > Automation Discovery Reports.
2. Click New

Automation Discovery

Select a data source to analyze to identify new or existing automation opportunities that can cover your users' queries.

- **Data source**: Incident (incident)

All of these conditions must be met

- **Filter by**: Select...
- **Field to analyze**: Short description (short_description)

Pick a taxonomy to run your data against so we can recommend automation opportunities that need to be improved or created.

- **Taxonomy**: ITSM
  - Cluster unmapped records to identify new automation opportunities to add.

Pick frequency for the report generation

- **Frequency**: Run Once

Recipients for the report

- **Recipient List**: Search and add users to watch list
- **Report name**: Incident 03/24/2021

# of records: 10,066

Report

3. Fill in the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>Type of records that you want to analyze.</td>
</tr>
<tr>
<td></td>
<td>Default is incident (incident).</td>
</tr>
<tr>
<td><strong>Filter by</strong></td>
<td>Criteria for selecting the records you want to analyze.</td>
</tr>
<tr>
<td><strong>Field to Analyze</strong></td>
<td>Field on the data tables that you want Automation Discovery to analyze.</td>
</tr>
<tr>
<td><strong>Taxonomy</strong></td>
<td>Application to run the data against.</td>
</tr>
<tr>
<td></td>
<td>Default is ITSM.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
Select the check box to use the same taxonomy to group unmatched records together.

**Frequency** How often the report runs with the given conditions. **Default is Run Once.**
You can choose to continuously run a report after adding opportunities to your model to check the improvement.

**Recipient list** Users to receive the report via email.

**Report name** Name of the report.

1. **Note:** The **# of records** number provides an estimate to how many records meet your criteria.

4. **Click Run Report.**
Your report appears at the top of the list on the **Discovery Reports** page. The page lists the **Status** of your report. Once the analysis completes, you can click the report to view the results.

**Performance Analytics**

ServiceNow® Performance Analytics is an in-platform process optimization solution to create management dashboards, report on KPIs and metrics, and answer key business questions to help increase quality and reduce the costs of service delivery.

For a basic overview of Performance Analytics, take the following training at no extra charge: Performance Analytics Essentials.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Data Architecture</th>
<th>Visualizing Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Get Started with Performance Analytics (Customer Success Center)</td>
<td>• Indicators</td>
<td>• Analytics Hub</td>
</tr>
<tr>
<td>• Performance Analytics and Reporting release notes</td>
<td>• Breakdowns</td>
<td>• Performance Analytics widgets</td>
</tr>
<tr>
<td>• Upgrade to Rome</td>
<td>• Data collection and cleanup</td>
<td>• Create and use dashboards</td>
</tr>
<tr>
<td>• Watch Performance Analytics videos</td>
<td>• Domain separation and Performance Analytics</td>
<td></td>
</tr>
</tbody>
</table>
Understanding Performance Analytics

Review the Performance Analytics use cases, components, and architecture and begin to implement the product.

Performance Analytics drives business transformation by enabling businesses to set, track, and analyze progress against goals. It connects more people with better data in less time and helps them focus on the things that really matter.

ℹ️ Important: Set up and test Performance Analytics on a non-production instance before you set it up on a production instance.

Performance Analytics improves performance and accelerates continual service improvement by:

- Tracking critical process metrics and trends.
- Measuring process health and behavior against organizational targets.
- Identifying process patterns and potential bottlenecks before they occur.
- Continually visualizing historical and real-time process health statistics in role-based dashboards enabling individual stakeholders to make informed decisions.

Benefits of using Performance Analytics can include:
Delivering insights in an instant

Your people can get relevant, personalized insight by clicking a button instead of exporting data from databases and spreadsheets. You no longer manually create reports that quickly become stale and outdated.

Establishing a single version of truth

By defining visualizations and ensuring they are based on consistent, accurate data, you provide a single version of reality that teams can use to drive positive change.

Accelerate time-to-value

Implement Performance Analytics within weeks instead of months and quickly take advantage of data insights.

Drive toward continual improvement

Performance Analytics can help you pinpoint areas for improvement. Act based on key indicators, mobile-enabled scorecards, time charts, drill-downs, and dashboards.

<table>
<thead>
<tr>
<th>Watch this five-minute video to familiarize yourself with ServiceNow Performance Analytics concepts.</th>
<th>Watch this seven-minute video to learn how Performance Analytics benefits different kinds of users on different dashboards.</th>
</tr>
</thead>
<tbody>
<tr>
<td>This video shows a sample business scenario and how Performance Analytics supports that scenario.</td>
<td>This video describes Performance Analytics dashboards for executives, process owners, and front-line workers who have different goals and needs with regards to dashboards.</td>
</tr>
</tbody>
</table>

Tip: For an introduction to using Performance Analytics, take the Performance Analytics Essentials course.

Performance Analytics concepts

Performance Analytics uses terms and concepts that can differ from industry norms due to the unique nature of the ServiceNow platform.

Note: Performance Analytics is used by other applications, such as Benchmarks. The information below describes the core Performance Analytics functionality. For information about other applications that use Performance Analytics, refer to the documentation for those applications.

Performance Analytics includes the following concepts and components:
Key components

Indicators
define a performance measurement taken at regular intervals of a business service, an activity, or organizational behavior. These performance measurements result in a series of indicator scores over time. Businesses track these scores to measure current conditions and to forecast trends.

Technically, an indicator combines a data set and a data aggregate, such as Count, along with optional conditions.

Key characteristics of indicators include:

• Indicator scores can be generated automatically from a set of records defined in an indicator source, entered manually, or calculated from other indicators.

• Indicator scores can be viewed or analyzed in the Analytics Hub or presented, via widgets, on dashboards.

For convenience, you can organize indicators thematically into an indicator group.

Synonyms: Metrics, business metrics, KPIs

Breakdowns and elements
enable you to group or filter indicator scores by a qualitative attribute such as Priority, Category, or Assignment Group. You can apply a breakdown on the Analytics Hub, in KPI Details, and on dashboards.

For example, you can look at the Number of Open Changes by Assignment Group. Or you can see the Number of New Changes by Priority.

The values for each breakdown are called breakdown elements. For example, the Priority breakdown may have the elements Critical, High, and Low. Breakdowns are categorized as automated, manual, or external, depending on where these elements come from. Automated breakdown elements are specified in breakdown sources. Manual breakdowns have their elements entered manually to define an organization. Lastly, an external breakdown specifies the JDBC data source and SQL statement for retrieving breakdown elements.

Synonyms: dimensions, drill-downs

Data collector
is the engine that takes periodic snapshots of your process tables and stores them in the Scores and Snapshots tables. You can set up data collector jobs to run automatically according to a schedule. Usually set a job schedule to match the frequency in the indicator source. One job usually generates scores for multiple indicators that use the same indicator source. You can also set up jobs that run manually, such as historical jobs, which you run only when collecting data for a new indicator.

Classic Visualizations

Analytics Hub

is an exploratory view of indicators, used for more detailed analysis. It lets you see trends, predictions, breakdowns, and associated records for a specific indicator. Set on the indicator record whether that indicator is to be included in the Analytics Hub.

The Analytics Hub was previously named the Detailed Scorecard.

Dashboards

are collections of multiple Performance Analytics, reporting, and other widgets, arranged in a logical view for the audience. Dashboards can be responsive or non-responsive. To create or share a responsive dashboard, you need at least one role, but this can be any role. You can drag to move and resize widgets on responsive dashboards. Non-responsive dashboards use less flexible drop zone layouts, and require Performance Analytics roles to view, create, and edit.

Time series

can refer to either of the following items:

• A type of widget that aggregates and shows multiple scores of an indicator collected over a period. See Time series widgets.

• A statistical function applied to collected indicator scores over a time period in the Analytics Hub or in a widget, also called an aggregator. See Applying time series aggregations.

Targets

are goals your organization wants to achieve, operationalized as indicator scores. Targets enable you to visualize the difference between the desired score at a certain date and the actual score of an indicator.
A target can be personal or global. A personal target is visible only to the user that created it and appears as a light line. A global target is visible to all users and appears as a dark line. Personal targets appear only on the Analytics Hub, whereas global targets appear on the Analytics Hub and time series widgets.

**Thresholds**

define a normal range of scores for an indicator and alert you when certain events occurs, such as when a score reaches an all-time high or low.

When a threshold is triggered, the instance generates an email notification. This message is associated with the indicator and the message is directly available via the Analytics Hub.

A threshold can be personal or global. A personal threshold is visible only to the user that created it and appears as a light gray dotted line. A global threshold is visible to all users and appears as a dark gray dotted line. Personal thresholds appear only on Analytics Hubs, while global thresholds appear on both the Analytics Hub and time series widgets.

**Widgets**

in Performance Analytics are reusable visualizations of indicator scores. For example, a widget can display the evolution of an indicator over time, how an indicator can be broken down, or how several indicators look side by side. Many variations are possible. Widgets are visible only when added to a dashboard.

**Other concepts**

**Aggregate/Aggregation**

can refer to either of the following functions:

- The Performance Analytics function of aggregating, or collecting, indicator scores over time. The indicator configuration includes the frequency with which indicator scores are collected.

- Statistical functions applied to collected indicator scores over a time period. For example, you can apply a 3-month SUM to indicator scores. Aggregation functions can be added either in the indicator form or later in the the Analytics Hub or widget. Aggregation functions in the Analytics Hub or widget are named time series.
specify the relationships, or 'map,' breakdowns to indicator sources. A breakdown mapping either specifies a field on the indicator source or specifies a script that queries the indicator source. The latter is sometimes called a scripted breakdown mapping, and a breakdown with such a mapping is called a scripted breakdown.

**Breakdown sources**

specify which unique values, called breakdown elements, a breakdown contains. A breakdown source is defined as a set of records from a table or database view or as a bucket group. Multiple breakdowns can use the same breakdown source. For example, instead of seeing ALL assignment groups for the Number of Open Changes indicator, you can limit the element list to just those groups that are part of the change process by configuring the Breakdown Source.

**Bucket groups**

are used to recategorize data so it can be used as a breakdown, for example by grouping a range of values into discrete buckets.

To work with a bucket group, create a breakdown source that uses Bucket [pa_buckets] as the facts table and specifies the bucket group in a condition. If a breakdown built on this source uses a breakdown mapping with a script, the breakdown groups the values that the script returns into buckets. If the breakdown mapping specifies a field instead of using a script, the breakdown groups the values of the mapped field into buckets.

In the data architecture, bucket groups are defined in Bucket Group [pa_bucket_groups] records and buckets in Bucket [pa_buckets] records. Each Bucket [pa_buckets] record contains a Bucket Group field that is a reference to a Bucket Group [pa_bucket_groups] record.

**Day**

A day in Performance Analytics is always defined as 24 hours. Performance Analytics does not use the concept of 'business days.'

**Indicator sources**

are data sets consisting of filtered records from one table or database view. An indicator source configuration specifies a table, such as Incident [incident], conditions for filtering records from that table, and a frequency that you base on the conditions. An indicator source cannot specify a rotated table. Multiple indicators can use the same indicator source. Data collection jobs query the
database once for each indicator source. Thus, all indicators that use the same indicator source get data from the same point in time.

Typically, an indicator tracks the situation on a certain date. The indicator source conditions usually include a date-related filter, such as `[Opened][on][Today]`. Indicators collected less frequently might specify a larger date range, such as `[Closed][on][This month]`.

**Scripted breakdown**

is a breakdown that uses a script to query the indicator source as its breakdown mapping.

**Snapshots**

are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with **Collect records** selected.

The snapshot/list of records can be retrieved in the Analytics Hub.

Snapshots are kept for the main indicator and for first-level breakdowns. Second-level breakdown snapshots are derived as an intersection of the two first-level breakdown snapshot lists.

**Performance Analytics stakeholders**

The most common personas that benefit from the deployment of a Performance Analytics solution are: Service owners, Executives, Front Line workers, and of course, the End Users.

Listen to the Story of the Four Stakeholders to understand who are the main personas interacting with Performance Analytics and what types of business process data is needed by different people in your organization.

The story of the four main stakeholders of Performance Analytics and the data that they need

**Put a Spotlight on records**

Use the Spotlight feature to illuminate records that you might overlook.

You can define weighted criteria to identify and rank records that require attention, such as when triaging incidents or performing lead scoring. You can rank records based on multiple dimensions, instead of by a single field value such as priority. While most organizations address high-priority items in a timely manner, lower priority items sometimes are not addressed for an extended period of time. Spotlight helps you focus on items based on business need.

Watch this 5-minute video about the business use of Spotlight.

Conceptual understanding of Spotlight
Try out Complimentary Performance Analytics for Incident Management

Complimentary Performance Analytics for Incident Management is a limited version of Performance Analytics that is included in the base system, enabling you to become familiar with the functionality. Subscribe to Performance Analytics for complete functionality.

ℹ️ **Note:** As an alternative to using Complimentary Performance Analytics for Incident Management, you can activate a plugin with the full features of Performance Analytics without a subscription on a non-production instance.

Complimentary Performance Analytics for Incident Management has the following features and limitations:

- Includes the Performance Analytics Admin Console, which you can use to activate the full set of Performance Analytics features.
- Indicators cannot be added or deleted
- A maximum of 180 days of historic scores are visualized
- Is usable only in the global domain

To try out Complimentary Performance Analytics for Incident Management, navigate to **Performance Analytics > Guided Setup** and launch the Incident Management guided setup. This setup takes you on a tour of indicators, breakdowns, their sources, data collection, and viewing results.

You can also try out the Spotlight feature with Complimentary Performance Analytics for Incident Management. Spotlight helps prioritize work by evaluating records against multiple weighted criteria. Without a license you can only use Spotlight with incident records and you cannot access the Spotlight interactive analysis. To try out Spotlight, activate the Performance Analytics - Spotlight - Incident Spotlight plugin and follow the guided setup at **Spotlight > Guided Setup**. The admin role is necessary to activate the plugin.

The free two-hour course **Performance Analytics Essentials** provides an introduction to PA components and concepts you can use with Complimentary Performance Analytics for Incident Management. (Registration required.)

**Performance Analytics compared to Reporting**

Performance Analytics and Reporting are two distinct applications. They address different use cases and are complementary to each other.

Watch this overview video of Reporting and Performance Analytics to understand the limitations of Reporting and how Performance Analytics is used
to fill in the gaps and provide accurate trends over time. Video comparing trends from operational reports and snapshots

Performance Analytics is able to generate accurate historical trends by capturing continuous snapshots on a regular schedule. As illustrated by the following diagram, Reporting answers the question of "Where are we today," while Performance Analytics answers questions of what is happening over time.

In addition to calculating trends from snapshots, Performance Analytics is able to:

- Track performance against Targets.
- Alert when Thresholds are met.
- Forecast future performance.
- Compare performance at different points in time.
- Accelerate time to value with best practice metrics.

**Implement Performance Analytics**

Follow these steps to begin using Performance Analytics to improve your service levels.

**Plan and Prepare**

Define goals and measurements to assess and drive improvement.
1. Identify the business processes you want to measure and improve.
2. Determine factors and behaviors which affect the health of these business processes.
3. Decide on the metrics to measure.

For a tool to help you plan and prepare your Performance Analytics solution, see Design your Performance Analytics solution with KPI Composer.

Start with Analytics and Reporting Solutions
Before you create new indicators, try out the built-in dashboards and indicators available in Analytics and Reporting Solutions.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

1. Check your license entitlement and activate applicable Solutions, as described in Analytics and Reporting Solutions.
2. Verify that your indicator and breakdown sources refer to the correct tables.
3. Customize your indicators and breakdowns to meet the needs of your organization.

Collect data
Collection jobs need to be configured to run with the desired frequency and activated.
1. Schedule and activate data collector jobs.
2. Run historical data collector jobs as a one-off to populate empty indicators.

Share results
Display actionable KPIs that tell the story of your business process and display the right level of information to their intended viewers.
1. Explore the available pre-configured content to get a feel for your data and decide on any dashboard customizations.
2. Grant dashboard access to stakeholders.
3. Empower everyone to take action with embedded, real-time analytics.
Performance Analytics data flow

Before you get started with Performance Analytics, understand how the data flows through the platform, ultimately resulting in your ability to visualize process improvements.

1. Daily business operations and interactions generate data and populate the respective business process tables.
   
   Example: Submitting a new incident creates a record in the Incident table.

2. Active scheduled jobs run regularly to take periodic snapshots of process behavior. Each job calculates indicator (KPI) scores, based on metadata in PA indicators and breakdowns. Over time, this continuous stream of scores builds a trend.
   
   Example: A collection job counts the number of incidents in the Incident table daily. After one month, a trend containing about 30 data points can be viewed.

3. Data snapshots and scores are stored in Performance Analytics data tables. These tables are the source of all Performance Analytics visualizations.

4. Widgets present indicator scores in a specific format, such as a trend line or a bar chart.
   
   Example: The Number of new incidents is an indicator you may want to track. This indicator can be visualized as a single score or a trend of daily readings over time by configuring the appropriate widget.

5. Multiple Performance Analytics widgets are presented in a single Dashboard view, allowing stakeholders to view all relevant business process information in a single place.
Activating your Performance Analytics subscription

For unlimited access to all Performance Analytics features, purchase a subscription to Performance Analytics. After you purchase the subscription, activate the plugin associated with that subscription within the production instance.

All ServiceNow instances are provisioned with a complimentary version of Performance Analytics that has configuration limitations. If you attempt to use functionality on a production instance that is outside those limits, you get a warning that a subscription is required.

New Performance Analytics configuration records cannot be created with the complimentary version of Performance Analytics. To create this record, your business must license Performance Analytics. Contact your sales representative for more information.
The Performance Analytics Admin Console also warns you when an instance does not have the full version of Performance Analytics activated.

Performance Analytics subscriptions enable you to use the following functionality beyond what is available on the complimentary version:

- Creating Performance Analytics indicators, breakdowns, widgets, or other configuration records
- Ability to use Analytics and Reporting solutions besides Incident Management and Spotlight - Incident Management
- Preserving scores for longer than 180 days (Five full months for monthly indicators)
- Creating in-form analytics
- Creating reports using a Microsoft Excel data source as part of the Report Designer report creation workflow
- Creating text analytics widgets
- Using Performance Analytics with external data

**Identify your entitlement to Performance Analytics**

When you purchase a subscription to a Performance Analytics product line, you are entitled to activate the corresponding plugin on production instances.

As an administrator, view your Performance Analytics subscriptions by navigating to **Subscription Management > Subscriptions**. From Subscription Management you can find the Performance Analytics plugins which you are entitled to activate. For more information, see View your subscription applications and allocation levels.
Activate the plugin for your Performance Analytics subscription

When you have purchased a Performance Analytics subscription and identified the associated plugin, activate that plugin as follows.

Before you begin

**Important:** Set up and test Performance Analytics on a non-production instance before you set it up on a production instance.

Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Under Filters, find the Licensing section and select Subscribed.
3. Search for plugins with performance analytics premium in the name.
4. Find the Performance Analytics premium plugin that matches your entitlement and click Install.
   Only the Performance Analytics premium plugins for which you have a subscription should appear in the filtered list.
   The Activate Plugin dialog opens.
5. In the Activate Plugin dialog, click Activate.
Results
A progress bar shows you the progress of the plugin activation, after which you have several options of what to view.

What to do next
When the process is complete, consider installing Analytics and Reporting solutions, which include preconfigured dashboards and all necessary underlying components. For more information, see Analytics and Reporting Solutions.

Also consider activating Spotlight. Spotlight helps prioritize records by evaluating them against multiple weighted criteria. For more information, see Ranking records with Spotlight.

Performance Analytics fundamentals
Create and configure indicators and breakdowns. Collect data. Display calculated Performance Analytics scores.

For an overview of the essential use of Performance Analytics, take the free training Performance Analytics Essentials.

Note: In all visualizations, high scores are abbreviated following the metric system. Thus scores in the millions are abbreviated with an M and scores in the (US) billions with a G.

Design your Performance Analytics solution with KPI Composer
KPI Composer ensures that your performance management strategy aligns with business goals and has support from executive sponsors. Use KPI Composer to bridge the gap between defining your performance measurement strategy and the realization of that strategy from within Performance Analytics. Start with your business goals and plan all your components through indicators up to the final dashboard.

KPI Composer helps you elicit performance management requirements and drive stakeholder alignment by visualizing implementation objectives, desired business outcomes, and required technical deliverables in a concise visual summary. This holistic approach ensures that stakeholders are completely aligned on the desired outcomes and requirements before implementers spend time working on any technical deliverables. When ready, Performance Analytics implementers get a task list of exactly what they need to create — indicators, breakdowns, reports, and dashboards — to support the goals, and you can even use KPI Composer to track the progress of the implementation.

A free training in KPI Composer is available at NOW Learning.
Activating KPI Composer

KPI Composer is available on the ServiceNow Store. Navigate to **System Applications > Search ServiceNow Store**, or point a browser to [https://store.servicenow.com/sn_appstore_store.do#!/store/home](https://store.servicenow.com/sn_appstore_store.do#!/store/home). Search for the application named KPI Composer. If you are downloading the application to a production instance, you need a Now Support account.

After you download the application, navigate to **System Applications > All Available Applications > All**. Search for the KPI Composer application and install it. For an example, see Activate a ServiceNow Store application.

⚠ Note: To get full use of KPI Composer, you should have the appropriate entitlement to use Performance Analytics.

Related reference

Performance Analytics roles

Access to KPI Composer

The level of access to KPI Composer determines whether a user can create, edit, or only view a KPI Composer project. It also determines which projects a user can access and whether they can access the underlying records or only the UI.

Access to KPI Composer depends on the following things, singly or in combination:

- User role
- Responsibility
- Access granted during sharing

Role-based access

An admin can grant a user the role of a KPI Composer admin or user. A KPI Composer admin has the same privileges as a Now Platform admin for KPI Composer. A KPI Composer user does not automatically have access to all projects and cannot associate indicator or breakdown definitions with actual Performance Analytics entities.

User roles for KPI Composer

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_kpi_composer.admin or admin</td>
<td>pa_viewer</td>
<td>• Full access to all components of KPI Composer, including records.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Full access to all projects.</td>
</tr>
</tbody>
</table>
### User roles for KPI Composer (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• Can share or assign responsibility for projects.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Can associate indicator and breakdown definitions with Performance Analytics indicators and breakdowns.</td>
</tr>
<tr>
<td>sn_kpi_composer.user</td>
<td>None</td>
<td>• Can access only projects that they have created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Can share or assign responsibility for projects they create.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Can access only the design tabs, artifact properties, indicator definitions, and breakdown definitions of those projects.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cannot add Performance Analytics indicators or breakdowns to the respective definitions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A user with this role may have access to more projects based on responsibility or on projects being shared with them.</td>
</tr>
</tbody>
</table>

The appropriate Performance Analytics roles are also necessary to implement KPI Composer designs in Performance Analytics.

**Responsibility for projects**

A responsible user has the following access to the projects they are responsible for:

- Can view and edit the projects.
- Can share or assign responsibility for the projects.
- Can access only the design tabs, artifact properties, indicator definitions, and breakdown definitions of those projects.
- Cannot add Performance Analytics indicators or breakdowns to the respective definitions.
This level of access is equivalent to what the sn_kpi_composer.user role grants. It is also equivalent to having a project shared with edit rights. Responsibility differs first in being independent of any role. The second difference is procedural, not technical: Responsible users are understood to be in charge of oversight and implementation of the project. Even the creator of a project is therefore not automatically responsible for it.

Responsible users are named in the project properties. Any user with edit rights can name responsible users. For more information about naming responsible users, see Define properties for a project.

**Shared projects**

Any user with edit rights can share a project. When you share a project, you grant one of two levels of access:

**Edit access**

This level of access is technically the same as the access of a responsible user, or a user with the sn_kpi_composer.user role. The first difference is that no role is required. The second difference is that there is no implication of responsibility to oversee or implement the project.

**View access**

A user with view access can read the design tabs, artifact properties, indicator definitions, and breakdown definitions of the shared project. They can use all viewing utilities, like search and filter. However, they cannot change anything in the project. The only thing they can add is a journal entry.

For more information, see Share a KPI Composer project.

**KPI Composer projects**

KPI Composer is based on projects. Each project in KPI Composer consists of Key Performance Indicator (KPI) trees and the functional and technical definitions of all artifacts within those trees. You can create multiple projects.

The KPI Composer project UI provides you with a sequence of four tabs, each corresponding to a phase in your project:

**Analysis**

In this phase, you create a hierarchical tree of Business Goals, Critical Success Factors, and Measurements (or KPIs). Conceptually defining KPIs and mapping them to Goals and Success Factors produces a detailed functional specification of all required Performance Analytics configurations. This specification is vetted
by the business sponsors and provides a clear direction to the technical implementers.

Dashboard Design

In this phase, you create a design specification for one or more Performance Analytics dashboards. Use the Dashboard Visualization tab in presentations early in your implementation to get timely feedback, so when your project is complete, the dashboard viewers get the visualizations they expect.

Data Definition

In this phase, you provide technical specifications for Performance Analytics Indicators that match the KPIs that you defined during Analysis. You can link the KPIs to appropriate Performance Analytics indicators that already exist or that you create later.

Review

In this phase, verify the design components in your project, run a system definition health check, and generate a task list for implementing the project in Performance Analytics.

Create a KPI Composer project

As the first step in using KPI Composer, create a project.

Before you begin
Role required: sn_kpi_composer.user, sn_kpi_composer.admin, admin

Procedure

1. Navigate to KPI Composer > Projects and click New.
2. In the Create new project dialog, give the project a meaningful name and click Save.

Results
Your project is created and is visible in the Projects page.

What to do next
As you work on the project, keep track collaboratively in the Project Journal.
Define properties for a project

In the Project Properties, you can associate knowledge articles, owners, and contact persons with the project.

Before you begin

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

Note: Project Properties are similar to the Info tab of Artifact Properties. Only the scope is different.

Procedure

1. Navigate to KPI Composer and create or open a project.

2. In the Analysis tab, click the Information icon (at the top right of the screen.

3. Give the project a meaningful name.

4. Add a detailed description of the project, so other users can understand its purpose.

5. Specify the business objective you hope to reach with this project.

6. Specify any of the following details:

   • Knowledge articles that contain information relevant to the project. You can link any number of knowledge articles.

   • Responsible users. A responsible user has full editing privileges but also is expected to be responsible for implementing the project. This responsibility
distinguishes a responsible user from a user with whom the project has been shared with editing rights.

- Contact persons

**Add personas to a project**

Each project has several personas with different roles in the Performance Analytics solution that you are designing. A persona is a role within your company, such as service desk manager or service owner.

**Before you begin**

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

**Prerequisites**

Create a KPI Composer project

**Procedure**

1. Navigate to **KPI Composer** and create or open a project.

2. In the Analysis tab, click the persona icon (👍) at the top right of the screen.

3. In the Persona dialog, click **Add item**.

4. Type the name of the new persona and click outside the text box. The persona appears in the header of the KPI tree canvas. Each persona automatically gets a 2-letter identifier, which is based on the first two words (or first two letters if only one word) that are in the name.

5. Repeat these steps to add more personas.
Example: Adding personas to a KPI Composer project

In the following short animation, you see how to add the personas Agent and CIO to a project. Then you see how to add the CIO persona to a Business Goal.

What to do next

Drag personas onto existing artifacts on the canvas to add them to those artifacts. You can add an unlimited number of personas to any artifact. If an artifact has more than three personas, the full names of the personas are hidden. To see the full names, point to the personas.

By holding down the Ctrl/Command or Alt/Option key while dropping a persona onto an artifact, you activate the following advanced functions:

Hold Ctrl while dropping

Add the persona to the artifact on which it is dropped and to all child artifacts of that artifact.

Hold Alt while dropping

Remove the persona from the artifact on which it is dropped.

Hold Ctrl and Alt while dropping
Remove the persona from the artifact on which is dropped and from all child artifacts of that artifact.

**Group data by breakdown definitions**

Each project can have a set of breakdown definitions that you can use to group the data in KPIs. These breakdown definitions provide the specifications for Performance Analytics breakdowns that you eventually create.

**Before you begin**

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

**Prerequisites**

Create a KPI Composer project

**Procedure**

1. Navigate to **KPI Composer** and create or open a project.

2. In the Analysis tab, click the 'Group by' icon ( ) at the top right of the screen.

3. In the 'Group by' dialog, use the sliders to select which breakdown definitions to include in your project.
The selected breakdown definitions appear in the header of the KPI tree canvas. From here, you can drag them onto artifacts.

4. To add a new breakdown definition to your project, click **Add Item** and enter the term.

The new item appears in the 'Group by' list, and a matching breakdown definition record is created.
Example: Selecting breakdown definitions for a KPI Composer project

In the following short animation, you see how to select the breakdown definitions Assignment Group, Impact, and Priority to a project. Then you see how to group the values of a KPI tree artifact by Assignment Group and Priority.

What to do next

Drag breakdown definitions (‘Group by’ items) onto existing artifacts on the canvas. You can group the data associated with an artifact by any number of breakdown definitions. The colored dots on an artifact show which breakdown definitions the artifact is grouped by. To see the names of these breakdown definitions, point to any of the colored dots on the artifact.

By holding down the Ctrl/Command or Alt/Option key while dropping a breakdown definition onto an artifact, you activate the following advanced functions:

**Hold Ctrl while dropping**

Add the breakdown definition to the artifact on which it is dropped and to all child artifacts of that artifact.
Hold Alt while dropping
Remove the breakdown definition from the artifact on which it is dropped.

Hold Ctrl and Alt while dropping
Remove the breakdown definition from the artifact on which is dropped and from all child artifacts of that artifact.

Define a breakdown
Provide the functional description of how to build an actual Performance Analytics breakdown in a breakdown definition. Once an appropriate Performance Analytics breakdown exists, you can link to it in the breakdown definition.

Before you begin
Role required: sn_kpi_composer.user, sn_kpi_composer.admin (to link to Performance Analytics breakdown), admin. No roles required for responsible user or user with edit access, except to link to link to Performance Analytics breakdown.

About this task
The breakdown definitions that you add to KPI Composer projects are not actual Performance Analytics breakdowns. They are only placeholders that describe what the Performance Analytics breakdown should be. In KPI Composer breakdown definitions, you provide either or both of the following pieces of information:

• The details that a Performance Analytics expert needs to create the actual breakdown.
• A reference to an existing Performance Analytics breakdown that meets your requirements.

Procedure

1. In the Analysis tab, click the 'Group by' icon ( ).
2. Click the name of the breakdown you want to define.
3. Fill in the following information:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA Breakdown</td>
<td>A Performance Analytics breakdown that exists on this instance.</td>
<td>If a breakdown definition does not have a reference to a Performance Analytics breakdown, consider creating that breakdown.</td>
</tr>
<tr>
<td>(Restricted to sn_kpi_composer.admin and admin roles)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Facts Table</td>
<td>The table that the breakdown source for the Performance Analytics breakdown has to reference.</td>
<td>Key information for creating a breakdown.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The filter conditions to apply to the facts table either in the breakdown source or in the breakdown itself.</td>
<td></td>
</tr>
</tbody>
</table>

**Write journal entries for a project**

Keep track of your KPI Composer project with journal entries

**Prerequisites**

Create a KPI Composer project

**About this task**

Anyone with access to a KPI Composer project, including view access, can write a journal entry.

**Procedure**

1. Click the journal icon ().
2. Write a journal entry.
3. Click Post.

**Results**

All posted journal entries appear in descending chronological order.
You can share a KPI Composer project that you own or that you are responsible for. You can provide the user with either read-write or read-only access.

**Before you begin**
Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

**Prerequisites**
Create a KPI Composer project

**About this task**
When you share a project with the right to edit, that user has the same rights technically as a responsible user. The difference has to do with project management: A user who has had a project shared with them simply can...
edit the project, whereas a responsible user is responsible for the successful implementation of the project.

**Procedure**

1. Navigate to **KPI Composer** and create or open a project.

2. Click the Sharing icon on the toolbar (/uploads/).

3. Click **Add groups and users**.

4. Type to search for either a group or a user.

5. Select either **Can view** or **Can edit** access.

6. Select **Share** or **Cancel**.

**Analysis and the KPI tree**

In the Analysis tab of KPI Composer, design your KPI tree. Specify your business goals, their associated critical success factors, and the measurement related to those factors. Chart the logical relationship between these factors and the personas who are responsible for them.

A KPI tree contains the following hierarchically related artifacts:

**Business goals**
Typically, you put a business goal at the top of your KPI tree. This goal represents what you want to achieve with the dashboards coming forth from this project. A business goal can be something like "Cost Efficiency" or "Quality Assurance."

**Critical Success Factors**

Put these factors under your business goals to identify what your organization needs to do to achieve the business goal. Critical success factors can be placed under a business goal or under other critical success factors.

**Measurements**

Decide how to measure the performance of a critical success factor. Measurements are the most 'indicator-like' artifact in the KPI tree. They contain the functional description of how to make the measurement. Additionally, you can store who is responsible for the measurement and who to contact in case this measurement is used in different projects.

The KPI tree has a header and a footer with the following drag-and-drop icons:

- **Artifacts**, on the left of the footer
- **Breakdown definitions**, on the right of the header (See Group data by breakdown definitions)
- **Personas**, on the left of the header (See Add personas to a project)

**Filtering**

The following filter options are available on the Analysis tab:

- **Filter by persona.** Select a Persona icon in the header to highlight the artifacts that are linked to the persona. You can select multiple personas. In this case, any artifact that is linked to at least one of the selected personas is highlighted.

- **Filter by breakdown definition.** Select a Breakdown definition icon in the header to highlight the artifacts that are linked to the breakdown. You can select multiple breakdowns. In this case, any artifact that is linked to at least one of the selected breakdowns is highlighted.

- **Filter on text.** Enter text in the filter field, then leave the field. All artifacts that contain the text are highlighted.

All filter functions can be used with each other.
Expanding and collapsing tree nodes

When working with large KPI trees, you can close those parts of the tree that you are not currently working with. To collapse part of a tree, click the minus - icon on an artifact that has child artifacts. Collapsed nodes appear as a shadow under the top-level node. To expand collapsed nodes, click the plus + icon.

When a filter or a search matches a collapsed, hidden artifact, the tree does not expand. Instead, the “shadow” turns white although the top-level element remains grey.
Add artifacts to a KPI tree

Add artifacts to the KPI tree by using the drag-and-drop tiles at the bottom of the project canvas.

Before you begin

Think about your business goal and critical success factors before you begin to work on a project.

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

Procedure

1. Navigate to KPI Composer and open or create a project, then navigate to the Analysis tab.

2. Locate the KPI tree artifacts at the bottom of the screen.

3. Drag a Business Goal icon to the top of your project.
   To keep your planning simple, usually you have one business goal for each project, but you can have business goals as children of other business goals.

4. Set the Business Goal properties as described in "Artifact properties."
   You can edit these properties later by clicking the Edit icon (▎) on the artifact tile.
5. Repeat this process with Critical Success Factors and Measurements. Drop an artifact on top of another artifact to have the new artifact displayed as a child of the existing artifact. Critical Success Factors can be children of Business Goals or other Critical Success Factors. A Measurement can be a child of any artifact.

6. As an alternative to creating and configuring all your artifacts, you can add an existing Library Element.

   a. Select the bookmark icon to open the Library Elements list.

   b. Drag an appropriate library element into your KPI tree.

For more information, see Cross-project library elements.

**What to do next**

If you change your mind about the relationships in a tree, you can select and drag an existing artifact to a different artifact. You can also change the ordering of artifacts. Drag a child artifact onto its parent to move it into the top position among its siblings.

**Artifact properties**

Each artifact in a KPI tree can reference knowledge base articles, personas, or breakdown definitions.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique, meaningful name</td>
<td>High-quality cost-effective business resolution (for a business goal artifact)</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the artifact to help others understand its purpose and to avoid redundancy</td>
<td>Total monetary cost from when an incident is raised until it is resolved, including estimated salary and opportunity costs</td>
</tr>
<tr>
<td>Target</td>
<td>The future performance improvement you want from Performance Analytics. If you do not yet have a quantitative target score for an indicator, describe the target qualitatively.</td>
<td>A 10% reduction every month until a final value of 40 is reached.</td>
</tr>
<tr>
<td>Add this element to the library</td>
<td>Adds this artifact and any child artifacts in the KPI tree to a multi-project, reusable library element.</td>
<td>For more information, see Cross-project library elements.</td>
</tr>
<tr>
<td>Info</td>
<td>Specify any of the following details: • Knowledge articles that contain further explanation about the artifact. You can link any number of knowledge articles. • Artifact owners • Contact persons</td>
<td>This short animation shows a knowledge article being added to an artifact.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Persona</td>
<td>The personas currently linked to the project. In the artifact properties, you can only add and remove personas to the artifact. For information about adding personas to the project, see Add personas to a project.</td>
<td>In this image, the Agent and CIO personas are linked to the project. The CIO persona is linked to the artifact and the Agent persona is not.</td>
</tr>
<tr>
<td>Group by</td>
<td>Group the data associated with an artifact by one or more of the breakdown definitions selected for the project. For information about adding breakdown definitions to the project, see Group data by breakdown definitions.</td>
<td>In this image, the Assignment Group, Impact, and Priority breakdown definitions are available for the artifact. The data in the artifact is grouped by only Assignment Group.</td>
</tr>
</tbody>
</table>

Cross-project library elements

Library elements are single artifacts or trees of artifacts that you can reuse in multiple projects.

Each library element has a single root artifact. All child artifacts of that artifact are included in the library element. The following image shows a library element based on the Improve Customer Service Quality critical success factor. The two measurement artifacts that are its children are included automatically in the library element.
You can drag a library element into a KPI Tree from the **Library Elements** menu on the Analysis tab of any project.

**Create a library element**

Convert an artifact and its children in a KPI tree into a KPI Composer cross-project library element.

**Before you begin**

You need an existing project with a KPI tree with at least one artifact.
Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

About this task

Tip: You can nest library elements. In other words, you can create a library element from an artifact that includes another library element among its descendants. The elements of the original library element are included in the new, higher-level one. The original library element still exists and can be included in a KPI tree on its own.

Procedure

1. Open the Analysis tab of a KPI Composer project.
2. Select an artifact in the tree.
   Select an artifact that you want to be able to reuse in other projects. If you want to reuse a group of artifacts, select the root artifact. All descendant artifacts of the root artifact will be included in the library element.

Example

In this example, you want to reuse the "Improve Customer Service Quality" critical success factor. You want to use it with its two child measurements "% of incidents resolved on time" and "% of major incident first call resolution."
3. In the properties window of the artifact, select **Add this element to the library**.

**Example**
In this example, you have opened the properties of the “Improve Customer Service Quality” artifact and are about to click **Add this element to the library**.
Results
The selected artifact and its descendants are converted to a library element. A bookmark icon is added to each of their tiles to identify them as belonging to a library element. You can no longer edit them in the original project.

Example: "Improve Customer Service Quality" library element
This example shows the library element that results from the procedure steps. The root artifact is "Improve Customer Service Quality." The library element consists of it and the two measurements "% of incidents resolved on time" and "% of major incident first call resolution."

What to do next
A library element starts out as Personal in scope. Only the user who created it can add it to a KPI tree. If you have the admin or sn_kpi_composer_admin role, you can change the scope of a library element to Global. All users can add Global library elements to their KPI trees. You cannot edit a library element from inside a project.

Use a library element
Add a library element to a KPI tree in any KPI Composer project.
Before you begin
You must have at least one library element you can use.
Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

Procedure
1. Navigate to Application > Module.
2. Select the bookmark icon to open the Library Elements list.
3. Drag an appropriate library element into your KPI tree.
   The tile for a library element lists the number and type of artifacts included in the element. The following image shows the tile for a library element with one critical success factor and two measurements.

4. To remove a library element from a KPI tree, delete the root artifact.
   You do not have the delete option from any other artifacts in the library element.

What to do next
You can add as many library elements as you want to a KPI tree. You can add the same library element as many times as you want.

Edit or delete a library element
You can add artifacts to a library element, or convert a library element back to project-based artifacts. You can also edit the data definitions of artifacts in a library element.

Before you begin
Role required: sn_kpi_composer.admin or admin for full editing functions
Procedure

1. Open the Analysis tab of a KPI Composer project.

2. Select the root artifact of one of the library elements in the KPI tree to open its properties.
   Bookmark icons ( ☐ ) identify the artifacts that are in a library element. The root artifacts, or parent artifacts, are the most top-level artifacts in each library element.

3. To delete a library element, select **Unlink element from library**.

4. To edit a library element, select **Open library element**.

The artifacts are no longer members of that library element. However, every KPI tree that contained that library element still contains those artifacts, only now they are a separate set of ordinary artifacts in each tree.
Note:

- You can open a library element from any artifact in that element, not only the root artifact.
- If you have the sn_kpi_composer.admin or admin role, you can instead navigate to KPI Composer > Library and open a library element from a set of library element tiles.

5. To add an artifact to the library element, follow the instructions in Add artifacts to a KPI tree.

Note:

- You do not need to click Add this element to the library in the properties of the new artifact. If you click this link, you add the new artifact to a new library element that is nested inside this library element.
- Instead of adding a new artifact, you can add another library element, which is then nested inside this library element. For more information, see Use a library element.

6. To add indicator and report definitions to the artifacts in a library element, open the Data Definition tab and follow the instructions in Defining indicators and reports.

7. Select the information icon ( ) to view or edit the library element properties, such as whether the library element is global or personal in scope. You need the sn_kpi_composer.admin or admin role to edit properties. Otherwise, they are read-only.

Library element properties

Each KPI Composer library element has the following properties. You need the sn_kpi_composer.admin or admin role to edit them.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique, meaningful name</td>
<td>By default, the name is the same as the name of the root artifact, such as Improve Customer Service Quality.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the artifact to help others understand its</td>
<td>Total monetary cost from when an incident is raised until it is resolved.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Purpose and to prevent redundancy</td>
<td>including estimated salary and opportunity costs</td>
<td></td>
</tr>
<tr>
<td>Objective</td>
<td>The future performance improvement you want from Performance Analytics. If you do not yet have a quantitative target score for an indicator, describe the target qualitatively.</td>
<td>A 10% reduction every month until a final value of 40 is reached.</td>
</tr>
<tr>
<td>Global</td>
<td>When Yes, all users can add this library element to their KPI trees. When No, this library element is personal and only the user who created it can use it. Default: No</td>
<td>N/A</td>
</tr>
<tr>
<td>Knowledge Articles</td>
<td>Articles in the knowledge base that contain further explanations about the library element. Specify any of the following details:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Knowledge articles that contain further explanation about the artifact. You can link any number of knowledge articles.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Artifact owners</td>
<td>KB0000006 Dealing with Spyware and Viruses</td>
</tr>
<tr>
<td></td>
<td>• Contact persons</td>
<td></td>
</tr>
<tr>
<td>Responsible</td>
<td>A responsible user has full editing privileges but also is expected to be responsible for maintaining the library element. For more</td>
<td>Abel Tuter</td>
</tr>
</tbody>
</table>
### Designing dashboards

In the Dashboard Visualization tab, you can create mock-ups of multiple dashboards with visualizations corresponding to artifacts in the Analysis tab. You can link widgets in this mock-up to Performance Analytics widgets.

The final outputs of your project are Performance Analytics dashboards, with perhaps separate dashboards or separate tabs corresponding to your Critical Success Factors and widgets displaying the measurements. In Performance Analytics, you cannot create these dashboards until all of the underlying indicators and breakdowns are created. Designing the widgets for these indicators is also somewhat technical, requiring at least a pa_power_user role. When you share the final dashboards, too often the viewers who need the dashboards send feedback that your designs did not quite meet their needs or expectations.

The KPI Composer Dashboard Visualization tab lets you start dashboard design much earlier in the workflow. You can start work on the visualization when you have only a conceptual tree of your success factors and measurements on the Analysis tab. Furthermore, you can involve other stakeholders earlier in the process. Use KPI Composer in presentations early on to get timely feedback, so when your project is complete, the dashboard viewers get the visualizations they expect.

### Add a dashboard

As the first step in designing your dashboards, add an empty dashboard to the KPI Composer Dashboard Visualization tab.

### Before you begin

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab.

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

---

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>information, see Access to KPI Composer.</td>
<td></td>
</tr>
<tr>
<td>Contacts</td>
<td>A person who is not responsible for the library element but is an interested party or a relevant subject matter expert to consult.</td>
<td>Abraham Lincoln</td>
</tr>
</tbody>
</table>
Procedure

1. Navigate to KPI Composer and open the project.
2. Navigate to the Dashboard Visualization tab.
3. Click + Add Dashboard.
4. Give the Dashboard a meaningful name, probably corresponding to a Business Goal or a higher-level Critical Success Factor in the KPI tree.
5. Optional: Click the Edit Item icon (edit) in the Dashboard artifact to edit dashboard properties.
6. Repeat this process for all Business Goals or Critical Success Factors for which you want to create dashboards.

Example: Add a Customer Experience dashboard to the Design tab

In the following short animation, you see the user create a dashboard named Customer Experience, after a Critical Success Factor. The user adds the Agent and CIO personas, who are expected to view the dashboard. The user groups all the widgets on the dashboard by Assignment Group, intending to create a breakdown dashboard.

KPI Composer dashboard details

Each KPI Composer dashboard mock-up can reference project personas or 'Group by' categories, or an existing Performance Analytics dashboard.
<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA Dashboard</td>
<td>Link to an existing Performance Analytics dashboard. This can be an older dashboard that corresponds to your use case, or a new dashboard that you create based on this KPI Composer design. By linking dashboards as you create them, you can keep track of the state of your project.</td>
<td>In this image, you see the existing Performance Analytics dashboards being filtered by the word &quot;Incident&quot;.</td>
</tr>
<tr>
<td>Persona</td>
<td>The personas you expect to view the final dashboard. Choose from the personas currently linked to the project. For information about adding personas to the project, see Add personas to a project. After you link personas to a dashboard mock-up, only the artifacts from the Analytics tab that are associated with those personas are available.</td>
<td>In this image, the Agent, CIO, and Incident Manager personas are linked to the project. The Agent and CIO personas are linked to the dashboard. The Incident Manager is not.</td>
</tr>
<tr>
<td>Group by</td>
<td>Group all the widgets you place on a dashboard by one or more breakdown definition. (The resulting design is for a Performance Analytics breakdown</td>
<td>In this image, the Assignment Group, Impact, and Priority breakdown definitions are available to dashboards in the project. The data in the dashboard is</td>
</tr>
<tr>
<td>Detail</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>(dashboard.) Choose from the breakdown definitions currently selected for the project. For information about adding breakdown definitions to the project, see Group data by breakdown definitions.</td>
<td>grouped by Impact only.</td>
</tr>
</tbody>
</table>

**Related information**

**Using breakdowns on dashboards**

**Add tabs and rows to a dashboard**

A dashboard mock-up in KPI Composer requires you to lay out the tabs and rows before adding visual components.

**Before you begin**

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. You also have at least one dashboard defined in the Dashboard Visualization tab.

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

**Procedure**

1. Open a **KPI Composer** project and navigate to the Dashboard Visualization tab.
2. Select one of the dashboards in the tab.
3. Click the + icon underneath the dashboards.

   ![Dashboard Visualization Tab](image)

4. Either:
• Select a tab template. The tab is created with a name, rows, and canvases inherited from the template. You do not have to add rows or canvases, but you can edit the ones you have.

• Select No template. You create an empty tab and populate it with rows and canvases, as described in the rest of this procedure.

5. Give the tab a meaningful name, probably matching a lower-level Critical Success Factor.

6. Click Add Row.
   A row is a horizontal design area. Add at least one row to each tab.

7. In the Row details dialog, select the number of canvases in the row.
   The term 'canvases' here refers to spaces that hold widgets and refer to artifacts. Decide how many canvases you want placed horizontally in the row. You can select up to three canvases. You can change this number or move the row later.

Example: Adding a tab and a row to a dashboard

In the following short animation, you see a user adding the Quality of service tab to the Customer Experience
dashboard mock-up. The user gives the first row in this tab three canvases.

**What to do next**
Add more rows or tabs following this procedure. Or, you can add canvases to the rows you have created and come back and add more tabs and rows later.

**Add canvases to a dashboard tab**
Combine analytics artifacts and widgets to create visual components, called canvases, on a KPI Composer dashboard mock-up.

**Before you begin**
You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. You also have at least one dashboard defined in the Dashboard Visualization tab. Lastly, one of these dashboards has at least one tab, containing at least one row.

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

**Prerequisites**
- Add a dashboard
Procedure

1. Open a **KPI Composer** project and navigate to the Dashboard Visualization tab.

2. Select one of the dashboards in the tab. Select a dashboard with at least one tab and a row with empty canvas slots.

3. In the upper right of the Dashboard Visualization tab, expand the Artifacts icon ( ).

4. Select an artifact that you want to represent in a canvas slot, and drag the artifact to the slot. You previously defined these artifacts in the KPI tree in the Analysis tab. You can drag multiple artifacts into the same canvas slot. You can even drop artifacts onto a canvas slot after you have added a widget to that slot. However, you cannot drop artifacts onto a canvas slot that contains a content block or an interactive filter widget. When you drag an artifact onto an unnamed canvas, you give the name of the artifact to the canvas. Dragging additional artifacts onto the canvas does not change the name. If you have selected any personas in the dashboard properties, only the artifacts that are linked to those personas are available.

5. In the upper right of the Dashboard Visualization tab, expand the Widgets icon ( ).

6. Decide which widget represents the data in the artifact you previously selected, and drag it to the same canvas slot. Widget designs use static images and not actual data visualizations. Interactive Filter widgets only affect Report widgets that are on the same dashboard. To replace a widget on a canvas, drag another widget onto it. The title of the original widget remains, unless you replace it with a Content Block. Replacing widgets does not affect artifacts associated with a canvas. After you drag a widget, the Canvas Details dialog opens.

7. Fill in the Canvas Details, as follows:
Note: To change the Canvas Details of an existing widget, click the pencil icon (✏️) on the canvas. This icon appears when you point to the top-right corner of a canvas.

Canvas Detail options for all widgets

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget type</td>
<td>Select the type of widget that represents the artifact. If you have already selected a widget type, you can change that type. The other fields depend on which widget type you select.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter a meaningful title, such as Percent of incidents per assignment group.</td>
</tr>
<tr>
<td>Description</td>
<td>Information about the widget for internal use, such as Widget based on formula indicator % open incidents by assignment group. This entry is not visible in the widget.</td>
</tr>
</tbody>
</table>

Canvas Detail options for Performance Analytics widgets

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visualization type</td>
<td>Decide which visualization best illustrates the element.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Set whether this widget follows the breakdown element that a viewer selects on a Performance Analytics breakdown dashboard.</td>
</tr>
<tr>
<td>Time Series</td>
<td>Show results in daily, weekly, or monthly increments.</td>
</tr>
<tr>
<td>Measurement</td>
<td>The artifact measured in this widget. You can select any artifact in this field, not only Measurements.</td>
</tr>
<tr>
<td>PA Widget</td>
<td>Select an existing Performance Analytics widget that matches this mock-up widget. For more information, see Performance Analytics widgets.</td>
</tr>
</tbody>
</table>
### Canvas Detail option for Content Block widgets

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content block</td>
<td>Select from an existing content block. For more information, see <a href="#">Content blocks</a>.</td>
</tr>
</tbody>
</table>

### Canvas Detail options for Interactive Filter widgets

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI control type</td>
<td>Choose the UI style for the interactive filter.</td>
</tr>
<tr>
<td>Interactive filter</td>
<td>Select an existing interactive filter. For more information, see <a href="#">Interactive Filters</a>.</td>
</tr>
</tbody>
</table>

### Canvas Detail options for Report widgets

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visualization type</td>
<td>Decide which visualization best illustrates the element.</td>
</tr>
<tr>
<td>Follow interactive filter</td>
<td>Set whether the report can be filtered by an interactive filter on the dashboard. If you select Yes, also include an interactive filter widget.</td>
</tr>
<tr>
<td>Measurements</td>
<td>Select the Measurements artifact that this report shows.</td>
</tr>
<tr>
<td>Report</td>
<td>Select an existing Report. For more information, see <a href="#">Creating reports</a>.</td>
</tr>
</tbody>
</table>

### Canvas Detail options for Spotlight widgets

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurements</td>
<td>Select the Measurements artifact that this report shows.</td>
</tr>
<tr>
<td>Spotlight group</td>
<td>Select an existing Spotlight group. For more information, see <a href="#">Ranking records with Spotlight</a>.</td>
</tr>
</tbody>
</table>

**Results**

You have an artifact from your analysis and a visualization to illustrate that artifact on your dashboard.
Example: Adding a canvas to a dashboard

Note: In this short animation, a canvas is added to the Quality of Service tab of the Customer Experience dashboard. The user first picks an artifact from their KPI Tree and then selects a widget to illustrate that artifact.

What to do next
When you have populated a dashboard, you can change the row order, widget order, or widget title in the artifact banner. The
following short animation demonstrates how to move dashboard components.

Create a dashboard tab template

To reuse a dashboard tab design, create a template from that tab.

**Before you begin**
Create a dashboard with a tab populated with canvases.
Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin. No role required for responsible user or user with edit access from project sharing.

**Prerequisites**
- Add a dashboard
- Add tabs and rows to a dashboard
**Procedure**

1. Open the menu on the dashboard tab and select **Save as Template**.

   ![Dashboard menu]

2. Give the template a meaningful title and description.

3. Select **Save**.

**Results**

You have a personal template that you can use to create new tabs on dashboards. You cannot edit this template.

**What to do next**

For this template to be available to other users, ask a KPI Composer admin to set the **Template global** value to `true` in **KPI Composer > Dashboard tab templates**.

**Defining indicators and reports**

On the KPI Composer Data Definition tab, you further specify the artifacts you defined during analysis and link them to indicator and report definitions.

After you open the Data Definition tab, you see the same KPI tree that you defined in the Analysis tab. The header with personas and breakdown definitions and the footer with new artifacts are gone.

Each artifact that is associated with a Performance Analytics widget on the Dashboard Visualization should reference an indicator definition. Each artifact that is associated with a Reporting widget should reference a report...
definition. An artifact can be associated with both an indicator and a report definition. If a definition is missing, a clickable plus sign + appears with a message to create the definition. If the artifact is linked to any definitions, there is a hyperlink to open each definition. You can quickly get an overview of which artifacts are missing definitions by filtering on Create definition.

The following illustration shows a measurement artifact that needs both a report and an indicator definition. An artifact definition named "% changes closed within SLA" is linked. The artifact still needs a report definition.

Before you create a new definition, see if a suitable definition already exists. Click on an artifact to open its properties. You see a read-only view of the properties you set on the Analysis tab, with one addition: You can link the artifact to an existing indicator and/or report definition. Start typing to populate the list of matching definitions. Linking existing definitions is simpler in the properties dialog than in the indicator or report definition records.

Filtering
The following filter options are available on the Data Definition tab:
• Filter by name, for filtering by one or more words that appear in the artifact name
• Filter by task
• Create definition, for filtering by whether an indicator or report definition is needed
• Link PA Indicator, for filtering by artifacts with indicator definitions that are not linked to Performance Analytics indicators

Indicator definitions

An indicator definition contains the description of how to develop a specific Performance Analytics indicator. The indicator definition itself is not a Performance Analytics indicator. The indicator definition bridges the function-oriented artifact in the KPI tree and the technical implementation of the indicator in Performance Analytics.

If a suitable indicator definition does not exist, click the create indicator definition link in the artifact tile. Specify the required properties of the indicator. Also write any development instructions in the field provided for them. If you are defining an automated indicator, specify the facts table for the indicator source. Also describe any conditions, either on the indicator itself or on the indicator source. You can describe the conditions qualitatively, not following condition builder format. If you are defining a formula indicator, add definitions of its contributing indicators.

When a suitable Performance Analytics indicator exists, you can add a link to it in the indicator definition. You can see the technical details of the linked indicator. Reproduce the Performance Analytics indicator exactly or specify a modified version.
Report definitions

A report definition contains the description to create a report. The key information is the facts table or the report source, along with any conditions. You do not have to follow a technical format when writing the conditions.
Create an indicator definition

You can create a new indicator definition directly from the relevant artifact in the Data Definition tab. Fill the indicator definition with the necessary information for creating a Performance Analytics indicator.

Before you begin

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. You also need technical knowledge of Performance Analytics indicators.

Role required: sn_kpi_composer.admin or admin to link to a Performance Analytics indicator, sn_kpi_composer.user for other functionality. No roles are required for responsible users or users with edit access, except to link to a Performance Analytics indicator.

About this task

You can create an indicator definition for every artifact in your project, whether or not it is associated with a Performance Analytics widget. You cannot add more than one indicator definition for an artifact. However, if you link an artifact to a formula indicator, you automatically link it to all the contributing indicators in the formula.
Procedure

1. Navigate to KPI Composer and open the relevant project.
2. Navigate to the Data Definition tab.
3. Locate an artifact, probably a Measurement, that you want to define an indicator for.
   
   Tip: Before you continue to create an indicator definition, check whether any suitable indicator definitions already exist. Click the artifact to open its properties. Then browse the list of available indicator definitions.

4. Select the plus sign, +.

5. In the PA Indicator field, you can search the existing Performance Analytics indicators on this instance to see if any match this indicator definition. If you select a Performance Analytics indicator, its properties appear read-only in the 'Linked PA indicator details' column. This information is there to help you base the indicator definition on the linked indicator.

   Note: Requires the sn_kpi_composer.admin or admin role. You can only search the indicators by name.

A link icon appears in artifacts next to the name of an indicator definition that is linked to a Performance Analytics indicator.
6. Fill in the **Development instructions** field with any information for your developers that is not in the rest of the form. The information in **Development instructions** is for your internal developers use only. You can also provide details about the indicator in the **Description** field. The information in the **Description** field should be replicated in the **Description** field of the resulting Performance Analytics indicator.

7. Decide on the **Direction** of the indicator.

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td>Select if an increase in this indicator score is desired. For example, consider selecting <strong>Maximize</strong> for an indicator that shows revenue. Analytic tools and graphic elements reflect that an increase in this indicator score is good and a decrease is bad.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting <strong>Minimize</strong> for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td>None</td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

8. Decide whether an Automated, Formula, or Manual indicator best represents the information in the artifact.

<table>
<thead>
<tr>
<th>Indicator Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automated</td>
<td>An automated indicator uses an indicator source as its data set. The indicator source specifies a table, conditions for filtering records from that table, and the frequency at which you expect to display the data. The indicator applies an aggregator and optional conditions to this data.</td>
</tr>
<tr>
<td>Formula</td>
<td>Create a formula indicator to produce a new computed score from</td>
</tr>
</tbody>
</table>
one or more other indicators. Besides indicator scores, the formula can include calculations from the Analytics Hub, such as the gap between an indicator score and the indicator target.

Manual indicators are not associated with an indicator source. Scores for manual indicators are not generated automatically by a data collection job. Instead, populate these indicators by adding scores to the score sheet manually.

Manual indicators are typically used for data that cannot be retrieved from the ServiceNow instance because it comes from an outside system, such as customer data from a third-party sales system.

9. Fill in any remaining fields.

- If you are defining a Manual indicator, you do not have to add any more information.
- If you are defining a Formula indicator, clearly describe to a Performance Analytics administrator how to build the formula. You do not have to use actual formula indicator JavaScript syntax.
- If you are defining an Automated indicator, include the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>The aggregate function to apply to the data from the indicator source.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Expected periodicity for collecting data. Usually the indicator Frequency matches the indicator source Valid for frequency value.</td>
</tr>
<tr>
<td>Facts table</td>
<td>The table that the indicator source references.</td>
</tr>
</tbody>
</table>
10. Either click **Submit**, or, if you want to define supporting indicators, open the context menu and click **Save**.

**Example: Creating an indicator definition**

In the following short animation, the user defines a formula indicator for the measurement "% of major incident first call resolution." The indicator is based on an existing PA indicator that calculates a similar percentage but does not filter on Priority.
Related information

Automated indicators
Indicator sources
Formula indicators
Manual indicators

Add contributing indicators

After you create an indicator definition in KPI Composer, you can add contributing indicators to that definition. Formula indicator definitions, where the formula includes one or more other indicators, require contributing indicators to be complete.

Before you begin

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. This project has at least one indicator definition that requires references to other indicators.

You need technical knowledge of Performance Analytics indicators.

Role required: Same as creating an indicator definition

Procedure

1. In the relevant artifact on the Data Definition tab, click the indicator definition name to open the indicator definition.

2. In the Supporting Indicator Definitions related list, click one of the following buttons:
   - Click New to create a new indicator definition. Follow the same procedure as in Create an indicator definition.
   - Click Edit to open a list of existing indicator definitions in this project. You can select as many indicators as you need. Search the existing indicator definitions before you create new ones, so as not to duplicate indicators.

Results

After saving the changes, the artifact in the Data Definition tab shows the contributing indicator definitions under the main indicator definition, with a darker background.
Example: Adding a contributing indicator

In this example, the contributing indicator Number of resolved incidents is added to the % of major incident first call resolution artifact. This indicator matches an existing indicator definition.

Create a report definition

You can create a new report definition directly from the relevant artifact in the Data Definition tab. Fill the report definition with the necessary information for creating a report.

Before you begin

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. You also need technical knowledge of Reporting.

Role required: sn_kpi_composer.admin or admin to link to an existing report, sn_kpi_composer.user for other functionality. Responsible users and users with edit access also can use any functionality other than linking to an existing report.
Procedure

1. Navigate to KPI Composer and open the relevant project.
2. Navigate to the Data Definition tab.
3. Locate an artifact that has a create report definition link and open that link. Only artifacts associated with Report widgets in the Dashboard Visualization tab have links for creating report definitions.
4. Provide a name and a description for the report. By default, the report definition has the same name as the artifact that contains it. This default name is the same as the default for an indicator definition for that artifact, so consider differentiating them.
5. In the Development instructions field, provide the developer with any technical information they need besides the report properties. The Description field should contain information for the user. The Development instructions field should contain internal information for the developer.
6. Select either a Facts Table or a Report Source.
7. In the Condition field, describe the filtering conditions for the report. You can write the conditions in plain text instead of the condition builder syntax.

Reviewing your project

Summarize both the created KPI Composer project artifacts and the planned Performance Analytics components. Validate the contents of your project. Generate the tasks to build the planned Performance Analytics components.

Navigate to the Review tab at any time for an up-to-date account of completed design work and pending Performance Analytics configurations.

The review tab shows four boxes of information:

**Summary**

Sums up the number of artifacts, personas, and breakdowns defined on the Analysis tab. Click an item type to open a list of those items.

**PA Artifacts**

Shows the number of Indicator Definitions and Breakdown Definitions in the project. Click an artifact type to open a list of those artifacts.

**Project validation**

Click Refresh Data after adding new or editing existing definitions. The following levels of issues are identified:
• Warning: A Critical Success Factor is not linked to an Indicator Definition.

• Error: A Measurement is not linked to an Indicator Definition, or an Indicator or Breakdown definition is not linked to a facts table.

**To Do List**

Shows the tasks that are generated based on the project definitions. For more information, see the "To Do List" section.

**To Do List**
The To Do List shows what Performance Analytics indicators and breakdowns you have to create to produce the dashboard that you designed in this KPI Composer project. Click Rebuild To Do List to generate a new list of tasks. All existing tasks of the project are removed first.

ℹ️ **Note:** The Project validation list includes dashboard design validation messages. However, the To Do List generates only tasks related to creating indicators and breakdowns.

If an indicator definition is already linked to a Performance Analytics indicator, a task to create that indicator is not generated. The same logic applies to breakdown definitions.

Some validation tasks have you check whether Performance Analytics indicators and breakdowns are correctly configured. See the contents of these tasks to get detailed instructions on what to check.

To see a full list of project tasks, navigate to KPI Composer > Project Tasks.

When a task is completed, open the relevant Project Task record and select Implemented.

**Performance Analytics indicators**

Indicators define a performance measurement taken at regular intervals of a business service, an activity, or organizational behavior. These performance measurements result in a series of indicator scores over time.

Key characteristics of indicators include:

• Indicator scores can be generated automatically from a set of records defined in an indicator source, entered manually, or calculated from other indicators.

• Indicator scores can be viewed or analyzed in the Analytics Hub or presented, via widgets, on dashboards.
Indicators that are based directly on indicator sources are the most common type of indicator. These indicators are named automated indicators.

Video showing the difference between automated, manual, and formula indicators, and how to create them

Planning your indicators

Before creating an indicator, clarify what goals you wish to attain with the indicator.

Ask these questions before you create an indicator:

• What
  • What do you want to measure? Are you basing what you want to measure on progress towards a business goal? Consider starting with a business goal and then deciding what to measure. You can use KPI Composer to help you.
  • Do you want a simple count, like the number of open incidents, or something more sophisticated, like the average age to close an incident?
  • Is more better or is less better?
    For example, you would want the number of open incidents to be as low as possible, but the number of sales to go up.
  • What factors contribute the most to this number?
  • What factors would skew this number?
    Seasonality? A shift in staffing numbers or composition?
  • What will you do if the number goes from good to bad?

• Who
  • Who is responsible for this indicator?
    A request fulfiller? A manager?
  • Who should not see this information?

• Why
  • What is the next question you will ask?
    For example, once you know the number of open incidents, you may want to know what percentage of them has been open for more than 30 days
  • Does this number predict what will happen or show what did happen?

• How
Do you measure this today?
If Yes, what do you do with it?
If No, why not?

• When
  ◦ How fast does the data change?
  ◦ What is a meaningful period to look at?
    Are daily changes meaningful or too noisy? How much time does it take to establish a real trend?

• Is there already an indicator that matches my use case, or do I have to build my own?
  ◦ Has the Analytics and Reporting Solution for the subject area been installed? These solutions contain indicators for many common use cases.
  ◦ In the indicator list, is there an indicator that matches, or comes close to matching, your requirements? Can I duplicate an existing indicator and tweak it?
  ◦ Can I create a formula indicator from existing indicators that will meet my requirements?

Related information

Analytics and Reporting Solutions

Workflow for creating indicators

Start with Now Platform tables and work your way up to a completed indicator with score collection that you can share on a dashboard.

Before you begin

Design your KPIs before trying to create them. Using KPI Composer, start by deciding on the business goals you want to achieve with Performance Analytics. For each business goal, determine the critical success factors for that goal. Finally, decide what measurements you need to make to see your progress on those critical success factors. These measurements correspond to the KPIs you need to implement. For more information about designing your Performance Analytics Solution, see Design your Performance Analytics solution with KPI Composer.

Once you have your PA indicators designed, check whether one of the prepackaged Analytics and Reporting Solutions available from ServiceNow meets your needs. Generally speaking, it is a lot easier to customize one of these
prepackaged Solutions than to build one from scratch. For more information, see Analytics and Reporting Solutions.

**About this task**

When you know what KPIs you need, you can begin to create indicators and breakdowns and, if necessary, their data sources. The following workflow applies to automated indicators, which are the implementation of KPIs that collect scores from Now Platform database tables. (Remember that you can combine and apply operations to automated indicators in formula indicators. You can also have manual indicators and external indicators, which do not refer to the Now Platform database at all.)

**Important:** Performance Analytics should be implemented by qualified personnel. Several training courses are available, as described in this Now Community article. This documentation is not meant to substitute for training.

Whereas designing KPIs for Performance Analytics is a top-down process, the technical implementation of indicators is a bottom-up process:

**Procedure**

1. **Identify the table with the data you want to analyze.**
   
   Minimum Role: pa_data_collector
   
   What tables do your KPIs refer to? For example, if your KPI is about incidents, the information is in Incident [incident]. If the KPI is about change requests, the table is Change Request [change_request]. If you use KPI Composer to design your KPIs, you already have this information.

2. **Determine the subsets of records that are relevant to your KPIs.**
   
   Minimum Role: pa_data_collector
   
   Almost certainly you do not have a KPI that refers to all the records of a table. Instead you have KPIs that refer to subsets of the records, such as Number of Open Incidents, Open Incidents That Have Been Reassigned at Least Once, or Incidents That Were Resolved on the Day They Were Opened. For each table, note the conditions that you can use to define relevant subsets of records, such as ‘open,’ ‘reassigned at least once,’ ‘resolved,’ ‘status > resolved on the day it was opened.’
   
   Again, if you use KPI Composer to design your KPIs, you already have this information.

3. **Decide which indicator sources you need, based on the conditions that define the subsets of records that are relevant to your KPIs.**
An indicator source is a data source that refers to a ServiceNow table and one or more conditions that filter the records on that table. You want as few indicator sources as possible. The main reason for this parsimony is efficiency. Data collection involves querying the database for sets of indicators that share an indicator source, not for each indicator. Minimizing the number of indicator sources also helps maintain a single source of truth across indicators. If you need to change a condition, you can change it on the indicator source and propagate this change automatically to all associated indicators.

Look for common conditions that you can apply to multiple indicators when you are designing indicator sources. Consider the following KPIs:

- Number of incidents that are open
- Number of open incidents that have been reassigned at least once
- Incidents that have been open for more than 30 days
- Incidents that are marked 'resolved'
- Incidents that were resolved the day they were opened

You could create two indicator sources that would get scores collected for all these KPIs:

- One on the Incidents table, filtering for incidents that are open
- Another one on the Incidents table, filtering for incidents that have been resolved

4. Search for existing indicators and indicator sources that match your needs.

Minimum Role: pa_data_collector, pa_power_user (indicators only)

Redundant indicators and indicator sources are a common problem. Only when you have verified that no suitable indicators or indicator sources exist, create the indicators and indicator sources.

If you can find indicator sources that meet your needs, see if there are already indicators on those sources that match your designed KPIs.

Note: KPI Composer incorporates a search for suitable existing Performance Analytics indicators into the design process.

5. Create any missing indicator sources that you need.

Minimum role: pa_data_collector
6. Create any missing automated indicators that match the KPIs you need.

   Minimum role: pa_power_user

   After you have the indicator sources, someone with the pa_power_user role, such as a business analyst, can create automated indicators.

   When you create the indicators, add any additional conditions. These conditions apply only to one or two indicators and are not efficient to apply at the level of the indicator source. If you have efficiently divided your conditions between indicator sources and indicators, some indicators on an indicator source will have no additional conditions. These indicators are simply aggregations on a column in the indicator source.

7. Associate and map any relevant breakdowns with the new indicators.

   Minimum role: pa_power_user

   When you designed your indicators, you also should have designed any breakdowns to apply to the indicators. Breakdown design is included in KPI Composer. You may need to create new breakdowns or breakdown sources, but that is outside the scope of this workflow.

8. Collect and manage a matrix of breakdowns.

   Minimum role: pa_power_user

   If you want to collect more than one level of breakdown, such as breaking down by both Priority and Category, set up the breakdown matrix. Be sure to exclude unnecessary or nonsensical breakdown combinations.

9. Edit a job for the indicator.

   Minimum role: pa_data_collector

   Add one scheduled and (usually) one unscheduled data collection job to the indicator. Run an unscheduled job to collect historical data for the indicator, if historical data exists. Usually you only run this job when you create an indicator and never again. Activate the scheduled job to collect periodic data moving forward, usually following the frequency of the indicator. Collect only for one period. For example, when you have an indicator with the Daily frequency, set the scheduled job to collect every day for the previous (last completed) day.

Results

At the end of this workflow, you have an automated indicator that is populated with data. This automated indicator corresponds to a measurement, a critical success factor, or a supporting indicator that you designed in KPI Composer.
What to do next
You can include this indicator in a formula indicator. You can also design widgets to visualize the indicator and create dashboards to share these visualizations with the appropriate stakeholders.

Indicator sources
Indicator sources are data sets consisting of filtered records from one table or database view.

An indicator source configuration specifies a table, such as Incident [incident], conditions for filtering records from that table, and a frequency that you base on the conditions. An indicator source cannot specify a rotated table. Multiple indicators can use the same indicator source. Data collection jobs query the database once for each indicator source. Thus, all indicators that use the same indicator source get data from the same point in time.

Typically, an indicator tracks the situation on a certain date. The indicator source conditions should include a date-related filter, such as [Opened] [on] [Today]. Indicators collected less frequently might specify a larger date range, such as [Closed] [on] [This month].

Create indicator sources carefully. Since multiple indicators may be linked to an indicator source, it is not easy to change the indicator source after you created it. Furthermore, changing an indicator source can cause a disjoint with scores that you have already collected.

Note: Indicator sources must be created before you can create an indicator.

Define an indicator source
To provide a filtered data set of records that you can evaluate with one or more indicators, create an indicator source.

Before you begin
Look at the list of indicator sources, for these reasons:

• An indicator source that meets your requirements may already exist. To help maintain your instance, you should not create duplicate indicator sources.

• Ensure that you give a unique name to any indicator source that you create. Giving the same name to different indicator sources can be confusing.

Role required: pa_data_collector or admin
Procedure

1. Navigate to **Performance Analytics > Indicator Sources** and click **New**.

2. Enter a unique **Name** by which you can easily see what the indicator source is used for, such as **Incidents.Open**.

3. Add a detailed **Description** to help others understand the use and purpose of this indicator source and to help them avoid creating duplicates.

4. In the **Calendars** field, select either the standard calendar or a business calendar that is defined on the instance.

   ▶ **Warning:** If you use a business calendar and later alter that business calendar's entries, you invalidate your Performance Analytics data. The scores you collected before changing the entries will not be compatible with the scores you collect after you change the entries. This warning also applies to fiscal calendar schedules.

   ☑ **Tip:** If you use a business calendar, you can create data collection jobs that run on the Business Calendar: Entry start or Business Calendar: Entry end times.

5. Fill either the **Valid for frequency** or **Calendar Frequency** field.

   • If you select the standard calendar, you have the **Valid for frequency** field. This field gives you a choice of standard indicator frequencies. The default choice is **Daily**.

   • If you select a business calendar, you have the **Calendar Frequency** field. This field is required. The business calendar you selected determines the range of frequencies that are available.

   Indicators based on this indicator source use the value of this field as the indicator **Frequency**. By default, the score collection periods on the indicators follow this frequency. You can override this behavior on the indicator record.

   If you are uncertain about the frequency to set, base the frequency on your business cycle.

6. Select a facts table, either directly or by reusing a report source:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facts table</td>
<td>Specify the facts table and any conditions for filtering the records of that table. You can specify a database view as the facts table. Remote tables are not supported.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Report source</td>
<td>Specify an existing report source to reuse. A report source specifies a facts table and filtering conditions. If the report source changes, a warning appears when you view the indicator source to inform you about the change. To update the indicator source, click the refresh button next to the Report source field.</td>
</tr>
</tbody>
</table>

⚠️ **Warning:** Performance Analytics does not support remote tables.

⚠️ **Warning:** Do not change the facts table for a source after you have started collecting data. If you change the facts table, you lose all historical scores for the associated indicators at the next score collection.

7. If you select a facts table directly, add **Conditions** that must be fulfilled before the data is included in the subset.

**Example**

For example, set the conditions `[Active] [is] [true] OR [Created] [at or before] [date]`.

**Note:**

- Indicator source conditions on text fields are not case-sensitive.
- Conditions set on indicator sources and indicators all apply.
- For an indicator to display real-time scores, set a condition either on the indicator or the indicator source.
Tip:

- Due to the reusability of indicator sources, use only high-level criteria to define indicator source conditions. Use the advanced filters on individual indicators to go deeper into the data.

- Indicator sources should have at least one date condition, such as [Created][on][Today].

- Usually, your date conditions should refer to the same time period as the indicator frequency. For example, conditions about the number of days should only be on daily indicators. Conditions about the number of months should only be on monthly indicators.

- Avoid dot-walking to the sys_id or display value of a table. Instead, use the reference field by itself, to avoid creating unnecessary joins.

- If you design the indicator source conditions well, at least one of the indicators on that source does not have any additional conditions of its own.

For general information about building conditions, see Condition builder.

8. Optional: Define RELATED LIST CONDITIONS to include a relationship with another table in the filter. For more information, see Add related list conditions.

9. To see how many records this indicator source would return, click Preview.

Warning:

You may exceed the maximum limit of collected records despite what the Preview function shows. The Preview function shows you a lower number of records than the number that the data collector actually fetches. The Data Collection job ignores ACLs and business rules when fetching records, but the Preview function follows them. For more information, see KB0756238.

10. In the Records View tab, in List view, select the default view. The default view applies on Workbench widgets and to the lists of records collected for this indicator source on the Analytics Hub and KPI Details. The available views vary depending on the facts table.

11. Optional: In the Records Collection tab, override the maximum number of records that a job can collect for a single indicator source, for this indicator source only. Select Override record collection, then enter a value in Maximum number of records collected. You are overriding the default value set on the property...
com.snc.pa.dc.max_row_count_indicator_source. For more information, see Performance Analytics properties.

12. Expand the context menu and click **Save**.

13. **Optional:** If you have configured this indicator source to use a business calendar, set the number of periods for retaining scores and snapshots and for finding seasonal patterns.
These settings apply to all indicator sources and indicators that use the same calendar frequency. The owner of an indicator can override these settings for that indicator. If you do not set these values in the indicator source, the first time someone creates an indicator using this calendar frequency, they are prompted to set these values.

a. In the Related Links, click **Configure retention periods**.
A PA Business Calendar Retention Period record opens.

b. In the **Number of entries to establish seasonality** field, enter the number of time periods, as defined in business calendar or schedule entries, that are necessary to find seasonal patterns.
   For more information about business calendar entries, see Creating business calendars.

c. Set the number of time periods, as defined in business calendar or schedule entries, to retain scores and snapshots.
   A default value of one is provided, but you should consider changing it.

**Example: Simple indicator source**
The following settings create an indicator source that collects new incidents daily:

- **Name:** Incidents.New
- **Frequency:** Daily
- **Facts table:** Incident [incident]
- **Condition:** [Opened] [on] [Today]
What to do next
After you create an indicator source, you can define text index configurations in a related list on the record. Use these configurations to create Performance Analytics text widgets with word clouds. For more information, see Set up text analytics.

If you are reusing a report source and the report source changes, a warning appears on the indicator source record. To update the indicator source to match the report source, click Update report source. You can also click the refresh button next to the Report source field.

The read-only Report source updated at field displays the last time the report source was updated. This date and time always appear in the GMT time zone.

Related information
- Report sources
- Creating business calendars

Use a database view in an indicator source
You can select a database view as the facts table in an indicator source. Database views enable you to combine data from tables in your ServiceNow instance that are not connected by default.

About this task
By joining tables in a database view, you can easily access them by calling up the view. Then you can select fields from any of the tables included in the view.
For example, if you want to report on the number of SLAs breached, you need fields from both the SLA and the Incident tables.

**Procedure**
If you select a database view as the facts table for an indicator source, provide additional configuration in the **Records view** section of the Indicator Source form.

### Records View section on the indicator source form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Table</td>
<td>A snapshot of records is collected from only one table in the database view. Select which table has its records collected.</td>
</tr>
<tr>
<td>List View</td>
<td>Select the list view used to display collected record sets. <strong>Default view</strong> is suggested, but you can select any defined view, such as <strong>Workspace</strong>.</td>
</tr>
</tbody>
</table>

**Important:** If you change this value, you effectively remove all earlier snapshots. This change takes effect the next time that the data collection job runs. This change does not affect historical scores.
Tip: Try to use a table that generates unique sys_ids as the view table. Otherwise, when you collect second-level breakdowns, the score and the number of records may disagree. If these values disagree, the score is correct. The record count is wrong because it is an artifact of non-unique sys_ids. For more details and an example, see KB0748969.

Related information

Database views

Automated indicators

An automated indicator uses an indicator source as its data set. The indicator source specifies a table, conditions for filtering records from that table, and the frequency at which you expect to display the data. The indicator applies an aggregator and optional conditions to this data.

Automated indicators are the most frequently used type of indicator and are perhaps the most fundamental component of Performance Analytics. Use an automated indicator to calculate scores on a set of records from a table that stores information about a business process, such as change requests or HR cases. You have the score calculated automatically in a scheduled data collection job, which follows the same periodicity as the frequency in the indicator source. You also set one or more data collection jobs that you run manually, for example to collect a span of historical data when you first create the indicator.

You can associate the indicator with any number of breakdowns to slice or filter the indicator scores. For example, if you have an indicator for the number of open incidents, you can associate this indicator with the Priority breakdown to see how many Critical priority incidents you have. You can also associate the indicator with the Category breakdown to compare the number of Hardware and Software incidents.

If you have an indicator source to use and want to create a fairly straightforward automated indicator, you can use the wizard. If you need to specify the indicator more fully, use the form that is described in this section. For more information about creating an indicator from a wizard, see Create an automated indicator with a wizard. Before creating an indicator through either means, plan out your indicator as described in Planning your indicators. Also see whether an appropriate indicator is already available in one of the baseline Performance Analytics Solution content packs.

You can use automated indicators as inputs to a formula indicator, for example to calculate the percentage of open incidents that are new incidents.
Create an automated indicator

To analyze the performance of a business process that is recorded in a ServiceNow table, use an automated indicator. If a suitable indicator is not provided in an Analytics and Reporting Solution, create a new one.

Before you begin

You must have a suitable indicator source, as explained in Automated indicators. You also should design your KPIs as part of a business strategy before you create them, as described in Design your Performance Analytics solution with KPI Composer and Planning your indicators. Also familiarize yourself with the Workflow for creating indicators.

Role required: pa_power_user

About this task

This form provides all the many options for creating an automated indicator. To create a simple automated indicator quickly, see Create an automated indicator with a wizard. However, for deeper information about indicator options and for tips, read this topic first.

Note:

- You must have a subscription for Performance Analytics to create indicators.
- If you are using domain separation, the indicator is created in the domain that you are currently in.

Procedure

1. In the Name field, give the indicator a descriptive name, such as Number of Critical Incidents.

2. In the Calendars field, select either the standard calendar or a business or fiscal calendar group.

3. If you selected a business or fiscal calendar, select the calendar frequency. The choice of calendar frequencies depends on the setting of the business calendar entries or fiscal calendar schedules.

4. Optional: If you selected a standard calendar, you can select the indicator frequency.

If you do not select an indicator frequency, the frequency is set automatically when you select an indicator source. By selecting an indicator frequency manually, you filter the available indicator sources to the ones whose frequency matches the selected value. The indicator frequency field is hidden after you select the indicator source.
5. Scroll to the **Source** tab and select an **Indicator Source**. Typing a partial name in the field filters the list of available indicator sources accordingly. If you are using domain separation, you can select only indicator sources to which you have visibility.

You can only select an indicator source that supports the specified **Calendar frequency** or **Frequency**.

6. In the **Aggregate** field of the **Source** tab, select the aggregate function to apply to the data from the indicator source.

**Count** counts the number of records. **Count distinct** counts the number of unique values rather than the total number of records. For example, if the name of a user appears more than once in a list, the user is only counted once. Other choices perform the specified aggregate operation, such as summing the values in a field across records.

If you select a Sum, Minimum, or Maximum aggregate, consider excluding some types of time series from being applied to the indicator. For more information, see **Exclude time series from an indicator**.

**Tip:** Try to avoid using the Average aggregate, because that aggregate can complicate the use of time series. Instead, create a Sum automated indicator and a Count automated indicator. Then create a formula indicator that divides the Sum indicator by the Count indicator to calculate the average.

7. If you prefer that the score of this indicator increases or decreases over time, select **Maximize** or **Minimize** in the **Direction** field. Analytical tools and graphic displays use this **Direction** with this indicator.

**Tip:** Set a direction whenever you can. All key indicators should be set to **Maximize** or **Minimize**.

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td>Select if an increase in this indicator score is desired. For example, consid-</td>
</tr>
<tr>
<td></td>
<td>er selecting <strong>Maximize</strong> for an indicator that shows revenue. Analytic tools</td>
</tr>
<tr>
<td></td>
<td>and graphic elements reflect that an increase in this indicator score is good</td>
</tr>
<tr>
<td></td>
<td>and a decrease is bad.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Select if a decrease in this indicator score is desired. For example, consid-</td>
</tr>
<tr>
<td></td>
<td>er selecting <strong>Minimize</strong> for an indicator that shows costs. Analytic tools</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Value

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

#### 8. In the **Source** tab, complete any remaining fields.

If the **Aggregate** is set to **Count**, only the **Collect records** and **Value when nil** fields are available.

**Source tab fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect records</td>
<td>Check box to indicate if the individual record sys_ids are stored when the indicator is collected. Selecting this check box enables you to drill down to those details in the Analytics Hub and widgets. When available, collected records appear on the <strong>Records</strong> tab.</td>
</tr>
</tbody>
</table>

Tip: Generally avoid collecting records with aggregates other than Count and Sum. Users rarely want to see the records that go into a Min or Max, and the number of records in a Count Distinct may differ from the score. Consider collecting records for indicators with these other aggregates only if a user asks for them.

This option must be enabled for the main indicator of a Spotlight group. Otherwise, the Spotlight group cannot evaluate a snapshot of collected records. For more information, see **Evaluating a snapshot or platform data**.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scripted</td>
<td>A check box to indicate if the value should be aggregated based on a script. This option is available only if <strong>Aggregate</strong> is not set to <strong>Count</strong>. Clear the <strong>Scripted</strong> check box to aggregate the values in a field.</td>
</tr>
<tr>
<td>Field</td>
<td>The field to perform the aggregate operation on. This field appears only if <strong>Aggregate</strong> is not <strong>Count</strong> and <strong>Scripted</strong> is not selected.</td>
</tr>
<tr>
<td>Script</td>
<td>Select a script or create a new script for the aggregation. This option is available only if the <strong>Scripted</strong> check box is selected. For more information, see <strong>Scripting in Performance Analytics</strong>.</td>
</tr>
<tr>
<td>Value when nil</td>
<td>The value that is inserted as the score when no value is collected. This value applies only to the indicator score. It does not impact scores for breakdown elements.</td>
</tr>
</tbody>
</table>

9. In the **Access control** tab, set whether to publish this indicator to the Analytics Hub, and whether to limit the visibility of the indicator by user, group, or role.

10. Expand the context menu and click **Save**.
11. Perform one of the following procedures:

- If no prompts appear to take further action and the indicator meets your requirements, click **Manage Breakdowns**. Go to **Assign and map breakdowns**.

- If you are prompted to take further action or you have designed a more elaborate indicator, complete the advanced indicator settings.

**Related information**

- Create an indicator group
- Collect and manage a matrix of breakdowns

**Advanced indicator settings**

After you create an automated indicator with the required settings, you can configure optional, advanced settings.

**Before you begin**
You have created and saved an automated indicator.
Role required: pa_power_user
Procedure

1. If you selected a business or fiscal calendar, and this is the first indicator created with this calendar frequency, you are prompted to set the periodicity. These settings apply to all indicators with the same calendar frequency, unless you override the settings in the **Collection periods** tab. For more information, see the section "Indicators with business calendars."

   **a.** In the Related Links section, click **Configure periodicity**. A PA Business Calendar Retention Period record opens.

   **b.** In the **Number of entries to establish seasonality** field, enter the number of time periods, as defined in business calendar or schedule entries, that are necessary to find seasonal patterns. For more information about business calendar entries, see [Creating business calendars](https:// servicenow.com).

   **c.** Set the number of time periods, as defined in business calendar or schedule entries, to retain scores and snapshots. A default value of one is provided, but you should consider changing it.

2. In the **Additional Conditions** tab, add conditions to limit the set of records that the indicator evaluates. The conditions in the indicator apply in addition to the conditions in the indicator source. For real-time scores to be displayed, a condition must be set in the indicator or indicator source. However, the following operators are not supported on indicators. You can use these operators on the indicator source conditions instead:
   - **keywords**
   - **greater than field**
   - **less than field**
   - **greater than or is field**
   - **less than or is field**
Warning: To avoid a data collection job completing with errors, follow these limitations:

- Do not add a condition that references Roles to an indicator. You can reference the Roles table only in an indicator source.

- If you define conditions that refer only to dot-walked fields, you must associate at least one breakdown with the indicator.

In general, try to avoid dot-walking to sys_id or the display value of a table, as doing so creates unnecessary table joins.

Tip: To verify that your conditions are well-designed, list the indicators for an indicator source and include the Conditions field in the view. You should have at least one indicator that only uses the conditions on the indicator source. Otherwise, your indicator source is probably collecting unused data. In this case, consider moving common conditions from the indicators to the indicator source, or splitting the indicator source.

3. Specify any of the optional indicator properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>The unit of measurement for the score, such as number, days, or percentages.</td>
</tr>
<tr>
<td></td>
<td>To collect scores in the system reference currency on a Price, Currency, or FX Currency field, select <strong>Use reference currency</strong>. For more information, see <a href="#">Indicator scores in reference currency</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>If you select % or a time period as the unit, consider excluding some types of time series from being applied to the indicator. For more information, see Exclude time series from an indicator.</td>
</tr>
<tr>
<td>Precision</td>
<td>The number of digits behind the decimal separator. For thousands and millions, the score is given in thousands or millions followed by a k or an M, with the next lowest power of 10 following the decimal. For more information, see Rounding and precision in indicators.</td>
</tr>
<tr>
<td></td>
<td>This field is not available when the unit is Use reference currency. In this case, the precision is inherited from the reference currency.</td>
</tr>
<tr>
<td>Key</td>
<td>Identifies the indicator as a key indicator. Used only to filter the list of indicators in Performance Analytics &gt; Analytics Hub.</td>
</tr>
</tbody>
</table>

4. **Optional:** In the **Other** tab, set various miscellaneous properties.

**'Other' tab fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default time series</td>
<td>A predefined analytical function, like a 7-days running average, to apply to the indicator instead of showing the raw scores of the indicator. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> You cannot set the default time series for an indicator that uses a business or fiscal calendar. These calendars do not support time series aggregations.</td>
<td></td>
</tr>
<tr>
<td>Live group profile</td>
<td>Live Group Profile [live_group_profile] record for a Live Feed group. Specify a group profile to cause that group to get notifications about this indicator. For more information about this social application on the Now Platform, see Live Feed.</td>
</tr>
<tr>
<td>Order</td>
<td>Number indicating the order in which indicators are displayed in the Analytics Hub. Indicators with the lowest value are displayed at the top of the list. If no values are provided in the Order field, indicators are displayed from a to z using the Name field. To use the order field, you must enter order numbers for all indicators. If you put in numbers for only a few indicators, the order in which indicators are displayed reverts to a to z.</td>
</tr>
<tr>
<td>Default chart type</td>
<td>Set a default chart type (line, column, spline, or area) for this indicator. When opening the Analytics Hub for this indicator for the first time, the default chart type is used. If the chart type is changed in the Analytics Hub, that preference is remembered.</td>
</tr>
<tr>
<td>Render continuous lines</td>
<td>When selected, the Analytics Hub shows unbroken data lines for this indicator, even when there is no data for a specific date. This behavior may be useful when displaying data sets</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show real-time score</td>
<td>When selected, the Analytics Hub shows the score of this indicator in real time, as well as the current state of associated records. Clear this check box when indicator data is not available in real time, such as in an integration that uses data from a third-party source. For more information, see <a href="#">Real-time scores</a>. Note: A condition must be set on the indicator or the associated indicator source for real-time scores to be displayed.</td>
</tr>
<tr>
<td>Show delta</td>
<td>When selected, enables reporting of historic records when viewing this indicator in the Analytics Hub. You can filter the data to display only the current data, only the historical data, or the data shared between both sets.</td>
</tr>
</tbody>
</table>
8. **Optional:** In the **Statistics exclusion** tab, select any statistics that you do not want to show on the Analytics Hub.

   **Example**
   For example, you might not want to show the Change % for an indicator with a percentage unit.

9. **Click** Manage Breakdowns.  
   For further instructions, see Assign and map breakdowns.

### Indicators with business calendars

Business and fiscal calendars do not have standard periods. Performance Analytics has introduced several innovations to accommodate these custom periods. Your workflow for creating indicators differs accordingly.

**Important:** The **Create New** indicator creation wizard does not support indicators based on business or fiscal calendars.

### Differences in how periods are defined

Unlike the standard calendar, business calendars have custom periods based on business calendar entries. To accommodate this difference, the following properties are defined differently on indicators that use business or fiscal calendars:

- The indicator frequency is derived from the business calendar instead of from a static list of choices. The Frequency column of the indicator record is ignored. Instead, the Calendar frequency column is used.

- For forecasting, you have to specify the number of periods that are needed to find seasonal patterns. This value cannot be determined automatically from the calendar period, like for standard calendars. You set this value for each calendar frequency, in PA Business Calendar Retention Periods [pa_calendars_retention] records.

- You have to set the number of calendar periods to retain scores and snapshots. The system properties that set the default numbers of calendar periods for retaining data are ignored. Instead, set these numbers for each calendar frequency in PA Business Calendar Retention Periods records.

### PA Business Calendar Retention Periods records and overriding them

When you first create an indicator that uses a particular calendar frequency, you are prompted to complete a PA Business Calendar Retention Periods record. Any indicators you make in the future with that calendar frequency use the same PA Business Calendar Retention Periods record.
You can override the settings in a PA Business Calendar Retention Periods record for a specific indicator. Override the defaults in the **Collection periods** tab of the indicator record, the same as for standard calendar indicators. However, when you first select **Override retention periods**, you see the default retention periods for a Daily indicator with a standard calendar. These values are display artifacts only and you can ignore them. Put in the values you want, and they will override the PA Business Calendar Retention Periods record values.

⚠️ **Note:** You cannot override the **Number of entries to establish seasonality** value from the PA Business Calendar Retention Periods record.

### Business calendar groups

When you select an entry in the **Calendar** field other than the standard calendar, you actually select a business or fiscal calendar group. Both business and fiscal calendar groups are listed under **Business calendar** > **Business Calendar Groups**. Each business or fiscal calendar group contains a set of business calendars, which you select under **Calendar frequency**. Each business calendar in turn contains a set of either business calendar or schedule entries, for business and fiscal calendars, respectively.

The process for generating a fiscal calendar automatically creates a fiscal calendar group. For business calendars, the creator of the business calendar must also create the business calendar group, manually. If you have any questions, contact the admin responsible for creating business calendars. For more information, see [Create a Business Calendar Group](#).

### Automated indicators in formulas

A formula indicator can include automated indicators that use business calendars. The formula indicator must use the same business calendar as at least one of the contributing automated indicators. For more information, see [Create a formula indicator](#).

### Assign and map breakdowns

Select which breakdowns to assign to an indicator. Map which field on the indicator source references the breakdown source. If no appropriate field is available, specify a script to associate the indicator and breakdown sources.

**Before you begin**

The desired breakdowns must be defined with breakdown sources.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin
About this task
You can create multiple mappings for the same breakdown, enabling you to use that breakdown for multiple indicators.

⚠️ Note:

- The maximum number of breakdown elements that can be included in data collection is set in the property `com.snc.pa.dc.max_breakdown_elements_limit`. Warnings appear in the tool when this value is exceeded. For more information, see Performance Analytics properties.
- The procedure on this page uses a graphical tool. You can instead select the breakdowns for the indicator in the Breakdowns related list on the indicator form, as described in Kingston documentation. You also can map the indicator fields or queries for the indicator source on the breakdown form. For more information, see Create a breakdown mapping on a breakdown record.

Procedure

1. Navigate to the indicator that you want to assign a breakdown to.
2. Click Manage Breakdowns.
   For further instructions, see Assign and map breakdowns.
3. Move the breakdown you want to assign to the indicator from **Available Breakdowns** to **Selected**

4. If you are adding an unmapped breakdown, do one of these actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Use a field to map values to elements.** | Select the **Field** in the indicator source that maps to records in the breakdown.  
See the use of the **Category** field in Example: Field mapping. |
| **Use a script to map values to elements.** | Select **Scripted**, then select the **Script** that defines the association between indicator records and breakdown elements.  
Use a script when you do not have the simple use case of a field in the indicator source that maps to a breakdown source table. A script can |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>define a wide range of mapping relationships. The most common use case is when the breakdown source is a bucket group and the script returns an integer to assign an indicator score to a bucket. See <strong>Example: Script mapping</strong>.</td>
</tr>
<tr>
<td></td>
<td>You cannot show real-time scores for an indicator that uses a scripted breakdown.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> Try to implement scripted breakdown mappings so that ([\text{mapping of level 1} &amp;&amp; \text{mapping of level 2}]) is equal to the intersection of ([\text{mapping of level 1}]) and ([\text{mapping of level 2}]). Otherwise, the score and the number of records may not agree for second-level breakdowns. If these values disagree, the score is correct. For more details and an example, see KB0748969.</td>
</tr>
</tbody>
</table>
Note: If you click the Facts table choice list, it opens, but you cannot select a different facts table.

5. Click Submit.
6. Repeat steps 2–5 as needed, to define additional mappings.

What to do next
If you have assigned at least two breakdowns to an automated indicator, you can collect the two-breakdown combinations. If you do so, save system resources by excluding meaningless combinations of breakdowns from being collected. See Collect and manage a matrix of breakdowns.

Collect and manage a matrix of breakdowns
Collect a matrix of the two-breakdown combinations for an indicator. Exclude unnecessary or meaningless combinations of breakdowns from being collected.

Before you begin
Breakdowns must be assigned to the indicator. See Assign and map breakdowns.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin
About this task
Sometimes, not all breakdown combinations give useful information. For example, the combination [Country, Region] gives the same scores as the breakdown Country. You can prevent the instance from collecting data for these invalid combinations with breakdown matrix exclusions. These exclusions are not shown in the Analytics Hub or in the scoresheet and cannot be selected when creating widgets.

To prevent performance issues, the property `com.snc.pa.dc.max_breakdown_elements_level2_limit` limits the number of elements from breakdown connections that are included in data collection. If you exceed this limit, some of the combinations in your matrix are grayed out. By excluding some breakdown combinations, you can help to avoid exceeding this limit. For more information, see Performance Analytics properties.

Note:
• The scores for individual breakdowns are still collected when the combination of those breakdowns has been excluded.
• Scores that were collected in previous jobs for breakdown combinations are not deleted when those combinations are later excluded. New scores for those combinations are not collected.
• These instructions are for using the graphical tool to manage breakdown matrix exclusions. However, you can also manage them in the Breakdown matrix exclusion tab of the indicator form. For more information, see Exclude a breakdown from the breakdown matrix in the Kingston documentation.

Procedure
1. Navigate to Performance Analytics > Automated Indicators.
2. Select the automated indicator for which you want to configure the breakdown matrix.
3. Under Indicator properties, select the Collect breakdown matrix tab.
4. Select the Collect breakdown matrix check box.
5. Click Manage Breakdowns.
6. Click Configure Breakdown Matrix.
   The matrix shows the number of element combinations for each breakdown pair, calculated by multiplying the number of elements for the two breakdowns. Breakdown pairs with a higher number of combinations are shown in a darker color, to help you spot possible performance bottlenecks.
at a glance. By default, all combinations are included in data collection. You can select combinations to exclude from data collection.

7. **Optional:** In the **Breakdown Matrix** pop-up, select breakdown combinations to exclude from Analytics Hub and dashboard widgets. Included combinations are shaded in the breakdown matrix. Excluded combinations are white. If the number of breakdown combinations exceeds the value of `com.snc.pa.dc.max_breakdown_elements_level2_limit`, some combinations are grayed out.

8. **Optional:** On the indicator form, open the **Breakdown matrix exclusion** tab and see which breakdown combinations have been excluded. You can manage which breakdown combinations to exclude in this tab instead of using the graphical tool.

**Add a collection job to an indicator**

To collect scores for an automated indicator, add a collection job to that indicator.

**Before you begin**

ℹ️ **Note:** This procedure shows how to add fully configured data collection jobs to an automated indicator, from the indicator side. For information about configuring data collection jobs and adding them to indicators from the job side, see [Configure a job indicator](#). Only persons with the `pa_data_collector` role, such as Performance Analytics administrators, can configure job indicators.

Role required: `pa_power_user`, or admin
Procedure

1. Open an existing automated indicator.
2. In the Jobs related list, click Edit.
3. Optional: Use Add Filter and Run Filter to limit the selection of jobs.
4. Select one or more jobs in the Collections or Jobs List. Unless you have a clear use case to do otherwise, help keep your jobs manageable by selecting no more than one scheduled job for your indicator. Select as many unscheduled jobs as are relevant. Generally, add one historical job that you run only once on a new indicator.
5. Use the arrow buttons to move the jobs to the other list.
6. Click Save.

Create an automated indicator with a wizard

Quickly create a Performance Analytics automated indicator with breakdowns, widgets, and data collection jobs for that indicator. You still need to be trained in Performance Analytics and to have planned your KPIs to use this wizard.

Before you begin

Familiarize yourself with Performance Analytics concepts and create indicators only as part of an analytics strategy. Plan your KPIs with KPI Composer. Study the Workflow for creating indicators.
Ensure that there is at least one indicator source and a data collection job for the indicator source facts table.

⚠️ Warning: The wizard does not support the creation of indicators with business or fiscal calendars.

Role required: pa_contributor, pa_data_collector, pa_power_user, or pa_admin

About this task

These instructions are for using a wizard to create a simple automated indicator quickly. If you need access to the full range of indicator parameters, see Create an automated indicator.

⚠️ Note: If you are using domain separation, the indicator is created in the domain that you are currently in.

Procedure

1. Navigate to Performance Analytics > Indicators > Create New.
2. Fill in the General tab.
### General tab fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator name</td>
<td>A descriptive name, such as Average number of open incidents.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional text description of the indicator. Can include purpose and internal logic. Descriptions can help you and other users remember the purpose of an indicator.</td>
</tr>
</tbody>
</table>
| Direction           | Select one of the following:  
  • **None**: The indicator has no preferred trend up or down.  
  • **Minimize**: The indicator score should decrease over time.  
  • **Maximize**: The indicator score should increase over time.                                       |
| Unit                | The unit of the score of the indicator. Possible units include:  
  • #: Simple number (default)  
  • $: Dollars  
  • %: Percent                                                                                   |
| Group               | The indicator group to which the indicator belongs, if any.                                                                                   |

3. Click **Next** and fill in the **Data Source** tab.

### Data Source tab fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator Source</td>
<td>A selection of the available indicator sources. An indicator source is a data source that refers to a Now Platform table and one or more conditions that filter the records on that table. After you select the source, you can select <strong>Preview records for this indicator source</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aggregate</td>
<td>The aggregate function to apply when calculating the indicator on the indicator source. <strong>Count</strong> counts the number of records. <strong>Count distinct</strong> counts the number of unique values rather than the total number of records. For example, if the name of a user appears more than once in a list, the user is only counted once. Other choices perform the specified aggregate operation, such as summing the values in a field across records.</td>
</tr>
<tr>
<td>Field/Script</td>
<td>For any aggregate other than Count, you must specify either a field in the table that the indicator source uses, or a script. The aggregate function applies to either the value in the field or the value that the script returns.</td>
</tr>
<tr>
<td>Conditions</td>
<td>An optional list of values and operations to apply to fields in the table that the indicator source uses. These conditions stack with any conditions that are specified in the indicator source. Several limitations exist for conditions on indicators. For more information, see the step for adding additional conditions in Create an automated indicator.</td>
</tr>
</tbody>
</table>

4. In the **Breakdowns** tab, select which of the available breakdowns to apply to this indicator. For two levels of breakdown to apply, also select **Collect breakdown matrix**.

5. In the **Data Collection** tab, select the data collection job that will collect scores for this indicator.
Scores will be collected depending on the schedule of the job. You can also run the job manually.

6. To collect scores from the past and create a trend, select **Collect data from the past** and specify the time period. This job runs only once, when you create the indicator. Not all indicators allow retrospective score collection. As an alternative, manually associate a Historical data collection job with the indicator and run it.

7. In the **Widgets** tab, select any combination of time series, last score, and breakdown widgets to create. You can also put the widgets in the tab of an existing dashboard. For more information about creating and displaying widgets from this wizard, see **Indicator creation widget options**.

8. In the **Summary** tab, review the changes, then click **Apply**. The indicator is created and linked to the selected indicator source, breakdowns, and data collection job. Any widgets associated with the indicator are created and added to the specified dashboard tab.

9. **Optional:** Click **Create another indicator** to restart the process with a new indicator.

**What to do next**

If the data collection job is configured to collect scores from the past, a temporary data collection job with a Run value of **Once** is created. You can delete this job record after the job runs.

**Related information**

- Create an automated indicator
- Indicator sources
- Performance Analytics data collection

**Indicator creation widget options**

There are several options for creating widgets to display the indicator data when creating an indicator and related records. You can create any or all of the available widget types.

**Time series widget options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Time series widget options
### Time series widget options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series widget</td>
<td>Select this check box to create a time series widget to display the indicator data.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Visualization</td>
<td>Select the chart type to use to display the data, such as <strong>Line</strong> or <strong>Column</strong>.</td>
</tr>
</tbody>
</table>

### Latest score widget options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest score widget</td>
<td>Select the check box to create a score widget with a <strong>Visualization</strong> value of <strong>Latest Score</strong> to display the indicator data.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Periods back</td>
<td>Select the number of periods to compare the score with. For example, if the <strong>Time series</strong> is <strong>By week SUM</strong>, enter a <strong>Periods back</strong> value of <strong>4</strong> to compare the current score with scores from the past 4 weeks.</td>
</tr>
</tbody>
</table>

### Breakdown widget options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown widgets</td>
<td>Select this check box to create a breakdown widget with a scorecard visualization for each breakdown applied to this indicator.</td>
</tr>
</tbody>
</table>
Dashboard display options for widgets

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Put the widgets on a new tab on dashboard</td>
<td>Select a dashboard you want to add these widgets to. If you do not select a dashboard, widget records are created but they are not added to any dashboard.</td>
</tr>
<tr>
<td>New tab name</td>
<td>Enter a name for the new tab created to display these widgets. This field is required if you select a dashboard.</td>
</tr>
</tbody>
</table>

Related information

Performance Analytics widgets

Formula indicators

Formula indicators use data from other indicators to calculate new metrics.
Unlike automated indicators, formula indicators are not based on an indicator source that is populated during data collection. The score of a formula indicator is calculated from a mathematical statement that includes data from one or more other indicators. This data can be the score of an indicator or an Analytics Hub calculated value for the indicator. For example, a formula can include the gap, or difference, between the score of an indicator and the target value set on the Analytics Hub.

ℹ️ **Important:** Formula indicator scores are calculated when a user views the indicator on a dashboard or the Analytics Hub.

Create a formula indicator in these cases:

- To calculate a score from multiple indicators, such as the average of two indicators.
- To extract a calculated value of an indicator from the Analytics Hub and perform operations on that value.
- To measure the gap to the overall target of multiple, combined indicators (an index indicator).

💡 **Tip:** Training is available for creating and using formula indicators. See the course Formula Indicators Overview in the NOW Learning Center.

Create a formula indicator

Create a formula indicator to produce a new computed score from one or more other indicators. Besides indicator scores, the formula can include
calculations from the Analytics Hub, such as the gap between an indicator score and the indicator target.

**Before you begin**
Role required: pa_power_user or admin

**About this task**
Formulas are often used to:

- Calculate ratios and percentages.
- Combine data from different applications.
- Build predictive indicators based on historic performance.

The fields of a formula indicator are similar to the fields of an automated indicator. However, instead of Source, Additional Conditions, and Collection properties, a Formula Statement is defined. Formulas can consist of other indicators, constants, variables, and time series, or any combination of these elements.

**Note:**
- You must have a subscription for Performance Analytics to create indicators.
- If you are using domain separation, the indicator is created in the domain that you are currently in.

**Procedure**

1. Navigate to **Performance Analytics > Formula Indicators** and click **New**.
2. In the **Name** field, give the indicator a descriptive name, such as Average duration of open incidents.
3. In the **Calendars** field, select either the standard calendar or a business or fiscal calendar group.
4. If you selected a business or fiscal calendar, select the calendar frequency. The choice of calendar frequencies depends on the setting of the business calendar entries or fiscal calendar schedules.
5. If you prefer that the score of this indicator increases or decreases over time, select **Maximize** or **Minimize** in the **Direction** field. Analytical tools and graphic displays use this **Direction** with this indicator.

**Tip:** Set a direction whenever you can. All key indicators should be set to Maximize or Minimize.
### Value

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td>Select if an increase in this indicator score is desired. For example, consider selecting <strong>Maximize</strong> for an indicator that shows revenue. Analytic tools and graphic elements reflect that an increase in this indicator score is good and a decrease is bad.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting <strong>Minimize</strong> for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td>None</td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

6. Define the Formula for this indicator.

a. (Repeatable) To use an Analytics Hub calculated value in the formula, click **Browse for a method**.
   A dialog opens for you to insert a method from `PAFormulaUtils()` into the formula. This API returns the Analytics Hub calculated value for an indicator. For more information about using this API, see [Get analytics methods in formulas](#).

b. (Repeatable) To put the score of an indicator in the formula, click the **Browse for an indicator** link and fill in the dialog.

### Indicator selection dialog

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator</td>
<td>The indicator you are inserting as a contributing indicator into the formula. If you use a business or fiscal calendar for this indicator, at least one indicator in the formula must</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>use the matching calendar and calendar frequency.</td>
<td></td>
</tr>
<tr>
<td>Breakdown, Element, second-level Breakdown, second-level Element</td>
<td>Up to two levels of breakdown and element for filtering the scores on the indicator. If you specify a breakdown, you must specify an element of that breakdown. These breakdowns and elements apply only to this component indicator and not to the formula indicator as a whole.</td>
</tr>
<tr>
<td>Time series</td>
<td>A predefined analytical function, like a 7-days running average, to apply to the indicator instead of showing the raw scores of the indicator. This time series applies only to this component indicator and not to the formula indicator as a whole.</td>
</tr>
<tr>
<td>Allow breakdowns</td>
<td>Allows breakdowns that apply to the entire formula indicator to apply to this component indicator. Enabled by default. To see which breakdowns apply to the entire formula indicator, click Manage breakdowns at the top of the record.</td>
</tr>
<tr>
<td>Use in method</td>
<td>Returns a unique identifier instead of the score for this indicator. Select this box when you are specifying an indicator for a method in the formula. These methods get calculated values for the indicator from the Analytics Hub. For more information about using these methods, see Get analytics methods in formulas.</td>
</tr>
</tbody>
</table>
You could add indicators manually. However, by using the **Browse for an indicator** function, you ensure that you have the proper notation for indicators and breakdown elements.

After you save the formula indicator, the indicators in the formula appear in the **Contributing indicators** related list. If you included any formula indicators, their contributing indicators are also listed.

c. Add mathematical operators and symbols to the **Formula** as needed.

Enter any operators or numbers to include in the formula. Use valid operator symbols, such as +, -, /, %, >, <. You can also add more indicators to the formula. For example, to calculate the average age of open incidents based on summed age of open incidents and number of open incidents, use the following formula: `[[Summed age of open incidents]] / [[Open incidents]] / 24`

To specify a data collection period in the formula, you can use the variables `score_start` and `score_end` to refer to the start and end of the data collection period, respectively. However, see the caveats in **Changes to score_start/end because of different user time zones**.

**Important:** Try not to use **GlideRecords** or **GlideAggregates** in Performance Analytics scripts or formula indicators. While sometimes you must use these operations to get what you want, they are expensive, potentially running hundreds of thousands of times. Be certain that no alternative exists before you use them.

7. To apply a breakdown to the entire formula indicator, click **Manage breakdowns** at the top of the page.

You can apply any breakdown to a formula indicator, but only breakdowns that are configured for every contributing indicator in the formula give meaningful information. Attempts to view scores for unsupported breakdowns in a widget or on the Analytics Hub result in a warning message instead of a value.

The breakdown can only be used interactively, meaning on the Analytics Hub, KPI Details, appropriately configured breakdown widgets, and breakdown dashboards. For information about using the **Manage breakdowns** tool, see **Assign and map breakdowns**.

8. In the **Access control** tab, set whether to publish this indicator to the Analytics Hub, and whether to limit the visibility of the indicator by user, group, or role.

9. In the **Other** tab, set miscellaneous properties. These properties apply to the entire formula indicator.
### 'Other' tab fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default time series</td>
<td>A predefined analytical function, such as a 7-day running average. Depending on whether <strong>Apply time series to result</strong> is set, this time series can apply either to each component indicator before the result is calculated, or to the result.</td>
</tr>
<tr>
<td>Live group profile</td>
<td>Live Group Profile [live_group_profile] record for a Live Feed group. Specify a group profile to cause that group to get notifications about this indicator. For more information about this social application on the Now Platform, see Live Feed.</td>
</tr>
<tr>
<td>Order</td>
<td>Number indicating the order in which indicators are displayed in the Analytics Hub. Indicators with the lowest value are displayed at the top of the list. If no values are provided in the <strong>Order</strong> field, indicators are displayed from a to z using the <strong>Name</strong> field. To use the order field, you must enter order numbers for all indicators. If you put in numbers for only a few indicators, the order in which indicators are displayed reverts to a to z.</td>
</tr>
<tr>
<td>Render continuous lines</td>
<td>When selected, the Analytics Hub shows unbroken data lines for this indicator, even when there is no data for a specific date. This behavior may be useful when displaying data sets with varied starting dates or data that is not regularly updated, such as stock information.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Continuous lines are not rendered when a time series is set on the indicator or the Analytics Hub.</td>
</tr>
<tr>
<td><strong>Apply time series to result</strong></td>
<td>Applies a time series aggregation to the result of the calculation of the formula instead of to each component indicator before the result is calculated. This option applies to a time series selected for the indicator on a widget or on the Analytics Hub. If a default time series is specified for the indicator, this option also applies to that time series. For more information, see Applying time series to result or to contributing indicators.</td>
</tr>
<tr>
<td><strong>Allow formula component to be NULL</strong></td>
<td>Has the formula calculated even when it contains a null score. Useful for troubleshooting. For more information, see Detect indicators with no scores in a formula.</td>
</tr>
<tr>
<td><strong>Allow aggregation of multiple breakdown element scores</strong></td>
<td>Enables widgets to show an aggregate score of multiple breakdown elements on this indicator. If this field is selected, you can select either aggregated or separated values on the form for a breakdown dashboard that uses this indicator. Formulas based on addition, subtraction, or multiplication are generally good candidates for allowing aggregation. Percentages are also supported. On the other hand, the results of aggregating elements on averages are usually not meaningful. <strong>Warning:</strong> These aggregations are not checked for mathematical validity.</td>
</tr>
</tbody>
</table>
10. Optional: In the **Forecasting** tab, set the forecast method, the number of data collection periods to forecast, the amount of historical data to base the forecast on, and the upper and lower limits of forecast values. For more information, see [Performance Analytics scores forecasts](#).

**Example: Incident Backlog Growth**

As an Incident Manager, you want to improve the efficiency of incident resolution. You already track new and resolved incidents as the Number of new incidents and Number of resolved incidents indicators. However, these indicators do not tell you if you are achieving your goal of improving incident resolution.

You need a new Backlog Growth KPI to measure the volume of outstanding incidents. To implement this KPI, you create a formula indicator named Incident Backlog Growth, with the following formula:

$$[[\text{Number of new incident}]] - [[\text{Number of resolved incidents}]]$$

The following screenshot shows the Incident Backlog Growth indicator in the Analytics Hub, with the Information tab expanded to show the formula.
Get analytics methods in formulas
To insert a calculated value from the Analytics Hub into a formula, use a method in the formula.

Before you begin
Role required: pa_power_user, admin

About this task
You can use a value that was calculated in the Analytics Hub as input for a formula. That value can be from any indicator, including from the current formula indicator itself.
To get a value from the Analytics Hub, insert a method from PAFormulaUtils() into the formula. To call one of these methods, use the Performance Analytics variable pa. For example, to use the PAFormulaUtils.getScore method, call pa.getScore. For more information, see PAFormulaUtils API.

Procedure
1. Open the formula indicator record.
2. Beneath the Formula box, click Browse for a method. A dialog box opens where you can select a method.
3. Browse for the method that matches your needs. Methods refer either to the current formula that you are editing or to a different indicator that you must specify. The list shows a descriptive label for each method instead of the method name.
4. Select a method.
When you select a method, a description opens, including the name of the method and any parameter fields.

Date fields can take the following values:

- An absolute date in YYYY-MM-DD format, such as 2018-12-21.
- The variable `score_start` or `score_end`. These variables represent the first and last second of the collection period being calculated for the referenced indicator. The times are calculated from the difference between the time zone of the user and the database server time zone, which is GMT. For more information, see Changes to score_start/end because of different user time zones.
- A date parameter that you have coded yourself using the GlideDate or the GlideDateTime API.

5. Fill in any parameters and click **Select**.
The dialog closes and the method appears in the formula field of the indicator form.

6. If the method requires you to specify an indicator, select the `indicator` parameter with the cursor and click **Browse for an indicator**. The indicator selection dialog opens.

7. Select the indicator and optionally any breakdowns or elements and a time series aggregation.

8. Select **Use in method** and click **Submit**.

The method is complete, with an indicator selected. Note that a dollar sign, $, precedes the indicator. This dollar sign means that the Analytics Hub values for the indicator instead of the
indicator score are returned. The Analytics Hub values are selected instead of the score when you select the **Use in method** check.

---

**Example: Index indicator**

Index indicators are a use case of formula indicators for generating a single score that represents multiple indicators. In the following example, you want a single index that aggregates the gap between score and global target for the following indicators:

- The percentage of incidents that are overdue.
- The average age of the last update of open incidents.
- The total number of open incidents.

To get this single index, you create a formula indicator with **Direction** set to **Maximize**. All index indicators must maximize. Then you use the **Browse for a method** and **Browse for an indicator** functions to create the following formula:
```javascript
var a = pa.getGap($[$% of open overdue incidents$], score_start) / pa.getGlobalTarget($[$% of open overdue incidents$], score_start);
var b = pa.getGap($[$Average age of last update of open incidents$], score_start) / pa.getGlobalTarget($[$Average age of last update of open incidents$], score_start);
var c = pa.getGap($[$Number of open incidents$], score_start) / pa.getGlobalTarget($[$Number of open incidents$], score_start);
var res = 100 - (100 * (a + b + c) / 3);
res;
```

**Example: Set targets on a change itself**

You want to set a target for your teams of a 10% reduction month-on-month in the incident backlog. You create a formula indicator with the following formula, and set a target of -10% for this indicator on the Analytics Hub.

```javascript
var lastPeriod = new GlideDateTime(score_start.getYear() + '-' + score_start.getMonth() + '-01');
lastPeriod.addDaysUTC(-1);
pa.getChangePercentage($[$Number of open incidents$], lastPeriod.addDaysUTC(-1), score_start);
```

**Example: Filter out scores based on breakdown and element**

You want to filter out the scores of incidents where Priority = 1 - Critical.

1. Obtain the unique record identifiers for the Priority breakdown and the 1 - Critical element. Breakdown records are in the Breakdown table. The location of element records varies, but is identified in the Breakdown Source of the breakdown. In this case, the element is a Choice [sys_choice] record. For directions on how to obtain the unique record identifiers, see [The unique record identifier (sys_id)](#).

   The unique record identifiers are baec0752bf130100b96dac808c0739ed for the Priority breakdown and 8a4dde73c6112278017a6a4baf547aa7 for the 1 - Critical element.

2. Create an indicator with the following formula:

```javascript
var res = $[$Number of open incidents$];
if(pa.getCurrentBreakdownID() == 'baec0752bf130100b96dac808c0739ed' && pa.getCurrentElementID() == '8a4dde73c6112278017a6a4baf547aa7') {
    res = 0;
}
res;
```
PAFormulaUtils API

The PAFormulaUtils API enables you to obtain a value that was calculated in the Analytics Hub and use that value as input for a formula.

To use the PAFormulaUtils API, you must satisfy these requirements:

- Performance Analytics must be enabled.
- The user who creates the formula indicator that uses this API must have the pa_power_user, pa_admin, or admin roles.

A dollar sign, $, precedes indicator names in PAFormulaUtils parameters, like the Number of open incidents indicator in this example: `pa.getGap($[[Number of open incidents]], score_end)`; This dollar sign means that the Analytics Hub calculated values for the indicator are returned instead of the indicator score.

Date parameters in PAFormulaUtils methods take one of the following forms:

- An absolute date in YYYY-MM-DD format, such as 2018-12-21.
- The variable `score_start` or `score_end`. These variables represent the first and last second of the collection period being calculated for the referenced indicator. The times are calculated from the difference between the time zone of the user and the database server time zone, which is GMT. For more information, see Changes to score_start/end because of different user time zones.
- A date parameter that you have coded yourself using the GlideDate or the GlideDateTime API.

**Warning:** The PAFormulaUtils API can be used only in formula indicators, not in scripts.

The PAFormulaUtils API contains the following methods:

**getChange(String indicator, Object fromDate, Object toDate)**

Returns the change in the score of an indicator between two specified dates.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator for which to calculate the change.</td>
</tr>
<tr>
<td>fromDate</td>
<td>Object</td>
<td>Initial date of the comparison.</td>
</tr>
<tr>
<td>toDate</td>
<td>Object</td>
<td>End date of the comparison.</td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Difference in the specified indicator score between the two dates.</td>
</tr>
</tbody>
</table>

Example:

```java
pa.getChange($[['Number of open incidents']], new GlideDateTime(score_start.getYear() + '-' + score_start.getMonth() + '-01'), score_start);
```

Related information

PAFormulaUtils API

getchangePercentage(String indicator, Object fromDate, Object toDate)

Returns the percentage of change in the score of an indicator between two specified dates.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator for which to calculate the percentage of change.</td>
</tr>
<tr>
<td>fromDate</td>
<td>Object</td>
<td>Initial date of the comparison.</td>
</tr>
<tr>
<td>toDate</td>
<td>Object</td>
<td>End date of the comparison</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Percent change of the specified indicator between the two specified dates.</td>
</tr>
</tbody>
</table>

Example:

```java
var lastPeriod = new GlideDateTime(score_start.getYear() + '-' + score_start.getMonth() + '-01');
lastPeriod.addDaysUTC(-1);
pa.getChangePercentage($[['Number of open incidents']], lastPeriod, score_start);
```
**Related information**

**PAFormulaUtils API**

**getCurrentAggregateID()**

Returns the time series aggregate identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic time series aggregate ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no time series aggregate ID, the method does not return a value.</td>
</tr>
</tbody>
</table>

**Example:**

```javascript
var res = [['Number of open incidents']];
if(pa.getCurrentAggregateID() == '89ea4c11d7001100ba986f14ce6103dc')
{
    res = 0;
}
res;
```

**Related information**

**PAFormulaUtils API**

**getCurrentBreakdownID()**

Returns the level 1 breakdown identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

Use this method to obtain the sys_id of the level 1 breakdown when altering the formula for a specific breakdown.
### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic level 1 breakdown ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no level 1 breakdown ID, the method does not return a value.</td>
</tr>
</tbody>
</table>

**Example:**

```javascript
var res = [[Number of open incidents]];  
if(pa.getCurrentBreakdownSysID() == 'baec0752bf130100b96dac808c0739ed' &&  
    pa.getCurrentElementSysID() == '8a4dde73c6112278017a6a4ba547aa7')  
{  
    res = 0;  
}  
res;
```

### Related information

**PAFormulaUtils API**

**getCurrentBreakdownLevel2ID()**

Returns the level 2 breakdown identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

Use this method to obtain the sys_id of the level 2 breakdown when altering the formula for a specific breakdown.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic level 2 breakdown ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no level 2 breakdown ID, the method does not return a value.</td>
</tr>
</tbody>
</table>

Example:

```javascript
var res = 
[[Number of open incidents]];
if(pa.getCurrentBreakdownLevel2ID() == 'baec0752bf130100b96dac808c0739ed' &&
 pa.getCurrentElementLevel2ID() == '8a4dde73c6112278017a6a4baf547aa7')
{
    res = 0;
}
res;
```

Related information

PAFormulaUtils API

currentElementLevel2ID()

Returns the level 1 breakdown element identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

Use this method when altering a formula for a specific element. For example, use the method when running a query to count different attributes, such as excluding scores for changes from groups that do not change.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic level 1 breakdown element ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub).</td>
</tr>
</tbody>
</table>
Related information

P AMariaNow API

currentElementLevel2ID()

Returns the level 2 breakdown element identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

Use this method when altering a formula for a specific element. For example, use the method when running a query to count different attributes, such as excluding scores for changes from groups that do not change.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic level 2 breakdown element ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no level 2 breakdown element ID, the method does not return a value.</td>
</tr>
</tbody>
</table>
Example:

```javascript
var res = [[Number of open incidents]];  
if(pa.getCurrentBreakdownLevel2ID() == 'baec0752bf130100b96dac808c0739ed' &&  
  pa.getCurrentElementLevel2ID() == '8a4dde73c6112278017a6a4baf547aa7')  
  {  
    res = 0;  
  }  
res;
```

Related information

**PAFormulaUtils API**

**getGap(String indicator, Object onDate)**

Returns the global target gap for the specified indicator on the specified date.

The gap is the difference between the score on the specified date and the target. For an indicator with the MAXIMIZE direction, the gap is calculated as the score minus the target. For an indicator with the MINIMIZE direction or no direction, the gap is calculated as the target minus the score.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator for which to provide the gap information.</td>
</tr>
<tr>
<td>onDate</td>
<td>Object</td>
<td>Date of the score to use to compare against the target score.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Difference between the score on the specified date and the global target score.</td>
</tr>
</tbody>
</table>

Example:

```javascript
var a = pa.getGap($[$% of open overdue incidents$], score_start) / pa.getGlobalTarget($[$% of open overdue incidents$], score_start);
var b = pa.getGap($[$Average age of last update of open incidents$], score_start) / pa.getGlobalTarget($[$Average age of last update of open incidents$], score_start);
```
var c = pa.getGap($\{Number of open incidents\}, score_start) / 
  pa.getGlobalTarget($\{Number of open incidents\}, score_start);
var res = 100 - (100 * (a + b + c) / 3);
res;

Related information

PAFormulaUtils API

globalTarget(String indicator, Object onDate)

Returns the global target associated with the specified indicator for the specified date.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator.</td>
</tr>
<tr>
<td>onDate</td>
<td>Object</td>
<td>Date for which to return the global target.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Global target for the specified date and indicator.</td>
</tr>
</tbody>
</table>

Example:

```javascript
pa.getGlobalTarget($\{% of open overdue incidents\},score_start);
```

Related information

PAFormulaUtils API

getPersonalTarget(String indicator, Object onDate)

Returns the personal target associated with the specified indicator for the specified date.

Use this method to obtain a personal index score. "Personal" refers to the active user who is looking at the Analytics Hub.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator.</td>
</tr>
<tr>
<td>onDate</td>
<td>Object</td>
<td>Date for which to return the personal target.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Personal target for the specified date and indicator.</td>
</tr>
</tbody>
</table>

Example:

```javascript
var a = pa.getGap($[% of open overdue incidents]), score_start) / 
    pa.getPersonalTarget($[% of open overdue incidents], score_start);
var b = pa.getGap($[[Average age of last update of open incidents]], score_start) / 
    pa.getPersonalTarget($[[Average age of last update of open incidents]], score_start);
var c = pa.getGap($[[Number of open incidents]], score_start) / 
    pa.getPersonalTarget($[[Number of open incidents]], score_start);
var res = 100 - (100 * (a + b + c) / 3);
res;
```

Related information

PAFormulaUtils API

gscore(String indicator, Object onDate)

Returns the score of the specified indicator for the specified date.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator whose score is to be retrieved.</td>
</tr>
<tr>
<td>onDate</td>
<td>Object</td>
<td>Date for which to return the score.</td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Score for the specified date and indicator.</td>
</tr>
</tbody>
</table>

Example:

```javascript
pa.getScore($([Number of open incidents]), score_end);
```

Related information

PAFormulaUtils API

Prevent a contributing indicator in a formula from following breakdowns

You can select contributing indicators in a formula to not be broken down. When a user applies a breakdown to the formula indicator, the breakdown does not apply to these indicators.

When you apply a breakdown to a formula indicator, such as on a breakdown dashboard, the breakdown applies to all contributing indicators. You prevent a contributing indicator from being broken down using the syntax `{{Indicator}}`. You can also prevent a contributing indicator from following breakdowns by clearing the Allow breakdowns check box in the Browse for an indicator pop-up.

For example, consider the formula `[[Incidents]] / [[Customers]]`. If you apply a region breakdown to this indicator, and specify EU as the breakdown element, the formula indicator returns scores using the formula `[[Incidents > region = eu]] / [[Customers > region = eu]]`. However, to view the EU incidents divided by the total number of incidents across all regions, you can write the formula as `[[Incidents]] / {{Customers}}`. Using the `{{Indicator}}` format causes the Customers indicator to ignore breakdowns. This way, when you apply the region breakdown with the EU breakdown element, this formula indicator is equivalent to the formula `[[Incidents > region = eu]] / [[Customers]]`.

You can specify a breakdown element for a contributing indicator, such as `[[Incidents]] / {{Customers > importance = high}}`. In this example, the formula denominator is always broken down to include only the high-importance customers. Any breakdown applied to the formula indicator, such as the region breakdown, does not apply to the Customers indicator.

Breakdown matrices in formula indicators

Formula indicators inherit breakdown matrices from indicators in the formula.

If all the indicators in the formula collect breakdown matrices, second-level breakdowns are available for the formula indicator. If none of the indicators in
the formula collects breakdown matrices, second-level breakdowns are not available for the formula indicator. If only some of the indicators in the formula collect breakdown matrices, only those indicators can be broken down at a second level.

**Example: Formula with two contributing indicators where breakdown matrices are calculated for one or both indicators**

Consider the case when breakdown matrices are collected for the indicators 'Summed age of open incidents' and 'Number of open incidents.' You now create an indicator with the following formula:

\[
\text{[[Summed age of open incidents]]/[[Number of open incidents]]}/24
\]

On a particular day, the score for this formula indicator is 170, calculated as follows:

| Summed age of open incidents with Category = Software and Priority = 2: 8,152 hours | Number of open incidents with Category = Software and Priority = 2: 2 |
| Number of open incidents with Category = Software and Priority = 2: 2 |
| Formula: 8152/2/24=170 |

What if the breakdown matrix is calculated only for 'Summed age of open incidents'? In this case, the 'Number of open incidents' is broken down only by Category and not by Priority. The score for the same formula indicator on the same day is 11, calculated as follows:

| Summed age of open incidents with Category = Software and Priority = 2: 8,152 hours |
| Number of open incidents with Category = Software: 31 |
| Formula: 8152/31/24=11 |

**Applying time series to result or to contributing indicators**

For a formula indicator, a time series aggregation can apply either to each indicator in the formula individually or to the formula result.

Decide how time series aggregation apply with the **Apply time series to result** option. You can select or disable this option in the **Other** properties tab of a formula indicator record. This option applies to any time series aggregation you apply to the indicator in the Analytics Hub or in a widget. This option also applies to the default time series if one is set.

ℹ️ **Note:** Although **Apply time series to result** applies both on the Analytics Hub and on widgets, the default time series applies only on the Analytics Hub. If you do not select a time series aggregation on a widget, the default time series does not apply.

When **Apply time series to result** is checked, first the formula is evaluated and then the selected time series is applied to the final result. When **Apply time
series to result is not checked, each contributing indicator is evaluated and the default time series is applied to it. Then the formula is evaluated. The results between the two settings can differ significantly. Neither setting is wrong, but you have to think carefully about what you are measuring before making your choice.

Example: Applying a time series to result compared to applying it to contributing indicators
Consider the formula indicator “% of new P1 incidents”. Every day this indicator calculates the percentage of new incidents that are Priority 1 - Critical:

\[
\left( \frac{\text{Number of new incidents > Priority = 1 - Critical}}{\text{Number of new incidents}} \right) \times 100
\]

You decide that you want the result to display a 7-day running average by default on the Analytics Hub. In the Other tab of the indicator record, you select the 7d running AVG default time series. You apply the time series to the result.

In the resulting calculation, the formula is resolved for each day. Then the average of the result is taken for that day and the previous six days:

\[
\frac{(\text{New P1/All new Day 1} \times 100) + \text{(New P1/All new Day 2} \times 100) + \ldots + \text{(New P1/All new Day 7} \times 100)}{7}
\]

You aren't sure if you want the 7-day average of the final result or the average 7-day average of each indicator. So, you copy the previous formula indicator, with the same time series, but with Apply time series to result unchecked.

Now, the time series is applied to the Number of new incidents > Priority = 1 - Critical and Number of new incidents contributing indicators separately before the formula is resolved:
You plot both formula indicators in a time series widget to see the difference in outcome between the two settings. Because the default time series only applies on the Analytics Hub, you also add the 7d running AVG time series to the widget:

\[
\frac{(\text{New P1}_{\text{Day 1}} + \text{New P1}_{\text{Day 2}} + \ldots + \text{New P1}_{\text{Day 7}})}{(\text{All new}_{\text{Day 1}} + \text{All new}_{\text{Day 2}} + \ldots + \text{All new}_{\text{Day 7}})} \times 100
\]

Related information

Applying time series aggregations

Detect indicators with no scores in a formula

As the formula creator, you can handle contributing indicators that have null scores. First set the formula indicator to calculate the formula even when it contains a null score.

Before you begin

Role required: pa_power_user, admin

About this task

The formulas in formula indicators typically contain one or more other indicators. If one of those indicators has no score, by default the formula is not calculated and the formula indicator returns no score. However, several use cases exist for identifying the indicator that has no score instead of having the formula indicator return null. First enable the formula to be calculated when an indicator in the formula has no score. Then you can assign a value to an indicator with no score.
Procedure

1. Open the formula indicator of interest.
2. Select **Allow formula component to be null**.
3. In the **Formula**, add an `if{} else {}` statement that ascribes a value to an indicator when it has no score.

**Example: Field indicator with Allow formula component to be null**

Consider the following formula indicators for a collection period when there are no closed incidents, so the indicator Number of closed incidents has no score.

Formula 1:

```
[[Number of open incidents]] / [[Number of closed incidents]]
```

Formula 2:

```
[[Formula 1]] + 23
```

Formula 3:

```
if ([[Formula 1]] == null) { 23 } else { 11 }
```

Formula 4:

```
[[Formula 2]] || 64
```

Formula 5:

```
([[[Formula 1]] == null && [[Formula 2]] == null] ? 11 : 18)
```

If **Allow formula component to be null** is not selected for any of the formula indicators, none of them have scores.

If **Allow formula component to be null** is selected for all of the formula indicators, they have the following scores:

- Formula 1 = null
- Formula 2 = 23
- Formula 3 = 23
- Formula 4 = 64
- Formula 5 = 11
Formula 2, Formula 3, Formula 4, and Formula 5 represent four different ways to handle the null score.

**Indexing multiple indicators in a formula**

You can write a formula to measure what the gap is to the overall target of multiple, combined indicators. Such a formula indicator is called an 'index indicator'.

The performance of processes, services, groups, and other business entities are often tracked and monitored using more than one indicator. When viewing and analyzing performance of these processes, business services, or workgroups, the overall picture can be confusing and ambiguous. For example:

- Although the scores for three indicators improved somewhat, the scores for 2 of them are still below target and 1 is above target.
- The score for one indicator remained more or less the same and is still below target.
- The score for one indicator did significantly deteriorate, but is fortunately just above target.

Looking at this information, the answers to the following questions are not clear:

- Is the overall performance of the process/service/group still at or above the desired level?
- Did the overall performance improve?

An index indicator can answer these questions. With an index indicator, the scores of multiple indicators are aggregated into one score. It is a weighted average of several indicators. If the weighted sum of these indicators is improving, the calculated score of the index formula goes up. As with any other indicator, the index indicator shows if the score is good or not and if the score has improved or not.

The principle behind an index indicator is to calculate a score value indexed to 100 for each indicator. When you have these indexed scores, you are mathematically allowed to calculate an overall average of them.

To be included in an index indicator, an indicator must have a direction and a target. The basic formula to calculate the indexed score for an indicator that has a Maximize direction is:

\[
100 + \left( \frac{\text{actual score} - \text{target}}{\text{target}} \times 100 \right)
\]

For indicators that have a Minimize direction, the formula is:

\[
100 - \left( \frac{\text{actual score} - \text{target}}{\text{target}} \times 100 \right)
\]
If you are weighting the indicators evenly, you can index the final aggregation to 100 instead of indexing the individual indicators to 100.

You can use methods of the PAFormulaUtils() API to get the gap between score and target for the indicator from the Analytics Hub. For more information, see Get analytics methods in formulas:

```
pa.getGap(indicator, On date) / pa.getGlobalTarget(indicator, On date)
```

Because of the different operator for the different direction, if the score of an underlying indicator is improving (up or down), the index indicator score is increasing. Therefore, always set the direction of the index indicator to Maximize.

If no target value is set for an indicator, use a norm value instead. Indicators that have a target or norm value equal to 0 cannot be used in the index indicator, because it would require dividing by 0.

Set a target of 100 for each index indicator. This target is the calculated, overall, indexed score if all underlying indicators have an actual score equal to their target or norm value.

An index indicator is measuring what the gap is to the overall target of multiple, combined indicators. It is measuring the 'Percentage of Target Achievement'.

**Example: Index indicator using PAFormulaUtils() methods**

In the following example, you want a single index that aggregates the gap between score and global target for the following indicators:

- The percentage of incidents that are overdue.
- The average age of the last update of open incidents.
- The total number of open incidents.

To get this single index, you follow these steps to produce an index indicator:

1. You navigate to Performance Analytics > Formula Indicators and click New. Index indicators are a use case of formula indicators.
2. You give the indicator a meaningful name, such as Aggregate incident gap.
3. Because you are creating an index indicator, you set the Direction to Maximize.
4. In the Formula field, you use the Browse for a method and Browse for an indicator functions to create the following formula:

```javascript
var a = pa.getGap($[% of open overdue incidents], score_start) / pa.getGlobalTarget($[% of open overdue incidents], score_start);
var b = pa.getGap($[Average age of last update of open incidents], score_start) / pa.getGlobalTarget($[Average age of last update of open incidents], score_start);
```
var c = pa.getGap($[[Number of open incidents]], score_start) / 
   pa.getGlobalTarget($[[Number of open incidents]], score_start);
var res = 100 - (100 * (a + b + c) / 3);
res;

The three indicators are weighted equally, so the aggregation is indexed to 100 instead of the individual indicators.

**Changes to score_start/end because of different user time zones**

For formula indicators, the values of the variables `score_start` and `score_end` are calculated based on the time zone of the user who is executing the formula. If users in different time zones execute the same formula, the values of `score_start` and `score_end` change.

⚠️ **Warning:** The date value of the `score_start` and `score_end` variables can shift when users from different time zones view the same formula.

Formulas can include `score_start` or `score_end` variables as parameters for indicators that the formula references. These variables represent the first and last second of the specific collection period being calculated for the referenced indicator. The values of the `score_start` and `score_end` variables are calculated from the difference between the time zone of the user executing the formula and the time zone of the database server, which is GMT. A user executes a formula whenever they view the formula indicator in a dashboard widget or on the Analytics Hub. As a result, the date value of the start or end of the collection period can shift when different users view the same formula.

**Example: Different values of score_end for different user time zones**

Consider a formula indicator with a daily frequency and the following formula:

```plaintext
pa.getScore($[[Number of open incidents]], score_end);
```

Three different users view a dashboard widget with this formula indicator on 18 October. The database server considers `score_end` for 18 October to be 23:59:59 GMT on 18 October.

- One user is in the Europe/Berlin time zone. Their `score_end` value is "2019-10-18 21:59:59", and the score for the date 18 October is returned.
- One user is in the US/Pacific time zone. Their `score_end` value is "2019-10-19 06:59:59", and the score for the date 19 October is returned.
- One user is in the GMT time zone. Their `score_end` value matches the database server, "2019-10-18 23:59:59", and the score for the date 18 October is returned.

**Related reference**

**Performance Analytics variables**
Manual indicators

Manual indicators do not use scores collected from a database. Manual indicators are typically used for data that cannot be retrieved from the ServiceNow instance because it comes from an outside system, such as customer data from a third-party sales system.

Before you begin
Role required: pa_admin, pa_power_user, or admin

About this task
Manual indicators are not associated with an indicator source. Scores for manual indicators are not generated automatically by a data collection job. Instead, populate these indicators by adding scores to the scoresheet manually.

Note:
- You must have a subscription for Performance Analytics to create indicators.
- If you are using domain separation, the indicator is created in the domain that you are currently in.

Procedure
1. Navigate to Performance Analytics > Indicators > Manual Indicators and click New.
2. In the Name field, give the indicator a descriptive name, such as Number of Critical Incidents.
3. In the Frequency field, select the frequency at which scores are set. The default value is Daily.
   
   Note: The frequency for a manual indicator specifies how to visualize its data. For example, if you set the data points per day or per month in the charts, the setting also affects the scoresheet, so it determines whether you can enter daily or monthly values.

4. If you prefer that the score of this indicator increases or decreases over time, select Maximize or Minimize in the Direction field. Analytical tools and graphic displays use this Direction with this indicator.

   Tip: Set a direction whenever you can. All key indicators should be set to Maximize or Minimize.
<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximize</strong></td>
<td>Select if an increase in this indicator score is desired. For example, consider selecting Maximize for an indicator that shows revenue. Analytic tools and graphic elements reflect that an increase in this indicator score is good and a decrease is bad.</td>
</tr>
<tr>
<td><strong>Minimize</strong></td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting Minimize for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td><strong>None</strong></td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

5. Specify any of the optional indicator properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>The unit of measurement for the score, such as number, days, or percentages. To collect scores in the system reference currency on a Price, Currency, or FX Currency field, select Use reference currency. For more information, see Indicator scores in reference currency. If you select % or a time period as the unit, consider excluding some types of time series from being applied to the indicator. For more information, see Exclude time series from an indicator.</td>
</tr>
<tr>
<td>Precision</td>
<td>The number of digits behind the decimal separator. For thousands</td>
</tr>
</tbody>
</table>
In the **Access control** tab, set whether to publish this indicator to the Analytics Hub, and whether to limit the visibility of the indicator by user, group, or role.

### 7. Optional:
In the **Access Control** tab, set which user is the **Contributor** authorized to populate the indicator scores.
You can select only a user with the pa_admin, pa_power_user or pa_contributor role. If you do not specify a **Contributor**, anyone with one of these roles can edit the indicator scores.

8. In the **Other** tab, set various miscellaneous properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default time series</td>
<td>A predefined analytical function, like a 7-days running average, to apply to the indicator instead of showing the raw scores of the indicator. For more information, see <strong>Applying time series aggregations</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live group profile</td>
<td>Live Group Profile [live_group_profile] record for a Live Feed group. Specify a group profile to cause that group to get notifications about this indicator. For more information about this social application on the Now Platform, see Live Feed.</td>
</tr>
<tr>
<td>Value when nil</td>
<td>The value that is inserted as the score when no value is collected. This value applies only to the indicator score. It does not impact scores for breakdown elements.</td>
</tr>
<tr>
<td>Order</td>
<td>Number indicating the order in which indicators are displayed in the Analytics Hub. Indicators with the lowest value are displayed at the top of the list. If no values are provided in the <strong>Order</strong> field, indicators are displayed from a to z using the <strong>Name</strong> field. To use the order field, you must enter order numbers for all indicators. If you put in numbers for only a few indicators, the order in which indicators are displayed reverts to a to z.</td>
</tr>
<tr>
<td>Render continuous lines</td>
<td>When selected, the Analytics Hub shows unbroken data lines for this indicator, even when there is no data for a specific date. This behavior may be useful when displaying data sets with varied starting dates or data that is not regularly updated, such as stock information. Continuous lines are not rendered when a time series is set on the indicator or the Analytics Hub.</td>
</tr>
</tbody>
</table>
9. **Optional:** In the **Forecasting** tab, set the forecast method, the number of data collection periods to forecast, the amount of historical data to base the forecast on, and the upper and lower limits of forecast values. For more information, see **Performance Analytics scores forecasts**.

**What to do next**
Create manual breakdowns and assign them to this indicator. Then, manually add scores.

**Related information**
- Manual breakdowns
- Add or edit indicator scores manually

**Performance Analytics scores forecasts**
Performance Analytics enables you to forecast future scores based on past behavior. You can forecast scores on Performance Analytics time series widgets and the Analytics Hub. Forecast scores appear as a dotted line.

Forecasting is set up in the **Forecasting** tab of the indicator record. The number of data points included in the forecast depends on the indicator frequency and the number of **Periods to forecast** configured on the indicator. A period is a set number of scores based on the indicator frequency.

**Forecast methods**
Performance Analytics can use the following standard forecast methods.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>Generates a linear regression forecast based on the historical scores, using constant and trend as explanatory variables.</td>
</tr>
<tr>
<td>Drift</td>
<td>The forecasts start as the value of the last score but increase or decrease over time, where the amount of change over time (called the drift) is set as the average change seen in the historical data.</td>
</tr>
<tr>
<td>Naive Seasonal</td>
<td>Generates a seasonal forecast that is a copy of the previous season of data. This method does not consider trend data beyond the previous season, such as increasing scores season over season. A 'season' for this analysis is one period.</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Naive Seasonal Drift</td>
<td>As Naive Seasonal, the forecast starts as a copy of the previous season of data. Additionally, the forecast increases or decreases over time, where the amount of change over time (the drift) is set as the average season over season change in the historical data.</td>
</tr>
<tr>
<td>Seasonal Trend Loess (STL)</td>
<td>Generates a seasonal forecast based on a best-fit function. This method fits a trend, a season, and a random noise process to the data using an exponential weighted moving average approach. The forecast is based on the full data set, with more weight given to more recent observations. A 'season' for this analysis is one period.</td>
</tr>
<tr>
<td>Random Forest (available only for time series)</td>
<td>Creates a combination of decision trees where the predictions produced by these trees are averaged to get a single prediction. The randomness comes from each tree being built from a random subset of the available data and inputs. For more information about the random forest method, see this Medium article.</td>
</tr>
</tbody>
</table>

**Displaying the forecast**

To show the forecast on a time series widget, select **Show forecast** in the **Display Settings** section of the Widget form. You can also show the 95% confidence interval of the forecast, by selecting **Show forecast range**.

To show the forecast on the Analytics Hub, click the chart settings icon (⚙️) and enable the **Forecast** option. Similarly, in KPI Details in a Now® Experience, open **Chart options** and enable **Forecast**.

**Related reference**

- Additional settings for time series widgets
- Exploring indicators with KPI Details

**Related information**

- Create an automated indicator
- Analytics Hub for a specific indicator

**Selecting the forecast method**

If you are a statistics expert, you can select a forecast method manually. By default, the instance chooses the best method for you automatically, based on the fit of the method.
To determine the best fitting forecast method, the instance generates forecasts using each forecast method with your historical data. The instance then compares those forecasts with the latest data based on how far ahead you want to forecast. The instance performs this evaluation each time it displays the forecast. Therefore, collecting additional scores can alter which forecast method is used.

For example, if you configure an indicator with a daily frequency to forecast ahead two periods, the instance applies each forecasting method to your historical data that is older than two weeks. Then the instance compares those forecasts against the latest two weeks of data. The forecast that most closely fits the latest two weeks of data is then recalculated using the entire data set. The instance shows the results of this final calculation in the Analytics Hub.

**Forecasting and targets**

When forecasting is enabled for an indicator and there is a global target defined, the forecast shows when the target will be reached. Additionally, the instance sends a notification 14 days before it expects target to be reached. You can change how many days ahead the notification is sent by setting the `pa.job.forecast.target.days_to_check` property.

This functionality is available only for global targets. Thresholds and personal targets do not interact with forecasts.

**Related information**

- Performance Analytics targets and thresholds

**Forecast periods**

Depending on the frequency of the score, a different period length is selected. Consult the table to find out the length of the period that is used for your series.

<table>
<thead>
<tr>
<th>Score frequency</th>
<th>Number of data points per period</th>
<th>Total period length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>7</td>
<td>1 Week</td>
</tr>
<tr>
<td>Weekly</td>
<td>13</td>
<td>1 Quarter</td>
</tr>
<tr>
<td>Bi-weekly</td>
<td>6</td>
<td>1 Quarter</td>
</tr>
<tr>
<td>Four Weekly</td>
<td>13</td>
<td>1 Year</td>
</tr>
<tr>
<td>Monthly</td>
<td>12</td>
<td>1 Year</td>
</tr>
<tr>
<td>Bi-monthly</td>
<td>6</td>
<td>1 Year</td>
</tr>
</tbody>
</table>
Forecast periods (continued)

<table>
<thead>
<tr>
<th>Score frequency</th>
<th>Number of data points per period</th>
<th>Total period length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quarterly</td>
<td>4</td>
<td>1 Year</td>
</tr>
<tr>
<td>Fiscal Quarterly</td>
<td>4</td>
<td>1 Year</td>
</tr>
<tr>
<td>Half Yearly</td>
<td>2</td>
<td>1 Year</td>
</tr>
<tr>
<td>Yearly</td>
<td>4</td>
<td>4 Years</td>
</tr>
<tr>
<td>Fiscal Yearly</td>
<td>4</td>
<td>4 Years</td>
</tr>
</tbody>
</table>

Forecasting with time series aggregations

If you apply a time series aggregation to an indicator, the forecast period length changes. The change depends on the type of the time series.

Time series aggregation effects on forecast periods

<table>
<thead>
<tr>
<th>Time aggregate</th>
<th>Effect on forecast period</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running</td>
<td>The number of points in the period is equal to the “range” field value.</td>
<td>For a 7-day running sum, the forecast period has 7 data points. For a 28-day running sum, it has 28 data points.</td>
</tr>
<tr>
<td>By period</td>
<td>The selected period is treated as if it were the indicator frequency.</td>
<td>A &quot;By week&quot; time aggregate applied to a daily indicator has 13 data points per forecast period, which is a quarter long. This forecast period is the same as for a weekly indicator with no time aggregate.</td>
</tr>
<tr>
<td>To date</td>
<td>The period length matches the time span of the aggregation. The number of data points per period is a product of this time span and the indicator frequency.</td>
<td>See the rest of this section.</td>
</tr>
</tbody>
</table>

For an indicator with the Daily frequency, you have the following number of data points per period for To date aggregations:
Data points per period for a daily indicator with a time aggregation

<table>
<thead>
<tr>
<th>Week to date</th>
<th>Month to date</th>
<th>Quarter to date</th>
<th>Year to date</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>30</td>
<td>91</td>
<td>365</td>
</tr>
</tbody>
</table>

With one exception, indicators with non-daily frequencies support only year-to-date among to-date time aggregations. Monthly indicators are the exception. They also support quarter-to-date time aggregations. A monthly indicator with a quarter-to-date aggregation has three data points per period. The number of data points per forecast period for different indicator frequencies with year-to-date aggregations follows:

Number of data points per forecast period for year-to-date time series aggregations

<table>
<thead>
<tr>
<th>Indicator frequency</th>
<th>Data points per period, year to date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>365</td>
</tr>
<tr>
<td>Weekly</td>
<td>52</td>
</tr>
<tr>
<td>Four-weekly</td>
<td>13</td>
</tr>
<tr>
<td>Biweekly</td>
<td>26</td>
</tr>
<tr>
<td>Quarterly (fiscal)</td>
<td>4</td>
</tr>
</tbody>
</table>

Related information

Applying time series aggregations

Create an indicator group

For convenience, you can organize related indicators into an indicator group. When you configure some visualizations that show multiple indicators, you can specify an indicator group instead of individual indicators.

Before you begin
Role required: pa_admin, pa_power_user, or admin

About this task
By creating indicator groups, you can organize indicators along whatever themes are most useful to you. The indicators do not have to be of the same type or share an indicator source or data collector job. Indicator groups save you the trouble of specifying multiple individual indicators when you configure the following objects:
• List widgets
• Time series widgets with the relative compare visualization
• Email notifications about indicators
• Security Incident Analytics treemaps

After you create an indicator group, you can add indicators to the group or remove them from the group. This change propagates to all objects that use the indicator group, so you do not need to edit the configurations of the objects.

Procedure
1. Navigate to Performance Analytics > Indicator Groups.
2. Click New.
3. Enter a Label for the indicator group.
4. Open the Additional actions menu (…) and click Save. The Indicators related list appears.
5. Click Edit on the Indicators related list and add indicators to the group.
6. Click Save to finish adding indicators, then Update to exit the Indicator Group record.

Example: Creating and using the 'Open and Resolved Incidents' indicator group
In this example, create an indicator group with all the indicators that refer to either open or resolved incidents. The incidents are all included with the demo data for Performance Analytics. After creating the indicator group, create a list widget that uses the indicator group and add the widget to a dashboard.

1. First, go to Performance Analytics > Indicator Groups and click New. An empty Indicator Group form opens.
2. Give the indicator group the label Open and Resolved Incidents, and save the form from the Additional actions menu.
3. Click **Edit**, which opens the Edit Members dialog. To group all the indicators that involve resolved or open incidents, add all the indicators with 'resolved' or 'open' in their name. Also add the Incident backlog growth indicator.
4. The indicator group is complete. Click **Save** in the Edit Members dialog and then **Update** on the indicator group record.

5. Now create a Performance Analytics List widget and specify the Open and Resolved Incidents indicator group.
6. To share the widget with other users, add it to the Incident Management dashboard.

**Related reference**
- List widgets

**Related information**
- Create a relative compare visualization for a time series widget
- Create an email notification for indicators
- Create or update a treemap category (Security Incident Analytics)
Rounding and precision in indicators

Indicators round fractional results using "Banker's rounding" or mathematical rounding depending on the indicator **Precision**.

**Scores below 10,000**

When an indicator has a **Precision** of 0, the indicator rounds the result to the nearest even, whole number. For example, if an indicator with **Precision** 0 calculates the values $7 + (5 / 2)$, the indicator rounds the result up to 10. However, if the formula calculates $2 + (5 / 2)$, the indicator rounds the result down to 4.

When an indicator has a **Precision** greater than 0, the indicator rounds to the nearest decimal point for the given precision. For example, an indicator with **Precision** 1 rounds a result of 4.45 as 4.5.

**Scores above 10,000**

For indicator scores above 10,000, the score is rounded off and displayed with unit abbreviations as follows:

<table>
<thead>
<tr>
<th>Number</th>
<th>Abbreviation</th>
<th>Example, precision=0</th>
<th>Example, precision=1</th>
</tr>
</thead>
<tbody>
<tr>
<td>10,000-999,999</td>
<td>Nearest thousand, K</td>
<td>13,291 displayed as 13 K</td>
<td>13,291 displayed as 13.3 K</td>
</tr>
<tr>
<td>1,000,000-999,999,999</td>
<td>Nearest million, M</td>
<td>17,824,391 displayed as 18 M</td>
<td>17,824,391 displayed as 17.8 M</td>
</tr>
<tr>
<td>1,000,000,000+</td>
<td>Nearest billion, G</td>
<td>2,378,425,321 displayed as 2 G</td>
<td>2,378,425,321 displayed as 2.4 G</td>
</tr>
</tbody>
</table>

**Note:** Unlike numbers under 10,000, large numbers are not rounded off to the nearest even number when precision=0.

**Exceptions**

Y-axis values plotted on a line or column chart are not rounded. The score and tooltip displayed when you point to a value on the chart are rounded based on the indicator **Precision**.

**Note:** In formula indicators, rounding applies only to the formula result. Values within the formula are not rounded.
Indicator scores in reference currency

You can track the trends for monetary fields of the types Price, Currency, or FX Currency. The scores for an indicator based on any of these fields are collected in the Reference Currency values. To collect these scores, select the unit on the indicator as Use reference currency.

⚠️ Note: A currency administrator must configure FX Currency fields before you use them in indicators.

⚠️ Warning: If the reference currency for a field changes after you have set up the indicator, scores are no longer collected properly.

Sometimes you need to provide your users with monetary KPIs converted to a standard currency. Consider a global project manager or CFO who deals with project costs in many different original currencies. They need to see all these costs converted to the global company currency so they can make decisions based on global trends. To provide such users with the KPIs they need, you can configure Performance Analytics indicators to collect scores denominated in a reference currency.

To collect indicator scores in a reference currency, create an indicator with the following characteristics:

- The indicator is an automated indicator, not a formula or a manual indicator.
- The aggregate is not Count or Count Distinct and the indicator is not Scripted.
- The selected Field to aggregate has the type Price, Currency, or FX Currency.
- The selected Unit for the scores is Use reference currency.

For the full procedure of creating such an indicator, see Create an automated indicator.

⚠️ Note: The Precision field is not available on the indicator form when Use reference currency is selected. Instead, the precision is inherited from the FX Currency configuration.

After the scores have been collected, you can explore them more deeply in the Analytics Hub or share them through a widget. The reference currency precision and symbol are used in all visual elements: the score value, change value, target, threshold, and tooltips.

System Reference Currency reference

As a Performance Analytics expert, you do not set up the reference currency. Someone with a currency administrator role performs this task. However, you
may still want to know how reference currencies work on the Now Platform. A brief summary with links follows.

For a Price or Currency field, the system reference currency is the value of `glide.system.locale` as set in the localization properties. If this property is not set, the system default based on physical location is used. For more information about setting the reference currency for these fields, see Setting up and operating standard currency fields.

⚠️ Note: Performance Analytics indicators do not use session currency values.

For an FX Currency field, the indicator scores are based on this hierarchy of configuration settings:

1. If field-level FX Currency configurations are set, these take precedence. If they are not set...
2. The Global FX Currency configuration is used. If the global configuration is not set...
3. The setting in `glide.system.locale` is used. If no value is set in this property...
4. The system default is used.

For more information about configuring FX Currency fields, see Setting up and operating FX Currency fields.

Create a unit

You can define units in which Performance Analytics indicator scores are shown. Units can be numbers, percentages, currencies, quantities of time, or any other entity you define. The most commonly used units are provided by default.

Before you begin

Roles required: pa_admin or pa_data_collector

⚠️ CAUTION: Do not delete any of the units that are provided by default. For example, if you remove the Use reference currency unit, it is not possible to show indicator scores in a reference currency.

Procedure

1. Navigate to Performance Analytics > System > Units.
2. Click New.
3. Enter the Name of the unit.
Example
For example, Gallon.

4. Specify the way the unit must be formatted.

Example
For example, \{0\}Gal gives you the number of gallons with the abbreviation Gal. For currencies, you can place the symbol for the unit in front of the number, such as \${0}.

5. Click Submit.
Units can be used for automated, manual, and formula indicators.

Exclude time series from an indicator

Some time series aggregations are inappropriate to apply to some indicators. You can exclude time series on automated, formula, and manual indicators. Excluded time series are not selectable from the Analytics Hub, KPI Details, or widgets. Other time series remain selectable.

To exclude a time series from an indicator, select the time series in the Time series exclusions related list on the indicator form.

One use case for excluding time series is the logical relationship between the indicator aggregation and the time series aggregation. For example, you may not want to allow a time series aggregation that takes a SUM or an AVG of an indicator that itself is an average.

Possible time series exclusions based on indicator aggregation

<table>
<thead>
<tr>
<th>Indicator aggregate</th>
<th>Consider excluding time series:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>All SUM, AVG. All partial periods (+).</td>
</tr>
<tr>
<td>Sum</td>
<td>All SUM</td>
</tr>
<tr>
<td>Minimum</td>
<td>All SUM</td>
</tr>
<tr>
<td>Maximum</td>
<td>All SUM</td>
</tr>
</tbody>
</table>

You may also want to exclude time series based on the indicator unit type. For example, if you have an indicator whose score is a percentage value, you may not want to display any SUMs of these percentages. Similarly, time series aggregations for indicators which themselves are measured in days, weeks, months, quarters, or years may not make much sense.

As a final point, consider the subject matter of the indicator. Some time series aggregations may not be appropriate for an indicator for qualitative reasons.
Control access to an indicator

You can control which user roles grant access to specific indicators. Access to an indicator is regulated in the indicator record.

Before you begin
pa_admin or admin

Procedure
1. Navigate to Performance Analytics > Automated Indicators or to Manual Indicators or Formula Indicators if applicable.
2. Select an indicator record.
3. In the Access control section, clear the Visible by all roles check box.
4. Select the Roles that grant access to the indicator.
5. Click Update.

Related information
- Control ability to view breakdown elements
- Share a responsive dashboard
- Control access to a non-responsive dashboard

Create an email notification for indicators

Performance Analytics can automatically generate an email with the score, change %, target, and score-target gap % of one or more indicators.

Before you begin
Enable and configure email notifications before you can use email summaries.

Procedure
1. Navigate to Performance Analytics > Automation > Email Summaries.
2. Click New.
3. Enter a Name and a Description for the email summary.
4. Select the Active check box to run a scheduled job that creates the email summary.
5. Select when the job should run.
   - Daily
   - Weekly
• Monthly
• Periodically
• Once
• On Demand

6. Set the time to run the job by changing the hours, minutes, and seconds (using 24-hour notation).
   By default, the job runs at midnight.

7. Select the indicators to include in the summary, either dynamically or manually.
   
   **Dynamically**
   
   Select the **By Condition** check box. Use the condition builder to define the conditions that determine which indicators the email summary includes. For example, you can select all key indicators by setting the condition to [Key] [is] [true].

   **Manually**
   
   Clear the **By Condition** check box. After you save the Scheduled Email Summary form, select individual indicators to include in the summary in the **Indicators** related list.

8. Right-click the form header and select **Save**. The related lists become available.

9. Select any number of users in the **Users** related list.

10. If you are selecting indicators manually, select them in the **Indicators** related list.

**Results**

The email summary job runs based on the schedule you configured. You can also run the job manually by clicking **Execute Now**.

**Related information**

   **Email and SMS notifications**

**Schedule the export of an indicator to PDF**

Schedule an indicator to automate its distribution.

**Before you begin**

This feature requires the licensed version of **Performance Analytics**.

Role required: pa_power_user, pa_admin, or admin
Procedure

Navigate to **Performance Analytics > Scheduled Indicators** and create a new record.

**Scheduled Indicator fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator</td>
<td>Select the indicator that you want to export.</td>
</tr>
<tr>
<td>Breakdown</td>
<td>Select a breakdown to filter the indicator scores.</td>
</tr>
<tr>
<td>Element</td>
<td>If you selected a breakdown, select a breakdown element to show only scores associated with that element.</td>
</tr>
<tr>
<td>Chart</td>
<td>Select this checkbox to include the scores visualization in the PDF. The visualization is the same as displayed on the indicator Analytics Hub.</td>
</tr>
<tr>
<td>Breakdowns</td>
<td>Select this checkbox to include the scores for each breakdown and breakdown element in a table at the bottom of the PDF. If you have selected a <strong>Breakdown</strong> and <strong>Element</strong>, the breakdowns displayed at the bottom of the PDF are 2nd-level breakdowns.</td>
</tr>
<tr>
<td>Users</td>
<td>Users who should receive the indicator.</td>
</tr>
<tr>
<td></td>
<td>To receive indicators, users must have an Email address defined and have <strong>Notifications</strong> set to <strong>Enable</strong> in their user records.</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups that should receive the indicator.</td>
</tr>
<tr>
<td>Email</td>
<td>Email addresses of users who should receive the indicator but who are not in the system.</td>
</tr>
<tr>
<td>addresses</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Check box that enables (selected) or disables (cleared) scheduling for the indicator.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency for exporting the indicator.</td>
</tr>
<tr>
<td>Time</td>
<td>Time of day to export the indicator.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Check box that displays (selected) or hides (cleared) the <strong>Condition</strong> field, which allows you to specify conditions under which the indicator is exported.</td>
</tr>
<tr>
<td>Condition</td>
<td>User-created script that checks for certain conditions to be true before exporting the indicator. This field is visible only when <strong>Conditional</strong> is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subject</td>
<td>Text that appears in the subject line of the distribution email.</td>
</tr>
<tr>
<td>Introductory message</td>
<td>Additional message that is delivered with the indicator.</td>
</tr>
<tr>
<td>Include with</td>
<td>Additional scheduled indicators to send.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Select the page orientation, Landscape or Portrait.</td>
</tr>
<tr>
<td>Zip output</td>
<td>Select this check box to send the indicator as a zip file.</td>
</tr>
</tbody>
</table>

**Link an automated indicator to a benchmark**

To enable the comparison of indicators to ITSM and ITOM benchmarks, link an automated indicator to the corresponding benchmark KPI. A benchmark KPI can be linked to only one indicator. You can compare the linked indicators in the Analytics Hub.

**Before you begin**

You must opt-in to the ServiceNow® Benchmarks application.

Role required: pa_data_collector, pa_power_user, admin

ℹ️ **Note:** If you have the sn_bm_client.benchmark_admin role, you can link Performance Analytics indicators to benchmark indicators through the Benchmarks Setup interface. For instructions about linking indicators through that interface, see [Link or customize a benchmark KPI](#).

**About this task**

Used together, benchmarking and Performance Analytics enables you to measure your enterprise ITSM and ITOM against industry standards while driving improvements across all important metrics. For more information, see [Benchmarks](#).

**Procedure**

1. In the list of automated indicators or the list of formula indicators, identify which benchmark indicator you want to link to which other indicator. Benchmark indicator names begin with the word **Benchmark**.

2. Verify that the benchmark indicator and the linked indicator are configured compatibly. Specifically, verify that the following properties match in both indicators:
• Indicator source
• Unit
• Formula (for formula indicators)

⚠️ Warning: The indicators in Analytics and Reporting Solutions are not configured the same as the matching benchmark indicators.

3. Open the benchmark indicator record.

4. In the Linked indicator field under Indicator properties, select the automated indicator to link to the benchmark.

⚠️ Note:
• The fully licensed version of Performance Analytics must be activated to see the complete list of Performance Analytics automated and formula indicators.
• To edit the Linked indicator field, you may need to change the scoped application that you are working in, at the top of the record.
• The names of the benchmark indicator and the indicator to link might not match.

Results
After you update the benchmark KPI record, you can compare the benchmark KPI and the automated indicator on the Compare tab of the Analytics Hub for the automated indicator. For more information and an example, see Compare scores.

Performance Analytics breakdowns
Breakdowns enable you to group or filter indicator scores by a qualitative attribute such as Priority, Category, or Assignment Group. You can apply a breakdown on the Analytics Hub, in KPI Details, and on dashboards.

The values for each breakdown are called breakdown elements. For example, the Priority breakdown may have the elements Critical, High, and Low. Breakdowns are categorized as automated, manual, or external, depending on where these elements come from. Automated breakdown elements are specified in breakdown sources. Manual breakdowns have their elements entered manually to define an organization. Lastly, an external breakdown specifies the JDBC data source and SQL statement for retrieving breakdown elements.

For example, you can look at the Number of Open Changes by Assignment Group. Or you can see the Number of New Changes by Priority.
Create a breakdown from a wizard

Create a breakdown, breakdown source, and breakdown mappings, and associate the breakdown with indicators.

**Before you begin**
Role required: pa_power_user, pa_data_collector, or admin

⚠️ Note: Users with only the pa_power_user role cannot create breakdown sources.

**About this task**
Create a simple breakdown based on an existing indicator. To create more advanced breakdowns or breakdown sources, such as to limit data sets with complex filters, create or update breakdown and breakdown source records directly.

**Procedure**

1. Navigate to Performance Analytics > Breakdowns > Create New.

2. Select the **Indicator** that you want to create the breakdown for.
   - The **Table** field is automatically populated based on the indicator source table. You can apply the new breakdown to other indicators with the same source table on the **Link to indicators** tab.

3. Select the **Field** to base the breakdown on.
   - The breakdown uses values from this field as breakdown elements and breaks down collected data based on the value of this field in each record.

4. Click **Next**.
   - The **Define the breakdown** tab displays different data depending on if a breakdown, breakdown source, or breakdown mapping exist for the specified indicator, table, and field.

5. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a breakdown, breakdown source, and mapping</td>
<td>If no breakdown or breakdown source exists for the specified table, enter a name for the new breakdown. A breakdown source and mapping for the selected table and field are created automatically. Click <strong>Show filter to make adjustments</strong> to fil-</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create a mapping using an existing breakdown source</td>
<td>If at least one breakdown source exists for the specified table and there are one or more breakdowns using the source, select the breakdown to create a mapping for.</td>
</tr>
<tr>
<td></td>
<td>If a mapping exists between a breakdown with the selected source and a field on a parent of the indicator table, you can only select an existing breakdown to create the mapping for. If no such mapping exists for a parent table, you can select an existing breakdown or create a new breakdown.</td>
</tr>
<tr>
<td>Review existing records</td>
<td>If a breakdown and breakdown source exist for the specified table, and a breakdown mapping exists for the specified breakdown and field, review the settings. You do not need to make any changes.</td>
</tr>
</tbody>
</table>

6. Click **Next**.

7. On the **Link to indicators** tab, select any additional indicators that you want to apply the breakdown to.
   You can apply the breakdown to other indicators with the same source table as the indicator you selected first. If the breakdown already applies to an indicator, that indicator is not displayed.

8. Click **Next**.

9. On the **Data Collection** tab, select how many days of historical, broken-down scores and snapshots to collect, or clear the **Collect data from the past** to skip historical data collection.

10. Click **Next**.

11. Review the settings and confirm that the correct records will be created, then click **Apply**.
    A check mark appears next to each record after it is created. When all records are created the **Create another breakdown** button appears.
Define a breakdown source

Breakdown sources specify which unique values, called breakdown elements, a breakdown contains.

Before you begin

Roles required: pa_data_collector, pa_admin, or admin. The breakdown source creator needs access to the table and reference column that the indicator source uses.

About this task

A breakdown source is defined as a set of records from a table or database view or as a bucket group. Multiple breakdowns can use the same breakdown source. For example, instead of seeing ALL assignment groups for the Number of Open Changes indicator, you can limit the element list to just those groups that are part of the change process by configuring the Breakdown Source.

Always use a facts table with a field that has a unique value for every record, usually Sys ID. For example, the Incident.Category breakdown source takes its elements from the Choice table. The elements are identified by the Sys ID field. The breakdown source filters the choices to those that are on the Incident table, in English, and not inactive.

Tip: As in this example, if you use Choice [sys_choice] for the facts table, put conditions on the Table, Element, and Language fields. Also filter out Inactive records.
The breakdown source uses the following records from the Choice table:

![Choice table](image)

**Note:** The Choice table includes every possible choice from every table, which is why it has Table and Element columns. Most other facts tables you would use for a breakdown source are simpler.

**Procedure**

1. Navigate to **Performance Analytics > Breakdown Sources** and click **New**.
2. Give the breakdown source a meaningful **Name**.
3. Add a detailed **Description** to help others understand the use and purpose of this breakdown source and to help them avoid creating duplicates.

4. For the **Facts Table**, select the table that the breakdown source gets elements from.
   For example, for the breakdown source to specify user groups as elements, select **Group [sys_user_group]**.

   \[\textbf{Warning:} \] Do not change the facts table for a source after you have started collecting data. If you change the facts table, you lose all historical scores for the associated indicators at the next score collection.

5. In the **Field** table, select a field that contains a unique value for every record. This field is usually **Sys ID**.

6. Set the **Conditions** to filter out unneeded elements.
   If you set Choice [sys_choice] as the facts table, always filter on table, element, and language, and filter out inactive records. For example:

   \[
   \text{[Table] [is] [Incident]} \quad \text{and} \\
   \text{[Element] [is] [Category]} \quad \text{and} \\
   \text{[Language] [is] [en]} \quad \text{and} \\
   \text{[Inactive] [is] [false]} \quad \text{or} \\
   \text{[Inactive] [is] [empty]}
   \]

7. To see how many records match the selected conditions, click **Preview**.

8. **Optional:** Define **RELATED LIST CONDITIONS** to include a relationship with another table in the filter.
   For more information, see Add related list conditions.

   **Example**
   For example, consider a breakdown source for Configuration Item (CI) Managers. The facts table is User [sys_user], but the only condition you can apply from this table is to filter for active users. No field on the table lets you select only users who are CI Managers. You get hundreds of results.
If you add a condition that the Name on the User record must match at least one entry in the Managed by column of the Configuration Item [cmdb_ci] table, the breakdown source only returns the users who are CI Managers.
9. **Optional:** In **Label for unmatched**, write a custom label to use when the value in a mapped field on an indicator source record does not match any elements on the breakdown source. The default label is **Unmatched**.

**Example**
The Incident.Category breakdown source references records on the Choices [sys_choices] table where the value of the Table field is incident and the value of the Element field is category. The Category breakdown includes a mapping from the Incident.Category breakdown source to the Category field on the Incidents [incident] table. If an Incident record has a null value in the Category field, the value when you apply the Category breakdown to this record is **Unmatched**, by default.

10. In the **Security** tab, set whether to exclude or include breakdown source elements by role based on element security lists. For more information, see **Define an elements security list**.
What to do next
Create breakdowns that use this breakdown source. You can open the Breakdowns tab and click New. The Breakdown form opens, as described in Create an automated breakdown. After you create breakdowns that use this source, these breakdowns are listed in the Breakdowns tab.

Bucket groups for breakdown sources
Bucket groups are used to recategorize data so it can be used as a breakdown, for example by grouping a range of values into discrete buckets.

In the data architecture, bucket groups are defined in Bucket Group [pa_bucket_groups] records and buckets in Bucket [pa_buckets] records. Each Bucket [pa_buckets] record contains a Bucket Group field that is a reference to a Bucket Group [pa_bucket_groups] record.

To work with a bucket group, create a breakdown source that uses Bucket [pa_buckets] as the facts table and specifies the bucket group in a condition. If a breakdown built on this source uses a breakdown mapping with a script, the breakdown groups the values that the script returns into buckets. If the breakdown mapping specifies a field instead of using a script, the breakdown groups the values of the mapped field into buckets.

Related information
- Create a breakdown mapping on a breakdown record

Grouping field values into buckets
You can use a bucket group with a breakdown mapping that does not use a script, to group the values of any mapped field to buckets.

The use case can be as simple as translating the true and false values of a boolean into two buckets with meaningful labels.

Example: Sorting boolean values into buckets
A base Performance Analytics installation includes the Active breakdown as part of the Analytics Usage Overview. This breakdown uses a mapping to the job.active boolean field from the Job Log [pa_jobs_logs] table. The breakdown source uses a bucket group where true values for job.active are sorted into the Active bucket, while false values are sorted into the Inactive bucket. Note that false values are numerically considered to be a value less than one, while true values are numerically one and above.
Grouping script results into buckets

When you have a breakdown mapping script that collects a range of values, you can define a bucket group to divide those values into discrete buckets.

After you create the bucket group, you create a breakdown source based on the bucket group. Then you create a breakdown that uses that breakdown source. When you create the breakdown mapping for the breakdown, define or select a script for the mapping. The breakdown groups the results that the script returns into the buckets of the bucket group. For an example, see Example: Script mapping.

You can write a bucket group for an existing script, or you can first write the bucket group and then write the script. Both must exist before you can create the breakdown.
Note: The same script can be used with any number of bucket groups. Also, in principle any scripts that returned the same kind of data could be used with the same bucket group.

Create a bucket group
Specify a group of buckets into which you want to recategorize data.

Before you begin
Role required: pa_data_collector or admin

Procedure
1. Navigate to Breakdowns > Bucket Groups.
2. Click New.
3. Enter a Name that clearly identifies the bucket group, like Age Ranges in Days.
4. Double-click Insert a new row to add a new bucket.
5. Enter a Name for the first bucket, then press Enter or click the green check icon.
6. Double-click in the Start and End columns to enter the starting and ending values for the range. Records that match the end value are excluded from the bucket. Therefore, set the end value of one bucket and the start value of the next bucket to be the same. Records that exactly match that value are sorted into the bucket that has that value as the start value.

⚠️ Warning: If the end value of one bucket does not match the start value of the next bucket, you have a 'hole' where records are not sorted into any bucket. For example, if you have a bucket that ends at 20 and the next bucket starts at 21, records for which the script returns a value between 20.0000~ and 20.9999~ do not get sorted into any buckets.

7. Click Submit after all the bucket ranges have been defined.

Example: Incident Age Ranges bucket group
Consider the case where you want to group incidents by age, as follows:

- Less than a day
- 1–5 days
- 6–30 days
- 30–90 days
- More than 90 days
In **Performance Analytics > Scripts**, you already have a script named Incident.Age.Days. This script derives the age in days of an incident from its opening date and the latest date on which a score was collected:

```javascript
var diff = function(x, y) { return y.dateNumericValue() - x.dateNumericValue(); };
var days = function(x, y) { return diff(x, y) / (24 * 60 * 60 * 1000); };
days(current.opened_at, score_end);
```
You create a new bucket group named Incident Age Ranges (Days). In this bucket group, you define a set of buckets that start at the desired date and end at the beginning of the next bucket. For example, the 06–30 Days bucket starts at 6 and ends at 31:

This bucket will contain incidents from the age of precisely 6 days to the age of 30 days, 23 hours, 59 minutes, and 59 seconds.

At the end, you have a bucket group with five buckets corresponding to the age ranges in which you want to divide incidents.
The Script Mapping example shows a breakdown that uses this bucket group and script.

**What to do next**
Create a breakdown source that uses the Bucket [pa_buckets] facts table, the Sys ID field, and the condition [Bucket group][Is][<the name of the bucket group you created>]. Then create a breakdown that uses this breakdown source and uses the relevant script for the breakdown mapping.

**Related information**
- Example: Script mapping
- Scripting in Performance Analytics

**Automated breakdowns**
An automated breakdown uses a breakdown source to determine selectable elements.

Automated breakdowns are based on a breakdown source, which is a set of records from a table. The breakdown maps these records, known as breakdown elements, with fields on tables that indicators collect scores from. Scores collected from mapped tables can then be grouped and filtered based on the values in the mapped fields and the breakdown elements.

For example, the Groups breakdown source that includes records from the Groups [sys_user_groups] table is available by default. This breakdown source specifies the filter [Active][is][true] to include only active groups as elements. You can map this breakdown source to fields on other tables that reference the Groups table, such as the Incident Assignment group field. Scores collected from the mapped table are grouped based on the value of that field. You can then filter the scores on the Analytics Hub and dashboards by selecting the breakdown and an element, such as to show scores only for incidents assigned to the Hardware group.

**Create an automated breakdown**
To create an automated breakdown, select a breakdown source for it to use and apply access restrictions. Then map which field on the indicator source references the breakdown source. Finally, assign indicators to the breakdown.

**Before you begin**
Familiarize yourself with the definitions and uses of breakdowns in general and automated breakdowns in particular.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin
About this task
An automated breakdown uses a breakdown source to determine selectable elements. You can use an existing breakdown source or you can define a new one.

ℹ️ Note: This process allows you to create a fully customized breakdown. To create a simple automated breakdown, see Create a breakdown from a wizard.

Procedure
1. Navigate to Performance Analytics > Automated Breakdowns and click New.
2. Specify a meaningful Name.
   The name of a breakdown is frequently based on the label of the field that is used in the breakdown mappings.
3. In the Automated tab, select the Breakdown source.
4. Optional: Select a Default elements filter.
   Use element filters to restrict the elements that are visible to a user. For more information, see Element filters.
5. Optional: In the Access control tab, set who can see the breakdown.
   These restrictions apply in all cases: seeing the breakdown in the list of breakdowns, seeing the breakdown in an Analytics Hub or dashboard, or using the breakdown when creating a widget.

<table>
<thead>
<tr>
<th>Value of Visible to</th>
<th>Further settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone (default)</td>
<td>You can restrict visibility by roles. Un-select Visible by all roles and select the Roles that are required to access the breakdown.</td>
</tr>
<tr>
<td>Groups and Users</td>
<td>Select the Groups and individual Users who can access this breakdown. You can select groups or users from a list, and you can select users by email address.</td>
</tr>
</tbody>
</table>

What to do next
Create breakdown mappings and associate indicators with the breakdown. You can do this from the indicator, using a graphical tool (see Assign and map breakdowns)
Create a breakdown mapping on a breakdown record

Specify which field on the indicator source references the breakdown source. If no appropriate field is available, specify a script to query the indicator source.

Before you begin

Assign a breakdown source to the breakdown before creating the mapping. The required roles are the same as for creating a breakdown.

About this task

You can create multiple mappings for the same breakdown, enabling you to use that breakdown for multiple indicators.

⚠️ Note: The procedure on this page uses a related list on the breakdown form. You can instead use a graphical tool that you access from the indicator form. See Assign and map breakdowns.

Procedure

1. If you are adding a mapping to an existing breakdown, find that breakdown in the relevant list of breakdowns and open it.

2. In the Breakdown Mapping related list, click New.

3. Select the Facts table. This table is the indicator source that you want to break down.

4. Do one of these actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use a field to map values to elements.</td>
<td>Select the Field in the indicator source that maps to records in the breakdown. See the use of the Category field in Example: Field mapping.</td>
</tr>
<tr>
<td>Use a script to map values to elements.</td>
<td>Select Scripted, then select the Script that defines the association between indicator records and breakdown elements. Use a script when you do not have the simple use case of a field in the indicator source that maps to a breakdown source table. A script can define a wide range of mapping relationships. The most common use case is when the breakdown source...</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>is a bucket group and the script returns an integer to assign an indicator score to a bucket. See <strong>Example: Script mapping</strong>. You cannot show real-time scores for an indicator that uses a scripted breakdown.</td>
</tr>
</tbody>
</table>

**Tip:** Try to implement scripted breakdown mappings so that `[mapping of level 1 && mapping of level 2]` is equal to the intersection of `[mapping of level 1]` and `[mapping of level 2]`. Otherwise, the score and the number of records may not agree for second-level breakdowns. If these values disagree, the score is correct. For more details and an example, see KB0748969.

5. Click **Submit**.
6. Repeat steps 2–5 as needed, to define additional mappings.

**Example: Field mapping**

The Category breakdown maps the **Category** field on the incident table to the Incident.Category breakdown source, which references the Choices[sys_choice_list] table.

**Example:**

In the first image, you see the Category breakdown with the Incident.Category breakdown source. This breakdown has a breakdown mapping to the **Category** field on the incident table.
The Incident.Category breakdown source uses records in the Choices[sys_choice_list] table.
The next image shows the Choices[sys_choice_list] table records that meet the conditions that are specified in the Incident.Category breakdown source. Note the Label field values.

Finally, you see the Category field of some records on the Incidents table. This field is mapped to the Category breakdown. The field values match the Label fields of the records of the Choices[sys_choice_list] table that the Incident.Category breakdown source filters for.
Example: Script mapping

The Age breakdown uses the Incident.Age.Days script to calculate the age of incidents in days and map the values to the Incident Age Ranges bucket group.

Example:
In the first two images, you see the Age breakdown, which uses the Incident.Age.Days breakdown source and the Incident.Age.Days script for breakdown mapping. You also see that the breakdown source refers to the Incident Age Range (Days) bucket group.
**Breakdown - Age [Automated view]**

<table>
<thead>
<tr>
<th>Field</th>
<th>Script</th>
<th>Missing?</th>
</tr>
</thead>
<tbody>
<tr>
<td>incident</td>
<td>incident.Age.Days</td>
<td>true</td>
</tr>
<tr>
<td>incident sla</td>
<td>incident.SLA.Age.Days</td>
<td>true</td>
</tr>
</tbody>
</table>

**Access control**

Specify access control for this breakdown.

- Visible to: Everyone
- Visible by all roles: ✔️

**Breakdown Mappings**

- **Facts table**: incident
- **Field**: incident.Age.Days
- **Script**: incident.Age.Days
- **Scripted**: true
The Incident.Age.Days script takes the time stamp when the incident was opened from the incident table and subtracts this from the time stamp at the end of the collection period. The script converts this value from milliseconds to days.

```
var diff = function(x, y){return y.dateNumericValue() - x.dateNumericValue();};
var days = function(x, y){return diff(x, y)/(24*60*60*1000);};
days(current.opened_at, score_end);
```

The resulting numbers of days are sorted into the buckets of the bucket group.
Here is the result of running this script on the Number of open incidents indicator.

<table>
<thead>
<tr>
<th>Bucket group</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Age Ranges (Days)</td>
<td>00 - 01 Day</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>01 - 05 Days</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>06 - 30 Days</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>31 - 90 Days</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>90+ Days</td>
<td>91</td>
</tr>
</tbody>
</table>
Number of open incidents
August 3 ▶️ ▶️ ▶️

318 ▲ 273 (606.7%)

Search breakdowns and elements

<table>
<thead>
<tr>
<th>Priority</th>
<th>Category</th>
<th>Assignment Group</th>
<th>State</th>
<th>Age</th>
<th>Element</th>
<th>Score</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>90+ Days</td>
<td>250</td>
<td>243</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>31 - 90 Days</td>
<td>32</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>06 - 30 Days</td>
<td>29</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01 - 05 Days</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>00 - 01 Day</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

Related information
Scripting in Performance Analytics
Assign an indicator to an automated breakdown

Associate automated or formula indicators with a breakdown to enable the collection of broken down scores for those indicators.

Before you begin
The breakdown must have a breakdown mapping for the indicator source table.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin

Procedure
1. Navigate to Performance Analytics > Automated Breakdowns.
2. Select a breakdown record.
3. In the Indicators related list, click Edit.
4. Use the slushbucket to select the indicators you want to assign to this breakdown.
5. Click Save.
6. Optional: In the Indicator Breakdowns related list, set the Display value to false to hide the breakdown on the Analytics Hub and dashboard widgets. If the Display field is false, broken-down scores are still populated during data collection, but the breakdown is not selectable on the Analytics Hub or on dashboard widgets.

What to do next
Run a data collection job on the indicator to collect scores for the new breakdown.

Important: If you add a breakdown to an existing indicator for which you already have scores, be careful to collect scores for the new breakdown without overwriting any collected scores.

For this purpose, create a special one-off collection job. Set the job to collect data for as far back as you need. Select only the indicator or indicators to which you have added this breakdown. Configure the resulting job indicators to exclude all other breakdowns. Clear the Collect indicator option on the job indicators. Then run the job.

If your role does not allow you to create collection jobs, contact your Performance Analytics admin.

For more information, see Create or schedule a data collection job and Configure a job indicator.
Manual breakdowns

In a manual breakdown, you define the breakdown elements and the indicator scores for each element manually instead of using records from a breakdown source.

Unlike an automated breakdown, a manual breakdown does not map to any fields on the indicator source table. Instead, users must populate the broken-down scores manually.

Create a manual breakdown

Create a breakdown for an indicator where you add scores manually.

Before you begin

Roles required: pa_data_collector, pa_power_user, pa_admin, or admin

Procedure

2. Click New.
   - The Type is set to Manual automatically.
3. Enter a descriptive Name.
4. Right-click the form header and select Save.
5. In the Manual section, double-click Insert a new row to add a new breakdown element.
6. Press Enter or click the green check mark to save the entry.
7. Optional: Change the Order value.
   - Elements with a lower Order value appear higher in the list of elements, such as on the Analytics Hub and dashboards.
8. Repeat steps 5-7 to add additional breakdown elements.
9. Click Submit.

What to do next

Associate manual indicators with this breakdown and populate scores using the scoresheet.

Assign a manual indicator to a manual breakdown

Associate a manual indicator with a manual breakdown to enable users to enter broken-down scores for the indicator.
Before you begin
Role required: pa_data_collector, pa_power_user, pa_admin, or admin

About this task

Note: You can break down manual indicator scores by only one breakdown at a time. You cannot apply a 2nd-level breakdown to a manual indicator.

Procedure

2. Select a breakdown record.
3. In the Indicators related list, click Edit.
4. Use the slushbucket to select the indicators you want to assign to this breakdown.
5. Click Save.
6. Optional: In the Indicator Breakdowns related list, set the Display value to false to hide the breakdown on the Analytics Hub and dashboard widgets. If the Display field is false, broken-down scores are still populated during data collection, but the breakdown is not selectable on the Analytics Hub or on dashboard widgets.

What to do next
Populate broken-down scores for the indicators using the scoresheet.

Element filters

Element filters enable you to limit the displayed breakdown elements on an Analytics Hub or widget using filter conditions including personalized visuals.

Elements filters let you apply a conditional filter or related list conditions to a breakdown source. You can apply this filtered set of elements when looking at a breakdown in the Analytics Hub or on a breakdown widget. You can also apply this elements filter instead of a first-level element on time series and score widgets, including to widget indicators on time series widgets.

Tip: Use an elements filter with dynamic conditions to create personalized visuals on a widget. For more information, see Personalized visuals.

Elements filters on visualizations

You can select the element filter on an Analytics Hub Breakdown tab when viewing a breakdown based on the same breakdown source as the element
filter. Similarly, you can select an elements filter in the \Filter pane of KPI Details to refine the list of elements to choose from.

You can specify a **Default element filter** for a breakdown to select that element filter automatically when viewing the breakdown. Users that view the breakdown on an Analytics Hub or in KPI Details can change or clear the selected element filter.

The following widget types support element filters:

- Breakdown
- Score
- Time series

On each of these widgets, specify the **Element filter** in the **Element settings** tab. For time series and score widgets, the element filter replaces the first-level breakdown element. For breakdown widgets, the element filter limits the elements that are shown. Users cannot change or clear the element filter on a widget when viewing the widget.

⚠️ **Note:** It is not possible to change element filters that are used to personalize visuals when viewing the visual on a dashboard or workspace. For more information, see [Personalized visuals](#).

You can also add element filters to widget indicators. Widget indicators are available on time series and list widgets. For more information, see [Add widget indicators](#).

⚠️ **Note:** If you put an elements filter on a widget indicator, the names of all elements that get applied are appended to the name or label of the indicator.

**Related reference**

- [Exploring indicators with KPI Details](#)

**Related information**

- Analytics Hub
- Performance Analytics widgets

**Create an elements filter**

Select the breakdown source and filter conditions to filter breakdown elements from that breakdown source.

**Before you begin**

Role required: pa_data_collector or admin
Procedure

Navigate to **Performance Analytics > Elements Filters** and create a new record (see table for field descriptions).

### Element filter fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown source</td>
<td>Select the breakdown source you want to create an element filter for. The element filter is available for any breakdowns based on this breakdown source.</td>
</tr>
<tr>
<td>Facts table</td>
<td>Read-only. Displays the breakdown source facts table.</td>
</tr>
<tr>
<td>Filter</td>
<td>CONDITIONS: Specify the filter conditions to limit the available elements. Only elements that meet these conditions are displayed when you apply this element filter.</td>
</tr>
<tr>
<td></td>
<td>For example, if the breakdown source facts table is User [sys_user], you can add a filter condition to include only users in the HR department. This filter condition is [Department][is][HR].</td>
</tr>
<tr>
<td></td>
<td>For <strong>Personalized visuals</strong>, the operator in the filter condition must be [is (dynamic)].</td>
</tr>
<tr>
<td>RELATED LIST CONDITIONS: Include a relationship with another table in the conditions. For example, you could create an element filter on the Groups breakdown source, which uses the Group [sys_user_group] table. If you added a related list condition on Incident [incident]-&gt;Assignment group, you would get only groups that had an incident assigned to them. If this condition included [[Created][on][Last 6 Months]], you would get groups that were assigned</td>
<td></td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
| Title | Assignment Groups with Incidents |
| Breakdown source | Groups |
| Facts table | Group [sys_user_group] |

Roles | Select any roles that a user must have to select this element filter. A user must have at least one of the specified roles. If no roles are specified, all users can access this element filter.

---

**What to do next**

Use an element filter with dynamic conditions to create personalized visuals on a widget. For more information, see [Personalized visuals](#).

All widget indicators that use this elements filter and all diagnostic results that mention this elements filter are listed at the bottom of the elements filter record.

**Navigating breakdown elements with breakdown relations**

Breakdown relations open a new navigation path for viewing breakdown scores, by moving from one breakdown element to another breakdown element. Breakdown relations can be between the elements of different breakdowns, or they can be within a hierarchical structure of elements in the same breakdown. Breakdown relations affect navigation on the Analytics Hub and in breakdown widgets.

You can use breakdown relations to navigate between the elements of a single breakdown that are in a hierarchical relationship. For example, the Location breakdown has a hierarchy of ‘parent’ and ‘child’ elements, where a country can be the parent of cities. Breakdown relations let an Analytics Hub viewer navigate from a country down into a city, from a city to the country, or between cities in the same country.
Navigating on the Analytics Hub between elements of the same breakdown

<table>
<thead>
<tr>
<th>Child Locations - Related Breakdown</th>
<th>Element Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
<td><strong>Score</strong></td>
</tr>
<tr>
<td>Hamburg</td>
<td>4</td>
</tr>
<tr>
<td>Frankfurt</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parent Locations - Related Breakdown</th>
<th>Element Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
<td><strong>Score</strong></td>
</tr>
<tr>
<td>Emea</td>
<td>49</td>
</tr>
</tbody>
</table>

Similarly, a breakdown widget can show the parent, child, or sibling elements of the element that was chosen for the breakdown dashboard. For more information about using breakdown relations on breakdown dashboards, see Showing breakdown relations on dashboards.
Breakdown relations also enable navigation between the elements of different first-level breakdowns. For example, first choose an element of the Assignment Group breakdown, then look at the Members breakdown relation. In this relation, navigate to an element of the Assigned To breakdown. The selected member of Assigned To is not necessarily a member of the Assignment Group. Furthermore, the number of assignments of members of Assigned To is greater than the number of assignments of the selected Assignment Group. You see the total of all assignments, not only the assignments in the originally selected Assignment Group. You are changing which first-level breakdown you are looking at, not drilling down to a second level of breakdown and element. Again, this breakdown relation can be used both on the Analytics Hub and in a breakdown widget on a breakdown dashboard.
Navigating on the Analytics Hub between elements of different breakdowns

More details about these cases for using breakdown relations are in the topics about creating breakdown relations.

Create a breakdown relation between breakdowns

To set up navigation in a visualization between the elements of two breakdowns at the same level, create a breakdown relation between the breakdowns. A table must exist with fields that reference the records for both breakdowns.

Before you begin
Review the use cases for breakdown relations in Navigating breakdown elements with breakdown relations.

Role required: pa_data_collector, pa_power_user, admin

Note: While a business analyst, typically with the pa_power_user role, is most likely to know what breakdown relations to create, creating them requires the knowledge and access to tables of a technical expert with pa_data_collector. A pa_admin is likely to understand both. Consider having either a pa_admin create the relation or have a collaboration between a pa_power_user and a pa_data_collector.
About this task
You want to be able to navigate quickly between two breakdowns at the same level that are logically related. The example used in this topic involves the breakdowns Assignment Group and Assigned To for the indicator Number of open incidents. In the following animation, you switch from seeing the number of incidents assigned to the Oracle Support group and seeing the number of incidents assigned to Candace Bruckman. Both breakdowns are first level, which means that you see the total number of incidents assigned to Oracle Support and the total assigned to Candace Bruckman. If you had selected Candice as a second-level breakdown instead of through a breakdown relation, you would have seen only the Oracle Support issues that she was working on.

Note: Breakdown relations are one-way relationships. To create a bi-directional relationship, define multiple breakdown relations.
Procedure

1. Navigate to Breakdowns > Breakdown Relations and click New.
2. Fill in the fields on the form, as follows.

Breakdown Relation form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown</td>
<td>Select the breakdown that this relationship belongs to. You can access related breakdowns from this breakdown only.</td>
<td>For our example, where you want a selection of group members to appear when you select an Assignment Group, the Breakdown is Assignment Group.</td>
</tr>
<tr>
<td>Related breakdown</td>
<td>Select the breakdown you want to associate with the first breakdown.</td>
<td>For our example, the related breakdown with the Assignment Group members is Assigned To.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table with fields that reference the facts table records of the sources of both breakdowns. For many-to-many relationships, select a many-to-many table. For one-to-many relationships, select a facts table.</td>
<td>The Assignment Group breakdown uses Group data. The Assigned To breakdown uses User data. Assignment Groups can have many members, and a user can be a member of more than one Assignment Group, so they have a many-to-many relationship. Therefore, you select the Group Member [sys_user_grmember] table, which is a many-to-many table that joins groups and users.</td>
</tr>
<tr>
<td>Breakdown field</td>
<td>Select the field from the specified table that identifies the breakdown element you can navigate from.</td>
<td>In our example, you select the Group field. This field in the Group Member [sys_user_grmember] table identifies the element of the Assignment Group breakdown.</td>
</tr>
<tr>
<td>Related breakdown field</td>
<td>Select the field from the specified table that identifies the breakdown elements</td>
<td>In our example, you select the User field. This field in the Group Member [sys_user_grmember] table identifies the element of the Assigned To breakdown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>you can navigate to when viewing this relation.</td>
<td></td>
</tr>
<tr>
<td>Common field</td>
<td>Leave this field empty when defining a relation between breakdowns.</td>
<td></td>
</tr>
<tr>
<td>Conditions</td>
<td>Define any further conditions that a record must fulfill to appear as a related breakdown for this relationship.</td>
<td>In our example, you add the condition <code>[User.Active] [is] [true]</code> to filter our inactive group members.</td>
</tr>
</tbody>
</table>

**Results**

After you submit the Breakdown Relation form, the navigation options are available in the Analytics Hub for the relevant indicator. You do not need to run a data collection job first.

**What to do next**

View examples of breakdown relations that are shipped by default in every instance. The example shown here is the **Members** breakdown relation. The **Member of** breakdown relation provides navigation in the reverse direction, starting with an element in Assigned To and navigating to an Assignment Group. Lastly, the **Manager** breakdown relation is similar to **Members**, but because each assignment group has only one manager, it shows a many-to-one relationship. It thus uses a facts table instead of a many-to-many table.

**Create relations between elements of one breakdown**

Use a breakdown relation to set up navigation on an Analytics Hub between a hierarchy of elements within the same breakdown. A field in the breakdown records must identify the hierarchical relationship of one record to another.

**Before you begin**

Review the use cases for breakdown relations in *Navigating breakdown elements with breakdown relations*.

Role required: pa_data_collector, pa_power_user, admin
Note: While a business analyst, typically with the `pa_power_user` role, is most likely to know what breakdown relations to create, creating them requires the knowledge and access to tables of a technical expert with `pa_data_collector`. A `pa_admin` is likely to understand both. Consider having either a `pa_admin` create the relation or have a collaboration between a `pa_power_user` and a `pa_data_collector`.

About this task
You can create breakdown relations to navigate the following hierarchical relationships between elements of a breakdown:

- Child relations, to navigate from a parent element to its children
- Parent relations, to navigate from a child element to its parents
- Sibling, or peer relations, to navigate between elements that share the same parent element

In a breakdown with a hierarchical relationship between elements, one field in the element record identifies the position of the element in the hierarchy. Typically this field is `Parent`, and identifies the parent element. Elements that are the parent of one element can themselves have a parent element, and you can navigate this multi-level hierarchy in the Analytics Hub.

The example used in this topic is the Location breakdown for the Number of open incidents indicator. A child relation and a parent relation are needed to navigate the several levels of hierarchy, such as from region to country to city and back.
Note: Breakdown relations are one-way relationships. Define multiple breakdown relations to create a bi-directional relationship.

Procedure

1. Navigate to Breakdowns > Breakdown Relations and click New.

2. In the Breakdown and Related breakdown fields, select the breakdown whose elements you want to navigate between. These fields have the same value when you are creating a relation between elements of the same breakdown. For our example, select the Location breakdown in both fields.

3. In the Table field, select the same table as the breakdown source facts table. In our example, select Location [cmn_location].

4. Fill in the rest of the form, depending on whether you are creating a child, a parent, or a sibling/peer relation.

Breakdown Relation form

<table>
<thead>
<tr>
<th>Field</th>
<th>Child relation</th>
<th>Parent relation</th>
<th>Sibling/peer relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown field</td>
<td>Select the field that identifies the parent element.</td>
<td>Select the unique identifier field for</td>
<td>Select the unique identifier field for</td>
</tr>
<tr>
<td>Field</td>
<td>Child relation</td>
<td>Parent relation</td>
<td>Sibling/peer relation</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>For the Location</td>
<td>For the Location breakdown, select <strong>Parent</strong>.</td>
<td>elements of this breakdown.</td>
<td>elements of this breakdown.</td>
</tr>
<tr>
<td>Related breakdown</td>
<td>Select the unique identifier field for elements of this breakdown.</td>
<td>Select the field that identifies the parent element.</td>
<td>Select the unique identifier field for elements of this breakdown.</td>
</tr>
<tr>
<td>field</td>
<td>For the Location breakdown, as for most breakdowns, select <strong>Sys ID</strong>.</td>
<td>For the Location breakdown, select <strong>Parent</strong>.</td>
<td>For the Location breakdown, as for most breakdowns, select <strong>Sys ID</strong>.</td>
</tr>
<tr>
<td>Common field</td>
<td>Leave empty.</td>
<td>Leave empty.</td>
<td>Select the field that identifies the parent element.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For the Location breakdown, select <strong>Parent</strong>.</td>
</tr>
</tbody>
</table>

5. Under **Conditions**, define any further conditions that a record must fulfill to appear as a related breakdown for this relationship.

**Results**

After you submit the Breakdown Relation form, the navigation options are available in the Analytics Hub for the relevant indicator. You do not need to run a data collection job first.

**What to do next**

View examples of breakdown relations that are shipped by default in every instance. For the Location breakdown, the **Child Location** and **Parent Location** breakdown relations are included. The **Sibling Group** breakdown relation is an example of a sibling or peer relation.

**Control ability to view breakdown elements**

To limit which breakdown elements a subset of users can view on indicators, implement element security. Element security applies to widgets, workspaces, and the Analytics Hub.
Before you begin
Roles required: pa_admin or admin

About this task
There are no visibility options for breakdowns. Instead, access to breakdowns is regulated by ACLs in the breakdown sources.

Procedure
1. Navigate to Performance Analytics > Breakdown Sources.
2. Open the breakdown sources record for the breakdown you want to set access to.
3. In the Security type list, select from the following:

<table>
<thead>
<tr>
<th>Security type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deny list</td>
<td>Exclude groups and users with the roles you specify. They cannot view the indicator scores for the breakdown elements you specify. Groups and users without these roles can view the scores for the elements.</td>
</tr>
<tr>
<td>Allow list</td>
<td>Include groups and users with the roles you specify. Only they can view the indicator scores for the breakdown elements you specify. Groups and users without these roles cannot view the scores for the elements.</td>
</tr>
</tbody>
</table>

4. Define an Elements Security List record and either:
   - Select the elements for the list.
   - Set conditions to define which elements are on the list.
5. Specify the roles that the elements security list applies to.

Define an elements security list
An elements security list prevents unauthorized access to breakdown elements.

Procedure
1. Navigate to Performance Analytics > Breakdown Sources.
2. Open an existing breakdown source record.
3. In the Elements Security List related list, click New.
4. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the elements security list.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description of what the elements security list does and its purpose.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for making the elements security list active (selected) or inactive (cleared).</td>
</tr>
<tr>
<td>All roles</td>
<td>Select to indicate that the list applies to all roles. Clear the check box and click the lock icon to specify the roles belonging to this elements security list. You can use the search button to look for specific roles.</td>
</tr>
<tr>
<td>Security type</td>
<td>[Read-Only] Security type selected for the associated breakdown source.</td>
</tr>
<tr>
<td>Dimension</td>
<td>[Read-Only] Dimension selected for the associated breakdown source.</td>
</tr>
<tr>
<td>Facts table</td>
<td>[Read-Only] Facts table selected for the associated breakdown source.</td>
</tr>
<tr>
<td>Select elements</td>
<td>Select to specify explicitly the elements that this security list applies to. If this option is cleared, use <strong>Conditions</strong> to determine which elements to include.</td>
</tr>
<tr>
<td>All elements</td>
<td>Select for the security list to include all elements. Clear to specify individual elements in this security list. Default: selected</td>
</tr>
<tr>
<td>Show blank option</td>
<td>Select to allow a user on a breakdown dashboard to see scores without any breakdown elements specified. Clear to allow a user on a breakdown dashboard to see only scores for the breakdown elements that are visible to their role. This setting affects only widgets that follow breakdown dashboard elements. Users with the admin role can always see unfiltered scores on breakdown dashboards.</td>
</tr>
</tbody>
</table>
| Conditions        | The conditions for determining which breakdown elements the security list applies to. For example, **[User.Manager][is (dynamic)] [Me]**. Conditions are applied on top of the
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>breakdown source conditions. This field is available only if Select elements is not selected.</td>
<td></td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Role restrictions with deny lists**

If deny list security is specified for a breakdown source, and any of the roles of a user are on an element security list for that breakdown source, that user cannot see the elements which that security list applies to.

**Visibility of breakdown element by user role with deny list security**

<table>
<thead>
<tr>
<th>User role on element security list?</th>
<th>Visibility of elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>None of the roles of the user are in an element security list.</td>
<td>All elements that the security list applies to are visible.</td>
</tr>
<tr>
<td>Any of the roles of the user are in an element security list.</td>
<td>None of the elements that the security list applies to are visible.</td>
</tr>
<tr>
<td>User has the admin role.</td>
<td>All elements are visible.</td>
</tr>
</tbody>
</table>

**Role restrictions with allow lists**

If allow list security is specified for a breakdown source, and any of the roles of a user are on an element security list for that breakdown source, that user can see the elements which that security list applies to.

**Visibility of breakdown element by user role with allow list security**

<table>
<thead>
<tr>
<th>User role on element security list?</th>
<th>Visibility of elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>None of the roles of the user are in a security list.</td>
<td>None of the elements that the security list applies to are visible.</td>
</tr>
<tr>
<td>Any of the roles of the user are in a security list.</td>
<td>All elements that the security list applies to are visible.</td>
</tr>
<tr>
<td>User has the admin role.</td>
<td>All elements are visible.</td>
</tr>
</tbody>
</table>

**Using breakdowns on dashboards**

You can add breakdown sources to a dashboard. Dashboard users then can select a breakdown source and one or more breakdown elements to filter scores in the visualizations on the dashboard.
The selected elements filter those Performance Analytics widgets on the dashboard that follow these conditions:

- An indicator on the widget uses a breakdown that is based on the selected breakdown source. For formula indicators, all the contributing indicators in the formula must use a breakdown based on this source.
- The widget follows elements on breakdown dashboards.

The selected elements filter reports on the dashboard under the following conditions:

- You have configured the dashboard to use the breakdown source as an interactive filter.
- The report follows interactive filters on the dashboard.

If the dashboard user selects multiple elements, widgets can show scores separately for those elements, or show a single aggregate, depending on the widget type and configuration. For more information, see Showing multiple elements separately or aggregated.

The following illustration shows a breakdown widget with the scores given separately for each selected element of the Category breakdown. The dashboard user has selected three elements of the Incident.Category breakdown source. If this user has access to the Analytics Hub, they can click any score to view the score trend in the Analytics Hub.

**Related information**

- Performance Analytics widgets
- Performance Analytics breakdowns
- Define a breakdown source
Analytics Hub for a specific indicator
Make a breakdown act as an interactive filter

Add breakdown sources to a dashboard

To enable dashboard users to filter visualizations on a dashboard by breakdown element, add breakdown sources to the dashboard.

Before you begin
Role required: pa_admin, pa_power_user, or admin

About this task

Procedure

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. Open the relevant dashboard.
3. From the context menu, select **Dashboard Properties**.

The dashboard record opens.

4. Click **Edit** in the Breakdown Source related list.
A dialog opens where you can move breakdown sources into and out of the list.

5. Move the breakdown sources you want to apply to the Breakdown Source List.

6. Click Save.

Results

The breakdown sources are available on the dashboard. Users can group the dashboard on the selected elements.

What to do next

• You can configure the entries in the Breakdown Source related list so that reports on the dashboard can use the breakdown sources as interactive filters. You first create interactive filters that are based on the same tables as the breakdown sources. For more information, see Make a breakdown act as an interactive filter.

• Configure the Performance Analytics widgets on the dashboard so that users can filter them by selecting breakdown elements on the dashboard. For more information, see Configure widgets for breakdown dashboards.

Configure widgets for breakdown dashboards

Configure each widget that goes on a breakdown dashboard. The configuration determines whether and how the widget follows the elements selected on the dashboard. For some widgets and indicator, you can select whether to show multiple element values separately or as an aggregate.

Before you begin

This task assumes that you are starting from an open breakdown dashboard.

Role required: pa_power_user, admin
Procedure

1. On the breakdown dashboard, click the plus sign (++) to put the dashboard in edit mode.

2. Point to the widget, then click the pencil icon (✏️). The widget record opens.

3. Select **Follow element** in the widget record.

   ![Widget record showing options](image)

   If you do not select **Follow element** for a widget, that widget does not follow any breakdown elements selected on the dashboard. The **Followed breakdown** and **Show multiple elements as** options are not visible.

   **Note:** If the widget is for a formula indicator, all contributing indicators in the formula must support the selected breakdown source on the dashboard. Otherwise, no scores are displayed in the widget. In this case, a message displays to inform you of the situation.

   **Important:** Do not specify a breakdown and element on the widget record when you want the elements for that breakdown to be selected on a breakdown dashboard. The element on the widget record overrides any elements selected on the breakdown dashboard for that breakdown.

4. If more than one breakdown uses one of the breakdown sources on the dashboard, specify which breakdown applies to the widget in **Followed breakdown**.

   **Example**

   For example, the breakdowns Opened by, Requested by, Requested for, and Assigned to use the Users.Active breakdown source. If you add Users.Active to a dashboard, select the relevant breakdown in **Followed breakdown** for each
of the widgets that you have on that dashboard. This option does not affect any other breakdown sources you may have added to the dashboard.

5. In the **Show multiple elements as** field, select how to show scores when a dashboard viewer selects multiple breakdown elements.

Choose from two possibilities:

- **Aggregate**, which shows a single, aggregate score of all selected elements.
- **Separate**, which shows each selected element separately.

Not all widget and indicator types support both views. Some types do not support selecting multiple elements at all. If it is not possible to select multiple elements for a widget/indicator combination, the field says **Not available**. For more information, see *Showing multiple elements separately or aggregated*.

**Showing multiple elements separately or aggregated**

When you select multiple elements on a dashboard, widgets that follow these elements can show their values either separately or as an aggregate.

On a widget form, use the **Show multiple elements as** field to set whether multiple elements are shown separately or as an aggregate. Widgets with the view type **Separate** show a different value for each breakdown element selected. Widgets with the view type **Aggregate** show a single value that represents the aggregated value of all selected breakdown elements.

The indicator type and widget type determine whether an aggregated view, a separate view, or both are available. There are also logical limitations to which views are available on a filtered dashboard. For example, a Score widget can only show an aggregated view. Some combinations of widget and indicator type cannot be filtered on multiple elements. For example, a Score widget for a formula indicator cannot be filtered on multiple elements, because formula indicators do not support the Aggregate view and Score widgets only support the Aggregate view. In this latter case, the **Show multiple element as** field displays **Not available** and is greyed out.

**Widget support of aggregate and separate views**

- Time series widgets support aggregate and separate views.
- List widgets support aggregate and separate views.
- Score widgets only support the aggregate view.
- Breakdown widgets only support the aggregate view.

**Note:** You cannot select multiple elements on pivot, workbench, or text visualization widgets.
**Indicators that support aggregate of multiple elements**

The following indicators support the Aggregate view:

- Automated indicators that aggregate data as a Count, Sum, Minimum, or Maximum value

  **Note:** The word "aggregate" is used for two different things here: the aggregate view of multiple indicator scores, and the data aggregation that is set on an indicator.

- Manual indicators

- External indicators that do not use `SQL AVG()` or `SQL COUNT(DISTINCT...)` in their SQL statement

- Formula indicators that have aggregate element views enabled on their indicator records. For more information, see the entry on the Allow aggregation of multiple breakdown element scores field on the Other tab in Create a formula indicator.

**Important:** Indicators that aggregate data as an Average or a Count Distinct do not support the Aggregate view.

**Note:** The Show multiple elements as value applies to both the main widget and any indicator widgets. If Aggregate is selected but one of the indicator widgets does not support the Aggregate view, that indicator does not follow the elements on the breakdown dashboard. Instead, the indicator follows any first-level breakdown and element that are set in the widget configuration. The other indicators follow the elements on the breakdown dashboard and show an aggregate of their values.

**Results when showing aggregate view**

The aggregate view of multiple elements shows a different result depending on the indicator's data aggregation:

<table>
<thead>
<tr>
<th>Automated indicator data aggregation</th>
<th>External indicator SQL statement</th>
<th>In a widget, what an aggregate view of multiple elements shows</th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNT</td>
<td><code>SQL COUNT()</code></td>
<td>A sum of the scores of the selected elements</td>
</tr>
<tr>
<td>SUM</td>
<td><code>SQL SUM()</code></td>
<td>A sum of the scores of the selected elements, which themselves are sums</td>
</tr>
<tr>
<td>MAX</td>
<td><code>SQL MAX()</code></td>
<td>Whichever element had the highest value at each time point</td>
</tr>
</tbody>
</table>
### Automated indicator data aggregation

<table>
<thead>
<tr>
<th>External indicator SQL statement</th>
<th>In a widget, what an aggregate view of multiple elements shows</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL MIN()</td>
<td>Whichever element had the lowest value at each time point</td>
</tr>
</tbody>
</table>

With the aggregate view selected, not all features are available on all widgets or when the user navigates from the widget to the Analytics Hub:

- Targets, thresholds, and comments are not available when you navigate to the Analytics Hub from a widget with multiple breakdown elements selected in an aggregate view. The breakdown selector and search functionality are also unavailable.
- Targets and thresholds are not available in time series widgets.
- Targets and bullet charts are not available in list widgets.

### Widget indicators and breakdown dashboards

When a user selects breakdown elements on a breakdown dashboard, the breakdown and element names are appended to the widget indicator names. Widget indicator labels also have the breakdown and element names appended. The breakdown and element names are not appended to the widget indicator names and labels in the following circumstances:

- The widget shows an aggregate view of multiple elements, and the widget indicator does not support this view.
- The widget does not follow elements.
- The widget indicators do not support the selected breakdown elements.
Names and labels for widget indicators with multiple elements selected, separate view

- Resolved incidents > Assignment Group = Capacity Mgmt
- Resolved incidents > Assignment Group = CAB Approval
- # open inc > Priority = 1 - Critical > Assignment Group = Capacity Mgmt
- # open inc > Priority = 1 - Critical > Assignment Group = CAB Approval
- # unsolved inc > Assignment Group = Capacity Mgmt
- # unsolved inc > Assignment Group = CAB Approval
- Avg close time > Priority = 1 - Critical > Assignment Group = Capacity Mgmt
- Avg close time > Priority = 1 - Critical > Assignment Group = CAB Approval

Names and labels for widget indicators with multiple elements selected, aggregate view

- Resolved incidents > Assignment Group IN (CAB Approval, Capacity Mgmt)
- # open inc > Assignment Group IN (CAB Approval, Capacity Mgmt) > Priority = 1 - Critical
- # unsolved inc > Assignment Group IN (CAB Approval, Capacity Mgmt)
- Avg close time

Widget indicator label for formula indicator that does not support aggregate view
Example: Open incidents with aggregate and separate values for multiple elements

Consider a breakdown dashboard with the Incident.Category breakdown source and the three elements Inquiry/Help, Network, and Software selected.

The dashboard contains a time series widget called Open Incidents. This widget shows the Number of Open Incidents indicator, which has the Count aggregate. The widget follows the elements that are selected on the dashboard. Therefore, the widget can show multiple elements selected on the dashboard either separately or as an aggregate value. The **Show multiple elements as** field is set to **Separate**.
On the dashboard, a separate column is shown for each of the three selected elements for each day.

With the Show multiple elements as field set to Aggregate, a single, aggregate score is shown for the three selected elements.

Disable multiple element selection on a dashboard
Dashboard owners have the option to disable multiple element select on an entire breakdown dashboard.

Before you begin
Role required: admin

About this task
When you disable multiple element selection on a breakdown dashboard, users of that dashboard are only able to filter the dashboard's widgets on one element of the breakdown.
Procedure

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.

2. Select the breakdown dashboard that you want to filter by only one breakdown element at a time.

3. From the context menu, select Dashboard Properties.

4. Select Disable multiple element selection. This option is available when there is at least one breakdown source in the dashboard’s Breakdown Source related list.

5. Click Update.

Results

When you filter the dashboard on breakdown elements, you can select only one breakdown element. The widgets on the dashboard follow the single breakdown element selected. When you select elements or clear selected elements, you have to click Apply to make this choice.

Same breakdown on widget and dashboard

If a widget uses the same breakdown as the dashboard, the dashboard breakdown does not apply.

When you design a widget, you can specify up to two levels of breakdown to apply to that widget. Then you can add that widget to any dashboard, including a breakdown dashboard. If one of the breakdowns for the dashboard
is the same as one of the breakdowns of the widget, that dashboard breakdown does not affect the widget. The behavior for that breakdown is the same as though **Follow element** was disabled for this widget.

If you add a breakdown type widget with interactive breakdown selection to a dashboard, this limitation does not fully apply. When the user selects the same breakdown on the widget and on the dashboard, the dashboard breakdown is ignored. However, when the user selects any other combination of widget and dashboard breakdowns, both breakdowns apply.

**Example: Breakdown widget on a breakdown dashboard**

In the following animation, you have a breakdown widget on a breakdown dashboard. The widget has **Follow element** selected in its configuration. Both the dashboard and the widget are using elements of the Category breakdown. When you select elements on the dashboard, it has no effect on the widget. Then you select the Urgency breakdown on the widget. Now selecting elements on the dashboard does affect the widget. If you had changed the breakdown source on the dashboard instead of the breakdown on the widget, selecting elements on the dashboard also would have affected the widget.
**Widget with interactive breakdown selection on a breakdown dashboard**

![Widget screenshot]

**Showing breakdown relations on dashboards**

A breakdown widget can display 1st level breakdown elements that are related to the element selected for the dashboard. The widget must be on a breakdown dashboard, and that dashboard must include the breakdown sources of the related breakdowns.

**Note:** Multiple element selection on a breakdown dashboard is not supported on a widget when you select a breakdown relation to follow.

Consider an indicator such as Number of open incidents. This indicator uses the Location breakdown. The Location breakdown has three breakdown relations between its own elements. For an element of Location, these relations are:
• Parent Locations, whose Sys ID value is in the Parent field of other Location elements.

• Child Locations, which have the Sys ID value of another Location element in their Parent fields.

• Sibling Locations, consisting of Location elements who share the same value in the Parent field.

Breakdown relations between elements of Location

Now consider a widget that displays the Number of open incidents indicator scores grouped by Location. You set the widget to follow an element selected in a breakdown dashboard. Now you must select which of the breakdown relations to follow.
Setting up widget to show elements by breakdown relation

Important: The Followed breakdown relation menu works only when the Scorecard visualization is selected. To allow the user to follow breakdown relations with other visualizations, select Show visualization selector on the widget form.

You select Child Locations. Now you put the widget in a breakdown dashboard that uses the Locations breakdown source. Locations is the breakdown source of the Location breakdown, so on the dashboard you can select any of the elements of Location. If you select EMEA, the widget shows the locations that have EMEA as a parent.
A widget on a breakdown dashboard showing the children of the dashboard element

You can go down more levels, to "grandchild" and "great-grandchild" elements. For example, here the location of Germany is selected:
If you edit the widget to display the Parent Location instead of the Child Locations and select Germany on the dashboard again, you see the parent location of Germany.
Breakdown widget showing the parent of the dashboard element

Locations ▼ Germany ▼

Incident Overview Incident Open Incident New Incident Resolved

Open incidents by location

<table>
<thead>
<tr>
<th>Name</th>
<th>Jul 26</th>
<th>Trend</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emea</td>
<td>11</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related information

Navigating breakdown elements with breakdown relations
Create a scorecard visualization for a breakdown widget

Analytics Hub

The Analytics Hub is an exploratory view of indicators, used for more detailed analysis. It lets you see trends, predictions, breakdowns, and associated records for a specific indicator. The Analytics Hub replaces scorecards.

In the Analytics Hub, analyze indicator scores by aggregating data, comparing scores, or viewing changes over time, and filter scores by breakdown. Enhance the Analytics Hub by adding targets, thresholds, trendlines, and useful comments for significant changes.

On the indicator form, you can set the indicator to be included in the Analytics Hub automatically.

⚠️ Note: Values between 10,000 and 999,999 are rounded off to the nearest thousand and abbreviated with a K, such as 11K for 11,234. Values between 1 million and 999,999,999 are rounded off to the nearest million and abbreviated with an M. Values of 1 billion and higher are rounded off to the nearest billion and abbreviated with a G.
ServiceNow Performance Analytics – Analytics Hub

Watch this five-minute video to learn how to use Analytics Hub to analyze, explore, and compare Performance Analytics indicator data. Introduction to using the Analytics Hub.

Related information
Performance Analytics indicators

Analytics Hub list of indicators
The Analytics Hub provides a list of indicators, their scores, and a customizable selection of other analytics. Click the name of an indicator to see more details about that indicator. The Analytics Hub replaces scorecards.

To access the Analytics Hub list, navigate to Performance Analytics > Analytics Hub.

Indicator list controls
The list of indicators includes the following controls:

- Click the name of an indicator to open a view of the Analytics Hub that is focused on the indicator. An extended set of analytical tools is available in this view.
- Click the pencil icon next to an indicator to open the indicator record for editing. This icon is available only if your roles give you access to the indicator record.
- A solid green star beside an indicator name indicates that it is a favorite. Click the star beside the indicator to mark it as a favorite.
- A black dot beside an indicator name indicates that it is a key indicator. Mark indicators as key by selecting the Key check box when creating the indicator.
To customize what the Analytics Hub shows, click the list settings icon (⚙️) beside the search box.
The list settings include the following sections:

- Filter settings
- Breakdown source and element settings
- Column settings
**Filter settings**
You can filter which indicators are shown with the following settings:

**Key indicators**
Only indicators that are defined as key indicators in the indicator record are shown.

**With a target**
Only indicators with a defined target are shown.

**Formula**
Only formula indicators are shown.

**Manual**
Only manual indicators are shown.

**Filter setting to show only formula indicators**

<table>
<thead>
<tr>
<th>Filters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Indicators</td>
<td></td>
</tr>
<tr>
<td>With a target</td>
<td></td>
</tr>
<tr>
<td>Formula</td>
<td></td>
</tr>
<tr>
<td>Manual</td>
<td></td>
</tr>
</tbody>
</table>

**Breakdown source and element settings**
Within the settings, you can also select a breakdown source. Only indicators that use that breakdown source are shown. After choosing the breakdown source, you can further filter the list of indicators by selecting a breakdown element. Only indicators to which that element applies are shown.

In the following example, you see how the scores change when the list is filtered on the Indicator.Priority breakdown source and then on the 1 - Critical element.
### Indicator list with no breakdown filter applied

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of incidents resolved by first assigned group</td>
<td>0.00%</td>
</tr>
<tr>
<td>% of new critical incidents</td>
<td></td>
</tr>
<tr>
<td>% of open incidents not updated in last 30 days</td>
<td>37.50%</td>
</tr>
<tr>
<td>% of open incidents not updated in last 5 days</td>
<td>45.00%</td>
</tr>
<tr>
<td>Active Users</td>
<td>603</td>
</tr>
<tr>
<td>AppSec: Number of Emails per Day</td>
<td>0</td>
</tr>
<tr>
<td>AppSec: Spam Emails per Day</td>
<td>0</td>
</tr>
<tr>
<td>Average age of last update of open incidents</td>
<td>514.39 days</td>
</tr>
<tr>
<td>Average age open incidents</td>
<td>599 days</td>
</tr>
<tr>
<td>Average re-assignment of open incidents</td>
<td>0.60</td>
</tr>
<tr>
<td>Average resolution time of resolved incidents</td>
<td>90.03 days</td>
</tr>
<tr>
<td>Inactive Users</td>
<td>1</td>
</tr>
</tbody>
</table>

### Indicator list with a breakdown source filter applied

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of incidents resolved by first assigned group</td>
<td>0.00%</td>
</tr>
<tr>
<td>% of open incidents not updated in last 30 days</td>
<td>37.50%</td>
</tr>
<tr>
<td>% of open incidents not updated in last 5 days</td>
<td>45.00%</td>
</tr>
<tr>
<td>Average age of last update of open incidents</td>
<td>514.39 days</td>
</tr>
<tr>
<td>Average age open incidents</td>
<td>599 days</td>
</tr>
<tr>
<td>Average re-assignment of open incidents</td>
<td>0.60</td>
</tr>
<tr>
<td>Average resolution time of resolved incidents</td>
<td>90.03 days</td>
</tr>
<tr>
<td>Incident backlog growth</td>
<td>-19</td>
</tr>
<tr>
<td>Number of New Incidents</td>
<td>0</td>
</tr>
<tr>
<td>Number of open Incidents</td>
<td>40</td>
</tr>
<tr>
<td>Number of open Incidents not updated in last 30 days</td>
<td>15</td>
</tr>
<tr>
<td>Number of open Incidents not updated in last 5 days</td>
<td>18</td>
</tr>
</tbody>
</table>
**Indicator list with a breakdown source and element filter applied**

**Column settings**
Select which analytics to show in the indicator list. The indicator scores are always shown.

**Change**
The change in scores, in absolute value, between the most recent and the preceding data collection.

**Trend**
The trend line for scores over the course of the data collection. This trend line is a miniaturization of the trend line that can be seen when the Analytics Hub is focused on a specific indicator.

**Bullet chart**
A chart comparing current score to target. This chart is shown for an indicator only if a target is set on that indicator.

**Date**
Date that the latest score was collected.

**Target**
The target for the indicator, if one has been set.

**Gap**

The gap between the latest score and the target. A value is shown only if a target has been set for the indicator.

**Frequency**

The frequency with which scores are calculated for the indicator.

**Direction**

Whether the score for the indicator should minimize, maximize, or neither.

**Show percentage**

If activated, the change in score is shown as a percentage instead of as an absolute value.

**Filter by performance**

You can filter the list of indicators based on the indicator performance, in addition to filtering the list in the settings.

- **Best**: Shows indicators that are outperforming their target (green), ordered by Gap % (best performers on top).
- **Worst**: Shows indicators that are under performing their target (red), ordered by Gap % (worst performers on top).
- **Improved**: Shows indicators that have improved compared to the previous data collection (moving in the right direction).
- **Degraded**: Shows indicators that have degraded compared to the previous data collection (moving in the wrong direction).

**Analytics Hub for a specific indicator**

Use the Analytics Hub to analyze indicator data deeply, such as by aggregating data, comparing scores, or viewing changes over time.

To access the Analytics Hub for an indicator, select any of these methods:

- Navigate to **Performance Analytics > Analytics Hub**, then select an indicator.
- Click the **Show analytics hub** related link on the relevant Indicator record.
• From a dashboard, click any value in a Performance Analytics widget.

ℹ️ Note:

◦ When the indicator scores in a breakdown dashboard are aggregated on multiple elements, the Analytics Hub is aggregated on the same elements. For more information, see the section **Aggregate scores for multiple elements**.

◦ Time series aggregations are validated on the Analytics Hub and in KPI Details but not in widgets. Therefore, you might navigate from a working widget to the Analytics Hub and get a warning that the indicator has an invalid aggregation.

### Adding Targets, Thresholds, Comments, and Improvement Initiatives

All tabs in the Analytics Hub have a toolbar at the top with the following actions:

• Targets
• Thresholds
• Add a comment
• Information
• Create Improvement Initiative (Requires the Continual Improvement Management application)

A tooltip identifies each icon in the toolbar.

The toolbar always has the rightmost four icons from the screenshot. Clicking one of these icons opens a pane where you can view or create a target, threshold, or comment. You can also view the basic information about the indicator from this pane.
Note: Targets, thresholds, and comments are not supported on the Analytics Hub when indicator scores are aggregated on multiple elements.

For a formula indicator, this basic information includes the formula. In the Info panel you can also expand a list of the daily scores for the indicator. To see the scores for each component indicator in a formula indicator, click on the indicator name in the formula. Doing so refocuses the Analytics Hub on that indicator.

If you have the Continual Improvement Management application and the sn_cim.improvement_requester role, you can create an improvement initiative.

Click the Create Improvement Initiative icon ( ) to open an Improvement Initiative form. This form is automatically populated with details of the indicator and Analytics Hub. To see the initiative start and finish dates on the timeline, click the improvement initiative icon in the chart options on the Overview tab.

If you have the Process Optimization application and a Process Optimization role, you can open the indicator in a Process Optimization dashboard. Click the Go to Process Optimization icon ( ).

Editing indicators and scores, exporting to PDF or CSV, and generating graphics
Every tab on the Analytics Hub has a context menu with the following options:
• Edit the indicator record
• Edit the indicator scores
• Create a graphical image of the tab in PNG or PDF
• Launch a dependency assessment

Click the context menu a second time to close it without making a choice.

Different tabs on the Analytics Hub
The Analytics Hub for a specific indicator has the following tabs, which provide different information about an indicator:

Related information
   Performance Analytics indicators
   Performance Analytics targets and thresholds
   Dependency Assessment
   Continual Improvement Management

View scores and statistics
The Analytics Hub Overview tab shows the score for a time period, statistics, and a time series. You can set the time period for the statistics and time series. You can also filter scores by breakdown and element.
Overview tab

Note: The ability to view formula indicator calculations, which had been available in the pre-Madrid Detailed Scorecard, is not supported on the Analytics Hub. For more information, see KB0783438.

Indicator summary
At the top left of the tab, you see the following information:

• The score for a chosen time period
• The change, both absolute and percentage, between that score and the score for the previous time period
• If a target is set, the difference between the score and that target
• Controls for switching to the previous, next, or last time period
• A calendar for selecting a time period or the real-time score

Score section showing compliance with a target
Number of open incidents

February 5   🔽 -12 (-6.2%)

Target: 450   Gap: 269 (59.8%)
Results are color-coded to show favorability. If the direction of an indicator is Maximize, increases in scores are shown in green and decreases in red. If the direction of an indicator is Minimize, increases in scores are shown in red and decreases in green. Similarly, a color bar indicates whether the target has been met or missed. The colors depend on the color scheme that has been set for the target. For more information, see Create a target color scheme.

The time period that is associated with a score is shown above the score. Controls let you move to the next time period, the previous time period, or the last time period. The date you select here is reflected in the statistics and the time series graph. The selected time period is carried over when you change to another tab. The length of a time period (day, month, quarter...) is the same as the frequency of the indicator.

You can also select the date by clicking along the time series chart. Furthermore, if you navigate to this Analytics Hub from a widget, the date that you select in the widget persists when you open the Analytics Hub.

**Viewing real-time scores on the Analytics Hub**

You can select real-time scores instead of the last score in the following circumstances:

- The indicator is an automated indicator.
- It is configured to show real-time scores.
- The aggregate function for the indicator does not use a script.
- The indicator source does not use a database view.
- None of the breakdowns that are applied to the indicator use a scripted breakdown source.

⚠️ **Warning:** Real-time scores can differ per viewer and differ from collected scores. Real-time scores are taken directly from the relevant facts tables. Therefore, the Access Control Lists (ACL) of those facts tables determine the real-time scores that each logged-in user sees.

⚠️ **Important:** The Analytics Hub does not refresh real-time scores automatically. To get the most up-to-date score, refresh the browser page.

If you can select real-time scores, select them in the date selector or by selecting the current time period in the **Records** view. However, when viewing real-time scores, you cannot see records that do not match a breakdown element in the **Records** view.
Selecting to show real-time score

Number of open incidents

Today at 16:39

Note: You can show real-time scores to dashboard users in some widgets. For more information, see Real-time scores.

Time series aggregation
In the top-right corner, you can set the time series aggregation for the Analytics Hub. For more information, see Applying time series aggregations.

Menus of daily time series aggregations

The time series aggregation is reflected in the score, the statistics, the time series graph, and the charts in other tabs. The available time series depend on the frequency of the indicator. For more information, see Applying time series aggregations.
Note:

- Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation for an indicator that uses such a calendar.
- Selecting a time series aggregation overrides the **Render continuous lines** option that is set on the indicator. This option causes the Analytics Hub to show unbroken data lines for this indicator, even when there is no data for a specific date.

**Date range**

You can set the time period of scores that the Analytics Hub describes. The controls for doing so are above the statistics and to the left of the time series aggregation. The time period you choose is reflected in the statistics and the time series graph. You have two control options to set the time period:

- The calendar:

- The sliders with the navigation bar:

**Note:** If you specify a date range such as 3 MONTHS with a time series aggregation such as By month SUM, you may see one more time period than you expect. The instance interprets a period such as three months as 0-3 months and may show four months of scores.
Statistics

In the upper right, you have a series of statistics over a time period. You can set the time period with the controls above the statistics.

You cannot customize the statistics display on the Analytics Hub. However, because not all statistics are relevant to all indicators, you can exclude statistics on the indicator record. For example, you can exclude Change % for an indicator with a score expressed as a percentage. For more information, see Create an automated indicator.

Breakdowns, elements, and elements filters

You can show a separate line or column on the chart for every element of a breakdown. You can also filter the scores by selecting a breakdown and an element. You can search for breakdowns and elements by name or you can open a breakdown and element selection dialog.

If you select a breakdown but not an element, the chart shows each element of the breakdown.
Note:

- The scores are not shown when no element from the breakdown applies. This rule also applies to Choice [sys_choice] table breakdowns when a label defined in NULL_OVERRIDRE replaces the value of none.
- If you try to apply a breakdown to a formula indicator but not all contributing indicators support the breakdown, the breakdown is not applied. Instead, you see the score for the formula indicator without the breakdown. A message appears to let you know this has happened.

If you select a breakdown and an element, you filter the entire Analytics Hub to show only the values for that breakdown and element.

Analytics Hub filtered to show only low-priority incidents

If the breakdown has an elements filter defined for its breakdown source, you can choose one of those elements filters. For more information, see Element filters.

If breakdown relations are defined for the indicator, after you select a first-level breakdown and element, you can navigate to a related element. The element can be in a parent-child relationship in the same breakdown, or it can be in another breakdown. For more information about breakdown relations including procedures for creating them, see Navigating breakdown elements with breakdown relations.
Breakdown relations

After you select a first-level breakdown and element, you can select a second-level breakdown and element. You cannot select more than two levels of breakdown in total.
Selecting breakdowns and elements

The following animation shows the selection and clearing of a first- and second-level breakdown and element.

The table shows the priority levels and their corresponding scores and changes:

- **4 - Low**: Score 56, Change 0
- **5 - Planning**: Score 50, Change 0
- **3 - Moderate**: Score 46, Change 0
- **2 - High**: Score 32, Change 0
- **1 - Critical**: Score 16, Change 0

The bar chart and line graph illustrate the number of open incidents over time, with a significant increase from August 25 to November 26.
You can clear either the first- or second-level breakdown and element combination by clicking the X in the tile for that breakdown/element pair. If you clear the first-level breakdown/element, the second-level breakdown/element becomes the first-level breakdown/element. You can also clear the selection by following the breadcrumbs above the score.

**Aggregate scores for multiple elements**
If you click a value on a chart in a widget on a dashboard, you open the Analytics Hub on that indicator. If you are on a breakdown dashboard and have multiple elements selected, and the widget shows the aggregate of those elements, the Analytics Hub also shows the aggregate of those elements.

![Chart showing open incidents over time](image)

The Analytics Hub opens on whichever date was selected in the widget. The multiple elements are shown in the format **(Breakdown) in (element_1, element_2, element_3, +x more)**.
Analytics Hub with multiple elements

Note: Targets, thresholds, and comments are not available when you navigate to the Analytics Hub from a widget with multiple breakdown elements selected in an aggregate view. The breakdown selector and search functionality are also unavailable. If you then select Show Records on the Analytics Hub, you see the records that match any of the elements you selected on the dashboard.

Show Records

You can toggle between showing a time series of indicator scores and a list of the records used to calculate those scores. Click Show Records or Hide Records in the upper right corner to toggle. In either case, the scores or records are shown for the time period that is chosen at the top of the tab. The scores or records are also filtered by any breakdown/element pairs that you selected.

If you opened the Analytics Hub from a breakdown dashboard with multiple elements selected, what you see depends on the dashboard widget. If the widget displays each element value separately, you see the records that match the element you selected. If the widget displays an aggregate score of the elements, you see the records that match any of those elements.
Note:

- Records are shown only for automated indicators.
- The Show Records function is not supported for real-time scores of unmatched breakdown elements. If you are viewing scores in real time, records that are not assigned to any breakdown element are not displayed.
- You can change the view of the list of records in the context menu of the Records list, depending on the views available to the facts table. The default view is set on the indicator source.
- In some cases, when you collect second-level breakdowns, the score and the number of records do not agree. When these values do not agree, the score is correct. For more details and an example, see KB0748969.

Chart options

You can change what the chart displays. Click the Show more icon, and a toolbar of additional icons appears.

A tooltip for each icon identifies which chart option the icon turns on and off. The chart options include:

- The type of measurement that is displayed.
- Displaying labels
- Displaying a forecast of future scores, depending on how forecasting is set up on the indicator.
- Displaying confidence bands
• Displaying the trend line
• Displaying comments
• Displaying thresholds
• Displaying targets
• Selecting the chart visualization

If you have the Continual Management Improvement application installed, you also have an icon to show or hide Improvement Initiatives ( ). If you also have the sn_cim.improvement_requester role, you can create an improvement initiative by clicking the identical icon in the toolbar, as described in Analytics Hub for a specific indicator.

The available measurements are:
• Year-over-year
• Change
• Change percent
• Score

Score is the default measurement. All measurement types except Year-over-year can be shown together. Year-over-year can apply to only one other measurement at a time, such as Score or Change, but not both. A full year of data is necessary to make Year-over-year meaningful.
Visualizations
To change the visualization used for the graph, select a visualization from the list menu. Area, column, line, and spline visualizations are available.

User preferences
The Analytics Hub tracks the following user preferences:

- All display settings
- Chart visualizations
- Time period

All preferences are stored per indicator and user, so each user can configure each Analytics Hub to display as preferred.

⚠️ Note: If you are upgrading from a version with scorecards instead of the Analytics Hub, the table with old user preferences is preserved. The first time a user opens the Analytics Hub for an indicator, the preferences are imported from the old table. This import is overridden if the preferences for that user and indicator are set manually in the PA Analytics Hub Preferences [pa_ds_preference] table before the user opens the Analytics Hub.

Domain separation on Analytics Hub
The Analytics Hub follows whichever domain you have selected in the System Settings. You see only the scores that are collected in that domain. Any target, threshold, or comment you add is automatically associated with the current domain. The Edit scores option is not available.

Besides system settings, some dashboards are configured so that you can select the domain on the dashboard. If you navigate to the Analytics Hub from a widget on such a dashboard, you see only the scores that are collected for that
domain. For more information, see Associate a domain configuration with a dashboard.

**Compare scores**

In the Analytics Hub Compare tab, compare scores on any two dates, or compare scores against linked benchmark scores.

![Compare tab](image)

**Note:** The Compare tab is available only for automated indicators.

You can compare the scores of an automated indicator on two dates. Date selection works the same way as in the Overview tab. Furthermore, any dates selected on one tab persist when you change to another tab.

If the scores refer to a count, below the scores, you see the following information, from left to right:

- The score on the earlier date
- The number of records that have moved out, or left the indicator since the earlier date
- The number of records that are shared by the indicator on both dates, meaning the records are in the indicator on both the earlier and later date
- The number of records that moved in, or were added to the indicator on the later date
- The number of records on the latest date
A list of records in the indicator is in the lower pane. If you are comparing dates, click the graph icon to open the Activity Stream. The Activity Stream shows, for each record, the fields most relevant to the latest activity on the record and its current state. Hovering the cursor over the timestamp of an activity reveals the Comment link. This link opens a dialog where you can leave either an Additional Comment or a Work Note.

### Activity Stream

#### When I send an email to the Sales group

- **Assigned to**: Abel Tuter
- **Resolution code**: Solved Remotely (Permanently)
- **Resolution notes**: Solved Remotely (Permanently)
- **Configuration item**: E-Commerce
- **Impact**: 3 - Low
- **Incident state**: Closed
- **Priority**: 5 - Planning

**PD pa.demo**  
2018-12-08 00:32:35  4d ago

#### my phone doesn’t ring

- **Assigned to**: Abel Tuter
- **Resolution code**: Solved (Permanently)
- **Resolution notes**: Solved (Permanently)
- **Configuration item**: Windows Mobile
- **Impact**: 3 - Low
- **Incident state**: Closed
- **Opened by**: Ted Bozelle
- **Priority**: 5 - Planning

**PD pa.demo**  
2018-12-08 00:21:54  4d ago

If the indicator is linked to a benchmark indicator, select **Benchmarks** to compare the two indicators. Select a date range for comparing the indicators as you would in the **Overview** tab.
Comparing the indicator to a linked benchmark indicator

Related information
- Link an automated indicator to a benchmark

Analytics Hub UUIDs

Every combination of breakdowns, elements, a time series aggregation, and a domain that you specify for an indicator has a unique identifier (UUID). To write scripts or just to understand how the Analytics Hub works, you should understand how these UUIDs are constructed.

In the Analytics Hub and the workspace KPI Details, you select an indicator and can specify it further by the following:

- Up to two levels of breakdown
- Element filter
• Up to two levels of breakdown element, including multiple elements per level (aggregate score)
• A time series aggregation
• Domain separation

Each combination is represented by a so-called UUID. The UUID is concatenated from the sys_IDs of the indicator and any of these specifiers, in the following order (note the semicolon before the domain id):

<indicator_sys_id>:<breakdown_sys_id>:<elements_filter_sys_id or element_sys_ids>:<lvl-2 breakdown_sys_id>:<lvl-2 elements_filter_sys_id or element_sys_ids>:<aggregate_sys_id>;<domain_sys_id>

All specifiers other than indicator_sys_id are optional, with one exception: If a breakdown_sys_id is specified, so must be at least one element_sys_id. To specify a breakdown and not specify elements, for example to get a list of all elements, the breakdown sys_id goes in a separate parameter. For an example, see this GET/now/pa/scorecards REST API example. To refer to those scores that do not match any elements of the specified breakdown, the string unmatched goes in place of an element_sys_id.

Targets, thresholds, and other Analytics Hub and KPI Details functions apply per UUID. In other words, they apply separately to each unique combination of indicator, breakdowns, elements and element filters, time series aggregation, and domain. The KPI Signals application also monitors each fully specified indicator separately, per UUID.

Related information
Integrate Performance Analytics
KPI Details

Performance Analytics targets and thresholds
Targets and thresholds enable you to define important points in your data and provide notifications when a score reaches a specific point.

Create your first target and threshold

Performance Analytics targets
Targets are goals your organization wants to achieve. Targets show the difference between the desired score at a certain date and the actual score of an indicator.

A target can be personal or global. A personal target is visible only to the user that created it and appears as a light line. A global target is visible to all users
and appears as a dark line. Because you cannot share a personal target, it appears only on the Analytics Hub and KPI Details. Global targets also appear on time series widgets, if the widget is so configured.

Create or edit targets
You can set target values for indicators. You can have the targets apply only to specific breakdown elements and time series. The target starts to apply at a selected date and continues to apply until you set the next target. However, you can set a review date on which to reconsider the target.

Before you begin
Role required: pa_target_admin to create global targets that are visible to all users. Any user who can view an indicator on the Analytics Hub or KPI Details can view targets and create personal targets.

Procedure
1. Either:
   - Open the Analytics Hub for an indicator.
   - If you are working in Now® Experience workspaces or applications, open KPI Details for an indicator. For more information, see Create a target in KPI Details.

2. To limit the target to a subset of the scores, select a breakdown and a breakdown element.
You can also select a 2nd-level breakdown and element.

3. Select a time aggregation if the target should apply only to a specific time series, such as 7-day SUM. For more information, see Applying time series aggregations.

4. Click the Target icon (⁺). The Targets panel opens.

5. In the Targets panel, select either Global or Personal targets. You see all the existing Global or Personal targets on this indicator that apply to whichever breakdown elements or time series you selected. You can select and deselect breakdown elements or a time series interactively, and the list of targets updates.

6. Either create a new target or edit or delete an existing target:
   - To create a target, click the + plus sign.
   - To edit an existing target, click it in the Targets panel.
   - To delete an existing target in the Analytics Hub, click the delete icon.

7. Enter the target value for the score. Either:
   - Enter an absolute value in Target, or
   - Select Set target as an improvement of the baseline. If you select this option, the following fields become available:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Calculation</td>
<td>Select either a percentage improvement or a number of units of the indicator to improve by.</td>
</tr>
<tr>
<td>Direction</td>
<td>When the indicator has a defined direction, this field is read-only. If the indicator direction changes, this field changes. Targets are recalculated accordingly.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>If the indicator does not have a direction, you can set a direction on the target here. However, usually it is better to define a direction on the indicator. For example, the score color that indicates an improvement or a deterioration works only when a direction is defined on the indicator.</td>
<td></td>
</tr>
<tr>
<td>Percentage/Units of the KPI</td>
<td>Enter either the percentage or the number of units of the KPI that you want as the targeted change to the baseline.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Decide whether the improvement applies against the existing target or against the average value for the date range selected in the Analytics Hub. Another target must already exist to select Existing Target. For more information about the date range, see Date range.</td>
</tr>
<tr>
<td>Baseline value</td>
<td>Read-only calculated value that serves as the basis for the target.</td>
</tr>
<tr>
<td>Target</td>
<td>This value is calculated from the baseline and the target calculation. You can adjust this value, for example to change a decimal value to a whole number for a count. If you adjust the target, the Percentage/Units of the KPI are recalculated.</td>
</tr>
</tbody>
</table>

8. Select a start date.  
   You can set a date in the future.

9. Select a review date.  
   The target applies from the selected start date until the start date of the next target, if any. If you do not define a later target, the target applies indefinitely. Thus, the review date serves as a reminder to consider changing the target. Whether or not you change the target value after review, consider selecting a new, future review date.
Note: Overlapping targets are not allowed. Only one target at a time can be active.

10. Click Save.

Example: Creating, reviewing, and editing a target

Here we are going to look at the more advanced target features. Let's say it's July 1 and your Number of Open Incidents varied regularly from late May until mid-June, with a gradual downward trend. Then it started going up and down wildly, but the overall trend is still downward.

As an incident manager, you want the number of open incidents to go down. You are not sure from your scores on a good target to set. However, the numbers look reliable up to mid-June, so a 10% decrease in the average score up to that point seems reasonable. So you create a new global target for your team. You select a date range up to June 15, and you set a 10% decrease on
the average for that period as your target. You decide to start the target today and evaluate it on July 15.

**Field settings of first target**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Calculation</td>
<td>Percentage (%)</td>
</tr>
<tr>
<td>Percentage</td>
<td>10</td>
</tr>
<tr>
<td>Baseline</td>
<td>Average score for the selected date range (only choice, because no older target was set)</td>
</tr>
<tr>
<td>Target</td>
<td>Originally calculated as 202.5. Since the incident count can only be a whole number, you decide to round off this value to 203.</td>
</tr>
<tr>
<td>Start/End date</td>
<td>July 1/July 15</td>
</tr>
</tbody>
</table>
July 15 comes around, and your team has exceeded all expectations —Or your customers are all on holiday and not reporting incidents.
In any case, the number of open incidents is far below your target.

You now have several options:

- Edit the existing target. Set a new target value and a new review date, for example 160 and August 15.

- Create another target. The old target ceases to apply on the date the new target starts. The new target could again be an improvement of the baseline. You have the option of setting the old target as the baseline for the new target.

**What to do next**

Select which users receive notifications. Notifications are sent when a target is achieved or is expected to be achieved within 14 days. For more information, see the section "Configure which users receive a target notification."
Related information

KPI Details

Create a target color scheme
A target color scheme can be used to visualize the position of the indicator score relative to its target.

Before you begin
Role required: pa_admin, pa_power_user, or admin

About this task
For example, if you want to filter the number of open incidents, the scores for an increase of 25% can be shown in red, an increase of 10% in orange, and no change in yellow. Whereas, for example, a decrease by 25% can be shown in dark green. Two target color schemes are available in Performance Analytics by default: the 3-color traffic light and the 5-color traffic light.

Note: You can only set a color scheme for a global target, not a personal target.

Procedure
1. Navigate to Performance Analytics > System > Target Color Schemes.
2. Click New.
3. Enter a Name and a Description.
4. Define each of the five ranges and their associated colors. If you do not want to use all the ranges, you can use the same range color for multiple range limits.
5. Click Submit.

A Default indicator target color scheme can be set in Performance Analytics > System > Properties. This is used when no color scheme has been selected for an indicator target.

Add a target for all elements of a breakdown
You can specify a target that applies separately to each subset of data for an indicator with a breakdown.

Before you begin
Role required: pa_target_admin or admin
About this task
For example, you can set a target on an Incident indicator that applies separately to the scores for each assignment group.

Note: This functionality is available only for global targets. The Any element check box does not appear for personal targets.

Procedure
1. Navigate to Performance Analytics > Targets.
2. Select the Indicator you want to set the target for.
3. Select a Breakdown.
   The Any element check box is selected by default. Do not clear this check box.
4. Optional: Select a Time series.
   For example, you can measure closed incidents daily and set monthly targets for closed incidents.
5. Optional: Select a Color scheme for the target.
6. Click Submit.

What to do next
Define target values for the new target.

Configure which users receive a target notification
You can control which users receive a notification when a target is achieved. Notifications are also sent when it appears that a target will be achieved within the next 14 days.

Before you begin
Role required: pa_target_admin

About this task
This functionality applies to global targets only. For personal targets, the target owner automatically receives notifications.

Procedure
1. Navigate to Performance Analytics > Targets.
2. Select a target.
3. In the Users related list, click Edit.
4. Move the users that you want to notify from the **Collection** column to the **Users List** column.

5. Click **Save**.

**What to do next**
The notification is sent automatically when a target is reached. Users that receive a notification can unsubscribe from that notification.

**Related information**

**Notifications**

**Add, modify, or delete a target or threshold**
Performance Analytics administrators can add, modify, or delete global targets and thresholds as well as personal targets and thresholds for all users.

**Before you begin**
Role required: pa_admin

**About this task**
Personal targets and thresholds are visible on the Analytics Hub and KPI Details only to the user that created them. On the indicator record, you can create personal targets and thresholds for other users, or modify and delete existing targets and thresholds that other users have created.

**Procedure**

1. Navigate to **Performance Analytics > Automated Indicators, Manual Indicators, or Formula Indicators**.

2. Select the indicator for which you want to add, modify, or delete a target or threshold.

3. Use the **Targets** or **Thresholds** related lists to add, modify, or delete targets or thresholds.
   The related lists display both personal and global targets and thresholds. When you create a new personal target or threshold, ensure that the **Owner** field is populated.

**Performance Analytics thresholds**
Thresholds define a normal range of scores for an indicator and alert you when certain events occurs, such as when a score reaches an all-time high or low.

When a threshold is triggered the instance generates an email notification. This message is associated with the indicator and the message is directly available via the detailed Analytics Hub.
A threshold can be personal or global. A personal threshold is visible only to the user that created it and appears as a light grey dotted line, a global threshold is visible to all users and appears as a dark grey dotted line. Personal thresholds appear only on the Analytics Hub and KPI Details. Global thresholds also appear on time series widgets, if the widget is so configured.

Create or edit a threshold
Create a threshold to define the range of scores considered normal.

Before you begin
Role required: pa_power_user or admin

About this task
Thresholds can be set for any indicator. You can specify a breakdown and element combination that a threshold applies to. On the Analytics Hub, you can also specify a time series aggregation.

Procedure
1. Either:
   - Open the Analytics Hub for an indicator.
   - If you are using workspaces, open KPI Details on a workspace for an indicator.
2. To limit the threshold to a subset of the scores, select a breakdown and a breakdown element. You can also select a 2nd-level breakdown and element.
3. On the Analytics Hub only, you can select a time series aggregation if the threshold should apply only to a specific aggregation of the data.
4. Click the threshold icon ( ).
   The Thresholds panel opens.
5. In the Thresholds panel, select either a Global or a Personal threshold. Personal thresholds are visible only to you, although users with the admin role can edit or delete them. Personal thresholds are not visible on widgets.
6. Either create a new threshold or edit or delete an existing threshold:
   - To create a threshold, click the plus + sign.
   - To edit an existing threshold, click it in the Thresholds panel.
To delete an existing threshold in the Analytics Hub, click the delete icon.

To delete an existing threshold in KPI Details, open it for editing and click **Delete**.

7. If you are creating or editing a threshold, select the condition that triggers the threshold notification.
   The condition can be when the score reaches an all-time high, or when the score falls lower than a specific value.

8. Click **Save**.

**What to do next**
After you create a threshold, set up threshold notifications.

**Related information**

**KPI Details**

**Configure which users receive a threshold notification**
Configure which users should receive an email when a threshold is reached.

**Before you begin**
Role required: pa_admin, pa_power_user, or admin

**About this task**
This procedure applies to global thresholds. Notifications for personal thresholds are sent only to the owner of the threshold. To configure the message content, modify the PA Threshold Reached notification. See the Notifications documentation for more information.

**Procedure**

1. Navigate to **Performance Analytics > Indicators > Thresholds**.
2. Open a threshold.
3. In the **Users** related list, click **Edit**.
4. In the Edit Members screen, use the slushbucket to add members.
5. Click **Save**.
   Besides the notifications for each indicator, you can also send notifications with an overview of all indicators for which the threshold is reached.

**Configure the threshold comment**

The Check PA Thresholds job triggers the PA threshold reached comment script action, which adds a comment for the indicator that has reached the threshold.

**Before you begin**
Role required: admin

**About this task**

The comment is displayed when you open the Analytics Hub for the indicator. Configure the threshold comment to display different text.

**Procedure**

1. Navigate to **System Policy > Events > Script Actions**.
2. Open **PA threshold reached comment**.
3. Modify the `buildMessage` function within the script.
4. Click **Update**.

**Configure threshold overview notifications**

Besides the notifications for each indicator, you can also send notifications with an overview of all indicators for which the threshold is reached.

**Before you begin**
Role required: pa_admin, pa_power_user, or admin

**About this task**

This procedures describes how to access the summary notification and change the users who receive the notification as well as the content of the notification.

**Procedure**

1. Navigate to **System Policy > Email > Notifications**.
2. Select **PA Thresholds Notification**.
3. **Optional**: Add users or groups to the **Who will receive** section by clicking the lock icon for either **Users** or **Groups** and then selecting the appropriate users or groups.
4. **Optional:** Change the content of the message by modifying the **Message** field.

5. Click **Update**.

**Add, modify, or delete a target or threshold**

Performance Analytics administrators can add, modify, or delete global targets and thresholds as well as personal targets and thresholds for all users.

**Before you begin**

Role required: pa_admin

**About this task**

Personal targets and thresholds are visible on the Analytics Hub and KPI Details only to the user that created them. On the indicator record, you can create personal targets and thresholds for other users, or modify and delete existing targets and thresholds that other users have created.

**Procedure**

1. Navigate to **Performance Analytics > Automated Indicators**, **Manual Indicators**, or **Formula Indicators**.

2. Select the indicator for which you want to add, modify, or delete a target or threshold.

3. Use the **Targets** or **Thresholds** related lists to add, modify, or delete targets or thresholds.

   The related lists display both personal and global targets and thresholds. When you create a new personal target or threshold, ensure that the **Owner** field is populated.

**Performance Analytics widgets**

Widgets enable you to define visualizations for indicator scores. Widgets are shown on dashboards.

A Performance Analytics widget ties an indicator to a visualization, such as a trend line, a set of columns, or a pie chart. Within the widget, you can filter or group indicator scores by breakdowns. You can also apply time series functions, such as 7-day sums, to the scores.

To create or edit a Performance Analytics widget, the user must have the pa_admin or pa_power_user role. These roles are also required to add widgets to a dashboard. However, any user can view a widget that has been added to a dashboard.
Note: If a user is prevented from viewing a visualization, a warning message prompts the user to contact the administrator.

If the dashboard is so configured, you can select breakdown elements on the dashboard that apply to all the widgets on the dashboard. If you click a score in a widget on a dashboard, you open the Analytics Hub focused on that indicator.

Note: Time series aggregations are validated on the Analytics Hub and in KPI Details but not in widgets. Therefore, you might navigate from a working widget to the Analytics Hub and get a warning that the indicator has an invalid aggregation.

Rounding off

Values between 10,000 and 999,999 are rounded off to the nearest thousand and abbreviated with a K, such as 11K for 11,234. Values between 1 million and 999,999,999 are rounded off to the nearest million and abbreviated with an M. Values of 1 billion and higher are rounded off to the nearest billion and abbreviated with a G.

Rounded calculations based on averages may be off by a small amount due to rounding errors.

Widget types and creation details

The first step in creating a widget is to select the type of widget to create. Base this decision on the business goals you are trying to achieve with the widget.

<table>
<thead>
<tr>
<th>Widget type</th>
<th>Purpose</th>
<th>Typical Visualizations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Series widget</td>
<td>Shows changes over time in indicator scores.</td>
<td>Line visualization is the most usual. Other visualizations are: spline, step, column, stacked column, area, and relative compare.</td>
</tr>
<tr>
<td>Breakdown widget</td>
<td>Groups indicator scores by the elements of a breakdown.</td>
<td>Scorecard, pie and similar charts, funnel and pyramid, column and similar charts, relative compare, line, Pareto, pivot scorecard, and treemap.</td>
</tr>
<tr>
<td>Score widget</td>
<td>Shows aggregate indicator scores. Can show an indicator score against a target.</td>
<td>Latest score, speedometer, real-time score.</td>
</tr>
<tr>
<td>Widget type</td>
<td>Purpose</td>
<td>Typical Visualizations</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>List widget</td>
<td>Lists the metrics for several indicators.</td>
<td>Scorecard, spider web.</td>
</tr>
<tr>
<td>Pivot widget</td>
<td>Groups the scores of one indicator by the elements of two breakdowns.</td>
<td>Heatmap</td>
</tr>
<tr>
<td>Text analytics</td>
<td>Visualizes word frequencies and groupings in the text that users enter in forms</td>
<td>Word cloud</td>
</tr>
<tr>
<td>Workbench widget</td>
<td>Shows multiple indicators and their relations, to monitor a workflow or other process.</td>
<td>Workbench</td>
</tr>
</tbody>
</table>

**Security requirements for viewing widgets**

Starting with Quebec, widgets follow indicator and breakdown access control lists (ACLs). Outside of ACLs, no roles are required for viewing widgets.

However, if you upgrade an instance from a version earlier than Quebec, by default the pre-Quebec rules still apply. Indicator and breakdown ACLs are followed only in these areas:

- List widgets follow indicator ACLs.
- When viewing breakdowns, breakdown ACLs apply.

Furthermore, on an upgraded instance, the following widgets may require users to have the pa_viewer role:

- List widgets
- Text widgets
- The Breakdowns section of Workbench widgets

Upgraded instances cannot automatically follow the rules introduced in Quebec because of the variation in how ACLs are configured.
Time series widgets

Time series widgets show changes in an indicator score over time. Different visualizations emphasize the trend in the scores or the scores themselves, and can display one indicator or compare several indicators.

A time series is an ordered sequence of metrics taken continuously over time. Indicator scores are measured over time at uniform intervals, which makes them an appropriate subject for time series widgets. The following business cases are some of the uses of a time series widget:

- Identifying trends, patterns, and outliers in indicator scores.
- Identifying turning points, such as whether a change in policy led to a change in indicator scores.
- Evaluating the relationships between indicators.

When you are selecting a visualization for a time series, consider whether you want to emphasize the trend in the scores or specific changes in the scores. Also consider whether you want to show one indicator or compare several related indicators.

**Note:** Some visualizations of other widget types include a time series. For example, the breakdown widget visualizations Stacked Column and Columns and Total include a time series of the indicator scores.

<table>
<thead>
<tr>
<th>Time series widget visualizations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Visualization</strong></td>
</tr>
<tr>
<td>Visualizing trends in the scores of an indicator</td>
</tr>
<tr>
<td>Line</td>
</tr>
<tr>
<td>Spline</td>
</tr>
</tbody>
</table>
Time series widget visualizations (continued)

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Comparing scores in an indicator</strong></td>
<td></td>
</tr>
<tr>
<td>Column</td>
<td>Shows changes between scores over time by displaying them as proportional vertical columns. Use either to visualize score changes in one indicator or to compare indicators. To compare indicators with a column visualization, either add indicators to the widget, or place several column visualization widgets next to each other in a dashboard.</td>
</tr>
<tr>
<td>Step</td>
<td>Emphasizes changes in indicator scores between discreet points in time. Use to show small incremental changes in scores, especially when a line visualization smudges the data.</td>
</tr>
<tr>
<td><strong>Comparing scores or trends between indicators</strong></td>
<td></td>
</tr>
<tr>
<td>Stacked Column</td>
<td>Each column is divided into a stack of slices representing different indicators. Use when you want to see the cumulative result of multiple indicators.</td>
</tr>
<tr>
<td>Area</td>
<td>Resembles a line visualization, but the area between the axis and line is emphasized with colors. Use with multiple indicators to highlight the relative contribution that each indicator makes to the whole.</td>
</tr>
<tr>
<td>Relative Compare</td>
<td>Shows how multiple indicators diverge over time.</td>
</tr>
</tbody>
</table>

**Considerations when creating a time series widget**

To create a time series widget that fulfills your business goal, keep several points in mind.

When you are creating a time series widget, consider the following points:

- To show a filtered set of scores in a time series widget, apply a breakdown to the widget. Only the scores that match the specified element of the breakdown will appear.
- To show aggregated scores, such as a seven-day average or a sum, apply a time series to the widget.
• To show the scores of secondary indicators over the same time line, add widget indicators to an existing widget. For more information, see Add widget indicators.

• When you are selecting a visualization for a time series, consider whether you want to emphasize the trend in the scores or specific changes in the scores. Also consider whether you want to show one indicator or compare several related indicators.

• Rounded calculations based on averages may be off by a small amount due to rounding errors.

Create a line visualization for a time series widget

To show the trend over time in indicator scores, create a time series widget with a line visualization.

Before you begin
Role required: pa_power_user or admin

About this task
Line visualization is the simplest way to show the trend over time in the scores of a single indicator. Consider it the default visualization for a time series. If you are unsure which visualization to use for a time series, use a line.

The following example is a line visualization of the number of open incidents over the month of July. The Show trend optional display setting has been enabled.

Procedure
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Time series.
If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Line**.

5. In the **Indicator** field, select the main indicator for which you want to show scores.

6. Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the <strong>Elements Settings</strong> tab. Use elements filters for creating personal visualizations. For more information, see Additional settings for time series widgets.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Field | Description
--- | ---
 | as a 7-day sum or average. For more information, see Applying time series aggregations.

Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.

Previous period chart | Compares the scores of the main indicator in similar periods.
The Column visualization works well for previous period charts. Also consider setting a Color scheme.
Activating Previous Period Chart disables any secondary Widget Indicators.

Label | Specifies a custom label for the main indicator.

Color | A single color that applies only to the scores for the main indicator. This field overrides any color selected in Color scheme.

Color scheme | A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

a. Select Follow element.
Selecting this option removes the ability to set a second breakdown and element on the widget.
b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown.** Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown.**

c. **In Show multiple elements as,** select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation. Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see **Showing multiple elements separately or aggregated.**

**Important:** Do not specify a breakdown and element on the widget record when you want the elements for that breakdown to be selected on a breakdown dashboard. The element on the widget record overrides any elements selected on the breakdown dashboard for that breakdown.

8. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see **Additional settings for time series widgets**

9. Click **Submit.**

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Considerations when creating a time series widget
- Create a line visualization for a breakdown widget
Create a column visualization for a time series widget

To emphasize the indicator scores over time instead of the trend in scores, create a time series widget with a column visualization. You can also use column visualizations to compare indicators.

Before you begin
Role required: pa_power_user or admin

About this task
If you want to emphasize indicator scores instead of the trend in scores over time, use a column visualization. Column visualizations are also useful for comparing the scores of several indicators. To compare indicators, add indicators to the widget, or place several widgets with column visualization next to each other in a dashboard.

Column visualization

To help see whether there is a correlation between two indicators, add a second indicator to the widget. For best results, select an indicator that has discreet values as the main indicator and a continuous set of data as the secondary indicator.
Procedure

1. Navigate to **Performance Analytics > Widgets** and click **New**.

2. In the **Name** field, give the widget a name that reflects the information being displayed.

3. In the **Type** field, select **Time series**.
   - If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Column**.

5. In the **Indicator** field, select the main indicator for which you want to show scores.

6. Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the Elements Settings tab. Use elements filters for creating personal visualizations. For more information, see Additional settings for time series widgets.</td>
</tr>
<tr>
<td>Important:</td>
<td>If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td>Note:</td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods.</td>
</tr>
<tr>
<td></td>
<td>The Column visualization works well for previous period charts. Also consider setting a Color scheme.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Activating Previous Period Chart</td>
<td>Activating Previous Period Chart disables any secondary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in Color scheme.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

   a. Select **Follow element**.

      Selecting this option removes the ability to set a second breakdown and element on the widget.

   b. Optional: Set which of the available breakdowns to follow in **Followed breakdown**.

      Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

      (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field Followed breakdown.
c. In **Show multiple elements as**, select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation. Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see **Showing multiple elements separately or aggregated**.

**Important:** Do not specify a breakdown and element on the widget record when you want the elements for that breakdown to be selected on a breakdown dashboard. The element on the widget record overrides any elements selected on the breakdown dashboard for that breakdown.

8. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see **Additional settings for time series widgets**

9. Click **Submit**.

**What to do next**

To compare your indicator to other indicators, perform one of the following actions:

- Add indicators to the Widget Indicators related list. Use the **Column** visualization for those indicators.
- Create widgets with **Column** visualizations for each of the other indicators. Place these widgets next to each other in a dashboard.

To view the widget, add it to a dashboard or a portal.

**Related information**

- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Add widget indicators
- Considerations when creating a time series widget

**Create an area visualization for a time series widget**

To examine the contribution of one or more indicators to a summing indicator, create a time series widget with an area visualization.

**Before you begin**

Role required: pa_power_user or admin
About this task
If you want to examine the contribution of one or more indicators to a more inclusive indicator, use an area visualization. An area visualization can emphasize the relative contribution of one or more component indicators to the total trend. At the same time, you can still see the individual trends. Compare to the Stacked Column visualization, which sums the indicator scores and emphasizes the contribution of each score to the sum.

Procedure
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Time series.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Area.
5. In the Indicator field, select the main indicator for which you want to show scores.
6. Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the <strong>Elements Settings</strong> tab. Use elements filters for creating personal visualizations. For more information, see <strong>Additional settings for time series widgets</strong>.</td>
</tr>
<tr>
<td>Important:</td>
<td>If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see <strong>Applying time series aggregations</strong>.</td>
</tr>
<tr>
<td>Note:</td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods. The <strong>Column</strong> visualization works well for previous period charts. Also consider setting a <strong>Color scheme</strong>.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activating Previous Period Chart</td>
<td>Enables primary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators.</td>
</tr>
</tbody>
</table>

### 7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

**a. Select Follow element.**

Selecting this option removes the ability to set a second breakdown and element on the widget.

**b. Optional:** Set which of the available breakdowns to follow in Followed breakdown.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field Followed breakdown.
c. In **Show multiple elements as**, select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation.

Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see **Showing multiple elements separately or aggregated**.

**Important:** Do not specify a breakdown and element on the widget record when you want the elements for that breakdown to be selected on a breakdown dashboard. The element on the widget record overrides any elements selected on the breakdown dashboard for that breakdown.

8. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see **Additional settings for time series widgets**

9. Click **Submit**.

**What to do next**

- To compare your selected indicator with other indicators, add indicators to the Widget Indicators related list. Select the **Area** visualization for those indicators.
- To view the widget, add it to a dashboard or a portal.

**Related information**

- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Considerations when creating a time series widget
- Add widget indicators

**Create a spline visualization for a time series widget**

To show the trend over time in indicator scores when you need to apply curve fitting, create a time series widget with a spline visualization.

**Before you begin**

Role required: pa_power_user or admin
About this task
A spline visualization replaces the straight line of a line visualization with a curve. As with a line visualization, use a spline visualization to show the trend over time in the indicator scores. Use a spline instead of a line when you need to fit a curve to your indicator scores.
In the following example, the trend line and 95% confidence interval is shown with a spline visualization of the number of open incidents.

Procedure
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Time series.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Spline.
5. In the Indicator field, select the main indicator for which you want to show scores.
6. Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>only scores that are not</td>
<td>associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>Note:</td>
<td>Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the Elements Settings tab. Use elements filters for creating personal visualizations. For more information, see Additional settings for time series widgets.</td>
</tr>
<tr>
<td>Important:</td>
<td>If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td>Note:</td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>The <strong>Column</strong> visualization works well for previous period charts. Also consider setting a <strong>Color scheme</strong>. Activating Previous Period Chart disables any secondary Widget Indicators.</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in <strong>Color scheme</strong>.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

   a. **Select Follow element.**

      Selecting this option removes the ability to set a second breakdown and element on the widget.

   b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.

      Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

      (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for
the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.

c. In **Show multiple elements as**, select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation. Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see **Showing multiple elements separately or aggregated**.

**Important:** Do not specify a breakdown and element on the widget record when you want the elements for that breakdown to be selected on a breakdown dashboard. The element on the widget record overrides any elements selected on the breakdown dashboard for that breakdown.

8. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see **Additional settings for time series widgets**.

9. Click **Submit**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Considerations when creating a time series widget

**Create a step visualization for a time series widget**
To emphasize changes in indicator scores between discreet points in time, create a time series widget with a step visualization.

**Before you begin**
Role required: pa_power_user or admin

**About this task**
Consider using a step visualization in the following circumstances:
• You want to emphasize the change in an indicator score between specific points in time, instead of the trend over time.

• The changes in indicator scores are too small to be easily seen in a line visualization.

The use case for a step visualization is the opposite of the use case for the spline visualization. Use a spline to emphasize a trend or the fuzziness of your data over time.

### Step visualization - time series

![Step visualization graph]

**Procedure**

1. Navigate to **Performance Analytics > Widgets** and click **New**.

2. In the **Name** field, give the widget a name that reflects the information being displayed.

3. In the **Type** field, select **Time series**.
   
   If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Step**.

5. In the **Indicator** field, select the main indicator for which you want to show scores.

6. Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>with any element of the breakdown are shown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the Elements Settings tab. Use elements filters for creating personal visualizations. For more information, see Additional settings for time series widgets.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Field | Description
--- | ---
The **Column** visualization works well for previous period charts. Also consider setting a **Color scheme**. Activating Previous Period Chart disables any secondary Widget Indicators.

**Label**
Specifies a custom label for the main indicator.

**Color**
A single color that applies only to the scores for the main indicator. This field overrides any color selected in **Color scheme**.

**Color scheme**
A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

**a. Select Follow element.**
Selecting this option removes the ability to set a second breakdown and element on the widget.

**b. Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.
Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for
the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.

c. In **Show multiple elements as**, select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation. Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see **Showing multiple elements separately or aggregated**.

**Important:** Do not specify a breakdown and element on the widget record when you want the elements for that breakdown to be selected on a breakdown dashboard. The element on the widget record overrides any elements selected on the breakdown dashboard for that breakdown.

8. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see **Additional settings for time series widgets**

9. Click **Submit**.

What to do next
To view the widget, add it to a dashboard or a portal.

Related information
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Considerations when creating a time series widget

Create a stacked column visualization for a time series widget
To compare and sum the scores of several indicators, create a widget as a time series with a stacked column visualization.

**Before you begin**
Role required: pa_power_user or admin

**About this task**
To show the sum of scores of several indicators over time, and to show the relative contribution of each indicator to the sum, use a stacked column visualization.
In the following example, indicators for each regional sales center are stacked in columns to show both the total sales and the relative contribution of each region.

Stacked column visualization - time series

Procedure

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Time series.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Stacked Column.
5. In the Indicator field, select the main indicator for which you want to show scores.
6. Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the <strong>Elements Settings</strong> tab. Use elements filters for creating personal visualizations. For more information, see <a href="#">Additional settings for time series widgets</a>.</td>
</tr>
<tr>
<td><strong>Important:</strong></td>
<td>If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see <a href="#">Applying time series aggregations</a>.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods. The <strong>Column</strong> visualization works well for previous period charts. Also consider setting a <strong>Color scheme</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Activating Previous Period Chart</td>
<td>Disables any secondary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in Color scheme.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

a. Select **Follow element**.
   
   Selecting this option removes the ability to set a second breakdown and element on the widget.

b. Optional: Set which of the available breakdowns to follow in **Followed breakdown**.
   
   Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.
   
   (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field Followed breakdown.
c. In **Show multiple elements as**, select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation. Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see *Showing multiple elements separately or aggregated*.

**Important:** Do not specify a breakdown and element on the widget record when you want the elements for that breakdown to be selected on a breakdown dashboard. The element on the widget record overrides any elements selected on the breakdown dashboard for that breakdown.

8. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see *Additional settings for time series widgets*.

9. Right-click the form header and select **Save**.

10. Add additional indicators in the Widget Indicators related list, giving each indicator the **Stacked Column** visualization.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Considerations when creating a time series widget
- Add widget indicators

**Create a relative compare visualization for a time series widget**
To show how the relative proportions of several indicators change over time, use a relative compare visualization for a time series.

**Before you begin**
Role required: pa_power_user or admin

**About this task**
Like a pie chart, a relative compare visualization shows relative proportions between data points, but it can also show how those proportions change over time. Traditional uses of relative compare visualizations are stock charts or
population growth trends. When you create a relative compare visualization, it uses a baseline of zero and then shows how the data changes over time. For example, this visualization shows the change of the total number of open incidents compared to the change in the number of open incidents that were not updated for 5 or more days. When you point to a line, the number of incidents and the percentage change for that day appear. The percentage change shown for a data point is calculated from a baseline of zero, not the previous data point as on most other time series visualizations.

Example of a relative compare visualization for a time series

![Graph showing relative compare visualization]

Procedure

1. Navigate to **Performance Analytics > Widgets**.
2. Click **New**.
3. From the **Type** list, select **Times Series**.
4. From the **Visualization** list, select **Relative Compare**.
5. Specify which indicators to include in the visualization with one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator group</td>
<td>If you select an indicator group, you cannot select a single indicator.</td>
</tr>
<tr>
<td>Indicator</td>
<td><strong>Warning:</strong> This option is not currently functional. Specify a single indicator and additional widget indicators.</td>
</tr>
<tr>
<td>Indicator</td>
<td>If you select a single indicator, you must manually add additional indica-</td>
</tr>
</tbody>
</table>
6. Fill in any of the following optional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the Elements Settings tab. Use elements filters for creating personal visualizations. For more information, see Additional settings for time series widgets.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Applying time series aggregations.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---

| Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar. |

7. Right-click the form header and select **Save**.

8. If you selected a single indicator, add additional indicators in the Widget Indicators related list. If you selected an indicator group, additional indicators are optional.

9. Select the **Show date range selector** check box on the **Date Settings** tab. This setting lets users dynamically change the amount of time displayed in the visualization.

10. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:
   
   a. Select **Follow element**. Selecting this option removes the ability to set a second breakdown and element on the widget.

   b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown**. Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

   (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.

   c. In **Show multiple elements as**, select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation.
Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see Showing multiple elements separately or aggregated.

**Important:** Do not specify a breakdown and element on the widget record when you want the elements for that breakdown to be selected on a breakdown dashboard. The element on the widget record overrides any elements selected on the breakdown dashboard for that breakdown.

11. Fill in the other fields, as appropriate.
12. Click **Update**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related reference**
- Additional settings for time series widgets

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Considerations when creating a time series widget
- Add widget indicators

**Additional settings for time series widgets**
Time series widgets have the following optional settings for display, for the date range, and for the axis labels. You can also use these setting to select an elements filter in place of a first-level breakdown element.

**Date settings**
The date settings are available only if **Previous period chart** is not selected.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period</td>
<td>Select the date range to display in the widget. Several options are available.</td>
</tr>
</tbody>
</table>
### Setting Description

- Select a specific time range. The default is **3m** (3 months).
- Select **max** to use scores up to the current date.
- Select **between** and then fill in the **From** and **To** fields to define a time period.

The **Period** field is available with only the following visualizations:

- Line
- Spline
- Column
- Area
- Step
- Stacked Column
- Relative Compare

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show date range selector</td>
<td>Display a date range selector on the widget. Users can then change the selected period when viewing the widget on a dashboard.</td>
</tr>
</tbody>
</table>

**Note:**
- Selecting a date range on a widget does not update the trend line.
- If you combine a time series aggregation such as **By month SUM** with a date range selector, the user may see one more time period than they expect. The instance interprets a period such as **3 m** as 0-3 months and may show four months of scores.

### Axis settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y-axis title</td>
<td>Specify a title to display on the vertical axis of the chart.</td>
</tr>
<tr>
<td>Y-axis from</td>
<td>Specify the starting point for the range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Y-axis to</td>
<td>Specify the ending point for the range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td>2nd Y-axis title</td>
<td>Specify a secondary title to display on the vertical axis of the chart.</td>
</tr>
<tr>
<td>2nd Y-axis from</td>
<td>Specify the starting point for a 2nd range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td></td>
<td>The 2nd Y-axis can be used if scores normally move between a limited range, but you have some exceptions that would otherwise distort the chart. For example, scores normally lie from 40 through 60, but there is an exception of 1000.</td>
</tr>
<tr>
<td>2nd Y-axis to</td>
<td>Specify the ending point for a 2nd range of values for the vertical axis of the chart.</td>
</tr>
</tbody>
</table>

**Display settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show target</td>
<td>Display the target score, if defined. This field appears only if <em>Previous period chart</em> is not selected.</td>
</tr>
<tr>
<td>Show thresholds</td>
<td>Display thresholds such as an all time high or an all time low. Thresholds appear only if they have been defined for this indicator.</td>
</tr>
<tr>
<td>Show data labels</td>
<td>Display the score for each data point, such as each slice of a pie chart.</td>
</tr>
<tr>
<td>Show trend</td>
<td>Display the trend line. This field appears only if <em>Previous period chart</em> is not selected.</td>
</tr>
<tr>
<td>Show confidence bands</td>
<td>Display confidence bands in this chart. For information about how the confidence band is calculated, see <em>Widget confidence bands</em>.</td>
</tr>
<tr>
<td>Show forecast</td>
<td>Display forecast data in the chart based on current trend data. Forecasting must be configured on the indicator.</td>
</tr>
</tbody>
</table>
### Element settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elements filter</td>
<td>Specify an element filter in place of the first-level breakdown element. Use an elements filter to personalize which elements appear according to the characteristics of the viewer. For example, you can filter elements of the Assignment Group breakdown to show only the groups to which the viewer belongs. For more information, see <a href="#">Personalized visuals</a>.</td>
</tr>
</tbody>
</table>

### Previous Period settings

Previous period settings are available only if [Previous period chart](#) is selected.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range of periods</td>
<td>Select the range of periods to compare with the current period.</td>
</tr>
<tr>
<td>Number of periods</td>
<td>Specify the number of previous periods to display.</td>
</tr>
</tbody>
</table>

### Widget confidence bands

The visible points of the trend line are used to calculate the confidence band. If you increase the date range, the bands are recalculated using the trend for the new date range.

First, the confidence bands are calculated using the standard error of the trend. The width of the band depends on the number of points that are included in the calculation and the mean of the scores. If the standard error is low, the trend line is shown to be accurate. As the number of points decreases, or outliers are recorded, the confidence band widens. The confidence of the trend is less certain with fewer data points or with volatile scores.
Score widgets

Score widgets show aggregate indicator scores.

Score widget visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest score</td>
<td>Shows a single indicator score and the change in that score compared to a previous period. A line representing the time series of scores appears in the background.</td>
</tr>
<tr>
<td>Speedometer</td>
<td>Shows the most recently collected score of an indicator in the form of a round meter. The indicator target and its color scheme are shown on the dial.</td>
</tr>
<tr>
<td>Dial</td>
<td>Shows an overview of the most recently collected score of an indicator in a half circle.</td>
</tr>
<tr>
<td>Real-time score</td>
<td>Shows the current indicator score and the change in that score compared to the score at the last scheduled collection. A line representing the time series of scores appears in the background.</td>
</tr>
</tbody>
</table>

Create a latest score visualization for a score widget

To see the change between the latest score and a previous score, use a latest score visualization in a score widget. You can also show a trend line of scores.

Before you begin

Role required: pa_power_user or admin

About this task

A latest score visualization shows the latest score and both the absolute and percentage change between this score and a previous score. This visualization is similar to a Chart view in an Analytics Hub. You can choose how many scores back to compare to the latest score. You can also display a trend line of absolute or percentage changes in scores.
Procedure

1. Navigate to Performance Analytics > Widgets and click New.

2. In the Name and Subtitle fields, give the widget a name and subtitle that reflect the information being displayed.

3. In the Type field, select Score.
   If you change the value of Type after you fill in other fields, those fields are cleared.

4. In the Visualization field, select Latest score.

5. In the Indicator field, select the indicator for which you want to show scores.

6. Fill in any of the following optional fields:

   Optional fields in score widgets

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the <strong>Elements Settings</strong> tab. Use elements filters for creating personal visualizations. For more information, see Additional settings for time series widgets.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
</tbody>
</table>

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:
a. Select **Follow element**.

Selecting this option removes the ability to set a second breakdown and element on the widget.

b. Optional: Set which of the available breakdowns to follow in **Followed breakdown**.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.

⚠️ **Note:** Record watcher is not supported on Score widgets when multiple elements are selected on a breakdown dashboard. In this case, real time is refreshed only on page refresh.

For more information, see Configure widgets for breakdown dashboards.

8. Optional: Select a template.

<table>
<thead>
<tr>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template 1</td>
<td>Line shows absolute change in score.</td>
</tr>
<tr>
<td>Template 2</td>
<td>Line shows percentage change in score.</td>
</tr>
<tr>
<td>Template 3</td>
<td>Line is not displayed.</td>
</tr>
</tbody>
</table>

Formula indicators that return a percentage value use Template 2 by default. Other indicators use Template 1 by default.

9. In the **Latest score settings** tab, select which previous score to compare against the latest score in the **Compare score with** field:

<table>
<thead>
<tr>
<th>Previous score</th>
<th>The score from the previous data collection. This setting is the default.</th>
</tr>
</thead>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
10. In the **Element Settings** tab, you can select an element filter instead of selecting a specific element in the **Element** field. Use this approach to personalize which breakdowns are shown depending on the viewer. For more information about using element filters to personalize widgets, see **Personalized visuals**.

11. Click **Submit**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- View scores and statistics

**Create a speedometer or a dial visualization for a score widget**
To show the latest score of an indicator compared to the range of scores, use a speedometer or dial visualization in a score widget. A speedometer also shows the indicator target.

**Before you begin**
Role required: pa_power_user or admin

**About this task**
A speedometer visualization shows the latest score with a needle on a speedometer. A dial visualization shows the latest score with a colored in section of a half-circle. By default, the speedometer or dial shows the range of possible scores, but you can create your own range.

The speedometer is particularly useful when a target is set on the indicator. If a direction is set on the indicator (minimize or maximize), the visualization reproduces the target and the 3- or 5-color traffic light set on the indicator. For example, the following speedometer shows the Average age open incidents indicator with a Minimize direction, a target of 10, and a 3-color traffic light.

To create a target color scheme, see **Performance Analytics targets**.
The dial visualization does not show the indicator target.

Procedure
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Score.
If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Speedometer** or **Dial**.

5. In the **Indicator** field, select the indicator for which you want to show scores.

6. **Optional:** Fill in any of the following optional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
</tbody>
</table>

**Note:** Instead of specifying an element for the first-level breakdown, you can specify an elements filter in the **Elements Settings** tab. Use elements filters for creating personal visualizations. For more information, see Additional settings for time series widgets.

| 2nd Breakdown and Element    | Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.                             |

| Time series                  | Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>information, see Applying time series aggregations.</td>
</tr>
<tr>
<td></td>
<td>Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
</tbody>
</table>

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

   a. Select **Follow element**.
      Selecting this option removes the ability to set a second breakdown and element on the widget.

   b. Optional: Set which of the available breakdowns to follow in **Followed breakdown**.
      Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.
      (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.
      
      ✪ Note: Record watcher is not supported on Score widgets when multiple elements are selected on a breakdown dashboard. In this case, real time is refreshed only on page refresh.
      
      For more information, see Configure widgets for breakdown dashboards.

8. Optional: In the **Speedometer/Dial Settings** tab, either select Auto scale, which shows the range of actual scores on the speedometer, or specify another scale.

9. In the **Element Settings** tab, you can select an element filter instead of selecting a specific element in the **Element** field.
Use this approach to personalize which breakdowns are shown depending on the viewer. For more information about using element filters to personalize widgets, see Personalized visuals.

10. Click Submit.

What to do next
To view the widget, add it to a dashboard or a portal.

Related information
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Performance Analytics targets

Create a real-time score visualization for a score widget
To see the current score, use a real-time score visualization in a score widget. You can also show a trend line of scores.

Before you begin
- The indicator for which you want the real-time scores must have the Show real-time score property enabled.
- Role required: pa_power_user or admin

About this task
A real-time score visualization shows the current score and both the absolute and percentage change between this score and the score at the last previous scheduled data collection. The score is calculated when a dashboard user opens a dashboard that contains the widget. This visualization is similar to a Chart view in an Analytics Hub. You can also show a trend line of absolute or percentage changes in scores.

For more information, see Real-time scores.

⚠️ Warning: Real-time scores can differ per viewer and differ from collected scores. Real-time scores are taken directly from the relevant facts tables. Therefore, the Access Control Lists (ACL) of those facts tables determine the real-time scores that each logged-in user sees.

ℹ️ Note: If the widget has too many data elements, it cannot update in real time. In this case, a message appears that instructs the viewer to refresh the widget manually.
Procedure

1. Navigate to Performance Analytics > Widgets.
2. Click New.
3. In the Name and Subtitle fields, give the widget a name and subtitle that reflect the information being displayed.
4. In the Type field, select Score.
   If you change the value of Type after you fill in other fields, those fields are cleared.
5. In the Visualization field, select Real-time score.
6. In the Indicator field, select the indicator for which you want to show scores.
7. Optional: Fill in any of the following optional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
</tbody>
</table>
8. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

a. Select **Follow element**.

Selecting this option removes the ability to set a second breakdown and element on the widget.

b. **Optional**: Set which of the available breakdowns to follow in **Followed breakdown**.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.
Note: Record watcher is not supported on Score widgets when multiple elements are selected on a breakdown dashboard. In this case, real time is refreshed only on page refresh.

For more information, see Configure widgets for breakdown dashboards.


<table>
<thead>
<tr>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template 1</td>
<td>Line shows absolute change in score.</td>
</tr>
<tr>
<td>Template 2</td>
<td>Line shows percentage change in score.</td>
</tr>
<tr>
<td>Template 3</td>
<td>Line is not displayed.</td>
</tr>
</tbody>
</table>

Real-time score visualizations use Template 2 by default.

10. In the Element Settings tab, you can select an element filter instead of selecting a specific element in the Element field. Use this approach to personalize which breakdowns are shown depending on the viewer. For more information about using element filters to personalize widgets, see Personalized visuals.

11. Click Submit.

What to do next
To view the widget, add it to a dashboard or a portal.

Related information
- Edit a responsive dashboard
- Real-time scores
- Performance Analytics widgets on Service Portal
- Create an automated indicator

List widgets
List widgets show the scores of multiple indicators.
**List widget visualizations**

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scorecard     | For several indicators, shows any of the following attributes:  
  - Scores at several points in time  
  - Changes between the last two scores  
  - % Change  
  - Trends  
  - Bullet charts |
| Spider        | Shows a plot of the latest score of each indicator on its own axis, starting with 0 at the center. |

**Permission to view indicators**

On upgraded instances, you might need the pa_viewer role to view List widgets. Furthermore, List widgets do not show indicators that you do not have permission to read.

**Create a scorecard visualization in a list widget**

To list the metrics of several indicators, use a scorecard visualization in a list widget.

**Before you begin**

Role required: pa_power_user or admin

**About this task**

Use this visualization to help compare several similar indicators regarding their scores, the trend in their scores, and their compliance with targets.

---

**Scorecard visualization - list widget**

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Aug 11</th>
<th>Aug 12</th>
<th>Score</th>
<th>Target</th>
<th>Gap</th>
<th>Gap %</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of new incidents</td>
<td>24</td>
<td>25</td>
<td>3</td>
<td>50</td>
<td>47</td>
<td>94.0%</td>
<td></td>
</tr>
<tr>
<td>Number of closed incidents</td>
<td>24</td>
<td>18</td>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of open incidents</td>
<td>202</td>
<td>133</td>
<td>380</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Procedure

1. Navigate to **Performance Analytics > Widgets**.
2. Click **New**.
3. In the **Name** field, give the widget a name that reflects the information being displayed.
4. In the **Type** field, select **List**.
   If you change the value of **Type** after you fill in other fields, those fields are cleared.
5. In the **Visualization** field, select **Scorecard**.
6. Select indicators in one of the following ways:
   - Select a group in the **Indicator Group** field.
   - Click **Save**, then add widget indicators as described in **Add widget indicators**.
7. To aggregate the widget data for a specific time period, such as applying a 7-day sum or average, select a function in the **Time series** field.

   **Note:** Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.

8. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

   a. Select **Follow element**.

   b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.
      Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.
      (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.
c. In **Show multiple elements as**, select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation.

Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see **Showing multiple elements separately or aggregated**.

9. **Optional:** Select the attribute on which to sort the data in the **Sort on** field.

10. Select the scores and metrics to show in the **Column Settings** tab.

<table>
<thead>
<tr>
<th>Column setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current score</td>
<td>Show the score from the latest data collection. Selected by default.</td>
</tr>
<tr>
<td>Trend</td>
<td>Shows the direction that the indicator is moving. The trend is shown in a mini-chart on the dashboard. Selected by default.</td>
</tr>
<tr>
<td>Bullet chart</td>
<td>Show a graphic that shows how close the latest score is to the latest target score. The graphic only appears if the indicator has a defined target.</td>
</tr>
<tr>
<td>Multiple scores</td>
<td>Shows the number of scores that are defined in the <strong>Number of periods</strong> field, which appears when <strong>Multiple scores</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td>If <strong>Current Score</strong> is also selected, the most recent period is labeled <strong>Score</strong>. Otherwise, the most recent period is labeled with the date.</td>
</tr>
<tr>
<td>Number of periods</td>
<td>Select the number of additional periods to include in the widget.</td>
</tr>
<tr>
<td>Period step</td>
<td>If the <strong>Number of periods</strong> &gt; 1, select the length of each period. The unit is based on the frequency of the first indicator.</td>
</tr>
<tr>
<td>Note:</td>
<td>Including indicators with different frequencies, such as daily or weekly, may result in different numbers of periods per indicator. For example, if the first indicator has a daily frequency, and another indicator has a weekly frequency, the daily indicator shows 7 scores for every 1 score of the weekly indicator.</td>
</tr>
<tr>
<td>Change</td>
<td>Shows the change in value from the previous score.</td>
</tr>
<tr>
<td>Column setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Change %</td>
<td>Shows the percentage change from the previous score.</td>
</tr>
<tr>
<td>Target</td>
<td>Shows the target for the indicator. A value appears only if the indicator has a defined target. The target and current score are shown graphically in the Bullet chart.</td>
</tr>
<tr>
<td>Gap</td>
<td>Shows the difference between the current score and the target. For indicators with a Maximize direction, the gap calculation is Score–Target. For indicators with a Minimize direction, the calculation is Target–Score. Thus a positive value is always good, and a negative value is always bad. A value appears only if the indicator has a defined target.</td>
</tr>
<tr>
<td>Gap %</td>
<td>Shows the percentage difference between the current and target scores. As with Gap, a positive Gap % is always good, and a negative Gap % is always bad, regardless of the direction of the indicator. A value appears only if the indicator has a defined target.</td>
</tr>
</tbody>
</table>

11. **Optional:** Filter which indicators to show in the List Settings tab.

<table>
<thead>
<tr>
<th>List setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard options</td>
<td>Select <strong>All</strong> indicators, indicators marked <strong>Key</strong>, or <strong>Favorite</strong> indicators to show only those indicators on the dashboard.</td>
</tr>
<tr>
<td>Page size</td>
<td>Select the number of rows to show on the list scorecard.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter the scorecard list for <strong>Best Performing</strong>, <strong>Worst Performing</strong>, <strong>Improved</strong>, <strong>Declined</strong>, or <strong>Deteriorated</strong>. Only indicator scores that match the filter are shown.</td>
</tr>
</tbody>
</table>

12. Click **Submit** or **Update**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Create a spider visualization in a list widget**
To plot the scores of several indicators, use a spider visualization in a list widget.

**Before you begin**
Role required: pa_power_user or admin
About this task
Use this visualization to help compare the scores of several similar indicators.

**Note:** You can compare a maximum of ten indicators in a spider visualization.

### Spider visualization - list widget

#### Procedure

1. Navigate to **Performance Analytics > Widgets**.
2. Click **New**.
3. In the **Name** field, give the widget a name that reflects the information being displayed.
4. In the **Type** field, select **List**.
   - If you change the value of **Type** after you fill in other fields, those fields are cleared.
5. In the **Visualization** field, select **Spider**.
6. Select indicators in one of the following ways:
   - Select a group in the **Indicator Group** field.
   - Click **Save**, then add widget indicators as described in **Add widget indicators**.
7. To aggregate the widget data for a specific time period, such as applying a 7-day sum or average, select a function in the **Time series** field.
Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.

8. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

a. Select **Follow element**.

b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.

c. In **Show multiple elements as**, select whether to show each element separately or to show an aggregate of elements based on the indicator aggregation.

Neither all widget visualizations nor all indicators support both aggregate and separate views. For automated and external indicators, only COUNT, SUM, MAX, and MIN data aggregations support aggregate views. COUNT DISTINCT and AVG do not. For more information, see **Showing multiple elements separately or aggregated**.

9. **Optional:** Select the attribute on which to sort the data in the **Sort on** field.

10. **Optional:** Filter which indicators to display in the **List Settings** tab.

<table>
<thead>
<tr>
<th>List setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator options</td>
<td>Select All indicators, indicators marked Key, or Favorite indicators.</td>
</tr>
<tr>
<td>Page size</td>
<td>Select the number of rows to show on the indicator list.</td>
</tr>
</tbody>
</table>
**What to do next**
To view the widget, add it to a dashboard or a portal.

**Breakdown widgets**

Breakdown widgets show indicator scores grouped by breakdown elements. Different visualizations can be used to compare the relative proportion of breakdown elements or the trends in these proportions.

When you are selecting a visualization for a breakdown widget, consider whether you want to compare the trends or the relative proportions of the breakdown elements. Also consider whether you want to show one indicator or compare several related indicators, and whether you want to show one or two breakdowns.

### Breakdown widget visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Shows the trends for one breakdown for a single indicator.</td>
</tr>
<tr>
<td>Column</td>
<td>Enables a comparison between the relative proportion of breakdown elements by displaying them as proportional vertical columns. Use when a pie, funnel, or other such visualization is not appropriate.</td>
</tr>
<tr>
<td>Pie</td>
<td>Enables a comparison between the relative proportion of breakdown elements by using a circle to represent the whole.</td>
</tr>
<tr>
<td>Donut</td>
<td>Enables a comparison between the relative proportion of breakdown elements by using a donut shape to represent the whole.</td>
</tr>
<tr>
<td>Semi-donut</td>
<td>Enables a comparison between the relative proportion of breakdown elements by using a semi-donut shape to represent the whole. A semi-donut chart uses a donut sliced in half to represent the whole.</td>
</tr>
</tbody>
</table>
Breakdown widget visualizations (continued)

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Funnel</td>
<td>Enables a comparison between the relative proportion of breakdown elements by displaying values as progressively decreasing proportions. The size of each section reflects a percentage of the total of all values.</td>
</tr>
<tr>
<td>Pyramid</td>
<td>Enables a comparison between the relative proportion of breakdown elements by displaying values as progressively increasing proportions. The size of each section reflects a percentage of the total of all values.</td>
</tr>
</tbody>
</table>

Visualizing both the trend in scores and the relative proportions of elements of a breakdown

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacked Column</td>
<td>Combines time series and breakdown widget functions. The X-axis is a time line and the visualization shows the development of indicator scores over time. Also, each column is divided into a stack of slices according to the elements of a breakdown. Thus the visualization shows the relative proportion of breakdown elements over time.</td>
</tr>
<tr>
<td>Column and total</td>
<td>Shows both the relative proportion of breakdown elements and the trend in the indicator score. Shows a separate column for each breakdown value and a line representing the total for all values, over time.</td>
</tr>
<tr>
<td>Line</td>
<td>Shows changes over time in the relative proportion of breakdown elements for an indicator by connecting a series of data points with straight lines.</td>
</tr>
<tr>
<td>Relative Compare</td>
<td>Shows how multiple breakdowns diverge over time.</td>
</tr>
</tbody>
</table>

Other visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pareto</td>
<td>Combines column and line visualizations to identify the most important factors in a large set of factors.</td>
</tr>
<tr>
<td>Pivot scorecard</td>
<td>Enables you to compare the breakdown elements for one breakdown applied to several indicators. The Y-axis can be the indicators or the breakdown elements.</td>
</tr>
</tbody>
</table>
### Breakdown widget visualizations (continued)

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treemap</td>
<td>Shows a treelike display of nested rectangles with a color gradient to signify positive to negative scores or trends in scores.</td>
</tr>
</tbody>
</table>

### Grouping by breakdown and filtering by breakdown

In breakdown widgets, breakdowns either group or filter indicator scores. When you create a widget, this dual purpose of breakdowns affects the function of the breakdown fields.

The **Breakdown** and **2nd Breakdown** fields in the widget form have a different function for breakdown widgets than for other widget types. In most other widget types, these fields specify filters. Only the indicator scores that correspond to the specified breakdown elements are shown. However, when you create a breakdown widget, you group the scores by a breakdown instead of filtering it. The elements of the breakdown are shown as the different wedges of a pie visualization, or separate columns in a column visualization, for example.

By default, a breakdown widget shows all the elements of the breakdown. However, you can restrict which elements are shown by applying an element filter. For more information, see [Element filters](#).

You can filter the scores by a first-level breakdown and element and show the elements of a second-level breakdown. To do this, specify a breakdown and an element in the **Breakdown** and **Element** fields. Then specify the breakdown that is used to group the data in the **2nd Breakdown** field. If you do not specify a **2nd Breakdown**, the **Element** field is ignored and the first **Breakdown** is used to group indicator scores instead of filtering them.

### Interacting with breakdown widgets on dashboards

Performance Analytics users can interact with individual breakdown widgets on dashboards to change the visualization or breakdown.

Widgets with the **Type of Breakdown** enable users to select the visualization when viewing the widget on a dashboard. Users can select any visualization for the widget type from the **Visualization** choice list when viewing the widget on a dashboard.

**Note:** You cannot select the **Pivot Scorecard** visualization from a dashboard. To use this visualization, configure the widget record.
Breakdown widgets also enable users to select the breakdown when multiple breakdowns are available. All available breakdowns for the widget Indicator appear in the Breakdown choice list when viewing the widget on a dashboard. If the indicator has only one associated breakdown, the Breakdown choice list does not appear on the widget.

Note: If the widget is added to a breakdown dashboard and the user selects the same breakdown on the widget and on the dashboard, the dashboard breakdown is ignored. However, when the user selects any other combination of widget and dashboard breakdowns, both breakdowns apply.

By default, the interactive breakdown applies as the 1st-level breakdown. However, if the widget is on a breakdown dashboard and Follow element is selected on the Widget form, the interactive breakdown applies as the 2nd-level breakdown. (Collect breakdown matrix must be set on the indicator for 2nd-level breakdowns to apply.) Any breakdown that is set on a dashboard that contains the widget applies as the 1st-level breakdown.

You can disable this functionality for a specific widget by clearing the Show visualization selector or Show breakdown selector check boxes on the Widgets form.

The visualization or breakdown selected in the widget record is used as the default.

Related information
- Performance Analytics breakdowns
- Using breakdowns on dashboards

Create a scorecard visualization for a breakdown widget
To show the trend for the elements of one breakdown applied to one indicator, use a scorecard visualization.

Before you begin
Role required: pa_power_user or admin

About this task
Scorecard visualizations show the trends by element for one breakdown applied to one indicator.
Scorecard visualization - breakdown

Open incidents by Priority

<table>
<thead>
<tr>
<th>Name</th>
<th>Aug 06</th>
<th>Change</th>
<th>Trend</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>B - Planning</td>
<td>73</td>
<td>-1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B - Law</td>
<td>75</td>
<td>-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B - Moderate</td>
<td>73</td>
<td>-2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B - High</td>
<td>4</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B - Critical</td>
<td>4</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to **Performance Analytics > Widgets** and click **New**.

2. In the **Name** field, give the widget a name that reflects the information being displayed.

3. In the **Type** field, select **Breakdown**.
   If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Scorecard**.
   You can let the user switch between visualizations. Select **Show visualization selector** in the **Display settings** tab.

5. In the **Indicator** field, select the main indicator which you want to break down.

6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
   - For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the **Breakdown** field. Do not select an element or a second breakdown.
   - You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the **Element Settings** tab. Do not specify an element in the **Element** field. You can personalize only the first-level breakdown elements. For more information, see **Personalized visuals**.
   - For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the **Breakdown** and **Element** fields. Then select the grouping breakdown in the **2nd Breakdown** field. The widget shows scores for each element of the **2nd Breakdown** but only if they match the first **Breakdown** and **Element**.
• The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the **Breakdown** field. Then select **Follow element** as described in a later step.

**Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

  a. **Select Follow element.**

     Selecting this option removes the ability to set a filtering breakdown on the widget. Scores are grouped by the elements of the first breakdown and filtered by the elements that the user selects on the dashboard.

  b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown.**

     Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

     (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to show separate values for the elements of the breakdown Assigned to. Therefore, you select **Assigned to** in the field **Followed breakdown.**

  c. **In Show multiple elements as,** only the **Aggregated** view is possible.

  d. **Optional:** Select a breakdown relation in **Followed breakdown relation.**

     The widget displays only the breakdown elements that follow the specified breakdown relation. A related breakdown element must be selected on the
breakdown dashboard. Otherwise, the widget does not display any data. For a detailed example, see Showing breakdown relations on dashboards.

Note:
- You can specify either a followed breakdown or a followed breakdown relation, not both.
- Multiple element selection is not supported on a widget that follows a breakdown relation.

For more information, see Configure widgets for breakdown dashboards.

8. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see Applying time series aggregations. Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Sort on (Optional) Sort direction</td>
<td>Sort the data on the Sort on attribute. Then select whether to sort in ascending or descending order. Note: The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
</tbody>
</table>

9. Optional: Review the Settings tabs and change settings as desired.

10. Click Submit.
What to do next
To view the widget, add it to a dashboard or a portal.

Related reference
Additional settings for breakdown widgets

Related information
Edit a responsive dashboard
Performance Analytics widgets on Service Portal
Grouping by breakdown and filtering by breakdown
Interacting with breakdown widgets on dashboards
Analytics Hub

Create a pie, donut, or semi-donut visualization for a breakdown widget
To show the relative proportions of the elements of a breakdown, use a pie, donut, or semi-donut visualization.

Before you begin
Role required: pa_power_user or admin

About this task
When you need to compare the percentages or relative proportions of breakdown elements, you can use a pie, a donut, or a semi-donut visualization. Consider trying all three to see which works best for a particular widget. These visualizations can be unclear in the following cases:

• The breakdown has many elements.
• Several elements in the breakdown are much smaller than the others.

In these cases, or to compare scores instead of proportions, consider using a column visualization.
Procedure

1. Navigate to **Performance Analytics > Widgets** and click **New**.
2. In the **Name** field, give the widget a name that reflects the information being displayed.
3. In the **Type** field, select **Breakdown**.
   If you change the value of **Type** after you fill in other fields, those fields are cleared.
4. In the **Visualization** field, select **Pie, Donut, or Semi donut**.
   You can let the user switch between visualizations. Select **Show visualization selector** in the **Display settings** tab.
5. In the **Indicator** field, select the main indicator which you want to break down.
6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
   • For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the **Breakdown** field. Do not select an element or a second breakdown.
   • You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the **Element Settings** tab. Do not specify an element in the **Element** field.
   You can personalize only the first-level breakdown elements. For more information, see **Personalized visuals**.
   • For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the **Breakdown** and **Element** fields. Then select the grouping breakdown in the **2nd Breakdown** field. The widget shows scores for each element of the **2nd Breakdown** but only if they match the first **Breakdown** and **Element**.
   • The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the **Breakdown** field. Then select **Follow element** as described in a later step.

**Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:
a. Select **Follow element**.

Selecting this option removes the ability to set a filtering breakdown on the widget. Scores are grouped by the elements of the first breakdown and filtered by the elements that the user selects on the dashboard.

b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to show separate values for the elements of the breakdown Assigned to. Therefore, you select **Assigned to** in the field **Followed breakdown**.

c. In **Show multiple elements as**, only the **Aggregated** view is possible.

For more information, see **Configure widgets for breakdown dashboards**.

*i Note:* The **Followed breakdown relation** menu works only with Scorecard visualizations. Also, multiple element selection on a breakdown dashboard is not supported on the widget when you set a breakdown relation to follow.

8. **Optional:** Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see <strong>Applying time series aggregations</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
<td></td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on the <strong>Sort on</strong> attribute. Then select whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td><strong>Note:</strong> The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the <strong>Sort on</strong> setting is ignored.</td>
<td></td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see <a href="#">Create a color scheme for widget visualizations</a>.</td>
</tr>
</tbody>
</table>

9. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see [Additional settings for breakdown widgets](#).

10. Click **Submit**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Grouping by breakdown and filtering by breakdown
- Interacting with breakdown widgets on dashboards

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create a pyramid or a funnel visualization for a breakdown widget

To show the relative proportions of the elements of a breakdown, particularly when the elements represent stages in a process, use a pyramid or funnel visualization.

**Before you begin**

Role required: pa_power_user or admin

**About this task**

When you need to compare the percentages or relative proportions of breakdown elements, consider using a funnel or pyramid visualization instead of a pie visualization. Funnel and pyramid visualizations are particularly appropriate when the elements of a breakdown represent stages in a process, such as going from lead to closed deal in a sales process. Funnel charts stack slices from top to bottom by decreasing percentage and pyramid charts stack slices by increasing percentage. Pyramid charts are often used to represent hierarchical levels in an organization.

Pyramid and funnel visualizations - breakdown

In the following examples, open incidents are displayed according to the stages that the incidents are in.
Procedure

1. Navigate to **Performance Analytics > Widgets** and click **New**.

2. In the **Name** field, give the widget a name that reflects the information being displayed.

3. In the **Type** field, select **Breakdown**.
   If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Pyramid** or **Funnel**.
   You can let the user switch between visualizations. Select **Show visualization selector** in the **Display settings** tab.

5. In the **Indicator** field, select the main indicator which you want to break down.

6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
   - For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the **Breakdown** field. Do not select an element or a second breakdown.
   - You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the **Element Settings** tab. Do not specify an element in the **Element** field. You can personalize only the first-level breakdown elements. For more information, see **Personalized visuals**.
   - For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the **Breakdown** and **Element** fields. Then select the grouping breakdown in the **2nd Breakdown** field. The widget shows scores for each element of the **2nd Breakdown** but only if they match the first **Breakdown** and **Element**.
   - The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the **Breakdown** field. Then select **Follow element** as described in a later step.

   **Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:
a. Select **Follow element**.

Selecting this option removes the ability to set a filtering breakdown on the widget. Scores are grouped by the elements of the first breakdown and filtered by the elements that the user selects on the dashboard.

b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to show separate values for the elements of the breakdown Assigned to. Therefore, you select **Assigned to** in the field **Followed breakdown**.

c. In **Show multiple elements as**, only the **Aggregated** view is possible.

For more information, see **Configure widgets for breakdown dashboards**.

⚠️ **Note:** The **Followed breakdown relation** menu works only with Scorecard visualizations. Also, multiple element selection on a breakdown dashboard is not supported on the widget when you set a breakdown relation to follow.

8. **Optional:** Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see <strong>Applying time series aggregations</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
<td></td>
</tr>
<tr>
<td><strong>Sort on</strong> (Optional) <strong>Sort direction</strong></td>
<td>Sort the data on the <strong>Sort on</strong> attribute. Then select whether to sort in ascending or descending order. <strong>Note:</strong> The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the <strong>Sort on</strong> setting is ignored.</td>
</tr>
<tr>
<td><strong>Color scheme</strong></td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see <a href="#">Create a color scheme for widget visualizations</a>.</td>
</tr>
</tbody>
</table>

9. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see [Additional settings for breakdown widgets](#).

10. Click **Submit**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- [Edit a responsive dashboard](#)
- [Performance Analytics widgets on Service Portal](#)
- [Grouping by breakdown and filtering by breakdown](#)
- [Interacting with breakdown widgets on dashboards](#)
Create a column visualization for a breakdown widget

To compare the elements of one breakdown applied to one indicator, use a column visualization.

Before you begin
Role required: pa_power_user or admin

About this task
If you want to compare the relative proportion of indicator scores by breakdown elements, and a pie visualization is not appropriate, use a column visualization. Column visualizations are clearer when there are many elements, when several elements are much smaller than others, or when several elements are close to each other in value.

Column visualization - breakdown

Procedure
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Column.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
• For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the Breakdown field. Do not select an element or a second breakdown.

• You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the Element Settings tab. Do not specify an element in the Element field. You can personalize only the first-level breakdown elements. For more information, see Personalized visuals.

• For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the Breakdown and Element fields. Then select the grouping breakdown in the 2nd Breakdown field. The widget shows scores for each element of the 2nd Breakdown but only if they match the first Breakdown and Element.

• The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the Breakdown field. Then select Follow element as described in a later step.

**Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

**a. Select Follow element.**

Selecting this option removes the ability to set a filtering breakdown on the widget. Scores are grouped by the elements of the first breakdown and filtered by the elements that the user selects on the dashboard.

**b. Optional:** Set which of the available breakdowns to follow in Followed breakdown.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to show separate values for
the elements of the breakdown Assigned to. Therefore, you select **Assigned to** in the field **Followed breakdown**.

c. In **Show multiple elements as**, only the **Aggregated** view is possible.

For more information, see Configure widgets for breakdown dashboards.

- **Note:** The **Followed breakdown relation** menu works only with Scorecard visualizations. Also, multiple element selection on a breakdown dashboard is not supported on the widget when you set a breakdown relation to follow.

8. **Optional:** Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see Applying time series aggregations.</td>
</tr>
</tbody>
</table>

- **Note:** Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort on</td>
<td>Sort the data on the <strong>Sort on</strong> attribute. Then select whether to sort in ascending or descending order.</td>
</tr>
</tbody>
</table>

- **Note:** The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the **Sort on** setting is ignored.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your</td>
</tr>
</tbody>
</table>
9. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see [Additional settings for breakdown widgets](#).

10. Click **Submit**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Grouping by breakdown and filtering by breakdown
- Interacting with breakdown widgets on dashboards

**Create a Pareto visualization for a breakdown widget**
To identify the most important breakdown elements when the breakdown has a large set of elements, use a Pareto visualization.

**Before you begin**
Role required: pa_power_user or admin

**About this task**
Pareto visualizations contain both bar and line graphs. The bars display the data in descending order from left to right, and the line graph shows the cumulative totals from each category in the same order. The left Y axis is the record count, and the right Y axis is the cumulative percentage of the total number of records evaluated. The data to the left of the intersection of the line graph and the 80% mark have the greatest effect on the overall outcome.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>own color scheme instead of using a provided color scheme. For more information, see <a href="#">Create a color scheme for widget visualizations</a>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to Performance Analytics > Widgets and click New.

2. In the Name field, give the widget a name that reflects the information being displayed.

3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.

4. In the Visualization field, select Pareto.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.

5. In the Indicator field, select the main indicator which you want to break down.

6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
   - For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the Breakdown field. Do not select an element or a second breakdown.
   - You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the Element Settings tab. Do not specify an element in the Element field. You can personalize only the first-level breakdown elements. For more information, see Personalized visuals.
   - For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the Breakdown and Element fields. Then select the grouping breakdown in the 2nd Breakdown field. The widget shows scores for each element of the 2nd Breakdown but only if they match the first Breakdown and Element.
   - The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the Breakdown field. Then select Follow element as described in a later step.

   **Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:
a. Select **Follow element**.

Selecting this option removes the ability to set a filtering breakdown on the widget. Scores are grouped by the elements of the first breakdown and filtered by the elements that the user selects on the dashboard.

b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard. (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to show separate values for the elements of the breakdown Assigned to. Therefore, you select **Assigned to** in the field **Followed breakdown**.

c. In **Show multiple elements as**, only the **Aggregated** view is possible.

For more information, see **Configure widgets for breakdown dashboards**.

| Note: The Followed breakdown relation menu works only with Scorecard visualizations. Also, multiple element selection on a breakdown dashboard is not supported on the widget when you set a breakdown relation to follow. |

8. **Optional:** Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
<td></td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on the Sort on attribute. Then select whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>(Optional) Sort direction</td>
<td>² Note: The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

9. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see Additional settings for breakdown widgets.

10. Click **Submit**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Grouping by breakdown and filtering by breakdown
- Interacting with breakdown widgets on dashboards
Create a line visualization for a breakdown widget

To follow changes over time in the relative proportion of breakdown elements for an indicator, use a line visualization in a breakdown widget.

Before you begin
Role required: pa_power_user or admin

About this task
A line visualization in a breakdown widget shows how the proportion of indicator scores belonging to different breakdown elements changes over time. To select the time period over which changes are tracked, go to the Date Settings tab.

Procedure
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Line.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
   • For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the Breakdown field. Do not select an element or a second breakdown.
   • You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the
Element Settings tab. Do not specify an element in the Element field.
You can personalize only the first-level breakdown elements. For more
information, see Personalized visuals.

- For the widget to show scores filtered by an element of one breakdown
then grouped by the elements of another breakdown, select the filtering
breakdown and element in the Breakdown and Element fields. Then select
the grouping breakdown in the 2nd Breakdown field. The widget shows
scores for each element of the 2nd Breakdown but only if they match the
first Breakdown and Element.

- The widget can also show scores grouped by one breakdown and filtered
by an element that the user selects on a breakdown dashboard. Select the
grouping breakdown in the Breakdown field. Then select Follow element as
described in a later step.

**Important:** If the widget is for a formula indicator, all contributing
indicators in the formula must support the breakdown. Otherwise an error
message instead of a value appears in the widget on a dashboard.

7. To have the widget follow the breakdown elements that are selected on a
breakdown dashboard, follow these steps:

a. Select Follow element.

Selecting this option removes the ability to set a filtering breakdown on the
widget. Scores are grouped by the elements of the first breakdown and
filtered by the elements that the user selects on the dashboard.

b. Optional: Set which of the available breakdowns to follow in Followed
breakdown.

Breakdown dashboards let you select a breakdown source and elements.
However, an indicator can use more than one breakdown that is based on
the same breakdown source. Use this setting to determine which of these
breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two
breakdowns: Assigned to, and Opened by. Both breakdowns are based on
the Users.Active breakdown source. Consider the case where you create
a widget for this indicator and you have the widget follow elements on
breakdown dashboards. You want the widget to show separate values for
the elements of the breakdown Assigned to. Therefore, you select Assigned
to in the field Followed breakdown.

c. In Show multiple elements as, only the Aggregated view is possible.
For more information, see Configure widgets for breakdown dashboards.

Note: The Followed breakdown relation menu works only with Scorecard visualizations. Also, multiple element selection on a breakdown dashboard is not supported on the widget when you set a breakdown relation to follow.

8. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td>Note:</td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Sort on (Optional)</td>
<td>Sort the data on the Sort on attribute. Then select whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Note:</td>
<td>The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>
9. Optional: Review the Settings tabs and change settings as desired. For more information, see Additional settings for breakdown widgets.

10. Click Submit.

What to do next
To view the widget, add it to a dashboard or a portal.

Related information
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Create a line visualization for a time series widget
- Grouping by breakdown and filtering by breakdown
- Interacting with breakdown widgets on dashboards

Create a columns and total visualization for a breakdown widget
To follow changes over time in both the scores of an indicator and the relative proportion of breakdown elements for that indicator, use a Columns and Total visualization in a breakdown widget.

Before you begin
Role required: pa_power_user or admin

About this task
This visualization combines a time series and a breakdown widget. A classic time series with a line visualization is shown for the indicator scores. This line is combined with a column visualization of the breakdown for each point in time at which indicator scores were collected. Use this widget to explore relationships between the indicator score and the relative proportion of breakdown elements for that indicator.

Columns and total visualization
Procedure

1. Navigate to **Performance Analytics > Widgets** and click **New**.

2. In the **Name** field, give the widget a name that reflects the information being displayed.

3. In the **Type** field, select **Breakdown**.
   - If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Columns and Total**.
   - You can let the user switch between visualizations. Select **Show visualization selector** in the **Display settings** tab.

5. In the **Indicator** field, select the main indicator which you want to break down.

6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
   - For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the **Breakdown** field. Do not select an element or a second breakdown.
   - You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the **Element Settings** tab. Do not specify an element in the **Element** field. You can personalize only the first-level breakdown elements. For more information, see [Personalized visuals](#).
   - For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the **Breakdown** and **Element** fields. Then select the grouping breakdown in the **2nd Breakdown** field. The widget shows scores for each element of the **2nd Breakdown** but only if they match the first **Breakdown** and **Element**.
   - The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the **Breakdown** field. Then select **Follow element** as described in a later step.

    **Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:
a. Select **Follow element**.

Selecting this option removes the ability to set a filtering breakdown on the widget. Scores are grouped by the elements of the first breakdown and filtered by the elements that the user selects on the dashboard.

b. **Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to show separate values for the elements of the breakdown Assigned to. Therefore, you select **Assigned to** in the field **Followed breakdown**.

c. In **Show multiple elements as**, only the **Aggregated** view is possible.

For more information, see **Configure widgets for breakdown dashboards**.

<i>Note:** The **Followed breakdown relation** menu works only with Scorecard visualizations. Also, multiple element selection on a breakdown dashboard is not supported on the widget when you set a breakdown relation to follow.

8. **Optional:** Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see <strong>Applying time series aggregations</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on the <strong>Sort on</strong> attribute. Then select whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>(Optional) Sort direction</td>
<td><strong>Note:</strong> The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the <strong>Sort on</strong> setting is ignored.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

9. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see Additional settings for breakdown widgets.

10. Click **Submit**.

What to do next
To view the widget, add it to a dashboard or a portal.

Related information
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Grouping by breakdown and filtering by breakdown
- Interacting with breakdown widgets on dashboards
- Create a line visualization for a time series widget
Create a stacked column visualization for a breakdown widget

To follow changes over time in the relative proportion of breakdown elements for an indicator, use a stacked column visualization in a breakdown widget.

**Before you begin**
Role required: pa_power_user or admin

**About this task**
This visualization shows the relative proportion of breakdown elements in a single column, and shows a column for every point in time that indicator scores are collected. To select the time period over which changes are tracked, go to the **Date Settings** tab.

![Stacked column visualization - breakdown](image)

**Procedure**
1. Navigate to **Performance Analytics > Widgets** and click **New**.
2. In the **Name** field, give the widget a name that reflects the information being displayed.
3. In the **Type** field, select **Breakdown**. If you change the value of **Type** after you fill in other fields, those fields are cleared.
4. In the **Visualization** field, select **Stacked Column**. You can let the user switch between visualizations. Select **Show visualization selector** in the **Display settings** tab.
5. In the **Indicator** field, select the main indicator which you want to break down.
6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
• For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the **Breakdown** field. Do not select an element or a second breakdown.

• You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the **Element Settings** tab. Do not specify an element in the **Element** field. You can personalize only the first-level breakdown elements. For more information, see Personalized visuals.

• For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the **Breakdown** and **Element** fields. Then select the grouping breakdown in the **2nd Breakdown** field. The widget shows scores for each element of the **2nd Breakdown** but only if they match the first **Breakdown** and **Element**.

• The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the **Breakdown** field. Then select **Follow element** as described in a later step.

**Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

   a. Select **Follow element**.
      Selecting this option removes the ability to set a filtering breakdown on the widget. Scores are grouped by the elements of the first breakdown and filtered by the elements that the user selects on the dashboard.

   b. Optional: Set which of the available breakdowns to follow in **Followed breakdown**.
      Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

      (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to show separate values for
the elements of the breakdown Assigned to. Therefore, you select Assigned to in the field Followed breakdown.

c. In Show multiple elements as, only the Aggregated view is possible.

For more information, see Configure widgets for breakdown dashboards.

⚠️ **Note:** The Followed breakdown relation menu works only with Scorecard visualizations. Also, multiple element selection on a breakdown dashboard is not supported on the widget when you set a breakdown relation to follow.

8. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td></td>
<td>⚠️ <strong>Note:</strong> Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Sort on (Optional)</td>
<td>Sort the data on the Sort on attribute. Then select whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td>⚠️ <strong>Note:</strong> The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

9. **Optional:** Review the **Settings** tabs and change settings as desired. For more information, see Additional settings for breakdown widgets.

10. Click **Submit**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Related information**
- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Grouping by breakdown and filtering by breakdown
- Interacting with breakdown widgets on dashboards

**Create a relative compare visualization for a breakdown widget**
To show how the relative proportions of several indicators change over time, use a relative compare visualization for a time series.

**Before you begin**
Role required: pa_power_user or admin

**About this task**
Like a pie chart, a relative compare visualization shows relative proportions between data points, but it can also show how those proportions change over time. Traditional uses of relative compare visualizations are stock charts or population growth trends. When you create a relative compare visualization, it uses a baseline of zero and then shows how the data changes over time. For example, this visualization shows the number of open incidents from December to March for three different incident types. When you point to a line, the number of incidents and the percentage change for that day appear. The percentage change shown for a data point is calculated from a baseline of zero, not the previous data point as on most other time series visualizations.
Example of a relative compare visualization

Procedure

1. Navigate to Performance Analytics > Widgets and click New.

2. In the Name field, give the widget a name that reflects the information being displayed.

3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.

4. In the Visualization field, select Relative Compare.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.

5. In the Indicator field, select the main indicator which you want to break down.

6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
   - For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the Breakdown field. Do not select an element or a second breakdown.
   - You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the Element Settings tab. Do not specify an element in the Element field. You can personalize only the first-level breakdown elements. For more information, see Personalized visuals.
   - For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the Breakdown and Element fields. Then select the grouping breakdown in the 2nd Breakdown field. The widget shows scores for each element of the 2nd Breakdown but only if they match the first Breakdown and Element.
• The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the **Breakdown** field. Then select **Follow element** as described in a later step.

**Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

### 7. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

**a. Select Follow element.**

Selecting this option removes the ability to set a filtering breakdown on the widget. Scores are grouped by the elements of the first breakdown and filtered by the elements that the user selects on the dashboard.

**b. Optional:** Set which of the available breakdowns to follow in **Followed breakdown**.

Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

(Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to show separate values for the elements of the breakdown Assigned to. Therefore, you select **Assigned to** in the field **Followed breakdown**.

**c. In Show multiple elements as, only the Aggregated view is possible.**

For more information, see **Configure widgets for breakdown dashboards**.

**f Note:** The **Followed breakdown relation** menu works only with Scorecard visualizations. Also, multiple element selection on a breakdown dashboard is not supported on the widget when you set a breakdown relation to follow.

### 8. Optional: Fill in any of the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td>Note:</td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on the Sort on attribute. Then select whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>(Optional)</td>
<td></td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

9. In the **Date Settings** tab, select **Show date range indicator**.

10. Review the **Settings** tabs and adjust other settings as desired.

11. Click **Submit**.

**What to do next**

To view the widget, add it to a dashboard or a portal.
Related reference
Additional settings for breakdown widgets

Related information
Edit a responsive dashboard
Performance Analytics widgets on Service Portal
Grouping by breakdown and filtering by breakdown
Interacting with breakdown widgets on dashboards

Create a pivot scorecard visualization for a breakdown widget
To compare the relative proportions of breakdown elements between a number of indicators, use a pivot scorecard visualization in a breakdown widget.

Before you begin
Role required: pa_power_user or admin

About this task
If you want to see the same breakdown applied to more than one indicator in the same widget, use a pivot scorecard. You can pivot the scorecard so that the axes for breakdown elements and for indicators are reversed.

### Pivot scorecard - breakdown

<table>
<thead>
<tr>
<th>Priority of all open incidents</th>
<th>1 - Critical</th>
<th>2 - High</th>
<th>3 - Moderate</th>
<th>4 - Low</th>
<th>5 - Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of open incidents</td>
<td>3</td>
<td>4</td>
<td>22</td>
<td>40</td>
<td>71</td>
</tr>
<tr>
<td>Number of open incidents not updated in last 5 days</td>
<td>2</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Number of open incidents not updated in last 30 days</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
</tbody>
</table>

### Pivot scorecard with the breakdown on the Y-axis

<table>
<thead>
<tr>
<th>Priority of all open incidents</th>
<th>Number of open incidents</th>
<th>Number of open incidents not updated in last 5 days</th>
<th>Number of open incidents not updated in last 30 days</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Critical</td>
<td>4</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>2 - High</td>
<td>4</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3 - Moderate</td>
<td>21</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>4 - Low</td>
<td>43</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5 - Planning</td>
<td>71</td>
<td>10</td>
<td>2</td>
</tr>
</tbody>
</table>
Procedure

1. Navigate to **Performance Analytics > Widgets** and click **New**.

2. In the **Name** field, give the widget a name that reflects the information being displayed.

3. In the **Type** field, select **Breakdown**.
   - If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Pivot Scorecard**.

5. In the **Pivot breakdown** field, select the breakdown whose elements you want to see across several indicators.

6. Click **Save**.
   - The **Indicators** related list appears at the bottom of the form.

7. In the **Indicators** related list, click **New**.

8. In the menu that appears, select the indicators that you want to compare breakdown elements between.

9. Click **Update**.

What to do next

- To view the widget, add it to a dashboard or a portal.
- Once the widget is in a dashboard, edit the widget and try the **Breakdown on Y-axis** display setting.

Related information

- Edit a responsive dashboard
- Performance Analytics widgets on Service Portal
- Grouping by breakdown and filtering by breakdown

Create a treemap visualization for a breakdown widget

To display a hierarchy of breakdown elements, use a treemap visualization.

Before you begin

Role required: pa_power-user or admin

About this task

If the elements of a breakdown differ in favorability, or if you want to compare each breakdown element against an indicator target, you can use a treemap. Treemaps use nested rectangles with the size representing the relative proportion of the element and the color representing the favorability.
Procedure

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Treemap.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Select the breakdown to group the scores, and optionally a breakdown and element to filter the scores.
   • For the widget to show scores grouped by the elements of a breakdown, select a breakdown in the Breakdown field. Do not select an element or a second breakdown.
   • You can have the widget show different elements depending on characteristics of the viewer. To do so, specify an elements filter in the Element Settings tab. Do not specify an element in the Element field.
     You can personalize only the first-level breakdown elements. For more information, see Personalized visuals.
• For the widget to show scores filtered by an element of one breakdown then grouped by the elements of another breakdown, select the filtering breakdown and element in the **Breakdown** and **Element** fields. Then select the grouping breakdown in the **2nd Breakdown** field. The widget shows scores for each element of the **2nd Breakdown** but only if they match the first **Breakdown** and **Element**.

• The widget can also show scores grouped by one breakdown and filtered by an element that the user selects on a breakdown dashboard. Select the grouping breakdown in the **Breakdown** field. Then select **Follow element** as described in a later step.

**Important:** If the widget is for a formula indicator, all contributing indicators in the formula must support the breakdown. Otherwise an error message instead of a value appears in the widget on a dashboard.

7. In the **Coloring method** field, select whether to rank the favorability based on score, change to score, percent of change, or an indicator target.

8. Select the color that indicates a positive in the **Positive color** field.

9. Depending on the **Coloring method**, you may need to select a **Negative color**

10. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average, from being applied to the indicator. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td>Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
<td></td>
</tr>
</tbody>
</table>

| Sort on             | Sort the data on the **Sort on** attribute. Then select whether to sort in ascending or descending order. |
| (Optional) Sort direction |                                                                                                                                 |
|                     |                                                                                                                                 |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>Note:</em> The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the <strong>Sort on</strong> setting is ignored.</td>
</tr>
</tbody>
</table>

- **Color scheme**: A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information, see [Create a color scheme for widget visualizations](#).

11. **Optional**: Review the **Settings** tabs and change settings as desired. For more information, see [Additional settings for breakdown widgets](#).

12. Click **Submit**.

**What to do next**

To view the widget, add it to a dashboard or a portal.

**Related information**

- [Edit a responsive dashboard](#)
- [Performance Analytics widgets on Service Portal](#)
- [Grouping by breakdown and filtering by breakdown](#)
- [Interacting with breakdown widgets on dashboards](#)

**Additional settings for breakdown widgets**

Breakdown widgets have the following optional settings for the date range, the display, the grouping breakdown, and for the column contents. Not all options are available for all visualizations.

**Date settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period</td>
<td>Select the date range to display in the widget. Several options are available.</td>
</tr>
</tbody>
</table>
### Setting Description

- Select a specific time range. The default is **3m** (3 months).
- Select **max** to use scores up to the current date.
- Select **between** and then fill in the **From** and **To** fields to define a time period.

The **Period** field is available only if you select **Line, Columns and Total**, or **Stacked Column** as the **Visualization**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show date range selector</td>
<td>Display a date range selector on the widget that enables users to change the selected period when viewing the widget on a dashboard.</td>
</tr>
</tbody>
</table>

**Note:**

- Selecting a date range on a widget does not update the trend line.
- If you combine a time series aggregation such as By month SUM with a date range selector, the user may see one more time period than they expect. The instance interprets a period such as 3m as 0-3 months and may show four months of scores.

### Axis settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y-axis title</td>
<td>Specify a title to display on the vertical axis of the chart.</td>
</tr>
<tr>
<td>Y-axis from</td>
<td>Specify the starting point for the range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td>Y-axis to</td>
<td>Specify the ending point for the range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td>2nd Y-axis title</td>
<td>Specify a secondary title to display on the vertical axis of the chart.</td>
</tr>
</tbody>
</table>
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd Y-axis from</td>
<td>Specify the starting point for a 2nd range of values for the vertical axis of the chart. The 2nd Y-axis can be used if scores normally move between a limited range, but you have some exceptions that would otherwise distort the chart, such as a range of 40 to 60, with an exception of 1000.</td>
</tr>
<tr>
<td>2nd Y-axis to</td>
<td>Specify the ending point for a 2nd range of values for the vertical axis of the chart.</td>
</tr>
</tbody>
</table>

### Display settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show target</td>
<td>Display the target score, if defined. This field appears only if Previous period chart is not selected.</td>
</tr>
<tr>
<td>Show thresholds</td>
<td>Display thresholds such as an all time high or an all time low. Thresholds appear only if they have been defined for this indicator.</td>
</tr>
<tr>
<td>Show data labels</td>
<td>Display the score for each portion of the chart, such as for each slice of a pie chart.</td>
</tr>
<tr>
<td>Show trend</td>
<td>Display the direction the indicator is moving. The trend is shown in a mini-chart on the dashboard.</td>
</tr>
<tr>
<td>Show confidence bands</td>
<td>Display confidence bands in this chart. For information about how the confidence band is calculated, see Widget confidence bands.</td>
</tr>
<tr>
<td>Show forecast</td>
<td>Display forecast data in the chart based on current trend data. Forecasting must be configured on the indicator.</td>
</tr>
<tr>
<td>Show comments</td>
<td>Display comments added to data points in the chart.</td>
</tr>
<tr>
<td>Show visualization selector</td>
<td>Display a choice list on the widget that enables users to change the selected visualization from a dashboard.</td>
</tr>
</tbody>
</table>
### Setting | Description
---|---

**Note:** You cannot select the Pivot Scorecard visualization from a dashboard. You must configure the widget record to use this visualization.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show breakdown selector</td>
<td>Display a choice list on the widget that enables users to change the selected breakdown from a dashboard. There must be more than 1 breakdown available for the widget for the breakdown choice list to appear.</td>
</tr>
<tr>
<td>Positive color</td>
<td>When the Visualization is Treemap, select the color used to indicate a score moving in the desired direction, based on the indicator Direction value. If Color based on is set to Target, the positive color indicates values closer to the target.</td>
</tr>
<tr>
<td>Negative color</td>
<td>When the Visualization is Treemap, select the color used to indicate a score moving in the wrong direction, based on the indicator Direction value. If Color based on is set to Target, the negative color indicates values further away from the target. This field is not available when Color based on is Score.</td>
</tr>
<tr>
<td>Show legend</td>
<td>When the Visualization is Treemap, select this option to display a legend for the positive and negative colors.</td>
</tr>
<tr>
<td>Include elements without data in the legend</td>
<td>Shows the breakdown name in the legend of the widget even when no records match the elements of the breakdown.</td>
</tr>
</tbody>
</table>

### Breakdown settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown on Y axis</td>
<td>Pivot Analytics Hub breakdown widgets display breakdown elements as the X axis and indicators as the Y axis by default. Select this check box to display breakdown elements as the Y axis and indicators as the X axis.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show total</td>
<td>If you selected <strong>Scorecard</strong> in the <strong>Visualization</strong> field, an extra row can be included in the breakdown chart showing the totals of all selected breakdowns.</td>
</tr>
<tr>
<td>Show bar</td>
<td>Represent the score for each instance by a bar.</td>
</tr>
</tbody>
</table>

**Element settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elements filter</td>
<td>Specify if only a certain subset of breakdown elements are available for this widget. By default all elements are available.</td>
</tr>
<tr>
<td></td>
<td>For example, elements of the breakdown <strong>Priority</strong> can be: <strong>Critical</strong>, <strong>High</strong>, <strong>Moderate</strong>, <strong>Low</strong> or <strong>Planning</strong>.</td>
</tr>
<tr>
<td>Manual elements</td>
<td>Breakdown elements can be selected automatically or manually. Select the <strong>Manual elements</strong> check box to display the <strong>Widget Elements</strong> related list for adding elements. Clear the <strong>Manual elements</strong> check box to automatically use the elements that belong to the breakdown.</td>
</tr>
<tr>
<td>Show top x</td>
<td>Show only the elements with the x highest scores, to make the chart easier to read. In case of ties, the first element listed in the scoresheet is shown. For example, if you have a widget where <strong>Show top x</strong> is 3 and the third-highest value for the Priority breakdown is tied between High and Moderate, the widget shows High, not Moderate.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Indicator scores: #</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>100%</td>
</tr>
<tr>
<td>1 - Critical</td>
<td>1</td>
</tr>
<tr>
<td>2 - High</td>
<td>2</td>
</tr>
<tr>
<td>3 - Moderate</td>
<td>2</td>
</tr>
<tr>
<td>4 - Low</td>
<td>4</td>
</tr>
<tr>
<td>5 - Planning</td>
<td>3</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>The order in which the scoresheet lists elements depends on the table containing the elements. For example, for elements on the Choice [sys_choice] table, this order follows the value in the Sequence field. For elements on the Group [sys_group] table, the order is alphabetical based on the Name field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The top elements are selected from the most recent scores. If the widget has a line visualization, the top elements are still selected from the most recent scores, even if other elements have a higher average score across the timespan shown.</td>
</tr>
<tr>
<td>Percentages</td>
<td>If you select <strong>No percentages</strong>, no score percentages are shown for the instances. If you select <strong>Percentage of elements</strong>, a score percentage is shown for each instance. For example, 6.4% of the total incidents are Critical, 11.8% are High, and so on.</td>
</tr>
</tbody>
</table>
## Column settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current score</td>
<td>Display the score from the latest data collection.</td>
</tr>
<tr>
<td>Trend</td>
<td>Display the direction the indicator is moving. The trend is shown in a mini-chart on the dashboard.</td>
</tr>
<tr>
<td>Multiple scores</td>
<td>Adds scores to the Analytics Hub. Select the number of additional scores to display in <strong>Number of periods</strong>. Select the length of each period in <strong>Period step</strong>. If <strong>Current Score</strong> is also selected, the Score column is counted as the most recent period and N-1 periods are added.</td>
</tr>
<tr>
<td>Change</td>
<td>Display the change from the previous score.</td>
</tr>
<tr>
<td>Change %</td>
<td>Display the percentage change from the previous score.</td>
</tr>
<tr>
<td>Target</td>
<td>Display the target for the indicator if a target has been defined.</td>
</tr>
<tr>
<td>Gap</td>
<td>Display the difference between the current and the target scores. Gap can be either positive (moving towards the target) or negative (moving away from the target).</td>
</tr>
<tr>
<td>Gap %</td>
<td>Display the percentage difference between the current and target scores. Gap % can be either positive (moving towards the target) or negative (moving away from the target).</td>
</tr>
</tbody>
</table>

## Latest score settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare score with</td>
<td>This tab is shown when the visualization type is Latest Score. Select Previous Score or Periods Back. You can specify any number of previous periods.</td>
</tr>
</tbody>
</table>

### Personalized visuals

Configure visuals with dynamic elements to show information that applies only to the person looking at the visual on a dashboard, service portal, or Workspace.
canvas. A visual can display only the tickets assigned to a support agent or the number of tasks assigned to the team of a manager, for example. When you navigate to an Analytics Hub from a personalized visual, the Analytics Hub is personalized as well.

Use personalized visuals to push Performance Analytics down to the managers and line workers. It can be particularly useful to add widgets with personalized visuals to service portals. Enable managers who log in to their portal to see analytics only for records that belong to groups they own. Enable line workers who log in to their portal to see analytics only for records that belong to them or to one of their groups. Performance Analytics comes with the "One of my groups," "Groups I manage," and "Me" element filters to let you create such personalized visuals.

Personalization applies to Time Series, Score, and Breakdown widgets. When you configure personalized visuals, the personalization applies wherever the widget appears: a dashboard, landing page, or the Service Portal.

Technically, you personalize a visual by applying an element filter to the widget instead of specifying breakdown elements. The personalization comes about through using a dynamic condition on the filter, such as [is (dynamic)] [me].

⚠️ Note: Personalized visuals apply only to first-level breakdowns.

**Showing multiple elements**

When an element filter returns more than one element, the scores for these elements are shown as an aggregated value on Score and Time Series widgets. However, these scores are shown separately on Breakdown widgets. The following example shows a Time Series widget and a Breakdown widget with the same personalized visuals. The logged in viewer is a member of the Technical Services Support, SAP Support, and Marketing Systems Support groups. The Time Series widget, on top, shows an aggregate view of these groups, while the Breakdown widget underneath shows a separate view.
Time Series widget and Breakdown widget with personalized visuals

Number of open incidents in groups that I am a member of - Time Series widget

Number of open incidents in groups that I am a member of - Breakdown widget
Note: When you configure a widget to follow the elements on a breakdown dashboard, your choice of an Aggregate or Separate view of multiple elements does not affect personalized visuals. For example, the following time series widget on a breakdown dashboard is configured to show multiple elements separately. This configuration applies to elements of the Category breakdown on the dashboard. However, the widget still shows the elements of Assignment Group from the personalized visual as an aggregate.

For more information, see Configure widgets for breakdown dashboards.

Configure a widget with personalized visuals

Personalized visuals enable you to share the information that is most relevant to the person who uses the visual on a dashboard or canvas. You personalize the visuals of a widget by applying an element filter.

Before you begin

Note: Personalized visuals apply only to first-level breakdowns.

Role required: pa_admin, pa_power_user

Procedure

1. Create one or more breakdown element filters with a dynamic condition, such as \[\text{is (dynamic)} \] \[\text{me}].
   Before you create an element filter, verify whether you can use an existing one.

2. Navigate to Performance Analytics > Widgets.

3. Select the widget that you want to personalize.
4. On the Widget form, select the breakdown that applies to the personalization, such as Assigned To or Assignment Group.

5. On the Element Settings tab, click the magnifier to select the Elements filter that applies to the breakdown and personalizes the widget.

6. Click Update.

**Results**

On a dashboard, Service Portal, or canvas that has this widget, the widget shows breakdown elements filtered for the viewer.

**Personalized visuals example**

To personalize a visual, you create an element filter and configure a Performance Analytics widget with the same filter. In this example, you create a filter to show only the incidents that belong to the user, then you configure a score widget with the filter you create.

**Before you begin**

Role required: pa_admin, pa_power_user

Element filters are persistent. Once you create an element filter, you can apply it to multiple visuals.
About this task
In this example, you create an element filter that uses the Users.Active breakdown source to filter on the user viewing a widget. Then you configure the widget to use the new element filter, and then you view the widget on a dashboard.

Procedure
1. Navigate to Performance Analytics > Elements Filters and create a new elements filter with the details in the Element filter fields table. For more information, see Create an elements filter.

Element filter fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown source</td>
<td>Click the magnifier and choose Users.Active. The element filter is available for any breakdowns based on this breakdown source.</td>
</tr>
<tr>
<td>Facts table</td>
<td>Choose the breakdown source facts table. The facts table for Users.Active is Group Member [sys_user_grmember].</td>
</tr>
<tr>
<td>Filter</td>
<td>Specify the filter conditions to limit the available elements. Only elements that meet these conditions are displayed when you apply this element filter. For this element filter, specify [User][is (dynamic)][Me]. For Personalized visuals, the operator in the filter condition must be [is (dynamic)].</td>
</tr>
<tr>
<td>Roles</td>
<td>Select any roles that a user must have to select this element filter. A user must have at least one of the specified roles. If no roles are specified, all users can access this element filter. For this example, we don’t want to limit who can select the filter.</td>
</tr>
</tbody>
</table>
2. Create a score widget with the details in the widget fields table. For more information, see Performance Analytics widgets. The important thing to know is that the elements filter applies to the indicator’s first-level breakdown.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>My open incidents</td>
</tr>
<tr>
<td>Indicator</td>
<td>Number of open incidents</td>
</tr>
<tr>
<td>Breakdown</td>
<td>Select Assigned To. If this breakdown is not available, add it to the indicator. For more information, see assign and map breakdowns.</td>
</tr>
<tr>
<td>Type</td>
<td>Score</td>
</tr>
<tr>
<td>Visualization</td>
<td>Latest Score</td>
</tr>
</tbody>
</table>

3. On the Element Settings tab of the widget, select Me, the Elements filter you created in step 1. Users who can see the widget My open incidents, see the score only for the incidents assigned to them.

4. Add the My open incidents widget to a dashboard.

What to do next
Log in as a user who is assigned incidents and open a dashboard with the My open incidents widget. The My open incidents widget
shows the score only for the incidents assigned to that user.

Click the score to open the Analytics hub for this indicator, filtered on the user looking at the dashboard.

Create a heatmap visualization in a pivot widget

To group the scores of an indicator by two breakdowns, use a heatmap visualization in a pivot widget.
Before you begin
Role required: pa_power_user or admin

About this task
If you want to apply two breakdowns to an indicator, create a pivot widget with the breakdowns as the two axes of the pivot table. Heatmaps, which use a color gradient to highlight when both scores are high, are the only visualization available for pivot widgets.

Note:
- Pivot widgets do not support the Follow Element function. Dashboard breakdowns cannot apply to these widgets.
- Heatmaps cannot display more than 1000 cells. If the total number of elements of the two breakdowns is above 1000, the heatmap does not appear.

Procedure
1. Navigate to Performance Analytics > Widgets.
2. Click New.
3. In the Name field, give the widget a name that reflects the information being displayed.
4. In the Type field, select Pivot.
   - If you change the value of Type after you fill in other fields, those fields are cleared.
5. In the Visualization field, select Heatmap.
6. In the Indicator field, select the indicator which you want to break down.
7. In the **Breakdown** field, select the breakdown to be the X-axis.

8. In the **2nd Breakdown** field, select the breakdown to be the Y-axis.

9. **Optional:** In the **Display Settings**, set the color scheme and whether to display data labels and the legend.

10. Click **Submit**.

**What to do next**
To view the widget, add it to a dashboard or a portal.

**Text analytics and text widgets**
Text analytics reveal any patterns that exist in user-entered text fields.

Text analytics provides visual tools for analyzing the text that users enter in forms. The possible benefits of such analyses include early warning of customer pain points, disclosure of fraudulent activity, and the extraction of certain entities or concepts that are clustering in sales, incident reports, etc. The useful information in this unstructured, qualitative data may be hidden from other tools.

**Note:** Text analytics is available only with licensed Performance Analytics.

Text analysis begins with indexing the text. Text indexing is defined on indicator sources, to allow for the reuse of a single index configuration by many indicators.

When you set up text analytics, you decide on:

- Which fields in an indicator source to index.
- Which indicators to apply a text index configuration to.
- Which stop words to exclude from analysis.
- What phrases to search for, besides single words.
- Keywords for default filtering.

When you have set up text analytics, create a widget to visualize the text and include the widget in a dashboard.

The following video walks you through the process of setting up and viewing text analytics:

Demonstrates how to create a Performance Analytics text analytics word cloud widget, which analyzes unstructured or qualitative data. You will also learn how to set up and collect data for text analytics widgets.

**Set up text analytics**
Select the text fields to analyze and which indicators to analyze.
Before you begin
Text analytics relies on specific steps in the data collection jobs. The **Collect** parameter in the relevant jobs must be set to collect text analytics. A job is relevant if it collects data for the same indicators that are subject to text analysis. See Create or schedule a data collection job.

Role required: pa_power_user or pa_admin

Procedure
1. Navigate to **Text Analytics > Setup Fields**.
   - To create a new text analytics configuration, click **New**.
   - To edit an existing text analytics configuration, click the information icon in that row and select **Open record**. Clicking the indicator source name opens the record for that indicator source, not the text analytics configuration.
2. Select the **Indicator source** whose input text you want to analyze.
3. Unlock **Fields to analyze** and select the fields whose input text you want to analyze.
   - You must select at least one field. Usually you want to include the **Short description** field.
   - You cannot select the following fields:
     - Dot-walked fields
     - Translated Text fields
     - Any other field with a type other than String
4. **Optional**: Select **Use system stop words** to include the Zing stop words.
   - Selected by default. The Zing global stop words apply to the indicator source. If you do not use the Zing stop words, you must select all stop words yourself.
5. Save the text index configuration.
   - The **Indicators** related list appears at the bottom of the form.
6. In the **Indicators** list, click **Edit** and select the indicators to analyze.
7. Run a relevant historical data collection job to collect initial data.
   - You may be able to run a job from this form, or you may have to run a historical data collection job. See the next topic for details.

Related information
- **Zing removes stop words from queries**

Collect initial text analytics data
When you configure text analytics for an indicator source, no data is available until a relevant data collector job is run. If you have newly created a text
analytics configuration, run a special collection job. If you have added
indicators to an existing text analytics configuration, run a historical data
collection job to collect only text analytics.

Before you begin
Role required: pa_power_user or admin

Procedure

• On the **Setup Fields** form, if the button is available next to **Save**, **Update**, and
  **Delete**, click **Run collection**.
  This button launches a single-use historical job that collects only text indexes. It
  is available only when you create a text analytics configuration.

  This job collects data for a period equal to the shortest period for which there
  is data for any of the indicators in the analysis. For example, if you are running
  text analysis on five indicators and you have one year of data for four of them
  but only four months of data for the fifth indicator, four months of text analytics
  are collected for all five indicators.

• If you have added an indicator to an existing text analytics configuration,
  configure and run a historical data collection job.

  1. Navigate to **Data collection > Jobs**.

  2. Create or edit a historical data collection job as described in **Create or
     schedule a data collection job**, with the following characteristics:
     ◦ Set the **Collect** job parameter to **Text indexes only**.
     ◦ Set the **Run** job parameter to **On demand**.
     ◦ Set **Relative start**, **Relative start interval**, **Relative end**, and **Relative end
       interval** values that are appropriate for the indicators for which you are
       performing text analytics.
     ◦ Ensure that the indicators for which you are performing text analytics
       match the indicators for the collection job.

  3. Execute the job.

What to do next
Now that text analytics are configured and initial data is collected, you can
create text analysis widgets for the selected indicators. Consider setting text
analytics stop words first. Both these stop words and the Zing stop words can
apply.
Select text analytics stop words
Select words to exclude from text analysis. You can exclude words at either the indicator source or the indicator level.

Before you begin
Role required: pa_analyst or pa_admin

Prerequisites
Set up text analytics

About this task
Select stop words to apply either at the indicator source or at the indicator level. If you select stop words for an indicator, you can filter the scores to which the stop words apply by breakdown and breakdown element. If you select stop words for an indicator source, you exclude them from data collection, which results in a leaner index.

By default, the Zing global stop words apply in addition to the stop words you select in this form. You can disable this behavior in the text index configuration. To find the list of the current stop words, navigate on your instance to System Definition > Text Index Stop Words.

Procedure
1. Navigate to Text Analytics > Stop Words and click New.
2. In the Type field, select either Indicator or Indicator source.
   If you specify an indicator, you can filter the text by one or two levels of breakdown.
   When specified on the indicator source, stop words are removed from data collection to keep the index lean. However, you cannot immediately bring these stop words back into the widget by removing them from the Stopwords field. They do not appear until the next data collection.
   Stop words that are specified on the indicator remain in the index. These stop words can be brought back into the widget immediately by removing them from the Stopwords list, but index size may affect performance.
3. Select either the Indicator or the Indicator source to which to apply the stop words.
4. Optional: To filter the text by a breakdown, select values in the Breakdown and first Element fields.
   If you select a breakdown but not an element, the widget analyses only the text that is not associated with any element of that breakdown.
5. Optional: If you have selected a breakdown and you want to filter the text by a second breakdown, select values in the 2nd Breakdown and second Element fields.

6. In the Stopwords field, enter a comma-separated list of words to exclude from the text analysis.

7. Click Submit.

Search text for phrases
You can specify phrases that text analytics searches for, instead of searching for only the most frequent individual words.

Before you begin
Role required: pa_analyst, pa_power_user, or admin

Prerequisites
- Set up text analytics
- Collect initial text analytics data

Procedure
1. Navigate to Text analytics > Phrases and click New.
   To edit an existing text index phrases form, click the information icon for that form, then select Open Record from the preview window.

2. Select the Indicator that you want to search for phrases. Text Analytics must be set up for this indicator.

3. Optional: In the Breakdown and Element fields, you can filter the records that are searched for the phrases.
   Specify both a breakdown and an element. You can filter to a second level by filling in the level 2 Breakdown and Element fields.

4. Enter a comma-separated series of phrases in the Phrases field.
   For example, enter "can't access, don't see."

What to do next
When you include a text widget for this indicator in a dashboard, the specified phrases appear in the trend line.
Create a text widget

To help analysts visualize any patterns in user-entered text in an indicator, create a word cloud visualization in a text widget.

Before you begin

Text indexing must be configured for the relevant indicator source, and this configuration must include the relevant indicator.

Text analytics is available only with the licensed version of Performance Analytics.

Role required: pa_power_user or admin

Prerequisites

Set up text analytics
Collect initial text analytics data

About this task

The Text widget provides a word cloud for visualizing the frequency of words and phrases.
Procedure

1. Navigate to Performance Analytics > Widgets and click New.

2. In the Name field, give the widget a name that reflects the information being displayed.

3. In the Type field, select Text.
   - If you change the value of Type after you fill in other fields, those fields are cleared.
   - Word Cloud is automatically selected as the Visualization.

4. In the Indicator field, select the main indicator for which you want to analyze text.

5. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only text that is associated with the specified element of the specified breakdown is analyzed. Select values for both Breakdown and Element. Otherwise, only text that is</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
</tbody>
</table>

6. To have the widget follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

a. Select **Follow element**.

   Selecting this option removes the ability to set a second breakdown and element on the widget.

b. Optional: Set which of the available breakdowns to follow in **Followed breakdown**.

   Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

   (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.

   **Note:** Record watcher is not supported on Score widgets when multiple elements are selected on a breakdown dashboard. In this case, real time is refreshed only on page refresh.

   For more information, see Configure widgets for breakdown dashboards.

7. Set the cutoff value, which filters which words and phrases are shown in the widget based on the frequency of a word or phrase in the field:
a. In the Cutoff field, select whether the cutoff value is a numerical count or a relative percentage.

- **Count** is the number of occurrences of a word or phrase in the field. For example, if the cutoff settings are `[Count][Greater than or equal to][10]`, the widget shows only words and phrases that occur ten or more times.

- **Percentage** refers to the percent of occurrences of all words in the field that are occurrences of the word or phrase. For example, if there are 30 total occurrences of all words in the field and the cutoff settings are `[Percentage][Greater than or equal to][10]`, the widget shows only words or phrases that occur three or more times.

b. In the Cutoff conditions field, select whether the cutoff value is a minimum or a maximum.

- **Greater than or equal to** has the widget show a word or phrase if it is at least as common as the cutoff value.

- **Less than or equal to** has the widget show a word or phrase if it is no more common than the cutoff value.

c. In the Cutoff value field, specify an integer value.

8. **Optional:** Set any of the remaining display settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default field</td>
<td>If multiple fields are selected in the text index configuration, this field appears by default.</td>
</tr>
<tr>
<td>Maximum number of words</td>
<td>The maximum number of words to be displayed in the word cloud</td>
</tr>
<tr>
<td>Maximum number of trendlines</td>
<td>The maximum number of trend lines to be displayed beneath the word cloud</td>
</tr>
</tbody>
</table>

**What to do next**

- Add the widget to a dashboard.
- The admin or the dashboard owner shares the dashboard containing the widget with these users.
• Text analysis uses special steps in the data collection job. If no data is available for the widget, verify that the relevant data collection job has run and that the job collects text indexes. See Collect initial text analytics data.
• Filter the word cloud by keywords.

Save keywords for text analytics

You can save keywords that will always filter a text analytics widget. You can save them directly on the widget in a dashboard, choosing from the words in the word cloud. Alternatively, you can create or edit a record of saved keywords.

Before you begin
Role required: pa_analyst or admin

Prerequisites
- Set up text analytics
- Collect initial text analytics data

About this task
To filter a word cloud by keywords, click the words in the cloud. You can save a list of the keywords, which will be used whenever someone views the widget. Each list of keywords applies to one breakdown and element combination for the indicator in one widget. In the following example, the word "battery" has been specified as a keyword. If you click Save, all viewers will see this widget filtered by "battery." Anyone with the required roles can delete the saved keywords later.
Alternatively, you can create or edit the record where the keywords are saved. This approach does not restrict your selection to keywords that have already appeared in the word cloud.

**Procedure**

1. Navigate to **Text Analytics > Keywords** and click **New**.
2. In the **Widget** field, specify the widget to which the keywords apply.
3. In the **Indicator** field, specify the indicator to which the keywords apply.
4. In the **Field** field, select the indicator field that the keywords apply to.
5. **Optional:** In the **Breakdown** and **Element** fields, you can filter the records to which the keywords apply by a breakdown element. Specify both a breakdown and an element. You can filter to a second level by filling in the level 2 **Breakdown** and **Element** fields.

If you specify a breakdown and element combination, the keywords only apply when that combination is selected in the widget. If you do not specify a breakdown and element combination, the keywords apply for all breakdown and element combinations that do not have keywords selected specifically for them.
6. In the **Keywords** field, enter a comma-separated list of keywords.

7. Click **Submit**.

**Monitor a workflow with a workbench process widget**

A workbench process widget is a collection of indicators that tell a story. The widget enables you to analyze multiple facets of multiple indicators on one screen without drilling down. This widget is useful when you want to monitor a process or service that has a workflow.

You choose the main indicators on the top of the widget. Optionally, each main indicator can have a unique set of supporting indicators.

The widget has four interconnected sections that dynamically update. For example, when you click a main indicator its score, trend, supporting indicators, and breakdown information appear. Click or select a date on any visualization and the entire widget displays data for that day.

**Note:**

- If real-time scores are supported for the main indicator and its applied breakdowns, you can view real-time scores. To view real-time scores, select **Real-time** in the date selector. Real-time scores are displayed only in the top pane of the workbench. For more information, see **Real-time scores**.

- The timespan that the widget shows for each score trend depends on the frequency of the indicator. The timespans are: 60 days for daily, one year for weekly and monthly, three years for quarterly, and 12 years for yearly. You cannot set this time span. However, applying a time series aggregation in the widget changes the time span accordingly.
The bottom section of the workbench process widget displays either available breakdowns or collected records for the selected indicator. Click the **Breakdowns** or **Records** tabs to display one or the other. If you select a supporting indicator that specifies an aggregate, such as the average age of open incidents, the **Records** tab is hidden.

When you create a workbench widget, you choose only main and supporting indicators. The score, trend, and breakdown sections of the widget are automatically configured and cannot be changed. However, you can change the order and appearance of indicators on the widget.

**Create a workbench process widget**

Create a workbench widget to monitor a process using multiple indicators.

**Before you begin**

- Familiarize yourself with the structure of the workbench widget
- Decide which main and supporting indicators to include
- Role required: pa_admin, pa_power_user, or admin

**Procedure**

1. Navigate to **Performance Analytics** > **Widgets** and click **New**. A new widget record appears.
2. **Name** the widget.
3. In the **Type** field, select **Workbench**.
4. Right-click the form header and select **Save**.
The Main Widget Indicators related list appears.

5. Add a main indicator to the workbench widget. Main indicators appear on the top of the widget. The maximum number of indicators you can add is specified in com.snc.pa.widget.max_widget_indicators. The default maximum number of widget indicators is seven.

a. Click New in the Main Widget Indicators related list.

b. Select an Indicator.

c. Set the Order to define where the indicator appears (from left to right).

d. Fill in other fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>A breakdown element filters the data that appears in the indicator. If you select a breakdown you must select an element. For example, if your indicator is <strong>Number of open Incidents</strong> and you select Breakdown for <strong>State</strong> and Active for <strong>Element</strong>, only scores for incidents in the active state are included in the widget.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Adds a second breakdown element that filters the data that appears in indicator. If you select a 2nd breakdown you must select an element. For example, imagine your indicator is <strong>Number of open incidents</strong> and the first breakdown filters for active state. You then select <strong>Category</strong> for 2nd Breakdown and <strong>Software</strong> for <strong>Element</strong>. The indicator will now display only scores for open incidents that are active and in the software category.</td>
</tr>
<tr>
<td>Time series</td>
<td>Adds the specified time period and aggregation to the widget’s trend visualization. Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Follow element</td>
<td>Specifies that a breakdown element applied to the dashboard where the widget is added also applies to the indicator. If you specify a 2nd Breakdown, Follow element is ignored.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Specifies that only this breakdown applies to the indicator as a <strong>Follow element</strong>. All other breakdowns applied to a dashboard where the widget has been added will be ignored. If you do not specify a <strong>Followed breakdown</strong> all breakdowns applied to the dashboard will apply to the indicator.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies the name of the indicator on the widget. If you do not specify a Label, the name of the indicator is used.</td>
</tr>
</tbody>
</table>

**e.** Right-click the form header and select **Save**.  
The Supporting Widget indicators list appears.

**6. Optional:** Add supporting indicators.  
When you click a main indicator, its supporting indicators appear in the middle of the widget. You can add an unlimited number of supporting indicators.

- **a.** Click **New** in the **Supporting Widget Indicators** related list.
- **b.** Select an **Indicator**.
- **c.** Set the **Order** to define where indicator appears (from left to right).
- **d.** Fill in other fields, as appropriate. You can configure supporting indicators the same way as main indicators. See step 5 for configuration options.
- **e.** Click **Submit** to return to the Main Indicator record.
- **f.** Repeat step 6 until you have added all supporting indicators.

**7.** Click **Update** to return to the widget record.

**8.** Repeat steps 5 - 7 until you have added all indicators.

**9. Optional:** Select one of the main indicators as the **Default indicator**.  
This default indicator appears automatically when a user views the widget. If you do not specify a default indicator, the widget displays the main indicator with the lowest **Order** value first.

**10.** Click **Update** to save the widget.
What to do next
Review the widget to ensure that the new indicators are correct. If you have not already, add the widget to a dashboard to view it.

Add widget indicators
Add any number of secondary indicators to an existing time series or list widget.

Before you begin
The widget must exist. If you want to add indicators to a widget that you are creating, save the widget instead of submitting it. The form remains open and the Widget Indicators related list appears at the bottom.

Role required: pa_power_user or admin

About this task
When you create a time series widget, you associate it with a single, main indicator. If you want to compare this indicator to another indicator in the same widget, add the additional indicator to the existing widget. This procedure is necessary when you create a Stacked Column visualization for a time series. When you create a list widget, you must either specify an indicator group or add widget indicators.

Note: When you include main and widget indicators with different frequencies on a time series widget, be aware of how the widget shows time values on the x-axis. For more information about this behavior, see KB0755757.

Warning: You cannot have Previous Period Chart and widget indicators on the same time series widget. If you enable Previous Period Chart on a time series that already has widget indicators specified, the widget indicator list is cleared.

If the widget follows elements on a breakdown dashboard, the Show multiple elements as value applies to both the main widget and any widget indicators. If Aggregate is selected but one of the widget indicators does not support the Aggregate view, that indicator does not follow the elements on the breakdown dashboard. Instead, the indicator follows any first-level breakdown and element that are set in the widget configuration. The other indicators follow the elements on the breakdown dashboard and show an aggregate of their values. For more information, see Configure widgets for breakdown dashboards.

When a user selects breakdown elements on a breakdown dashboard, the breakdown and element names are appended to the widget indicator names. Widget indicator labels also have the breakdown and element names.
appended. The breakdown and element names are not appended to the widget indicator names and labels in the following circumstances:

- The widget shows an aggregate view of multiple elements, and the widget indicator does not support this view.
- The widget does not follow elements.
- The widget indicators do not support the selected breakdown elements.

Procedure
1. Either save a widget that you are creating, or open an existing widget for editing.
   You can open a widget either from Performance Analytics > Widgets or from the dashboard. For more information, see Edit a responsive dashboard.
2. Scroll to the bottom of the form and locate a related list with the label Widget Indicators.
3. Click New.
4. In the Indicator field, select a secondary indicator for the widget.
   Selecting too many indicators might make your widget difficult to read.
5. In the Chart type field, select a visualization for the indicator.
   Select a visualization that works well with the visualization of the primary indicator. For instance, show the primary indicator as columns and the secondary indicators as lines. If you are using a Stacked Column visualization for the primary indicator of a time series widget, set all secondary indicators to also use Stacked Column.
6. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If the widget indicator is on a time series widget, you can specify an elements filter instead of a first-level element. See Step 8.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Applying time series aggregations.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget for an indicator that uses such a calendar.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which this indicator appears, if the widget has several secondary indicators. Consider adding extra digits, such as 200 and 300 instead of 2 and 3. This way, if you later add more indicators, you only have to specify the order of the new indicators. You do not have to resp securing the order of all secondary indicators.</td>
</tr>
<tr>
<td>Chart type</td>
<td>The type of chart for displaying the widget indicator</td>
</tr>
<tr>
<td>2nd Y-axis</td>
<td>Add a Y-axis for this indicator. (Optional) Only one secondary indicator Y-axis is displayed. If a second Y-axis is selected for several secondary indicators, only the axis for</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>the indicator that originally came first in the order is shown.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for this indicator.</td>
</tr>
<tr>
<td>Label</td>
<td>A custom label for this indicator.</td>
</tr>
</tbody>
</table>

7. To have the widget indicator follow the breakdown elements that are selected on a breakdown dashboard, follow these steps:

   a. Select **Follow element**.

      Selecting this option removes the ability to set a second breakdown and element on the widget.

   b. **Optional**: Set which of the available breakdowns to follow in **Followed breakdown**.

      Breakdown dashboards let you select a breakdown source and elements. However, an indicator can use more than one breakdown that is based on the same breakdown source. Use this setting to determine which of these breakdowns to apply in a breakdown dashboard.

      (Optional) For example, the indicator Number of open incidents uses two breakdowns: Assigned to, and Opened by. Both breakdowns are based on the Users.Active breakdown source. Consider the case where you create a widget for this indicator and you have the widget follow elements on breakdown dashboards. You want the widget to display separate values for the elements of the Assigned to breakdown. Therefore, you select **Assigned to** in the field **Followed breakdown**.

      For more information about breakdown dashboards, see **Using breakdowns on dashboards**.

8. (Time series widgets only) In the **Elements Filter** tab, you can select an element filter to use instead of selecting a first-level element in the **Element** field. See **Element filters**.

   Use this approach to personalize which breakdowns are shown depending on the viewer. For more information about using element filters to personalize widgets, see **Personalized visuals**.

   **Note**: On a dashboard, the names of all the elements that the elements filter passes are appended to the indicator name or label of the widget indicator.

9. Click **Submit**.
What to do next
To edit any of these settings later, go to the Widget Indicators list and click the information icon for the indicator, not the name.

Related information

Related lists

Set the on-click behavior of a widget
You can configure what happens when a user clicks on a widget.

Before you begin
Role required: pa_power_user, pa_admin, or admin

About this task
By default, when a user clicks on a widget, the detailed Analytics Hub for the widget indicator appears. You can configure a widget to direct users to a different URL instead.

Procedure

1. Navigate to Performance Analytics > Widgets.
2. Select the widget you want to configure.
3. In the On-click behaviors related list, click New and create a new record.
   If you create more than one On-click behavior record for a single widget, only the record with the lowest Order value is used.
   a. In the Label field, enter the text that appears for this option when a user clicks on the widget.
   b. In the Type field, select URL.
   c. In the Value field, enter the URL that you want to direct users to when they click on the widget.
      Only URLs relative to the instance URL are allowed. The value must begin with a / character, such as /incident.do.
   d. Click Submit.

Create a color scheme for widget visualizations
Create a color scheme to predefine and reuse a set of colors in Performance Analytics widgets.
Before you begin
Role required: pa_power_user or pa_admin

Procedure
1. Navigate to Performance Analytics > Chart Color Schemes.
2. Click New.
3. Enter a descriptive Name.
4. Select colors in the Color 1 and Color 2 fields.
   A color scheme must have at least two colors. All other colors are optional.
5. Optional: Select up to 32 total colors to include in the color scheme.
6. Click Submit.

What to do next
Select the color scheme in a new or edited Time Series or Breakdown widget. For an example, see the description of the Color Scheme field in Create a line visualization for a time series widget.

Performance Analytics widgets on Service Portal
You can show Performance Analytics indicators and breakdowns using Service Portal.

When you edit a portal, add the Performance Analytics widget. Use the widget options to select an existing Performance Analytics widget to show on the portal and whether to show its title.

Performance Analytics widget

Security requirements for viewing widgets
Starting with Quebec, widgets follow indicator and breakdown access control lists (ACLs). Outside of ACLs, no roles are required for viewing widgets.
However, if you upgrade an instance from a version earlier than Quebec, by default the pre-Quebec rules still apply. Indicator and breakdown ACLs are followed only in these areas:

- List widgets follow indicator ACLs.
- When viewing breakdowns, breakdown ACLs apply.

Furthermore, on an upgraded instance, the following widgets may require users to have the pa_viewer role:

- List widgets
- Text widgets
- The Breakdowns section of Workbench widgets

Upgraded instances cannot automatically follow the rules introduced in Quebec because of the variation in how ACLs are configured.

**Related information**

Create and edit a page using the Service Portal Designer
Reports on Service Portal
Performance Analytics widgets

**Activate the Performance Analytics and Reporting - Service Portal Widgets plugin**

You can activate the Performance Analytics and Reporting - Service Portal Widgets plugin (com.snc.pa.sp.widget) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**
Role required: admin

**About this task**
The Service Portal Widget plugin activates these related plugins if they are not already active.

**Plugins for Performance Analytics and Reporting - Service Portal Widgets**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
Procedure

1. Navigate to **System Applications > All Available Applications > All.**

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

- [List of plugins](#)

View widget statistics

You can view statistics about Performance Analytics widgets to help identify and resolve problems, such as if a widget is loading slowly on dashboards.

**Before you begin**

Role required: pa_power_user, pa_admin, or admin

Procedure

1. Navigate to **Performance Analytics > Widget Statistics.**

2. Select the widget you want to view statistics for.

3. Review the following fields.

   **Report Stats fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget</td>
<td>The widget that the statistics describe.</td>
</tr>
<tr>
<td>Number executions total</td>
<td>The total number of times the widget was loaded from the server.</td>
</tr>
</tbody>
</table>
### Widget statistics properties

These properties control how widget statistics are tracked and maintained.

#### Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.report.recent_executions_number</td>
<td>The number of widget executions that are considered recent for the purpose of recent average duration calculations.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 25</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property</td>
</tr>
</tbody>
</table>

### Real-time scores

You can view some Performance Analytics scores in real-time instead of from the most recent data collection job. If real-time scores are enabled, you can view them on the Analytics Hub and in some widgets and reports.

Usually, the most recent score that a visualization can show is the one from the most recent successfully run data collection job. However, some visualizations can show indicator scores in real-time, for some indicators.
You can show real-time scores for an indicator that meets the following criteria:

- The indicator is an automated indicator.
- It is configured to show real-time scores.
- The aggregate function for the indicator does not use a script.
- The indicator source does not use a database view.
- None of the breakdowns that are applied to the indicator use a scripted breakdown source.

The following visualizations can show scores in real time:

- The Analytics Hub
- KPI Details
- Performance Analytics score widgets with the Real-time visualization
- Single-score reports
- Workbench widgets, for the main indicator

⚠️ **Warning:** Real-time scores can differ per viewer and differ from collected scores. Real-time scores are taken directly from the relevant facts tables. Therefore, the Access Control Lists (ACL) of those facts tables determine the real-time scores that each logged-in user sees.

ℹ️ **Important:** The Analytics Hub does not update real-time scores automatically. To see the most up-to-date scores on the Analytics Hub, refresh the browser page. Widgets and KPI Details do update automatically.

**Related information**

- Create an automated indicator
- Analytics Hub for a specific indicator
- Create a real-time score visualization for a score widget
- Single score report
- Monitor a workflow with a workbench process widget

**Applying time series aggregations**

You can aggregate changes in indicators into discrete time intervals. A time series aggregation consists of a function, such as AVG or SUM, combined with a time series, such as By quarter. These aggregations can make trends more easily visible, or help track progress against a target. You can set up
these aggregations either in the Analytics Hub, in KPI Details in a Workspace Experience, or on Performance Analytics widgets.

Consider a watch, phone, or fitness tracker that keeps tabs on how many steps they walked each day. These devices all collect and save your measurements on a minute by minute basis. However, the apps and reports are often designed to show how your activity is progressing compared to last week, last month, or last year. It’s one thing to see if you were more active at noon versus 10 am. What you really want to know, however, is whether you’re continuing to improve over time. Aggregating your steps into weekly, monthly, and yearly scores gives you an easier way to identify trends in your activity.

While daily indicator scores are foundational and almost always desired, sometimes you also want to have the scores available by week, month, or quarter. In other cases, you want to have a month/quarter/year-to-date number that shows cumulative progress up until the current point. Instead of defining multiple indicator sources and indicators to track each interval, Performance Analytics natively allows you to capture the data once and then adjust the view. Use a time series aggregation for any of these scenarios:

• Aggregate the data to a less frequent period with a Period time series.
• Smooth out spikes in the data to reveal trends with a Running time series.
• Determine a period-to-date cumulative score with a To date time series.

⚠️ Note: Business and fiscal calendars do not support time series aggregations. You cannot set a time series aggregation on a widget or Analytics Hub entry for an indicator that uses such a calendar.

Partial periods
Some time series include indicator scores from incomplete collection periods. These periods can include the current period and the period from the beginning of data collection. A plus sign in the name, +, identifies these time series.

A time series that does not include data from partial periods must have data from the beginning and the end of the period. For example, a **By month SUM** time series aggregation requires scores from the start and the end of the month to be present. Otherwise that month is not included. A time series that includes data from partial periods, such as **By month SUM +**, needs only data from one day in the period.

⚠️ Warning: Partial periods can skew the results of certain aggregations, such as averages.
Aggregation definitions
Performance Analytics comes with default SUM, AVG, and other time series aggregation definitions.

**DANGER:** Do not alter these definitions. Do not add new definitions. Any changes to aggregation definitions can have unexpected results. Creating a new definition can prevent the data collector jobs from running.

Disallowed time series aggregations
You are not allowed to put a SUM aggregation on an indicator with percentage % as the unit. It is not meaningful to sum percentages.

Validation of time series aggregations
Time series aggregations are validated on the Analytics Hub and in KPI Details but not in widgets. Therefore, you might navigate from a working widget to the Analytics Hub and get a warning that the indicator has an invalid aggregation.

Excluding time series aggregations for an indicator
Some time series aggregations, while technically allowed, are not helpful to apply to an indicator. For example, a SUM of percentage values is unlikely to provide useful insight. You can exclude these time series aggregations from the indicator. For more information, see Exclude time series from an indicator.

Displaying time series aggregations with a date range selector
If on a widget you combine a time series aggregation such as By month SUM with a date range selector, you may show one more time period than you expect. The reason is that when a period such as 3m is selected in the date range selector, the instance interprets that as 0-3 months and shows four months of scores.

Related information

Applying time series to result or to contributing indicators

Use cases for time series aggregations
Performance Analytics offers four different types of time series. Understand their use cases to know which type to use.

Rounded calculations based on averages may be off by a small amount due to rounding errors.
<table>
<thead>
<tr>
<th>Type</th>
<th>Examples</th>
<th>Use Case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running</td>
<td>28d running AVG/SUM</td>
<td>Smoothes out spikes in the data to make trends easier to spot. For example, looking at daily incident counts may show a drop every weekend, but a 7-day running average smooths out those drops.</td>
</tr>
<tr>
<td></td>
<td>30d running AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7d running AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12m running AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3m running AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6m running AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>13w running AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4w running AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4q running AVG/SUM</td>
<td></td>
</tr>
<tr>
<td>To Date</td>
<td>Fiscal quarter-to-date AVG/SUM</td>
<td>Shows cumulative scores for the period. These time series aggregations are very useful if you have a monthly target to hit, but you need to also see the velocity throughout the month.</td>
</tr>
<tr>
<td></td>
<td>Fiscal year-to-date AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Month-to-date AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Quarter-to-date AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Week-to-date AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Year-to-date AVG/SUM</td>
<td></td>
</tr>
<tr>
<td>By Period</td>
<td>By week AVG/SUM</td>
<td>Shows the cumulative scores for entire periods. While you may want to track the number of P1 incidents daily, the frequency is too high when scores are considered daily. Instead, you can set a target at the monthly level with a “By Month” time series. The current period will never appear in the results because it is incomplete.</td>
</tr>
<tr>
<td></td>
<td>By month AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>By fiscal quarter AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>By quarter AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>By fiscal year AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>By year AVG/SUM</td>
<td></td>
</tr>
<tr>
<td>By Period (Including Partial)</td>
<td>By week + AVG/SUM</td>
<td>The “+” version of the “By” Time Series includes partial periods, so a score is always provided for the current period.</td>
</tr>
<tr>
<td></td>
<td>By month + AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>By fiscal quarter + AVG/SUM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>By quarter + AVG/SUM</td>
<td></td>
</tr>
</tbody>
</table>
Use cases and examples for each type of time series (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Examples</th>
<th>Use Case</th>
</tr>
</thead>
<tbody>
<tr>
<td>By fiscal year + AVG/SUM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>By year + AVG/SUM</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Indicator frequency limitations on time series aggregations

The frequency with which scores are collected for the indicator determines which time series are applicable. Some time series include data from partial collection periods.

When you select a time series aggregation, the frequency with which indicator scores are collected limits which time series you can choose. You cannot select a time series aggregation that is applied to scores more frequently than those scores are collected. For example, the **By week SUM** time series aggregation can apply to an indicator with a daily frequency. However, **By week SUM** cannot apply to an indicator with a weekly, monthly, quarterly, or yearly frequency.

ℹ️ Note:

- Only weekly indicators support the **4w running** and **13w running** time series. Weekly indicators support only weekly and yearly time series.
- Bi-monthly and yearly indicators do not support any time series aggregations.

The following table shows which time series are supported for which indicator frequencies. These relationships are independent of which aggregation (AVG, SUM, or custom) is combined with a time series, and therefore only the time series are shown.

<table>
<thead>
<tr>
<th>Time series</th>
<th>Indicator frequencies</th>
<th>Quarterly (Fiscal Q, 4-weekly, Bi-weekly)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>7d running</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>28d running</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Time series</td>
<td>Indicator frequencies</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Daily</td>
<td>Weekly</td>
</tr>
<tr>
<td>30d running</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>4w running</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>13w running</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>3m running</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>6m running</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>12m running</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>4q running</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>By week, by week +</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>By month, by month +</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>By quarter, by fiscal quarter, by quarter +, by fiscal quarter +</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>By year, by fiscal year, by year +, by fiscal year +</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Week to date</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Month to date</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Quarter to date, fiscal quarter to date</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
Time series and associated indicator frequencies (continued)

<table>
<thead>
<tr>
<th>Time series</th>
<th>Indicator frequencies</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Daily</td>
<td>Weekly</td>
<td>Monthly</td>
<td>Quarterly (Fiscal Q, 4-weekly, Bi-weekly)</td>
</tr>
<tr>
<td>Year to date, fiscal year to date</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Interactive Analysis

Interactive Analysis enables you to quickly explore data using visualizations.

From any list of records, you can access an interactive set of reports on the list data. You can also manipulate the data by grouping, stacking, aggregating, and applying interactive filters. Click the visualization to drill down into the data.

Click the information icon (ℹ️) to edit the source filter, view the list of applied filters, and copy the URL of the analysis.

Interactive Analysis on Incident data

Launch Interactive Analysis

Launch Interactive Analysis from any list.

Before you begin

Role required: none

You must have access to the list of records that you want to analyze.
Procedure

1. Navigate to any list.

2. **Optional:** Configure the columns that are displayed on the list. The columns that appear on the list when you launch Interactive Analysis determine which fields are included in the analysis. The included fields determine which Group by and Stack by options are available, and which interactive filters appear by default.

3. Right-click the column header for a reference, choice, date/time, integer, or boolean field and select **Launch Interactive Analysis.** The column that you launch Interactive Analysis from is used as the default Group by value.

4. **Optional:** Change how data is aggregated by selecting different values in the Group by and Stack by choice lists, or filter the data by applying one or more interactive filters.

5. **Optional:** Drill down into a subset of the data by clicking a visualization, such as a bar in the bar chart or a cell in the heatmap.

**In-form analytics**

In-form analytics integrate performance insights into forms so that users can access important metrics in context and make better decisions.

In-form analytics involve a UI action on a form that opens a view of a dashboard based on a breakdown. This breakdown dashboard provides valuable performance insights to the user who is completing the form. For example, you want support engineers, while creating an incident, to be able to see the expected time to close the incident based on the incident category. To enable the engineers to view this information, you create an in-form analytics UI action for incident forms. This UI action opens an Incident Category breakdown dashboard with a widget that shows the expected time to close an incident.
Incident: Category in-form analytics

The UI action for in-form analytics is activated through an icon next to the field on the form that represents the breakdown. If that field is not visible in the form view, neither is the icon. When you set up in-form analytics, you have the option of also including a Related Action link on the form. This link is always available.

**Related information**

- Using breakdowns on dashboards
- UI actions

**Add in-form analytics to a form**

Create a UI action that enables users to view relevant analytics while completing a form. The UI action associates the table that uses the form, a breakdown used with that table, and a breakdown dashboard.

**Before you begin**

Role required: pa_power_user, pa_admin, or admin. In addition to the Performance Analytics roles, you must be able to create records on the UI Actions [sys_ui_action] table.
Before adding in-form analytics for a specific table and breakdown, create a breakdown dashboard that uses that table and the breakdown source of that breakdown. Design the dashboard so that it prominently displays the most useful information to the users who create records on that table. For more information about breakdown dashboards, see Using breakdowns on dashboards.

Performance Analytics must be active to create in-form analytics.

**About this task**

**Procedure**

Navigate to Performance Analytics > In-Form Analytics and create a new record (see table for field descriptions).

### In-form analytics fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the UI action.</td>
</tr>
<tr>
<td>Table</td>
<td>The table to display analytics for. The in-page icon appears on forms for this table.</td>
</tr>
<tr>
<td>Breakdown</td>
<td>The breakdown for analyzing the table. The UI action icon appears next to the field that corresponds to this breakdown, if the field is included in the form view.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>The breakdown dashboard to display. The dashboard must use the selected Table and the breakdown source of the Breakdown.</td>
</tr>
<tr>
<td>Icon</td>
<td>The icon to display next to the breakdown-related field on the form.</td>
</tr>
<tr>
<td>Icon color</td>
<td>The color of the form icon.</td>
</tr>
<tr>
<td>Create in-form link</td>
<td>Display a related link on the form in addition to the icon when this check box is selected. The related link directs to the same dashboard as the icon.</td>
</tr>
</tbody>
</table>

**Example: Incident Assignment Group in-form analytics**

Consider the case where you want support engineers who create incidents to be able to see the expected time to close the incident based on the assignment group. You have designed a widget that shows the expected time to close an incident. You have added this widget to the In-Form Analytics breakdown dashboard, which uses the Groups breakdown source. 'Groups' is the source for the Assignment Group breakdown.
Now you create in-form analytics for the Incident [incident] table, the Assignment Group breakdown, and the In-form Analytics - Incidents dashboard. You select the icon for the UI Action. This icon will appear next to the Assignment Group field. You also decide to create a Related Link to the dashboard.
Clicking the dial icon opens the pop-up view of the dashboard. Note that instead of the dashboard name, the pop-up window is titled “Analysis of [Breakdown name]”.

**Opening dashboard view from incident form**

The Self-Service view does not show the Assignment Group field by default. In this case, you can still view the analytics from the Related Links.
Preconfigured in-form analytics

Preconfigured in-form analytics are available as plugins for several applications and their associated tables and forms.

In-form analytics plugins and associated tables

<table>
<thead>
<tr>
<th>Plugin name</th>
<th>Plugin ID</th>
<th>Table and forms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics - Context Sensitive</td>
<td>com.snc.pa.change.context_sensitive_analytics</td>
<td>Change Request [change_request]</td>
</tr>
<tr>
<td>Analytics for Change Management</td>
<td>com.snc.pa.change.context_sensitive_analytics</td>
<td>Change Request [change_request]</td>
</tr>
</tbody>
</table>
### In-form analytics plugins and associated tables (continued)

<table>
<thead>
<tr>
<th>Plugin name</th>
<th>Plugin ID</th>
<th>Table and forms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics - Context Sensitive</td>
<td>com.snc.pa.chat.context_sensitive_analytic</td>
<td>Chat Queue Entry</td>
</tr>
<tr>
<td>Analytics for Chat</td>
<td>[chat_queue_entry]</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive</td>
<td>com.snc.pa.cs.context_sensitive_analytic</td>
<td>Case</td>
</tr>
<tr>
<td>Analytics for Customer Service</td>
<td>[sn_customerservice_case]</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>com.snc.pa.incident.context_sensitive_analytic</td>
<td>Incident</td>
</tr>
<tr>
<td>- Context Sensitive Analytics for Incident</td>
<td>[incident]</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>com.snc.pa.problem.context_sensitive_analytic</td>
<td>Problem</td>
</tr>
<tr>
<td>- Context Sensitive Analytics for Problem</td>
<td>[problem]</td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When you activate a plugin for preconfigured in-form analytics, you also activate the Performance Analytics Solution for that application. For more information, see [Analytics and Reporting Solutions](#).

### Performance Analytics advanced topics

Define key metrics and data structure to generate scores.

The topics in this section are meant primarily for Performance Analytics administrators who deal directly with data structures.

### Performance Analytics Admin Console

From a single console, administrators can manage Analytics and Reporting Solution content, manage Performance Analytics widgets and dashboards, diagnose and resolve errors, view usage analytics, modify configuration settings and access ServiceNow help.

Users with the admin or pa_admin roles can navigate to **Performance Analytics > Admin Console**. If Performance Analytics is not enabled, click **Learn More** for information about activating it.
### Content Library

Guided Setup for the Analytics and Reporting Solutions.  
Click **Plugin List** to show a list of available system plugins for inactive Analytics and Reporting Solutions.

**Note:** You must have the admin role to see the list of plugins.

Click **Guided Setup** to launch guided setup for Analytics and Reporting Solutions.

### Explore and Manage

A single place where you can quickly identify and manage the relationships between your Performance Analytics elements and gauge the impact of change. For example, you can identify all the reports, indicators, and interactive filters in a dashboard group that are affected if you change a field name.

Click **Dashboards** to explore all of the dashboards in your instance sorted by group. Expand the group to view the individual dashboards.

Click **KPIs** to open the **Analytics Hub**, where you see an exploratory view of your indicators.

Use **Dependency Assessment** to view, analyze, and manage your Performance Analytics components.

### Troubleshoot

Diagnose and resolve configuration errors for your dashboards.

- **Diagnostic Errors**
- **Failed Jobs**
The **Troubleshoot** panel enables you to utilize diagnostics delivered by the ServiceNow application to investigate tests that result in an Error warning and failed data collection jobs. Out-of-the-box diagnostics run on a schedule, but can also be executed on demand. The Scheduled Data Collection list filters out jobs that are run only once and jobs that are run only on demand.

**Note:** If either of the numbers on the Troubleshoot card are greater than 0, there may be something wrong with your Performance Analytics implementation.

- Click **Diagnostic Errors** to view the Diagnostic Executions list, a summary of how many diagnostic tests were run, and how many issues were found. Use the **State** field to track which issues have been resolved. For more information on diagnostic executions, see Analytics Diagnostics.

- Click **Failed Jobs** to view the Scheduled Data Collection list. A failed job is a scheduled job for which the latest complete run is in the state **collected_error**. For more information on data collection, see Performance Analytics data collection and cleanup.

### Usage

Dashboards with statistics about data collection jobs and report usage.

- Use the **Data Collection Overview** dashboard to track and manage data collection. Note that data collection jobs are not run by default. dashboard widgets do not show data until you run the associated data collection jobs. For more information, see Performance Analytics data collection and cleanup.

- Use the **Reports Usage** dashboard to track and manage report usage. For more information, see Report statistics.

### Advanced Configuration

Quick links to advanced configuration settings.

- Performance Analytics properties
- Reporting properties
- Responsive dashboard properties
Help

The community, product documentation, and the video tutorials on the ServiceNow YouTube channel provide additional insights into Performance Analytics functionality.

Related information

Interactive Analysis information panel

Performance Analytics data collection

Performance Analytics uses scheduled jobs to collect and clean scores and snapshots, and enables you to manually set or import scores.

How to create a data collection job for Performance Analytics data in the ServiceNow platform.

To collect data immediately for existing records, run a historical data collection job.

For ongoing data collection, choose one of the following methods to collect indicator scores and snapshots based on the frequency and integrity of your data.

- If you need to measure an indicator once a month, quarter, or year, enter scores manually or import scores.
- If you need to measure indicators more frequently, or you want to eliminate any human involvement, use a scheduled data collection job.

Note: Performance Analytics snapshots are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with Collect records selected.

Performance Analytics data collection jobs do not collect scores older than specified in the property `com.snc.pa.dc.keep_snapshots_for`. Scores or snapshots older than this value are not collected during data collection.

Collect historical data

Run a historical data collection job to collect scores and snapshots for existing records. When collecting data for the first time, such as for a new indicator, run historical data collection once to generate scores and snapshots for existing records.

Before you begin

Role required: pa_data_collector or admin
About this task
Performance Analytics regularly collects scores from your data on an ongoing basis. When you first set up Performance Analytics for an application, or when you create new indicators or indicator sources, run historical data collection to collect scores on your existing data. Historical data collection enables you to analyze data that existed prior to setting up Performance Analytics.

⚠️ Warning: Avoid running a historical collection job more than once. If for example you create a new indicator, consider creating a new data collection job for that indicator instead of adding it to an existing job.

ℹ️ Note: A historical data collection job deletes any previously collected data for the periods and the indicators that the job covers. It does not delete data from outside that date range or for other indicators.

Historical jobs also collect snapshots of the existing data. Performance Analytics snapshots are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with Collect records selected.

Procedure
1. Navigate to Performance Analytics > Data Collector > Jobs.
2. Select a historical data collection job, such as [PA Change] Historic Data Collection, or create a new historic data collection job.
3. If you are creating or editing the historic data collection job, follow the procedure in Create or schedule a data collection job.

⚠️ Important: For a historical data collection job, set Run to On demand. Do not run historical data collection jobs on a fixed schedule.

4. In the job indicators, exclude any breakdowns that are based on fields whose value is likely to change during the historical collection period, as described in Configure a job indicator.
   For example, in the provided [PA Incident SLA] Historic Data Collection job, the job indicator ‘Number of open and overdue incidents’ excludes the Assignment Group and the State breakdowns. The value of both of these breakdowns could change over the data collection period, making the results meaningless.

5. Click Execute Now.

What to do next
After collecting historical data, use a scheduled data collection job to collect new scores regularly.
Create or schedule a data collection job

Schedule a data collection job to regularly collect scores.

Before you begin

Before defining data collection jobs, make sure that indicator sources, breakdown sources, and indicators have been defined. Otherwise, jobs cannot return any results.

Roles required: pa_data_collector or admin

About this task

The important items to know when you configure a data collection job are:

• Collection period
• Collection timezone
• Collected scores domain, if domains are used.
• The collection job runs without any restrictions. It does not use the permissions of the user who runs it.

Data collection jobs run different steps to collect scores and to collect text analytics data. By default, jobs collect both types of data. To improve performance, you can instead schedule separate jobs for scores and for text analytics data.

Procedure

1. Navigate to Performance Analytics > Data Collector > Jobs and click New. You can instead edit an existing data collection job, for example to change the schedule of when the job runs. In this case, navigate to Performance Analytics > Data Collector > Jobs and click the job name.

2. In the Name field, give the job a meaningful name. Follow a standard format for naming data collector jobs, such as [PA Indicator] Daily Data Collection, [PA Indicator] Historic Data Collection...

3. In the Operator field, select whether to collect data for an absolute or a relative time period.

<table>
<thead>
<tr>
<th>Operator value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed</td>
<td>Collects data for an absolute time period.</td>
</tr>
<tr>
<td>Operator value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Relative</td>
<td>Collect data for a period of time that is relative to the time when the job is run.</td>
</tr>
</tbody>
</table>

4. If you selected **Fixed** as the operator, select the **Fixed start** date and the **Fixed end** date.

5. If you selected **Relative** as the operator, specify the intervals prior to the run time to collect data from.

   a. In the fields **Relative start** and **Relative start interval**, set the number and the length, respectively, of time periods in the past to begin to collect data from.

   b. In the fields **Relative end** and **Relative end interval**, set the number and the length, respectively, of the last period in the past to collect data from.

   **Tip:**
   - Most indicators, and therefore most data collection jobs, run Daily. Daily scheduled jobs normally should collect for the most recently completed day. Therefore, they should have both a relative start and relative end of one day ago. Run historical data collection jobs, which have longer collection periods, only once.
   - If you plan to use this job with indicators that use business calendars, consider the **periods ago** interval. This interval is based on the periods that are defined for a business calendar.

**Example**
For example, you want to collect scores for a set of several new indicators with a daily frequency, all using the same indicator source. First you create a historical data collection job that collects data from two months ago up to the day before yesterday. For this job, enter **60** in **Relative start and days ago** in **Relative start interval**. Enter **2** in **Relative end and days ago** in **Relative end interval**. Set the **Run** field to **On Demand**. Click **Execute now** and run this job once, to collect the initial scores.

Create a second job with relative start and end of 1 day ago and set the **Run** field to **Daily**. Activate this job to collect the scores for yesterday and all future scores for the day before the job is run.

6. Fill in the **Job parameters**, as appropriate.
<table>
<thead>
<tr>
<th>Job parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run as</td>
<td>For domain separated instances, select the user that runs this job. The job collects scores from facts table and Performance Analytics records that have either the Global domain or are in the domain of this user. The data collection job follows only the domain, not the permissions of this user. ACLs and business rules do not apply to data collection jobs. Any user can run the job. <strong>Important:</strong> If you select a domain configuration for this job, it overrides the <strong>Run as</strong> user. See Step 9 in this topic.</td>
</tr>
<tr>
<td>Run as tz</td>
<td>Select the time zone that the queries use when they are executed from the job. Use the reporting time zone of your company if one exists. By default the System time zone is used. This time zone determines what day is &quot;Today&quot; for conditions like <code>[[Opened][on][Today]]</code>.</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, as it is by default, the data collection occurs at the scheduled date and time.</td>
</tr>
</tbody>
</table>
| Run           | Select the schedule for collecting the data. Choices are:  
  - Daily  
  - Weekly  
  - Monthly  
  - Periodically  
  - Once  
  - On demand  
If you are using business calendars, you also have these options, for the start and end of the business calendar period (See **Define business calendar entries**):  
  - Business calendar: Entry start  
  - Business calendar: Entry end  
If you are creating a historical data collection job, schedule the job to run **On demand**. |
| Day           | If **Run** is **Weekly**, specify the day of the week.  
  - If **Run** is **Monthly**, specify the day of the month. |
<table>
<thead>
<tr>
<th>Job parameter</th>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To collect at the end of the month, set for day 1 and set Time to soon after midnight. This setting collects data for a completed month regardless of the length of the month.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>If Run is Periodically, specify the amount of time between scheduled data collections, in days and hour.</td>
<td></td>
</tr>
<tr>
<td>Starting</td>
<td>If Run is Periodically or Once, specify the date and time of the first scheduled data collection.</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Time that the job runs, on 24 hour clock. Field appears after Active is selected.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Time based on the time zone for your user session, not the Run as tz time zone.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Generally set for an hour between midnight and 6 am at your company, to collect the last complete period.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, if you are in New York and want to collect data at 5 am for your company that is on Los Angeles time, set the time to 08:00:00.</td>
<td></td>
</tr>
<tr>
<td>Collect</td>
<td>Data collection jobs have separate steps for collecting scores and for collecting text analytics. Select one of:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Scores only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Text index only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Both scores and text index (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information, see Set up text analytics.</td>
<td></td>
</tr>
<tr>
<td>Conditional</td>
<td>If checked, the data collection occurs only if certain conditions are met.</td>
<td></td>
</tr>
<tr>
<td>Conditions</td>
<td>If Conditional is selected, write a script that specifies under what conditions the job is run.</td>
<td></td>
</tr>
</tbody>
</table>

7. Right-click the form header and select **Save**.

8. In the **Indicators** related list, click **Edit** and select the indicators that this job collects data for.
Important:

- Include at least one indicator for the job. Otherwise, the job cannot return any results.
- To help keep jobs maintainable, try not to associate an indicator with more than one active collection job unless you have a clear use case. If you are trying to get real-time data, consider using a real-time indicator.

Note: The data collection job produces one database query for each indicator source for the associated indicators. Thus the data for all indicators that share an indicator source represent the same point in time.

9. If you have enabled domain configurations, you can select a domain configuration to associate with this job in the Domain configurations related list. Domain configurations are grouping of domains based on their visibility to a user group or other condition. These groupings can include parent-child relationships. If you select a domain configuration for a job, the job collects scores for records in the domains of the configuration, including the global domain. Domain configurations override the Run as user. For more information, see Grouping domains in Performance Analytics domain configurations.

10. Click Submit.

What to do next

- By default, for each job indicator, data is collected for all breakdowns and the indicator itself. To change this configuration for an indicator, see Configure a job indicator.
- If you have enabled domain support, you have a related list named Domain configuration. In this tab, click Edit to relate an existing domain configuration with this job or click New to create a new domain configuration. For more information, see Create a domain configuration.

Configure a job indicator

Increase the efficiency of data collection by configuring job indicators to collect only necessary and sensible data.

Before you begin
Role required: admin, pa_admin
**About this task**

By default, a job indicator collects data for the indicator itself and for all breakdowns that are associated with that indicator. However, not all breakdown data might make sense for a particular data collection job. For example, breakdowns that are based on fields that are likely to change over a collection period, such as Assignment Group and State, are usually excluded from historical jobs. Often, the job collects the value of Assignment Group and of State only at the time the job is run. A six-month-old incident, hopefully completed, can end up with a State of Complete for its entire six-month history. Such values are misleading.

Alternatively, you might need to collect only breakdown data and not to calculate the indicator scores. You can configure a job indicator not to collect unnecessary or meaningless data, thus reducing the resource consumption of the job.

**Procedure**

1. Navigate to **Performance Analytics > Jobs**.

2. Open the job for which you want to configure a job indicator. Job indicators are specific to the job that uses them.

3. In the **Indicators** tab, click the name of the job indicator that you want to configure.

4. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job</td>
<td>Is automatically copied from the job name.</td>
</tr>
<tr>
<td>Indicator</td>
<td>The associated automated indicator. When you add a job indicator with the Edit button on the Scheduled Data Collection record, you select the automated indicator.</td>
</tr>
<tr>
<td>Collect indicator</td>
<td>Choose to collect <strong>All breakdowns</strong> or <strong>No breakdowns</strong>, or to exclude specific breakdowns.</td>
</tr>
<tr>
<td>Tip:</td>
<td>When you have added a breakdown to existing indicators, consider running a one-time historical collection job on these indicators to get scores for that breakdown. Collect only on the added breakdown and not for the indicators themselves.</td>
</tr>
</tbody>
</table>
5. If in the **Collect** field you chose to **Exclude these breakdowns**, select breakdowns to exclude.

   a. Open the context menu and click **Save**.  
      A related list of excluded breakdowns appears.

   b. Click **Edit** in the **Excluded breakdowns** list and add or remove breakdowns to exclude.

**Cancel a data collection job**

Cancel an active data collection job to stop the job from collecting scores.

**Before you begin**

Role required: pa_data_collector and schedule_admin, or admin

**Procedure**

1. Navigate to **Performance Analytics > Data Collector > Jobs**.
2. Select the job you want to cancel.
3. Click **Cancel Job**.

**Add or edit indicator scores manually**

You can manually enter score data for indicators, including automated indicators.

**Before you begin**

Role required: pa_contributor, pa_admin, pa_power_user, or admin

**About this task**

You typically add scores manually for indicators that require an update only once a month or less often. In addition, if data cannot be collected automatically for some entities, like customers, you can manually enter or import data.

You can manually overwrite data that a job collected. However, the next time that a job is run that collects this data, the manually entered data is overwritten in turn.

**: Note:** Auditing does not track manual changes to the scoresheet. Manual inserts, updates, and deletions are not audited, even when auditing is enabled at the Dictionary level for all pa_scores tables.
Procedure

1. Navigate to **Performance > Indicators > Scoresheet**.

2. Select the indicator for which you want to enter manual scores.

3. **Optional**: Change the selected date by clicking the left or right arrows around the date range, or click the date range to select a new range.

4. Fill in the main scores for the indicator in the **Indicator Scores** row. Alternatively, if an indicator contains breakdowns, fill in the indicator scores per breakdown element.

   **Note**: A percentage bar above each column of scores indicates the percentage of breakdown elements that contain scores. A value of 0 counts as a score; only the absence of any value counts as empty.

   a. Click **Aggregate scores**.

   b. Choose whether you want to use the **Sum** or the **Average** of a specific breakdown to calculate the main scores for the indicator.

   c. Select the breakdown to aggregate, such as **Priority**, and click **Apply**. All scores for that breakdown are totaled or the average is calculated for them.

   For automated indicators that collect a second-level breakdown and are based on two or more breakdown sources, multi-level breakdown scores can be entered in the scoresheet. For example, for Open incidents by workgroup by priority, you can enter both scores for the elements of workgroup (first level) and the elements of priority (second level). Aggregations for these indicators are calculated in the same way as other breakdowns.

Related information

- **Manual indicators**

View a data collection job event

Job events show which jobs have been executed for Performance Analytics and which actions have been triggered in your ServiceNow instance, such as notifications or business rules.

**Before you begin**

Role required: **pa_data_collector** or **admin**
Procedure
1. Navigate to Performance Analytics > Data Collector > Job Events.
2. Click Created to view the details of a specific job event.
   Additional information on the job event is displayed.

Related information
View the data collection job logs

View the data collection job logs
Job logs display information about the data collection jobs that have run for Performance Analytics. You can view job logs, create events, and view and edit the event registry. The list view displays all log entries, unless filtered.

Before you begin
Role required: pa_data_collector or admin

Procedure
1. Navigate to Performance Analytics > Data Collector > Job Logs.
The log provides the following information for all occurrences.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Date and time the data collection job started.</td>
</tr>
<tr>
<td>State</td>
<td>One of the following values: Collecting, Collected, or Collected with errors.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the job.</td>
</tr>
<tr>
<td>Completed</td>
<td>Date and time the data collection job ended.</td>
</tr>
<tr>
<td>Inserts</td>
<td>The number of new records that have been inserted.</td>
</tr>
<tr>
<td>Updates</td>
<td>The number of existing records that have been updated.</td>
</tr>
<tr>
<td>Warnings</td>
<td>The number of warnings that occurred during the data collection process.</td>
</tr>
<tr>
<td>Errors</td>
<td>The number of errors that occurred during the data collection process.</td>
</tr>
<tr>
<td>Run time</td>
<td>Duration of the job.</td>
</tr>
</tbody>
</table>
2. Click Created to view the details of a specific job. Additional information on the job settings and sequence steps is displayed. If notifications are enabled, you can send emails about the data collection results to users.

What to do next
Click on a job in the list to see a detailed log of the job. For information about the contents of individual job logs, see Data collection process and logging.

Related information
View a data collection job event

Data collection process and logging
To debug data collection, it is helpful to understand the data collection process and how it is reflected in the job logs.

As an administrator, sometimes you have to debug a data collection job. Each job generates a log, but to understand the entries in this log, you must know which step in the data collection process produced the entries.

Collection process overview
The data collection job involves executing an SQL query for each indicator source that uses the data collector. The query repeats for every collection time from the start date to the stop date. Then queries run for the next indicator source. Each step of executing a query is documented in the data collection job log.
Data collection job subprocesses

Optimizations for large datasets
Starting in Paris, the following optimizations have been made to the data collection process. These optimizations are intended to improve the handling of large datasets. You can deactivate or reset them by changing the relevant system properties. At the beginning of each job log, you are informed of which optimizations are active.
**Note:** Memory optimization involves a trade-off with the speed of data collection. Consider recalculating the length of time it takes to run your standard jobs and rescheduling if necessary. If you cannot resolve your problem through job rescheduling, consult Customer Service and Support.

- Snapshots are purged from memory and archived. By default, every 1000 snapshots are purged.
- Nested collection replaces flat mapping, to reduce redundant objects. For example, instead of creating identical indicator objects for every breakdown and artifact on that indicator, only one object is created for the indicator.
- Count Distinct aggregation is stored as a HashCode instead of as separate values.

**Data collection job log walkthrough**
In this section you can follow the data collection process as revealed in log messages. The log messages in each subprocess have been separated into their own tables.

### Starting and completing collection job

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the domain of the collection job Run As user.</td>
<td>User &lt;admin&gt; belongs to domain global</td>
</tr>
<tr>
<td>Collection starts. Job start specifies whether scores, text index, or both are being collected. Messages also specify the settings of the data collection optimization properties.</td>
<td>Starting collection of Both scores and text index. Value of properties in system - Flush Snapshot Count: 1,000 Is nested collection: true Using hashcode for count distinct: true</td>
</tr>
<tr>
<td>Shows the domains for which scores are collected. Also shows other relevant details about the domains.</td>
<td>DomainConfig: Testing Domain Config Collection logs - 3d359877b77000106886e664de11a97c, Type: conditions, RollUpType: roll_up_children, collectAggregate?: Yes, collectChildren?: Yes, AggregateDomain: Name: 3d359877b77000106886e664de11a97c - SysID: d1659c77b77000106886e664de11a91e, Domains:</td>
</tr>
</tbody>
</table>
### Starting and completing collection job (continued)

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Default, MSP, ACME, Cisco, Initech, Oceanic Airlines</td>
</tr>
<tr>
<td>Lists indicator sources that the job collects data for, including their unique IDs.</td>
<td>Indicator Sources to collect: Incidents.New: b54f2c23d7030100b96d45a3ce61032f, Incidents.Open: b5cf2c23d7030100b96d45a3ce6103cc, Incidents.Closed: 2ac8dd31ff2302001e68ffffffff3d, Incidents.Resolved: 4c207c23d7030100b96d45a3ce610308</td>
</tr>
<tr>
<td>Lists each indicator associated with the job and the indicator properties that are related to data collection:</td>
<td>JobIndicator: Number of open incidents - de537dc3d7131100b96d45a3ce610305 Job Indicator Properties: collectIndicator?: Yes, BreakdownCollectionType: WITH_EXCLUDE Excluded Breakdowns: Assignment Group, State Indicator Properties =&gt; CollectingRecords: Yes, Overridden Collection Periods: No, Scripted?: No, Breakdown Combinations?: Yes, Excluded Breakdown Combinations: No combination is excluded.</td>
</tr>
<tr>
<td>Are records collected in a snapshot?</td>
<td></td>
</tr>
<tr>
<td>Are any breakdowns excluded?</td>
<td></td>
</tr>
<tr>
<td>Are the collection periods in the indicator source overridden?</td>
<td></td>
</tr>
<tr>
<td>Is the breakdown matrix collected?</td>
<td></td>
</tr>
<tr>
<td>If the breakdown matrix is collected, are any breakdown combinations excluded?</td>
<td></td>
</tr>
<tr>
<td>Iterate steps for each indicator source</td>
<td>See table Steps iterated for each indicator source.</td>
</tr>
<tr>
<td>Show statistics for the data collection job</td>
<td>Statistics: inserts 184, updates 0, deletes 92, errors 0, warnings 0</td>
</tr>
<tr>
<td>Complete job</td>
<td>Collection ended</td>
</tr>
</tbody>
</table>

### Steps iterated for each indicator source

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve indicator source.</td>
<td>Processing indicator source Incidents.Open</td>
</tr>
</tbody>
</table>
**Steps iterated for each indicator source (continued)**

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>List indicators that have additional conditions, beyond the conditions inherited from the indicator source.</td>
<td>Indicator: Number of reassigned open incidents - ffb59561ff2302001e68ffffffffffffff33, Additional Conditions: reassignment_count&gt;0</td>
</tr>
<tr>
<td>Indicates whether score collection is following the nested data structure instead of using flat mapping. Nested collection creates fewer redundant objects in memory. Non-nested collection supports batching of scores.</td>
<td>Using nested collection. Note - Batch inserts of scores are not supported with nested collection.</td>
</tr>
<tr>
<td>Iterate steps for each collection period.</td>
<td>See table <a href="#">Steps iterated for each collection period</a></td>
</tr>
<tr>
<td>Retrieve next indicator source.</td>
<td>Processing indicator source Incidents.New</td>
</tr>
</tbody>
</table>

**Steps iterated for each collection period**

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date of collection job.</td>
<td>Collecting for 20191103 on Indicator Source Incidents.Open</td>
</tr>
<tr>
<td>Fetch the following fields:</td>
<td>Fetching &quot;short_description,sys_id, opened_at, assignment_group, description, priority, category&quot; from &quot;incident&quot;</td>
</tr>
<tr>
<td>• The unique fields of the breakdown sources (typically sys_id)</td>
<td></td>
</tr>
<tr>
<td>• The indicator fields used in breakdown mappings</td>
<td></td>
</tr>
<tr>
<td>• The table fields used in scripted breakdown mappings</td>
<td></td>
</tr>
<tr>
<td>• The indicator source fields used in text analytics, if the text index is collected (typically includes short_description)</td>
<td></td>
</tr>
</tbody>
</table>
Steps iterated for each collection period (continued)

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate SQL based on the conditions that are specified in the indicator source.</td>
<td>SELECT task0.<code>sys_id</code> FROM task task0 WHERE task0.<code>sys_class_name</code> = 'incident' AND (task0.<code>opened_at</code> &gt;= '2019-10-28 07:00:00' AND task0.<code>opened_at</code> &lt;= '2019-10-29 06:59:59')</td>
</tr>
<tr>
<td><strong>Note:</strong> If the indicator source specifies Today in one of the conditions, Today is considered relative to the period for which the data collection job is executed. For example, the Incidents.New indicator source includes the condition <code>[Opened][on][Today]</code>. With days defined to start at 07:00:00, when data is collected for 2019-10-28, the job produces the SQL script on the right.</td>
<td></td>
</tr>
<tr>
<td>Display the number of records fetched by the SQL.</td>
<td>Fetched 150 rows from Indicator Source Incidents.Open (facts table: incident)</td>
</tr>
<tr>
<td>Run the map/reduce function to calculate indicator scores.</td>
<td>See the table Steps of the map/reduce function</td>
</tr>
<tr>
<td>If text indexing is active and has been configured for the indicator source, the data collector stores the resulting text index.</td>
<td>Storing Text Index for indicator source Incidents.Open</td>
</tr>
<tr>
<td>Bytes used by text index: 41,984 for: Incidents.Open</td>
<td></td>
</tr>
<tr>
<td>Begin storing newly collected results for the indicator source.</td>
<td>Scores to be stored: 374,842 (excluding lazily evaluated level 2 count distinct scores for indicators - ID - All Incidents with All 3 Breakdowns)</td>
</tr>
<tr>
<td>Any indicator with a null value is logged.</td>
<td>Stored 'Value when nil': 0.0 as score for indicator: Number of incidents deflected by knowledge</td>
</tr>
<tr>
<td>Finish storing results.</td>
<td>Scores stored: 1,125,057</td>
</tr>
<tr>
<td></td>
<td>Stored collected results</td>
</tr>
</tbody>
</table>
### Steps iterated for each collection period (continued)

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify which indicators the data collector does not collect scores for.</td>
<td>Not collecting for Indicator: Summed age of open incidents with excluded Breakdown: Assignment Group</td>
</tr>
<tr>
<td>Finish collecting data for that indicator source for that period.</td>
<td>Collection for 20200519 on Indicator Source Incidents.Open finished</td>
</tr>
<tr>
<td>Display the average amount of time spent on a record to process additional conditions that were set on indicators.</td>
<td>Average time taken to process additional indicator condition for each record: 138 ms</td>
</tr>
</tbody>
</table>

### Steps of the map/reduce function

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>The map/reduce function runs.</td>
<td>Applying map/reduce function for indicator source Incidents.Open</td>
</tr>
<tr>
<td>Warning if text indexing is active for the job but cannot run because of a missing or invalid text index configuration.</td>
<td>Skipping text index collection as there is missing or invalid text index configuration</td>
</tr>
<tr>
<td>Delete previous scores for the indicators and breakdowns that use the indicator source.</td>
<td>Deleting previous results for indicator source Incidents.Open</td>
</tr>
<tr>
<td></td>
<td>Deleted previous results 38 for indicator: External Logins</td>
</tr>
<tr>
<td></td>
<td>Deleted previous results 21 for indicator: Failed Logins</td>
</tr>
<tr>
<td>Process each record on the indicator source to calculate scores. Log messages track running total of processed records and memory usage. Processing for each record involves:</td>
<td>Processed 18% (1) records, Result Object size: 5 MB</td>
</tr>
<tr>
<td>• Execute or evaluate any scripts.</td>
<td>Processed 42% (2) records, Result Object size: 9 MB</td>
</tr>
<tr>
<td>• Validate indicator conditions.</td>
<td>Processed 76% (3) records, Result Object size: 14 MB</td>
</tr>
<tr>
<td>• Calculate the indicator score.</td>
<td>Processed 100% (4) records, Result Object size: 20 MB</td>
</tr>
</tbody>
</table>
Steps of the map/reduce function (continued)

<table>
<thead>
<tr>
<th>Collection job step</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• For each breakdown:</td>
<td></td>
</tr>
<tr>
<td>1. Calculate the breakdown score or execute the breakdown script.</td>
<td></td>
</tr>
<tr>
<td>2. Retrieve all breakdown unique values.</td>
<td></td>
</tr>
<tr>
<td>3. Create or update the array for scores or snapshots. The array is:</td>
<td></td>
</tr>
<tr>
<td>Indicator, Breakdown 1, Artifact 1, Breakdown 2, Artifact 2, Domain, Value, Array of [sys_id]</td>
<td></td>
</tr>
<tr>
<td>The map/reduce function completes.</td>
<td>Applied map/reduce function</td>
</tr>
</tbody>
</table>

View data collection usage

To view statistics about data collection jobs, click Data Collection Overview in the Usage tile on the Performance Analytics Admin Console.

Before you begin
Role required: pa_admin, admin

Procedure
1. Navigate to Performance Analytics > Admin Console.
2. In the Usage tile, click Data Collection Overview.

Results
The following widgets are displayed:
• The net new scores, average run time, and number of errors for the day
• The weekly net new scores and average run time
• The number of data collection job inserts and deletes over time

What to do next
By default, weekly statistics are shown in an Analytics Hub, broken down by data collector. You can select different visualizations and breakdowns in the widget.
**Performance Analytics diagnostics**

Identify and diagnose configuration issues using predefined scripts that examine the database for invalid records and provide suggestions to resolve issues.

Each diagnostic consists of a script or database query with a severity code, message text, and suggested solution. Diagnostics are read-only. You cannot create or edit diagnostics.

You can run one or all diagnostics against all applicable records, or you can run all applicable diagnostics against one record.

**Run diagnostics for all records**

To determine if any configuration issues could impact your Performance Analytics implementation, run diagnostics. You can select whether to run one diagnostic or all diagnostics. The diagnostics examine the subset of Performance Analytics records to which they logically apply.

**Before you begin**

Role required: sn_pa_diagnostics.pa_diagnostic

**Procedure**

1. Navigate to **Performance Analytics > Diagnostics**.

2. Select the diagnostic you want to run.
   
   To run all active diagnostics, click **Execute All** from the list.

3. Click **Run Diagnostic**.
   
   The diagnostics script is canceled automatically if it takes longer than 2 minutes to run.

4. After the diagnostic completes, click **View Result**.

**What to do next**

If a diagnostic returns a warning or error, review the provided solution and take steps to resolve the issue.

**Run all active diagnostics for one record**

To determine if any of the configuration details of a record could impact your Performance Analytics implementation, run the set of all applicable diagnostics on that record.

**Before you begin**

Role required: sn_pa_diagnostics.pa_diagnostic
Procedure

1. Navigate to **Performance Analytics** and open a list of any components: indicators, indicator sources, breakdowns, breakdown sources, widgets, or others.

2. Locate and open the record of interest.

3. Click the link **Run diagnostics**.
   A dialog opens to show the progress of the diagnostics.

4. When the diagnostic run is complete, click **View Result** in the progress dialog.

What to do next
If a diagnostic returns a warning or error, review the provided solution and take steps to resolve the issue.

Performance Analytics roles
Assign roles to ensure that users can perform all necessary actions.

Roles and personas

<table>
<thead>
<tr>
<th>Role</th>
<th>Authorizations</th>
<th>Typical persona</th>
</tr>
</thead>
<tbody>
<tr>
<td>No role</td>
<td>• View Performance Analytics visuals on the Service Portal.</td>
<td>Requester who does not need any access to Performance Analytics beyond certain visualizations of results</td>
</tr>
<tr>
<td></td>
<td>• View dashboards that have been shared with this user.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Some dashboards require a subject matter related role for viewing, such as sn_hr_core_basic for the HR Agent dashboard.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dashboard owners and administrators can also restrict dashboard access by role.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information, see <strong>Dashboard permissions</strong>.</td>
<td></td>
</tr>
<tr>
<td>Role</td>
<td>Authorizations</td>
<td>Typical persona</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| Any role (not necessarily a Performance Analytics role) | • Create dashboards.  
• Restrict access by role to a dashboard they create.  
• Share dashboards they own. |  |
| pa_viewer | Before Quebec, this role was necessary for the following actions. It may still be necessary on upgraded instances.  
• View Analytics Hub.  
• Create thresholds and targets for indicators.  
• Read, Update, and Delete thresholds and targets that they created.  
• View text analytics widgets on dashboards. | Requester who needs and understands the details of key performance indicators |
| sn_pa_diagnostics.pa_diagnostic | Read from the Diagnostics tables.  
• Activate or deactivate a diagnostic.  
• Run diagnostics.  
• Delete message records and diagnostic logs. | No specific persona, but this role would typically be assigned to individual business analysts or groups of fulfillers. |
| pa_contributor | For indicators for which the user is designated as a **Contributor**:  
• Read and update scores in scoresheets.  
• View the Analytics Hub. | No specific persona, but this role would typically be assigned to individual fulfillers or groups, |
<table>
<thead>
<tr>
<th>Role</th>
<th>Authorizations</th>
<th>Typical persona</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This user can also read dashboards that have been shared with them.</td>
<td>who are allowed to set indicator scores manually</td>
</tr>
<tr>
<td>pa_kpi_signal_admin</td>
<td>Enables the user to dismiss a signal or reset the baseline for KPI Signals.</td>
<td>Process owner who also has some training in Performance Analytics. Also needs the pa_viewer role.</td>
</tr>
<tr>
<td>Contained by: admin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pa_target_admin</td>
<td>• Create targets.</td>
<td>Manager who knows what targets to set but may not have any further input to Performance Analytics</td>
</tr>
<tr>
<td>Contained by: pa_power_user, pa_admin</td>
<td>• Read, update, and delete all targets, including those that they do not own.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assign targets to indicators.</td>
<td></td>
</tr>
<tr>
<td>pa_threshold_admin</td>
<td>• Create thresholds.</td>
<td>Manager who knows what thresholds to set but may not have any further input to Performance Analytics</td>
</tr>
<tr>
<td>Contained by: pa_power_user, pa_admin</td>
<td>• Read, update, and delete all thresholds, including those that they do not own.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assign thresholds to indicators.</td>
<td></td>
</tr>
<tr>
<td>pa_analyst</td>
<td>• CRUD text analytics keywords, phrases, and stop words</td>
<td>No specific persona, but this role would be assigned to individual fulfillers or groups whose expertise includes keywords, phrases, and</td>
</tr>
<tr>
<td>Contained by: pa_power_user, pa_admin</td>
<td>• Read indicator sources.</td>
<td></td>
</tr>
<tr>
<td>Role</td>
<td>Authorizations</td>
<td>Typical persona</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>pa_power_user</td>
<td>• CRUD indicators and breakdowns.</td>
<td>Business analyst. Understands the business use cases for Performance Analytics and the requirements for indicators and breakdowns.</td>
</tr>
<tr>
<td></td>
<td>• CRUD widgets</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add Performance Analytics widgets to dashboards.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CRUD text index configurations for text analytics.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CRUD bucket groups.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CRUD indicator groups</td>
<td></td>
</tr>
<tr>
<td>pa_data_collector</td>
<td>• CRUD, schedule, and run data collection jobs</td>
<td>Technical expert who understands the underlying database record structure of Performance Analytics</td>
</tr>
<tr>
<td></td>
<td>• CRUD indicator and breakdown sources</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Read some system properties</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CRUD system units</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CRUD scripts and automated notifications</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CRUD bucket groups</td>
<td></td>
</tr>
<tr>
<td>pa_admin</td>
<td>• Read Performance Analytics properties.</td>
<td>Performance Analytics technical expert who also understands business needs.</td>
</tr>
<tr>
<td></td>
<td>• Access Admin Console</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Launch Dependency Assessment</td>
<td></td>
</tr>
<tr>
<td>admin</td>
<td>The system administrator role. Users with the admin role can perform all pa_admin functions, edit properties, create database views, CRUD</td>
<td>System administrator</td>
</tr>
<tr>
<td>Role</td>
<td>Authorizations</td>
<td>Typical persona</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>any dashboard, and assign ownership to dashboards.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Spotlight roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Authorization</th>
<th>Typical persona</th>
</tr>
</thead>
<tbody>
<tr>
<td>pa_spotlight</td>
<td>CRUD Spotlight groups and criteria.</td>
<td>Expert who understands the business logic of what records require reminders.</td>
</tr>
<tr>
<td>Contains: pa_viewer,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pa_spotlight_copy_breakdown</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pa_spotlight_viewer</td>
<td>Access to the dashboards from the Analytics and Reporting Spotlight Solutions.</td>
<td>Fulfiler who needs more than simple Priority setting to remind them of records that require action.</td>
</tr>
<tr>
<td>pa_spotlight_copy_breakdown</td>
<td>Can copy Spotlight groups to multiple elements of a breakdown.</td>
<td>Spotlight expert or business analyst who understands the applicability of a Spotlight group by breakdown element.</td>
</tr>
<tr>
<td>pa_spotlight_copy_domain</td>
<td>Can copy Spotlight groups to multiple domains</td>
<td>Domain administrator with Performance Analytics expertise</td>
</tr>
</tbody>
</table>

### Role hierarchy

Certain roles such as pa_power_user and pa_admin include other roles. For example, pa_power_user includes pa_contributor. This diagram shows the role hierarchy.
Required roles for actions

<table>
<thead>
<tr>
<th>Module</th>
<th>Action</th>
<th>Minimal required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Console</td>
<td>Access</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Analytics Hub (Scorecards)</td>
<td>View</td>
<td>None, since Quebec. However, upgraded instances may still require pa_viewer.</td>
</tr>
<tr>
<td>Automated indicators</td>
<td>CRUD</td>
<td>pa_data_collector or pa_power_user</td>
</tr>
<tr>
<td>Automation schedules</td>
<td>Read and delete (other security restrictions likely apply)</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Automation scripts</td>
<td>CRUD</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Module</td>
<td>Action</td>
<td>Minimal required role</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Breakdowns and elements, including breakdown relations</td>
<td>CRUD</td>
<td>pa_data_collector or pa_power_user</td>
</tr>
<tr>
<td>Bucket groups</td>
<td>CRUD</td>
<td>pa_data_collector or pa_power_user</td>
</tr>
<tr>
<td>Color schemes for charts and targets</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Create a dashboard. Update a dashboard they created, including restricting access by role.</td>
<td>Any roles necessary to access the data to display, or any one role</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Add Performance Analytics widgets to dashboards you own.</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Read a dashboard that has been shared with you</td>
<td>No role by default, but dashboards can require roles to view their data. For more information, see Dashboard permissions.</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Update, delete, or share a dashboard that you own.</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Update, delete, or share any dashboard. Reassign ownership of any dashboard.</td>
<td>admin (and dashboard role dashboard_admin)</td>
</tr>
<tr>
<td>Data collector jobs</td>
<td>Read, write, execute</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Dependency assessment</td>
<td>Launch dependency assessment from indicator or breakdown form</td>
<td>pa_admin</td>
</tr>
<tr>
<td>External indicators and breakdowns</td>
<td>CRUD</td>
<td>pa_data_collector or pa_power_user</td>
</tr>
<tr>
<td>Module</td>
<td>Action</td>
<td>Minimal required role</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Formula and manual indicators</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Indicator Groups</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Sources, either indicator or breakdown</td>
<td>CRUD</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Indicator targets</td>
<td>Read and edit targets that you do not own</td>
<td>pa_target_administrator</td>
</tr>
<tr>
<td>Indicator targets or thresholds</td>
<td>Create new. Read or edit ones you own.</td>
<td>None, since Quebec. However, upgraded instances may still require pa_viewer.</td>
</tr>
<tr>
<td>Indicator thresholds</td>
<td>Read and edit thresholds that you do not own</td>
<td>pa_threshold_administrator</td>
</tr>
<tr>
<td>In-form analytics</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>KPI Signals</td>
<td>Reset baseline or dismiss signal</td>
<td>pa_kpi_signal_admin</td>
</tr>
<tr>
<td>Lists in all applications</td>
<td>Access an interactive analysis</td>
<td>No role by default, but some interactive analyses require roles to view their tables</td>
</tr>
<tr>
<td>Manage diagnostics</td>
<td>Read, execute, delete</td>
<td>sn_pa_diagnostics.pa_diagnostic</td>
</tr>
<tr>
<td>Scheduled email summary jobs</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Scoresheets</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Service Portal</td>
<td>View Performance Analytics visuals</td>
<td>No role</td>
</tr>
<tr>
<td>System Properties</td>
<td>Edit</td>
<td>admin</td>
</tr>
<tr>
<td>System Properties</td>
<td>Read</td>
<td>pa_data_collector for some, pa_admin for all</td>
</tr>
<tr>
<td>System Units</td>
<td>CRUD</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Module</td>
<td>Action</td>
<td>Minimal required role</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Text Analytics</td>
<td>Set up text index configurations</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Text Analytics</td>
<td>View a text widget on a dashboard</td>
<td>None, since Quebec. However, upgraded instances may still require pa_viewer.</td>
</tr>
<tr>
<td>Text analytics keywords, phrases, or stop words</td>
<td>CRUD</td>
<td>pa_analyst</td>
</tr>
<tr>
<td>What's on the Move News Rules and Statistics Generators</td>
<td>Read, edit</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Widgets</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
</tbody>
</table>

**Related information**

Dashboard permissions

Administering reports

**Performance Analytics properties**

These system properties control the behavior of Performance Analytics.

To configure properties, navigate to Performance Analytics > System > Properties or to sys_properties.list.

**Collection cleanup properties**

Several properties determine how long Performance Analytics scores and snapshots are maintained before the scheduled cleanup job deletes them.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.dc.keep_scores_for.frequency</td>
<td>Maximum number of periods prior to today for which scores are collected and kept. The number of periods varies according to the score collection frequency, as follows: daily; weekly; bi-weekly; four weeks; monthly; bi-</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.dc.keep_snapshots_for.frequency</td>
<td>Maximum number of periods prior to today for which lists of records (snapshots) related to a score are collected and kept. The number of periods varies according to the score collection frequency, as follows: daily; weekly; bi-weekly; four weeks; monthly; bi-monthly; quarterly; fiscal quarterly; half-yearly; yearly; fiscal yearly. Snapshots older than this limit are not collected during data collection.</td>
</tr>
<tr>
<td>• Type: String</td>
<td></td>
</tr>
<tr>
<td>• Default value:</td>
<td>732; 105; 53; 40; 30; 20; 20; 20; 10; 10</td>
</tr>
<tr>
<td>• Location: Performance Analytics &gt; System &gt; Properties</td>
<td></td>
</tr>
</tbody>
</table>

### Fiscal year properties

These properties set the year in Performance Analytics to match your company fiscal year.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.fy_start</td>
<td>Start of the fiscal year of your company</td>
</tr>
<tr>
<td></td>
<td>Range: 1 (January) - 12 (December)</td>
</tr>
<tr>
<td></td>
<td>Default: 1</td>
</tr>
</tbody>
</table>
Default color schemes
These properties set the default colors for the chart overall and for indicator targets.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.indicator_target_default_color_schema</td>
<td>Default indicator target color scheme</td>
</tr>
<tr>
<td></td>
<td>Default: 3 color traffic light</td>
</tr>
<tr>
<td>com.snc.pa.chart_default_color_schema</td>
<td>Default visualization color scheme</td>
</tr>
<tr>
<td></td>
<td>Default: Default UI14</td>
</tr>
</tbody>
</table>

Breakdown and visualization properties
Most of these properties relate to breakdowns and how breakdowns are displayed in visualizations.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.scoresheet.max_elements</td>
<td>Maximum number of elements of a breakdown that can be shown in a scoresheet</td>
</tr>
<tr>
<td></td>
<td>Default: 500</td>
</tr>
<tr>
<td>com.snc.pa.breakdown_element_cutoff</td>
<td>Maximum number of elements that a breakdown can have for the elements without scores to be shown in an Analytics Hub. If the value of this parameter is exceeded, no scoreless elements are shown in the Analytics Hub.</td>
</tr>
<tr>
<td></td>
<td>Example: The value of the parameter is 10. Breakdown A has 8 elements. All 8 are shown in the Analytics Hub. Breakdown B has 12 elements, of which 5 have scores. Only those 5 elements are shown.</td>
</tr>
<tr>
<td></td>
<td>Notes:</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>• This parameter does not affect whether unmatched elements are shown.</td>
<td></td>
</tr>
<tr>
<td>• Both historical and real-time/live scores are counted when considering whether an element has a score.</td>
<td></td>
</tr>
<tr>
<td>• If the element involves a formula with multiple scores, the element is considered to have a score if all parts of the formula have scores at any point in time. The formula is considered to have a score even if the result is invalid, such as a division by 0.</td>
<td></td>
</tr>
<tr>
<td>Default: 50</td>
<td></td>
</tr>
<tr>
<td>com.snc.pa.scorecards.max_breakdown_elements</td>
<td>Maximum number of breakdown elements in Analytics Hub lists</td>
</tr>
<tr>
<td>Default: 1000</td>
<td></td>
</tr>
<tr>
<td>com.snc.pa.scorecard.breakdown.chart.max_rows</td>
<td>Number of breakdown elements in visualizations</td>
</tr>
<tr>
<td>Default: 10</td>
<td></td>
</tr>
<tr>
<td>com.snc.pa.thresholds.frequency_intervals_in_the_past_limit</td>
<td>Maximum number of frequency intervals in the past that a threshold check job will analyze</td>
</tr>
<tr>
<td>Default: 2</td>
<td></td>
</tr>
<tr>
<td>com.snc.pa.scorecard.max_record_num</td>
<td>Number of records to be loaded automatically on the records tab of a detailed Analytics Hub. If the number of records exceeds the value of this property, records are not automatically loaded. In this case, the user is presented with a message and a button to load all records.</td>
</tr>
<tr>
<td>Default: 50,000</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>com.snc.pa.breakdown_element_ui_max_records</td>
<td>Deprecated in Analytics Hub. Limit for the number of elements to be fetched for a breakdown. Used for the lookup fields (breakdown dashboard, old detailed scorecard, etc.) Default: 100</td>
</tr>
<tr>
<td>com.snc.pa.target_batch_operation_limit</td>
<td>Applies only to KPI Details: The maximum number of targets that can be inserted or updated in one bulk action on the Targets Configuration page. If you face timeouts while inserting or updating targets in bulk, consider reducing this limit. Default: 100</td>
</tr>
<tr>
<td>com.snc.pa.widget.max_widget_indicators</td>
<td>Maximum number of widget indicators, in addition to the main indicator, that can be added to a widget Default: 7</td>
</tr>
</tbody>
</table>
| com.snc.pa.widgets.respect_acl | Restrict widget visibility following the ACLs of indicators and breakdowns. True | false.  
- Default on new instances: true  
- Default on upgraded instances from before Quebec: false |

**Chart properties**

A chart refers here to a graphical component of a widget visualization or the Analytics Hub.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.default_chart_line_color</td>
<td>Color of the scores in the Analytics Hub and widgets, including the trend line and bullet chart.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.snc.pa.text.trendline_points_for.frequency</td>
<td>Maximum number of points visible in the text analytics trend-line Default: 30</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_target_color</td>
<td>Color of the target in a graph.</td>
</tr>
<tr>
<td></td>
<td>• Format: Hexadecimal</td>
</tr>
<tr>
<td></td>
<td>• Default: #506163</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_personal_target_color</td>
<td>The line color for personal targets displayed on Analytics Hubs.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: #879394</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_threshold_color</td>
<td>Color of the threshold in a chart.</td>
</tr>
<tr>
<td></td>
<td>• Format: Hexadecimal</td>
</tr>
<tr>
<td></td>
<td>• Default: #506163</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_personal_threshold_color</td>
<td>The line color for personal thresholds displayed on the Analytics Hub.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: #879394</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_area_color0</td>
<td>Color of the first gradient area in a chart.</td>
</tr>
<tr>
<td></td>
<td>• Format: RGBA</td>
</tr>
<tr>
<td></td>
<td>• Default: 106,183,239,1</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_area_color1</td>
<td>Color of the second gradient area in a chart.</td>
</tr>
<tr>
<td></td>
<td>• Format: RGBA</td>
</tr>
<tr>
<td></td>
<td>• Default: 106,183,239,0</td>
</tr>
<tr>
<td>com.snc.pa.navigator_line_color</td>
<td>Color of the Line in the chart navigator.</td>
</tr>
<tr>
<td></td>
<td>• Format: RGBA.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default</strong>: 106,183,239,1</td>
</tr>
</tbody>
</table>
### Data collector properties

Data collector properties enable you to configure various limits for Performance Analytics data collection. The properties are configured to safeguard the data collection process. The default values are appropriate for most environments.

⚠️ **Note:** Try not to increase these values beyond what is necessary. Depending on your implementation, increases in these values may impact performance. If possible, consult a domain expert or implementation partner, who may be able to find an alternative solution to increasing the property value.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.spark_line_width</td>
<td>Pixel width of the chart line. Used only on the workbench widget. Default: 1</td>
</tr>
<tr>
<td>com.snc.pa.scorecard.breakdown.chart.name_max_length</td>
<td>Maximum length of element names on the legend in a breakdown widget. Default: 27</td>
</tr>
<tr>
<td>com.snc.pa.dc.script_timeout</td>
<td>The maximum time in seconds that a script is allowed to run during a data collection process.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>collection cycle, such as an indicator source script or a breakdown script. This limit applies individually for each record processed by the data collection job. If a script exceeds this limit, the data collection job skips the current record. If your scripts frequently reach the default limit, simplify the scripts as much as possible before modifying this property.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 30</td>
</tr>
<tr>
<td>com.snc.pa.dc.query_time_limit</td>
<td>The maximum duration in minutes that a single query for a data collection job can run before a warning is logged.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 60</td>
</tr>
<tr>
<td>com.snc.pa.dc.max_row_count_indicator_source</td>
<td>The maximum number of records that a job can collect from a single indicator source.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> If the number of records that an indicator source contains is higher than the value of this property, no indicators are collected for this indicator source.</td>
</tr>
<tr>
<td></td>
<td>This limit applies separately to each indicator source included in a data collection job. The number of indicators associated with each indicator source does not affect this limit. For example, if a data collection job collects scores for 12 indicators from three indicator sources, the job can...</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>collect a maximum of 150,000 records by default: 50,000 from each indicator source.</td>
<td></td>
</tr>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 50,000</td>
<td></td>
</tr>
<tr>
<td>com.snc.pa.dc.max_breakdown_elements_limit</td>
<td>Maximum number of breakdown elements retrieved by data collection for each breakdown source. If a breakdown source has more elements than this property defines, it is disabled. This limit applies separately to each breakdown source included in a data collection job. The number of breakdowns associated with each breakdown source does not affect this limit. For example, if a data collection job collects scores for 12 breakdowns from three breakdown sources, the job can collect a maximum of 30,000 records by default: 10,000 from each breakdown source.</td>
</tr>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 10,000</td>
<td></td>
</tr>
<tr>
<td>com.snc.pa.dc.max_breakdown_elements_level2_limit</td>
<td>Maximum number of breakdown elements resulting from the combination of two breakdowns for a data collection. For example, if the first-level breakdown has 10 elements, and the second-level breakdown has 5, 50 breakdown elements are collected.</td>
</tr>
</tbody>
</table>

⚠️ Warning: Increasing this limit increases the processing load on the node.

• Type: integer
• Default value: 10,000
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Consider a first-level breakdown with the maximum of 10,000 elements. In this scenario, the second-level breakdown can specify at most 100 breakdown elements before reaching the default second-level limit of 1,000,000 total elements.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This limit is also affected by the <code>com.snc.pa.dc.max_breakdown_elements_limit</code> property. For example, if the first-level breakdown has greater than 10,000 elements, the breakdown is disabled.</td>
</tr>
<tr>
<td>com.snc.pa.dc.max_error_count</td>
<td>The maximum number errors that may occur for a single data collection job run before data collection is stopped. Errors during data collection usually occur due to an invalid script, or when encountering the script timeout limit. If you encounter this limit, review any scripts that run during data collection to ensure that they are valid and perform as expected.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 500</td>
</tr>
<tr>
<td>com.snc.pa.dc.max_records</td>
<td>Maximum number of sys IDs that are stored on a single Snapshot [pa_snapshots] record. A Snapshot record is created for each collected score, and a field in this record contains all the sys IDs from the indicator that contribute to the score. If this limit is exceeded, a Snapshot record is not created for this score. This</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>limit applies only when Collect records is selected for an indicator. For example, say you are using the default limit of 5,000 and you run a job that collects a score referring to 4,500 sys IDs. The system creates a Snapshot record with a comma-separated list of the 4,500 sys IDs in the sys ID field. If the same job also collects a score of 5,001, the system does not create a Snapshot record corresponding to that score. Generally, the default limit provides enough detail into collected records. Increasing this limit may impact performance during data collection or when performing operations on the Snapshots table.</td>
</tr>
</tbody>
</table>
|          | • Type: integer  
|          | • Default value: 5000 |

**Dependency Assessment**

Dependency Assessment enables you to view, analyze, and edit your performance analytics components including widgets, indicators, and breakdowns, from a single view. By viewing the hierarchy of components and the relationships between them, you can see immediately who is impacted by a change and what the effects of your changes are.

Dependency Assessment consists of several components:

**Top-down tree view**

The top-down tree view shows the components of a performance analytics entity in a hierarchical view. If you launch dependency assessment on a dashboard, for example, the top-down tree view shows nodes for each of the dashboard tabs. When you select a dashboard tab, the tree view expands to show nodes that represent each of the widgets on the dashboard.

**Bottom-up tree view**
The bottom-up tree view shows where a performance analytics entity is used in your instance. If you select Show Used By from the context menu of a tree view component, the tree view shows all the places where that entity is used. Click the reset icon (⟲) to return to the top-down tree view.

**Component summaries**

Click the info icon (ℹ️) to see a summary of the component.

**Other actions**

Click the context menu icon (≡) in any component to view the actions available for that component. These include editing the component, viewing the schema map of the component, and previewing a widget.

ℹ️ Note: The tree view is persistent. When you return to Dependency Assessment, the tree view shows the same configuration as on the last visit.

**Launch Dependency Assessment**

Use the Dependency Assessment tree view to view and edit Performance Analytics components including widgets, indicators, and breakdowns, from a single view. You can see the effects of your changes immediately. The tree view opens in the same browser window from which you launched it. Edit windows open in pop-ups so that you do not have to navigate between browser windows or lose context.

**Before you begin**

Role required: pa_admin

**About this task**

This task describes how to launch Dependency Assessment from the Dashboards list. You can also navigate to any of the following locations, select an item from the list, and click Launch Dependency Assessment in the Related Links:

- Performance Analytics > Widgets
- Performance Analytics > Scripts
- Performance Analytics > Indicators > Automated Indicators
- Performance Analytics > Indicators > Manual Indicators
- Performance Analytics > Sources > Indicator Sources
- Performance Analytics > Breakdowns > Automated Breakdowns
- Performance Analytics > Breakdowns > Manual Breakdowns
- Performance Analytics > Sources > Breakdown Sources
• Performance Analytics > Scorecards

**Note:** From an Analytics Hub, click the context menu and select Launch Dependency Assessment.

**Procedure**

1. Navigate to Performance Analytics > Dashboards > or Self-Service > Dashboards.
2. Select the dashboard you want to analyze.
3. From the context menu, select Launch Dependency Assessment.

**Results**

The tree view of the selected dashboard opens.

**Dependency Assessment tree view**

The tree view enables admin users to see the relationships between PA entities and to know the impact of changes made to any node in the tree view hierarchy.

The Dependency Assessment tree view consists of a variety of possible nodes and a legend. The nodes represent Performance Analytics entities. Point to a
node and the node's type is highlighted in the legend. When you click on a node in the tree view, the child nodes open. If there are more than eight nodes in a level of the tree view, then six are shown and a seventh node indicates how many nodes are not shown. Click this node to view a list of the other nodes.

The tree view header contains choice lists for changing the PA entity type and a value. The tree view updates according to your choices. Click the reset button to return the tree view to the starting point with just the first level parent and its immediate child nodes.

Each node has a context menu where you can choose from a number of actions. Choose Show Used By to change the tree view to show where a node is used in your instance. See Bottom-up tree view for more information.

The figure below gives an example of the top-down tree view, starting from a dashboard at the top level, its tabs on the second level, the widgets of one of the dashboard tabs on the third level, and so on. The tree view in the example shows all breakdowns and supporting indicators as they are defined in the Breakdown form.
Related information

Performance Analytics breakdowns

Bottom-up tree view

You can see where any element in the tree view is used. This is useful when you want to change an element such as an indicator or breakdown and see the effect of your change on other PA elements.

Before you begin
Role required: admin
Procedure

1. **Launch Dependency Assessment** on the Performance Analytics entity you want to investigate. For example,
   a. Navigate to Performance Analytics > Dashboards.
   b. Select the dashboard you want to investigate or the dashboard that uses the entity you want to investigate. In this example, we start with the Usage by Requestor dashboard.
   c. From the context menu ( ), select Launch Dependency Assessment.

2. Expand the tree view to locate the entity you want to investigate.

3. Click the context menu ( ) of the entity and select **Show Used By**.

4. The top-down tree view is replaced with a view which shows all of the entities which use the selected entity. In this case, the API Transactions Requestor Stats table is used by one
breakdown source, three reports, and two interactive filters:

5. Click the reset button (⟳) to return the tree view to the base selection as shown in the header.

Tree view navigation
To navigate the admin console tree view effectively, it's good to know what the various icons and other visual data in the tree view indicate.

Moving through the tree view
You can click and drag the tree view to show nodes that are outside of the screen. You can also use Ctrl+A and then use the arrow keys to move the tree view around. Use Tab to return to the first node in the tree. All other keyboard navigation works as described in Using accessibility features.

Node types
The node types reflect the different features of Performance Analytics. When you click a node, it expands into its child features on the next level of the tree view.

Dashboard-related nodes
Dashboards group nodes expand into dashboards. Dashboards expand into dashboard tabs even if the dashboard has only one tab. Dashboard tabs expand into the contents of the tab.

Widgets
Widgets open nodes that show their component parts.

Indicators
All indicator nodes open into nodes for their component sources, breakdowns, jobs, and scripts. Indicator nodes include automated, formula, widget, manual, external and supporting indicators.

Reports
Reports open nodes that show their component tables.

**Breakdowns**

Breakdowns open nodes that show their sources.

**Sources**

All source nodes (breakdown, indicator, and report sources) open nodes that show their source tables.

When you click a text widget, the underlying file appears as a pop-up over the tree view. Choices from a context menu appear in a pop-up as well.

### Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Context menu actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>📊</td>
<td>Dashboard group</td>
<td>• Edit</td>
</tr>
<tr>
<td>📊</td>
<td>Dashboard</td>
<td>• Edit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View Dashboard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you select View Dashboard, the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>dashboard is shown in a pop-up over</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the tree view.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All the dashboard's features are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>available including sharing, layout</td>
</tr>
<tr>
<td></td>
<td></td>
<td>configuration, and adding widgets.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you close the pop-up, the tree</td>
</tr>
<tr>
<td></td>
<td></td>
<td>view is visible again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Used By</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Launches the <strong>Bottom-up tree view</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>which shows all entities that use this entity.</td>
</tr>
<tr>
<td>📚</td>
<td>Dashboard tab</td>
<td>• Edit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Used By</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Context menu actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Report</td>
<td>Launches the <strong>Bottom-up tree view</strong> which shows all entities that use this entity. • <strong>Edit</strong> Opens the report in the Report Designer in a pop-up window. When you close the pop-up, the tree view is visible again. • <strong>Show Used By</strong> Launches the <strong>Bottom-up tree view</strong> which shows all entities that use this entity.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Report source</td>
<td>• <strong>Edit</strong> • <strong>Show Used By</strong> Launches the <strong>Bottom-up tree view</strong> which shows all entities that use this entity.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Interactive Filter</td>
<td>• <strong>Edit</strong> • <strong>Show Used By</strong> Launches the <strong>Bottom-up tree view</strong> which shows all entities that use this entity.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Performance Analytics Widget</td>
<td>• <strong>Edit</strong> • <strong>Preview Widget</strong> Select <strong>Preview Widget</strong> to show the widget in a pop-up window. • <strong>Show Used By</strong></td>
</tr>
<tr>
<td>Icon</td>
<td>Function</td>
<td>Context menu actions</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>----------------------</td>
</tr>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Other Widget</td>
<td>No context menu.</td>
</tr>
</tbody>
</table>
| ![Icon](image2) | Formula Indicator | - Edit  
- Show Analytics Hub  
- Show Used By  
Launches the Bottom-up tree view which shows all entities that use this entity. |
| ![Icon](image3) | Automated Indicator | - Edit  
- Show Analytics Hub  
- Show Scores  
- Show Used By  
Launches the Bottom-up tree view which shows all entities that use this entity. |
| ![Icon](image4) | Widget Indicator | - Edit  
- Preview Widget  
Select **Preview Widget** to show the widget in a pop-up window. |
<p>| <img src="image5" alt="Icon" /> | Supporting Indicators | - Edit |
| <img src="image6" alt="Icon" /> | Manual indicator | - Edit |
| <img src="image7" alt="Icon" /> | External indicator | - Edit |</p>
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Context menu actions</th>
</tr>
</thead>
</table>
| ![calendar_icon](calendar_icon.png) | Indicator source | • Edit  
• Show Schema Map  
• Show Used By  
Launches the **Bottom-up tree view** which shows all entities that use this entity. |
| ![key-encoder_icon](key-encoder_icon.png) | Linked Breakdown | No context menu. Click the tile to reveal the associated breakdowns. |
| ![key-encoder_icon](key-encoder_icon.png) | Breakdown       | • Edit  
• Show Used By  
Launches the **Bottom-up tree view** which shows all entities that use this entity. |
| ![key-encoder_icon](key-encoder_icon.png) | Breakdown Source | • Edit  
• Show Schema Map  
• Show Used By  
Launches the **Bottom-up tree view** which shows all entities that use this entity. |
| ![hourglass_icon](hourglass_icon.png) | Job             | • Edit  
• Execute Now  
• View All Logs  
• View Last executed Log  
• Show Used By  
Launches the **Bottom-up tree view** which shows all entities that use this entity. |
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Context menu actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Script" /></td>
<td>Script</td>
<td>• Edit</td>
</tr>
</tbody>
</table>
| ![Table](image) | Table | • Edit  
• Show Schema Map  
• Show Used By  
Launches the Bottom-up tree view which shows all entities that use this entity. |
| ![Filter widget](image) | Filter widget | • Edit  
• Preview Widget  
Select Preview Widget to show the widget in a pop-up window.  
• Show Used By  
Launches the Bottom-up tree view which shows all entities that use this entity. |

**Other visual data**
Each node has one or more of these icons. Point to the upper right corner of the node to show them.

**Info button [i]**
Click the info button to reveal further details about the node. A node’s information panel shows different information depending on the type of node, but all information panels have an Open Record button. Click Open Record to open the record for editing.

**Context menu [≡]**
Click the context menu icon to perform further actions on the node’s source.

**Error indicators [▲]**
Open the element the node refers to so that you can correct any issues.
Domain separation and Performance Analytics

Domain separation is supported for Performance Analytics. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data. Performance Analytics supports collecting scores from multiple domains and can be configured to enable domain-specific administration. Extended domain configuration functionality is available for customers with complex domains.

Support level: Enhanced

• Includes Basic and Standard levels
• Data-driven process enables service provider customers to modify business logic that is based on defined use cases. These configurations are UI-based and fail-safe so that configurations by one customer cannot affect another.
• Tenants of the instance must be able to configure minimum viable product (MVP) business logic and data parameters for themselves. This logic and parameters would be expected for the application’s normal function.

Sample use case: Tenant-customers of a shared environment must be able to modify the impact, urgency, or priority matrix to set priority within their domain.

For more information on support levels, see Application support for domain separation.

Requirements

• A fully enabled, subscription version of Performance Analytics. See Activating your Performance Analytics subscription.
• The Domain Support — Domain Extension Installer plugin.

⚠️ Warning: Non-responsive dashboards do not support domain separation.

Approaches to domain separation

There are three approaches to domain separation in Performance Analytics:

Global

The Performance Analytics records, such as indicators and breakdowns, are all in the global domain. Data collection jobs respect the domains of facts table records, such as incidents, when they collect indicator scores. Users see scores only from domains they have visibility into. Analytics and Reporting Solutions use this approach. It is the most suitable approach in most cases.

Domain-specific
The Performance Analytics records themselves are domain-separated. Each domain has users with pa_admin and other roles for managing Performance Analytics.

**Hybrid**

Low-level Performance Analytics records, such as indicator sources, are global. High-level Performance Analytics records, such as widgets, are domain-separated. The pa_admin users manage the low-level, global records. Each domain has users with roles like pa_power_user to manage high-level records. This approach is advanced.

For more information, see:

- Approaches to Performance Analytics with domain separation
- Performance Analytics for Managed Service Providers
- ITBM Project Portfolio Management, Domain Separation and Managed Service Providers

**Extended functionality for complex domains**

You can extend the domain separation support for Performance Analytics with the following features, designed especially for customers with complex domains to manage:

- **Hierarchical multi-domain configurations**
  Group domains together, based on their visibility to a user group or on other conditions. Collect scores on some, all, or none of the child domains of these domains. Decide whether to roll up child domain scores to the parent domain, and whether for all children or only those explicitly in the configuration.

- **Collect aggregate scores**
  Combine scores from the multiple domains in a domain configuration to create an aggregate score.

- **Dashboard filtering by domain**
  Filter dashboards to show scores by domain or domain aggregate, as you would by breakdown.

The extended functionality is available in the Performance Analytics — Domain Separation Support plugin. The general requirements for domain separation in Performance Analytics also apply.

Extended functionality supports only the global approach to domain separation.
For more information about this extended functionality, see: Grouping domains in Performance Analytics domain configurations

**Related information**
- Domain separation for service providers
- Domain separation with Spotlight

**Approaches to Performance Analytics with domain separation**

When using Performance Analytics with domain separation, you can collect domain-specific scores. You can use global or domain-specific Performance Analytics table records or even a combination of both.

**Global approach and collecting domain-specific scores**

You can keep all Performance Analytics records, such as indicators, breakdowns, and widgets, in the Global domain. In this case, you apply domain separation through domain-specific data collection jobs. To configure a data collection job to be domain-specific, add one of these entities to the job:

- A user in the job’s **Run as** field, who is a member of the desired domain. For more information, see Create or schedule a data collection job.
- A domain configuration. This domain configuration overrides the **Run as** user. Domain configurations are part of the Performance Analytics plugin for domain support, intended to help with complex domain management. For more information, see Associate a domain configuration with a data collection job.

The data collection job collects scores against facts table records in the Global domain. The job also collects scores against records in the domains of the **Run as** user or domain configuration. The job stores the scores in the domain it collected them from. In data visualizations, a user sees only scores from domains they have visibility into.

If the job uses the domain of the **Run as** user, scores from all child domains are rolled up to the parent. More options are available if you use a domain configuration. For more information about options for collecting and rolling up child domain scores, see Grouping domains in Performance Analytics domain configurations.

Only users with the pa_admin role who are members of one of the domains that the job collects scores for can modify domain-separated data collection jobs. Global users with pa_admin can modify any job.

By default, Analytics and Reporting Solutions use the global approach.
Note: Domain configurations require a global approach to domain separation. For more information, see Grouping domains in Performance Analytics domain configurations.

Domain-specific approach

By using domain-specific Performance Analytics records, you can grant the pa_admin role to domain users to create their own domain-specific components. Users, including administrators, can create and edit Performance Analytics records only within their domain. Users in child domains can read but not edit Performance Analytics records in a parent domain.

You must create a domain-specific copy of a Performance Analytics record to use it in that domain. For example, to add a domain-specific condition to an indicator source, you must create a copy of the indicator and indicator source in that domain.

You can quickly copy an indicator or breakdown and related data from a different domain. Use the Insert and Stay with Relations UI action on the Indicator or Breakdown forms. Any breakdowns, breakdown exclusions, or time series exclusion relationships are also copied. Any associated scheduled jobs are copied only if the Run as user for that job is the current user.

To collect scores, create a new data collector job associated with the domain-specific indicators.

Note: Domain users cannot set Performance Analytics properties that begin with com.snc.pa. Only users with the admin or pa_admin roles in the global domain can see or set these properties.

Hybrid approach

A hybrid approach keeps reusable, foundational Performance Analytics records such as indicator sources within the global domain or a parent domain. At the same time, administrators in other domains create domain-specific higher-level Performance Analytics records such as indicators and widgets.

Note: The hybrid approach is an advanced option. Implement either the global or domain-specific approaches successfully before attempting to use a hybrid approach.

When using a hybrid approach, foundational records should be managed only within the global domain or a parent domain. All other Performance Analytics records, such as widgets and indicators, should be managed separately within each child domain. The following record types are considered foundational records:
• Bucket groups
• Buckets
• Scripts
• Breakdown sources
• Indicator sources
• Filters
• Breakdowns
• Managed sources
• Manual breakdowns
• Breakdown mappings
• Breakdown relations

Copying Performance Analytics records between domains

You can reuse Performance Analytics records in multiple domains. The PADomainUtils API provides functionality that enables administrators to move or copy Performance Analytics records between domains.

Grouping domains in Performance Analytics domain configurations

Instead of configuring Performance Analytics for the domains of a specific user, create a reusable domain configuration. Select domains that are visible to a group of users, or filter domains directly. Domain configurations let you define hierarchical relationships and aggregate scores across multiple domains.

Important: Performance Analytics domain configurations are enabled with the Performance Analytics – Domain Separation Support plugin. For more information about plugins, see Activate a Plugin.

Associate these domain configurations with specific data collection jobs and dashboards to provide relevant scores to users. At the same time, maintain your Performance Analytics records, such as indicators, breakdowns, and their sources, in the global domain.

When you apply a domain configuration to a Performance Analytics data collection job, it overrides the Run as user. Scores are collected for all the domains in the configuration. Only Performance Analytics administrators with access to all the domains in a configuration can edit a data collection job that has a domain configuration applied to it.
Required approach

Only the Global approach to Performance Analytics with domain separation supports domain configurations. For more information, see Approaches to Performance Analytics with domain separation.

Collection, roll-up, and aggregation options

The Domain Configuration record provides flexibility in the way domain records contribute to scores. Prior to the availability of the Domain Support plugin, records in child domains would “roll up” and contribute to the score of a parent domain. The Domain Support plugin provides additional options for how records in child domains should be handled:

- Select whether to collect scores from individual child domains.
- Select whether to roll up scores from child domains into the parent domain score. You can roll up child domain scores with or without also collecting the individual scores.
- If you roll scores from child domains up to the parent domain, select whether to roll up all child domains or only the ones that the domain configuration explicitly includes.
- Select whether to sum all collected individual domain scores into an aggregate score. This score is stored in a separate domain.

The following table shows the scores that are collected for different configurations with a parent domain and three child customer domains. The table also shows aggregate values.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Parent Domain: MSP</th>
<th>Child domains: Customers</th>
<th>MSP contains customers</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>Data</td>
<td></td>
<td>30</td>
<td>100</td>
</tr>
<tr>
<td>Results</td>
<td></td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Example of domain configurations for a single parent domain with three children (continued)

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Parent Domain: MSP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Child domains: Customers</td>
</tr>
<tr>
<td></td>
<td>A</td>
</tr>
<tr>
<td><strong>No aggregate options + Aggregate</strong></td>
<td>-</td>
</tr>
<tr>
<td>Collect Children</td>
<td>30</td>
</tr>
<tr>
<td>Collect children + Aggregate</td>
<td>30</td>
</tr>
<tr>
<td>Collect Children + Roll up only selected domains (A and C)</td>
<td>30</td>
</tr>
<tr>
<td>Collect children + Roll up only selected domains (A and C) + Aggregate</td>
<td>30</td>
</tr>
<tr>
<td>Collect Children + Roll up all child domains</td>
<td>30</td>
</tr>
<tr>
<td>Collect Children + Roll up all child</td>
<td>30</td>
</tr>
</tbody>
</table>
### Example of domain configurations for a single parent domain with three children (continued)

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Child domains: Customers</th>
<th>MSP contains customers</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>domains + Aggregate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roll up only selected domains (A and C)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roll up only selected domains (A and C) + Aggregate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roll up all child domains</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roll up all child domains + Aggregate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Domain configuration records

The Performance Analytics – Domain Separation Support plugin adds the Domain Configurations [pa_domain_configurations] table to your instance. The details of each domain configuration are stored in one of these records.

### Transferring records between instances

Use update sets to transfer domain configurations between instances. If the domain configuration has **Collect aggregate** enabled, also transfer the aggregation domain separately. For more information, see [Transfer domain configuration with score aggregation](#).
Create a domain configuration

Create a domain configuration to define which domains to collect scores from and how to store scores within the domain hierarchy.

**Before you begin**

Role required: pa_admin or admin

The Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) must be activated.

**Procedure**

Navigate to Performance Analytics > Domain Configuration and create a new record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Configuration type | Specify how you want to determine which domains to include in this configuration.  
Select **Visibility group** to include all domains visible to a specific group, based on existing visibility domains associated with that group.  
Select **Conditions** to specify the domains directly, using conditions. |
| Visibility group | When Configuration type is Visibility group, select or create a Group [sys_user_group] that has at least one visibility domain. All visibility domains available to this group are included in this domain configuration. For more information about visibility domains, see Visibility domains and Contains domains. |
| Conditions       | When Configuration type is Conditions, specify conditions to determine which domains are included in this configuration. The conditions you select apply to the Domain [domain] table. For example, select `[[Type][is][MSP]]` to select all managed service provider domains. |
| Collect aggregate | Aggregate scores from the specified domain hierarchy. Aggregate scores are stored in a separate domain that exists outside of the domain hierarchy and contains only scores.  
One aggregate domain is created for each domain configuration where **Collect aggregate** is selected. The name of this domain is displayed in the read-only **Aggregate domain** field. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Collect children | Select this option to collect scores from children of the specified domains. Scores are collected from all child domains, not only those domains that are direct children of the specified domains.  
Scores collected from a child domain are stored in that domain. |
| Roll up       | Select this option to roll collected scores of child domains up to the top-level parent domain in the hierarchy.                                                                                              |
| Roll up type  | Select **All child domains** to roll up scores from the specified domains and all of their child domains. Select **Only selected domains** to roll up scores only from the child domains that are explicitly included in the domain configuration.  
For a visibility group, a domain configuration explicitly includes a child domain if it and its parent domain are in a visibility domain of the group.  
For conditions, a domain configuration explicitly includes a child domain if the conditions select that domain and its parent domain. |

**Related information**

**Domain separation setup and administration**

**Associate a domain configuration with a data collection job**

To collect Performance Analytics indicator scores from the domains specified in a domain configuration, associate that domain configuration with a collection job.

**Before you begin**

Role required: pa_data_collector or admin  
The Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) must be activated.

**About this task**

When you use a domain configuration to control the domain of a data collection job, the domain of the **Run as** user is not used.
Procedure
1. Navigate to Performance Analytics > Jobs.
2. Select a data collection job.
3. In the Domain Configurations related list, click Edit.
4. Select the domain configurations you want to associate with this job.
   A separate data collection job runs for each domain included in the configuration.
5. Click Save.
6. Optional: Modify the Order of the domain configuration.
   If multiple domain configurations are associated with a collection job, any overlap in the included domains may cause scores to be collected incorrectly. Only the scores collected for the domain configuration with the highest Order value are preserved for the overlapping domains.

   Tip: When using multiple domain configurations with a single job, ensure each domain configuration specifies a unique set of domains.

Associate a domain configuration with a dashboard
Display a domain picker on a dashboard to enable users of that dashboard to view scores from specific domains.

Before you begin
Role required: pa_power_user or admin
The Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) must be activated.

About this task
A user must have visibility into all domains in the domain configuration to view domain-specific scores on a dashboard.

Procedure
1. Navigate to Performance Analytics > Dashboard Administration.
2. Select a dashboard.
3. In the Domain Configurations related list click Edit.
4. Select the domain configurations you want to associate with this dashboard.
5. Click Save.
Results
A user who has visibility to all the domains in the domain configuration, such as an admin, can select a domain. The reports and widgets on the dashboard show only scores and values from that domain.

What to do next
If you open the Analytics Hub from a dashboard with a domain picker, you see only the scores collected for the selected domain. Any target, threshold, or comment you add is automatically associated with the current domain. The Edit scores option is not available.

Transfer domain configuration with score aggregation
To transfer between instances a Performance Analytics domain configuration that is set to aggregate scores, transfer both the configuration and the aggregation domain.

Before you begin
Transfer the domain configuration with an update set. For more information about using update sets to transfer configurations between instances, see System update sets.

Role required: admin

Procedure
1. Log in as admin to the source instance from which you transferred the domain configuration.
2. Navigate to Data Collector > Domain Configurations.
3. Open the domain configuration record that you transferred in the update set.
4. Right-click on the header of the form and select Show XML.
5. Copy the sys_id, which is the value of the **aggregate_domain** element.

6. Navigate to **Domain Admin > Domains**.

7. Filter the list of domains by the sys_id that you copied from the transferred domain configuration.

8. Open the filtered domain and from the context menu, export the domain record to XML.

9. Log in as admin to the target instance.

10. Navigate to **Domain Admin > Domains**.

11. From the context menu, import the XML file of the domain record from the source instance.

**Results**

You can execute data collection jobs for the transferred domain.
PADomainUtils - Global

The PADomainUtils API enables you to copy Performance Analytics records between different domains on the same instance.

Use this API in server scripts to copy Performance Analytics records such as indicators, breakdowns, and dashboards, to different domains. This API enables you to create a Performance Analytics record in one domain and copy that record to any number of additional domains.

Note: This API cannot copy records into the Global domain.

To use PADomainUtils, you must satisfy these requirements:

• Performance Analytics must be enabled.
• The user running the script must have the admin role.
• The instance must use domain separation.
• The script must be run from the global domain.
• When moving or copying records, the source and target domains must be different.

PADomainUtils - PADomainUtils()

Instantiates a new PADomainUtils object to move or copy Performance Analytics records from the global domain.

Use the PADomainUtils(String domainFrom) constructor instead when moving or copying records from a domain other than the global domain.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

// PADomainUtils initialized with the global domain
var globalUtils = new SNC.PADomainUtils();

PADomainUtils - PADomainUtils(String domainFrom)

Instantiates a new PADomainUtils object to move or copy Performance Analytics records from the specified domain.
Use the `PADomainUtils()` constructor instead when moving or copying from the global domain.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>domainFrom</td>
<td>String</td>
<td>The domain to copy records from.</td>
</tr>
</tbody>
</table>

```javascript
// c90d4b084a362312013398f051272c0d is the sys id of the ACME domain
var acmeUtils = new SNC.PADomainUtils('c90d4b084a362312013398f051272c0d');
```

**PADomainUtils - setFoundation(Boolean foundation)**

Use this method to move or copy only foundational records in a hybrid domain configuration.

You can implement a hybrid approach by maintaining some types of record in a parent domain and some types in child domains. Generally, the parent domain contains foundational records and the child domain contains higher-level records, such as widgets. The following types of record are considered foundational records.

- Bucket groups
- Buckets
- Scripts
- Breakdown sources
- Indicator sources
- Filters
- Breakdowns
- Managed sources
- Manual breakdowns
- Breakdown mappings
- Breakdown relations

Other Performance Analytics records such as widgets and indicators are not foundational records. Set this method to false to move or copy these additional records as well.
## Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>foundation</td>
<td>Boolean</td>
<td>Indicates if only foundational records should be copied or moved by this PADomainUtils object.</td>
</tr>
</tbody>
</table>

## Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PADomainUtils</td>
<td>The object calling this function.</td>
</tr>
</tbody>
</table>

```javascript
var pa = new SNC.PADomainUtils().setFoundation(true);
pa.copy('bb6b58b01f1310005a3637b8ec8b70dd');
```

### PADomainUtils - setOverrides(Boolean overrides)

Use this method before copying records to set the sys_override value of the new record to the original parent record.

Using this method enables you to automatically override records in a parent domain. By overriding the parent records, the parent records do not impact the child domain. If the source domain is not the parent of the target domain when copying records, setting the sys_override value will not have any impact on behavior. You can specify an override only when copying records, not when moving records.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>overrides</td>
<td>Boolean</td>
<td>Indicates that copied records in a child domain should override the source record in the parent domain. This value is true by default.</td>
</tr>
</tbody>
</table>

#### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PADomainUtils</td>
<td>The object calling this function.</td>
</tr>
</tbody>
</table>
PADomainUtils - copy(String runAs)
Copies Performance Analytics records to a different domain.

To copy dashboards or scheduled jobs, see copyDashboard and copyJob.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy records to.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

// copy all the Performance Analytics records from global to user's domain
var pa = new SNC.PADomainUtils();
pa.copy('09ff3d105f231000b12e3572f2b4775d');

PADomainUtils - copyJob(String paJob, String runAs)
Copies a Performance Analytics scheduled data collection job record to another domain.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>paJob</td>
<td>String</td>
<td>The sys_id of a Performance Analytics scheduled data collection job [sysauto_pa] record.</td>
</tr>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy the job to.</td>
</tr>
</tbody>
</table>
PADomainUtils - copyDashboard(String dashboardId, String runAs)
Copy a dashboard to another domain.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dashboardId</td>
<td>String</td>
<td>The sys_id of the dashboard to copy.</td>
</tr>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy the dashboard to.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

PADomainUtils - move(String runAs)
Moves Performance Analytics records to a different domain.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy records to.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

// move all the Performance Analytics records from the global to the customers domain
var pa = new SNC.PADomainUtils();
pa.move('774190f01f1310005a3637b8ec8b70ef')

PADomainUtils - isWriteable(String table, String id)
Evaluate if you can write to a specific record identified by table and sys_id.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>String</td>
<td>The name of the table containing the record to query, such as pa_indicators.</td>
</tr>
<tr>
<td>id</td>
<td>String</td>
<td>The sys_id of the record to query.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Indicates that you can write to the specified record.</td>
</tr>
<tr>
<td></td>
<td>Returns true if the record exists within the domain of the current user.</td>
</tr>
<tr>
<td></td>
<td>Returns false if the record does not exist, or is in a different domain.</td>
</tr>
</tbody>
</table>

var pa = new SNC.PADomainUtils();
pa.isWriteable('pa_incidents','cd8125b5140012007665a83e633b028d');

Integrate Performance Analytics
Integrate Performance Analytics with an external system to collect scores based on remote data or to expose Analytics Hub information.
REST and Javascript APIs are available for you to create your queries.

**Scorecards API**

The Scorecards REST API enables you to query data about Performance Analytics indicators. The query parameters equate to the functions available on the Analytics Hub for drilling down into an indicator.

This API requires the Performance Analytics (com.snc.pa.analytics_center) application.

**Scorecards - GET /now/pa/scorecards**

Retrieves details about indicators from the Analytics Hub.

Access to tables through the REST API is restricted by BasicAuth. Access control lists defined for tables are enforced to restrict access to data.

To make queries using the Performance Analytics API, you must also have the pa_viewer role.

Almost all queries use the **sysparm_uuid** parameter. This parameter consists of the indicator sys_id followed by a colon-separated list of additional, optional sys_ids. The **sysparm_uuid** is always the first parameter.

**URL format**

Versioned URL: /api/now/{api_version}/pa/scorecards

Default URL: /api/now/pa/scorecards

**Supported request parameters**

<table>
<thead>
<tr>
<th>Path parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>api_version</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Query parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>sysparm_breakdown</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sysparm_breakdown_relation</td>
<td>Sys_id of a breakdown relation to break down the returned data using that relation.</td>
</tr>
<tr>
<td>sysparm_contains</td>
<td>Comma-separated list of names or descriptions to return results only from indicators with a matching value. The comma-separated list items must match, or no results are returned: The list follows AND logic, not OR logic.</td>
</tr>
<tr>
<td>sysparm_display</td>
<td>Flag that indicates the type of indicators to return. Valid values: • true: Return only indicators that display on the Analytics Hub. • all: Return all indicators.</td>
</tr>
<tr>
<td>sysparm_display_value</td>
<td>Data retrieval operation for reference and choice fields. Based on this value, retrieves the display value and actual value from the database.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_elements_filter</td>
<td>Sys_id of an elements filter to apply to the returned data. You cannot obtain the sys_id of an indicator group through this API. Instead, get the sys_id from the indicator group record. For more information about obtaining sys_ids from records, see Unique record identifier (sys_id). Data type: String</td>
</tr>
</tbody>
</table>
| sysparm_exclude_reference_link | Flag that indicates whether to hide additional information provided for reference fields, such as the URI to the reference resource. Valid values:  
  • true: Hide additional information provided for reference fields.  
  • false: Do not hide additional information provided for reference fields.  
  Data type: Boolean  
  Default: false                                                                                                                                                                                                                                                  |
| sysparm_favorites         | Flag that indicates whether to return only indicators that are favorites of the querying user. Valid values:  
  • true: Return only indicators that are favorites of the querying user.  
  • false: Return all indicators.  
  Data type: Boolean  
  Default: false                                                                                                                                                                                                                                             |
| sysparm_from              | Earliest date to return scores from. Only scores from this date or later are returned.                                                                                                                                                                                                                                                         |
### Query parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This parameter requires that ( \text{sysparm_include_scores} ) be set to \text{true}. Date type: String</td>
</tr>
<tr>
<td></td>
<td>Format: ISO-8601 standard</td>
</tr>
<tr>
<td><code>sysparm\_include\_available\_aggregates</code></td>
<td>Flag that indicates whether to return all available aggregates for an indicator when no aggregate has been applied. Valid values:</td>
</tr>
<tr>
<td></td>
<td>• true: Return all available aggregates for an indicator when no aggregate has been applied.</td>
</tr>
<tr>
<td></td>
<td>• false: Return no aggregates.</td>
</tr>
<tr>
<td></td>
<td>Data type: Boolean</td>
</tr>
<tr>
<td></td>
<td>Default: false</td>
</tr>
<tr>
<td><code>sysparm\_include\_aggregates</code></td>
<td>Flag that indicates whether to return all possible aggregates for an indicator, including aggregates that have already been applied. Valid values:</td>
</tr>
<tr>
<td></td>
<td>• true: Return all possible aggregates for an indicator, including aggregates that have already been applied.</td>
</tr>
<tr>
<td></td>
<td>• false: Return no aggregates.</td>
</tr>
<tr>
<td></td>
<td>Data type: Boolean</td>
</tr>
<tr>
<td></td>
<td>Default: false</td>
</tr>
<tr>
<td><code>sysparm\_include\_available\_breakdowns</code></td>
<td>Flag that indicates whether to return all available breakdowns for an indicator. Valid values:</td>
</tr>
<tr>
<td></td>
<td>• true: Return all available breakdowns for an indicator.</td>
</tr>
<tr>
<td></td>
<td>• false: Return no breakdowns.</td>
</tr>
<tr>
<td></td>
<td>Data type: Boolean</td>
</tr>
<tr>
<td></td>
<td>Default: false</td>
</tr>
</tbody>
</table>
### Query parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_include_forecast_scores</td>
<td>Flag that indicates whether to return the forecast_scores element that contains an array of date-value pairs that define the forecast data for the Analytics Hub. This parameter requires that the <code>sysparm_include_scores</code> parameter is also set to true. Valid values:</td>
</tr>
</tbody>
</table>
|                                                | • true: Return the forecast_scores element.  
• false: Do not return the forecast_scores element.  
Data type: Boolean  
Default: false                                                                                           |
| sysparm_include_realtime                       | Flag that indicates whether to return the realtime_enabled element which indicates if real-time scores are enabled for the indicator, and the realtime_value element which contains the real-time score value. This parameter is not supported for formula indicators. Valid values:  |
|                                                | • true: Return the realtime_enabled element.  
• false: Do not return the realtime_enabled element.  
Data type: Boolean  
Default: false                                                                                           |
| sysparm_include_score_notes                   | Flag that indicates whether to return all notes associated with the score. The note element contains the note text as well as the author and timestamp when the note was added. Valid values:  |
|                                                | • true: Return all notes associated with the score.  
• false: Do not return all notes associated with the score.  
Data type: Boolean  
Default: false                                                                                           |
<p>| sysparm_include_scores                         | Flag that indicates whether to return indicator scores for the entire time range selected on the Analytics Hub.                                                                                                                                                                                                                       |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| sysparm_include_scores | not specified, this parameter defaults to false and returns only the most recent score value. To constrain the date range of the scores that are returned, combine this parameter with `sysparm_from` and `sysparm_to`. Valid values:  
• true: Return indicator scores for the entire selected time range.  
• false: Do not return indicator scores for the entire time range.  
Data type: Boolean  
Default: false |
| sysparm_include_target_color_scheme | Flag that indicates whether to return the `target_color_scheme` element that contains the minimum and maximum values, and the color of each section of the target color scheme for the Analytics Hub. Valid values:  
• true: Return the `target_color_scheme` element.  
• false: Do not return the `target_color_scheme` element.  
Data type: Boolean  
Default: false |
| sysparm_include_trendline_scores | Flag that indicates whether to return the `trendline_scores` element that contains an array of date-value pairs that define the Analytics Hub trendline. This parameter requires that the `sysparm_include_scores` parameter is also set to true. Valid values:  
• true: Return the `trendline_scores` element.  
• false: Do not return the `trendline_scores` element.  
Data type: Boolean  
Default: false |
### Query parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_key</td>
<td>Flag that indicates whether to return results only for key indicators. Valid values:</td>
</tr>
<tr>
<td></td>
<td>• true: Return the trendline_scores element.</td>
</tr>
<tr>
<td></td>
<td>• false: Do not return the trendline_scores element.</td>
</tr>
<tr>
<td></td>
<td>Data type: Boolean</td>
</tr>
<tr>
<td></td>
<td>Default: false</td>
</tr>
<tr>
<td>sysparm_limit</td>
<td>Maximum number of scores to return.</td>
</tr>
<tr>
<td></td>
<td>Data type: Number</td>
</tr>
<tr>
<td>sysparm_page</td>
<td>Page number. For example, when querying 20 indicators with the default sysparm_per_page value (10), specify a sysparm_page value of 2 to retrieve indicators 11-20.</td>
</tr>
<tr>
<td></td>
<td>Data type: Number</td>
</tr>
<tr>
<td>sysparm_per_page</td>
<td>Maximum number of indicators each query can return on a page.</td>
</tr>
<tr>
<td></td>
<td>Data type: Number</td>
</tr>
<tr>
<td></td>
<td>Default: 10</td>
</tr>
<tr>
<td></td>
<td>Maximum: 100</td>
</tr>
<tr>
<td>sysparm_sortby</td>
<td>Value to use when sorting results. Valid values:</td>
</tr>
<tr>
<td></td>
<td>• bullet</td>
</tr>
<tr>
<td></td>
<td>• change</td>
</tr>
<tr>
<td></td>
<td>• changeperc</td>
</tr>
<tr>
<td></td>
<td>• date</td>
</tr>
<tr>
<td></td>
<td>• default</td>
</tr>
<tr>
<td></td>
<td>• direction</td>
</tr>
<tr>
<td></td>
<td>• due_date</td>
</tr>
<tr>
<td></td>
<td>• frequency</td>
</tr>
<tr>
<td></td>
<td>• gap</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>gapperc</td>
<td>• gapperc</td>
</tr>
<tr>
<td>group</td>
<td>• group</td>
</tr>
<tr>
<td>indicator_group</td>
<td>• indicator_group</td>
</tr>
<tr>
<td>name</td>
<td>• name</td>
</tr>
<tr>
<td>order</td>
<td>• order</td>
</tr>
<tr>
<td>target</td>
<td>• target</td>
</tr>
<tr>
<td>trend</td>
<td>• trend</td>
</tr>
<tr>
<td>value</td>
<td>• value</td>
</tr>
</tbody>
</table>

Data type: String
Default: value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_sortdir</td>
<td>Sort direction. Valid values: • asc: Denotes ascending • des: Denotes descending</td>
</tr>
</tbody>
</table>

Data type: String
Default: Descending

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_step</td>
<td>Numeric value to skip scores, based on the indicator frequency. For example, specify a value of 3 to return scores from every third day for a daily indicator, or from every third week for a weekly indicator.</td>
</tr>
</tbody>
</table>

Data type: Number

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_tags</td>
<td>Indicator group sys_id in which to return the indicators of that group. Do not use sysparm_uuid with this parameter. You cannot obtain the sys_id of an indicator group through this API. Instead, get the sys_id from the indicator group record. For more information about obtaining sys_ids from records, see Unique record identifier (sys_id).</td>
</tr>
</tbody>
</table>

Data type: String

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_target</td>
<td>Flag that indicates whether to return results only for indicators that have a target set on the Analytics Hub.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
Query parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>sysparm_to</td>
<td>Latest date from which to return scores. Only scores from this date or earlier are returned. This parameter requires that \texttt{sysparm_include_scores} is set to \texttt{true}.</td>
</tr>
<tr>
<td>sysparm_uuid</td>
<td>Colon-separated list of sys_id values to specify which indicators, breakdowns, aggregates, and domains to query. The parameter follows this format: \texttt{&lt;indicator_sys_id&gt;:&lt;breakdown_sys_id&gt;:&lt;element_sys_id&gt;:&lt;aggregate_sys_id&gt;:&lt;domain_sys_id&gt;}, where each colon-separated value specifies an indicator, breakdown, aggregate, or domain, respectively. The parameter must begin with the sys_id of an indicator record. Optionally, you can append the sys_id values of a breakdown and breakdown element to group the response based on the breakdown, and the sys_id of an aggregate to apply that aggregate. You can use a breakdown with an aggregate, or use only one.</td>
</tr>
</tbody>
</table>

**Note:** If an indicator is configured to use a Default time series, all values that this API retrieves for that indicator use the selected aggregate.

For examples of fully-constructed sysparm_uuid values, see Performance Analytics REST API examples.

Data type: String
Request body parameters (XML or JSON)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

**Headers**

The following request and response headers apply to this HTTP action only, or apply to this action in a distinct way. For a list of general headers used in the REST API, see Supported REST API headers.

**Request headers**

<table>
<thead>
<tr>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept</td>
<td>Data format of the response body. Supported types: application/json or application/xml. Default: application/json</td>
</tr>
</tbody>
</table>

**Response headers**

<table>
<thead>
<tr>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

**Status codes**

The following status codes apply to this HTTP action. For a list of possible status codes used in the REST API, see REST API HTTP response codes.

**Status codes**

<table>
<thead>
<tr>
<th>Status code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>Successful. The request was successfully processed.</td>
</tr>
<tr>
<td>401</td>
<td>Unauthorized. The user credentials are incorrect or have not been passed.</td>
</tr>
<tr>
<td>500</td>
<td>Internal server error. An unexpected error occurred while processing the request. The response contains additional information about the error.</td>
</tr>
</tbody>
</table>
Response body parameters (JSON or XML)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Depends on request parameters.</td>
</tr>
</tbody>
</table>

**Example: Return an indicator filtered by a breakdown and element**

```bash
# The GET request gets the details for
# the indicator Number of open
# incidents, where the Priority of the
# incident is 1 - Critical. The sys_id
# values for the indicator, the
# Priority breakdown, and the 1 -
# Critical element are all passed in
# the sysparm_uuid parameter.

curl --verbose --user "username":"password" \
--header "Accept:application/json" \
"https://instance.servicenow.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:e5900140200331007665978299a805f3"

```json
{
// The request is made Dec 12. The
// score is 76, which is unchanged from
// Dec 11, and which exceeds the
// target of 70.
"result": [  
{  
"indicator": {  
"display_value":"Number of open incidents",

"link":"https://instance.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",

"value":"fb007202d7130100b96d45a3ce6103b4"
},  
"gap_formatted": "-6%",
"benchmarking":false,
"frequency_label": "Daily",
"changeperc_formatted": "0.0%",
"direction_label": "Minimize",
"precision":0,
"breakdown": {  
"display_value": "Priority",
```
```
```
Number of incidents open based on resolved date is empty.

```
"link":"https://instance.service-now.com/api/now/v1/table/pa_breakdowns/0df47e02d7130100b96d45a3ce610399",
"value":"0df47e02d7130100b96d45a3ce610399",
"personal_target":null,
"description":"Number of incidents open based on resolved date is empty.",
"value_color": "#ff8c00",

"uuid":"fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:5f012106db5123003ee8f93baf9619bd",
"frequency":10,
"gap":-6.0,
"value_unit":"76",
"indicator_frequency":10,
"value":76.0,
"indicator_aggregate":1,
"facts_table": {
   "name":"incident",
   "label":"Incidents"
},
"key":false,
"indicator_frequency_label":"Daily",
"direction":2,
"element": {
   "display_value":"1 - Critical",

"link":"https://instance.service-now.com/api/now/v1/table/sys_choice/5f012106db5123003ee8f93baf9619bd",
"value":"5f012106db5123003ee8f93baf9619bd",
"period_title":"Dec 12",
"period":"Dec 12",
"target_formatted":"70",
"change":0.0,
"gapperc_formatted": "-8.6%",

"query":"opened_atONToday@javascript:gs.beginningOfToday()@javascript:gs.endOfToday()^ORopened_at<javascript:gs.beginningOfToday()^resolved_atISEMPTY^ORresolved_at>javascript:gs.endOfToday()^state!=8^priority=1^EQ",
"realtime_enabled":true,
"changeperc":0.0,
"target":70.0,
"unit": {
Example: Sample Python request

```python
import requests

url = "https://instance.servicenow.com/api/now/v1/pa/scorecards"

user = 'username'
pwd = 'password'

querystring = {
    "sysparm_uuid": "fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:5f012106db5123003ee8f93baf9619bd"
}

headers = {"Accept": "application/xml"}

response = requests.get(url, auth=(user, pwd), headers=headers, params=querystring)

# Check for HTTP codes other than 200
if response.status_code != 200:
    print('Status:', response.status_code, 'Headers:', response.headers, 'Error Response:', response.content)
    exit()

# Decode the XML response into a dictionary and use the data
print(response.content)
```

<?xml version="1.0" encoding="UTF-8"?>
<response>
<result><indicator><display_value>Number of open incidents</display_value></indicator><link>https://instance.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4</link><value>fb007202d7130100b96d45a3ce6103b4</value></indicator><gap_formatted>-6</gap_formatted><benchmarking>false</benchmarking><frequency_label>Daily</frequency_label><changeperc_formatted>0.0%</changeperc_formatted><direction_label>Minimize</direction_label><precision>0</precision><breakdown><display_value>Priority</display_value><link>https://instance.service-now.com/api/now/v1/table/pa_breakdowns/0df47e02d7130100b96d45a3ce610399</link><value>0df47e02d7130100b96d45a3ce610399</value></breakdown><personal_target>null</personal_target><description>Number of incidents open based on resolved date is empty.</description><value_color>#ff8c00</value_color><uuid>fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:5f012106db5123003e8f93baf9619bd</uuid><frequency>10</frequency><gap>-6.0</gap><value_unit>76</value_unit><indicator_frequency>10</indicator_frequency><value>76.0</value><indicator_aggregate>1</indicator_aggregate><facts_table><name>incident</name><label>Incidents</label></facts_table><key>false</key><indicator_frequency_label>Daily</indicator_frequency_label><direction>2</direction><element><display_value>1 - Critical</display_value>
Performance Analytics API examples

These examples demonstrate how to perform a REST query using cURL commands, and show the data returned for each command. Each example builds upon the last, with later examples using the data returned by earlier examples.
Return all indicators that are displayed in the Analytics Hub
You can request a list of all indicators that are displayed in the Analytics Hub, including their unique record identifiers.

⚠️ **Note:** These examples use the Mac syntax for curl commands. The Windows syntax can differ.

**Command:**
```bash
curl -v -u "user:password" -H "Accept:application/json"
  "https://instance.service-now.com/api/now/v1/pa/scorecards"
```

The following response is truncated to show only the Number of open incidents indicator, which is used in the other examples on this page:

```json
{
  "result": [
    ...
    {
      "change_formatted": "",
      "key": false,
      "value_unit": "",
      "value_formatted": "",
      "period_title": null,
      "gapperc": null,
      "gap": null,
      "target": null,
      "period": null,
      "target_formatted": "",
      "favorite": false,
      "direction_label": "Minimize",
      "uuid": "fb007202d7130100b96d45a3ce6103b4",
      "name": "Number of open incidents",
      "value_color": "#000000",
      "frequency_label": "Daily",
      "change": null,
      "gap_formatted": "",
      "gapperc_formatted": "",
      "value": null,
      "unit": {
        "display_value": "#",
        "link": "https://instance.service-now.com/api/now/v1/table/pa_units/17b365e2d7320100ba986f14ce6103ad"
      }
    }
  ]
}
```
Return indicator details
You can query the Analytics Hub for a particular indicator by providing the
`sysparm_uuid` parameter with an indicator `sys_id` value. In this case, you use the
sysID for the Number of open incidents indicator, which you retrieved in the first
example, when you got all the indicators in the Analytics Hub:

```
"uuid" : "fb007202d7130100b96d45a3ce6103b4",
"name" : "Number of open incidents",
```

Command:

```
curl -v -u "user:password" -H "Accept:application/json"
  "https://instance.service-now.com/api NOW/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4"
```

Response:

```
{
  "result" : [
    {
      "change_formatted" : "",
      "key" : false,
      "value_unit" : "",
      "value_formatted" : "",
      "period_title" : null,
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Return all breakdowns and aggregates for an indicator

You can query a list of available breakdowns and aggregates for an indicator by setting the `sysparm_include_available_breakdowns` and `sysparm_include_available_aggregates` parameters to true.
Command:

curl -v -u "user:password" -H "Accept:application/json"
   "https://instance.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4&sysparm_include_available_breakdowns=true&sysparm_include_available_aggregates=true"

Response:

```json
{
   "result": [
   {
      "key": false,
      "change_formatted": "",
      "aggregates": [
         {
            "display_value": "7d running SUM",
            "link": "https://instance.service-now.com/api/now/v1/table/pa_aggregates/89ea4c11d7001100ba986f14ce6103dc",
            "value": "89ea4c11d7001100ba986f14ce6103dc"
         },
         {
            "display_value": "28d running SUM",
            "link": "https://instance.service-now.com/api/now/v1/table/pa_aggregates/4dfa4c11d7001100ba986f14ce6103e2",
            "value": "4dfa4c11d7001100ba986f14ce6103e2"
         },
         {
            "display_value": "30d running SUM",
            "link": "https://instance.service-now.com/api/now/v1/table/pa_aggregates/3e409011d7001100ba986f14ce610319",
            "value": "3e409011d7001100ba986f14ce610319"
         }
      ],
      "changeperc": null,
      "value_formatted": "",
      "period_title": null,
      "gapperc": null,
      "value_unit": "",
      "target": null,
```
// Aggregates truncated for brevity
```
Return a time series aggregation of indicator scores

You can apply the 7d running SUM aggregate to the Analytics Hub using the `sysparm_uuid` value with the sys_id of the aggregate.

Command:

```
```

Response:

```
{
  "result": [
    {
      "key": false,
      "change_formatted": "",
      "value_unit": "",
      "value_formatted": "",
      "period_title": null,
      "aggregate": {
        "display_value": "7d running SUM",
        "link": "https://instance.service-now.com/api/now/v1/table/pa_aggregates/89ea4c11d7001100ba986f14ce6103dc",
        "value": "89ea4c11d7001100ba986f14ce6103dc"
      },
      "gapperc": null,
      "result": null
    }
  ]
}
```
Return the elements for a breakdown

To get the scores associated with each element of a breakdown, and to get the sys_ids of those elements, use the `sysparm_breakdown` parameter with the sys_id of the breakdown. In this example, you get the elements of the Assignment Group breakdown for the Number of open incidents indicator. From previous example,
you have the sys_id of fb007202d7130100b96d45a3ce6103b4 for the Number of open incidents indicator and the sys_id of baec0752bf130100b96dac808c0739ed for the Assignment Group breakdown.

Command:

```
curl -v -u "user:password" -H "Accept:application/json" "https://<instance>.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4&sysparm_breakdown=baec0752bf130100b96dac808c0739ed"
```

The response consists of a set of indicator objects, each containing one element object. The element objects each contain the name and sys_id of an object. Because the information about the indicator is the same for each indicator object, in this example only the first indicator object is given in detail.

Response:

```
{
  "result":{
    "indicator": {
      "display_value":"Number of open incidents",
      "link":"https://<instance>.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
      "value":"fb007202d7130100b96d45a3ce6103b4"
    },
    "gap_formatted":"",
    "benchmarking":false,
    "frequency_label":"Daily",
    "changeperc_formatted":"0.0%",
    "direction_label":"Minimize",
    "precision":0,
    "breakdown": { 
      "display_value":"Assignment Group",
      "link":"https://<instance>.service-now.com/api/now/v1/table/pa_breakdowns/baec0752bf130100b96dac808c0739ed",
      "value":"baec0752bf130100b96dac808c0739ed"
    },
    "personal_target":null,
    "description":"Number of incidents open based on resolved date is empty.",
    "value_color":"#455464",
    "uuid":"fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:unmatched",
    "frequency":10,
    "gap":null,
  }
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
"value_unit":"14",
"indicator_frequency":10,
"value":14.0,
"indicator_aggregate":1,
"facts_table": {
  "name":"incident",
  "label":"Incidents"
},
"key":false,
"indicator_frequency_label":"Daily",
"direction":2,
"element": {
  "display_value":"Unassigned"  // Element name
}
"link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/unmatched",
"value":"unmatched"  // No sys_id for unmatched scores
},
"period_title":"Jul 22",
"period":"Jul 22",
"target_formatted":"
"change":0.0,
"gapperc_formatted":"

"query":"opened_atONToday@javascript:gs.beginningOfToday()@javascript:gs.endOfToday()^ORopened_at<javascript:gs.beginningOfToday()^resolved_atISEMPTY^ORresolved_at>javascript:gs.endOfToday()^state!=8",
"realtime_enabled":true,
"changeperc":0.0,
"target":null,
"unit": {
  "display_value":"#",

  "type":"formatted",
  "value":"17b365e2d7320100ba986f14ce6103ad"
},
"value_formatted":"14"  // Score where Assignment Group=Unassigned
"name":"Number of open incidents > Assignment Group = Unassigned",
"gapperc":null,
"change_formatted":"0",
"favorite":false,
"personal_targetFormattedMessage":"
"}
{"indicator": {

  "element": {
    "display_value":"Software",
    "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/8a4dde73c6112278017a6a4baf547aa7",
    "value":"8a4dde73c6112278017a6a4baf547aa7"  // sys_id of element Software
  },
  ...

  "value_formatted":"6",                        // Score where Assignment Group: Software
  "name":"Number of open incidents > Assignment Group = Software",
  "gapperc":null,
  "change_formatted":"0",
  "favorite":false,
  "personal_target_formatted":"
  },
  "{indicator": {
    ...

  "element": {
    "display_value":"Service Desk",
    "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/d625dccec0a8016700a222a0f7900d06",
    "value":"d625dccec0a8016700a222a0f7900d06"  // sys_id of element Service Desk
  },
  ...

  "value_formatted":"5",                        // Score for Assignment Group: Service Desk
  "name":"Number of open incidents > Assignment Group = Service Desk",
  "gapperc":null,
  "change_formatted":"0",
  "favorite":false,
  "personal_target_formatted":"
  }
}
"element": {
    "display_value":"Hardware",

    "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/8a5055c9c61122780043563ef53438e3",
    "value":"8a5055c9c61122780043563ef53438e3"   // sys_id for element Hardware
},
...

"value_formatted":"3",                         // Score for Assignment Group: Hardware
    "name":"Number of open incidents > Assignment Group - Hardware",
    "gapperc":null,
    "change_formatted":"0",
    "favorite":false,
    "personal_target_formatted":""
},
{"indicator": {
...

"element": {
    "display_value":"Network",

    "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/287ebd7da9fe198100f92cc8d1d2154e",
    "value":"287ebd7da9fe198100f92cc8d1d2154e"}, // sys_id for element Network
...

"value_formatted":"3",                         // Score for Assignment Group: Network
    "name":"Number of open incidents > Assignment Group - Network",
    "gapperc":null,
    "change_formatted":"0",
    "favorite":false,
    "personal_target_formatted":""
},
...
Return the indicator filtered by a breakdown and element

You can apply a breakdown by appending the breakdown and breakdown element sys_id values to the `sysparm_uuid` parameter. In this example, the data is broken down to show priority 1 incidents. The sys_id for the Priority breakdown is `0df47e02d7130100b96d45a3ce610399` and is in the example Return all breakdowns and aggregates for an indicator. You can get the sys_id for the 1 - Critical element by running the same command as in Return all elements for a breakdown, but with the Priority breakdown instead of Assignment Group. The sys_id for 1 - Critical is `5f012106db5123003ee8f93baf9619bd`.

Command:

```bash
curl -v -u "user:password" -H "Accept:application/json" "https://instance.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:5f012106db5123003ee8f93baf9619bd"
```

Response:

```json
{
// The request is made Dec 12. The
// score is 76, which is unchanged from
// Dec 11, and which exceeds the
// target of 70.
"result": [
{
  "indicator": {
    "display_value": "Number of open incidents",
    "link": "https://instance.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
    "value": "fb007202d7130100b96d45a3ce6103b4"
  },
  "gap_formatted": "-6",
  "benchmarking": false,
  "frequency_label": "Daily",
  "changeperc_formatted": "0.0%",
  "direction_label": "Minimize",
  "precision": 0,
  "breakdown": {
    "display_value": "Priority",
    "link": "https://instance.service-now.com/api/now/v1/table/pa_breakdowns/0df47e02d7130100b96d45a3ce610399",
    "value": "0df47e02d7130100b96d45a3ce610399"
  }
}
```
Return the indicator broken down by location

The Performance Analytics API returns geolocation data when available.

Command:
```
curl -v -u "user:password" -H "Accept:application/json" 
  "https://<instance>.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4&sysparm_breakdown=656d5662eb23310065deac6aa206fee7"
```

Response:
```
{
  "result": [
    ... 
    "element": {
      "display_value": "San Diego",
      "link": "https://<instance>.service-now.com/api/now/v1/table/cmn_location/108752c8c611227501d4ab0e392ba97f",
      "value": "108752c8c611227501d4ab0e392ba97f",
      "longitude": -117.15726,
      "latitude": 32.71533
    },
    ...
  
  ... 
  ]
}
```
```
{
... 
  "element": {
    "display_value": "Florida",
    "link": "https://<instance>.service-now.com/api/now/v1/table/cmn_location/8e3e85f037d0200044e0bfc8bcbe5d14",
    "value": "8e3e85f037d0200044e0bfc8bcbe5d14",
```
Return first- and second-level breakdown scores

You can apply multiple breakdowns by appending multiple breakdown sys_ids to the `sysparm_uuid` parameter. In this example, the data is broken down by priority to show priority 1 incidents, and by category to show database incidents.

Command:
```
curl -v -u "user:password" -H "Accept:application/json" 
"https://instance.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:e5900140200331007665978299a805f3:1f918835d7231100b96d45a3ce6103fe:9e418d40200331007665978299a805c1"
```

Response:
```
{
    "result": [
        {
            "value_formatted": "",
            "indicator": {
                "display_value": "Number of open incidents",
                "link": 
                "http://instance.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
                "value": "fb007202d7130100b96d45a3ce6103b4"
            },
            "gapperc": null,
            "change": null,
            "value_color": "#000000",
            "direction": 2,
            "target_formatted": "",
            "frequency": 10,
            "changeperc_formated": "",
            "direction_label": "Minimize",
            "period_title": null,
            "description": "Number of incidents open based on resolved date is empty.",
            "name": "Number of open incidents / Priority / 1 - Critical / Category / Database",
            "value": null,
```
Return scores across a range of dates for two levels of breakdown

You can request a list of individual scores for all available dates by setting the `sysparm_include_scores` parameter to true. To specify the date range of scores, also use the `sysparm_from` and `sysparm_to` parameters. In this example, the level 1 breakdown and element are Assignment Group: Software (sys_id baec0752bf130100b96dac808c0739ed and 8a4dde73c6112278017a6a4baf547aa7). The level 2 breakdown and element are Priority: 1 - Critical (sys_id 0df47e02d7130100b96d45a3ce610399 and e590014020031007665978299a805f3). Only scores on and after 30 November 2018 are returned.

Command:
```
curl -v -u "resttest:resttest" -H "Accept:application/json"
https://<instance>.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:e590014020031007665978299a805f3&sysparm_include_scores=true&sysparm_from=2018-11-30
```

Response:
```
{
  "result": [
    {
      "indicator": {
        "display_value": "Number of open incidents",
        "link": "https://<instance>.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
        "value": "fb007202d7130100b96d45a3ce6103b4"
      },
      "gap_formatted": "",
      "benchmarking": false,
      "frequency_label": "Daily",
      "scores": [
        {
          "end_at": "2018-12-04",
          "period": "Dec 04",
```
"value_formatted":"2",
"start_at":"2018-12-04",
"value":2.0
},
...

{ "end_at":"2018-11-30",
"period":"Nov 30",
"value_formatted":"0",
"start_at":"2018-11-30",
"value":0.0
}

"changeperc_formatted":"",
"direction_label":"Minimize",
"precision":0,
"breakdown": { //First-level breakdown
  "display_value":"Assignment Group",
  "link":"https://<instance>.service-now.com/api/now/v1/table/pa_breakdowns/баe0752bf130100b96dac808c0739ed",
  "value":"баe0752bf130100b96dac808c0739ed"
},
"personal_target":null,
"description":"Number of incidents open based on resolved date is empty.",
"value_color":"#455464",

"uuid":"fb007202d7130100b96d45a3ce6103b4:баe0752bf130100b96dac808c0739ed:8a4dde73c6112278017a6a4baf547aa7:0df47e02d7130100b96d45a3ce610399:e590014020031007665978299a805f3",
"frequency":10,
"gap":null,
"value_unit":"2",
"indicator_frequency":10,
"value":2.0,
"indicator_aggregate":1,
"key":false,
"indicator_frequency_label":"Daily",
"direction":2,
"element": { //First-level breakdown element
  "display_value":"Software",
  "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/8a4dde73c6112278017a6a4baf547aa7",
  "value":"8a4dde73c6112278017a6a4baf547aa7"
Return breakdown relations for a breakdown and element

To obtain the sys_id values for all breakdown relations associated with an indicator, use the `sysparm_include_available_breakdowns` parameter. In the `sysparm_uuid` parameter, include the sys_ids of the first-level breakdown and element whose relations you want to find. In this example, the `sysparm_uuid` parameter includes the sys_id for the Assignment Group breakdown and the sys_id for the Software element. The sys_id of the Assignment Group was obtained in the example where all breakdowns and aggregates were returned.
The sys_id of the Software element was obtained in the previous example, where all the elements of Assignment Group were returned. The sys_id of the Assignment Group breakdown is baec0752bf130100b96dac808c0739ed and of the Software element is 8a4dde73c6112278017a6a4baf547aa7. The breakdown relation is obtained for the Number of open incidents indicator, whose sys_id is fb007202d7130100b96d45a3ce6103b4.

Note: To find the breakdown relations for incidents that do not match any element value in a breakdown, such as in Assignment Group: Unassigned, use the string unmatched in place of the element sys_id. In this case, the parameter would be

```
sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:8a4dde73c6112278017a6a4baf547aa7:unmatched
```

Command:
```
curl -v -u "user:password" -H "Accept:application/json"  
"https://<instance>.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:8a4dde73c6112278017a6a4baf547aa7&sysparm_include_available_breakdowns=true"
```

Response:
```
{
   "result": [ 
   {
      "value_formatted": "37",
      "indicator": {
         "display_value": "Number of open incidents",
         "link": "https://<instance>.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
         "value": "fb007202d7130100b96d45a3ce6103b4"
      },
      "gapperc": null,
      "change": 9.0,
      "value_color": "#455464",
      "direction": 2,
      "target_formatted": "",
      "frequency": 10,
      "changeperc_formatted": "32.1%",
      "direction_label": "Minimize",
      "period_title": "Jul 22",
      "description": "Number of incidents open based on resolved date is empty.",
      "name": "Number of open incidents / Assignment Group / Software",
      "value": 37.0,
```
"key": false,
"gap_formatted": "",
"element": {
  "display_value": "Software",
  "link": "https://<instance>.service-now.com/api/now/v1/table/sys_user_group/287ee6fe9fe198100ada7950d0b1b73",
  "value": "8a4dde73c6112278017a4baf547aa7"
},
"precision": 0,
"breakdowns": [
  // Information about each breakdown
],
"breakdown_relations": [
  {
    "display_value": "Child Groups",
    "link": "https://<instance>.service-now.com/api/now/v1/table/pa_breakdown_relations/301fd511eb23310065deac6aa206fe31",
    "value": "301fd511eb23310065deac6aa206fe31"
  },
  {
    "display_value": "Parent Group",
    "link": "https://<instance>.service-now.com/api/now/v1/table/pa_breakdown_relations/790b6e11eb23310065deac6aa206fe1c",
    "value": "790b6e11eb23310065deac6aa206fe1c"
  },
  {
    "display_value": "Sibling Groups",
    "link": "https://<instance>.service-now.com/api/now/v1/table/pa_breakdown_relations/15e15a12eb233100871aac6aa206fe59",
    "value": "15e15a12eb233100871aac6aa206fe59"
  }
],
"breakdown": {
  "display_value": "Assignment Group",
  "link": "https://<instance>.service-now.com/api/now/v1/table/pa_breakdowns/baec0752bf130100b96dac808c0739ed",
  "value": "baec0752bf130100b96dac808c0739ed"
}
Return indicator using a breakdown relation

To use a breakdown relation, include the sys_id values of the indicator, breakdown, and element in the `sysparm_uuid` parameter, and the sys_id of the breakdown relation in the `sysparm_breakdown_relation` parameter. This example returns the Sibling Group values for Assignment Group: Software from the previous example.

Command:

```
curl -v -u "user:password" -H "Accept:application/json" 
  "https://<instance>.service-now.com/api/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:8a4dde73c6112278017a6a4baf547aa7&sysparm_breakdown_relation=15e15a12eb233100871aac6a206fe59"
```

Response:

```
{
  "result": [
    {
      "indicator": {
        "gap_formatted": "",
        "benchmarking": false,
        "name": "Assignment Group: Software",
        "sysparm_breakdown_relation": "15e15a12eb233100871aac6a206fe59",
        "sysparm_uuid": "fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:8a4dde73c6112278017a6a4baf547aa7"
      }
    }
  ]
}```
"frequency_label":"Daily",
"changeperc_formatted":"0.0%",
"direction_label":"Minimize",
"precision":0,
"breakdown": {
  "display_value":"Assignment Group",
  "link":"https://<instance>.service-now.com/api/now/v1/table/pa_breakdowns/baec0752bf130100
b96dac808c0739ed",
  "value":"baec0752bf130100b96dac808c0739ed"
},
"personal_target":null,
"description":"Number of incidents open based on resolved date is empty",
"value_color":="#455464",
"uuid":"fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:0a52d3dcd7011200
f2d224837e6103f2",
"frequency":10,
"gap":null,
"value_unit":"0",
"indicator_frequency":10,
"value":0.0,
"indicator_aggregate":1,
"facts_table": {
  "name":"incident",
  "label":"Incidents"
},
"key":false,
"indicator_frequency_label":"Daily",
"direction":2,
"element": {
  "display_value":"Application Development",
  "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/0a52d3dcd701120
0f2d224837e6103f2",
  "value":"0a52d3dcd7011200f2d224837e6103f2"
},
"period_title":"Dec 03",
"period":"Dec 03",
"target_formatted":"
"change":0.0,
"gapperc_formmatted":"
"query":"opened_at@ontoday/javascript:gs.beginningoftoday() javascript:gs.endoftoday() @orop
Return a filtered set of elements for a breakdown

You can apply a filter to the Analytics Hub data using the `sysparm_elements_filter` parameter with the sys_id of a Performance Analytics element filter record.

Get the sys_id of the elements filter from the elements filter record, as described in The unique record identifier (sys_id).

In this example, the element filter applies to the Groups breakdown source, with the condition `[[Parent][is][Database]]`. The sys_id of this element filter is `7b9eb563eb11020065deac6aa206fe11`. The example gets the elements of the Assignment Group breakdown that have the element Database as a parent.

Command:
```
```

Response:
"unit": {  
  "display_value": ",",
  "link": "https://<instance>.service-now.com/api/now/v1/table/pa_units/17b365e2d7320100ba986f14ce6103ad",
  "value": "17b365e2d7320100ba986f14ce6103ad"
},
  
  "frequency_label": "Daily",
  "target": null,
  "changeperc": 0.32142857142857145,
  "uuid": "fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:287ee6fe9fe198100ada7950d0b1b73",
  "gapperc_formatted": ",",
  "value_unit": "37",
  "gap": null
},

{  
  "value_formatted": "20",
  "indicator": {  
    "display_value": "Number of open incidents",
    "link": "https://<instance>.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
    "value": "fb007202d7130100b96d45a3ce6103b4"
  },
  
  // Database Atlanta
  "gapperc": null,
  "change": 4.0,
  "value_color": ",455464",
  "direction": 2,
  "target_formatted": ",",
  "frequency": 10,
  "changeperc_formatted": "25.0%",
  "direction_label": "Minimize",
  "period_title": "Jul 22",
  "description": "Number of incidents open based on resolved date is empty.",
  "name": "Number of open incidents / Assignment Group / Database Atlanta",
  "value": 20.0,
  "key": false,
  "gap_formatted": ",",
  "element": {  
    "display_value": "Database Atlanta",
    "link": 
  }
// Database San Diego
"gapperc": null,
"change": 0.0,
"value_color": "#455464",
"direction": 2,
"target_formatted": "",
"frequency": 10,
"changeperc_formatted": "0.0%",
"direction_label": "Minimize",
"period_title": "Jul 22",
"description": "Number of incidents open based on resolved date is empty.",
"name": "Number of open incidents / Assignment Group / Database San Diego",
"value": 10.0,
"key": false,
"gap_formatted": "",
"element": {
  "display_value": "Database San Diego",
  "link": "https://<instance>.service-now.com/api/now/v1/table/sys_user_group/db53a9290a0a0a650091abebccf833c6",
  "value": "db53a9290a0a0a650091abebccf833c6"
},
"precision": 0,
"breakdown": {
  "display_value": "Assignment Group",
  "link": "http://localhost:8080/api/now/v1/table/pa_breakdowns/baec0752bf130100b96dac808c0739ed",
  "value": "baec0752bf130100b96dac808c0739ed"
},
"period": "Jul 22",
"favorite": false,
"change_formatted": "0",
"unit": {
  "display_value": "#",
  "link": "http://<instance>.service-now.com/api/now/v1/table/pa_units/17b365e2d7320100ba986f14ce6103ad",
  "value": "17b365e2d7320100ba986f14ce6103ad"
},
"frequency_label": "Daily",
"target": null,
"changeperc": 0.0,
Performance Analytics Javascript API

The Performance Analytics Javascript API enables you to query data about Performance Analytics indicators programatically. The query parameters equate to the functions available on the Analytics Hub for drilling down into an indicator.

PAScorecard - Scoped

The PAScorecard API enables you to fetch data about indicators and their associated records, such as breakdowns.

This API requires the Performance Analytics (com.snc.pa.analytics_center) application.

PAScorecard - addParam(String parameter, String value)

Add a query parameter to filter the returned scores.

Call this method multiple times on the same PAScorecard object to pass multiple parameters, such as the indicator sys_id and a breakdown sys_id. After specifying all parameters, call query() to run the query.

If you query a PAScorecard object with no parameters, the API returns a list of all indicators that are displayed on the Analytics Hub, with their scores.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>uuid</td>
<td>String</td>
<td>Enter a colon-separated list of sys_id values to specify which indicators, breakdowns, aggregates, and domains to query. The parameter follows this format: &lt;indicator_sys_id&gt;:&lt;breakdown_sys_id&gt;:&lt;elements_filter_sys_id_or_element_sys_ids&gt;:&lt;lvl-2</td>
</tr>
</tbody>
</table>
### Parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>breakdown_sys_id:&lt;lvl-2 elements_filter_sys_id or element_sys_ids&gt;:&lt;aggregate_sys_id&gt;:&lt;domain_sys_id&gt;</td>
<td></td>
<td>The parameter must begin with the sys_id of an indicator record. Optionally, you can append the sys_id values of a breakdown and breakdown element to group the response based on the breakdown, and the sys_id of an aggregate to apply that aggregate. You can use a breakdown with an aggregate, or use only one. For information about obtaining the sys_id values of records, see <a href="#">Unique record identifier (sys_id)</a>.</td>
</tr>
<tr>
<td>breakdown</td>
<td>String</td>
<td>Sys_id of a breakdown to return chart information organized as defined by the breakdown. For example, the sys_id of a priority breakdown to return separate task chart information for each priority value, such as the number of open incidents / Priority / 2 - High. Data type: String</td>
</tr>
<tr>
<td>breakdown_relation</td>
<td>String</td>
<td>Specify the sys_id of a breakdown relation to breakdown the returned data using that relation. You can view available breakdown relations by setting the <a href="#">include_available_breakdowns</a> parameter to true.</td>
</tr>
<tr>
<td>elements_filter</td>
<td>String</td>
<td>Specify the sys_id of an elements filter to apply that filter to the returned data.</td>
</tr>
</tbody>
</table>
| display                   | String | Flag that indicates the type of indicators to return. Valid values:  
  • true: Return only indicators that display on the Analytics Hub.  
  • all: Return all indicators.  
  Data type: String                                                                                                                                                                                                                                                          |
### Parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| favorites | String | Flag that indicates whether to return only indicators that are favorites of the querying user.  
Valid values:  
- true: Return only indicators that are favorites of the querying user.  
- false: Return all indicators.  
  
Data type: Boolean  
Default: false |
| key    | String | Flag that indicates whether to return results only for key indicators.  
Valid values:  
- true: Return the trendline_scores element.  
- false: Do not return the trendline_scores element.  
  
Data type: Boolean  
Default: false |
| target | String | Flag that indicates whether to return results only for indicators that have a target set on the Analytics Hub.  
Valid values:  
- true: Only return results for indicators that have a target set.  
- false: Return results for all applicable indicators.  
  
Data type: Boolean  
Default: false |
<p>| contains | String | Comma-separated list of names or descriptions to return results only from indicators with a matching value. All the comma-separated list items must match, or no results are returned: The list follows AND logic, not OR logic. |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tags</td>
<td>String</td>
<td>Enter an indicator group sys_id to return the indicators in that group. Do not use <code>uuid</code> with this parameter.</td>
</tr>
<tr>
<td>per_page</td>
<td>String</td>
<td>Maximum number of indicators each query can return on a page. Data type: Number Default: 10 Maximum: 100</td>
</tr>
<tr>
<td>page</td>
<td>String</td>
<td>Specify the page number. For example, when querying 20 Analytics Hubs with the default <code>per_page</code> value (10), specify a page value of 2 to retrieve Analytics Hubs 11-20.</td>
</tr>
<tr>
<td>sortby</td>
<td>String</td>
<td>Value to use when sorting results. Valid values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• bullet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• change</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• changeperc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• direction</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• duedate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• frequency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• gap</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• gapperc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• indicator_group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• order</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• target</td>
</tr>
</tbody>
</table>
### Parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>trend</td>
<td>String</td>
<td>-</td>
</tr>
<tr>
<td>value</td>
<td>String</td>
<td>-</td>
</tr>
</tbody>
</table>

Data type: String
Default: value

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| sortdir    | String     | Sort direction. Valid values:  
- asc: Denotes ascending  
- des: Denotes descending  
Data type: String  
Default: Descending |

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| display_value   | String | Data retrieval operation for reference and choice fields.  
Based on this value, the display value and/or the actual value in the database are retrieved.  
- true returns display values for all of the fields.  
- false returns actual values from the database. If a value is not specified, this parameter defaults to false.  
- all returns both actual and display values. |

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| exclude_reference  | String   | Flag that indicates whether to hide additional information provided for reference fields, such as the URI to the reference resource.  
Valid values:  
- true: Hide additional information provided for reference fields.  
- false: Do not hide additional information provided for reference fields.  
Data type: Boolean  
Default: false |
### Parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| include_scores   | String | Flag that indicates whether to return indicator scores for the entire time range selected on the Analytics Hub. If a value is not specified, this parameter defaults to false and returns only the most recent score value.  
To constrain the date range of the scores that are returned, combine this parameter with the **from** and **to** parameters. |
| from             | String | Earliest date to return scores from. Only scores from this date or later are returned.                                                                                                                      |
|                  |        | This parameter requires that **include_scores** is set to **true**.                                                                                                                                          |
| to               | String | Latest date from which to return scores. Only scores from this date or earlier are returned.                                                                                                               |
|                  |        | This parameter requires that **include_scores** is set to **true**.                                                                                                                                       |
| step             | String | Numeric value to skip scores, based on the indicator frequency. For example, specify a value of 3 to return only scores from every third day for a daily indicator, or from every third week for a weekly indicator.  
Data type: Number                                                                                                                  |
| limit            | String | Maximum number of scores to return.                                                                                                                                                                      |
|                  |        | Data type: Number                                                                                                                                                                                          |
| include_available_breakdowns | String | Flag that indicates whether to return all available breakdowns for an indicator.                                                                                                                         |
|                  |        | Valid values:  
- true: Return all available breakdowns for an indicator.                                                                                                                                          |
- false: Return no breakdowns.                                                                                                        |
<p>|                  |        | Data type: Boolean                                                                                                                                                                                          |
|                  |        | Default: false                                                                                                                                                                                              |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>include_available_aggregates</td>
<td>String</td>
<td>Flag that indicates whether to return all possible aggregates for an indicator, including aggregates that have already been applied.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valid values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• true: Return all possible aggregates for an indicator, including aggregates that have already been applied.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• false: Return no aggregates.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data type: Boolean</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: false</td>
</tr>
<tr>
<td>include_realtime</td>
<td>String</td>
<td>Flag that indicates whether to return the realtime_enabled element which indicates if real-time scores are enabled for the indicator, and the realtime_value element which contains the real-time score value. This parameter is not supported for formula indicators.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valid values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• true: Return the realtime_enabled element.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• false: Do not return the realtime_enabled element.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data type: Boolean</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: false</td>
</tr>
<tr>
<td>include_target_color_scheme</td>
<td>String</td>
<td>Flag that indicates whether to return the target_color_scheme element that contains the minimum and maximum values, and the color of each section of the target color scheme for the Analytics Hub.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valid values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• true: Return the target_color_scheme element.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• false: Do not return the target_color_scheme element.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data type: Boolean</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>include_forecast_scores</td>
<td>String</td>
<td>Flag that indicates whether to return the forecast_scores element that contains an array of date-value pairs that define the forecast data for the Analytics Hub. This parameter requires that the <code>include_scores</code> parameter is also set to <code>true</code>.</td>
</tr>
<tr>
<td>include_trendline_scores</td>
<td>String</td>
<td>Flag that indicates whether to return the trendline_scores element that contains an array of date-value pairs that define the Analytics Hub trendline. This parameter requires that the <code>include_scores</code> parameter is also set to <code>true</code>.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

In this example, the `uuid` parameter specifies the Number of open incidents indicator, and the `breakdown` parameter specifies the Priority breakdown. Both parameters have the `sys_id` of the respective records as their values. The `query()` function returns the results as an object.

```javascript
var sc = new SNC.PAScorecard(); // in a scoped app, do not use the SNC namespace
sc.addParam('uuid', 'fb007202d7130100b96d45a3ce6103b4'); // Number of open incidents
sc.addParam('breakdown', '0df47e02d7130100b96d45a3ce610399'); // by Priority
var result = sc.query(); // Query results, which are returned as an object
for (var i = 0; i < result.length; i++)
gs.info(result[i].name + ': ' + result[i].value + ' ' + result[i].unit.display_value);
```

**PAScorecard - query()**

Perform a query based on the specified parameters and return the results as an object.

Before calling this method, configure parameters for the PAScorecard object by calling `addParam(String parameter, String value).`
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>The PAScorecard object.</td>
</tr>
</tbody>
</table>

PAScorecard - result()

Get the last query result as an object.

This method does not perform a query. To perform a query before returning the result, use query().

This function cannot run in a scope other than global.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>The results from the last query, returned as a JS object.</td>
</tr>
</tbody>
</table>

PASnapshot - Scoped

The PASnapshot API enables you to query information about Performance Analytics snapshots. Snapshots are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with Collect records selected.

You can query information about a snapshot at a certain date using the indicator sys_id and date, and perform comparisons between snapshots for an indicator at different dates.
PASnapshot - getIDs(String sys_id, Number date)

Get the sys_id values for all records contained in the snapshot for a specified indicator at the specified date.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>String</td>
<td>The indicator sys_id.</td>
</tr>
<tr>
<td>date</td>
<td>Number</td>
<td>The date when the snapshot was taken, in the format yyyymmdd.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>A comma-separated list of sys_id values.</td>
</tr>
</tbody>
</table>

```javascript
var snapshot1 = PASnapshot.getIDs('fb007202d7130100b96d45a3ce6103b4', 20160530);
gs.info(snapshot1);
```

Output: *** Script:
09c01200d7002100b81145a3ce6103ab,19c01200d7002100b81145a3ce6103e9,fcc01200d7002
....

PASnapshot - getCompareIDs(String sys_id, Number date1, Number date2, String type)

Compare records in snapshots for a specified indicator at multiple dates, such as to identify records included in one snapshot but not the other.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>String</td>
<td>The indicator sys_id.</td>
</tr>
<tr>
<td>date1</td>
<td>Number</td>
<td>The date of the first snapshot, in the format yyyymmdd.</td>
</tr>
<tr>
<td>date2</td>
<td>Number</td>
<td>The date of the second snapshot, in the format yyyymmdd.</td>
</tr>
<tr>
<td>type</td>
<td>String</td>
<td>Specifies what data to retrieve. Valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• all1: all records in the first snapshot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• all2: all records in the second snapshot</td>
</tr>
</tbody>
</table>
Parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
|      |      | • shared: records that are in both snapshots  
|      |      | • movedin: records that are in the first snapshot, but not the second  
|      |      | • movedout: records that are in the second snapshot, but not the first |

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>A comma-separated list of sys_id values.</td>
</tr>
</tbody>
</table>

```javascript
var snapshot2 = PASnapshot.getCompareIDs('fb007202d7130100b96d45a3ce6103b4', 20160430, 20160531, 'shared');
gs.info(snapshot2);
```

Output: *** Script:  
09c01200d7002100b81145a3ce6103ab,19c01200d7002100b81145a3ce6103e9,fcc01200d7002100b81145a3ce6103e9....

**PASnapshot - getQuery(String sys_id, Number date)**

Get the query used to generate the snapshot for a specified indicator at the specified date.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>String</td>
<td>The indicator sys_id.</td>
</tr>
<tr>
<td>date</td>
<td>Number</td>
<td>The date when the snapshot was taken, in the format yyyymmd.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The table, view, and encoded query as a JSON string.</td>
</tr>
</tbody>
</table>
var snapshot3 = PASnapshot.getQuery('fb007202d7130100b96d45a3ce6103b4', 20160530);
gs.info(snapshot3);

Output: *** Script: {"view":"","query":"sys_id IN javascript:new PAUtils().getSnapshotIDs("fb007202d7130100b96d45a3ce6103b4", "20160530"),"table":"incident"}

PASnapshot - getCompareQuery(String sys_id, Number date1, Number date2, String type)

Get the query used to compare records in snapshots for a specified indicator at multiple dates.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>String</td>
<td>The indicator sys_id.</td>
</tr>
<tr>
<td>date1</td>
<td>Number</td>
<td>The date of the first snapshot, in the format yyyymmdd.</td>
</tr>
<tr>
<td>date2</td>
<td>Number</td>
<td>The date of the second snapshot, in the format yyyymmdd.</td>
</tr>
<tr>
<td>type</td>
<td>String</td>
<td>Specifies what data to retrieve. Valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• all1: all records in the first snapshot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• all2: all records in the second snapshot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• shared: records that are in both snapshots</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• movedin: records that are in the second snapshot, but not the first</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• movedout: records that are in the first snapshot, but not the second</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The table, view, and encoded query as a JSON string.</td>
</tr>
</tbody>
</table>

var snapshot4 = PASnapshot.getCompareQuery('fb007202d7130100b96d45a3ce6103b4', 20160530, 20160531, 'all1');
gs.info(snapshot4);
Scripting in Performance Analytics

Performance Analytics provides several script objects for use in scripts and APIs for querying Performance Analytics data. The scripts serve as breakdown mappings or to calculate a value from an indicator.

Tip:

- Scripts are best used only to support indicators like Age with date processing, using the score_start and score_end variables.
- Limit unnecessary fields. Every time you include an extra dot-walked field, you add an extra join to the query.
- Try to replace manual breakdowns with database views for better performance.
- Try to use script includes for common functions. For more information, see Script includes.
- If the data is not structured in a way you need for reporting, try adding 'reporting fields' to the operational tables instead of creating scripts. For more information, see this Community post.

Important: Try not to use GlideRecords or GlideAggregates in Performance Analytics scripts or formula indicators. While sometimes you must use these operations to get what you want, they are expensive, potentially running hundreds of thousands of times. Be certain that no alternative exists before you use them.

A breakdown mapping script typically returns either a sys_id of a breakdown element or an integer to put the score in a bucket. Indicator scripts return a score calculated from one or more fields. The same script can serve both as a breakdown mapping script and as an indicator script. For example, consider the provided Incident.Age.Days script, which uses the opened_at field from the incident table. This script serves as a breakdown mapping for the Age breakdown, which uses the Incident Age Ranges (Days) bucket group as the breakdown source.

```javascript
var diff = function(x, y) { return y.dateNumericValue() - x.dateNumericValue();};
var days = function(x, y) { return diff(x, y) / (24*60*60*1000);};
days(current.opened_at, score_end);
```
In this example, `current.opened_at` gets the timestamp of when the currently evaluated record was opened. The `score_end` script variable comes from the data collector and is bound to the period being collected. For example, if a monthly indicator is being collected, the `score_end` is the end of the month. Here the timestamp of when the incident was opened is subtracted from the timestamp of the end of the collection period and the result is converted to days.

⚠️ Note:

This example includes the `Incident.opened_at` field, which is specified in the `Fields` field for this script. You can use `score_start` and `score_end` without defining them in the `Fields` field.

Related information

- Create a breakdown mapping on a breakdown record
- Server API Reference

Create a script in Performance Analytics

To create a script, first select the facts table to which the script applies and explicitly select any fields.

Before you begin

Role required: admin, pa_admin

Procedure

1. Navigate to Performance Analytics > Scripts and click New.
2. Give the script a descriptive Name.
3. Select the Facts table that the script applies to.
   - Only indicators that use the same facts table can use this script.
4. Select the fact table Fields, if any, that will be used in the script.
   - You select fields by their labels.
5. Write the script.
   - The script must conform to the following relationships and restrictions:
     - You can include only the fields that are selected in this form and script variables. For more information, see the section about Performance Analytics variables.
     - When you use a field in the script, you use the column name. If necessary, look up the column name in the facts table.
     - When you use a field from a database view, you must include the prefix. For example, the incident_sla database view includes the task_sla table,
with the prefix taskslatable. Task_sla includes the business_duration column. To use the business_duration field from the incident_sla database view, write it as taskslatable_business_duration. If you do not have access to the database view, ask your system administrator to find the prefix for you.

**What to do next**

After you create the script, create a breakdown mapping or indicator that uses the script. You can open a breakdown mapping or indicator form by clicking **New** in either the breakdown mapping or indicator tab. The breakdown mappings and indicators that use this script are listed in those tabs.

**Performance Analytics variables**

Several variables are available for use in Performance Analytics scripts and formula indicators.

You can use the following variables in Performance Analytics scripts and formulas.

- **score_start**: First second of the day of the first indicator score collection. For scripts, the time is calculated based on the difference between the time zone of the Run As user for the collection job and the database time zone, which is GMT. For formulas, the time is calculated based on the difference between the time zone of the user who executes the formula and GMT. A user executes a formula by viewing the formula indicator in a dashboard widget or on the Analytics Hub.

- **score_end**: Last second of the day of the last indicator score collection. The time is calculated the same way as for **score_start**.

- **pa**: A formula variable, not usable in scripts, that provides a set of Analytics Hub-related attributes and methods.

In scripts, the score collection start and end variables are GlideElementGlideObject objects. You can obtain a GlideDateTime object from these variables by calling getGlideObject(), such as in this example:

```
gs.log("Score main = " + score_end.getGlideObject().getDayOfWeek());
```

In formulas, the score collection start and end variables already are GlideDateTime objects. Therefore, you can use the variables directly without calling getGlideObject(), such as in this example:

```
gs.log("Score main = " + score_end.getDayOfWeek());
```

The values of the start and end variables are bound to the period being collected. For example, if a monthly indicator is being collected, the **score_end** is the end of the month.
The `score_start` and `score_end` values are calculated based on the time zone of the relevant user. For Performance Analytics scripts, this is the Run As time zone for the collection job. For formulas, this is the time zone of the user who views the formula indicator in a dashboard widget or the Analytics Hub. Users in different time zones therefore may have different dates for `score_start` and `score_end` in a formula.

**Related information**
- GlideDateTime - Scoped
- Get analytics methods in formulas
- Changes to `score_start/end` because of different user time zones

**Using Performance Analytics with external data**

Performance Analytics on external data sources enables you to perform detailed analysis on data that is not in your ServiceNow instance.

When you collect scores on external data, Performance Analytics stores scores and breakdown elements from the external data on your instance. The raw data being analyzed remains on the external data source and is not copied to your instance. This functionality enables you to analyze and share metrics without duplicating the underlying data.

Performance Analytics external data collection uses three types of configuration records:

- An external indicator which specifies the JDBC data source and SQL statement used to collect scores.
- An external breakdown which specifies the JDBC data source and SQL statement used to specify breakdown elements.
- An external indicator breakdown which defines the relationship between an external indicator, and breakdown, and the SQL statement used to collect scores for each breakdown element for that indicator.

**Supported database formats for external data**

Performance Analytics supports only the database formats that ServiceNow supports by default. If a customer adds a JDBC driver for an unsupported database format, Performance Analytics does not support that database format as an external data source.
Supported database formats

<table>
<thead>
<tr>
<th>SQL Server Type</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL</td>
<td>3306</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>1433</td>
</tr>
<tr>
<td>Oracle</td>
<td>1521</td>
</tr>
</tbody>
</table>

Related information

**JDBC type data source**

Create an indicator for external data

Create an external indicator to define what data to evaluate and the SQL statement used to determine the indicator score.

**Before you begin**
Role required: pa_admin, pa_power_user, or admin

**Procedure**

1. Navigate to Performance Analytics > External Indicators and click New.
2. Give the indicator a descriptive Name.
3. In the Frequency field, specify the frequency of data points for the indicator, such as Daily, Weekly, or Monthly.
4. In the Source tab, select a Data Source to collect scores from.
   Only JDBC type data sources are supported by Performance Analytics. Refer to the data sources documentation for information on setting up data sources.

   **Note:** The SQL Statement and Import set table defined in the data source are not used by Performance Analytics.

5. Specify the SQL Statement to use to calculate the score value.
   The SQL statement must return an aggregate value with the alias value, and should filter data based on a date field, such as `SELECT count(*) AS value FROM... WHERE DATE(date_field) >= DATE(${start_at})`.

   **Important:** The aggregate alias must be value.

6. If you prefer that the score of this indicator increases or decreases over time, select Maximize or Minimize in the Direction field.
   Analytical tools and graphic displays use this Direction with this indicator.
**Tip:** Set a direction whenever you can. All key indicators should be set to Maximize or Minimize.

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td>Select if an increase in this indicator score is desired. For example, consider selecting <strong>Maximize</strong> for an indicator that shows revenue. Analytic tools and graphic elements reflect that an increase in this indicator score is good and a decrease is bad.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting <strong>Minimize</strong> for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td>None</td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

7. Specify any of the optional indicator properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>The unit of measurement for the score, such as number, days, or percentages. To collect scores in the system reference currency on a Price, Currency, or FX Currency field, select <strong>Use reference currency</strong>. For more information, see <strong>Indicator scores in reference currency</strong>. If you select % or a time period as the unit, consider excluding some types of time series from being applied to the indicator. For more information,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>see <strong>Exclude time series</strong> from an indicator.</td>
<td></td>
</tr>
<tr>
<td>Precision</td>
<td>The number of digits behind the decimal separator. For thousands and millions, the score is given in thousands or millions followed by a k or an M, with the next lowest power of 10 following the decimal. For more information, see Rounding and precision in indicators. This field is not available when the unit is <strong>Use reference currency</strong>. In this case, the precision is inherited from the reference currency.</td>
</tr>
<tr>
<td>Key</td>
<td>Identifies the indicator as a key indicator. Used only to filter the list of indicators in <strong>Performance Analytics &gt; Analytics Hub</strong>.</td>
</tr>
</tbody>
</table>

8. In the **Access control** tab, set whether to publish this indicator to the Analytics Hub, and whether to limit the visibility of the indicator by user, group, or role.

9. **Optional:** In the **Other** tab, set various miscellaneous properties.

**‘Other’ tab fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default time series</td>
<td>A predefined analytical function, like a 7-days running average, to apply to the indicator instead of showing the raw scores of the indicator. For more information, see Applying time series aggregations.</td>
</tr>
</tbody>
</table>

**Note:** You cannot set the default time series for an indicator that uses a business or fiscal calendar. These calendars do not support time series aggregations.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live group profile</td>
<td>Live Group Profile [live_group_profile] record for a Live Feed group. Specify a group profile to cause that group to get notifications about this indicator. For more information about this social application on the Now Platform, see Live Feed.</td>
</tr>
<tr>
<td>Order</td>
<td>Number indicating the order in which indicators are displayed in the Analytics Hub. Indicators with the lowest value are displayed at the top of the list. If no values are provided in the Order field, indicators are displayed from a to z using the Name field. To use the order field, you must enter order numbers for all indicators. If you put in numbers for only a few indicators, the order in which indicators are displayed reverts to a to z.</td>
</tr>
<tr>
<td>Default chart type</td>
<td>Set a default chart type (line, column, spline, or area) for this indicator. When opening the Analytics Hub for this indicator for the first time, the default chart type is used. If the chart type is changed in the Analytics Hub, that preference is remembered.</td>
</tr>
<tr>
<td>Render continuous lines</td>
<td>When selected, the Analytics Hub shows unbroken data lines for this indicator, even when there is no data for a specific date. This behavior may be useful when displaying data sets with varied starting dates or data that is not regularly updated, such as stock information. Continuous lines are not rendered when a time series is set on the indicator or the Analytics Hub.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show real-time score</td>
<td>When selected, the Analytics Hub shows the score of this indicator in real time, as well as the current state of associated records. Clear this check box when indicator data is not available in real time, such as in an integration that uses data from a third-party source. For more information, see Real-time scores. Note: A condition must be set on the indicator or the associated indicator source for real-time scores to be displayed.</td>
</tr>
<tr>
<td>Show delta</td>
<td>When selected, enables reporting of historic records when viewing this indicator in the Analytics Hub. You can filter the data to display only the current data, only the historical data, or the data shared between both sets.</td>
</tr>
</tbody>
</table>

10. **Optional:** In the **Forecasting** tab, set the forecast method, the number of data collection periods to forecast, the amount of historical data to base the forecast on, and the upper and lower limits of forecast values. For more information, see Performance Analytics scores forecasts.

11. Save the indicator.

12. Press **Test Collection**. This action tests the main query of the indicator.

**What to do next**
If you want to collect breakdown scores for the indicator, define an external breakdown and associate it with the indicator.

**Create a breakdown using external data**
Create an external breakdown to define what elements are available to break down external indicator scores.

**Before you begin**
Role required: pa_admin, pa_power_user, or admin
About this task
By default an external breakdown can contain a maximum of 5000 elements. This limit is controlled by the property com.snc.pa.dc.max_external_elements.
External breakdown elements are stored on the pa_ext_elements tables.

Procedure
1. Navigate to Performance Analytics > External Breakdowns.
2. Click New.
3. Select a Data Source that contains the records you want to use as breakdown elements. Only JDBC type data sources are supported by Performance Analytics. Refer to the data sources documentation for information on setting up data sources.

   Note: The SQL Statement and Import set table defined in the data source are not used by Performance Analytics.

4. Specify a SQL Statement to select the breakdown elements. The SQL Statement must return the unique key for each breakdown element with the alias id and the element display name with the alias name, such as SELECT guid AS id, user_name AS name FROM....

   Important: The unique key alias must be id and the display name alias must be name.

5. Save the breakdown.
6. Press Test Collection. This action tests the query that selects the breakdown elements.

What to do next
After defining how to collect breakdown elements, associate the external breakdown with one or more external indicators.

Configure an external indicator to use an external breakdown
Associate an external indicator and external breakdown to define how to collect breakdown scores for the indicator.

Before you begin
Role required: pa_admin, pa_power_user, or admin
Procedure

1. Navigate to **Performance Analytics > External Indicators**.
2. Select an indicator.
3. In the **Breakdowns** related list, click **New**.
4. Select the external **Breakdown** to apply to this indicator.
5. In the **SQL statement** field, enter a SQL statement that calculates the score value for each breakdown element.
   The SQL statement should use the same aggregate function as the indicator SQL statement, such as COUNT. The SQL statement must return the aggregate value with the alias **value** and the breakdown element unique key with the alias **id**. The SQL statement must also group the data by the column that contains the breakdown element values.
   For example, `SELECT count(*) AS value, guid as id FROM... WHERE DATE(date_field) >= DATE({$start_at}) GROUP BY guid`

   **Important**: The aggregate alias must be **value** and the breakdown unique key alias must be **id**.

6. Save your changes.
7. Press **Test Collection**.
   This action tests the SQL statement that calculates the score value for the breakdown element.

**What to do next**
Repeat the previous steps to add additional breakdowns to the indicator. Test the SQL statement after adding each one.

**Test external indicators and breakdowns**
Test your external indicators and breakdowns to ensure you can connect to the external data source and collect the data you expect.

**Before you begin**
Role required: pa_admin, pa_power_user, or admin

**About this task**
Test an indicator to test the query for that indicator and the queries for all breakdown elements. Test a breakdown to test the query used to determine available breakdown elements.
No scores or breakdown elements are saved when you test an indicator or breakdown.
Procedure

1. Navigate to Performance Analytics > External Indicators or Performance Analytics > External Breakdowns.

2. Select the indicator or breakdown that you want to test.

3. Click the Test button.

   If the query runs successfully, the number of scores or breakdown elements that would be collected appears. If an error occurs during testing, the error message appears.

What to do next

After confirming that all queries run successfully and return the data you expect, add the external indicator to a data collection job to begin collecting scores.

Filtering external data by date

When using Performance Analytics with external data you must filter SQL statements that collect scores by date.

In indicator and indicator breakdown SQL statements, filter the query by date, such as WHERE DATE(my_date_field) >= DATE(${start_at}). It is not necessary to filter breakdown SQL statements by date as breakdown SQL statements collect only elements and not scores.

The variable ${start_at} contains the date of the period being collected in the format YYYYMMDD. For daily indicators this value is always the date being collected. For indicators with longer collection frequencies, such as weekly or monthly, the date is the first day of the collection period. The date that the data collection job runs on does not affect this variable.

When you test an indicator or breakdown, the ${start_at} variable is always set to the current date.

Limitations when using Performance Analytics with external data

Certain Performance Analytics functionality is not available when you measure external data.

- You cannot collect snapshots
- You cannot view real-time scores
- You cannot apply 2nd-level breakdowns
- You cannot use widget visualizations that depend on 2nd-level breakdowns with external data. This includes pivot and heatmap visualizations.
- Because snapshots are not available, you cannot view changes in collected records
Cleaning collected Performance Analytics data

Performance Analytics scores and snapshots may grow over time and should be routinely cleaned to ensure optimal performance and accurate data.

Performance Analytics uses a scheduled job to remove old scores and snapshots.

The Clean PA collections scheduled job is active by default and has no impact on performance. By default, the job runs daily so it only has to delete a small amount of data.

⚠️ Note: The table attributes nibble_size and nibble_sleep affect the behavior of the collection cleaner job if the attributes are defined for the Scores or Snapshots tables.

This scheduled job also deletes any Score [pa_scores], Score Level 1 [pa_scores_l1], Score Level 2 [pa_scores_l2], or Snapshots [pa_snapshots] records that do not have an associated indicator or breakdown. For example, if a user deletes an indicator, the scheduled job cleans up any scores or snapshots that were associated with the deleted indicator.

Related information

Dictionary Attributes

Modify the Clean PA collections job

Modify the scheduled job to configure when Performance Analytics scores and snapshots are cleaned. The scheduled cleanup job should not run while a data collection job is running.

Before you begin
Role required: pa_admin or admin

About this task
By default, the Clean PA collections job runs at 05:00 which is appropriate when using the default data collection jobs. If you create additional data collection jobs, you may need to change the start time of the Clean PA collections job.

Procedure

1. Navigate to Performance Analytics > Automation > Schedules.
2. Select the Clean PA collections job.
3. Make any necessary changes. For example, change the **Run time** field value to change when the job runs.

4. Click **Update**.

**Related information**

**Scheduled jobs**

**Migrating Performance Analytics scores**

The Performance Analytics Scores [pa_scores] table was split into two tables. This structure helps with processing large numbers of scores. You can migrate your scores from the old table structure to the new, using the score migration tool.

⚠️ **Warning:** The new table structure is not supported on Oracle databases.

In Istanbul, the Scores [pa_scores] table was split into Scores Level 1 [pa_scores_l1] and Scores Level 2 [pa_scores_l2]. The pa_scores_l2 table contains the second-level breakdown matrix of scores and the pa_scores_l1 table contains all other scores. This separation of scores ensures optimal performance when collecting and analyzing scores, and enables larger sets of scores. New instances created on the Istanbul release or later use the new scores tables by default.

Instances created prior to Istanbul still use the original Scores [pa_scores] table after upgrading. However, you can migrate your scores on these instances to the new scores tables. Your instance must be on a release that supports the scores migration tool, as follows:

- London, with patch 10
- Madrid, with patch 6
- All New York and later releases

**Migration Monitor**

After beginning the migration, you can track the migration status by navigating to **Performance Analytics > Scores Migration Monitor**.

If any errors occur during migration, contact Customer Service and Support to resolve the issue.

**Delays in starting score migration**

If any of the following processes are running, score migration remains in the **Waiting** state until they stop:
• Data collector jobs
• Collection cleaner jobs
• Scoresheet editing

**Schedule the Performance Analytics scores migration**

Schedule the automated migration process to move existing scores to the new table structure.

**Before you begin**
Role required: admin. Users with the pa_admin role can view the migration monitor page but cannot schedule the migration.

**About this task**
Migrating scores improves performance and scalability of Performance Analytics. Migration should be performed during off-peak hours.

During migration you cannot collect, modify, or delete scores. Scheduled data collection jobs do not run during migration. After migration completes, check any data collection jobs that were scheduled to run during the migration, as these jobs were suspended.

**Note:**
- The scores migration can take several hours to complete, depending on the number of scores. Schedule the migration in a non-production instance and then carefully plan the migration in production.
- The original Scores [pa_scores] table is truncated 10 days after successful migration.

**Procedure**

1. Navigate to **Performance Analytics > Scores Migration Monitor**.
2. Click the **Schedule Scores Migration** button.
   The scores migration is scheduled. The page displays the time that the migration is scheduled to start, and the estimated completion time.
3. **Optional:** Click the **Logs** or **Active Jobs** links to view additional information about the migration.
   If there are any data collection or cleanup jobs running when you start the migration, the migration waits for those jobs to complete before beginning. All scheduled collection and cleanup jobs are paused during the migration.
What to do next
If the migration fails for any reason, contact Customer Service and Support for assistance. Existing scores remain in place.

(Legacy) Quickly configure Performance Analytics for a task table

The configuration generator enables you to quickly configure Performance Analytics to display data from any task table.

Note: The configuration generator is a legacy feature. Performance Analytics Solutions are content packs of Performance Analytics components including dashboards. These Performance Analytics Solutions have been greatly expanded over the last few releases. The separate configuration generator has lost most of its value. For custom applications, it makes more sense to find and to install a closely related Performance Analytics Solution and modify it as needed. For more information, see Analytics and Reporting Solutions.

You can specify a Task-based table to report on, and the configuration generator automatically creates indicators, breakdowns, formulas, data collection jobs, and dashboards. This configuration provides the same elements as the Performance Analytics incident solution, but for any Task table. When using domain separation, all records are created in the domain of the current user.

Note: You can use the configuration generator only with tables that extend Task.

You can access the configuration generator by navigating to Performance Analytics > Configuration Generator.

After generating a configuration for the selected table, you can view the created records using the Go to the configuration record, Generated Indicators, and Generated Jobs related links. You can modify the generated records as needed using standard Performance Analytics configuration options.

Note: You may need to tweak the configuration before you start using the files that are created by the generator.

Activate the Performance Analytics configuration generator

As an administrator, you can enable the Performance Analytics configuration generator plugin (com.snc.pa.configurationgenerator).
Before you begin
Role required: admin
Before starting this procedure, you must have a subscription to Performance Analytics.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Reporting

ServiceNow® Reporting enables you to create and distribute reports that show the current state of instance data, such as the number of open incidents of each priority. Reporting functionality is available by default for all tables, except for system tables.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Administer</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Analytics, Intelligence, and Reporting release notes</td>
<td>• Administering reports includes role information</td>
<td></td>
</tr>
<tr>
<td>• Upgrade to Rome</td>
<td>• Report Administration module</td>
<td>• Getting started with reports</td>
</tr>
<tr>
<td>• Domain separation and Reporting</td>
<td></td>
<td>• Creating reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Distribute reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add a report to a dashboard or homepage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Using multiple data series in a report</td>
</tr>
</tbody>
</table>

Develop

• Data Visualization
• Developer documentation

Videos

• Watch Reporting videos

Troubleshoot and get help

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Getting started with reports

ServiceNow reports are visualizations of your data that you can share with users on dashboards and service portals, export to PDF, and send via email. Learn how to create, run, edit, view, and share reports.

Note: To administer reports, reporting roles, and report sources, navigate to Reports > Administration and select the area to administer.

Introduction to reporting video

The ServiceNow system includes a range of predefined reports that provide data on applications and features like incident management and service catalog requests. You can also create your own reports. Add reports on homepages and dashboards to share information across your organization.

The following podcast offers additional information on Reporting.

Reporting Podcast

Related information

Administering reports

Reporting compared to Performance Analytics

Reporting and Performance Analytics are two distinct applications. They address different use cases and are complementary to each other.

Watch this overview video of Reporting and Performance Analytics to understand the limitations of Reporting and how Performance Analytics is used to fill in the gaps and provide accurate trends over time. Video comparing trends from operational reports and snapshots

Performance Analytics is able to generate accurate historical trends by capturing continuous snapshots on a regular schedule. As illustrated by the following diagram, Reporting answers the question of "Where are we today," while Performance Analytics answers questions of what is happening over time.
Common process insight questions for Reporting and for Performance Analytics

In addition to calculating trends from snapshots, Performance Analytics is able to:

- Track performance against Targets.
- Alert when Thresholds are met.
- Forecast future performance.
- Compare performance at different points in time.
- Accelerate time to value with best practice metrics.

Run a report
Run a report to view current data with an existing report configuration.

Before you begin
To administer reports, reporting roles, and report sources, navigate to Reports > Administration and select the area to administer.

Procedure
1. Navigate to Reports > View/Run.
2. Click the title of the report you want to run.

Results
The report is shown in the Report Designer.
Note: If you are prevented from viewing a report, such as in cases of wrong configuration settings, not allowed access, or lack of data, a message specific to the error prompts you to contact the administrator.

Related information

Administering reports

Run a report from a list

You can create a pie or bar chart report directly from a list. If you have a reporting role you can also save, distribute, and export these reports.

Procedure

1. Navigate to the list.

2. Right-click the header of the column that contains the values you want to be displayed as the bars or slices in the chart.

3. Select **Pie Chart** or **Bar Chart**.

   ![Image of a list with options to create a chart]

   The report is generated and opened in the report creation tool.

What to do next

- Share the report using the Report Designer.
- Publish the report by generating a URL to share with other users.

Related information

Pie charts
Bar and horizontal bar reports
Create a report visualization
Create a report to visualize and analyze current instance data or temporary data that you have imported.

About this task
Watch this six-minute video to learn about generating reports, creating reports in the Report Designer, and sharing and scheduling reports. How to generate new reports, create reports in the report designer, share reports, and schedule reports.

Procedure
1. Follow one of these paths:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a report</td>
<td>Navigate to <strong>Reports &gt; Create New</strong>.</td>
</tr>
<tr>
<td>Edit an existing report</td>
<td>Navigate to <strong>Reports &gt; View / Run</strong> and click the edit icon (EDIT) beside the report name.</td>
</tr>
<tr>
<td>Create a report on a dashboard</td>
<td>Navigate to the dashboard where you want to add the report, click the Add Widgets icon (+), and select <strong>Reports</strong>.</td>
</tr>
<tr>
<td>Edit a report on a dashboard</td>
<td>Navigate to the dashboard where the report resides and click <strong>Edit</strong>. To edit a report, click its edit icon (EDIT).</td>
</tr>
</tbody>
</table>

2. On the **Configure** and **Style** tabs, fill in the fields, as appropriate.
3. Click **Save**.
   The report is generated.

   ☀ **Note:** For details on creating a specific report type, see **Creating reports**.

Report options
When you edit a form, you can also choose to save, share, run, delete, or view more information about the report.

All actions are available from the upper right side of the form, from the **Save** and **Share** lists and the **Info**, **Delete**, and **Run** buttons. Available report options vary depending on the role of the user working with the report.
### Report options

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link (🔗)</td>
<td>Displays the URL of a saved report that you can copy into other documents.</td>
</tr>
<tr>
<td>Info (ℹ️)</td>
<td>Displays general and statistical information for the report. General information includes the base table, type, creator, users, groups, and last modification date of the report. Statistical information includes when the report was last run, the number of runs, and run time.</td>
</tr>
<tr>
<td>Sharing (🔄)</td>
<td>Displays several options for sharing the output of the report.</td>
</tr>
<tr>
<td>Share</td>
<td>Enables you to set the visibility of the report. Options are Me, Everyone, and Groups and Users. See Share a report for more information on sharing. This option is available from the Sharing icon (🔄).</td>
</tr>
<tr>
<td>Schedule</td>
<td>Creates a schedule for running the report.</td>
</tr>
</tbody>
</table>

**Note:** You cannot schedule calendar reports.
Report options (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to Dashboard</td>
<td>Adds the current report to a dashboard or homepage. For details on how to edit reports and other dashboard content, see Edit a responsive dashboard.</td>
</tr>
<tr>
<td>Note: Users can add reports to any homepage they can view. Users who do not have edit rights to a homepage create new homepages with the added information when they modify a homepage that they don't own.</td>
<td></td>
</tr>
<tr>
<td>Export to PDF</td>
<td>Generates a PDF that you can download or email. This option is not available for calendar reports.</td>
</tr>
<tr>
<td>Note: Drilldown reports do not export to PDF. If you select Export to PDF on a drilldown report, a PDF of the top-level report is generated.</td>
<td></td>
</tr>
<tr>
<td>Publish</td>
<td>Creates a URL for the report and displays the URL above the report form. You can email this URL to share the report.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the report.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves your changes to the report and leaves the form open.</td>
</tr>
<tr>
<td>Update</td>
<td>Saves your changes to the report and returns to the Reports list.</td>
</tr>
<tr>
<td>Insert</td>
<td>Duplicates the report record, inserts it into the Reports list, and opens the Reports list. Use this option to create a report quickly by changing values in an existing report. Be sure to give the new report a unique name.</td>
</tr>
<tr>
<td>Insert and Stay</td>
<td>Duplicates the report record, inserts it into the Reports list, and opens the new record. Use this option to create a report quickly by changing values in an existing report. Be sure to give the new report a unique name.</td>
</tr>
<tr>
<td>Save as data source</td>
<td>Opens the Create new report source window in which you can save the report conditions as a report source that can be reused for other reports.</td>
</tr>
</tbody>
</table>
Report options (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Run</td>
</tr>
<tr>
<td>Run</td>
<td>Creates the report based on the conditions and layout you select.</td>
</tr>
</tbody>
</table>

Related information

Administering reports

View the Reports list

View a list of reports and create reports from the Reports list.

On the View / Run report module, standard platform ACLs control access to reports in the reports list. For information about the ACLs used to control access to reports, see Access control rules.

You can sort and filter the search results using the standard report list controls, such as by clicking tabs, column headings, or the favorites icon (★).

Select the gear icon (⚙️) next to the Create a report button to configure the columns displayed in the Reports list.
You can filter the Reports list with the following tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My reports</td>
<td>Reports that you created.</td>
</tr>
<tr>
<td>Group</td>
<td>Reports that have been shared with you and with the groups that you are a member of.</td>
</tr>
<tr>
<td>Global</td>
<td>Reports that are available to everyone.</td>
</tr>
<tr>
<td>All</td>
<td>All reports that you have access to (Global, Group, and My reports).</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Users with report_admin or admin roles also see these columns on their Reports list.

### Additional columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>Indicates if the report is scheduled to run in the future. Reports can be run periodically to be emailed.</td>
</tr>
<tr>
<td>Published</td>
<td>If the report is published, shows a check mark (✔).</td>
</tr>
</tbody>
</table>

### View favorite reports

You can show either all reports or only those reports marked as favorites. Reports can be marked favorite both automatically and manually.

**About this task**

To toggle between showing only favorite reports and showing all reports, click the favorites icon (⭐) in the list header.

ℹ️  **Note:** Favorites filtering is persistent. If you chose to show only favorites the last time you viewed the Reports list, then only favorites are shown the next time. Click the favorites icon or the Favorites filtering is on button to show all reports you have the rights to view in the selected category. The My reports category is selected by default when you open the Reports list.
A report is automatically marked as a favorite when you open it. You can manually mark a report as a favorite by clicking the star icon beside the report title.

Note: To turn off the automatic marking of reports as favorites, disable the user preference glide.ui.nav.auto_favorite. For more information, see User preferences.

Reports list URL parameters
You can add parameters to the Reports list URL to filter the list before it loads.

Reports list URL structure
For example, the URL https://yourbusiness.service-now.com/report_home.do?jvar_selected_tab=MyReports returns the Reports list with the My Reports tab selected.

Parameters
The following parameters are available for Reports list URLs:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>jvar_selected_tab</td>
<td>Shows the Reports list with the specified tab selected. Use these values:</td>
</tr>
<tr>
<td></td>
<td>• myReports</td>
</tr>
<tr>
<td></td>
<td>• groupReports</td>
</tr>
<tr>
<td>Parameter</td>
<td>Possible values</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>jvar_search_table</td>
<td>Filter reports created on a specified table. For example, the parameter jvar_search_table=incident shows only the reports created on the incident table.</td>
</tr>
<tr>
<td>jvar_list_order_by</td>
<td>Sorts the list on one of these columns:</td>
</tr>
<tr>
<td></td>
<td>• type</td>
</tr>
<tr>
<td></td>
<td>• title</td>
</tr>
<tr>
<td></td>
<td>• table</td>
</tr>
<tr>
<td></td>
<td>• modificationDate</td>
</tr>
<tr>
<td></td>
<td>• scheduled</td>
</tr>
<tr>
<td></td>
<td>• published</td>
</tr>
<tr>
<td></td>
<td>• createdBy</td>
</tr>
<tr>
<td></td>
<td>For example <a href="https://yourbusiness.service-now.com/report_home.do?jvar_list_order_by=table">https://yourbusiness.service-now.com/report_home.do?jvar_list_order_by=table</a> returns the list sorted by the source table of the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use jvar_list_sort_direction to specify ascending or descending order.</td>
</tr>
<tr>
<td>jvar_list_sort_direction</td>
<td>Specifies the direction of the sort.</td>
</tr>
<tr>
<td></td>
<td>• asc — Sorts the list in ascending order</td>
</tr>
<tr>
<td></td>
<td>• desc — Sorts the list in descending order</td>
</tr>
<tr>
<td>.sysparm_reportquery</td>
<td>Filters the reports with names that contain the specified value, for example: sysparm_reportquery=Active</td>
</tr>
<tr>
<td>Parameter</td>
<td>Possible values</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>returns reports with the string Active in the title.</td>
</tr>
<tr>
<td>jvar_search_created_by</td>
<td>the user who has created the report for example:</td>
</tr>
<tr>
<td></td>
<td><a href="https://yourbusiness.service-now.com/report_home.do">https://yourbusiness.service-now.com/report_home.do</a>?</td>
</tr>
<tr>
<td></td>
<td>jvar_selected_tab=allReports&amp;jvar_search_created=itil</td>
</tr>
<tr>
<td></td>
<td>returns the reports created by the user with user name itil.</td>
</tr>
<tr>
<td>sysparm_query</td>
<td>Enables you to filter on any condition in platform condition builder format. For example,</td>
</tr>
<tr>
<td></td>
<td>For more information, see <a href="#">Condition builder</a></td>
</tr>
</tbody>
</table>

**Copy a report**

Users who cannot create their own global reports can modify a global report, and then save a personal version of the report.

**Before you begin**

Role required: itil, report_user, report_group, report_global, report_admin, or admin.

**About this task**

If you save a global report as a group or personal report, the platform copies the report. The security state of the report is not changed.

ℹ️ **Note:** If you open a personal report and try to save it as a group or global report, only the security state is changed. The report itself is not copied.

ℹ️ **Note:** When you select **Insert and Stay** to copy a report, sharing settings are not copied to the new report.
Procedure

1. Navigate to Reports > View / Run.

2. Click the arrow next to the Save button or next to the Share icon ( ).
   If you have permission to change the report, you see the Save button. You only see the arrow if you don’t have permission to change the original report.

3. Select Insert and Stay.

<table>
<thead>
<tr>
<th>With the Save button</th>
<th>Without the Save button</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
</tbody>
</table>

The Insert and Stay action creates a copy of the report that you can modify.


5. Optional: Change the report visibility. In the upper right side of the report form, click the Sharing icon ( ) and select Share.

Related information

Share a report

Delete a report

Delete reports that are no longer used.

Before you begin
You must be the creator, an administrator, or have a managing role of a report to delete it. If a report has been shared with you, and you do not have a report managing role, you do not have the ability to delete it.

Procedure

1. Navigate to Reports > View / Run.
2. Select the report to delete.
3. When the report opens, click the **Delete** icon (🗑).
4. Confirm that you want to delete the report.

**Results**
The selected report is removed, and is no longer available to share, publish, or view.

**Related information**
Administering reports

**Report Designer keyboard shortcuts**
Keyboard shortcuts enable you to perform certain functions in the Report Designer without using your mouse.

You can use the following keyboard shortcuts.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run the current report</td>
<td>Control + Alt (Option) + R</td>
</tr>
<tr>
<td>Save the current report</td>
<td>Control + Alt (Option) + S</td>
</tr>
<tr>
<td>Delete the current report</td>
<td>Control + Alt (Option) + D</td>
</tr>
<tr>
<td>Opens the <strong>Data</strong> tab</td>
<td>Control + Alt (Option) + 1</td>
</tr>
<tr>
<td>Open the <strong>Sharing</strong> menu</td>
<td>Control + Alt (Option) + H</td>
</tr>
<tr>
<td>Display the <strong>Report info</strong> panel</td>
<td>Control + Alt (Option) + N</td>
</tr>
</tbody>
</table>

**Related information**
Keyboard shortcuts

**Distribute reports**
Distribute reports to provide business information to other users.

Watch the following video for an overview of distributing reports.

Different ways to distribute and share reports after they have been created.

**Report access control**
You can control who sees reports by applying a security state. You can make reports that are:
• Globally visible to all users
• Visible only to you if you are the report creator.
• Visible to one or more specific roles
• Visible to one or more specific users or groups

Sharing by user, group, or role, is the primary method of sharing reports. You can use access control lists (ACLs) to control access to the underlying table or database view data. Users are able to view reports when the user does not have access rights to a data record in a data source or source table of a report. However, they are not able to see that record in a list view or in a drill-down view. Database-view-list reports require the reporting user to satisfy ACLs on the target data to view records in the list. Users without sufficient permissions see filtered list reports.

Note: ACLs for a table do not propagate to database views based on that table. Database views require separate ACLs.

Reports that present aggregate data, such as pie or bar reports, do not require the user to satisfy target table ACLs to view the report. ACLs are required to view the list of records when you select a portion of a report visualization. When you have access to a report but not to some of its records, you do not see those records in a drill-down list or in a list view of the data in the report. However, they are included in visualizations of data.

If a user saves a global report as a group or personal report, the platform copies the report rather than changing its security state. Copying the report enables users who cannot create their own global reports to modify a global report, and then save a personal version of the report.

If a user opens a personal report and tries to save it as a group or global report, the security state is changed rather than copying the report.

Related information
ACL troubleshooting reference

Share a report
Control which users and groups can see a report in their Reports list.

Before you begin

Note: Users who do not have the report_admin, report_global, or report_group roles do not see the share menu in Report Builder.
The following roles can share reports:

<table>
<thead>
<tr>
<th>Role</th>
<th>Report sharing permissions</th>
</tr>
</thead>
</table>
| report_admin        | Can share a report that is shared with the user, any group, or everyone. This role can share with:  
|                     | • any user                                                                                 |
|                     | • any group                                                                                 |
|                     | • everyone                                                                                 |
| report_global       | • Can share a report that is shared with everyone. This role can share with everyone.        |
|                     | • Cannot share a report that is shared with the user or a group                           |
| report_group        | • Can share a report that is shared with the user, or a report shared with a group the user belongs to. This role can share the report with:  
|                     | ◦ any user                                                                                 |
|                     | ◦ any group                                                                                 |
|                     | • Cannot share a report that is shared with everyone, or with a group the user does not belong to. |
| report_publisher    | No sharing permissions.                                                                      |
| report_scheduler    | No sharing permissions.                                                                      |
| report_user         | No sharing permissions.                                                                      |

**About this task**

You can control who sees reports by making them:

- Globally visible to all users
- Visible only to you if you are the report creator.
- Visible to one or more specific users
- Visible to one or more specific groups
**Procedure**

1. Navigate to **Reports > View / Run** and select the report you want to control.

2. In the upper right side of the report form, click the **Sharing** icon ( ) and select **Share**.

3. In the Sharing settings dialog box, fill in the fields and click **OK**.

**Sharing settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible to</td>
<td>Users to whom the report is available. You can select the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Me</strong> Only you can view the report. This option is only available to you on the reports that you create.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Everyone</strong> All users can view the report. If roles are selected from the <strong>Roles</strong> field and added to the <strong>Role required</strong> list, only users with those roles can view the report.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Groups and Users</strong> Only specific groups and users can see the report.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Groups and Users</strong> option is visible to users with the report_group role.</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups whose members have permission to see the report.</td>
</tr>
<tr>
<td></td>
<td>This field is available when the <strong>Groups and Users</strong> option is selected.</td>
</tr>
<tr>
<td>Users</td>
<td>Users who have permission to see the report.</td>
</tr>
<tr>
<td></td>
<td>This field is available when the <strong>Groups and Users</strong> option is selected.</td>
</tr>
</tbody>
</table>

4. Click the **Sharing** icon ( ) and select **Add to Dashboard** or **Publish**.

5. Share the dashboard or share the URL of the published report. You can share the URL of the published report with any user, role, or group with whom you have shared the report.

The people with whom you share the report must have rights to view the report data.
Automate report distribution

Schedule a report to automate its distribution. Scheduled reports can be distributed in PDF, CSV, or XLS format. Graphical reports can be distributed in PNG or PDF format. Multilevel pivot reports can only be scheduled in PDF format.

Before you begin
Role required: To create scheduled reports, you must have both the report_user role and either the report_admin or report_scheduler role.

Note: It is not possible to schedule Calendar, Map, Pivot Table, and Single Score reports.

Procedure
1. Navigate to Reports > Scheduled Reports and click New.
2. Click a report that you want to schedule for distribution.
3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the scheduled report.</td>
</tr>
<tr>
<td>Report</td>
<td>Click the search icon to select the report to schedule.</td>
</tr>
<tr>
<td>Users</td>
<td>Enter individual recipients of the report.</td>
</tr>
<tr>
<td></td>
<td>To receive reports, users must have an email address defined and have <strong>Notifications</strong> set to <strong>Enable</strong> in their user records.</td>
</tr>
<tr>
<td>Groups</td>
<td>Select groups to receive the report.</td>
</tr>
<tr>
<td>Email addresses</td>
<td>Email addresses of report recipients who are not in the system.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to enable delivery of scheduled reports.</td>
</tr>
<tr>
<td>Run</td>
<td>Specify how often to generate and deliver the report.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time</td>
<td>Time of day to generate the report.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Select to specify a scripted condition for generating the report.</td>
</tr>
<tr>
<td>Omit if no records</td>
<td>Select to prevent the distribution of empty reports.</td>
</tr>
<tr>
<td>Condition</td>
<td>User-created script that checks for certain conditions to be true before generating reports.</td>
</tr>
<tr>
<td></td>
<td>This field is visible only when <strong>Conditional</strong> is selected. For more information about scripts on the ServiceNow platform, see <a href="#">Scripts</a>.</td>
</tr>
<tr>
<td>Subject</td>
<td>Text that appears in the subject line of the distribution email.</td>
</tr>
<tr>
<td>Introductory message</td>
<td><em>(Optional)</em> Add a message to the report. If the report output type is Embedded PNG,</td>
</tr>
<tr>
<td></td>
<td>• Use the tag <code>${report:png}</code> in the message body to position the report in the message. Otherwise, the report appears at the bottom of the message.</td>
</tr>
<tr>
<td></td>
<td>• Use the tag <code>${report:include_with}</code> to position other reports included with the email. Otherwise, these reports appear at the bottom of the message.</td>
</tr>
<tr>
<td>Type</td>
<td>Report output type. Graphical reports can be PNG or PDF files. List reports can be PDF, Excel, or CSV files.</td>
</tr>
<tr>
<td></td>
<td>When scheduling a graphical report, select the output type <strong>PDF</strong> or <strong>PDF-landscape</strong> to include the chart grid data. When scheduling a List report, select output type <strong>Excel</strong> or <strong>CSV</strong>.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Embedded PNG</strong> to embed the report visualization in the body of the email. Large images are scaled to fit the email.</td>
</tr>
<tr>
<td>Zip output</td>
<td>Select to send the report as a zip file.</td>
</tr>
<tr>
<td>Include with</td>
<td>Select one or more additional reports to include with the email. It is not possible to order the reports within the email.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Page size (Multilevel pivot report only) | Select from A3, A4, Letter, or Legal size. To specify the dimensions for a different paper size, select Custom and enter the Page height and Page width in pixels.
Page height (in pixels) (Multilevel pivot report only) | Shows when Page size is set to Custom. For non-standard paper sizes, multiply the page height in inches by 72 and enter the value in this field.
Page width (in pixels) (Multilevel pivot report only) | Shows when Page size is set to Custom. For non-standard paper sizes, multiply the page width in inches by 72 and enter the value in this field.

4. Click Submit.

5. Optional: Create additional scheduled reports. Click the search icon next to Include with to select the additional scheduled reports.

(Optional) Each report you add to the Included with list must have its own schedule. Send different reports to recipients of the previously identified reports, each with its own schedule.

To unschedule a report:

a. Navigate to Reports > Scheduled reports.

b. Select the entry.

c. Choose Delete from Actions on selected rows.

This action only deletes the report schedule, not the report itself.

Report output formats

You can export reports in certain output formats. You can schedule these reports for regular export.

Report output formats

<table>
<thead>
<tr>
<th>Report format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>Generate a PDF in portrait or landscape orientation. PDF reports include the chart grid data. Map reports cannot be exported to PDF format. <strong>Note:</strong> To export Multilevel pivot tables to PDF, you must enable the Webkit HTML to PDF (com.snc.whtp) plugin.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Report output formats (continued)

<table>
<thead>
<tr>
<th>Report format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excel</td>
<td>Report visualization shows as a Microsoft Excel (XLS) spreadsheet.</td>
</tr>
<tr>
<td>PNG</td>
<td>Report visualization shows as a Portable Network Graphic (PNG) file. Also see how to embed reports as images in a scheduled report email.</td>
</tr>
<tr>
<td>CSV</td>
<td>Report visualization shows as a comma-separated value (CSV) plain-text file.</td>
</tr>
</tbody>
</table>

**Publish a report**

Publish a report to create a URL that anyone can use to access the report, including people who are not users. When anyone navigates to the URL, the report is generated with current data from the instance. Reports are available until they are unpublished.

**Before you begin**

Role required: both the report_publisher and report_user, report_admin, or admin.

**About this task**

There are limitations to what users see when they follow the publish URL for a report:

- Data that is visualized as a graphic report and not limited by business rules is always visible in published reports. Graphic reports are all reports except for list reports.
- Read ACLs govern the content of list reports. Users cannot see records for which they do not have access.
- Public roles with access to a published report may see a smaller subset of the original data displayed in the report if they're not logged in. For help resolving when a published report isn't showing all the expected data, see KB article KB0736982.

Users with the admin or report_admin role can see if a report has been published. Navigate to Reports > View / Run, open the report, and click the Sharing icon ( ). If the Sharing menu has the Publish option, the report is not yet published. If the Sharing menu has the Unpublish option, the report has been published.
Note: To make a report available only to logged in users, set its Sharing setting to Everyone, but do not publish it.

Procedure
1. Enable the property glide.report.published_reports.enabled. For more information about configuring properties, see Add a system property.
3. Click the report you want to publish.
4. In the upper right side of the report form, click the Sharing icon (])== and select Publish.
   A link icon (🔗) shows with the Report option icons message. Click this icon to show a link to the published report. This link is available as long as the report is published.
   
   Note: Business rules may affect how records are collected for public reports.

Unpublish a report
Published reports are available at the published URL until you unpublish them.

Before you begin
Role required: both the report_publisher and report_user, report_admin, or admin

Procedure
1. Navigate to Reports > View / Run.
2. Select the report you want to unpublish.
3. From the upper right side of the report form, click the Sharing icon ( расположен ) and select Unpublish.

Results
The report is no longer published and the link icon (🔗) is removed from the report designer for the unpublished report.
Add a report to a dashboard or homepage

Make actionable decisions faster by combining relevant reports and widgets onto a dashboard or a homepage. Navigating to single reports and widgets is time-consuming and less efficient.

Before you begin

Role required: Any user who can create a report can add it to a responsive dashboard or a homepage.

To add a report to a non-responsive dashboard, one of the following roles is required: itil, report_user, report_global, report_group, report_admin, pa_power_user.

Note: It is recommended to add a report to a dashboard. Homepages have more restrictive layouts and permission structures than dashboards. For more information, see Differences between homepages and responsive and non-responsive dashboards.

Watch this six-minute video to learn about generating reports, creating reports in the Report Designer, and sharing and scheduling reports. How to generate new reports, create reports in the report designer, share reports, and schedule reports.

Procedure

1. Click the Settings icon.
2. Select the General tab.
3. Under Home, select Dashboards or Homepages.

5. Select a report.

6. Click the Sharing icon ( ) and select Add to Dashboard.

7. Select if you want to add the report to a Homepage or Dashboard (default).

8. Based on your selection, perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>Select the Dashboard and Tab to add the report to.</td>
</tr>
<tr>
<td>Homepage</td>
<td></td>
</tr>
<tr>
<td>a.</td>
<td>Select the Homepage to add the report to.</td>
</tr>
<tr>
<td>b.</td>
<td>For non-responsive homepages, click Add here to add the report in a specific position, or click Add to add the report to the first available position on the homepage.</td>
</tr>
</tbody>
</table>

9. If you selected a dashboard to add the report to, perform the applicable action:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>for responsive dashboards</td>
<td>Click Add. The widget is added to the dashboard in the top position and the dashboard opens. Click Edit to move or resize the widget.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>for non-responsive dashboards</td>
<td>Click Add here to add the report in a specific position, or click Add to add the report to the first available position on the homepage or dashboard.</td>
</tr>
</tbody>
</table>

Reports on Service Portal

Show reports using Service Portal.

When you edit a portal, add the Report widget. Use the widget options to specify a report to show on the service portal and whether to show the title of the report.
With the report widget, you can show all report types on your portal except for list reports. Use the Simple List Widget instead.

**Activate the Performance Analytics and Reporting - Service Portal Widgets plugin**

You can activate the Performance Analytics and Reporting - Service Portal Widgets plugin (com.snc.pa.sp.widget) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

The Service Portal Widget plugin activates these related plugins if they are not already active.

**Plugins for Performance Analytics and Reporting - Service Portal Widgets**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Tip:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plug-in name>`.

**Related information**

**List of plugins**

**PDF page header footer templates**

Administrators and report owners can create header and footer templates in Report Builder for reports exported as PDFs.

**Tip:** This feature is not available from the Report Designer.

A default PDF page header footer template appears on all PDF exports that do not specify a custom header footer template. PDF page header footer templates are saved independently from reports. All header and footer text uses 8-point Helvetica bold font. A PDF page header footer template is made of multiple cells containing report attributes or user-specified content.

The default PDF page header footer template appears on all reports, as well as exports from lists, unless you define a specific template for that report. You can modify the default template but you cannot delete it. In the default template, the header shows the report **Title** and the page number in the format **Page X**. The footer shows the report **Run by** field and the report run time and date.

**Create a header footer template for reports exported to PDF**

A PDF page header footer template defines the page header and footer layout for PDF files exported from your instance.

**Before you begin**

Role required: report_admin or admin

**About this task**

The header and footer each have three cells: Left, Middle, and Right. To leave a cell blank, select **Empty**.
Procedure
1. Navigate to Reports > Header Footer Templates.
2. Click New.
3. Enter a Name for the template.
4. Select the content option for each header and footer cell, and enter or upload content as appropriate.

Template form view

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page number of the PDF</td>
<td>Page number in either the Page X format or Page X of Y format.</td>
</tr>
<tr>
<td>Report Title</td>
<td>Title of the report.</td>
</tr>
<tr>
<td>Run by</td>
<td>Name of the user who ran the report.</td>
</tr>
<tr>
<td>Run Date and Time</td>
<td>Date and time the report ran.</td>
</tr>
<tr>
<td>User Specified Text</td>
<td>User-defined message. Messages are truncated at 150 characters.</td>
</tr>
<tr>
<td>Image</td>
<td>User-specified. Upload a new image when selecting Image content. Images are scaled to fit the space available in the template cell.</td>
</tr>
</tbody>
</table>

5. Click Submit.

What to do next
To apply the template to the PDF output of any report, you must do so from the Report Builder (Classic UI). See steps for this task in the Kingston release documentation: Apply a PDF page header footer template to a report

Creating reports
Learn about different types of reports you can create, and when and how to create them.

Report types
You can generate the following types of reports, organized by category:
• Bar reports enable you to compare scores across data dimensions.

• Pie and Donut reports visualize the relationship between the parts and the whole of a data set using shapes such as pies.

• Time Series reports visualize data over time. In addition to data from within your instances and imported data sources, you can also use MetricBase data in time series reports. For more information, see MetricBase application.

• Multidimensional reports visualize data across dimensions in a single table or graph.

• Scores visualize single data points either across ranges or as a single value.

• Statistical reports visualize data with statistical values such as medians and means.

• Other reports include calendars, maps, and lists.

How to generate new reports, create reports in the report designer, share reports, and schedule reports.

You can also use Natural Language Query (NLQ) inside Report Designer to generate a report. Simply write a question into the NLQ field, and the Report Designer generates a report of an appropriate type.

### Bar reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar and horizontal bar reports</td>
<td>Shows vertical bars with lengths proportional to the values that they represent.</td>
</tr>
<tr>
<td>Bar and horizontal bar reports</td>
<td>Shows horizontal bars with lengths proportional to the values that they represent.</td>
</tr>
<tr>
<td>Pareto reports</td>
<td>Combines bar and line reports to identify the most important factors in a large set of factors.</td>
</tr>
<tr>
<td>Histogram reports</td>
<td>Provides visual interpretation of numerical data by indicating the number of data points that lie within a range of values.</td>
</tr>
</tbody>
</table>
## Pie and Donut reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pie charts</td>
<td>Shows how individual pieces of data relate to the whole using a circle to represent the whole.</td>
</tr>
<tr>
<td>Donut reports</td>
<td>Shows how individual pieces of data relate to the whole using a donut shape to represent the whole.</td>
</tr>
<tr>
<td>Semi-donut reports</td>
<td>Shows how individual pieces of data relate to the whole using a semi-donut shape to represent the whole. A semi-donut report uses a donut sliced in half to represent the whole.</td>
</tr>
</tbody>
</table>

## Time series reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column reports</td>
<td>Shows how one or more values change over time by displaying them as proportional vertical columns.</td>
</tr>
<tr>
<td>Line reports</td>
<td>Shows how one or more values change over time by connecting a series of data points with straight lines.</td>
</tr>
<tr>
<td>Step line reports</td>
<td>Shows how one or more values change over time by connecting a series of data points with horizontal and vertical lines.</td>
</tr>
<tr>
<td>Area and spline reports</td>
<td>Resembles a line chart, but the area between the axis and line is commonly emphasized with colors.</td>
</tr>
<tr>
<td>Area and spline reports</td>
<td>Shows how one or more values change over time by connecting a series of data points with a fitted curve through the data points. Spline reports let you take a limited set of known data points and approximate intervening values.</td>
</tr>
</tbody>
</table>

## Multidimensional reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multilevel pivot tables</td>
<td>Displays aggregate data broken down by multiple metrics in a single chart.</td>
</tr>
</tbody>
</table>
**Multidimensional reports (continued)**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heatmap reports</td>
<td>Displays aggregate data in a matrix using colors to represent different values.</td>
</tr>
<tr>
<td>Bubble reports</td>
<td>Displays multiple metrics on a single chart.</td>
</tr>
</tbody>
</table>

**Scores**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speedometer reports</td>
<td>Shows an overview of the count of an indicator at the current moment in the form of a round meter.</td>
</tr>
<tr>
<td>Dial reports</td>
<td>Shows an overview of the count of an indicator you want to measure at this moment in a half circle, where the part in which scores are shown is filled out with a color.</td>
</tr>
<tr>
<td>Single score report</td>
<td>Displays a single aggregate value that is important to your business.</td>
</tr>
</tbody>
</table>

**Statistical analysis visualizations**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control reports</td>
<td>Displays data as a series of connected points to determine whether a business process is in a state of statistical control and to identify outliers. (Found in the Other reports section.)</td>
</tr>
<tr>
<td>Trend reports</td>
<td>Shows how the value of one or more items changes over time. Values along the horizontal axis of the trend report represent the time measurement. Values on the vertical axis represent the changes to the items being monitored. The trend line or curve reveals a general pattern of change. (Found in the Other reports section.)</td>
</tr>
<tr>
<td>Box reports</td>
<td>Shows the distribution of values in a data set highlighting statistical averages. (Found in the Other reports section.)</td>
</tr>
</tbody>
</table>
### Statistical analysis visualizations (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trendbox reports</td>
<td>Shows the distribution of values in a data set highlighting statistical averages for a specified period of time. (Found in the Other reports section.)</td>
</tr>
</tbody>
</table>

### Other reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Funnel and pyramid reports</td>
<td>Displays values as progressively decreasing proportions. The size of each section reflects a percentage of the total of all values. (Found in the Other reports section.)</td>
</tr>
<tr>
<td>List reports</td>
<td>Displays data in the form of an expandable list, similar to a standard ServiceNow list.</td>
</tr>
<tr>
<td>Calendar reports</td>
<td>Displays data-driven events in a calendar format.</td>
</tr>
<tr>
<td>Map reports</td>
<td>Displays data on a geographical map image.</td>
</tr>
<tr>
<td>Pivot tables</td>
<td>Aggregates data from a table to display the source of summarized data. This functionality is expanded in multilevel pivot reports.</td>
</tr>
<tr>
<td>Funnel and pyramid reports</td>
<td>Visualizes a variation on a bar report using pyramid sections instead of rectangles. (Found in the Other reports section.)</td>
</tr>
</tbody>
</table>
Choosing a report type

Choose a report type based on the story you want data to tell.

Create a report with Analytics Q&A

Enter a question on the Report Designer form, and Analytics Q&A generates a report. Analytics Q&A gives you a choice of data sources and picks an appropriate visualization.

Before you begin

Analytics Q&A requires Natural Language Query (NLQ). NLQ also must be enabled for use with the Report Designer, in Reporting properties. Check with your administrator.

Note: Analytics Q&A is not available when using Microsoft Internet Explorer.

Role required: None

About this task

Analytics Q&A supports the following languages:

- English
- French
• Spanish
• German
• Japanese

The feature is not available in sessions that use an unsupported language.

**Procedure**

1. Navigate to **Reports > Create New**.

2. Start typing what information you want in the report into the Analytics Q&A field.
   Analytics Q&A uses keywords in your query to determine what kind of information you are looking for. It displays suggestions while you type based on these keywords. To see a full list of keywords and their uses, click **How can I improve my results?**.

3. Click **Ask**.
   Analytics Q&A generates the report, including an appropriate visualization.
What to do next
You can modify the report, such as changing the visualization, in the left-margin menu. If you enter a new query and click Ask, you generate a new report. Any custom visualizations you added are cleared, but other settings persist in the new report.

Related information
- Natural Language Query
- Analytics Q&A

Area and spline reports
Area reports show trends over time for related attributes. Spline reports show how one or more values change over time by connecting a series of known data points with a curve that emphasizes the trend over individual data points.

For example, you can create an area or spline reports for incident counts, to show how the number of incidents changes over time. The incident count often increases during the first few months after a product upgrade is deployed. Over time, the number of reported incidents decreases as users become more accustomed to the changes in the product.

Area reports

![Area chart Incidents by Assignment group](image-url)
Note:
When the sections of an area report with multiple datasets overlap, it is not possible to drill down into the various sections. To drill down, click items in the legend to clear them from the report.

Spline report

Create an area or spline report
Create an area or spline report to show trends over time for related attributes.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td></td>
<td>⚠ Note: If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name. For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon () to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.

5. On the Type tab, enter Area or Spline in the filter, select the report type, and click Next.

   The application shows a preliminary version of the report. To view the updated report at any time, click Run.

6. On the Configure tab, fill in the following fields and click Next.
## Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group by</strong></td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables. Click the info icon (i) for a description of the selected field. Configured function fields appear in this list after you save the report. <strong>Note:</strong> - It is not possible to group or stack reports by the <strong>Tags</strong> field, or by certain field types, such as MEDIUMTEXT. - Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.</td>
</tr>
<tr>
<td><strong>Additional group by</strong></td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see How to report on extended tables. Click the info icon (i) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. <strong>Note:</strong> - It is not possible to group or stack reports by the <strong>Tags</strong> field, or by certain field types, such as MEDIUMTEXT. - Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.</td>
</tr>
<tr>
<td><strong>Display data table</strong></td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to <strong>true</strong>. The glide.ui.section508 property overrides the <strong>Display data table</strong> field.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence. Click the info icon (i) for a description of the selected field. <strong>Note:</strong> If you selected a remote table in the <strong>Table</strong> field, the option you select in this field aggregates the data that was retrieved from an external source and aggregated in memory. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td>Calendar</td>
<td>Calendar that is the basis for the time series in the report. Select either the standard calendar or a customized business calendar.</td>
</tr>
<tr>
<td>per</td>
<td>Time period to group data by. The range of available time periods depends on the calendar that you selected. Time periods range from an hour to a year. You can also specify a date. <strong>Note:</strong> If reporting per week: When the report range includes more than one calendar year, inconsistencies result when a week is split between two years. To show data values more accurately according to ISO weeks, add and enable the glide.db.aggregates.trend.use_iso_week property in the System Properties [sys_properties] table.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list.</td>
<td></td>
</tr>
<tr>
<td>Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report.</td>
<td></td>
</tr>
<tr>
<td>For more information on aggregation options, see <strong>Aggregation in reporting</strong>.</td>
<td></td>
</tr>
<tr>
<td>If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>.</td>
<td></td>
</tr>
<tr>
<td>For information about aggregating on FX currency values, see <strong>FX Currency values in reporting</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Percentage calculation</strong></td>
<td>Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when <strong>Aggregation</strong> is set to <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>.</td>
</tr>
<tr>
<td>• <strong>Use Aggregation</strong> calculates the percentage using the selection in the <strong>Aggregation</strong> field. Only data that is displayed in the report is used to calculate the percentage.</td>
<td></td>
</tr>
<tr>
<td>For example, a report shows assets by department with the <strong>Aggregation</strong> set to <strong>Sum</strong> and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Use Record Count</strong> calculates the percentage using the total number of records in the data set.</td>
<td></td>
</tr>
<tr>
<td>For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the low-priority section is 40%.</td>
<td></td>
</tr>
<tr>
<td><strong>Set Value Formatting</strong></td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See <strong>Value formatting in reports</strong>.</td>
</tr>
</tbody>
</table>

**7. Optional:** Configure the sort order of the applicable fields in the report (column, row, **Group by**, **Stack by** or **Trend by** depending on the report type). Click the filter icon (🔍) and select **Add Sort**.
a. In the Sorting Order list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click + to configure additional sorting order conditions. (Click - to delete configured sorting order conditions.)

c. Click Save.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

8. Optional: To limit the information displayed in the report, click the filter icon (谤) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click Save.
What to do next

- Click the Report info icon (ℹ️) and add a description of the report.
- Click the sharing icon (分享) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Area and spline report style options
Change the look of your area or spline report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

Area and spline report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Chart color</td>
<td>Colors used in the report. If you do not group or stack the report, Use one color is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options: • Use color palette: Select a color palette from the predefined system color palettes. • Use several colors: Define a custom set of Colors using hex codes. You can add any number of colors. • Use chart colors: Use the colors defined in Reports &gt; Chart Colors. Note: It is not possible to use transparency hex values.</td>
</tr>
<tr>
<td>Set color</td>
<td>Color used in the report. This field displays when you select Use one color from the Chart color list. Click the search icon (🔍) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Colors</td>
<td>Colors used in the report. This field displays when you select Use several colors from the Chart color list. Click the search icon (🔍) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
</tbody>
</table>
## Area and spline report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the <strong>Chart color</strong> list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Do not plot nil as zero</td>
<td>Check box to specify whether to replace missing data points with values of zero. This field is available when creating or editing time series reports (area, spline, line, and step line reports only) that include multiple datasets, and when creating or editing datasets within the applicable time series reports. This field is not available when data in the report is grouped, or is aggregated by Count or Count Distinct. If selected, the report may show gaps where no data exists.</td>
</tr>
<tr>
<td>Show marker</td>
<td>Check box to show a symbol at each data point.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See <strong>Access control rules</strong>.</td>
</tr>
</tbody>
</table>

For more information, see **Define a report drilldown**.
### Area and spline report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
</tbody>
</table>

#### Title

<table>
<thead>
<tr>
<th>Show chart title</th>
<th>When the chart title is shown for the report.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Never</strong></td>
<td>Never show the chart title.</td>
</tr>
<tr>
<td><strong>Report only</strong></td>
<td>Shows the chart title on reports.</td>
</tr>
<tr>
<td><strong>Always</strong></td>
<td>Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
</tbody>
</table>
### Area and spline report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
<tr>
<td>Show legend</td>
<td>Legends are truncated by default. To adjust truncation lengths, configure the properties <strong>glide.chart.label.legend.truncate_to</strong> and <strong>glide.chart.label.legend.truncate_to.large</strong>. For more information, see Reporting properties.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
## Area and spline report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show legend border</strong></td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td><strong>Left align legend text</strong></td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Y axis and X axis</strong></td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>Title for the axis.</td>
</tr>
<tr>
<td><strong>Title size</strong></td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td><strong>Title bold</strong></td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td><strong>Opposite</strong></td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td><strong>Display grid</strong></td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td><strong>Grid dotted</strong></td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td><strong>From</strong></td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
</tbody>
</table>
Area and spline report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>- Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td></td>
<td>- If you format duration fields additionally using Set Value Formatting from the Configure tab:</td>
</tr>
<tr>
<td></td>
<td>- Values entered in the From/To fields (Style &gt; Y axis) are in seconds. The visualization displays y-axis labels as the selected Minimum/Maximum duration unit (Configure &gt; Set Value Formatting), and returns data that falls within the From/To (seconds) values.</td>
</tr>
<tr>
<td></td>
<td>- Example: If you set the minimum and maximum duration unit to Minute, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td>Note:</td>
<td>- Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td></td>
<td>- If you format duration fields additionally using Set Value Formatting from the Configure tab:</td>
</tr>
<tr>
<td></td>
<td>- Values entered in the From/To fields (Style &gt; Y axis) are in seconds. The visualization displays y-axis labels as the selected Minimum/Maximum duration unit (Configure &gt; Set Value Formatting), and returns data that falls within the From/To (seconds) values.</td>
</tr>
<tr>
<td></td>
<td>- Example: If you set the minimum and maximum duration unit to Minute, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the X axis tab, specify the size of the labels for the rows of the report. On the Y axis tab, specify the size of the labels for the columns in the report.</td>
</tr>
</tbody>
</table>
Area and spline report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

Bar and horizontal bar reports

Vertical and horizontal bar reports compare individual or aggregate scores across data dimensions. Vertical bar report columns originate on the x-axis, and horizontal bar report columns originate on the y-axis.

Bar reports display data in either a horizontal or vertical bar format with each bar representing a specific category of data. A bar report can use a single color to represent all categories of data, or a different color for each category.

The following figure shows an example of a bar report that displays discrete categories of data. The report includes data from the Incident [incident] table for all incidents recorded up until the time that the report is generated.
You can configure the bar report to stack data or change the measurement units of the bars. Stacked bar reports show the parts that contribute to the total. The following figure shows a bar report with the number of incidents that are assigned to each user. It is also stacked to display how many of the incidents are from each incident category.

Stacked bar report

Create a bar report

Bar reports enable you to show information in segments that are proportional to the values they represent.

Before you begin

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td>Note:</td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.

5. On the Type tab, enter Bar or Horizontal bar in the filter, select the report type, and click Next.

The application shows a preliminary version of the report. To view the updated report at any time, click Run.
6. On the **Configure** tab, fill in the following fields and click **Next**.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group by       | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see *How to report on extended tables*. Click the info icon (i) for a description of the selected field. Configured function fields appear in this list after you save the report. **Note:**  
  • It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.  
  • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
| Additional group by | Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see *How to report on extended tables*. Click the info icon (i) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. **Note:**  
  • It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.  
  • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
| Stack by       | Divide each bar using the values in this field. To stack by fields on extended tables, see *How to report on extended tables*. Click the info icon (i) for descriptions of the selected fields. |
On a bar chart of incidents sorted by Category and stacked by Priority, a user sees the proportion of high, medium, and low-priority issues for each category.

Select stacked fields carefully to avoid cluttering the report. Sometimes it is a better practice to create another report that shows these relationships rather than stack too much data. Bar charts display a legend only when a stacked field is selected. Boolean, reference, and choice lists can be used as stacked fields. Date, date/time, integer, long, string, and text fields cannot be used as stacked fields.

**Note:** Date types are not allowed starting with the introduction of the Report Charting v2 plugin.

You can choose to display the stacked field either in a single bar or as a group of bars.

If you select a Group by field on the report form, you can choose to visualize the bars as Grouped bars. In this case, bars are displayed next to one another according to the Group by field (for example, the state of the incident), instead of stacked.

If you choose fields with Additional group by, these fields are also available in a Stacked by control at the bottom of the report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data table</td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields.</td>
<td>Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected.</td>
</tr>
<tr>
<td></td>
<td>To show only unique records, select <strong>Count Distinct</strong>.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Average, Sum, or Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report.</td>
</tr>
<tr>
<td></td>
<td>For more information on aggregation options, see <strong>Aggregation in reporting</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you choose <strong>Average, Sum, Count Distinct, Minimum, or Maximum</strong>, you may be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>.</td>
</tr>
<tr>
<td></td>
<td>For information about aggregating on FX currency values, see <strong>FX Currency values in reporting</strong>.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when <strong>Aggregation</strong> is set to <strong>Average, Sum, or Count Distinct</strong>.</td>
</tr>
<tr>
<td>calculation</td>
<td>• <strong>Use Aggregation</strong> calculates the percentage using the selection in the <strong>Aggregation</strong> field. Only data that is displayed in the report is used to calculate the percentage.</td>
</tr>
<tr>
<td></td>
<td>For example, a report shows assets by department with the <strong>Aggregation</strong> set to <strong>Sum</strong> and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Record Count</td>
<td>calculates the percentage using the total number of records in the data set. For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the low-priority section is 40%.</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See Value formatting in reports.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group Other. If you select Show all, all groups up to a limit of 50 are displayed. The rest of the results are grouped as Other.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in Max number of groups.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (_launch_button) and select Add Sort.

a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order. The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click **to configure additional sorting order conditions.** (Click **to delete configured sorting order conditions.)**

c. Click **Save**. For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.
8. **Optional:** To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. To learn how to construct conditions, see **Condition builder.**

   **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

   **What to do next**

   - Click the Report info icon (📝) and add a description of the report.
   - Click the sharing icon ((['/])) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Bar report style options**

Change the look of your bar report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the
following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Bar report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td><strong>Chart color</strong></td>
<td>Colors used in the report. If you do not group or stack the report, <strong>Use one color</strong> is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options: • <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes. • <strong>Use several colors</strong>: Define a custom set of <strong>Colors</strong> using hex codes. You can add any number of colors. • <strong>Use chart colors</strong>: Use the colors defined in <strong>Reports &gt; Chart Colors</strong>.</td>
</tr>
<tr>
<td>Set color</td>
<td>Color used in the report. This field displays when you select <strong>Use one color</strong> from the <strong>Chart color</strong> list. Click the search icon (🔍) to choose from the <strong>Chart color schemes</strong> or <strong>Color Definitions</strong> list.</td>
</tr>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the <strong>Chart color</strong> list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Select to display the current value for each bar. This field is available when you select None from the <strong>Stacked by</strong> list or if there is no <strong>Stacked by</strong> list. • Select <strong>Data labels in the middle</strong> to show the labels in the middle of each bar. • Select <strong>Allow data labels to overlap</strong> to override default separation of labels in the visualization.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels. <strong>Note</strong>: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See Access control rules.</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
</tbody>
</table>
### Bar report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td></td>
</tr>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>• <strong>Never</strong>: Never show the chart title.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
<td></td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
</tbody>
</table>
# Bar report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the Custom chart title position option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
</tbody>
</table>
### Bar report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
<tr>
<td>Note:</td>
<td>Depending on configured <a href="https://www.highcharts.com">Highcharts</a> settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td></td>
<td>If you format duration fields additionally using <strong>Set Value Formatting</strong> from the Configure tab:</td>
</tr>
<tr>
<td></td>
<td>◦ Values entered in the <strong>From/To</strong> fields (<strong>Style &gt; Y axis</strong>) are in seconds. The visualization displays y-axis labels as the selected <strong>Minimum/Maximum duration unit</strong> (<strong>Configure &gt; Set Value Formatting</strong>), and returns data that falls within the From/To (seconds) values.</td>
</tr>
<tr>
<td></td>
<td>◦ Example: If you set the minimum and maximum duration unit to <strong>Minute</strong>, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
<tr>
<td>Note:</td>
<td>Depending on configured <a href="https://www.highcharts.com">Highcharts</a> settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td></td>
<td>If you format duration fields additionally using <strong>Set Value Formatting</strong> from the Configure tab:</td>
</tr>
<tr>
<td></td>
<td>◦ Values entered in the <strong>From/To</strong> fields (<strong>Style &gt; Y axis</strong>) are in seconds. The visualization displays y-axis labels as the selected <strong>Minimum/Maximum duration unit</strong> (<strong>Configure &gt; Set Value Formatting</strong>), and returns data that falls within the From/To (seconds) values.</td>
</tr>
<tr>
<td></td>
<td>◦ Example: If you set the minimum and maximum duration unit to <strong>Minute</strong>, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.</td>
</tr>
</tbody>
</table>
Bar report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| X axis / Y axis label size | On the **X axis** tab, specify the size of the labels for the rows of the report.  
On the **Y axis** tab, specify the size of the labels for the columns in the report. |
| Label bold    | Check this box to show the labels of the report in a bold typeface.           |

Box reports

Box reports, also called box plots, visualize the distribution of data including the maximum, minimum, quartiles, median, and mean.

Use box charts to report multiple data sets from different sources that are related to each other.

For example, use a box chart to view the age range of all customers who attended a convention. The box chart helps you determine where most ages are grouped. With this information, you can attempt to increase attendance levels at future events by targeting advertisements at the age groups that had lower attendance levels.

**Box chart**

[Box chart image]

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
A box chart displays the following information for each group of data:

1. Sample maximum
2. Upper quartile
3. Median
4. Mean
5. Lower quartile
6. Sample minimum

Note: When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see Enabling accessibility features.

Create a box report
Create a box report to show the distribution of values in a data set.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

About this task
Box reports enable you to show data organised by statistical averages.
Procedure

1. Navigate to **Reports > Create New**.

2. On the **Data** tab, give the report a name that reflects the information being grouped.

3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see <a href="#">Report sources</a>.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (_attach) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <a href="#">MetricBase</a>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
5. On the **Type** tab, enter **Box** in the filter, select the report type, and click **Next**.

The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Group by**           | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see **How to report on extended tables**. Click the info icon (i) for a description of the selected field. Configured function fields appear in this list after you save the report. **Note:**
|                        | • It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
|                        | • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.  
|                        | **Note:** Label names longer than 20 characters may show or print a truncated view.                                                            |
| **Additional group by**| Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see **How to report on extended tables**. Click the info icon (i) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. **Note:**
|                        | • It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
<p>|                        | • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Measured by</td>
<td>Field to use as a measurement for the data. Date and time fields are not supported for box charts. Click the info icon (i) for a description of the selected field.</td>
</tr>
</tbody>
</table>

7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort.**

   **a.** In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order. The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

   **b.** Click ✍️ to configure additional sorting order conditions. (Click ⌅ to delete configured sorting order conditions.)

   **c.** Click **Save.** For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.
8. **Optional:** To limit the information displayed in the report, click the filter icon (鹞) and select conditions to filter the report data. To learn how to construct conditions, see [Condition builder](#).

**Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

   **What to do next**

   - Click the Report info icon (])). and add a description of the report.
   - Click the sharing icon (↑) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Box report style options**

Configure the look of your box report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the
following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td><strong>Note:</strong> This field is available when <strong>Custom chart size</strong> is selected.</td>
<td></td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td><strong>Note:</strong> This field appears when <strong>Custom chart size</strong> is selected.</td>
<td></td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
<tr>
<td><strong>Note:</strong> Percentage labels do not change accordingly with the decimal precision specified.</td>
<td></td>
</tr>
</tbody>
</table>
### Report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>Show chart title</td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the Custom chart title position option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
</tbody>
</table>
Report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
</tbody>
</table>

**Note:**
- Depending on configured **Highcharts** settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.
- If you format duration fields additionally using **Set Value Formatting** from the Configure tab:
  - Values entered in the **From/To** fields (**Style > Y axis**) are in seconds. The visualization displays y-axis labels as the selected **Minimum/Maximum duration unit** (**Configure > Set Value Formatting**), and returns data that falls within the From/To (seconds) values.
  - Example: If you set the minimum and maximum duration unit to **Minute**, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.

| To    | Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type **Number**, the **From** and **To** fields are not available. |

**Note:**
- Depending on configured **Highcharts** settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.
- If you format duration fields additionally using **Set Value Formatting** from the Configure tab:
  - Values entered in the **From/To** fields (**Style > Y axis**) are in seconds. The visualization displays y-axis labels as the selected **Minimum/Maximum duration unit** (**Configure > Set Value Formatting**), and returns data that falls within the From/To (seconds) values.
  - Example: If you set the minimum and maximum duration unit to **Minute**, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.
Report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| X axis / Y axis label size | On the **X axis** tab, specify the size of the labels for the rows of the report.  
                             | On the **Y axis** tab, specify the size of the labels for the columns in the report. |
| Label bold                | Check this box to show the labels of the report in a bold typeface.          |

**Bubble reports**

Bubble reports plot data points on X and Y axes and use a third aggregate dimension to define bubble size.

Bubble reports can use numeric values to define the X and Y axes, and an aggregate value to determine the size of each bubble.

**Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see [Enabling accessibility features](Enabling+accessibility+features).

For example, when using Demand Management you can create a bubble report on the Demand table to compare risk and reward for various demands. Each bubble represents one demand. The risk and financial return determine the position of each bubble, while the total financial benefit for the demand determines the bubble size. You can quickly identify demands with low risk and high reward using the large bubbles in the top left of the report.
Create a bubble report

Create a bubble report to display multiple separate metrics on a single chart.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

About this task
Bubble reports aggregate information over three different metrics, using the X axis, Y axis, and bubble size.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.

5. On the Type tab, enter Bubble in the filter, select the report type, and click Next.

   The application shows a preliminary version of the report. To view the updated report at any time, click Run.

6. On the Configure tab, fill in the following fields and click Next.
## Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Field to group data by. Each value is represented by a unique bubble color on the chart. Click the info icon (ℹ️) for a description of the selected field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.</td>
</tr>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see <a href="#">How to report on extended tables</a>. Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report.</td>
</tr>
</tbody>
</table>
|                        | **Note:**  
<p>|                        | • It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.                                                                                       |
|                        | • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.                                                                                             |
| Row                    | Numeric field to use as the Y axis. Click the info icon (ℹ️) for a description of the selected field.                                                                                                       |
| Column                 | Numeric field to use as the X axis. Click the info icon (ℹ️) for a description of the selected field.                                                                                                      |
| Configure function field | Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see <a href="#">Report on function fields</a>. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see <strong>Aggregation in reporting</strong>. If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>. For information about aggregating on FX currency values, see <strong>FX Currency values in reporting</strong>.</td>
</tr>
</tbody>
</table>

7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

   a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

      The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

   b. Click 🔄 to configure additional sorting order conditions. (Click ❌ to delete configured sorting order conditions.)

   c. Click **Save**.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.
8. **Optional:** To limit the information displayed in the report, click the filter icon (▼) and select conditions to filter the report data. To learn how to construct conditions, see [Condition builder](#).

ℹ️ **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

What to do next

- Click the Report info icon (▼) and add a description of the report.

- Click the sharing icon (▲) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Bubble report style options**

Change the look of your bubble report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the
following tabs: **General, Title, Legend,** and **Axis.** To see how the report looks with the changed settings, click **Save.**

### Bubble report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small, Medium, and Large.</strong></td>
</tr>
<tr>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <a href="#">Configure the list layout</a>. If you specify a <strong>Report drilldown,</strong> <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See <a href="#">Access control rules</a>. For more information, see <a href="#">Define a report drilldown</a>.</td>
<td></td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
<tr>
<td><strong>Note:</strong> Percentage labels do not change accordingly with the decimal precision specified.</td>
<td></td>
</tr>
</tbody>
</table>
### Bubble report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td><strong>Show chart title</strong></td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td><strong>Chart title</strong></td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td><strong>Size of the chart title</strong></td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td><strong>Chart title color</strong></td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
</tbody>
</table>
### Bubble report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. Legends are truncated by default. To adjust truncation lengths, configure the properties <code>glide.chart.label.legend.truncate_to</code> and <code>glide.chart.label.legend.truncate_to.large</code>. For more information, see Reporting properties.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
Bubble report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left align legend</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
</tbody>
</table>

Calendar reports

Calendar reports display date-driven events on a calendar.

You can highlight calendar events by relevant criteria such as priority, status, or escalation. Events that have no end date have a duration of one hour.

Limitations

- You can limit the number of events that may be returned when you browse backwards in a calendar visualization. There is a limit of 30 days into the past, starting from the first day in the current Calendar view. Events that start more than 30 days before the first day visible on a calendar are not displayed. If you select Year, then the calendar includes events that start between December 1 of the previous year and December 31 of the current year.

The KB article Weekly calendar view does not display all entries covers scenarios in which some expected entries do not display.

To show more or fewer days, edit the glide.report.calendar.max_days_back property. See Reporting properties.

Note: Performance may degrade if this value is too large.
• This report type cannot be run as a scheduled report.

• Persistent highlighting of one selected criterion, for example, **Priority** can be set by an admin. See Set persistent highlighting for a calendar criterion.

### Create a calendar report

Create a calendar report to show and highlight date-driven events.

#### Before you begin

**Role required:** itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

#### Procedure

1. Navigate to **Reports > Create New.**
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name. For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a <strong>Trend by</strong> field option to aggregate its data. To learn more about remote</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (▲) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Calendar** in the filter, select the report type, and click **Next**.

The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Event to display</td>
<td>The date-driven event to display on the calendar. This list contains fields that are in the date/time format in the data source or source table. Click the info icon (ℹ️) for a description of the selected event.</td>
</tr>
</tbody>
</table>

7. Optional: To limit the information displayed in the report, click the filter icon (⏬) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.
Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

8. Click Save.

What to do next

Note: When there are more events on a date than fit in the calendar cell, a link is shown to view the additional events.

If there are more than thirty events, the cell shows + many. Click this link to show all the events in a list view for that date.

- Click the Report info icon ( ) and add a description of the report.
- Click the sharing icon ( ) to open the Sharing menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

Disable new calendar reports

To use the version of calendars from releases prior to Helsinki, disable the new calendar version. Reasons to use the old calendar include having scripts that are incompatible with the new calendar and preference for the style of the older calendar. The updated calendar is also not supported in Internet Explorer versions 7 and 8.

Before you begin
Role required: report_admin or admin

Procedure

1. Navigate to Reports > Administration > Properties.
2. Add the glide.report.new_calendar system property, and set it to false.
For help with adding this, see Reporting properties.

**Note:**

If this system property is set to true, it is supported only in the classic UI.
Click **Switch to classic UI** in the report designer.

**Column reports**

Column reports show how the value of one or more items changes over time with columns.

Values along the horizontal axis of the column chart represent the time measurement (years, hours, minutes, milliseconds, and so on). Values on the vertical axis represent the changes to the items being monitored. Users with the report_admin role can define the ranges that are used in a column chart report. See [Report ranges](#) for information on creating report ranges.

For example, you can create a column chart for incident counts, to show how the number of incidents changes over time. The incident count often increases during the first few months after a product upgrade is deployed. Over time, the number of reported incidents decreases as users become more accustomed to the changes in the product.

The figure shows resolved incidents stacked by category with a legend that indicates which category the colors represent.
A grouped column chart shows the categories as individual bars, rather than stacked colors in a single bar.
Create a column report

Create a column report to show how the value of one or more data elements changes over time using vertical columns.

Before you begin

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon ( vá) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Column** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.
Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group by               | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see [How to report on extended tables](#). Click the info icon (ℹ️) for a description of the selected field. Configured function fields appear in this list after you save the report. **Note:**  
  - It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
  - Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
| Additional group by    | Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see [How to report on extended tables](#). Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. **Note:**  
  - It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
  - Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
<p>| Stacked bars / Grouped bars | How to show the relationship of individual items from the selected field to the whole. You can choose to display the stacked field either in a single bar or as a group of bars. Select <strong>Stacked bars</strong> to display the parts that contribute to the whole for each column in the chart. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>Select <strong>Grouped bars</strong> to display the parts that contribute to the whole as individual columns. Bars are displayed next to one another according to the <strong>Group by</strong> field (for example, the state of the incident), instead of stacked.</td>
</tr>
<tr>
<td>Display data table</td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the <code>glide.ui.section508</code> system property is set to <strong>true</strong>. The <code>glide.ui.section508</code> property overrides the <strong>Display data table</strong> field.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see <strong>Report on function fields</strong>. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence. Click the info icon (i) for a description of the selected field. <strong>Note:</strong> If you selected a remote table in the <strong>Table</strong> field, the option you select in this field aggregates the data that was retrieved from an external source and aggregated in memory. To learn more about remote tables, see <strong>Retrieving external data using remote tables and scripts</strong>.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Calendar that is the basis for the time series in the report. Select either the standard calendar or a <strong>customized business calendar</strong>.</td>
</tr>
<tr>
<td>per</td>
<td>Time period to group data by. The range of available time periods depends on the calendar that you selected. Time periods range from an hour to a year. You can also specify a date.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Note: | If reporting per week: When the report range includes more than one calendar year, inconsistencies result when a week is split between two years. To show data values more accurately according to ISO weeks, add and enable the glide.db.aggregates.trend.use_iso_week property in the System Properties [sys_properties] table.

#### Aggregation
- Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.
- To show only unique records, select **Count Distinct**.
- Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list.
- Select **Minimum** or **Maximum** to show the maximum or minimum value for each segment of the report.
- For more information on aggregation options, see **Aggregation in reporting**.
- If you choose **Average**, **Sum**, **Count Distinct**, **Minimum**, or **Maximum**, you may be able to aggregate on fields from extended tables. See **How to report on extended tables**.
- For information about aggregating on FX currency values, see **FX Currency values in reporting**.

#### Percentage calculation
- Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when **Aggregation** is set to **Average**, **Sum**, or **Count Distinct**.
  - **Use Aggregation** calculates the percentage using the selection in the **Aggregation** field. Only data that is displayed in the report is used to calculate the percentage.
  - For example, a report shows assets by department with the **Aggregation** set to **Sum** and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Use Record Count</strong></td>
<td>calculates the percentage using the total number of records in the data set.</td>
</tr>
<tr>
<td></td>
<td>For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the low-priority section is 40%.</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See <a href="#">Value formatting in reports</a>.</td>
</tr>
</tbody>
</table>

7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

   a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

   b. Click ‹ to configure additional sorting order conditions. (Click ➡ to delete configured sorting order conditions.)

   c. **Click Save.**

   For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.
8. **Optional:** To limit the information displayed in the report, click the filter icon (▼) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

   **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

### What to do next

- Click the Report info icon (▼) and add a description of the report.

- Click the sharing icon (▼) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

### Column report style options

Change the look of your column report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the
following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

**Column report style options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>Colors used in the report.</td>
</tr>
<tr>
<td><strong>Chart color</strong></td>
<td>If you do not group or stack the report, <strong>Use one color</strong> is automatically selected. Select a single predefined system color.</td>
</tr>
<tr>
<td></td>
<td>If you group or stack the report, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use several colors</strong>: Define a custom set of Colors using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use chart colors</strong>: Use the colors defined in Reports &gt; Chart Colors.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: It is not possible to use transparency hex values.</td>
</tr>
<tr>
<td><strong>Set color</strong></td>
<td>Color used in the report. This field displays when you select <strong>Use one color</strong> from the Chart color list. Click the search icon (🔍) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td><strong>Set palette</strong></td>
<td>Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the Chart color list.</td>
</tr>
<tr>
<td><strong>Colors</strong></td>
<td>Colors used in the report. This field displays when you select <strong>Use several colors</strong> from the Chart color list. Click the search icon (🔍) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td><strong>Display data labels</strong></td>
<td>Select to display the current value for each bar. This field is available when you select None from the Stacked by list or if there is no Stacked by list.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Data labels in the middle</strong> to show the labels in the middle of each bar.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Allow data labels to overlap</strong> to override default separation of labels in the visualization.</td>
</tr>
<tr>
<td><strong>Custom chart size</strong></td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <a href="#">Configure the list layout</a>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See <a href="#">Access control rules</a>. For more information, see <a href="#">Define a report drilldown</a>.</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
</tbody>
</table>
### Column report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td></td>
</tr>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the Custom chart title position option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Legend</td>
<td></td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a Group by field is selected on the report form. Legends are truncated by default. To adjust truncation lengths, configure the properties glide.chart.label.legend.truncate_to and glide.chart.label.legend.truncate_to.large. For more information, see Reporting properties.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when Show legend is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when Show legend is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when Show legend is selected.</td>
</tr>
</tbody>
</table>
Column report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
</tbody>
</table>
### Column report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td></td>
<td>• If you format duration fields additionally using Set Value Formatting from the Configure tab:</td>
</tr>
<tr>
<td></td>
<td>◦ Values entered in the From/To fields <em>(Style &gt; Y axis)</em> are in seconds. The visualization displays y-axis labels as the selected Minimum/Maximum duration unit <em>(Configure &gt; Set Value Formatting)</em>, and returns data that falls within the From/To (seconds) values.</td>
</tr>
<tr>
<td></td>
<td>◦ Example: If you set the minimum and maximum duration unit to <strong>Minute</strong>, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the From and To fields are not available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td></td>
<td>• If you format duration fields additionally using Set Value Formatting from the Configure tab:</td>
</tr>
<tr>
<td></td>
<td>◦ Values entered in the From/To fields <em>(Style &gt; Y axis)</em> are in seconds. The visualization displays y-axis labels as the selected Minimum/Maximum duration unit <em>(Configure &gt; Set Value Formatting)</em>, and returns data that falls within the From/To (seconds) values.</td>
</tr>
<tr>
<td></td>
<td>◦ Example: If you set the minimum and maximum duration unit to <strong>Minute</strong>, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report.  On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
</tbody>
</table>
## Control reports

Control reports visualize data over time using standard deviations to show statistical likelihood and identify outliers.

Control reports display data as a series of connected points. The blue line at the center of the report is drawn at the mean. Upper and lower control limits, represented by red lines, indicate the thresholds at which activity is considered statistically unlikely. If the process is in control, all points are plotted within the control limits. You may want to investigate any activity outside these limits.

> **Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see Enabling accessibility features.
Note: The mean is calculated by taking a sum of the data points on the Data Points line and dividing by the number of points. These values depend on the aggregation (Count, Average, Sum, or Count Distinct). This mean can differ from averages in other reports based on the same data if the other reports use different aggregations. For example, the mean number of incidents (Count) per month over a period is different from the mean Average duration of those same incidents.

Create a control report
Create a control chart to determine whether a business process is in a state of statistical control.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td>Note: If you select a data source used by existing reports, a notification prompts you to view them.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggre-</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>gates, in memory, data retrieved from an external source. Then select a <strong>Trend by</strong> field option to aggregate its data. To learn more about remote tables, see <a href="#">Retrieving external data using remote tables and scripts</a>.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (-upload_icon-) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <a href="#">MetricBase</a>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Control** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see <a href="#">Report on function fields</a>. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence. Click the info icon (info_icon-) for a description of the selected field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you selected a remote table in the <strong>Table</strong> field, the option you select in this field aggregates the data that was retrieved from an external source and aggregated in memory. To learn more about remote tables, see <a href="#">Retrieving external data using remote tables and scripts</a>.</td>
</tr>
</tbody>
</table>
| per   | Time period to group data by. The range of available time periods depends on the calendar that you selected. Time periods range from an hour to a year. You can also specify a date.  

**Note:** If reporting per week: When the report range includes more than one calendar year, inconsistencies result when a week is split between two years. To show data values more accurately according to ISO weeks, add and enable the `glide.db.aggregates.trend.use_iso_week` property in the System Properties [sys_properties] table. |
| Aggregation | Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.  
To show only unique records, select **Count Distinct**.  
Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list.  
Select **Minimum** or **Maximum** to show the maximum or minimum value for each segment of the report.  
For more information on aggregation options, see [Aggregation in reporting](#).  
If you choose **Average**, **Sum**, **Count Distinct**, **Minimum**, or **Maximum**, you may be able to aggregate on fields from extended tables. See [How to report on extended tables](#).  
For information about aggregating on FX currency values, see [FX Currency values in reporting](#). |
| Set Value Formatting | Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See [Value formatting in reports](#). |
7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select Add Sort.

   a. In the Sorting Order list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report’s source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

   b. Click to configure additional sorting order conditions. (Click to delete configured sorting order conditions.)

   c. Click Save.

   For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

   To learn how to construct conditions, see Condition builder.

   Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.
9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click Save to generate the report.

What to do next

- Click the Report info icon ( ) and add a description of the report.
- Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Control report style options

Change the look of your control report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

Control chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td>Note: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td>This field is available when Custom chart size is selected.</td>
<td></td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td>This field appears when Custom chart size is selected.</td>
<td></td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
</tbody>
</table>
Control chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Drilldown view      | List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.  
  
  **Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message "Number of rows removed from this list by Security constraints:" followed by the number. See Access control rules.  
  
  For more information, see Define a report drilldown. |
| Decimal precision   | Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.  
  
  **Note:** Percentage labels do not change accordingly with the decimal precision specified. |
### Control chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>When the chart title is shown for the report.</td>
</tr>
</tbody>
</table>
| **Show chart title** | - **Never**: Never show the chart title.  
|                  | - **Report only**: Shows the chart title on reports.  
|                  | - **Always**: Shows the chart title on reports, dashboards, and homepages. |
| **Chart title**  | The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| **Size of the chart title** | Size of the chart title in pixels. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| **Chart title color** | Color of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
### Control chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Legend</td>
<td></td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. Legends are truncated by default. To adjust truncation lengths, configure the properties <code>glide.chart.label.legend.truncate_to</code> and <code>glide.chart.label.legend.truncate_to.large</code>. For more information, see Reporting properties.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
### Control chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>On the <strong>Y axis</strong> tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report. On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

### Dial and speedometer reports

Dials and speedometers provide a real-time count for an indicator. These charts cannot contain comparison or historical data. You can configure colors to display at a glance that values are within specified ranges.

For example, red indicates unacceptable value ranges. A low value for monthly sales is worse than a high value, but a low value for incident resolution times is better than a high value. So you would configure red for low values in the report.
for monthly sales and red for high values in the report for incident resolution times.

Dials and speedometers also have different appearances:

- A speedometer shows numbers in the form of a round meter with a defined range.
- A dial shows where a score falls across ranges on a half-circle dial.

Angular speedometer report
Create a dial or speedometer report

Create a dial or speedometer to provide a real-time count for an indicator, with colors to indicate value ranges.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
</tbody>
</table>
## Options and Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a <strong>Trend by</strong> field option to aggregate its data. To learn more about remote tables, see <a href="#">Retrieving external data using remote tables and scripts</a>.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (عون) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Speedometer** or **Dial** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.
### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. For example, if you select an integer field, such as <strong>Priority</strong>, the data is expressed as a decimal value number. If you choose <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, you may further be able to aggregate on fields from extended tables. See How to report on extended tables. Note: For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.</td>
</tr>
</tbody>
</table>

7. **Optional:** To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. To learn how to construct conditions, see **Condition builder**.

   Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

8. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

9. Click **Save**.
What to do next

- Click the Report info icon ( Educação) and add a description of the report.
- Click the sharing icon ( Edição ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Dial and speedometer report style options

Change the look of your dial or speedometer report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

### Dial chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Chart color (dial chart only)</td>
<td>A predefined system color for the dial.</td>
</tr>
<tr>
<td>Set color</td>
<td>Color used in the report. This field displays when you select Use one color from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
</tbody>
</table>
### Dial chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td><strong>Direction</strong></td>
<td>Choose whether lower or larger numbers are better. Select <strong>Minimize</strong> if lower numbers are better. Select <strong>Maximize</strong> if larger numbers are better. This setting works with <strong>Lower Limit</strong> and <strong>Upper Limit</strong>, which determine the colors for the areas in the dial or speedometer.</td>
</tr>
<tr>
<td><strong>Lower limit</strong></td>
<td>The lower threshold for color change on the dial or speedometer. If it uses only two colors, specify the same number for both lower and upper limits.</td>
</tr>
<tr>
<td><strong>Upper limit</strong></td>
<td>The upper threshold for color change on the dial or speedometer. If it uses only two colors, specify the same number for both lower and upper limits.</td>
</tr>
<tr>
<td><strong>Dial autoscale</strong></td>
<td>Check box to automatically generate start and end values for the dial or speedometer based on the selected data.</td>
</tr>
<tr>
<td><strong>From</strong></td>
<td>Custom minimum value to display on the left side of the dial or speedometer. This field is available when <strong>Dial Autoscale</strong> is cleared.</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td>Custom maximum value to display on the right side of the dial or speedometer. This field is available when <strong>Dial Autoscale</strong> is cleared.</td>
</tr>
<tr>
<td><strong>Drilldown view</strong></td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
</tbody>
</table>

For example, a dial contains a current score of 50 and **Dial Autoscale** is selected. The **Lower Limit** is set to 50 and **Upper Limit** is set to 100 and the direction is **Minimize**. The dial displays the area 0–50 in green, the area 50–100 in orange, and the area above 100 in red.

If **Lower Limit** is set to 50, **Upper Limit** is set to 100 and the direction is **Maximize**, the colors are reversed.

If no upper and lower limits have been set, no colors are used in the visualization. If you want to have only two section or colors, you can set the upper and lower limits to the same number.
Dial chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See Access control rules. For more information, see Define a report drilldown.</td>
<td></td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value. Note: Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
</tbody>
</table>
## Dial chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td></td>
</tr>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>• <strong>Never</strong>: Never show the chart title.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
<td></td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the Custom chart title position option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
</tbody>
</table>
Donut reports

Donut and semi-donut reports show the proportions that make up a whole.

Donut reports are similar to pie reports, but the donut report has empty space in the middle. The difference between a donut and a semi-donut is that a semi-donut is a donut sliced in half. The information presented is the same. Donut and semi-donut reports can be placed on homepages where users can quickly interpret the information displayed.

For example, use a donut or semi-donut reports to show open incidents by priority. At any time, there are open incidents of different priority levels. A donut or semi-donut report enables you to see quickly whether incident counts of different priorities are within acceptable ranges.
Create a donut report
Create a donut chart report to compare the size of parts to the whole.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name. For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a <strong>Trend by</strong> field option to aggregate its data. To learn more about remote tables, see <a href="#">Retrieving external data using remote tables and scripts</a>.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <a href="#">MetricBase</a>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Donut** in the filter, select **Donut** or **Semi-donut**, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.
### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group by         | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see [How to report on extended tables](#). Click the info icon (ℹ️) for a description of the selected field. Configured function fields appear in this list after you save the report.  

**Note:**  
- It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
- Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
| Additional group by | Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see [How to report on extended tables](#). Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report.  

**Note:**  
- It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
- Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
<p>| Display data table | Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to <strong>true</strong>. The glide.ui.section508 property overrides the <strong>Display data table</strong> field. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see Aggregation in reporting. If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See How to report on extended tables. For information about aggregating on FX currency values, see FX Currency values in reporting.</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See Value formatting in reports.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>. If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>
7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click to configure additional sorting order conditions. (Click to delete configured sorting order conditions.)

c. Click **Save**.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

8. **Optional:** To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. To learn how to construct conditions, see **Condition builder**.

   - **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.
9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

**What to do next**

- Click the Report info icon (📖) and add a description of the report.
- Click the sharing icon (➡️) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Donut chart style options**

Change the look of your donut or semi-donut chart.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Donut width</td>
<td>Percentage for the width of the donut or semi-donut band, ranging from 1 through 100 percent. 100 percent equals a pie chart. The default value is 50.</td>
</tr>
<tr>
<td>Show total and hide legend</td>
<td>Check box to display the total aggregation value in the center of the donut. Also automatically hides the chart legend.</td>
</tr>
<tr>
<td>Chart color</td>
<td>Color for the chart. Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use several colors</strong>: Define a custom set of <strong>Colors</strong> using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use chart colors</strong>: Use the colors defined in <strong>Reports &gt; Chart Colors</strong>.</td>
</tr>
</tbody>
</table>
## Donut chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the <strong>Chart color</strong> list.</td>
</tr>
<tr>
<td>Colors</td>
<td>Colors used in the report. This field displays when you select <strong>Use several colors</strong> from the <strong>Chart color</strong> list. Click the search icon (🔍) to choose from the <strong>Chart color schemes</strong> or <strong>Color Definitions</strong> list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See <strong>Access control rules</strong>.</td>
</tr>
</tbody>
</table>

For more information, see **Define a report drilldown**.
### Donut chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Decimal precision      | Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value. This option is available for Average aggregations.  
  
  ⚠️ **Note:** Percentage labels do not change accordingly with the decimal precision specified. |

<table>
<thead>
<tr>
<th>Title</th>
<th>When the chart title is shown for the report.</th>
</tr>
</thead>
</table>
| Show chart title       | - **Never:** Never show the chart title.  
  - **Report only:** Shows the chart title on reports.  
  - **Always:** Shows the chart title on reports, dashboards, and homepages.                                                                 |
## Donut chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the Custom chart title position option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
</tbody>
</table>

### Legend

- **Show legend**: Check box to show a chart legend. This check box appears when a Group by field is selected on the report form.

   Legends are truncated by default. To adjust truncation lengths, configure the properties glide.chart.label.legend.truncate_to and glide.chart.label.legend.truncate_to.large. For more information, see Reporting properties.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend horizontal</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>

**Funnel and pyramid reports**

Funnel and pyramid reports visualize the distribution of data. The size of the slices or sections represents a percentage of the total of all values.

Funnel reports are often used to represent stages in a sales process (from lead to closed deal), or to identify potential problem areas in a process. If you apply a neck in a funnel chart, all values below a certain percentage of the total value are represented as a bar. The bar indicates that their differences are of equal importance.

Funnel reports stack slices from top to bottom by decreasing percentage and pyramid charts stack slices by increasing percentage. Pyramid reports are often used to represent hierarchical levels in an organization. Funnel and pyramid reports can be placed on homepages where users can quickly interpret the information displayed.

For example, use a funnel or pyramid report to show open incidents by priority. At any time, there are open incidents of different priority levels. For example, an organization has a policy that P1 incidents can never exceed 40% of all open incidents. Funnel and pyramid charts show whether incident counts are within acceptable ranges.
Funnel report of incidents by priority

Pyramid report of incidents by priority
Create a funnel or pyramid report

Create a funnel report where the size of each slice represents a percentage of the total, showing distribution of data in a process.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources. Note: If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (Upload)</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>——</td>
<td>to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.

5. On the Type tab, enter Pyramid or Funnel in the filter, select the report type, and click Next.

The application shows a preliminary version of the report. To view the updated report at any time, click Run.

6. On the Configure tab, fill in the following fields and click Next.

**Funnel chart**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by Assignment group, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables. Click the info icon (ℹ️) for a description of the selected field. Configured function fields appear in this list after you save the report.</td>
</tr>
</tbody>
</table>

**Note:**
- It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.
- Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.

**Note:** Label names longer than 20 characters may show or print a truncated view.

<p>| Additional group by | Extra fields to group the report by. When you select Additional group by fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>as well, see How to report on extended tables. Click the info icon (i) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. Note: • It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT. • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.</td>
</tr>
<tr>
<td>Display data table</td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is Count, which shows the number of records selected. To show only unique records, select Count Distinct. Select Average, Sum, or Count Distinct, to show a list of fields from the selected Table. Select a field to Aggregate by from this list. Select Minimum or Maximum to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see Aggregation in reporting.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>If you choose <strong>Average, Sum, Count Distinct, Minimum, or Maximum</strong>, you may be able to aggregate on fields from extended tables. See How to report on extended tables. For information about aggregating on FX currency values, see FX Currency values in reporting.</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See Value formatting in reports.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>. If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>

7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type).

   Click the filter icon (🔎) and select **Add Sort**.

   **a.** In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.
   
   The list contains all possible fields from the report’s source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).
   
   **b.** Click 🔗 to configure additional sorting order conditions. (Click 🔗 to delete configured sorting order conditions.)

   **c.** Click **Save**.

   For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.
8. **Optional:** To limit the information displayed in the report, click the filter icon ($filter icon$) and select conditions to filter the report data. To learn how to construct conditions, see [Condition builder](#).

**Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

**What to do next**

- Click the Report info icon (report info icon) and add a description of the report.
- Click the sharing icon (-sharing icon-) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Funnel and pyramid report style options**

Change the look of your funnel or pyramid report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the
following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

**Funnel and pyramid chart style options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>[Funnel charts only] Enter a percentage for the width of the funnel, from 1–100 percent. 1 percent is the lowest value that can be represented above the funnel neck. Values lower than 1 percent are stacked below the neck in a bar of a set width. 100 percent equals a bar chart. The default value is 30.</td>
</tr>
<tr>
<td><strong>Chart color</strong></td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use several colors</strong>: Define a custom set of <strong>Colors</strong> using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use chart colors</strong>: Use the colors defined in <strong>Reports &gt; Chart Colors</strong>.</td>
</tr>
<tr>
<td><strong>Set palette</strong></td>
<td>Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the <strong>Chart color</strong> list.</td>
</tr>
<tr>
<td><strong>Colors</strong></td>
<td>Colors used in the report. This field displays when you select <strong>Use several colors</strong> from the <strong>Chart color</strong> list. Click the search icon (🔍) to choose from the <strong>Chart color schemes</strong> or <strong>Color Definitions</strong> list.</td>
</tr>
<tr>
<td><strong>Custom chart size</strong></td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td>☰ <strong>Note</strong>: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td><strong>Chart width</strong></td>
<td>Width of the report in pixels. The default value is 600.  This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td><strong>Chart height</strong></td>
<td>Height of the report in pixels. The default value is 450.  This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td><strong>Chart size</strong></td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td></td>
<td>☰ <strong>Note</strong>: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
</tbody>
</table>
### Funnel and pyramid chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Drilldown view      | List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.  

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message "Number of rows removed from this list by Security constraints:" followed by the number. See Access control rules.  

For more information, see Define a report drilldown. |
| Decimal precision   | Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.  

**Note:** Percentage labels do not change accordingly with the decimal precision specified. |
## Funnel and pyramid chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td></td>
</tr>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>• <strong>Never</strong>: Never show the chart title.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
<td></td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. Legends are truncated by default. To adjust truncation lengths, configure the properties <code>glide.chart.label.legend.truncate_to</code> and <code>glide.chart.label.legend.truncate_to.large</code>. For more information, see Reporting properties.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
Funnel and pyramid chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>

**Heatmap reports**

Heatmap reports display aggregate data visually using colors to represent different values on a matrix. Heatmap reports can have no more than 1000 cells.

⚠️ **Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see [Enabling accessibility features](#).

In the figure, the cell for confirmed low priority problems is filled to highlight the large value.

<table>
<thead>
<tr>
<th>Problems older than 30 Days by Priority and State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 – High</td>
</tr>
<tr>
<td>2 – Moderate</td>
</tr>
<tr>
<td>3 – Low</td>
</tr>
<tr>
<td>5 – Planning</td>
</tr>
</tbody>
</table>

**Create a heatmap report**

Create a heatmap report to show aggregate data visually using colors to represent different values on a matrix.
Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

About this task

Note: A smaller-sized heatmap chart doesn’t display non-zero values which would otherwise overlap an adjacent value. Row labels for these values also do not show. You can hover over a blank value cell to see its value, or enlarge the chart size to accommodate values. Understanding how this particular chart type behaves can help you interpret results and determine the appropriate sizing for your data.

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources. Note: If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name. For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (_attach) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Heatmap** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. Fill in the fields, as appropriate (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Row** | Field used as the source of the data for the rows in the heatmap. To select a source field on an extended table, see [How to report on extended tables](#). Click the info icon (️) for a description of the selected field.  

  ⚠️ **Note:** Label names longer than 20 characters may show or print a truncated view. |
| **Column** | Field used as the source of the data for the columns in the heatmap. To select a source field on an extended table, see [How to report on extended tables](#). Click the info icon (️) for a description of the selected field.  

  ⚠️ **Note:** Label names longer than 20 characters may show or print a truncated view. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see Aggregation in reporting. If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See How to report on extended tables. For information about aggregating on FX currency values, see FX Currency values in reporting.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>. If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>

**7. Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.
a. In the Sorting Order list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

The list contains all possible fields from the report’s source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click + to configure additional sorting order conditions. (Click - to delete configured sorting order conditions.)

c. Click Save.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

8. Optional: To limit the information displayed in the report, click the filter icon ($filter$) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click Save.
What to do next

- Click the Report info icon (/embed) and add a description of the report.
- Click the sharing icon (share) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

### Heatmap report style options

Change the look of your heatmap chart.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

#### Heatmap chart style options

<table>
<thead>
<tr>
<th><strong>General</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use heatmap colors</td>
<td>Check box to use different colors to indicate different values.</td>
</tr>
<tr>
<td>Color for high scores</td>
<td>Color used to indicate a high value on the chart.</td>
</tr>
<tr>
<td>Color for low scores</td>
<td>Color used to indicate a low value on the chart.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Display Zero</td>
<td>Select this check box to display the number 0 when the value of a cell is 0. Clear this check box to display an empty cell when the value of the cell is 0.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
</tbody>
</table>
## Heatmap chart style options (continued)

<table>
<thead>
<tr>
<th><strong>General</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>This field is available when <strong>Custom chart size</strong> is selected.</td>
<td></td>
</tr>
</tbody>
</table>

| **Chart height** | Height of the report in pixels. The default value is 450. This field appears when **Custom chart size** is selected. |
| **Chart size** | Chart size. This field is available when **Custom chart size** is cleared. Options are **Small**, **Medium**, and **Large**. |

> **Note:** The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.

| **Drilldown view** | List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See **Configure the list layout**. If you specify a **Report drilldown**, **Drilldown view** is ignored. |

> **Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message "Number of rows removed from this list by Security constraints:" followed by the number. See **Access control rules**.

For more information, see **Define a report drilldown**.

| **Decimal precision** | Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value. |

> **Note:** Percentage labels do not change accordingly with the decimal precision specified. |
Heatmap chart style options (continued)

### General

<table>
<thead>
<tr>
<th>Average Reassignment count</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>1.5</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>0.5</td>
</tr>
<tr>
<td>0</td>
</tr>
</tbody>
</table>

**Chart title**

The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list.

**Title**

<table>
<thead>
<tr>
<th>Show chart title</th>
<th>When the chart title is shown for the report.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Never</strong></td>
<td>Never show the chart title.</td>
</tr>
<tr>
<td><strong>Report only</strong></td>
<td>Shows the chart title on reports.</td>
</tr>
<tr>
<td><strong>Always</strong></td>
<td>Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chart title</th>
<th>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Size of the chart title</th>
<th>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Chart title color</th>
<th>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</th>
</tr>
</thead>
</table>
# Heatmap chart style options (continued)

## General

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
</tbody>
</table>

## Legend

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. Legends are truncated by default. To adjust truncation lengths, configure the properties <code>glide.chart.label.legend.truncate_to</code> and <code>glide.chart.label.legend.truncate_to.large</code>. For more information, see Reporting properties.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
Heatmap chart style options (continued)

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Left align legend text</strong></td>
</tr>
</tbody>
</table>

**Histogram reports**

Histograms group numbers in a data set into ranges. The data used in a histogram is continuous data. Continuous data is measured whereas discrete data, which is used in bar charts, is counted.

For example, a histogram can show the pattern of P1 incidents logged over a four-week period after a product release. For the first week after the product was released, P1 incidents are low because users do not really understand the product enough to use it. In the second week, more users start working with the product and P1 issues increased. In the third week, P1 issues increase even more as more users began working with the product. In the fourth week, P1 issues stay the same as the third week. The information suggests that it is not necessary to increase support staff until the third week after a product is released.

**Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see Enabling accessibility features.

**Create a histogram report**

Histograms group numbers in a continuous data set into ranges.

**Before you begin**

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

**Procedure**

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see <a href="#">Report sources</a>.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/15" alt="Note" /> Note:</td>
<td>If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see <a href="#">Retrieving external data using remote tables and scripts</a>.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (_LOOK) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <a href="#">MetricBase</a>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Histogram** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.
Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Measured by</td>
<td>Select a field to report against. The values from this field appear on the X axis of the histogram and determine the width of the bars. Click the info icon (i) for a description of the selected field.</td>
</tr>
</tbody>
</table>

7. **Optional:** To limit the information displayed in the report, click the filter icon ((filters) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

   **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

8. Click **Save**.

What to do next

- Click the Report info icon (i) and add a description of the report.
- Click the sharing icon (share) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Line reports**

Line reports plot individual data points to show how the value of one or more items changes over time.

The value of an item at specific dates or times is displayed as data points connected by horizontal lines. Values along the horizontal axis of the line chart represent the time measurement (years, hours, minutes, milliseconds, and so on).
Values on the vertical axis represent the changes to the items being monitored. Users with the report_admin role can define the ranges that are used in a line chart report.

For example, you can create a line report for incident counts, to show how the number of incidents changes over time. The incident count often increases during the first few months after a product upgrade is deployed. Over time, the number of reported incidents decreases as users become more accustomed to the changes in the product. This figure shows the number of incidents per caller over time.

Create a line report

Create a line report to show the trend in the value changes of one or more items over time.

Before you begin

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
Procedure

1. Navigate to Reports > Create New.

2. On the Data tab, give the report a name that reflects the information being grouped.

3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the **Type** tab, enter **Line** in the filter, select the Line report type in the **Time Series** section, and click **Next**.

The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group by            | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see [How to report on extended tables](#). Click the info icon (ℹ️) for a description of the selected field. Configured function fields appear in this list after you save the report. **Note:**  
  - It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
  - Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
| Additional group by | Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see [How to report on extended tables](#). Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. **Note:**  
  - It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
  - Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data table</td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence. Click the info icon (i) for a description of the selected field.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Calendar that is the basis for the time series in the report. Select either the standard calendar or a customized business calendar.</td>
</tr>
<tr>
<td>per</td>
<td>Time period to group data by. The range of available time periods depends on the calendar that you selected. Time periods range from an hour to a year. You can also specify a date.</td>
</tr>
</tbody>
</table>

**Note:** If you selected a remote table in the Table field, the option you select in this field aggregates the data that was retrieved from an external source and aggregated in memory. To learn more about remote tables, see Retrieving external data using remote tables and scripts.

**Note:** If reporting per week: When the report range includes more than one calendar year, inconsistencies result when a week is split between two years. To show data values more accurately according to ISO weeks, add and enable the glide.db.aggregates.trend.use_iso_week property in the System Properties [sys_properties] table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see <strong>Aggregation in reporting</strong>. If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>. For information about aggregating on FX currency values, see <strong>FX Currency values in reporting</strong>.</td>
</tr>
<tr>
<td>Percentage calculation</td>
<td>Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when <strong>Aggregation</strong> is set to <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>.</td>
</tr>
</tbody>
</table>

- **Use Aggregation** calculates the percentage using the selection in the **Aggregation** field. Only data that is displayed in the report is used to calculate the percentage. For example, a report shows assets by department with the **Aggregation** set to **Sum** and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.

- **Use Record Count** calculates the percentage using the total number of records in the data set. For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the low-priority section is 40%.

| Set Value Formatting | Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See **Value formatting in reports**.                                                                 |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔎) and select **Add Sort**.

a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order. The list contains all possible fields from the report’s source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click 🔄 to configure additional sorting order conditions. (Click 🖐️ to delete configured sorting order conditions.)

c. Click **Save**.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

8. **Optional:** To limit the information displayed in the report, click the filter icon (🔎) and select conditions to filter the report data. To learn how to construct conditions, see **Condition builder**.

ℹ️ **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.
9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

**What to do next**

- Click the Report info icon (ℹ️) and add a description of the report.
- Click the sharing icon (🔗) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Line report style options**

Configure the look of your line report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Line chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Chart color</td>
<td>Colors used in the report. If you do not group or stack the report, <strong>Use one color</strong> is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use several colors</strong>: Define a custom set of <strong>Colors</strong> using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use chart colors</strong>: Use the colors defined in <strong>Reports &gt; Chart Colors</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: It is not possible to use transparency hex values.</td>
</tr>
<tr>
<td>Set color</td>
<td>Color used in the report. This field displays when you select <strong>Use one color</strong> from the <strong>Chart color</strong> list. Click the search icon (🔍) to choose from the <strong>Chart color schemes</strong> or <strong>Color Definitions</strong> list.</td>
</tr>
</tbody>
</table>
### Line chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the <strong>Chart color</strong> list.</td>
</tr>
<tr>
<td>Colors</td>
<td>Colors used in the report. This field displays when you select <strong>Use several colors</strong> from the <strong>Chart color</strong> list. Click the search icon (🔍) to choose from the <strong>Chart color schemes</strong> or <strong>Color Definitions</strong> list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Do not plot nil as zero</td>
<td>Check box to specify whether to replace missing data points with values of zero. This field is available when creating or editing time series reports (area, spline, line, and step line reports only) that include multiple datasets, and when creating or editing datasets within the applicable time series reports. This field is not available when data in the report is grouped, or is aggregated by Count or Count Distinct. If selected, the report may show gaps where no data exists.</td>
</tr>
<tr>
<td>Show marker</td>
<td>Check box to display a symbol at each data point.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
</tbody>
</table>
### Line chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See <a href="#">Access control rules</a>. For more information, see <a href="#">Define a report drilldown</a>.</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value. <strong>Note:</strong> Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
</tbody>
</table>
Line chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>Show chart title</td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the Custom chart title position option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Legend</td>
<td>Check box to show a chart legend. This check box appears when a Group by field is selected on the report form.</td>
</tr>
</tbody>
</table>
### Line chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Legends are truncated by default. To adjust truncation lengths, configure the properties glide.chart.label.legend.truncate_to and glide.chart.label.legend.truncate_to.large. For more information, see Reporting properties.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Legend horizontal alignment</strong></td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td><strong>Legend vertical alignment</strong></td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td><strong>Show legend border</strong></td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td><strong>Left align legend text</strong></td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>

### Axis

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Y axis and X axis</strong></td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>Title for the axis.</td>
</tr>
<tr>
<td><strong>Title size</strong></td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td><strong>Title bold</strong></td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td><strong>Opposite</strong></td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td><strong>Display grid</strong></td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td><strong>Grid dotted</strong></td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
</tbody>
</table>
### Line chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report. On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

### List reports

List reports display data in the form of an expandable list. You can configure whether lists appear expanded or collapsed. Lists are often used for enumerations such as the number of incidents or changes. They contain columns that show more detailed information, such as a short description, category, or state.

**Notes:**

- List reports display in List v2, even if List v3 is enabled.
- As of the Kingston release, the record count and pagination buttons appear only at the bottom of the list.

This example list report displays incidents sorted by caller.
Create list reports

List reports show data in the form of an expandable list.

Types of list reports

There are three types of list reports.

Basic list reports

List reports with no additional features

List reports with variable columns

List reports based on a data source or table that has variables associated with it, for example, Service Catalog data sources. Variables are often variations in products such as amounts of storage in a computer.

List reports with question columns
List reports based on a data source or table that has questions associated with it. For example, if a form prompts a user to select the specific nature of a problem, you can create a list report with columns for their responses.

Differences between the types of list reports

Basic list reports can use a table, a data source, an imported Excel spreadsheet, or a MetricBase table for their report sources. List reports with variable and question columns use only tables and data sources.

There are extra steps to configure the question and variable columns.

Create a basic list report

List reports display data in the form of an expandable list. For example, an incident report grouped by priority displays only the priority names and a number of records that display if the user clicks the priority. You can configure whether lists display expanded or collapsed.

Before you begin

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
</tbody>
</table>

Note: If you select a data source used by existing reports, a notification prompts you to view them.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name. For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (🖼️) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **List** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose columns</td>
<td>Fields to display as columns in the list report. In the Columns window that opens after you click <strong>Choose columns</strong>, select fields in the Available list that you want to appear in your report and move them to the Selected list. Click the info icon (ℹ️) for descriptions of the selected fields.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field Description</td>
<td>Depending on system configuration, you can add fields from tables that extend the selected table. For more information, see <em>Report on extended tables</em>.</td>
</tr>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <em>How to report on extended tables</em>. Click the info icon (i) for a description of the selected field. Configured function fields appear in this list after you save the report.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>• It is not possible to group or stack reports by the <strong>Tags</strong> field, or by certain field types, such as MEDIUMTEXT.</td>
</tr>
<tr>
<td></td>
<td>• Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.</td>
</tr>
<tr>
<td>Additional</td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see <em>How to report on extended tables</em>. Click the info icon (i) for descriptions of the selected fields. Configured function fields appear in this list after you save the report.</td>
</tr>
<tr>
<td>group by</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>• It is not possible to group or stack reports by the <strong>Tags</strong> field, or by certain field types, such as MEDIUMTEXT.</td>
</tr>
<tr>
<td></td>
<td>• Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.</td>
</tr>
<tr>
<td>Configure</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see <em>Report on function fields</em>. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields.</td>
</tr>
<tr>
<td>function field</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
</tbody>
</table>

7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click ☞ to configure additional sorting order conditions. (Click ⇠ to delete configured sorting order conditions.)

c. Click **Save**.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

8. **Optional:** To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. To learn how to construct conditions, see **Condition builder**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.


10. Click Save.

What to do next

- Click the Report info icon (ℹ️) and add a description of the report.

- Click the sharing icon (편지함) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules. For more information, see Share a report.

Note:
- The default number of rows in a list report exported to PDF is 1000. To configure this value, enter `sys_properties.list` in the Filter Navigator, and edit the property `glide.pdf.max_rows`. For more information, see: Add a system property.
- Despite list filtering, pdf-format exported rows will count all record rows sequentially up to the export limit and show as blank for roles prevented by ACLs from viewing restricted data.

- Configure and use list functions

Create a list report with variable columns

You can create a list report with variables columns based on a data source or table that has variables associated with it. For example, if an item has a variable called Storage, you can create a list report that has a column for the values in this variable.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has variables associated with it. There are two kinds of report sources:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>

For list reports with variables, the report source is usually the service catalog table.
4. Click Next.
5. On the Type tab, enter List in the filter, select the report type, and click Next.
   The application shows a preliminary version of the report. To view the updated report at any time, click Run.
6. On the Configure tab, click Choose columns and select Variables [+] in the Columns window that opens.
   Variables [+] is at the bottom of the list of available columns.
   Depending on system configuration, you can add fields from tables that extend the selected table. For more information, see Report on extended tables.
7. Click the structure icon (>>) to choose an item.
8. Select an item from the Catalog item list that appears. The variables associated with the selected item then appear in the **Columns** window.
9. Select and move variables to the **Selected** column and click **OK**.

10. On the **Configure** tab, fill in the following fields and click **Next**.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <strong>How to report on extended tables</strong>. Click the info icon (ℹ️) for a description of the selected field. Configured function fields appear in this list after you save the report.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>• It is not possible to group or stack reports by the <strong>Tags</strong> field, or by certain field types, such as MEDIUMTEXT.</td>
</tr>
<tr>
<td></td>
<td>• Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.</td>
</tr>
<tr>
<td><strong>Additional group by</strong></td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see <a href="#">How to report on extended tables</a>. Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report.</td>
</tr>
<tr>
<td><strong>Configure function field</strong></td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see <a href="#">Report on function fields</a>. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
</tbody>
</table>

11. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

   a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report’s source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).
b. Click + to configure additional sorting order conditions. (Click – to delete configured sorting order conditions.)

c. Click Save.
For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

![Add Sort](image)

12. Optional: To limit the information displayed in the report, click the filter icon (▼) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.


14. Click Save.

What to do next

• Click the Report info icon (✓) and add a description of the report.

• Click the sharing icon (➡️) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to
the web, and set visibility and schedules. For more information, see Share a report.

**Note:**
- The default number of rows in a list report exported to PDF is 1000. To configure this value, enter `sys_properties.list` in the Filter Navigator, and edit the property `glide.pdf.max_rows`. For more information, see: Add a system property.
- Despite list filtering, pdf-format exported rows will count all record rows sequentially up to the export limit and show as blank for roles prevented by ACLs from viewing restricted data.

**Create a list report with question columns**

You can create a list report with question columns based on a data source or table that has questions associated with it. For example, if a form prompts a user to select the specific nature of a problem, you can create a list report that lists columns for those values.

**Before you begin**

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

**Procedure**

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has questions associated with it. There are two kinds of report sources:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the Type tab, enter List in the filter, select the report type, and click Next.
The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, click **Choose columns** and select **Questions [+]** in the **Columns** window that opens.

**Questions [+]** is at the bottom of the list of available columns.

Depending on system configuration, you can add fields from tables that extend the selected table. For more information, see **Report on extended tables**.

7. Click the structure icon (¶) to choose an item.

8. Select an item from the Catalog item list that appears. The variables associated with the selected item then appear in the **Columns** window.
9. Select and move questions to the **Selected** column and click **OK**.

10. On the **Configure** tab, fill in the following fields and click **Next**.

### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <strong>How to report on extended tables</strong>. Click the info icon (i) for a description of the selected field. Configured function fields appear in this list after you save the report.</td>
</tr>
</tbody>
</table>

**Note:**

- It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.
- Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.
### Field Description

| Additional group by | Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see [How to report on extended tables](#). Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report.  

#### Note:
- It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.  
- Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.  

| Configure function field | Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see [Report on function fields](#). Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the **Group by** and **Additional group by** lists after you save the report. |

#### 11. Optional:  
Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (meye) and select **Add Sort**.  

- **a.** In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.  
  
  The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).  

- **b.** Click ➕ to configure additional sorting order conditions. (Click ➖ to delete configured sorting order conditions.)  

- **c.** Click **Save**.  
  For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is
often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

12. **Optional:** To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. To learn how to construct conditions, see [Condition builder](#).

⚠️ **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

13. **Optional:** On the **Style** tab, add and configure a report title. See [List report style options](#).

14. Click **Save**.

**What to do next**

- Click the Report info icon (📝) and add a description of the report.

- Click the sharing icon (➡️) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules. For more information, see [Share a report](#).

⚠️ **Note:** The default number of rows in a list report exported to PDF is 1000. To configure this value, enter `sys_properties.list` in the Filter Navigator, and edit the property `glide.pdf.max_rows`. For more information, see: [Add a system property](#).
List report style options

Add a title to your list report configure the title's size, color, and alignment.

When you create or edit a list report, you can add a title that replaces the report name you provide on the Data tab. Users you share the report with see the new title instead of the name of the report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>alignment</td>
<td></td>
</tr>
</tbody>
</table>

Group records in list reports

Grouped list reports can display only the records in each group that are configured to appear in a normal list. You can group rows of information in list reports by specific fields. You cannot group list reports by service catalog variables.

A list configured to display 100 records at a time can show only the first 100 records, regardless of the number of records in that group. Paging is not available within groups, and you cannot access the remaining records without leaving the grouped list. To access all the records in a group:
• Increase the display size of the list.
• Click the group header to return to a normal list for that group with paging enabled.

List reports do not support the user preference to automatically expand grouped records.

The sections of the report are collapsed by default. In this example, a list of products is grouped by manufacturer and the items associated with Gateway are expanded.

### Grouped list report

<table>
<thead>
<tr>
<th></th>
<th>Name</th>
<th>Manufacturer</th>
<th>Asset tag</th>
<th>Operating System</th>
<th>CPU speed (MHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1GAP-3-GATEWAY</td>
<td>Gateway</td>
<td>P1000038</td>
<td>Windows XP Professional</td>
<td>2,992</td>
</tr>
<tr>
<td>2</td>
<td>8400-953105</td>
<td>Gateway</td>
<td>P1000024</td>
<td>Windows XP Professional</td>
<td>3,391</td>
</tr>
<tr>
<td>3</td>
<td>DAIKIN</td>
<td>Gateway</td>
<td>P1000051</td>
<td>Windows XP Professional</td>
<td>3,132</td>
</tr>
<tr>
<td>4</td>
<td>DR Series</td>
<td>Gateway</td>
<td>P1000241</td>
<td>Windows XP Professional</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>JENREALTY</td>
<td>Gateway</td>
<td>P1000221</td>
<td>Windows XP Professional</td>
<td>3,332</td>
</tr>
<tr>
<td>6</td>
<td>KIRIKI</td>
<td>Gateway</td>
<td>P1000111</td>
<td>Windows XP Professional</td>
<td>2,394</td>
</tr>
<tr>
<td>7</td>
<td>MEGANS</td>
<td>Gateway</td>
<td>P1000222</td>
<td>Windows XP Professional</td>
<td>2,793</td>
</tr>
<tr>
<td>8</td>
<td>OLIVAS</td>
<td>Gateway</td>
<td>P1000163</td>
<td>Windows XP Professional</td>
<td>3,049</td>
</tr>
<tr>
<td>9</td>
<td>Product KSKS</td>
<td>Gateway</td>
<td>P1000096</td>
<td>Windows XP</td>
<td></td>
</tr>
</tbody>
</table>

### Export a list report to Excel

You can export a list report to Excel from the list columns, or by scheduling its export.

**Procedure**

• To export a list report as an Excel spreadsheet, right-click any column heading and select **Export > Excel**.

• To schedule export of a saved list report as an Excel spreadsheet, click **Schedule** and specify **Type** as Excel Spreadsheet. Excel displays report duration values in milliseconds, rather than the "<x> days <y> hours" format.
Applying list report column configurations with an update set

Configured columns in list reports can be moved to another instance by committing an update set.

Configured list report columns are not automatically applied to an instance when you commit an update set. List reports render using UI views created each time you save a report. To ensure configured columns render in a list report or on a dashboard widget in another instance:

1. From the UI View table, search for the sys_id of the report (RPT) view record for your changes.
2. Add it to the update set.

For information on adding customized configurations to an update set and applying them, see System update sets.

Map reports

Map reports display data on a map. You can display data as a geographical heatmap ( 🌍 ) or view specific data points ( ⬤ ).

Zoom in on a map to get a more detailed view. In heatmap mode, click any region on the map that contains data to drill down into its map.

Important: Save the map report to drill down into it. You cannot drill down into unsaved reports.

The lowest level of a map hierarchy can display only data points. Click data on this lowest level to see the data in list view, or in drill-down view if one has been configured.

Limitations

- Maps are not supported on Internet Explorer versions 7 and 8.
- Map reports cannot be saved as images on Internet Explorer versions 7 to 9, Firefox versions 31 to 37, Safari 5, or all versions of the Edge browser. For best results, use Chrome to work with map reports.
• Map reports cannot be exported as PDFs, but can be saved as images.
• This report type cannot be run as a scheduled report.

Create a map report
Create a map report to plot your data on geographical heatmap or with pin locations for specific data points.

Before you begin
Role required: itil, report_user

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>Option</td>
<td>provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name. For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon () to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the Type tab, enter Map in the filter, select the report type, and click Next.
   The application shows a preliminary version of the report. To view the updated report at any time, click Run.
6. On the Configure tab, fill in the following fields and click Next.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data table</td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to <strong>true</strong>. The glide.ui.section508 property overrides the <strong>Display data table</strong> field.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report.</td>
</tr>
</tbody>
</table>
For more information on aggregation options, see **Aggregation in reporting**.

If you choose **Average, Sum, Count Distinct, Minimum, or Maximum**, you may be able to aggregate on fields from extended tables. See **How to report on extended tables**.

For information about aggregating on FX currency values, see **FX Currency values in reporting**.

### Map this data

The data that you want to plot on the map. Only data that a report administrator has prepared as a map source is available.

### Set map

The starting map for the report. You can zoom in but cannot zoom out from this map.

7. **Optional:** To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. To learn how to construct conditions, see **Condition builder**.

   **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

8. On the **Style** tab, configure the appearance of the report. Fill in the fields as appropriate.

### Map report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Use heatmap colors</strong></td>
<td>Check box to use different colors to indicate different values on the map. If you clear this check box, all geographical locations with data are displayed in the same color.</td>
</tr>
<tr>
<td><strong>Color for high scores</strong></td>
<td>Color to indicate high values.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Color for low scores</td>
<td>Color to indicate low values.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Display geographical labels</td>
<td>Check box to display the names of geographical objects on the map, such as countries, regions, and states.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td>Note: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared.</td>
</tr>
<tr>
<td></td>
<td>Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td></td>
<td>Note: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
<tr>
<td></td>
<td>Note: All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See Access control rules. For more information, see Define a report drilldown.</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Note: Percentage labels do not change accordingly with the decimal precision specified.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
</tr>
<tr>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chart title</th>
</tr>
</thead>
<tbody>
<tr>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Size of the chart title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>--------------------------------------</td>
</tr>
<tr>
<td>Chart title color</td>
</tr>
<tr>
<td>Custom chart title position</td>
</tr>
<tr>
<td>Chart title X position</td>
</tr>
<tr>
<td>Chart title Y position</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
</tr>
<tr>
<td>Title vertical alignment</td>
</tr>
<tr>
<td>Legend tab fields (available only when colors are used on the report)</td>
</tr>
<tr>
<td>Show legend</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
</tr>
<tr>
<td>Show legend border</td>
</tr>
<tr>
<td>Left align legend text</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

9. **Optional:** To limit the information displayed in the report, click the filter icon (⬇️) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

⚠️ **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

10. Click **Save**.

**What to do next**

- Click the Report info icon (🔍) and add a description of the report.
- Click the sharing icon (➡️) to open the **Sharing** menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

**Multilevel pivot tables**

Multilevel pivot tables display aggregate data broken down by multiple dimensions in a single table. They display separate cells for each row and column value combination, as well as a column subtotal for each first-level row. Aggregate information is presented in the top left of the chart.

You can also create multilevel pivot tables with columns and rows containing variables. See Use service catalog variables in a report.

You can expand and collapse the rows in the table to show the chart details, or only the subtotals. The top row of a multilevel pivot report is always visible.

⚠️ **Note:**

- Some row configurations prevent the chart from displaying subtotal information, such as when a string column has the same text value but with different character cases.
- You can only schedule this report type as a PDF.
## Multilevel pivot with subtotals and expanded rows

### Multilevel Pivot Report Example

<table>
<thead>
<tr>
<th>Last name</th>
<th>Name</th>
<th>Active</th>
<th>false</th>
<th>true</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>State</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Closed</td>
<td>New</td>
<td>In Progress</td>
<td>On Hold</td>
</tr>
<tr>
<td>(empty)</td>
<td>Total</td>
<td>5</td>
<td>1</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(empty)</td>
<td>5</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>▼ Anglin</td>
<td>Total</td>
<td>1</td>
<td>5</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Sales</td>
<td>1</td>
<td>5</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>▼ Goodlife</td>
<td>Total</td>
<td>4</td>
<td>4</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Development</td>
<td>4</td>
<td>4</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>▼ Johnson</td>
<td>Total</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Sales</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>▼ Loo</td>
<td>Total</td>
<td>6</td>
<td>1</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Development</td>
<td>6</td>
<td>1</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>▶ Luddy</td>
<td>Total</td>
<td>2</td>
<td>1</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>▶ Richman</td>
<td>Total</td>
<td>1</td>
<td>1</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>▶ User</td>
<td>Total</td>
<td>3</td>
<td></td>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>▶ Whitherspoon</td>
<td>Total</td>
<td>1</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>▶ Wilson</td>
<td>Total</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td></td>
<td>20</td>
<td>5</td>
<td>20</td>
<td>6</td>
</tr>
</tbody>
</table>

### Create a multilevel pivot report

Create a multilevel pivot report to display aggregate data broken down by multiple metrics in a single table.

### Before you begin

**Role required:** itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
Procedure

1. Navigate to Reports > Create New.

2. On the Data tab, give the report a name that reflects the information being grouped.

3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td></td>
<td>Note: If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (Upload) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the **Type** tab, enter **Multi-level pivot table** in the filter, select the report type, and click **Next**.

The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select columns</strong></td>
<td>One or more fields to use as chart columns. The chart displays data broken down by a combination of row and column values. You can select up to three columns. Click the info icon (i) for descriptions of the selected fields.</td>
</tr>
<tr>
<td><strong>Select rows</strong></td>
<td>One or more fields to use as chart rows. The chart displays data broken down by a combination of row and column values. You can select up to five rows. Click the info icon (i) for descriptions of the selected fields.</td>
</tr>
<tr>
<td><strong>Configure function field</strong></td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the <strong>Group by</strong> and <strong>Additional group by</strong> lists after you save the report.</td>
</tr>
<tr>
<td><strong>Aggregation</strong></td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For more information on aggregation options, see Aggregation in reporting.</td>
</tr>
<tr>
<td></td>
<td>If you choose <strong>Average, Sum, Count Distinct, Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See How to report on extended tables.</td>
</tr>
<tr>
<td></td>
<td>For information about aggregating on FX currency values, see FX Currency values in reporting.</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See Value formatting in reports.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the <strong>Other</strong> group in the report. The <strong>Other</strong> group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Currency fields default to two decimal places. With the **Set Value Formatting** option, you can configure decimal precision for 0-4 decimal places.

**7. Optional:** Select **Default expanded** to display the report with the rows expanded. Otherwise, the report will display with all rows collapsed.
8. **Optional:** Check **Display row lines** and **Display column lines** to show the lines that separate the cells in the report.

![Multilevel pivot report with collapsed and expanded rows](image)

9. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

   a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report’s source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).
b. Click to configure additional sorting order conditions. (Click to delete configured sorting order conditions.)

c. Click Save.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

10. Optional: To limit the information displayed in the report, click the filter icon (◀) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

11. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

12. Click Save.
What to do next

- Click the Report info icon (ℹ️) and add a description of the report.
- Click the sharing icon (Sharing) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.
- Search the Community site for more insight or help with multi-level pivot reports.

Create a multilevel pivot report with variable columns and rows

You can create a multilevel pivot report with variables columns and rows based on a data source or table that has variables associated with it. Variables are descriptions of catalog items. For example, if a service catalog item has a variable called Storage, you can create a report that has a column or row for the values in this variable, such as 128 GB, 500 GB, and 1 TB.

Before you begin

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a ta-</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts.</td>
</tr>
<tr>
<td></td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.

5. On the Type tab, enter Multi-level pivot table in the filter, select the report type, and click Next.

The application shows a preliminary version of the report. To view the updated report at any time, click Run.

6. On the Configure tab, click Select columns.

From the Available list in the Multilevel Pivot Columns window, select columns that you want to use in the report and move them to the Selected list.

Note: It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.

Depending on system configuration, you can add fields from tables that extend the table selected as the report data source. For more information, see Report on extended tables.

7. Select variables to use as columns:
a. Select one or more fields to use as report columns. The report visualization displays data broken down by a combination of row and column values. You can select up to three columns including the variables.

b. Select Variables [+] and click the structure icon (⋯) to choose an item.

c. Select a Catalog item from the pop-up window. The variables associated with the item appear in the Columns window.
d. Move the selected variables to the **Selected** column and click **OK**. Click the info icon (ℹ️) for descriptions of the selected fields.

8. Click **Select rows** to select one or more fields to use as report rows. You select rows similarly to how you select columns. Click the info icon (ℹ️) for descriptions of the selected fields.

The report visualization displays data broken down by a combination of row and column values. You can select up to five rows including the variables.

*i* **Note:** It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as **MEDIUMTEXT**.

9. On the **Configure** tab, fill in the following fields and click **Next**.

---

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td>and grouping. You have to save the report before you can configure function fields. Confirmed function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td><strong>Aggregation</strong></td>
<td>Mathematical calculation to perform on the data. The default is Count, which shows the number of records selected. To show only unique records, select Count Distinct. Select Average, Sum, or Count Distinct, to show a list of fields from the selected Table. Select a field to Aggregate by from this list. Select Minimum or Maximum to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see Aggregation in reporting. If you choose Average, Sum, Count Distinct, Minimum, or Maximum, you may be able to aggregate on fields from extended tables. See How to report on extended tables. For information about aggregating on FX currency values, see FX Currency values in reporting.</td>
</tr>
<tr>
<td><strong>Set Value Formatting</strong></td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See Value formatting in reports.</td>
</tr>
<tr>
<td><strong>Max number of groups</strong></td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group Other. If you select Show all, all groups up to a limit of 50 are displayed. The rest of the results are grouped as Other.</td>
</tr>
<tr>
<td><strong>Show Other</strong></td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in Max number of groups.</td>
</tr>
</tbody>
</table>

**Note:** Currency fields default to two decimal places. With the Set Value Formatting option, you can configure decimal precision for 0-4 decimal places.
10. **Optional:** Check **Display row lines** and **Display column lines** to show the lines that separate the cells in the report.

**Open incidents by Priority/State/Category**

<table>
<thead>
<tr>
<th>State</th>
<th>Category</th>
<th>1 - Critical</th>
<th>2 - High</th>
<th>3 - Moderate</th>
<th>4 - Low</th>
<th>5 - Planning</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>In Progress</td>
<td>Total</td>
<td>11</td>
<td>4</td>
<td>3</td>
<td>0</td>
<td>2</td>
<td>20</td>
</tr>
<tr>
<td>On Hold</td>
<td>Total</td>
<td>4</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>Count</td>
<td></td>
<td>15</td>
<td>4</td>
<td>6</td>
<td>1</td>
<td>5</td>
<td>31</td>
</tr>
</tbody>
</table>

11. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔎) and select **Add Sort**.

**a.** In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

**b.** Click ✈️ to configure additional sorting order conditions. (Click 👎 to delete configured sorting order conditions.)

**c.** Click **Save**.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.
12. **Optional:** To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. To learn how to construct conditions, see **Condition builder.**

**Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

13. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

14. Click **Save.**

**What to do next**

- Click the Report info icon (ⓘ) and add a description of the report.
- Click the sharing icon (🏞) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.
- Search the **Community** site for more insight or help with multi-level pivot reports.

**Multilevel pivot report style options**

Change the look of your multi-level pivot chart.
When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

**Multilevel pivot report style options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Display Zero</td>
<td>Check this box to display the number 0 when the value of a cell is 0. Clear this check box to display an empty cell when the value of the cell is 0. Applicable when Aggregation is Count or Count Distinct.</td>
</tr>
<tr>
<td>Default expanded</td>
<td>Check this box to expand all rows when the report is displayed. Clear this check box to collapse all rows when the report is displayed. See Multilevel pivot report with collapsed and expanded rows</td>
</tr>
<tr>
<td>Display row lines</td>
<td>Check this box to display lines between rows in the report.</td>
</tr>
<tr>
<td>Display column lines</td>
<td>Check this box to display lines between columns in the report.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules.

For more information, see Define a report drilldown.

| Edit coloring rules    | Click this hyperlink to configure how cells and cell text with numerical values are colored in the report. You can create rules to define which colors are used based on operators and values. For example, you can specify that any value greater than 5 displays in red. See Create coloring rules for multilevel pivot reports. |
### Multilevel pivot report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>It is not possible to apply coloring rules to the Total cells in multilevel pivot reports.</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
<tr>
<td>Title</td>
<td><strong>Show chart title</strong></td>
</tr>
<tr>
<td></td>
<td>When the chart title is shown for the report.</td>
</tr>
</tbody>
</table>
### Multilevel pivot report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Never</td>
<td>Never show the chart title.</td>
</tr>
<tr>
<td>• Report only</td>
<td>Shows the chart title on reports.</td>
</tr>
<tr>
<td>• Always</td>
<td>Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
</tbody>
</table>

- **Chart title**
  - The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list.

- **Size of the chart title**
  - Size of the chart title in pixels. This field appears when **Report only** or **Always** is selected from the **Show chart title** list.

- **Chart title color**
  - Color of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list.

- **Title horizontal alignment**
  - How the chart title is aligned horizontally. This field is available when the **Custom chart title position** option is cleared.

- **Title vertical alignment**
  - How the chart title is aligned vertically. This field appears when **Custom chart title position** is cleared.

---

**Multilevel pivot report with collapsed and expanded rows**

Open incidents by Priority/State/Category

---

![Chart](chart.png)
**Pareto reports**

Pareto charts help you identify the most important dimension in a large set of dimensions. Columns show data in descending order. A line shows cumulative percentage.

Pareto charts contain both bar and line graphs. The bars display the data in descending order from left to right, and the line graph shows the cumulative totals from each category in the same order. The left Y axis is the record count, and the right Y axis is the cumulative percentage of the total number of records evaluated. The blue line at the 80% mark helps determine which data is the most influential in the process. The data to the left of the intersection of the line graph and the 80% mark have the greatest effect on the overall outcome.

The figure below shows that five callers account for 80% of the incident calls, while seven account for the other 20%.

**Pareto report example**

Create a Pareto report to identify the most important factors in a large set of factors. Columns show data in descending order while a curve shows cumulative percentage.
Procedure

1. Navigate to **Reports > Create New**.

2. On the **Data** tab, give the report a name that reflects the information being grouped.

3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (的操作) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click **Next**.
5. On the **Type** tab, enter **Pareto** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
   | Group by               | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see **How to report on extended tables**. Click the info icon (ℹ️) for a description of the selected field. Configured function fields appear in this list after you save the report. **Note:**
   |                         | • It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.                                                                                         |
   |                         | • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.                                                                                         |
   | Additional group by    | Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see **How to report on extended tables**. Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. **Note:**
<p>|                         | • It is not possible to group or stack reports by the <strong>Tags</strong> field, or by certain field types, such as MEDIUMTEXT.                                                                                         |
|                         | • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.                                                                                         |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data table</td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group Other. If you select Show all, all groups up to a limit of 50 are displayed. The rest of the results are grouped as Other.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in Max number of groups.</td>
</tr>
</tbody>
</table>

7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔧) and select **Add Sort**.

   a. In the Sorting Order list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

      The list contains all possible fields from the report’s source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

   b. Click ⬆️ to configure additional sorting order conditions. (Click ⬇️ to delete configured sorting order conditions.)

   c. Click **Save**.

   For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is
determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

8. **Optional:** To limit the information displayed in the report, click the filter icon (.hadoop) and select conditions to filter the report data. To learn how to construct conditions, see [Condition builder](#).

   **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

**What to do next**

- Click the Report info icon (fb) and add a description of the report.
- Click the sharing icon (up) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Pareto report style options**

Change the look of your Pareto report.
When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

**Note:** The cumulative totals percentage line is not configurable. It cannot be disabled and the color cannot be changed.

### Pareto chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Chart color** | Colors used in the report. If you do not group or stack the report, **Use one color** is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:  
  • **Use color palette**: Select a color palette from the predefined system color palettes.  
  • **Use several colors**: Define a custom set of **Colors** using hex codes. You can add any number of colors.  
  • **Use chart colors**: Use the colors defined in **Reports > Chart Colors**.  
  **Note:** It is not possible to use transparency hex values. |
| **Set color**    | Color used in the report. This field displays when you select **Use one color** from the **Chart color** list. Click the search icon (🔍) to choose from the **Chart color schemes** or **Color Definitions** list. |
| **Set palette** | Color palette used in the report. This field appears when you select **Use color palette** from the **Chart color** list. |
| **Display data labels** | Select to display the current value for each bar. This field is available when you select None from the **Stacked by** list or if there is no **Stacked by** list.  
  • Select **Data labels in the middle** to show the labels in the middle of each bar.  
  • Select **Allow data labels to overlap** to override default separation of labels in the visualization. |
| **Custom chart size** | Check box to specify the width and height of the report in pixels. |
### Pareto chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See Access control rules.</td>
</tr>
<tr>
<td>Title</td>
<td>Show chart title</td>
</tr>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>• Never</td>
<td>Never show the chart title.</td>
</tr>
<tr>
<td>• Report only</td>
<td>Shows the chart title on reports.</td>
</tr>
<tr>
<td>• Always</td>
<td>Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
</tbody>
</table>
## Pareto chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the Custom chart title position option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this</td>
</tr>
</tbody>
</table>
Pareto chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>check box</td>
<td>check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the X axis tab, specify the size of the labels for the rows of the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

Pie charts

Pie charts show the proportions that make up a whole.

You can use a pie chart to show things like open incidents by priority. For example, suppose that an organization has a policy that critical incidents can never exceed 40% of all open incidents. Given that there are always open incidents of various priority levels, you can quickly see with a pie chart when incident counts exceed acceptable ranges. This figure shows that 14.61% of the open incidents are critical.
Create a pie chart
Create a pie chart to compare the size of individual categories to the whole.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name. For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a <strong>Trend by</strong> field option to aggregate its data. To learn more about remote tables, see <strong>Retrieving external data using remote tables and scripts</strong></td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (👍) to import a new file. See <strong>Create a report from an imported Microsoft Excel document</strong>.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <strong>MetricBase</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.
5. On the **Type** tab, enter **Pie** in the filter, select the report type, and click **Next**.
   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.
6. On the **Configure** tab, fill in the following fields and click **Next**.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>placed in separate groups.</td>
<td>To group by fields on extended tables, see How to report on extended tables. Click the info icon (i) for a description of the selected field. Configured function fields appear in this list after you save the report.</td>
</tr>
</tbody>
</table>
| Note:                      | • It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.  
• Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
| Additional group by         | Extra fields to group the report by. When you select Additional group by fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see How to report on extended tables. Click the info icon (i) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. |
| Note:                      | • It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.  
• Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
<p>| Display data table         | Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field. |
| Configure function field   | Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see <strong>Aggregation in reporting</strong>. If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>. For information about aggregating on FX currency values, see <strong>FX Currency values in reporting</strong>.</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See <strong>Value formatting in reports</strong>.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>. If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>

7. **Optional**: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.
a. In the Sorting Order list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order. The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click + to configure additional sorting order conditions. (Click - to delete configured sorting order conditions.)

c. Click Save.
For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

8. Optional: To limit the information displayed in the report, click the filter icon (ə) and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click Save.
What to do next

• Click the Report info icon (ℹ️) and add a description of the report.

• Click the sharing icon (↗️) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Pie chart style options

Change the look of your pie chart.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

Chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Chart color</td>
<td>Colors used in the report. If you do not group or stack the report, <strong>Use one color</strong> is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use several colors</strong>: Define a custom set of Colors using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use chart colors</strong>: Use the colors defined in Reports &gt; Chart Colors.</td>
</tr>
<tr>
<td>Note:</td>
<td>It is not possible to use transparency hex values.</td>
</tr>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the Chart color list.</td>
</tr>
<tr>
<td>Colors</td>
<td>Colors used in the report. This field displays when you select <strong>Use several colors</strong> from the Chart color list. Click the search icon (🔍) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
</tbody>
</table>
## Chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data labels</td>
<td>Check box to display the value for each slice.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See Access control rules.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Define a report drilldown.</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value. This option is available for Average aggregations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>Show chart title</td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Legend</td>
<td></td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. Legends are truncated by default. To adjust truncation lengths, configure the properties <code>glide.chart.label.legend.truncate_to</code> and <code>glide.chart.label.legend.truncate_to.large</code>. For more information, see Reporting properties.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
**Chart style options (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>

**Pivot tables**

Pivot tables aggregate data from a table into columns and rows, which you define. They help you quickly investigate the source of the summarized data. Non-empty cells display tooltips to indicate how many records the cell represents. Click a non-empty cell to display a breakdown of those records.

You can configure a filter to further refine the data and select the aggregation values.

**Note:** Pivot tables are no longer supported. If you have a problem with a pivot table report, open the report and change the type to **Multilevel pivot table**. The multilevel pivot table report is more stable and has more features than the pivot table.

**Pivot table**

**Incident Breakdown**

<table>
<thead>
<tr>
<th>Assigned to</th>
<th>Request</th>
<th>Inquiry / Help</th>
<th>Software</th>
<th>Hardware</th>
<th>Network</th>
<th>Database</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>(empty)</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Beth Anglin</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Bow Ruggerl</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Bud Richman</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Charlie Whitherspoon</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>David Loo</td>
<td>0</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>0</td>
<td>1</td>
<td>9</td>
</tr>
<tr>
<td>Don Goodliffe</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>7</td>
</tr>
<tr>
<td>Fred Luddy</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Howard Johnson</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>ITIL User</td>
<td>0</td>
<td>8</td>
<td>5</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>15</td>
</tr>
<tr>
<td>Luke Wilson</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Total</td>
<td>1</td>
<td>20</td>
<td>16</td>
<td>8</td>
<td>3</td>
<td>2</td>
<td>50</td>
</tr>
</tbody>
</table>
Create a pivot table

Create a pivot table to aggregate data from a table into columns and rows. Tooltips indicate what the values represent.

About this task

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td>Note: If you select a data source used by existing reports, a notification prompts you to view them.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon ( ) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
</tbody>
</table>

Table: Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click Next.

5. On the Type tab, enter Pivot in the filter, select the Pivot report type from the Other section, and click Next.

The application shows a preliminary version of the report. To view the updated report at any time, click Run.

6. On the Configure tab, fill in the following fields and click Next.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row</td>
<td>Select one field for the chart rows. The chart displays data broken down by a combination of row and column values. To select a source field on extended table, see How to report on extended tables. Click the info icon (i) for a description of the selected field.</td>
</tr>
<tr>
<td>Column</td>
<td>Select one field for the chart columns. The chart displays data broken down by a combination of row and column values. To select a source field on an extended table, see How to report on extended tables. Click the info icon (i) for a description of the selected field.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is Count, which shows the number of records selected. To show only unique records, select Count Distinct.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report.</td>
</tr>
<tr>
<td></td>
<td>For more information on aggregation options, see <strong>Aggregation in reporting</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>.</td>
</tr>
<tr>
<td></td>
<td>For information about aggregating on FX currency values, see <strong>FX Currency values in reporting</strong>.</td>
</tr>
<tr>
<td>Max number</td>
<td><strong>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>.</strong></td>
</tr>
<tr>
<td>of groups</td>
<td>If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td><strong>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</strong></td>
</tr>
</tbody>
</table>

7. **Optional**: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (👇) and select **Add Sort**.

a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report’s source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click 🔄 to configure additional sorting order conditions. (Click 👈 to delete configured sorting order conditions.)

c. Click **Save**.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is
often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

![Add Sort](image)

8. **Optional:** To limit the information displayed in the report, click the filter icon (▼) and select conditions to filter the report data. To learn how to construct conditions, see [Condition builder](#).

   ![](image)

   **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

**What to do next**

- Click the Report info icon (▼) and add a description of the report.

- Click the sharing icon (▼) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

- Search the Community site for more insight or help with pivot reports.
Note: While the Import Export property glide.pdf.max_rows applies to row limits for pdf data exports in the platform product, for pivot reports exported to pdf from the Reporting product, it sets the maximum number of total cells (both rows and columns).

Pivot report style options
Change the look of your pivot report.
When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

Pivot report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

Note: All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message "Number of rows removed from this list by Security constraints:" followed by the number. See Access control rules.

For more information, see Define a report drilldown.

Single score report
Single score reports display a single value that is key to your business. Add single score reports to dashboards and configure them to update in real time.
Note: Single score reports which include dynamic conditions added at the report level will not show real-time updates on dashboards unless manually refreshed, or upon a page refresh. The real-time dashboard widget relies on the record watcher to know when an update has been made in order for the single score widget to auto-refresh. However, dynamic conditions aren't supported as part of the record watcher. See further explanation in Create a real-time score visualization for a score widget.

![Single score report that has been added to a dashboard](image)

Note: This report type cannot be run as a scheduled report.

Create a single score report

Create a single score chart to display a metric or score that is key to your business. The value updates in real time on a dashboard.

Before you begin

Role required: itil, report_user

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification prompts you to view them.</td>
<td></td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (button) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Single score** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.
# Configuration tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Computational method for aggregating report data. The default is <strong>Count</strong>, which displays the number of records selected.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A single score chart displays only the aggregate value.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Count Distinct</strong>, only unique records are counted. For example, you want to generate a report with a distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use <strong>Count Distinct</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, a list of fields from the selected <strong>Table</strong> appears. You may further be able to aggregate on fields from extended tables. See How to report on extended tables. Select a field to aggregate by from this list. For example, if you select a duration field, such as <strong>Business duration</strong> on the Incident table, the aggregated data is expressed in days, hours, and minutes.</td>
</tr>
<tr>
<td></td>
<td>If you select an integer field, such as the <strong>Priority</strong> field, the data is expressed as a number. You may further be able to aggregate on fields from extended tables. See How to report on extended tables.</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See Value formatting in reports.</td>
</tr>
</tbody>
</table>
Note: Currency fields default to two decimal places. With the Set Value Formatting option, you can configure decimal precision for 0-4 decimal places.

7. Optional: To limit the information displayed in the report, click the filter icon (蘼) and select conditions to filter the report data.
To learn how to construct conditions, see Condition builder.

Note: The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

8. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

9. Click Save.

What to do next

• Click the Report info icon (строен) and add a description of the report.

• Click the sharing icon (.FileReader) to open the Sharing menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

Single score report style options

Change the look of your single score report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

Single score chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Display Zero</td>
<td>Check box to display the number 0 when the value of the report is zero. Clear this check box to display an error message when the value of the cell is 0. Applicable when Aggregation is Count or Count Distinct.</td>
</tr>
</tbody>
</table>
## Single score chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default color</td>
<td>Color of the score in the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message "Number of rows removed from this list by Security constraints:" followed by the number. See Access control rules.

For more information, see Define a report drilldown.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit coloring rules</td>
<td>Click this hyperlink to configure how values are colored in the report. You can create rules to define which colors are used based on operators and values. For example, you can specify that any value greater than 5 displays in red. See Create coloring rules for single score reports.</td>
</tr>
<tr>
<td>Title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>Show chart title</td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
</tbody>
</table>
Single score chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
</tbody>
</table>

**Step line reports**

Step line reports plot individual data points to show how the value of one or more items changes over time. Horizontal lines in the step report show the duration of a change and vertical lines show its magnitude.

The values of an item at specific dates or times are displayed as data points connected by horizontal lines. Values along the horizontal axis of the step line report represent the time measurement (years, hours, minutes, milliseconds, and so on). Values on the vertical axis represent the magnitude of changes to the items being monitored. Users with the report_admin role can define the ranges that are used in a step line report.

For example, you can create a step line report for incident counts, to show how the number of incidents changes over time.
Create a step line report

Create a step line report to show how the value of one or more items changes over time. Step line reports emphasize the duration and magnitude of the change.

**Before you begin**
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

**About this task**
This task refers to the Rome release under UI15 and UI16.

**Procedure**
1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you select a data source used by existing reports, a notification prompts you to view them.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.</td>
</tr>
<tr>
<td></td>
<td>For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Step** in the filter, select the report type, and click **Next**.
   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group by              | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables. Click the info icon (ℹ️) for a description of the selected field. Configured function fields appear in this list after you save the report. **Note:**  
  • It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.  
  • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
| Additional group by   | Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see How to report on extended tables. Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report. **Note:**  
  • It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.  
  • Grouping or stacking by Variables or Questions fields is not supported for reports based on database views. |
| Display data table    | Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the **Display data table** field.                                                                 |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence. Click the info icon (i) for a description of the selected field.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you selected a remote table in the Table field, the option you select in this field aggregates the data that was retrieved from an external source and aggregated in memory. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
<tr>
<td>Calendar</td>
<td>Calendar that is the basis for the time series in the report. Select either the standard calendar or a customized business calendar.</td>
</tr>
<tr>
<td>per</td>
<td>Time period to group data by. The range of available time periods depends on the calendar that you selected. Time periods range from an hour to a year. You can also specify a date.</td>
</tr>
<tr>
<td>Note:</td>
<td>If reporting per week: When the report range includes more than one calendar year, inconsistencies result when a week is split between two years. To show data values more accurately according to ISO weeks, add and enable the glide.db.aggregates.trend.use_iso_week property in the System Properties [sys_properties] table.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is Count, which shows the number of records selected. To show only unique records, select Count Distinct.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see <strong>Aggregation in reporting</strong>. If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>. For information about aggregating on FX currency values, see <strong>FX Currency values in reporting</strong>.</td>
</tr>
<tr>
<td>Percentage</td>
<td><strong>calculation</strong> Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when <strong>Aggregation</strong> is set to <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Aggregation</strong> calculates the percentage using the selection in the <strong>Aggregation</strong> field. Only data that is displayed in the report is used to calculate the percentage. For example, a report shows assets by department with the <strong>Aggregation</strong> set to <strong>Sum</strong> and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use Record Count</strong> calculates the percentage using the total number of records in the data set. For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the low-priority section is 40%.</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See <strong>Value formatting in reports</strong>.</td>
</tr>
</tbody>
</table>

7. **Optional:** Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.
a. In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

b. Click **+** to configure additional sorting order conditions. (Click **-** to delete configured sorting order conditions.)

c. Click **Save**.

For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

![Add Sort](image)

### 8. Optional:
To limit the information displayed in the report, click the filter icon (**iyor**) and select conditions to filter the report data.

To learn how to construct conditions, see **Condition builder**.

**Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

### 9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

### 10. Click **Save**.
What to do next

- Click the Report info icon (ADDR) and add a description of the report.
- Click the sharing icon (ADDR) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Step line report style options

Configure the look of your step line report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

### Step line report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
</tbody>
</table>
| Chart color    | Colors used in the report. If you do not group or stack the report, **Use one color** is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:  
  - **Use color palette**: Select a color palette from the predefined system color palettes.  
  - **Use several colors**: Define a custom set of Colors using hex codes. You can add any number of colors.  
  - **Use chart colors**: Use the colors defined in Reports > Chart Colors.  

  Note: It is not possible to use transparency hex values. |
| Set palette    | Color palette used in the report. This field appears when you select **Use color palette** from the Chart color list. |
| Colors         | Colors used in the report. This field displays when you select **Use several colors** from the Chart color list. Click the search icon (ADDR) to choose from the Chart color schemes or Color Definitions list. |
### Step line report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set color</td>
<td>Color used in the report. This field displays when you select <strong>Use one color</strong> from the <strong>Chart color</strong> list. Click the search icon (🔍) to choose from the <strong>Chart color schemes</strong> or <strong>Color Definitions</strong> list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Do not plot nil as zero</td>
<td>Check box to specify whether to replace missing data points with values of zero. This field is available when creating or editing time series reports (area, spline, line, and step line reports only) that include multiple datasets, and when creating or editing datasets within the applicable time series reports. This field is not available when data in the report is grouped, or is aggregated by Count or Count Distinct. If selected, the report may show gaps where no data exists.</td>
</tr>
<tr>
<td>Show marker</td>
<td>Check box to show a symbol at each data point. When selected, the marker shows in the center of the step and the endpoints of the report visualization.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
</tbody>
</table>
### Step line report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Decimal precision</strong></td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>
Step line report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>Show chart title</td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Legend</td>
<td>Show legend</td>
</tr>
<tr>
<td></td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
</tbody>
</table>
### Step line report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legends are truncated by default. To adjust truncation lengths, configure the properties <code>glide.chart.label.legend.truncate_to</code> and <code>glide.chart.label.legend.truncate_to.large</code>. For more information, see Reporting properties.</td>
<td></td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>

### Axis

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
</tbody>
</table>
Step line report style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report. On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

**Trend reports**

Trend reports show how the value of one or more items changes over time. Values along the horizontal axis of the trend report represent the time measurement. Values on the vertical axis represent the changes to the items being monitored.

Users with the report_admin role can define the ranges that are used in a trend chart report. See [Report ranges](#) for information on creating report ranges.

An example of an item that changes over time is incident count. The incident count will likely increase during the first few months after a product upgrade is released. Over time, the number of incidents reported drops as users become more accustomed to the changes in the product.
Create a trend report

Create a trend report to show how the value of one or more data element changes over time.

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Data source  | Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see Report sources.  
§ Note: If you select a data source used by existing reports, a notification prompts you to view them. |
| Table        | The raw data from a table with no filters applied. When you select a table, its short description appears below the table name.  
For trend reporting, you can also select a remote table, which aggregates, in memory, data retrieved from an external source. Then select a Trend by field option to aggregate its data. To learn more about remote tables, see Retrieving external data using remote tables and scripts |
| External import | Choose an existing imported report source, or click the Upload icon (قرار) to import a new file. See Create a report from an imported Microsoft Excel document. |
MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase.

4. Click **Next**.

5. On the **Type** tab, enter **Trend** in the filter, select the Trend report type from the **Other** section, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

<table>
<thead>
<tr>
<th>Configure tab</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Group by**  | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see **How to report on extended tables**. Click the info icon (ℹ️) for a description of the selected field.

Configured function fields appear in this list after you save the report.

**Note:**
- It is not possible to group or stack reports by the **Tags** field, or by certain field types, such as MEDIUMTEXT.
- Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.

**Additional group by** | Extra fields to group the report by. When you select **Additional group by** fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see **How to report on extended tables**. Click the info icon (ℹ️) for descriptions of the selected fields.

Configured function fields appear in this list after you save the report.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data table</td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added. All report visualizations show the report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Trend by per</td>
<td>Table field whose values you want to show in a time sequence. Click the info icon (ℹ️) for a description of the selected field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you selected a remote table in the Table field, the option you select in this field aggregates the data that was retrieved from an external source and aggregated in memory. To learn more about remote tables, see Retrieving external data using remote tables and scripts</td>
</tr>
</tbody>
</table>

Note: It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT. Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>If reporting per week: When the report range includes more than one calendar year, inconsistencies result when a week is split between two years. To show data values more accurately according to ISO weeks, add and enable the glide.db.aggregates.trend.use_iso_week property in the System Properties [sys_properties] table.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. Select <strong>Minimum</strong> or <strong>Maximum</strong> to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see <strong>Aggregation in reporting</strong>. If you choose <strong>Average</strong>, <strong>Sum</strong>, <strong>Count Distinct</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>, you may be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>. For information about aggregating on FX currency values, see <strong>FX Currency values in reporting</strong>.</td>
</tr>
<tr>
<td>Percentage calculation</td>
<td>Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when <strong>Aggregation</strong> is set to <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>. <strong>Use Aggregation</strong> calculates the percentage using the selection in the <strong>Aggregation</strong> field. Only data that is displayed in the report is used to calculate the percentage. For example, a report shows assets by department with the <strong>Aggregation</strong> set to <strong>Sum</strong> and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.</td>
</tr>
</tbody>
</table>
### Description

- **Use Record Count** calculates the percentage using the total number of records in the data set.

  For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the low-priority section is 40%.

### Set Value Formatting

Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See [Value formatting in reports](#).

### Max number of groups

Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group **Other**.

If you select **Show all**, all groups up to a limit of 50 are displayed. The rest of the results are grouped as **Other**.

### Show Other

Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in **Max number of groups**.

### Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type).

Click the filter icon (🔍) and select **Add Sort**.

- **a.** In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

  The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

- **b.** Click ⚡ to configure additional sorting order conditions. (Click ⏹️ to delete configured sorting order conditions.)

- **c.** Click **Save**.

  For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.
8. **Optional:** To limit the information displayed in the report, click the filter icon (⬇️) and select conditions to filter the report data. To learn how to construct conditions, see **Condition builder.**

**Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

**What to do next**

- Click the Report info icon (ⓘ) and add a description of the report.
- Click the sharing icon (➡️) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Trend report style options**

Change the look of your trend report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the
following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Trend chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
</tbody>
</table>
| Chart color       | Colors used in the report. If you do not group or stack the report, **Use one color** is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:  
  • **Use color palette**: Select a color palette from the predefined system color palettes.  
  • **Use several colors**: Define a custom set of **Colors** using hex codes. You can add any number of colors.  
  • **Use chart colors**: Use the colors defined in **Reports > Chart Colors**.  |
| Note:             | It is not possible to use transparency hex values.                           |
| Set color         | Color used in the report. This field displays when you select **Use one color** from the **Chart color** list. Click the search icon (🔍) to choose from the **Chart color schemes** or **Color Definitions** list. |
| Set palette       | Color palette used in the report. This field appears when you select **Use color palette** from the **Chart color** list. |
| Colors            | Colors used in the report. This field displays when you select **Use several colors** from the **Chart color** list. Click the search icon (🔍) to choose from the **Chart color schemes** or **Color Definitions** list. |
| Display data labels| Select to display the current value for each bar. This field is available when you select None from the **Stacked by** list or if there is no **Stacked by** list.  
  • Select **Data labels in the middle** to show the labels in the middle of each bar.  
  • Select **Allow data labels to overlap** to override default separation of labels in the visualization. |
| Custom chart size | Check box to specify the width and height of the report in pixels.          |
| Note:             | The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart. |
### Trend chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message &quot;Number of rows removed from this list by Security constraints:&quot; followed by the number. See <strong>Access control rules</strong>. For more information, see <strong>Define a report drilldown</strong>.</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart_decimal_precision and specify the value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
</tbody>
</table>
## Trend chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td>Show chart title</td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
</tbody>
</table>
## Trend chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the <strong>Custom chart title position</strong> option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td><strong>Legend</strong></td>
<td></td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. Legends are truncated by default. To adjust truncation lengths, configure the properties <code>glide.chart.label.legend.truncate_to</code> and <code>glide.chart.label.legend.truncate_to.large</code>. For more information, see <strong>Reporting properties</strong>.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
Trend chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
</tbody>
</table>
## Trend chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>• Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td></td>
<td>• If you format duration fields additionally using Set Value Formatting from the Configure tab:</td>
</tr>
<tr>
<td></td>
<td>◦ Values entered in the From/To fields (Style &gt; Y axis) are in seconds. The visualization displays y-axis labels as the selected Minimum/Maximum duration unit (Configure &gt; Set Value Formatting), and returns data that falls within the From/To (seconds) values.</td>
</tr>
<tr>
<td></td>
<td>◦ Example: If you set the minimum and maximum duration unit to Minute, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.</td>
</tr>
</tbody>
</table>

| To | Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available. |
|    | Note:       |
|    | • Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator. |
|    | • If you format duration fields additionally using Set Value Formatting from the Configure tab: |
|    | ◦ Values entered in the From/To fields (Style > Y axis) are in seconds. The visualization displays y-axis labels as the selected Minimum/Maximum duration unit (Configure > Set Value Formatting), and returns data that falls within the From/To (seconds) values. |
|    | ◦ Example: If you set the minimum and maximum duration unit to Minute, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields. |

| X axis / Y axis label size | On the X axis tab, specify the size of the labels for the rows of the report. On the Y axis tab, specify the size of the labels for the columns in the report. |
Trend chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

Trendbox reports

Trendbox reports visualize the distribution of data between groups over a specific time period.

A trendbox report is similar to a box report, but it also allows you to specify a time period for the report. When defining the report, use a descriptive title that indicates the use of the time period. Use trendbox reports when you have multiple small data sets from different sources that are related to each other. Examples include incident resolution times for different product features, or incident resolution times for different priorities.

For example, a trendbox report can show incident resolution duration for high priority incidents by support employee. Suppose every support employee handles P1 incidents, but you know that the time it takes to resolve each P1 incident varies. A trendbox report would show, by employee, the longest and shortest resolution times, and a grouping with the most common or closely clustered resolution times. With this information, you can compare resolution times by employee, or you can use the information to estimate future support staffing levels.
About trendbox reports
Each box in a trendbox report displays the following information for each group of data:
Box chart scale

1- Sample maximum  The highest count reached during the time frame.
2- Upper quartile  The median of the upper half of the data.
3- Median  If all the interval counts are ordered from minimum to maximum, the median represents the center most value.
4- Mean  The mean is visualized by the blue dot. It is the average of all the data points, or the sum of the counts divided by the number of intervals.
5- Lower quartile  The median of the lower half of the data.
6- Sample minimum  The lowest count reached during the time frame.

To understand how to read the box chart scale, reference the following theoretical trendbox which reports on incidents assigned to an employee per month. The employee worked the following number of incidents per month:

<table>
<thead>
<tr>
<th>Month</th>
<th>Month 1</th>
<th>Month 2</th>
<th>Month 3</th>
<th>Month 4</th>
<th>Month 5</th>
<th>Month 6</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1 incident</td>
<td>3 incidents</td>
<td>5 incidents</td>
<td>2 incidents</td>
<td>6 incidents</td>
<td>5 incidents</td>
</tr>
</tbody>
</table>

In this example report which shows trends per month, the values are:

- **Median:** In the dataset 1,2,3,5,5,6, the median is 4, because it’s an even dataset ((3+5)/2). If the dataset was an odd number of values, the median would be the exact center value.

- **Upper quartile:** When the data is split, 5,5,6 represents the set of data in the upper half. In the example, the upper quartile is 5. Because the example data
set is an even number of values, the upper quartile is an exact value. If the dataset was an odd number of values, you would average the two center values.

- **Maximum value**: The month where the employee had the most incidents assigned, or 6 incidents in month 5.

- **Mean**: \((1+3+5+2+6+5)/6\), or 3.66.

- **Lower quartile**: When the data is split, 1,2,3 represents the set of values in the lower half of the data. In the example, the lower quartile is 2. Because the dataset has an even number of values, the lower quartile is an exact value. If the dataset had an odd number of values, you would average the two center numbers.

- **Minimum**: The month where the employee had the least number of incidents assigned, or 1 incident in this example.

**Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see [Enabling accessibility features](#).

## Create a trendbox report

Create a trendbox report to show the distribution of values in a data set, with a specified time period.

### About this task

### Procedure

1. Navigate to **Reports > Create New**.

2. On the **Data** tab, give the report a name that reflects the information being grouped.

3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>Also called a report source, a data source is a table with filters applied to provide a single source of information for all users. For more information, see <a href="#">Report sources</a>.</td>
</tr>
</tbody>
</table>
### Trendbox report configuration options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group by      | Group report data using the values of this field. For example, in an incident report grouped by **Assignment group**, all incidents

4. Click **Next**.

5. On the **Type** tab, enter **Trendbox** in the filter, select the report type, and click **Next**.

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables. Click the info icon (ℹ️) for a description of the selected field. Configured function fields appear in this list after you save the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.</td>
</tr>
<tr>
<td></td>
<td>• Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Label names longer than 20 characters may show or print a truncated view.</td>
</tr>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select Additional group by fields or function fields, the report includes a control at the bottom that allows you to group the report by any one of the additional fields. To group by fields on extended tables as well, see How to report on extended tables. Click the info icon (ℹ️) for descriptions of the selected fields. Configured function fields appear in this list after you save the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• It is not possible to group or stack reports by the Tags field, or by certain field types, such as MEDIUMTEXT.</td>
</tr>
<tr>
<td></td>
<td>• Grouping or stacking by Variables or Questions fields is not supported for reports based on database views.</td>
</tr>
<tr>
<td>Configure function field</td>
<td>Configure fields based on calculation of multiple inputs including arithmetic functions. For more information, see Report on function fields. Function field results are calculated when the report is run. You can use the results for aggregations and grouping. You have to save the report before you can configure function fields. Configured function fields appear in the Group by and Additional group by lists after you save the report.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence. Click the info icon (i) for a description of the selected field. <strong>Note:</strong> If you selected a remote table in the Table field, the option you select in this field aggregates the data that was retrieved from an external source and aggregated in memory. To learn more about remote tables, see Retrieving external data using remote tables and scripts.</td>
</tr>
<tr>
<td>per</td>
<td>Time period to group data by. The range of available time periods depends on the calendar that you selected. Time periods range from an hour to a year. You can also specify a date. <strong>Note:</strong> If reporting per week: When the report range includes more than one calendar year, inconsistencies result when a week is split between two years. To show data values more accurately according to ISO weeks, add and enable the glide.db.aggregates.trend.use_iso_week property in the System Properties [sys_properties] table.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is Count, which shows the number of records selected. To show only unique records, select Count Distinct. Select Average, Sum, or Count Distinct, to show a list of fields from the selected Table. Select a field to Aggregate by from this list. Select Minimum or Maximum to show the maximum or minimum value for each segment of the report. For more information on aggregation options, see Aggregation in reporting. If you choose Average, Sum, Count Distinct, Minimum, or Maximum, you may be able to aggregate on fields from extended tables. See How to report on extended tables. For information about aggregating on FX currency values, see FX Currency values in reporting.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Value Formatting</td>
<td>Enables you to configure how to show numerical values in reports, including rounding, minimum and maximum duration units, and abbreviations for duration units. See Value formatting in reports.</td>
</tr>
</tbody>
</table>

7. **Optional**: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type).

   Click the filter icon (🔎) and select **Add Sort**.

   **a.** In the Sorting Order list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source and fields on extended, or related, tables. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type).

   **b.** Click + to configure additional sorting order conditions. (Click − to delete configured sorting order conditions.)

   **c.** Click **Save**.

   For fields of the type Choice list, sort order is not determined alphabetically or numerically. For multi-level pivot table and heatmap reports, sort order is determined by the value of the choices in the list. For example, a priority list is often indexed from Critical to Planning as shown in the figure below. For other report types, sequence of the list choices determines the sort order.

![Add Sort](image-url)
8. **Optional:** To limit the information displayed in the report, click the filter icon (⬇️) and select conditions to filter the report data. To learn how to construct conditions, see [Condition builder](#).

**Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

**What to do next**

- Click the Report info icon (📋) and add a description of the report.

- Click the sharing icon (겠다) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Related information**

- [Share a report](#)

**Trendbox report style options**

Change the look of your trendbox report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

**Trendbox chart style options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Custom chart size: Check box to specify the width and height of the report in pixels. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
</tbody>
</table>
Trendbox chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
</tbody>
</table>
## Trendbox chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td></td>
</tr>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when the Custom chart title position option is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Axis</td>
<td>Y axis and X axis</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
</tbody>
</table>
### Trendbox chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
</tbody>
</table>

**Note:**
- Depending on configured **Highcharts** settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.
- If you format duration fields additionally using **Set Value Formatting** from the Configure tab:
  - Values entered in the **From/To** fields (**Style > Y axis**) are in seconds. The visualization displays y-axis labels as the selected **Minimum/Maximum duration unit** (**Configure > Set Value Formatting**), and returns data that falls within the From/To (seconds) values.
  - Example: If you set the minimum and maximum duration unit to **Minute**, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.

| To    | Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type **Number**, the **From** and **To** fields are not available. |

**Note:**
- Depending on configured **Highcharts** settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.
- If you format duration fields additionally using **Set Value Formatting** from the Configure tab:
  - Values entered in the **From/To** fields (**Style > Y axis**) are in seconds. The visualization displays y-axis labels as the selected **Minimum/Maximum duration unit** (**Configure > Set Value Formatting**), and returns data that falls within the From/To (seconds) values.
  - Example: If you set the minimum and maximum duration unit to **Minute**, the visualization displays y-axis labels as minutes, and returns data which falls within the corresponding seconds values set in the From/To fields.
Trendbox chart style options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X axis / Y axis label size</td>
<td>On the X axis tab, specify the size of the labels for the rows of the report. On the Y axis tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

Analytics accessibility options

Understand how you can set accessibility options for data visualizations on dashboards, reports, and widgets.

You can enable and disable these options to make your experience in an instance more accessible.

- Data visualization patterns enabled
- Accessibility enabled

Click the settings icon to display the System Settings > Accessibility menu.
Data visualization patterns enabled
Here's an example of a dashboard showing visualizations without accessibility enabled.
When you click **Data visualization patterns enabled**, you can see how the visualization's solid colors become differently patterned for more accessible viewing.
Accessibility enabled

You can also click **Accessibility enabled**, which displays a plus icon on the chart.

Here’s a closer view of the plus icon which, when enabled, displays regardless of the data table setting set for individual reports.

Click the plus icon to display the corresponding data table.
Aggregation in reporting

Aggregation enables you to apply calculations to data displayed in reports.

- The count aggregation gives the number of records in each element of a report.
- Count distinct provides the count of unique values for a given field.
- Average shows the arithmetic mean of the values for a given field.
- Sum shows the total of the aggregated values.
- Minimum and Maximum show the least or greatest values for each displayed category.
- Standard deviation shows data variation from the average value for a given field.

If you choose **Average, Sum, Count Distinct, Minimum, Maximum, or Standard deviation**, you may be able to aggregate on fields from extended tables. See **How to report on extended tables**.

For information about aggregating on FX currency values, see **FX Currency values in reporting**.
**Count aggregations**

The default aggregation is **Count**. The Count aggregation shows the number of records selected.

To show only unique records, select **Count Distinct**. For example, you want to show the value for the distinct number of task types being performed. Task types being performed for multiple customers are counted multiple times unless you use **Count Distinct**.

The following images compare Count and Count Distinct. The first shows that the raw count of for one column is 632. The second shows that the distinct count for the same column is only 8.

![Count vs Count Distinct](image)

**Average**

**Average** shows the arithmetic mean of the field you aggregate on. For example, select a duration field. The aggregated data is expressed in terms of days, hours, minutes, and seconds. (You can configure durations to show the level of detail you want.) If you select an integer field, such as **Priority**, the data is expressed as a decimal value number.
Sum

Select **Sum** to show the sum of the field you aggregate on. For example, select a duration field. The aggregated data is expressed in terms of days, hours, minutes, and seconds. (You can configure durations to show the level of detail you want.) Select an integer field, such as **Priority**, and the data is expressed as a whole number.
Minimum and Maximum

Select **Minimum** or **Maximum** to show the maximum or minimum value for each segment of the report. For example, apply the Maximum aggregation to incidents grouped by priority. The report shows a bar for the incident in each priority with the highest business duration.

The following images illustrate maximum and minimum duration using grouped bars to show the different priorities of each category of incident side by side. Stacked bars give the illusion that the element on top of the stack has a greater value. In fact, the bar is only showing the relative value of the two elements.

### Standard deviation

Select **Standard deviation** to see variation from average values for a duration or numeric field. For example, apply the Standard deviation aggregation to business duration of incidents. The report shows deviation from the average business duration of incidents in each priority.
Value formatting in reports

In most reports, you can configure how numerical values look when you publish the report.

Supported value formats
A limited number of visualization types support value formatting.

<table>
<thead>
<tr>
<th>Visualization type</th>
<th>Supported value formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single score</td>
<td>Both number and duration formatting</td>
</tr>
<tr>
<td>Multilevel pivot</td>
<td>Both number and duration formatting</td>
</tr>
<tr>
<td>Horizontal and vertical bar</td>
<td>Only duration formatting</td>
</tr>
<tr>
<td>Pie</td>
<td>Only duration formatting</td>
</tr>
</tbody>
</table>
## Visualization type

| Time series visualizations (Area, column, line, spline, and step line) | Only duration formatting |

Formatting applies for aggregate values.

### Types of value formatting

**Unit format**

Show the format of time fields as d/h/m/s or day/hour/minute/second.

**Maximum/Minimum duration unit**

Select the largest or smallest unit to be shown: Day, Hour, Minute, or Second.

**Hide seconds when unit is greater than one minute**

Removes seconds display when a duration value is greater than one minute. Only available if you choose Second as the maximum duration unit.

**Decimal precision**

Number of decimal places to show, from zero to four decimal places.

**Rounding**

For values greater than one minute, simplifies a number by rounding, while keeping it close to its value. See Rounding options.

**Use the thousands group separator**

Separate a value of thousands or higher with a comma or period.

**Enable abbreviation**

Show a value of thousands or higher with a single character.

- **Note:** Abbreviation for Currency, Price, or FX Currency values is not supported.

**Hide value in tooltip**

Do not show the unrounded, unabbreviated value in the tooltip.

### Rounding options

For values greater than one minute, rounding options simplify a number, but keep it close to its value. Select from these rounding options:
• Up - to the next larger whole number if positive and to the next smaller whole number if negative. Example: For original values of:
  ◦ 1.1 returns a value of 2
  ◦ 1.6 returns a value of 2
  ◦ -1.6 returns a value of -2

• Down - to the next smaller whole number if positive and to the next larger whole number if negative. Example: For original values of:
  ◦ 1.1 returns a value of 1
  ◦ 1.6 returns a value of 1
  ◦ -1.6 returns a value of -1

• Ceiling - to the next larger whole number, toward the positive. Example: For original values of:
  ◦ 1.1 returns a value of 2
  ◦ 1.6 returns a value of 2
  ◦ -1.6 returns a value of -1

• Floor - to the next smaller whole number, toward the negative. Example: For original values of:
  ◦ 1.1 returns a value of 1
  ◦ 1.6 returns a value of 1
  ◦ -1.6 returns a value of -2

• Half up - to the nearest neighboring whole number. If both neighbors are equidistant, rounds to the next larger whole number. Example: For original values of:
  ◦ 1.1 returns a value of 1
  ◦ 1.6 returns a value of 2
  ◦ 2.5 returns a value of 3

• Half down - to the nearest neighboring whole number. If both neighbors are equidistant, rounds to the next smaller whole number. Example: For original values of:
  ◦ 1.1 returns a value of 1
  ◦ 1.6 returns a value of 2
  ◦ 2.5 returns a value of 2

• Half even - to the nearest whole number. If both neighbors are equidistant, rounds to the closest even number. Example: For original values of:
1.1 returns a value of 1
1.6 returns a value of 2
-2.5 returns a value of -2

Summary of rounding options

<table>
<thead>
<tr>
<th>Input number</th>
<th>Up</th>
<th>Down</th>
<th>Ceiling</th>
<th>Floor</th>
<th>Half up</th>
<th>Half down</th>
<th>Half even</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.5</td>
<td>6</td>
<td>5</td>
<td>6</td>
<td>5</td>
<td>6</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>2.5</td>
<td>3</td>
<td>2</td>
<td>3</td>
<td>2</td>
<td>3</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>1.6</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>1.1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1.0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>-1.0</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
</tr>
<tr>
<td>-1.1</td>
<td>-2</td>
<td>-1</td>
<td>-1</td>
<td>-2</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
</tr>
<tr>
<td>-1.6</td>
<td>-2</td>
<td>-1</td>
<td>-1</td>
<td>-2</td>
<td>-2</td>
<td>-2</td>
<td>-2</td>
</tr>
<tr>
<td>-2.5</td>
<td>-3</td>
<td>-2</td>
<td>-2</td>
<td>-3</td>
<td>-3</td>
<td>-2</td>
<td>-2</td>
</tr>
<tr>
<td>-5.5</td>
<td>-6</td>
<td>-5</td>
<td>-5</td>
<td>-6</td>
<td>-6</td>
<td>-5</td>
<td>-6</td>
</tr>
</tbody>
</table>

Configure formatted values in reports

In existing reports, you can configure formatted values on the Configure tab of the Report Designer.

**Before you begin**
Role required: itil, report_user, report_group, report_global, report_admin, or admin

**Procedure**
1. Navigate to Reports > View / Run.
2. Select the report with the values you want to format.
3. Select the Configure tab.
4. Click Set Value Formatting.
5. In the Value Formatting window, configure duration, decimal precision, rounding options, unit separators, and abbreviations. Value formatting options for a single score report with Count aggregation:

Advanced reporting

Learn how to further customize report visualizations and the data you report on. Topics in this section are appropriate for users who are already familiar with the basics of report creation.

Drilling down within reports

You can drill down within a report to visualize a subset of its data. For example, you can click on the critical section of a report sorted by priority to view the categories of those critical incidents.

For reports with a defined drilldown, click on a portion of the chart to display a subset of data. The subset may use a different chart type. In the example, the user clicks on the critical incidents in a bar chart to reveal the categories of critical incidents in a semi-donut chart.
All chart types except for list, histogram, calendar, control, box, and trendbox charts support drilling down. Drilling down is not available on charts added to forms, and charts embedded as iframes. You can define any number of drilldown levels for a report.

⚠️ **Note:** Drilldown reports do not export to PDF. If you select **Export to PDF** on a drilldown, a PDF of the top level report is generated.

How to create drilldowns and datasets in the report creation tool.

**Define a report drilldown**

You can define a report drilldown to enable reporting users to view subsets of the report data. When you define a report drilldown, it applies only to the report for which you define it.

**Before you begin**

The report that you want to define a drilldown for must exist.

⚠️ **Note:** You can only drill down to data in the same table as the report. The following report types do not support the drilldown feature: list, histogram, calendar, control, box, and trendbox.

How to create drilldowns and datasets in the report creation tool.

**Procedure**

1. Navigate to **Reports > View / Run**.
2. Select the report you want to add a drilldown to.
3. Click the **Show report structure** icon (√).
A badge on the Report structure icon displays the number of defined drilldowns.

4. Click the Add drilldown icon (➕).

Drilldown example

**Report structure**

5. Enter a **Title** for the drilldown and click **Next**.

6. Select the chart **Type** to display the data and click **Next**. See **Creating reports**. The drilldown chart type can be different than the parent report.

7. Configure the drilldown report the same way you would configure any other report. Configuration options depend on the selected drilldown report **Type**.

8. Click **Save drilldown**.

**Results**
The user can drill down from the top-level report to the specified drilldown report visualizations.

**Note:** All users can view report visualizations, such as pie charts and column reports. However, the last level of a drilldown is always a list. Platform access control lists determine user access to list information. Users may see a message indicating that rows were removed from the list by Security constraints. For more information, see **Access control list rules**.

**Set the on-click behavior of a report**

You can configure a URL to open when a user clicks a report.

**Before you begin**
Role required:
• When creating reports: Any

• When editing reports created by others: report_admin, report_global, or report_group

About this task
Redirect the user to a URL rather than to the configured drilldown or the list that underlies the clicked section of a report.
See Define a report drilldown to read which report types do not support the drilldown feature.

Procedure
1. Navigate to Reports > View / Run.
2. Select the report you want to configure.
3. Click the Show report structure icon (¶)
4. Click the link icon (🔗).
5. In the Set redirect URL dialog box, enter relative link in the instance, for example, /$knowledge.do.
   When the user points to the report, the tooltip includes the text Click to open.
6. Optional: Enter a label for the URL.
   When the user points to the report, the tooltip includes the text Click to open and the text of the label, for example, Click to open Knowledge Base.
7. Click Save.

Results
When the user clicks the report, the redirect URL replaces any drilldown functionality.

Using multiple datasets in a report
You can create reports that use datasets from multiple tables in a single report.

The following report types support multiple datasets: bar, horizontal bar, line, column, area, spline.

Multiple Group bys are not supported on multiple datasets. When using multiple datasets, the report legend is always displayed.
Incident and Problem data in one report

Add an additional dataset to a report

Add an extra dataset to a report to visualize data from multiple sources in a single report.

**Before you begin**

Role required: itil, report_user. The property `glide.ui.doctype` must be enabled.

**Procedure**

1. Navigate to Reports > View / Run.
2. Select a report with a type that supports multiple datasets.
   
   You can add additional sets to bar, horizontal bar, line, column, area, and spline reports.

3. Click the **Show report structure** icon ( ));
4. Click **Add dataset**.

5. On the **Data** tab, provide a custom name for the additional data set to appear in the legend of the report, select a data source, and click the **Configure** tab.

6. On the **Configure** tab, specify applicable fields the same way that you would configure a standalone report. Note attention to the following fields on applicable report types.
Note: The Display data table option is not available from the Add dataset module, but is only available from the Configure tab of the main Report Designer. If the Display data table option is selected, only the first dataset will display on the data table.

7. On the Style tab, specify the following fields the same way that you would configure a standalone report.

8. Click Save dataset.

Results
The report is generated with the information from the additional dataset.

Add an additional group by or stack by
You can configure a report to let users adjust its grouping and stacking.

Before you begin
Role required: itil, report_user

About this task
Configure alternative Group by and Stack by choices that users can select when viewing the chart. Additional group bys can be added to any report that supports group bys (such as bar or pie) and to list reports as columns. When you configure an additional group by to a bar or horizontal bar, it is also added as an additional stack by. You can add variables and variable groups as additional group bys.
Note: Available Stack by fields are limited to catalog variables, reference fields, choice lists, and boolean values. Date/time, integer, long, string, list, and text fields cannot be used as stacked fields.

Procedure
1. Navigate to Reports > View / Run.
2. Select a report.
3. On the Configure tab, click Additional group by.
4. Move one or more fields to the Selected list.
5. Optional: Select a Stack by field used to show the relationship of individual items from the selected field to the whole. For example, group a bar chart of incidents by Category and stack by Priority. The viewer can then determine at a glance the proportion of high, medium, and low priority issues for each category. Users viewing the report can select one of these fields to group or stack the report data. The report Group by and Stack by field values are the default choices.

Note: Only bar and horizontal bar reports use stacked data. Other report types allow only grouping.
6. Arrange the fields in the Selected column in the order you want them to appear to users.
7. Click Close.
8. In the report builder, click Save.

Create a report from an imported Microsoft Excel document
You can import Excel spreadsheets (.xlsx files) of data maintained outside of your instance and create reports from those files.

Before you begin
Role required: admin, sys_admin, report_admin, pa_admin, or pa_power_user
You must have the subscription version of Performance Analytics to create reports with imported data. See Activate your Performance Analytics subscription.
Note: The following restrictions apply to imported data:

- The maximum file size is 2 MB.
- The maximum number of rows is 10,000. The maximum number of columns is 25.

Note: You can import .xlsx files of up to 50,000 rows, but only the first 10,000 rows appear in your data set.

- Only the first sheet of an .xlsx file with multiple sheets is imported.
- The first row and first column of the imported file must not be empty. The first row is used to identify the column names.
- It is not possible to join columns, calculate fields, or make other changes to the table after import. These changes must be made before import.
- The imported .xlsx file must have a specified expiration date.
- If the owner deletes the table after import, reports based on the imported table are also deleted.

About this task

Note: Importing report data in this way is useful when you have information that is maintained outside of your instance, for example, recurring third-party data. To import an external data set into your instance permanently, see Importing data using import sets.

Procedure

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. In the Source type list, select External.

Note: The External import menu option is only available if Performance Analytics is enabled.
4. Choose an existing imported report source, or click the **Upload** icon to import a new file.
   
a. Click and drag the file onto the drop zone or click **Browse files** to choose it from your file system.

b. Enter a name for the uploaded file.

c. Set the expiration of the file. After this date, the imported file is deleted and reports based on it are no longer available.

d. Select the visibility for the uploaded file: Only you, all users, or a specified group of users, groups, or roles.

e. Click **Upload**.

f. Click **Done**.

5. Click **Next**.

6. On the **Type** tab, select the type of report you want to create and click **Next**. For information on specific reports, see [Creating reports](#).

   The application shows a preliminary version of the report. To view the updated report at any time, click **Run**.

7. On the **Configure** tab, fill in the fields as appropriate for the report type.

8. **Optional:** To limit the information displayed in the report, click the filter icon and select conditions to filter the report data.

   To learn how to construct conditions, see [Condition builder](#).

   **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

## Results

The report is created from the external source. Reports on a dashboard or a homepage show an icon to show that the report is temporary and expires when the external data source expires.
What to do next

• Click the Report info icon ( ) and add a description of the report.

• Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

• Click the sharing icon ( ) to open the Sharing menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

Edit an imported data source

You can edit imported Excel spreadsheets (.xlsx files) of data maintained outside of your instance.

About this task

Only the person who imported the data source can edit it.

Procedure

1. Navigate to Reports > View / Run.

2. Click the name of a report that uses to imported data source to open the report in the Report Designer.

3. On the Data tab, click the pencil icon ( ) next to the name of the external import.

4. In the Edit external import dialog box you can make these changes:

   Change file
   Select this option to upload a new .xlsx file with the same name and structure.

   Name
   Provide a new name for the external import. This name appears on the Data tab of the Report Designer in the External Import list.

   Expire
   Set a new expiry date for the external import. After this date, the imported file is deleted and reports based on it are no longer available.

   Visible to
Change the visibility for the uploaded file: Only you, Everyone, or Custom. Select Custom to specify users, groups, or roles.

If you select Custom, click Next to choose who can use the data in the imported file and click Submit.

5. Click Submit.

Results
If you changed the file, the data from the new file replaces that of the old in any reports that are based on the imported file. Changed name, expiry date, and visibility apply to the imported file.

Create reports from MetricBase time-series data
Use the MetricBase application to create time-series reports from MetricBase data.

Before you begin
You must have the MetricBase product. To get it, see Request the MetricBase product. For more information about MetricBase, see MetricBase.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, enter a report name that reflects the information in the report.
3. In the Source type list, select MetricBase.
Note:

- The **MetricBase** menu option is available only if you have MetricBase installed on your instance.

- The default maximum number of series per data set is 20. You can increase the maximum value up to 100 by configuring the `glide.report.metric_max_series` system property. However, due to the 10,000 data points limit, increasing the number of series in a data set results in a smaller number of data points per series.

- The total number of data points that can be displayed per series is 10,000 / (actual number of series in dataset * number of data sets). For example:
  - 1 dataset used with 20 series: 10K / (20*1) = 500
  - 2 datasets used with 20 series: 10K / (20*2) = 250
  - 1 dataset used with 100 series: 10K / (100*1) = 100

- If the actual number of data points in a series exceeds the limit, the data is resampled.

4. Choose an existing MetricBase table.

5. Click **Next**.

6. On the **Type** tab, select the type of report to create and click **Next**.
   
   Only time series reports are available. For information on specific reports types, see [Creating reports](#). To view the updated report, click **Run**.

7. On the **Configure** tab, fill in the following fields and click **Next**.
**Configure tab form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Report data that you group by any of the applicable fields in the Metrics table.</td>
</tr>
<tr>
<td>Metric</td>
<td>Metrics determined in your MetricBase database. Click the plus icon (+) to add multiple metrics. For each metric, you can set one or more transforms. Click the minus icon (-) to remove a metric.</td>
</tr>
<tr>
<td>Transform</td>
<td>Data is altered.</td>
</tr>
<tr>
<td></td>
<td>• Select no transforms to show the raw data in your report.</td>
</tr>
<tr>
<td></td>
<td>• Select one transform.</td>
</tr>
<tr>
<td></td>
<td>• Select multiple transforms to create a transform chain. A transform chain applies a new transform to the results of the previous transform.</td>
</tr>
<tr>
<td></td>
<td>For more information, see MetricBase transforms.</td>
</tr>
<tr>
<td>Time range</td>
<td>Period of time that the report covers. Relative values are a number of minutes, hours, days, months, or years from the current time. Absolute ranges enable you to specify the start time and end time of the report.</td>
</tr>
<tr>
<td>Display data table</td>
<td>Select this option to show report data in a list below the report. The list appears on dashboards where the report is added.</td>
</tr>
<tr>
<td></td>
<td>All report visualizations show the report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
</tbody>
</table>

8. **Optional:** To limit the information displayed in the report, click the filter icon and select conditions to filter the report data. To learn how to construct conditions, see Condition builder.

   **Note:** The Keywords field is a special field that is used for text searches across all fields. If you use it in a filter or condition, in combination with other conditions, it may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report. See the Style options section of the report that you are creating for more information.
• Area and spline report style options
• Line report style options
• Step line report style options

10. Click **Save**.

**Results**
The report is created from the MetricBase source. If the report visualization is truncated, a message appears.

**What to do next**
• Click the Report info icon (iards) and add a description of the report.

• Click the sharing icon (iards) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

• Click the sharing icon (iards) to open the **Sharing** menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

**MetricBase transforms**
Transforms enable you to visualize MetricBase data in different ways.

**Available transforms**
All transforms except for the **Label** transform are mathematical functions you can apply to the metrics data. Apply multiple transforms to create a transform chain.

<table>
<thead>
<tr>
<th>Transform</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Calculates an outcome by adding the specified value to the data points in the dataset.</td>
</tr>
<tr>
<td>Average</td>
<td>Calculates the arithmetic means of all currently selected metrics.</td>
</tr>
<tr>
<td>Bottom</td>
<td>Shows only the lowest specified number of values of the metric dataset.</td>
</tr>
<tr>
<td>Chi-square</td>
<td>Shows how well a statistical model fits the metric dataset.</td>
</tr>
<tr>
<td>Count</td>
<td>Shows the count of data points within the metric dataset.</td>
</tr>
<tr>
<td>Transform</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Decompose</td>
<td>Separates out components of predictive models. You can decompose and request both the min and the max to get the lower and upper bounds of a predictive model.</td>
</tr>
<tr>
<td>Divide</td>
<td>Calculates an outcome by dividing the data points in the dataset by a specified value.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Shows the minimum and maximum values of the metric dataset.</td>
</tr>
</tbody>
</table>
| Filter    | Produces a new series with values calculated using the given aggregation function over a sliding time window of the given duration. A sliding 15-minute average would use the Filter transform with the **Average** aggregation function and a duration of 15 minutes. Supported aggregation functions:  
  * AVG  
  * CHISQUARE  
  * LAST  
  * MAX  
  * MEDIAN  
  * MIN  
  * STDDEV |
<p>| Fit       | Generates a prediction model that can be used by the model-based trigger. |
| Fractiles | Returns a new series with values representing the given percentiles of the underlying data. For example, to query for the 90th and 99th percentile response times, supply an array of [0.9,0.99]. |
| Interpolate| Constructs new data points a specified duration to calculate an outcome. |
| Label     | Enables you to set a label for your transform. |
| Last      | Returns the last defined value in the period window. |
| Log       | Calculates the natural logarithm of all values in the dataset. |
| Max       | Shows the largest value at each point in time for the metric dataset. |</p>
<table>
<thead>
<tr>
<th>Transform</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Median</td>
<td>Shows the median of the metric dataset. The median separates the higher values of the metric dataset from the lower values.</td>
</tr>
<tr>
<td>Min</td>
<td>Shows the smallest value at each point in time for the metric dataset.</td>
</tr>
<tr>
<td>Multiply</td>
<td>Calculates an outcome by multiplying the data points in the dataset by a specified value.</td>
</tr>
</tbody>
</table>
| Partition | Produces a new series with values calculated using the given aggregation function over a fixed time frame of a given duration. Specify the Base (a timestamp) to align the partition window. Supported aggregation functions:  
- AVG  
- CHISQUARE  
- LAST  
- MAX  
- MEDIAN  
- MIN  
- STDDEV |
| Predict   | Compares predicted time-series data generated by the prediction model selected in the MetricBase Models table (mb_model) to real data. The predicted and real data can be graphed. Prediction triggers are based on the predicted values as well as thresholds. Thresholds are values above and below the predicted value. Real data that falls outside of those thresholds execute prediction triggers. |
| Put       | Copies a time-series metric into a different MetricBase time-series metric, for example, `copyData('targetMetric').put()` |
| Resample  | Expands or contracts the data to fit the given period. When you extend the period, the aggregation function is used to combine the data to fit the new period. When you shorten the period, the existing data is propagated to the underlying periods. Supported aggregation functions:  
- AVG  
- CHISQUARE  
- LAST |
<table>
<thead>
<tr>
<th>Transform</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAX</td>
<td></td>
</tr>
<tr>
<td>MEDIAN</td>
<td></td>
</tr>
<tr>
<td>MIN</td>
<td></td>
</tr>
<tr>
<td>STDDEV</td>
<td></td>
</tr>
</tbody>
</table>

**Standard Deviation**
Calculates the standard deviation across the underlying data. Used to quantify the variation or dispersion of a set of data values in the metric dataset.

**Subtract**
Calculates an outcome by subtracting the specified value from the data points in the dataset.

**Sum**
Calculates the sum of the data points within the metric dataset. See **Sum transform** for more information.

**Top**
Shows only the highest specified number of values of the metric dataset.

**Sum transform**
A value at timestamp “T” denotes the value for the range (T-period, T). In your query, `sum()` gives the input series. You have one series and then you resample the original series into a new series with period = 1 day. When you resample the original series to a period, it creates two data points (2000-04-02T00:00:00Z and 2000-04-03T00:00:00Z). The value at 2000-04-02T00:00:00Z is 1 because there is one data point. The value at 2000-04-03T00:00:00Z is calculated by aggregating values in the
range \((2000-04-02T00:00:00Z, 2000-04-03T00:00:00Z]\). The value is equals 3.

In this example, the result of

```javascript
var startTime = new GlideDateTime('2000-04-02 00:00:00');
var endTime = new GlideDateTime('2000-04-02 23:00:00');
transformer.metric('u_cost').sum().resample('SUM', GlideDuration('1 00:00:00'))
```

is \([1, 3]\) rather than \([4]\).

----- rest api result for GET -----
```
{
  "seriesRef": {
    "subject": "28e6bf5d73c233000355bccdbdf6a70c",
    "table": "sn_cld_intg_aws_cost_usage",
    "metric": "u_cost"
  },
  "label": "28e6bf5d73c233000355bccdbdf6a70c:sn_cld_intg_aws_cost_usage|u_cost",
  "values": [
    {
      "timestamp": "2000-04-02T00:00:00Z",
      "value": 1
    }
  ]
}
```
Configure charts on forms

You can add reports to forms such as change requests, and configure the report visualizations to display information relevant to the user of the form. The configuration is specific to the current view.

Before you begin

Role required: admin

The following report types are not supported on forms: List, Pivot, Multilevel Pivot, Calendar, and Single Score.
Procedure

1. Select the table on which you want to configure a form with a report in the Filter navigator and select a record. For example, select a record from task.list.

2. From the context menu, select Configure > Form Layout.

3. From the Available list, add *Chart to the Selected column. Use the up and down arrows to position the report on the form.

4. Optional: Specify a label for the chart. The label appears next to the report in the form. If you do not specify a label, the label New Chart is used.

5. Click Save.

A grey box with the text Configure chart appears on the form in the specified position.

6. Click Configure chart.

7. Click the search icon (🔍) to select a report.

8. Optional: Specify the height of the chart. The default value is 300 pixels.

9. Optional: You can filter the data in the report based on selected fields or based on a scripted filter or an encoded query. The first field must be visible on the form. To add fields to the form, select Configure > Form Layout and use the Available Fields slush bucket.

On the Report condition extension tab, select the form field on which the report is updated and the field on the report source table to which the form field is compared.

To specify a scripted filter or an encoded query, select Advanced Condition Extensions and paste the script in the Report Qual text box. Advanced condition extensions, if present, override report condition extensions.

10. Click Update.
11. To change the configuration, right click on the label and select **Configure chart**.

![Configure chart](image)

**Results**
The selected report appears on all forms which are of the same type as the one selected. These reports are filtered based on the report condition extensions.

**Embedding reports in Jelly**
You can embed reports in any Jelly-based element, such as a UI page.

**Enabling Embedding**
To enable embedding reports in Jelly, add the following element to your Jelly code.

```xml
<g:inline template="reporting_includes.xml" />
```

After adding this code, you can embed an existing report, or generate a report within the Jelly code.

**Embedding an existing report**
You can embed an existing report by calling the `embedReportById(targetSpan, reportId)` function.

For example, add the following to the HTML/XML block in the UI page record:

```xml
<xml version="1.0" encoding="utf-8">
  <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
    <g:inline template="reporting_includes.xml" />
    <div id="report_stuff" />
</j:jelly>
</xml>
```
And add the following to the Client script block in the UI page record. Replace `<report sys_id>` with the report's actual sys_id:

```javascript
var div = $j("#report_stuff");
embedReportById(div, "<report sys_id>");
```

Alternatively, you can embed the JavaScript in the jelly code entirely in the HTML/XML block. Add the code from the client script block between `<script>` tags:

```xml
<xml version="1.0" encoding="utf-8">
    <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
        <g:inline template="reporting_includes.xml" />
        <div id="report_stuff" />
        <script>
            var div = $j("#report_stuff");
            embedReportById(div, "<report sys_id>");
        </script>
    </j:jelly>
</xml>
```

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetSpan</td>
<td>The jQuery element to embed the chart in. The chart uses the size of this element.</td>
</tr>
<tr>
<td>reportId</td>
<td>The sys_id of the report you want to embed.</td>
</tr>
</tbody>
</table>

### Generate and Embed a Report

You can generate a report within the UI by calling the `embedReportByParams(targetSpan, parms)` function. When embedding a report in this way, you can generate a new report using parameters, or specify a report sys_id to display that report.

For example, add the following to the HTML/XML block in the UI page record:

```xml
<xml version="1.0" encoding="utf-8">
    <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
        <g:inline template="reporting_includes.xml" />
        <div id="report_stuff" />
    </j:jelly>
</xml>
```
And add the following to the Client script block in the UI page record:

```javascript
var div = $j("#report_stuff");
embedReportByParams(div, params);
```

Alternatively, you can embed the JavaScript inside the jelly code. Add the code from the client script block between `<script>` tags:

```xml
<xml version="1.0" encoding="utf-8">
   <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
      <g:inline template="reporting_includes.xml" />
      <div id="report_stuff" />
      <script>
         var div = $j("#report_stuff");
         embedReportByParams(div, params);
      </script>
   </j:jelly>
</xml>
```

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetSpan</td>
<td>The jQuery element to embed the chart in.</td>
</tr>
<tr>
<td>params</td>
<td>A JSON object defining the report. Available parameters depend on the report type.</td>
</tr>
</tbody>
</table>

### Generating and embedding a list report

When you embed an existing list report or generate a list report and embed it, you must enter one more line of code.

Add the following to the HTML/XML block in the UI page record:

```xml
<xml version="1.0" encoding="utf-8">
   <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
      <g:inline template="reporting_includes.xml" />
      <g:inline template="list2_js_includes.xml" />
      <div id="report_stuff" />
</j:jelly>
</xml>
```
Add the following to the Client script block in the UI page record. Replace `<report sys_id>` with the report's actual sys_id:

```javascript
var div = $j("#report_stuff");
embedReportById(div, <"report sys_id">);
```

Or embed the JavaScript in the jelly code entirely in the HTML/XML block. Add the code from the client script block between `<script>` tags:

```xml
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null"
 xmlns:g2="null"
   <g:inline template="reporting_includes.xml" />
   <g:inline template="list2_js_includes.xml" />
   <div id="report_stuff" />
   <script>
      var div = $j("#report_stuff");
      embedReportById(div, <"report sys_id">);
   </script>
</j:jelly>
```

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetSpan</td>
<td>The jQuery element to embed the chart in. The chart uses the size of this element.</td>
</tr>
<tr>
<td>reportId</td>
<td>The sys_id of the report you want to embed.</td>
</tr>
</tbody>
</table>

### Embedded report parameters

When embedding a report in a Jelly element, you can define a report at any time by passing parameters.

### Common parameters

Certain parameters are used by multiple report types.
### Common parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>jvar_report_id</td>
<td>The sys_id of a report record. If you pass this parameter, do not specify any other parameters. All values are taken from the report record.</td>
<td></td>
</tr>
<tr>
<td>sysparm_report_id</td>
<td>Use this parameter instead of jvar_report_id when you want to override any of the other sysparm parameters that exist in the report.</td>
<td></td>
</tr>
<tr>
<td>sysparm_title</td>
<td>The title of the report.</td>
<td></td>
</tr>
<tr>
<td>sysparm_table</td>
<td>The table to report on. Specify this value or sysparm_report_source_id, but not both.</td>
<td></td>
</tr>
<tr>
<td>sysparm_report_source_id</td>
<td>The sys_id of a report source. Specify this value or sysparm_table, but not both. This value is used instead of sysparm_table if you pass both.</td>
<td></td>
</tr>
<tr>
<td>sysparm_type</td>
<td>The type of report to create.</td>
<td>line</td>
</tr>
<tr>
<td></td>
<td>Possible values: list, line, line_bar, area, spline, bar, horizontal_bar, pareto, hist, pie, donut, semi_donut, speedometer, dial, pivot, pivot_v2, funnel, calendar, pyramid, box, trend, control, trendbox, and heat map.</td>
<td></td>
</tr>
<tr>
<td>sysparm_field</td>
<td>The field from the specified table to group data by. Required for time series, column, bar, pie, donut, funnel, pyramid, box, trend, and trendbox reports. Optional for list reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_query</td>
<td>The filter to apply to the data before generating the report. Specify a query string for this value. To sort your query results by a specific field, add ^ORDERBY&lt;field_name&gt; or ^ORDERBYDES&lt;field_name&gt; to the end of the query string. ORDERBY sorts the query by</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>asc</td>
<td>ascending order. ORDERBYDESC sorts the query by descending order.</td>
<td></td>
</tr>
<tr>
<td>sysparm_aggregate</td>
<td>The aggregation type. Possible values: AVG, COUNT, SUM, and COUNT_DISTINCT.</td>
<td>COUNT</td>
</tr>
<tr>
<td>sysparm_sumfield</td>
<td>The field to aggregate data on. This parameter does not apply when using a COUNT aggregation type.</td>
<td></td>
</tr>
<tr>
<td>sysparm_display_grid</td>
<td>A true/false value that controls whether the report displays a data grid.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_show_other</td>
<td>A true/false value that controls whether the Other group appears on the report. This group appears only if the number of groups exceeds the number specified in the sysparm_others parameter. This parameter applies to bar, pie, funnel, pyramid, pivot, and heat map reports.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_others</td>
<td>The maximum number of individual groups of data to display. Any additional data groups are combined into the Other group. This parameter applies to bar, pie, funnel, pyramid, pivot, and heat map reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_source_type</td>
<td>The source of the embedded report. Optional. Possible values: table, metricbase, source, import</td>
<td>table</td>
</tr>
<tr>
<td>sysparm_set_color</td>
<td>The color setting for the report. Possible values: one_color, color_palette, several_colors</td>
<td>color_palette</td>
</tr>
<tr>
<td>sysparm_color_palette</td>
<td>The color palette that the report uses. This parameter is used when sysparm_set_color=&quot;color_palette&quot;.</td>
<td>UI14</td>
</tr>
</tbody>
</table>
### Common parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_color</td>
<td>The color that the report uses. This parameter is used when sysparm_set_color=&quot;one_color&quot;. Possible value: The sys_id of a color palette</td>
<td></td>
</tr>
<tr>
<td>sysparm_chart_colors</td>
<td>The set of chart colors that the report uses. This parameter is used when sysparm_set_color=&quot;several_colors&quot;. Possible value: A comma-separated list of color hex codes</td>
<td></td>
</tr>
<tr>
<td>sysparm_show_marker</td>
<td>A marker is the value represented by a dot in a line or another graphic element in a chart. This parameter is a true/false value that controls whether the marker appears.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_show_empty</td>
<td>A true/false value that controls if records with empty grouping or trend values appear on the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_stack_field</td>
<td>The field used to control stacking on bar and column reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_bar_unstack</td>
<td>A true/false value that controls if stacked data is presented as a single bar or column, or as multiple bars.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_box_field</td>
<td>The numeric field used to measure the data. This parameter is required for box and histogram reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_trend_field</td>
<td>The date-time field used to organize trend data. This parameter is required for time series, trend, and box reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_trend_interval</td>
<td>The interval to measure trend values by. Possible values: year, quarter, month, week, dayofweek, hour, and date.</td>
<td>year</td>
</tr>
</tbody>
</table>
### Common parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_compute_percent</td>
<td>The value to use when displaying report percentages. You can display percentages based on the total record count, or by the specified aggregate. Possible values: aggregate and count</td>
<td>count</td>
</tr>
<tr>
<td>sysparm_funnel_neck_percent</td>
<td>A number 1–100 that defines the percentage of a funnel report that is the neck of the funnel.</td>
<td>30</td>
</tr>
<tr>
<td>sysparm_show_chart_data_label</td>
<td>A true/false value that controls if data labels appear on the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_show_zero</td>
<td>A true/false value that controls if zeroes appear on multilevel pivot and heat map reports.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_ct_row</td>
<td>The field used to define the rows in heat map and bubble reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_ct_column</td>
<td>The field used to define the columns in heat map and bubble reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_y_axis_category_fields</td>
<td>The field used to define the rows in multilevel pivot reports. Specify up to five comma-separated field names.</td>
<td></td>
</tr>
<tr>
<td>sysparm_x_axis_category_fields</td>
<td>The field used to define the columns in multilevel pivot reports. Specify up to three comma-separated field names.</td>
<td></td>
</tr>
<tr>
<td>sysparm_list_ui_view</td>
<td>The sys_id of a list view to use when a user drills into the report.</td>
<td></td>
</tr>
<tr>
<td>sysparm_show Marker</td>
<td>A true/false value that controls if markers appear at every plotted point on a report.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_apply_alias</td>
<td>A true/false value that controls if configured aliases appear in embedded reports.</td>
<td></td>
</tr>
</tbody>
</table>
Service catalog parameters
Certain parameters apply only to reports created on service catalog tables, such as the Requested Item [sc_req_item] table. These parameters are not available on list or calendar type reports.

Service catalog report parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_sc_groupby_item_id</td>
<td>The sys_id of a catalog item. Use this parameter with the sysparm_sc_groupby_variable_id parameter to group a service catalog report based on a catalog variable value. These parameters replace the sysparm_field parameter when grouping on service catalog variables.</td>
</tr>
<tr>
<td>sysparm_sc_groupby_variable_id</td>
<td>The sys_id of the catalog item variable used to determine how data is grouped on the report. This variable must belong to the catalog item specified in the sysparm_sc_groupby_item_id parameter.</td>
</tr>
<tr>
<td>sysparm_sc_stackby_item_id</td>
<td>The sys_id of a catalog item. Use this parameter with the sysparm_sc_stackby_variable_id parameter to stack a service catalog report based on a catalog variable value. These parameters replace the sysparm_stack_field parameter when grouping on service catalog variables. Only reports that support stacking, such as bar reports, support these parameters.</td>
</tr>
<tr>
<td>sysparm_sc_stackby_variable_id</td>
<td>The sys_id of the catalog item variable used to determine how data is grouped on the report. This variable must belong to the catalog item specified in the sysparm_sc_stackby_item_id parameter.</td>
</tr>
</tbody>
</table>

MetricBase parameters
To use MetricBase in an embedded report, the sysparm_source_type parameter must be set to "metricbase".

MetricBase also requires the sysparm_custom_configuration parameter, which has the following syntax:
sysparm_custom_config:
"{query_condition:"\"",transforms:[{transform:{transform:"Reference\",name:"chart-subjects\"},metric:"mb_metricname\"}], group_by:"\", table:"mb_tablename\"}";

In this syntax:

- A **transform** is a chain of nested transform functions. The last transform of every chain must always be the Reference transform:

```
{transform:"Reference\",name:"chart-subjects\"}
```

- A **metric** is a metric field of a metric table.
- The **group-by** field is the field on the selected metric table by which the time series is grouped.
- **table** refers to the metric table
- **mb_...** are placeholder names

All attributes are required except for **group-by**.

**Chart-specific parameters**

Certain parameters are available only for specific report types.

### Donut report parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_show_chart_total</td>
<td>A true/false value that controls if the total score of the grouped donut appears in the center of the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_donut_width_percent</td>
<td>An integer 1–100 that controls the thickness of the donut report.</td>
<td>50</td>
</tr>
</tbody>
</table>

### Heatmap parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_use_color_heatmap</td>
<td>A true/false value that controls if the heatmap uses a gradient to color the report. When true, the sysparm_axis_max_color and sysparm_axis_min_color values are used.</td>
<td>true</td>
</tr>
</tbody>
</table>
Heatmap parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_axis_max_color</td>
<td>The color used in the heatmap gradient to indicate a high value. This value must be the sys_id of a Color Definition [sys_report_color] record.</td>
<td>UI14 blue</td>
</tr>
<tr>
<td>sysparm_axis_min_color</td>
<td>The color used in the heatmap gradient to indicate a low value. This value must be the sys_id of a Color Definition [sys_report_color] record.</td>
<td>white</td>
</tr>
</tbody>
</table>

Dial parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_gauge_autoscale</td>
<td>A true/false value that controls if the dial automatically calculates the minimum and maximum scale on the report. If you set this value to false, you must specify a sysparm_from and sysparm_to value.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_from</td>
<td>A number that defines the minimum value for the axis scale.</td>
<td></td>
</tr>
<tr>
<td>sysparm_to</td>
<td>A number that defines the maximum value for the axis scale.</td>
<td></td>
</tr>
<tr>
<td>sysparm_upper_limit</td>
<td>A number that defines the upper threshold for the dial. If you do not specify a value, the dial has no upper threshold.</td>
<td></td>
</tr>
<tr>
<td>sysparm_lower_limit</td>
<td>A number that defines the lower threshold for the dial. If you do not specify a value, the dial has no lower threshold.</td>
<td></td>
</tr>
<tr>
<td>sysparm_direction</td>
<td>A value that controls which values are considered positive on the report, lower values or higher values. Possible values: minimize and maximize.</td>
<td>minimize</td>
</tr>
</tbody>
</table>
Chart size parameters
Certain parameters control the width and height of the report.

Size parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_chart_size</td>
<td>The size of the chart in the report. Valid values are small, medium, and large.</td>
<td>large</td>
</tr>
<tr>
<td>sysparm_custom_chart_size</td>
<td>Enable this parameter to specify custom chart height and width values instead of using a size option from the sysparm_chart_size parameter.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_custom_chart_height</td>
<td>The height of the chart in the report, in pixels.</td>
<td></td>
</tr>
<tr>
<td>sysparm_custom_chart_width</td>
<td>The width of the chart in the report, in pixels.</td>
<td></td>
</tr>
</tbody>
</table>

Chart title parameters
Certain parameters are available only for reports that display a title. These report types include time series, bar, column, pie, donut, dials, trend, box, trend box, histogram, pyramid, heat map, funnel, and control reports.

Title parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_report_title_size</td>
<td>A number that defines the font size of the title.</td>
<td>16</td>
</tr>
<tr>
<td>sysparm_report_title_color</td>
<td>The title text color. This value must be the sys_id of a Color Definition [sys_report_color] record.</td>
<td>black</td>
</tr>
<tr>
<td>sysparm_title_horizontal_alignment</td>
<td>Where the title is placed horizontally relative to the report. This value is used only if sysparm_custom_report_title_position is false. Possible values are: left, center, and right.</td>
<td>center</td>
</tr>
</tbody>
</table>
### Title parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_title_vertical_alignment</td>
<td>Where the title is placed vertically relative to the report. This value is used only if sysparm_custom_report_title_position is false. Possible values: top, middle, and bottom.</td>
<td>top</td>
</tr>
<tr>
<td>sysparm_custom_report_title_position</td>
<td>A true/false value that controls whether the x and y coordinates define the report title position instead of relative alignment.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_report_title_x_position</td>
<td>A number that defines the x position of the title on the report. This value is used only if sysparm_custom_report_title_position is true.</td>
<td>0</td>
</tr>
<tr>
<td>sysparm_report_title_y_position</td>
<td>A number that defines the y position of the title on the report. This value is used only if sysparm_custom_report_title_position is true.</td>
<td>0</td>
</tr>
</tbody>
</table>

### Chart border parameters

Certain parameters are available only for reports that display a border. These report types include: time series, bar, column, pies, donuts, dials, trend, box, trend box, histogram, pyramid, heat map, funnel, and control reports.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_show_report_border</td>
<td>A true/false value that controls whether the report displays a border.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_report_border_width</td>
<td>A number that defines the width of the border, in pixels.</td>
<td>1</td>
</tr>
</tbody>
</table>
### Border parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_report_border_radius</td>
<td>A number that defines the radius size of the corners of the border, in pixels.</td>
<td>0</td>
</tr>
</tbody>
</table>

### Legend parameters

Certain parameters are available only for reports that display a legend. These report types include pie, donut, stacked bar, stacked column, time series, trend, box, histogram, pyramid, control, and heat map reports.

#### Legend parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_show_legend</td>
<td>A true/false value that controls whether the report displays a legend.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_legend_horizontal_alignment</td>
<td>Where the legend is placed horizontally relative to the report. Possible values: left, center, and right.</td>
<td>center</td>
</tr>
<tr>
<td>sysparm_legend_vertical_alignment</td>
<td>Where the legend is placed vertically relative to the report. Possible values: top, middle, and bottom.</td>
<td>bottom</td>
</tr>
<tr>
<td>sysparm_show_legend_border</td>
<td>A true/false value that controls whether the legend displays a border.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_legend_border_width</td>
<td>A number that defines the width of the legend border, in pixels.</td>
<td>1</td>
</tr>
<tr>
<td>sysparm_legend_border_radius</td>
<td>A number that defines the radius size of the corners of the legend border, in pixels.</td>
<td>0</td>
</tr>
</tbody>
</table>

### X-axis parameters

Certain parameters are available only for reports that use an X axis. These report types include bar, horizontal bar, pareto, column, line area, spline, box, trendbox, control, and trend reports.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### X-axis parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_x_axis_title</td>
<td>The name to display on the x axis.</td>
<td></td>
</tr>
<tr>
<td>sysparm_x_axis_title_size</td>
<td>A number that defines the font size of the x-axis title.</td>
<td></td>
</tr>
<tr>
<td>sysparm_x_axis_title_bold</td>
<td>A true/false value that controls whether the x-axis title text is bold.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_x_axis_opposite</td>
<td>A true/false value that controls if the x axis appears at the top of the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_x_axis_display_grid</td>
<td>A true/false value that controls if vertical grid lines appear from the x axis.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_x_axis_grid_dotted</td>
<td>A true/false value that controls whether the vertical grid lines are dotted.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_x_axis_label_size</td>
<td>A number that defines the font size for increment labels on the x axis.</td>
<td>11</td>
</tr>
<tr>
<td>sysparm_x_axis_label_bold</td>
<td>A true/false value that controls whether the x-axis increment labels are bold.</td>
<td>false</td>
</tr>
</tbody>
</table>

### Y-axis parameters

Certain parameters are available only for reports that use a Y axis. These report types include bar, horizontal bar, Pareto, column, line area, spline, box, trendbox, control, and trend reports.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_y_axis_title</td>
<td>The name to display on the y axis.</td>
<td>An automatically generated description of the report aggregation</td>
</tr>
<tr>
<td>sysparm_y_axis_title_size</td>
<td>A number that defines the font size of the y-axis title.</td>
<td></td>
</tr>
<tr>
<td>sysparm_y_axis_title_bold</td>
<td>A true/false value that controls whether the y-axis title text is bold.</td>
<td>true</td>
</tr>
</tbody>
</table>
Y-axis parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_y_axis_opposite</td>
<td>A true/false value that controls if the y axis appears on the left of the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_y_axis_display_grid</td>
<td>A true/false value that controls if horizontal grid lines appear from the y axis.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_y_axis_grid_dotted</td>
<td>A true/false value that controls whether the horizontal grid lines are dotted.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_y_axis_label_size</td>
<td>A number that defines the font size for increment labels on the y axis.</td>
<td>12</td>
</tr>
<tr>
<td>sysparm_y_axis_label_bold</td>
<td>A true/false value that controls whether the y-axis increment labels are bold.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_y_axis_from</td>
<td>A number defining the lowest value displayed on the y axis.</td>
<td></td>
</tr>
<tr>
<td>sysparm_y_axis_to</td>
<td>A number defining the highest value displayed on the y axis.</td>
<td></td>
</tr>
</tbody>
</table>

Report on extended tables

Learn how to include fields from tables that extend the Task table in a single report. For example, you could include both incidents and problems in a single report.

Before you begin

To include the columns in the report that are unique to the extended tables, a user with the admin role must enable a system property [glide.ui.list.allow_extended_fields]:

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
1. Navigate to System Properties > UI Properties.

2. Enable the property Allow base table lists (task, cmdb_ci, and so on) to include extended table fields (incident_state, os_version, etc.), and allow filtering on extended table fields (glide.ui.list.allow_extended_fields).

3. Click Save at the bottom of the page.

About this task
Role required: report_admin
Watch this six-minute video to learn how to include fields on extended tables in reports by starting with the parent table.

How to include fields on extended tables—which are not available through dot-walking—in reports.

The video shows how to create a report with data from multiple tables using the Report Designer. The report contains both incidents and problems, which are child tables of the Task table. Here’s how to create the report, Active Incidents and Problems of Priority 1 or 2.

Procedure
1. Navigate to Reports > Create New.

2. On the Data tab, name the report Active Incidents and Problems of Priority 1 or 2, select the Source type Table, and select the table Task [task].

   ![Edit report](image)

   - Report name
     - Active Incidents and Problems of Priority 1 or 2
   - Source type
     - Table
   - Table
     - Task [task]

3. On the Type tab, enter List in the filter, select the report type, and click Next.
The application shows a preliminary version of the report. To view the updated report at any time, click Run.

4. On the Configure tab, Group by Task type and click Save.
   The list report is refreshed with all tasks collapsed into their types.

5. Use the Condition Builder to limit what the report displays to only the information you want. Click the filter icon (🔍) to open the Condition Builder.

6. To show only active incidents and problems of priority 1 or 2, set these conditions, and click Save.
   - Active is true.
   - Task type is Incident OR Task type is Problem.
   - Priority is one of 1 - Critical or 2 - High.
The new report only has the two task types. Because you selected only Active tasks, there are fewer tasks in each category as well.

7. Select the columns to display in the report, including the extended table fields Category [Incident] and Related Incidents [Problem] and click Save.
The Category [Incident] and Related Incidents [Problem] fields are unique to the extended tables (Incident and Problem). They appear at the bottom of the list of columns that are available from the Task table. These two fields are available because you enabled the property `Allow base table lists to include extended table fields, and allow filtering on extended table fields` (glide.ui.list.allow_extended_fields).

The report shows the open incidents and their categories and the open problems with the number of their related incidents.

**Related tables in reporting**

Watch the video to learn how to use dot-walking, dynamic filters, and database views to access data on extended, or related, tables.

Watch this five-minute video to learn how to use dot-walking to include data from extended or related tables in reports. The video also discusses using dynamic filters in reports and reporting on database views. How to use dot-walking and database views to include data from extended, or related, tables in reports.
Reporting on extended table fields using dot-walking

Dot-walking provides access to fields on extended, or related, tables, enabling you to report on fields from those tables.

When creating or editing a report, you can access references on extended tables from the Group by/Stack by, column/row, or Trend by fields on the Configure tab. The Add Sort option also enables you to configure the sort order of applicable reference fields on extended tables. Tables that reference other tables are denoted with an arrow (ières) icon.

Dot-walking references a field by building a chain of field names separated by dots (periods). For instance, `incident.assigned_to.company` references the company of the user assigned to an incident. The recommended limit for chain length is three levels.

Related information

Dot-walking examples

FX Currency values in reporting

Manage projects in multiple currencies with FX (Foreign Exchange) Currency. You can report on the projects in currency values entered by the user, a reference currency, or both.

⚠️ Note: You don’t have to install a plugin to use FX Currency functionality. It’s activated by default.

FX Currency functionality is described in detail in Currency administration. In the context of reporting, it is important to aggregate on the reference currency which the other currencies are converted to.

⚠️ Note: When there are multiple currencies, calculations may not be possible. Change your aggregation source or filter conditions to show the report.

When you aggregate by Average or Sum on an FX currency field, you choose the Aggregation Source.

Use FX currency configuration

Calculates the values based on the FX Currency Configuration table. For more information, see Setting up and operating FX Currency fields.

As entered values

Calculate values based on currency values entered by the user.
Note: If you select this option, you may experience situations where amounts entered in different currencies can't be properly aggregated. For example, if there are currency amounts in US Dollars, Yen, and Euros. It is only possible to aggregate values on one currency at a time. If you aggregate records in different currencies, this error displays: 'Cannot generate the report. There are mismatched currency codes.' See Mismatched currency example.

Reference values
Calculates the values based on the reference currency.

Report on FX currency fields
When you report on FX Currency fields, there are certain limitations that may generate errors. These errors are associated with aggregation.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, name the report, choose the source table with FX currency fields, and then click Next.
   The source must have FX Currency fields. See Setting up and operating FX Currency fields.
3. On the Type tab, choose the visualization type that you want to use. See Creating reports.
4. On the Configure tab, choose how you want to group, stack, and aggregate the report.
   It is only possible to aggregate values on one currency at a time. If you aggregate records in different currencies on an FX Currency field, this error displays: "Cannot generate the report. There are mismatched currency codes."

Mismatched currency example
When you report on FX Currency tables, some combinations of group and aggregation type are not possible to calculate. These combinations return the message 'Cannot generate the report. There are mismatched currency codes. Change your aggregation source or filter conditions.'
The source of this report has costs in euros, Japanese yen, and British pounds. This visualization aggregates costs by count distinct, meaning that each individual value gets its own segment.

When you try to aggregate costs in multiple currencies by sum or average, there are several possible outcomes.

**Aggregation Source is Use FX Currency configuration**

It is not possible to perform the calculation, because the currencies are mismatched.

**Aggregation Source is As entered values**

Usually the entered values are in multiple currencies as well and it is not possible to perform the calculation.

**Aggregation Source is Reference values**

In this case, the values are converted to the reference value before calculation and the report is generated. For more information, see [Understanding FX Currency values in forms](#).

**Report on service catalog variables**

Create reports grouped by a variable on a selected service catalog item. You can also create filters on the same variable.

Reporting on variables can be helpful in determining if certain catalog items are useful on an instance, for example.
Additionally, you can create filters on the same variable. For example, if a specific mobile phone item has a storage variable, you can create a report that only shows those phones with 32 GB of storage.

See an overview video on dot-walking to, filtering, and using catalog variables in a database view at: Reporting on Catalog Variables.

• To group by variables, see Group a report by service catalog variables.
• To group a report on a field and also group by a variable, see Add additional group by variables to a service catalog report.
• To add a variable field to a list report, see Create a list report with variable columns.

For a record producer, you can specify filters on questions while creating a report so that the records are filtered based on the set conditions. The following types of questions are not displayed in the condition builder:

• Label
• Rich text label
• Macro
• Container

For reporting on variable questions, see: Report on questions

Use service catalog variables in a report

In reports on service catalog data, stack and group by variables, use variables as columns in list reports, and as columns and rows in multilevel pivot tables.

Before you begin

Role required: itil, report_user, report_global for global reports, or report_group for group reports.

Users with the report_admin role can report on service catalog variables. Add the report_admin role to the ACLs for the Options [sc_item_option], Variable Ownership [sc_item_option_mtom], and Variables [item_option_new] tables.
Note:

- The report you want to use the variable for must be based on the Requested Items table [sc_req_item] or the Catalog Task table [sc_task]. Using other types of variables causes an error when generating the report.

- The Oracle Database CLOB field does not have the functionality to retrieve the variables data in reports. For a column string field of less than 4000 bytes, you can change the column type to varchar2. To compare the CLOB columns of a smaller size, use the to_char() function. For a larger size CLOB, you must get a substring for comparison using the dbms_lob.substr functions.

About this task

For primary Group by and Stack by, these steps are intuitive.

Note: List, Box, Trendbox, and Pivot reports cannot use service catalog variables as a primary or secondary Group by. Single Score, Calendar, Control, and Map reports do not support Group by on any fields. List reports can use service catalog variables as columns.
Use a variable as an additional **Group by**, as a column in a list report, or as a column or row in a multilevel pivot table.

**Procedure**

1. Navigate to **Reports > View / Create** and open the report to add the variable to.
2. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add as a column in a list report</td>
<td>On the <strong>Configure</strong> tab, move <strong>Variables+</strong> to the <strong>Selected</strong> column.</td>
</tr>
<tr>
<td>Add as an additional Group by</td>
<td>On the <strong>Configure</strong> tab, click <strong>Additional group by</strong>, then move <strong>Variables+</strong> at the bottom of the <strong>Selected</strong> of the <strong>Additional group by</strong> list.</td>
</tr>
<tr>
<td>As as a column or row in a multilevel pivot table</td>
<td>Click <strong>Select columns</strong> or <strong>Select rows</strong>, then select <strong>Variables+</strong> at the bottom of the list.</td>
</tr>
</tbody>
</table>

3. Click the structure icon () and then the plus sign that appears. A list of service catalog items appears.
4. Select a catalog item with the variable. The variables for that item appear in the **Available** list.
5. Move the variable that you want to use to the **Selected** column.
6. **Save** the report.

**Group a report by service catalog variables**

You can create reports grouped by variable on a selected service catalog item. In addition you can create filters on the same variable. For example, if a specific mobile phone item has a storage variable, you can create a report that only shows those phones with 32 GB of storage.

**Before you begin**

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
About this task
You can apply these steps to any report type as long as the report source has variables associated with it. If the report source does not have variables, the Variables option does not display in the Group by and Stack by fields.

Note: List, Box, Trendbox, and Pivot reports cannot use service catalog variables as a primary or secondary Group by. Single Score, Calendar, Control, and Map reports do not support Group by on any fields. List reports can use service catalog variables as columns.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has variables associated with it. There are two kinds of report sources:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the Type tab, select the report type and click Next.
6. On the Configure tab, select Variables from the Group by or Stack by filters.
7. Search for and select the variable associated with the item to group or stack by.

8. Continue to configure and style the report according to its report type. See Creating reports.

Add additional group by variables to a service catalog report

You can create reports grouped by any field with an additional group by variable on a selected service catalog item. In addition you can create filters on the same variable. For example, if a specific mobile phone item has a storage variable, you can create a report that only shows those phones with 32 GB of storage.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
About this task
You can apply these steps to any report type as long as the report source has variables associated with it. If the report source does not have variables, the Variables option does not display in the Additional group by filter.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has variables associated with it. There are two kinds of report sources:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the Type tab, select the report type and click Next.
6. On the Configure tab, select a Group by filter.
7. Click Additional group by.
8. Select Variables [+] and click the structure icon (◸◹◸◹◹) to choose an item.
9. Select a **Catalog item**.
The variables associated with the item appear in the **Additional group by** window.

10. Add the desired variables to the **Selected** column and click **OK**.
11. Continue to configure and style the report according to its report type. See [Report on function fields](#).

**Report on function fields**

While regular fields store a value in the database, a function field displays the results of a database query. The function field generates the value based on computations of other fields and constants. You can use these fields in reports as you would other fields.

The responsibility for creating, editing, and deactivating function fields belongs to the user with the role function_field_admin. On upgrade, no user has this role. An admin must give this role to a non-admin user. See [Create a role](#).

Learn about function fields here: [Function field](#).

**Function field operations**

Function fields can perform the following operations using the `glidefunction:<operation>` syntax.
Note: Specify constants in single or double quotes. The examples for the `concat()`, `dayofweek()`, `position()`, and `substring()` operations show the use of constants in function fields.

Function field operations

The Function field operations table contains columns for the names of function field operations, a detailed description of what the operation does, and an example that includes both code and what the code returns.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>add()</code></td>
<td>Takes two number fields as input, adds them, and returns the results as a field value. This function also takes numerical values for either input. Place numerical values in single or double quotation marks.</td>
<td><code>glidefunction:add(child_incidents, parent_incident)</code> Returns 6 if the incident has five child incidents and one parent incident. Possible return types: Decimal, Floating Point Number, Large Whole Number, Whole Number</td>
</tr>
<tr>
<td><code>subtract()</code></td>
<td>Takes two number fields as input, subtracts the second from the first, and returns the result as a field value. This function also takes numerical values for either input. Place numerical values in single or double quotation marks.</td>
<td><code>glidefunction:subtract(u_num1, u_num2)</code> Returns 2 if num1 = 8 and num_2 = 6. Possible return types: Decimal, Floating Point Number, Large Whole Number, Whole Number</td>
</tr>
<tr>
<td><code>multiply()</code></td>
<td>Takes two number fields as input, performs the multiplication, and returns the results as a field value. This function also takes numerical values for either input. Place numerical values in single or double quotation marks.</td>
<td><code>glidefunction:multiply(u_num1, u_num2)</code> Returns 48 if num1 = 8 and num_2 = 6. Possible return types: Decimal, Floating Point Number, Large Whole Number, Whole Number</td>
</tr>
<tr>
<td><code>divide()</code></td>
<td>Takes two number fields as input, divides the first by the second, and returns the result as a field value.</td>
<td><code>glidefunction:divide(u_num2,u_num1)</code></td>
</tr>
</tbody>
</table>
Function field operations

The function field operations table contains columns for the names of function field operations, a detailed description of what the operation does, and an example that includes both code and what the code returns.

(continued)

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>concat()</td>
<td>Takes any number of comma-separated fields and constants as input, concatenates the input, and returns a single string as a field value.</td>
<td>glidefunction:concat(incident_number, '/', short_description) Returns &quot;INC0001 / My client needs a new laptop.&quot; if the value of the number field is 'INC0001' and the short_description is 'My client needs a new laptop'. Return type: Text</td>
</tr>
<tr>
<td>datediff()</td>
<td>Takes two date/time fields as input, calculates the difference between the dates in days, minutes, and seconds, and returns the results as a duration field value.</td>
<td>glidefunction:datediff(closed_at, sys_created_on) Returns the duration of an incident from the creation date to the close date. Example result: 10 days, 8 hours 23 minutes 11 seconds Return type: Duration</td>
</tr>
<tr>
<td>dayofweek()</td>
<td>Takes two arguments: A date field and a constant of either '1' (week starts on Sunday) or '2' (week starts on Monday). Returns the results as an integer value that represents the day of the week.</td>
<td>glidefunction:dayofweek(resolved_at, '1') If resolved_at occurs on a Wednesday, returns 4 if the integer is 1 and</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Function field operations

The Function field operations table contains columns for the names of function field operations, a detailed description of what the operation does, and an example that includes both code and what the code returns.

(continued)

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>length()</td>
<td>Takes a string field as input, calculates the field length in characters, and returns the results as a field value.</td>
<td>glidefunction:length(短描述)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Returns 37 if short_description = &quot;This application is performing a test&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Return type: Whole number</td>
</tr>
<tr>
<td></td>
<td>Note: This function is not available for Kagami.</td>
<td></td>
</tr>
<tr>
<td>coalesce()</td>
<td>Takes any number of comma-separated fields as input and returns the first non-empty value.</td>
<td>glidefunction:coalesce(关闭时间,已解决时间,sys_更新时间)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the value of closed_at is empty, the function returns the value of resolved_at. If the value of resolved_at is also empty, the function returns the value of sys_更新时间。</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Return type: Text</td>
</tr>
<tr>
<td>position()</td>
<td>Takes two text fields or two text fields and a whole number as input. One or both of the text fields can also be strings.</td>
<td>1. glidefunction:position('e',短描述)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the value of the short_description field is &quot;This computer&quot;</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Function field operations**

The Function field operations table contains columns for the names of function field operations, a detailed description of what the operation does, and an example that includes both code and what the code returns.

(continued)

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Returns the position of the first occurrence of the string of the first</td>
<td><code>glidefunction:position('e',short_description,'14')</code> returns 12.</td>
</tr>
<tr>
<td></td>
<td>text field in the second.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. If the whole number is specified, returns the position of the second</td>
<td><code>glidefunction:position('e',short_description,'14')</code> returns 19.</td>
</tr>
<tr>
<td></td>
<td>text field after the position of the whole number.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Returns 0 if the first text field is not present in the second (after the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>position of the whole number if specified).</td>
<td></td>
</tr>
<tr>
<td><code>substring()</code></td>
<td>Takes a text field and two whole numbers as input. Returns the first</td>
<td><code>glidefunction:substring(short_description, '7', '2')</code> returns 'go'.</td>
</tr>
<tr>
<td></td>
<td>instance of a string that starts at the position of the first whole number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and is the length of the second.</td>
<td></td>
</tr>
</tbody>
</table>

**Configure function fields**

You can configure up to 20 active function fields per table for use in reporting using the Report Designer. When you configure a function field on a table, you can group or stack by the results of the function calculation.

**Before you begin**

Role required: admin, function_field_admin

Limitations:

- Function fields in reporting do not support dot walking.
- Database views do not support function fields.
• Security is evaluated on the components of the function and on the calculated value of the field. When used in visualizations, sections that contain information that the user is not allowed to see are hidden from the user.

• Only the creator of a function field or a platform admin can edit or deactivate that field. Platform admins can deactivate any function field.

• Datediff is not supported in the Kagami database.

• Field function names must be unique.

• Only 20 function fields can be active on a table at any one time. To add function fields, you must deactivate others. See Deactivate a function field.

Create a function field
Create a function field to be able to group and stack a report by the results of the field's calculation.

Before you begin
Role required: admin, function_field_admin

Each function field requires a label, a return type, and a definition. The definition consists of the operation and one or more fields that the operation is performed on.

⚠️ Note: It is not possible to change the label or the return type after you save a function field. If necessary, deactivate the function field and start again.

Procedure
1. Navigate to Reports > Create New.
2. Select the report you want to add a function field to.
   When you configure a function field on a table, it is available anywhere you use the table on the Now Platform, including any report on the same table. For example, a function field that calculates the age of open incidents is available for all reports on the incident table.
3. Open the Configure tab and click Configure function field.
4. Optional: Enter the field name in the search bar to see if someone has already created the function field. Point to the search results to see the function definition.
5. Click Create.
   There can be a maximum of 20 active function fields on the table the report is based on. If the table already has 20 function fields, a creator of one of the fields or a platform_admin must deactivate or delete one.
6. Specify the **Label**. The label is the name users can see when they group or stack data in a report.

7. Select the **Return type**.
The return type is the kind of information the function produces. For example, the `datediff()` function returns a Duration type because it calculates the duration between two dates.

   **Note**: You do not see a message if your return type is not a logical result of the function.

8. Select the Operation.
The **Syntax** text box shows the name of the function preceded by `glidefunction:`.

9. Select the fields the function operates on. Some functions require only one field; some require two or three fields. See [Report on function fields](#). Make sure that you separate the fields with commas.

10. When the syntax is correct, you can save the function field.
When the syntax is incorrect, you see the message: Syntax error: Invalid expression. You may also see other messages.

Results
Configured function fields appear in the Group by and Additional group by lists after you save the report.

Use the created function field it in your report configuration. For information on using function fields elsewhere on the Now Platform, see Function field.

Edit a function field
The user who created a function field or a user with the platform_admin role can edit the definition of a saved function field. It is not possible to edit the label or the return type of a saved function field.

Before you begin
Role required: admin, function_field_admin
Procedure
1. Navigate to Reports > Create New.
2. Select a report based on the table you want to add a function field to.
   When you configure a function field, it is available in any report on the same table. For example, a function field that calculates how long incidents have been open is available for all reports on the incident table.
3. Open the Configure tab and Click Configure function field.
4. Optional: Enter text in the Search functions box to find the function field you want to edit. Search functionality searches on the Label of the field, the name of the field, and the function definition.
5. Select a new operation, new fields the function operates on, or both. Validation of the edited function may indicate that it returns an invalid result.
6. Click Save.
   If one or more reports use the function field, you see a link to a list of those reports. You can review the list, click Save anyway, or click Cancel.

Results
The results of the edited function field replace the old results in all reports in which the function field is used.

Deactivate a function field
The user who created a function field or a user with the platform_admin role can deactivate it. If there are more than 20 function fields on a table, you cannot create a new function field without deactivating one or more existing ones.

Before you begin
Role required: admin, function_field_admin

Procedure
1. Navigate to Reports > Create New.
2. Select the report with the function field to deactivate.
3. Open the Configure tab and Click Configure function field.
4. Optional: Enter text in the Search functions box to find the function field you want to deactivate.
5. Select the function field and click Deactivate.
   If one or more reports use the function field, you see a link to a list of those reports. You can review the list, click Deactivate anyway, or click Cancel.
6. Confirm the deactivation or cancel.
Results
The deactivated function field is no longer available for use in the reports on the table it was based on.

Report on questions
Report on selected questions by grouping or filtering on them.
Creating reports grouped by questions is helpful to:
• Determine whether questions that customers ask are getting answered.
• Gain more information from customers during the request process.

Report on questions using report types which support these fields:
• Group by
• Stack by
• Additional group by
• Select columns
• Select rows

⚠️ Note:
• The report for which you want to use questions must report on a data source or non-service catalog table which has questions associated with it. You can report on questions from a record producer table [sc_cat_item_producer], or a table extended from the Task [task] table, for example the [incident] or [problem] tables. For more information on record producer, see Record Producer

You can also filter on questions using the condition builder.

Group or stack a report by questions
You can create reports grouped or stacked by questions, as well as create filters on the same questions. For example, you can create a report that shows customer responses of their reasons for requesting help, or descriptions of their issues.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
About this task
You can apply these steps to any report type as long as the report source has questions associated with it. If the report source does not have questions, the Questions option does not display in the Group by and Stack by fields.

Note: List, Box, Trendbox, and Pivot reports cannot use questions as a primary or secondary Group by. Single Score, Calendar, Control, Histogram, and Map reports do not support Group by on any fields. List reports can use questions as columns. Multilevel Pivot reports can use questions as columns and rows.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has questions associated with it and click Next.
4. On the Type tab, select the report type and click Next.
5. On the Configure tab, select Questions from the Group by or Stack by filters.

6. Search for and select questions associated with the category to group or stack by.
7. Continue to configure and style the report according to its report type. See Creating reports.
Add additional group by questions to a report

Create reports additionally grouped by selected questions. You can also create filters on the same questions. For example, you can create a report that shows customer responses of their reasons for requesting help, or descriptions of their issues.

Before you begin
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

About this task
You can apply these steps to any report type as long as the report source has questions associated with it. If the report source does not have questions, the Questions option does not display in the Additional group by filter.

Procedure
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has questions associated with it and click Next.
4. On the Type tab, select the report type and click Next.
5. On the Configure tab, select a Group by filter.
6. Click Additional group by.
7. Select Questions [+] and click the structure icon (▲▼) to choose an item.
8. Select a question category.
The variable questions associated with the category appear in the Additional group by window.

9. Add the desired questions to the Selected column and click OK.

10. Continue to configure and style the report according to its report type. See Creating reports.

**Chart colors**

Report administrators can change the look of charts by specifying colors used to represent specific report data categories.

You can configure the system to use the same color for all bars on a bar or column chart. You can also define new system colors that can be used in charts. The following reports use the color palette specified on the Style tab of the Report Designer:

- Pie charts
- Bar and column charts that have a Stack by or Group by value
- Line and trend reports that have a Stack by or Group by value
Bar and column charts and line and trend reports that do not have a Stack by or Group by value use one color.

**Using chart colors**

Newly generated bar or pie chart reports update the Chart Colors list to show each data category for the report and the color associated with the category. The colors used in bar and pie charts for a particular data category are consistently used across all bar and pie charts created. For example, priority 1 incidents in a chart always have the same color and do not change color based on their relative position within the chart.

Colors from the following list are automatically assigned to each category the first time the category is used in a chart. If there are more than 15 possible categories, the colors repeat.

<table>
<thead>
<tr>
<th>Chart colors</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="chart_colors.png" alt="Chart colors" /></td>
</tr>
</tbody>
</table>

**Define colors for report data categories**

You can define colors for a specific value for a data category.

**About this task**

Role required: report_admin
Procedure

1. Navigate to Reports > Administration > Chart Colors.
2. Click New.

3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Table used for the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The list shows only tables and database views that are in the same scope.</td>
</tr>
<tr>
<td>Element</td>
<td>Column name specific to the selected table.</td>
</tr>
<tr>
<td>Value</td>
<td>The sys_id of the value for which the specified color should be displayed.</td>
</tr>
</tbody>
</table>
### Chart Colors

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>incident</td>
<td><strong>Note:</strong> A sys_id value applies when the element being used is a reference type. This value must be the value defined in choice entries. When entering the value, letter casing must match. To understand the various ways to get a record’s sys_id, see <a href="https://docs.servicenow.com/app/doc/sn-tips-guide">The unique record identifier (sys_id)</a>.</td>
</tr>
<tr>
<td>incident</td>
<td>Color name, as defined in the <strong>Color Definition</strong> module. When a report generates, this color represents the specified Value.</td>
</tr>
<tr>
<td>incident</td>
<td>Hexadecimal value used to specify a color that is not already defined in the <strong>Color Definition</strong> module.</td>
</tr>
</tbody>
</table>

**Note:** If the **Color name** field contains a value, the **Color** field is ignored.

4. Click **Submit**.

**Results**

The value selected in the **Element** field for the table in the **Name** field is displayed with the specified color.
Define system colors for reports
You can define colors that the system uses in reports.

Procedure
1. Navigate to Reports > Administration > Color Definition.
2. Click New.
3. Fill in these fields.

New color definition form

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the new color.</td>
</tr>
<tr>
<td>Color</td>
<td>Enter a hexadecimal value, for example #003366.</td>
</tr>
</tbody>
</table>

4. Click Submit.

What to do next
The default color scheme glide.ui.chart.default.colors contains the following 20 colors:

<table>
<thead>
<tr>
<th>Default colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. #278ECF</td>
</tr>
<tr>
<td>2. #4BD762</td>
</tr>
<tr>
<td>3. #FFCA1F</td>
</tr>
<tr>
<td>4. #FF9416</td>
</tr>
<tr>
<td>5. #D42AE8</td>
</tr>
<tr>
<td>6. #535AD7</td>
</tr>
<tr>
<td>7. #FF402C</td>
</tr>
<tr>
<td>8. #93BFFF</td>
</tr>
<tr>
<td>9. #6EDB8F</td>
</tr>
<tr>
<td>10. #FFE366</td>
</tr>
</tbody>
</table>
Scoped reports
When editing a report from a different application scope than the current scope, actions modifying the original report are unavailable.

To modify the original report, change the current application scope to the report’s scope and make any changes.

The following actions are available from the Save menu after opening a report from a different application scope in the Report Designer. Other actions, such as Update are not available.

• Insert
• Insert and Stay
• Schedule
• Add to Dashboard
• Export to PDF
• Report History

You can create a new report based on an existing report, but within the current application scope using the Insert or Insert and Stay options.

Related information
Application scope

Administering reports
Learn about the tasks report administrators typically perform, the objects that they work with, and the roles and rules that apply.

To administer reports, reporting roles, and report sources, navigate to Reports > Administration and select the area to administer.

Provides management practices for reports to ensure that they deliver the intended value without impacting system performance.
Reporting roles

Note:

- Users must have the report_user role to see the Reports module on the application navigator (left navigation pane).
- Users with any reporting role or the itil role can access the following report options for all reports that are visible to them: Insert, Insert and Stay, Add to Dashboard, and Export to PDF.
- In the table below, the term manage indicates access to the following report options: Update, Delete, and Export settings.

Navigate to User Administration > Roles to manage roles.

<table>
<thead>
<tr>
<th>Role title[name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No role</td>
<td>Can view reports that are shared with them.</td>
</tr>
<tr>
<td>itil [itil], report user [report_user]</td>
<td>Can create and view reports that have been shared with them. Cannot share, edit, or delete reports that have been shared with them.</td>
</tr>
<tr>
<td>report publisher [report_publisher]</td>
<td>Can Publish reports that they can manage. Publishing a report creates a public link to that report. Users with this role must also have another role that grants permission to create, edit, and share reports.</td>
</tr>
<tr>
<td>report scheduler [report_scheduler]</td>
<td>Can Schedule emailing of all reports that they can see, including reports they cannot manage. Users with this role must also have another role that grants permission to create, edit, and share reports.</td>
</tr>
<tr>
<td>group report user [report_group]</td>
<td>Can manage and share reports that are shared with them (listed in Group).</td>
</tr>
<tr>
<td>global report user [report_global]</td>
<td>Can manage reports that are shared with everyone (listed in Global).</td>
</tr>
<tr>
<td>report administrator [report_admin]</td>
<td>Can manage, share, publish, and schedule all reports. Can access Reports &gt; Administration and manage all report-related objects. The report_admin role inherits all other report roles.</td>
</tr>
</tbody>
</table>
Report roles (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
</table>

Related reference

Performance Analytics roles

Related information

Dashboard permissions

Restrict report creation with an ACL rule

Create an access control list rule to restrict who can create a report on a table, data source, or database view.

Before you begin

Requires role: security_admin

Note: In addition to report_on ACLs for specific tables, a write ACL on the [sys_report] table controls write access for all reports. If this ACL prevents you from saving the current report, the Save button in the Report Designer is disabled. For example, when you view a report that another user shared with you. If you have the correct security settings, click Save > Insert to save an editable copy of the report.

Procedure

1. Navigate to System Security > Access Control (ACL).
2. Add an access control record with the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>record</td>
</tr>
<tr>
<td>Operation</td>
<td>report_on</td>
</tr>
<tr>
<td>Name (table)</td>
<td>&lt;select the table name&gt;</td>
</tr>
</tbody>
</table>

3. Define the rules that determine whether a user can report on a table.

If a user does not have report_on access for a table, the table does not appear in the Table field when the user creates a report. Data sources based on tables for which a user does not pass the report_on ACL do not appear in
the **Data Source** list in the Report Designer. To restrict one or more users from seeing a data source in the **Report Source** list, create a new read ACL on the [sys_report_source] table that excludes those users.

**Note:**
- Users can view and run reports on tables even if they cannot create reports due to report_on ACL restrictions.
- System tables are not reportable by default. To allow reporting against system tables, administrators can configure the `glide.ui.permitted_tables` property. To learn more, see Reporting on system tables.
- The ACL `report_on` operation grants the right to report on the target table.
- Database views have their own ACLs. If a user has `report_on` rights to all the tables in a database view, they still require `report_on` rights on the database view to create reports on it. See Database views.

**Related information**
- Create an ACL rule
- Access control rules

**Report_view access control**

There are two kinds of report_view access control lists: report_view table ACLs and report_view field ACLs. Report_view table and column ACLs grant access to report content based on the table or column specified in the ACL only to users who meet the criteria specified by the ACL.

For example, a report_view field ACL grants the report_admin role viewing access to the salary field in an HR table. When users with the itil or report_user role access a report grouped on the salary field, they see: Access to this content denied based on report_view field ACLs.

**Note:** The report_view table and report_view field ACLs do not support scripts or advanced conditions.

**Related information**
- ACL rule types

**ACL Assessment for Reports**

Use the ServiceNow® ACL Assessment for Reports to identify reports that are blocked by ACLs.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Application components

Use the Report ACL dashboard to identify reports shared with users who cannot see them. ACLs can even block report creators from their own reports if the owner doesn’t meet ACL constraints. Consider a report shared with all itil users. A table or table column the report is based on limits access to those users with an admin role. In this case, most itil users are not able to view the report. The application identifies both the users and the reports. Using the information from the assessment, you can ignore users and reports and address them later.

Outside of the application, you can change sharing in the report designer, or change the access of users, groups, and roles.

The application has four components:

- **Report ACL Dashboard**
  Within the dashboard, you run the scan and activate report_view ACLs.

- **Affected Reports List**
  View all affected reports in a platform list. You can remediate reports here using platform filtering capabilities.

- **Ignored Reports and Users List**
  Remove users and reports from this list so that they appear the next time you scan your reports.

- **Report View ACLs List**
  Use the links in this list to view the details of individual report_view ACLs.

**Note:** Some tables in the ServiceNow platform have access control lists created on them.

To use the ACL Assessment for Reports, perform these activities:

1. **Perform Report View assessment scan.**
2. **Manage Report ACL assessments.**
   The assessments enable you to grant or deny users access to reports. Identify the users you want to add to groups so that they can view reports. Other users continue to have no access to these reports.

3. **Perform report remediation tasks.**
4. **Reassess ignored reports.**
5. **Reassess ignored users.**
6. **View the list of affected reports**
Required Now Platform roles
• admin and security_admin

Installation
To install the ACL Assessment for Reports, request the store application. For more information, see Request a free or paid application.

Perform Report View assessment scan
Scan your instance for reports that users would be unable to view based on existing access control lists (ACLs).

About this task
Roles required: admin and security_admin
The assessment scan returns a list of affected reports. A report is affected if a user has seen the report who would not be able to see it based on a report_view ACL.

The time the assessment scan takes can vary according to the number of records in the instance. Consider running the assessment over night. Also consider filtering the reports the assessment applies to. For more information, see Filter report assessment scans.

Note: The scan considers only ACLs that come with the ServiceNow® product and with installed plugins and applications. The scan does not consider any custom report_view ACLs.

Procedure
1. Elevate your role to security_admin. See Elevate to a privileged role.
3. Click Run Assessment Scan.
   The assessment scan can take a long time on instances with many reports. You can choose to view partial results while the scan is in progress, or click View Result when the scan is complete. When the scan is complete, a message shows who ran the assessment and the start and stop time of the assessment. You can also filter the reports that the assessment scan considers. For more information, see Filter report assessment scans.

Note: The scan calculates the number of executions of each impacted report. If the property sn_report_acl.run_scan_based_on_report_execution_only is false, the Total Executions column in the Impacted Reports list is always empty and process_reports_executed_within_X_days_ago is ignored.
The initial scan shows:

- Who executed the scan and its start and end times
- How many reports are impacted
- The percent of reports in the instance that are impacted
- The number of tables with report_view access control lists

4. **Optional:** If the impacted reports list is empty, navigate to `report_executions.list`.

   a. If this table is empty, there are no ACL issues.

   b. If `report_executions.list` has entries, change the system property `sn_report_acl.run_scan_based_on_report_execution_only` to false and run the scan again. This second scan often takes longer to run.

5. Review the list under Step 2 - Impacted Reports. You can navigate to **Reports > Report view ACL assessment > Affected Reports List** to view the same list.

The Impacted Reports list shows the reports affected by ACLs. The column headings are important:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>The report name with a hyperlink to its form.</td>
</tr>
<tr>
<td>Table</td>
<td>The source table of the report.</td>
</tr>
<tr>
<td>Total executions</td>
<td>The number of times a user has viewed the report.</td>
</tr>
<tr>
<td></td>
<td>This column is empty if the property <code>run_scan_based_on_report_execution_only</code> is false.</td>
</tr>
<tr>
<td>is global</td>
<td>True / False. If true, the report owner has shared it with all users. If false, the report owner has shared it with specific users, groups, or roles.</td>
</tr>
<tr>
<td>Shared to roles</td>
<td>Roles the report owner has shared it with (regardless of access control list). This field is empty if the report is global.</td>
</tr>
<tr>
<td>Shared to users</td>
<td>Users the report owner has shared it with (regardless of access control list).</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>This field is empty if the report is global.</td>
<td></td>
</tr>
<tr>
<td>Shared to groups</td>
<td>Groups the report owner has shared it with (regardless of access control list). This field is empty if the report is global.</td>
</tr>
<tr>
<td>Blocked by table ACLs</td>
<td>Shows the name of the ACL if a table ACL (or column ACL that applies to all columns in a table) blocks a user.</td>
</tr>
<tr>
<td>Blocked by table ACLs roles</td>
<td>The roles defined in the table ACL whose members can view reports based on the ACL. A user needs at least one of these roles to see the report.</td>
</tr>
<tr>
<td>Table ACLs link</td>
<td>Click the link to view a list of the table ACLs that apply to the impacted report. The Role field in the list shows the required roles. A user must have one of the roles to view reports based on the table.</td>
</tr>
<tr>
<td>Blocked by column ACLs</td>
<td>Shows the name of the ACL if a specific column ACL blocks a user.</td>
</tr>
<tr>
<td>Blocked by column ACLs roles</td>
<td>The roles defined in the column ACL whose members can view reports based on the column. A user needs at least one of these roles to see the report.</td>
</tr>
<tr>
<td>Column ACLs link</td>
<td>Click the link to view the column ACLs that apply to the impacted report. The Role field in the list shows the required roles. A user must have one of the roles to view reports based on the column.</td>
</tr>
</tbody>
</table>

**View the list of affected reports**

You can view a list of all impacted reports identified by the ACL assessment for reports. Use this list to remediate affected reports and users.
Before you begin
Role required: admin and security_admin

Procedure

1. Navigate to Reports > ACL Assessment for Reports > Affected Reports List.
The list report shows the affected reports.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>The report name with a hyperlink to its form.</td>
</tr>
<tr>
<td>Table</td>
<td>The source table of the report.</td>
</tr>
<tr>
<td>Total executions</td>
<td>The number of times a user has viewed the report. This column is empty if the property run_scan_based_on_report_execution_only is false.</td>
</tr>
<tr>
<td>is global</td>
<td>True / False. If true, the report owner has shared it with all users. If false, the report owner has shared it with specific users, groups, or roles.</td>
</tr>
<tr>
<td>Shared to roles</td>
<td>Roles the report owner has shared it with (regardless of access control list). This field is empty if the report is global.</td>
</tr>
<tr>
<td>Shared to users</td>
<td>Users the report owner has shared it with (regardless of access control list). This field is empty if the report is global.</td>
</tr>
<tr>
<td>Shared to groups</td>
<td>Groups the report owner has shared it with (regardless of access control list). This field is empty if the report is global.</td>
</tr>
<tr>
<td>Blocked by table ACLs</td>
<td>Shows the name of the ACL if a table ACL (or column ACL that applies to all columns in a table) blocks a user.</td>
</tr>
<tr>
<td>Blocked by table ACLs roles</td>
<td>The roles defined in the table ACL whose members can view reports based on the ACL. A user needs at</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Table ACLs link</td>
<td>Click the link to view a list of the table ACLs that apply to the impacted report. The Role field in the list shows the required roles. A user must have one of the roles to view reports based on the table.</td>
</tr>
<tr>
<td>Blocked by column ACLs</td>
<td>Shows the name of the ACL if a specific column ACL blocks a user.</td>
</tr>
<tr>
<td>Blocked by column ACLs roles</td>
<td>The roles defined in the column ACL whose members can view reports based on the column. A user needs at least one of these roles to see the report.</td>
</tr>
<tr>
<td>Column ACLs link</td>
<td>Click the link to view the column ACLs that apply to the impacted report. The Role field in the list shows the required roles. A user must have one of the roles to view reports based on the column.</td>
</tr>
</tbody>
</table>

2. Address the affected reports and users as described in Manage Report ACL assessments.

Manage Report ACL assessments

When you run the Report ACL assessment scan, the result is a list of impacted reports. The assessment details who has seen a report including the report creators and those the creator has shared the report with; the roles the report is restricted to; and the groups that contain those roles.

About this task

Role required: admin and security_admin

**Important:** The roles associated with blocking table ACLs and blocking column ACLs come from the sys_security_acl_role table. ACLs that don’t have a role record in sys_security_acl_role table don’t appear in the Report View ACLs List or when you open a link to affected table and column ACLs.
Procedure

1. Navigate to Reports > ACL Assessment for Reports > Affected Reports List.

2. Select a report to address. Click the info button (ℹ️) next to the report and click Open record to see the options associated with the report. This result shows the following information.

   a. The users, roles, and groups that the report owner belongs to and has shared the report with. If the field is global is checked, the report is shared with all users.

   b. The number of times users have viewed the report. This field is empty if the property run_scan_based_on_report_execution_only is false.

   c. Table ACLs (and column ACLs that apply to all columns on the table) that apply to the report

   d. Roles associated with blocking table ACLs

   e. Links to associated table ACLs

   f. Column ACLs that apply to the report

   g. Roles associated with blocking column ACLs

   h. Links to the associated column ACLs

   i. A real-time rendition of the report visualization
3. **Optional:** Click **Ignore Report** to remove this report from future assessments. To review these reports later, see **Reassess ignored reports**.

4. Click **Show Affected Users** and then **View Result**.
   The first several affected users appear in a related list below the report assessment. Affected users are users the report owner has shared the report with but who cannot see the report based on report_view ACLs.

   The default number of affected users shown is five. To show more, configure the property `sn_report_acl.com.par_report_acl_assessment.max_affected_users`. For more information, see **Filter report assessment scans**.

5. **Optional:** Select one or more of the affected users and choose **Action on selected rows** > **Ignore** to leave users' access to the report unchanged. Selected users are still unable to view the report but their names do not show up next time that you run the assessment scan.

6. Perform one of the **report remediation tasks**.

**Filter report assessment scans**

Especially on large instances, ACL Assessment for Reports can take a long time. To reduce the assessment time, you can use system properties to filter which reports the assessment applies to.

**Before you begin**

Role required: admin and security_admin

You can work with all the properties in the ACL Assessment for Reports except two:

- `sn_report_acl.glide.script.block.client.globals`

**Procedure**

1. Navigate to **System Properties > All Properties**.
2. Filter the list to show only the Report ACL Assessment application.
3. Filter out the properties
   sn_report_acl.com.par_report_acl_assessment.report_view.sys_ids and
   sn_report_acl.glide.script.block.client.globals.

4. Use the remaining properties to configure the assessment scan.

**Report assessment system properties**

Use these properties to configure the ACL Assessment for Reports scan.

To configure system properties, navigate to `sys_properties.list` and filter on the property name.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_report_acl.run_scan_with_queryNo-Domain</td>
<td>Only valid on domain-separated instances. Defines whether the app considers the user domain when you run the query. If false, the security_admin gets results only for the domains they have visibility to. A global security_admin can set the property to true and retrieve the results for all the domains on the instance. The individual security_admins can then view the collected results for their own domains. For more information, see Report assessment and domain separation. If you set this property to true on an instance that is not domain separated, then the assessment runs as a normal query. If you delete this property, the default value in the code is false. Type: true/false Default: false</td>
</tr>
<tr>
<td>sn_report_acl.add_encoded_query_for_sys_report_table</td>
<td>Allows security admin users to add an encoded AND query condition to the query that the assessment scan is executing on the sys_report table. For example, you can add an encoded</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>sn_report_acl.com.par_report_acl_assessment.collect_dotwalk</td>
<td>Determines whether the app checks dot-walked fields for affected reports. When false, the performance of the app improves, but the app provides only a subset of the total results. Type: true/false Default: false</td>
</tr>
<tr>
<td>sn_report_acl.add_encoded_query_for_sys_user_table</td>
<td>Allows security admin users to add an encoded AND query condition to the query that the assessment scan executes on the sys_user table. For example, you can add an encoded query that assesses only specified roles. The validity of the encoded query is the user’s responsibility. For performance reasons, the app does not validate additional queries in code before execution. If you delete this property, or it has an empty value, then the assessment scan runs with the original conditions only. Type: string</td>
</tr>
<tr>
<td>sn_report_acl.process_reports_executed_within_X_days_ago</td>
<td>Defines the maximum number of days since the last time a report was</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>viewed by any user that the app considers when running the assessment scan. Type: Integer Default: 365</td>
</tr>
<tr>
<td>sn_report_acl.run_scan_based_on_report_execution_only</td>
<td>The scan calculates the number of executions of each impacted report. If this property is false, the <strong>Total Executions</strong> column in the Impacted Reports list is always empty and <strong>process_reports_executed_within_X_days_ago</strong> is ignored. Type: true/false Default: true</td>
</tr>
<tr>
<td>sn_report_acl.com.par_report_acl_assessment.max_affected_users</td>
<td>The maximum number of affected users retrieved when you click <strong>Show Affected Users</strong>. Applies to reports viewable by users with specified roles or reports viewable by everyone. For reports shared with groups, this value is the maximum number of affected users retrieved per group. Type: Integer Default: 5</td>
</tr>
</tbody>
</table>

**Report remediation tasks**

After you perform the report assessment, you can address affected users. You can change ACL roles, change sharing options on reports, or add report users to a group to grant them blocking roles.

**Edit ACL roles**

Add one or more roles to a blocking ACL. Click the link on the blocking ACLs in the Affected Reports form to open the ACL role list.

**Edit the report sharing options**

Open the report in the Report Designer and change who it is shared with. For more information, see **Share a report**.
Add users to a group
Add users to a group that the report has been shared with. For more information, see User administration.

Reassess ignored reports
When you address the ACL Assessment for Reports, you can ignore any report. View these reports to consider their statuses again.

Before you begin
Role required: admin and security_admin

Procedure
1. Navigate to Reports > ACL Assessment for Reports > Ignored Reports and Users List.
2. In the Ignore Report column, set the value of the reports to reassess to false.

Results
The ACL Assessment for Reports assesses the false reports the next time you run the assessment.

Reassess ignored users
When you address the ACL Assessment for Reports, you can ignore any individual user. View these users to consider their statuses again.

Before you begin
Role required: admin and security_admin

Procedure
1. Navigate to Reports > ACL Assessment for Reports > Ignored Reports and Users List.
2. Select the row with the Ignored User.
3. From the Actions on select rows list, select Delete.

Results
The ACL Assessment for Reports includes the users you deleted from this report the next time you run the assessment.

Report assessment and domain separation
In domain separated instances, the ACL Assessment for Reports has certain limitations.
Domain separation property

Configure the true/false property `sn_report_acl.run_scan_with_queryNoDomain` to specify whether the assessment applies to the whole instance or to an individual domain.

This property is only valid on domain-separated instances. It defines whether the app considers the user domain when you run the query. If false, `security_admins` gets results only for the domains they have visibility to.

A global `security_admin` can set the property to true and view the results for all the domains on the instance. The individual `security_admins` can then retrieve the collected results for their own domains. For more information, see Filter report assessment scans.

The assessment runs as a normal query when this property is set to true on a single domain instance. The application treats the assessment as if the property is false if the property is deleted.

Note: When you run the assessment as a global `security_admin`, be sure to set the property back to false. If true, any `security_admin` can query the entire instance. Other `security_admins` don't see data that they don't have the right to view, but collected data is overwritten.

Column view access control for list reports

For list reports, the `glide.report.add_to_list_supported` system property enables the add_to_list access control list. This access control list prevents users from reporting on list report columns with sensitive data.

A manager can prevent users from reporting on the Assigned to column when creating a report, for example. If a table field is restricted for the user, it doesn't appear in the Available column. Users are therefore not able to select it in the reports they create.

Note: When the property is enabled: A user who doesn't pass the add_to_list access control list for a column sees the restricted columns that are already included in the report in the Selected column. This user also sees those columns' data in the report. If the user removes the column from the Selected column, it is no longer listed in the Available column. The user isn't able to select it again to include in a report.

This property is disabled by default. To enable it, navigate to sys_properties.list (System Property table) and set `glide.report.add_to_list_supported` to true. Admin role required.

Once enabled, existing reports aren't affected. Columns are only invisible on newly created list reports whose fields you specify as restricted.
Related information

ACL rule types

Remove the old Report Builder UI

The admin can remove the old Report Builder from London and prior releases, and restrict users to the new Report Designer UI for creating and editing reports. With users restricted to the new UI, they can no longer switch to the old UI through a UI hyperlink in the upper right corner of the Report Designer.

Before you begin
Role required: admin

About this task
The new Report Designer has a clearer work flow, is easier to navigate, and is generally easier to use.

Procedure
1. Follow the steps to Add a system property
2. Add the `glide.ui.report.old_report_builder` property, and set the property value to `false` to disable use of the old Report Builder UI.

Report statistics

The Report Stats list enables you to view how often each of your reports is run and how long it takes for the reports to run.

Role required: admin or report_admin

To view report statistics, navigate to Reports > Administration > Report Statistics. By default, the Report Statistics list displays all reports that have been run. To view all reports, click the context menu icon (⋮) and select Add Unused Reports.

ℹ️ Note: Adding unused reports to this list takes some time, especially if your instance contains many reports.

Overview and suggestions on how to manage reports within the ServiceNow environment.
The Report Stats list has the following columns:
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>The name of the report. Click the hyperlink to view the report properties.</td>
</tr>
<tr>
<td>Last run</td>
<td>The date and time the report was last run.</td>
</tr>
<tr>
<td>Runs</td>
<td>The number of times the report has been run.</td>
</tr>
<tr>
<td>Runs on page</td>
<td>The number of times the report has been run on dashboard or homepage.</td>
</tr>
<tr>
<td>Recent run time</td>
<td>The average execution time of the report in milliseconds based on the 25 most recent runs. Edit the <code>glide.report.recent_executions_number</code> property to change the number of runs used to calculate this value.</td>
</tr>
<tr>
<td>Run time</td>
<td>The average execution time in milliseconds of all runs of the report.</td>
</tr>
</tbody>
</table>

- To view the reports that take the most time to run, sort **Recent run time** from z-a.
- To view used reports, filter out the value 0 from the **Runs** column.
- To view the most used reports, sort the **Runs** column from z-a.

**Reports Usage dashboard**

The Reports Usage dashboard provides an overview of how reports are used in a ServiceNow instance or domain.

To view report statistics, navigate to **Performance Analytics > Admin Console** and select **Report Usage** on the Usage tile.

ℹ️ **Note:** The report_admin role cannot view this console. The admin or pa_admin role is required.

The Reports Usage dashboard shows the following widgets:
<table>
<thead>
<tr>
<th>Widget</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Reports</td>
<td>Single Score with percentage change month on month.</td>
<td>The number of reports in the instance. Click the score to view a dashboard with chart and lists of breakdowns, records, and scores.</td>
</tr>
<tr>
<td>% Reports not viewed in the last 6 months</td>
<td>Single Score with percentage change month on month.</td>
<td>The percentage of reports in the domain or instance that have not been viewed in the last six months. Click the score to view a detailed dashboard with a chart on which you can adjust the period, the calculation used, and additional information on the report.</td>
</tr>
<tr>
<td>Top 10 Report Tables</td>
<td>List</td>
<td>A list of the top 10 tables used in reports. Point to the name of a table to read its description. Click the name of the table or the number of reports to show a dashboard with an enlarged chart, a list of the records in the table, the scores, and additional information on the report.</td>
</tr>
<tr>
<td>Reports by Visualization type</td>
<td>Bar chart (with option to change the visualization to one of several other report types)</td>
<td>The number of times the report has been run on dashboard or homepage. Click a report segment to show a dashboard with an enlarged chart, a list of the records in the table, the scores, and additional information on the report.</td>
</tr>
</tbody>
</table>
Report sources

Report sources are predefined data sets for creating reports.

Use report sources for reports containing the same conditions, so you do not have to define the conditions more than once. You can also use report sources to implement the same definitions across your organization.

A report source always consists of a table and a number of conditions. When you create a new report, you can either use a report source or select a table. Some examples of report sources are open incidents, closed problems, and so on.

Creating report sources; using report data from fields in related tables; using related lists.

Use the option to create a report source based on the conditions of an existing report, or see the following steps for creating a source based on new conditions you add.

For more tips on using report sources, see How to save time with Report Sources.

Create a report source

Create a custom set of data that you can use to create reports. In the Report Designer, report sources are called Data Sources.

Before you begin
Role required: report_admin

About this task
If you update the conditions in a report source, these conditions are automatically propagated to all reports based on that report source.

Procedure
1. Navigate to Reports > Administration > Report Sources.
2. Click New.
3. Fill in the fields on the form, as appropriate.
### Report Source New record

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the report source. For example, Open incidents</td>
</tr>
<tr>
<td>Table</td>
<td>The table on which the report source is based. For example, Incident [incident].</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description of what the report source does and its purpose.</td>
</tr>
<tr>
<td>Filter</td>
<td>Conditions for the specific table records to include in the report source. For example, to include open incidents, select [State] [is] [Active] for the Incident table.</td>
</tr>
</tbody>
</table>

**Note:**
- If the report source is used for a report that includes OR conditions, only records that match both the report and the report source conditions are included.
- Sorting on data fields is accessible from within reports for specific report types. For information on how to access, search for the Add Sort field description in a Creating reports topic for the report type to sort data on.
- If a report source specifies a related list condition, a report created that is based on the report source will ignore any additional related list conditions specified from within the report.

4. To view reports based on a report source, click the Reports using this report source related link in the report source record.

5. Click Submit.

**What to do next**
Use the report source to create a report.

**Note:** While a report source is used by active reports, you cannot delete it.

**Report ranges**
Use a report range to define data intervals that are used in bar and pie charts.
Sometimes it can be helpful to group results into ranges or buckets rather than viewing every result as an individual score. Think of a bar or pie chart which
shows a percentage result. By default each individual value from 0% – 100% would be a separate data point, creating an unnecessarily crowded-looking visual. However, segmenting the results into logical groups of scores can add context and help the audience understand which ranges are good, bad, or concerning. A report range is used to define data intervals for bar, pie, and donut charts. For example, if you’re interested in understanding how many tasks were completed well within the SLA versus how many elapsed during the SLA.

Example use case: There is a significant cost involved to a business each time a SLA is breached at a company. A Service Manager can understand which SLAs are being easily met versus which ones are being breached, or are coming close to being breached. This information helps her identify which SLAs may need to be adjusted.

⚠️ **Note:** Reports only show historical data. It is not possible to set report ranges for dates in the future.

⚠️ **Note:** The module for report ranges is hidden by default. You may need to enable the module before use. For more information, see Enable or disable an application menu or module.
How report ranges work

Report ranges work with elements that hold only dates, lists, or integers.

Report range elements list

<table>
<thead>
<tr>
<th>Type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dates</td>
<td>Using the Created field in the Incident table: Same Day, 2 Days, 2–5 Days, 5–7 Days, 1–2 Weeks, 2–4 Weeks, 1–2 Months, &gt; 2 Months</td>
</tr>
<tr>
<td>Lists</td>
<td>Using the Priority field in the Incident table: Low, Moderate, High, Critical, Planning</td>
</tr>
<tr>
<td>Integers</td>
<td>Using the Count field in the Incident table: Overloaded, Optimized, Under Utilized</td>
</tr>
</tbody>
</table>

Report ranges can be globally applied to all date type fields (date, due date, duration, date/time, date time), or you can limit report ranges to a specific table.

View all report ranges

To view all currently configured report ranges, navigate to Reports > Administration > Report Ranges.

The following are important columns and their associated data types:
Create a report range

Create a report range to define data intervals that are used in bar and pie charts.

Procedure

1. Navigate to Reports > Administration > Report Ranges.
2. Select New.
3. Fill in the form (see table):

   Use the following fields to refine the data displayed in the report and to design the appearance of your report visualization:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the table to draw the values from.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is required before you can select from the <strong>Element</strong> list.</td>
</tr>
<tr>
<td>Element</td>
<td>The table field to draw the values from.</td>
</tr>
<tr>
<td>Label</td>
<td>The name for the report range that is displayed in reports.</td>
</tr>
<tr>
<td>Value list</td>
<td>For list elements, this field defines which values are within the range. After the range is saved, the value list is populated with the choices of the element.</td>
</tr>
<tr>
<td>Color name</td>
<td>The color to display this report range in. The color appears in the <strong>Display</strong> field. If you enter a color name, you do not need to enter a color value.</td>
</tr>
<tr>
<td>Color</td>
<td>The hexadecimal value for the color to report this report range in. The color appears in the <strong>Display</strong> field. If you enter a value for color, you do not need to enter a color name.</td>
</tr>
<tr>
<td>Upper value int</td>
<td>For integer-type elements, this field defines the upper limit of the range. The upper value of the report range with nearest lower <strong>Order</strong> defines the lower limit of this range. If no range with a lower <strong>Order</strong> exists, the lower limit is zero.</td>
</tr>
<tr>
<td>Upper value duration</td>
<td>For duration-type elements, this field defines the upper limit of the range. The upper value of the report range with nearest lower <strong>Order</strong> defines the lower limit of this range. If no range with a lower <strong>Order</strong> exists, the lower limit is zero.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>of 19. Values from 5 to 10 display the formatting specified by this range.</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>Read-only. Shows the color that is used for the specific report range.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the report ranges are used. If a value is defined within more than one label, it is reported under the report range with the lowest order.</td>
</tr>
</tbody>
</table>

**Note:** Once configured, a report range will show as empty if there's no data available in your report. Context fields such as data labels or legend related to the configured report range will still show and be highlighted.

**Enable the report range module**

To use report ranges in your bar and pie charts, you must enable the report range module.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Definition > Application Menus**.
2. Open the **Reports** application menu.
3. In the Modules related list, enable the Report Ranges module. The Modules related list may have over 100 entries. Filter it on the word range to shorten your search.

Results
You can define report ranges for your pie and bar charts.

Using imported report data
Imported Excel spreadsheets enable you to generate reports based on data maintained outside of your instance and to distribute those reports.

Users with admin, sys_admin, report_admin, pa_admin, and pa_power_user roles are able to upload .xlsx files. Uploaded data is temporary and has a specified expiration date, after which reports based on those files are no longer available.

You must have the subscription version of Performance Analytics to create reports with imported data. See Activate your Performance Analytics subscription.

Note: Importing report data in this way is useful when you have information that is maintained outside of your instance. To import an external data set into your instance permanently, see Easy import.

Reporting on system tables
System tables are, by default, restricted from the Reporting module. These tables include, but are not limited to:
• Sys audit [sys_audit]
• Log [syslog]
• Transaction Log [syslog_transaction]
• Attachment [sys_attachment]
• Email [sys_email]

The reason for this is because sys_audit is typically the largest table in any instance. It is not unusual for the audit table, in even a mid-sized instance, to be several gigabytes. In a large installation, this table can be 50GB or more.

When we access the sys_audit table programmatically, we know what our query pattern is going to look like, so we have added appropriate data indexes to match our queries. This means that when you bring up, for example, the history of an incident, the database can use an index to efficiently pull back the few dozen rows it needs for that query.

With freeform reporting, however, we cannot predict what your query pattern is going to look like. Maybe you want to group by fieldname, or sort by oldvalue. So it is possible your queries are not going to be indexed queries. The net result is you will be asking the database to table scan a multiple gigabyte file, which is bad for these reasons:

• It is slow, so your report will take an unacceptably long time to run.
• While the database is scanning your table, your instance will slow down or even become unavailable because other queries cannot get the resources they need.

If you must report on a system table, you can add it to the glide.ui.permitted_tables property. Navigate to System Properties > UI Properties and locate the property labeled List of system tables (beginning with "sys_", comma separated), that are reportable. By default, system tables are not reportable. Proceed with caution.

Map report administration

Learn how about the different objects that are used in map reports, and how to create and modify them.

Map report objects

Map objects define the different levels that users can drill down into on a map report and the data displayed on these levels. Admins can create and manage these objects.
Each map report contains a map source hierarchy, which configures the data for a map level. The report also contains a map hierarchy, which defines the map drill levels. The Level field connects levels for these hierarchies. For example, the data in the Level 1 map is displayed on the Level 1 map object.

**Note:** A set of predefined map sources and maps are available by default. Use these predefined objects whenever possible. If you need a map source that does not exist, generate it automatically using **Generate map source levels** link on the map source form, then customize it. You can automatically generate map source levels only for map sources that reference the location table. These map sources have a field that ends in `.location`.

### Map objects

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map source</td>
<td>Defines a set of data to display on a map report. The map source that a user selects in the <strong>Map data</strong> field when creating a map report is actually a map source hierarchy. There is one map source level for each drill level on the map. The top map source in the hierarchy is not a level, but rather a wrapper for other hierarchy levels. Each map source contains the data for a single map.</td>
</tr>
</tbody>
</table>
Map objects (continued)

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map hierarchy drill level, with both having the same Level. Because they both specify the data that is used for a report, a map source is similar to a report source. However, in a map source you select a field to report on instead of a table.</td>
<td></td>
</tr>
</tbody>
</table>

**Map**
The map that data is displayed on. Maps are set up in a hierarchy defined by parent-child relationships. Each hierarchy level is a drill level on the map report. A JSON definition (geoJSON definition for geographical maps) defines the actual map layout.

Select an existing map or create a new one. You can optionally define conditions for a map, which further filters the data it displays.

**Mappings**
Transform the data in a map source to a value that can be displayed on a map.

Mappings are organized into the Countries and State / Province mapping groups. During map source configuration, you select the mapping group to transform the data in that source. The mapping group that you select must match the Field that you have selected.

For example, a map source that has a Field value of Locations Country would use the Country mappings group. A map source that has a Field value of Locations State / Province would use the Region and state mappings mapping group.

Automatically generate a map source hierarchy

A map source hierarchy is a data source that is used to create a map report. Except for the top-level wrapper, each map source level in the hierarchy defines the data for one map drill level.

**Before you begin**
Role required: report_admin or admin
About this task

Note: A set of predefined map sources and maps are available by default. Use these predefined objects whenever possible. If you need a map source that does not exist, generate it automatically using Generate map source levels link on the map source form, then customize it. You can automatically generate map source levels only for map sources that reference the location table. These map sources have a field that ends in .location.

Procedure

1. Navigate to Reports > Administration > Map Sources.
2. Click New.
3. Fill in these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name. For example, Incident by location. Users select the map source by this name in the Map data field when they create a map report.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table that contains the field that you want to map. All map source levels in the hierarchy use this table.</td>
</tr>
<tr>
<td>Field</td>
<td>Select the field with the data that you want to display on the map report. This field must reference the location table. For example, incident.caller.location or incident.location. You can dot walk to this field.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the map source available when creating map reports.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and select Save.

5. Click Generate map source levels.

Three map source levels are created. Only the level 1 map source is visible in the Map Sources related list.

Note: A map source can have up to four levels, but only three are automatically generated. If the map hierarchy you are using requires an extra drill level, you can create a fourth level map source.
What to do next
The map source is ready to use in a map report.

Customize a map source level
A map source configures data to be displayed in a map report. Customize existing map sources according to your needs.

Before you begin
Role required: report_admin or admin

About this task

(Note: A set of predefined map sources and maps are available by default. Use these predefined objects whenever possible. If you need a map source that does not exist, generate it automatically using Generate map source levels link on the map source form, then customize it. You can automatically generate map source levels only for map sources that reference the location table. These map sources have a field that ends in .location.

Procedure

1. Navigate to Reports > Administration > Map Sources.
2. Open the map source whose level you want to customize, then navigate down to the appropriate level using the Map Sources related lists. For example, click the level 1 map source name to reopen the Map Source form with the level 2 map source in the related list, and so on.
3. Modify these fields as appropriate.

Map source fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the map source. Include the level in the names of map source levels. For example, Incident by location - level 2.</td>
</tr>
<tr>
<td>Table</td>
<td>The same table is used throughout a map source hierarchy, and is specified in the top-level map source.</td>
</tr>
<tr>
<td>Field</td>
<td>Select the field whose data you want to display on the map. You can dot walk to other fields. Select a field that is one level more granular than the map you want to display the data on. For example, imagine you are configuring data for a level 1 map source that is displayed on the world map.</td>
</tr>
</tbody>
</table>
Because the data for countries are displayed on the world map, select **Location Country**. Similarly, if you are configuring data to display on a map of Germany or the United States, select **Location State / Province**.

**Note:** The city label is the most granular level able to be displayed when drilling down into a map report. For example: If you want to report on various site locations within a city, and define the bottom-level map source field to include location.name, the map report displays the multiple locations as the corresponding city labels. As a result, reporting on multiple locations which have the same location.city value results in displaying multiple map dots with the same label, but with different aggregated values, and which drill down to different locations.

Most map sources use a field on the Location table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Select a hierarchy level for this map source. You can have a maximum of four levels. Each map source level corresponds to a drill level on the map hierarchy, and these levels much match. Each level must exist in a hierarchy only once.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box to make this map source unavailable when creating map reports.</td>
</tr>
</tbody>
</table>

4. In the **Data transformation** section, modify these fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Select how to use data in this map source.</td>
</tr>
<tr>
<td></td>
<td><strong>Use data on table:</strong> Use the data in the ServiceNow platform without transforming it. Select this option when the data already matches the JSON key values that you are mapping to.</td>
</tr>
<tr>
<td></td>
<td><strong>Use mapping:</strong> Transform that data so it matches the JSON key values that you are mapping to. For geographical map sources that use the hc-key geoJSON key, always select this option.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
• **Use longitude and latitude**: Use latitude and longitude coordinates to plot your data. Always select this option for the bottom map level, such as level 3. Ensure that your data has latitude and longitude values.

⚠️ **Warning**: Because the **Use longitude and latitude** option disables heatmap and drilling for maps using this map source, select this option only on map source levels that are the bottom level in a hierarchy.

| Use these mappings | If you selected **Use mapping**, select a mapping group to use. A mapping group is a collection of key-value pair mappings that transform data. To review the mappings in a mapping group, go to the Locations Mappings [sys_report_map_source_mapping] table. For example, if you are transforming field value **USA** to hc-key value **us**, select **Country mappings**, which contains the relevant key-value pair mapping. |

5. In the **JSON key** section, select a JSON key to connect the map source data to maps.

Geographical maps typically use hc-key.

Every report map has a JSON definition. Select one JSON key-value pair to map the data to. The data to appear on the map must match the JSON key values. So the key that you select determines whether you must transform your data with the settings in the **How to use data** section. All default platform maps and mappings use the geoJSON hc-key and ISO 3166 standard values. For custom maps, you can enter a different JSON key.

6. Click **Update**.

**Create a key-value pair mapping**

Key-value pair mappings transform data in the ServiceNow platform to a value that can be plotted on a map. Mappings are used during map source configuration when data requires transformation. Each mapping exists in a mapping group.

**Before you begin**

Role required: report_admin or admin
About this task
Default system key-value pairs map data to geoJSON hc-key values. All hc-key values follow ISO 3166 standards. Default mappings exist for the most commonly used data values. If your data uses a different value, you must create a key-value pair mapping.
For example, the default mapping for United States of America maps key USA to ISO value us. If your data has value of United States instead of USA, you must make a new key-value pair to map United States to ISO value us.

Procedure
2. Open the mapping group to add the mapping to.
   Select the mapping group that corresponds to type of object that you want to create a mapping for. For example, if you are creating a mapping for field value United States, select the Country mappings group.
3. Click New.
4. Fill in these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The field value to transform. For example, USA.</td>
</tr>
<tr>
<td>Value</td>
<td>The value to transform the key to. For example, us. This value is typically an ISO 3166 standard value. Each value can be used only once per map.</td>
</tr>
<tr>
<td>Map</td>
<td>The map to associate with this mapping. If you do not fill in this field, this mapping can be used with any map.</td>
</tr>
</tbody>
</table>

5. Click Submit to save your changes.

What to do next
Add the mapping to a report source, so it can be used to map data from that source to a map.

Create a map
Create a map that can be used in a map hierarchy.

Before you begin
Role required: report_admin or admin
Procedure

1. Navigate to Reports > Administration > Maps, and click New.
2. Fill in the following fields as appropriate.

### Report Maps form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>Specify a unique key that links this map to other maps. For default maps, the key is the hc-key value. The key must be included in the geoJSON of the parent map.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the map.</td>
</tr>
<tr>
<td>Level</td>
<td>Specify the level for this map in the map hierarchy.</td>
</tr>
<tr>
<td>JSON definition</td>
<td>Define the geoJSON for the map. You can download predefined maps from Highcharts, or use any map that follows geoJSON standards. For more information, see the GeoJSON site.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select a parent map for this map. The parent-child relationships define drill levels in a map hierarchy.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box to make the map unavailable when creating map reports.</td>
</tr>
<tr>
<td>Geographical map</td>
<td>If your map is not geographical, clear this check box. For example, clear this check box for a floor map.</td>
</tr>
</tbody>
</table>

3. Right-click the form header and select Save.

4. To add conditions that filter the data in the map:
   a. Click New in the Map conditions related list.
   b. Fill in these fields.

### Map condition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select this check box to apply this condition.</td>
</tr>
<tr>
<td>Table</td>
<td>Specify the table that these conditions apply to. Conditions cannot be shared across tables.</td>
</tr>
<tr>
<td>Map source</td>
<td>Select the map source that the condition applies to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Conditions</td>
<td>Add filter conditions to apply to this map.</td>
</tr>
</tbody>
</table>

**c. Click Submit.**

5. **Optional:** In the Report Maps related list, create a child map to extend the map hierarchy.

6. Click **Update** to save the map.

**Set the default map for map reports**

You can change the map that appears by default in the Set map field when you create a map report.

**Before you begin**

Role required: admin or report_admin

**Procedure**

1. Navigate to Reports > Administration > Properties.

2. In the Set the default map for reports of type 'Map' field, type the key of the map that you want to set as default. You can find a list of maps under Reports > Administration > Maps.

3. Click **Save**.

**Administer table and field descriptions**

Users with the report_description_admin role can add and edit table and field descriptions that users see when they create reports.

A user with the admin role must enable the report_description_admin role. The user with the report_description_admin role can edit field and table descriptions.

In the Report Designer, the user sees the table descriptions on the Data tab. When appropriate, the user sees the field descriptions on the Configure tab.

**Enable the report description admin role**

Users with the admin role can enable the report_description_admin role. Users with this role can add and edit table and field descriptions.

**Before you begin**

Role required: admin
Procedure

1. Navigate to **System Definition > Plugins**.
2. Enter `com.glideapp.report.description_config` in the search bar.
3. Install the **Table and field description configuration for report** plugin.

4. Assign the `report_description_admin` role. For more information, see **Assign a role to a user** and **Assign a role to a group**
   Users with the `report_admin` role have the new role automatically.

Results

In the Report Designer, the user sees the table descriptions on the **Data** tab and the field descriptions, when appropriate, on the **Configure** tab.

**Edit table and field descriptions**

Users with the `report_description_admin` role can add and edit table and field descriptions that users see when they create reports.

**Before you begin**

Role required: `report_description_admin`

**Procedure**

1. Navigate to **Reports > Administration > Field Descriptions**.
   The **Field Labels** list has four columns:

   **Table**
   
   Lists the table the element is associated with. There is one entry in this column for every field in the table, plus one for the table itself.

   **Element**
The field in the table that the description applies to. If the **Element** value is empty, then the description applies to the table.

**Language**

Two-letter code of the language the field is localized in. Read-only.

**Note:** Right-click the code of the language you’re adding descriptions in and select **Show Matching**. In this way, you limit the table to only the fields you need for this task.

**Hint**

Contains the descriptions of the tables and fields that users see in the Report Designer.

2. Double-click the cell in the **Hint** column and add a description. Click the green check icon to save the description.

---

**Create coloring rules for multilevel pivot reports**

Configure rules for how numerical values are displayed in a multilevel pivot table report. Coloring rules make it easy to highlight the more important values. The color rule is applied to the content of cells in pivot reports.

**Before you begin**

**Role required:** report_admin or admin

**Note:** It is not possible to apply coloring rules to the Total cells in multilevel pivot reports.

**Procedure**

1. On the **Style** tab of the Report Designer, click **Edit coloring rules**. If you see the error message ‘Security constraints prevent access to requested page,’ an access control list is preventing access. If necessary, a user with the
security_admin role should create new read and write ACLs on the Multilevel Pivot Rule [sys_report_mpivot_rule] table.

2. In the Multilevel Pivot Rules dialog box, click **New rule**.
3. Fill in the fields on the form.

**Multilevel Pivot Rule fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>The operator used when evaluating values in cells, such as <strong>greater than</strong> or <strong>between</strong>. For example, to style cells with a value less than 5, select <strong>lower than</strong> and specify a <strong>Value 1</strong> value of 5.</td>
</tr>
<tr>
<td>Value 1</td>
<td>The number to evaluate cell values against. When the <strong>Operator</strong> value is <strong>between</strong>, enter the lower value in the <strong>Value 1</strong> field.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>When creating rules based on a duration value, specify the duration in seconds.</td>
</tr>
<tr>
<td>Value 2</td>
<td>The maximum value a cell can contain to match this rule. This field only appears when the <strong>Operator</strong> value is <strong>between</strong>.</td>
</tr>
<tr>
<td>Font color</td>
<td>The font color to apply to cells that match this rule.</td>
</tr>
<tr>
<td>Background color</td>
<td>The background color to apply to cells that match this rule. This option applies only to multilevel pivot table reports.</td>
</tr>
<tr>
<td>Rule order</td>
<td>A numerical value that determines the order in which the rules apply. Rules with a higher rule order apply later and override lower-order rules.</td>
</tr>
<tr>
<td></td>
<td>For example, one rule matches cells with a value greater than 140, and another rule matches cells with a value less than 150. The rule with the higher order applies to cells with values from 141 through 149.</td>
</tr>
</tbody>
</table>

4. Click **Submit** to save the rule and create a new rule, or click **OK** to save the rule and return to the Report Designer.

**Create coloring rules for single score reports**

Configure rules for how numerical values are displayed in single score reports, to easily highlight why a value is important.

**Before you begin**

This task is part of configuring the style options of a single score report.
Procedure
1. On the **Style** tab of the Report Designer, click **Edit coloring rules**.
2. In the Multilevel Pivot Rules [Single Score Color Rule view] dialog box, click **New rule**.
3. Fill in the fields on the form.

**Single Score Color Rule fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>The operator used when evaluating values, such as greater than or between. For example, to style values of less than 5, select lower than and specify a Value 1 value of 5.</td>
</tr>
<tr>
<td>Value 1</td>
<td>The number to evaluate cell values against. When the Operator value is between, enter the lower value in the Value 1 field.</td>
</tr>
</tbody>
</table>
| Note:          | * The color rule is applied to the aggregated values.  
* When creating rules based on a duration value, specify the duration in seconds. |
| Value 2        | The maximum value to match this rule. This field only appears when the Operator value is between. |
| Font color     | The font color to apply to values that match this rule. |
| Rule order (Optional) | A numerical value that determines the order in which rules apply.  
Rules are evaluated from lowest value to highest. For example, you have one rule applies the color blue to the value 7, and a second rule that applies the color red to values between 1 and 10. If you want the 7 to appear blue, the Rule order value for the first rule should be higher so that the second rule does not override it.  
If you do not specify a rule order, coloring rules are applied in the order in which they were created. |

4. Click **Submit** to save the rule and create a new rule, or click **OK** to save the rule and return to the Report Designer.

**Domain separation and Reporting**

Domain separation is supported in reporting and how it relates to report creation and administration. Domain separation enables you to separate data,
processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Standard**
- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see [Application support for domain separation](#).

**Overview**

To activate the domain separation plugin, see [Request domain separation](#).

**How domain separation works in Reporting**

In the case of Reporting, the data that is separated includes report designs and report content. A report defined at the global level is visible to users in all child domains. In the figure below, the TOP domain represents the global domain.

- Reports created in the TOP domain are visible to users in the Joe's company domain and HR, CS, and IT child domains of Joe's company.
- Reports created in either the IT, CS, or HR child domains are not visible to users in the other child domains, but they are visible to users in the parent Joe's company domain.
- Reports created in the parent Joe's company domain are available only to users in that domain, but not to users in the child domains.
However, if you create a report in one domain and copy it to another, the report structure remains the same, but the data the report accesses is adjusted for the domain. For example, a report on the [incident] table that shows active incidents will show all active incidents to a user in the parent domain, but only IT incidents to a user in the IT domain.

Related information
- Application support for domain separation
- Understanding domain separation

Enable domain separation on reports
Activate the domain separation plugin to enable reports to display content based on data, rules, and settings from the logged-on user domain.

Before you begin
Requires role: security_admin

About this task
By default, the Domain Support plugin separates data on certain tables by domain. It does not, however, separate reports by domain unless the MSP Extensions plugin is installed. The report displays data only from the user's domain, but the user is able to see all the reports.

Follow these steps to ensure domain separation on reports if the MSP Extensions plugin is not installed.

Procedure
1. Navigate to Reports > Administration and select a report to separate by domain.
2. Right-click the header and select Configure > Dictionary.
3. Configure the dictionary on the `sys_domain` field and fill in the **Reference** field with the domain for this report. If left blank, the report is global.

**Domain** fields appear on reports, and this field references a table. After a domain field exists on a form, all records within the table will have the domain field enabled. By default, all these records are global.

**Related information**

**Quick start tests for Reporting**

Validate that Reporting still works after you make any configuration change such as applying an upgrade. Copy and customize these quick start tests to pass when using your instance-specific data.

The Reporting quick start test Automated Test Framework - Reporting plugin (com.glide.automated_testing_impl.report) is active by default or instance reboot.

⚠️ **Note:** Reporting quick start tests do not test report access from dashboards. To test dashboards, see **Quick start tests for Dashboards**.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Visibility</td>
<td>Confirm whether reports are still visible to users whom they are shared with.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**Related information**

**Quick start tests**

**Report Visibility test steps**

You can customize these pre-configured example test steps.

**About this task**

The Report Visibility test contains two types of steps:

- **Impersonate**
  
  When configuring this step, select which user to impersonate when executing theConfirm steps that follow. Select a user with the role or roles whose access you are testing.

- **Report Visibility**
When configuring this step, select which report to test. Also select whether the test succeeds with positive results or with negative results. In other words, set whether Report Visibility succeeds when the user can view the report or when the user cannot view the report.

The example test included in the plugin includes the following three steps:

1. Impersonate the user.
2. Confirm a test report can be viewed by the test user.
3. Confirm a test report cannot be viewed by the test user.

However, when you customize a test, you can combine steps in any logical sequence by adding and configuring the two types of steps. For example, you could configure the Report Visibility test as follows:

1. Impersonate a user.
2. Confirm that this user can view a report.
3. Confirm that this user can view another report.
4. Confirm that this user cannot view a third report.

**Customize calendar reports**

You can specify the fields that are displayed in calendar tasks.

By default, the **number** and **short_description** fields are displayed, but this behavior is configurable. Radio buttons on reports can be configured for various fields to highlight calendar entries by properties such as priority level and approval status. You can select a unique highlight color for each task property.

**Configure how calendar entries look**

To configure how calendar entries appear for a table, add calendar_elements attributes to the System Dictionary entry for that table.

**Procedure**

1. Open a form for any record in that table.
2. Right-click the form header and select **Configure > Dictionary**.
3. In the record list that appears, select the first record that does not have a value in the **Column name** field.

5. In the Attributes field, add `calendar_elements=<field name>;<field name>`, listing the fields you want to appear in each entry of your calendar report separated by semi-colons.

**Note:** When you define attributes for calendar elements, you replace the default display elements of `number` and `short_description` with the attributes that you list in this field. To add any additional attributes to the calendar entry and retain the number and short description of the change, include the `number` and `short_description` fields in your attributes. For example, to add state information to your task calendar, add the following attribute to the Task table:

```
calendar_elements=number;short_description;state
```
6. If the table already has an attribute, separate it from the attribute you are adding with a comma, for example:

```
reference_index_include=active,calendar_elements=number;short_description;state
```

7. Click **Update**.

**Results**
The calendar entries display the attributes you have added for the selected table.

**Modify or add calendar report system properties**
Specify system property values to override Task table highlighting in calendar events, limit the number of events in a calendar cell, or change the day the calendar week starts.

**Override Task table field styles for highlighting calendar events**
Highlighting for calendar report events is configured with field styles, which are defined for a particular table. You can configure whether calendar reports use field styles from the tables or report sources that they are based on.
Before you begin
Role required: admin

About this task
By default, field styles in the Task [task] table are applied to calendar reports. If calendar reports are configured to use field styles from their tables or report sources, these field styles override the Task table styles.

Procedure

1. In the filter navigator, enter: `sys_properties.list`
2. Select the `glide.ui.report.extend_calendar_choices` property to specify which field styles are used during calendar highlighting.
   • If false, calendar reports will use only styles from the Task table when determining options for calendar highlighting. For example, a calendar report on the Change Request [change_request] table will only use styles from the Task [task] table instead of styles from a the combination of the two tables.
   • If true, calendar reports will use field styles from the table that the calendar report is based on.
3. Click Update.

Limit the number of events displayed on calendar days

For calendar reports, the maximum number of events that appear in some calendar views is configurable. When this maximum is exceeded a + `<number>` link appears, which opens a pop-up window with additional events. You can also configure the maximum number of events that appear in this pop-up window. When this maximum is exceeded, a + many link appears, which opens a list of events instead of a pop-up window.

Before you begin
Role required: report_admin, admin

About this task
You can configure these settings for the following calendar views:

• A calendar day when calendar is in month or year view
• The top 'full day' section of a calendar day when a calendar is in day or week view
Procedure

1. In the navigation filter, enter `sys_properties.list`.
2. Configure the `glide.report.calendar.max_events_displayed_per_cell` and `glide.report.calendar.max_more_events_per_day` properties.
3. Click Update.

Change the day that calendar weeks start on

By default, weeks for calendar reports start on Monday. You can add a system property to start weeks on Sunday or another day instead. Weeks use ISO numbering regardless of what day they start on.

Before you begin

Role required: admin

The `glide.ui.date_format.first_day_of_week` system property modifies the generated date/time value used in the query and sets the start day of the week in the rendered calendar.

Note:

- `glide.ui.filter.first_day_of_week` must also be set to the same value as `glide.ui.date_format.first_day_of_week` for the set day to display properly.
- If you change the `glide.ui.filter.first_day_of_week` property after collecting Performance Analytics score data, you won’t be able to view the scores for weekly indicators. To access them, you’ll need to collect scores again.

Procedure

1. Add the `glide.ui.date_format.first_day_of_week` system property.
2. Set one of the following integer values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start weeks on Monday</td>
<td>Set Value to 2</td>
</tr>
<tr>
<td>Start weeks on Sunday</td>
<td>Set Value to 1</td>
</tr>
</tbody>
</table>

3. Click Submit.
Set calendar record limit

By default, calendar reports save up to 10,000 records. Change this limit by setting the `glide.ui.max_calendar_records` system property. If the number of records fetched exceeds this limit, you are prompted to filter the data and run the report again.

Before you begin
Role required: admin

Procedure

1. Add the `glide.ui.max_calendar_records` system property.
2. Complete the form with the following values.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><code>glide.ui.max_calendar_records</code></td>
</tr>
<tr>
<td>Description</td>
<td>Enter a phrase that describes the function of the property, such as</td>
</tr>
<tr>
<td></td>
<td>Maximum number of calendar records saved.</td>
</tr>
<tr>
<td>Type</td>
<td>Integer</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the desired value for the number of records retained by the platform.</td>
</tr>
<tr>
<td></td>
<td>The default value if this property is not configured is 10,000.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Related information

Add a system property

Change highlighting of calendar report events

Field styles control the highlighting of events in calendar reports. Manage field styles to change how highlighting works.

Before you begin
Role required: admin
About this task
You can apply field styles for the table that a calendar is based on or field styles for the Task [task] table to a calendar. The field styles that are applied for calendar highlighting depends on the `glide.ui.report.extend_calendar_choices` system property.

You can change only the background color of calendar events. All other CSS is ignored. Events without a defined field style display a white background when highlighting is applied to a calendar report.

Procedure
Define field styles for the appropriate table.

- To define field styles for all calendar reports, define the style on the Task [task] table.
- To define field styles that apply only to calendars that are based on a specific table or report source, define the field styles on that table.

If calendar reports are configured to use field styles from their tables or report sources, these field styles override the Task [task] table styles.

Set persistent highlighting for a calendar criterion
Calendar report and widget criteria highlighting is removed once you close the report or widget. Set highlighting for a selected criterion to remain persistently.

Before you begin
Role required: admin

Procedure
1. Navigate to Homepage Admin > Pages.
2. Click the homepage or dashboard title where the calendar report is located.
3. Click the Dropzone the calendar report type is listed under.
4. Click New to define a new portal preference.
5. Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter <code>sysparm_calstyle</code></td>
</tr>
<tr>
<td>Value</td>
<td>Enter the value you want to highlight, for example, <code>priority</code></td>
</tr>
</tbody>
</table>
6. Click **Update** to save the preference and return to the homepage or dashboard portal page form.

**Results**

Each time you open the report, the selected criterion will be highlighted.
Customize a start and end date

You can configure calendar reports to support the spanning of multi-day events across calendar cells.

Before you begin
Role required: dictionary admin or admin

About this task
A change request with a Work Start date on Monday and a Work End date on Tuesday is displayed on both days when viewed in a Calendar field. However, when two custom fields named First Date and Last Date are used, the same behavior does not occur.

The code looks for an ending field with the same name as the start date field, except using the word end instead of start. If the custom fields are My Start Date and My End Date, the system correctly interprets the meaning of these fields because their names are the same except for the words start and end.

Procedure
1. Follow the steps in Add and customize a field in a table.
2. Enter the following values in the form to create the start date span field.
3. Add another field using the following values for the end date span field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Calendar end date span</td>
</tr>
<tr>
<td>Database column name</td>
<td>u_last_date → u_my_end_date</td>
</tr>
<tr>
<td>Type</td>
<td>Date</td>
</tr>
</tbody>
</table>

**Translate a report’s grouping labels**

When executing reports that group results by a Translated Text field, to ensure that individual field labels and values display as translated, use the Translated_field type.

⚠️ **Note:** Reporting only supports columns of type Translated_field.

When executing reports, for example multi-level pivot or bar reports, that group results by a Translated Text field, the labels may not all display as translated when the instance language is changed from English to another language. These field labels are entries from the Translated Name / Field Table.

Translation errors can occur when translating more than the first row or column of a report, or when creating a custom field for grouping. Use the Translated_field type to Translate individual field labels and values. See Creating reports for grouping options available from the Configure tab for the specific report type.

If you create a custom field for a report, the label is not added automatically. You need to add the label in the Field Label table and manually Translate a field label.
Related information
- Translation tables
- Administer translated text fields
- Internationalization support

Report Administration module
Learn how to administer reports on the ServiceNow platform using the Reports > Administration module.

This module is not enabled by default, and must be activated. For a list of the reporting roles delivered with the ServiceNow platform, see Base system roles.

ℹ️ Note: Restricting a report by role restricts who can view a report. Users without the admin role cannot edit global reports. If a non-admin user edits a global report, saving that report creates a personalized version belonging to that user.

Use the record list view to filter, view, or modify reports using any of the standard record list controls. Click New to create reports or select any of the records to display the report as a form. All the standard ServiceNow form controls apply.

You can select the table and field on which to report and the characteristics of the report format. Create a condition in the Filter field to further restrict the data that is presented in the report and select a role that can use the report.

Report Security
The Report Security enforce access control checks plugin allows administrators to use access control list (ACL) rules to restrict report access. This functionality prevents unauthorized users from editing, updating, or deleting reports either through the UI or through a URL construct. See Access control list rules for more information.

Available Report Fields
The following fields can be manipulated:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>A unique and descriptive name for the report.</td>
</tr>
<tr>
<td>Table</td>
<td>The ServiceNow table against which this report is run.</td>
</tr>
<tr>
<td>Field Name</td>
<td>The name of the group-by field.</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>The <strong>report type</strong> for this report.</td>
</tr>
<tr>
<td>Chart Size</td>
<td>Large, medium, or small.</td>
</tr>
<tr>
<td>Visible to</td>
<td>Select a group whose members are authorized to see the report. Select <strong>Everyone</strong> to give all your users access.</td>
</tr>
<tr>
<td>User</td>
<td>The user who can view the chart. Enter <strong>GLOBAL</strong> to make the report accessible to all.</td>
</tr>
<tr>
<td>Filter</td>
<td>The filter applied to the report data.</td>
</tr>
<tr>
<td>Roles</td>
<td>The roles required to view the report.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Determine how you want the data in the report aggregated. The default is <strong>Count</strong>, which displays the number of records selected. When you select <strong>Average</strong>, <strong>Sum</strong> or <strong>Count Distinct</strong>, you can select from a list of additional fields whose values you want to use to aggregate the data. Typical values to use as an average or a sum are the time measurements, such as <strong>Business duration</strong> (expressed in days, hours, and minutes) and <strong>Resolve time</strong> (expressed in seconds). Other fields, such as <strong>Priority</strong>, have numerical values associated with their levels and can be used as aggregators. <strong>Note:</strong> Averages are calculated by dividing the sum of all fields by the number of those fields that contain a value. Fields that are empty or that contain a light gray zero are not included in the field count that is used when dividing the sum.</td>
</tr>
<tr>
<td>Content</td>
<td>An HTML field for describing the content of the report. Not processed in the generation of the report.</td>
</tr>
<tr>
<td>Display grid</td>
<td>Select to display a table under the chart that contains a breakdown of the requested data. The aggregation units are <strong>Count</strong>, <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>. The percentage of the total data represented by each discrete piece is displayed.</td>
</tr>
<tr>
<td>Group</td>
<td>Select a group whose members are authorized to see the report. select <strong>Everyone</strong> to give all your users access.</td>
</tr>
<tr>
<td>Interval</td>
<td>For <strong>Trend</strong> or <strong>Trendbox</strong> charts, the interval of time to measure along.</td>
</tr>
<tr>
<td>No Groups</td>
<td>Use the values in this list to limit the number of bars that appear in the chart. The platform displays 12 bars by default, from high</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Others</td>
<td>Check box to include the Other group in the report.</td>
</tr>
<tr>
<td>Select fields for list</td>
<td>The fields that display in a list report.</td>
</tr>
<tr>
<td>Select fields for orderBy</td>
<td>The order of fields that display in the report.</td>
</tr>
<tr>
<td>Show Empty</td>
<td>Whether to display empty categories.</td>
</tr>
<tr>
<td>Sumfield</td>
<td>The field to perform a sum on for Trend or Trendbox Charts.</td>
</tr>
<tr>
<td>Trend Field</td>
<td>The field to track over time for Trend or Trendbox Charts.</td>
</tr>
</tbody>
</table>

### Reporting properties

Use properties to fine-tune report behavior and appearance.

### Introduction

Navigate to Reports > Administration > Properties to configure the main reporting properties. In the Filter navigator, enter `sys_properties.list` to configure other reporting properties.

### Reporting properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable Natural Language Queries (NLQ) in Report Designer      | • Type: true | false  
| com.snc.par.nlq.report_designer.enabled                       | • Default value: true  
|                                                               | • Location: Reports > Administration                                        |
| Truncates x-axis labels to 20 characters. (Applicable only to charts generated with the charting v2 plugin) | • Type: true | false  
| glide.chart.truncate.x_axis_labels                            | • Default value: true  
<p>|                                                               | • Location: Reports &gt; Administration                                        |
| glide.ui.report.old_report_builder                             | Enables (true) or disables (false) use of the old report builder.            |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.chart.bar.horiz.max_col_slant_labels</td>
<td>Sets the maximum number of columns in a horizontal bar chart before slanting (angling) labels.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property to the <code>[sys_properties]</code> table.</td>
</tr>
<tr>
<td>glide.chart.animation</td>
<td>Enables animations for reports and Performance Analytics visualizations that support animations.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Reports &gt; Administration</td>
</tr>
<tr>
<td>glide.chart.data_labels.remove_leading</td>
<td>Sets the default truncation for truncated values.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Reports &gt; Administration</td>
</tr>
<tr>
<td>glide.chart.histogram.bins</td>
<td>Number of bins in a histogram chart (minimum 1, maximum 20). Determines the number of sections on the Y axis of the histogram.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 10 (Allowed range: 1–20)</td>
</tr>
<tr>
<td></td>
<td>• Location: Reports &gt; Administration</td>
</tr>
</tbody>
</table>

**Note:** Map reports do not support animations and therefore do not follow this property.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Color of the mean value dot in box and trendbox charts. glide.chart.box.mean.color | Sets the color of the 'mean' value dot in box and trendbox report.  
• Type: string  
• Default value: #2f7ed8  
• Location: Reports > Administration  
This property applies to box and trendbox reports. |
| glide.chart.drill.open_new_win | If enabled, opens the default list drilldown in a new tab if no drilldown is defined. Applies only for non-list type reports.  
• Type: true | false  
• Default value: false  
• Location: Reports > Administration |
| Color of the box and whisker in box charts glide.chart.box.color | Sets the color of the box report.  
• Type: string  
• Default value: #FF0000  
• Location: Reports > Administration  
This property applies to box reports. |
| Default Color list name for each dataset glide.ui.report.datasets.default_colors | Sets the default colors to use when adding multiple data sets to a single chart. These values are used when the Chart color value is Use one color.  
Enter a comma-separated list of chart colors. You can view available colors and define new colors on the [sys_report_chart_color] table. Each color is used in order as the default chart color when adding a data set to a chart. If there are more data sets than default colors, the colors repeat.  
• Type: string  
• Default value: Default Color  
• Location: Reports > Administration |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.report.datasets.default_palettes</td>
<td>List of color palette names that are used as a default color palette for each dataset. Enter a comma-separated list of chart color scheme Name values. You can view the available and define new palettes on the Chart Color Schemes [pa_chart_color_schemes] table. Each palette is used in order as the default chart palette when adding a data set to a chart. If there are more data sets than default palettes, the palettes repeat. Sets the default palette to use when adding multiple data sets to a single chart. These values are used when the Chart color value is Use color palette.</td>
</tr>
<tr>
<td>glide.ui.chart.color</td>
<td>Specify the chart color.</td>
</tr>
<tr>
<td>glide.ui.chart.use_full_color_palette</td>
<td>Enable this property to generate bar and Pareto charts with different colors for each bar.</td>
</tr>
<tr>
<td>glide.ui.report.map.default_map</td>
<td>Set the default map for reports of type 'Map'. Specifies the default map to use when creating Map-type reports.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `glide.chart.label.legend.truncate_to` | This property applies to bar, horizontal bar, and Pareto reports. Truncates legend labels for left or right alignment for all chart sizes except large charts. Prevents shrinking of charts when labels are too long.  
  - Type: integer  
  - Default value: 14  
  - Location: System Property [sys_properties] table |
| `glide.chart.label.legend.truncate_to.large` | Truncates legend labels for left or right alignment for large charts. Prevents shrinking of charts when labels are too long.  
  - Type: integer  
  - Default value: 20  
  - Location: System Property [sys_properties] table |
| `glide.report.new_calendar` | Enables you to specify the number of days with events that are returned when you browse backward and forward in a calendar report. Evaluated on the Calendar by field in the report creator.  
  - Type: true | false  
  - Default value: true  
  - Location: System Property [sys_properties] table |
| `glide.report.calendar.max_days_back` | The default duration for an event without a specified end date. |
| `glide.report.calendar.default_event_duration` | Enables you to specify the number of days with events that are returned when you browse backward and forward in a calendar report. Evaluated on the Calendar by field in the report creator.  
  - Type: integer  
  - Default value: 30  
  - Location: Add a system property to the System Property [sys_properties] table  
  This property applies to calendar reports. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.report.calendar.max_more_events_per_day</td>
<td>Defines the maximum number of calendar events that can appear in the <code>+ &lt;number&gt; &lt;link&gt;</code> pop-up window for:</td>
</tr>
<tr>
<td></td>
<td>• A calendar day when calendar is in month or year view</td>
</tr>
<tr>
<td></td>
<td>• The top 'full day' section of a calendar day when a calendar is in day or week view</td>
</tr>
<tr>
<td></td>
<td>When this number is exceeded, a <code>+ many &lt;link&gt;</code> appears, which opens a list of events instead of a pop-up. For more information, see <code>glide.report.calendar.max_events_displayed_per_cell</code>.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 30</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property to the System Property <code>sys_properties</code> table.</td>
</tr>
<tr>
<td>glide.report.calendar.max_events_displayed_per_cell</td>
<td>Defines the maximum number of events that can appear in calendar report for:</td>
</tr>
<tr>
<td></td>
<td>• A calendar day when calendar is in month or year view</td>
</tr>
<tr>
<td></td>
<td>• The top 'full day' section of a calendar day when a calendar is in day or week view</td>
</tr>
<tr>
<td></td>
<td>Events that exceed this value are visible via a link in the calendar cell. See <code>glide.report.calendar.max_more_events_per_day</code> for more information.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 30</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property to the System Property <code>sys_properties</code> table.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.report.extend_calendar_choices</td>
<td>Controls which field styles are applied during calendar highlighting. If this property is set to false, field styles in only the Task table are used. If the property is set to true, the calendar first uses field styles from the table that the report is based on. If no applicable styles exist in that table, the calendar uses field styles from the Task table.</td>
</tr>
<tr>
<td>glide.ui.filter.first_day_of_week</td>
<td>Identifies the first day of the calendar week for the company. By default, the start of the week is Monday, meaning that the calendar week begins with Monday and ends with Sunday. To change this behavior, add the property glide.ui.filter.first_day_of_week to the instance as an integer property. Enter the integer corresponding with the day of the week that the calendar week begins on. 1 is Sunday, 2 is Monday, and so on. The function impacts all charts and calculations where the day of the week is used as a parameter.</td>
</tr>
<tr>
<td>glide.ui.chart.bar.horiz.max_col_slant_labels</td>
<td>Sets the maximum number of columns in a horizontal bar chart before slanting (angling) the labels.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.chart.pie.labels</td>
<td>Enables (true) or disables (false) labels on pie chart slices.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property to the [sys_properties] table.</td>
</tr>
<tr>
<td>glide.ui.chart.pie.labels.max_items</td>
<td>Sets the maximum number of pie chart slice values that can be returned to display the labels.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 8</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property to the [sys_properties] table.</td>
</tr>
<tr>
<td>glide.chart.data.label.truncate_to</td>
<td>Sets the maximum length of a data label for a chart. If longer, the label is truncated and an ellipsis (…) appended.</td>
</tr>
<tr>
<td></td>
<td>• Note: This property does not apply to stacked bar chart reports.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 13</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
<tr>
<td>glide.report.pivot.fixed_headers</td>
<td>When disabled, the header row of a pivot table is unfrozen and scrolls out of frame when the user scrolls through the table.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Add a system property [sys_properties] table</td>
</tr>
<tr>
<td>glide.report.metric_max_data_points</td>
<td>Configure the maximum number of data points per MetricBase report. Typically only MetricBase time series and bar chart reports will use this.</td>
</tr>
<tr>
<td></td>
<td>This property applies to multilevel pivot tables.</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.report.metric_max_series</td>
<td>Configure the number of series per MetricBase report.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 20</td>
</tr>
<tr>
<td></td>
<td>• Maximum value: 100</td>
</tr>
<tr>
<td></td>
<td>• Location: Add a system property to the System Property [sys_properties] table</td>
</tr>
</tbody>
</table>

#### Interactive Filters properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.homepage_interactivity.ui_ctrls_max_display_options</td>
<td>Maximum number of choices for radio button and check box interactive filters.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 25</td>
</tr>
<tr>
<td></td>
<td>• Location: Reports &gt; Administration &gt; Properties</td>
</tr>
</tbody>
</table>

#### Interactive Analysis

Interactive Analysis enables you to quickly explore data using visualizations.

Interactive Analysis allows you to access an interactive set of reports on the list data. You can also manipulate the data by grouping, stacking, aggregating, and applying interactive filters. Click the visualization to drill down into the data.
Click the information icon ( ) to edit the source filter, view the list of applied filters, and copy the URL of the analysis.

**Interactive Analysis on Incident data**

Launch Interactive Analysis from any list.

**Before you begin**
Role required: none
You must have access to the list of records that you want to analyze.

**Procedure**

1. Navigate to any list.

2. **Optional:** Configure the columns that are displayed on the list. The columns that appear on the list when you launch Interactive Analysis determine which fields are included in the analysis. The included fields determine which **Group by** and **Stack by** options are available, and which interactive filters appear by default.

3. Right-click the column header for a reference, choice, date/time, integer, or boolean field and select **Launch Interactive Analysis**. The column that you launch Interactive Analysis from is used as the default **Group by** value.
4. **Optional:** Change how data is aggregated by selecting different values in the **Group by** and **Stack by** choice lists, or filter the data by applying one or more interactive filters.

5. **Optional:** Drill down into a subset of the data by clicking a visualization, such as a bar in the bar chart or a cell in the heatmap.

**Interactive Filters deduplication**

When you launch Interactive Analysis, the **Filters** panel displays all of the configured filters that are available on your personalized view. So that you do not have to clean up the filter panel, duplicate filters are removed automatically.

Duplicate filters are removed according to the following criteria:

- If the configuration is the same, the UI control determines which filter is shown on initial launch. Multiple input filters have first priority, then single input, check box, and radio buttons. For reference on available UI control type field options for displaying the filter, see .

- If the configuration is the same, except that some filters have only one target and others have multiple targets, then only the last updated filter is retained.

- If both the configuration and the UI control are the same, then the last updated filter is retained.

- If the configuration is the same, but some filters have multiple target columns in the same target table, then all the filters are considered as separate filters and retained. An example of multiple target columns in the same target table is the **Date opened** and **Date escalated** columns in the incident table.

- If the configuration and the UI control are the same, but the base condition is different for any two filters, then they are considered separate filters and retained.

**Interactive Analysis information panel**

The **Filter Info** panel summarizes what the current filter shows and enables you to edit the source filter condition, bookmark an interactive analysis, and share an interactive analysis with colleagues.

Click the information icon ( ) to open the **Filter Info** panel.

The information panel has the following features:

**Source Filter**

Shows the conditions that apply to the filter. Click the star to add this interactive analysis to your favorites.
**Edit Source Filter**

Click the **Edit Source Filter** button to open the condition builder. You can edit the source filter here instead of reopening the definition page of the interactive filter.

**Applied Filter**

Shows a summary of the filters that are applied to the current interactive analysis.

**Share**

Shows the full URL of the analysis. Click the URL to highlight it. For more information, see .

---

**Bookmark an interactive analysis**

To save an interactive analysis for later use, you can add it to your favorites.
Procedure
1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select Launch Interactive Analysis.
3. Click the information icon (i) to open the Filter Info panel.
4. Apply filters to the interactive analysis and click Apply Filters.
5. Click the star icon to add the interactive analysis to your favorites.

Results
The favorites list on the navigation panel is updated with a bookmark for the current interactive analysis.

Share an interactive analysis
You can share the URL of an interactive analysis with other users.
Procedure

1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select **Launch Interactive Analysis**.
3. Click the filter icon (🔍) to show the interactive filters.
4. Make the desired filter changes and click **Apply Filters**.
5. Click the information icon (ⓘ) to open the **Filter Info** panel.
6. Right-click the URL in the **Share** section and select **Copy**.
Results
You can share the URL for the interactive analysis via email with users who have rights to the information in the analysis.

Add a filter to Interactive Analysis
Add a filter to show more refined information in your Interactive Analysis.

Procedure
1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select Launch Interactive Analysis.
3. Click the filter icon (istrator icon) and click Add filters. Use the Search Filters bar to limit the number of filters displayed.

4. Select the filter to add.
5. Click **Apply Filters**.

![Filter Configuration](image)

**Filters**

- **Add Filters**

  **INCIDENT CATEGORY**

  - Software
    - Software ×
    - Network ×
    - Database ×

  **ASSIGNMENT GROUP**

  - Change Management
    - Change Management ×

  **INCIDENT OPENED**

  - Last 6 months

![Apply Filters Button](image)

**Results**

The new filter is applied to the interactive analysis. Click the information icon (°) to view the filters in the source filter summary.

**Remove a filter from Interactive Analysis**

You can remove a filter from Interactive Analysis and specify whether to remove the filter element from Group by and Stack by lists in the analysis.
Procedure

1. Navigate to the table that you want to analyze.
2. Right-click on a column header and select Launch Interactive Analysis or open a dashboard that you own to show the interactive filters.
3. Click the filter icon (🔍) to show the interactive filters.
4. Point to the filter you want to remove and click the Remove filter icon.

Results
The filter is removed from the Interactive Analysis.

Edit source filters
You can edit a source filter in the Interactive Analysis Filter Info panel.

Procedure

1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select Launch Interactive Analysis.
3. Click the information icon (︾) to open the Filter Info panel.
4. Click Edit Source Filter.
5. Click **Load Filter** and select the filter to edit.

6. Edit the existing conditions and add new conditions.

7. Click **Save changes**.

**Results**
The interactive analysis updates with the new source filter. The **Filter Info** panel shows the updated conditions.

**Related information**
- Condition builder

**Interactive Analysis persistence**
The filters that you select persist between uses of Interactive Analysis per view and per user.

When you launch Interactive Analysis on a view, a specific column in a table, for the first time, all filters are set to their default values. The next time you launch Interactive Analysis on the same view, selections including filters, filter order, group by, stack by, and aggregation parameters persist from the previous visit.

In addition, **Group by** and **Stack by** elements are updated when filters are added to an analysis. For example, add a manager filter to an Interactive Analysis page. You can immediately group and stack your widgets by manager.
Synchronize Group by and Stack by elements in filters

Synchronize Group by and Stack by elements in an interactive analysis when filters are added to the filter panel and when they are removed from the filter panel. You can also remove a filter without synchronizing group by and stack by elements.

Procedure

1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select Launch Interactive Analysis.
3. In the Filters panel, click Add Filters and add a new filter.
4. Click Apply Filters.
   The new filter element appears in the Group by and Stack by lists.
5. Remove the filter from the interactive analysis to remove the filter from the Filters panel.

6. Optional: Select Remove element from Group by and Stack by.
   The option Remove element from Group by and Stack by is not shown if:
   - There is another filter on the Filters panel that has the same target field as the filter you are removing.
   - You have personalized the source list before launching interactive analysis.
   You cannot synchronize Group by and Stack by elements by adding or removing a filter if the column is part of a personalized list.

Interactive Analysis aggregations

When you work with Interactive Analysis, you can view data from the perspectives of record counts, sums, averages, and distinct counts.

Aggregation types

Count

Count is the default aggregation and shows when you launch Interactive Analysis. The Count aggregation shows the number of records selected. For example, an analysis of incidents grouped
by state, stacked by priority, and aggregated by count shows the number of incidents in each category in hints and in the cells of multidimensional reports.

**Average, Sum, Count Distinct**

Select **Average, Sum, or Count Distinct**, to show a list of fields from the selected **Table**. You may further be able to aggregate on fields from extended tables. See **How to report on extended tables**. Select a field to **Aggregate by** from this list. For example, if you select an integer field, such as **Reassignment count**, the data is expressed as a decimal value number. For more information, see **Column reports**.

**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.

If you select **Count Distinct**, only unique records are counted. For example, you want to generate a report with a distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.
Interactive Filters

Interactive Filters allow you to filter report widgets directly from a homepage or dashboard without modifying the reports.

You can create an interactive filter and add it to a homepage or dashboard as a widget. Selecting a value in the Interactive Filter widget filters the data in report widgets on the homepage or dashboard. On dashboards, selected filters are saved for each user and applied automatically next time that user views the dashboard.

Interactive filters on homepages do not retain default values or retain values across logins or page refreshes. This functionality is available on dashboards. For more information, see Create a dashboard version of a homepage.

Note: Interactive filters are not supported for reports which are based on a MetricBase source. For more information, see MetricBase.

For information about the unified filter experience on Workspace, see Now Experience filters.

Available Interactive Filter types

You can create Interactive Filters for multiple field types.
Interactive filter types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice list</td>
<td>Allows you to filter data based on the value of a specific choice list. You must select the table and choice list field. The filter affects reports on the specified table.</td>
</tr>
<tr>
<td>Reference</td>
<td>Allows you to filter data based on the value of one or more reference fields. You must select the referenced table, as well as reference fields from other tables. The filter affects reports on tables that have the specified reference fields.</td>
</tr>
<tr>
<td>Date</td>
<td>Allows you to filter data based on the value of one or more date fields. You must select the tables and date fields. The filter affects reports on the specified tables.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Allows you to filter data based on the value in a specific true/false field. You must select the table and the true/false field. The filter affects reports on the specified table.</td>
</tr>
<tr>
<td>Group</td>
<td>Allows you to display multiple interactive filters in a single widget on a homepage. Users viewing the homepage can select which grouped filters to apply.</td>
</tr>
<tr>
<td>Empty/ non-empty</td>
<td>Filter based on whether a field contains a value.</td>
</tr>
<tr>
<td>Cascading</td>
<td>Allow you to filter based on multiple values in a hierarchy, such as by region, country, and city.</td>
</tr>
</tbody>
</table>

Create a choice list interactive filter

A choice list interactive filter enables users to filter report widgets based on the value of a choice list.

Before you begin

Choice lists contain a limited number of specified values to choose from. Status and Priority are two examples of choice lists. User and location are not usually choice list selections. For more information, see Choice list field type.

Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.
**Note:** If the interactive filter has a default value or specifies the last selected value, non-responsive dashboards do not apply this value automatically. This feature is only available on Responsive dashboards.

**Procedure**

1. **Optional:** Check the existing interactive filters on the same table.
   a. Navigate to Homepage Admin > Interactive Filters and select an interactive filter based on the same table you want to filter.
   b. Under Related Links, select Other filters on Table.
   c. Review the other filters that are available on the same table to see if the filter you want already exists.

2. Navigate to Homepage Admin > Interactive Filters.

3. Click **New**.

4. In the **Filter based on** list, select **Choice list**.

5. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the Add content menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the Name value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See Available interactive filter UI control types.</td>
</tr>
</tbody>
</table>

6. **Optional:** Select **Apply to all tables in hierarchy** to apply the filter to parent, child, and sibling tables of an extended table.

7. **Optional:** Select **Apply filter to database views and tables** to apply the filter to widgets based on both database views and tables.

**Note:** It is not possible to apply filters to tables which extend the database view’s tables. For more information, see Interactive filters on database views and table hierarchies.
8. **Optional:** Exclude specific elements from appearing on the filter using the Exclusion list. However, data for excluded choices is included when you select All on the interactive filter.

9. In the Table list, select the table that contains the choice list to filter on.

10. In the Field list, select the field to filter on.

11. **Optional:** Add any list elements you want to exclude from the filter to the Exclusion list field.

12. **Optional:** Select a Default value for the filter. This default is applied automatically for all users. Values that a user selects override the global default for that user. You can specify more than one default value when using a UI control type that enables multiple selections, such as Select Multiple Input.

   ✉️ **Note:** To pass more than 50 default values, or if you see the error This is exceeding the GET call limitation, create multiple interactive filters.

13. Click **Submit**.

**What to do next**
After you create the filter, add it to a homepage or dashboard.

**Create a reference field interactive filter**
A reference field interactive filter allows users to filter report widgets based on the value of a reference field.

**Before you begin**
Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

 Cosby: If the interactive filter has a default value or specifies the last selected value, non-responsive dashboards do not apply this value automatically. This feature is only available on Responsive dashboards.
Procedure

1. **Optional:** Check the existing interactive filters on the same table.
   a. Navigate to **Homepage Admin > Interactive Filters** and select an interactive filter based on the same table you want to filter.
   b. Under Related Links, select **Other filters on Table**.
   c. Review the other filters that are available on the same table to see if the filter you want already exists.

2. Navigate to **Homepage Admin > Interactive filters**.

3. Click **New**.

4. In the **Filter based on** list, select **Reference**.

5. In the **Reference table** list, select the table that stores the referenced records you want to filter on.

6. **Optional:** Select a **Default value** for the filter.
   This default is applied automatically for all users. Values that a user selects override the global default for that user. You can specify more than one default value when using a UI control type that enables multiple selections, such as **Select Multiple Input**.

   **Note:** To pass more than 50 default values, or if you see the error **This is exceeding the GET call limitation**, create multiple interactive filters.

7. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the <strong>Add content</strong> menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the <strong>Name</strong> value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See <strong>Available interactive filter UI control types</strong>.</td>
</tr>
</tbody>
</table>

8. **Optional:** Select **Apply to all tables in hierarchy** to apply the filter to parent, child, and sibling tables of an extended table.
9. **Optional:** Select *Apply filter to database views and tables* to apply the filter to widgets based on both database views and tables.

   **Note:** It is not possible to apply filters to tables which extend the database view’s tables. For more information, see *Interactive filters on database views and table hierarchies.*

10. Right-click on the form header and select *Save.*

11. **Optional:** If the UI control type is *Select Single Input,* select *Remove All option* to configure the interactive filter without the All option.

12. In the *Interactive filter references* related list, click *New.* This related list does not appear until you save the filter.

13. In the *Reference table* field, select a table that has reports that you want to filter.

14. Select the *Reference field* to filter on.

   The field must reference the table specified in the parent filter *Reference table* field.

   You can dot-walk from fields that reference other tables. For example, if the parent filter *Reference table* is Department [cmn_department], you can select Incident as the reference *Reference table,* then select *Caller Department* as the *Reference field.*

15. **Optional:** Add a related list condition. You can add a condition to your filter based on the records in one related table.

   **a.** Click the link labeled *Greater than or Equal to 1.* From the list, select the number of records on the source table that must be related to a record on the target table.

   The options are:
   - Greater than or Equal to
   - Greater than
   - Less than or Equal to
   - Less than
   - Equal to
   - None
   - Between
b. Choose the related table.

c. Specify the conditions on that table that must be met for the filter to be valid.

16. Click Submit.

What to do next
Repeat steps 10–13 as needed for each reference field you want to filter on. After you create the filter, add it to a homepage or dashboard.

Note: A filter may be converted from the Check boxes control type to the Select Multiple Input control type for performance reasons.

Related reference
Available Interactive Filter types
Related information
Reference field type
Add related list conditions

Create a date interactive filter
A date interactive filter allows users to filter report widgets based on the value in a date field.

Before you begin
Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.
Note: If the interactive filter has a default value or specifies the last selected value, non-responsive dashboards do not apply this value automatically. This feature is only available on Responsive dashboards.

Procedure

1. Optional: Check the existing interactive filters on the same table.
   a. Navigate to **Homepage Admin > Interactive Filters** and select an interactive filter based on the same table you want to filter.
   b. Under Related Links, select **Other filters on Table**.
   c. Review the other filters that are available on the same table to see if the filter you want already exists.

2. Navigate to **Homepage Admin > Interactive filters**.

3. Click **New**.

4. In the **Filter based on** list, select **Date**.

5. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the Add content menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the Name value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See Available interactive filter UI control types.</td>
</tr>
</tbody>
</table>

6. Optional: Select **Apply to all tables in hierarchy** to apply the filter to parent, child, and sibling tables of an extended table.

7. Optional: Select **Apply filter to database views and tables** to apply the filter to widgets based on both database views and tables.

Note: It is not possible to apply filters to tables which extend the database view’s tables. For more information, see Interactive filters on database views and table hierarchies.
8. In the **Date** section, use the slushbucket to select one or more date ranges that users can filter on. Available date filters are defined in the **Get Date Filter options for Date Filters** business rule. Customize this business rule to add or remove filter options.

9. **Optional:** Select a **Default value** for the filter. This default is applied automatically for all users. Values that a user selects override the global default for that user. You can specify more than one default value when using a UI control type that enables multiple selections, such as **Select Multiple Input**.

⚠️ **Note:** To pass more than 50 default values, or if you see the error **This is exceeding the GET call limitation**, create multiple interactive filters.

10. Right-click on the form header and select **Save**.

11. In the **Interactive filter Dates** related list, click **New**.

12. In the **Table** field, select a table that has reports you want to filter.

13. In the **Field** field, select a date field to filter on.

14. Click **Submit**.

**What to do next**
Repeat steps 8-11 as needed for each date field you want to filter on. After you create the filter, add it to a dashboard or homepage.

**Create a boolean interactive filter**
A boolean interactive filter allows users to filter report widgets based on the value of a true/false field.

**Before you begin**
Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

⚠️ **Note:** If the interactive filter has a default value or specifies the last selected value, non-responsive dashboards do not apply this value automatically. This feature is only available on **Responsive dashboards**.
Procedure

1. Optional: Check the existing interactive filters on the same table.
   a. Navigate to Homepage Admin > Interactive Filters and select an interactive filter based on the same table you want to filter.
   b. Under Related Links, select Other filters on Table.
   c. Review the other filters that are available on the same table to see if the filter you want already exists.

2. Navigate to Homepage Admin > Interactive filters.

3. Click New.

4. In the Filter based on list, select Boolean.

5. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the Add content menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the Name value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See Available interactive filter UI control types.</td>
</tr>
</tbody>
</table>

6. Optional: Select Apply to all tables in hierarchy to apply the filter to parent, child, and sibling tables of an extended table.

7. Optional: Select Apply filter to database views and tables to apply the filter to widgets based on both database views and tables.

   Note: It is not possible to apply filters to tables which extend the database view’s tables. For more information, see Interactive filters on database views and table hierarchies.

8. In the Table list, select the table that contains the true/false field to filter on.

9. In the Field list, select the true/false field to filter on.

10. Optional: Select a Default value for the filter.
This default is applied automatically for all users. If a user selects a different value, that value is saved as the user's default and overrides the global default.

11. Click **Submit**.

**What to do next**
After you create the filter, add it to a homepage or dashboard.

**Create a group interactive filter**
A group interactive filter allows users to select multiple interactive filters to apply to reports on a homepage or dashboard.

**Before you begin**
Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

ℹ️ **Note:** If the interactive filter has a default value or specifies the last selected value, non-responsive dashboards do not apply this value automatically. This feature is only available on Responsive dashboards.

Before starting this procedure, create several choice list, reference field, boolean, or date filters to group.

ℹ️ **Note:** Default values selected for child filters are not applied when using a group filter. Selected values in a group filter are not saved when you reload the dashboard.

**Procedure**
1. **Optional:** Check the existing interactive filters on the same table.
   a. Navigate to **Homepage Admin > Interactive Filters** and select an interactive filter based on the same table you want to filter.
   b. Under Related Links, select **Other filters on Table**.
   c. Review the other filters that are available on the same table to see if the filter you want already exists.
2. Navigate to **Homepage Admin > Interactive filters**.
3. Click **New**.
4. In the **Filter based on** list, select **Group**.
5. Set the following fields:
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the <strong>Add content</strong> menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the <strong>Name</strong> value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See <a href="#">Available interactive filter UI control types</a>.</td>
</tr>
</tbody>
</table>

### Optional:

6. **Apply to all tables in hierarchy** to apply the filter to parent, child, and sibling tables of an extended table.

7. **Apply filter to database views and tables** to apply the filter to widgets based on both database views and tables.

    **Note:** It is not possible to apply filters to tables which extend the database view's tables. For more information, see [Interactive filters on database views and table hierarchies](#).

8. In the **Group** section, click **Insert a new row**.

9. Select an interactive filter to add to this group.

    You cannot add a group filter to another group filter.

10. Repeat steps 7 and 8 as needed for each filter you want to group.

11. Click **Submit**.

### What to do next

After you create the filter, add it to a dashboard or homepage.

### Create an interactive filter for whether a field is empty or populated

You can create a Boolean interactive filter that lets users filter report widgets based on whether a specific field is empty or populated.

### Before you begin

Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.
Note: If the interactive filter has a default value or specifies the last selected value, non-responsive dashboards do not apply this value automatically. This feature is only available on **Responsive dashboards**.

About this task
Create this filter for a field where **Yes** filters for records where the specified field is populated and **No** filters for records where the field is empty. Name the filter to represent this logical relationship. For example, you can use the name "Incident generated problem" for a filter based on the Incident table and the Problem field.

Procedure
1. Navigate to **Reports > Interactive filters**.
2. Click **New**.
3. In the **Filter based on** list, select **Boolean**.
4. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the <strong>Add content</strong> menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the <strong>Name</strong> value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See <strong>Available interactive filter UI control types</strong>.</td>
</tr>
</tbody>
</table>

5. Optional: Select **Apply to all tables in hierarchy** to apply the filter to parent, child, and sibling tables of an extended table.

6. Optional: Select **Apply filter to database views and tables** to apply the filter to widgets based on both database views and tables.

   Note: It is not possible to apply filters to tables which extend the database view’s tables. For more information, see **Interactive filters on database views and table hierarchies**.

7. In the **Table** list, select the table that contains the field to filter on.
8. In the Field list, select the field to filter on.

9. Click Submit.

What to do next
After you create the filter, add it to a homepage or dashboard.

Create a cascading filter
Cascading filters allow you to filter based on multiple values in a hierarchy, such as by region, country, and city. Lower-level choices are filtered by the values selected at higher levels. For example, you can create a cascading filter that allows users to select from a list of managers, then select from groups that report to that manager. Report data is then filtered to show only records assigned to that group. Alternatively, you can leave lower levels of the filter unselected, such as by selecting only a manager but no group. Report data is then filtered to show records assigned to any group managed by that manager. Cascading filters retain the last elements selected on a dashboard.

Before you begin
Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

Ensure that the structure of the data that you use to create the filter is consistent. For example, in a cascading filter based on location, ensure that the top-level choices are all regions, and the second-level choices are all countries. You can define filter conditions to ensure that only appropriate choices for each level are available.

About this task
This procedure includes examples based on a cascading interactive filter using managers and groups. In this example, the top-level choice allows users to select a manager and the second-level choice allows users to select a user group managed by that manager.
Example cascading filter
By manager and group

Manager
Abel Tuter

Group
All

CAB Approval
Database Atlanta
eCAB Approval

Only groups managed by the selected manager appear

Note: You can filter reports based on the values in reference fields only. Cascading filters support only the Single Select UI control type.

Procedure
1. Homepage Admin > Interactive filters.
2. Click New.
3. In the Filter based on list, select Cascading Filters.
4. Right-click the form header and select Save.
5. Define the first level of the cascading filter.
   a. In the Cascading Filter related list, click New.
   b. Select the Table and the Display field from the table that contains the values you want to use as the top-level filter choices. The Display Field is limited to the types boolean, choice, reference, and string. To define the top level of a hierarchy based on managers and the groups they manage, select Group [sys_user_group] as the Table and Manager as the Display field.
   c. Optional: Use the Filters field to limit which choices are available to users.
Filter conditions are especially useful when you create a cascading filter based on a self-referencing table, such as Location [cmn_location]. Filter the data to ensure that each level of the cascading filter only has options appropriate for that level.

d. Right-click the form header and select Save.

6. Define the next level of the hierarchy.
Cascading filters use a one-to-many relationship between higher-level filters and lower-level filters. One higher-level filter can affect the choices available in any number of lower-level filters.

a. From the manager filter, in the Cascading Filter related list, click New.

b. Select the Table and the Display field from the table that contains the values you want to use as the second-level filter choices. The Display Field is limited to the types boolean, choice, reference, and string. In the managers and groups example, select Group [sys_user_group] as the Table and Name as the Display field.

c. In the Parent Reference Field field, select the field that contains the value selected from the higher-level filter. For example, when you create the Group filter, the Parent Reference Field value is Manager. In this example, the manager selected in the first filter is used to filter the list of available groups based on the Manager field value of each group.

d. Right-click the form header and select Save.

e. Repeat these substeps for each additional filter you want to add. To add another level to the filter hierarchy, add a new record in the Cascading Filter related list of the lowest-level filter. For example, add the Group filter instead of a top-level filter such as the Manager filter.

7. Define how each filter level applies the filter to reports on a dashboard.

a. In the Target Tables related list, click New.

b. Select the Target table that contains the data you want to filter, such as Incident.

c. Select the Field to filter on.
The field must reference the table specified in the filter. For example when filtering incident data, the Field for the top-level manager filter is **Assignment group.Manager**. In this example, the Field for the second-level group filter is **Assignment group**.

d. Click **Submit**.

e. Repeat these substeps to add targets for each level of the filter.

You can define multiple targets for each filter level. For example, filter incident data by assignment group or CMDB CIs by support group using the same Groups [sys_user_group] filter.

**Note:** A cascading filter hierarchy must specify at least one target.

You can define a cascading filter that skips levels in a hierarchy, or a cascading filter that only specifies targets for certain levels in a hierarchy. For example, define a target only for the Group-level filter and not the Manager-level filter. In this example, reports are filtered only when a user selects a specific group and not just a manager.

The following images demonstrate the completed configuration for the example cascading filter. The **Cascading Filter** related list (not shown) in the top-level filter contains the second-level filter.

---

**What to do next**

After you create all levels of the filter, add it to a homepage or dashboard.

**Cascading filters deduplication**

So that you do not have to clean up the filter panel, duplicate filters are removed automatically.

Duplicate filters are removed according to the following criteria:
• If the configuration is the same, the last edited filter is retained.

• If the configuration is the same, except that some filters have only one target and others have multiple targets, then only the last updated filter is retained.

• If the configuration is the same, but some filters have multiple target columns in the same target table, then all the filters are considered as separate filters and retained. An example of multiple target columns in the same target table is the Date opened and Date escalated columns in the incident table.

• If the configuration and the UI control are the same, but the base condition is different for any two filters, then they are considered separate filters and retained.

Interactive filters on database views and table hierarchies

When you create an interactive filter on an extended table, you can also apply the filter to database views and to the other tables in the hierarchy.

When you create an interactive filter, you can:

Select All tables in the hierarchy.

If the source table is incident, then the interactive filter applies to incident; its parent table, task; and to its sibling tables, problem and change.

Select Apply filter to both database views and tables.

If the source table is incident, then the interactive filter applies to both incident and, for example, the [incident_sla] database view.

Select both check boxes.

The interactive filter applies to all tables in the hierarchy and to database views.

Select neither check box.

Interactive filters apply only to the source table, such as incident.

Note: This is the default setting when you create an interactive filter.
Interactive filters applied to extended tables also apply to the other tables in the hierarchy.

**Note:** Interactive filters on a database view do not apply automatically to the siblings of the database view's source table. For example, [problem_sla] is a database view created on the table [task_problem]. Interactive filters applied to [problem_sla] do not apply automatically to widgets based on the [task_change] table, a sibling of [task_problem], even if you have selected both options.

### Available interactive filter UI control types

The interactive filter **UI control type** field provides several options for displaying the filter.

<table>
<thead>
<tr>
<th>UI control type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radio Buttons</td>
<td>Displays each filtering option as a radio button. Users can select only one radio button at a time.</td>
</tr>
<tr>
<td>Check boxes</td>
<td>Displays each filtering option as a check box. Users can select any number of check boxes at a time.</td>
</tr>
<tr>
<td>Select Single Input</td>
<td>Displays the filtering options as a choice list. Users can select only one choice at a time.</td>
</tr>
<tr>
<td>Select Multiple Input</td>
<td>Displays the filtering options as a choice list. Users can select any number of choices at a time. Click the X next to a selected choice to deselect that choice.</td>
</tr>
</tbody>
</table>
Note: Filtering behavior depends on the filter type when selecting multiple values using the Check boxes or Select Multiple Input control types. Choice and reference filters use an AND query, meaning records must match all conditions. Date filters use an OR query, meaning records must match at least one of the specified conditions.

Note: A filter may be converted from the Check boxes to the Select Multiple Input control type for performance reasons.

Interactive Filters on homepages and dashboards
You can make an Interactive Filter available to users by adding the filter to a homepage or dashboard.

To be effective, interactive filters must be based on the same tables as the reports they filter. Report widgets based on the user table, for example, do not change based on the settings of Interactive Filters based on the incident table. For more information, see Make a report follow interactive filters.

Add an interactive filter widget to a responsive dashboard
Add an interactive filter to a dashboard to filter reports on that dashboard.

Before you begin
Role required: pa_power_user. You must have edit access to the dashboard you want to add the widget to.

About this task
To be effective, interactive filters must be based on the same tables as the reports they filter. Report widgets based on the user table, for example, do not change based on the settings of Interactive Filters based on the incident table. For more information, see Make a report follow interactive filters.

Procedure
1. Navigate to a dashboard.
2. Click the add content icon ( + ).
3. Select Interactive filters.
4. Select the type of filter to add, such as Choice list or Reference.
5. Select the filter you want to add.
6. Click Add or drag the filter onto the dashboard.
Add an interactive filter widget to a non-responsive dashboard

Add an interactive filter to a dashboard to filter reports on that dashboard.

Before you begin
Role required: pa_power_user

⚠️ Note: If the interactive filter has a default value or specifies the last selected value, this value is not applied automatically on non-responsive dashboards. This feature is only available on Responsive dashboards.

About this task
To be effective, interactive filters must be based on the same tables as the reports they filter. Report widgets based on the user table, for example, do not change based on the settings of Interactive Filters based on the incident table. For more information, see Make a report follow interactive filters.

Procedure
1. Navigate to a dashboard.
2. Click Edit.
3. Click the add content icon (+).
4. In the Add content menu, select Interactive filters from the left column.
5. Select the type of filter to add, such as Choice list or Reference.
6. Select the filter you want to add.
7. Click Add here in the section you want the filter to appear.

Add an interactive filter widget to a homepage

You can use an interactive filter by adding the filter widget to a homepage.

Before you begin
Role required: itil, report_user. You must have edit access to the homepage you want to add the filter to.

About this task
Add an interactive filter to a homepage to filter reports on that homepage. To be effective, interactive filters must be based on the same tables as the reports they filter. Report widgets based on the user table, for example, do not change based on the settings of Interactive Filters based on the incident table. For more information, see Make a report follow interactive filters.
Note: Interactive filters on homepages do not retain default values or retain values across logins or page refreshes. This functionality is available on dashboards. For more information, see Create a dashboard version of a homepage.

Procedure
1. Navigate to a homepage.

2. Click the add content icon (+).

3. In the Add content menu, select Interactive filters from the left column.

4. Select the type of filter to add, such as Choice list or Reference.

5. Select the filter you want to add to the homepage.

6. Click Add here in the section you want the filter to appear.

Make a breakdown act as an interactive filter
You can configure a breakdown on a dashboard to act as an interactive filter for reports on the dashboard.

Before you begin
There must be a dashboard configured with one or more reports and breakdowns, and an interactive filter based on the same table as the breakdown source.

The Act as Filter column in the Breakdown Source related list is visible by default unless you have personalized the list columns. See Add Act as Filter column.

Role required: pa_power_user, pa_admin, or admin

About this task
When you select a breakdown and breakdown element on a dashboard, that element can be used to filter reports on the dashboard based on the filtering rules defined in an interactive filter.

Procedure
1. Navigate to Performance Analytics > Dashboards.

2. Select the dashboard with the breakdown you want to make act as an interactive filter.

3. Click the context menu icon and select Dashboard Properties.

4. In the Act as filter field, select the interactive filter you want this breakdown source to act as.
The breakdown source **Facts table** must match the table that the interactive filter is based on.

For example, for the breakdown source HR.Groups.Active, use a reference field interactive filter for the Groups [sys_user_group] table. Breakdown elements from the HR.Groups.Active breakdown source are not valid selections for interactive filters on other tables, such as interactive filters based on a choice or date field.

ℹ️ **Note:** You cannot use a breakdown source that is based on a bucket group as an interactive filter.

5. Click **Update**.
6. On the dashboard's record, click **View Dashboard**.
7. Click the + icon to put the dashboard in edit mode.
8. Click the cog icon to open the Edit Widget window.
9. Select **Follow interactive filter**.
   
   Select **Show when following filter** to show a filter icon next to the widget title when the widget is following an interactive filter.
10. Click **Done**.

**Results**
The selected breakdown acts as an interactive filter on the dashboard's reports.

**Add Act as Filter column**

When you configure breakdown sources on a dashboard, the **Act as Filter** column is usually visible by default. If it is not visible in the **Breakdown Source** related list, you can add it.

**Before you begin**
Role required: pa_power_user, pa_admin, or admin

**Procedure**

1. Navigate to **Performance Analytics > Dashboards**.
2. Select any dashboard.
3. Click the context menu icon and select **Dashboard Properties**.
4. Click the Breakdown source Column options icon and select **Configure > List**

![Dropdown menu showing List Layout and related options]

**Related Links**
- View Dashboard
- Launch Dependency Assessment

<table>
<thead>
<tr>
<th>Breakdown Source</th>
<th>Domain Configuration</th>
<th>Dashboard</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Layout.**

There are context menu icons next to the name of the related list and next to the column header. Both are called **Breakdown Source**. Only the context menu next to column header has the choice to select **Configure > List Layout**.

5. Move Act as filter to the **Selected** column and click **Save**.

**Results**

The Act as filter column is visible in the **Breakdown Source** related list for all dashboards.

**Make a report follow interactive filters**

You can configure a report widget to accept input from interactive filters.

**Before you begin**

Role required: itil, report_user

**Procedure**

1. Navigate to a homepage or dashboard.
2. Put the dashboard or homepage in edit mode.
3. In the report widget, click the Edit widget icon (🔗).

4. Select **Follow interactive filter**.
   This option is available for all report widgets. If you do not see the **Follow interactive filter** option, the widget is a list, PA, or other non-report widget.

5. To show a filter icon (🔗) on the top left corner of the report when it is following an interactive filter, select **Show when following**.

6. Click **Done**.

7. Refresh the current browser page to apply the change.

**What to do next**
Add one or more interactive filters to the homepage or dashboard.

**Related information**
- Edit a responsive dashboard

**Make a report act as an interactive filter**
You can configure an existing report widget to filter other report widgets on the same homepage or dashboard.

**Before you begin**
Role required: itil, report_user

**Procedure**
1. Navigate to a homepage or dashboard.
2. Put the dashboard into Edit mode.
   - On a non-responsive dashboard, click **Edit**.
   - On a responsive dashboard, click the sharing icon (🔗).
3. Point to the top of the report widget, and click the Edit widget icon (🔗).
4. Select **Act as interactive filter**.
   This field appears only for reports that can be filters. Only reports with a **Type** value of pie, donut, semi donut, funnel, or pyramid may be filters.

   **Note:** If responsive canvas is disabled, then there is no delay in filtering when a user clicks segments of a report that acts an interactive filter in quick succession.

5. Click **Done**.
6. Refresh the current browser page to apply the change.
What to do next
Click a subset of data in the report, such as a slice of pie in a pie chart, to filter all subscriber reports for the same table. All subscriber reports on the homepage or dashboard for the same table show information about that subset of data only.

Reset all interactive filters on a dashboard tab
Reset all applied filters on a dashboard tab to view the unfiltered data.

Before you begin
Role required: none. You must have access to the dashboard.

Procedure
1. Navigate to Self-Service > Dashboards.
2. Select the dashboard and tab that you want to reset.
3. Click the context menu (Ξ) and select Reset Filters.

Custom interactive filters
As an administrator, you can create scripted interactive filter widgets to provide advanced filtering options on dashboard reports.

With a custom interactive filter, you can control aspects of the filter interface and filtering logic. Create filters that fit your specific needs. Custom interactive filters include filters that perform multiple, common filtering operations with a single click.

Custom filters are scripted System UI Widgets that use the DashboardMessageHandler JavaScript class to define and publish report filters.

Note: The exposed API for custom interactive filters is limited and does not provide parity with standard interactive filters. Before implementing any custom interactive filters, review the Custom interactive filter limitations.

Note: Access control lists on the Table API may restrict the records shown when a dashboard is filtered. To alleviate this problem, add users or roles to the Table API access control list. For more information, see Access control list rules.

The code that publishes the filter must call the SNC.canvas.interactiveFilters.setDefaultValue() method and it must call the dashboardMessageHandler.publishFilter() method to publish the filter.

Define the appearance of the widget, such as available buttons, using Jelly.
Note: You can add multiple custom interactive filters to the same dashboard. The filters must have unique IDs in the filter object and unique IDs for the DashboardMessageHandler.

Custom interactive filter example
As an administrator, you can create custom interactive filter widgets to provide advanced filtering options on dashboards.

Use case
This example details how to create a custom filter to filter reports on the Task table, or its child tables. The filter only shows records where the current user is the caller. The filter exposes two buttons to the user, one button to add the filter and one to remove the filter.

Create the widget
To create a custom filter, navigate to Content Management > Blocks > Dynamic. Click New to create a new dynamic content record and define the user interface for the filter.

Define the filtering logic
Filters use the DashboardMessageHandler class to manage active filters. Instantiate DashboardMessageHandler with a unique value.
Note: The ID of the custom interactive filter must be unique. If it has the same ID as another interactive filter or custom interactive filter, the filtering logic does work properly.

The **Only mine** button publishes a filter on Task table reports using the encoded query `caller_idDYNAMIC90d1921e5f510100a9ad2572f2b477fe`. The **All tasks** button removes the filter.

You can then add buttons or other interface elements to the dynamic content. In this example, the code for the `clearFilter()` function and the buttons in the filter are added below the `publishFilter()` function.

```xml
<?xml version="1.0" encoding="utf-8" ?>
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
<script>
    var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");

    function publishFilter () {
        var filter_message = {};
        filter_message.id = "my_unique_id";
        filter_message.table = "task";

        <!-- Add your own filter query logic here -->
        filter_message.filter = "assigned_toDYNAMIC90d1921e5f510100a9ad2572f2b477fe";
        SNC.canvas.interactiveFilters.setDefaultValue({
            id: filter_message.id,
            filters: [filter_message]
        }, false);
        my_dashboardMessageHandler.publishFilter(filter_message.table,
        filter_message.filter);
    }

    function clearFilter() {
        var filter_message = {};
        filter_message.id = "my_unique_id";
        filter_message.table = "task";
        filter_message.filter = "";
        SNC.canvas.interactiveFilters.setDefaultValue({
            id: filter_message.id,
            filters: [filter_message]
        }, false);
        my_dashboardMessageHandler.removeFilter();
    }
</script>
```
Example of a filter that generates a static filter on 'task' table reports, or removes it

```html
<br/>
<input id="allTasks" type="button" value="All tasks" onclick="clearFilter();" />
<input id="onlyMine" type="button" value="Only mine" onclick="publishFilter();" />
</j:jelly>

Add the filter to a dashboard

After creating the filter, add it to a dashboard that contains reports on the Task table or child tables.

Clicking the **Only mine** button on the filter filters reports on the dashboard to only show tasks where the current user is the caller.

### Custom filter

```
Publisher sample
Example of a publisher, that generates a static filter on 'task' table or removes it

[All tasks] [Only mine]
```

### Related information

- Configure a content block
- UI scripts
- Jelly tags
- Add an interactive filter widget to a homepage
- Add an interactive filter widget to a non-responsive dashboard
- DashboardMessageHandler

### Custom interactive filter example - Multiple reports

You can use a custom interactive filter to filter multiple reports using different tables. There are two different APIs to publish an interactive filter for a single table or multiple tables. This example filters a report on the incident and problem tables by assignment group using a custom interactive filter.

### About custom interactive filters on multiple tables

Keep the following in mind when you create a custom interactive filter:
• Custom interactive filters that apply to only one table use the function `DashboardMessageHandler.publishFilter()`.

• Custom interactive filters that apply to multiple tables use the function `DashboardMessageHandler.publishMessage()`.

• Before you publish, an interactive filter call to the `SNC.canvas.interactiveFilters.setDefaultValue()` function is required.

• A call to either the `SNC.canvas.interactiveFilters.removeDefaultValue()` or the `DashboardMessageHandler.removeFilter()` function is required before you reset the filter.

A custom interactive filter that calls the `publishFilter()` method multiple times refreshes the associated report the same number of times. Repeated calls to this method can cause performance issues.

**How to apply Custom Interactive Filter to multiple tables**

The following example filters the report by assignment group on the Incident [incident] and Problem [problem] tables.

`DashboardMessageHandler.publishMessage()` accepts multiple filters as an array. Construct the filter array and then create a single instance of `DashboardMessageHandler` which calls `DashboardMessageHandler.publishMessage([[filters]])`. This method refreshes the widget only once.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<j:jelly xmlns:j="jelly:core" xmlns:g="glide" xmlns:g2="null" xmlns:j2="null" trim="false">
  <script>
    var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");

    function publishMultipleFilter() {
      <!-- Multiple filters can be passed as an array -->
      var finalFilter = [
        {"table":"incident","filter":"assignment_group=6fcd3b573b331300ad3cc9bb34efc447"},
        {"table":"problem","filter":"assignment_group=6fcd3b573b331300ad3cc9bb34efc447"};
      <!-- call setDefaultValue first -->
      SNC.canvas.interactiveFilters.setDefaultValue({
        id: my_dashboardMessageHandler._unique_id,
        filters: finalFilter,
      }, false);

      <!-- then call PublishMessage to publish filters-->
      my_dashboardMessageHandler.publishMessage(finalFilter);
    }
  </script>
</j:jelly>
```
function clearFilter() {
    SNC.canvas.interactiveFilters.removeDefaultValue(my_dashboardMessageHandler._unique_id,
        false);
    my_dashboardMessageHandler.removeFilter();
}
</script>

Example of a filter that filters incident and problem table where the assignment group is Problem solving
<input id="allTasks" type="button" value="All" onclick="clearFilter();" />
<input id="onlyMine" type="button" value="Assignment group is [Problem solving]" onclick="publishMultipleFilter();" />
</j:jelly>

Use the Debug filter

The debug interactive filter helps you create custom filters. This filter displays a JSON array representation of all active filters on a dashboard.

About this task
To use the debug filter, add it to a homepage. The debug filter is read-only and intended to aid in the design and implementation of custom interactive filters.

Use the Debug filter

The debug interactive filter helps you create custom filters. This filter displays a JSON array representation of all active filters on a dashboard.

About this task
To use the debug filter, add it to a homepage. The debug filter is read-only and intended to aid in the design and implementation of custom interactive filters.

Procedure

1. In the dashboard, click the Add widgets ( + ) icon.
2. In the Add Widgets panel, select the widget category Interactive Filters and the widget (Debug).
3. In the Debug filters list, select Debug homepage filters and click Add.

Results
The widget is added to your dashboard.
Custom interactive filter limitations

Custom interactive filters are a fallback for use when standard interactive filters do not provide certain functionality.

⚠️ Note: The exposed DashboardMessageHandler API for custom interactive filters is limited and does not provide parity with standard interactive filters. The API does not support these features.

Unsupported custom interactive filter features

Setting default filter values

Creators of custom interactive filters are not able to select default filter values.

Retaining filter value on refreshing the widget

When you click a widget's refresh icon (↺) to refresh its content, or when you select Refresh from the context menu (≡), the custom interactive filter value does not persist.

Resetting custom filter values / All filter values

When you select Reset Filters from the context menu (≡), the custom interactive filter does not change and is still applied.

Setting filter values on page load or tab switch

Custom interactive filter values do not persist when the user switches tabs, or opens a new dashboard and returns to the first dashboard or dashboard tab.

Adding multiple instances of the same custom interactive filter on a tab

If there is more than one instance of the same custom interactive filter on a tab, unexpected behavior can result.

⚠️ Note: Custom interactive filter values do not persist across tabs. To filter values on multiple tabs on the same dashboard, you must add the custom interactive filter to each tab.

Unsubscribing reports on removal of custom interactive filter

Reports following a custom interactive filter on a dashboard continue to follow that filter even when the filter is deleted from the dashboard.

Applying a custom interactive filter to more than one table at a time
In the definition of a custom interactive filter, it is possible to specify only one table. If multiple tables are specified, the filter is invalid. The publishFilter method of the API only takes one table as an argument.

Filtering widgets in Export to PDF

When you create custom content to be placed as widgets on dashboards and home pages, you must perform extra tests before you export the content to PDF. In the exported PDF, report widgets that are filtered using custom interactive filters may appear as blank squares or the widget content does not respect the filter.

Custom filters do not apply to lazy loaded dashboard widgets

Custom interactive filters only apply to the widgets below the filter and on the screen when the filter is visible. Widgets that are loaded when the user scrolls through a longer dashboard are not filtered. For more information on lazy loading, see Differences between homepages and responsive and non-responsive dashboards.

Custom interactive filters cannot be used in a breakdown dashboard

On breakdown dashboards, the breakdown itself is used to filter all Performance Analytics widget data. For more information, see Using breakdowns on dashboards.

DashboardMessageHandler

The DashboardMessageHandler class allows you to define custom filtering logic for interactive publishers.

DashboardMessageHandler - DashboardMessageHandler(String id)

Instantiate a DashboardMessageHandler object with a given unique ID.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>String</td>
<td>A unique ID for the filter. This ID allows report widgets to track which filter applied each filter. The ID does not need to be unique across all dashboards, but each dashboard cannot have multiple filters with the same ID.</td>
</tr>
</tbody>
</table>

```java
var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");
```
DashboardMessageHandler - publishFilter(String table, String encodedQuery)

Each DashboardMessageHandler object can publish a single filter.

Publishing a new filter from the same object overwrites the original filter. Use multiple DashboardMessageHandler objects to publish multiple filters.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>String</td>
<td>The table to filter, such as task.</td>
</tr>
<tr>
<td>encodedQuery</td>
<td>String</td>
<td>An encoded query that specifies the filter to publish.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```javascript
var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");
<input id="onlyMine" type="button" value="Only mine"
onclick="my_dashboardMessageHandler.publishFilter('task','caller_idDYNAMIC90d1921e5f510100
a9ad2572f2b477fe');"/>
```

DashboardMessageHandler - removeFilter()

Removes the current filter published by this DashboardMessageHandler object from all reports on the homepage or dashboard.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>
 Analytics and Reporting Solutions

Prepackaged solutions featuring Performance Analytics components are available for many ServiceNow® products. These content packs contain some initial best practice key performance indicators (KPIs) and dashboards you can use to get started quickly.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can use Performance Analytics for your application with minimal setup. You can also create your own objects.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

**Required Performance Analytics entitlement**

To enable an Analytics and Reporting Solution, you must be entitled to use Performance Analytics with the relevant ServiceNow product. For example, to enable the Customer Service Management - Advanced Analytics and Reporting Solution, you must be entitled to use Performance Analytics for Customer Service Management.

Analytics and Reporting Solutions that do not contain any Performance Analytics components do not require a Performance Analytics entitlement.

**Related information**

Activating your Performance Analytics subscription

**Available Analytics and Reporting Solutions**

The following Analytics and Reporting Solutions are available for their corresponding ServiceNow Performance Analytics entitlements. The solutions are at no extra charge, but the underlying applications require appropriate licensing.
Analytics and Reporting Solutions provide dashboards and underlying Performance Analytics components. These dashboards leverage Performance Analytics to create greater value for the product each Analytics and Reporting Solution supports.

**General Performance Analytics Solutions**
Activate the following Performance Analytics Solutions with any paid-for Performance Analytics entitlement.

- Configuration Management (CMDB) (com.snc.pa.cmdb)
- Guided Tours dashboard
- Knowledge Management (com.snc.pa.knowledge_v2)
- Service Desk Chat (com.snc.pa.chat)
- Service Portal (sn_portal_db, on ServiceNow Store)

**Performance Analytics Solutions for APM**
Activate the following Solutions when you have the Performance Analytics for APM entitlement.

- Application Portfolio Management (com.snc.pa.apm)
- Application Portfolio Management and Change Management (com.snc.pa.apm.change_request)
- Application Portfolio Management and Problem Management (com.snc.pa.apm.problem)
- Financial Management (com.snc.pa.fm)
- Financial Management for Customer Service (com.snc.pa.fm.csm)
- Financial Management for Field Service Management (com.snc.pa.fm.fsm)
- Financial Management for Financial Planning (com.snc.pa.financial_planning)
- Project Portfolio Suite with Financials (com.snc.financial_planning_pmo)
  Starting in New York, this solution replaces the Project Portfolio Suite (com.snc.pa.ppm) Solution. It includes dashboards for Time Card Management.

**Performance Analytics for Customer Service Solutions**
Activate the following Solutions when you have the Performance Analytics for Customer Service entitlement.

- Advanced Work Assignment (com.snc.pa.awa)
- Change Management (com.snc.pa.change)
- Communities (com.snc.pa.communities)
• **Customer Service (com.snc.pa.customer_service)** - Includes a Spotlight Group and reports. Activation also activates the Spotlight plugin. See [Activate Analytics and Reporting Spotlight solutions](#).

• **Customer Service Management - Advanced (com.snc.pa.customer_service_advanced)** Preconfigured Performance Analytics indicators and breakdowns for Customer Service Management. Has the contents of the older OOTB Customer Service Performance Analytics Solution, and also supports the following features:
  ◦ Case Management
  ◦ Major Issue Management
  ◦ Customer Service Case Action Status
  ◦ Customer Service with Request Management
  ◦ Customer Service with Service Management
  ◦ Agent Chat
  ◦ Advanced Work Assignment for CSM
  ◦ Performance Analytics - Content Pack - Advanced Work Assignment

• **Field Service Management (com.snc.work_management_pa)**

• **Incident Management (com.snc.pa)**

  ⚠️ **Note:** Incident management content is available by default with Performance Analytics in a limited version.

• **Incident SLA (com.snc.pa.sla)**

• **ITSM Dashboards (com.snc.pa.itsm_dashboards)**

• **Major Incident Management (com.snc.pa.incident.mim)**

• **Problem Management (com.snc.pa.problem)**

• **Request Management (Requested Item) (com.snc.pa.request)**

• **Request Management (Requests) (com.snc.pa.request2)**

• **Self-Service Analytics for Customer Service (com.snc.pa.self_service_analytics_csm)**

  ⚠️ **Note:** To use Performance Analytics with Self-Service Analytics for applications other than Customer Service Management, see [Adding Self-Service Analytics widgets to a dashboard or Service Portal](#).

• **Virtual Agent content pack:** This Analytics and Reporting Solution has been deprecated starting in the Quebec release. Use the [Conversational Analytics Dashboard](#) instead.
• Spotlight - Incident Spotlight Content Pack (com.snc.pa.spotlight.incident)
• Spotlight - Problem Spotlight Content Pack (com.snc.pa.spotlight.problem)
• Spotlight - Request Spotlight Content Pack (com.snc.pa.spotlight.request)

ℹ️ Note: For Performance Analytics Spotlight solutions, see Analytics and Reporting Spotlight solutions.

Performance Analytics for Governance, Risk, and Compliance Solutions
When you have the Performance Analytics for GRC entitlement, first activate the GRC: Performance Analytics Premium Integration plugin. Then activate the following Solutions:
• GRC: Audit Management
• GRC: Policy and Compliance Management
• GRC: Risk Management

Performance Analytics for Human Resource Management Solutions
Activate the following Solutions when you have the Performance Analytics for Human Resource Management entitlement:
• Content Analytics (com.snc.pa.premium.content_analytics)
• Content Automation (com.snc.pa.premium.content_automation)
• Human Resources Employee Document Management Scoped App (com.sn_hr_employee_files_pa)
• Human Resources Scoped App (com.sn_hr_pa)

ℹ️ Note: The solution for the unscoped version of Human Resources, com.snc.pa.hr_core, is deprecated. If you are using the unscoped version of Human Resources and want to activate its solution plugin, contact Customer Service and Support.
• Human Resources Lifecycles Events Scoped App (com.sn_hr_lifecycle_pa)

Performance Analytics for Business Management, Financial Management, and Service Strategy Solutions
Activate the following solutions if you have an entitlement to Performance Analytics for Business Management, Performance Analytics for Financial Management, or Performance Analytics for Service Strategy:
• Agile 2.0 (sn_scrum_dashboard on ServiceNow Store)
• Essential SaFE
• Financial Management (com.snc.pa.fm)
• Financial Management for Application Portfolio Management (com.snc.pa.fm.apm)
• Financial Management for Customer Service (com.snc.pa.fm.csm)
• Financial Management for Field Service Management (com.snc.pa.fm.fsm)
• Financial Management for Financial Planning (com.snc.pa.financial_planning)
• Financial Services Operations (sn_bom_pa)
• Project Portfolio Suite with Financials (com.snc.financial_planning_pmo)
  Starting in New York, this solution replaces the Project Portfolio Suite (com.snc.pa.ppm) Solution. It includes dashboards for Time Card Management.

Performance Analytics for ITOM Solutions
Activate the following Solutions when you have the Performance Analytics for IT Operations Suite or Performance Analytics for IT Operations Management entitlements:
• Cloud Management (com.snc.pa.cmp)
• Discovery (com.snc.pa.discovery)
• Event Management (com.snc.pa.em)
• Operational Intelligence (com.snc.sa.metric.pa.content)
• Service Mapping (com.snc.service-mapping.pa.content)

Performance Analytics for Project Portfolio Management Solutions
Activate the following Solutions when you have the Performance Analytics for Project Portfolio Management entitlement:
• Project Portfolio Suite with Financials (com.snc.financial_planning_pmo)
  Starting in New York, this solution replaces the Project Portfolio Suite (com.snc.pa.ppm) Solution. It includes dashboards for Time Card Management.

Performance Analytics for Security Incident and Vulnerability Response Solutions
Activate the following Solutions when you have the Performance Analytics for Security Incident Response entitlement:
• Security Incident Response (com.snc.security_incident.analytics - in ServiceNow Store)
• Vulnerability Response (com.snc.vulnerability.analytics - in ServiceNow Store)
Performance Analytics for Service Management Solutions
Activate the following Solutions when you have the Performance Analytics for Service Management entitlement:

- Change Management (com.snc.pa.change)
- Incident Management (com.snc.pa)

⚠️ Note: Incident management content is available by default with Performance Analytics in a limited version.

- Incident SLA (com.snc.pa.sla)
- ITSM Dashboards (com.snc.pa.itsm_dashboards)
- ITSM Predictive Intelligence Workbench dashboard - Requires the Predictive Intelligence application, which is available in the ITSM Pro SKU.
- Major Incident Management (com.snc.pa.incident.mim)
- Problem Management (com.snc.pa.problem)
- Request Management (Requested Item) (com.snc.pa.request)
- Request Management (Requests) (com.snc.pa.request2)

- Service Level Management (com.snc.pa.sla.overview)
- Spotlight - Incident Spotlight Content Pack (com.snc.pa.spotlight.incident)
- Spotlight - Problem Spotlight Content Pack (com.snc.pa.spotlight.problem)
- Spotlight - Request Spotlight Content Pack (com.snc.pa.spotlight.request)

⚠️ Note: For Performance Analytics Spotlight solutions, see Analytics and Reporting Spotlight solutions.

Performance Analytics for Software Asset Management Solutions
Activate the following Solutions when you have the Performance Analytics for Service Management entitlement:

- Software Asset Management Professional (com.snc.pa.samp)

Adding Self-Service Analytics widgets to a dashboard or Service Portal
If you have Self-Service Analytics activated on an instance, you can add Self-Service analytics widgets to your Performance Analytics dashboards or a Service Portal. To obtain a ready-made set of indicators and breakdowns, activate the Self-Service Analytics PA (com.snc.pa.self_service_analytics) plugin. Find the Self-Service indicators through the Performance Analytics Admin Console, then
create widgets and add them to your dashboard or portal. Also activate the [SSA] Self-Service Analytics data collection job.

ℹ️ Note: Customer Service Management customers can install the Analytics and Reporting Solution for Self-Service Analytics for Customer Service. This Solution contains additional Customer Service-specific indicators and breakdowns as well as widgets and a dashboard. For more information, see Self-Service Analytics for Customer Service.

**ITSM Dashboard solutions**
The ITSM Dashboards plugin (com.snc.pa.itsm_dashboards) activates the following solutions, along with a set of additional dashboards:

- Change Management (com.snc.pa.change)
- Problem Management (com.snc.pa.problem)
- Request Management (Requested Item) (com.snc.pa.request)
- Request Management (Requests) (com.snc.pa.request2)
- Incident SLA (com.snc.pa.sla)
- Major Incident Management (com.snc.pa.incident.mim)
- Spotlight - Incident Spotlight Content Pack (com.snc.pa.spotlight.incident)

ℹ️ Note: For Performance Analytics Spotlight solutions, see Analytics and Reporting Spotlight solutions.

- Fixed Costs (com.snc.fixed_costs)

**ServiceNow Store applications with Performance Analytics content**
The following applications on the ServiceNow® Store include Performance Analytics components, such as a dashboard showing widgets for indicators.

Unlike Analytics and Reporting Solutions, these applications include stand-alone functionality. The Performance Analytics components included in the application support this functionality.

A Performance Analytics administrator may need to reschedule the data collection jobs provided with these applications. Most of the applications do not have historical data collection jobs, and their scheduled jobs are active by default.

ℹ️ Note: Be aware that these applications may have licensing requirements. Check the entry for the app on the ServiceNow Store.
Configuration Management Database applications
• CSDM and CMDB Data Foundations dashboards

Customer Service applications
• Conversational Analytics Dashboard

⚠️ Note: The Conversational Analytics Dashboard replaces the Virtual Agent content pack, starting with the Quebec release.

• Workforce Optimization for Customer Service Management

DevOps applications
• DevOps Insights

Employee Service Management
• Safe Workplace dashboard

IT Asset Management applications
• Cloud Insights
• Cloud Spend dashboard

IT Business Management applications
• Strategic Spend Tracking for PPM

IT Operations Management applications
• Firewall Audits and Reporting

IT Service Management applications
• Coaching
• Continual Improvement Management
• On-Call Scheduling
• Service Portfolio Management Premium (Service Owner Workspace)

NOW Intelligence applications
• NLU Workbench
Activate a Solution using guided setup

If a product has a Performance Analytics guided setup, use that guided setup to activate and configure the associated Analytics and Reporting solution quickly and consistently.

Before you begin
Role required: admin

About this task
Performance Analytics guided setups walk you through enabling and testing Analytics and Reporting solutions for the related product. After you complete guided setup, you can collect data and view indicator scores on the Analytics Hub and on the preconfigured Solution dashboards.

Important: Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

Note: If a guided setup is not available for a Solution, you can install that Solution from the Plugins list. If the Solution is not on the Plugins list, look for it on the ServiceNow Store.

Procedure

1. Navigate to Performance Analytics > Guided Setup.
   You can also guided setup from the Performance Analytics admin console.

2. Click Get Started.

3. Scroll to the application you want to set up a solution for, such as Incident or Customer Service.

4. If the plugin is not yet active, guided setup is locked until you activate the solution plugin.

   Note: A user must have the admin role to complete these steps.

   a. Click View plugins.

   b. Click the Activate/Upgrade related link.

   c. Click Activate.

   Activating a Performance Analytics solution plugin also activates any plugins for the associated application if they are not already active. For example, activating the Performance Analytics - Content Pack - Customer
Service plugin also activates the Customer Service plugin, if it is not already active.

d. After the plugin is activated, close the plugin window to return to guided setup.

5. Click **Get Started** for the application you are setting up.

6. Follow the guided setup instructions to review the provided records such as indicators, breakdowns, widgets, and dashboards and to begin collecting Performance Analytics scores.
   As you perform each step, additional information appears in the right-side **Help** menu.

**Related information**

- Using guided setup
- List of plugins

**Install a dashboard**

Use the Solution Library to install a dashboard and all its associated visualizations such as widgets and reports, and to configure existing dashboards.

**Before you begin**

Role required: pa_admin

**About this task**

When you install or upgrade a Performance Analytics solution, out of the box content in the instance is overwritten and new content is added to the dashboard. Any content that you have previously customized on the dashboard is not changed.

To reinstall a solution metadata record from a dashboard, such as a widget, without impacting other records used by the same dashboard, see Install a single solution metadata record.

**Procedure**

1. Navigate to **PA Solution Library > Solutions**.
2. Select the dashboard you want to install.
   The dashboards provided in the Solution Library may depend on indicators, indicator sources, or other configuration records. Solution Library content always includes the associated visualization and configuration content.
3. Click **Install**.
4. In the confirmation window, click **Install**.
The installation may take some time to complete after you confirm. Clicking **Cancel** during this time closes the confirmation window but does not stop the in-progress installation.
When the installation is complete, the confirmation window disappears and the *Installed Metadata* related list is populated with the records that were installed.

**What to do next**
Navigate to the dashboard to begin analyzing your data.

**Related information**
- Activate a plugin

**Upgrade a dashboard**
When you upgrade a dashboard, solution metadata that have updates available, including any new records added to the dashboard, are installed. Solution metadata records that you have customized, even if those records are updated in the newer release, are not affected.

**Before you begin**
Role required: pa_admin

**About this task**
When you install or upgrade a Performance Analytics solution, out of the box content in the instance is overwritten and new content is added to the dashboard. Any content that you have previously customized on the dashboard is not changed.

**Procedure**
1. Navigate to **PA Solution Library > Solutions**.
   Records where the **Update Available** field is true can be upgraded.
2. Select the dashboard you want to upgrade.
3. Review the **Solution Metadata** related list.
   When you click **Upgrade**, solution metadata records in which `update_available = true` are installed. Previously customized records are not overwritten.
4. Click **Upgrade**.
   The **Upgrade** button is available if at least one solution metadata record has an update available and the solution content has been installed at least once.
5. In the confirmation window, click **Upgrade**.
   The upgrade may take some time to complete after you confirm. If you click **Cancel** during this time, the confirmation window closes, but does not stop an in-progress upgrade.

**Results**
New dashboard records are added to the dashboard. Updates to dashboard records that are not customized are applied. Dashboard records that you have customized are left unchanged.

**What to do next**
If the dashboard does not appear as you expected after installing the solution content, see if the uninstalled records appear on the customer update table. Any uninstalled records on this table were previously customized. To view the customer updates table, enter `sys_update_xml.list` in the filter navigator.

**Install a single solution metadata record**
Install a single solution metadata record used by a dashboard, such as a widget, to match the latest version of the record without impacting other records used by the same dashboard.

**Before you begin**
Role required: pa_admin

**About this task**
To install the entire dashboard and all associated records, see **Install a dashboard**.

⚠️ **Note:** Installing a record does not overwrite any customizations you have made to that record.

Available solution metadata types:
- Breakdown
- Breakdown Source
- Bucket Group
- Dashboard
- Dashboard Group
- Filter
- Indicator
- Indicator Source
• Permission
• Report
• Report Source
• Scheduled Data Collection
• Script
• Tag
• Widget

Procedure
1. Navigate to **PA Solution Library > Solutions**.
2. Select the dashboard that uses the record you want to install.
3. In the **Solution Metadata** related list, select the record you want to install.
4. Click **Install**.
5. In the confirmation window, click **Install**.

**Duplicate an Analytics and Reporting Solution dashboard**
Copy an Analytics and Reporting Solution dashboard, including the tabs, portal pages, and canvas records. Widgets on the dashboard are not duplicated.

**Before you begin**
Role required: pa_admin

**About this task**
By duplicating a dashboard, you can modify or upgrade one copy without affecting the other.

**Note:** Duplicating a dashboard does not duplicate the widgets displayed on the dashboard. You can rearrange or remove widgets from one copy of the dashboard without affecting the other. However, modifying a widget record affects both the original dashboard and the duplicate.

To copy a dashboard that is not part of an Analytics and Reporting Solution, see **Manage responsive dashboards**.

Procedure
1. Navigate to **PA Solution Library > Solutions**.
2. In the Solutions list, click the name of the dashboard you want to copy.
3. On the Solutions form, click the **Duplicate Dashboard** icon.

<table>
<thead>
<tr>
<th>Name</th>
<th>Incident Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>Incident Premium</td>
</tr>
</tbody>
</table>

4. Confirm that you want to duplicate the dashboard.

**Results**

A copy of the dashboard with the name Copy of (original dashboard name) is created. You can view it in the Dashboards Overview.

**Configure Analytics and Reporting Solutions**

Analytics and Reporting Solutions come configured with the expectation that you keep your Now Platform data in a standard set of tables and fields. If you are using different fields, configure the Solutions to point to the correct locations.

**Tip:** You may find it convenient to use the Performance Analytics admin console as the starting point for configuring Analytics and Reporting Solutions. From the admin console, you can perform the following actions:

- Activate the Solution from the plugins list or through a guided setup, if one is available. (You cannot activate Solutions that are only available on the ServiceNow Store from the admin console.)
- Check whether Performance Analytics is fully activated on this instance.
- Run diagnostics.
- Look up KPIs to configure.
- Use Dependency Assessment to find the related indicators, breakdowns, and sources for your Solution.

For more information, see [Performance Analytics Admin Console](#).

**Run diagnostics**

After you install any Analytics and Reporting Solutions, run all diagnostics on all records, as described in [Run diagnostics for all records](#). These diagnostics can catch many mismatches between the configuration of your Analytics and Reporting Solutions and your tables.
Domain separation and 'Run As' user

By default, System Administrator is the Run As user for data collection jobs in the Analytics and Reporting Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate Run As user can cause errors or limit the data that is collected. If you have Domain Separation enabled, ensure you set an appropriate Run As user in each domain.

Review the indicator sources

Determine which fields contain the data you are looking for in each application you are enabling for Performance Analytics.

Before you begin

You have enabled Performance Analytics according to your entitlement. You have also installed the relevant Analytics and Reporting solutions, and run diagnostics.

Role required: pa_admin, admin

About this task

Ensure that the indicator sources that Analytics and Reporting Solutions contain point at the correct fields for you to measure the performance of your processes.

Procedure

1. Navigate to Performance Analytics > Administration Console.
2. Click the Dashboards link in the Explore and Manage tile.
3. Verify the names of the dashboards that have been installed with this Analytics and Reporting Solution.

4. Open the **Indicator Sources** tab.

5. For each dashboard included in this Analytics and Reporting Solution:

   a. Filter the indicator sources on the dashboard name.

   **Example**
   
   This screenshot shows the indicator sources filtered on the Self-Service Analytics dashboard from the Self-Service
b. Review the facts table, conditions, and frequency of the indicator sources compared to the data structure on your own instance.

**Important:** Pay particular attention to time stamp fields such as Resolved, Opened, or Created in the Conditions. You may need to use different time stamp fields.

c. If necessary, open an indicator source and make corrections.

d. If you are editing an indicator source record, go to the Indicators related list and review the **Conditions** field for each indicator. Changing the indicator source can also affect the additional conditions on the individual indicators.

e. Click **Update** to save your changes.

**Related information**

**Indicator sources**

**Update Performance Analytics scripts**

Analytics and Reporting Solutions include Performance Analytics scripts to perform calculations on records. These scripts use the time stamp fields from the indicator sources. If you change the time field stamps in an indicator source, also modify the related scripts.
Before you begin

**Important:** If you did not update any indicator sources in your Analytics and Reporting Solutions, skip this task.

Role required: pa_admin, admin

Procedure

1. Navigate to **Performance Analytics > Automation > Scripts**.
2. Click a script to open its details.

   **Example**
   For example, the Change.CloseTime.Hours script record contains the following script:

   ```javascript
   var diff = function(x,y){return y.dateNumericValue() - x.dateNumericValue();};
   var hours = function(x,y){return diff(x,y)/(60*60*1000);};
   hours(current.opened_at, current.closed_at);
   ```

3. In the Source section, click the lock icon next to the list of Fields.

   **Source**

   Select the facts table to which the script will be applied.

<table>
<thead>
<tr>
<th>Facts table</th>
<th>Change Request (change)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields</td>
<td>Opened, Closed</td>
</tr>
</tbody>
</table>

   The Fields selector opens.

4. Move the desired fields into the fields that are **Selected** for the script, and remove fields that are not appropriate.

   **Example**
   For example, if your organization uses the **Created** time stamp field to define a new change, replace **Opened** with **Created**.
5. In the **Script** field, replace the references to disused fields with references to the fields you just selected.

**Example**
In this example, references to the **Opened** field are replaced by references to **Created**.

```javascript
var diff=function(x,y){return y.dateNumericValue() - x.dateNumericValue();};
var hours=function(x,y){return diff(x,y)/(60*60*1000);};
hours(current.opened_at, current.sys_created_on, current.closed_at);
```

6. Click **Update** to save your changes.

**Review the breakdown sources**
Breakdown sources represent the elements that you use to examine a KPI in more detail. Modify the breakdown source to limit the element list to only those items that are meaningful for the data analysis.

**Before you begin**
Role required: pa_admin, admin

**About this task**
For example, the Assignment Group automated breakdown uses the Groups breakdown source. This breakdown source returns ALL active groups in your instance, and the system uses all these groups to examine your data. If you look at the Number of Open Changes indicator, and you examine the Assignment Group breakdown, you see all groups in your instance instead of just the groups that are actually working on your Change requests.

Restricting the number of elements that a breakdown source returns has the following benefits:
• Smaller element lists make it easier for consumers to find the data they need. Sorting through a list of 25 groups associated with a particular process is easier than trying to sort through thousands of groups.

• Smaller element lists lead to less data collection and more efficient use of data. Instead of the data collector crunching through 1,000 different groups, the data collector can analyze the 25 groups that are meaningful to the process.

Note: You probably do not need to change the breakdown sources in Analytics and Reporting Solutions. However, you may find it helpful to review and understand exactly what is being measured in your processes.

Procedure

1. Navigate to Performance Analytics > Sources > Breakdown Sources.
2. Click a breakdown source to see its details.
3. In the Source tab, examine the definition for the breakdown elements, including the table that contains the unique list of sys_ids.

Example

For example, in the Change.Impact breakdown source, the unique values contained in the Change Request Impact field come from the Choice [sys_choice] table. The conditions provide additional filters to ensure that the
query returns only the Change Impact fields from the Choice [sys_choice] table.

4. Click **Preview** to see the number of elements that the query returns.

**Example**
In the example, the query returns three impact elements.

5. Click **x records match condition** to see the specific values that the query returned.
Example
In the example, clicking **3 records match condition** opens a new browser tab with a filtered list of records from the Choice [sys_choice] table.

6. Verify that the list of records match what you expect to see in the breakdown element list.

7. If the records were not what you expected, modify the conditions in the Source tab of the breakdown source to match your environment and repeat steps 4-6 until you are satisfied.

8. Click **Update** to save your changes.

What to do next
You are now ready to collect data, as described in Collect data for Analytics and Reporting Solutions.

Related information
Define a breakdown source

Collect data for Analytics and Reporting Solutions
After you install an Analytics and Reporting Solution and ensure that it points at the correct data structures in your instance, collect the data for the indicators and breakdowns.

Whenever you activate an Analytics and Reporting Solution, you automatically install Data Collector jobs for that Solution. These Data Collector jobs collect analytics information for the indicators and breakdowns in the Solution. After the
jobs run, you can see the data in the widgets and dashboards for the Solution. Technically, the Data Collector jobs do the following actions:

- Run periodically, usually daily
- Read your operational tables
- Measure the data for the period (usually a day) against the definitions that the indicators and breakdowns specify
- Store the resulting measurement scores and (optionally) raw data in Performance Analytics tables.

The plugin or ServiceNow Store application for an Analytics and Reporting Solution usually installs the following two jobs:

**Historic Data Collection**

Run the historic Data Collector job when you first install an Analytics and Reporting Solution. By default, the historic Data Collector job collects the last 60 days of data for the indicators specified in the job. If you want to go back further in time, you can configure the job to collect more historic data. A historic Data Collector job overwrites all data for the period of collection. Therefore, run it only once, when you first install the Analytics and Reporting Solution. Run a periodic Data Collector job for all subsequent data.

**Periodic Data Collection (usually daily)**

This job populates the Performance Analytics tables with data going forward. Schedule the periodic data collector to run with the same periodicity as the frequency of the indicators for which it collects data. Most indicators have a Daily frequency, so most Data Collector jobs also run daily. After you schedule the job, verify that it is Active, or it will not run.

**Related information**

Performance Analytics data collection

**Run historical data collection for a Now Intelligence Solution**

After you activate an Now Intelligence Solution, run a historical data collection job. This job gives you immediate insight from your existing data.

**Before you begin**

Role required: pa_admin, admin
Procedure

1. Navigate to Performance Analytics > Data Collector > Jobs.

2. Filter the list of jobs for those containing the word 'Historic'.

3. Locate and open the historic job that corresponds to your new Now Intelligence Solution.

4. Go to the Collection Parameters section, and set the Relative start and Relative start interval fields to collect data from as far back as you want. The Data Collector runs a number of times equal to the number of days (or other collection periods) specified in the form. For example, the default configuration of 60 days causes the Data Collector to run 60 times in succession. The Data Collector starts at T-60 days and examines all records as if the date were 60 days ago. After processing those records, the Data Collector runs again at T-59 days. The Data Collector repeats the process until it gets to the current date.

Each day’s collection may take a minute or two to complete depending on the size of your tables. A historic data collection over multiple months may take some time to complete.

If the product or application for which you installed the Now Intelligence Solution is new, you might not have much historical data. In this case, you can shorten the relative start interval. If you have not yet used the product or application, you can skip collecting historical data altogether.

5. Ensure that the user specified in the Run as field exists.

If you are using domain separation, you collect only records from domains which the Run as user can view. However, the ACL permissions of the Run as user do not affect data collection.

6. Verify that the Run As tz time zone is appropriate for your company.

Database queries based on this indicator source use this time zone. This time zone affects the timestamps for the data collection job. This time zone also defines what day is 'Today' for conditions like [[Created][on][Today]].

7. Click Execute Now to run the job.

8. Navigate to Data Collector > Job Logs.

9. Look at the State of the job you are running.

Refresh the view periodically until the job completes. If the job is successful, the State changes to Collected.

Example: Collecting historical data for newly installed Now Intelligence Solution

You have just installed a set of Now Intelligence Solutions. You want to run the initial historical data collection job on them, so you navigate to Performance Analytics > Data Collector > Jobs. Filter the list for those containing the word 'Historic'. Locate and open the historic job that corresponds to your new Now Intelligence Solution. Go to the Collection Parameters section, and set the Relative start and Relative start interval fields to collect data from as far back as you want. The Data Collector runs a number of times equal to the number of days (or other collection periods) specified in the form. For example, the default configuration of 60 days causes the Data Collector to run 60 times in succession. The Data Collector starts at T-60 days and examines all records as if the date were 60 days ago. After processing those records, the Data Collector runs again at T-59 days. The Data Collector repeats the process until it gets to the current date.

Each day’s collection may take a minute or two to complete depending on the size of your tables. A historic data collection over multiple months may take some time to complete.

If the product or application for which you installed the Now Intelligence Solution is new, you might not have much historical data. In this case, you can shorten the relative start interval. If you have not yet used the product or application, you can skip collecting historical data altogether.

Ensure that the user specified in the Run as field exists. If you are using domain separation, you collect only records from domains which the Run as user can view. However, the ACL permissions of the Run as user do not affect data collection.

Verify that the Run As tz time zone is appropriate for your company. Database queries based on this indicator source use this time zone. This time zone affects the timestamps for the data collection job. This time zone also defines what day is 'Today' for conditions like [[Created][on][Today]].

Click Execute Now to run the job.

Navigate to Data Collector > Job Logs.

Look at the State of the job you are running. Refresh the view periodically until the job completes. If the job is successful, the State changes to Collected.
Analytics > Data Collector > Jobs. To find the historic jobs for Now Intelligence Solutions, you filter the list on `[[Name][contains][Historic]]`.

**Tip:** When you start to create your own historical data collector jobs, include the word 'Historic' in their names.

You decide to run the job for the Knowledge Management solution first. To ensure that nobody has run the knowledge management historical job yet,
you navigate to **Data Collector > Job Logs** and filter the list on `[[Job][contains]] [knowledge]`. 

No records to display
In this case, you see that the job has not been run since the last zBoot. So you navigate back to the Jobs list and open [PA Knowledge] Historic Data.

In the form, you verify the following details:

1. The **Relative start** field is set for the default 60 days, which is fine for you.
2. The **Run as** user exists on your instance. Otherwise, you would have to choose a different user.
3. The time zone is appropriate for your company.

You are satisfied with the settings for the historical job, so you click **Execute Now**. After a few minutes, the job is shown as **Collected** in the job logs.

**Related information**

**Collect historical data**

**Schedule data collection for a Now Intelligence Solution**

Enable the periodic data collection job for your Now Intelligence solution. Check that the time that it runs is correct.

**Before you begin**

Role required: pa_admin, admin

**About this task**

Every Now Intelligence solution includes a periodic data collection job.
Procedure

1. Navigate to **Performance Analytics > Data Collector > Jobs**.

2. Filter the job list on `[[Run][is not one of][Once | On Demand]] AND [[Active] [is][false]]`. You now see only periodic data collection jobs that you have not activated.

3. Open the periodic data collection job for your Now Intelligence Solution. The following steps refer to the Job Parameters section of the job record.

### Job parameters

1. **Run as**
   - System Administrator
2. **Run As tz**
   - System (America/Los_Angeles)
3. **Active**
   - Checked
4. **Time**
   - Hours 02 00 00

4. Ensure that the user specified in the **Run as** field exists.
   If you are using domain separation, you collect records only from domains that the **Run as** user can view. However, the access control list permissions of the **Run as** user do not affect data collection.

5. Verify that the **Run As tz** time zone is appropriate for your company.
   The database queries created for this job use this time zone, which is reflected in the logs for this job. This time zone also determines what day is "Today" for indicator conditions like `[[Created][on][Today]]`.

6. Select **Active** to enable the scheduled run of the job.
   Scheduling options are now available.

7. Ensure that the time that the job runs is during your company downtime.
• The **Time** value is based on the time zone for your user session, not the **Run as tz** time zone.

• To get an accurate measurement for a day, the day must have completed. For a Daily job, the **Time** value should be between midnight and 06:00 in the **Run as tz** time zone, to collect for the previous day. For example, if you are logged in from New York and want to run the job at 05:00 in the System/Los Angeles time zone, set **Time** to 08:00:00.

• For a Monthly job, you also set the day that you want to run the job on. Generally set it to run on the first day of the month, soon after midnight in the **Run as tz** time zone. This setting gets all the data for the preceding month, regardless of the length of the month.

**Results**
After the next collection period, the dashboards and widgets should show scores from that period.

**What to do next**
Check the **Job Logs** to see if the job ran successfully after the next period.

**Related information**
Create or schedule a data collection job

**Installed Performance Analytics indicators**
This section contains lists of the indicators included in the Analytics and Reporting Solutions and in other applications.

For a full list of Analytics and Reporting Solutions, including those that do not contain Performance Analytics indicators, see Available Analytics and Reporting Solutions.

For a full list of other applications that contain Performance Analytics indicators, see ServiceNow Store applications with Performance Analytics content.

**Advanced Work Assignment indicators**
Indicators included in the Advanced Work Assignment Analytics and Reporting Solution.

For more information, see Advanced Work Assignment (com.snc.pa.awa).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage of Exceeding Target Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Exceeding Target Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Accepted Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Timed Out Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Percentage of Rejected Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Percentage of Exceeding Target Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Sum of Accepted Task Wait Times</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Rejected Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Rejected Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Sum of Accepted Interaction Wait Times</td>
<td>NewYork</td>
</tr>
<tr>
<td>Percentage of Timed Out Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Percentage of Rejected Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Percentage of Abandoned Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Exceeding Target Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Timed Out Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Percentage of Accepted Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Percentage of Timed Out Task Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Abandoned Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Average of Accepted Task Wait Times</td>
<td>NewYork</td>
</tr>
<tr>
<td>Percentage of Accepted Interaction Work Items</td>
<td>NewYork</td>
</tr>
<tr>
<td>Average of Accepted Interaction Wait Times</td>
<td>NewYork</td>
</tr>
<tr>
<td>Number of Accepted Interaction Work Items</td>
<td>NewYork</td>
</tr>
</tbody>
</table>

**Agile 2.0 indicators**

Indicators included in the Agile 2.0 (sn_scrum_dashboard on ServiceNow Store) Analytics and Reporting Solution.

For information about this dashboard, see [Install Performance Analytics Content Pack for Agile 2.0](#).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scrum: Sum of story points of active stories in the current release</td>
<td>New York</td>
</tr>
<tr>
<td>Scrum: Sum of story points of active stories in the current sprint</td>
<td>New York</td>
</tr>
<tr>
<td>Scrum: Sum of story points of all stories in active releases</td>
<td>New York</td>
</tr>
<tr>
<td>Scrum: Sum of story points of all stories in epics</td>
<td>New York</td>
</tr>
<tr>
<td>Scrum: Sum of story points of all stories in the current sprint</td>
<td>New York</td>
</tr>
<tr>
<td>Scrum: Sum of story points of completed stories in active releases</td>
<td>New York</td>
</tr>
<tr>
<td>Scrum: Sum of story points of completed stories in epics</td>
<td>New York</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scrum: Time elapsed in sprint</td>
<td>New York</td>
</tr>
<tr>
<td>Scrum: Average Story State Duration</td>
<td>Orlando</td>
</tr>
<tr>
<td>Scrum: Percent Completed by Points</td>
<td>Orlando</td>
</tr>
<tr>
<td>Scrum: Percent Completed by Points for Release</td>
<td>Orlando</td>
</tr>
<tr>
<td>Scrum: Story State Duration</td>
<td>Orlando</td>
</tr>
<tr>
<td>Scrum: Sum of story points of completed stories in current sprint</td>
<td>Orlando</td>
</tr>
<tr>
<td>Scrum: Time elapsed in release</td>
<td>Orlando</td>
</tr>
<tr>
<td>Scrum: Count of all stories in active releases</td>
<td>Paris</td>
</tr>
<tr>
<td>Scrum: Count of all stories in current epic</td>
<td>Paris</td>
</tr>
<tr>
<td>Scrum: Count of stories in the current sprint</td>
<td>Paris</td>
</tr>
</tbody>
</table>

**Application Portfolio Management indicators**

Indicators included in the Performance Analytics Application Portfolio Management Analytics and Reporting Solution.

For more information, see Application Portfolio Management (com.snc.pa.apm).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum App Score Fiscal Quarterly</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum Application Indicator Scores – Quarterly</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Cost per user By quarter</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum Active User count</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>
## Application security indicators

Indicators included in the Performance Analytics Application Security content pack and base feature, com.snc.pa.instance_sec_dash and com.glide.instance_sec_center.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppSec-Total Number of Configuration Properties</td>
<td>London</td>
</tr>
<tr>
<td>AppSec-Number of Non-Compliant Configuration Properties</td>
<td>London</td>
</tr>
<tr>
<td>AppSec-Number of Compliant Configuration Properties</td>
<td>London</td>
</tr>
<tr>
<td>External Logins</td>
<td>London</td>
</tr>
<tr>
<td>Admin Logins</td>
<td>London</td>
</tr>
<tr>
<td>Failed Logins</td>
<td>London</td>
</tr>
<tr>
<td>AppSec: Calculating Total Compliance Score</td>
<td>London</td>
</tr>
<tr>
<td>Security Elevations</td>
<td>London</td>
</tr>
<tr>
<td>Impersonations</td>
<td>London</td>
</tr>
<tr>
<td>Admin Users Added</td>
<td>London</td>
</tr>
<tr>
<td>AppSec-Spam Emails per day</td>
<td>Madrid</td>
</tr>
<tr>
<td>AppSec-Number of Emails per day</td>
<td>Madrid</td>
</tr>
<tr>
<td>SNC Logins</td>
<td>New York</td>
</tr>
</tbody>
</table>

## Case Management indicators

Indicators included in the Performance Analytics Case Management content pack, com.snc.pa.customer_service_advanced.

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Cases Resolved on First Contact</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of cases resolved on first contact</td>
<td>Kingston</td>
</tr>
<tr>
<td>Indicators</td>
<td>Version introduced</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Number of open cases with breached SLAs</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of resolved cases reopened</td>
<td>Kingston</td>
</tr>
<tr>
<td># of unassigned open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Sum of agent reassignment counts for closed cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of promoters (NPS)</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of reopened open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>NPS</td>
<td>Kingston</td>
</tr>
<tr>
<td>CSAT</td>
<td>Kingston</td>
</tr>
<tr>
<td>Sum of agent reassignment counts for open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of open cases that were reopened</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of reassigned open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of P1 open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Summed duration of First Response Time</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of Open Cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of open cases that were escalated</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of satisfied customers (CSAT)</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of CSAT survey respondents</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of open cases with agent reassignment</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of NPS survey respondents</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of open cases that were escalated</td>
<td>Kingston</td>
</tr>
<tr>
<td>Sum of reopen counts for resolved cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of promoters (NPS)</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of detractors (NPS)</td>
<td>Kingston</td>
</tr>
<tr>
<td># of open cases with PRBs attached</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of open cases with breached SLAs</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of open cases not updated last 5 days</td>
<td>Madrid</td>
</tr>
<tr>
<td>Indicators</td>
<td>Version introduced</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Number of Open cases per agent</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of closed cases re-assigned</td>
<td>Madrid</td>
</tr>
<tr>
<td>Summed age of last update of open cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Case Average NPS</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average age of last update of open cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Cases closed per agent per week</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Closed cases re-assigned</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of agents active</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Resolved cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of new P1 Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Summed age of open cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average re-assignment of open cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Summed duration of closed cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Cases closed same day opened</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Cases closed per agent per month</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open cases not updated last 30 days</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average age of open cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open cases not updated in last 5 days</td>
<td>Madrid</td>
</tr>
<tr>
<td>Summed re-assignment count of open cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of New cases per agent per month</td>
<td>Madrid</td>
</tr>
<tr>
<td>Case average overall customer satisfaction</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of New cases per agent per week</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of New cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average resolution time of cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of closed cases with breached SLAs</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of cases closed same day opened</td>
<td>Madrid</td>
</tr>
<tr>
<td>Indicators</td>
<td>Version introduced</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Number of Closed Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Closed cases with breached SLAs</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average close time of cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of open cases not updated in the last 30 days</td>
<td>Madrid</td>
</tr>
<tr>
<td>Summed duration of resolved cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Blocked Open Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open Cases Caused by Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Re-open rate</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open Major Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Resolved Major Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Child Cases which are Auto Created from Major Case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open Cases with Incident</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Cases which are Child of Major Case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Major Case Candidates</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Closed Cases with Incident</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Resolved Major Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Customers Impacted by Major Case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Resolved Cases which are Child of Major Case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Open Cases with Incident</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of resolved cases reopened</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open Cases which are Child of Major Case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Responded Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Case backlog growth</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open Cases with Request</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases Caused by Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Closed Cases with Request</td>
<td>Madrid</td>
</tr>
<tr>
<td>Indicators</td>
<td>Version introduced</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Number of detractors (NPS)</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Open Major Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Open Cases Caused by Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Case SLAs Open</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases with Problem</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Closed Cases Caused by Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Major Case Candidates</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Child Cases which are Auto Created from Major Case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Open Cases with Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Open Cases with Problem</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Closed Cases with Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases with Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open Cases with Problem</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Unblocked Open Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases with Request</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Open Cases with Request</td>
<td>Madrid</td>
</tr>
<tr>
<td>Case Average Response Time</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Closed Cases with Problem</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Open Cases with Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average# of agent reassignments per open case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases with Incident</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average# of agent reassignments per closed case</td>
<td>Madrid</td>
</tr>
<tr>
<td>PCSO: Percent of internally reported cases that were promoted to major case</td>
<td>NewYork</td>
</tr>
<tr>
<td>PCSO: Number of Alerts where case is non empty</td>
<td>NewYork</td>
</tr>
<tr>
<td>PCSO: Number of affected deployments</td>
<td>NewYork</td>
</tr>
<tr>
<td>PCSO: Number of Proactive Cases</td>
<td>NewYork</td>
</tr>
<tr>
<td>Indicators</td>
<td>Version introduced</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>PCSO: Percent of critical and acknowledged alerts that spawned a proactive case</td>
<td>NewYork</td>
</tr>
<tr>
<td>PCSO: Number of Critical and Acknowledged Alerts</td>
<td>NewYork</td>
</tr>
<tr>
<td>PCSO: Number of Affected Customers</td>
<td>NewYork</td>
</tr>
<tr>
<td>PCSO: Number of Proactive reported cases promoted to major</td>
<td>NewYork</td>
</tr>
</tbody>
</table>

**Change Management indicators**

Indicators included in the Change Management Analytics and Reporting Solution.

For more information, see Change Management (com.snc.pa.change).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average age of open changes % unsuccessful changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average re-assignment of open changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed changes rejected</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average close time of changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of updated since of open changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of updated since of open changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open changes before planned end date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new emergency changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed implementation time closed changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of new emergency changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of changes closed before planned end date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open changes before planned end date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of open changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Number of unsuccessful changes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open changes after planned end date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed re-assignment of open changes</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

**Cloud Insights Indicators**

All Cloud Insights applications on the ServiceNow Store share the following indicators.

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Insight Potential Savings Recommendations</td>
<td>2020-03-16</td>
</tr>
</tbody>
</table>

**Cloud management indicators**

Indicators included in the Performance Analytics Cloud Management content pack, com.snc.pa.cmp.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum Cloud Mgmt Billing Daily Cost</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of total Cost</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum Daily Usage GB Hours</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum Daily Usage Hours</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum Daily Usage GB</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

**Cloud Spend Indicators**

The Cloud Spend Core application on the ServiceNow Store uses the following indicators.

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current SaaS Spend</td>
<td>2020-03-27</td>
</tr>
</tbody>
</table>
### Indicators

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage of Potential Savings SaaS</td>
<td>2020-03-24</td>
</tr>
<tr>
<td>SaaS Recommendations Summary</td>
<td>2020-04-28</td>
</tr>
<tr>
<td>SaaS Subscription Reclaimed Candidates</td>
<td>2020-03-27</td>
</tr>
<tr>
<td>Underperforming SaaS Spend</td>
<td>2020-03-27</td>
</tr>
</tbody>
</table>

### CMDB and CSDM Data Foundations Dashboards Indicators

The CMDB and CSDM Data Foundations Dashboards application on the ServiceNow Store uses the following indicators.

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Services Missing Business App Relation</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Active CIs Not Updated in 90 Days</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Application Services Missing Business Service Offerings</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Application Services with Incorrect Business Application Relationship</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Business Application missing Application Service Relationship</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Business Service Offerings Missing App Service Relationship</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Business Units Without Companies</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Catalog Request Items Related to Service Offerings</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>CIs Missing Name</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Custom Service Tables</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Dynamic CI Groups without CMDB Group</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Information Object Missing a Relationship to Business App</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
</tbody>
</table>
Indicators

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations Without Parent</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Named Product Models With Missing Product Owners</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Services Using Custom CMDB Tables</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Technical Service Offering without Support or Change Group</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Technical Service Offerings</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
<tr>
<td>Technical Service Offerings Missing a Relationship to Technical Services</td>
<td>2021-03-26 version 1.3.0</td>
</tr>
</tbody>
</table>

Coaching indicators

Indicators included in the Coaching application, com.sn_coaching.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching Assessments closed</td>
<td>2020-04-13</td>
</tr>
<tr>
<td>Coaching: # of incident related assessments</td>
<td>2020-04-20</td>
</tr>
<tr>
<td>Coaching: # of incident related assessments that were completed</td>
<td>2020-04-20</td>
</tr>
<tr>
<td>Coaching: % of assessments closed with incidents</td>
<td>2020-04-13</td>
</tr>
</tbody>
</table>

Communities indicators

Indicators included in the Communities Analytics and Reporting Solution.

For more information, see Communities (com.snc.pa.communities).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communities - % of content with any activity</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - % of questions marked as solved</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - % of unanswered questions</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Average number of answers/comments per content item</td>
<td>Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Communities - Average number of social activities per content item</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Average number of views per content item</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of Active Contributors</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of content views</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of new content contribution</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of new members</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of Questions that have been answered</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of questions that have been solved</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of searches</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of sessions going into community</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of total members</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of unanswered questions</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total number of blogs, videos and documents</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total number of comments and answers across content</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total Number of Content</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total number of content other than comments or answer</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total number of content with any activity</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total Number of Contributors</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total Number of Discussions</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total Number of Helpful Markings</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total number of points awarded</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total number of questions</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total Number of Up-votes</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Total Social Activity</td>
<td>Kingston</td>
</tr>
<tr>
<td>Communities - Number of Featured Content</td>
<td>NewYork</td>
</tr>
</tbody>
</table>
## Configuration Management (CMDB) indicators

Indicators included in the Configuration Management Analytics and Reporting Solution.

For more information, see [Configuration Management (CMDB)](com.snc.pa.cmdb).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Monitored Configuration Items</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

**Content Analytics indicators**

Indicators included in the Analytics and Reporting Solution for Content Analytics.

For more information, see Content Analytics (com.snc.pa.premium.content_analytics).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Visits in Last 365 Days</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average Page Views per Session</td>
<td>Madrid</td>
</tr>
<tr>
<td>Visits per Day</td>
<td>Madrid</td>
</tr>
<tr>
<td>Page Views per Day</td>
<td>Madrid</td>
</tr>
<tr>
<td>Today's Top Pages</td>
<td>Madrid</td>
</tr>
<tr>
<td>This Week's Top Pages</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**Content Automation indicators**

Indicators included in the Analytics and Reporting Solution for Content Automation.

For more information, see Content Automation (com.snc.pa.premium.content_automation).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days Running</td>
<td>Madrid</td>
</tr>
<tr>
<td>Total Engagement</td>
<td>Madrid</td>
</tr>
<tr>
<td>Event Activity Over Time</td>
<td>Madrid</td>
</tr>
<tr>
<td>Events Over Time by Content</td>
<td>Madrid</td>
</tr>
<tr>
<td>Events Over Time by Action</td>
<td>Madrid</td>
</tr>
<tr>
<td>Campaign: Impact Target</td>
<td>Orlando</td>
</tr>
<tr>
<td>Campaign: Impact Evaluation</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
Continual Service Improvement indicators

Indicators included in the Performance Analytics Continual Service Improvement content pack, sn_cim.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign: Impact Baseline</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

Customer Service Management - Advanced indicators

Indicators included in the Analytics and Reporting Solution for Customer Service Management.

For more information, see Customer Service Management - Advanced (com.snc.pa.customer_service_advanced).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of cases resolved on first contact</td>
<td>Madrid</td>
</tr>
<tr>
<td>Exceeding Chat Target</td>
<td>Madrid</td>
</tr>
<tr>
<td>Exceeding Case Target</td>
<td>Madrid</td>
</tr>
<tr>
<td>Mean Time to Resolve</td>
<td>Madrid</td>
</tr>
<tr>
<td>Case Backlog Growth</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Customers Impacted by Major Case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Child Cases which are Auto Created from Major Case</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Blocked Open Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Unblocked Open Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of Open Cases Not Updated in 5 Days</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of Open Major Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>% of Open Cases with Breached SLAs</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of P1 Open Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of open cases that were escalated</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Open Cases with Problem</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of open cases with Agent Reassignment</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Major Case Candidates</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of open cases that were reopened</td>
<td>Madrid</td>
</tr>
<tr>
<td>% Open with Request</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases with Problem</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases Caused by Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of cases closed same day opened</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of resolved cases reopened</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Resolved Major Cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of Closed Cases Re-assigned</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of Closed Cases with Breached SLAs</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases with Change</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Closed Cases with Incident</td>
<td>Madrid</td>
</tr>
<tr>
<td>% Closed with Request</td>
<td>Madrid</td>
</tr>
<tr>
<td>Agent Efficiency Trend</td>
<td>Madrid</td>
</tr>
<tr>
<td>Closed Cases by Agent and Account</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Exceeding Target Task Work Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Accepted Task Work Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Accepted Interaction Work Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Percentage of Abandoned Interaction Work Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of open cases</td>
<td>Madrid</td>
</tr>
<tr>
<td>PCSO: Active Case Outages</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
DevOps Insights indicators

The DevOps Insights application on the ServiceNow Store uses the following indicators.

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average duration of resolved incidents caused by DevOps change</td>
<td>2020-05-10</td>
</tr>
<tr>
<td>Average duration of resolved incidents caused by DevOps Change</td>
<td>2020-04-05</td>
</tr>
<tr>
<td>Average duration of resolved incidents caused by DevOps Change last 30 days</td>
<td>2020-04-10</td>
</tr>
<tr>
<td>Average resolution time of resolved incidents caused by DevOps Change</td>
<td>2020-04-05</td>
</tr>
<tr>
<td>Average Service Availability last 30 days</td>
<td>2020-04-10</td>
</tr>
<tr>
<td>Change Failure Rate</td>
<td>2020-04-07</td>
</tr>
<tr>
<td>Closed DevOps Changes In The Last 30 Days</td>
<td>2020-05-10</td>
</tr>
<tr>
<td>Daily Closed DevOps Changes</td>
<td>2020-05-10</td>
</tr>
<tr>
<td>Daily number of Incidents</td>
<td>2020-04-27</td>
</tr>
</tbody>
</table>
## Discovery indicators

Indicators included in the Discovery Analytics and Reporting Solution.

For more information, see Discovery (com.snc.pa.discovery).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum duration of jobs executed today</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of New Completed Discovery today</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Discovery Logs</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% New Discovered Devices Issues</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>New Discovered Devices with Issues</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>New Discovered Devices</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Issues on Device</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum New Discovered Devices Issue</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

## Essential SaFE indicators

Indicators included in the Essential SAFe Analytics and Reporting Solution on the ServiceNow Store.
For more information, see Essential SaFe.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version added</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe: Average Story State Duration</td>
<td></td>
</tr>
<tr>
<td>SAFe: Percent Completed by Points</td>
<td></td>
</tr>
<tr>
<td>SAFe: Percent Completed by Points for PI</td>
<td></td>
</tr>
<tr>
<td>SAFe: Story State Duration</td>
<td></td>
</tr>
<tr>
<td>SAFe: Sum of story points of active stories in the current PI</td>
<td></td>
</tr>
<tr>
<td>SAFe: Sum of story points of active stories in the current sprint</td>
<td></td>
</tr>
<tr>
<td>SAFe: Sum of story points of all stories in the current PI</td>
<td></td>
</tr>
<tr>
<td>SAFe: Sum of story points of all stories in the current sprint</td>
<td></td>
</tr>
<tr>
<td>SAFe: Sum of story points of completed stories in current PI</td>
<td></td>
</tr>
<tr>
<td>SAFe: Sum of story points of completed stories in current sprint</td>
<td></td>
</tr>
<tr>
<td>SAFe: Time elapsed in PI</td>
<td></td>
</tr>
<tr>
<td>SAFe: Count of all stories in current epic</td>
<td>Paris</td>
</tr>
<tr>
<td>SAFe: Count of all stories in the current PI</td>
<td>Paris</td>
</tr>
<tr>
<td>SAFe: Count of stories in the current sprint</td>
<td>Paris</td>
</tr>
<tr>
<td>SAFe: Sum of story points of all stories in epics</td>
<td>Paris</td>
</tr>
<tr>
<td>SAFe: Sum of story points of all stories in the feature</td>
<td>Paris</td>
</tr>
<tr>
<td>SAFe: Sum of story points of completed stories in epics</td>
<td>Paris</td>
</tr>
</tbody>
</table>
### Event Management indicators

Indicators included in the Event Management Analytics and Reporting Solution.

For more information, see [Event Management](com.snc.pa.em).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summed age of open alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open and unacknowledged alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of reopened alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of primary alerts out of total alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of primary alerts out of total alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of all alerts created today except virtual</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of alerts closed same day opened</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of alerts closed by operator</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of new critical alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open alerts not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of last update of open alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open alerts not updated in last 2 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open unacknowledged alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of alerts reopened at least once</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% Today’s Impacted Business Services</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of alerts without assigned task</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of alerts that are flapping</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average resolution time of closed alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open alerts not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version Introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Number of alerts that are flapping</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of Closed Alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age open alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of ungrouped alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open alerts not updated in last 2 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of alerts closed same day opened</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of last update of open alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Compression ratio events to alerts (today)</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of ungrouped alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of Open Alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of all events created today</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of Total Business Services</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% Business Services Uptime of today</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>New Impacted Business Services</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of Total Impacted Services</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>%Impact Time of Today</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Impacted Business Services</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>New Business Services</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Business Services Impact Time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum Business Services Impact Time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of New Alerts</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of Business Services</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new non-secondary alerts</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of alert grouping coverage</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of alert groups</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of new virtual alerts</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of alert grouping compression</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
### Field Service Management indicators

Indicators included in the Field Service Management Analytics and Reporting Solution.

For more information, see Field Service Management (com.snc.work_management_pa).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of new Work Orders</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of Work Order Tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed work duration for Work Order Tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>%actual duration to planned duration for closed work order tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>%utilization of agents for work order tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed Work Orders</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Closing time for Work Orders</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed planned duration of Work Order Tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Total Planned duration for Work Order Tasks in hours</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed work orders</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Total actual duration for Work Order Tasks in hours</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>%productive agent time for Work Order Tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open Work Orders</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of unique agents for closed Work Order Tasks</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>
**Financial Management indicators**

Indicators included in the Financial Management Analytics and Reporting Solutions.

For more information, see [Financial Management Analytics and Reporting Solutions](https://www.servicenow.com). 

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum Charges Service.Charge.Expense.Line.Details</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum Cost Service.Charge.Expense.Line.Details</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Last Period Total Charge Variance</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Total Capex Fiscal Quarterly</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Total Opex Fiscal Quarterly</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Cost Per Case for Products</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of cases closed in Fiscal Quarter</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Cost Per Case for Account</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Cost Per case</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Cost Per Work Order Task for Companies</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Cost Per Work Order Task for Products</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>FSM. Cost Per Workorder</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>FSM. Total cost of the quarter</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>FSM. Number of Work Order per Quarter</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>FSM.Total cost for fiscal quarter</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Plan Actuals Yearly</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of Pending Tasks</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total Budgeted Plan Item Amount</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of Approved Tasks</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total OPEX Amount</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total CAPEX Amount</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of Plan Tasks</td>
<td>Kingston</td>
</tr>
<tr>
<td>Budget Actuals Monthly</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total Budgeted Amount</td>
<td>Kingston</td>
</tr>
<tr>
<td>Budget Vs Actuals Variance</td>
<td>Kingston</td>
</tr>
<tr>
<td>Budget Vs Forecast Variance</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total Amount Of Approved Tasks</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total Forecast Amount</td>
<td>Kingston</td>
</tr>
<tr>
<td>%of Approved Tasks</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total Amount Of Pending Tasks</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total Expenses Fiscal Quarterly - Service Cost Model</td>
<td>Madrid</td>
</tr>
<tr>
<td>Total Expenses Fiscal Quarterly - Business Capability Cost Model</td>
<td>Madrid</td>
</tr>
<tr>
<td>Total Expenses Fiscal Quarterly Breakdowns - Business Capability Cost Model</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average Cost Per User</td>
<td>Madrid</td>
</tr>
<tr>
<td>Total Expenses Fiscal Quarterly - Business Service Cost Model</td>
<td>Madrid</td>
</tr>
<tr>
<td>Total Expenses Fiscal Quarterly From Aggregates - Shared Services</td>
<td>Madrid</td>
</tr>
<tr>
<td>Total Expenses Fiscal Quarterly From Aggregates - Application Cost Model</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
### Financial Services Operations (FSO) indicators

Indicators included in the Financial Services Operations Analytics and Reporting Solution, available on the ServiceNow Store.

For more information, see [Analytics and Reporting Solutions for Financial Services Operations](#).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Productivity</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Payment Closed Cases</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Agents</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Closed Cases (Cases Closed Today)</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Closed Cases (SLA Closed Today)</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Closed Cases with Breached SLAs</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Closed Cases with SLAs</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Number of closed external claims having bank error based upon outcome</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of closed external claims having bank error with actual treatment as exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of closed external claims having bank error with actual treatment as protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of closed external claims having bank error with requested treatment as exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of closed external claims having bank error with requested treatment as protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of closed external claims having customer error with actual treatment as exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of closed external claims having customer error with actual treatment as protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of closed external claims having customer error with requested treatment as exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of closed external claims having customer error with requested treatment as protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of New Cases</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open Cases</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of open cases having requested treatment as protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of open cases having requested treatment as exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of open cases having requested treatment as None</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of open Cases with Breached SLAs</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open Cases with SLAs Breach &gt; 80%</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having bank error category with requested treatment as None</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having bank error with requested treatment as None</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having bank error with requested treatment as Exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Number of Open internal Claims having bank error with requested treatment as Protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having customer error with payment processor as Exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having customer error with payment processor as None</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having customer error with payment processor as Protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having customer error with requested treatment as Exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having customer error with requested treatment as None</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Number of Open internal Claims having customer error with requested treatment as Protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Payment: Number of open cases with breached SLAs</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Sum of claim amount for closed claims</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Sum of refund amount for closed claims</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Sum of refund amount for closed external claims having bank error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Sum of refund amount for closed external claims having customer error based upon Actual Treatment</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Sum of total amount for open internal claims having bank error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Sum of total amount for open internal claims having customer error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Summed age of open cases</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Summed duration of closed cases</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Summed duration of payment closed cases</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total count of open internal claims having bank error based upon requested treatment</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of closed external claims having customer error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of closed external claims having bank error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Total number of closed external claims having bank error based upon actual treatment</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of closed external claims having bank error used in total number recovery</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of closed external claims having customer error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of closed external claims having customer error based upon actual treatment</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of closed external claims having customer error based upon outcome</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of internal closed claims</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open cases having requested treatment as Exception</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open cases having requested treatment as Protected</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open internal claim cases</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open internal claims having bank error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open internal claims having bank error based upon error category</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open internal claims having bank error grouped by payment processor</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open internal claims having customer error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open internal claims having customer error grouped by payment processor</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total number of open internal claims having customer error with custom error category</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total sum of refund amount for closed external claims having bank error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total sum of refund amount for closed external claims having customer error</td>
<td>1.0.1</td>
</tr>
<tr>
<td>Total volume</td>
<td>1.0.1</td>
</tr>
</tbody>
</table>
Firewall Audit and Reporting indicators

Indicators included with the Firewall Audits and Reporting application from the ServiceNow Store.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date created</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewall Devices</td>
<td>2020-04-01</td>
</tr>
<tr>
<td>Firewall Security Policies</td>
<td>2020-04-06</td>
</tr>
<tr>
<td>New Firewall Security Policies</td>
<td>2020-04-06</td>
</tr>
<tr>
<td>Open Firewall Audit Responses</td>
<td>2020-04-06</td>
</tr>
<tr>
<td>Open Firewall Tasks</td>
<td>2020-04-06</td>
</tr>
</tbody>
</table>

GRC: Advanced Dashboard indicators

Indicators included with the GRC: Advanced Dashboards (com.sn_grc_pa_advanced) plugin.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accepted issues</td>
<td>2020-03-08</td>
</tr>
<tr>
<td>Approved exceptions</td>
<td>2020-03-09</td>
</tr>
<tr>
<td>Critical priority issues</td>
<td>2020-03-06</td>
</tr>
<tr>
<td>Expired exceptions</td>
<td>2020-03-09</td>
</tr>
<tr>
<td>High priority issues</td>
<td>2020-03-06</td>
</tr>
<tr>
<td>High Risks</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Issues closed today</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Issues created today</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Issues to be Resolved by this month</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Issues to be Resolved by this quarter</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Issues to be Resolved by this week</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Issues to be Resolved by this year</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Issues to be Resolved by today</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Low Risks</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Indicator</td>
<td>Date added</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Moderate Risks</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Number of exceptions approved</td>
<td>2020-03-09</td>
</tr>
<tr>
<td>Number of exceptions requested</td>
<td>2020-03-09</td>
</tr>
<tr>
<td>Open exceptions</td>
<td>2020-03-09</td>
</tr>
<tr>
<td>Open issues</td>
<td>2020-03-06</td>
</tr>
<tr>
<td>Past due issues</td>
<td>2020-03-06</td>
</tr>
<tr>
<td>Past Due issues new</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Past due issues state analyze</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Past due issues state respond</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Past due issues state review</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Past due remediation tasks open</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Past due remediation tasks state respond</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Past due remediation tasks state review</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Past due remediation tasks state work in progress</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Pending exception approvals due this month</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Pending exception approvals due this quarter</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Pending exception approvals due this week</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Pending exception approvals due today</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Pending exception extension approvals due this month</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Pending exception extension approvals due this quarter</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Pending exception extension approvals due this week</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Pending exception extension approvals due today</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Rejected exceptions</td>
<td>2020-03-09</td>
</tr>
<tr>
<td>Remediation tasks closed today</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Remediation tasks created today</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Remediation tasks to be completed by this month</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Remediation tasks to be completed by this quarter</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Indicator</td>
<td>Date added</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Remediation tasks to be completed by this week</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Remediation tasks to be completed by this year</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Remediation tasks to be completed by today</td>
<td>2020-03-02</td>
</tr>
<tr>
<td>Upcoming Acceptance Task Expiration this Month</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Upcoming Acceptance Task Expiration this Quarter</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Upcoming Acceptance Task Expiration this Week</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Upcoming Acceptance Task Expiration this Year</td>
<td>2020-04-13</td>
</tr>
<tr>
<td>Upcoming Acceptance Task Expiration today</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Upcoming exception expirations next week</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Upcoming exception expirations this month</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Upcoming exception expirations this week</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Upcoming exception expirations today</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Upcoming exception expirations tomorrow</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Very High Risks</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Very Low Risks</td>
<td>2020-03-31</td>
</tr>
</tbody>
</table>

**GRC: Advanced Risk indicators**

Indicators included with the GRC: Risk Events, GRC: Exposure by Risk Statements, GRC: Exposure by Entity, and GRC: Operational Risk Management dashboards in the GRC: Advanced Risk (sn_risk_advanced) application.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Events</td>
<td>New York, modified Orlando</td>
</tr>
<tr>
<td>Average of average calculated ALE for this quarter [from ActiveGRCEntities]</td>
<td>New York</td>
</tr>
<tr>
<td>Average of average calculated ALE for this quarter [from ActiveGRCRiskStatements]</td>
<td>New York</td>
</tr>
<tr>
<td>Average of sum calculated ALE for this quarter [from ActiveGRCRiskStatements]</td>
<td>New York</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Average of sum calculated ALE for this quarter [from ActiveGRCEntities]</td>
<td>New York</td>
</tr>
<tr>
<td>My Risk Tasks by Priority</td>
<td>New York</td>
</tr>
<tr>
<td>Team Risk Backlog</td>
<td>New York</td>
</tr>
<tr>
<td>Team Very High Risks</td>
<td>New York</td>
</tr>
<tr>
<td>Unassigned Risks</td>
<td>New York</td>
</tr>
<tr>
<td>Overdue Risk Assessments</td>
<td>New York</td>
</tr>
<tr>
<td>Team Risks by Calculated Score</td>
<td>New York</td>
</tr>
<tr>
<td>Citation Authority Document Compliance</td>
<td>New York</td>
</tr>
<tr>
<td>Overall Profile Compliance (Quarterly)</td>
<td>New York</td>
</tr>
<tr>
<td>Average Citation Authority Document Compliance Score</td>
<td>New York</td>
</tr>
<tr>
<td>Maximum of maximum calculated ALE for this quarter [from ActiveGRCEntities]</td>
<td>New York</td>
</tr>
<tr>
<td>Maximum of maximum calculated ALE for this quarter [from ActiveGRCRiskStatements]</td>
<td>New York</td>
</tr>
<tr>
<td>Minimum of minimum calculated ALE for this quarter [from ActiveGRCEntities]</td>
<td>New York</td>
</tr>
<tr>
<td>Minimum of minimum calculated ALE for this quarter [from ActiveGRCRiskStatements]</td>
<td>New York</td>
</tr>
<tr>
<td># of events with high non-financial impact (Monthly)</td>
<td>Orlando</td>
</tr>
<tr>
<td># of events with high non-financial impact (Quarterly)</td>
<td>Quebec</td>
</tr>
<tr>
<td># of events with impact &gt; 1 M (Monthly)</td>
<td>Orlando</td>
</tr>
<tr>
<td># of events with impact &gt; 1 M (Quarterly)</td>
<td>Quebec</td>
</tr>
<tr>
<td>Annual Loss Expectancy [from ActiveGRCMonthlyEntities]</td>
<td>Orlando</td>
</tr>
<tr>
<td>Annual Loss Expectancy [from ActiveGRCMonthlyRiskStatement]</td>
<td>Orlando</td>
</tr>
<tr>
<td>Average additional cost per event</td>
<td>Orlando</td>
</tr>
<tr>
<td>Average gross loss per event</td>
<td>Orlando</td>
</tr>
<tr>
<td>Average Net Loss Per Event</td>
<td>Orlando</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Average recovery made per loss event</td>
<td>Orlando</td>
</tr>
<tr>
<td>Gross Loss</td>
<td>Orlando</td>
</tr>
<tr>
<td>Near Miss</td>
<td>Orlando</td>
</tr>
<tr>
<td>Net Loss</td>
<td>Orlando</td>
</tr>
<tr>
<td>Non-financial impact</td>
<td>Orlando</td>
</tr>
<tr>
<td>Number of events</td>
<td>Orlando</td>
</tr>
<tr>
<td># of High Residual Risks</td>
<td>Paris</td>
</tr>
<tr>
<td># of Ineffective Controls</td>
<td>Paris</td>
</tr>
<tr>
<td># of Risk Events</td>
<td>Paris</td>
</tr>
<tr>
<td>Average Control Effectiveness</td>
<td>Paris</td>
</tr>
<tr>
<td>Average Inherent Risk</td>
<td>Paris</td>
</tr>
<tr>
<td>Average Residual Risk</td>
<td>Paris</td>
</tr>
<tr>
<td>Non-financial Risk Events</td>
<td>Paris</td>
</tr>
<tr>
<td>Risk Assessments (Open)</td>
<td>Paris</td>
</tr>
<tr>
<td>Risk Assessments in Monitor State</td>
<td>Paris</td>
</tr>
<tr>
<td>Total Expected Loss</td>
<td>Paris</td>
</tr>
<tr>
<td>Total Gross Loss</td>
<td>Paris</td>
</tr>
<tr>
<td>Total Net Loss</td>
<td>Paris</td>
</tr>
<tr>
<td>Total Potential Loss</td>
<td>Paris</td>
</tr>
<tr>
<td>Entity residual risk trend</td>
<td>Quebec</td>
</tr>
<tr>
<td>Residual risk</td>
<td>Quebec</td>
</tr>
<tr>
<td>PPM - Project Risk Assessments</td>
<td>Quebec</td>
</tr>
<tr>
<td>PPM - Enterprise Risk Assessments</td>
<td>Quebec</td>
</tr>
<tr>
<td>PPM - Risks Assessed</td>
<td>Quebec</td>
</tr>
<tr>
<td>PPM - Risks with Enterprise Impact</td>
<td>Quebec</td>
</tr>
<tr>
<td>PPM - Total Risks</td>
<td>Quebec</td>
</tr>
<tr>
<td>High Risk with Failed Control</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Risks with failed indicators</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**GRC: Audit Management indicators**

Indicators included with the GRC: Audit Management Analytics and Reporting Solution.

For more information, see [GRC: Audit Management Analytics and Reporting Solution](#).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>All control tests</td>
<td>Quebec</td>
</tr>
<tr>
<td>Control tests created this quarter</td>
<td>Quebec</td>
</tr>
<tr>
<td>Failed control test quarterly</td>
<td>Quebec</td>
</tr>
<tr>
<td>Failed control tests</td>
<td>Quebec</td>
</tr>
<tr>
<td>Failed controls</td>
<td>Quebec</td>
</tr>
<tr>
<td>Key Controls not Tested</td>
<td>Quebec</td>
</tr>
<tr>
<td>Ongoing Control Test</td>
<td>Quebec</td>
</tr>
<tr>
<td>Open Audit Issue</td>
<td>Quebec</td>
</tr>
<tr>
<td>Passed Controls</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**GRC: Policy and Compliance indicators**

Indicators included with the GRC: Policy and Compliance application from the ServiceNow Store.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date created</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Failed Control Indicators</td>
<td>2020-03-30</td>
</tr>
<tr>
<td># of Failed Control Tests</td>
<td>2020-03-30</td>
</tr>
<tr>
<td>Controls (not retired)</td>
<td>2020-03-30</td>
</tr>
<tr>
<td># of attestation failures</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td># of failed control indicators</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td># of failed control tests</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Indicator</td>
<td>Date created</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Active Controls</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>All active control indicators in last 6 months</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Authority document compliance score percentage</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Citation compliance score percentage</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Control Not Attested</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Control Objective Compliance Score Percentage</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Controls without KCI's</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Controls without Test Plans</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Entity compliance score %</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Exempted Controls</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Failed control indicators in last 6 months</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Key Controls</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Key Controls with Failed Indicators</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Mandated Controls</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>New Controls</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Orphan Controls</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Policy Compliance Score Percentage</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
<tr>
<td>Total Control Indicators</td>
<td>2021-03-26, version 12.0.1</td>
</tr>
</tbody>
</table>

**GRC: Profiles indicators**

Indicators included with the GRC: Profiles application from the ServiceNow Store.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date created</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator Task (created this quarter)</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>Issues (created this quarter)</td>
<td>2020-03-31</td>
</tr>
<tr>
<td>All Open Issues</td>
<td>2021-03-27</td>
</tr>
<tr>
<td>All Open Issues QoQ</td>
<td>2021-03-27</td>
</tr>
</tbody>
</table>
### GRC: Risk Management Indicators

Indicators included with the GRC: Risk Management application from the ServiceNow Store.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date created</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Failed Risk Indicators</td>
<td>2020-03-30</td>
</tr>
<tr>
<td># of Open Mitigation Tasks</td>
<td>2020-03-30</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
## Guided Tour indicators

Indicators included in the Guided Tour Analytics and Reporting Solution. This Solution is available as a ServiceNow Store application.

For more information, see [Guided Tour Designer (sn.touranalytics)](sn.touranalytics).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version Introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guided Tour: All Qualified Tour Users</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Users who Completed Tours</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Tours Failed</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Unique Users</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Unique Users Weekly</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Summed Session Duration</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Tours Completed</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Tours Dismissed</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Plays</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Unique Users who Completed Tour Weekly</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Average Session Duration (sec)</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: Number of Disengaged Users</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: All Tour Completion Users</td>
<td>NewYork</td>
</tr>
<tr>
<td>Guided Tour: User Completions over Qualified Tour Users</td>
<td>NewYork</td>
</tr>
</tbody>
</table>

## Health Log Analytics indicators

Indicators included with NOW Intelligence Solutions for Health Log Analytics, available on the ServiceNow Store.

For more information, see [NOW Intelligence Solutions for Health Log Analytics](sn.touranalytics).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date created</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ Saved</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>Indicator</td>
<td>Date created</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>$ saved (MTTR)</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>Active streaming endpoints</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>Alerts compression ratio</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>Alerts with KB</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>Alerts.Open</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>Average time between HLA alert occurrence time and alert closed time</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>Closed alerts without ITSM ticket</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>Detections.accepted</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>HLA alerts that marked as significant</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>HLA alerts turned ITSM ticket</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
<tr>
<td>HLA alerts with ITSM ticket</td>
<td>2021-03-28 version 19.1.4</td>
</tr>
</tbody>
</table>

**Human Resources indicators**

Indicators included in the Human Resources, Human Resources: Employee Relations, and Human Resources Lifecycles Events Analytics and Reporting Solutions.

For more information, see [HR Performance Analytics Scoped Solutions](#) and [Analytics and Reporting Solutions for Employee Relations](#).

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average age of open cases</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new cases</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed cases</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Total number of cases and requests logged in first 30 days</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of HR Cases logged in first 30 days of employment</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of IT Requests logged in first 30 days of employment</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of Facilities Requests logged in first 30 days of employment</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average reassignment of open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average age of closed cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average time taken for onboarding activities - Employee</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of employees leaving the company</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average time taken for onboarding activities - Fulfiler</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average number of onboarding activities per onboarding case - Fulfiler</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average number of onboarding activities per onboarding case</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average number of onboarding activities per onboarding case - Employee</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average time taken for onboarding activities</td>
<td>Kingston</td>
</tr>
<tr>
<td>Summed reassignment of open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of reassigned open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>HR Cases Growth</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of open cases with breached SLAs</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of cases with no updates in last 10 days</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of closed HR Cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Summed duration of open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of cases with no updates in last 3 days</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of unassigned open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average case survey score</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of open cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of closed HR cases</td>
<td>Kingston</td>
</tr>
<tr>
<td>Average new hire satisfaction survey score</td>
<td>London</td>
</tr>
<tr>
<td>Number of new lifecycle events cases</td>
<td>London</td>
</tr>
<tr>
<td>Number of closed onboarding activities - Employee</td>
<td>London</td>
</tr>
<tr>
<td>Number of open lifecycle events cases - Pre Day 1</td>
<td>London</td>
</tr>
<tr>
<td>Number of Closed Onboarding Activities</td>
<td>London</td>
</tr>
<tr>
<td>Number of open lifecycle events cases - Post Day 1</td>
<td>London</td>
</tr>
<tr>
<td>Summed Duration of Onboarding Activities</td>
<td>London</td>
</tr>
<tr>
<td>Summed duration of onboarding activities - Fulfiller</td>
<td>London</td>
</tr>
<tr>
<td>Number of closed lifecycle events cases</td>
<td>London</td>
</tr>
<tr>
<td>Summed duration of onboarding activities - Employee</td>
<td>London</td>
</tr>
<tr>
<td>Number of closed onboarding activities - Fulfiller</td>
<td>London</td>
</tr>
<tr>
<td>Number of open lifecycle events cases - Employees starting in next 7 days</td>
<td>London</td>
</tr>
<tr>
<td>ContentAnalytics.Daily Page Views</td>
<td>Madrid</td>
</tr>
<tr>
<td>ContentAnalytics.All Visits</td>
<td>Madrid</td>
</tr>
<tr>
<td>ContentAnalytics.Daily Visits</td>
<td>Madrid</td>
</tr>
<tr>
<td>ContentAnalytics.Weekly Page Views</td>
<td>Madrid</td>
</tr>
<tr>
<td>ContentAnalytics.Daily Unique Users</td>
<td>NewYork</td>
</tr>
<tr>
<td>ContentAnalytics.Daily Events</td>
<td>NewYork</td>
</tr>
<tr>
<td>Content Analytics.Events.ServiceNowTracking Only</td>
<td>NewYork</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Content Analytics.Daily bounce rate</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.Daily New Users</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.Daily average time per page</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.All-time average page views per session.ServiceNow Tracking Only</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.Daily Browser Visits</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.Weekly Visits</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.Average session duration</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.All Page Views.ServiceNowTracking Only</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.Daily Total Session Duration</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.Weekly average page views per session</td>
<td>New York</td>
</tr>
<tr>
<td>Content Analytics.Daily Bounces</td>
<td>New York</td>
</tr>
<tr>
<td>Campaign.To-dos.All</td>
<td>New York</td>
</tr>
<tr>
<td>ERCases.AllegationTypes</td>
<td>Quebec</td>
</tr>
<tr>
<td>ERCases.CorrectiveActions</td>
<td>Quebec</td>
</tr>
<tr>
<td>ERCases.NewThisWeek</td>
<td>Quebec</td>
</tr>
<tr>
<td>ERCases.Open</td>
<td>Quebec</td>
</tr>
<tr>
<td>ERCases.PastSLA</td>
<td>Quebec</td>
</tr>
<tr>
<td>ERCases.Restricted</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

### Idea Manager dashboard indicators

Indicators included with the Idea Manager dashboard for PPM from the ServiceNow Store.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date created</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Failed Risk Indicators</td>
<td>2020-03-30</td>
</tr>
<tr>
<td># of Open Mitigation Tasks</td>
<td>2020-03-30</td>
</tr>
</tbody>
</table>
## Incident Management indicators

Indicators included in the Performance Analytics Incident Management content packs: com.snc.pa, com.snc.pa.itsm_dashboards, com.snc.pa.itsm_dashboards.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average age of last update of open incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open incidents reassigned at least once</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of incidents not solved</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open incidents not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open incidents not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of last update of open incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average close time of incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average re-assignment of open incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of incidents resolved on the same day opened</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of incidents resolved on same day opened</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open incidents not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average resolution time of resolved incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of resolved incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of open incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Incident backlog growth</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed re-assignment of open incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of incidents closed by self-service</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version Introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Number of incidents closed by self-service</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of new critical incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of incidents resolved without reassignment</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of resolved incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of incidents not solved</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of resolved incidents by first assigned group</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of incidents resolved by first assigned group</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age open incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of reassigned open incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open incidents not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open incidents missed SLA</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of open incidents with problem</td>
<td>Kingston</td>
</tr>
<tr>
<td>% of overdue requested items</td>
<td>Kingston</td>
</tr>
<tr>
<td>Active Major Incidents</td>
<td>Kingston</td>
</tr>
<tr>
<td>Closed workload</td>
<td>Kingston</td>
</tr>
<tr>
<td>ITSM average overall customer satisfaction</td>
<td>Kingston</td>
</tr>
<tr>
<td>ITSM normalized satisfaction score</td>
<td>Kingston</td>
</tr>
<tr>
<td>ITSM survey instances</td>
<td>Kingston</td>
</tr>
<tr>
<td>Major Incidents Opened Today</td>
<td>Kingston</td>
</tr>
<tr>
<td>New workload</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of incidents missed SLA</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of open changes planned in the next 7d</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of open incident unassigned</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of open incidents with problem</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of resolved major incidents</td>
<td>Kingston</td>
</tr>
<tr>
<td>Open workload</td>
<td>Kingston</td>
</tr>
<tr>
<td>Summed duration of resolved Major incidents</td>
<td>Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version Introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Workload backlog growth</td>
<td>Kingston</td>
</tr>
<tr>
<td>Number of Resolved Incidents with Breached SLAs</td>
<td>Madrid</td>
</tr>
<tr>
<td>ITSM survey instances</td>
<td>Madrid</td>
</tr>
<tr>
<td>% Closed Requests with Breached SLA</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of open incidents missed SLA</td>
<td>Madrid</td>
</tr>
<tr>
<td>Predicted Average Cost of Open Incidents</td>
<td>Madrid</td>
</tr>
<tr>
<td>% Resolved Incidents with Breached SLA</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average Cost per Request</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of open changes planned in the next 7d</td>
<td>Madrid</td>
</tr>
<tr>
<td>Closed workload</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of open incidents with problem</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of open incident unassigned</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of active task SLA</td>
<td>Madrid</td>
</tr>
<tr>
<td>Active Breached SLAs Today</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of requests closed after due date</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Closed Requests with Breached SLAs</td>
<td>Madrid</td>
</tr>
<tr>
<td>Workload backlog growth</td>
<td>Madrid</td>
</tr>
<tr>
<td>Cost of Incidents Resolved</td>
<td>Madrid</td>
</tr>
<tr>
<td>ITSM normalized satisfaction score</td>
<td>Madrid</td>
</tr>
<tr>
<td>ITSM Average Overall Customer Satisfaction</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of overdue requested items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Open workload</td>
<td>Madrid</td>
</tr>
<tr>
<td>Cost of Requests Completed</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**Incident SLA Management indicators**

Indicators included in the Incident SLA Management Analytics and Reporting Solution.

For more information, see [Incident SLA (com.snc.pa.sla)](https://service-now.com).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of open and overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of updated since of open and overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% open and overdue incident assignments</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of updated since of open and overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of incident assignments responded to in time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open incidents that should be resolved in time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% incidents resolved in time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% open and overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age open and overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td># of incident assignments that should have been responded to in time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% incident assignments responded in time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of open and overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td># of incidents resolved that should have been resolved in time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed reassignments of open and overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average reassignments of open and overdue incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of incidents resolved in time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td># of open incident assignments that should be responded to in time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open and overdue incident assignments</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

**ITSM indicators**

Indicators included in the ITSM Analytics and Reporting Solutions (ITSM Agent, ITSM Manager, ITSM Executive).

For more information, see [ITSM Dashboards](com.snc.pa.itsm_dashboards).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>% Closed Requests with Breached SLA</td>
<td>Madrid</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>% of open incidents missed SLA</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of open incidents with problem</td>
<td>Madrid</td>
</tr>
<tr>
<td>% of overdue requested items</td>
<td>Madrid</td>
</tr>
<tr>
<td>% Resolved Incidents with Breached SLA</td>
<td>Madrid</td>
</tr>
<tr>
<td>Active Breached SLAs Today</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average Cost per Incident</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average Cost per Request</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average Cost per Request - Weekly=</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average Cost per Resolved Incident - Weekly</td>
<td>Madrid</td>
</tr>
<tr>
<td>Average resolution time of resolved incidents in hour</td>
<td>Orlando</td>
</tr>
<tr>
<td>Closed workload</td>
<td>Madrid</td>
</tr>
<tr>
<td>Cost of Incidents Resolved</td>
<td>Madrid</td>
</tr>
<tr>
<td>Cost of Requests Completed</td>
<td>Madrid</td>
</tr>
<tr>
<td>ITSM Average Overall Customer Satisfaction</td>
<td>Madrid</td>
</tr>
<tr>
<td>ITSM normalized satisfaction score</td>
<td>Madrid</td>
</tr>
<tr>
<td>ITSM survey instances</td>
<td>Madrid</td>
</tr>
<tr>
<td>New workload</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of active task sla</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of breach task sla today</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**Knowledge Management indicators**

Indicators included in the Knowledge Management Analytics and Reporting Solution.

For more information, see Knowledge Management (com.snc.pa.knowledge_v2).
## Knowledge Management, pre-London version (deprecated)

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total rating of published knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum of rating of new knowledge feedback</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of active questions</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of published articles viewed</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average time to publish knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of published articles used</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average views per knowledge article</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average view count of published articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of incidents deflected by knowledge</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of active questions answered</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average question answer count</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new knowledge feedback</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of published articles flagged</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum view count of published knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of published articles marked not useful</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of published articles marked useful</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of knowledge articles viewed</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of unique users viewing knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum use count of published knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of published knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average article rating</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of use of knowledge articles viewed</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of published articles flagged</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average use per knowledge article</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of published articles viewed</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>
Knowledge Management, pre-London version (deprecated) (continued)

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of questions answered</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of flagged knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of published articles marked useful</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average question view count</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of published articles used</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of flagged knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of published articles</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of published knowledge articles marked not useful</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new knowledge feedback rated</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of knowledge articles used</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of knowledge articles</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

Knowledge Management v2

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version Introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Knowledge Articles Published</td>
<td>London</td>
</tr>
<tr>
<td>Average Click Rank</td>
<td>London</td>
</tr>
<tr>
<td>Average Time to Publish</td>
<td>London</td>
</tr>
<tr>
<td>Click Through Rate</td>
<td>London</td>
</tr>
<tr>
<td>Monthly Average Article Rating</td>
<td>London</td>
</tr>
<tr>
<td>Number of Active Users Who Performed Searches — Monthly</td>
<td>London</td>
</tr>
<tr>
<td>Number of Active Users Who Viewed Articles — Monthly</td>
<td>London</td>
</tr>
<tr>
<td>Number of Knowledge Articles Active</td>
<td>London</td>
</tr>
<tr>
<td>Number of Knowledge Articles Published</td>
<td>London</td>
</tr>
</tbody>
</table>
**Knowledge Management v2 (continued)**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version Introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Knowledge Articles Rated — Monthly</td>
<td>London</td>
</tr>
<tr>
<td>Number of Knowledge Searches with Rank — Monthly</td>
<td>London</td>
</tr>
<tr>
<td>Number of Knowledge Searches — Monthly</td>
<td>London</td>
</tr>
<tr>
<td>Sum of Knowledge Article Rating — Monthly</td>
<td>London</td>
</tr>
<tr>
<td>Sum of Knowledge Search Ranks — Monthly</td>
<td>London</td>
</tr>
<tr>
<td>Average Click Rank for Unauthenticated Users</td>
<td>Quebec</td>
</tr>
<tr>
<td>Click Through Rate for Unauthenticated Users</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of Article Views by Unauthenticated Users — Monthly</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of Knowledge Searches by Unauthenticated Users — Monthly</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of Knowledge Searches with Click Rank for Unauthenticated Users — Monthly</td>
<td>Quebec</td>
</tr>
<tr>
<td>Sum of Knowledge Search Ranks by Unauthenticated Users — Monthly</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**Major Incident Management indicators**

Indicators included in the Major Incident Management Analytics and Reporting Solution.

For more information, see Major Incident Management (com.snc.pa.incident.mim).
## Indicators

### NLU Workbench indicators
Indicators included with the NLU Workbench plugin (com.snc.nlu_studio).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version added</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLU Intent Predictions Count</td>
<td>Paris</td>
</tr>
</tbody>
</table>

### On-call Scheduling indicators
Indicators included with the On-call Scheduling plugin (com.snc.on_call_rotation).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version added</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Call: % of Acknowledged Escalation Contact Attempts</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: % of Acknowledged Escalations</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: % of Unacknowledged Escalation Contact Attempts</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: % of Unacknowledged Escalations</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Average Escalation Acknowledgment</td>
<td>Paris</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version added</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>On-Call: Average Level Acknowledgment</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Average Notification Acknowledgment Response</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Count of Contact Attempts Acknowledged</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Count of Escalation Contact Attempts</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Count of Escalation Notifications</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Count of Escalation Notifications Acknowledged</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Count of Escalation Notifications Unacknowledged</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Count of Escalations</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Count of Escalations Acknowledged</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Number of Escalations Unacknowledged</td>
<td>Paris</td>
</tr>
<tr>
<td>On-Call: Number of Unacknowledged Escalation Contact Attempts</td>
<td>Paris</td>
</tr>
</tbody>
</table>

**Operational Intelligence indicators**

Indicators included in the Performance Analytics Operational Intelligence content pack: com.snc.sa.metric.pa.content.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Promoted Anomalous Alerts</td>
<td>London</td>
</tr>
<tr>
<td>Summed duration of closed promoted anomaly alerts</td>
<td>London</td>
</tr>
<tr>
<td>Number of Closed Promoted Anomaly Alerts</td>
<td>London</td>
</tr>
<tr>
<td>Number of New Promoted Anomaly Alerts</td>
<td>London</td>
</tr>
<tr>
<td>Number of new anomaly alerts</td>
<td>London</td>
</tr>
<tr>
<td>Avg Resolve Time of Promoted Alerts</td>
<td>London</td>
</tr>
</tbody>
</table>

**Performance Analytics Usage Overview indicators**

Indicators included in the Performance Analytics Usage Overview content pack and dashboard, which is included in the base installation of Performance Analytics: com.snc.pa.usage.overview
### Platform Usage indicators

Indicators included in the Performance Analytics Platform Usage content pack and dashboard, which is included in the base installation of Performance Analytics: com.snc.usage_admin.dashboards

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Custom Tables</td>
<td>Madrid</td>
</tr>
<tr>
<td>Tables not Mapped</td>
<td>Madrid</td>
</tr>
<tr>
<td>Tables Mapped per Subscription</td>
<td>Madrid</td>
</tr>
<tr>
<td>Tables Included per Subscription</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

### Predictive Intelligence indicators

Indicators included in the Predictive Intelligence Reports content pack: com.glide.platform_ml_pa
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of attempted predictions based on Created Today</td>
<td>London</td>
</tr>
<tr>
<td>Prediction Coverage</td>
<td>London</td>
</tr>
<tr>
<td>Number of successful predictions not skipped based on final value date</td>
<td>London</td>
</tr>
<tr>
<td>Prediction Precision</td>
<td>London</td>
</tr>
<tr>
<td>Number of predicted results based on final value date</td>
<td>London</td>
</tr>
<tr>
<td>Number of applied predictions based on Created Today</td>
<td>London</td>
</tr>
<tr>
<td>Number of attempted predictions based on final value date</td>
<td>Orlando</td>
</tr>
<tr>
<td>Prediction Recall</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

**Problem Management indicators**

Indicators included in the Problem Management Analytics and Reporting Solution.

For more information, see Problem Management (com.snc.pa.problem).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version Introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of open problems classified as known errors</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of updated since of open problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average re-assignment of open problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of updated since of open problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of open problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open problems with at least one open incident</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed re-assignment of open problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open problems not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of closed problems without any close notes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open problems not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of problems closed on first assignment</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of open problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed problems without close notes</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average close time of problems</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open problems not updated in last 90 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open problems with at least one incident</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average reassignment count of closed problem</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

**Project Portfolio Suite with Financials indicators**

Indicators included in the Project Portfolio Suite with Financials Analytics and Reporting Solution.

For more information, see Project Portfolio Suite with Financials (com.snc.financial_planning_pmo).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summed overdue age of project tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average percentage complete of open projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum of estimated costs of projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of portfolios</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open project tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of overdue project tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of overdue projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum of resources allocated costs of projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum of actual costs of projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of overdue project tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open project tasks per project</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average overdue age of overdue project tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed project tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum of budget costs of projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new project tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of overdue projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Sum of resources planned costs of projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open projects per project manager</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average percentage complete of overdue projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of projects per portfolio</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Project task backlog growth</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed overdue age of projects</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>PPM- Number of Demands With Project s This Month</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Total Age of Open Project</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Total Age of Open Demand in Submitted, Screening, Qualified, Approved state</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Total Age of Demand to Project This Month</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- EAC Greater Than Planned Cost</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Number of Open Ideas</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Active Project s in Open, Pending, Work in Progress State</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Open Demands Submitted, Screening, Qualified or Approved</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Total Age of Open Idea</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Number of Total Demands This Month</td>
<td>Madrid</td>
</tr>
<tr>
<td>PPM- Number of Ideas With Demands This Month</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**Request Management indicators**

Indicators included in the Request Management (Requested Item) and Request Management (Requests) Performance Analytics Solutions.
For more information, see Request Management (Requested Item) (com.snc.pa.request) and Request Management (Requests) (com.snc.pa.request2).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summed re-assignment of open requested item</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average re-assignment of open requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of open requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of rejected requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open requested items not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of requested items closed before due date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open requested items not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed requested items cancelled</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed requested items rejected</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of open requested item</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open requested items before due date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of updated since of open requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of requested items closed before due date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open requested items not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average close time of requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of updated since of open requested item</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Requested items backlog growth</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open requested items before due date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open requested items not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of cancelled requested items</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Number of open requests before due date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of requests closed before due date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average close time of requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Requests backlog growth</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average re-assignments of open requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open requests before due date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed re-assignments of open requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of requests closed before due date</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of open requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open requests not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of updated since of open requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open requests not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of open requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of updated since of open requests</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open requests not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open requests not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

**Safe Workplace indicators**

Indicators included with the Safe Workplace dashboard from the ServiceNow Store.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date added</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Employees That Want To Return To Work</td>
<td>2020-05-14</td>
</tr>
<tr>
<td>% of Space Reserved</td>
<td>2020-05-15</td>
</tr>
<tr>
<td>Indicator</td>
<td>Date added</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Active Cases</td>
<td>2020-06-16</td>
</tr>
<tr>
<td>Contacts Under Investigation</td>
<td>2020-06-17</td>
</tr>
<tr>
<td>Employees Rejected % Change from Prior Day</td>
<td>2020-05-15</td>
</tr>
<tr>
<td>New Confirmed Cases</td>
<td>2020-05-14</td>
</tr>
<tr>
<td>New Deaths</td>
<td>2020-05-14</td>
</tr>
<tr>
<td>Number of Employees Admitted</td>
<td>2020-05-13</td>
</tr>
<tr>
<td>Number of Employees Not Ready to Return</td>
<td>2020-05-12</td>
</tr>
<tr>
<td>Number of Employees Ready to Return</td>
<td>2020-05-12</td>
</tr>
<tr>
<td>Number of Employees Rejected</td>
<td>2020-05-13</td>
</tr>
<tr>
<td>Number of Employees Surveyed for Return Readiness</td>
<td>2020-05-14</td>
</tr>
<tr>
<td>Number of Workplace Reservable Spaces</td>
<td>2020-05-13</td>
</tr>
<tr>
<td>Number of Workplace Reserved Spaces</td>
<td>2020-05-13</td>
</tr>
<tr>
<td>Number of Workplace Spaces</td>
<td>2020-05-13</td>
</tr>
<tr>
<td>Number of Workplace Tasks</td>
<td>2020-05-13</td>
</tr>
<tr>
<td>PPE Inventory</td>
<td>2020-05-13</td>
</tr>
<tr>
<td>PPE Inventory % Change from Prior Day</td>
<td>2020-05-15</td>
</tr>
<tr>
<td>Total Confirmed Cases</td>
<td>2020-05-14</td>
</tr>
<tr>
<td>Total Deaths</td>
<td>2020-05-14</td>
</tr>
</tbody>
</table>

**Strategic Spend Tracking for PPM indicators**

Indicators included with the Strategic Spend for PPM application from the ServiceNow Store.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Date created</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aligned vs. Not Aligned Actual Cost</td>
<td>2020-03-19</td>
</tr>
<tr>
<td>Aligned vs. Not Aligned Actual Cost-Goals</td>
<td>2020-03-19</td>
</tr>
<tr>
<td>Aligned vs. Not Aligned Benefit</td>
<td>2020-03-27</td>
</tr>
<tr>
<td>Aligned vs. Not Aligned Benefit-Goals</td>
<td>2020-03-27</td>
</tr>
<tr>
<td>Indicator</td>
<td>Date created</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Aligned vs. Not Aligned Planned Cost</td>
<td>2020-03-19</td>
</tr>
<tr>
<td>Aligned vs. Not Aligned Planned Cost-Goals</td>
<td>2020-03-19</td>
</tr>
<tr>
<td>Aligned vs. Not Aligned Projects</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Aligned vs. Not Aligned Projects-Goals</td>
<td>2020-03-19</td>
</tr>
<tr>
<td>Number of Projects Aligned to Goals</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Number of Projects Aligned to Strategies</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Number of Projects Not Aligned to Goals</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Number of Projects Not Aligned to Strategies</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Total Actual Cost for All Goals</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Total Actual Cost for All Strategies</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Total Actual Cost for All Unaligned Projects</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Total Actual Cost for Goals All Unaligned Projects</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Total Benefits for All Goals</td>
<td>2020-03-27</td>
</tr>
<tr>
<td>Total Benefits for All Strategies</td>
<td>2020-03-27</td>
</tr>
<tr>
<td>Total Benefits for All Unaligned Projects</td>
<td>2020-03-27</td>
</tr>
<tr>
<td>Total Benefits for Goals All Unaligned Projects</td>
<td>2020-03-27</td>
</tr>
<tr>
<td>Total Planned Cost for All Goals</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Total Planned Cost for All Strategies</td>
<td>2020-03-18</td>
</tr>
<tr>
<td>Total Planned Cost for All Unaligned Projects</td>
<td>2020-03-10</td>
</tr>
<tr>
<td>Total Planned Cost for Goals All Unaligned Projects</td>
<td>2020-03-18</td>
</tr>
</tbody>
</table>

### Security Incident Response indicators

Indicators included in the Security Incident Response Analytics and Reporting Solution, available as an application on the ServiceNow Store.

For more information, see Security Incident Response (com.snc.security_incident.analytics).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version Introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of open security incidents not updated in last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Priority 1</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of security incidents closed on first assignment</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age open security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Average Duration Time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed security incident tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average close time of security incident tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Very High Risk</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed security incident tasks</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of security incidents not resolved</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident All Risk</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Business Criticality - non-critical</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average resolution time of closed security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average close time of security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open security incidents that have been reassigned</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Security Incidents - Closed</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>#of open security incidents not updated in the last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed re-assignment of open security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average re-assignment of open security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of security incidents closed by mitigating threat</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Average Time To Identify</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of open security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Severity 1</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of new security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>#of open security incidents not updated in the last 30 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of security incidents closed on first assignment</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version Introduced</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>SI - Incident Priority 2</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Severity 2</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Impact 2</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of open security incidents reassigned</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Priority All</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>#of security incidents closed on the same day opened</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Business Criticality - high</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Total Incident Count</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of security incidents closed on the same day opened</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Impact All</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Impact 1</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Security incident backlog growth</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of new critical security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of closed security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed duration of closed security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Sum of age of open security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average age of last update of open security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open security incidents not updated in last 5 days</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Denial of Service</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident High Risk</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Severity All</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of new security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Summed age of last update of open security incidents</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>SI - Incident Business Criticality – critical</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Time to Identity (Weekly)</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Time to Contain (Weekly)</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Time to Eradicate (Weekly)</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version Introduced</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>New Security Incidents This Week</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Security Incidents Closed This Week</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of Security Incidents by Priority</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>New vs. Closed Security Incidents (Weekly)</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Security Incident Map</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Business Services with Security Incidents - Business Impact</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

**Self-Service Analytics PA indicators**

Indicators included in the Self-Service Analytics PA plugin. This plugin provides the indicators and breakdowns you need to create Performance Analytics widgets for putting Self-Service Analytics on your dashboards. This plugin is installed automatically as a dependency of the Self-Service Analytics for Customer Service content pack.

**Indicator sources**

<table>
<thead>
<tr>
<th>Indicator source</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog.Views.Monthly</td>
<td>Paris</td>
</tr>
<tr>
<td>Catalog.Requests.Monthly</td>
<td>Paris</td>
</tr>
<tr>
<td>Community.Feedback.Monthly</td>
<td>Paris</td>
</tr>
<tr>
<td>Community.Views.Monthly</td>
<td>Paris</td>
</tr>
<tr>
<td>Knowledge.Views.Monthly</td>
<td>Paris</td>
</tr>
<tr>
<td>VA.Conversations.Monthly</td>
<td>Paris</td>
</tr>
</tbody>
</table>

**Indicators**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog: Percentage of requests</td>
<td>Paris</td>
</tr>
<tr>
<td>Catalog: Success Rate</td>
<td>Paris</td>
</tr>
<tr>
<td>Catalog: Views this month</td>
<td>Paris</td>
</tr>
<tr>
<td>Communities: Helpful Feedback</td>
<td>Paris</td>
</tr>
</tbody>
</table>
Indicators (continued)

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communities: Percentage of community viewed</td>
<td>Paris</td>
</tr>
<tr>
<td>Communities: Views this month</td>
<td>Paris</td>
</tr>
<tr>
<td>Knowledge: Articles viewed this month</td>
<td>Paris</td>
</tr>
<tr>
<td>Knowledge: Helpful Feedback</td>
<td>Paris</td>
</tr>
<tr>
<td>Knowledge: Percentage of articles viewed</td>
<td>Paris</td>
</tr>
<tr>
<td>Number of Catalog requests</td>
<td>Paris</td>
</tr>
<tr>
<td>Percentage of helpful Community Content</td>
<td>Paris</td>
</tr>
<tr>
<td>Percentage of helpful Knowledge Articles</td>
<td>Paris</td>
</tr>
<tr>
<td>Self-Service: Engagements</td>
<td>Paris</td>
</tr>
<tr>
<td>Self-Service: Success Rate</td>
<td>Paris</td>
</tr>
<tr>
<td>Self-Service: Successful Engagements</td>
<td>Paris</td>
</tr>
<tr>
<td>VA: Conversations this month</td>
<td>Paris</td>
</tr>
<tr>
<td>VA: Percentage of Conversations</td>
<td>Paris</td>
</tr>
<tr>
<td>VA: Success Rate</td>
<td>Paris</td>
</tr>
<tr>
<td>VA: Successful Conversations</td>
<td>Paris</td>
</tr>
</tbody>
</table>

**Self-Service Analytics for Customer Service indicators**

Indicators included in the Self-Service Analytics for Customer Service plugin. When you install this content pack, you install Self-Service Analytics PA automatically as a dependency. The two content packs together contain all the indicators of the Analytics and Reporting Solution for Self-Service for Customer Service Management.

For more information, see [Self-Service Analytics PA](#).

**Indicator sources**

<table>
<thead>
<tr>
<th>Indicator source</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases.Resolved.Monthly</td>
<td>Paris</td>
</tr>
<tr>
<td>Deflections.Created.Monthly</td>
<td>Paris</td>
</tr>
</tbody>
</table>
### Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog: Deflections</td>
<td>Paris</td>
</tr>
<tr>
<td>Communities: Deflections</td>
<td>Paris</td>
</tr>
<tr>
<td>Knowledge: Deflections</td>
<td>Paris</td>
</tr>
<tr>
<td>Number of cases resolved</td>
<td>Paris</td>
</tr>
<tr>
<td>Number of Deflections</td>
<td>Paris</td>
</tr>
<tr>
<td>Self-Service: Confirmed Deflections</td>
<td>Paris</td>
</tr>
<tr>
<td>Self-Service: Cost Saved</td>
<td>Paris</td>
</tr>
<tr>
<td>Self-Service: Potential Deflections</td>
<td>Paris</td>
</tr>
<tr>
<td>VA: Deflections</td>
<td>Paris</td>
</tr>
</tbody>
</table>

### Service Desk Chat indicators

Indicators included in the Service Desk Chat Analytics and Reporting Solution.

For more information, see [Service Desk Chat (com.snc.pa.chat)](mailto:service-desk-chat).  

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of New Chats</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of total Closed Chats</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Response Time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Chat Queue Response Time</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Average Closed Chat Duration</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Number of Closed Chat</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

### Service Level Management indicators

Indicators included in the Analytics and Reporting Solutions for Service Level Management Analytics and Reporting Solution.

For more information, see [Analytics and Reporting Solutions for Service Level Management](mailto:analytics-and-reporting-solutions).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average durations of breached task SLA closed today</td>
<td>London</td>
</tr>
<tr>
<td>Number of closed task SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Average duration of achieved SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Number of achieved closed task SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Achieved SLAs Today</td>
<td>London</td>
</tr>
</tbody>
</table>

**Service Mapping indicators**

Indicators included in the Performance Analytics Service Mapping content pack: com.snc.service-mapping.pa.content

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Map status</td>
<td>Kingston</td>
</tr>
<tr>
<td>Service mapping error categories</td>
<td>Kingston</td>
</tr>
</tbody>
</table>

**Service Portfolio Management indicators**

Indicators included in Service Portfolio Management Premium: snc_spm

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPM Availability</td>
<td>Madrid</td>
</tr>
<tr>
<td>SPM P1 Incident and Major Incident Count</td>
<td>Madrid</td>
</tr>
<tr>
<td>SPM Catalog Activity</td>
<td>Madrid</td>
</tr>
<tr>
<td>Service Offering: Subscribers</td>
<td>Madrid</td>
</tr>
<tr>
<td>Service Performance</td>
<td>Madrid</td>
</tr>
<tr>
<td>SPM Breached SLA</td>
<td>Madrid</td>
</tr>
<tr>
<td>Taxonomy Node Performance</td>
<td>Madrid</td>
</tr>
<tr>
<td>SPM SLA %</td>
<td>Madrid</td>
</tr>
<tr>
<td>SPM CSAT per Service Offering</td>
<td>Madrid</td>
</tr>
<tr>
<td>Offering Metric Weight</td>
<td>New York</td>
</tr>
<tr>
<td>Offering Performance</td>
<td>New York</td>
</tr>
</tbody>
</table>
### Service Portal indicators

Indicators included in the Service Portal Analytics and Reporting Solution on the ServiceNow Store.

For more information, see Service Portal (sn_portal_db).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Click Rank</td>
<td>Orlando</td>
</tr>
<tr>
<td>Average Click-Through Rate</td>
<td>Orlando</td>
</tr>
<tr>
<td>Distinct Page Views</td>
<td>New York</td>
</tr>
<tr>
<td>Number of Daily Unique Service Portal Visitors</td>
<td>New York</td>
</tr>
<tr>
<td>Number of Searches</td>
<td>Orlando</td>
</tr>
<tr>
<td>Number of Searches Resulting in a Click</td>
<td>Orlando</td>
</tr>
<tr>
<td>Number of Service Portal Page Views</td>
<td>New York</td>
</tr>
<tr>
<td>Number of Users who Searched</td>
<td>Orlando</td>
</tr>
<tr>
<td>Pages per Visitor</td>
<td>New York</td>
</tr>
</tbody>
</table>

### Software Asset Management indicators

Indicators included in the Software Asset Management Professional Analytics and Reporting Solution.

For more information, see Software Asset Management Professional (com.snc.pa.samp).

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over-licensed Amount</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Potential Savings</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Publishers Out of Compliance</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Publishers Over-licensed</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Potential Savings</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Products Over-licensed</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Publishers Out of Compliance</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Products Over-licensed</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Over-licensed Amount</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Publishers Over-licensed</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>Products Out of Compliance</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of Products Compliant</td>
<td>Kingston</td>
</tr>
<tr>
<td>% Spend in Use</td>
<td>Kingston</td>
</tr>
<tr>
<td>Active Removal Candidates</td>
<td>Kingston</td>
</tr>
<tr>
<td>Actual Savings Year-to-date</td>
<td>Kingston</td>
</tr>
<tr>
<td>Count of Products</td>
<td>Kingston</td>
</tr>
<tr>
<td>Percent Spend Not in Use</td>
<td>Kingston</td>
</tr>
<tr>
<td>Products in Compliance</td>
<td>Kingston</td>
</tr>
<tr>
<td>SAM % Software Spend Change Monthly</td>
<td>Kingston</td>
</tr>
<tr>
<td>SAM Products Out of Compliance</td>
<td>Kingston</td>
</tr>
<tr>
<td>Software Spend</td>
<td>Kingston</td>
</tr>
<tr>
<td>Total True-up Cost</td>
<td>Kingston</td>
</tr>
<tr>
<td>True-up Cost</td>
<td>Kingston</td>
</tr>
<tr>
<td>Percent Spend Not in Use</td>
<td>London</td>
</tr>
<tr>
<td>% of Products Compliant</td>
<td>London</td>
</tr>
<tr>
<td>% of Unused Subscriptions</td>
<td>London</td>
</tr>
<tr>
<td>% Spend in Use</td>
<td>London</td>
</tr>
<tr>
<td>True-up Cost</td>
<td>London</td>
</tr>
<tr>
<td>Over-licensed Amount</td>
<td>London</td>
</tr>
<tr>
<td>Potential Savings</td>
<td>London</td>
</tr>
<tr>
<td>Publishers Over-licensed</td>
<td>London</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Publishers Out of Compliance</td>
<td>London</td>
</tr>
<tr>
<td>Products Over-licensed</td>
<td>London</td>
</tr>
<tr>
<td>Products Out of Compliance</td>
<td>London</td>
</tr>
<tr>
<td>Active Removal Candidates</td>
<td>London</td>
</tr>
<tr>
<td>Actual Savings Year-to-date</td>
<td>London</td>
</tr>
<tr>
<td>Software Spend</td>
<td>London</td>
</tr>
<tr>
<td>Sum of Active Rights</td>
<td>London</td>
</tr>
<tr>
<td>Current Subscription Spend</td>
<td>London</td>
</tr>
<tr>
<td>Unused Subscriptions</td>
<td>London</td>
</tr>
<tr>
<td>Available Subscriptions</td>
<td>London</td>
</tr>
<tr>
<td>Count of Products</td>
<td>London</td>
</tr>
<tr>
<td>SAM Products Out of Compliance</td>
<td>London</td>
</tr>
<tr>
<td>Total True-up Cost</td>
<td>London</td>
</tr>
<tr>
<td>Products in Compliance</td>
<td>London</td>
</tr>
<tr>
<td>Count of SQL Server Installs</td>
<td>London</td>
</tr>
<tr>
<td>Software Models Out of Compliance</td>
<td>London</td>
</tr>
<tr>
<td>Assigned Subscriptions</td>
<td>London</td>
</tr>
<tr>
<td>Rights Consumed</td>
<td>Madrid</td>
</tr>
<tr>
<td>Rights Owned</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP Unique Users Monthly</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP Potential Savings</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP System Users Without a Named User Assignment</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP Users Who Last Logged On Over 90 days ago</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP Locked Users Consuming A License</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP Non-Dialog Users With a Named User Assignment</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP Over-licensed Amount</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP Total True-up Cost</td>
<td>Madrid</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Named Users Out of Compliance</td>
<td>Madrid</td>
</tr>
<tr>
<td>SAP Potential User For Role Based Optimization</td>
<td>New York</td>
</tr>
<tr>
<td>Available Subscriptions for SAAS</td>
<td>New York</td>
</tr>
<tr>
<td>SAP User Activity</td>
<td>New York</td>
</tr>
<tr>
<td>Assigned Subscriptions Monthly</td>
<td>New York</td>
</tr>
<tr>
<td>Under-performing Subscription Spend</td>
<td>New York</td>
</tr>
<tr>
<td>Envelopes remaining</td>
<td>New York</td>
</tr>
<tr>
<td>Subscription Reclaimed Candidates</td>
<td>New York</td>
</tr>
<tr>
<td>% of Stale Subscriptions</td>
<td>New York</td>
</tr>
<tr>
<td>Envelopes consumed</td>
<td>New York</td>
</tr>
<tr>
<td>Expense</td>
<td>New York</td>
</tr>
<tr>
<td>SAP Web Activity</td>
<td>New York</td>
</tr>
<tr>
<td>Accounts Payable</td>
<td>New York</td>
</tr>
<tr>
<td>Subscriptions in Use</td>
<td>New York</td>
</tr>
<tr>
<td>Software Subscription True-up Cost</td>
<td>New York</td>
</tr>
<tr>
<td>Stale</td>
<td>New York</td>
</tr>
<tr>
<td>Actively Used</td>
<td>New York</td>
</tr>
<tr>
<td>SAM: Engineering App Current Spend</td>
<td>Orlando</td>
</tr>
<tr>
<td>SAM: Engineering App Potential Savings</td>
<td>Orlando</td>
</tr>
<tr>
<td>SAM: PA SAP User Activity for Potential...</td>
<td>Orlando</td>
</tr>
<tr>
<td>SAM: SAP PA Web Activity for indirect Access</td>
<td>Orlando</td>
</tr>
<tr>
<td>SAM Expiring Maintenance</td>
<td>Orlando</td>
</tr>
<tr>
<td>SAP Active Engines</td>
<td>Paris</td>
</tr>
<tr>
<td>SAP Engine Out of Compliance</td>
<td>Paris</td>
</tr>
<tr>
<td>SAP Engines usage reached 90% and above</td>
<td>Paris</td>
</tr>
<tr>
<td>SAP Unused Engines</td>
<td>Paris</td>
</tr>
<tr>
<td>Citrix License Consumption History</td>
<td>Quebec</td>
</tr>
</tbody>
</table>
Microsoft Products Across Hybrid Environments
Potential savings by optimizing licenses
Potential software subscription savings
SAM: SAP Total Potential Savings
SAP Potential User for Transaction-Based License Optimization
SAP Potential Savings from Removal Candidates
Stale Subscription by Instance

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Products Across Hybrid Environments</td>
<td>Quebec</td>
</tr>
<tr>
<td>Potential savings by optimizing licenses</td>
<td>Quebec</td>
</tr>
<tr>
<td>Potential software subscription savings</td>
<td>Quebec</td>
</tr>
<tr>
<td>SAM: SAP Total Potential Savings</td>
<td>Quebec</td>
</tr>
<tr>
<td>SAP Potential User for Transaction-Based License Optimization</td>
<td>Quebec</td>
</tr>
<tr>
<td>SAP Potential Savings from Removal Candidates</td>
<td>Quebec</td>
</tr>
<tr>
<td>Stale Subscription by Instance</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**Spotlight indicators**

Indicators included in the Performance Analytics Spotlight content pack: com.snc.pa.spotlight.incident

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of open incidents under the spotlight</td>
<td>Pre-Kingston</td>
</tr>
<tr>
<td>% of open incidents under the spotlight</td>
<td>Pre-Kingston</td>
</tr>
</tbody>
</table>

**Vulnerability Response indicators**

Indicators included in the Vulnerability Response Analytics and Reporting Solution, available as an application on the ServiceNow Store.

For more information, see Vulnerability Response (com.snc.vulnerability.analytics).
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Vulnerabilities</td>
<td>Madrid</td>
</tr>
<tr>
<td>Vulnerable Configuration Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Vulnerable Items by Risk Rating</td>
<td>Madrid</td>
</tr>
<tr>
<td>Vulnerable Items by Age and Risk Rating</td>
<td>Madrid</td>
</tr>
<tr>
<td>Number of Vulnerability Groups</td>
<td>Madrid</td>
</tr>
<tr>
<td>% Vulnerable Items Met Remediation Target</td>
<td>Madrid</td>
</tr>
<tr>
<td>VI Mean Time to RemEDIATE (MTTR)</td>
<td>Madrid</td>
</tr>
<tr>
<td>Critical Vulnerability Groups Near Due</td>
<td>Madrid</td>
</tr>
<tr>
<td>New and Closed Vulnerable Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Closed Vulnerable Items by Remediation Target Status</td>
<td>Madrid</td>
</tr>
<tr>
<td>Critical Vulnerable Items by Assignment Group</td>
<td>Madrid</td>
</tr>
<tr>
<td>Critical Vulnerable Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Overdue Critical Vulnerable Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>High Risk Vulnerable Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Critical Vulnerable Items by Service Owner</td>
<td>Madrid</td>
</tr>
<tr>
<td>Critical Overdue Vulnerable Items by Service Owner</td>
<td>Madrid</td>
</tr>
<tr>
<td>Overdue High Risk Vulnerable Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Deferred Vulnerable Items by Reason</td>
<td>Madrid</td>
</tr>
<tr>
<td>Deferral Requests About to Expire</td>
<td>Madrid</td>
</tr>
<tr>
<td>Vulnerability Groups by Risk Rating and State</td>
<td>Madrid</td>
</tr>
<tr>
<td>Vulnerability Groups by Risk Rating and Remediation Target Status</td>
<td>Madrid</td>
</tr>
<tr>
<td>Overdue Critical Vulnerability Groups by Assignment Group</td>
<td>Madrid</td>
</tr>
<tr>
<td>Critical Vulnerability Groups by Assignment Group</td>
<td>Madrid</td>
</tr>
<tr>
<td>Unassigned Vulnerability Groups</td>
<td>Madrid</td>
</tr>
<tr>
<td>Unassigned Vulnerable Items</td>
<td>Madrid</td>
</tr>
<tr>
<td>Vulnerability Groups by State</td>
<td>Madrid</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version introduced</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Vulnerable Items by Remediation Target Status</td>
<td>Madrid</td>
</tr>
<tr>
<td>Vulnerability Group Details</td>
<td>Madrid</td>
</tr>
<tr>
<td>Distinct Vulnerabilities</td>
<td>Orlando</td>
</tr>
<tr>
<td>Critical Deferred Vulnerable Items</td>
<td>Paris</td>
</tr>
<tr>
<td>Deferral Requests (created)</td>
<td>Paris</td>
</tr>
<tr>
<td>% of Closed Vulnerable Items that Met Target</td>
<td>Quebec</td>
</tr>
<tr>
<td>Active Vulnerable Configuration Items</td>
<td>Quebec</td>
</tr>
<tr>
<td>Active Vulnerable Items</td>
<td>Quebec</td>
</tr>
<tr>
<td>Average Age of Vulnerable Items</td>
<td>Quebec</td>
</tr>
<tr>
<td>Average Vulnerabilities per Asset</td>
<td>Quebec</td>
</tr>
<tr>
<td>Closed Vulnerable Items</td>
<td>Quebec</td>
</tr>
<tr>
<td>Closed Vulnerable Items (Target Met)</td>
<td>Quebec</td>
</tr>
<tr>
<td>Current Scan Coverage</td>
<td>Quebec</td>
</tr>
<tr>
<td>Deferred Vulnerable items</td>
<td>Quebec</td>
</tr>
<tr>
<td>Monthly Remediation Efficiency</td>
<td>Quebec</td>
</tr>
<tr>
<td>New Vulnerable Items</td>
<td>Quebec</td>
</tr>
<tr>
<td>Scannable Assets</td>
<td>Quebec</td>
</tr>
<tr>
<td>Scanned Assets</td>
<td>Quebec</td>
</tr>
<tr>
<td>Services with Most Vulnerabilities</td>
<td>Quebec</td>
</tr>
<tr>
<td>Total Duration of Closed Vulnerable Items</td>
<td>Quebec</td>
</tr>
<tr>
<td>Vulnerable Items Mean Time to Remediate</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**Workforce Optimization for Customer Service indicators**

Indicators included with Workforce Optimization for Customer Service.
<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td># of cases resolved on first contact</td>
<td>Quebec</td>
</tr>
<tr>
<td># of P1 cases resolved on first contact</td>
<td>Quebec</td>
</tr>
<tr>
<td># of P2 cases resolved on first contact</td>
<td>Quebec</td>
</tr>
<tr>
<td># of P3 cases resolved on first contact</td>
<td>Quebec</td>
</tr>
<tr>
<td># of P4 cases resolved on first contact</td>
<td>Quebec</td>
</tr>
<tr>
<td>Average handling time for chats</td>
<td>Quebec</td>
</tr>
<tr>
<td>Average wait time for chats</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSAT for chats</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSAT for cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSAT for P1 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSAT for P2 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSAT for P3 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSAT for P4 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>MTTR for cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>MTTR for P1 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>MTTR for P2 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>MTTR for P3 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>MTTR for P4 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of abandoned chats</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of chats handled</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of closed cases (weekly)</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of closed cases (daily)</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of closed chats</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of closed P1 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of closed P2 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of closed P3 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Indicator</td>
<td>Version</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Number of closed P4 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of incoming cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of resolved cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of resolved P1 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of resolved P2 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of resolved P3 cases</td>
<td>Quebec</td>
</tr>
<tr>
<td>Number of resolved P4 cases</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**Performance Analytics and Reporting for Workspace**

Integrate data visualization and reporting functionality into the workspace experience. Get notified about behavioral process changes. Explore KPIs, and get answers and insights on analytics with these Performance Analytics and Reporting Workspace integrations.

These features enable users to see pre-configured dashboard views. The features also show cases via trend line, column, comparison, proportional, and score visualizations within workspaces. Users can view and drill down into reports that show key performance indicators over time. They also see the current state of instance data, such as how many open incidents of each priority there are.

**Plugins**

- Along with plugins required for your workspace configuration, a Performance Analytics plugin activates Performance Analytics for workspaces by default in a new Rome release instance. It is not activated by default in an upgraded instance. If inactive, activate a Performance Analytics plugin.

- Your activated Performance Analytics plugin enables you to use Performance Analytics visualizations within workspaces.

- Reporting features for ServiceNow workspaces are available by default.

**Roles**

These roles are required to add, configure, or view Performance Analytics and Reporting features in Now® Experience.
### Role Permissions

<table>
<thead>
<tr>
<th>Role</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin, ui_builder_admin</td>
<td>Can add data visualization components to a Now® Experience.</td>
</tr>
<tr>
<td>sn_ui_builder.dashboard_builder_admin</td>
<td>Can use the Dashboard Builder to create, read, update, or delete any dashboard.</td>
</tr>
<tr>
<td>ui_dashboard_builder</td>
<td>Has the following permissions in Dashboard Builder:</td>
</tr>
<tr>
<td></td>
<td>• Can create dashboards.</td>
</tr>
<tr>
<td></td>
<td>• Can read, update, or delete dashboards that they created.</td>
</tr>
<tr>
<td></td>
<td>• Can read dashboards that are shared with them.</td>
</tr>
<tr>
<td></td>
<td>• Can also update dashboards that are shared with them if they were authorized by the dashboard sharer.</td>
</tr>
</tbody>
</table>

### Related information

- Workspace
- List of plugins

### Performance Analytics and Reporting visualizations

Add specific Performance Analytics and Reporting (PAR) visualizations to a Workspace landing page using one of the visualization component configurations.

#### Data visualization component configuration for UI Builder in Workspace

From the UI Builder, you can create visualizations based on aggregated table data or indicator data with the **Data Visualization** component configuration.

#### Calendar report

Add a calendar report to a workspace to show date-driven events.

See how to add the previous data visualization components to a workspace: **Data Visualization components in UI Builder.**
KPI Details visualization
The KPI Details page enables you to delve into the information behind your key performance indicators. See KPI Details.

Dashboard builder in Workspace
The Dashboard Builder enables you to create dashboards in Workspace Experiences for sharing data visualizations.

Related information
Creating custom landing pages
Share a report

Analytics Center
Add Analytics Center to any Workspace to get a single interface for analytics-related answers and insights. Access to the Analytics Center requires the relevant workspace roles.

On the Analytics Center, you can access the following features:
- A list of the Performance Analytics indicators that you are allowed to access based on your roles.
- Analytics Q&A, where you can ask questions about trends and health of your processes. (The Natural Language Query feature is required.)

To access Analytics Center, click the Analytics Center module on any Workspace.

Your KPIs
The Analytics Center includes a list of all the KPIs to which you have access.

The list of KPIs includes name, trend, score, change, and target. You can sort KPIs in ascending or descending order alphabetically or by one of the numerical columns. To filter the KPIs, click the three vertical dots and enter the filter terms in
the dialog that opens. The filter is applied to the names and the descriptions of the KPIs.

You can see any automated, formula, external, or manual indicator to which your roles grant you access. However, you do not see any benchmark indicators. Real benchmarking data is accessible only through the Compare tab on the classic Analytics Hub. You also can see only indicators that have Publish on Analytics Hub enabled on their indicator records.

Click the name of a KPI to open its KPI Details.

### Related information

- **KPI Details**
- **Performance Analytics targets**

### Analytics Q&A

You can make natural language queries related to indicators, tables, or columns from the Analytics Q&A in the Analytics Center.

Analytics Q&A supports the following languages:

- English
- French
- Spanish
- German
- Japanese

This feature is not available in sessions that use an unsupported language.


Note: Analytics Q&A is also available in the classic UI, in Report Designer. For more information, see Create a report with Analytics Q&A

Entering queries

As you type in a query, Analytics Q&A suggests recent searches, indicators, tables, and columns that match what you have typed so
far. Only the tables and columns to which you have access are shown.

**Ask a question about your data**

You can see how things are performing now and trends over time.

---

**Selecting from several likely tables**

If Analytics Q&A cannot determine which table you want, it shows you up to three likely tables. In the following screenshot, the user has asked for assets grouped by asset tag and displayed as a bar chart. However, the system cannot determine whether the user is interested in the Asset \[alm_asset\] table or the Tag \[label\] table.

---

**Help us refine your search**

Let us know if you’re looking for one of these tables. If not, you can try a different search.

- **Suggestion 1**
  Asset \[alm_asset\]

- **Suggestion 2**
  Tag \[label\]
Results
If your query is successful, Analytics Q&A shows your result as whichever of the following visualizations you specified. If you do not specify a visualization, Analytics Q&A determines which visualization is the most appropriate:

- List
- Trend
- Single score
- Bar
- Pie chart visualization

The results are subject to an ACL security check against your roles. Visualizations based on reports follow Reporting security. Visualizations based on Performance Analytics follow PA security.

The following example shows the results of a query where you specify a breakdown for grouping the results. Analytics Q&A determines that the query matches an indicator. Because indicators show trends over time, Analytics Q&A determines that a trend line is the appropriate visualization:
If you do not want to see the change in scores over time, click **Click here to see only the current data**. Analytics Q&A returns the current values on the underlying table instead of the indicator scores.
Hold your cursor over the chart to get more information about breakdowns. In a time series trend, you get the values for all the breakdowns on the selected day. In a column chart of the latest scores, you get the score of the breakdown you select. If the result is a visualization for an indicator, click on a value to open the indicator in KPI Details.

By default, you also see the following details if they apply:

- Which table you are querying
- The unit for the values
- The data aggregation method
- Which column you are grouping by
- What date field you are measuring the trend by, and at what frequency
- Which additional conditions you want to apply to your query
New queries
To make a new query or view a list of your KPIs, click **Back to Analytics Center**. Returning to the Analytics Center updates your list of the last five successful queries.

How to make a valid query
When you write a query, use special keywords to denote the type and range of information you are looking for, filters you want to apply, and other parameters. To see a full list of keywords and their uses, click **How can I improve my results?**. You can ask your Now Platform administrator to add synonyms and semantic shortcuts for keywords. For more information, see Manage Synonyms for Natural Language Query.

### Keywords guide

#### Tips to improve results
Analytics Q&A uses natural language to help you search and visualize data. Your System Administrator can add synonyms and semantic shortcuts to improve results further.

We're still working on improving this capability, which will continue to evolve with your valuable feedback. For now, Analytics Q&A only recognizes the English language.

#### Here are some keywords you can use in your phrases:

| Metrics or counts   | • total
|                    | • count
| Trends over time   | • average
| Sorting or grouping| • minimum
| Dates              | • maximum
| Type of visualization|
| Filtering          | Examples:
| Other information  | • Count of incidents assigned to me

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
significant changes. You can also aggregate changes in indicators into discrete time intervals by selecting a time aggregation. Enhance KPI Details further by configuring KPI Signals.

**Tip:** A free training for KPI Details is available from the NOW Learning Center.

**Note:** Values between 10,000 and 999,999 are rounded off to the nearest thousand and abbreviated with a K, such as 11K for 11,234. Values between 1 million and 999,999,999 are rounded off to the nearest million and abbreviated with an M. Values of 1 billion and higher are rounded off to the nearest billion and abbreviated with a G.

### View KPI Details

From a Workspace Experience, you can open KPI Details from the Analytics Center or a Performance Analytics widget. Other Now® Experience applications may contain KPI Details or a component that links to KPI Details.

#### Before you begin

Role required: None. However, upgraded instances may require pa_viewer.

#### About this task

The following actions open KPI Details:

#### Procedure

- From a Workspace Experience, click the Analytics Center icon (.sigmoid) to open the list of **Your KPIs**. Click on any indicator name to open it in KPI Details.
- If a query in Analytics Q&A returns an indicator, click on an indicator score to open the indicator in KPI Details.
- If a Workspace Experience contains a Performance Analytics widget, click in the widget to open the indicator shown in KPI Details. If this widget uses an element filter that returns more than one element, only the first element is applied in KPI Details.
- In an application built with Now® Experience Components, a component such as Indicator Overview may link to KPI Details.

#### Results

The KPI Details page on the selected indicator opens.
Exploring indicators with KPI Details

The KPI Details feature enables you to delve into the information behind your key performance indicators. Apply forecasts, trends, targets, and thresholds. Filter by breakdown element or apply time series aggregations.

KPI Details overview

The KPI Details page has three sections:

- **Header**
  The header contains the name of the indicator, the date of last data collection, and the score itself. The header for a target that is
set for a selected date also shows the target value and gap from the target for the selected date.

If real-time scores are enabled for the indicator, you can select whether to view them in the header. For more information, see Real-time scores.

**Indicator visualization**

The indicator visualization shows:

- The **Chart options** menu
- A date picker to choose the date range of the information in the visualization
- A time series graphic representation of the indicator over time
- A time series aggregation selector
- The **Show records** toggle, which shows you the records associated with the indicator score on the selected date.

⚠️ **Warning:** In some cases, when you collect second-level breakdowns, the score and the number of records do not agree. When these values do not agree, the score is correct. For more details and an example, see KB0748969.

ℹ️ **Important:** Records are not listed for the "Unmatched" breakdown element when you select it in the filter.

ℹ️ **Note:** The list view of shown records follows one of these settings, in order of priority:

  1. The value of the **Records list view** config property in the UI Builder, if set
  2. The value in the **List View** field on the indicator source, if set
  3. The Default view

**Sidebar**

Use the sidebar controls to:

- Filter by breakdown and element ✂️.

- View KPI Signals for the indicator (📈). See KPI Signals.
• Set an indicator target (➕). See Indicator targets in KPI Details.

• Set an indicator threshold (葭). See Indicator thresholds in KPI Details.

Header
At the top left of the tab, you see:

• The name of the indicator followed by an information icon (ℹ). Click the icon for the KPI’s description, frequency, and direction. KPIs based on formula indicators also show the formula in the information panel.

• The score at a selected data collection period. By default, the score is for the latest data collection period.

• The change, both absolute and percentage, between that score and the score for the previous collection period.

• A calendar for selecting the data collection period. The score for this period displays, and it is also the latest period that the visualization shows. By default, the most recent data collection period is selected.

• If real-time scores are enabled on the indicator record, you have an icon for displaying real-time scores. This icon is solid when real-time scores are displaying (🕒). It is transparent when real-time scores are off (🕒). For more information, see Real-time scores.

• If Process Optimization is enabled, you have a link to open the indicator in a Process Optimization dashboard. For more information, see Process Optimization.

Results are color-coded to show favorability. If the direction of an indicator is Maximize, increases in scores are shown in green and decreases in red. If the direction of an indicator is Minimize, increases in scores are shown in red and decreases in green. Similarly, a color bar indicates whether the target has been met or missed. The colors depend on the color scheme that has been set for the target. For more information, see Create a target color scheme.

The time period that is associated with a score is shown above the score. Controls let you move between time periods. The date you select here is
reflected in the score, change, change percentage, and time series graph. The selected time period persists when you change to another tab. The length of a time period (day, month, quarter, and so on) is the same as the frequency of the indicator.

You can also select the date by clicking along the time series chart. When you navigate to KPI Details from a widget, the date selected in the widget persists.

**Date range**

You can set the time period of scores that the KPI Details page describes. The controls for doing so are above the right side of the visualization. The time period you choose is reflected in the score, change, change percentage, and time series graph. Set the time period by adjusting the calendar:

Select either a range of dates from the calendar, or a preset relative time period from the menu on the left. Only time periods in the past are valid. Selecting a time period in the future results in an error message.

**Edit a record**

If you have activated *Show records*, you can edit one of the records without leaving KPI Details.

Depending on how the KPI Details component is configured, you can edit a listed record in one of the following ways:
• Click the Information icon ( ) next to the list entry. Doing so opens a Quick Edit pane on KPI Details. By default, KPI Details components have this function enabled.

• You may be able to edit a record by clicking on a record number.

In this case, the editable record opens in a new page or a new tab.

The two approaches are not mutually exclusive. KPI Details can be set up in UI Builder to support one or the other method, both methods, or neither method. In the last case, you cannot open a record to edit.

Compare records

You can compare indicator scores and underlying records for any two periods. List the records that have been moved out, shared, or moved in between these periods.
Click **Compare records** above the chart to open the record comparison view. Select the periods to compare either by typing in the dates or by using a calendar. Dates are in a [Jan-Dec] DD YYYY format. The period on the left must be the same or earlier than the period on the right. If you try to select a later period on the left or an earlier period on the right, both scores switch to the period you just selected.

Between the two scores, you see the number of records that have been moved out, shared, or moved in between these periods. Each of these values is a button. Select a value to list the corresponding records.

You can compare records filtered on up to two breakdowns, each with one element. You cannot compare records filtered on multiple level-1 elements.

You can compare records from a past period with real-time scores. When real-time scores are turned on, by default you compare the score from the last collected period to the real-time score.

**Important:** Record comparison is available only for automated indicators that have record collection turned on. Also, if you apply a time aggregation, you can compare only scores, not records.

**Chart options**

The KPI Details **Chart options** menu enables you to show, hide, or change aspects of an indicator visualization. Selected chart options persist per user for each indicator. Chart options are divided into analysis, time series, and chart type options.

**Analysis options**

**Note:** Targets, thresholds, trends, and comments are not supported in KPI Details when indicator scores are aggregated on multiple elements.

**Targets**

Targets are the desired scores for the indicator. Select to show indicator targets on the visualization. If no targets are configured on the indicator, this option is not available.

**Thresholds**

Thresholds define a normal range of scores for an indicator. Select to show indicator thresholds on the visualization. If no thresholds are configured on the indicator, this option is not available.

**Forecast**

Forecasts enable you to forecast future scores based on existing trends. To configure forecasts, see Performance Analytics scores.
forecasts. If forecasts are not configured on the indicator, this chart option is not available

**Trend**

Shows the linear trend in score values over the selected time period. Trends are not available for indicators that are filtered on multiple elements.

**Comments**

Select to show comments added to the indicator in the Analytics Hub or generated by system calculations. System calculations include notifications for breaching thresholds.

**Labels**

Labels show the main time series values of the indicator. Labels are not shown for derived time series lines such as targets and thresholds.

**Time series options**

The time series options set the kind of measurements that the chart displays. All measurements can be shown together.

- Score (default)
- Change
- Change %

**Chart type options**

Select from the following chart visualizations:
• Line (default)

• Spline

• Area
Select time aggregation

You can aggregate changes in indicators into discrete time intervals. A time aggregation consists of an AVG or SUM function combined with a time series, such as By quarter.

Before you begin

Role required: None. However, upgraded instances may require pa_viewer.
About this task
To explore a different time aspect of the indicator, apply one of the following time aggregations:

**Running**
Smooth out spikes to reveal trends. For example, looking at daily incident counts may show a decrease every weekend, but a 7-day running average smooths out those drops.

**Period**
Aggregate data to a less frequent period. For example, you may want to track the number of P1 incidents daily, but the frequency is too high when scores are considered daily. Instead, you can set a target at the monthly level with a "By Month" time series.

**To date**
Show cumulative scores. These time aggregations are useful when you have a monthly target to hit, but you also need to see the velocity throughout the month.

For more information about the use, behavior, and limitations of time aggregations, see *Applying time series aggregations*.

**Procedure**
1. In KPI Details, expand the time aggregation menu on the indicator visualization.

![Chart Options](image)

<table>
<thead>
<tr>
<th>Chart Options</th>
<th>Dec 02 2020</th>
<th>Jan 24 2021</th>
</tr>
</thead>
</table>

**Note:** Time aggregations are not available for real-time scores. When you select a time aggregation, real-time scores are disabled. If you return to the default frequency, real-time scores are re-enabled but turned off. You can turn them on if you want.

2. Select either a **Running**, a **Period**, or a **To date** aggregation to configure.

3. Select a time period.
   - Invalid and excluded time periods for the indicator frequency are not enabled. For more information about excluded time periods, see *Exclude time series from an indicator*.

4. Select either the average or the sum function.
5. If you have selected a **Period** aggregation, decide whether to **Include partial periods**.
   If you include partial periods, you show a score for the current period even when it has not yet completed. Use caution because including partial periods can skew averages.

**Results**
The indicator visualization refreshes with each selection you make. Change your selection as much as you want. To return to the default time aggregation for the indicator, select **Reset**.

**Example: Time aggregation on an daily indicator**
In the following time aggregation menu, the daily indicator Number of open incidents is aggregated by period to a weekly sum. Partial weeks are not included.
Filter by breakdown elements

In KPI Details, you apply breakdowns and elements to the indicator in the Filters sidebar.

Before you begin
Role required: None. However, upgraded instances may require pa_viewer.

About this task
You can select up to two breakdowns. You can select multiple elements on the first breakdown but only one element on a second breakdown.
Procedure

1. In the sidebar of KPI Details, select the Filter icon.

You see a list of the breakdowns for this indicator.

2. Expand a breakdown.

You see a list of the elements of the breakdown.

3. If an elements filter exists for the breakdown, you can use it to refine the list of elements.

   a. Expand the **Refine by** list to see the available element filters.

   **Example**
   
   This image shows the "Groups I manage" and "One of my groups" elements filters, which are available for the Assignment Group breakdown in the base system.

   ![Assignment Group](image)

   b. Select an elements filter.
Example
In this image, the "One of my groups" is selected. The list of elements now includes only the assignment groups to which the logged-on user belongs.

- Assignment Group
  - Refine by
    - One of my groups
  - Sort by
    - Score

  - Hardware
    - 7 ▼-2 (-22.22%)

  - CAB Approval
    - 7 ▲1 (16.67%)

  - Database
    - 6 ▼-2 (-25.00%)

4. In the Sort by menu, sort the elements by name, by the score for the selected date, or by the change from the previous date. If real-time scores are turned on, only sorting by name is available.

5. Select one or more elements.
   If the elements are sorted by score, the filter panel shows you the score for each breakdown element for the selected date. If the elements are sorted by change, the filter panel shows you the percent change since the previous collection period for the selected date. When real-time scores are turned on, no previews are available.

6. Optional: Select a second-level breakdown.
   a. Expand a second breakdown.
   b. Select only one element.

7. If you have selected multiple elements, select how to display the elements.
   By default, the aggregate score is displayed. Select Display as separate time series to show each element separately. You can make a selection only in cases where both aggregate and separate score displays are possible. For more information, see Aggregate score of multiple elements.

8. Click Apply

Example: Selecting elements to filter by
In this example, the filter sidebar has been opened. You expand the Priority breakdown and select the 1 - Critical, 2 - High, and 3 - Moderate elements. You
are about to click **Apply**. You will see the values of these elements as a single aggregate, because you did not select **Display as separate time series**.

### Aggregate score of multiple elements

When you filter an indicator by multiple breakdown elements, you can either view a single aggregate score of all elements or a separate score for each element. However, not all indicators support an aggregate score of multiple elements.

The following indicators support an aggregate score of multiple elements:

- Automated indicators that aggregate data as a Count, Sum, Minimum, or Maximum value

⚠️ **Note:** The word "aggregate" is used for two different things here: the aggregate view of multiple indicator scores, and the data aggregation that is set on an indicator.
• Manual indicators

• External indicators that do not use SQL AVG() or SQL COUNT(DISTINCT...) in their SQL statement

• Formula indicators that have aggregate element views enabled on their indicator records. For more information, see the entry on the Allow aggregation of multiple breakdown element scores field on the Other tab in Create a formula indicator.

⚠️ Note: When you navigate to KPI Details from a Performance Analytics widget on a Workspace Experience, and this widget uses an element filter that returns more than one element, only the first element is applied.

If the indicator supports a view of multiple elements, KPI Details shows the Display as separate time series control in the Filters sidebar. The behavior of this control depends on which views of multiple elements are supported:

• If an indicator supports both aggregate and separate views, you see the aggregate view by default. To show a separate line for each element of a breakdown, select Display as separate time series.

• If an indicator supports only the view of multiple elements as separate lines, Display as separate time series is selected and the choice is disabled.

⚠️ Note: The Display as separate time series control is not enabled until you select multiple elements.

Example: Aggregate compared to separate view of multiple elements

In this example, the Number of open incidents indicator aggregates by Count and therefore supports an aggregate view of multiple elements. Both aggregate and separate views are shown.
The following formula indicator does not have aggregate views of multiple elements enabled. The **Display as separate time series** option is selected automatically and you cannot change it.
Filter sidebar of indicator that does not support aggregate view

Related information

Performance Analytics breakdowns

Indicator targets in KPI Details

Targets are goals your organization wants to achieve. They show the difference between the desired and actual scores of an indicator on a certain date.

A target can be personal or global. A personal target is visible only to the user that created it and appears as a light line. A global target is visible to all users and appears as a dark line. Because you cannot share a personal target, it appears only in KPI Details. Global targets appear on both the KPI Details and time series widgets.

Create a target in KPI Details

You can set target values for indicators. You can have the targets apply only to specific breakdown elements and time series aggregations. The target starts to apply at a selected date and continues to apply until you set the next target. However, you can set a review date on which to reconsider the target.

Before you begin

Role required: pa_target_admin to create global targets that are visible to all users. Any user who can view an indicator on KPI Details can view targets and create personal targets. Personal targets and thresholds are visible on KPI Details only to the user that created them.
Procedure

1. Navigate to the workspace with the indicator you want to work with.

2. Click the Analytics Center icon ( ) to open the list of Your KPIs.

3. Click an indicator in this list to view its KPI Details page.

4. To limit the target to a subset of the scores, select a breakdown and a breakdown element.
   You can also select a 2nd-level breakdown and element.

   Note: To add targets for multiple breakdown elements, see Add targets for multiple breakdown elements.

5. If you want the target to apply to a specific time series aggregation, select the time series.
   For more information about time series aggregations, see Applying time series aggregations.

6. Click the target icon ( ).

7. Select either Global or Personal targets.
   You see all the existing Global or Personal targets on this indicator that apply to whichever breakdown elements or time series you selected. You can select and deselect breakdown elements or a time series interactively, and the list of targets updates.

   Note: Instead of creating a new target, you can edit one of these existing targets. Select the tile for a target to edit that target. You can only change the absolute value of the target and the start and review dates. For more sophisticated target editing, see Edit targets in KPI Details.

8. Click the Create Target icon ( ).

9. Enter the target value for the score. Either:
   • Enter an absolute value in Target.
   • Select Set target as an improvement of the baseline. If you select this option, the following fields become available:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Calculation</td>
<td>Select either a percentage improvement or specify the number of units of the KPI to improve by.</td>
</tr>
</tbody>
</table>
| Direction             | When the indicator has a defined direction, this field is read-only. If the indicator direction changes, this field changes with targets recalculated accordingly.  
                        | If the indicator does not have a direction, you can set a direction on the target here. However, usually it is better to define a direction on the indicator. For example, a color that shows improvement or deterioration works only when you specify the indicator direction. |
| Percentage/Units of the KPI | Enter either the percentage or the number of units of the KPI that you want as the targeted change to the baseline.                     |
| Baseline              | Decide whether to base the new target on the existing target or on the average value for the date range selected in the KPI Details timeline. Another target must already exist to select Existing Target. |
| Baseline value        | Read-only calculated value that serves as the basis for the target.                                                                        |
| Target                | This value is calculated from the baseline and the target calculation. You can adjust this value, for example, to change a decimal value to a whole number for a count. If you adjust the target, the Percentage/Units of the KPI are recalculated. |
10. Select a start date.
   You can set a date in the future.

11. Select a review date.
   The target applies from the selected start date until the start date of the next target, if any. If you do not define a later target, the target applies indefinitely. Thus, the review date serves as a reminder to consider changing the target. Whether you change the target value after review, consider selecting a new, future review date.

   Note: KPI Details does not support overlapping targets. Only one target at a time can be active.

12. Click Save.

Example: Creating and reviewing a target

It's January 1 and your Number of Open Incidents varied regularly from late November, with a gradual downward trend. Then it started going up and down wildly, but the overall trend is still downward.

As an incident manager, you want the number of open incidents to go down. You are not sure from your scores on a good target to set. However, the numbers look reliable up to mid-June, so a 10% decrease in the average score up to that point seems reasonable. So you create a new global target for your team. You select a date range up to June 15, and you set a 10% decrease on the average for that period as your target. You decide to start the target today and evaluate it on July 15.

Field settings of first target

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set target as an improvement of the baseline</td>
<td>Selected</td>
</tr>
<tr>
<td>Target Calculation</td>
<td>Percentage (%)</td>
</tr>
<tr>
<td>Percentage</td>
<td>10</td>
</tr>
<tr>
<td>Baseline</td>
<td>Average score for the selected date range (only choice, because no older target was set)</td>
</tr>
<tr>
<td>Target</td>
<td>Originally calculated as 202.5. Since the incident count can only be a whole number, you decide to round off this value to 203.</td>
</tr>
</tbody>
</table>
July 15 comes around, and your team has exceeded all expectations—or your customers are all on holiday and not reporting incidents. In any case, the number of open incidents is far below your target.

You have several options:

- Create another target. The old target ceases to apply on the date the new target starts. The new target could again be an improvement of the baseline. You have the option of setting the old target as the baseline for the new target.
- Edit the existing target. Set a new target value and a new review date, for example 160 and August 15. For more information, see Edit targets in KPI Details.

Edit targets in KPI Details

Retroactively change one or more existing targets from their start date instead of ending them and starting new targets from a later date. You can edit multiple targets to have the same value, the same change in value, or the same date.

Before you begin

Required role: pa_admin, pa_target_admin, pa_power_user, or admin

About this task

If you have multiple targets set on the same indicator, the Target Configuration panel in KPI Details lets you set them in bulk to have the same start date, review date, or value. As a manager, you can use this feature to modify targets for a set of segments.

You can change only identical target values to new values. You can change differing start and review dates to new, identical start or review dates. However, none of the new periods when the targets would apply can overlap the periods of other targets that match the same filters.

Note: An alternative interface is available for a quick edit of a single target. Open the Targets panel and select the tile for a target. You can change the absolute value and the Start and Review dates of the target. For more options in editing a target, or to edit multiple targets, use the following procedure instead.
Procedure

1. Open KPI Details for an indicator.

2. Click the target icon. The Targets panel opens.

3. Click the cogwheel to open the Targets Configuration page.

   ![Targets Configuration](image)

   The Targets configuration view opens.

4. Click Filter to set whether you see targets that have expired, targets that are currently in effect, or targets that will come into effect in the future. By default, you see targets that are currently in effect and those that will come into effect.

   ![Filters](image)

5. To further filter the selection of targets, select the hidden filter icon on the right side of each column header. You can filter or sort by item name, value, start date, or review date. In the following example, the Item column is about to be filtered for names containing priority. Only targets on the Priority breakdown will show.

   Tip: You can filter on item name for either breakdowns or time aggregations. For example, filtering on 7d returns only targets on weekly time aggregations.
6. Select one or more targets.

7. Set new target values, either as an absolute value or as a change to a baseline.
   
   - To set an absolute value for the targets instead of a change to a baseline, select **None** in **Target calculation** and an absolute value in the **Value** field.
   
   - To select a change from the current targets, select the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target calculation</td>
<td>Current target (units) or Current target (%)</td>
</tr>
<tr>
<td>Direction</td>
<td>Select <strong>Increase</strong> for the new target value to be higher than the current target or <strong>Decrease</strong> for the new</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>value to be lower than the current target.</td>
</tr>
<tr>
<td>Change (units) or Change (%)</td>
<td>The value either added or subtracted to the current targets to calculate the new targets, depending on the setting in <strong>Direction</strong>. The value you enter is either an absolute value (units) or a percentage. For example, you have selected two targets with values of 20 and 5. You have also selected Current target (units) as the target calculation and Decrease as the direction. When you enter 2 in Change (units), the new target values are 18 and 3. If you instead select Current target (%) as the target calculation and enter 25 under Change (%), the new target values are 15 and 4.</td>
</tr>
<tr>
<td></td>
<td>• To select a change from the average score over a period of time, select the following:</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>Target calculation</td>
<td>Average score (units) or Average score (%)</td>
</tr>
<tr>
<td>First score</td>
<td>The opening date of the time period over which to calculate the average score</td>
</tr>
<tr>
<td>Last score</td>
<td>The closing date of the time period over which to calculate the average score</td>
</tr>
<tr>
<td>Direction</td>
<td>Select <strong>Increase</strong> for the target to be higher than the average score or <strong>Decrease</strong> for the target to be lower than the average score.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change (units) or Change (%)</td>
<td>The value either added or subtracted to the average score to calculate the new targets, depending on the setting in Direction. The value you enter is either an absolute value (units) or a percentage.</td>
</tr>
</tbody>
</table>

8. Select the start date, when the targets come into effect, and a review date.

**Add targets for multiple breakdown elements**

Select multiple breakdown elements in the KPI Details target configuration panel. Add a target to each element. This target can be an improvement on a baseline instead of an absolute value.

**Before you begin**

Required role: pa_admin, pa_target_admin, pa_power_user, or admin

**About this task**

**Procedure**

1. Open KPI Details for an indicator.

2. Click the target icon (⊕).

   The Targets panel opens.

3. Click the cogwheel to open the Targets Configuration page.

   The Targets configuration view opens.

4. Select Add targets to breakdowns.
The Add targets to breakdown elements dialog opens.

5. Select one breakdown from the list of breakdowns for the indicator.
6. Select any number of elements for the breakdown and click Next.

🤔 Tip: If you have many elements to scroll through, sort or filter on a value in any of the columns. You can also click Filter and use the condition builder to narrow down the selection.

7. Set targets for the elements as described in Step 7 in Edit targets in KPI Details.
8. Set a start date, when the targets come into effect, and a review date.

Example: Configuring targets for multiple elements

Starting February 11, your company began tracking open incidents for each assignment group. By the end of the month, the number of open incidents assigned to your top 4 groups had varied from 18 to 60. The trends also were highly variable.
You would like consistent improvement across these four groups. Therefore, you want to set them targets that are equivalent despite the differences in absolute values. You also want to set the targets together. To achieve this aim, you open the Targets configuration view and click **Add targets to breakdowns**.

You select the Assignment group breakdown.
You get a list of the elements of the Assignment Group breakdown. There are many elements. The four elements you are looking for all have “Support” in the name, so you filter the Name column on “Support.”
The filter reduces the number of elements to browse to 9, from which you easily select the 4 that you want and click Next.

You can either specify a target value or base it on a calculation. The difference between HR Systems Support and the other three elements is too much to give all four elements the same target value. Therefore, you base the target on a calculation applied to each element.

Calculations can be made on the existing target or on an average score over a time period. There are no existing targets for these elements, so you must select an average score.

You can set the target either as a unit number improvement on the average score, such as 3 or 4.5, or as a percentage improvement. The scores are close enough that you could probably use a unit number. However, you decide to set the target as a percentage improvement on the average score.
You take the average score from February 11 until February 28. You think 5% is a good improvement target for the next month, so you set the targets to begin March 1 and to review them March 31.
Here is a table showing the values you filled in on the Targets Configuration panel:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target calculation</td>
<td>Average score (%)</td>
</tr>
<tr>
<td>First score [for calculating average score]</td>
<td>2021-02-11</td>
</tr>
<tr>
<td>Last score [for calculating average score]</td>
<td>2021-02-28</td>
</tr>
<tr>
<td>Direction</td>
<td>Decrease</td>
</tr>
<tr>
<td>Change (%)</td>
<td>5</td>
</tr>
<tr>
<td>Start date [when target takes effect]</td>
<td>2021-03-01</td>
</tr>
<tr>
<td>Review date</td>
<td>2021-03-31</td>
</tr>
</tbody>
</table>
After you click **Add** and dismiss the success message, you see the four targets that you created.

<table>
<thead>
<tr>
<th>Target Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>Number of open incidents</td>
</tr>
<tr>
<td>Assignment Group: HR Systems Support</td>
</tr>
<tr>
<td>Assignment Group: Oracle Support</td>
</tr>
<tr>
<td>Assignment Group: Technical Services Support</td>
</tr>
<tr>
<td>Assignment Group: Financial Systems Support</td>
</tr>
</tbody>
</table>

Here is a table with the targets you created and their values. All targets take effect on 1 March and are scheduled for review on 31 March.

**Indicator thresholds in KPI Details**

Thresholds define a normal range of scores for an indicator and alert you when certain events occurs, such as when a score reaches an all-time high or low. In a Workspace Experience, set and view thresholds in KPI Details.

When a threshold is triggered, the instance generates an email notification. This message is associated with the indicator and the message is directly available via KPI Details.
A threshold can be personal or global. A personal threshold is visible only to the user that created it. It appears as a light grey dotted line. A global threshold is visible to all users and appears as a dark grey dotted line. Personal thresholds appear only on the KPI Details page. If the widget is configured to show global thresholds, they also appear on time series widgets.

**Add, modify, or delete a KPI Details threshold in Workspace**

Add, modify, or delete global targets and thresholds as well as personal targets and thresholds for all users in Workspace.

**Before you begin**
Role required: pa_admin

**About this task**
Any user who can view an indicator on KPI Details is able to view thresholds and create personal thresholds. Personal targets and thresholds are visible on KPI Details only to the user that created them. Users with the pa_admin role also able to create personal targets and thresholds for other users. They can also modify and delete existing targets and thresholds that other users have created.

**Note:** If more than one breakdown element from the same breakdown is applied, the threshold toggle button is turned off. The message, "Thresholds are not available when multiple breakdown elements are selected" appears.

**Procedure**

1. Navigate to the workspace with the indicator you want to work with.

2. Click the Analytics Center icon ( ) to open the list of **Your KPIs**. Use Analytics Q&A to enter a question about your data or click an indicator in this list to view its KPI Details page.

3. Click the threshold icon ( ).

4. Select either Global or Personal thresholds.
   You see all the existing Global or Personal thresholds on this indicator.

5. Click the Create Threshold icon ( ) or select an existing target to edit it.

6. Choose the visibility of the threshold, either **Global** or **Personal**.

7. Select or change the **Threshold Type**:
• All time high
• All time low
• Less than
  Enter a threshold value to trigger a message if the value of the indicator drops below the threshold.
• More than
  Enter a threshold value to trigger a message if the value of the indicator exceeds the threshold.

8. Click **Save** if you are creating a threshold or **Update** if you are modifying a threshold.

**Configure a widget for KPI Details**

To open the KPI Details page from a Performance Analytics widget, you must configure the widget.

**Before you begin**

Role required: pa_admin
By default, when you click a Performance Analytics widget in a workspace, its KPI Details page opens.

⚠️ **Note:** Performance Analytics widgets are available only in Workspace Experiences, not from the User Interface (UI) Builder.

**Procedure**

1. Navigate to **NOW Experience Framework > Experiences** and locate the Workspace with the indicators you want to investigate.

2. Select the entry in the Admin panel column for the workspace.

   ![Workspace Search](image)

   The Workspace record opens.

3. If you are in the wrong application scope, click the **here** link.
4. Click **Open in UI Builder**.

5. Select the landing page you want to configure.

6. **Optional:** Click the Open Toolbox icon ( ) and add a data visualization to the selected page. For more information, see Add a component to UI Builder.

7. Select the widget to configure.
8. In the Configuration sidebar, toggle **Disable KPI Details on click** off to enable users to go to the KPI Details page for the indicator.
Configuration

PA Widget

Search for a PA Widget

Background refresh interval (minutes)

2

Size Variant

Auto

is_realtime

Optional Widget Label

Incident SLA Breached

Single score live updates

Live refresh rate (seconds)

0

Disable KPI Details on click

Follow unified filters
KPI Details Performance Analytics properties

KPI Details supports several Performance Analytics properties. These system properties control the behavior of Performance Analytics elements in the context of KPI Details.

To configure properties, navigate to Performance Analytics > System > Properties or to sys_properties.list.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.indicator_target_default_color_schema</td>
<td>Default indicator target color scheme</td>
</tr>
<tr>
<td>com.snc.pa.chart_default_color_schema</td>
<td>Default visualization color scheme</td>
</tr>
<tr>
<td>com.snc.pa.scorecards.max_breakdown_elements</td>
<td>Maximum number of breakdown elements in KPI Details lists.</td>
</tr>
<tr>
<td>com.snc.pa.target_batch_operation_limit</td>
<td>Maximum number of targets that can be inserted or updated in one bulk action on the KPI Details Targets Configuration page. If you face timeouts while inserting or updating targets in bulk, consider reducing this limit. Default: 100</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_line_color</td>
<td>Color of the scores in a KPI Details page and widgets, including the trend line and bullet chart.</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_target_color</td>
<td>Color of the target in a chart.</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_personal_target_color</td>
<td>The line color for personal targets displayed on KPI Details pages.</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_threshold_color</td>
<td>Color of the threshold in a chart.</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_personal_threshold_color</td>
<td>The line color for personal thresholds displayed on a KPI Details page.</td>
</tr>
</tbody>
</table>

KPI Details UUIDs

Every combination of breakdowns, elements, a time series aggregation, and a domain that you specify for an indicator has a unique identifier (UUID). To understand how the KPI Details and KPI Signals applications work, you should understand how these UUIDs are constructed.
In the Analytics Hub and the workspace KPI Details, you select an indicator and can specify it further by the following:

- Up to two levels of breakdown
- Element filter
- Up to two levels of breakdown element, including multiple elements per level (aggregate score)
- A time series aggregation
- Domain separation

Each combination is represented by a so-called UUID. The UUID is concatenated from the sys_IDs of the indicator and any of these specifiers, in the following order (note the semicolon before the domain id):

```
<indicator_sys_id>:<breakdown_sys_id>:<elements_filter_sys_id or element_sys_ids>:<lvl-2 breakdown_sys_id>:<lvl-2 elements_filter_sys_id or element_sys_ids>:<aggregate_sys_id>;<domain_sys_id>
```

All specifiers other than `indicator_sys_id` are optional, with one exception: If a `breakdown_sys_id` is specified, so must be at least one `element_sys_id`. To specify a breakdown and not specify elements, for example to get a list of all elements, the breakdown sys_id goes in a separate parameter. For an example, see this GET/now/pa/scorecards REST API example. To refer to those scores that do not match any elements of the specified breakdown, the string `unmatched` goes in place of an `element_sys_id`.

Targets, thresholds, and other Analytics Hub and KPI Details functions apply per UUID. In other words, they apply separately to each unique combination of indicator, breakdowns, elements and element filters, time series aggregation, and domain. The KPI Signals application also monitors each fully specified indicator separately, per UUID.

**KPI Signals**

KPI Signals notifies you when the behavior of a process changes significantly, and how that change affects you. This feature applies standard statistical Process Behavior Charts to Performance Analytics indicators.

**Tip:** A free training for KPI Signals is available from the NOW Learning Center.

Every process undergoes variation. Most of this variation is normal, or 'common cause' variation, such as the small differences between each time you sign your name. What you need to know about is abnormal, or 'special cause' variation, such as when you sign with your off hand. KPI Signals lets you know
when abnormal variation is occurring. KPI Signals incorporates Process Behavior Charts. These charts use standard statistical methods to pick out the signal of special cause variation from the noise of common cause variation.

KPI Signals uses standard 3-sigma parameters. "Three-sigma" means that the indicator scores for the process are expected almost always to remain within three standard deviations of the norm. The charts require at least five consecutive scores to calculate parameters.

Disabling KPI Signals
KPI Signals is activated by default. If you do not want this feature, request a Now Platform administrator to set the property `com.snc.pa.activate_kpi_signals` to `false`. Because this property does not exist by default, the administrator must add it. You can refer them to Add a system property.

> **Important:** If you reactivate KPI Signals, signal detection resumes from the time you originally deactivated the feature, not from the time you reactivated it.

Signal, no signal, and anti-signal
When KPI Signals detects abnormal variation in the scores of a KPI, it generates a signal. When KPI Signals does not detect abnormal variation for a significant amount of time, it generates an "anti-signal." The anti-signal lets you know that your workflow is under control.

Both the presence and absence of signals conveys information:

- The presence of signals lets you know that a workflow has changed, or at least is not statistically stable.
- The long-term absence of signals indicates that a workflow is statistically stable. With this information you can decide to launch a process improvement initiative, for example.

Signals
The KPI Signals application considers the following behaviors to 'signal' special cause variation:

- **Outlier**
  Every score beyond a three standard deviation (3-sigma) upper or lower limit.

- **Short run**
  Four consecutive scores on the same side of the central line, with three of the scores close to the upper or lower limit. "Close to the limit" is defined as outside two standard deviations.
**Long run**

Seven consecutive scores on the same side of the central line. That is, seven scores in a row all greater than or all less than the average value.

ℹ️ **Note:** The KPI Signals app counts dismissed outliers when calculating whether a short or long run has occurred.

In the following example, you see a "Long run" signal: seven consecutive scores above or below the central line.

ℹ️ **Note:** The KPI Signals application can detect signals for an indicator with no more than one first-level breakdown element. The application does not support multiple breakdown elements or a second-level breakdown.

**Anti-signals**

The application issues an anti-signal when it has not detected a signal for a length of time equal to the following formula:

\[
\text{Length of time to calculate the baseline for the KPI} \times \text{Anti-signal factor}
\]

The application takes 14 days by default to calculate the baseline for a daily indicator. The default anti-signal factor is two. Thus, the default length of time to detect an anti-signal on a daily indicator is 28 days. For more information
about setting the time to calculate a baseline, see **Configure signal detection.**
For more information about setting the anti-signal factor, see **Configure signal notifications.**

In this example, the default configuration values apply to a daily indicator. The application has not detected a signal for 28 days, so it shows a 28-day anti-signal.

Although responsible users are notified when an anti-signal is generated, no action is required.

**No signal**

Usually no signal is detected for a shorter amount of time than it takes to detect an anti-signal. In this case, the application shows a simple "No signal" message. No notifications are sent and no action is necessary.

In the following example, no signal is detected for five days after the baseline was most recently reset. The baseline has been reset three times in the period being shown.
View KPI Signals

Access KPI Signals from the KPI Details page on a Workspace.

Before you begin
Role required to view signals: Any roles necessary to access the workspace. The access control lists (ACLs) for indicators and breakdowns are also respected.

Procedure
1. Open KPI Details for an indicator as described in View KPI Details.

2. Optional: Open the Filters ( 🔍 ) panel and select one breakdown and one element.
   KPI Signals can monitor each first-level breakdown and element applied to an indicator. It cannot monitor second-level breakdowns.

   Note: In the context of KPI Signals, the term KPI refers to an indicator with optionally a first-level breakdown and element.
3. Click the Open KPI Signals icon on the right. (The KPI Signals panel opens.)

4. If KPI Signals monitoring is not active for this KPI, you can follow the instructions in Activate KPI Signals monitoring for a KPI.
   If you do not have a role that allows you to activate KPI Signals monitoring for a KPI, contact an administrator instead.

**Example: KPI Signals with a breakdown element**

In the following example, you see the KPI Signals panel for the Number of open incidents indicator. This indicator is filtered on the Priority: 1 - Critical breakdown element. No signals have been detected.
Activate KPI Signals monitoring for a KPI

KPI Signals does not monitor KPIs by default. You activate monitoring for individual KPIs. When you activate KPI Signals for a KPI, you make yourself a responsible user for that KPI.

Before you begin
Role required: pa_kpi_signals_admin, pa_admin, or admin

Procedure
1. Open KPI Signals for an indicator, as described in View KPI Signals.
2. If KPI Signals monitoring for the KPI has not been activated, click Make me responsible in the KPI Signals panel.

KPI Signals cannot be active for a KPI unless there is at least one responsible user. Therefore, when you activate monitoring, you automatically make yourself a responsible user. You can then reassign responsibility. For more information, see Configure responsibility for KPI Signals.

3. Select a start date from which to evaluate the KPI for signals.
   By default, signals are calculated starting three months before you activate KPI Signals for the KPI. If meaningful data for calculating a baseline begins earlier or later than this date, change the date.
4. Set the number of KPI scores that are used to calculate the baseline. The default number of scores for calculating the baseline depends on the indicator frequency for the KPI. Do not change this number unless you are confident you have good reasons. The minimum number is five.

5. Click **Confirm**.

**What to do next**

After you activate KPI Signals monitoring for a KPI, you can:

- Deactivate monitoring on the KPI
- Reactivate monitoring if it was deactivated
- Reconfigure the number of points for calculating the baseline
- Change the start date for calculating the baseline
- Change the type of trend calculation for the baseline
For more information, see Configure signal detection.

**Configure signal detection**

You can set the start date of the current baseline calculation, the number of scores used to calculate the baseline, and the trend method. You also can deactivate or reactivate KPI Signals monitoring for a KPI.

**Before you begin**

Role required: admin, or must be a responsible user

**Procedure**

1. Open KPI Signals for a KPI.
2. Click the cogwheel to open the Configuration options.
3. Open the Signal Detection tab.
   
   In this image, you see the Number of open incidents indicator with no breakdowns, and the same indicator with the Priority = 1-Critical breakdown and element. The KPI with the Priority = 1-Critical breakdown has been deactivated. Only KPIs that had been activated at some point appear in this list.

   **KPI Signals Configuration**

<table>
<thead>
<tr>
<th>Item</th>
<th>Active</th>
<th>Baseline start</th>
<th>Required scores</th>
<th>Trend method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of open incidents</td>
<td>true</td>
<td>2020-09-04</td>
<td>14</td>
<td>Linear</td>
</tr>
<tr>
<td>Priority &gt; 1 - Critical</td>
<td>false</td>
<td>2020-07-30</td>
<td>14</td>
<td>Linear</td>
</tr>
</tbody>
</table>

4. Select the KPIs that you want to edit.
5. Fill in the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active (check box)</td>
<td>Deselect to deactivate KPI Signals monitoring of the KPI. The KPI remains in the list afterwards. Select <strong>Active</strong> later to reactivate monitoring on the KPI. If you reactivate monitoring on a KPI, it begins from the date you deactivated monitoring, not the date you reactivated it.</td>
</tr>
<tr>
<td>Baseline start</td>
<td>The beginning date of the data points used to calculate the baseline. This date is based on the most recent resolved signal. If there never was a resolved signal, the date was set when monitoring on the KPI was first activated.</td>
</tr>
<tr>
<td>Number of scores for baseline calculation</td>
<td>The number of scores, or data points, that the application uses to calculate the baseline. The default number of scores for calculating the baseline depends on the indicator frequency for the KPI. Do not change this number unless you are confident you have good reasons. The minimum number is five.</td>
</tr>
</tbody>
</table>
| Trend method                               | The statistical method for calculating the baseline. Options are:  
  - Linear trend, calculated by linear regression  
  - No trend, just the average score                                                           |

6. Click **Save**.

**Example: Linear trend versus no trend**

In the following example, the initial linear trend kept resulting in signals despite the average remaining stable. Following the signal in early September, signal detection was changed to "no trend." Following
this change, the average remained stable and no further signals were detected.

**Configure responsibility for KPI Signals**

Besides security access, a user needs a level of responsibility to act on a signal. Responsibility is granted for individual indicator/breakdown element combinations that the KPI Signals application monitors.

A KPI can have multiple responsible users.

Users with the admin, pa_admin, or pa_kpi_signal_admin role can reset a baseline or dismiss a signal without explicitly being a responsible user. Users with other roles must become responsible users to take such actions. These users also need a role that gives them access to a relevant workspace.

Responsible users get email notifications about the following:

- New signals
- Unresolved signals
- Actions to resolve signals
- "Anti-signals," which indicate that a KPI is long-term stable

Even responsible users without workspace access get these email notifications.
Related information

Configure signal notifications

Assign responsibility for signals
You can assign responsibility for KPI Signals for a KPI to yourself or someone else. You can also unassign responsibility.

Before you begin
Role required: Any role if a responsible user, or pa_admin or admin

Procedure
1. Open KPI Signals for an indicator, as described in View KPI Signals.

2. Click the cogwheel to open the KPI Signals configuration.

3. In the KPI Signal Configuration screen, open the Responsibility tab.

4. Select the KPI that you want to assign responsibility for.

KPI Signals Configuration

The user needs relevant workspace roles to view or act on signals. However, a responsible user without these roles still gets email notifications about unresolved signals or actions on signals.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
5. In the Editing configuration items panel, open a list of users and select whom to assign responsibility to.
6. To unassign responsibility, click the x next to a user's name.
7. Click Save.

Configure signal notifications

As a responsible user, you receive email reminders about signals that have not been resolved. You can configure how frequently you get these reminders and the maximum number of reminders to get for a signal.

Before you begin
Role required: admin, or must be a responsible user

About this task
As a responsible user, you receive email notifications in the following circumstances:

- A new signal is detected on a KPI that you are responsible for.
- No signal has been detected on a KPI long enough for it to be considered long-term stable (an "anti-signal").
- A signal for a KPI you are responsible for is resolved (baseline reset or dismissal).
- A signal for a KPI you are responsible for has not been resolved, according to subsequent signal collection jobs.

In this last case, you can set how frequently a KPI is checked for resolution. You can also set the maximum number of reminders you get.

Procedure
1. Open KPI Signals for a KPI.
2. Click the cogwheel to open the Configuration options.
3. Open the Notifications tab. You see a list of all the KPIs that you are responsible for on this indicator. KPI refers to the combination of the indicator with 0-1 breakdown and element pair.

4. Select the KPIs that you want to edit.
   If you select one KPI, its settings appear in the Editing configuration items panel. If you select more than one KPI, only the values that are the same for all these KPIs appear in the panel. When you enter the new values in that panel, they apply to all selected KPIs.

5. Set the interval between getting reminders about unresolved signals.
6. Set the count of the maximum number of reminders you want to receive about an unresolved signal.

7. Set the anti-signal factor.
   This factor helps determine when a KPI is stable enough to generate an "anti-signal," according to the following formula:
   \[
   \text{Length of time to calculate the baseline for the KPI} \times \text{Anti-signal factor}
   \]
   The default anti-signal factor is two. Set this factor if you decide it needs to be changed. For more information, see Signal, no signal, and anti-signal.

8. Click Save.

**Configure signals for breakdown elements**

Configure signal detection and assign responsibility for multiple breakdowns and breakdown elements on one indicator.

**Before you begin**
An administrator must activate KPI Signals for the indicator. For more information, see Activate KPI Signals monitoring for a KPI.

Role required: responsible user for the indicator or admin

**About this task**
For example, KPI Signals could simultaneously monitor the following indicators and breakdowns:

- Number of open incidents (no breakdown)
- Number of open incidents, Priority = 1-Critical
- Number of open incidents, Priority = 2-High
- Number of open incidents, Category = Software

However, KPI Signals could not monitor "Number of open incidents, Priority = 1-Critical, Category = Software."

**Procedure**
1. Open KPI Signals for the indicator, without first selecting a filtering breakdown in KPI Details.
2. Click the cogwheel to open the Configuration options.
3. Click **Add breakdowns**.
   The **Add Breakdowns** dialog opens.

4. Click in the Breakdowns field and select a breakdown.
   A list of elements for the breakdown appears.

5. **Optional:** Click **Filter** and use the condition builder to build a filter for the elements.

6. Select at least one element and click **Add**
7. To monitor signals on elements of another breakdown, click **Add breakdowns** again and repeat the steps.

8. In the Signal Detection tab, activate monitoring for the KPIs and set the baseline start and number of scores required to calculate the baseline. For more information about the settings on the Signal Detection tab, see **Configure signal detection**.

9. Open the Responsibility tab and assign a responsible user to each KPI. For more information about responsible users and the settings on the Responsibility tab, see **Configure responsibility for KPI Signals**.

10. Open the Notifications tab and set how often the responsible user should get an email notification for an unresolved signal. You can also set the total number of reminders the responsible user gets for an unresolved signal. Also set the anti-signal factor, which is used to calculate how many scores without a signal result in an anti-signal. For more information about anti-signals, see **Signal, no signal, and anti-signal**. For more information about the settings on the Notifications tab, see **Configure signal notifications**.

**Reset baseline or dismiss signal**

When you get a signal that abnormal variation has occurred, either dismiss the signal or recalculate the parameters. Investigate the reason for the variation before making your decision. If you determine that the signal represents a "new normal," recalculate the baseline. If you determine that the signal is the result of a temporary circumstance, dismiss the signal.

**Before you begin**

Role required: You must have access to KPI Details, which requires the relevant workspace roles. The user must also be a responsible user, unless they have the admin, pa_admin, or pa_kpi_signal_admin role.

**Procedure**

1. Open KPI Signals from KPI Details.

   In the KPI Details page for an indicator, you see a notification dot on the KPI Signals tab. This dot tells you that you have a signal for the indicator.
Note: KPI Signals can detect signals for an indicator that is filtered on one first-level breakdown element. It does not support multiple elements or second-level breakdowns.

2. Examine the signal and investigate the business reasons behind this variation in process behavior.

• If you determine that the signal shows a temporary change in behavior, click Dismiss signal. A temporary change in behavior may be due to a temporary change in circumstances, or due to a problem you are able to quickly correct.

• If you determine that the signal shows a long-term, real change in the process behavior, click Reset baseline.

3. Optional: If you recalculate the baseline, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset from date</td>
<td>The date from which to begin calculating the new baseline. By default, this date is the first date of the signal. If the signal is irregular or followed immediately by more variation, consider a later start date.</td>
</tr>
<tr>
<td>Number of scores for baseline calculation</td>
<td>The default number of scores for calculating the baseline depends on the indicator frequency for the KPI. Do not change this number unless you are confident you have good reasons. The minimum number is five.</td>
</tr>
</tbody>
</table>

4. Whether you dismiss the signal or reset the baseline, give the reason for your decision.
   A required field labeled What has changed? appears in the KPI Signals panel. Briefly describe the results of your investigation into the signal.
   The reason for your decision appears when you view Past signals. It is key information for deciding whether to revert a signal dismissal or baseline reset.

5. Click either Dismiss signal or Confirm, to dismiss the signal, or reset the baseline, respectively.
In the dialog for resetting the baseline, you can first click **How does it work?**
Doing so opens a window with information about what a baseline reset is and when to perform one.

### Understand Baseline Reset

**What is a baseline reset?**
A baseline reset is the calculation of the minimum and maximum expected value and the average based on the scores from the signal.

**Why should I reset the baseline?**
A new baseline reflects that your KPI has moved to a new normal.

**When should I reset the baseline?**
Reset the baseline if investigation of the signal confirms a real and persistent change in the process that is being measured with this KPI.

---

**Results**
If you reset the baseline, a message appears that the baseline is reset. You also see whether there is a more recent signal than the one you just handled. You can review the signals that you dismissed and your baseline resets in the **Past** tab.

**Revert baseline reset or signal dismissal**
Review previous decisions to reset the KPI Signals baseline or dismiss a signal. Revert the decision if necessary.

**Before you begin**
You must have access to KPI Details.
Role required: You must be a responsible user for the KPI, or have the admin, pa_admin, or pa_kpi_signal_admin role.
Procedure

1. From KPI Details, open the KPI Signals panel.

2. Switch to the Past tab.

3. To focus on a baseline reset or a signal dismissal, click the card for that decision.
You can also point to the callout for a signal to see the reason for its dismissal or for the baseline reset.

**Note:** You cannot revert an anti-signal.

4. If you determine that an earlier decision to dismiss a signal or reset a baseline was incorrect, click **Revert**.

5. Review the list of all decisions that you would revert.
When you revert a signal dismissal or baseline reset, you also revert all later decisions.

6. If you decide to proceed with reverting the decisions, click **Confirm**.

**What to do next**

Now make a new decision for the oldest signal whose decision you reverted. Then work your way through any subsequent signals.

**KPI Signals automated detection jobs**

The KPI Signals application includes jobs that detect signals automatically. These jobs run so responsible users can be notified of new signals without opening the application. The job for signals on formula indicators requires scheduling.

When you view an indicator in KPI Details and open the KPI Signals panel, that indicator is checked for signals. You therefore always have the most up-to-date signals. However, the KPI Signals application also has automated signal detection jobs. These jobs send notifications about signals to subscribed users without them having the application open.

For automated indicators, these jobs run whenever a data collection job runs. The KPI Signals application checks all indicator and breakdown element combinations that it is active for. The data collection jobs are domain specific, so the signals are also domain specific.

The situation is different for formula indicators. The formula in a formula indicator uses the scores of other indicators. These other indicators are referred to as contributing indicators. The scores of these indicators can be collected in different data collection jobs. Bear in mind the KPI Signals calculation uses the most recently detected contributing indicator scores. The KPI Signals job should run after the scores of all the contributing indicators have been detected.
To help you ensure that formula indicators are checked for signals at the right time, the KPI Signals application comes with a scheduled job: PA - KPI Signals - Formula Indicator Signals Calculation Job.

**Schedule the job to detect signals for formula indicators**

Set the PA - KPI Signals - Formula Indicator Signals Calculation Job to run after all data detection jobs have run.

**Before you begin**

Review the Performance Analytics data detection jobs. Determine a time after these jobs have run that signals should be detected for formula indicators.

⚠️ **Note:** This procedure is optional. Modifying the job schedule can prevent lags between new scores and new signals on formula indicators. However, the default signal detection every 8 hours should not produce errors and may be sufficient for you.

Role required: admin

**Procedure**

1. Navigate to **System Definition > Scheduled Jobs**.
2. Filter the list for jobs whose name contains **KPI Signals**.
3. Open the PA - KPI Signals - Formula Indicator Signals Calculation Job.
4. Modify the following fields to schedule the job:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Frequency you want the job to run. The choice of subsequent fields depends on your setting in this field. By default, the job runs <strong>Periodically</strong>.</td>
</tr>
<tr>
<td>Day</td>
<td>Day you want the scheduled job to run.</td>
</tr>
<tr>
<td></td>
<td>If you selected <strong>Weekly</strong> in the Run field, this field displays the days of the week. If you selected <strong>Monthly</strong> in the Run field, this field displays the days of the month.</td>
</tr>
<tr>
<td>Time</td>
<td>Time you want the scheduled job to start.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>Number of days and hours before the scheduled job runs again. This field appears when <strong>Periodically</strong> is selected from the <strong>Run</strong> list. By default, the job runs every 8 hours.</td>
</tr>
<tr>
<td>Starting</td>
<td>Date and time to start the periodic updates. This field appears when <strong>Periodically</strong> is selected from the <strong>Run</strong> list.</td>
</tr>
</tbody>
</table>

**Now® Experience dashboards**

The ServiceNow® Dashboards for Workspace product enables you to display multiple Performance Analytics, reporting, and other visualizations on a single screen. Use dashboards to create a story with data that you can share with multiple users.

**Working with Now® Experience dashboards**

There are several paths to create or edit Workspace dashboards in the Dashboard Builder.

**Enabling dashboards in an Experience**

Construct the dashboard in Dashboard Builder and add a Dashboard Viewport component in a Workspace Experience to view the dashboard. See [Work with viewport components](#).

**Roles in Workspace dashboards**

**Administrators and developers**

- Enables dashboard functionality in a specific experience/workspace (only supported for WEP experiences)
- Configures the available functionality on a dashboard page and configures the interaction behavior such as drill downs.

**Dashboard administrator**

Has full access to create and manage dashboards and define who has access to each dashboard.

**Dashboard Builder/Power user**
Creates dashboards and shares them with other users. Can only access dashboards in Dashboard Builder that are shared with them with edit rights.

Other users

Consume dashboards that are shared with them.

For more information, see Permissions in Now Experience dashboards.

Now® Experience dashboard components

You can populate your Workspace dashboard with several configurable components.

What you can add to your dashboard

The default dashboard builder supports the following components.

Container

Containers hold the various components you can add to the dashboard. They help you define the layout and group your components. Containers can also hold other containers. See Container components in UI Builder.

Data visualization

Add a visualization based on data in your instance, such as tables or indicators. See Data visualization components in UI Builder.

Filter

Filter the data visualizations in a workspace without modifying the visualizations. See Now Experience filters.

Heading

The Heading holds text that you can use to describe the workspace. See Heading components in UI Builder.

Image

The image component provides a holder for image files. See Image components in UI Builder.

Simple list

The Simple list component is a holder for a list visualization. See List components in UI Builder.

Rich text

The Rich text component enables you to add html to the workspace. See Rich text components UI Builder.
Create a dashboard in Dashboard Builder

When you create a Workspace dashboard, you are adding dashboard functionality to a specific dashboard viewport component. You can add its functionality to multiple Workspace experiences.

Before you begin
Role required: admin, dashboard_admin, ui_dashboard_builder, sn_ui_builder.dashboard_builder_admin

The Workspace Dashboard Builder implements UI Builder functionality including Components and Layouts.

Configure a dashboard viewport in the experience.

Optional: Configure dashboard overview.

Procedure

1. Navigate to Now Experience Framework > Experiences.
2. Click the link in the Admin panel column for the application you want to work with.
3. On the App Configuration page, click Open in UI Builder.
4. From the 3-dot menu, select Create page.

5. Name the page and click Create. The Create a page dialog also shows how the page is named in the URL and the path to the page.

6. Double-click a Dashboard viewport component or drag one to the staging area of the UI Builder.

7. In the Config panel, select Open Dashboard Builder. This is where you create your dashboard.
8. On the right side of the Dashboard Builder, in the **Layout** tab, choose a layout. To show the **Layout** tab at any time, select **Body** in the content menu to view the layout choices. The layout organizes containers in various pre-determined patterns. Containers hold dashboard components including data visualizations, static text boxes, and images. You can change the layout at any time. For more information, see **Change layout of a page**.

Click the plus icon (➕) in any container to add an item from the **Dashboard Builder Toolbox**, such as a data visualization, filter, or image. Alternately, Click the toolbox icon (🔧) to open the **Dashboard Builder Toolbox** and drag a container to the main window to start building.

9. Add a component to the container, from either the **Components** menu on the left or by clicking **+ Add** in the staging area. The **Config** panel on the right enables you to configure the component you chose.

If the dashboard you are creating has tabs, select the Tab Set component first. See **Add tabs to the example dashboard** for an example tab set.
If you select a visualization component, you can configure the entire visualization from the source, to the visualization type, to the styling. When you select a table, you see a preview of the records in the source. When you select an indicator, you see a preview of the indicator's details including type, source, and filters. If the source you select is correct, click **Add this source**.

If you select a filter, see **Now Experience filters**.

10. In the **Config** panel, configure the visualization. The source determines the aspects of the visualization that you can alter. For example, a table source enables you to choose the type of visualization, the metric, and how often it's refreshed. For more information on configuring the different visualizations, see **Dashboard builder visualization types**.

11. **Optional:** Add more containers, components, and configurations.

12. Click **Save** at any time to save the changes you've made to the dashboard.

**What to do next**

Configure data visualizations and Share the dashboard.
Add data visualizations in Dashboard Builder

Indicator visualizations in Workspace provide views into key performance indicators over time. Visualizations based on table data enable views of the current state of instance data.

**Before you begin**
Role required: admin, dashboard_admin, ui_dashboard_builder, sn-ui_builder.dashboard_builder_admin

**Procedure**

1. Navigate to **User Experience Framework > Dashboard Builder**.
2. From the **Dashboard** menu, select the dashboard you want to edit.

![Dashboard Builder](image)

3. Add a container. Click the toolbox icon ( ) to open the **Dashboard Builder Toolbox** and drag a container to the main window.

4. Drag the **Data visualization** tile onto the container, or click the Insert component icon ( ) and select the **Data visualization** tile.
The **Config** tab opens with a button to add a data source to the new visualization. The Config tab opens whenever you select a visualization on the dashboard.

5. Click **Add data source**.
   A window opens where you can search for tables or indicators to base your visualization on.

6. Type the first few letters of the indicator or table you want to limit the number of options. Choose a table or indicator to see a preview of the data.
   - If you select a table, a preview of table records displays.
   - If you select an indicator, you see a preview of the indicator's latest score and its properties.

7. Click **Add data source**.
   The visualization opens in the Dashboard Builder with the **Config** tab open. To configure visualizations, see Visualization types.

**Dashboard builder visualization types**
When you create a dashboard in the dashboard builder, you have the choice of several visualizations

**Table data visualization types**
When you base your visualization on table data, you can select one of these visualization types.
<table>
<thead>
<tr>
<th>Visualization type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area or Spline</td>
<td>Area reports show trends over time for related attributes. Spline reports show how one or more values change over time by connecting a series of known data points with a curve that emphasizes the trend over individual data points.</td>
</tr>
<tr>
<td>Column</td>
<td>Column reports show how the value of one or more items changes over time with columns.</td>
</tr>
<tr>
<td>Line</td>
<td>Line reports plot individual data points to show how the value of one or more items changes over time.</td>
</tr>
<tr>
<td>Step line</td>
<td>Step line reports plot individual data points to show how the value of one or more items changes over time. Vertical lines show the duration of a change and vertical lines show its magnitude.</td>
</tr>
<tr>
<td>Bar or Horizontal bar</td>
<td>Vertical and horizontal bar reports compare individual or aggregate scores across data dimensions. Vertical bar report columns originate on the x-axis, and horizontal bar report columns originate on the y-axis.</td>
</tr>
<tr>
<td>Donut or Semi-donut</td>
<td>Donut and semi-donut reports show the proportions that make up a whole.</td>
</tr>
<tr>
<td>Pie</td>
<td>Pies charts show the proportions that make up a whole.</td>
</tr>
<tr>
<td>Single score</td>
<td>Single score reports display a single value that is key to your business. Add single score reports to dashboards and configure them to update in real time.</td>
</tr>
</tbody>
</table>
**Indicator data visualization types**
When you base your visualization on indicator data, you can select one of these visualization types.

<table>
<thead>
<tr>
<th>Visualization type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area or Spline</td>
<td>Area reports show trends over time for related attributes. Spline reports show how one or more values change over time by connecting a series of known data points with a curve that emphasizes the trend over individual data points.</td>
</tr>
<tr>
<td>Column</td>
<td>Column reports show how the value of one or more items changes over time with columns.</td>
</tr>
<tr>
<td>Line</td>
<td>Line reports plot individual data points to show how the value of one or more items changes over time.</td>
</tr>
<tr>
<td>Step line</td>
<td>Step line reports plot individual data points to show how the value of one or more items changes over time. Horizontal lines in the step report show the duration of a change and vertical lines show its magnitude.</td>
</tr>
<tr>
<td>Single score</td>
<td>Single score reports display a single value that is key to your business. Add single score reports to dashboards and configure them to update in real time.</td>
</tr>
</tbody>
</table>

**Edit a Now® Experience dashboard**

Once you have a Workspace dashboard, you can change the layout, add tabs, images, text, lists, and filters.

**Before you begin**
Role required: dashboards_admin, dashboard_builder, pa_power_user
Procedure

1. Navigate to **User Experience Framework > Dashboard Builder**.

2. To change the layout:

   a. From the content tree, select the **Body** component to open the **Layout** pane.

```
Dashboard Builder  Menu  Help

Dashboard:  My Second Dashboard  :

Content

Search

.Body

Man

Add Component
```
b. From the Layout pane, select the layout you want.

The components on the dashboard follow the selected layout.

3. Add a container.

   a. Click the toolbox icon ( ) to open the **Dashboard Builder Toolbox**.
   b. Drag a container to the main window.

4. **Optional**: Choose a layout for the container.
   The layout adds containers inside the container you selected in the pattern of the layout.

5. Add a filter.

   a. Drag the **Filter** tile onto the container.
   b. Click **+Add** and select a table and field to filter on.
   c. Follow the directions in **Now Experience filters** to configure the filter you create.
6. Add a simple list.

   a. Drag the List - Simple tile onto the container. The container shows a default list.

   b. In the Config panel, determine how you want the list to appear. See List components in UI Builder.

Rename a Now® Experience dashboard

You can rename a dashboard from within the Dashboard Builder. You can select any component or container and choose to rename it from the context menu. You can also navigate to the dashboard in the Pages menu.

Before you begin
Role required: dashboards_admin, dashboard_builder, pa_power_user

Procedure
1. Navigate to Now Experience Framework > Dashboard Builder.
2. From the Dashboard menu, select the dashboard you want to rename.
3. From the Dashboard Options menu (⋮), select Edit settings.
4. In the Edit settings window, enter the dashboard’s new name and click **Save**.

**Delete a Now® Experience dashboard component**

You can delete individual components from a workspace dashboard. You can select any component or container and delete it from the options menu. You can also select a component in the dashboard’s outline and delete it there.

**Before you begin**
Role required: dashboards_admin, dashboard_builder, pa_power_user

**Procedure**

1. Navigate to **User Experience Framework > Dashboard Builder**.
2. From the **Dashboard** menu, select the dashboard with the component you want to delete.
3. Select the component you want to delete. A small toolbar appears above the component.
4. From the toolbar’s options menu, select **Delete**.
5. Confirm the deletion.

6. To delete from the outline:

   a. Click the Pages icon ().

   b. Select the component you want to delete. The component is highlighted in the main section of the Dashboard Builder.

   c. From the component's options menu, select **Delete component**.

   d. Confirm the deletion.
Delete a Now® Experience dashboard

You can delete a dashboard from within the Dashboard Builder. You can select any component or container and choose to delete it from the context menu. You can also navigate to the dashboard in the Pages menu.

Before you begin
Role required: dashboards_admin, dashboard_builder, pa_power_user

Procedure
1. Navigate to User Experience Framework > Dashboard Builder.
2. From the Dashboard menu, select the dashboard you want to delete.
3. From the Dashboard Options menu (), select Edit settings.
4. In the Edit settings window, click Delete and confirm the deletion.
Share a Now® Experience dashboard

Users who can create Workspace dashboards or who have sharing permissions on a Workspace dashboard can share. User access to Workspace dashboards and to specific information on them is subject to access control lists.

Before you begin
Role required: dashboards_admin, dashboard_builder, pa_power_user

There are multiple ways to share a dashboard. The first is to share it from the dashboard builder. The second is to share it from the dashboard itself at runtime. To share at runtime, create a page in UI Builder with a Dashboard Viewport component. See Work with pages.

Procedure

1. Navigate to Now Experience Framework > Dashboard Builder.
2. From the Dashboard menu, select the dashboard you want to share.
3. Click the Share button (Share).
4. In the Share dashboard dialog, start typing the names of users, groups, or roles who can either view or edit the dashboard. If companies, titles, or positions are configured, they appear below the name of the user. Users, groups, and roles are also called Audience types.
### Who you're sharing with

<table>
<thead>
<tr>
<th>Group</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: Only users with the roles sn_ui_builder.dashboard_/ builder_admin, ui_builder_admin, or admin can share dashboards with roles.</td>
</tr>
</tbody>
</table>

5. Choose to add the selected users, groups, and roles as viewers or contributors. Viewers can see the dashboard but cannot edit or share it. Contributors can view, edit, and share the dashboard.

   **Share dashboard**

   ![Share dashboard interface]

   - Add as viewer
   - Add as contributor

6. To manage the access of people you share the dashboard with, type a name or select an audience type. In the tile of the user you want to change, click the current access level and choose a new level of access.
7. Click **Confirm**.

**Results**
A confirmation message indicates that you have successfully changed access to the dashboard for a specified number of users, groups, and roles.

**Permissions in Now® Experience dashboards**
Your role determines your ability to share dashboards. To view Now® Experience dashboards at runtime, a user must have at least the canvas_user role.

**Permissions matrix**
There are several roles associated with the Dashboard Builder: canvas_user, dashboard_admin, admin, ui_dashboard_builder, and two UI Builder admin roles:
- ui_builder_admin
- sn_ui_builder.dashboard_builder_admin

In addition, this matrix refers to Other, meaning users who don't have any of these roles.
The Share, Edit, and Create buttons refer to what the user can see in a runtime view of the dashboard, not in the Dashboard Builder. In the Dashboard Builder, you grant permissions when you share. For more information, see Share a Now Experience dashboard.

**Admin permissions**
Users with any of the four admin roles:

<table>
<thead>
<tr>
<th>Access granted via sharing</th>
<th>See dashboard runtime</th>
<th>See Dashboard Builder</th>
<th>Share button</th>
<th>Edit button</th>
<th>Create button</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>None</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**ui_dashboard_builder permissions**
Users with any of the ui_dashboard_builder roles:

<table>
<thead>
<tr>
<th>Access granted via sharing</th>
<th>See dashboard runtime</th>
<th>See Dashboard Builder</th>
<th>Share button</th>
<th>Edit button</th>
<th>Create button</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Edit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>None</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

**Other user permissions**
Users with any other role:

<table>
<thead>
<tr>
<th>Access granted via sharing</th>
<th>See dashboard runtime</th>
<th>See Dashboard Builder</th>
<th>Share button</th>
<th>Edit button</th>
<th>Create button</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Yes</td>
<td>No access</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Edit</td>
<td>Yes</td>
<td>No access</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>None</td>
<td>No</td>
<td>No access</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Now® Experience filters

Filters enable you to filter data visualizations without modifying the visualizations. The filters can apply to both tables and indicators in a Now® Experience or dashboard.

Drag a filter component onto a workspace to add it. Then select a table, field, and other values to configure the filter. When a user selects one or more values, the filter applies to those data visualizations that are based on the same data source.

Interactive filters that you configure on a workspace or UI Builder dashboard retain default values across logins or page refreshes. However selected values do not persist on workspaces across refreshes and logins.

Filter behavior

When you configure a filter, you select a table and a field on that table that the filter applies to. The field type determines the behavior of the filter. A simple example is choosing the Incident table and the Active field. Because Active is a Boolean (true/false) field, the filter is also Boolean.

To apply a filter to an automated indicator, select the data table that the indicator source uses. To apply a filter to a formula indicator, select the tables that the sources of the contributing indicators use. Also select a field that is common to those tables.

Another example: Choose the Incident table and the Assignment Group field. The filter applies to that table and field. The values derive from the sys_group table because that is the table the Assignment group field references.

Choice

- Enables users to filter data visualizations based on the value of a choice field. For example, you can filter on the value of the Priority field on the incident table.

Boolean

- Enables users to filter data visualizations based on the value of a Boolean (true/false) field. For example, you can filter on the value of the Active field on the incident table.

Reference

- Enables users to filter data visualizations based on a field on a related table. For example, you can filter on the Assignment group on the task table, which references sys_user_group on the user table.

Date
Enables users to filter data visualizations based on selected dates or date ranges. For example, you can filter on the Opened field on the incident table.

Caveats

Common fields across tables

You can add multiple data sources, such as tables and table views, and fields to the same filter. However, only the fields in the first data source apply if there is a discrepancy between the two. For example, the first table you add has the priorities High, Medium and Low. The second table has the priorities High, Medium, and Critical. The filter only applies to the priorities High, Medium, and Low. If the user selects Low, visualizations based on the second table show no data.

Field mismatch

You can configure a filter with fields from multiple tables. If there is a mismatch in the data, the filter does not apply to visualizations based on the second table. For example, your first data selection is a choice field, and your second is a true/false field. The visualizations that reference the true/false field on the second table are not correctly filtered.

Indicator visualizations

Indicators are configured with breakdowns, which behave the same way filters do. For a filter to apply to an indicator visualization, it must filter on a field that corresponds to a breakdown on that indicator. For example, an indicator has the breakdowns Priority, Category, and State. An Assignment group reference filter on the same Workspace does not apply to that indicator. In the Configuration panel, select Group by to see the breakdowns.

Interactive filters in the classic UI

For information about interactive filters on non-Workspace dashboards, see Interactive Filters.

Create a Boolean filter for Now® Experience

Boolean filters enable you to filter on true/false fields. For example, you can enable users to choose only the incidents where Active=True. The filters can apply to both tables and indicators in a Now® Experience or dashboard.

Before you begin
Role required: admin or ui_builder_admin
There are four kinds of filters: choice, Boolean, date, and reference. The table field you choose determines the type of filter you create. For example, Active is a true/false (Boolean) field, so when you choose to filter on Active, you create a Boolean filter.

Procedure

1. To configure a filter for a dashboard, navigate to Now Experience Framework > Dashboard Builder and select the dashboard you want to add a filter to. To configure a filter for a Now® Experience, navigate to Now Experience Framework > UI Builder and open the experience and page you want to add the filter to.

2. From the Toolbox, add a Filter component to a container on the layout. The Filter panel opens to the Config tab where you configure the selected filter.

   **Important:** Filters on a component do not apply to tabs in that component. If you have a tab set on a page or dashboard and want a filter to apply, add the filter to the relevant individual tabs.

3. Name the filter. This is the name of the filter that the end user sees.

4. Click + Add in the Data box to select the first table and field to filter on. The filter can apply to any indicators whose indicator sources use this table. The indicators must also have breakdowns defined and collected. The filter must apply to the same field as used in the breakdown source.

5. **Optional:** Add more tables and fields to filter on. If there is a mismatch in the field types, the filter only works for the first table and field you set. For example, your first data selection is a choice field, Priority, and your second is a Boolean field, Active. You get the configuration options for a choice filter, and the filter does not apply to the Active field.

   (Optional) Typically, you select the same field on different tables. For example, first select the Priority field on the Incident [incident] table, then the Priority field on Problem [problem]. To apply a filter to a formula indicator, filter on the same field for all tables that the indicator sources of the contributing indicators use.

6. **Optional:** Select the default value or values for the filter. The dashboard applies these values when a user opens it.

7. **Optional:** Enter display values for the Boolean values true and false. For example, if you're filtering the Active field, you can have the dashboard show Open and Closed instead of true and false.

8. Click Save.
**Results**
The filter you create is available in the workspace in which you created it.

**What to do next**
When you configure filters in Workspaces, you must configure an event handler to apply the filters. For more information, see Configure events for Now Experience filters.

💡 **Tip:** If you have multiple filters on a page, dashboard, or tab, consider adding a Button component to clear all those filters at once. Add the following page script and use it for the button event handler:

```javascript
function resetFilter ({ api }) {
    api.setState('parFilters', []);
}
```

**Create a Choice filter for Now® Experience**
Filter data visualizations on choice fields directly from a workspace without modifying the visualization source. The filters can apply to both tables and indicators in a Now® Experience or dashboard.

**Before you begin**
Role required: admin or ui_builder_admin

There are four kinds of filters: choice, Boolean, date, and reference. The table field you choose determines the type of filter you create. For example, Priority is a choice field, so when you filter on Priority, you create a choice filter.

**Procedure**

1. To configure a filter for a dashboard, navigate to Now Experience Framework > Dashboard Builder and select the dashboard you want to add a filter to. To configure a filter for a Now® Experience, navigate to Now Experience Framework > UI Builder and open the experience and page you want to add the filter to.

2. From the Toolbox, add a Filter component to a container on the layout. The Filter panel opens to the **Config** tab where you configure the selected filter.

   🔄 **Important:** Filters on a component do not apply to tabs in that component. If you have a tab set on a page or dashboard and want a filter to apply, add the filter to the relevant individual tabs.

3. Name the filter. This is the name of the filter that the end user sees.

4. Click + Add in the **Data** box to select the first table and field to filter on.
The filter can apply to any indicators whose indicator sources use this table. The indicators must also have breakdowns defined and collected. The filter must apply to the same field as used in the breakdown source.

5. **Optional:** Add more tables and fields to filter on.
   If there is a mismatch in the field types, the filter only works for the first table and field you set. For example, your first data selection is a choice field, Priority, and your second is a Boolean field, Active. You get the configuration options for a choice filter, and the filter does not apply to the Active field.

(Optional) Typically, you select the same field on different tables. For example, first select the Priority field on the Incident [incident] table, then the Priority field on Problem [problem]. However, for choice fields, only the values from the first table you select are available in the filter menu. For example, filter on Priority in both the Incident and Problem tables. Add the Incident table first, which has the priorities High, Medium, and Low. Add the Problem table second, which has the priorities Critical, High, and Medium. The user cannot filter on the value Critical. When they filter on the value Low, the visualizations for Problem show that no data is found.

To apply a filter to a formula indicator, filter on the same field for all tables that the indicator sources of the contributing indicators use. The contributing indicators must each have a breakdown set up with a breakdown source that refers to the same field as the filter. For example, if a formula indicator has the formula \( \left( \frac{[\text{Number of open problems}]}{[\text{Number of open incidents}]} \right) \times 100 \), and you want to filter the formula indicator on Priority, the filter must apply to the Priority field on both the Problem [problem] and Incident [incident] tables. Both indicators must also have a Priority breakdown set up and collected.

6. **Optional:** Select the default value or values for the filter. The dashboard applies these values when a user opens it.

7. **Optional:** Enable multiple element selection. When enabled, the user can filter on more than one of the choices. For example, they could select both High and Critical incidents. If you enable multiple element selection, you can also select multiple default values.

8. **Select the Sort direction**. If you select Ascending, the lowest filtered values are shown first. If you select Descending, the highest values are shown first. The user can change this value.

9. **Click Save.**

**Results**
The filter you create is available in the workspace in which you created it.
What to do next
When you configure filters in Workspaces, you must configure an event handler to apply the filters. For more information, see Configure events for Now Experience filters.

Tip: If you have multiple filters on a page, dashboard, or tab, consider adding a Button component to clear all those filters at once. Add the following page script and use it for the button event handler:

```javascript
function resetFilter ({ api }) {
    api.setState('parFilters', []);
}
```

Create a Date filter for Now® Experience
Date filters enable the user to choose predefined periods or specify custom start and end dates for the data shown in a visualization. The filters can apply to both tables and indicators in a Now® Experience or dashboard.

Before you begin
Role required: admin or ui_builder_admin

There are four kinds of filters: choice, Boolean, date, and reference. The table field you choose determines the type of filter you create. For example, Opened On is a date field, so when you filter on Opened On, you create a date filter.

Date filters apply to Time Series visualizations for Performance Analytics and to Bar, Pie, Donut, and Single Score visualizations for Reporting.

Procedure
1. To configure a filter for a dashboard, navigate to Now Experience Framework > Dashboard Builder and select the dashboard you want to add a filter to. To configure a filter for a Now® Experience, navigate to Now Experience Framework > UI Builder and open the experience and page you want to add the filter to.
2. From the Toolbox, add a Filter component to a container on the layout. The Filter panel opens to the Config tab where you configure the selected filter.

   Important: Filters on a component do not apply to tabs in that component. If you have a tab set on a page or dashboard and want a filter to apply, add the filter to the relevant individual tabs.

3. Name the filter. This is the name of the filter that the end user sees.
4. Click + Add in the Data box to select the first table and field to filter on.
The filter can apply to any indicators whose indicator sources use this table. The indicators must also have breakdowns defined and collected. The filter must apply to the same field as used in the breakdown source.

5. Optional: Add more tables and fields to filter on.
   If there is a mismatch in the field types, the filter only works for the first table and field you set. For example, your first data selection is a choice field, Priority, and your second is a Boolean field, Active. You get the configuration options for a choice filter, and the filter does not apply to the Active field.

(Optional) Typically, you select the same field on different tables. For example, first select the Priority field on the Incident [incident] table, then the Priority field on Problem [problem]. To apply a filter to a formula indicator, filter on the same field for all tables that the indicator sources of the contributing indicators use.

6. Optional: Select the default start and end dates for the filter. The dashboard applies these values when a user opens it.

7. Click Save.

Results
The filter you create is available in the workspace in which you created it.

What to do next
When you configure filters in Workspaces, you must configure an event handler to apply the filters. For more information, see Configure events for Now Experience filters.

Tip: If you have multiple filters on a page, dashboard, or tab, consider adding a Button component to clear all those filters at once. Add the following page script and use it for the button event handler:

```javascript
function resetFilter ({ api }) {
    api.setState('parFilters', []);
}
```

Create a Reference filter for Now® Experience
Reference filters let you filter on tables that the base table refers to. The filters can apply to both tables and indicators in a Now® Experience or dashboard.

Before you begin
Role required: admin or ui_builder_admin

There are four kinds of filters: choice, Boolean, date, and reference. The table field you choose determines the type of filter you create. For example, the...
Assignment Group field references the table Group [sys_user_group], so filters on Assignment Group are reference filters.

In a reference filter, you can select either the reference field or you can dot-walk to a field on the referenced table. When you select a field on the referenced table, you get the filter configuration options, other than for data, that correspond to the type of that field. If you select only the reference field itself, you get the options for a Choice filter. In any case, you get extra Data options that are specific to reference filters.

Procedure

1. To configure a filter for a dashboard, navigate to Now Experience Framework > Dashboard Builder and select the dashboard you want to add a filter to.
   To configure a filter for a Now® Experience, navigate to Now Experience Framework > UI Builder and open the experience and page you want to add the filter to.
2. From the Toolbox, add a Filter component to a container on the layout. The Filter panel opens to the Config tab where you configure the selected filter.

   **Important:** Filters on a component do not apply to tabs in that component. If you have a tab set on a page or dashboard and want a filter to apply, add the filter to the relevant individual tabs.

3. Name the filter. This is the name of the filter that the end user sees.
4. Click + Add in the Data box to select the first table and field to filter on. When you select the field, an expansion icon to the right of the field name indicates that the field references another table.
5. **Optional**: Select a field on the referenced table.

   a. Click the expand icon next to the reference field. The list refreshes back to the top.

   b. Locate the desired reference field again and click the now highlighted expand icon. The list expands to show fields on the referenced table.

   c. Select a field on the referenced table. You can select another reference field and dot-walk further.

In this short animation, you select the Incident [incident] table and then the Assignment Group field. This field is a reference field, referring to the Group [sys_user_group] table. By expanding the Assignment Group, you can select a field on the Group table. You select Default assignee. Because this field is a choice field, the configure options for a choice field appear. If you had chosen a date field on sys_user_group, such as Created, the configuration options for a date filter would have appeared.
6. Click **Configure values** to define the values that appear in the filter.

7. Specify one or more conditions on the referenced table that the filter must meet. These conditions can be specific, such as Name starts with M, or dynamic, such as Manager is (dynamic) Me.

8. **Optional:** Add a related list condition. You can add a condition to your filter based on the records in one table that is related to the referenced table.

   a. Click the link labeled **Greater than or Equal to 1**. From the list, select the number of records on the source table that must be related to a record on the target table.

      The options are:

      • Greater than or Equal to
      • Greater than
• Less than or Equal to
• Less than
• Equal to
• None
• Between

b. Choose the related table.

c. Specify the conditions on that table that must be met for the filter to be valid.

9. Optional: Select **Show empty values as one option.**
   Lets the runtime user filter for records that have an empty or null value in the filtering field. If you activate this option, define a label to represent empty values, such as **Unmatched.**

10. Click **Save.**

**Results**
The filter you create is available in the workspace in which you created it.

**What to do next**
When you configure filters in Workspaces, you must configure an event handler to apply the filters. For more information, see Configure events for Now Experience filters.
Tip: If you have multiple filters on a page, dashboard, or tab, consider adding a Button component to clear all those filters at once. Add the following page script and use it for the button event handler:

```javascript
function resetFilter ({ api }) {
  api.setState('parFilters', []);
}
```

Create a Domain filter for Now® Experience

Filter data visualizations on domains in a domain-separated instance. Domain filters enable the user to see data associated with one or more domains. The filters can apply to both tables and indicators in a Now® Experience or dashboard.

Before you begin

Domain filters are available on instances with domain separation enabled. For more information, see Domain separation for service providers.

Domain filters are only available in UI Builder. You cannot configure domain filters in Dashboard builder.

Domain filters support both the instance’s list of domains and Performance Analytics domain configurations. Filters based on the domain list provide different results than filters based on domain configurations. For more information, see Differences between domain list and domain configuration filters.

Role required: admin or ui_builder_admin

Procedure

1. To configure a filter for a Now® Experience, navigate to Now Experience Framework > UI Builder and open the experience and page you want to add the filter to.

2. Add the Domain Filter component to a container on the layout. To learn more about using UI Builder, see Using UI Builder.

3. Name the filter. This is the name of the filter that the end user sees.

4. Set configuration properties to determine what data to display in your filter. For a more detailed description of how these properties affect the results of the filter, see Differences between domain list and domain configuration filters.
a. Select a **Domain display** value. You can filter on either a domain configuration or a standard domain list.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the Performance Analytics domain configuration</td>
<td>Allows users to filter results based on a domain configuration. To learn more about domain configurations, see <a href="#">Grouping domains in Performance Analytics domain configurations</a>.</td>
</tr>
<tr>
<td>Use the standard domain list</td>
<td>Allows users to filter results based on the list of domains. Only displays active domains, and does not include aggregations.</td>
</tr>
</tbody>
</table>

b. Set the **Include global domain data** property. When selected, the filter includes values from records in the global domain.

**Example**

5. Click **Save**.

What to do next
When you configure filters in Workspaces, you must configure an event handler to apply the filters. For more information, see [Configure events for Now Experience filters](#).

Differences between domain list and domain configuration filters
Domain filters based Performance Analytics domain configurations behave differently than domain filters based on the list of platform domains.
Overview of differences
The results of domain filtering differ based on the presence of child domains and the inclusion of the global domain. If you use domain configurations, results also depend on aggregation.

Platform domain list

Global domain included

Visualizations based on indicator data
Show only the scores for the selected domain. Child domain and global domain scores are not included. The values can come from both data collection jobs and manual input.

Visualizations based on table data or database views
Combine the values of the global and selected domains, and any child or parent domains.

Global domain not included

Visualizations based on indicator data
Show only the score for the selected domain. Child domain and global domain scores are not included.

Visualizations based on table data or database views
Combine the values of the selected domain and the values of the child domains.

Performance Analytics domain configurations
See Grouping domains in Performance Analytics domain configurations for a detailed discussion of domain configurations.

Once you group domains in a Performance Analytics domain configuration, there are two considerations when you filter on a domain in that configuration:

• Does the domain have children or is it a standalone domain?
• Is the data aggregated?

Global domain included

Visualizations based on indicator data
Show only the scores for the selected domain, and only if a data collection job collected indicator scores for that domain.
Aggregated scores come from all domains in the domain configuration, but exclude child domains. The global domain is also excluded.

**Visualizations based on table data or database views**
Include values from the selected domain, any child domains of that domain, and the global domain.

Aggregated results come from all domains in the configuration, including their child domains, plus the global domain.

**Global domain not included**

**Visualizations based on indicator data**
Show only the scores for the selected domain. Child domains and the global domain are excluded.

Aggregated scores come from all domains in the domain configuration, but exclude child domains. The global domain is also excluded.

**Visualizations based on table data or database views**
Include the values of the selected domain and children of the selected domain, if present. Global domain values are not included.

Aggregated results come from all domains in the domain configuration plus any children of domains in that configuration. Global domain values are not included.

**Related information**
Approaches to Performance Analytics with domain separation

**Configure events for Now® Experience filters**
For filters to work in a Now® Experience, you must configure an event handler to apply the filters. Filters work differently in dashboards. Dashboards handle event configuration by default.

**Before you begin**
Role required: admin or ui_builder_admin
About this task

Procedure

1. Navigate to **Workspace Experience > Workspaces > All Workspaces** and select the Workspace you want to filter.

2. Click the Client Scripts icon ( ) at the bottom of the navigation bar on the left. A script editing panel opens below the Workspace. It has three panels: Page scripts, Details, and a text editor.

3. In the Page scripts section, click **Add**, and in the Details section, name the event handler **applyFilter**.

4. In the editor, replace the existing code with the following script:

```javascript
function applyFilter ({ api, event, imports }) {
  api.setState('parFilters', ({ currentValue }) => {
    const { payload: { appliedFilters } } = event;
    return imports['global.mergePARFilters']()(currentValue, appliedFilters);
  });
}
```

**Tip:** If you have multiple filters on a page, dashboard, or tab, consider adding a Button component to clear all those filters at once. Add the following page script and use it for the button event handler:

```javascript
function resetFilter ({ api }) {
  api.setState('parFilters', []);
}
```

5. In the Details section, type **mergePARFilters** under Add a script include, and click **Add**.
6. Click the Client State icon ( ) at the bottom of the navigation bar on the left.

7. In the Client state parameters section, click Add.
   a. Name the parameter `parFilters`.
   b. Select the type JSON.
   c. Set the initial value to `[]` (empty square brackets).
8. Add the event handlers.
   a. Select the first filter on the workspace and select the **Events** tab.
   b. Click **Add a new event handler**.
   c. In the Event handler preview, select the client script you created.
   d. Repeat steps a-c for all filters on the workspace.

**Results**

The filters apply to the data visualizations on the workspace.
Now Experience dashboard and filters example

To show how easy it is to create a Now Experience dashboard and add filters, this is a walk-through of the whole process.

In this example, you follow these steps to make a dashboard. C, add a dashboard viewport component, create a dashboard with multiple tabs and visualizations and then add filters on each tab.

1. **Design a dashboard.**
   This step is here because it is best to identify the audience and purpose of the dashboard before you begin.

2. **Create a Now Experience in UI Builder**

3. **Add a dashboard viewport component.**

4. **Build a dashboard with two tabs, multiple visualizations and filters.**

5. **Configure the filters on the dashboard.**

This example reiterates some of the information found in Using UI Builder. We’ll link back to information there as necessary.

**Design a dashboard**

It's far easier to create a dashboard if you know its purpose and audiences.

When you create a dashboard, consider the dashboard's users in the design phase. This consideration is part and parcel of understanding the audience of the experience in general. See Understanding your audiences.

The dashboard we’re going to create has two audiences, an incident process manager who consumes operational data, and a general improvement manager or officer who looks at analytical data. Operational data, in this case, consists of reports on the incident table used by managers and support agents. Analytical data contains trends and forecast information based on indicators.

**Create a Now Experience for your dashboard**

Now Experience Dashboards don’t exist on their own. They are parts of experiences that may also contain landing pages, portal experiences, and applications.

**About this task**

You’re creating this dashboard from scratch, but you may have templates that you can use to create your UI experience.
Procedure

1. Navigate to Now Experience Framework > UI Builder.

2. From the UI Builder home page, select + Create experience in Platform. You leave UI Builder and go to the ServiceNow platform to create the experience.

3. On UX Applications, click New. You’re going to create a dashboard, but in UI Builder, you can create many kinds of experiences.

4. Name this experience Incident Manager.

5. Select the App Shell UI named Agent Workspace App Shell.

6. The URL path enables users to find the dashboard easily. The path you enter follows the root URL https://<your_instance.service-now.com/.../... Enter incident-manager. Save this path for later to view it in runtime.

7. Click the magnifier icon next to Admin panel. Don't change the default Table name, UX App Configuration.

8. Click the magnifier next to Document to create a new UX App configuration. Click New. Name the configuration Incident Manager Dashboard and click Submit.

9. In the Select the document dialogue, click OK.

10. On the UX App Config page, click Submit. In UI Builder, this experience shows up in the list of experiences.

11. Return to the UI Builder list of your experiences. Select the Incident Manger experience. Reload the list if you don't see this experience.

12. Open the application in UI Builder and click Create a page.

13. Name the dashboard’s page. In this exercise, name the page Dashboard Example.

14. Optional: Edit the URL path to that page. In this exercise, keep the path dashboard-example.

15. Skip selecting a page template and click Create. You can use the fields in the Success pop up to specify a page and variants. For now, click Done.
16. Click **Add component** in either the canvas or the Content tree and select **Dashboard Viewport** from the toolbox.

**Note:** The dashboard viewport may contain the contents of the last dashboard you created. These contents appear because all the dashboards created in your experiences use the Dashboard Viewport component.

17. Click **Save**.

18. In the **Config** panel, click **Open Dashboard Builder**.
Results
The Dashboard Builder opens. You can add components including visualizations and filters.

Add tabs to the example dashboard
Add visualizations to the dashboard you created. The visualizations are based on table and indicator data.

About this task
Configure the layout of your dashboard, add tabs, visualizations, and some styling.

Note: If there are already Now® Experience dashboards in your instance, you may see content when you open the Dashboard Builder.

Procedure
1. In the Dashboard Builder, click Create a new dashboard.
   Name the dashboard Dashboard Example and click Create. Application scope is outside the scope of this example. See Application scope.

2. Remember from the section Design a dashboard that you're creating a dashboard with two tabs, one for operational data and one for analytical data.

3. In the Content treeview, click Add component under Main. Adding the component here puts it at the top level of your dashboard.

4. Select Tab set.

5. Click Manage content.
   If you have unsaved work, click Save and continue.

6. Click Create a new tab.
7. Name the first tab Operational, enter 5 in the Order field, and click Create. The value in the Order field determines the order the tabs appear in the dashboard.

The Dashboard Builder shows the empty tab. In the corner, you can see the tab you're on (Operational, in this case) or go back to the dashboard.

8. Click the three-dot icon next to the tab name and select Create tab.

9. Name the second tab Analytical, enter 10 in the Order text box, and click Create.

Results
Your dashboard has two empty tabs. Next, you add content to the tabs.

Add layouts to the example dashboard
Add containers and layouts to the dashboard you created. The layouts provide the framework for the visualizations you add.
About this task
Containers and layouts enable you to place multiple dashboard components in one place. Containers also enable you to format multiple components at the same time.

There's no limit to the number of containers you can nest. For the purposes of this dashboard, you add three containers and add layouts to each container.

Procedure
1. Add three containers. Perform this step three times.
   a. Click the three dot menu next to Body > Main in the Content tree.
   b. Select Add component.
   c. Choose Container.
The tab has three containers named Container 1, Container 2, and Container 3.

2. It can be useful to change the component labels. To rename the component label, select the Configure tab, click the pencil icon, and edit the component name.
3. Name the first container Filters, name the second container Single score visualizations, and name the third container Bar visualizations.

4. Add layouts to the containers.
   a. Select the first container in the Content tree. Its outline color changes.
   b. On the right side of the Dashboard Builder, select Layout and choose the layout with three columns. You add the three filters to this dashboard tab here.

5. Change the layouts of the second and third rows. Add the layout with three columns to the second row and add the layout with two columns to the third row.
6. Click **Save**.

7. Switch to the Analytical tab and add two containers with these layouts and names:
   - Three horizontal columns, **Filters container**
   - Two horizontal columns, **Indicator visualizations**

8. Click **Save** and switch back to the Operational tab.

**Results**
The dashboard has two tabs with layouts that you will add visualizations and filters to in the next tasks.

**Add visualizations to the dashboard's Operational tab**

Add visualizations to the first tab of the dashboard you created. The visualizations are based on table data.

**About this task**

Visualizations are what people are coming to your dashboard to see. The containers and layouts you configured hold the visualizations and filters.

**Procedure**

1. On the dashboard's **Operational** tab, select the Filters container in the Content treeview.
   ![Content treeview](image)
   Note the outline around the container in the main design section.

2. Click the Add component icon (➕) in the first box in the container and select **Filter**.
   Repeat this step for all the boxes in this row. After you configure the other tab, you configure the filters on the dashboard.

3. Select the Single Scores container in the Content treeview.
   Note the outline around the container in the main design section.

4. Click the Add component icon (➕) in the first box in the container and select **Data Visualization**.
   Repeat this step for all the boxes in this row and the following row.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
5. Before you configure the visualizations, click **Save** and look at the dashboard in runtime.

   a. Click **Back to Incident manager** to return to the dashboard's parent page in the Dashboard Builder.

   ![UI Builder and Incident Manager interfaces](image)

   b. Next to the dashboard's URL, click **Open**.

   ![Dashboard URL interface](image)

   The dashboard framework you created is all in place, including tabs and containers for the data visualizations.

6. Configure the first single score visualization. On the first row, you add three single score reports, for Open incidents, critical incidents, and incidents assigned to service desk. On the second row, you add two bar reports, one for incidents grouped by assignment group, and the second by priority.

   a. Select the first visualization container and click **Add data source**.

   b. Select the Incident table.

   c. In the **Filters** option, you can select a predefined condition. Select **Incidents.Open** and click **Add this source**.

   The default visualization type is Single Score. You can see the value of the open incidents in the first data visualization container.

   d. Under **Component header**, type **Open Incidents** so users know what the score is telling them, and click **Save**.
7. Configure the second single score visualization.
   a. Select the second visualization container and click **Add data source**.
   b. Select the Incident table.
   c. In the **Filters** options, select **Custom Conditions**.
   d. In the condition builder, set the condition to [Priority] [is] [Critical] and click **Add this source**.
      The default visualization type is Single Score. You can see the value of the critical incidents in the second data visualization container.
   e. Under **Component header**, type **Open Incidents**, and click **Save**.

8. Configure the first bar visualization.
   a. Select the first container on the third row and click **Add data source**.
   b. Select the Incident table and click **Add this source**.
   c. In the **Configuration** tab, select the **Visualization type** Vertical bar.
   d. Under **Group by**, select Assignment group.
   e. Under **Component header**, type **Incidents by assignment group**, and click **Save**.

9. Configure the second bar visualization.
   a. Select the second container on the third row and click **Add data source**.
   b. Select the Incident table and click **Add this source**.
   c. In the **Configuration** tab, select the **Visualization type** Horizontal bar.
   d. Under **Group by**, select **Priority**.
   e. Under **Component header**, type **Incidents by priority**, and click **Save**.

**Results**
Your dashboard tab contains:
- A row of filters that you have not configured yet
- A row of three Single Score visualizations
- A row of two bar visualizations
What to do next

- Configure the second tab with analytical visualizations
- Configure the filters on both tabs

Add visualizations to the dashboard's Analytical tab

Add visualizations to the second tab of the dashboard you created. The visualizations are based on table and indicator data.

About this task

Visualizations are what people are coming to your dashboard to see. The containers and layouts you configured hold the visualizations and filters. On this tab, you add filters and a different kind of visualization.

Procedure

1. Select the **Analytical** tab.
2. Select the Filters container in the **Content** treeview.
   - Click the Add component icon (➕) in the first box in the container and select **Filter**.
     - Repeat this step for all three boxes in this row. After you configure the visualizations on this tab, you configure the filters on both tabs.
3. Select the Indicator visualizations container in the Content treeview.
5. Click the Add component icon (➕) in the first box in the container and select **Data Visualization**.
Repeat this step for the other box in this row.

6. Select the first visualization container and click **Add data source**.

   a. Under Select a source, type **Number of open incidents**

   b. Select the indicator with that name, and click **Add this source**.

**Add data source**

*Select a source* 📖

- **number of open incidents**
- **Indicators**

  **Number of open incidents**
  
  **Number of open incidents** not updated in last 3...
  **Number of open incidents** not updated in last 5 ...
  **Number of open incidents** that should be resolved...
  **Number of open incidents** with problem

The dashboard shows the data visualization with the default Single Score type.
c. In the **Configuration** tab, change the **Visualization type** to Area and change the **Metric** to **Daily**.
d. Choose the **Presentation** tab and change the size to

![Configuration options](image)

Select the second visualization container and click **Add data source**.

7. Select the second visualization container and click **Add data source**.
a. Choose the **Number of open incidents** indicator again.

b. Filter the indicator with the condition **Priority is 1 - Critical**, and click **Add this source**.

The dashboard shows the data visualization with the default Single Score type.

c. In the **Configuration** tab, change the **Visualization type** to Area and change the **Metric** to Daily.

d. Choose the **Presentation** tab, change the size to **Medium**, and Click **Save**.

**Results**

Your dashboard has two tabs with multiple visualizations.

**What to do next**

Configure the filters on both tabs of the dashboard.

**Add filters to the example dashboard**

Create and configure interactive filters on your dashboard. Interactive filters enable your users to limit the information they see on the dashboard and they operate on both table and indicator data.

**About this task**

On each tab of the dashboard, you configure several filters to drill down into the dashboard data.

**Procedure**

1. On the Operational tab of the dashboard, select the first filter component.
   
   You added the filters when you created the layout for the tab.

2. In the **Config** tab, click the **Add** button to configure the filter's data.
3. Select the Incident [incident] table and the Category field. All of your visualizations are based on this table, so that is the obvious choice. Filters based on fields in other tables have no effect on these visualizations.

4. Choose one or more default values. The default values you choose are filters applied when a user opens the dashboard. In this case, select Hardware. Select **Allow multiple element selection** to enable the user to filter the dashboard tab on multiple categories.

**Dashboards**

The ServiceNow® Dashboards product enables you to display multiple performance analytics, reporting, and other widgets on a single screen. Use dashboards to create a story with data you can share with multiple users.
Create and use dashboards

Learn about different types of dashboards and how to use them.

- To create a responsive dashboard, see Create or configure a responsive dashboard.
- To create a non-responsive dashboard, see Create or configure a non-responsive dashboard.

Watch this seven-minute video to learn more about flexible layouts, multiple tabs, sharing, converting homepages to dashboards, and enabling responsive dashboards.

Overview of dashboard features including flexible layouts, multiple tabs, sharing, converting homepages, and enablement.

Watch this seven-minute video to learn how Performance Analytics benefits different kinds of users on different dashboards.

This video describes Performance Analytics dashboards for executives, process owners, and front-line workers who have different goals and needs with regards to dashboards.

Working with responsive dashboards

Responsive dashboards enable you to share widgets such as reports and Performance Analytics visualizations. An easy-to-use drag and drop canvas helps you create, edit, and arrange content, and then share it with colleagues.

Use dashboards to:

- Create and edit Performance Analytics reports and other widgets directly from the dashboard.
- Quickly find and preview widgets, then add them to the dashboard from the Add Widget pane.
- Easily share dashboards with other users from the integrated Sharing pane.
- Snap widgets into a predefined layout, then adjust the layout as desired.
- Access information that you use frequently by setting dashboards as your Home.
Watch this seven-minute video to learn more about flexible layouts, multiple tabs, sharing, converting homepages to dashboards, and enabling responsive dashboards. (This video reflects the Jakarta release, but its information is accurate for Rome.)

Introduction to using responsive dashboards

**Benefits**

- Optimize performance with configurable widget loading. For more information on the benefits of configurable widget loading, see Optimize widget rendering time on responsive dashboards.
- Use the **Restrict to roles** field to specify roles required to access the dashboard. Users with any of the specified roles can access the dashboard if they have been given access to the dashboard on the dashboard Share pane.

**Limitations**

- The mobile apps do not give access to dashboards as dashboards are not optimized for mobile screen sizes. You can access dashboards on a tablet using the standard web interface.

**Related information**

- Enable responsive dashboards
- Differences between homepages and responsive and non-responsive dashboards
- Set dashboards as your Home
- Browser support

**Create or configure a responsive dashboard**

Create a dashboard where you can add Performance Analytics widgets and other widgets that you frequently use. You can then share the dashboard with other users.

**Before you begin**

Users with any role can create responsive dashboards.

**Procedure**

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. Click **New**.
3. Fill in the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the dashboard.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter an Order number to indicate the order the dashboard appears on the dashboard picker. Dashboards with lower numbers are listed first.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this field to mark the dashboard inactive. Inactive dashboards are visible on the Dashboard Overview page and in the dashboard picker only to the owner, and users with the dashboard_admin and admin roles. Users with the dashboard_admin role have full view, edit, delete, and share privileges on all dashboards in the instance, including inactive dashboards.</td>
</tr>
<tr>
<td>Owner</td>
<td>The dashboard owner. Only a user with the administrator role can change this value.</td>
</tr>
</tbody>
</table>

4. **Optional:** Click the **Restrict to roles** edit icon (📝) to specify the roles that a user must have to access this dashboard.
For more information, see Share a responsive dashboard.

5. **Optional:** Users with admin, pa_admin, and pa_power_user roles can configure these additional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group</strong></td>
<td>Click the magnifier icon to add the dashboard to a <strong>Group</strong>. Groups organize dashboards in the dashboard picker list. Grouped dashboards appear at the top of the list. Ungrouped dashboards appear in the list under <strong>Other</strong>.</td>
</tr>
<tr>
<td><strong>Breakdown Source</strong></td>
<td>Select one or more breakdown sources in the <strong>Breakdown Source</strong> related list. Breakdowns enable users to filter Performance Analytics data on the dashboard. The <strong>Breakdown Source</strong> related list is available on the Dashboard form after you create the dashboard. For more information, see Using breakdowns on dashboards.</td>
</tr>
<tr>
<td><strong>Act as filter</strong></td>
<td>You can configure a breakdown on a dashboard to act as an interactive</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>filter for reports on the dashboard. Select the interactive filter you want this breakdown source to act as.</td>
<td></td>
</tr>
</tbody>
</table>

6. Click **Submit**.

![Dashboard interface](image)

**Results**
The dashboard is created with no content. To add your first content, select a widget type and a widget and click **Add**.

**What to do next**
Add more content to your new dashboard. For more information, see **Edit a responsive dashboard**.

**Related information**
- Performance Analytics breakdowns
- Add a breakdown to a dashboard
- Organize dashboards into groups

**Create a dashboard version of a homepage**
To take advantage of responsive dashboard functionality, you can migrate existing homepages to dashboards.
Before you begin

Users with any role can copy their own homepage to a dashboard. Users with the admin role can create dashboard versions of any homepage. Advantages of dashboards include:

- Responsive design — The widgets on a dashboard are optimized for the screen you are using: desktop, tablet, or mobile phone.
- Drag-and-drop widgets — You can add dashboard widgets precisely where you want them and rearrange the dashboard with easy to use tools.
- Shareability — You can share dashboards easily with users, roles, and groups.

About this task

When you create a dashboard version of a homepage, the content is added to the new dashboard, but these converted dashboards do not retain the permissions that were associated with the old homepage. To apply permissions to the dashboard, specify the permissions again. Users who you share a dashboard may or may not be able to edit the dashboard or share it with others. The ability to edit or share a dashboard is based on the user's role and the permissions granted to them.

Note:

You can convert any home page that you can access through home.do. It is not possible to convert manually coded UI pages that utilize the homepage layout system, but are not accessible through home.do.

Homepages with layouts that include scripts or style sheets might not work or might not look as you expect them to after conversion. This is because Jelly is not evaluated during conversion. Jelly, a tool for turning XML into executable code, is used in many homepage scripts.

When you convert a homepage to a dashboard, the dashboard is independent of the homepage. Changes you make to the dashboard do not migrate to the source homepage. In addition, changes that you make to the homepage after conversion do not migrate to the dashboard.

Procedure

1. Enable responsive dashboards. For more information, see Responsive dashboard properties.
2. Navigate to Self-Service > Homepage.
3. From the list, select the homepage you want to copy.
4. Click the Homepage settings icon 🛡️ and choose Create Dashboard Version.

5. Select Create new dashboard or Add to existing dashboard and click Create. The Add to existing dashboard list contains only the dashboards you own. If you select this option, the homepage is added as a tab to the existing dashboard.
Results
When successful, the dashboard version opens as a new dashboard or as a tab on the selected dashboard.

⚠️ Note: The layout of the dashboard version is similar to the homepage layout but may not be precisely the same.

⚠️ Note: Homepages with dashboard versions show a button with the text Open Dashboard Version. This button takes the user to the most recently created dashboard version of the homepage.

What to do next

• Navigate to Self-Service > Dashboards to view all of your dashboards. You can view all dashboards that you have the rights to view, dashboards owned by you, and dashboards shared with you. Use the Search box to search for dashboards by name.

• You can share the dashboard version of your homepage with other users. See Share a responsive dashboard.

Solving errors on dashboards created from homepages
Occasionally it is not possible to create a dashboard from a homepage. Follow the instructions for each error to solve these problems.

Entity name must immediately follow the '&-' in the entity reference
When you try to create a dashboard version of a homepage, the following error may occur: ‘The entity name must immediately follow the '&-' in the entity reference’. To solve this error, remove ampersands from the names of the dashboards in the instance or temporarily change the value of the glide.ui.escape_text property.

Before you begin
Role required: security_admin to edit glide.ui.escape_text or admin/dashboard_admin to rename dashboards.

About this task
There are two sources of this error:

• The system property glide.ui.escape_text is set to false.

  Only users with the security_admin role can enable or disable the glide.ui.escape_text property.
There are dashboards in the instance that contain an ampersand (&) in the title.

If any dashboard in the instance has an ampersand in the title, and the `glide.ui.escape_text` property is set to false, then conversion of homepages to dashboards is not possible.

If both of these conditions are met, then the list of dashboards that you can add the converted homepage to does not populate and you cannot convert the homepage.

With the security_admin role, you can temporarily enable this property and convert the homepages in your instance to dashboards.

Procedure

1. Elevate your role to security_admin.
2. In the filter navigator, type `sys_properties.list`.
3. In the System Properties list, find `glide.ui.escape_text` and enable this property.
4. Create dashboard versions of the homepages.
   The dashboard list is shown and you can create dashboard versions the homepages as new dashboards or add the dashboard versions as tabs to existing dashboards.
5. Disable `glide.ui.escape_text`.

Dashboards overview

The Dashboards Overview enables you to choose from dashboards that you have access to, dashboards associated with a single group, or a list of all dashboards. Click a card to open the dashboard.

Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.

Watch this two-minute video to learn more about using the Dashboards Overview. Introduction to the Dashboards Overview page

The Dashboards Overview enables you to show dashboards in one of these categories. By default, the Recent category is selected when you visit the Dashboards Overview.

- **Recent** shows up to nine dashboards that you have visited recently. The most recent are shown first.
- **Owned by me** shows the dashboards that you have created and those dashboards to which you have been assigned ownership.
• **Shared with me** shows the dashboards which have been shared with you as a user, or member of a group or role.

• **All** shows all the dashboards that you have access to.

**Note:** The category you choose limits the dashboard groups and individual dashboards you see when you choose from the **Groups** list and the **Dashboard Picker** search box. If no dashboards in the group you select have been shared with you, then the overview indicates 'No dashboards shared with you match your search.'

All tabs except for the Recent tab are sorted in ascending order by:

1. **Dashboard group — Order**
   
   The owner of the dashboard can specify an order number in the dashboard group's form. This field is optional.

2. **Dashboard group — Name**

3. **Dashboard — Order**

   The owner of the dashboard can specify an order number in the dashboard's form. This field is optional.

4. **Dashboard — Name**

**Dashboards Overview tiles**

Tiles on the overview show thumbnails of the dashboard's widgets, the Dashboard Group, your level of access, the dashboard name, and the dashboard owner. Dashboard access levels are Owner, Editor, and Viewer. For more information, see **Share a responsive dashboard**.

**Note:** When you are prevented from viewing a dashboard widget for any reason, a message specific to the error prompts you to contact the administrator.
Dashboards Overview Groups list
Use the Groups list to show only those dashboards in a single group. Dashboards that don't have a group specified fall under the group Other. The Groups list shows all dashboard groups without applying ACL rules. You may see dashboard groups in this list that have not been explicitly shared with you.

Dashboards Overview search box
Use the search box to search for dashboards by name or group.
Click **New** to create a responsive dashboard.

**Related information**

Working with responsive dashboards

**Find a responsive dashboard**

Use dashboard categories, dashboard groups, and dashboard lists to find the dashboard you want to use.

**Before you begin**

Role required: There are no specific permissions required to view dashboards. However, you must have permission to view at least one dashboard to see the Dashboards Overview and the dashboard picker. For more information about dashboard permissions, see [Solving permissions issues on a responsive dashboard](#).

**About this task**

On the Dashboards Overview, each tile contains information about the dashboard it represents: Thumbnails of the widgets on the dashboard, the Dashboard group, your role on the dashboard, the name of the dashboard, and the owner of the dashboard. Dashboards that are not assigned a group by their creators are assigned the group **Other**.
Procedure

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**. The Dashboards Overview shows tiles representing the most recent dashboards you have visited.

   ![Dashboard Tiles](image)

2. Select a category:

   - **Recent** shows up to nine dashboards that you have visited recently. The most recent are shown first.
   - **Owned by me** shows the dashboards that you have created and those dashboards to which you have been assigned ownership.
   - **Shared with me** shows the dashboards which have been shared with you as a user, or member of a group or role.
   - **All** shows all the dashboards that you have access to.

   All tabs except for the Recent tab are sorted in ascending order by:

   a. Dashboard group — Order
      
      The owner of the dashboard can specify an order number in the dashboard group's form. This field is optional.
   
   b. Dashboard group — Name
   
   c. Dashboard — Order
The owner of the dashboard can specify an order number in the dashboard's form. This field is optional.

d. Dashboard — Name

3. Select a group from the Groups list to filter the displayed tiles on a dashboard group. If no dashboards match the combination of category and group, a message is shown, for example, 'No dashboards shared with you match your search.'

The Groups list shows all dashboard groups without applying ACL rules. You may see dashboard groups in this list that have not been explicitly shared with you.

4. Type a string in the Search by name or group box to filter the dashboards further. For example, type complete to search for the Completeness dashboards.

5. Click a dashboard tile to open that dashboard.

6. On any open dashboard, click the grid icon ( ) to return to the Dashboards Overview.

7. To find another dashboard, click the arrow next to the dashboard name to open the Dashboard Picker. You can:

   • Type a string in the Search by name or group box to filter the list.

   • Click the Dashboard Group selector to filter the list on a specific dashboard group.

     The Dashboard Group selector shows all dashboard groups in the instance. If you do not have permission to view any dashboards in a selected group, you will see the message, 'No dashboards shared with you match your search.'

   • Scroll through all dashboards you have permission to open, starting with the most recent that you have viewed.
8. Select the name of a dashboard to replace the current dashboard with the new one.

**Edit a responsive dashboard**

You can edit the contents of a dashboard, including Performance Analytics widgets, reports, and tabs. Because dashboards are shared, any modifications you make are applied globally.

**Before you begin**

Users can edit dashboards that they own, or ones that they have the right to edit. See Dashboard permissions for more information about viewing and editing rights on dashboards.

ℹ️ **Note:** Responsive dashboards do not support the Sticky Notes widget.

**Procedure**

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. From the dashboard picker, select the dashboard that you want to edit.
3. Perform any of the following actions.
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Add a widget                | a. Click the plus sign (+) to put the dashboard in edit mode.  
|                             | b. From the list, select the type of widget that you want to add, for example, Performance Analytics, Report, or Content Block.  
|                             | c. Select the widget. A preview of the widget appears.  
|                             | d. Click Add. The widget appears at the top of the dashboard.  
|                             | e. Drag to move the widget or resize it.  
|                             | ⚠️ Note: Report titles are not automatically translated on localized ServiceNow instances.                                                |
| Delete a widget from the dashboard | a. Click the plus sign (+) to put the dashboard in edit mode.  
|                             | b. Point to the top of the widget, then click the X icon (×) that appears.  
|                             | ⚠️ Note: There is no confirmation message. The widget disappears from the dashboard.                                                   |
| Configure widget layouts    | To change widget appearance and layouts, and show and hide widget headers, see Configure widget layouts.                                  |
| Edit a widget               | a. Click the plus sign (+) to put the dashboard in edit mode.  
<p>|                             | b. Point to the widget, then click the pencil icon (✏️). This icon is available only if your roles give you access to the widget's source. Edit rights to a dashboard do not necessarily give you edit rights to the widgets on that dashboard. |</p>
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The widget opens in the tool where it was created. For example, when you edit a report widget, the source report opens in the Report Designer.</td>
</tr>
<tr>
<td></td>
<td>Click the configuration icon ( ) to open the Configuration pane, then click a layout to snap the widgets against. Modify the layout as desired.</td>
</tr>
<tr>
<td></td>
<td>Click the configuration icon ( ) to open the Configuration pane, then click <strong>Create Tab</strong>. The panel created with the dashboard becomes the dashboard's first tab. The default names of the tabs are the name of the dashboard followed by New Tab and New Tab 2. To change the default names, see <strong>Rename a tab</strong> in this table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot link an existing tab into a dashboard.</td>
</tr>
<tr>
<td></td>
<td>a. Click the plus sign ( ) to put the dashboard in edit mode.</td>
</tr>
<tr>
<td></td>
<td>b. Select the dashboard tab and drag it to the desired position. Alternatively,</td>
</tr>
<tr>
<td></td>
<td>a. Click the context menu ( ) and select <strong>Dashboard Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. On the <strong>Dashboard Tabs</strong> related list, enter numbers in the <strong>Order</strong> column to specify the tab order. Tabs display from left to right with lower numbers appearing first.</td>
</tr>
<tr>
<td></td>
<td>Click the tab to make it active. Point to the tab name and click the trash icon that appears.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The dashboard tab no longer appears on any dashboards where it appeared. Dashboards may have tabs that appear in multiple dashboards.</td>
</tr>
<tr>
<td>Action</td>
<td>Steps</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Rename a tab                  | **a.** Click the tab to make it active.  
**b.** Point to the tab name and click the pencil icon that appears.  
**c.** Type the new name then press Enter.  

**Note:** If you rename a tab on a dashboard that has been translated, the translations are replaced with the new English tab name. To translate the new name:  
**a.** Click the gear icon (⚙️) to open the System Settings.  
**b.** On the **General** tab, select the target language.  
**c.** On the translated dashboard, rename the tab with the translation of its new name. |
| Enable filtering of data for report widgets | Interactive filters let users filter data for all report widgets on a dashboard that follow them.  
**a.** Click the plus sign (➕) to put the dashboard in edit mode.  
**b.** From the list, select **Interactive Filters**.  
**c.** Navigate to the filter you want to add.  
**d.** Click **Add**.  
For more information, see **Interactive Filters**. |
| Configure a report widget to follow interactive filters | **a.** Point to the report widget, then click the gear icon (⚙️).  
**b.** In the Edit Widget window, select the **Follow interactive filter** check box.  
**c.** To show a filter icon (🔍) on the report when it is following an interactive filter, select the **Show when following** check box.  

**Note:** Performance Analytics widgets cannot follow interactive filters. |
Enable filtering of data for Performance Analytics widgets

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Click the plus sign (+) to put the dashboard in edit mode.</td>
<td></td>
</tr>
<tr>
<td>b. Add a breakdown to a dashboard so that users can filter data for all Performance Analytics widgets on that dashboard. Only users with the pa_admin or pa_power user roles can work with breakdowns.</td>
<td></td>
</tr>
</tbody>
</table>

See Add breakdown sources to a dashboard.

View the description of a widget

Point to the widget, then click the question mark (?). If the widget does not have a description, the question mark icon does not appear.

Related information

Share a responsive dashboard

Configure widget layouts

You can change the appearance of widgets; change widget layouts; change the widget title, header, and background color; and show or hide widget headers.

Before you begin

Users can edit dashboards that they own, or ones that they have the right to edit.

Note: Responsive dashboards do not support the Sticky Notes widget.

Procedure

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. From the dashboard picker, select the dashboard that you want to edit.
3. Click the plus sign (+) to put the dashboard in edit mode.
4. Perform any of the following actions.
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **Show or hide the widget border, header, and title** | **a.** Point to the widget, then click the gear icon (🔧).  
**b.** In the Edit Widget window, select or clear the boxes to show or hide the border, header, and title.  

**Note:** If you hide the header, point to the handlebar at the top of the widget to show the icons.  
**c.** To align the title, select **Left**, **Center**, or **Right**. |

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **Change the widget title color and header color** | **a.** Point to the widget, then click the gear icon (🔧).  
**b.** In the Edit Widget window, click the color picker icon (◮◯) for Title color or Header color.  
**c.** In the color picker, use the slider to choose a hue and select a color to choose it. You can also enter the hexadecimal code for the color in the **Title color** or **Header color** field. Delete the hexadecimal code to return to the default title or header color.  

When you hide the widget header, no header icons are visible, including the icon indicating that you have applied an interactive filter to the widget. |
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize or change the layout of widgets</td>
<td><img src="image" alt="Note:" /> When you select a dark header color, the icons in the header change to white. When you select a light header color, the icons in the header change to black.</td>
</tr>
<tr>
<td></td>
<td>a. Drag to move and resize widgets.</td>
</tr>
<tr>
<td></td>
<td>• To make a widget larger, point to the widget header and then click the resize icon ([↵]).</td>
</tr>
<tr>
<td></td>
<td>• To make a widget smaller, point to the widget header and press SHIFT as you click the resize icon.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note:" /> The background color applies to all tabs on the dashboard.</td>
</tr>
<tr>
<td>Apply a dashboard background color</td>
<td>a. Click the configuration icon ([↵]) to open the Configuration pane.</td>
</tr>
<tr>
<td></td>
<td>b. Click the color picker icon ([획 ]) for Dashboard Background and select the color to use. Use the slider to choose a hue and click a color to select it. You can also enter the hexadecimal code for the color in the Dashboard Background field. Delete the hexadecimal code to return to the default background color.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note:" /> The background color applies to all tabs on the dashboard.</td>
</tr>
<tr>
<td>Apply a quick layout to a dashboard</td>
<td>a. Click the configuration icon ([↵]) to open the Configuration pane.</td>
</tr>
<tr>
<td></td>
<td>b. Click a layout to snap the widgets against. Resize or change the layout of widgets as desired.</td>
</tr>
<tr>
<td>Action</td>
<td>Steps</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Delete a widget from the dashboard | a. Click the plus sign (➕) to put the dashboard in edit mode.  
b. Point to the top of the widget, then click the X icon (✗) that appears.  

Note: There is no confirmation message. The widget disappears from the dashboard. |

5. Optional: Add content blocks to divide the content of the dashboard or to provide other content. From the Add Widgets list, select Content Blocks. For information about static content blocks, see Configure a static HTML block.

**Share a responsive dashboard**

Share a dashboard with other users to create a shared view of data that you can use to collaborate. You can give other users viewing rights or both viewing and editing rights.

**Before you begin**

- Users can share dashboards that they own with other groups and users.
- Only users with the admin, dashboard_admin, pa_admin, or pa_power_user role can see roles in the Sharing panel.
- Users with the pa_admin or pa_power_user role can share dashboards that they can edit.
- Users with the admin role can share any dashboard they can access.

Administrators can set two properties that affect how users share responsive dashboards:

- **glide.cms.share_dashboards.role**
  
  In this system property, the admin can specify a comma-separated list of roles that can share their own dashboards.
  
  Note: If one role in this list is misspelled, that role will not be able to share dashboards. If there is only one role in this list and that role is misspelled, no user will be able to share dashboards until the value for this property is corrected.

- **glide.cms.dashboards.sharing_with_secure_search**
In this system property, the admin can specify that security rules are applied to the lists of users, user groups, and roles that are visible when users share responsive dashboards. Only users with one of these roles can see roles in the Sharing panel: admin, dashboard_admin, pa_admin, and pa_power_user.

For more information, see Dashboard permissions.

About this task
In general, when you share a dashboard, you are not granting permission to the widgets on that dashboard. Most Performance Analytics widgets, however, inherit security rules from the dashboards where they have been added. If you can view a dashboard, you can see the Performance Analytics widgets on that dashboard.

Note: Performance Analytics List widgets do not show the indicators that you do not have permission to read. While the dashboard permission applies to the whole Performance Analytics list widget, individual indicators in the widget follow the permissions for those indicators. For more information about indicator permissions, see Control access to an indicator.

Note: When domain separation is enabled and the system property glide.security.admin.override.accessterm is not selected, admins must be in the same domain as the dashboard to share it. See Evaluate the admin override at the access level.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard that you want to share from the dashboard picker on the top left.
3. Click the Sharing icon (↑) to open the Share panel.
4. Click Add groups and users (➕). Users who have the admin, pa_admin, dashboard_admin, or pa_power_user roles can also see roles on the Share panel.
5. Start typing the name in the To field.
6. Select a user, group, or role from the displayed list.
7. From the Recipients list, select Can view or Can edit to specify the permissions the user, group, or role has on the dashboard. When a person you have shared the dashboard with goes to the Dashboard Overview, they see either Viewer or Editor as their role on the dashboard.
**Note:** To edit a shared dashboard, a user must be in the same domain as the dashboard. Sharing a dashboard with write access (Can edit) does not change that. The Can edit option only works if the dashboard is shared with a user in the same domain as the dashboard. For more information, see Domain separation and Dashboards.

8. **Optional:** Clear the **Send an email invitation** check box. You can choose not to send an email message. For example, when recipients already know the dashboard has been shared with them.

9. **Optional:** Compose an addition to the default email invitation message. The default email message reads "The dashboard <Name of Dashboard> has been shared with you by <user role>.'" Users with the admin role can edit the default email message. Navigate to **System Notification > Email > Notifications** and open the Dashboard Sharing Notification. For more information, see Create an email notification.
10. Click **Share**.

**Results**

The dashboard is shared and, if specified, an invitation is sent to the invited users.

**Manage responsive dashboards**

Depending upon their role, users can delete or duplicate responsive dashboards, and remove a user from a dashboard. All users can mark a dashboard as a favorite.

**Delete a responsive dashboard**

Delete dashboards that are no longer used. Deleted dashboards cannot be restored.
Before you begin
Role required: dashboard_admin or admin, or be the owner of the dashboard.
Inform any users you have shared the dashboard with that you are deleting it. Users may have bookmarked the dashboard or marked it as a favorite. Those users see an error when they try to access a deleted dashboard.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard you want to delete.
3. Click the context menu (≡) and choose Delete Dashboard.

Results
When you delete a dashboard, dashboard tabs that are not used on other dashboards are deleted.

What to do next
Delete a dashboard tab
When dashboard tabs are no longer useful, it is possible to delete them.

Before you begin
To delete a dashboard tab, you must have edit rights on the dashboard.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard containing the tab you want to delete.
3. To delete a dashboard tab, point to the tab and click the trash icon.

Results
When you delete a dashboard tab, it is removed from the dashboard. If it is not used in any other dashboard, it is deleted entirely.

Copy a responsive dashboard
When you duplicate a responsive dashboard, its widget layout is preserved. However, sharing permissions are not preserved. Changes you make to the duplicated dashboard do not affect the original dashboard.
Before you begin
Any user who can share a dashboard can copy it.
To copy a dashboard associated with an Analytics and Reporting Solution, see Duplicate an Analytics and Reporting Solution dashboard.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard that you want to duplicate.
3. Click the context menu (≡) and select Duplicate Dashboard. A copy of the dashboard is created with you as the owner. The name of the copy is Copy of [Original Dashboard Name].
4. Optional: To rename the dashboard, click the context menu (≡), select Dashboard Properties, and edit the Name field.

Results
A copy of the dashboard is created with you as the owner.

What to do next
Modify the dashboard and then share it with other users.

Remove a user from a dashboard
When you no longer want to share a dashboard with a specific user, group, or role, you can remove their access to the dashboard.

Before you begin
Role required: Any dashboard owner can remove users or groups from dashboards they own.

Users with the dashboard_admin or admin role can remove users, groups, or roles from any dashboard.

Users with the pa_admin or pa_power_user role can remove users, groups, or roles from any dashboard that they can edit. These dashboards include dashboards that a user owns, and dashboards to which they have been granted edit rights.

For more information, see Dashboard permissions.
Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard you want to modify.
3. Click the sharing icon (↑).
4. In the Share panel, select the user, group, or role that you want to remove.
5. On the information panel of the user, group, or role, click Remove From Dashboard.

Results
The removed users no longer have the right to view the shared dashboard.

Related information
Restrict responsive dashboard access to specific roles

Mark a responsive dashboard as a favorite
You can mark a dashboard as a favorite to access it easily from the navigation pane.

Before you begin
Anyone who can access a dashboard can make it a favorite.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. From the dashboard picker, select the dashboard that you want to mark as a favorite.
3. Click the context menu (≡) and select Create Favorite.

Results
Favorite dashboards appear in the favorites tab of the Application Navigator.

Filter dashboards on breakdown elements
Some dashboards let you apply one or more Performance Analytics breakdown elements to filter the entire dashboard. For example, you can show only high and critical priority items or only the teams that report to a certain manager.
Before you begin
You must have a dashboard already created with the Performance Analytics that you want to filter by breakdown element. Dashboards that have been configured in this way are called breakdown dashboards.

Role required: None

About this task
To filter a dashboard on breakdown elements, such as priorities or categories, select the breakdown source and then select elements within that breakdown source. Reports and appropriately configured Performance Analytics widgets reflect the filter when it is applied. If you select multiple elements, Performance Analytics shows the values associated with those elements as an aggregation or as separated elements, depending on how each Performance Analytics widget is configured. For more information about configuring breakdown dashboards and their widgets, see Using breakdowns on dashboards.

Note: For performance reasons, there is no option to select all breakdown elements.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard that you want to filter by breakdown elements.
3. Select a breakdown source from the list in the upper left.
4. In the Select Elements list, select the element or elements you want to filter on and click Apply. The widgets on the dashboard that can be filtered are filtered on the selected elements. Next to their titles, filtered widgets show a filter icon.

Note: If element security settings prevent you from seeing one or more selected elements, a warning appears.

5. Click Selected to show only the selected breakdown elements. Click All to show all breakdown elements in the list.

6. Click Sort to sort the list of elements in alphabetical order. The direction of the triangle indicates a-z or z-a.

7. Click on a data point to show the indicator and breakdown elements in the Analytics Hub. Access to the Analytics Hub requires the pa_viewer role.

Targets, thresholds, and comments are not available when you navigate to the Analytics Hub from a widget with multiple breakdown elements selected in an aggregate view. The breakdown selector and search functionality are also unavailable. For more information about aggregate and separate views of multiple elements in a widget, see Configure widgets for breakdown dashboards.

8. Click Clear all to remove the selected elements and show the breakdown widget with all elements.

Disable multiple element selection on a dashboard

Dashboard owners have the option to disable multiple element select on an entire breakdown dashboard.

Before you begin
Role required: admin
About this task
When you disable multiple element selection on a breakdown dashboard, users of that dashboard are only able to filter the dashboard's widgets on one element of the breakdown.

Procedure

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.

2. Select the breakdown dashboard that you want to filter by only one breakdown element at a time.

3. From the context menu, select **Dashboard Properties**.

4. Select **Disable multiple element selection**. This option is available when there is at least one breakdown source in the dashboard's Breakdown Source related list.

5. Click **Update**.

Results
When you filter the dashboard on breakdown elements, you can select only one breakdown element. The widgets on the dashboard follow the single breakdown element selected. When you select elements or clear selected elements, you have to click **Apply** to make this choice.
Export a responsive dashboard to PDF

Export a dashboard as a PDF so you can archive, print, or distribute it.

Before you begin
Roles required: No role is required to export dashboards to PDF, however, an admin has to configure the instance for PDF export. See Enable PDF export of dashboards and homepages for more information.

About this task
Interactive filters that are applied to the dashboard are also applied to the PDF. However, applied breakdowns are not included in the export.

Note: To generate the PDF locally, set the interactive filters, click the settings icon, and choose Printer Friendly Version to open the dashboard in a new window or tab. Export the dashboard using the print settings of the browser.

Limitations:
- Custom content may not generate as expected when exported to PDF. For more information, see Custom content PDF export limitations.
- Dashboards that are exported to PDF do not include the dashboard layout. Widgets are stacked on top of each other and take up the full page width.
- Widgets are exported to a fixed height. Large widgets, such as workbench or list widgets, are truncated.
- Because exporting calendar reports to PDF is not supported, calendar reports exported from a dashboard may be truncated.
- Breakdowns applied to a dashboard are not included in the PDF.
- Widgets may appear in a different order than on the dashboard.
- Widget legends may not appear.
- Coloring on the delta text for single score report widgets is not preserved.
- When you select the Show date range selector at the widget level, the PDF does not reflect the selected time frame.
Note: PDFs that are sent as emails may not be generated immediately.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. From the dashboard picker in the upper left, select the dashboard that you want to export.
3. Click the context menu (⋮) and select Export to PDF.
4. Configure your print and delivery options.

Export to PDF
- Dashboard tabs: Print all tabs
- Orientation: Portrait, Landscape
- Paper size: Letter
- Delivery: Generate now, Send as an email

5. Click Export.

Results
The content is exported to PDF according to the print and delivery options. If the PDF does not generate, identify and resolve any JavaScript errors.

Export a dashboard using the browser's print function
It's possible to export any dashboard or homepage to PDF using your browser's print functionality.

About this task
You can use your browser's print functionality to export a PDF on demand, and to export a PDF with applied breakdowns. In scheduled PDFs, breakdowns are not applied to the data.
Procedure

1. Open the dashboard you want to export.
2. Set the interactive filters.
3. Click the settings icon.

4. In the System Settings pop-up, click the **Printer friendly version** icon (/favicon/).

A browser tab opens with the dashboard's widgets stacked one on top of another.

5. In the new browser tab, select the tab to print, the page size, and the page orientation.

6. Click **Print**.

7. In your browser's Print dialogue, select PDF as the print destination or output.

Results

The dashboard tab is exported to PDF with your chosen page size and orientation.
Copy a responsive dashboard URL

It is not possible to copy a dashboard URL from the browser. You can, however, create a URL that opens the current view of the dashboard, including tabs and breakdown elements. When the link is followed, the ServiceNow platform frame around the dashboard is not included.

Before you begin
You must be able to access the dashboard.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the responsive dashboard with the URL you want to copy.
3. Optional: Select a specific tab, breakdown, and breakdown element.
4. Click the context menu (≡) and select Copy Dashboard URL.

Results
The dashboard URL is copied to your clipboard. Some browsers prompt you to manually copy the URL to your clipboard.

What to do next
Share the URL with other users.

Dashboard URL format
It is possible to link to a Performance Analytics dashboard from your instance. Several URL parameters enable you to specify aspects of the dashboard when the link is followed.

All dashboard URLs follow this format:

https://<instance>.service-now.com/$dashboards.do?

Note: Because dashboards are not limited to users of Performance Analytics,

$dashboards.do

replaces

$pa_dashboard

, although both strings work in dashboard URLs.
This base URL is followed by several optional URL query parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_dashboard=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard to show.</td>
</tr>
<tr>
<td>sysparm_tab=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard tab to show. If you do not specify a tab, the leftmost tab is displayed. This parameter applies only if sysparm_dashboard exists.</td>
</tr>
<tr>
<td>sysparm_breakdown_source=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard breakdown to show.</td>
</tr>
<tr>
<td>sysparm_element=&lt;value&gt;</td>
<td>The sys_id or value of breakdown element to show. This parameter applies only if sysparm_breakdown_source also exists. Values are case-sensitive.</td>
</tr>
<tr>
<td>sysparm_element_value=&lt;value&gt;</td>
<td>The selected element value. This value may be the sys_id of a referenced record, or the database value for a choice list choice. Database values are case-sensitive. This parameter applies only if sysparm_element and sysparm_breakdown_source also exist.</td>
</tr>
</tbody>
</table>
| sysparm_header=<value>                      | Controls if the dashboard header appears. Possible values are:  
|                                              | • Visible — The full header is visible.                                                                                                        |
|                                              | • Hidden — The full header is hidden.                                                                                                         |
|                                              | • Embedded — The header is visible but only the options Refresh, Reset filters, and Export to PDF are visible.                                    |
| sysparm_breakdown=<value>                   | Controls if the dashboard breakdown appears. Possible values are:  
|                                              | • Visible — The full breakdown is visible, including both source and element.                                                                   |
|                                              | • Hidden — The full breakdown is hidden.                                                                                                       |
### URL parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Embedded — Only the breakdown element is visible.</td>
<td></td>
</tr>
<tr>
<td>• Readonly — The breakdown is visible but the user cannot change how the filter is configured.</td>
<td></td>
</tr>
</tbody>
</table>

When linking to your instance from an outside source such as a text document or presentation, use nav_to.do instead. For instructions on constructing this URL, see Navigate to a record or module using a URL.

### Enable real-time updating for single score report widgets

Real-time updates ensure that users viewing a responsive dashboard always see the most up-to-date information.

### Before you begin

You must have edit rights to the dashboard where the widget has been added. Four types of aggregation are available for single-score reports: Count, Average, Sum, and Count Distinct. Real-time updating is available only for single score widgets that use the **Count** aggregation.

> **Note:** Real-time updating does not work for single score report widgets on responsive dashboards under the following circumstances:

- When the report source is a database view, the user must click the Refresh icon on the widget to update the score. For more information, see Database views.
- When a business rule that uses the `current.update()` method fires on insert/update, the single score report increments by two instead of one. For more information, see KB article KB0693812.
- When a widget uses the filter `Assignment group - is (dynamic) - One of My Groups`, the widget does not update in real time. For more information, see KB article KB0749987.

### About this task

You can enable real-time updating for single score widgets on homepages and all dashboards.
Procedure
1. Navigate to the dashboard where the single score widget has been added.
2. Click the plus sign (➕) to put the dashboard in edit mode.
3. Point to the widget, then click the gear icon (⚙️) that appears.
4. Select Show real-time updates then click Done.
5. Click the plus sign (➕) to exit edit mode for the dashboard.
   The real-time icon (⏰) appears on the widget. This icon is permanently visible,
even when the score is not changing.

Change the owner of a responsive dashboard
The owner of a dashboard can edit it, and share it with other users.

Before you begin
Role required: Only users with the dashboard_admin or admin role can change
a dashboard owner.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics >
   Dashboards.
2. Open the dashboard whose owner you want to change.
3. Click the context menu (≡) and select Dashboard Properties.
4. Select a new owner in the Owner field.
5. Click Update.

Related information
Share a responsive dashboard
Edit a responsive dashboard

Working with non-responsive dashboards
Non-responsive dashboards have several limitations including who can create,
view, and edit them. Only users with the pa_viewer role can view non-responsive
dashboards. Only users with the admin, pa_admin, or pa_power_user roles can
create and edit them. Non-responsive dashboards use layouts with predefined
dropzones.
### Basic principles, non-responsive dashboards

<table>
<thead>
<tr>
<th>Principle</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboards</td>
<td>Users with any Performance Analytics role can have one or more dashboards assigned for viewing. Users with the pa_admin and pa_power_user role can set up and edit dashboards.</td>
</tr>
<tr>
<td>Tabs</td>
<td>Each dashboard may contain one or more dashboard tabs.</td>
</tr>
<tr>
<td>Rows</td>
<td>A tab can have multiple rows. For each row, you can specify the number of “placeholders” or columns. Each placeholder can hold a widget.</td>
</tr>
<tr>
<td>Widgets</td>
<td>Widgets contain information about one or multiple indicators.</td>
</tr>
</tbody>
</table>

*Note:* The mobile apps do not give access to dashboards as dashboards are not optimized for mobile screen sizes. You can access dashboards on a tablet using the standard web interface.

### Choosing the non-responsive dashboard layout

Click **Change Layout** to select one of the pre-defined dashboard layouts. When you add content, you can choose which placeholder the new content occupies.
Adding content to non-responsive dashboards

Click **Add content** on a non-responsive dashboard to select from a menu of possible items and select the location on the dashboard for the item to occupy. Items include Performance Analytics visualizations, reports, filters, and content blocks. You can fill one or more of the placeholders before closing the window.
Related information

Enable responsive dashboards

Differences between homepages and responsive and non-responsive dashboards

Create or configure a non-responsive dashboard

Create a dashboard to show the most relevant indicators for specific users or groups.

Before you begin

Roles required: pa_admin or pa_power_user

About this task

Watch these four-minute videos to learn how to create a non-responsive dashboard and a non-responsive breakdown dashboard.
Create your first non-responsive dashboard
Create your first non-responsive breakdown dashboard

You can create separate dashboards according to topic, such as for incident management, problem management, or request management. The Owner field is automatically populated. Only a user with the admin role can change the contents of the owner field.

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. From a dashboard, click the unlock icon (🔒).
3. Click the plus (+) icon in the top left.
4. Enter a Name that indicates what the dashboard shows. For example, Incidents Dashboard.
5. Enter an Order number to indicate the order the dashboard should appear on the Dashboards list.
   Dashboards with lower numbers appear before dashboards with higher numbers.
6. Select Active to make the dashboard available in the Dashboards list.
7. Select a dashboard Group to add the dashboard to. Dashboard groups determine how dashboards appear on the dashboard picker.
8. Optional: Select No tabs to disable the tab header.
   Dashboards with the tab header disabled can show only one tab. If you select the No tabs option, you cannot add additional tabs to the dashboard.
9. In the Visible to field, select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>Make the dashboard available to all users with the pa_viewer role.</td>
</tr>
<tr>
<td>Requires Roles</td>
<td>Select the roles a user must have to access the dashboard, in addition to the pa_viewer role.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Users and Groups</td>
<td>Select specific users or groups that can access the dashboard. Users must have the paViewer role.</td>
</tr>
</tbody>
</table>

10. Optional: Select one or more breakdown sources in the Breakdown Source related list. Breakdown dashboards have extra options in the dashboard header to select a breakdown and an element.

Related information
Add breakdown sources to a dashboard
Organize dashboards into groups

Add a tab on a non-responsive dashboard

By default, a dashboard is created with a Home tab. You can create and manage additional tabs to group information in a logical order. Tabs help you to manage information on your dashboard and keep related widgets in the same place.

Before you begin
Role required: pa_admin, pa_power_user, or admin

About this task
For example, the tabs Daily Indicators, Weekly Indicators, and Home could show the key indicators for incident management.

Procedure
1. On a non-responsive dashboard, click Edit.
2. Click the plus (+) icon beside the existing tabs.
3. In the pop-up window, enter a name for the new tab.
4. Perform one of these actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a name for the new tab and click Create tab.</td>
<td>Adds a new empty tab to the dashboard.</td>
</tr>
<tr>
<td>Select an existing tab from a different dashboard and click Link this tab.</td>
<td>Adds the tab to the dashboard. You can share a tab across multiple dashboards.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Select an existing homepage and click Link</td>
<td>Adds the homepage to the dashboard. You can show a homepage within the dashboard.</td>
</tr>
<tr>
<td>this homepage</td>
<td></td>
</tr>
</tbody>
</table>

To add or change content for a tab, click the plus (+) icon at the top left of the tab area.

To change the appearance of a tab, click **Change Layout**.

**Edit a tab on a non-responsive dashboard**

An existing tab can be renamed, reordered, or deleted. Rename a tab when you want to clarify what it contains in a different way; reorder tabs when you want to move tabs with related information closer together; and delete a tab when what it contains is no longer relevant.

**Before you begin**

Role required: pa_admin, pa_power_user, or admin

**About this task**

ℹ️ **Note:** The information on this page applies only to non-responsive dashboards. For information on how to use responsive dashboards, see *Working with responsive dashboards*.

**Procedure**

1. Navigate to the dashboard that you want to modify.
2. Click the **Edit** button.
3. Click the down arrow next to the name of the active tab to see the options for editing the tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Change the name of the tab.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> If you rename a tab on a dashboard that has been translated, the translations are replaced with the new English tab name. To translate the new name:</td>
<td></td>
</tr>
<tr>
<td><strong>a.</strong> Click the gear icon (⚙️) to open the System Settings.</td>
<td></td>
</tr>
<tr>
<td><strong>b.</strong> On the General tab, select the target language.</td>
<td></td>
</tr>
<tr>
<td><strong>c.</strong> On the translated dashboard, rename the tab with the translation of its new name.</td>
<td></td>
</tr>
<tr>
<td>Delete this tab</td>
<td>Delete the tab completely. When deleting the tab, it is also removed from all other dashboards.</td>
</tr>
<tr>
<td>Set as default tab</td>
<td>Make this tab the first tab users see when they select the dashboard. The homepage icon is added before the title of the tab.</td>
</tr>
<tr>
<td>Change tab order</td>
<td>Change the order of the tabs by giving them a number. The tab with the lowest number starts on the left and the tab with the highest number appears on the right.</td>
</tr>
</tbody>
</table>

**Change the layout of a non-responsive dashboard tab**

You can change the layout of a tab to improve the display of information in the same way you change the layout of homepages.

**About this task**

There are several layouts available in the base system.

**Procedure**

1. Click the **Edit** button.
2. In edit mode, click **Change Layout**.
3. In the pop-up window, select one of the available layouts. The layouts include the following options.

- Three columns with two wide columns and a narrow right, left, or middle column.
- Narrow left column, large right column, with a header.
- Minimalist approach to the CMS layout.
- Two columns with wide right column, header and footer.
- Two or three columns of equal width.
- A single cell centered on screen.

4. Click **Change** to apply the new layout to the tab. To revert the change, click **Change Layout** and select the original layout.

Manage non-responsive dashboards

Depending upon their roles, users can modify, delete, or duplicate non-responsive dashboards. Administrators can control access to a dashboard and add a Performance Analytics widget to a dashboard.

Modify, delete, or copy a non-responsive dashboard

You can manage non-responsive dashboards if you have an admin or power user role. Dashboard management includes duplicating or permanently deleting them.

**Before you begin**

Role required: pa_admin, pa_power_user, or admin

ℹ️ Note: Report titles are not automatically translated on localized ServiceNow instances.

**Procedure**

1. Navigate to the dashboard that you want to modify, delete, or copy.
2. Click **Edit** to put the dashboard in edit mode.
3. Click the gear icon at the top right and select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify</td>
<td>Change the basic dashboard settings, as described in .</td>
</tr>
<tr>
<td>Delete</td>
<td>Permanently delete the dashboard.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>Inform any users you have shared the dashboard with that you are deleting it. Users may have bookmarked the dashboard or marked it as a favorite. Those users see an error when they try to access a deleted dashboard.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Create a copy of the dashboard, with the name Copy of &lt;name&gt;. The copy contains all tabs and their content. Widgets are not copied, only widget links are copied.</td>
</tr>
</tbody>
</table>

You can add, delete, rename, and change the layout of tabs in a copy without affecting the original dashboard. However, changing the configuration of a widget on the copied dashboard also affects the original dashboard, since they share widgets. Use the Modify option to change the name and update the look and contents of the dashboard copy.

**Control access to a non-responsive dashboard**

You can control which users, groups, or user roles can access a dashboard.

**Before you begin**

Role required: pa_admin

**About this task**

If users can access a dashboard, they can see all widgets on that dashboard.

**Procedure**

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard you want to give access to.
3. Click Edit.
4. Click the properties icon (⚙).
5. Select Modify.
6. Limit access using one of these options:
• To limit access to users with certain roles, select the roles in the **Required Roles** field.

• To limit access to certain users and groups, select **Users and Groups** in the **Visible to** list and specify which users and groups get access.

**Add a Performance Analytics widget to a non-responsive dashboard**

You can add a widget to a non-responsive dashboard.

**Before you begin**

The dashboard must be in edit mode. To enable edit mode, click **Edit**.

Role required: pa_admin, pa_power_user, or admin

**About this task**

ℹ️ **Note:** The information on this page applies only to non-responsive dashboards. For information on how to use responsive dashboards, see **Working with responsive dashboards**.

Click the plus (+) icon at the top of the tab area to add widgets. A pop-up window appears for choosing which content you want to add to the tab. Content is not limited to Performance Analytics content, but may be from any area.

**Procedure**

1. Select **Performance Analytics** in the category list.

2. Select the type of content to use.
   - Breakdown
   - List
   - Score
   - Time Series
   - Relative Compare

3. Select an existing widget, or select the option to create a new one.

4. Select the desired tab location by clicking the corresponding **Add here** button.

5. You can either add another widget or close the pop-up window. The widget is saved automatically.
Copy the URL of a non-responsive dashboard

It is not possible to copy a dashboard URL from the browser. You can, however, create a URL that opens the current view of the dashboard, including tabs and breakdown elements. When the link is followed, the ServiceNow platform frame around the dashboard is not included.

Before you begin
Role required: pa_viewer

Procedure
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select a dashboard.
3. Optional: Select a specific tab, breakdown, and breakdown element.
4. Click the Copy URL icon (🔗).

What to do next
Distribute the URL to share the dashboard.

Dashboard URL format
It is possible to link to a Performance Analytics dashboard from your instance. Several URL parameters enable you to specify aspects of the dashboard when the link is followed.

All dashboard URLs follow this format:

https://<instance>.service-now.com/$dashboards.do?

Note: Because dashboards are not limited to users of Performance Analytics,

$dashboards.do

replaces

$pa_dashboard

, although both strings work in dashboard URLs.

This base URL is followed by several optional URL query parameters.
# URL parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_dashboard=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard to show.</td>
</tr>
<tr>
<td>sysparm_tab=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard tab to show. If you do not specify a tab, the leftmost tab is displayed. This parameter applies only if sysparm_dashboard exists.</td>
</tr>
<tr>
<td>sysparm_breakdown_source=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard breakdown to show.</td>
</tr>
<tr>
<td>sysparm_element=&lt;value&gt;</td>
<td>The sys_id or value of breakdown element to show. This parameter applies only if sysparm_breakdown_source also exists. Values are case-sensitive.</td>
</tr>
<tr>
<td>sysparm_element_value=&lt;value&gt;</td>
<td>The selected element value. This value may be the sys_id of a referenced record, or the database value for a choice list choice. Database values are case-sensitive. This parameter applies only if sysparm_element and sysparm_breakdown_source also exist.</td>
</tr>
<tr>
<td>sysparm_header=&lt;value&gt;</td>
<td>Controls if the dashboard header appears. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Visible — The full header is visible.</td>
</tr>
<tr>
<td></td>
<td>• Hidden — The full header is hidden.</td>
</tr>
<tr>
<td></td>
<td>• Embedded — The header is visible but only the options Refresh, Reset filters, and Export to PDF are visible.</td>
</tr>
<tr>
<td>sysparm_breakdown=&lt;value&gt;</td>
<td>Controls if the dashboard breakdown appears. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Visible — The full breakdown is visible, including both source and element.</td>
</tr>
<tr>
<td></td>
<td>• Hidden — The full breakdown is hidden.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
When linking to your instance from an outside source such as a text document or presentation, use nav_to.do instead. For instructions on constructing this URL, see Navigate to a record or module using a URL.

**Export a homepage or non-responsive dashboard to PDF**

You can generate a PDF of any homepage or dashboard.

**Before you begin**

Roles required: pa_viewer role is required to export dashboards to PDF, however, an admin has to configure the instance for PDF export. See Enable PDF export of dashboards and homepages for more information.

**About this task**

Some widgets may be truncated on PDF exports. Interactive filters and breakdowns configured as interactive filters and applied to the dashboard are not applied to the PDF exports. Interactive filters are applied when you generate the PDF locally using the browser’s print settings.

To generate the PDF locally, set the interactive filters, click the settings icon (⚙️), and choose Printer Friendly Version to open the dashboard in a new window or tab. Export the dashboard using the browser’s print settings.
Procedure

1. Navigate to a homepage or a dashboard.

2. Click the export to PDF icon ( ) on a homepage or the Export to PDF button on a dashboard.

3. In the Export to PDF dialog box, select formatting options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td>Page orientation of the exported PDF, either portrait or landscape.</td>
</tr>
<tr>
<td>Paper size</td>
<td>Paper size for the PDF. Available sizes match common paper sizes such as Letter and A4.</td>
</tr>
<tr>
<td>Zoom factor</td>
<td>Scaling percentage for the displayed widgets. This value must be a positive number.</td>
</tr>
<tr>
<td>Avoid page break inside widget</td>
<td>Prevents widgets from appearing across multiple pages. Widgets that span multiple pages appear on top of the following page.</td>
</tr>
<tr>
<td>Smart shrink</td>
<td>Automatically selects the necessary zoom factor for all content to fit into the width of the selected paper size.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Delivery</strong></td>
<td>PDF delivery method.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Generate now</strong> generates the PDF immediately and shows a button for downloading.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Send as an email</strong> shows a field for entering an email address. After you click <strong>Export</strong>, the PDF file is generated and sent to the email address.</td>
</tr>
</tbody>
</table>

4. Click **Export**.

5. If you selected the **Generate now** option, wait for the rendering to complete and then click **Download**.

**Results**
The content is exported to PDF according to the print and delivery options. If the PDF does not generate, identify and resolve any JavaScript errors.

**Enable real-time updating for single-score report widgets on a non-responsive dashboard**

Enable single score report widgets on a dashboard to update in real time. Real-time updates ensure that users see the most up-to-date information.

**Before you begin**
You must have edit rights to the dashboard where the widget has been added. Four types of aggregation are available for single-score reports: Count, Average, Sum, and Count Distinct. Real-time updating is available only for single score widgets that use the **Count** aggregation.

**About this task**
You can enable real-time updating for single score widgets on homepages and all dashboards.
Note: Real-time updating does not work for single score report widgets on non-responsive dashboards when a business rule that uses the `current.update()` method fires on insert/update. The single score report increments by two instead of one. For more information, see the Knowledge Base article KB article KB0693812.

Procedure

1. Navigate to the dashboard where the single score widget has been added.
2. Click **Edit** to put the dashboard in edit mode.
3. Point to the widget, then click the gear icon (⚙️) that appears.
4. In the Edit Widget window, select the **Show real-time updates** check box and then click **Done**.
5. Click **Done** to exit the edit mode for the dashboard.

The real-time icon (🕒) appears on the widget. This icon is permanently visible, even when the score is not changing.

Differences between homepages and responsive and non-responsive dashboards

ServiceNow has three ways to share Report and Performance Analytics visualizations with other users.

Responsive dashboard upgrade considerations

Any user, regardless of role, can create new responsive dashboards, share them with other users, and convert homepages to responsive dashboards.

Note: Responsive dashboard functionality is enabled by default from the New York release. If your instance requires non-responsive dashboard functionality, you can disable responsive dashboards.

Compare dashboard types

<table>
<thead>
<tr>
<th>Move and resize widgets</th>
<th>Responsive dashboards</th>
<th>Non-responsive dashboards</th>
<th>Homepages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag to move and resize widgets. Widgets do not dynamically expand to match the content such as</td>
<td></td>
<td>Layouts with drop zones, no custom resizing of widgets.</td>
<td>Layouts with drop zones, no custom resizing of widgets.</td>
</tr>
</tbody>
</table>
## Compare dashboard types (continued)

<table>
<thead>
<tr>
<th></th>
<th>Responsive dashboards</th>
<th>Non-responsive dashboards</th>
<th>Homepages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>a wide or long list</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>widget.</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Lazy loading</strong></td>
<td>Only visible widgets</td>
<td>All widgets load when the</td>
<td>All widgets</td>
</tr>
<tr>
<td></td>
<td>load. More widgets</td>
<td>dashboard is opened which</td>
<td>load when the</td>
</tr>
<tr>
<td></td>
<td>load as the user</td>
<td>results in slower</td>
<td>dashboard is</td>
</tr>
<tr>
<td></td>
<td>scrolls down. For</td>
<td>performance.</td>
<td>opened which</td>
</tr>
<tr>
<td></td>
<td>more information on</td>
<td></td>
<td>results in slower</td>
</tr>
<tr>
<td></td>
<td>the benefits of</td>
<td></td>
<td>performance.</td>
</tr>
<tr>
<td></td>
<td>configurable widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>loading, see</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Optimize widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>rendering time on</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>responsive dashboards.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Preconfigured</strong></td>
<td>Not required.</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td><strong>layouts</strong></td>
<td>On responsive</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>dashboards, you can</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>resize each widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>individually, or apply</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a quick layout.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>All users</td>
<td>Only users with</td>
<td>All users</td>
</tr>
<tr>
<td><strong>dashboards /</strong></td>
<td></td>
<td>pa_viewer role.</td>
<td></td>
</tr>
<tr>
<td><strong>homepages</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Any user with any</td>
<td>Only users with</td>
<td>Any user with</td>
</tr>
<tr>
<td><strong>dashboards /</strong></td>
<td>role.</td>
<td>pa_admin and</td>
<td>any role can</td>
</tr>
<tr>
<td><strong>homepages</strong></td>
<td></td>
<td>pa_power_user roles.</td>
<td>create, but</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>only admins can</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>share.</td>
</tr>
<tr>
<td><strong>Share</strong></td>
<td>Dashboard owners can</td>
<td>Users with pa_admin and</td>
<td>Only admins can</td>
</tr>
<tr>
<td><strong>permissions</strong></td>
<td>share with users,</td>
<td>pa_power_user roles can</td>
<td>assign read and</td>
</tr>
<tr>
<td></td>
<td>groups, and roles.</td>
<td>share.</td>
<td>write roles.</td>
</tr>
<tr>
<td></td>
<td>The ability of users</td>
<td>Users with pa_admin</td>
<td></td>
</tr>
<tr>
<td></td>
<td>to share responsive</td>
<td>and pa_power_user</td>
<td></td>
</tr>
<tr>
<td></td>
<td>dashboards may</td>
<td>roles can edit and view.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>be limited by the</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Compare dashboard types (continued)

<table>
<thead>
<tr>
<th>Responsive dashboards</th>
<th>Non-responsive dashboards</th>
<th>Homepages</th>
</tr>
</thead>
<tbody>
<tr>
<td>administrator. For more information, see Responsive dashboard properties.</td>
<td>Users with pa_viewer role can view dashboards that have been shared with them.</td>
<td></td>
</tr>
</tbody>
</table>

Dashboard headers
Responsive and non-responsive dashboards have different headers. For example, responsive dashboards have three icons that put the dashboard into edit mode. Non-responsive dashboards have an Edit button that enables you to edit the dashboard’s layout.

Set dashboards as your Home
You can set dashboards instead of homepages as your Home. With this setting, the last dashboard you selected appears when you navigate to Self-Service > Homepage, or click the logo on the upper left corner of the platform.

Before you begin
When dashboards are set as your Home, you can no longer navigate to homepages under Self-Service > Homepage or the company logo. The most recently selected dashboard is always loaded. You cannot specify a specific dashboard as your Home. Mark a dashboard as a favorite to easily navigate to the dashboard.
Procedure

1. Click the gear icon (⚙️) to access System Settings.
2. On the General tab, select Dashboards in the Home section.

When you navigate to Self-Service > Homepage, Self-Service > Dashboards, or click your company logo, the last dashboard you selected appears.

Request an analytics service

Request services associated with dashboards, such as to request a new dashboard or access to an existing dashboard.

Before you begin
Role required: none

Procedure

1. Navigate to either Self-Service > Service Catalog or Service Portal > Service Portal Home.
2. If you navigated to the Service Portal, select Order Something.
3. Select the Can We Help You? category.
4. Select Analytics Request.
5. Select the Request type, such as Request dashboard access, Edit a dashboard, or Report an issue.
6. Optional: If you are submitting the request for another user, select the Request on behalf of another user check box and select the user you are making the request for.
7. Provide additional details about your request, such as the name of the dashboard and a description of the changes you want made. Available fields depend on the request type. A notification is automatically sent to the requesting user.

What to do next
After you submit the request, the Analytics team is responsible for reviewing and implementing your requested changes.

Fulfill an analytics request
Analytics service requests are assigned to the Analytics group who can review and fulfill the requests.

Before you begin
At least one user must be a member of the Analytics group.

Role required:
• Fulfiller — itil and pa_admin. The fulfilling user must be a member of the Analytics group which automatically grants these roles.
• Approver — itil and approver_user

Procedure
1. Navigate to Service Desk > My Groups Work.
2. Select a request.
3. If the request is to grant access to a dashboard, select the Dashboard that this request applies to.
4. Select one or more users as the Request Approver. This approver should not be a member of the Analytics group.

Note: No approval is required when the request type is Report an issue.
5. The approver can then approve the request.
   a. Navigate to Self-Service > My Approvals.
   b. Select the request approval.
   c. Click Approve.
      If the approver rejects the approval, the request is closed automatically. If the approver selects an option other than approved or rejected, the fulfiller user can close the request by setting the State to Closed Skipped or Closed Incomplete.
After the request is approved, or if no approval was required, a task is created for the Analytics team. Navigate to the Tasks related list on the request record to view the task. An email notification is sent to the Analytics team.

6. After the approver approves the request, perform the requested changes to fulfill the request. Refer to the dashboards documentation for instructions on how to modify dashboards and dashboard permissions.

7. Update the task State to Closed Complete. The request State is updated automatically when the task is closed. An email notification is sent to the requesting user to inform the user that the requested changes are complete.

Related information

Create and use dashboards
Share a responsive dashboard

Activate the Self-Service Portal for Analytics plugin

You can activate the Self-Service Portal for Analytics plugin (com.snc.pa.bi_service) if you have the admin role.

Before you begin
Role required: admin

About this task
Self-Service Portal for Analytics activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics</td>
<td>Core Performance Analytics functionality</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

**Related information**

**List of plugins (Rome)**

**Administering dashboards**

Learn about administering dashboards including how to group dashboards, how to move a dashboard with an update set, and troubleshooting permissions.

Users with the dashboard_admin role have full access including view, edit, delete, and share permissions on all dashboards in an instance, including all inactive dashboards. To view a list of all dashboards in an instance, navigate to **Performance Analytics > System > Dashboard Administration**. Click on the name of a dashboard to view its form.

The fields on the dashboard's form are described in **Create or configure a responsive dashboard**. Use the related links to:

- Generate dashboard metadata
- View the dashboard
- Launch Dependency Assessment

**Explore and manage dashboards**

Quickly identify the relationships between Performance Analytics elements, such as dashboards, reports, and indicators. Each dashboard tab has customized interactive filters that enable you to refine the information that the dashboard shows. Navigate to **Performance Analytics > Admin Console** and select **Dashboards** or **Dashboard Groups** in the Explore and Manage tile.

**Explore dashboards example**

To see all the automated indicators related to the Incident dashboard group based on the Incident table:

1. Select Dashboard Groups and Incident from the first two lists.
2. Select the **Indicators** tab.
3. From the **Indicator — Table** list, select **Incident** to see only the indicators on the Incident table.

4. From the **Type** list, select **Automated** to see only the automated indicators on the Incident table.

**Dashboard and Dashboard Groups**

Click **Dashboard** or **Dashboard Groups** to view a dashboard that provides information about all the Performance Analytics essentials in your instance:

**Dashboard groups**

A list of all the dashboard groups in your instance. This tab has focus if you select **Dashboard Groups** on the Admin Console. Dashboards that do not have a group specified fall under the group **Other**.

Use the **Visibility** filter to show all dashboard groups, dashboard groups that are visible to everyone, or dashboard groups limited to specified groups and users.

**Dashboards**

A list of all the dashboards in your instance sorted by group. Expand the group to view the individual dashboards. Click the dashboard name to view and edit its details. This tab has focus if you select **Dashboards** on the Admin Console.

**Filters:**

- **Active** — Choose **All**, **Active=True**, or **Active=False**.
- **Dashboard owner** — Choose **All** or select one or more owners from a list.

**Widgets**

A list of all widgets used in your instance’s dashboards.

**Filters:**

- **Type** — Choose **All** or filter on one or more widget types. See **Performance Analytics widgets**.
- **Visualization** — Choose **All** or filter on one or more report visualization types from a list.

**Indicators**

A list of all indicators used in your instance’s dashboards. Filters:

You can filter the list on **Indicator Table**, **Type**, **Frequency**, **Indicator Source**, **Units**, **Direction**, **Scripted**, and **Aggregation Type**. Click
the name of the Indicator or Indicator Source to view and edit its details. For more information, see Performance Analytics Indicators.

**Indicator Sources**

A list of all indicator sources in your instance. You can filter the list on Indicator Table and Frequency. Click the name of the Indicator Source to view and edit its details. For more information, see Indicator sources.

**Breakdowns**

A list of all breakdowns in your instance. You can filter the list on one or more Breakdown Tables. Click the names of the breakdown and the breakdown source to view and edit their details. For more information, see Performance Analytics breakdowns.

**Breakdown Sources**

A list of all breakdown sources in your instance. You can filter the list on one or more Breakdown Tables. Click the name of the breakdown source to view and edit its details. For more information, see Define a breakdown source.

**Jobs**

A list of all jobs created in your instance. The Run column shows how often the job runs. The Time column shows how long the job took the last time it ran. The list also shows whether the job is Active. Click the name of the job to view its details. For more information, see Configure a job indicator.

**Reports**

A list of all reports created on your instance. You can filter the list on one or more Report Tables and one or more Report Types. Click the title of a report to view its details. For more information, see Create a report visualization.

**Interactive Filters**

A list of all interactive filters configured on your instance. You can filter on what tables and fields the interactive filter is based on and one or more UI control types. Click the Look up name to view and edit the details of the interactive filter. For more information, see Interactive Filters.

**Related information**

Tree view navigation
Set dashboards as home for all users
While it is possible for individual users to set dashboards, rather than homepages, you can also set dashboards as home for all users. By default, the most recent dashboard a user has visited is the dashboard they see when they log in to ServiceNow.

Before you begin
Role required: admin

Procedure
1. Navigate to Administration > User Preferences.
2. Create a new user preference with the name my_home_navigation_page.
3. Give the preference the description Set all homepages to dashboards.
4. Required: Leave the User field blank. This is the step that makes the preference universal.
5. Set the Type to string.
6. Set the value to $pa_dashboard.do.
7. Click Submit.

Results
All users see the last dashboard they visited when they log into ServiceNow.

What to do next
Set a specific dashboard as home for all users.

Set a specific dashboard as home for all users
Configure ServiceNow so that all users see the same dashboard when they log in.
Before you begin
Role required: admin

About this task
The dashboard that you configure should be available to all users.

Procedure
1. Configure the user preference `my_home_navigation_page`. For more information, see Set dashboards as home for all users
2. Navigate to the dashboard you want to set as home for all users.
3. From the context menu, select Dashboard Properties.

![Dashboard Properties](image)

4. On the Dashboard Properties form click the context menu again, and select Copy sys_id. Paste the sys_id into a text file so that you can copy it into the property you create.
5. Navigate to Administration > User Preferences.
6. Create a new user preference with the name: `com.snc.pa.ui.preferences_dashboards`.
7. Give the property a meaningful description that you can search for.
8. Check the box labeled System.
9. Required: Leave the User field blank.
   This is the step that makes the preference universal.
10. Set the **Type** to **string**.

11. In the **Value** field, enter the following: `{"last":"dashboard_sys_id"}`, but replace `dashboard_sys_id` with the `sys_id` you copied in step 4.

12. Click **Submit**.

**Results**
All users will see the same dashboard when they open ServiceNow.

**Organize dashboards into groups**
Assign dashboards to groups so that users can find the dashboards they want more easily. Dashboard groups determine how dashboards appear in the dashboard picker when you navigate to **Self-Service > Dashboards**. You can also add view permissions to dashboard groups.

**Before you begin**
Role required: admin, pa_admin, or pa_power_user

**About this task**
Permissions on dashboard groups apply to all the dashboards in that group.

**Note:**
- View permissions on an individual dashboard override the permissions set at the dashboard group level.
- Edit permissions on a dashboard do not affect group permissions.
- Dashboard group permissions do not appear in the dashboard Sharing panel.

To show single groups in the dashboard picker, add the parameter `sysparm_group=` followed by the group name to the dashboard URL. For example, to show only a dashboard group named incident, use the URL `https://<instance>/$dashboards.do?sysparm_group=incident`.

**Procedure**
1. Navigate to **Performance Analytics > System > Dashboard Administration**. Review current dashboards groupings using the **Group** column. Dashboards without groups assigned to them show `(empty)` in the **Group** column. On the Dashboard Overview, these dashboards are grouped as Other.

2. Click the dashboard that you want to add to a group to open its form.

3. In the **Group** field, select a group to add the dashboard to, or click **New** to create a group.
4. **Optional:** Open the form of the dashboard group to modify its permissions.
   Only view permissions can be set on dashboard groups.
   Dashboard groups use standard platform permissions. For more information, see [Access control rules](#).

5. **Click Update.**

**How dashboard and dashboard group permissions interact on responsive dashboards**

Dashboard group and dashboard permissions are not additive. Depending on how permissions are defined on a dashboard, dashboard group permissions may not apply.

If a dashboard belongs to a dashboard group, any view permissions defined on the dashboard override all view permissions on the dashboard group. Permissions on the dashboard group level are not visible from the **Share** panel of a dashboard. When changing the view permissions for a dashboard that is part of a group, always review the permissions for the dashboard group to ensure that users do not lose access. For more information, see [Dashboard permissions scenarios](#).

For example, the dashboard group Support Dashboards contains the dashboards Open Incidents and Incident Metrics. The dashboard group has view permissions for the group Support. When you give view permissions to user John Dee for the dashboard Incident Metrics, the group Support can no longer see that dashboard. View permissions on the dashboard override all view permissions on the dashboard group.

**Move a dashboard with an update set**

Portal pages related to dashboard tabs are not automatically transferred in update sets. You can add portal pages to update sets from a dashboard record using the **Unload Dashboard** function. The **Unload Dashboard** function unloads the entire dashboard with all related tabs, including portal pages.

**Before you begin**

Role required: admin

**About this task**

This procedure describes moving the dashboard structure to an update set. The dashboard structure includes the dashboard itself, tabs, the related security configuration, and dashboard-specific widget settings such as header color, and borders.
This procedure does not move the content of the dashboard (such as reports, PA widgets, content blocks, and other widgets) to the update set. You can add dashboard content to the update set using default platform functionality.

⚠️ **Note:** Make sure that the dashboard content is either in the same update set as the dashboard record or is already present in the target instance. Errors result if the moved dashboard points to content that does not exist on the target instance.

### Procedure

1. In the source instance, navigate to the location of the dashboard you want to unload, for example, **Self-Service > Dashboards**.
2. Select the dashboard you want to unload to an update set.
3. Verify that there is a portal page record associated with each tab.
   a. Click the context menu icon (≡) and select **Launch Dependency Assessment**.
   b. Point to the corner of the dashboard tab’s tile and click the info icon (ⓘ) to see the associated portal page.
4. Click **Open Record** to open the dashboard record.
5. Click the context menu icon (≡) and select **Unload Dashboard**.
   Only perform this step once the dashboard is ready to unload, meaning that you have added all content to the tabs.
6. When you are ready to move the update set, mark the update set as complete.
7. On the target instance, move the update using standard update set functionality. For more information, see **Retrieve an update set**.
On the Remote Instance page, the **Retrieved Update Sets** related list shows all retrieved update sets. Click the update set to see if there are errors. Errors are shown on the **Retrieved Update Set** form in a related list called **Update Set Preview Problems**. See [Solving errors on dashboards moved with update sets](#).

8. On the target instance, make sure that all the tabs of the dashboard have associated portal pages. See [Validate that tabs are moved to a target dashboard](#).
If the portal page is missing in the Tab form, click the search icon (🔍) next to the **Page** field to search for the associated portal page.

**Note:** If you cannot find the associated portal page in the target instance, follow these steps to move each missing portal page through the update:

a. Navigate to **Homepage Admin > Pages**.

b. Filter the list to show only the portal page with the sys_id you copied.

c. Right-click the record and select **Unload Portal Page**.

The portal page for the current tab is added to the current update set.

d. Move the update set to another instance using standard update set functionality. For more information, see **Retrieve an update set**.

**Results**
The dashboard and its tabs are moved to the target instance.
Validate that tabs are moved to a target dashboard

When you have moved a dashboard with an update set, validate that the tabs are moved to the target instance and are populated.

Before you begin
Role required: admin

About this task
Moving dashboards from one instance to another requires associating the sys_id values of dashboard tabs with the sys_id values of the associated portal pages. This task explains how to find these values and map them to each other if there are problems with moving the dashboard. Perform this task after you Move a dashboard with an update set.

Procedure
1. In the target instance, navigate to the dashboard you have just moved.
2. Click the context menu icon (≡) and select Dashboard Properties.
3. For each tab in the tab form, verify that the mandatory field Page (sys_portal_page reference) is there. If every tab has an associated portal page then the dashboard was successfully moved.
4. If the portal page in the target instance is missing in any of the tab forms, perform these steps:
   a. Click the context menu icon (≡) in the Tab form and select Copy sys_id.
   b. In the filter navigator of the source instance, enter pa_tabs.list.
   c. Filter the list to show only the tab with the sys_id you copied in substep a.
   d. Click the name of the tab to open its form.
   e. Click the information icon (ℹ️) of the Page value for that tab.
f. On the **Portal Page**, click the context menu icon (…) and select **Copy sys_id**. Paste this value into the text editor. This value is the sys_id for the portal page. It is different than the sys_id for the associated tab that you have already used. These values are used together to map the tab to the portal page.

g. Click the search icon (🔍) associated with the **Page** field.

h. In the pop-up window, filter on the portal page sys_id and select the returned query result.

i. Click **Update** in the Tab form to save your changes.

5. The associated portal page should be visible in the target instance. If you can’t find the portal page in the target, perform the following:

a. In the source instance, navigate to **Homepage Admin > Pages**.

b. Filter the list to show only the portal page with the sys_id you copied.
c. Right-click the record and select **Unload Portal**

![Portal Pages Screenshot](image)

All > Sys ID starts with 369

-  **Title**
-  **User**

-  **Search**
-  **Search**

-  **PA Incident Resol**

-  **Actions on selected rows...**

**Related Links**

-  **Expand Domain Scope**

-  **Show Matching**
-  **Filter Out**
-  **Copy URL to Clipboard**
-  **Copy sys_id**
-  **Assign Tag**
-  **Show Gantt View**
-  **Timeline Visualization**
-  **Unload Portal Page**
-  **View Homepage**
-  **Edit Homepage**
-  **Revert to Store App**
-  **Show Latest Update**

**d.** Move the update set to another instance using standard update set functionality. For more information, see **Retrieve an update set**.

---

**Solving errors on dashboards moved with update sets**

When you move a dashboard with an update set, if errors are shown on the **Update Set Preview Problems** tab of the Retrieved Update Set page, follow the instructions for each error to solve these problems.

**Could not find a record in sys_grid_canvas for column canvas_page referenced in this update**

When you move a dashboard with an update set, the following error may occur: 'Could not find a record in sys_grid_canvas for column canvas_page referenced in this update'. To solve this error, move the canvas page from the source instance to the target instance.

**Before you begin**

Role required: admin
Procedure

1. In the **Update Set Preview Problems** related list, click the information icon (ℹ️) next to the error.

2. In the `pa_tabs` record payload, copy the `sys_id` associated with the `canvas_page` field.

3. In the source instance, navigate to `sys_grid_canvas.list`.

4. Filter the list on the `sys_id` copied in step 2.

5. Right-click on the returned record and select **Unload Canvas Page** to add this record to the current update set.

6. Transfer the update set to the target instance using standard update set functionality. For more information, see **Retrieve an update set**.

7. Repeat this task for all update set preview problems that have this error.

Results
The missing dashboard tab content is moved to the target instance.

Dashboard permissions
Dashboards have special granular view and edit permissions that are managed from the Sharing pane. Access control lists (ACLs) apply to most widgets that are added to dashboards.
- Users with any role can create dashboards, share dashboards that they own with users and groups, and edit dashboards if they have been given edit permissions. Users with any role can restrict access by role to any dashboard that they have created. The user also needs whatever roles are necessary to access the specific data on the dashboards.

- Users without a role can view dashboards that have been shared with them, but cannot create or edit dashboards.

- Users with pa_admin and pa_power_user roles can manage users, groups, and roles on any dashboard that they can edit. For more information, see Performance Analytics roles.

- Users with the dashboard_admin or admin role can edit and manage users, groups, and roles for any dashboard. Admin and dashboard_admin users can also change a dashboard owner at any time.

- Only a dashboard owner and users with the dashboard_admin or admin role can delete that dashboard.

- The ability of users to share responsive dashboards may be limited by the administrator. For more information, see Responsive dashboard properties.

- If Explicit Roles are activated, dashboards are treated as internal resources. Users with the snc_external role cannot view dashboards by default. For more information, see Explicit Roles.

**Note:** The columns Visible to, Groups, Users, and Requires Roles only apply to non-responsive dashboards. The values in these columns do not apply to responsive dashboards.

Widget ACLs apply when that widget is added to dashboards (except for Performance Analytics widgets). If a user can view a dashboard but does not have ACLs to view one of its widgets, an empty widget placeholder is displayed. ACLs do not apply to data visualizations that aggregate data, such as pie or bar reports. ACLs always apply to list data that is displayed in widgets. Rows in a list that a user does not have access to are not displayed.

**Note:** ACLs are not applied to Performance Analytics widgets that are added to dashboards. Any user who can view a dashboard can view all its Performance Analytics widgets. Performance Analytics widgets can only be added to dashboards by users with the pa_power_user, pa_admin, and admin roles.

However, if a Performance Analytics widget displays real-time scores, the score each logged-in user sees depends on their roles and the ACLs of the facts table. For more information, see Real-time scores.
The **Restrict to role** field on the dashboard properties form and dashboard group permissions may have an impact on dashboard permissions. The dashboard owner, and users with `pa_power_user`, `pa_admin`, or `admin` roles can change dashboard properties. Users with the `pa_power_user`, `pa_admin`, and `admin` roles can change dashboard group permissions.

For example, when you add a pie report widget with 36 records to a dashboard, users who can access to that dashboard and that report can view the report of all 36 records. However, if a user drills down into the list view for that widget, only the records the user is allowed to access are visible.

**Related reference**
- Performance Analytics roles

**Related information**
- Restrict responsive dashboard access to specific roles
- Organize dashboards into groups
- Administering reports

**Solving permissions issues on a responsive dashboard**
Dashboard permissions can be set in several different locations.

**Before you begin**
When you find problems with permissions on responsive dashboards, you can review permissions on the Dashboard Sharing panel, group permissions and dashboard properties.

**Procedure**
- Check the permissions on the Dashboard Sharing pane.
  The dashboard owner, users with the `dashboard_admin` or `admin` role, and users with the `pa_power_user` or `pa_admin` role who can edit the dashboard can perform this step.

- Review permissions of the group to which the dashboard belongs. Dashboard group permissions do not show up in the dashboard Sharing panel.
  Users with the `dashboard_admin`, `admin`, `pa_power_user`, or `pa_admin` role can perform this step.

- Compare the dashboard and dashboard group permissions. If permissions are specified on a dashboard, the permissions on the dashboard group are overridden and do not apply.
  Users with the `dashboard_admin`, `admin`, `pa_power_user`, or `pa_admin` role can perform this step.
On the dashboard properties form, review the roles specified in the **Restrict to roles** field. Only users with one of the roles specified in this field can view the dashboard.

The dashboard owner, users with the dashboard_admin or admin role, and users with pa_power_user or pa_admin roles who can edit the dashboard can perform this step. Other users who can edit the dashboard can view this field but cannot edit it.

**Dashboard permissions scenarios**

Permissions on dashboards can be complicated. If you set a permission on a dashboard group, for example, permissions set on a dashboard within that group override it. This matrix shows what is visible based on various combinations of permissions.

The Dashboard permissions scenarios table uses these abbreviations:

- **DB** = Dashboard
- **DG** = Dashboard Group
- **RTR** = Restrict to Roles

For more information, see [Restrict responsive dashboard access to specific roles](#).

- **X** = Unspecified

**Note:** Users with admin and dashboard_admin roles have full permissions on all dashboards.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>DG</th>
<th>DG Permission</th>
<th>DB view permission</th>
<th>DB edit permission</th>
<th>RTR</th>
<th>Who can view the DB?</th>
</tr>
</thead>
<tbody>
<tr>
<td>No DG, no DB permissions</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Only the owner</td>
</tr>
<tr>
<td>Only RTR</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>asset</td>
<td>Only the owner</td>
</tr>
<tr>
<td>Only DB permissions</td>
<td>X</td>
<td>X</td>
<td>itil</td>
<td>X</td>
<td>X</td>
<td>Users with the itil role</td>
</tr>
<tr>
<td>Scenario</td>
<td>DG Permission</td>
<td>DB view permission</td>
<td>DB edit permission</td>
<td>RTR</td>
<td>Who can view the DB?</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------</td>
<td>--------------------</td>
<td>--------------------</td>
<td>-----</td>
<td>----------------------</td>
<td></td>
</tr>
<tr>
<td>DB permissions and RTR</td>
<td>X</td>
<td>X</td>
<td>itil</td>
<td>X</td>
<td>asset</td>
<td></td>
</tr>
<tr>
<td>Only DG without permissions</td>
<td>Exists</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Users with either the pa_admin role OR the pa_power_user role</td>
<td></td>
</tr>
<tr>
<td>DG without permissions and RTR</td>
<td>Exists</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>asset</td>
<td></td>
</tr>
<tr>
<td>Only DG and DG permissions</td>
<td>Exists</td>
<td>itil</td>
<td>X</td>
<td>X</td>
<td>Users with either the itil role OR the pa_admin role OR the pa_power_user role</td>
<td></td>
</tr>
<tr>
<td>DG, DG permissions, and RTR</td>
<td>Exists</td>
<td>itil</td>
<td>X</td>
<td>X</td>
<td>asset</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Dashboard permissions scenarios (continued)

<table>
<thead>
<tr>
<th>Scenario Description</th>
<th>DG, DG permissions, and DB permissions</th>
<th>DG, DG permissions, DB permissions, and RTR</th>
<th>DB view permission</th>
<th>DB edit permission</th>
<th>RTR</th>
<th>Who can view the DB?</th>
</tr>
</thead>
<tbody>
<tr>
<td>DG, DG permissions, and DB permissions</td>
<td>Exists</td>
<td>itil</td>
<td>itil_admin</td>
<td>X</td>
<td>asset</td>
<td>Users with both the itil_admin role AND the asset role</td>
</tr>
<tr>
<td>DG, DG permissions, DB permissions, and RTR</td>
<td>Exists</td>
<td>itil</td>
<td>itil_admin</td>
<td>X</td>
<td>X</td>
<td>Users with the itil_admin role</td>
</tr>
</tbody>
</table>

The default permissions for a dashboard group are pa_admin and pa_power_user. If a permission, such as itil, is specified on the dashboard group, this permission is added to the default permission. Permissions on individual dashboards override the dashboard group permission.

### Restrict responsive dashboard access to specific roles

Specify additional roles required to access the dashboard when you share a dashboard with specified users, groups, and roles. Only users who the dashboard has been shared with and who have one of the specified roles are able to access the dashboard.

### Before you begin

Role required: pa_admin, pa_power_user, admin, or be the dashboard owner. Other users who edit the dashboard can see this field but cannot modify it.

*Note:* Restricting access to a dashboard to specific roles is not the same as sharing the dashboard with those roles. You must share the dashboard before you can restrict access to specified roles. The best practice, however, is to use the Share panel to share with users, groups, and roles. Restrict to roles is not recommended.
The **Restrict to roles** field is available only after responsive dashboards have been enabled. If responsive dashboards have been enabled and then disabled, the **Restrict to roles** field remains available but does not affect dashboard access.

### About this task

When dashboards are migrated between releases, this field is automatically populated with the `pa_viewer` and `pa_contributor` roles to ensure that only users who could access the dashboard before migration can access it afterward.

### Procedure

1. Navigate to the dashboard to restrict to specific roles.
2. Click the context menu (⋮) and select **Dashboard properties**.
3. In the **Restrict to roles** field, specify the additional roles required to access the dashboard.
   Users with any of the specified roles can access the dashboard only if it has been shared with them first from the **Share** panel. For more information, see .

### Results

Only users with the restricted role are able to view the dashboard. A message on the Sharing panel indicates which roles have access. Click the roles in this message to view the properties of the dashboard.

<table>
<thead>
<tr>
<th>Share</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="This dashboard is restricted to the following roles: pa_viewer, pa_contributor" /></td>
</tr>
</tbody>
</table>

**Note:** The ability of users to share responsive dashboards may be limited by the administrator. For more information, see **Responsive dashboard properties**.

### Restrict responsive dashboard sharing by role

You can configure responsive dashboard properties to restrict which users are able to share responsive dashboards.
Before you begin
Role required: admin.

About this task
Configure a dashboard property to specify a comma-separated list of roles that can share their own dashboards. Users with these roles can see the Share icon (➡️) on responsive dashboards.

Procedure
1. Navigate to System Properties > Dashboard Properties.
2. In the field labeled List of roles (comma-separated) that can share their own dashboards, enter the roles. For example, if all users with the itil, asset, and pa_admin roles can share dashboards, enter itil, asset, pa_admin. If this field is empty, users with any role can share their own dashboards.
   If one role in this list is misspelled, that role will not be able to share dashboards.
   If there is only one role in this list and that role is misspelled, no user will be able to share dashboards until the value for this property is corrected.

Results
Users with the specified roles can see the Share panel when they view a dashboard that they own. Users with other roles are not able to see the Share panel.

Note: Properties that restrict dashboard sharing do not apply to users with the admin and dashboard_admin roles. Users with these two roles can always share any dashboard.

What to do next
To apply security rules to what is visible in the Share panel, select the box labeled Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards. For more information, see Restrict responsive dashboard sharing with security rules.

Related information
Share a responsive dashboard
Restrict responsive dashboard sharing with security rules
You can configure the users, roles, and groups that users can see on the Share panel when they share a responsive dashboard.
Before you begin
Role required: admin. To modify the Access Control List, the admin must elevate to the security_admin role. For information, see Elevate to a privileged role.

About this task
Users who can see the Share icon based on the configuration of List of roles (comma-separated) that can share their own dashboards may not see content in the Share panel based on the configuration of the property Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards.

Procedure
1. Navigate to System Properties > Dashboard Properties.
2. Select the box labeled Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards to apply security rules to what is visible in the Share panel.
   The existing security rule configuration for users, user groups and roles is described in their associated read access control list at the platform level. For more information, see Access control list rules.

Results
Only users whose roles are specified in the field labeled List of roles (comma-separated) that can share their own dashboards can share their dashboards. If this property is configured and a user's role is not specified in the property, the user does not see the Share panel. When Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards is enabled, security rules are applied to the list of users, groups, and roles that the user can share their dashboards with in the Share panel.

Related information
   Share a responsive dashboard

Responsive dashboard role examples
Your ability to create, edit, view, or share a dashboard depends on your roles. These examples show what you can do with a dashboard based on your roles.

These descriptions of dashboard roles assume base system functionality. It is possible to create roles and assign permissions that override this functionality.
No role

Users without a role only see dashboards that another user has shared with them. Information on the dashboard, especially list visualizations, may be hidden from the user based on ACLs.

Users without roles cannot create or share dashboards. An admin shared this dashboard with Avery, a user with no role. Much of the data on the dashboard is hidden and there is no sharing option.

Any role

Users with any role can create dashboards and can share dashboards that they create. They can view or view and edit dashboards that are shared with them with the **Can edit** permission. ACLs still apply to what they can view in a dashboard. An admin shared the dashboard with Daniel, a user with the pa_viewer role, with permission to **edit**.
Daniel created this dashboard and therefore they can share, configure, edit, and delete it.

**pa_admin and pa_power_user**

Users with pa_admin and pa_power_user roles can manage users, groups, and roles on any dashboard that they can edit. Marisa has the pa_power_user role. When they click the Sharing icon (🗂️), they see all three options for people to share the dashboard with.

**dashboard_admin or admin**

Users with the dashboard_admin or admin role have these abilities:
- Edit and manage users, groups, and roles for any dashboard
- Change the owner of any dashboard
- Delete any dashboard

Taylor has the dashboard_admin role and selected **Dashboard Properties** from the context menu ( ). Both the **Owner** and **Delete** options are available to them.

---

**Enable PDF export of dashboards and homepages**

To export dashboards and homepages to PDF, a plugin and property are needed.

**Before you begin**
Role required: admin

Activate the WebKit HTML To PDF plugin and configure the to export homepages, dashboards, and some reports as PDF documents.

**Procedure**
1. Navigate to **System Definition > Plugins**.
2. Search for **WebKit HTML to PDF**. Select the plugin to open its form.
3. Click **Activate/Repair**.
   - If the OAuth 2.0 plugin is not already active, the WebKit HTML To PDF plugin activates it as well. For more information, see **Activate a plugin**.

**Results**
Users can export homepages and dashboards to PDF to archive, print, or distribute.

© 2021 ServiceNow, Inc. All rights reserved.
Domain separation and Dashboards

Domain separation is supported in dashboard creation and administration. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response. For more information on support levels, see Application support for domain separation.

Overview

To activate the domain separation plugin, see Request domain separation.

Note: In order for users in child domains to view dashboards in parent domains, both domain separation and delegated administration must be enabled.

Users in child domains cannot overwrite dashboards. Child domain users only have read access to dashboards.

How domain separation works in Dashboards

Assumptions:

- Only dashboards that have been shared are visible to other users. See Share a responsive dashboard.

- Users granted edit permissions on a dashboard can only edit that dashboard if they are in the same domain as the dashboard. For example, a user who is in the HR domain cannot edit a dashboard created in the parent of the HR domain.
Dashboard data that is domain separated includes dashboard records, dashboard tabs, and widget containers. Widget content is governed by the domain separation that applies to the content itself. For example, an admin adds a report created in the HR domain to a dashboard in the IT domain. This dashboard is not visible to users in the IT domain, although they can see the widget container.

A dashboard defined at the global level is visible to all users with whom it has been shared. A shared dashboard created in a parent domain is visible to users in the parent and all its child domains. For example, a dashboard created in the TOP company is visible to users in:

- Joe’s company
- Other companies in the TOP company
- All HR, CS, and IT child domains in those companies if it is shared with those users.

In the following figure, dashboards created in the IT, CS, and HR domain are not visible to users in the other child domains or to users in the parent domain.

![Dashboard Data Table]

**Note:** Administrators should not edit a domain-separated dashboard from the global domain, because additions made to the dashboard are not visible to users within the separated domain. When editing dashboards, make sure that you are logged in to the correct domain.

**Related information**

- Understanding domain separation
- Domain separation recommended practices for service providers
Quick start tests for Dashboards

Validate that Dashboards still work after you make any configuration change such as applying an upgrade. Copy and customize these quick start tests to pass when using your instance-specific data.

Dashboards quick start tests require activating the Automated Test Framework - Responsive Dashboards plugin (com.glide.automated_testing_impl.dashboards). This plugin is active on zboot of the instance.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsive Dashboard</td>
<td>Confirm dashboard sharing by impersonating users.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Responsive Dashboard</td>
<td>Confirm dashboard visibility by impersonating users.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

Related information
Quick start tests

Dashboard URL parameters

Dashboard URL parameters allow you to control the visibility of headers and the breakdown sources of dashboards used in application pages.

Dashboard header
This sysparm_header URL system parameter controls the visibility of the header of the dashboard. It has the following values:

- hidden — The header is hidden on the application page.
- embedded — The dashboard header appears but only has limited options. Options to refresh, reset filters, and export to PDF are available on the context menu.
- visible (default) — The full header is visible on the application page.

<your-servicenow-instance.com>/$dashboards.do?sysparm_dashboard=ABC123&sysparm_tab=123ABC&sysparm_cancelable=true&sysparm_editable=false&sysparm_active_panel=false&sysparm_element=fe654&sysparm_element_value=def456&sysparm_breakdown_source=ghi789&sysparm_homepage_filters=%7B%7B%22table%22:%22incident%22%7D%7D&sysparm_ignore_default_filter=true&sysparm_header=embedded
Dashboard breakdown
The sysparm_breakdown URL system parameter controls the visibility of the dashboard breakdown. It has the following values:

- visible (default) — The full breakdown is visible including source and element.
- hidden — The full breakdown is hidden.
- embedded — Only the breakdown element is visible.
- readonly — The breakdown element is visible but is read only.

Dashboard group
The sysparm_group URL system parameter enables you to include a single dashboard group in the dashboard picker on the Dashboards overview page. This parameter takes only the name of the dashboard group for a value.

Dashboards overview URL parameter
Use the sysparm_group parameter to select the default value of the dashboard group on the Dashboards overview page.

Dashboard group
The sysparm_group URL system parameter enables you to open the All tab of the Dashboards overview page (pa_dashboards_overview.do) filtered by the specified dashboard group. This parameter takes as a value only the name of a dashboard group.

Note: If the dashboard group specified in the URL does not exist, the URL returns the Dashboards overview page with the Recent tab selected.

The example URL shows only the dashboards in the group CMDB Overview.
Optimize widget rendering time on responsive dashboards

Large dashboards can take a long time to render, especially when widgets require complex queries or queries on large tables. You can use system properties to optimize how widgets load.

Before you begin

Note: You can optimize widget rendering only for responsive dashboards.

Role required: admin

Procedure

1. Use these two system properties to optimize dashboard widget rendering:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.canvas.grid.widget_performance_threshold</td>
<td>Defines the maximum number of seconds for a widget to render on a dashboard. Widgets that exceed this time are not rendered and a warning message is shown. Users can click to restart rendering. Stopping widgets that render slowly enables faster widgets to load, and increases the speed of dashboard loading.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: none</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Dashboard Properties</td>
</tr>
<tr>
<td>glide.canvas.grid.widget_render_concurrent_max</td>
<td>Defines the maximum number of widgets that render simultaneously on a dashboard. With smaller values, more requests are made to the server. With larger values, fewer requests are made to the server.</td>
</tr>
<tr>
<td></td>
<td>Note: This property reduces load on the server. It does not necessarily improve performance of individual dashboards.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Widgets that are outside of the screen do not load at all until you scroll past them.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3 if the property is not manually set. The minimum value is 2 if you set the property manually. If you set this property manually to 1 or lower, all widgets on the dashboard load simultaneously.</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Dashboard Properties</td>
</tr>
</tbody>
</table>

The values to use for these properties depend on the performance of your instance and the contents of its dashboards.

2. You can also configure a transaction quota rule. Transaction quota rules enable you to set a maximum execution time for widget or a dashboard.

![Note:]
There are two scenarios for a widget that takes a long time to load:

**Transaction quota value is less than the performance threshold**

If the widget does not load before the transaction quota is reached, the widget does not load. The following message displays: Widget cancelled - maximum execution time exceeded.

**Performance threshold value is less than the transaction quota**

The behavior is the same as if the transaction quota does not exist. The widget stops loading and a message is shown. You can click the widget to reload it. Note that the transaction quota still applies and may halt rendering.

**Related information**

Available system properties
Disable responsive dashboards

If you disable responsive dashboards for an instance, all dashboards become non-responsive dashboards and revert to non-responsive functionality. Disabling responsive dashboard functionality after it has been enabled is discouraged.

Before you begin
Role required: admin

About this task
On upgrade to Rome, all dashboards are responsive. If your instance requires non-responsive dashboard functionality, you can disable responsive dashboards.

When you disable responsive dashboards:

- Sharing permissions that were added while responsive dashboards were enabled are lost and must be manually readded to dashboards. Only dashboard owners will be able to see dashboards that were created after responsive dashboards were enabled. On dashboards that existed before responsive dashboards were enabled, dashboard permissions revert to their pre-conversion state.

- The layouts of dashboards made after enabling responsive dashboards are lost. These dashboards use the default drop zone layout. Dashboards created before enabling responsive dashboards revert to their pre-conversion layout. Any widgets added or removed while the dashboard was responsive are preserved.

- The **Restrict to roles** and **Owner** fields remains available in the **Dashboard Properties** form. However, the **Restrict to role** field does not do anything.

! Note: Switching between responsive and non-responsive dashboards can result in mismatches between the responsive and non-responsive dashboard since changes are not synchronized.

Procedure

1. Navigate to **System Properties > Dashboard Properties**.
2. Clear **Enable responsive dashboard**.

Related information

- Working with responsive dashboards
- Working with non-responsive dashboards
Enable responsive dashboards
A user who has the admin role can enable responsive dashboards for an entire instance. On upgrade to Rome, all dashboards are responsive.

Before you begin
Role required: admin

About this task
During conversion to responsive dashboards, the layout of dashboards may slightly change. Highly customized dashboards may have significant changes, such as different widget layouts. Review each dashboard for changes and adjust its layout as necessary on the drag-and-drop canvas.

Procedure
1. Navigate to System Properties > Dashboard Properties.
2. Under Enable responsive dashboard, select the box labeled Yes | No.
   Clear this box to disable responsive dashboards.

Results
All new dashboards are responsive, and existing dashboards become responsive. Review the layout of all existing dashboards.

Related information
   Working with responsive dashboards

Admin Console for Dashboards
The Performance Analytics Admin Console contains several features for dashboard management.

Explore and Manage
Navigate to Performance Analytics > Admin Console.
The Explore and Manage dashboard contains tools to find, modify, and create dashboards and indicator-related records. Click the links to manage Dashboard Groups and Dashboards.

Advanced Configuration
Navigate to Performance Analytics > Admin Console.
The Advanced Configuration tile on the Admin Console shows a link to Dashboard Properties.
Tree view
The Admin Console tree view enables you to identify and view the relationships between Performance Analytics and Reporting entities in a hierarchy. With the tree view, you don't have to sift through multiple pages to determine how they relate to one another. For more information, see Dependency Assessment.
For more information on Admin Console functionality, see Performance Analytics Admin Console.

Responsive dashboard properties
Use properties to fine-tune dashboard behavior and appearance.

Introduction
Navigate to System Properties > Dashboard Properties to configure the main responsive dashboard properties.

Responsive Dashboard properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable responsive dashboards. glide.cms.enable.resposive_grid_layout                               | • Type: true | false  
|                                                                                                     | • Default value: true  
|                                                                                                     | • Location: System Properties > Dashboard Properties  
|                                                                                                     | For more information, see Disable responsive dashboards.                                                                     |
| Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards. glide.cms.dashboards.sharing_with_secure_search | • Type: true | false  
|                                                                                                     | • Default value: false  
|                                                                                                     | • Location: System Properties > Dashboard Properties  
<p>|                                                                                                     | When enabled, the list of users, user groups, and roles that are visible in the sharing panel is restricted.                |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>The restriction is based on the configuration of the sys_user, sys_user_group, and sys_user_role ACLs. For more information, see Access control list rules. There is a performance penalty associated with enabling this property. Performance degradation may be based on the number and complexity of business rules and ACLs on your instance.</td>
</tr>
</tbody>
</table>
| Specify a comma-separated list of roles that can share their own dashboards. | • Type: string  
• Default value: empty  
When this property is empty, all users can share their own dashboards.  
• Location: System Properties > Dashboard Properties |
<p>| glide.cms.share_dashboards.role | Note: Properties that restrict dashboard sharing do not apply to users with the admin and dashboard_admin roles. Users with these two roles can always share any dashboard. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of seconds for a widget to render on a responsive dashboard. glide.canvas.grid.widget_performance_threshold | • Type: integer  
• Default value: none  
• Location: **System Properties > Dashboard Properties**  
For more information, see **Optimize widget rendering time on responsive dashboards.** |
| Maximum number of widgets that can render simultaneously on a responsive dashboard. glide.canvas.grid.widget_render_concurrent_max | • Type: integer  
• Default value: 3  
• Location: **System Properties > Dashboard Properties**  
For more information, see **Optimize widget rendering time on responsive dashboards.** |
| Number of minutes that responsive dashboard widgets are cached in the browser. glide.canvas.grid.widget_cache_ttl | • Type: integer  
• Default value: 2  
• Location: **System Properties > Dashboard Properties** |

### Custom content PDF export limitations

When you create custom content to be placed as widgets on dashboards and home pages, you must perform extra tests before you export the content to PDF.

### Outside of ServiceNow support

As with any custom implementations, several things have limited or no support when they are beyond ServiceNow’s control:
- Custom content blocks: Content blocks that are not part of the base system or part of a plugin.
- Custom content blocks: The number of content blocks containing report visualizations may affect export success. Successful export may also be intermittent.
- Custom interactive filters (dynamic content blocks).
- Custom Iframes, including Iframes that link back to existing UI pages and scripts.
- Custom widgets: widgets not created by ServiceNow.
- Custom Global UI scripts: UI scripts that are not part of the base system.
- Custom UI pages: UI pages that are not part of the base system.
- Custom script includes: Script includes that are not part of the base system.

PDF export engines do not render pages the same way a browser does. PDF export functionality supports the following web technologies: HTML 4, CSS2, and JavaScript 1.5. Content block developers are responsible for testing their code against PDF export and for adjusting their implementation to these limitations.

**Gauge support**

Gauges are containers for holding graphical content on dashboards and homepages in ServiceNow®, but gauges are no longer supported. Widgets are the supported containers for graphical content.

It is not possible to create gauges through the Dashboard and Homepage user interfaces. When you navigate to System UI > Gauges and click New, a widget is created for your content. You may have gauges in your instance if they have been moved from an earlier instance in an update set or are present in an older installed plugin. If gauges do not contain content or do not behave correctly, create a new widget with the content you want to show.

⚠️ **Note:** Admins can create gauges at the table level using platform functionality. An ACL on the sys_gauge table restricts other users from creating gauges.

To create a new widget, navigate to System UI > Widgets and click New. For an example, see Create a widget that displays a ServiceNow UI page.

**Related information**

Service Portal widgets
Widgets

Objects that have been added to dashboards are called widgets. You can create and manage widgets. Many applications have their own widgets. See an application's documentation for information about the widgets included with the application.

Widget types include:

**Reports**

Report visualizations are snapshots of your data that show the state of your information in real time.

**Performance Analytics**

Performance Analytics widgets visualize information based on indicator data collected over time. For more information, see Performance Analytics widgets.

**Filters and Interactive Filters**

Interactive Filters allow you to filter report widgets directly from a homepage or dashboard without modifying the reports.

**Content Blocks**

Content blocks are pieces of information that you can reuse across your instance. To learn more, see Configure a content block.

**Live Feed**

Live Feed is a social IT application that provides a place to post and share content in a ServiceNow instance. See Use Live Feed.

Create a widget that displays a ServiceNow UI page

You can create a ServiceNow UI page that displays a web page. You can then add that UI page to a widget that can be added to dashboards and homepages.

**Before you begin**

Role required: admin

**About this task**

A UI page is a ServiceNow page that is not a list or a form. Some UI pages, such as external site widgets or gadgets, do not display properly when placed in a dashboard.

To learn how to make a UI page without using a framework page template, see the Making a UI page without using the framework page template blog posting by a developer in the ServiceNow Community.
Procedure

1. Create or find a ServiceNow UI page that you want to display as a widget. Note the name of this UI page, to use in Step 4. The UI page name is the value of the name field in the form where you define the content of the UI page.

2. Navigate to System UI > Widgets and click New. Widgets records are widget category records, not records for individual widgets. When adding a widget to the dashboard, first select the category and then the widget. The JavaScript you specify in step 4 contains the list of widgets to include in that category.

3. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of this widget category. The user selects this category when adding its widgets to a dashboard.</td>
</tr>
<tr>
<td>Renderer Type</td>
<td>Select JavaScript.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear to make the widget unavailable to add to dashboards.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select roles that can see this category when adding widgets to dashboards. If you select no roles, all roles can see the category.</td>
</tr>
</tbody>
</table>

4. Add the following JavaScript in the Script field, making replacements as specified. The return statement contains the widgets listed in this widget category.

```javascript
function sections() {
    return {
        'widget_name': { 'uiPageName' : 'UI_page_name'}
    }
}
```
function render() {
    var uiPageName = renderer.getPreferences().get("uiPageName");
    return renderer.getRenderedPage(uiPageName);
}

function getEditLink() {
    var uiPageName = renderer.getPreference('uiPageName');
    return 'sys_ui_page.do?sysparm_query=' + encodeURIComponent('name=' + uiPageName);
}

5. Click Submit.

What to do next
Add content to a homepage Add a Performance Analytics widget to a non-responsive dashboard Edit a responsive dashboard

User Experience Analytics

The ServiceNow® User Experience Analytics application provides dashboard views for monitoring key performance indicators of users of your web and mobile applications built with the ServiceNow mobile platform and web assets in Service Portal instances. Visualize metrics and interactions to better understand the user experience, and create more intuitive journeys for your users.
Setting up User Experience Analytics

An admin can configure Service Portal and web applications built on the ServiceNow mobile platform to track user analytics.

User Experience Analytics plugin

The User Experience Analytics plugin (com.glide.appsee) is activated by default in the Now Platform in a new Rome instance, and in upgraded instances. The plugin is responsible for:

• Checking hourly for new web and mobile applications to register with the ServiceNow server.
• Providing access to the User Experience Analytics Dashboard.

Note: User Experience Analytics is not supported for on-prem instances.

Domain separation is not supported

This application does not support domain separation. For more information, see Application support for domain separation.

Related information

List of plugins (Paris)
User Experience Analytics for Service Portal

Configure User Experience Analytics Settings

Turn on user analytics tracking for instances within User Experience Analytics.

Before you begin

Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin

Note: To turn on user analytics tracking for Service Portal, see Create User Experience Analytics settings for Service Portal.

Procedure

1. Navigate to User Experience Analytics > Settings.
2. On the list, locate the record for the instance you want to enable analytics tracking on.
   The instance name is listed in the Name column.
3. On the same row, if the Enabled column value is not set at true, open the record by clicking false.
4. On the form, check the **Enabled** check box.

5. Click **Update**.

**What to do next**
Assign a web_analytics_viewer or portal_analytics_viewer role to users to enable them to view the **Dashboard**.

**Disable tracking for a mobile app**
You can turn off analytics tracking for a mobile instance by updating the User Experience Analytics Settings.

**Before you begin**
Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin

**Procedure**
1. Navigate to **User Experience Analytics > Settings**.
2. On the list, locate the record for the instance you want to disable analytics tracking on. The instance name is listed in the **Name** column.
3. Open the record by clicking **true** on the same row.
4. On the form, clear the **Enabled** check box.
5. Click **Update**.

**User Experience Analytics properties**
These properties are available for configuring user analytics tracking functionality.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Experience Analytics Enabled</td>
<td>glide.analytics.enabled</td>
</tr>
</tbody>
</table>

**Note:** When European users launch your application or start a web session the first time, they are prompted to select whether to consent to analytics tracking.
Properties for User Experience Analytics (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: Disabled</td>
<td></td>
</tr>
<tr>
<td>• Location: User Experience Analytics &gt; Properties</td>
<td></td>
</tr>
</tbody>
</table>

Domain separation and User Experience Analytics

Domain separation is unsupported for User Experience Analytics. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.
• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

Related information

Domain separation for service providers

Components installed with User Experience Analytics

Several types of components are installed with the User Experience Analytics plugin, including user roles, scheduled jobs, and tables.

User Experience Analytics uses these roles, scheduled jobs, tables, and business rules.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Experience Analytics Admin roles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>User Experience Analytics admin</td>
<td>User Experience Analytics administrators:</td>
<td>• mobile_analytics_admin</td>
</tr>
<tr>
<td>[analytics_admin]</td>
<td>• can view the <strong>Dashboard</strong> link and settings within User Experience Analytics in the application navigator.</td>
<td>• web_analytics_admin</td>
</tr>
<tr>
<td></td>
<td>• can control the User Experience Analytics settings for each mobile, web, and service portal application.</td>
<td>• analytics_viewer</td>
</tr>
<tr>
<td></td>
<td>• have <strong>admin</strong> role permissions to be able to create funnel and cohort reports from the User Experience Analytics Dashboard.</td>
<td></td>
</tr>
<tr>
<td>Mobile analytics admin</td>
<td>Mobile analytics administrators:</td>
<td>mobile_analytics_viewer</td>
</tr>
<tr>
<td>[mobile_analytics_admin]</td>
<td>• can view the <strong>Dashboard</strong> link and settings within User Experience Analytics in the application navigator.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• can control the User Experience Analytics settings for each mobile application.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• have <strong>admin</strong> role permissions to be able to create funnel and cohort reports from the User Experience Analytics Dashboard.</td>
<td></td>
</tr>
<tr>
<td>Web analytics admin</td>
<td>Web analytics administrators:</td>
<td></td>
</tr>
<tr>
<td>[web_analytics_admin]</td>
<td>• can view the <strong>Dashboard</strong> link and settings within User Experience Analytics in the application navigator.</td>
<td>• web_analytics_viewer</td>
</tr>
<tr>
<td></td>
<td>• ..............................................................................................................................................................................................................</td>
<td>• portal_analytics_admin</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>• can control the User Experience Analytics settings for each web application.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• If the Service Portal Analytics plugin (com.glide.service-portal.analytics) is activated, this role can control analytics settings for Service Portal.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• have admin role permissions to be able to create funnel and cohort reports from the User Experience Analytics Dashboard.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

User Experience Analytics Viewer roles

<table>
<thead>
<tr>
<th>User Experience Analytics viewer [analytics_viewer]</th>
<th>Users with the User Experience Analytics viewer role:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• can view the Dashboard link within User Experience Analytics in the application navigator.</td>
<td></td>
</tr>
<tr>
<td>• have viewer role permissions for User Experience Analytics for mobile, web, and service portal applications.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mobile analytics viewer [mobile_analytics_viewer]</th>
<th>Users with the Mobile analytics viewer role:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• can view the Dashboard link within User Experience Analytics in the application navigator.</td>
<td></td>
</tr>
</tbody>
</table>

<p>| None |</p>
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• have viewer role permissions for User Experience Analytics for mobile applications.</td>
<td>portal_analytics_viewer</td>
</tr>
</tbody>
</table>
| Web analytics viewer [web_analytics_viewer] | Users with the Web analytics viewer role:  
  • can view the Dashboard link within User Experience Analytics in the application navigator.  
  • have viewer role permissions for User Experience Analytics for web applications.  
  • If the Service Portal Analytics plugin (com.glide.service-portal.analytics) is activated, this role can view analytics in the dashboard for Service Portal. | portal_analytics_viewer |

### Scheduled jobs

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Experience Analytics Settings</td>
<td>Queries the sys_sg_native_client table hourly and processes any mobile applications which do not have corresponding User Experience Analytics Settings defined in the sys_analytics_bucket table.</td>
</tr>
<tr>
<td>Analytics</td>
<td>Registers any entry in sys_analytics_bucket that doesn’t have a matching entry in sys_analytics_authentication (analytics buckets with no authentication settings).</td>
</tr>
</tbody>
</table>
### Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Experience Analytics Settings [sys_analytics_bucket]</td>
<td>Primary table. Contains the information that associates the application it references with the ServiceNow server.</td>
</tr>
</tbody>
</table>

### Business rules

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create User Experience Analytics settings</td>
<td>sys_sg_native_client</td>
<td>Creates User Experience Analytics Settings each time a new web or mobile application is created.</td>
</tr>
<tr>
<td>Register new web and mobile applications</td>
<td>sys_sg_native_client</td>
<td>Enables immediate registration of new web and mobile applications.</td>
</tr>
</tbody>
</table>

### Use User Experience Analytics

Use User Experience Analytics to understand usage and adoption of your web or mobile application.

With User Experience Analytics, you’re able to gain insights on usage and adoption of your web and mobile applications, and understand where you can create a more intuitive user experience. In addition to seeing the number of users who engage your application and their retention rates over time, you can view user behavior as they perform steps, and see user flows that provide a larger view of how they navigate. Further, User Experience Analytics gives you tools to create user reports that report on analytics such as geographic, session length, and operating system.

An admin can see user application usage, event, and user-level analytics for your applications within these ServiceNow applications:

- Service Portal
- Mobile Agent
• Mobile Onboarding
• Now Mobile

Note:
The Mobile Onboarding app is being deprecated!

With the Now Platform Rome release in September 2021, we started phasing out support for the Mobile Onboarding. Customers may no longer activate it, and we are not offering enhancements or non-critical bug fixes. Mobile onboarding features are available in the Now Mobile app for HR Service Delivery."

Overview of the dashboard

User Experience Analytics shows detailed KPI data on a dashboard and on list views. Product managers gain relevant insight into the usage and adoption of a web or mobile application.

Users with any User Experience Analytics viewer role can access the dashboard by navigating to **User Experience Analytics > Dashboard**.

The dashboard provides access to the following modules and controls.

Dashboard

The top menu contains the web or mobile application, platform, and version lists you select from for performing the most frequent dashboard tasks.
### Application, platform, and version menus

<table>
<thead>
<tr>
<th>Feature area</th>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Web and Mobile applications list</td>
<td>List of registered web and mobile applications. You can select from these views:&lt;br&gt;• <strong>All Applications</strong> (default landing page) shows basic statistics across all applications within the current instance.&lt;br&gt;• Select the individual application whose analytics you want to view.</td>
</tr>
<tr>
<td>2</td>
<td>Mobile platform list</td>
<td>Select the mobile platform whose analytics you want to view. &lt;br&gt;• <strong>All Platforms</strong>&lt;br&gt;⚠️ <strong>Note:</strong> UI Analysis and Conversions modules cannot be viewed when you select this option.&lt;br&gt;• iOS&lt;br&gt;• Android</td>
</tr>
<tr>
<td>3</td>
<td>Application versions list</td>
<td>List of application versions you can select to view analytics for.</td>
</tr>
<tr>
<td>4</td>
<td>Date range selector</td>
<td>Enter the dates or use the slider to select the date range of data you want to view. Default is <strong>Last 30 days.</strong></td>
</tr>
</tbody>
</table>

The modules menu provides access to the sessions, analytics, and conversion report modules.

### Modules menu

<table>
<thead>
<tr>
<th>Feature area</th>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Overview</td>
<td>For a selected application or all applications within the current instance, shows a visualized overview of KPIs on one screen.</td>
</tr>
<tr>
<td>Feature area</td>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sessions</td>
<td></td>
<td>Shows user session lists you can filter, drill down into, and export.</td>
</tr>
<tr>
<td>Users</td>
<td></td>
<td>Shows user lists that you can filter, drill down into, and export.</td>
</tr>
<tr>
<td>UI Analysis</td>
<td></td>
<td>Shows insights on your application’s UI. This module is not available when All Platforms is selected from the Mobile platform list.</td>
</tr>
<tr>
<td>Analytics</td>
<td></td>
<td>Shows these analytics:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Usage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Technical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Geographic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Retention</td>
</tr>
<tr>
<td>Funnel</td>
<td></td>
<td>Shows and lets you create funnel reports based on relevant user conversion processes. This module is not available when All Platforms is selected from the Mobile platform list.</td>
</tr>
<tr>
<td>Action Cohort</td>
<td></td>
<td>Shows and lets you create cohort reports based on sequences of actions performed by users for meeting their goals. This module is not available when All Platforms is selected from the Mobile platform list.</td>
</tr>
<tr>
<td>Logged in User</td>
<td></td>
<td>A tooltip pop-up displays the name and email of the logged in user, and their role.</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td>Provides a URL link to relevant documentation.</td>
</tr>
</tbody>
</table>
Metrics across all applications
From the dashboard, you can view basic application usage and event details for all applications within an instance. Click **All Applications** from the Web and Mobile applications list to see these metrics simultaneously.

### Overview

<table>
<thead>
<tr>
<th></th>
<th>1,378</th>
<th>14.2K</th>
<th>10.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Unique Users</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sessions</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avg. Sessions per User</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Application Usage**

<table>
<thead>
<tr>
<th>Application</th>
<th>Channel</th>
<th>Active Unique Users</th>
<th>Sessions</th>
<th>Avg. Sessions</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now Mobile</td>
<td>Mobile</td>
<td>463</td>
<td>2,356</td>
<td>5.1</td>
<td>Launch Dashboard</td>
</tr>
<tr>
<td>Service Portal</td>
<td>Web</td>
<td>743</td>
<td>10,980</td>
<td>14.7</td>
<td>Launch Dashboard</td>
</tr>
<tr>
<td>Virtual Agent</td>
<td>Conversational Interfaces</td>
<td>540</td>
<td>870</td>
<td>1.6</td>
<td>Launch Dashboard</td>
</tr>
</tbody>
</table>

**Top Events**

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Mobile</th>
<th>Web</th>
<th>Conversational Interfaces</th>
<th>Total Occurrences</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Start</td>
<td>3,245</td>
<td>6,230</td>
<td>-</td>
<td>9,475</td>
<td>Expand</td>
</tr>
<tr>
<td>KB Article View</td>
<td>2,536</td>
<td>4,230</td>
<td>850</td>
<td>7,636</td>
<td>Expand</td>
</tr>
<tr>
<td>Order Catalog Item</td>
<td>-</td>
<td>3,456</td>
<td>159</td>
<td>3,415</td>
<td>Expand</td>
</tr>
</tbody>
</table>

Viewing session analytics

The Sessions module lists filterable application sessions you can drill down into for more detailed insights.
### Sessions module - Sessions list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Refreshes the sessions list with selected filters and updated session data.</td>
</tr>
<tr>
<td>List Filter</td>
<td>Property options to filter the sessions list.</td>
</tr>
<tr>
<td>Date</td>
<td>Date the session occurred.</td>
</tr>
<tr>
<td>Total Sessions</td>
<td>Total number of sessions available for the selected platform, application version, date range, and filter options.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time the session lasted.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> User Experience Analytics tracks a maximum session length of four (4) hours.</td>
</tr>
<tr>
<td>Version</td>
<td>Mobile application version.</td>
</tr>
<tr>
<td>User Index</td>
<td>Automatically generated number assigned to each unique user of an application version. Can be used instead of an internal User ID.</td>
</tr>
<tr>
<td>Hashed User ID</td>
<td>Generated hashed value ID for each user, or IDs can be set to anonymous. Actual user IDs are not displayed, and instead are automatically hashed via the SHA-256 hash function.</td>
</tr>
<tr>
<td>Session</td>
<td>Unique session number for the user. A new, consecutive session number is tracked for the user each time they start a session.</td>
</tr>
<tr>
<td>Device</td>
<td>Specific device the user session occurred on.</td>
</tr>
<tr>
<td>Location</td>
<td>Location the user accessed the application from.</td>
</tr>
<tr>
<td>Screens/Pages</td>
<td>Number of screens visited or pages viewed during the session by the user.</td>
</tr>
<tr>
<td>Actions</td>
<td>Number of actions the user performed during the session.</td>
</tr>
<tr>
<td>Details</td>
<td>Opens the Session Details record for the selected mobile session.</td>
</tr>
<tr>
<td>Indicators</td>
<td>Shows indicators and tags associated with a session or user record.</td>
</tr>
</tbody>
</table>
Sessions module - Sessions list (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User sessions record pane</td>
<td>Provides overview of and lets you navigate to further details of an individual session. The record pane is located below the sessions list.</td>
</tr>
</tbody>
</table>

**Note:** Sessions lists can only be reordered by session date.

**Filter options**

You can filter a Sessions list by these properties:

- Action
- App Killed
- Browser Types
- Browser Versions
- Cities
- Connectivity
- Countries
- Devices
- Device types
- Duration
- Events
- Hashed User ID
- Locales
- Offline
- Operating Systems
- Operating System Versions
- Pages
- Screens
- Session #
- States/Regions
- Tags
- User Index
Related reference

Session Details record

View a sessions list

View pre-filtered session lists, and search for session by additional properties.

Procedure

1. From the Dashboard, navigate to Sessions and select the sessions list you want to view.

<table>
<thead>
<tr>
<th>Sessions list option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Lists all user sessions.</td>
</tr>
<tr>
<td>First Sessions</td>
<td>Lists sessions for users that opened the app for the first time. Shows only the first session for each user.</td>
</tr>
<tr>
<td>Returning Users</td>
<td>Lists sessions for users who opened the app more than once. Shows only user sessions starting from their second session.</td>
</tr>
<tr>
<td>Loyal Users</td>
<td>Lists sessions for users who opened the app more than five times. Shows sessions starting from a user's fifth session and after.</td>
</tr>
<tr>
<td>Quick Abandons</td>
<td>Lists all sessions in which users spent less than 20 seconds in the first session.</td>
</tr>
<tr>
<td>Short Sessions</td>
<td>Lists sessions that lasted shorter than 20 seconds.</td>
</tr>
<tr>
<td>Long Sessions</td>
<td>Lists sessions that lasted longer than five minutes.</td>
</tr>
<tr>
<td>Killed by User</td>
<td>Lists sessions in which users forced an application quit.</td>
</tr>
<tr>
<td>Offline Sessions</td>
<td>Lists all offline sessions.</td>
</tr>
<tr>
<td>Favorites</td>
<td>Lists individual sessions marked as favorites.</td>
</tr>
</tbody>
</table>

2. Define filters to refine the list results.

3. View the list of sessions, or click an individual record to view more details of a specific user session.

Related information

Viewing user and session details
Filter a sessions list

Refine a sessions list to focus on data such as selected screens or events for your application.

Procedure

1. To display the list of filter options, click the filter menu noted by the filter icon or down arrow.
2. Select one or more properties and enter their values as applicable.
3. Click Apply to apply the selected properties and refresh the list.
   - To add another property, click Add filter.
   - To clear properties back to the original filter set for the session list, click Clear.
   - To remove a property from the filter options menu, click the delete icon next to the property.
4. Click All Sessions to display all sessions for your selected filters.

Sessions and users list indicators

You can view and filter indicators and tags on a Sessions or Users list.

From the list filter, you can filter a user or sessions list by an available indicator or tag.

ℹ️ Note: Indicators added to records from within the Sessions or Users modules display only within that module. For example, a tag added to a user record from within the Users module displays only on the Users list, and not the Sessions list.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Indicates an offline session. Offline sessions occur when users don’t have connectivity or are on a poor cellular network.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Note: User Experience Analytics tracks offline sessions by default.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Indicates that a User Experience Analytics account user has added a tag to a session.</td>
</tr>
</tbody>
</table>
Viewing user analytics

The Users module enables views of individual user journeys through your application, from the start of their session in the application to the time they end. View user analytics and behavior, including taps and swipes, and other timeline actions. Select the users you want to see, set filters, and drill down into individual user sessions for closer insights.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Filter</td>
<td>Property options to filter the users list.</td>
</tr>
<tr>
<td>Total Users</td>
<td>Total number of users for the selected application version and filter options.</td>
</tr>
<tr>
<td>User Index</td>
<td>Automatically generated number assigned to each unique user of an application version. Can be used instead of an internal User ID.</td>
</tr>
<tr>
<td>Hashed User ID</td>
<td>Generated hashed value ID for each user, or IDs can be set to anonymous. Actual user IDs are not displayed, and instead are automatically hashed via the SHA-256 hash function.</td>
</tr>
<tr>
<td>Instance Name</td>
<td>The instance's friendly display name.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Total number of sessions the user has performed across all versions and devices.</td>
</tr>
</tbody>
</table>
### Users module - Users list (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fist Session</td>
<td>Date and time when the user first accessed the application.</td>
</tr>
<tr>
<td>Last Session</td>
<td>Date and time when the user last began a session.</td>
</tr>
<tr>
<td>Time in App/Time on Site</td>
<td>Average time the user spent in the application across all versions and devices.</td>
</tr>
<tr>
<td>Devices</td>
<td>All web or mobile devices the user has installed the application on.</td>
</tr>
<tr>
<td>Last Location</td>
<td>Last location from where the user accessed the application.</td>
</tr>
<tr>
<td>Indicators</td>
<td>Shows indicators and tags associated with a session or user record.</td>
</tr>
</tbody>
</table>

⚠ **Note:** Users lists can only be reordered by user index.

### Filter options

You can filter a Users list by these properties:

- App Versions
- Browsers
- Browser Version
- Countries
- Device Count
- Device Types
- Favorite
- First Session Time
- Hashed User ID
- Last Session Time
- Locale
- Operating Systems
- Sessions Count
- Session Exists
- Tags
• Time on Site
• User Index
• Custom Properties

View a users list

View pre-filtered user lists, and search for users by more user or session properties.

Procedure

1. From the Dashboard, navigate to Users, then select the list you want to view.

<table>
<thead>
<tr>
<th>Users list option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Lists all users.</td>
</tr>
<tr>
<td>New Users</td>
<td>Lists users that opened the app for the first time in the last seven days. Shows only the first session for each user.</td>
</tr>
<tr>
<td>Returning Users</td>
<td>Lists users that opened the app more than once across all devices.</td>
</tr>
<tr>
<td>Loyal Users</td>
<td>Lists users who opened the app more than five times. Shows sessions starting from a user's fifth session and after.</td>
</tr>
<tr>
<td>Never Returned</td>
<td>Lists users who opened the app only once.</td>
</tr>
<tr>
<td>Active Last Week</td>
<td>Lists users who opened the app within the last seven days.</td>
</tr>
<tr>
<td>Multi Platform</td>
<td>Lists users who have installed the app on both iOS and Android.</td>
</tr>
<tr>
<td>Multi Device</td>
<td>Lists users who have installed the app on multiple devices.</td>
</tr>
<tr>
<td>Favorites</td>
<td>Lists individual users marked as favorites.</td>
</tr>
</tbody>
</table>

2. Add filter conditions to further refine the list results.

What to do next

Click a list item to view the selected user's session record.

Filter a users list

Refine a users list to focus on data such as the web or mobile platform or the user's country, or add a custom filter.
Procedure
1. On the **Where** condition line, select a property from the filter menu.
2. Select an operator and a value as applicable.
3. To add another property, click the add property icon +.
4. To clear filters back to the original filter set for the user list, click **Reset**.
5. To remove a filter property, click the delete icon next to the property.

View a session event timeline
View a user session timeline to see listed event times that show how long into the session a user interacted with elements on the page.

Before you begin
Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin

Procedure
1. Navigate to the **Sessions** or **Users** module, then select a list item to view the user session record.
2. View the timeline on the user session record, or select a user gesture list item from the timeline to view it from the Session Details screen.

Viewing user and session details
See details of a user session, and their history of sessions, on user session and Session Details records.

Navigate to the **Users** or **Sessions** module, and select a list item to display an individual user sessions record.

Note: User data is tracked by device, and logs sessions under the user. However, if a user accesses more than one application instance or language, historical data is not tracked, and instance ID, instance name, and language will reflect only the latest login of the user.

User sessions record
View overall session statistics for a user, and event timeline details for a user's specific sessions.
You can access a user sessions record from a sessions or users list screen.

- From the sessions list screen, click on a timeline event.
- From the users list screen, click on a user record from the list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>Generated hashed value ID for each user, or IDs can be set to anonymous. Actual user IDs are not displayed, and instead are automatically hashed via the SHA-256 hash function.</td>
</tr>
<tr>
<td></td>
<td>Note: User system IDs are not tracked.</td>
</tr>
<tr>
<td>Add tag</td>
<td>Enter a text label name to associate with a user’s record. You can view assigned tags on individual records in the Users or Sessions list.</td>
</tr>
<tr>
<td>Search</td>
<td>Opens the Sessions list filtered for all sessions performed by the user.</td>
</tr>
<tr>
<td>First Session</td>
<td>Date and time the user first accessed the application.</td>
</tr>
<tr>
<td>Last Session</td>
<td>Date and time the user last began a session.</td>
</tr>
<tr>
<td>Time in App/Time on Site</td>
<td>Average time the user spent on the site or in the application across all versions and devices, and total number of sessions performed by the user.</td>
</tr>
<tr>
<td>Locales</td>
<td>Language the user viewed the application in, and country they accessed from.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>App Versions</td>
<td>All application versions the user has installed across all devices.</td>
</tr>
<tr>
<td>Devices &amp; Installations</td>
<td>Shows browser type, device and device version used by the user, along with a list of date ranges in which the user was active per installation. Every time a user reinstalls the app, a new date range appears.</td>
</tr>
<tr>
<td>Locations</td>
<td>List of locations the user accessed sessions from.</td>
</tr>
<tr>
<td>Custom Properties</td>
<td>Opens available SDK API Reference documentation providing information on adding custom properties.</td>
</tr>
<tr>
<td>Instance ID</td>
<td>The instance’s unique identifier.</td>
</tr>
<tr>
<td>Instance Name</td>
<td>The instance’s friendly display name.</td>
</tr>
<tr>
<td>Language</td>
<td>The preferred language a user's device was set to in which they performed the session.</td>
</tr>
<tr>
<td>Login Count</td>
<td>The number of times a user has logged in to the app by entering their email and password.</td>
</tr>
<tr>
<td>Sessions window</td>
<td>Shows the following session details:</td>
</tr>
<tr>
<td></td>
<td>• Date - Date the session occurred.</td>
</tr>
<tr>
<td></td>
<td>• Index - Sequential number of session for the user.</td>
</tr>
<tr>
<td></td>
<td>• Duration - How long the session lasted.</td>
</tr>
<tr>
<td></td>
<td>• Version - Mobile application version the session occurred on.</td>
</tr>
<tr>
<td></td>
<td>• Device - Mobile device the user performed the session on.</td>
</tr>
<tr>
<td></td>
<td>• Search - Navigates to the Sessions list specific to sessions for the selected user.</td>
</tr>
<tr>
<td></td>
<td>You can reorder sessions by date, index number, session duration, or app version.</td>
</tr>
<tr>
<td>Timeline</td>
<td>Shows a timeline of events for the user session.</td>
</tr>
<tr>
<td></td>
<td>To see more detail for an event, click the Expand icon next to an event on the timeline.</td>
</tr>
<tr>
<td>Session Details</td>
<td>Displays the Session Details record for the selected session.</td>
</tr>
</tbody>
</table>
Related reference

Session Details record

View statistics and timeline details for a specific user session.

Access a Session Details record from a user sessions record.

- From the sessions list screen: On a user sessions record, click the Session Details button or on a timeline event.
- From the users list screen, click on a user record from the list, then click on a timeline event.

You can also see and add tags from a Session Details record, as well as view a user's session history.

Related reference

User sessions record
Related information

Create or view favorite lists

You can show user and session lists that are manually marked as favorites.

About this task

Each user and session list in the Dashboard has a star icon to the left of the user index or session date. Selecting a star icon automatically creates a favorite list. You can select and deselect a star to add or remove a user or session from a favorite list, then view the lists.

Procedure

1. Select a favorite list by clicking the favorites icon ✫ to the right of a list item.
2. Click Users > Favorites or Sessions > Favorites to show your most useful list items.

Using the Analytics module

Get single-user and aggregate insights in real time.

The Analytics module shows app usage, technical, geographic, event, and user retention data in several visualization types. KPIs show specific to the selected platform, app version, and date range. For certain visualizations, you can choose to see daily, weekly, and monthly data views.
Interacting with analytics visualizations
You can choose display options on some visualizations.

- On pie chart visualizations, display or turn off a property display by clicking the circle toggle next to a property.
- On line chart visualizations, display or turn off a property display by clicking the data point toggle next to a property.
- Show analytics as a pie chart to see value breakdown, or as a bar chart to see daily statistics, by clicking the corresponding chart toggle.

App usage
To give you view of user adoption, see analytics such as total number of users of your site or app, average number of sessions opened daily, and how long sessions last on average.

Navigate to **Analytics > Usage** to see an overview of usage KPIs. You can point to most visualizations to see brief, relevant details such as date of sessions, number and percentage of users, and app version number.

### App usage KPIs

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Active Users</td>
<td>Total number of users, including new users, whose last session occurred within the last seven days.</td>
</tr>
</tbody>
</table>
### App usage KPIs (continued)

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sessions</td>
<td>Total number of sessions that have occurred, and average number of sessions per day.</td>
</tr>
<tr>
<td>Average Screens/Session</td>
<td>Average number of pages or screens viewed and actions performed per session.</td>
</tr>
<tr>
<td>Avg. Session Duration</td>
<td>Average time spent across sessions for all users.</td>
</tr>
<tr>
<td>Total Sessions</td>
<td>Total number of sessions performed daily, weekly, and monthly.</td>
</tr>
<tr>
<td>Users</td>
<td>Total number of daily, weekly, and monthly active and new users.</td>
</tr>
<tr>
<td>New / Returning Users</td>
<td>Percentage of users who started their first sessions within the last seven days, and percentage of those users who subsequently started a second session.</td>
</tr>
<tr>
<td>App Versions</td>
<td>App versions installed by users for the selected platform(s).</td>
</tr>
<tr>
<td>App Version Adoption</td>
<td>Shows session segmentation between different versions of the app. For example, if a new app version was released yesterday, and today shows 10% of all app sessions, the current adoption of the new app version is 10%.</td>
</tr>
<tr>
<td>Session Duration</td>
<td>Percentages of sessions segmented by their length/duration.</td>
</tr>
<tr>
<td>Hourly Usage</td>
<td>Average number of app launches that occurred at a specific hour of the day over all days.</td>
</tr>
</tbody>
</table>

### Technical analytics

See analytics such as operating system, device, and resolution data for your users.

Technical analytics show data such as number of users who use a specific operating system or particular device, and how many use the application at a certain resolution, or access the app when connected by wifi.

Point to certain visualizations to see additional percentage or number details.
## Technical KPIs

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Active Users</td>
<td>Total number of users, including new users, whose last session occurred within the last seven days.</td>
</tr>
<tr>
<td>Most Popular Resolution</td>
<td>Most commonly set resolution user devices were set at during sessions.</td>
</tr>
<tr>
<td>Most Popular Device</td>
<td>Most commonly used device during sessions.</td>
</tr>
<tr>
<td>Killed sessions</td>
<td>Number of sessions that have been killed by users, and percentage of sessions killed over all opened sessions.</td>
</tr>
<tr>
<td>OS Versions</td>
<td>OS versions users performed sessions on.</td>
</tr>
<tr>
<td>Devices</td>
<td>Mobile devices users performed sessions on.</td>
</tr>
<tr>
<td>Device Resolutions</td>
<td>Resolutions user devices were set at during sessions.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>Network methods by which users accessed the internet for sessions.</td>
</tr>
</tbody>
</table>

### Geographic analytics

See the regions, countries, and states mobile users access your application from.

Navigate to **Analytics > Geographic** to see an app usage by country.
To drill into a country's province, state, or territory breakdown, click the country in the map, or country name in the panel list.

'Other' indicates that it's unknown which countries users performed sessions from.

Click the Sessions list icon next to a listed country to navigate to a filtered list of sessions from the country.

**Events**

View user analytics event occurrences to help you analyze core steps within your business processes.

**About this task**

User Experience Analytics automatically detects all screens, gestures, and user actions in your app, saving you time and improving your workflow. You can view occurrences of user-triggered events like menu selecting, button clicking, and swiping.
**Note:** Event properties showing 'Sampled data' are breakdown analyses based on only the most recent 10K records.

**Procedure**

1. Navigate to **Analytics > Events.**
2. Follow one of these options:
   - Search for an event:
     a. In the search field, type the name of the event to filter in the Events list, or scroll to search the Events list.
     b. Click the arrow right icon next to the event you want to see.
     c. Click the Sessions list icon next to the event to see similar occurrences from the Sessions list.
   - See events across all applications:
a. Click **All Applications** from the Web and Mobile applications list of the dashboard.

![All Applications from the Web and Mobile applications list](image)

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Mobile</th>
<th>Web</th>
<th>Conversational Interfaces</th>
<th>Total Occurrences</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Start</td>
<td>3,245</td>
<td>6,230</td>
<td></td>
<td>9,475</td>
<td>Expand</td>
</tr>
<tr>
<td>KB Article View</td>
<td>2,536</td>
<td>4,130</td>
<td>850</td>
<td>7,616</td>
<td>Expand</td>
</tr>
<tr>
<td>Order Catalog Item</td>
<td>-</td>
<td>3,456</td>
<td></td>
<td>3,456</td>
<td>Expand</td>
</tr>
<tr>
<td>Search Start</td>
<td>3,245</td>
<td>6,230</td>
<td></td>
<td>9,475</td>
<td>Expand</td>
</tr>
<tr>
<td>KB Article View</td>
<td>2,536</td>
<td>4,130</td>
<td>850</td>
<td>7,616</td>
<td>Expand</td>
</tr>
<tr>
<td>Order Catalog Item</td>
<td>-</td>
<td>3,456</td>
<td></td>
<td>3,456</td>
<td>Expand</td>
</tr>
</tbody>
</table>

b. Under **Actions** for a selected event, click expand to see additional visualized event details.
User Analytics Events KPIs

These event KPIs are tracked for web and mobile platforms.

<table>
<thead>
<tr>
<th>KPI</th>
<th>Event logs when:</th>
</tr>
</thead>
<tbody>
<tr>
<td>App Launch External</td>
<td>User launches application from a notification or deep link.</td>
</tr>
<tr>
<td>User Login</td>
<td>User successfully logs in.</td>
</tr>
<tr>
<td>Open App/ALP</td>
<td>User taps ALP/screen.</td>
</tr>
<tr>
<td>Open Applet</td>
<td>User opens an applet.</td>
</tr>
<tr>
<td>Voice Search Tapped</td>
<td>User taps the Microphone icon.</td>
</tr>
<tr>
<td>Contact Support Tapped</td>
<td>User taps the Contact Support icon.</td>
</tr>
<tr>
<td>Field Action</td>
<td>User taps a button, such as Call or Email.</td>
</tr>
<tr>
<td>Search Start</td>
<td>Search action starts.</td>
</tr>
<tr>
<td>Search Complete</td>
<td>Search action completes. This time is recorded in milliseconds.</td>
</tr>
</tbody>
</table>

User retention

User retention reports can help you understand if your app meets your users' needs and expectations, and enables you to measure how your app optimization efforts impact user retention.

About this task

View data such as how many new users you have, how many never returned, and how many returned the following day. User retention data also shows you the frequency of user sessions and the average time in between sessions given a certain time bucket. User retention analytics can help you, for example:

- Use cohort analysis to identify a month, week, or day with poor retention.
- Compare retention analytics across versions and devices.
Procedure

1. Navigate to Analytics > Retention.
2. Select whether to view Daily, Weekly, or Monthly insights.

Retention KPIs

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Users</td>
<td>Number of new users within the specified time bucket.</td>
</tr>
<tr>
<td>Never returned</td>
<td>Percentage and number of users who never returned to use the app after their initial session.</td>
</tr>
<tr>
<td>Returned after a day/week/month</td>
<td>Percentage and number of users who used the app on the following week after their initial session.</td>
</tr>
<tr>
<td>Time to 2nd session</td>
<td>Average time interval between the first and the second session.</td>
</tr>
<tr>
<td>Sessions Frequency</td>
<td>Measures the average number of sessions within the selected time bucket (daily/weekly/monthly). For example, 25% of users used the app two times per day.</td>
</tr>
<tr>
<td>KPI</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Average Time Between Sessions</td>
<td>Average times between initial and subsequent sessions.</td>
</tr>
<tr>
<td>Retention Cohort Analysis</td>
<td>Shows the number of new users who started to use the app during a specified time bucket, and the number who returned to use the app during a later week.</td>
</tr>
</tbody>
</table>

**UI analysis**

See insights on your mobile application's UI, and users' interaction with it. Analytics such as most popular screens and percent of users who exit on the screen can help you understand user progress, or where they may be experiencing issues on a screen.

ℹ️ **Note:** If **All Platforms** is selected, this functionality is not available. Select an individual device platform to see these insights.

To view UI insights for your application, navigate to **UI Analysis** and the module you want to see insights for.

**Insights**

The Insights module shows a tabbed overview of screen KPIs.

**UI Insights tabs**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quit Rate</td>
<td><strong>Screens with Highest Quit Rate</strong> - Shows screens which users quit the most, measured by total number of</td>
</tr>
</tbody>
</table>
### UI Insights tabs (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Interactions</strong></td>
<td><strong>Screens with Most User Interactions</strong> - Shows screens users engage with the most, measured by the number of gestures, for example, taps or swipes, performed in a screen relative to the total number of gestures performed by all users in the app.</td>
</tr>
<tr>
<td><strong>Screen Popularity</strong></td>
<td><strong>Most/Least Viewed Screens</strong> - Shows screens with the highest and lowest view rates, measured by number of sessions that contain the screen relative to total number of app sessions.</td>
</tr>
<tr>
<td><strong>User Engagement</strong></td>
<td><strong>Screens with the Longest/Shortest Visit Duration</strong> - Shows screens with the longest and shortest visit durations, with average visit durations in the screens.</td>
</tr>
</tbody>
</table>
| **Usability Problems**       | • **Screens with Unresponsive Gestures** - Shows screens with the most unresponsive gestures, for example, screens that did not respond to user gestures. Measured by number of unresponsive gestures relative to the total number of gestures performed in the screen by all users.  
  • **Screens with Slow Times to First Action** - Shows screens with the longest time to first action by showing average duration between the first screen appearance and the first gesture performed. These can indicate screens which are confusing to users. |

### Screens/Pages

The Screens module and Pages module show analytics specific to pages on your site or screens in your mobile application. View user action and navigation details for each.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen/Page name</td>
<td>Name of the selected screen/page. To change the name of a page, click the edit icon.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Shows the number of sessions that contained the screen, and number of impressions. If a screen was opened more than once during a session, it is only counted once.</td>
</tr>
<tr>
<td>Average Duration</td>
<td>Shows the average time spent on the screen, and percentage of time spent on the screen relative to the average time spent throughout the app during sessions.</td>
</tr>
<tr>
<td>% of App Interactions</td>
<td>Shows the relative interaction rate for the screen measured by the number of gestures performed.</td>
</tr>
</tbody>
</table>

**Actions, Gestures & Toasts**

| Top User Actions             | • % Occurrences  
|                              | • % Sessions     
|                              | • Avg. / Session |
| Gestures                    | Ratio of user gestures per screen, and percentage of unresponsive gestures.                                                                 |
### Item | Description
--- | ---
**Merge actions** | Enables you to merge actions.

### Navigation

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous screen/page</td>
<td>Shows the top screens from which users arrived to the selected screen, and percentage of sessions arriving from each screen relative to the total number of navigations to it. Rare actions may be omitted.</td>
</tr>
<tr>
<td>Next screen/page</td>
<td>Shows the top screens to which users arrived from the selected screen, and percentage of sessions navigating to each screen relative to the total number of navigations from it.</td>
</tr>
</tbody>
</table>

Where available, you can view sessions that contained a specific screen. Click the Sessions list icon ➤ to view these sessions from the Sessions list.

**View screen/page analytics**

See user actions, gestures and navigation analytics for each screen or page.

**Procedure**

1. Navigate to **UI Analysis > Screens** or **Pages**.
2. Scroll the screens or pages list, or enter letters in the Search field to filter page or screen names containing the letters, and select a screen or page.

**Merge page actions**

Merge two or more actions to track for a page.

**About this task**

Merging actions applies to new sessions only, and does not change existing data.

> **Note:** Once performed, merges cannot be reversed.

**Procedure**

1. Navigate to **UI Analysis > Pages**.
2. Search for and select the page with actions you want to merge.
3. Click the merge icon ➔ next to the first action you want to merge.
4. Select the checkbox next to the second action you want to merge.

5. Once you’ve selected all actions you want to merge together for a page, click **Apply**. The merged actions will list under the name of the first listed action.

**Popups**

View sessions of mobile app users who see a specific pop-up. Pop-up analytics help you easily identify bugs and errors your users encounter.

### Popups screen elements

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most Viewed</td>
<td>Most viewed pop-up in the app by number of views and percentage over all views of all pop-ups.</td>
</tr>
<tr>
<td>Highest Quit Rate</td>
<td>Shows screens which users quit the most, measured by total number of sessions ending in the screen relative to total app quits.</td>
</tr>
<tr>
<td>Popup</td>
<td>Name of the pop-up. To rename a pop-up, point to the pop-up name and click the edit icon to rename the pop-up.</td>
</tr>
<tr>
<td>Text</td>
<td>Text the user reads in the pop-up.</td>
</tr>
</tbody>
</table>
### Popups screen elements (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sessions</td>
<td>The percentage of sessions the pop-up has been viewed in. Click the Sessions list icon for a selected pop-up to see the list of sessions that contain the pop-up.</td>
</tr>
<tr>
<td>Options</td>
<td>Shows the options that were presented to the user in the pop-up. For example, ‘Confirm,’ or ‘Cancel’. Click the Sessions list icon to see the list of sessions filtered by options for the selected pop-up options.</td>
</tr>
</tbody>
</table>

### Users flow

See the common flows and different paths web or mobile app users take to gain a closer picture view of how they're navigating it.

![Users Flow Image]

A users flow can help you quickly understand where most of your users journey between different screens. A flow shows the inbound and outbound journeys for each screen and pop-up within your app. With user flow insights, you're able to:

- Investigate problematic screens to understand screen usability or performance issues.
- Understand user intent, for example, the different trends between new users who search around the app much more than returning users.
• Routinely monitor navigation patterns.
• Discover behavior trends across factors such as devices, user demographics, and operating systems.

**Differences between a users flow and a navigation path**

A users flow shows inbound and outbound traffic for each screen in the app, enabling you to understand navigation trends to and from each screen. In a flow visualization, each screen appears only once. These flows help answer the question of where users navigate to after a specific screen.

A navigation path shows the frequency of specific, ordered navigations in the app, enabling you to see the most common paths that users take in the app. Each screen can appear multiple times within a navigation path. For example, A > B > A > C.

**Viewing and interacting with a user flow**

You can choose whether to display flows showing analytics for **All Users**, **New users**, or **Returning users**. The ratio of users who visited screens shows as greater or lesser width path flows. Point to a path line of a screen to see the percentage of users who navigated to a certain screen.

**Tips for more easily visualizing a flow**

It can be easier to view a flow visualization using these tips. To more easily view:

• A flow from a particular screen: Enter a screen name in the search field and select it from the list.
• Where users navigated to: Reposition a screen within a flow by clicking and dragging a screen bar to a desired position.

You can further interact with a user flow in these ways.

<table>
<thead>
<tr>
<th>Action</th>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide or show pop-ups in the visualization.</td>
<td>Check or uncheck the <strong>Hide Popups &amp; Menus</strong> box to hide or show them.</td>
</tr>
<tr>
<td>Drill down into a specific screen to see the number of sessions, impressions, the inbound or outbound screens that relate to it.</td>
<td>Point to a screen bar to view, or further click an inbound or outbound toggle to highlight the corresponding screen path.</td>
</tr>
</tbody>
</table>
View the list of sessions that contain the navigation.
Point to a flow and click the Sessions list icon.

View the frequency of specific, ordered navigations most users take.
Point to an applicable screen and click the Show Navigation Paths icon.

**Navigation paths**

Navigation paths enable you to quickly understand and isolate users’ journeys through your web or mobile application. Assess the most and least common navigation paths your users take and how you can improve them.

Navigation paths give insights into the paths users follow from a root screen. These can help you:

- Identify user journeys that show user confusion, for example, navigation back and forth between two screens.
- Identify critical journeys that end prematurely.
- Understand the effect of pop-ups on user navigation.

**Differences between a users flow and a navigation path**

A users flow shows inbound and outbound traffic for each screen in the app, enabling you to understand navigation trends to and from each screen. In a flow visualization, each screen appears only once. These flows help answer the question of where users navigate to after a specific screen.

A navigation path shows the frequency of specific, ordered navigations in the app, enabling you to see the most common paths that users take in the app. Each screen can appear multiple times within a navigation path. For example, A > B > A > C.
**Viewing and interacting with a navigation path**

The Navigation Paths screen shows an initial visualization which contains data for all screens contained in your app. Each circle on the visualization represents a navigation level, and shows the numbers of navigations from the previous screen, up to five levels. You can choose whether to display the visualization with analytics for **All Users**, **New** users, or **Returning** users.

The bottom charts show aggregations of the first and second navigations across all paths.

You can interact with a navigation path in these ways.

<table>
<thead>
<tr>
<th>Action</th>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide or show pop-ups in the visualization.</td>
<td>Check or uncheck the <strong>Hide Popups &amp; Menus</strong> box to hide or show them.</td>
</tr>
<tr>
<td>Expand a path to focus more on it.</td>
<td>Point to an applicable path and click the zoom magnifier.</td>
</tr>
<tr>
<td>Change the root screen to see navigation paths from that screen onward, regardless of previous navigations to the screen.</td>
<td>Change the root screen several ways:</td>
</tr>
<tr>
<td>Action</td>
<td>Step</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Point to an applicable screen and</td>
<td>• Enter a screen name in the search field and select it from the list.</td>
</tr>
<tr>
<td>• Click the <strong>Show Navigation Paths</strong> icon to view paths</td>
<td></td>
</tr>
<tr>
<td>from the selected screen as the root.</td>
<td></td>
</tr>
<tr>
<td>View the list of sessions which contain a specified path.</td>
<td>Point to a path and click the Sessions list icon.</td>
</tr>
<tr>
<td>Navigating to a screen to see UI analytics.</td>
<td>Point to a screen and click its screen title.</td>
</tr>
</tbody>
</table>

**Creating conversion reports**

You can view and create event-based and action-based analytics reports to help you see how effectively users are performing steps and processes in your web or mobile application.

ℹ️ **Note:** If **All Platforms** is selected, this functionality is not available. Select an individual device platform to see and create reports.

**Create a funnel report**

View conversion rates and trends in aggregate user behavior to uncover the reasons behind success or failure of a specific in-application user goal. Investigating a conversion funnel can help you measure and optimize the conversion rates of relevant processes within your application.

**Before you begin**

Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin

**About this task**

A funnel analysis shows the percentage of users who completed a desired action along a critical path in your application, such as completing onboarding. You can also discover reasons why users drop off.

A funnel can include various actions leading up to success or failure of a conversion. There can be multiple paths users might take to reach a goal, so you may want to build several conversion funnels to determine which goal path is the most relevant and effective for your users. To measure users conversion rates on a particular goal, three primary metrics are worth examining to give you a baseline assessment of your conversion funnel's overall effectiveness:
• number of users that progress from one step to the next
• associated conversion rates
• average time it takes for users to advance from one step to the next

Procedure

1. From the Dashboard, navigate to Funnels, and click Create Your First Funnel or New Funnel.
2. Enter a name for the relevant process you want to measure.
3. Select the timeframe for sessions you want to include.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now</td>
<td>The report begins collecting data from the second the report is saved.</td>
</tr>
<tr>
<td>1 Week Ago</td>
<td>Reports on data seven days prior to the current date. Includes data generated at 12AM GMT of the date.</td>
</tr>
<tr>
<td>1 Month Ago</td>
<td>Reports on data 30 days prior to the current date. Includes data generated at 12AM GMT of the date.</td>
</tr>
<tr>
<td>3 Months Ago</td>
<td>Reports on data 90 days prior to the current date. Includes data generated at 12AM GMT of the date.</td>
</tr>
<tr>
<td>Original Date</td>
<td>This option is available when editing an existing report. Reports on data from the original date of the report.</td>
</tr>
</tbody>
</table>
4. Click **Next**.

5. From the **Step Type** options, select steps you want to measure, and screens, events, or actions as applicable.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Event Trigger</strong></td>
<td>Select <strong>User Analytics Events KPIs</strong> to measure.</td>
</tr>
<tr>
<td></td>
<td>To match a selected event by a certain property, click <strong>Match by properties</strong>, select a property from the drop down, and enter a value for the property.</td>
</tr>
<tr>
<td><strong>Screen Action</strong></td>
<td>Select a screen and applicable action type.</td>
</tr>
<tr>
<td><strong>Screen View</strong></td>
<td>Select a screen.</td>
</tr>
<tr>
<td><strong>Session Start (1st)</strong></td>
<td>Select to measure users' first sessions.</td>
</tr>
<tr>
<td><strong>Session Start (any)</strong></td>
<td>Select to measure any user sessions.</td>
</tr>
</tbody>
</table>

6. If applicable, add an alternative step type that users might choose at that point in the path.

7. Select any additional steps to add to the funnel.

8. Click **Finish**.
How User Experience Analytics matches funnels

Learn how User Experience Analytics matches sequences of pages you anticipate users seeing before they reach a goal.

User Experience Analytics bases funnel matching on unique users, and not on sessions. So steps can be matched between sessions. For example: A user may start the first step of a funnel in their first session, and continue the next step in another session. Users are counted only once for a selected time range, and step completions are only counted once per user.

A funnel measures users who complete a funnel step within 30 days. So a user can complete step #2 on January 1, then step #3 on January 30, to be counted.

Funnels steps are loosely matched. Users can perform other steps between the steps that define the funnel. For example:

For the funnel A > B > C:

• A > B > C are matched.
• A > B > D > C are also matched, where D can be any user action.
• A > B > E are not matched - the user is considered to have completed only step B.

When matching duplicate steps, the funnel analysis selects the first occurrence that progresses the funnel, and ignores duplicate occurrences. For example, for the funnel A > B > C: With a user who performs A > B > B > C, the second B is ignored.

When selecting a time range, the analysis shows only users who complete the entire funnel within the time range. If a user starts the first step before or after the selected time range, they are not counted.

Funnel analysis respects duplicate funnel entrances. For example, for the funnel A > B > C, a user performs the following actions:

A (Sunday) > B (Monday) > A > (Tuesday) > B (Wednesday) > C (Thursday)

The user is returned when selecting Sunday-Thursday, Monday-Thursday, Tuesday-Thursday, but not if they select Wednesday-Thursday.

This behavior is true both for reviewing individual sessions, and for the aggregated user count.

User Experience Analytics shows all sessions that progress through the funnel for the selected step, excluding ignored occurrences, and can show multiple sessions of a user.
When filtering by application versions, the analysis shows only the users who performed their first action from the selected version.

**Edit a funnel**
Edit funnel data to collect or steps to include in your analysis.

**Before you begin**
Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin

**Procedure**
1. From the Funnels module, click from the existing list of funnels the funnel to edit.
2. Click the edit icon.
3. Change the funnel name, timeframe of sessions to include, and edit or add steps as applicable.
4. Click Finish to update the funnel configuration.

**Delete a funnel**
Easily delete a funnel.

**Before you begin**
Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin

**Procedure**
1. From the Funnels module, click to highlight from the funnel list the existing funnel you want to delete.
2. Click the delete icon to delete the funnel.
3. Confirm that you want to delete the funnel by clicking OK.

**Create an action cohort**
Create an analysis of users who complete a predetermined sequence of actions so you can track conversion rates at each step.

**Before you begin**
Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin
About this task
An action cohort enables you to understand how often your users return to the app and perform certain actions in a given time frame. It analyzes a sequence of actions performed by an aggregated group of users within a specified time frame. A cohort report thus provides you information on how one in-app action relates to another. You can see measurement of how much time passes between a sequence of actions, and trends in user behavior and engagement over periods of time.

Procedure
1. From the Dashboard, navigate to Action Cohorts, and click Create Your First Cohort or New Cohort.
2. Enter a name for the relevant process you want to measure.
3. Select the timeframe for sessions you want to include.
### Table

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now</td>
<td>The report begins collecting data from the second the report saves.</td>
</tr>
<tr>
<td>1 Week Ago</td>
<td>Reports on data seven days prior to the current date. Includes data generated at 12AM GMT of the date.</td>
</tr>
<tr>
<td>1 Month Ago</td>
<td>Reports on data 30 days prior to the current date. Includes data generated at 12AM GMT of the date.</td>
</tr>
<tr>
<td>3 Months Ago</td>
<td>Reports on data 90 days prior to the current date. Includes data generated at 12AM GMT of the date.</td>
</tr>
<tr>
<td>Original Date</td>
<td>This option is available when editing an existing report. Reports on data from the original date of the report.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. Select the first action from the options that will define the cohort. Users who perform the defined action are grouped in the rows of the cohort.

- Visited a Screen
- Triggered an Event
- Performed an Action
- Started any Session
- Started their 1st Session

6. Click **Match by properties** to select and enter a property value to match the action with.

7. Select the second action that will define the cohort, and a screen, event, or action as applicable.

8. Click **Finish**.

**What to do next**

View the cohort to see how many of the users who performed the first defined action returned to perform the second action.

**Note:** If data shown in the cohort analysis is not final, a note indicates that retroactive data is still being processed. Refresh the screen to see the report with final data.
Edit an action cohort
Edit cohort session data to include in your analysis.

Before you begin
Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin

Procedure
1. From the Action Cohorts module, select from the drop down the cohort you want to edit.
2. Point to the cohort name to show the options, and click the edit icon.
3. Change the cohort name, sessions to include, and set of user actions as desired.
4. Click Finish to update the cohort configuration.
Delete an action cohort

Easily delete a cohort report.

Before you begin
Role required: analytics_admin, mobile_analytics_admin, web_analytics_admin, or portal_analytics_admin

Procedure
1. From the Action Cohorts module, select from the drop down list the cohort you want to delete.
2. Point to the cohort name to show the options, and click the delete icon.
3. Confirm that you want to delete the cohort by clicking OK.

How retention is calculated
Understand how Analytics calculates user and action retention.

User retention
User retention analysis groups new users and not the total number of users. A cohort includes every new user that uses the app within a defined time frame and selected date bucket (daily/weekly/monthly). A new user is only counted once per cohort, but can be included in more than one cohort.

For example, if looking at weekly cohorts, the numbers marked 1, 2, 3 along the top of the retention report indicate weekly buckets. The percentage under each weekly bucket represents the number of users who returned to use the application during that specific bucket.

The beginning and ending of each bucket is different for each new user in the cohort. The bucket marked ‘1’ indicates a time frame of seven days following the user’s initial session. For example, if a user’s initial session began at 10:00 on Sunday, bucket 1 for them begins at 10:00 Sunday of the following week. Bucket 1 for the user extends from 7 through 13 days from their initial session.

Action retention
Retention cohort analysis groups the number of users who performed the first action defined for the cohort, not the total number of application users. The action cohort includes every user that uses the app and performs the first action within the defined time frame and date bucket (daily/weekly/monthly).

For example, if looking at weekly cohorts, the numbers marked 1, 2, 3 along the top of the retention report indicate weekly buckets. The percentage under each weekly bucket represents the number of users who returned to use the application and performed the second action during that specific bucket.
The beginning and ending of each bucket is different for each new user in the cohort. The bucket marked '1' indicates a time frame of seven days following the user's initial session. For example, if a user's initial session began at 10:00 on Sunday, bucket 1 for them begins at 10:00 Sunday of the following week. Bucket 1 for the user extends from 7 through 13 days from their initial session.

A new user is only counted once per cohort, but can be included in more than one cohort. For example, if a weekly cohort is based on a login event, a customer who logs in at least once each week appears in every cohort.

When a user performs the second action, it is counted for every first action that was performed within the timeframe, not only the latest one. Each cohort cell is unique. If a user performs the second action twice within the same bucket, it is counted once. When creating a cohort in which both steps are similar, every action acts both as a first and second action.

For example, a cohort has defined two similar login actions. If a user logged in three times – on Sunday, Monday, and Tuesday – the action performed on Monday is counted as the second action for the login on Sunday. It also opens a new cohort that the Tuesday action completes.

When filtering by application versions, the analysis shows only the users who performed their first action from the selected version.

**Exporting data**

You can export data records to CSV format. Exporting user and session lists, and other analytics data to CSV is available wherever you see the download icon.

Click the ![download icon](download_icon.png) to begin automatic export of the data.
Ranking records with Spotlight

Use Spotlight to identify and rank records of interest based on multiple weighted criteria.

Spotlight illuminates records that otherwise you might overlook. You can define weighted criteria to identify and rank records that require attention, such as when triaging incidents or performing lead scoring. You can rank records based on multiple dimensions, instead of by a single field value such as priority. While most organizations address high-priority items in a timely manner, lower priority items sometimes are not addressed for an extended period of time. Spotlight helps you focus on items based on business need.

For example, you might want to have incidents brought to your attention if they have been open for a long time, or been reassigned multiple times, even if these incidents are low priority. Among those incidents, you might want one that has been open a long time and been assigned multiple times to be ranked above one that has only been open a long time.

Watch this ten-minute video for information about:

- Activating the Spotlight plugin and assigning roles
- Setting up Spotlight
- Sharing Spotlight results
This video describes Spotlight criteria, criteria weights, and incident ranking. Spotlight uses scheduled jobs that run to evaluate the records. The results of these jobs can be viewed in Spotlight interactive analyses. To share Spotlight results, share the URL of the analysis with any user who has the pa_spotlight_viewer role.

The following diagram demonstrates scoring in Spotlight. The large circle represents the set of all open incidents. Each of the smaller circles represents a weighted Spotlight criteria that applies to a subset of the open incidents.

**Spotlight diagram**

Open Incidents

- **Reassigned more than twice (weight = 200)**
- **SLA breached (weight = 1000)**
- **Open longer than 30 days (weight = 400)**
- Total weight 1600

**Note:** To use Spotlight, an administrator must activate the Spotlight plugin or one of the Analytics and Reporting Spotlight Solutions. For more information, see [Activate Analytics and Reporting Spotlight solutions](#).

**Setting up Spotlight**

Set up Spotlight for each set of table records that you want to evaluate and rank by importance. The records must be associated with an indicator.

Specify the records you want to evaluate by creating a Spotlight group. Create multiple Spotlight criteria and associate them with the group to define how to
weight records. In the Spotlight group, you set the sum of the weights of criteria that a record must meet to trigger the creation of a Spotlight.

**Note:** Before you start to work with Spotlight, an administrator must activate a Spotlight plugin. When activating Spotlight, consider activating one of the Analytics and Reporting Spotlight solutions. First, see whether one of these solutions already covers your business use case. Second, if you still need to create a new Spotlight group or Spotlight criteria, an Analytics and Reporting solution can be a useful template. For more information, see [Activate Analytics and Reporting Spotlight solutions](#).

After creating the Spotlight group and multiple Spotlight criteria, activate the Spotlight group. After the Group is activated, Spotlight scores are collected automatically according to the Spotlight group job schedule. You can also collect Spotlight scores manually at any time for an active group. A Spotlight is automatically created for any records with Spotlight scores that exceed the Spotlight group threshold, allowing you to quickly identify the highest priority work.

**Related reference**
- [Analytics and Reporting Spotlight solutions](#)

**Related information**
- [Performance Analytics concepts](#)

### Create a Spotlight group

Create a Spotlight group to define the records to evaluate. In the Spotlight group, you also set the threshold that the score of a record must exceed to trigger the creation of a Spotlight.

**Before you begin**

An administrator must have activated the Spotlight plugin or one of the Analytics and Reporting Spotlight Solutions. See [Activate Analytics and Reporting Spotlight solutions](#).

Role required: pa_spotlight or admin

**About this task**

Spotlight groups specify a set of records to evaluate and a threshold. If the score of a record in the data set exceeds the threshold, a spotlight is created for that record. The score of a record is the total weight from all applicable spotlight criteria in the spotlight group.

The set of records to evaluate must be associated with a Performance Analytics indicator. The Spotlight group specifies this indicator. A Spotlight group can
reference only one facts table: both the main indicator and all Spotlight criteria for the group must refer to the same table.

⚠️ **Note:** You can change the main indicator of an existing Spotlight group. However, after you select criteria for the group, you can change the main indicator only to another indicator that uses the same facts table.

If you have domain separation enabled, you create the Spotlight group in whichever domain you are logged in to when you create it. After you configure the Spotlight group, you can copy it to multiple domains, as described in [Copy a Spotlight group to domains](#).

⚠️ **Warning:** If you create a Spotlight group in the Global domain, every domain has access to the group.

**Procedure**

1. Navigate to **Spotlight > Spotlight Groups** and click **New**.
2. Fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>The sum of the weights of the Spotlight criteria that a record must meet to trigger the creation of a Spotlight. Consider revisiting this value when you assign weights to Spotlight criteria.</td>
</tr>
<tr>
<td>Main Indicator</td>
<td>The indicator that collects the records that you want this Spotlight group to evaluate. The main indicator must meet the following requirements:</td>
</tr>
<tr>
<td></td>
<td>• It must be an automated indicator.</td>
</tr>
<tr>
<td></td>
<td>• The collect_records property of the indicator must be set to true. This</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
 | property is set in the Source tab of the indicator form.
• The indicator source for the indicator must refer to an actual table, not a database view.
All criteria for evaluating this Spotlight group use the same facts table as the indicator source of the main indicator.

3. **Optional:** To filter the records to evaluate, select a **Breakdown** and an **Element**.
After you complete the Spotlight group, you can copy the completed Spotlight group to other elements in the same breakdown. Click **Copy Spotlight group for breakdown**. For more information, see **Copy a Spotlight group to breakdown elements**.

4. In the **Evaluate scores from** field, select whether the Spotlight job evaluates scores from a snapshot or from the platform.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performance Analytics snapshot</strong></td>
<td>A snapshot of records from when the relevant Performance Analytics data collection jobs last ran.</td>
</tr>
<tr>
<td><strong>Platform data</strong></td>
<td>Data from the platform at the time that the Spotlight job runs.</td>
</tr>
</tbody>
</table>

For more information, see **Evaluating a snapshot or platform data**.

5. In the context menu, select **Save**.

**Results**
You have created a Spotlight group with an indicator and a threshold, and you have defined whether to collect scores based on a snapshot or on platform data.

**What to do next**
• Create Spotlight criteria for the Spotlight group and set the schedule for collecting Spotlight scores. See **Create Spotlight criteria**.

• If you are using domain separation, the Spotlight group is created in the domain that you are in when you create the group. After you complete
configuring the Spotlight group, including criteria and scheduling, you can copy the Spotlight group to another domain by clicking **Copy to domain**.

- If you have specified a breakdown and element for the main indicator, you can copy the Spotlight group to other elements in the same breakdown. To do so, click **Copy Spotlight group for breakdown**. First complete the Spotlight group, including criteria and scheduling.

> **Note:** If you copy a Spotlight group to other domains or other breakdown elements, no Spotlight job results that were already generated for the original Spotlight group are copied.

**Related information**
- Domain separation with Spotlight
- Spotlight interactive analysis
- Performance Analytics indicators
- Performance Analytics data collection

**Evaluating a snapshot or platform data**

When a Spotlight job runs, it either evaluates a snapshot of collected records or it collects and evaluates data directly from the platform.

> **Note:** New Spotlight scores overwrite previous scores, regardless of whether the scores are from a snapshot or from platform data.

**Evaluating snapshot records**

By default, a new Spotlight group uses a snapshot of records. Snapshots are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with **Collect records** selected. The Performance Analytics data collection jobs for the main indicator and the criteria indicators of the Spotlight group create the snapshots. These jobs must run, collecting records, before the Spotlight evaluation job runs.

For a Spotlight group to use snapshot records, the data collection and Spotlight evaluation jobs must meet the following conditions:

- The main indicator and all the indicators used in the criteria of the Spotlight group have record collection enabled.

> **Note:** The **Collect Records** option on the Indicator form enables record collection, as described in Create an automated indicator.

- The main indicator and all the indicators used in the criteria of the Spotlight group have the same data collection frequency.
• The data collection jobs for all the Spotlight group indicators run as closely together as possible, to keep the data synchronized. The snapshots of the criteria indicators must have the same date as the last score date of the main indicator. Ideally, the main indicator and all the criteria indicators are in the same data collection job.

• The Spotlight score collection job runs at the same frequency as the data collection jobs, and as soon as possible after those jobs complete. Scheduling Spotlight score collection in this way ensures that the results are up-to-date and meaningful.

⚠️ **Note:** Only indicator-based Spotlight criteria evaluate snapshot records. Query-based criteria always evaluate platform data, even if you set the group to evaluate data from a snapshot.

**Evaluating platform data**

Spotlight can collect and evaluate records directly from the platform at the time that the Spotlight job runs. The resulting Spotlight scores reflect the state of the platform at the time of the latest Spotlight job.

Spotlight scores based on platform data are not truly in “real time.” A record may change in the platform, but the Spotlight score of the record will not reflect this change until the next time a Spotlight job runs.

Evaluating platform data requires more system resources to query the indicator data than evaluating records from a snapshot does.

Also, indicator-based criteria cannot be used to evaluate platform data when scripted breakdowns are applied. The specific restrictions are:

• If the indicator of a criterion uses a breakdown that is based on a script, this specific criterion cannot be used. Either collect snapshot instead of platform data or create query-based criteria in place of indicator-based criteria.

• If the main indicator of the Spotlight group uses a breakdown that is based on a script, you cannot evaluate platform data. Configure the Spotlight group to collect data based on snapshots only.

**Create Spotlight criteria**

Create Spotlight criteria to define when to weight a record, and the weight to assign.

**Before you begin**

Create a Spotlight group

Role required: pa_spotlight or admin
About this task
Spotlight criteria define how to weight records based on specific attributes. Each Spotlight criterion is associated with a Spotlight Group. Spotlight criteria can refer to an indicator or can use a direct query to the facts table. The former criteria are called indicator-based criteria and the latter are called query-based criteria. The indicator for an indicator-based criterion must meet the following requirements:

- It must be an automatic indicator.
- It must be set to collect records.
- It must be based on the same table that the indicator source of the main indicator is based on. This table cannot be a database view.
- If the Spotlight group evaluates platform data, the indicator cannot use a scripted breakdown.

A query-based criterion queries the same table that the indicator source of the main indicator is based on. The suitability of indicator-based and query-based criteria depends also on whether the Spotlight group evaluates platform data or snapshots of records. For more information, see Evaluating a snapshot or platform data.

Some criteria may be more important than others and have a higher weight. Weight from multiple criteria is cumulative within a Spotlight Group. The score of a record is the total weight from all applicable Spotlight criteria in the Spotlight Group.

If you have domain separation enabled:

- When you create Spotlight criteria for a global Spotlight group, the criteria are created in the domain of the logged-in user.
- When you create Spotlight criteria for a Spotlight group that is in a specific domain, the Spotlight criteria are created in that domain.

Messages appear to inform you of the domain situation when you create Spotlight criteria. For more information, see Domain separation with Spotlight.

Procedure
1. In a Spotlight group record, locate the Spotlight Criteria related list and click New.
2. Enter the Weight you want to assign to records that meet this criterion. Consider revisiting the Threshold value that is set in the associated Spotlight group. Optimize the weights of the Spotlight criteria of the group and the group threshold against each other.
3. Select the **Criteria Type** to determine which records are assigned the specified weight.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator</td>
<td>Select an <strong>Indicator</strong> to assign the weight to all records included in that indicator. Optionally, select one or two breakdowns and elements to limit the records to only those records with the specified breakdown element values.</td>
</tr>
<tr>
<td>Query</td>
<td>Set <strong>Filter conditions</strong>. The specified weight is assigned to all records from the facts table that match the filter conditions. The facts table of the main indicator of the Spotlight group is automatically selected.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
You have a criterion for a Spotlight group.

**Example: Spotlight group with three criteria**
Consider a Spotlight Group with the following three criteria, all referring to indicators:

- Open incidents not updated in 30 days, with a weight of 1000.
- Reassignment > 3 times, with a weight of 800
- Description is Empty, with a weight of 300

In this example, an open incident that has been reassigned 4 times and has an empty Description field has a total score of 1100. This incident is prioritized above an incident that has not been updated in 30 days, which has a total score of 1000.

**What to do next**
Repeat the procedure to create as many criteria as are necessary. Then collect scores. See **Collect Spotlight scores**.
Collect Spotlight scores

To collect Spotlight scores, schedule score collection and activate the Spotlight group. You can also collect scores manually for an active Spotlight group.

Before you begin

1. Create a Spotlight group
2. Create Spotlight criteria

Role required: pa_spotlight or admin

About this task

When Spotlight collects scores, Spotlight also deletes all older Spotlight records for the associated Spotlight group, without exception.

Procedure

1. Open the Spotlight group that you want to collect scores for.
2. If it is not already selected, select **Active** in the check box and save the Spotlight group form. New Spotlight groups are active by default. You can now execute the Spotlight job using the **Execute Now** button.

   ![Spotlight group form](image)

3. To collect scores immediately, click **Execute Now**.
4. Go to the **Schedule** section and in the **Run** field, select the frequency at which to collect Spotlight scores.
5. Fill in any specific information about when the Spotlight scores will be collected. The required information depends on the period you choose in the **Run** field. For example, if you choose to run **Daily**, you have to fill in the time of day to run. If you choose **Monthly**, you have to fill in the day of the month and the time of day to run.
6. If you are using domain separation, specify a user in the **Run as** field.
If you do not specify a Run As user, scores are evaluated for the Global domain. In this case, Spotlight scoring is performed for all matching records in all domains.

For more information, see Domain separation with Spotlight.

Results
Spotlight starts collecting scores according to the schedule you set. You can also collect scores manually at any time by clicking Execute Now. Administrators who need to troubleshoot scheduling can read Schedule Item [sys_trigger] records for Spotlight.

What to do next
You can see the details of the criteria that contribute to a Spotlight score. For more information, read See Spotlight score details. You can also see and share an interactive analysis of the results.

See Spotlight score details
To see the criteria whose weights contributed to a Spotlight score, view the details of the Spotlight record.

Before you begin
Role required: pa_spotlight or admin

Procedure
1. Navigate to Spotlight > Spotlight or view the Spotlights related list in a Spotlight Group record.

2. Locate the Spotlight that interests you and click the information icon.

3. Click Open Record

Results
The Spotlight record opens. In the Spotlight Audits related list, you can see which Spotlight criteria the record met and the contribution of each criterion to the total score.

Example: Spotlight criteria contributing to total score
Consider the Spotlight record for Incident INC0006831, which had a Spotlight score of 1,200 against a threshold of 1,000.
Opening the Spotlight record, you see that the following criteria weights contributed to the total score:

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open incidents not updated 30 days</td>
<td>1,000</td>
</tr>
<tr>
<td>Incidents older than 28 days</td>
<td>25</td>
</tr>
<tr>
<td>Incidents older than 7 days</td>
<td>25</td>
</tr>
<tr>
<td>Open incidents not updated 5 days</td>
<td>100</td>
</tr>
<tr>
<td>Incidents older than 14 days</td>
<td>25</td>
</tr>
<tr>
<td>Incidents older than 90 days</td>
<td>25</td>
</tr>
<tr>
<td><strong>TOTAL SCORE:</strong></td>
<td>1,200</td>
</tr>
</tbody>
</table>

**Spotlight interactive analysis**

Spotlight interactive analysis shows the key results of a Spotlight job. Access the analysis from a Spotlight Group record.
To open the Spotlight interactive analysis, open the Spotlight Group record for the group of interest and click the **Launch Interactive Analysis** related link. The pa_spotlight or admin role is necessary.

**Note:** Interactive analysis uses the Spotlight database view. Spotlight creates the database view for each Spotlight group when you create the group. If the database view is missing, a warning appears. If you have the pa_spotlight or admin roles, a link also appears for generating a database view. For more information, see **Spotlight database views**.

Using interactive analysis with any table other than incident requires fully enabled, subscription version of Performance Analytics. See **Activating your Performance Analytics subscription**.

Interactive Analysis contains the following information:

- The number of Spotlight records. This value is also the number of corresponding fact table records that exceeded the Spotlight Group threshold.
- The number of unassigned facts table records that exceeded the Spotlight threshold. These records have no value in the Assigned To column.
- The database view that joins the Spotlight table with the facts table of the main indicator. Each row of this view shows the columns from a Spotlight record and the corresponding facts table record.

**Note:**

- If a user cannot see the values in this table, ensure that they have the itil role.
- If domain separation is enabled, a user can only see Spotlights records for corresponding fact table records that are included in their domains.
- You can create reports by using this database view as a data source. You can include these reports in dashboards. Each of the Analytics and Reporting Spotlight Solutions includes such a dashboard and reports.

For more information, see **Spotlight database views**.

You can apply interactive filters to the analysis. The following filters are available, for facts tables with the matching columns:

- The **Priority** of the facts table record (tasks only)
- When the record was **Opened**
- The **Age** of the record
• The **Assignment Group** (tasks only)
• The **State** that the record is in

For information about adding or removing any of these filters, see Add a filter to Interactive Analysis and Remove a filter from Interactive Analysis.

**Note:** If you create an interactive filter for a Spotlight interactive analysis, the filter must be created on top of the relevant Spotlight database view. The admin role is necessary to access the database view. If you do not have this role, contact your system administrator.

To share the interactive analysis, share the URL from the Filter Info. The user with whom you share the interactive analysis must have the pa_spotlight_viewer role. For more information about the Filter Info, see Interactive Analysis information panel.

**Spotlight job logs**

The steps of Spotlight jobs are recorded in logs. Use these logs to debug any issues.

Users with the pa_spotlight or admin roles can read and delete Spotlight job logs.

The logs are listed at the following locations:

• At **Spotlight > Spotlight Logs**.
• As the Spotlight Job Logs related list on the relevant Spotlight Group record.

The same Spotlight Job Logs list opens in both places, but in the Spotlight Group form, the list is filtered by that Spotlight group.

To debug a Spotlight job, open the job log from the list and examine the job log row fields.

**Example: Debugging Spotlight jobs**

Consider the Incident Spotlight group, which evaluates real-time data from the Incident [incident] table. This table is the table that the indicator source of the Number of open incidents indicator uses.
A Spotlight job runs on this Spotlight group every day at 15:00 hours.

The Spotlight jobs for this group generate the following list of Spotlight job logs, where the most recent job completed with errors:

Clicking the timestamp of the 04:02:03 job shows a successful job with only informational messages.
Returning to the list and opening the log for the job that had errors, you see that the Spotlight criterion **Incident more than 30 days old** is invalid.
Navigating to the Spotlight criteria, you see that **Incident more than 30 days old** is an indicator-based criterion that uses the Age breakdown.

Viewing the Age breakdown shows that it uses a script in a breakdown mapping.

As shown at the top, the Incident Spotlight group evaluates real-time data. Therefore, the group cannot support criteria that use scripted breakdowns. For the job to run without errors, replace this criterion with a criterion that uses a query instead of an indicator and a breakdown. For example, create a criterion that queries the Incident [incident] table with the following conditions:
- \([\text{Opened}\ [\text{relative}\ [\text{on or before}][30]\ [\text{Days}][\text{ago}]])\]
- \([\text{Opened}\ [\text{relative}\ [\text{on or after}][90]\ [\text{Days}][\text{ago}]])\]

For more information, see Create Spotlight criteria.

**Domain separation with Spotlight**

If you have domain separation enabled, Spotlight applies it during Spotlight jobs.

**Domain of the Spotlight group**

When you create a Spotlight group, you create it in the domain of the user that you are logged in as when you create the group. For example, if you are a user in the ACME Products domain and you create a Spotlight group, that group is created in the ACME Products domain. If you create a Spotlight group as a user who is not a member of any domain, that Spotlight group is in the Global domain.

You can copy a Spotlight group to other domains, as defined in Now Platform® domain separation.

**Session domain and Spotlight group domain**

If you are logged into a different domain than the domain of a Spotlight group, you cannot edit that Spotlight group record. In this case, you can only copy the Spotlight group to another domain.

**Spotlight criteria domains**

- When you create Spotlight criteria for a global Spotlight group, the criteria are created in the domain of the logged-in user.
- When you create Spotlight criteria for a Spotlight group that is in a specific domain, the Spotlight criteria are created in that domain.

Messages inform you of the domain situation when you create Spotlight criteria.

**Evaluating scores with domain separation**

If the Spotlight group evaluates platform data, the main indicator and all criteria are queried according to the domain and domain visibility of the **Run As** user.

If the Spotlight group evaluates records from a snapshot, the main indicator and indicator-based criteria use the Performance Analytics snapshot that is collected specifically for the **Run As** user domain. The domain visibility of the **Run As** user does not apply to indicators in this case. (Query-based criteria always evaluate platform data, even when the Spotlight group is configured...
to evaluate snapshots. Therefore, query-based criteria always follow both the domain and the domain visibility of the Run As user.

**Note:** The snapshot of each indicator can differ depending on the domain configuration of the Performance Analytics data collection job that creates the snapshot.

**Related information**
- Create a Spotlight group
- Evaluating a snapshot or platform data
- Copy a Spotlight group to domains
- Domain separation and Performance Analytics

**Copy a Spotlight group to domains**

You can copy a Spotlight group to other domains, saving the effort of reproducing the group manually for each domain.

**Before you begin**
Finish configuring the Spotlight group that you want to copy.
Role required: admin, pa_spotlight_copy_domain

**About this task**
When you first create a Spotlight group, it is created in the domain that you are logged in to. To create identical Spotlight groups in other domains, use the copying function. The copying function follows the Now Platform® domain separation.

**Procedure**
1. Locate and open the Spotlight group record from the Spotlight Groups list.
2. Click Copy to Domain.
3. In the Copy Spotlight Group dialog, select a value for **Name Preference**:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not change the name</td>
<td>All copies will have the same name as the original Spotlight group.</td>
</tr>
<tr>
<td>Change the name</td>
<td>Manually write a new name that will be given to all copies of the Spotlight group.</td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Add domain name to new name as prefix</td>
<td>For each copy of the Spotlight group, the domain name is added to the beginning of the Spotlight group name. You can keep the base name from the original Spotlight group or specify a new one. The New Name field does not show these prefixes.</td>
</tr>
<tr>
<td>Add domain name to new name as suffix</td>
<td>For each copy of the Spotlight group, the domain name is added to the end of the Spotlight group name. You can keep the base name from the original Spotlight group or specify a new one. The New Name field does not show these suffixes.</td>
</tr>
</tbody>
</table>

4. Fill out the remaining fields of the Copy Spotlight Group dialog as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Name</td>
<td>Editable field showing the name of the Spotlight group copies you are creating. This field appears if you select any value for Name Preference other than Do not change the name. All copies have the same name unless you select Add domain name to new name as prefix or Add domain name to new name as suffix. The domain name prefixes or suffixes do not appear in this field.</td>
</tr>
<tr>
<td>Domain</td>
<td>Select any number of domains. The choices include the parent domain and all subdomains. A copy of the Spotlight group is made for each selected domain.</td>
</tr>
</tbody>
</table>

5. Click OK.
The Spotlight group is copied. If copying is successful, a list of the Spotlight groups that you have just created opens. If any error messages or warnings appeared during the copying process, read the Spotlight group copy logs.

6. Open each of the Spotlight groups you have just created and perform the following steps:

   a. Verify that the Run as user has access to the domain of the Spotlight group and change this user if necessary.
   b. Review the Spotlight job schedule and adjust as necessary.
   c. Activate the Spotlight group.

Example: Copying a Spotlight group to multiple domains

In this example, the ACME - Incident Spotlight group, which was created in the ACME domain, is copied to the subdomains for the ACME company product divisions.

1. Open the Spotlight Groups list and click ACME - Incident Spotlight.

2. The Incident Spotlight group record opens, and you click Copy to domain.

3. In the Copy Spotlight Group dialog, you select the ACME - Metallurgy and ACME - Rocketry subdomains. Only ACME and ACME subdomains
are available because the original Spotlight group was created in the ACME domain. You want the domain names to appear at the beginning of the group names, so you also select **Add domain name to new name as prefix**.

<table>
<thead>
<tr>
<th>Name Preference</th>
<th>Add domain name to new name as prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Name</td>
<td>ACME - Incident Spotlight</td>
</tr>
<tr>
<td>Domain</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Selected</td>
</tr>
</tbody>
</table>

4. Because the domain names that will be added as prefixes begin with ACME, you do not need ACME in
the base name of the group. Therefore, you remove it.

5. You click **OK**, and you are taken to a list showing you the Spotlight groups that you have just created. Note that both have the base name Incident Spotlight, as shown in the New Name field of the **Copy**
**Spotlight Group** dialog, with the domain name added as a prefix.

6. In the Run as field, you browse for a user in the ACME - Metallurgy domain and select Wiley C. Latrans. Only global users and users in the domain of the Spotlight group are available. Spotlight jobs run more efficiently with a Run as user in the same domain as the Spotlight group, because only the records visible to this domain are evaluated.

7. Review the Spotlight job run schedule, and activate the Spotlight group.
8. You verify the schedule for the ACME - Rocketry - Incident Spotlight group and activate the group.

What to do next
If any error messages or warnings appeared during the copying process, read the Spotlight group copy logs.

Copy a Spotlight group to breakdown elements
You can copy a Spotlight group across multiple elements of a single breakdown.

Before you begin
Finish configuring the Spotlight group that you want to copy.
Role required: admin, pa_spotlight, pa_spotlight_copy_breakdown

About this task
When you first create a Spotlight group, you can associate it with at most one element of one breakdown. To create identical Spotlight groups for multiple elements of a breakdown, use the copying function. For example, if you want to use the same Spotlight group configuration for multiple elements of the Countries breakdown, create a Spotlight group for one country and copy it to the other countries.

Procedure
1. Locate and open the Spotlight group record from the Spotlight Groups list.
2. Click Copy to breakdown element.
3. In the Copy Spotlight Group dialog, select a value for Name Preference:
<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Do not change the name</strong></td>
<td>All copies will have the same name as the original Spotlight group.</td>
</tr>
<tr>
<td><strong>Change the name</strong></td>
<td>Manually write a new name that will be given to all copies of the Spotlight group.</td>
</tr>
<tr>
<td><strong>Add element name to new name as prefix</strong></td>
<td>For each copy of the Spotlight group, the breakdown element name is added to the beginning of the Spotlight group name. You can keep the base name from the original Spotlight group or specify a new one. The New Name field does not show these prefixes.</td>
</tr>
<tr>
<td><strong>Add element name to new name as suffix</strong></td>
<td>For each copy of the Spotlight group, the breakdown element name is added to the end of the Spotlight group name. You can keep the base name from the original Spotlight group or specify a new one. The New Name field does not show these suffixes.</td>
</tr>
</tbody>
</table>

4. Fill out the remaining fields of the **Copy Spotlight Group** dialog:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Name</strong></td>
<td>Editable field showing the name of the Spotlight group copies you are creating. This field appears if you select any value for Name Preference other than Do not change the name. All copies have the same name unless you select Add element name to new name as prefix or Add element name to new name as suffix. The element name prefixes or suffixes do not appear in this field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Breakdown</td>
<td>If you specified a breakdown when you created the original Spotlight group, the breakdown name appears in this field. Otherwise, select a breakdown. Only the breakdowns that are associated with the main indicator are available.</td>
</tr>
<tr>
<td>Element</td>
<td>Select any number of elements for the specified breakdown. A copy of the Spotlight group is made for each selected element.</td>
</tr>
</tbody>
</table>

5. Click **OK**.
The Spotlight group is copied. If copying is successful, a list of the new Spotlight groups that you have created opens. If any error messages or warnings appeared during the copying process, read the *Spotlight group copy logs*.

6. Open each of the Spotlight groups you have created and perform the following steps:
   a. Review the Spotlight job schedule and adjust as necessary.
   b. Activate the Spotlight group.

**Example: Copying a Spotlight group for multiple breakdown elements**
In this example, you copy the Incident Spotlight group for the breakdown elements Category: Hardware and Category: Software.
1. Open the Spotlight Groups list and click **Incident**

2. The Incident Spotlight group record opens, and you click **Copy to Breakdown Element**

3. In the **Copy Spotlight Group** dialog, you specify the Category breakdown and select the Hardware and Software elements. You want the element names to appear at the end of the group
names, so you also select **Add element name to new name as**

**Copy Spotlight Group**

Copies the entire spotlight group with all the spotlight criteria.

The new spotlight groups will not be active. Please review the schedule time and Run as user before activating them.

- **Name Preference**: Add element name to new name as suffix
- **New Name**: Incident Spotlight
- **Breakdown**: Category
- **Element**: Available
  - Inquiry / Help
  - Network
  - Database
  - Hardware
  - Software

4. You click **OK**, and you go to a list showing you the Spotlight groups that you have created. Both Spotlight groups have the base name Incident Spotlight, as shown in the New Name field of the **Copy**
**Spotlight Group** dialog, with the element name added as a suffix.

5. Open the Incident Spotlight - Hardware group. Here you verify that the Spotlight job schedule is appropriate, and you activate the group.

6. You verify the schedule for the Incident Spotlight - Software group and activate the group.
What to do next
If any error messages or warnings appeared during the copying process, read the Spotlight group copy logs.

Spotlight group copy logs
When a Spotlight group is copied, the steps of the copying process are recorded in logs. Use these logs to debug any issues.

Users with the pa_spotlight or admin roles can read and delete Spotlight job logs.

The logs are listed at the following locations:

• At Spotlight > Spotlight Group Copy Logs.
• As the Spotlight Group Copy Logs related list on the relevant Spotlight Group record.

The same Spotlight Group Copy Logs list opens in both places, but in the Spotlight Group form, the list is filtered by that Spotlight group.

To debug a Spotlight group copying job, open the group copy log from the list and examine the log row fields. You can also open a group copy log from the notifications that appear at the end of a copying job.

Example: Group copy log with errors
In this example, the Incident Spotlight group was copied for the Assignment Group breakdown elements Database, Field Services, Hardware, and US Presidents Group 1. However, after the copying job has completed, a notification shows that copying failed for three of those elements.

Clicking Check the logs for details opens the Spotlight group copy log for this copying job. In this log, you can find the errors that caused each failure. In the following example, a business rule violation prevented the copy...
from being created. The error message instructs you to contact the System Administrator.

Administering Spotlight

Users with the admin role can access lower-level components of Spotlight.

Spotlight database views

Spotlight ensures that a database view joins the Spotlight [spotlight] table and the facts table whose records the Spotlight group evaluates. You need this database view to use Spotlight interactive analysis. Administrators can access this database view to create reports or to diagnose problems.

After creating the database view, Spotlight adds a reference to it in the related Spotlight Group record on the Spotlight Group [spotlight_groups] table. The reference consists of the primary key field value of the database view, which is in the database_view column of the record.
Note: If you upgrade from an earlier version than London, you start with an empty database_view value in the database_view column of your spotlight_groups records. This empty column has no impact. The column populates as users modify the records in the spotlight_groups table.

If you are an administrator, you can access the database view directly. To see the database view for a Spotlight Group, click the Show Database View related link on the Spotlight Group form. You can also add a Database View column to the Spotlight Groups list.

If the database view is missing or invalid, an error message appears on the Spotlight Group record. In this case, you can click the Generate Database View related link, which becomes available. A message appears afterwards to inform you whether database generation succeeded.

Spotlight group with missing database view

If you delete a Spotlight group, Spotlight deletes the database view associated with that group if it is safe to do so. To determine whether it is safe to delete the database view, Spotlight checks for the following conditions:

- Do any other Spotlight groups have a reference to that database view?
- Are any other Spotlight groups defined with a main indicator that uses the same facts table as the main indicator of the group that you are deleting?

If neither condition is true, Spotlight deletes the database view.
When creating, modifying, or deleting database views, Spotlight runs these business rules:

- Update Database View
- Delete Database View
- Set DB View on Insert

Related information
- Database views
- Activate Analytics and Reporting Spotlight solutions

Schedule Item [sys_trigger] records for Spotlight

Setting a Spotlight group to Active creates a Schedule Item [sys_trigger] record. As an administrator, access this record to troubleshoot scheduling. This record contains the scheduling information that is set on the Spotlight group.

Editing the schedule in the Spotlight group record replaces the Schedule Item [sys_trigger] record with a new one. Deactivating or deleting the Spotlight group deletes the Schedule Item record. If you reactivate the Spotlight group, you create a new Schedule Item record.

Note: As an administrator, you can access the Schedule Item [sys_trigger] record for a Spotlight group by clicking Show Scheduler on the Spotlight Group form.

The process of creating, editing, and deleting Schedule Item [sys_trigger] records uses business rules as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Business rule</th>
<th>Effect on Schedule Item record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activating a Spotlight group</td>
<td>Create Schedule Item [sys_trigger] record</td>
<td>A new Schedule Item [sys_trigger] record is created with the scheduling information.</td>
</tr>
<tr>
<td>Editing a schedule in a Spotlight group record</td>
<td>Create Schedule Item [sys_trigger] record</td>
<td>The existing Schedule Item [sys_trigger] record is replaced with a new record, with the new scheduling information.</td>
</tr>
</tbody>
</table>
### Spotlight group activation, business rules, and scheduling (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Business rule</th>
<th>Effect on Schedule Item record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivating a Spotlight group</td>
<td>Delete Schedule Item [sys_trigger] record</td>
<td>The existing Schedule Item [sys_trigger] record associated with that Spotlight group is deleted.</td>
</tr>
<tr>
<td>Reactivating a Spotlight group</td>
<td>Create Schedule Item [sys_trigger] record</td>
<td>A new Schedule Item [sys_trigger] record is created with the scheduling information.</td>
</tr>
<tr>
<td>Deleting a Spotlight group</td>
<td>Delete Schedule Item [sys_trigger] record</td>
<td>The existing Schedule Item [sys_trigger] record associated with that Spotlight group is deleted.</td>
</tr>
</tbody>
</table>

### Analytics and Reporting Spotlight solutions

These solutions contain pre-configured Spotlight components. The solutions also contain dashboards that present the same information as Spotlight interactive analyses.

The following Spotlight solutions are available with Complimentary Performance Analytics for Incident Management:

- Spotlight — Change Spotlight Performance Analytics Solution (com.snc.pa.spotlight.change)
- Spotlight — Incident Spotlight Performance Analytics Solution (com.snc.pa.spotlight.incident)
- Spotlight — Problem Spotlight Performance Analytics Solution (com.snc.pa.spotlight.problem)
- Spotlight — Request Spotlight Performance Analytics Solution (com.snc.pa.spotlight.request)

Spotlight groups may be included in other Analytics and Reporting Solutions that require the fully licensed version of Performance Analytics. For example, the Customer Service (com.snc.pa.customer_service) Solution includes the Case Spotlight group.
Activate Analytics and Reporting Spotlight solutions

To use Spotlight, activate the Spotlight plugin. Also activate any of the Spotlight solution plugins that apply to how you use the product. After you install Spotlight solutions, follow the Guided Setup to explore and customize those solutions.

Before you begin

- Analytics and Reporting Spotlight Solutions other than Incident Spotlight require fully enabled, subscription version of Performance Analytics. See Activating your Performance Analytics subscription.
- Performance Analytics Responsive Dashboards must be active. For more information, see Working with responsive dashboards.

Role required: admin

About this task
Spotlight functionality is not available until you activate the Performance Analytics - Spotlight plugin (com.snc.pa.spotlight). You can activate the plugin directly or through activating your first Spotlight solution plugin.

Each Spotlight Solution provides the following:

- A Spotlight dashboard for the relevant application. The information in this dashboard is similar to the information in the Spotlight interactive analysis. The reports in these dashboards can be used in other dashboards.
- A preconfigured Spotlight group. The Spotlight group defines which records to evaluate for prioritization, based on a specified indicator. The Spotlight group also defines which criteria to use to evaluate the data and the schedule for evaluating the data.
- Several spotlight criteria based on common business use cases.
- A database view joining the Spotlight table to the facts table that is the source of the main indicator of the Spotlight Group. Both the Spotlight dashboard for the solution and the Interactive Analysis use this database view. For more information, see Spotlight database views.

After Spotlight solutions are activated, use Guided Setup to walk you through the Spotlight solutions. Navigate to Spotlight > Guided Setup and follow the instructions there.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

<i>Note:</i> When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for &lt;plugin name&gt;.*

**What to do next**

If you have activated a Spotlight solution, examine the Spotlight group and Spotlight criteria for that solution. A Guided Setup is available to walk you through the solution. Navigate to **Spotlight > Guided Setup** and follow the instructions there.

**Example: Incident Spotlight**

This example describes the settings in the Incident Spotlight group, which is included in the Incident Spotlight Analytics and Reporting Solution. The example includes the results of a Spotlight job and the details of a resulting Spotlight record.

The Incident Spotlight solution includes the Spotlight group Incident Spotlight. This group uses the indicator **Number of open incidents** and has a threshold of 1000. Because the **Number of open incidents** indicator uses the incident facts table as its source, the Spotlight job evaluates records in that table.

The Incident Spotlight group has a job scheduled to execute every day at 1500. Set the group to **Active** for the job to execute according to the schedule.
The Incident Spotlight group has Spotlight Criteria related to:

- How long the incident has been open
- How long since the incident has been updated
- Whether the incident has a description
- Whether the incident has been reassigned more than three times
- Whether the priority of the incident is Low or Moderate. (Critical and High priority incidents are not expected to require Spotlight.)

Each criterion is assigned a weight, which varies in this case from 1 for a priority of P4 Low to 1000 for not being updated for more than 30 days.

When a data evaluation job executes, it evaluates the records of the incident facts table. Each record is given a score equal to the sum of the weights of the criteria that the record meets. The job generates a Spotlight for each incident record with a score that meets or exceeds the group threshold of 1000.
Clicking an information icon for a Spotlight shows the details of which criteria contributed to the score. For example, Incident INC0007001 met the following Spotlight criteria:

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incidents older than 28 days</td>
<td>25</td>
</tr>
<tr>
<td>Incidents older than 14 days</td>
<td>25</td>
</tr>
<tr>
<td>Open incidents not updated 30 days</td>
<td>1,000</td>
</tr>
<tr>
<td>Incidents older than 7 days</td>
<td>25</td>
</tr>
<tr>
<td>Incidents older than 90 days</td>
<td>25</td>
</tr>
<tr>
<td>Open incidents not updated 5 days</td>
<td>100</td>
</tr>
</tbody>
</table>

**TOTAL SCORE:** 1,200

The results of the Spotlight job are visible on the Incident dashboard, which is in the Spotlight group. This dashboard is
identical to the interactive analysis of the Incident Spotlight group.

Natural Language Understanding

ServiceNow® Natural Language Understanding (NLU) provides an NLU Workbench and an NLU inference service that you can use to enable the system to learn and respond to human-expressed intent. By entering natural language examples into the system, you help it understand word meanings and contexts so it can infer user or system actions.
NLU terminology
In NLU parlance, these terms identify the key language components the system uses to classify, parse, and otherwise process natural language content.

Intent
Something a user wants to do or what you want your application to handle, such as granting access.

Utterance
A natural language example of a user intent. For example, a text string in an incident's short description, a chat entry, or an email subject line. Utterances are used to build and train intents and should therefore not include several or ambiguous meanings or intents.

Entity
The object of, or context for, an action. For example: a laptop, a user role, or a priority level.

System defined entity
These are predefined in an instance and have highly reusable meanings, such as date, time, and location.

User defined entity
These are created in the system by users and can be built from words in the utterances they create.

**Common Entity**
A context commonly used and extracted via a pre-defined entity model, such as currency, organization, people, or quantity.

**Vocabulary**
Vocabulary is used to define or overwrite word meanings. For example, you can assign the synonym “Microsoft” to the acronym “MS”.

**NLU Model**
A collection of utterance examples and their associated intents and entities that the system uses as a reference to infer intents and entities in a new utterance. You can create default models tailored to business unit consumers, such as an ITSM Model, a CSM Model, a Federal Model, or a Boeing Model.

This image illustrates how Natural Language Understanding processes and renders utterance examples into intents and entities in the system.

**NLU Workbench**
Use the NLU Workbench to create morphological representations of human language. These models enable you to create intents and entities expressed in natural language utterances. Any ServiceNow application can invoke an NLU model to get an inference of intents and entities in a given utterance.

Using the `nlu_admin` role, you build your models in the NLU Workbench, where you create, train, test, and publish them iteratively.
For information on how to build and use an NLU model, see: Create an NLU model.

NLU inference service

Natural Language Understanding provides an NLU inference service that helps the system to understand natural language and drive intelligent actions. This service trains and predicts intents and entities for a given user utterance in your model so that its text translates into machine-understandable formats, such as APIs and parameters.

Here, the system uses an inference API to train NLU algorithms by using sample record data to identify intents and entities that are strong candidates for accurate prediction.
NLU model consumption

Other ServiceNow® applications consume NLU model output, such as Virtual Agent.

For example, Virtual Agent administrators can configure a Virtual Agent Designer conversation flow to consume NLU models so that agent chatbots can better understand user statements in the conversation. For more information on how Virtual Agent consumes NLU models, see: Natural Language Understanding in Virtual Agent.

Activate the NLU Workbench

Activate the following plugins to activate NLU Workbench.

Before you begin
Role required: admin

About this task
Activate the following plugins if they aren't already active in your instance.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLU Workbench - Core com.glide.nlu</td>
<td>Installs the required tables for persisting NLU models that are created using the NLU Workbench.</td>
</tr>
<tr>
<td>NLU Workbench com.snc.nlu_studio</td>
<td>Enables the creation of Natural Language Understanding (NLU) models. These models can understand</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>the intent (action) and entities (details about the action) for a given user utterance. Any ServiceNow application can invoke an NLU model. Requires the NLU Workbench - Core plugin.</td>
</tr>
<tr>
<td>Predictive Intelligence</td>
<td>Enables the NLU Service APIs used for model creation and inference. Enables the creation of machine learning solutions using data in your instance. The plugin provides various capabilities and solution types for training the system to predict, recommend, and drive data outcomes. A trained solution can be invoked by any application through the use of a prediction API.</td>
</tr>
<tr>
<td>com.glide.platform_ml</td>
<td>Enables the NLU Service APIs used for model creation and inference. Enables the creation of machine learning solutions using data in your instance. The plugin provides various capabilities and solution types for training the system to predict, recommend, and drive data outcomes. A trained solution can be invoked by any application through the use of a prediction API.</td>
</tr>
<tr>
<td>NLU Common Model</td>
<td>Packages all language NLU common models. Also includes commonly used pattern entities that can be imported and used in any NLU model in the NLU Workbench. Commonly used patterns like email, phone, and ServiceNow specific pattern entities such as INT, RITM are made available. Requires the NLU Workbench - Core plugin.</td>
</tr>
<tr>
<td>com.glide.nlu.model</td>
<td></td>
</tr>
</tbody>
</table>

The following two plugins are for apps associated with a for-fee subscription and are available on the ServiceNow Store. Installing these apps adds additional features to the NLU Workbench. Contact your account manager if you are interested in these apps.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intent Discovery</td>
<td>Delivers the Intent Discovery feature. Intent Discovery identifies user intents from analyzing incident/case data. Use this application to help identify which intents to model and build Virtual</td>
</tr>
<tr>
<td>sn_nlu_discovery</td>
<td>Delivers the Intent Discovery feature. Intent Discovery identifies user intents from analyzing incident/case data. Use this application to help identify which intents to model and build Virtual</td>
</tr>
</tbody>
</table>
### Plugin Description

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent conversations to attain maximum</td>
<td>For more information, see Install Intent Discovery.</td>
</tr>
<tr>
<td>deflection.</td>
<td></td>
</tr>
<tr>
<td>NLU Workbench - Advanced Features</td>
<td>Delivers the NLU Conflict Review, NLU Batch Testing and NLU Model Performance features. For more information, see Install NLU Workbench - Advanced Features.</td>
</tr>
<tr>
<td>com.snc.nlu.workbench.advanced</td>
<td></td>
</tr>
</tbody>
</table>

## Procedure

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the following plugins using the filter criteria and search bar: NLU Workbench - Core (com.glide.nlu), NLU Workbench (com.snc.nlu_studio), Predictive Intelligence (com.glide.platform_ml), and NLU Common Model (com.glide.nlu.model).

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

## NLU Workbench properties

Refer to the default system properties for the Natural Language Understanding (NLU) product

## NLU Workbench default properties and values

To access your default system properties, use the admin or nlu_admin role and the following navigation: **NLU Workbench > Properties**.
<table>
<thead>
<tr>
<th>Label and Name</th>
<th>Value</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of utterances per intent</td>
<td>200</td>
<td>NLU Workbench</td>
</tr>
<tr>
<td>glide.nlu.utterances_per_intent.value_limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable pre-built vocabulary for software names</td>
<td>enabled</td>
<td>NLU Workbench</td>
</tr>
<tr>
<td>glide.mlpredictor.option.nlu.@LookupSources:software</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable pre-built vocabulary for hardware names</td>
<td>enabled</td>
<td>NLU Workbench</td>
</tr>
<tr>
<td>glide.mlpredictor.option.nlu.@LookupSources:hardware</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum number of records in a Table vocabulary source</td>
<td>100,000</td>
<td>NLU Workbench</td>
</tr>
<tr>
<td>glide.platform_ml.api.max_nlu_lookupsource_records</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum number of records in a List vocabulary source</td>
<td>1,000</td>
<td>NLU Workbench</td>
</tr>
<tr>
<td>glide.nlu.static_lookup.value_limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum number of records for Intent Discovery classification</td>
<td>300,000</td>
<td>Intent Discovery</td>
</tr>
<tr>
<td>sn_nlu_discovery.intent_discovery_max_classification_limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimum number of records for Intent Discovery classification</td>
<td>10,000</td>
<td>Intent Discovery</td>
</tr>
<tr>
<td>sn_nlu_discovery.intent_discovery_min_classification_limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimum number of records for NLU performance analysis</td>
<td>5,000</td>
<td>NLU Workbench - Advanced Features</td>
</tr>
<tr>
<td>sn_nlu_workbench.glide.nlu.performance_min_clustering_records</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NLU Conflict Detection - Critical Threshold</td>
<td>.09</td>
<td>NLU Workbench - Advanced Features</td>
</tr>
<tr>
<td>Label and Name</td>
<td>Value</td>
<td>Plugin</td>
</tr>
<tr>
<td>----------------</td>
<td>-------</td>
<td>--------</td>
</tr>
<tr>
<td><code>sn_nlu_workbench.glide.nlu.conflict.critical_threshold</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NLU Conflict Detection - Moderate Threshold</td>
<td>.08</td>
<td>NLU Workbench - Advanced Features</td>
</tr>
<tr>
<td><code>sn_nlu_workbench.glide.nlu.conflict.moderate_threshold</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Controls the maximum number of rows a batch test import file can have</td>
<td>10,000</td>
<td>NLU Workbench - Advanced Features</td>
</tr>
<tr>
<td><code>sn_nlu_workbench.glide.nlu.batch_test.max_import_rows</code></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### NLU language support

The NLU Workbench application provides support for creating NLU models in different languages for use in other applications, such as Virtual Agent.

Here, the platform supports NLU for 16 languages. The following 5 of the 16 languages available to your models have both intent and entity support: English, French, German, Spanish and Japanese. Japanese entity support includes character annotation. The remaining 11 languages have intent-only support: Brazilian Portuguese, Simplified Chinese, Danish, Dutch, Finnish, French Canadian, Italian, Korean, Norwegian, Polish, and Swedish.

With intent and entity support, NLU can understand sophisticated utterances, such as intent-entity relationships, system-defined entities, and user-defined entities. With this, Virtual Agent using NLU has more information up front and the user is usually taken directly to the conversation topic that offers resolution.

With intent-only support, the focus is on intent recognition. With Virtual Agent using NLU, users are directed to the desired conversation topic, where qualifying follow-up questions may be asked before being taken to a topic that offers resolution.

<table>
<thead>
<tr>
<th>Available from NY</th>
<th>Available from Paris</th>
<th>Newly Introduced in Quebec</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>German, French</td>
<td>Japanese, Spanish, Brazilian Portuguese, Chinese (simplified), Korean, Swedish, Dutch, Italian, Canadian French, Polish, Finnish, Danish, Norwegian</td>
</tr>
</tbody>
</table>
NLU support for English has existed since the New York release, and French and German languages since Paris; hence they are more mature. The 13 new languages introduced in Quebec perform at varying levels of AI prediction accuracy, and we’re working with early adopters to mature the AI prediction accuracy over the next releases. If you’re interested in any of these newly introduced languages, before starting the implementation, we recommend that you contact your account team, where a ServiceNow expert will reach out to you in order to help guide you on your implementation journey.

If NLU isn’t supported in a language or doesn’t have sufficient quality in its current iteration, it’s possible to implement NLU in the supported languages and use keyword fallback in other languages in your Virtual Agent application. Please see this article for details.

Below is a checklist of the currently available NLU languages and the intents, entities, vocabulary, features, and applications they support.

**Note:** The system will take more time to train models that use the following 6 languages, since the training occurs asynchronously: Brazilian Portuguese, Canadian French, Danish, Finnish, Norwegian, and Swedish. Training can take anywhere from about 30 minutes to a few hours depending on the server traffic.

### Multilingual model management

Use this feature to maintain a consistent NLU model structure for intents and entities across languages to provide a unified experience.
Migration to language grouping

This optional feature includes a one-time migration of the NLU models in your instance. The migration groups your existing models into primary and secondary models, and indicates the primary language and primary model for the group. Each time you add a different language to the primary model, the system creates a secondary model for each language you add.

To access multilingual model management, use the admin or nlu_admin role to navigate to NLU Workbench > Models. The first time you access this screen, the following image appears, and shows you two options you can choose to either invoke or delay the one-time migration.

1. Click **Review groups** to have the system begin grouping your models immediately.

2. Click **Do this later** to defer the migration until a later time. When you choose option 2, the Models screen adds the **Group my models** link to the uppermost right section of the screen, as shown in the following image. The link remains there until you click it, which starts the migration.
The time it takes the system to group your models depends on how large they are and how many of them you have.

**Note:** This migration is a recommended step you should take as soon as you upgrade to Rome, as the migration is foundational for using multilingual models.

**Primary and secondary languages**

A primary language is the source language in which you create your models to begin with. These source models are labeled as your primary models, which you can translate into various languages. Your translated models are referred to as secondary models, and the languages in which they are translated are referred to as secondary languages. After the migration groups your models, the secondary models are nested under the primary model group in the user interface.

Multilingual model management provides a way for you to group, oversee, and update your NLU models and their translated languages by using primary and secondary models as defined below.

- Primary models have a language you assign to them during model creation, such as `en-us` for English. The language the primary model has is the source language for the translations that follow later in the secondary models.

- Secondary models are translated copies of the primary model, where each secondary model uses a different language, such as `FR` for France, `DE` for Germany, `JA` for Japanese, and `ES` for Spanish.

- Any supported language can be the primary language for a primary model or the secondary language for a secondary model.

**Primary and secondary model interactions**

To ensure consistency within a model group, the names of intents and entities in all secondary models are the same as those in the primary model. New intents can only be created in a primary model. Creating a new intent in a primary model creates a new intent in all of the secondary models within the model group, but without any utterances in them. These new intents are disabled by default. New entities can also be created in secondary models. Creating a
new entity in a primary model creates it across all secondary models within the model group.

When you add an intent to a primary model, the intent is added to all of its secondary models, and every intent in a secondary model is mapped to its corresponding intent in the primary model. This ensures that any application that intends to access these intents can access all of the secondary intents through their corresponding primary intents.

When you delete an intent or entity in a primary model, its corresponding intents and entities are also deleted in its secondary models. This is because secondary model content is only a translated copy of its primary model content. Therefore it must always follow the status of the primary model content. Although you can't delete intents in secondary models, you can disable them during editorial and translation review cycles.

You can't delete an entity created in a secondary model if it's a copy of a corresponding entity created in the primary model. However, you can add or delete an entity in a secondary model if it doesn't have a corresponding entity in the primary model.

When you add a new language to a primary model, which generates a secondary model, the secondary model becomes the vessel in which the secondary language translation activities occur. When the translations are completed, the secondary model is marked with the Needs review state.

If all of the intents in a secondary model are disabled, then the Train and Test buttons are also disabled in the model. However, even if only one intent is enabled in the model, then you can train and test the model. Ultimately, the goal is to get the primary model content translated into the secondary models, each of which will contain a distinct language translation.

**Note:** Within a model group, you can't have two secondary models that use the same language. For example, a model group can only have one secondary model that uses the Italian language.

**Note:** Prediction scores for similar utterances across primary and secondary models can be different. This is expected behavior and the scores don't have to be similar. The context comes across differently among languages due to inherent structural variations.

You can also navigate between languages in a model group. For example, the primary language you're using in a primary model is English-en, and you select French-fr from the language prompt to navigate to the French secondary model in the group.
Reviewing your newly grouped models

After the migration completes and your models are grouped together, the **Review recommended model groups** screen appears, where the system has a feed that pulls models that have intent and entity mappings from Virtual Agent (VA), when available.

There are two things you can do on this screen when using the nlu_admin role.

- Review and if needed, edit the recommended model groups based on your existing VA mappings.
- Manually group the ungrouped models in the **Here are your ungrouped models** section of the screen.

If you’re satisfied with the recommended model groups, then leave them as they are. If you want to update their VA mappings or to make one of their secondary languages the primary language in the group, then you can do so.
In this example scenario, you click **Edit** on the model group row, which invokes the following screen.

On the **Review mappings in this group** screen, you can reconfigure which model is the primary model in the model group, and which models are the secondary models. You can also add and remove secondary models and make changes to the intents. When you finish all of your edits, click **Save**.

When your review is completed, click **Finish**, which invokes a confirmation screen, as shown in the image below.
Click **Finish** again.

**Result:** The Models screen appears, showing a banner that lets you know your instance is now using grouped language models.

### Cloning grouped models and model groups

Using the nlu_admin role, you can clone primary models, secondary models, and entire model groups. When cloning a primary model, you can clone just the primary model or a set of secondary models from among the model group.

Here is a list of system behaviors you may encounter when you clone these models.

- If you clone a secondary model that’s in a model group, the cloned version becomes a separate primary model that is outside that model group.

- Intents are cloned regardless of being enabled or disabled, and the cloned version carries forward the enabled or disabled status of the original intent.

- When cloning a primary model, you can clone a set of secondary models, or all of the secondary models along with it. This action creates a new model group comprised of cloned versions with the respective original models marked as the source models.

- When cloning a model group, you can choose an existing secondary model to be the primary model for the cloned group.

- If you select a secondary model in an existing model group as a new primary model while cloning the group, all the disabled entities are enabled for the cloned version of the secondary model. This is because it’s now the primary model in the cloned model group.

- If you clone a primary model without any secondary model, the cloned version becomes a separate primary model.
Translate a multilingual model

Use this feature when your NLU model requires more than one language.

Before you begin

• Opt into the multilingual model management one-time migration that groups your existing NLU models into primary and secondary models.

• Activate the Localization Framework (com.glide.localization_framework.installer) plugin. See Activation of Localization Framework.

• Create or use an existing primary model that has at least one secondary model.

• Role required: nlu_admin or nlu_editor

About this task

When you use the multilingual model management feature to create a new model and choose a language for it, the system marks it as a primary model. When you add other languages to the model, the system automatically creates a secondary model for each new language, and collects them into a model group. The secondary models have intent and entity names that are pre-filled in the secondary language and not editable. Each model group has a caret before its name. Click the caret whenever you want to expand or collapse the model group. The primary model alone has the Enable Language option.

To translate a primary language into a secondary language, you must choose a translation mode. These modes appear in the user interface as individual cards which you use in Step 4 of this procedure. Activated cards appear surrounded by a thin green border. Inactive cards appear surrounded by a light grey shadow. When a card is activated, you can select it as your translation mode. For the Use Software and Use a third party modes, when you click Add after clicking an activated card, the actual translation occurs.

The Without translation mode is active by default and available for all languages. However, the Use Software and Use a third party modes are activated only when the localization framework (LF) settings for the secondary language are in place.

Note: Before you add the new secondary language, you must ensure that the LF settings for the secondary language are completed.

Multilingual models are supported in the following 16 languages: English, French, German, Japanese, Spanish, Brazilian Portuguese, Chinese (simplified), Korean, Swedish, Dutch, Italian, Canadian French, Polish, Finnish, Danish, and Norwegian.
It helps to keep in mind that secondary models are only a translated copy of the primary model. In essence, you create secondary models by translating the primary model.

**Note:** If you delete a primary model, the system deletes all of its secondary models.

In this example scenario, your primary model uses the English language and you’re translating it into the Spanish language. In this example procedure, you choose the *Use software* translation option with IBM as the translation service provider.

**Procedure**

1. Navigate to **NLU Workbench > Models**.

2. Identify a primary model to which you want to assign a secondary language. In this example scenario, you’re using the CSM for Virtual Agent primary model, and you’ve already added the Italian language to the model, as shown in the image below.

3. In the row where the primary model resides, click the three dots on the farthest right column of the screen, then click **Add a language**. You can view and act on the Add a Language option regardless of your scope or the model scope. Secondary models are always created in the same scope as the primary model scope.

4. In the **Add another language to this group** screen, configure the following fields.
a. **Primary Language**: The system automatically sets the field to English-en because in this example scenario, that's the language you assigned to the primary model when you first created it.

b. **Language**: Select the language you want to use in your secondary model. In this example scenario, you select Spanish-es for the translation.

c. **How to translate**: Choose one of the following modes to use for your translation.

   - **Without translation**: This is the default mode, where you can manually translate your primary language into a secondary language. Selecting this mode creates a draft secondary model with the intent names the same as that of the primary model. These intents are disabled by default, and you must enter your utterances manually. Intent names and names of entities imported from the primary model aren't editable. Names of entities that you create directly in the secondary model are editable. This mode is also helpful if you want to draft and save the primary model first, and then translate your utterances later.

   - **Use software**: Automatically translate using machine intelligence providers, such as Google or IBM. When you click an activated Use Software card, the system creates a translated secondary model in the Review state almost instantaneously. To activate the Use Software mode, users must select the Enable Machine Translate button in the LF settings. Note that these dynamic translation services can sometimes translate too literally, where the word “outlook” used in a sentence refers to a person’s perspective rather than the Microsoft Outlook email product. This is why a human must review and sometimes update each translation to ensure it uses the correct context. If the context is missing or inaccurate, it can heavily skew the results when you try to train and test a model. For more information, see Dynamic Translation.

   - **Use a third party**: Request translation by a professional translation team. When you select this mode, an LF task is created per the LF language group settings for the secondary language. To activate the Use a third party mode, you can select any or all of the options in the LF settings. When the translations are completed, the translated model is created in the Needs review state. Both this Use third party mode and the Use software mode above are defined by LF configuration settings. For more information, see Localization Framework and Translation modes.

   - **Note**: Localization Framework doesn’t support the Danish language. Therefore, the Use software and Use a third party modes aren’t available for the Danish language. You can, however, use the Without translation mode for the Danish language translation.
d. Click one of the activated cards for the mode you want to use for your translation. In this example scenario, you click the **Use software** card. If the **Use software** card is activated, the **Use a third party** card is also activated. If the **Use a third party** card is activated first, the **Use software** card may also be activated, but not in all scenarios.

e. Click **Add**.

Results:

- The screen refreshes to show your new secondary model with its Intents section highlighted, as shown in the image below. The intents are disabled by default, and until you enable them they are unavailable to other NLU models and applications. You can train, clone, and delete your new model from this screen, but the Test and Publish buttons are disabled by default. This enable/disable capability is used to accommodate the editorial review process by restricting access to the intents during translation and review. In addition, when an intent is disabled it’s not available for intent and entity predictions when you train and test the model. For example, a model has three intents that are mapped to a Virtual Agent (VA) topic. You decide not to use the first intent in the topic, so you disable it. However, until you train the model, that intent is still available for VA and predictions. So after you disable the intent, you must click **Train** to make the intent unavailable to VA and predictions.
In the Entities section of your secondary model, you can see the System Defined Entities are already translated into the language you assigned to the model, which in this scenario is Spanish. Note that these entities are enabled by default. This means they are available to any other NLU models unless you disable them again.

When you create a secondary model, the system adds it to the primary model group, where it's nested underneath the primary model, as shown in the image below. Because you chose the Use Software translation option, when you first translate the secondary model, the system translates the following model components into the secondary language: System Defined
Entities, utterances, vocabulary, and mapped entity values. In this example scenario, the system translates the components into the Spanish language.

What to do next
Repeat steps 1 through 4 for each new language you want to add to the model group.

Enable or disable a secondary model intent
Temporarily disable an intent while editors or admins author, review, or update its content and translations.

Before you begin
Role required: nlu_admin or nlu_editor

About this task
NLU admins and NLU editors can enable or disable intents in secondary models. If an intent is disabled, it won’t impact the predictions made by the model, but it also can’t be accessed by any ServiceNow application, such as Virtual Agent (VA) or Search.

Secondary model intents that are marked with the Needs review state are disabled by default so that others can’t access them during the translation review process. This allows you time to review the intent translations and update them if needed. When you’re satisfied with the content and enable the intent, it becomes accessible to other NLU models and ServiceNow applications. So any time you review an intent that has the Needs review status, you must first ensure that the intent is disabled. After you complete the review you can enable the intent.

Note: If you disable a secondary model intent that is already mapped to a VA topic, a message appears that asks you to confirm your decision.
In this review example, you have a list of disabled intents in the Needs review state. The goal of this task is to review, and update if necessary, the translated content for a secondary model. When you complete your review, or if the content is fine as it is, you click Mark as reviewed. This moves the intent into the Reviewed state. You can also undo the Mark as reviewed state for an intent by clicking the Unmark Reviewed button, but only as long as you remain on the Intent screen. If you leave the screen prematurely, the Unmark Reviewed button disappears and you won’t be able to retrieve it.

The editorial review also includes the Vocabulary section on the Model screen, where vocabulary that has been translated from the primary model to the secondary model is marked with an orange dot and the Needs review state. You can edit or delete the vocabulary items, even if they are in review. After you review the vocabulary and update the translations if needed, you can mark all of them at once by clicking the Mark all reviewed button. This action makes the orange dot disappear from the Vocabulary section of the Model screen.

**Note:** The Train and Test buttons on the Model screen are disabled until the vocabulary is reviewed, and the intents in the Needs review state are either reviewed or disabled.
In this example scenario, you have applied the Use Software translation mode to translate a secondary model into the Japanese language. Because the translation hasn’t been reviewed yet, the system marks the intents and the model with the Needs review state. When a model is in the Needs review state, it can’t be trained, tested, or published. When it moves out of the Needs review state, you can then train and test the model.

Note: An NLU editor can’t create or publish a model. Only the NLU admin has the permissions to do this.

In this example procedure, you’re reviewing the intents in the model one at a time.

Procedure

1. Navigate to NLU Workbench > Models.
2. Locate one of your secondary models that has already been translated. In this example scenario, you locate the Virtual Agent Conversation Setup JA model, as shown in the image below.
   In the Intents section of the model, there’s a list of five intents that are marked with the Needs review state. Above the list of intents, there’s also a box that shows a running count of the intents that need review.
3. Click an intent Name so you can access the intent content. In this scenario, you click the #End Conversations intent name.

4. Review the secondary language translations of the model intent names, utterances, entities, and vocabulary. Update the content if needed. When you finish your review of the intent, the Mark as reviewed button appears.

5. Click Mark as reviewed. Result: The system updates the #End Conversations intent from the Mark as reviewed state to the Reviewed state. In addition, the reviewed intents box changes its running count from 0 of 5 to 1 of 5.

6. If you're satisfied with your intent review, click the Enable button so the intent is available and can be accessed by any application, such as Virtual Agent (VA) or Search.

What to do next
Repeat Steps 1 through 6 for the four remaining intents in the list. As each intent review completes and is marked with the Reviewed state, the running count in the intents reviewed box increases toward 5 of 5.

Assign an NLU editor to a model
Assign an NLU editor to review and update your language model translations, vocabulary, and model structure as needed.

Before you begin
• Create or use existing primary and secondary models.
• Role required: nlu_admin

About this task
The nlu_editor role enables your organization to restrict the access for certain users to certain models. For example, only nlu_admins can assign or remove an editor to a model. However, even nlu_admins can't assign an editor to a prebuilt model, as those models are in read-only status. They also can't assign an editor to a model that has a translation in progress.

NLU editors can't create, add, delete, or clone models, and only have access to review, edit, train, and test the models they are assigned to. They can't publish models, even if the model is assigned to them.

NLU editors must be proficient in building an NLU model, and in reviewing the accuracy of the model translations. In addition to language translations and vocabulary, editor reviews cover the model structure, intents, entities, utterances, and model maintenance concerns, such as the language
consistency between primary and secondary models and their intent and entity names. Editors can also disable or enable an intent, and train and test a model. However, they can’t publish the model; that act requires the use of the nlu_admin role.

When you assign an editor to a model, you must do so at the model level. You can’t assign an editor at the model group level.

Now let’s take a look at the access and permissions that NLU editors use.

NLU editors have read-only access to all language models, and they have the skills required to perform the editorial actions on the models that are assigned to them. NLU editors assigned to models that are in the Needs review state have access to mark the models as Reviewed.

When NLU editors are assigned to a secondary model:

• They have access to enable and disable intents, and can add, edit, and remove utterances. They can also annotate utterances for entity marking purposes. They can train and test models, but can’t publish them.

• They can update entity properties other than the name of an entity. They can also add and update vocabulary, and modify the model confidence threshold.

When NLU editors are assigned to a primary model:

• They can add, edit, and delete utterances. They can also annotate utterances for entity marking purposes. They can train and test models, but can’t publish them. NLU editors can add and edit intents and entities in primary models.

• They can delete intents and entities and can add new vocabulary too. They can also modify the model confidence threshold and edit the names of intents and entities.

In this example procedure, you add NLU editors to primary and secondary models.

Procedure

1. Navigate to NLU Workbench > Models.

2. Identify any primary and secondary models you want to assign to NLU editors.

3. In the row of the model group where the target model resides, click the three dots on the farthest right column of the screen, then click Assign to editor. If there are other editors already assigned to the model, the system instead has you click Manage editors.
The Assign model to an editor screen appears and shows the translation language assigned to the model and a list of editors you can choose from to review the model.

4. Search for the NLU editor you want to assign to the Italian secondary model. In this example scenario, you search and assign NLU editor Abel Tuter.

5. Click Save.
**Result:** NLU editor Abel Tuter is assigned to the Italian secondary model nested under the CSM for Virtual Agent primary model on the Models screen, as shown in the following image.

![Model assignment image](image)

When you save an editor to a model, the editor's initials appear on a badge in the **Editors** column on the Models screen. These badges appear on the rows of all models wherever an editor is assigned, and if you point to the badge, you can see the editor's name.

![Badge with editor name](image)

In addition, whenever an editor is assigned, the system shows a running count of the number of editors assigned to the models in a model group.

![Count of editors](image)

**Import primary model content to a secondary model**

After your secondary models are translated and you need to make a change, you can expedite the revision process by importing primary model content directly to the secondary model.

**Before you begin**

Role required: nlu_admin or nlu_editor
About this task
You can import primary model content to a secondary model so that after the initial translation, if you modify the primary model, those changes can be imported to your secondary models without the need to translate the entire primary model once again.

In this example scenario, you have the ITSM English - us primary model in the Reviewed state, and you've added a new utterance to an intent in the model, which creates new translations in all of the secondary models under the primary model.

In this example procedure, you access the Covid perks intent to confirm the import of the new translated utterance.

Procedure
1. Navigate to NLU Workbench > Models > ITSM.
2. Access a secondary model that has been translated under the ITSM primary model.
   In this example scenario, you access the ITSM French - fr secondary model. In the Intents section of the secondary model screen, there are four intents that are in the Reviewed state.
3. Click Check primary model for new content.
4. Click the Covid perks intent Name so you can access the intent content and locate the French translation of the new utterance.

In the Utterances section of the Covid perks intent screen, the new utterance appears. Because the user interface shows you the primary (English-us) utterance underneath the secondary (French) utterance, you can compare the two of them to confirm that the new translation import has been successful.
**Result:** The utterance you imported from the primary model has been successfully translated and appears in the list of utterances in the French secondary model.

**NLU Service updates**

Refer to this documentation so you are up to date with changes to the NLU Service.

**Service update summary**

The NLU Service helps the system to understand natural language and drive intelligent actions. This service trains and predicts intents and entities for a given user utterance in your NLU model so it can understand human-expressed natural language, whether spoken or written.

This service is updated independently of your instance upgrade, and without any action required by you. This is done on a bi-monthly basis (once every two months) to improve the quality of NLU model training and predictions. While most of these updates don't impact your existing use of NLU, there may be some changes you need to be aware of.

**March NLU Service update**

The NLU Service was updated around March 18, 2021 (the exact date/time depends on your datacenter location). This update was minor and included mostly defects that were fixed. Customers who are already using the Quebec backend service will automatically get this update. Please see below how
you can check which version you are currently using. The March update will continue to use the 3.1.2-HYB version.

**Benefits of the March update to the NLU Service**

There are a couple of key benefits from the March update.

1. If you try an utterance which is exactly similar to an utterance found in the model, the prediction confidence will be closer to 100%.
2. With system-defined entities, entities are normalized when they are extracted. In other words, entity values are extracted in a normalized/standard form irrespective of how they are expressed in an utterance to make it easy to consume in a Virtual Agent topic.

January NLU Service update

The NLU Service was updated in January 2021. You can refer to this major update as the initial Quebec version for the NLU Service, or shortly referred to as Q.0. Note that the ServiceNow family release for Quebec is in March 2021, which includes updates to other ServiceNow capabilities and applications and requires you to upgrade your instance. The NLU Service update is independent
of your instance upgrade to Quebec, and refers to the NLU Service used for NLU training and predictions.

If you’re on a Paris instance, there will be no change in behavior to your existing NLU models (even if you retrain them) after this update, as we will continue to use the prior version of the NLU Service.

If you’re creating new models on your Paris instance after this update, you’ll benefit from the upgraded version which has significant quality improvements for NLU predictions. Note that the updated version will automatically become your default version of the NLU Service (for both existing and new models) if you have recently upgraded your instance to the Quebec family release.

If you wish to change the default NLU service version for any reason, you can use a system property as described later in this documentation.

**Benefits of the January Upgrade to the NLU Service**

1. Utterances are now case insensitive with the updated version of the NLU Service. When training an intent, you don’t need to provide the same utterance in a different case. If there are specific words that need to be case specific, use regex-based vocabulary so that the case specific meaning is used to understand the intent.

2. Precision Improvements:
   - There’s an improvement in identifying gibberish and skipping predictions rather than still mapping it to one of the existing intents.
   - Better score range for intents: The confidence scores will be spread for intents so that there is a clear difference between the correct intent and incorrect intents. *Using a lower model threshold is recommended for better results.* For example, for the OOB ITSM model, the new model threshold is 65 as compared to 82 (the update will be available to the OOB Model in the March 2021 store release). Retest your models to set the threshold appropriately. We will be releasing a feature for the NLU Workbench in a Store release soon which will recommend the right model threshold to help with this.
   - More accurate intent predictions: With the January upgrade, the NLU predictions will be more accurate. Seeing a menu in Virtual Agent because of multiple intents being returned for an utterance will reduce, as you are likely to be taken to the right topic more often. There’s a higher likelihood that the NLU Service will skip predicting an intent when a user enters an irrelevant or gibberish utterance rather than predicting a wrong intent.
With the Quebec NLU Service, the number of times multiple choices are shown is reduced, as the system is more confident about predicting the right one. Multiple predictions are returned only if an utterance is ambiguous.
With the Quebec NLU Service, utterances can be written in multiple cases and the prediction will be consistent.
Improvements for identifying gibberish and skipping predictions

With the Quebec NLU Service, the system detects gibberish in most scenarios and skips the prediction. However, in some cases where there is a use of acronyms in your model utterances, or where your model has fewer intents, or has intents that have a significantly larger number of utterances, it's possible that the gibberish might still predict an intent.

Using a system property to control the NLU Service version

If you want to use the prior version of the NLU Service for new models created in Paris, you need to add a new entry to the sys_properties.list in the global scope. See the following steps below to implement this.

1. When training the model, open the debug log. There you'll see an entry such as the following, which contains a JSON. Near the beginning of the text, you can see the “name” key, which has the model name, which is rendered below in bold font for emphasis. The ellipses at the end of the text represent the remainder of the text, which isn't shown here because of its length. The remainder of the text isn't needed to determine the model name, so it's excluded for brevity's sake.

   14:17:57.438 [DEBUG] NLU Model JSON:
   
   {"name":"ml_x_snc_global_b6994aab8{56010}
    {8777687101:"language":"en","confidenceThreshold":"0.6"modelPurpose":"search","schemaVersion":"NY-1", "version":"312-HYB", "intents"....

2. Add a system property in your instance for the specific model by using the model name:

   Name: glide.ml predictor.option.nlu.authoringModel.version.override
   Value:
   
   {   'language.ml_x_snc_global_global_b69944aab85f6010f8777b87c0a3f101': 'en',
     'version.ml_x_snc_global_global_b69944aab85f6010f8777b87c0a3f101': '2.1.2-HYB'
   }

   If you want to use the newer version of the NLU Service for existing models in Paris, or models in Quebec, you could achieve that by adding a system property for the specific model name as follows:

   Name: glide.ml predictor.option.nlu.authoringModel.version.override
   Value:
   
   {   'language.ml_x_snc_global_global_b69944aab85f6010f8777b87c0a3f101': 'en',
     'version.ml_x_snc_global_global_b69944aab85f6010f8777b87c0a3f101': '3.1.2-HYB'
   }
3. (Optional) If you want to use the newer version of the NLU Service for multiple existing models, you could achieve that by specifying multiple models for the same property:

```
Name: glide.mlpredictor.option.nlu.authoringModel.version.override
Value:
{
  'language.model1': 'en',
  'version.model1': '3.1.2-HYB',
  'language.model2': 'en',
  'version.model2': '3.1.2-HYB'
}
```

**NLU models**

The NLU Workbench provides one unified view of all NLU models across languages and applications. This workbench also provides and supports NLU model authoring, model management, and model tuning features so you can build models and monitor them at all stages of their creation and publication.

**Usage, roles, and navigation**

Use the admin or nlu_admin role to access and build models in the NLU Workbench. Your navigation path in the application navigator is **NLU Workbench > Models**. For example, the image below shows a grouping of various NLU models.

![NLU Workbench Models](image)

**Purpose, language, and search**

You can build NLU models for consumption by ServiceNow applications, such as Virtual Agent and Search. For example, the [ReadOnly] HR NLU for VA Copy3
model shown in the image below is a copy of a default model created for Virtual Agent chatbot conversation topics.

Here, the purpose of the model is to support the Virtual Agent application, whereas some of the other models support the Search application. You assign the purpose and language to a model during the model's creation.

The All Purposes filter is analogous to the name of the application you enter in the Created for field when you Create an NLU model. For example, you can select the Virtual Agent application or the Search application from the Created for field in the Create NLU Model screen.

Note: The Search application currently supports the following 5 languages: English, French, German, Spanish and Japanese. So if you create a Virtual Agent model and choose a non-Search language, and then switch back to Search as the Purpose, the language defaults to English.

The All Languages filter groups all models together on the Models screen that share a given language. When you click the All Languages filter, all available languages are listed on the prompt.
You can also use the **Search** field to look for NLU models by name.

**Mapped intents**

Mapped intents in a model are mapped to external objects, such as Virtual Agent (VA) conversation topics. When VA administrators create a conversation topic, they can map the VA topic to an NLU model from the VA Designer user interface. When the mapping completes, the mapped intent appears in the **Mapped intents** column of the NLU Workbench Models screen.

When you click the name of a model that has one or more mapped intents, such as the [Read Only] HR NLU for VACopy3 model above, you can see the VA conversation topics that are mapped to the model’s intents in the **Mapped objects** column of the Intents section of the Model screen, as shown in the image below.
Create an NLU model

Create an NLU model that the system uses to recognize and process user utterances, intentions (intents), and objects of, or contexts for, an action (entities). Train the model dataset iteratively using utterance examples so that the system predicts the optimal intent output for a new utterance.

Before you begin

- Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
- Role required: admin or nlu_admin

About this task

In this example procedure, you’re building an NLU model to help the system understand human-expressed intent regarding Human Resources user requests.

Note: As you build your NLU model and its component intents, utterances, and entities, make sure you click the Train button before you test the model. See Train and test your NLU model.
Procedure

1. Navigate to NLU Workbench > Models.

2. Click Create Model.

3. In the Model Name field on the Create NLU Model screen, enter a unique name for your new NLU model. In this example scenario, you enter HR Model for Virtual Agent.

4. In the Created for prompt, select the application the model supports. In this scenario, you select Virtual Agent.

5. In the Language prompt, select a language for your model. In this scenario, you use the default language, which is English.
6. In the **Description** field, enter a brief description of the model, such as **Natural language for Human Resources user requests**.

7. **Click Save**.

**Result:** The Model screen appears, showing your draft model status, including sections for your model intents, entities, and vocabulary.

**Result:** Your draft NLU model appears on the Models screen.
8. Optional: To change your NLU model name, go to the Settings section in your Model screen to make your edit and then click Save. To discard your NLU model draft and start again, click Delete.

What to do next
Create one or more intents for your NLU model per the instructions in Create an NLU intent.

Related information
Activate the NLU Workbench

Create an NLU intent
Create one or more intents for your NLU model based on utterance examples of what a user might say related to the intent.

Before you begin
• Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, NLU Workbench - Advanced Features plugin, Intent Discovery plugin, NLU Common Model plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
• Role required: admin or nlu_admin

About this task
This procedure shows you how to create an intent. To reuse intents from other models, see Reusing predefined NLU intents

You can think of intents as the core that drives NLU in machine-reading comprehension. Intents perform best if their utterances, entities, and vocabulary
work together to support your model. Using NLU vocabulary and realistic utterance examples can help the system to more accurately predict an intent for a model.

Here’s an example of how intents can interact with the vocabulary in their utterance examples.

- Intent: AddMembersToDistributionList
- Utterance A: “Please add Carlos Santana to the uxinfodev list”
- Utterance B: “I’m mistakenly removed from the arlo-drury-directreports group”
- Result: The system doesn’t recognize uxinfodev or arlo-drury-directreports and can’t use these words to accurately help predict the intent.
- Solution: Add uxinfodev and arlo-drury-directreports as vocabulary items and add synonyms to them. The synonyms you provide help add more context to the utterance and the intent in which they reside. Your intent prediction confidence can be even higher if you also mark them as entities. Note: Don’t enter and save words such as “OrderLaptop” or “sfsdfasdfs” in an utterance, as they are gibberish. Hence, they aren’t good samples to use to train your NLU model.

Note that it’s always a good practice to provide vocabulary for any acronyms or words that are specific to your organization or domain. For more vocabulary context and examples, see Using NLU vocabulary.

Here are some things to consider when you test your NLU models that have an average or small number of intents:

- A model needs to have at least two intents with five utterances in each intent.
- The recommended number of utterances per intent is 15 and there is a limit of 200 utterances per intent.
- The system currently supports up to 300 intents or 4,500 utterances (whichever comes first) per model.

**Note:** As you create intents, keep in mind that they can sometimes impact each other. For example, you could build and test an intent that works fine but when you test it in a larger intent environment, it might behave differently. To reduce the likelihood of such an event, you may want to create at least five intents in a model before you start proper testing.

In the following example procedure, you’re creating utterances that users might say when requesting Human Resources information or assistance. That’s their intent. So you’re using these utterance samples to train the system to learn and understand language in the context of human intent. Here you’ve created an
NLU model that you’ve titled HR Model for Virtual Agent and you’re creating an intent in that model.

Procedure

1. Navigate to NLU Workbench > Models > HR Model for Virtual Agent.
   HR Model for Virtual Agent is the name you saved in the system when you created your NLU model. See Create an NLU model.

2. In the Model screen, click New Intent.
   As you create intents for your model, you can also reuse intents from other NLU models. For more information, see Import an NLU intent.

3. In the Intent Name field on the Create a new intent screen, enter a name for your intent.
   In this example scenario, you enter PayDiscrepancy.

   Note: When you create an intent, the system adds a hashtag to the intent name.

4. In the Description field, enter a brief description for your intent. In this example scenario, you enter NLU utterances that users might say when requesting HR information or assistance.

5. Click Save.
   The #PayDiscrepancy Intent screen appears, including sections for its utterances, associated entities, and settings. The intent draft status is also shown in the upper right corner of the Intent screen.

6. In the Utterances section of the Intent screen, enter utterance examples of natural language that are relevant to the intent.

   Note: The utterance examples that you provide must be unique and contain less than 200 characters. Add at least 15 utterances, with as much variety between them as you can.

   In this scenario, you enter the following utterances into the Add fields, one at a time.
As you build and retrain your model iteratively, you can use your utterances to test your intent prediction confidence scores. See Train and test your NLU model.

7. Optional: Repeat Steps 2 through 6 if you want to create more intents for your model.

What to do next
Create one or more entities for your NLU intent per the instructions in Create a simple entity.

Reusing predefined NLU intents
You can reuse predefined NLU intents by importing them from a prebuilt NLU model to a new model you’re currently building. Virtual Agent provides these prebuilt models for the Customer Service Management, HR Service Delivery, and ITSM applications.

Prebuilt Virtual Agent NLU models provide the BU-specific language understanding needed for Virtual Agent chatbot conversation flows in ITSM, CSM, and HR topics. Each NLU intent in these models maps to a single Virtual Agent conversation topic created in Virtual Agent Designer accordingly.

In essence, these models, created in the NLU Workbench and set to read-only, function as templates that contain validated NLU intents that administrators can reuse in new NLU models. For example, below is an image of the prebuilt HR model for Virtual Agent.
Prebuilt Virtual Agent model content

Each of the three prebuilt Virtual Agent models uses language that's specific to their respective BU. The NLU that processes this language, built from a word corpus of 3 million words, is context-aware of general linguistic patterns and both ServiceNow and user-defined vocabularies.

<table>
<thead>
<tr>
<th>Name</th>
<th>Utterances</th>
<th>Associated Entities</th>
<th>Mapped objects</th>
<th>Created by</th>
<th>Last updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>#CreateHRGeneralQueryCase</td>
<td>92</td>
<td>0</td>
<td>--</td>
<td>admin</td>
<td>2020-07-31 03:10:33</td>
</tr>
<tr>
<td>#AskQuestion</td>
<td>3</td>
<td>0</td>
<td>--</td>
<td>admin</td>
<td>2020-04-15 23:36:50</td>
</tr>
<tr>
<td>#NewHROrientation</td>
<td>60</td>
<td>0</td>
<td>--</td>
<td>admin</td>
<td>2019-11-05 01:18:47</td>
</tr>
<tr>
<td>#Setup</td>
<td>81</td>
<td>0</td>
<td>--</td>
<td>admin</td>
<td>2019-11-05 01:18:40</td>
</tr>
<tr>
<td>#AddEmergencyContact</td>
<td>36</td>
<td>5</td>
<td>--</td>
<td>admin</td>
<td>2018-07-02 05:04:58</td>
</tr>
<tr>
<td>#AddEmergencyContact</td>
<td>31</td>
<td>1</td>
<td>--</td>
<td>admin</td>
<td>2018-07-02 05:04:49</td>
</tr>
<tr>
<td>#AddEmergencyContact</td>
<td>28</td>
<td>4</td>
<td>--</td>
<td>admin</td>
<td>2018-07-02 05:04:36</td>
</tr>
<tr>
<td>#AddEmergencyContact</td>
<td>42</td>
<td>2</td>
<td>--</td>
<td>admin</td>
<td>2018-07-02 05:04:32</td>
</tr>
<tr>
<td>#AddEmergencyContact</td>
<td>34</td>
<td>1</td>
<td>--</td>
<td>admin</td>
<td>2018-07-02 05:04:13</td>
</tr>
</tbody>
</table>

These models map to common conversation topics used by Virtual Agent chatbots across each of the three BUs, driven by the intents provided in their respective prebuilt models.
For more NLU and Virtual Agent context, refer to the following product documentation.

- For ITSM context, see ITSM Virtual Agent.
- For HR context, see HR Virtual Agent conversations.
- For CSM context, see Customer Service Virtual Agent conversations.

**Virtual Agent and NLU plugins and roles**

To access the prebuilt Virtual Agent models in the NLU Workbench, you must install and activate these plugins using the admin role.

<table>
<thead>
<tr>
<th>Plugins</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Resources Scoped App: Virtual Agent Conversations [com.sn_hr_virtual_agent]</td>
<td></td>
</tr>
<tr>
<td>ITSM Virtual Agent conversations [com.snc.itsm.virtualagent]</td>
<td></td>
</tr>
</tbody>
</table>
To create NLU models in the NLU Workbench, you need one of these two roles: admin or nlu_admin.

**Creating NLU models that reuse predefined Virtual Agent intents**
The prebuilt Virtual Agent models are set to read-only and can't be edited. However, the intents in these models can be imported into your new model, alongside any new intents you've created in your model. To reuse the intents in a prebuilt Virtual Agent model, follow these steps:

1. Review the predefined intents in the Virtual Agent prebuilt model for your respective area (HR, CSM, or ITSM). Identify the intents that you want to reuse.
2. Activate the NLU Workbench.
3. Create an NLU model in ServiceNow Studio.
4. Create one or more new intents in your model.
5. Create and annotate your intent's entities.
6. Import some or all of the intents from the prebuilt model into your new model. See Import an NLU intent.
7. Test and train your model.
8. Publish your NLU model.

**Import an NLU intent**
As you create intents for your NLU model, you can also import and reuse intents from other NLU models.

**Before you begin**
- Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
- Role required: admin or nlu_admin

**About this task**
In this example scenario, you’re creating intents for your NLU model and you want to enhance the model by reusing intents from another NLU model.

In this example scenario, you've created an NLU model that's titled *NLU for Access Requests*. In this example procedure, you want to enhance the model by adding a chatbot intent from a Virtual Agent Conversations model.
Procedure

1. Navigate to **NLU Workbench > Models > NLU for Access Requests**.
   
   *NLU for Access Requests* is the name you saved in the system when you created your NLU model. See [Create an NLU model](#).

2. In the *Intents* section of your Model screen, click **Import Intents**.

   ![](image1)

   The Import Intents screen appears, showing a list of NLU models from which you can select intents for import to your model.

3. In this scenario, you select the **GetHelp** intent in the [*Read Only*] Customer Service NLU for VA model.

   ![](image2)

4. Click **Import**.

   ![](image3)
**Result:** The #GetHelp intent appears in the Intents section of your Model screen. Note that by importing this particular intent, you have added 38 additional utterances to your model.

**Related information**

Import common entities

**Using NLU vocabulary**

Use NLU vocabulary to help train the system to learn the language of your data.
NLU vocabulary usage and context

It's important to use NLU vocabulary in a model as it helps to improve the model's intent prediction accuracy. For example, if a word in an utterance is an acronym or is specific to one domain, the system may be able to predict its intent from its context within the utterance. However, when you define the vocabulary details for the word within a vocabulary item, you can help raise the model's confidence level and strengthen its inference capability.

You create a vocabulary item in the Vocabulary section of your model. NLU vocabulary helps to process words that the system may not initially understand, or that have a different meaning within the context of other models. By adding synonyms to your vocabulary items, you can train the system to learn words and patterns it doesn't recognize.

Vocabulary item types

NLU provides the following vocabulary types that you can use to create and configure a vocabulary item.
<table>
<thead>
<tr>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td>A word or phrase that is commonly used and understood in a particular language.</td>
</tr>
<tr>
<td>Pattern</td>
<td>A word or phrase that has a specific format, such as an email address, phone number, database record number, or regular expression encoding.</td>
</tr>
</tbody>
</table>

For information on how to create these vocabulary items and their associated synonyms, see the documentation below.

- Create a regular vocabulary item
- Create a pattern vocabulary item

**Case insensitivity**

Regular vocabulary items are case-insensitive by default. If you want the vocabulary item to be case-sensitive, you must create a pattern vocabulary item. For an example of case-sensitivity, see Create a pattern vocabulary item.

**Vocabulary items and vocabulary sources**

Vocabulary items and vocabulary sources differ in their usage. Here’s what makes them distinct:

- If you use a vocabulary item that’s an individual word or acronym, then you provide a simpler word or synonym so the system can better understand the word. For example, you annotate the acronym `PTO` in an utterance by entering `paid time off` as its synonym.
- If there’s a list of values you want to use in an utterance, then you use a vocabulary source.

**Vocabulary sources**

Use NLU vocabulary sources when you have a list of values that can be referenced in an utterance. Once created, you can reuse them in multiple places across NLU models. These sources can be referenced from a list of values from a ServiceNow table or a static list that you define, such as a list of catalog items or conference rooms. Once you create and save these sources, you can use the `@` symbol to reference them in an utterance. You can also use these sources as entity values.

To create vocabulary sources, refer to the following documentation: Create a table vocabulary source and Create a list vocabulary source.
Vocabulary usage in relation to an intent

Here’s an example of how an intent can interact with the vocabulary in its utterance examples.

- **Intent:** OrderSoftware
- **Utterance A:** "I need to access sfcrm"
- **Result:** The system doesn’t recognize the acronym *sfcrm* and can’t use it to accurately help predict the intent.
- **Solution:** Add *sfcrm* as a vocabulary item and provide synonyms, such as CRM software and Salesforce software.

- **Utterance B:** "I need to install word"
- **Result:** The system is likely to recognize *word*, including its software context, as the utterance also uses the word *install*. *Install* may be enough for the system to predict intents that cover installations, but its prediction confidence score could also be too low to predict the OrderSoftware intent.
- **Solution:** Add *word* as a regular vocabulary item and provide synonyms, such as Microsoft document file software and editor software. You could also create a pattern vocabulary item that uses regex encoding, where you label it capitalized as *Word*. This way the system understands that *Word* represents a software product every time it occurs. So vocabulary items help add more context to the utterance and the intent in which it resides, and may be more likely to predict the OrderSoftware intent. If you want to extract the specific software name, which in this case is *Word*, to use in your Virtual Agent conversation topic, then annotate it as an entity.

For more context and examples, see Create an NLU intent.

Regex encoding examples for case sensitivity/insensitivity

Let’s say you’re applying regex encoding to a word, such as the acronym *IT*, to create a pattern that represents the word information technology exclusively.

For case-sensitive regex encoding you can use: `\bIT\b`. By surrounding the word *IT* with boundary markers in the regex encoding, the word *IT* appears exactly as what you entered in between the two boundaries.

For case-insensitive regex encoding you can use: `\b(?i)IT\b`. The (?i) regex encoding makes the regex case-insensitive. If you insert the (?i) modifier in the middle of the regex, the modifier only applies to the part of the regex to the right of the modifier.

Regex details: You can turn off modes by preceding them with a minus sign as follows: (?-i). When you do this, all modes after the minus sign are turned off. For
example, the (?i)te(?-i)st regex encoding should match both test and TEst, but not teST or TEST.

Related information
- Create an NLU intent
- Using regular expressions in entities

Create a regular vocabulary item
Add a regular word or phrase and its synonyms to the system vocabulary. Vocabulary items can help the system to more accurately predict an intent for a model.

Before you begin
- Create or use an existing NLU model.
- Role required: admin or nlu_admin

About this task
In this example scenario, you create a regular vocabulary item in an NLU model that's titled NLU for Access Requests. This model has an intent that's titled Reset Password.

Procedure
1. Navigate to NLU Workbench > Models > NLU for Access Requests.
2. In the Vocabulary section of your Model screen, click Add Synonym.

3. On the Add Synonym screen, configure the following fields.
   - Type: Select Regular.
   - Vocabulary: Enter BonaFide, which in this example scenario is a fictional system your company uses for HR records.
   - Synonym: In this scenario, you enter the following synonym for the vocabulary you entered above: System of record for employee reviews. Just add one synonym. If you add more, the system only recognizes the first synonym you added regardless.
Note: The synonym you use must be in the same language as your vocabulary item.

4. Click Add.

5. Click Save.

Result: The BonaFide regular vocabulary item appears in the Vocabulary section of your Model screen, along with its vocabulary type and associated synonym.

Create a pattern vocabulary item

Use regular expression (regex) encoding to establish a pattern format for vocabulary items such as email addresses, phone numbers, and record naming conventions.

Before you begin

• Create or use an existing NLU model.

• Role required: admin or nlu_admin

About this task

Pattern vocabulary items are words or phrases that have a specific format, such as an email address or phone number. They can also be used for words that have naming conventions that signify specific meanings that are often
repeatable. You can create your own patterns for the vocabulary data in your instance.

In this example scenario, you’ve created an NLU model that’s titled *NLU for Access Requests*. Here, you decide you want the acronym *IT* to represent the word *information technology* exclusively.

So instead of creating a regular vocabulary item, you use a pattern vocabulary item and add case-sensitive and word boundary markers in the regex encoding to specify *IT*. The boundary markers ensure the word renders exactly as what you entered in between the two boundaries. This way the system recognizes *IT* as *information technology* exclusively throughout the model, and not a different acronym with the same letters, such as *industrial technology*.

**Procedure**

1. Navigate to **NLU Workbench > Models > NLU for Access Requests**.  
   *NLU for Access Requests* is the name you assigned to your NLU model.

2. In the Vocabulary section of your Model screen, click **Add Synonyms**.

   ![Add Synonyms](image)

   The Add Synonym screen appears, with the Type field set to **Regular** by default.

3. In the **Type** choice list, select **Pattern**.
4. In the **Regex** field, enter `\bIT\b`.

5. In the **Synonyms** field, enter *information technology*.

6. Click **Add**.
   Your synonym appears as an object under the Synonyms field.

7. Click **Save**.
**Result:** Your pattern vocabulary item appears in the Vocabulary section of your Model screen, along with its regular expression encoding and synonyms. Each time the system processes the word *IT*, it recognizes the meaning of the word as *information technology* exclusively.

![Image](image.jpg)

**Related information**

- Using NLU vocabulary
- Using regular expressions in entities

**Create a list vocabulary source**

Create a static list source that you define for the system vocabulary.

**Before you begin**

- Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, NLU Common Model plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
- Role required: admin or nlu_admin

**About this task**

To help your NLU model to better understand the words, names, or specific information your users use, you can refer to an existing ServiceNow table or, in this scenario, create your own list.

Use a list vocabulary source when you don’t have a ServiceNow table that has the data you want to reference in an utterance. You create list vocabulary sources in the list item format.

In this example procedure, you’re creating a vocabulary source comprised of the values you manually assign in a list. Once the source is created, others can reuse it in the utterances they add to their NLU models.

**Note:** When you create a vocabulary source, the system adds the @ symbol to its name.
Procedure

1. Navigate to NLU Workbench > Vocabulary Sources.
2. In the My lists section of the screen, click Create new list.
3. In the Create a new list to refer to screen, configure these fields as follows.
   - **Handle**: Enter @mouse. In this scenario, you use the term @mouse because the list vocabulary source you create will have values for various names of computer hand-held mouse devices that users might use in an utterance. The handle is the text used in the utterance to refer to the list vocabulary source.
   - **Language**: Select English-en, as this is the language in which the current vocabulary source is being created.
   - **Synonym**: Enter a synonym of an item in the list. For example, a list about conference room names can have a synonym such as Meeting Room or Conference Room. In this scenario, you enter Mouse Device Model.
   - **Enable fuzzy matching (allow slight misspellings, partial matches, etc.)**: In this scenario, you select the check box. This controls how close of a match a word entered in an utterance should be to the words you create in the list. For example, recognizing a license plate number entered in an utterance needs to be an exact match to a value in the list, whereas recognizing a software name such as Microsoft Excel doesn’t need an exact match, as users can enter Excel or MS Excel in an utterance and the system will recognize them. So in the former case, the Enable fuzzy matching check box shouldn’t be selected, whereas in the latter case it could be selected.
   - **Make case sensitive**: Select the check box if you want the Handle and Synonym field values to use case sensitive vocabulary.
4. Click Create.
Your @mouse vocabulary source draft appears in the My lists section of the Vocabulary sources screen.

5. Click @mouse.
   The @mouse screen appears.

6. In the Values section, use the following steps to create a list item for your vocabulary source. Each Actual value you add becomes an item in the list.

   a. Click Add list item.

   b. Enter a value, such as Logitech in the Actual value field. An actual value is like a formal name or value for the item in the list.

   c. Click the green check mark button to save the value you just entered.

   d. Press tab on your keyboard to invoke the Alternate values field.

   e. In the Alternate values field, enter one or more alternate names or values that users can use in an utterance, such as nicknames, shorter names, alternate names, or colloquial names, for the actual value you just created. Alternate values can be comprised of synonyms for the actual value,
or words that describe or have a context for that value. In this example scenario, you enter mx master, mx vertical, mx anywhere, M705.

f. Click the green check mark button to save the value you just entered.

Result: You've created the first list item in your vocabulary source. List vocabulary sources contain both an actual value and an alternate value.

7. Repeat Step 6 for each list item you want to add to your vocabulary source.

Result: In this example scenario, you've collectively created two list items for your vocabulary source. In the following image you can see both of them on the Values section of the @mouse screen.
8. **Optional:** When your list items are complete, you may want to review the Properties section of your @mouse vocabulary source.

9. **Optional:** Make any properties changes you need to, if any. For example, you could change the value in the Synonym field of the @mouse vocabulary source from Mouse Device Model to mouse_company.

10. **Optional:** Click Save.

    **Result:** The @mouse vocabulary source appears and is available for others to use in the following areas of the user interface:
    - On the My lists section of the Vocabulary sources screen.
    - As a lookup reference value that others can reuse in an utterance example they create for an intent.
As the result of adding an utterance that uses the `@mouse` vocabulary source.

---

**Related information**

Create a table vocabulary source

Create a table vocabulary source when you have a list of values defined in a table and you want to use its values in your NLU model.

**Before you begin**

- Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, NLU Common Model plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
- Role required: admin or nlu_admin

**About this task**

Create a vocabulary source that's comprised of values from a ServiceNow table. When you complete the vocabulary source, others can reuse it in utterances via the `@` handle. They can also use it subsequently for entities.
Note: When you create and sync a table vocabulary source, the values from the table in your instance are extracted, and a vocabulary source is created in the NLU Service. When you create a table vocabulary source, the system also adds the @ symbol to its name. For more information on the NLU Service, see NLU Service Updates.

Note: Table vocabulary sources are not supported for Reference fields.

Procedure

1. Navigate to NLU Workbench > Vocabulary Sources.
2. In the ServiceNow Tables section of the screen, click Add another table.

3. On the Add another table to refer to screen, configure the fields as follows:
   - **Table**: In this example scenario, you select Location (cmn_location).
   - **Handle**: The system generates the value of this field based on the Table value you entered. In this scenario, it generates @Location. This is how a vocabulary source can be referenced in utterances.
   - **Synonym**: The system generates the value of this field based on the Table value you entered. This field is used as a synonym when the @vocabulary_source appears in an utterance to help with intent identification. In this example, it generates the Location value. You can update this value to ensure that it’s a synonym for an individual item in the vocabulary source.

   Note: The synonym you use must be in the same language as your vocabulary source.

4. In the Fields section of the form, configure the following fields.
• **Field name**: In this scenario, you select the **Country** and **City** values from the Location table.

• **Options**: Click **Options**, then select the **Use this field to look up values** check box for both of the two **Field name** values you chose above. By doing this, you allow either a country name or a city name to be used in an utterance for finding a record in the vocabulary source. You can also use multiple comma-separate values in this field. For example, if your city column has multiple names, such as NYC, New York, and New York City.

• **Fields can appear together e.g. [First name] [Last name]**: Leave the check box blank. This field is typically used in an NLU Search model, where users can enter words next to each other in an utterance to find a record. For example, you can enter Pierre Development while searching for an employee named Pierre who works in the Development team, where **Name** and **Team** are two fields in the table.

5. In the Advanced Options section of the form, configure the following fields.

• **Language**: Select a language for your vocabulary source. In this scenario you select **English - en**.

• **Refresh**: Select **Every 7 days**. By selecting this, you set the system to get new values from the table every 7 days. There are different refresh options you can choose as well.

• **Enable Fuzzy matching (Allow slight misspellings, partial matches etc.)**: Select the check box. By selecting this, a record can be matched even if
you enter a slightly misspelled word or part of a word. For example, when searching for a city such as Kansas City, you might enter Kansas City or just Kansas, and the system will still be able to match with the correct location record.

6. Click **Save**.

**Result:** Your **@Location** table vocabulary source appears on the Vocabulary sources screen, where it begins to sync with its source table.

7. If the sync doesn’t start immediately, point to the farthest column to the right of the screen to invoke the **Sync Lookup** icon. Click the icon to sync the source table data with the NLU Service.

**Result:** When the sync completes, your **@Location** vocabulary source is available for others to use within utterances in their NLU models.

**Related information**

Create a list vocabulary source
Sync a table vocabulary source

Synchronize a table vocabulary source to a ServiceNow® table so you can refresh your NLU model data.

Before you begin

- Create a table vocabulary source.
- Role required: admin or nlu_admin

About this task

In models that use table vocabulary sources, the values are referenced during model training. However, if the table values change over time, the model still references the values from the last training session.

To resolve this issue, you can run a sync operation that pulls the latest values from its source table so the vocabulary source references values that are updated and current.

If the vocabulary source has a refresh cycle set to a certain frequency such as once per month, the table data is synced at intervals without the need to manually sync it.

In the example scenario below, you’re syncing the @AccessRoles vocabulary source to the Catalog Item table by following the steps below.

Procedure

1. Navigate to NLU Workbench > Vocabulary Sources.
2. In the ServiceNow Tables section of the screen, point to the last column to invoke the Sync lookup icon.
3. Click Sync.

Result
In the following image, the sync operation begins in the Current status column. The first operation can take some time, depending on the source table size. However, the next time you sync, it completes in a matter of seconds or a few minutes.

In the final image example, the operation is complete and the values in the Last refresh and Current status columns reflect the current status accordingly.

Related information
Create a table vocabulary source

Prebuilt vocabulary
Use ServiceNow® prebuilt vocabulary for software and hardware terms so the system recognizes their multiple variations in utterances.

Prebuilt vocabulary also recognizes product misspellings and provides definitions for software and hardware terms whether they're expressed in slang or professional usage.

For example, when you navigate to an NLU model Intent screen and enter a software or hardware term in an utterance, the term has a blue line under it that
marks it as prebuilt vocabulary, as shown in the following image where the term Mac is used in an utterance.

When you click the word, a window appears with two options to choose for the word:

- A prebuilt suggested definition for the word
- An option to add a synonym

If you select the first option and click **Confirm**, the system uses the prebuilt suggested definition and the blue line disappears.

If you select the second option, enter a synonym for the word, and click **Confirm**, the word and the synonym are added to the model vocabulary.

If you select either of the two options and click **Ignore**, the blue line disappears and the word remains as it was previously.
Annotating entities

When you create an NLU entity, you can annotate it with synonyms and other definitions. Learn the details and various contexts required for you to annotate different types of entities effectively.

In Natural Language Understanding, you annotate entities to provide linguistic associations and meaningful context for the system vocabulary. Annotations strengthen the relevance of entities by adding associations and attributes to them that establish them more firmly within the overall linguistic framework.

NLU entities fall into two categories: system and user-defined. System entities such as DATE, TIME, and LOCATION are available by default in your instance. User-defined entities are those that you can create in the following types: simple, mapped, pattern, system-derived, open-ended, and common.

All entities are reusable across other NLU models. For example, if an ITSM NLU model admin is the first to create an entity titled laptop, it appears as a selectable option to use in all NLU models.

As you annotate or import NLU entities in the NLU Workbench using the nlu_admin role, consider the guidance below.

Creating simple entities

When you create a simple entity from a word or phrase, you can annotate it with synonyms, acronyms, and other contextual definitions. These annotations enrich the entity’s connectivity to its associated intents and utterances. For an example of how to create these entities, see Create a simple entity.

Creating mapped entities

When you create a mapped entity from a word or phrase, you can annotate it with a list of selectable values, such as High, Medium, and Low for an entity titled Priority. For an example of how to create such an entity, see Create a mapped entity.

Creating pattern entities

When you create a pattern entity from a word or phrase, you can annotate it with repeatable formats for things such as email addresses, phone numbers, and case record numbers. Patterns are an effective way to establish rules that govern and contextualize similar types of content. For an example of how to create these entities, see Create a pattern entity.
Creating system-derived entities
System-derived entities enable you to extend your default system entities such as date, time, location, and duration, making them parent entities to your user-defined child entities. See Create a system-derived entity.

Creating open-ended entities
Use an open-ended entity when you want to improve your intent prediction accuracy. When you mark a word or phrase as open-ended, the system focuses on the entity context to better infer the intent. See Create an open-ended entity.

Using common entities
Common entities are pattern entities that you don't need to annotate or create from utterance examples. They're so commonly used that their names and regular expressions are predefined. You can also import them directly into your models. See Import a common entity.

Create a simple entity
Create one or more simple entities from words in your utterance examples. An entity is an object of, or context for, an action.

Before you begin
• Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, NLU Common Model plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
• Create or use an existing NLU model.
• Create or use an existing NLU intent.
• Role required: admin or nlu_admin

About this task
There are six types of NLU entities: simple entities, mapped entities, pattern entities, system-derived entities, open-ended entities, and common entities.

In this example scenario, you've created an NLU intent that's titled CreateDistributionList. In this example procedure, you're creating a simple entity from an utterance example that you provided in that intent.

Procedure
1. Navigate to NLU Workbench > Models > ITSM Model.
The name you assigned to your NLU model.

ITSM Model
2. In the Intents section of your ITSM Model screen, click #CreateDistributionList. 
CreateDistributionList is the name of the intent you created in your ITSM Model.

3. In the Utterances section of the CreateDistributionList Intent screen, select a distribution list name from a given utterance that you want to define as a simple entity for your intent. In this scenario, you select the word docwriters because it’s the name you want to use for a distribution list. When you’ve annotated and saved this entity, the distribution list name will then be extracted as a simple entity.

![Screenshot of ITSM Model screen](image)

Note: You can also annotate a vocabulary source in an utterance as a simple entity by referencing @vocab_source, where vocab_source is a table vocabulary source or a list vocabulary source.

4. With the word docwriters highlighted, click Create New Entity.

![Screenshot of Create New Entity screen](image)

5. In the Create a new entity screen, enter distributionlistname in the Entity Name field.

6. Select Simple from the Type choice list.

   When you select an entity type, existing entities appear so you can select and reuse them. If you know a particular entity’s name, enter it in the search field to retrieve the entity and reuse it. If no existing entities are present, you can create a new entity.

7. Click Save.
Results:
The **distributionlistname** entity appears in the Associated Entities section of the `CreateDistributionList` Intent screen. It also appears in the Entities section of your `ITSM Model` screen. For information on other entity types and how to annotate an entity, see [Annotating entities](#).

What to do next
Create more entities of other types for your intent, as needed.

Create a mapped entity
Create an entity mapped to a vocabulary source, or to a list of values you manually create for the entity.
Before you begin

• Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, NLU Common Model plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
• Create or use an existing NLU model.
• Create or use an existing NLU intent.
• Role required: admin or nlu_admin

About this task
When you create a mapped entity, you have the following three options.

1. Map the entity to a table vocabulary source. Use this option if you have a ServiceNow table that has the values you’re looking for. Mapping an entity to a table vocabulary source enables the entity to reference multiple values from the table. For example, use a @Location vocabulary source, where @Location has values for cities and countries.

2. Map the entity to a list vocabulary source. Use this option if you don’t have a ServiceNow table that has the values you’re looking for. For example, use a @mouse vocabulary source, where @mouse has values for various models of hand-held computer devices.

3. If you don’t have a source, you can manually create a list of values for the entity. For example, you could create a mapped entity named urgency from the word “asap” in an utterance, then manually build a list for it with values of High, Medium, and Low.

Note: As shown in the image below, when creating mapped entities using this manual option you must use the secondary Source button, whereas those that are mapped to vocabulary sources use the primary Source button located above the secondary button.
Once the mapped entity is saved, others can reuse it and assign it a value of High, Medium, or Low.

In this example procedure, you create a mapped entity using the table vocabulary source option. The vocabulary source you'll use is titled @departmentName.

**Procedure**

1. Navigate to **NLU Workbench > Models > NLU for Access Requests**.  
   *NLU for Access Requests* is the name you assigned to your model.

2. In the Intents section of the model, click **#Reset Password**.  
   *Reset Password* is the name of the intent you created in your model.
3. In the Utterances section of the screen, add a new utterance example. Use the @ handle to select the vocabulary source you want to use as an entity in the utterance. In this scenario, you select the @departmentName vocabulary source.

4. Click @departmentName to invoke the Find entity name or value screen.

5. Click Create New Entity.

6. Configure the following fields for your mapped entity.
• **Entity Name**: Enter `departmentName`.

• **Type**: Select **Mapped**.

• **Model availability**: Select this box if you want this entity to be included in all of the intents in your model.

• **Source**: Select the **Use this if you have a table or list to refer to where the actual values and values they’re mapped to are stored** button.

• **Vocabulary source**: When a vocabulary source is first created and saved to the system, its **Name** and other source fields are set to read-only. This is because vocabulary sources are available for reuse in any NLU model's context, so their content must be stable.

• **Mapped value for the entity**: Select **Name**.

7. Click **Save**.

**Result**: Your `@departmentName` mapped entity appears on the following screens:

• The Associated Entities section of your Intent screen.
• The Entities section of your Model screen.

Related information

Create a table vocabulary source
Create a list vocabulary source

Create a pattern entity

Create a pattern entity from a word or phrase so you can annotate it withrepeatable patterns for things such as email addresses, phone numbers, andcase record numbers. These patterns help the system to recognize similar entitiesbased on a single shared pattern.

Before you begin

• Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, NLUCommon Model plugin, and Predictive Intelligence plugin are all installed andactivated on your instance.
• Create an NLU model.
• Create an NLU intent.
• Role required: admin or nlu_admin

About this task

There are six types of NLU entities: simple entities, list entities, pattern entities,system-derived entities, open-ended entities, and common entities. A patternentity is sort of like a primary entity that helps to identify, contextualize, andgovern similar types of content.
In this example scenario, you've created an NLU intent that's titled Reset Password. In this example procedure, you're creating a pattern entity from a word in an utterance example that you provided in that intent.

The word in question references an incident record number (INT7778889). You create an entity from that word and configure it as a pattern entity. Next, you create a second pattern entity that recognizes all incident record numbers.

Procedure

1. Navigate to System Applications > Studio.
2. In the Application Explorer, navigate to Natural Language Understanding > NLU Models > NLU for Access Requests. NLU for Access Requests is the name you assigned to your NLU model.
3. In the Intents section, click #Reset Password. Reset Password is the name of the intent you created in your NLU model. See Create an NLU intent.

   Note: When you create an intent, the system adds a hashtag to the intent name.

4. Locate and click on a word from your utterance examples that the system doesn't recognize. In this scenario, you click a word that's titled INT7778889.

5. In the Add Synonym window, configure these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base word</td>
<td>INT7778889 is auto-populated by the system.</td>
</tr>
<tr>
<td>Type</td>
<td>Pattern</td>
</tr>
<tr>
<td>Regex</td>
<td>Enter INT\d(7).</td>
</tr>
</tbody>
</table>
Field | Value
---|---
Synonyms | Enter incident record, incident, identifier.

Note: The Regex field value is a Java regular expression. For more information on how to use Regex, see Using regular expressions in entities.

6. Click **Save**.
   The base word passes validation and the red error icon changes to a green check mark icon, as you've added synonyms to help the system identify the word.

7. Click **INT7778889** again.
   Note that in this scenario, there are no Pattern Entities that you can reuse and apply to **INT7778889**, so you will need to create a new one.

8. Click **Create New Entity**.
   In Step 5 you configured the word **INT7778889** as a pattern, which refers to an incident record number in your instance. In this step, you're creating a pattern entity for all incident numbers that occur in your utterances. This enables the system to automatically recognize words that have the same pattern as **INT7778889**. So you're essentially contextualizing the entity so the system can better understand what the word means.
9. In the Create a new entity window, configure these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity Name</td>
<td>Label the entity with a unique word that describes what the pattern is for, such as IncidentNumber.</td>
</tr>
<tr>
<td>Type</td>
<td>Pattern</td>
</tr>
<tr>
<td>Regex</td>
<td>Enter INT\d{7}.</td>
</tr>
</tbody>
</table>

10. Click Save.

**Result:** The IncidentNumber pattern entity is complete and appears on the Create New Entity picker in the Utterances section of your Reset Password NLU Intent screen. Per this example scenario, it's the first pattern entity created in your instance.

The IncidentNumber pattern entity also appears in the following areas of the user interface:

- The Entities section of your NLU for Access Requests NLU Model screen.
- The Associated Entities section of your Reset Password NLU Intent screen.
• The Utterances section of your Reset Password NLU Intent screen.
• The IncidentNumber NLU Entity screen, where you can see the intent and utterance it’s associated with.

What to do next
Create other pattern entities for your Reset Password intent and any other intents that you create. For further examples of how these entities are configured, see Using regular expressions in entities.

Related information
Annotating entities
Import common entities

Create a system-derived entity
Create a custom entity that’s derived from a default system entity such as date, time, duration, or location.

Before you begin
• Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, NLU Common Model plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
• Create or use an existing NLU model.
• Create or use an existing NLU intent.
• Role required: admin or nlu_admin

About this task
The Natural Language Understanding (NLU) application provides both system entities and system-derived entities.

System entities are prebuilt in your ServiceNow® instance by default, and appear on the Entities section of the Model screen. These entities are enabled by default. You can disable and re-enable them if needed by clicking the Enable button, as shown in the image below.
With each ServiceNow release, new system entities are occasionally added to the application. For example, the HARDWARE and SOFTWARE system entities were introduced in the Rome release. Unlike other entities, the system predicts these entity types without requiring any utterances to be annotated in the model.

System-derived entities however, enable you to extend your system entities, making them parent entities to your user-defined child entities. Any system-derived entities you create and save appear in the User Defined Entities section of the model screen.

In this example scenario, you’ve created an NLU model that’s titled Booking Reservations. You’re using the model to define details for booking flights, cars, hotels, and events.

In this example procedure, you’ve created an utterance that references a flight between two locations: San Diego and San Francisco. As you annotate the utterance, you realize you have the same system entity (LOCATION) appearing twice in the utterance. So you mark one of them as From and the other as To, where both are extended and derived from LOCATION. That way, when these two entities are extracted, a Virtual Agent topic knows which one is source and which one is destination.

**Note:** When parent and child system entities are linked, you can’t disable the parent entity until you remove all of its child entities.
Procedure

1. Navigate to NLU Workbench > Models > Booking Reservations. Booking Reservations is the title you assigned to the NLU model you’re working in.

2. In the Utterances section on your model’s #Book a Flight Intent screen, select the departing city entity from its utterance, then select System-Derived and click Create New Entity. In this scenario, you annotate the from San Diego phrase in the utterance as the departing location for the flight. This phrase is your target for creating the first of two system-derived entities.

3. In the Create a new entity screen, enter or select these values.
   - Entity Name: Enter FromLocation.
   - Model Availability: Leave blank.
   - Type: Select System-Derived.
   - Parent Entity: Select LOCATION.

4. Click Save.
5. Select the arriving city entity from the same utterance and click **Create New Entity**.

In this scenario, you're annotating the *to San Francisco* phrase in the utterance as the arriving location for the flight. This phrase is your target for your second system-derived entity. Enter or select these values.

- **Entity Name**: Enter *ToLocation*.
- **Model Availability**: Leave blank.
- **Type**: Select *System-Derived*.
- **Parent Entity**: Select *LOCATION*.

6. Click **Save**.

**Result**: Your two system-derived entities appear in the entity picker for creating an entity. When you point to the name of either of these two new entities, you can see they both persist in the user interface where they're reusable in all other NLU models in your instance. When you click the name of the entity, you can view and edit its entity associations.

**Result**: Your two system-derived entities appear on the Entities section of your *Booking Reservations* NLU Model screen.
7. **Click Train.**
   You only need to click **Train** prior to testing your NLU model.

8. **On the Booking Reservations Model screen, click Test.**

9. **In the Test Model panel, enter an utterance example that includes the **FromLocation** and **ToLocation** entities to ensure they're recognized by the system in an intent. In this scenario, you add this utterance:** *can we get from San Diego to San Francisco now?*

10. **Click Go.**

    **Result:** The **FromLocation** and **ToLocation** entities can be recognized in test utterances for the **#Book a flight** intent.

---

**What to do next**

Create additional system-derived entities for your **Booking Reservations** model. For example, you could create an entity that's derived from your **DURATION** system entity that defines the estimated length of time for a flight.
Create an open-ended entity

Use an open-ended entity when you want to improve your NLU intent prediction accuracy.

Before you begin

• Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, NLU Common Model plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
• Create or use an existing NLU model.
• Create or use an existing NLU intent.
• Role required: admin or nlu_admin

About this task

When you mark a word or phrase as open-ended, the system skips the entity itself, and predicts its intent from the context that precedes or follows the entity in the utterance. For example, the system extracts the value iPhone as an entity value for the open-ended CatalogItem entity, and identifies #OrderCatalogItem as the intent. The next time the system sees an utterance in a similar context, it categorizes the entity as the open-ended one you defined.

We call these entity types "open-ended" as they can have a very large range of values, such as a thousand laptop types for an entity labeled as laptop. Naming all of these types would be an unbearable task for the model author.

It helps to understand what an open-ended entity accomplishes in NLU by comparing it to a simple entity or a list entity. Let’s say you create a ResolveSoftwareIssue intent that uses an utterance example such as “I have an issue with outlook”. In this utterance, you’ve annotated “outlook” as an entity. With both open-ended and simple entities, the system extracts the raw value from the utterance as an entity, which in this case is outlook. List entities however, return a normalized or category value. For example, Outlook, Gmail, and Yahoo, which are all email software products, might be mapped to “email” where email is extracted as an entity.

For your ResolveSoftwareIssue scenario, the reason for using an open-ended entity instead of a simple entity is that for accurate intent detection, the entity itself is less relevant; so you want the system to ignore it. In other words, ResolveSoftwareIssue is your intent, and irrespective of where you have the issue, you always want to associate “I have an issue” with your ResolveSoftwareIssue intent. “Outlook” would still be extracted as an entity, but the model would have higher confidence in the intent prediction if you associate outlook with the ResolveSoftwareIssue intent.
In other scenarios you should use a simple entity, as there could be multiple intents where you shouldn’t have the system ignore the entity. For example, if you create `ResolveEmailIssue` and `ResolveVPNConnectivityIssue` as separate intents, you can’t be confident in the intent detection based only on the “I have an issue with...” part of the utterance. Hence, the entity becomes important for the intent prediction.

**Note:** You can’t annotate a vocabulary source (referenced by `@vocab_source` in an utterance) as an open ended entity. You can only annotate a vocabulary source as a simple entity or a mapped entity. For example, if the utterance is “I want to order a laptop”, then the word “laptop” can be annotated as an open ended entity. However, if the utterance is “I want to order @laptop” where @laptop refers to a table vocabulary source or a list vocabulary source, it can’t be annotated as an open ended entity.

In this example scenario, you’ve created an NLU model that has an `OrderHardware` intent. You’re using the model to define NLU details for a wide array of items users can order from various systems in your instance.

In the following example procedure, you create a `laptop` entity from one of your utterances so the system can recognize it as open-ended and reusable in other NLU models in your instance.

**Note:** You can only use one open-ended entity per intent.

**Procedure**

1. Navigate to NLU Workbench > Models > Provision Management. In this scenario, Provision Management is the title you assigned to the model you’re working in.

2. In the Utterances section of your OrderHardware Intent screen, select the word `laptop` from its utterance example, then select Open-Ended and click Create New Entity.
3. On the Create a new entity screen, enter or select these values.
   - Entity Name: `laptop`
   - Type: **Open-Ended**

4. Click **Save**.

   **Results:**
   
   The `laptop` open-ended entity is annotated in the Utterances section of your model's Intent screen. When you point to its name, you can see that it persists as a new entity in the annotation details. This entity is now reusable in all other NLU models in your instance.
The **laptop** open-ended entity appears on the Entities section of your Provision Management Model screen, including its type, model availability status, and associated intents.

5. Click **Train**.

6. On the **OrderHardware** Intent screen, click **Test**.

7. In the Test Model panel, enter an utterance example that's similar but not quite the same as those you've already created. The utterance should include an intent statement, such as "I need to order..." or "I want to request...". In this example scenario, you add this utterance: **I need to order some hardware for my Macbook air**.

8. Click **Go**.

**Result:** The system predicts a Macbook air value by using the **laptop** open-ended entity. This value has a 95% match to your **#OrderHardware** intent even though Macbook air isn't present in the utterances you created in that intent. Here, the system correctly identifies a laptop model, and predicts its
associated intent with high accuracy by focusing on the entity context in an utterance and not the entity itself.

Assigning intent relationships to entities

Assign an intent relationship to an entity to help improve its prediction accuracy. This is an optional feature and can be used in certain NLU scenarios.

Before you begin

• Make sure that the NLU Workbench plugin, NLU Workbench - Core plugin, and Predictive Intelligence plugin are all installed and activated on your instance.
• Role required: admin or nlu_admin

About this task

The purpose of an intent match in the entity relationship is to boost the prediction confidence score of a particular intent when the utterances are provided. By default, there is no specific relationship to an intent when an entity is created.

Users have two options to choose when assigning an intent relationship to an entity.

• Choose **Likely match** when the presence of an entity in an utterance will boost the confidence of that specific intent. Note that this option is available only for NLU Models where the Model Purpose is Search.
• Choose **Definite match** when the presence of an entity in an utterance will boost the confidence of this specific intent to 100 percent.

This procedure shows you an example of scenarios to consider when you’re choosing to assign either a likely relationship or a definite relationship.

To assign an intent relationship to an entity, you select **Likely match** or **Definite match** for the entity on the Intent match column of the Intent screen. If you want to change an entity relationship, select **--Clear label--** on the Intent match
prompt for the entity, then select the **Likely match** or **Definite match** value you want to assign.

<table>
<thead>
<tr>
<th>Associated intents</th>
<th>Utterances</th>
<th>Intent match</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Likely match</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Definite match</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **NLU Workbench > Models**.
   In this scenario, you’ve created an NLU model that’s titled *Default AI Search Genius Results Model*, where its Model Purpose is Search. This model contains the `#personFind` intent and the `#catalogFind` intent with a goal to identify either person or catalog.

   On the `#personFind` intent screen, you’ve assigned intent relationships to four entities.

2. Review the following example for using Likely and Definite matches.

   **Example:**
   **An intent that has both Likely and Definite matches:**

   The `#personFind` intent contains the following entities where the `personName` entity is a definite match and `jobTitle`, `DepartmentName` and `CityLocation` are likely matches.
This means that when a person name is identified in the utterance, the intent confidence will be boosted to 100 percent. If only a city location or a job title is indicated in a search query without a person name, the confidence is boosted for the #personFind intent, but at a lower percentage.

When you test the Default AI Search Genius Results Model and search for the person Abel Tuter, the intent is boosted 100 percent, which means it will return search results that match only the person Abel Tuter.

An intent that has a Definite match:

In this scenario, you have an #OrderLaptop intent with a laptop entity you’ve marked as a Definite match.
This can be useful if the only intent that has anything to do with laptop is the #OrderLaptop intent.

When you test the model that has the #OrderLaptop intent, both the intent and the entity have definite matches of 100 percent.

Using regular expressions in entities

Learn how to use regular expressions in your NLU entities to establish patterns that help the system locate, match, and manage text.

Pattern entities use regular expressions (regex) to match any pattern of text, such as the format of an email address, a phone number, or an incident or case ID.
As you annotate NLU entities using the Admin or Delegated Developer role (with permission of All File Types) role in ServiceNow Studio, consider the following guidance.

ℹ️ Note: ServiceNow uses and supports Java regex exclusively and not other vendor options, such as Perl regex.

Regex examples

For an example of regex code used in a pattern entity for incident records, refer to Create a pattern entity.

The four regex examples below follow the same steps used in Create a pattern entity and correspond to the images in steps 5 and 10 of that procedure. For a breakdown of the regex code values shown in the four examples, see Regex example formatting.

Knowledge base article

The base word for this pattern entity example is KB1212121. See the regex code that’s applied to the entity.

When you save the **KBArticleNumber** entity, it appears as a reusable pattern that other NLU admins can assign to their KB article words.

Case number
The base word for this pattern entity example is CS4442220. See the regex code that’s applied to the entity.

When you save the CaseNumber entity, it appears as a reusable pattern that other NLU admins can assign to their case number words.

Email address

The base word for this pattern entity example is antoni@bummerfest.com. See the regex code that’s applied to the entity.
When you save the **EmailAddress** entity, it appears as a reusable pattern that other NLU admins can assign to their email address words.

**Phone number**

The base word for this pattern entity example is **510-888-2062**. See the regex code that's applied to the entity.

When you save the **PhoneNumberUSA** entity, it appears as a reusable pattern that other NLU admins can assign to their USA phone numbers.
Regex example formatting
Here's a breakdown of the regex code values used in the examples provided above.

Knowledge base article example
The regex code is KB\d{7}, where KB = knowledge base record and \d{7} = 7 digits.

Case number example
The regex code is CS\d{7}, where CS = case record and \d{7} = 7 digits.

Email address example
The regex code is ^[a-zA-Z0-9._%+-\]+@[a-zA-Z0-9.-]+\.[a-zA-Z]{2,6}$, which supports these formats: antoni@bummerfest.com and antoni_cleo@bummerfest.co.in.

Phone number example
The regex code is \d{10} | (?:\d{3}-)\d{4} | \d{3}-\d{4}, which supports these formats: 5108882062, 510-888-2062, and (510)888-2062.

Regex resources
For further information on regular expressions, see
- Java Regular Expressions
- Java Regular Expression Tester
- Pattern (Java Platform SE7)
- Java regex match abbreviations

Import common entities
Use predefined pattern entities that don't require utterance examples or annotation. These common entities are reusable across all NLU models in your instance.

Before you begin
Roles required: Admin or Delegated Developer role (With permission of All file types) along with the nlu_admin role

About this task
The NLU Common Model application, available by default in your instance, uses the NLU Common Entities model to package predefined pattern entities for reuse across all NLU models. You can't edit this prebuilt read-only model to
gain access to its entities. Instead, you reuse the entities by importing them into your own NLU models. When they're in your model, you can customize them if needed.

You can also import these entities from any other model in your instance. Importing them into a model automatically makes them available in that model, and across all intents in that model.

In this example scenario, you've created an application in Studio that's titled NLU for Instances. Within that app, you've created an NLU model that's titled Problem MGMT. This model contains the Provision Instance and Access Instance intents.

In this example procedure, you import three common entities from the NLU Common Entities model into your Problem MGMT model. Next, you customize the third entity.

Procedure

1. Navigate to **System Applications > Studio > NLU for Instances**.
   In this scenario, NLU for Instances is the title you assigned to an application that you created in Studio.

2. Click **File > Switch**.
3. In the Select Application screen, click **NLU Common Model**.

4. In the Application Explorer, click **NLU Common Entities**.

5. In the Entities section of the **NLU Common Entities** NLU Model screen, identify the entities you want to import into your **Problem MGMT** model. In this example scenario, you decide to use these three entities for import: **Ticket**, **Email**, and **Case**.
6. Click **FileSwitch**.

7. In the Application Explorer, navigate to **Natural Language Understanding > NLU Models > Problem MGMT**.

8. In the Entities section of your Problem MGMT NLU Model screen, click **Import Entity**.

9. In the Import Entity screen, select the three entities you’ve chosen from the NLU Common Model application.

   **Tip:** You can also search for other entities in other NLU models and import them into your model.
10. Click **Import**.

**Result:** Your chosen entities appear in the Entities section of the **Problem MGMT** model screen.

11. Click **Email** to customize this common entity.

In this scenario, you configure the pattern entity to use a specific email format for company internal communications.
12. On the Email NLU Entity screen, click **Properties**.

13. On the Update NLU Entity screen, enter `Email_Internal` in the **Entity Name** field.

   ✅ **Tip:** It's good practice to rename the entity but retain a part of its original name that denotes which predefined common entity you've customized.

14. Update the code in the **Regex** field so it renders the email format that you're looking for accordingly.
   For example, you could update the code so it formats the email to show the term `Internal:` as the first word in the subject line.

15. **Optional:** Click **See documentation for Regular Expressions** for guidance on Regex configuration options.
16. Click **Save**.

**Result:** Your customized common entity appears in the Entities section of your *Problem MGMT NLU Model* screen.

**What to do next**
Import additional common entities from other NLU models, if needed.

**Related information**
- Import an NLU intent

**Promote an entity to NLU model availability**
Share an entity across all of a model's intents by marking it as available at the NLU model level.
Before you begin

• Create or reuse an NLU model that has two or more intents with at least one entity in each intent.

• Roles required: Admin or Delegated Developer role (With permission of All file types) along with the nlu_admin role

About this task
To define an existing entity across all intents in your model, you select an entity check box that promotes it from the intent level to the NLU model level.

In this example scenario, you’ve created an app in Studio that’s titled NLU App for Booking. Within that app you’ve created an NLU model that’s titled NLU for Reservations. This model includes these intents:

• #MakeReservation, which has these two entities: StartReservation and EndReservation.

• #CancelReservation, which has this entity: EndReservation.

Your goal is to make the StartReservation entity available to the #CancelReservation intent by promoting the entity to the NLU model level.

Procedure

1. Navigate to System Applications > Studio > NLU App for Booking.
   In this scenario, NLU App for Booking is the title you assigned to the application that you created in Studio.
   Selecting your app in Studio automatically updates the application scope.

2. In the Application Explorer, navigate to Natural Language Understanding > NLU Models > NLU for Reservations.
   In this scenario, NLU for Reservations is the title you assigned to the NLU model that you’re working in.

3. In the Associated Entities section of your #MakeReservation NLU Intent screen, click the StartReservation entity.

4. In the StartReservation NLU Entity screen, click Properties.
5. In the Update NLU Entity screen, select the **Model Availability** check box.

6. Click **Save**.

   The **StartReservation** entity is marked as available in the Entities section on your **NLU for Reservations** NLU Model screen, and can be recognized in utterances across all intents in the model.

7. Click **Train**.

8. On the NLU for Reservations Model screen, click **Test**.
9. In the Test Model panel, enter an utterance example that includes the **StartReservation** time entity, such as *Can we get a table for two that starts at 7pm?*.  

10. Click Go.  

**Result:** The **StartReservation** time entity can be recognized in utterances for both the **#MakeReservation** intent and the **#CancelReservation** intent. It’s recognized because you’ve promoted it to the NLU model level, which makes the entity available across all intents in the model.

### Clone an NLU model

Copy an existing NLU model to use its clone as an iterative testbed for creating, importing, and comparing alternate NLU components, predictions, and confidence threshold scores between the clone and the original model.

**Before you begin**

- Create and train or use an existing NLU model that you will copy into a clone in the NLU Workbench.
- Role required: admin or nlu_admin

**About this task**

In this example procedure, you’ve already created a model that’s titled **NLU for Access Requests** and you want to customize it with additional intents from other NLU models. Here, you copy the original model into a clone and then modify it accordingly. The clone becomes your custom version of the original model so you can leverage its existing intents and entities but still add intents and entities of your own.

**Procedure**

1. Navigate to **NLU Workbench > Models > NLU for Access Requests**.  

   **NLU for Access Requests** is the name you saved in the system when you created your NLU model. See Create an NLU model.
2. **Optional:** In your Model screen, you have the option of creating a clone by clicking the **Clone** button, as shown in the image below.

![Clone button](image)

3. However, in this example scenario, you navigate to **NLU Workbench > Models**, and point to the empty space to the right of the **NLU for Access Requests** model, where a Clone icon appears.

4. **Click Clone.**
   In the Clone this Model screen, note that the system appends the word Copy1 to the end of the **Model Name** field to distinguish it from its source model.

5. In the **Description** field, enter a description for the new model, such as the one shown in the image below.

![Clone Model](image)

6. **Click Clone Model.**
   Your cloned model appears, with Copy1 added to its name.
7. Optional: In the Model screen of the new clone draft, click **Settings** so you can update the model name.

8. In the Settings section of the Model screen, configure these fields.
   - **Model Name**: Add *(version 2)* to the name.
   - **Confidence Threshold(%)**: Change the default setting of 60 to 70.

9. Click **Save**.
Your new clone appears on the Models screen, showing its revised name and model status.

![Models screen with a clone model]

**What to do next**
You can customize the new clone model by adding new intents and entities to it, and testing them against the performance of the original source model.

**Train and test your NLU model**
Train and test your model iteratively so that its intents and entities are validated, compiled, and saved to your model.

**Before you begin**
- Make sure that the NLU Model Builder - Core plugin, NLU Model Builder plugin, and Predictive Intelligence plugin are all installed and activated.
- Create an NLU model.
- Create one or more NLU intents and their associated entities.
- Role required: Admin or Delegated Developer role (with permission of All File Types)

**About this task**
In this example scenario, you’ve already created and trained numerous intents, utterances, entities, and their associated annotations. In this example procedure, you’re testing the NLU model by providing the system with utterances so it can deliver prediction results and confidence scores.

**Procedure**
1. Navigate to System Applications > Studio.
2. In the Application Explorer, navigate to Natural Language Understanding > NLU Models > NLU for Access Requests.

*NLU for Access Requests* is the name you saved in the system when you created your NLU model. See Create an NLU model.
3. Make sure the objects and data you've created are complete in the NLU Model, NLU Intent, and NLU Entity screens. If key data is missing or incomplete, remedy the situation.

4. In the Intents section of the NLU Model screen, click **Train**. You only need to click **Train** prior to testing your NLU model.

5. Click **Test**.

6. In the Test Model panel, enter an utterance or partial utterance from your utterance examples.

7. Click **Go**.

   **Result:** The system predicts the top intents and entities and shows you their matching confidence scores. In this scenario, you enter **reset my password to a@b.com**. That utterance prediction result has a 94% match (confidence score) to the utterances you provided in your **Reset Password** intent.

---

**What to do next**

- Keep testing new utterances if you're not satisfied with the confidence scores the system assigns to your utterance inputs. See **Compare draft and published versions of your NLU model**.

- If you want to adjust the current **Confidence Threshold(%)** value, click the **Properties** button in your **NLU for Access Requests NLU Model** screen, set a new value, and click **Save**.

- If you're satisfied with the results of your testing, **Publish your NLU model**.

**Compare draft and published versions of your NLU model**

Compare a draft NLU model to its most recent published version. Test and review the accuracy of its prediction confidence scores.
Before you begin

• Make sure that the NLU Model Builder - Core plugin, NLU Model Builder plugin, and Predictive Intelligence plugin are installed and activated.

• Role required: Admin or Delegated Developer role (with permission of All File Types)

About this task
In this example scenario, you’re training and testing a published NLU model in Studio iteratively with the goal of improving its prediction confidence scores.

In this example procedure, you’ve cloned the model from a prebuilt read-only out of the box ITSM model. You’ve cloned the model to create your own business-specific version of it while leveraging the existing intents from the prebuilt model.

When you test an utterance against an NLU model:

• If the model is trained and never published, the Test Model panel shows only trained model results.

• If the model is trained and published, the Test Model panel shows only published model results.

• If you're updating a published model, the Test Model panel shows both the trained model results and the published model results for comparison.

Note: Prediction confidence score results appear in green font if they meet or surpass the confidence threshold you’ve established for the model. In this scenario, the threshold value is 60%. Scores that fall below that value appear in red font.

Procedure

1. Navigate to the published model you’ve created in Studio.

2. Train and test the published model so you can see its current prediction scores.
   a. Click Train.
   b. Click Test.
   c. In the Test Model panel, enter this utterance: raise a PRB immediately.
   d. Click Go.

   Result: The trained and published model scores are identical because you haven’t made any changes to the published model yet.
3. Update the model with new or revised intents, utterances and entities as needed.

4. When you’ve finished your edits, click Train.

5. On the NLU Model screen or NLU Intent screen, click Test.

6. In the Test Model panel, enter the same utterance you used in Step 2: raise a PRB immediately.

7. Click Go.

   **Result:** The Test Model panel refreshes to show both trained model prediction results and published model prediction results. The confidence scores for the Create Problem intent have improved from 67% in the published model version to 68% in the trained model version.
What to do next

• Continue to test utterances for your model intents to see if their prediction results are to your satisfaction. If you’re satisfied with the confidence scores as they are, publish your NLU model.

• Check the success and quality of your NLU predictions.

Related information

Create an NLU intent
Train and test your NLU model

Publish your NLU model

Publish your model so that its most recent version is active and available for use in other applications that consume NLU.

Before you begin

• Make sure that the NLU Model Builder - Core plugin, NLU Model Builder plugin, and Predictive Intelligence plugin are all installed and activated.

• Create an NLU model.

• Create one or more NLU intents and their associated entities.

• Train and test your NLU model.

• Role required: Admin or Delegated Developer role (with permission of All File Types)

About this task

In this example scenario, you’ve already trained and tested your NLU model. In this example procedure, you’re publishing your final version of the model so it’s available for use in other ServiceNow applications.

Procedure

1. Navigate to System Applications > Studio.

2. In the Application Explorer, navigate to Natural Language Understanding > NLU Models > NLU for Access Requests.

   NLU for Access Requests is the name you saved in the system when you created your NLU model. See Create an NLU model.

3. Click Publish.
Result: The most recent version of your NLU model is active and available for use in other ServiceNow applications, such as Virtual Agent. Publishing also replaces any older versions of the model that are currently in use by those applications.

Virtual Agent and NLU Workbench integration

Virtual Agent administrators can access and update their NLU models from within the Virtual Agent Designer user interface.

Integration setup tasks, roles, and details

As Virtual Agent administrators create and configure their conversation topics, they must first create their NLU model and its associated intents in the NLU Workbench. This action requires they use the NLU Workbench and the admin or nlu_admin role. For instructions on creating an NLU model, see Create an NLU model.

In addition, they must also complete the following tasks in Virtual Agent General Settings.

- Enable NLU.
- Select the NLU service provider.
- If using language-specific NLU models, enable the languages for those models.

Virtual Agent administrators also need to apply their NLU model to a conversation topic by completing the following tasks in Virtual Agent Designer:

- In Topic Properties, select the NLU model, the NLU intent, and the topic switching behavior.
- For input controls used in the topic flow, set the NLU properties for entity extraction.

Once the NLU model is complete and associated with a Virtual Agent conversation topic, administrators with the virtual_agent_admin or admin role can update the NLU intent utterances and train, test, and publish their NLU model from within the Virtual Agent Designer user interface. For more information, see Natural Language Understanding in Virtual Agent.

NLU Workbench - Advanced Features

NLU Workbench - Advanced Features expands the functionality of NLU Workbench that helps you manage and improve your models.
**Summary usage**
NLU Workbench - Advanced Features includes the following features:

- **NLU Conflict Review**: Identify conflicting intents within or across models to improve model performance.
- **NLU Batch Testing**: Test large groups of utterances against your NLU models to see how the model predicts intents.
- **NLU Model Performance**: Discover new intents and utterances to add to existing Virtual Agent topics to improve model performance.

**Installation**
NLU Workbench - Advanced Features is available from the ServiceNow Store. For more information, see [Install NLU Workbench - Advanced Features](#).

**Install NLU Workbench - Advanced Features**
You can install the NLU Workbench - Advanced Features application (com.snc.nlu.workbench.advanced) if you have the admin role.

**Before you begin**
- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see [Get entitlement for a ServiceNow product or application](#).
- **NLU Workbench - Advanced Features** requires the following plugins. Ensure that these plugins are activated before you install NLU Workbench - Advanced Features.

  **Required ServiceNow plugins**
  - **Predictive Intelligence (com.glide.platform_ml)**
    Enables various Predictive Intelligence and Machine Learning capabilities for training models. See [Activate Predictive Intelligence](#).
  - **NLU Model Builder - Core (com.glide.nlu)**
    Adds NLU Model capabilities. See [Activate the NLU Workbench](#).
  - **NLU Workbench (com.snc.nlu_studio)**
    Create and train NLU models. NLU Workbench contains the advanced features once downloaded. See [Activate the NLU Workbench](#).
• NLU Workbench - Advanced Features requires the following ServiceNow Store applications. Ensure that these applications are installed before you install NLU Workbench - Advanced Features.

**Required ServiceNow Store applications**

**Intent Discovery**

Discover user intents from incidents, cases or request data to maximize deflection with Virtual Agent and NLU. For more information, see Install Intent Discovery.

Role required: admin

**About this task**

Tables are installed with NLU Workbench - Advanced Features.

For more information, see Components installed with NLU Workbench - Advanced Features.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the NLU Workbench - Advanced Features application (com.snc.nlu.workbench.advanced) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install NLU Workbench - Advanced Features.

4. Click **Install**.

**Components installed with NLU Workbench - Advanced Features**

Several types of components are installed with activation of the com.snc.nlu.workbench.advanced plugin, including tables.
Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLU Performance Ignored Clusters</td>
<td>Contains information on the ignored cluster. Filled when user clicks Ignore.</td>
</tr>
<tr>
<td>[nlu_performance_ignored_clusters]</td>
<td></td>
</tr>
<tr>
<td>NLU Batch Test Result</td>
<td>Contains the parsed results of a batch test including each utterance and predicted intent.</td>
</tr>
<tr>
<td>[nlu_batch_test_result]</td>
<td></td>
</tr>
<tr>
<td>NLU Conflict Execution</td>
<td>Stores the information related to each execution of a conflict analysis run for a given definition.</td>
</tr>
<tr>
<td>[nlu_conflict_execution]</td>
<td></td>
</tr>
<tr>
<td>NLU Batch Test Run Definition</td>
<td>Contains base information related to the batch test execution.</td>
</tr>
<tr>
<td>[nlu_batch_test_run_definition]</td>
<td></td>
</tr>
<tr>
<td>NLU Batch Test Run Execution</td>
<td>Contains information related to each execution of the batch test.</td>
</tr>
<tr>
<td>[nlu_batch_test_run_execution]</td>
<td></td>
</tr>
<tr>
<td>NLU Conflict Result</td>
<td>Stores the complete results of a conflict analysis execution.</td>
</tr>
<tr>
<td>[nlu_conflict_result]</td>
<td></td>
</tr>
<tr>
<td>NLU Batch Test Utterance</td>
<td>Contains the utterances used for a test set. Populated by the import set.</td>
</tr>
<tr>
<td>[nlu_batch_test_utterance]</td>
<td></td>
</tr>
<tr>
<td>NLU Batch Test Set</td>
<td>Includes the information for the batch test. Referenced by the utterance record and run definition.</td>
</tr>
<tr>
<td>[nlu_batch_test_set]</td>
<td></td>
</tr>
<tr>
<td>NLU Performance Utterance Trace</td>
<td>Contains the information on the utterances added to an intent.</td>
</tr>
<tr>
<td>[nlu_performance_utterance_trace]</td>
<td></td>
</tr>
<tr>
<td>NLU Conflict Definition</td>
<td>Contains the details of the NLU model or pair of models used for the conflict.</td>
</tr>
<tr>
<td>[nlu_conflict_definition]</td>
<td></td>
</tr>
</tbody>
</table>

### NLU Conflict Review

Identify conflicting intents within or across models so you can take corrective actions, resolve such conflicts, and improve your NLU performance.
Summary usage

As the number of intents within a model increases, there can be overlapping intents based on how broad or narrow the intent is. For example, the utterance examples in one intent could be almost identical to those in another. There can also be conflicts between intents across models, and even applications.

To address these issues, the ServiceNow® Store NLU Workbench - Advanced Features app provides a conflict review analysis that you can use to resolve these issues prior to model publication and deployment.

Running the Conflict Review analysis

Make sure that you have the NLU Workbench - Advanced Features (com.snc.nlu.workbench.advanced) ServiceNow® Store plugin installed and activated on your instance. For more information on the required plugins, see Activate the NLU Workbench.

The Conflict Review screen shows a list view of all conflict reviews created in your instance. When a review is completed, it’s added to a running list of reviews. In this example scenario, you’re creating the first review in your instance, so when it’s completed, it’s shown in the count as 1 of 1 reviews. As more conflicts arise over time, you will see multiple reviews in the list.

Conflict reviews are analyzed on either one or two NLU models. When you run an analysis on a single model, the system shows intents and utterances that are only in that model. When you run an analysis on 2 models, the system shows intents and utterances that are in both models.

Conflict reviews always run on the last trained version of the model(s) they analyze.

Conflict reviews have two types: Critical and Moderate. The standard approach is to begin with the critical ones.

Note that a conflict review shows intents that have overlaps with specific utterances that are used for training an intent. When you run the analysis, you use one of following actions to resolve the conflict:

- Ignore the conflict
- Delete an identical or nearly identical utterance from one of the intents
- Edit the utterances to make them more distinct, with little or no overlap between them

In this example scenario, you’re resolving a conflict where two distinct intents have the exact same utterance.

1. Using the admin or nlu_admin role, navigate to NLU Workbench > Conflict Review.
2. Click **Run analysis**.

3. In the **Model(s)** field on the Choose one or two models to analyze for conflicts screen, select two NLU models for the analysis. In this example scenario, you choose the `demo_hardware_issue` and `demo_it_request` models.

4. Click **Run Analysis**.

The Conflict Review screen refreshes to show the analysis, including the two models you selected for analysis, the counts of Critical and Moderate conflicts under review, the number of reviews that have been completed, and the run date for the analysis. If you point to the far right column on the screen you'll see options to rerun the analysis, or delete it and start all over.
5. In the Model(s) column, click your two paired models so you can drill down into the review.

The screen refreshes to show the details of the conflict review. Note the summary of the two models you chose for the analysis, their latest training dates, the types of conflicts they hold, and the version time stamp of the analysis. Note also the 0 of 1 count, which indicates that this is the first conflict review created in this instance. As the system detects more conflicts over time, and those conflicts are reviewed, the count increases.

If you were to determine the utterances in the image below are fine as they are, then you should click Ignore. Clicking Ignore tells the system you’ve completed your review, so it marks it as reviewed and moves on to the next conflict review. However, in this scenario, you don’t ignore the conflict, because intents that share the same utterance are a conflict worthy of review.

To determine how you’ll resolve this conflict, consider the 2 intent names and the identical utterances they share. Consider which intent is more likely to use the laptop is really slow utterance. If you compare the 2 intent names closely, you might realize that a laptop that’s really slow isn’t the same as a laptop that doesn’t work. However, a laptop that’s really slow is indeed a laptop issue. So
in this example scenario, you decide to dig deeper into the intents to scan the context of their other utterances.

Note also that when an intent uses unique utterances, it helps the system to more accurately predict which utterances belong to it. Hence, you'll need to edit or delete the utterance from 1 of the 2 intents. In this example scenario, you decide to dig into the #laptop_not_working intent.

6. Click #laptop_not_working.

The #laptop_not_working Intent screen appears, showing its current 3 utterances. You make the decision to delete the laptop is really slow utterance from the #laptop_not_working intent.
7. Click the **Delete this utterance** trash can icon.

The Confirm Delete screen appears.

8. Click **Delete**.

The Confirm Delete screen disappears, and the Utterances count drops from 3 to 2 because you’ve deleted the *laptop is really slow* utterance from the intent.

9. Click **Train**.
A banner appears on the Intent screen, confirming the model is successfully trained.

10. Click **Conflict Review** in the navigator.

![png file](image.png)

**Result:**

The **Conflict Review** list screen appears, showing your conflict review analysis is complete, and that it’s been reviewed.

![png file](image.png)

**NLU Batch Testing**

Test your Natural Language Understanding (NLU) models against a large set of utterances to evaluate the performance of the model. Use batch testing to improve the intent prediction capabilities of your models.

**Summary usage**

Use Batch Testing to create, upload, and test datasets comprised of utterances and their expected intents. You can then run tests against your NLU models.

Batch Testing helps you test and optimize your models to better respond to your users’ intents.

**Installation**

Batch Testing is part of the NLU Workbench - Advanced Features app available on the ServiceNow® Store.

To use Batch Testing, ensure that the NLU Workbench- Advanced Features (com.snc.nlu.workbench.advanced) plugin is active on your instance.
For more information, see Install NLU Workbench - Advanced Features and Activate the NLU Workbench.

**Localization**

Batch Testing supports utterances for the following languages:

- English
- Spanish
- French
- German
- Japanese
- Dutch
- Italian
- Korean
- Polish
- Chinese
- Swedish
- Norwegian
- Danish
- Finnish
- Portuguese (Brazil)
- French (Canadian)
Test sets are lists of utterances and expected intents. Create a test set by using a table in a CSV or XLSX file. The table should contain two columns, one for utterances and one for the expected intent. Your test set can include up to 10,000 rows.

To get the most out of testing your NLU models, your test sets should include:

- Utterances that the model is likely to encounter from your users
- Utterances with no intents
- Utterances with more than one intent, separated by a comma

By including these types of utterances, the test better assesses the model’s ability to perceive intents and respond to your users.

To create a test set, see Create a test set for batch testing.

Once you have a test set, you can test trained NLU models. You can train multiple models at a time, but it is not recommended to select more than 3–4 models.

To begin testing, see Create a test set for batch testing.

After running a test, your results appear on the Test results page.
The **Test results** page lists your completed and in-progress tests. At a glance, the results page shows the model tested against, the number of utterances, and prediction percentages.

To see more about the test results, click the name of the test set.
The **Overview** page shows basic information about the results and includes a graphic for the prediction percentages.

Batch testing results include the following percentages:

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct</td>
<td>The percentage of utterances that your model correctly predicted the intent.</td>
</tr>
<tr>
<td>Correct among multiple</td>
<td>For utterances that include more than one intent. The percentage of utterances that your model correctly predicted some but not all of the intents for that utterance.</td>
</tr>
<tr>
<td>Missed</td>
<td>The percentage of utterances that your model did not predict an intent.</td>
</tr>
<tr>
<td>Incorrect</td>
<td>The percentage of utterances that your model did not predict the correct intent.</td>
</tr>
</tbody>
</table>

The **Intents that need attention (Current thresholds)** shows the top 5 missed and incorrect intents. Click the intent to load a list of the utterances that make up the percentages. Use this information to see which intents your model struggles with and make changes to the model.

The **Detailed results** page lists information about each utterance that was tested.
From here, you can see the prediction outcome and confidence of your model for each utterance. Filter the results by using the search bar or interacting with the filter tools and column headers.

You can also export the results via a CSV or XLSX file by clicking Export. The file includes columns similar to the detailed results page.

**Model threshold**

The confidence threshold of a model dictates the strictness of your model in the test. A lower score may overgeneralize your utterances while a higher score may be too literal and incorrectly predict your utterances. Finding the ideal threshold improves your model's ability to correctly predict intents.

Pre-built models come with a tuned threshold. The confidence threshold on pre-built models were chosen specifically for that model. For custom models or copies of pre-built models, the model test can recommend a better threshold.
Batch test results include a model threshold recommendation only if they meet the following requirements:

- Test is a model test
- Test isn’t against a pre-built model
- Test set includes at least 100 utterances
- Threshold covers at least 25% of the model’s intents
- The recommended threshold would have better results than the current threshold

Test results that have a threshold recommendation show an extra graphic. The second graphic shows the prediction percentages with the recommended thresholds applied.

Applying the threshold recommendation may improve the prediction percentages of your model. Click Apply recommendations to change the threshold percentages of the models. If you apply the recommendation, the model automatically retrain. The test results show the prediction percentages with the new threshold.

To learn more about confidence thresholds, see Compare draft and published versions of your NLU model.
**Model optimization**

Model optimization helps improve the prediction capabilities of your models. Similar to a batch test, run the model against a test set. However, model optimization performs additional processes to continue to tune the model for optimal performance. Perform model optimization as a last step before publishing your model.

To learn more about optimizing your model, see [Model optimization](#).

**Create a test set for batch testing**

Import a file with a table of your utterances paired with the correct intents. Use the test sets to run batch tests on the utterances against a trained NLU model.

**Before you begin**

Role required: admin or nlu_admin

**About this task**

Your CSV or XLSX file should contain a table that pairs your utterances with the expected intent. Your file can contain up to 10,000 utterances.

⚠️ **Note:** For test sets in languages other than English, you must add the glide.import.csv.charset system property with the value UTF-8. For more information, see [Import sets](#) and [Import sets properties](#).

To get the most out of testing your NLU models, your test sets should include:

- Utterances that the model is likely to encounter from your users
- Utterances with no intents
- Utterances with more than one intent, separated by a comma

By including these types of utterances, the test better assesses the model’s ability to perceive intents and respond to your users.

**Example test set table**

<table>
<thead>
<tr>
<th>Utterance</th>
<th>Expected intent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Let me have a burger</td>
<td>Order</td>
</tr>
<tr>
<td>I want to pay</td>
<td>Payment</td>
</tr>
<tr>
<td>Get me something sweet</td>
<td>Order</td>
</tr>
<tr>
<td>Something wrong with my payment</td>
<td>Payment</td>
</tr>
<tr>
<td>Burger cost</td>
<td>Order, Payment</td>
</tr>
</tbody>
</table>
Procedure

1. Navigate to **NLU Workbench > Batch Testing** and click **Test sets**.

2. Click **Create a test**

   **Create new test set**

   - Test set name
   - Language **English - en**
   - Test set file **Select file**

   Please Note: Ensure that your file has “Utterance” and “Expected Intent” columns:

<table>
<thead>
<tr>
<th>Utterance</th>
<th>Expected intent</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Choose a name for the test set.

4. Choose a language.

5. Click **Select file** and choose a CSV or XLSX file.

6. Click **Create**. Your test set shows in the list.

**What to do next**

Use the test set to run a batch test or a model optimization test. To learn how, see **Run a batch test** and **Optimize a model**.
Once you have created a test set, you can add more utterances to it. Click **Import utterances** when looking at a test set.

Click **Import utterances** when looking at a test set.

Select a CSV or XLSX file with your additional utterances to import.

**Import a list of utterances paired with correct intents**

Click **Import**. The system starts to add your utterances to the test set. Once complete, rerun any tests using the test set to test the added utterances.

**Run a batch test**

Test multiple utterances against trained NLU models. Test the quality of a model and tune the confidence threshold to improve intent prediction.
Before you begin

• Role required: admin or nlu_admin
• Create and train an NLU model. See Create an NLU model and Train and test your NLU model.

If you choose to test multiple models, your test set must cover at least 25% of the total intents of all the models. It is not recommended to test more than 3-4 models at a time.

Procedure
1. Navigate to NLU Workbench > Batch Testing.
2. Click Run new analysis.
3. In the Run new analysis window, select Test.

Run a new analysis

You have two analysis options to choose from, based on your model state.

If you are still working on the model, test to validate its quality and find out where you can improve it. If you are done making changes to the model, you can optimize it to enhance performance before you publish it. What do you want to do?

- Test model

Select a test set: My test set
Select model(s): --None--

Optimise model

Applying these optimisation changes can take time. Also, you will have to optimise the model again if you make changes and retrain an optimized model. Hence it is recommended that you only do this once you’re ready to publish your model.

4. Select a test set.
5. Select one or more models.
6. Click Run.
   Your new test shows on the Test results list with a In Progress status.

What to do next
Once you begin the batch test, you can click the name of the test set to view the test results. Use the results to modify your NLU model. Rerun the test or run an optimization test to further improve the intent prediction.
Model optimization
Model optimization helps improve the prediction capabilities of your models. Perform model optimization as a last step before publishing your model.

Summary usage
An optimized model is an existing model that has been tuned based on an analysis of your records. Similar to a threshold recommendation, model optimization helps improve the prediction capabilities of your models. However, model optimization goes a step further by tuning your model for optimal performance and more correct predictions.

Model optimization includes the following functionalities:

- Irrelevance detection: Trains the model to identify scenarios when not to provide a prediction. Helps the model avoid incorrect predictions.
- Improved training pipeline: Trains the model using advanced algorithms from recent research to improve performance.
- Enterprise language model: Trains the model using ServiceNow natural language understanding data to improve the performance base.

Only optimize your model when it is ready to be published. Consider the optimization test as the finishing touches for your model before publication.

When running a new analysis, you can select to optimize a single model. To learn more about how to run model optimization, see Optimize a model.

To successfully run a model optimization, your model and test set must meet the following requirements:

- Model is in the English language
- Model is not pre-built model

⚠️ Note: You can copy a pre-built model and optimize
- Test set includes at least 100 utterances
- Test set covers at least 25% of each intent tested by the model

Optimization results
Optimization only happens if a significant change to the model significantly increases the correct predictions or reduces the incorrect predictions. If
you don’t see the optimization performance, your model is already optimal.

Once model optimization finishes, you can see the model’s current performance compared to the optimized model on the **Overview** results page. The current model prediction percentages show on the left side. The optimized model prediction percentages show on the right side. Depending on the optimization, you might see an increase in the correct percentage or a decrease in the incorrect percentage.

Optimization provides an overall increase in correct predictions or decrease in incorrect predictions. While the threshold for each prediction may change, the overall optimization improves the models performance.

The **Optimization changes** tab shows the predictions that would be changed by the optimizations. You can see predictions that will become correct, incorrect, and missed if you apply the optimization.
Review the changes to see if you want to apply the optimization.

Here’s how predictions will change once your models are optimized. Review their impact on predictions before you accept them.

<table>
<thead>
<tr>
<th>Predictions that will be corrected after optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original prediction</td>
</tr>
<tr>
<td>When someone says I can’t speak with someone in HR</td>
</tr>
<tr>
<td>How can I get general help from HR?</td>
</tr>
<tr>
<td>general inquiry</td>
</tr>
<tr>
<td>emergency contact</td>
</tr>
<tr>
<td>Here is my emergency contact.</td>
</tr>
</tbody>
</table>

Publishing
Once you apply the optimization, your model is ready to be published.

If you make any changes after optimizing the model, you must reoptimize the model. Also, if you make any changes to a published model, you must also need reoptimize.

See Publish your NLU model.

Optimize a model
Optimize one of your trained and tested models to reduce incorrect predictions and improve correct predictions. Optimize a model right before publishing.

Before you begin
- Role required: admin or nlu_admin
- Train and test a model

About this task
Run an optimization analysis after your model has already been trained and tested. The optimization provides a final tuning to your model before publication.

To receive a model optimization, your test must meet the following requirements:
- Model is in the English language
- Model is not pre-built model

Note: You can copy a pre-built model and optimize
• Test set includes at least 100 utterances
• Test set covers at least 25% of each intent tested by the model

Procedure
1. Navigate to NLU Workbench > Batch Testing.
2. Click Run new analysis.
3. In the Run a new analysis window, select Optimize

Run a new analysis

You have two analysis options to choose from, based on your model state.

If you are still working on the model, test to validate its quality and find out where you can improve it. If you are done making changes to the model, you can optimize it to enhance performance before you publish it. What do you want to do?

- [ ] Test model
- [x] Optimize model

Applying these optimization changes can take time. Also, you will have to optimise the model again if you make changes and retrain an optimized model. Hence it is recommended that you only do this once you’re ready to publish your model.

- [ ] Select a test set
  - [ ] My test set
- [ ] Select a model
  - [ ] None

4. Select a model and test set from the lists.
5. Click Run.

Your new test shows on the Test results list with a In Progress status.

What to do next
Optimization time depends on the model size, server bandwidth, and number of models in the test/optimize queue. Optimization takes longer than batch testing and can take anywhere from 30 minutes to several hours.

Once your optimization test completes, you can compare the prediction results of the current model and the optimized model. You can choose to apply or dismiss the optimization.

In the test results page, select Optimization changes to see a breakdown of the changes if you apply the optimization.
After applying the optimization, your model is ready to be published.

**Note:** If you make any changes to the model before publishing, you must reoptimize. Only optimize a model when it is ready to be published.

**NLU Model Performance**

Use the system to improve the precision of how often Virtual Agent (VA) NLU model predictions are correct, and how clustered utterances can help VA users identify new intents and utterances for their models.

NLU Model Performance provides an improvement analysis and report of how well your NLU models predict VA users’ intents from their utterances. When you first access this feature, the data you see on the screen is the completed report from a previous analysis. It’s shown in the following image primarily as an example of a report’s basic format.
Summary usage and plugin information

As NLU models for VA are updated, published and deployed, you can use NLU Model Performance to track the efficacy of the intent predictions they make.

If these predictions are skipped, it’s because they’re unable to predict an intent with a high enough confidence score for the model.

To improve intent prediction performance, the system groups unsupported utterances into clusters for analysis, and generates a report that identifies new intents or utterances you can add to your existing VA intents. This improves the model performance.

Before you access NLU Model Performance, use the admin role to install the following two plugins on your instance in the following order:

1. Glide Virtual Agent (com.glide.cs.chatbot). See Activate Virtual Agent
2. NLU Workbench - Advanced Features (com.snc.nlu.workbench.advanced)

⚠️ Note: To use NLU Model Performance, you must first have 5,000 VA utterances in your instance.

Reviewing results from the previous analysis report

NLU Model Performance uses three bars that track VA intent predictions across a specified date range. Each bar distributes VA utterances and intents into the following categories: unsupported utterances, multiple prediction scenarios, and single prediction scenarios.
To familiarize yourself with the types of data you’ll see in the new analysis you run, take steps to review the second and third bars of the previous report, as shown in the following images.

1. Using the admin or nlu_admin role, navigate to NLU Workbench > Performance.

2. Click the tool tip on each of the three bars to see a description of what data they address, such as unsupported utterances, or what VA user scenarios they measure, such as intent prediction success.

3. Click **Multiple predictions made, intent selected** to review the data in the second bar. Here, the system successfully predicted an appropriate intent, and VA launched a topic flow to try to resolve the issue.

<i>Note:</i> The term *topic flow* refers to a chatbot conversation that VA users created in the VA Designer application.
4. Click the caret on any prediction to see a list of alternate intents the system predicted, and their associated confidence scores.

5. Click **One prediction made, topic launched** to review the data in the third bar. Here, the system successfully predicted a single intent from a user's utterance, and VA automatically launched a topic flow to try to resolve the issue.
Running the improvement analysis

Now that you’ve reviewed the three bars on the Model Performance screen, you turn your attention to the unsupported utterances. In this example scenario, you recall that the number of unsupported utterances in the previous report was 2,176, and the total number of utterances was 5,603. To ensure you have plenty of utterances for the analysis, you decide to increase the date range for the analysis from 30 days out to 90 days out.

1. Click Past 90 days. When you increase the number of days in the date range, the system pulls the most recent VA utterances and intents into the analysis.

2. Click Run analysis.

Result: The screen refreshes to show that your total utterances have increased from 5,603 to 13,585. This is because you expanded the date range from 30 days to 90 days out. Also, The Unsupported utterances section appears on the bottom of the screen and shows a list of clusters that hold similar unsupported utterances that you can add to other intents. A banner also appears, notifying
you that your new analysis is in progress. In addition, you can see that the system is currently processing 666 clusters for the analysis.

When your analysis completes, a second banner appears, notifying you that your analysis has delivered intent prediction improvement suggestions in the form of clustered utterances. It also reduced the number of processed clusters from 666 to 661.
Click the X icon on the each of the banners if you prefer to see them closed.

**Using clustered utterances to improve intent prediction**

In the **Unsupported utterances** section of the screen, scroll though the rows of improvement suggestions to find the most appropriate intents for your unsupported utterances. Each row on the screen represents a cluster of utterances. Your actions within a cluster are to either add utterances to an intent, or to click **Ignore** to hide the cluster. You can also make the cluster reappear on the screen by clicking **Don't ignore**.

To learn more details on how to use these clusters that hold the utterance data, review the steps in the following three example scenarios.

First, click the **Show additional** picker to see the check boxes that control the visibility of the clusters that are added to an intent, and those that are ignored. The default view shows the **Clusters added to intent** box selected and the **Ignored clusters** box clear. If you select both types of cluster views, they both appear on the screen.

**Scenario 1: Scroll down the screen to the 7th cluster.**

1. Click the caret on the cluster, then click **Add to Intent**.
2. In the Add cluster to an intent screen, click **Show top 20** to expand the utterance list to the top 20 utterances in the cluster.

3. Review the utterances to determine if they could be candidates for a given intent.

4. Since almost all of the utterances are duplicates which seem unlikely to match an intent, click **Cancel**, then click **Ignore**.

**Result:** The cluster you ignored disappears, and the **Clusters** count next to the **Show additional** picker changes from 661 to 660.

Scenario 2: Scroll down the screen to the 15th cluster.
1. Click the caret on the cluster, then click Add to Intent.

2. In the Add cluster to an intent screen, click Show top 20.

3. Review the utterances to determine if they could be candidates for a given intent.

4. In this example scenario, you have a decent amount of utterances that apply to the password reset theme, but you can't find an appropriate intent to use for these utterances. To resolve this issue, you can create a new intent to house the utterances, as follows.

5. Select some utterances from the list. In this example scenario, you select Unable to reset the admin password and I need to reset my admin account.

6. In the Choose intent picker, click the caret to find and select an appropriate intent. However, since there's no appropriate intent available, you enter ResetPassword to name an intent, then click Create "ResetPassword".
7. In the **Choose model** picker, select an NLU model. In this scenario, you choose the **[Read Only] ITSM NLU for Virtual A Copy1** model.

8. Click **Add to Intent**.
**Result:** A banner appears on the screen, notifying you that the two utterances you added to the *ResetPassword* intent are now associated with the *[Read Only]* ITSM NLU for Virtual A Copy 1 model. The intent has a live link.

9. Click the intent link to confirm the changes you made appear in the #ResetPassword intent you created earlier. Note that the two utterances you added to the intent are also available in this view.

---

Scenario 3: Scroll up the screen to the 11th cluster.

1. Click the caret on the cluster, then click **Add to Intent**.
2. In the *Add cluster to an intent* screen, click **Show top 20** to expand the utterance list to the top 20 utterances in the cluster.
3. Review the utterances to determine if they could be candidates for a given intent.
4. In this example scenario, you have utterances that only contain numbers. You’re befuddled as to why these utterances aren’t comprised of natural human-expressed phrases that include the number in some kind of believable context, so you click Ignore.

Result: A banner appears, notifying you that your ignored cluster is no longer visible.

5. In this example scenario, your colleagues advise you to keep this cluster for testing purposes, so you take the following steps to do so.

6. Click Show additional, then clear the Clusters added to intents check box and select the Ignored clusters check box.

7. Scroll back to the 11th cluster and click Don't ignore.
**Result:** The cluster reappears on the list of all other clusters.

**Related information**

Virtual Agent

Natural Language Understanding in Virtual Agent

**Intent Discovery**

Use the Intent Discovery app to help identify opportunities for incident deflection. For example, you can use it to identify which Virtual Agent conversations to activate next.

**Summary usage**

Intent Discovery provides a coverage analysis that you can run on historic incident data or other task data.

You can also group the run’s remaining records into different clusters so you can manually add utterances to NLU intents. In addition, you can use specific clusters to create new intents in a model.

For applications such as Virtual Agent, that consume NLU, Intent Discovery helps you to better understand which OOB intents you can benefit from, and which custom intents would be useful to create.

In this example scenario, you're using intent discovery to identify the top intents in your instance, and how much coverage they can provide across your incident records in the current quarter.
Installation

Intent Discovery is available from the ServiceNow Store. For more information, see Install Intent Discovery.

Creating an Intent Discovery report

1. Using the admin or nlu_admin role, navigate to NLU Workbench > Intent Discovery. The items you see on the Intent Discovery screen are previous reports that others have created.

2. Click Run Analysis.

Running a coverage analysis on the report

1. For this example report, you configure the following fields on the Intent discovery > Create new screen.

   - Data Source: Select the Incident (incident) table.
   - Filter by: [Created] [on] [This quarter]
   - Field to analyse: Short description (short_description). You choose Short description because it's a highly used string field that references words that can help the system identify an intent.
   - Taxonomy: Select ITSM. This field tells the system to run classification processing on your ITSM incident records. It has 3 options: Classification, ITSM, or blank, which defaults as Classification.
   - Cluster unmapped utterances by keywords... : Select the check box. When you check this box, the system groups your incident records that weren't classified into clusters.
   - Report name: The field automatically defaults to Incident <month/day/year>. You can edit the name if you prefer. In this example scenario, you enter Incident 12/16/2020 – SF Test.
2. Click **Run analysis**.

**Result:** Your report appears on the Intent Discovery screen, showing its status as the coverage analysis begins. The subsequent status values appear in the following order during the analysis: Preparing to run, Work in progress, Clustering, and Done. This can take from 5 minutes to 30 minutes to complete. The fewer the records you have in a cluster, the less time it takes. Turning clustering off can also speed up the process.

When the analysis completes, the column values on the screen appear, with the **Status** column value set to **Done**, as shown in the image below.
Note: If you want to delete the report and start over, point to the right of the Status column to invoke the **Delete report** icon.

3. Click the **Name** of your report.

---

### Intent Discovery

Check on your latest analyses or run a new one to get recommendations on intents that cover queries you’re getting from your users.

Each of these reports is an analysis of a dataset you identified against a product model.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data source</th>
<th>% covered</th>
<th>Recommended intents</th>
<th>Unmapped clusters</th>
<th>Total records</th>
<th>Run date</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>SF Incident 12/16/2020 Report</td>
<td>incident</td>
<td>40%</td>
<td>121</td>
<td>208</td>
<td>22,731</td>
<td>2020-12-20</td>
<td>Done</td>
</tr>
<tr>
<td>SF Incident 12/16/2020 Cluster Only</td>
<td>incident</td>
<td>80%</td>
<td>1</td>
<td>26,707</td>
<td>2020-12-20</td>
<td>Done</td>
<td></td>
</tr>
<tr>
<td>SF Incident 12/16/2020 Classification Only</td>
<td>incident</td>
<td>30%</td>
<td>321</td>
<td>27,386</td>
<td>2020-12-20</td>
<td>Done</td>
<td></td>
</tr>
<tr>
<td>SF Incident 11/10/2020</td>
<td>incident</td>
<td>30%</td>
<td>321</td>
<td>27,386</td>
<td>2020-11-20</td>
<td>Done</td>
<td></td>
</tr>
<tr>
<td>SF Incident 11/10/2020 - Last 4 months</td>
<td>incident</td>
<td>40%</td>
<td>131</td>
<td>27,091</td>
<td>2020-12-31</td>
<td>Done</td>
<td></td>
</tr>
</tbody>
</table>

**Result:** The screen refreshes, showing the analysed incident records and the remaining incident records that weren’t classified.

### Importing recommended intents to new or existing custom models

1. On the **Records covered by recommendations** section of the screen, click the caret icon on a recommended intent you want to add to a custom model.
**Result:** The details of the recommended intent appear so you can review them, as shown in the image below.

![Incident 12/16/2020 - SF Test](image)

2. Click **Add to Model**.

3. On the Select a destination model screen that appears, choose a model you want to add the recommended intent to. If you can’t find an appropriate model, create a new one, return to the report, and add the new model.

**Note:** The chosen model’s application scope must be the same as the current scope.
4. Click **Save**.

**Result:** A banner appears on the screen, confirming the intent is added to the target model.

The recommended intent also appears on the Model screen of the target model, as shown in the image below.
Adding clustered utterances to an intent and its model

1. On the Remaining records section of the intent discovery records screen, select and open a cluster of utterance and short description data that you want to add to an intent and its associated model.

As you continue to build out new intents from these clusters, you can click the Ignore icon to remove any unwanted intents from the report.

There’s also a Show Additional filter you can use to show or hide the added intents, and the ignored intents as well.

2. Click Add to intent.

3. In the Add this cluster to an intent and model screen, select an intent and model pair you want to associate to this cluster.
4. Enter a few utterance examples into the open text field. Click **Add** each time you complete your entry to save it in the system. Use the pencil icon or the trash can icon respectively to edit or delete your entry.

5. Click **Save**.

**Result:** The records screen appears, showing a banner confirming you added two new utterances to the target intent and its associated model. The model and intent pair appears in the **Added To** column, as shown in the image below.
Use the **Show Additional** filter if you want to show or hide the clusters that have added intents, and the clusters that are ignored.

**Running another analysis on your intent discovery report**

1. Click **Run Again**.
Result: The new run begins. When it's in progress, the option to cancel the run appears, as shown in the image below.

When the run completes, a new banner appears that states you have a new version of the report.

2. Select the new version; then click Run Again.
Result: The time stamp you selected for the most recent run appears in the Run date column of the Intent discovery screen.

Install Intent Discovery

You can install the Intent Discovery application (sn_nlu_discovery) if you have the admin role.

Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- Intent Discovery requires the following plugins. Ensure that these plugins are activated before you install Intent Discovery.

  **Required ServiceNow plugins**

  **Predictive Intelligence (com.glide.platform_ml)**

  Enables various Predictive Intelligence and Machine Learning capabilities for training models. See Activate Predictive Intelligence.
NLU Model Builder - Core (com.glide.nlu)

Adds NLU Model capabilities. See Activate the NLU Workbench.

Role required: admin

About this task
Tables are installed with Intent Discovery:
For more information, see Components installed with Intent Discovery.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Intent Discovery application (sn_nlu_discovery) using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Intent Discovery.
4. Click Install.

Components installed with Intent Discovery
Several types of components are installed with activation of the sn_nlu_discovery plugin, including tables.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery Report</td>
<td>Reference table for discovery clusters and intents.</td>
</tr>
<tr>
<td>[sn_nlu_discovery_report]</td>
<td></td>
</tr>
<tr>
<td>Discovery Message</td>
<td>Contains flexible references to the source record and field that was used for analysis.</td>
</tr>
<tr>
<td>[sn_nlu_discovery_processed_message]</td>
<td></td>
</tr>
<tr>
<td>Discovery Report Trace</td>
<td>Contains the information on the utterances added to intents.</td>
</tr>
<tr>
<td>[sn_nlu_discovery_report_trace]</td>
<td></td>
</tr>
<tr>
<td>Discovery Intent</td>
<td>Contains the intents for a report.</td>
</tr>
<tr>
<td>[sn_nlu_discovery_intent]</td>
<td></td>
</tr>
<tr>
<td>Discovery Cluster</td>
<td>Contains the clusters for a report.</td>
</tr>
<tr>
<td>[sn_nlu_discovery_cluster]</td>
<td></td>
</tr>
<tr>
<td>Discovery Report Definition</td>
<td>Includes the necessary information for generating reports.</td>
</tr>
<tr>
<td>[sn_nlu_discovery_report_definition]</td>
<td></td>
</tr>
</tbody>
</table>

Natural Language Query

Natural Language Query (NLQ) enables you to query the data in your instance by entering plain language requests into the user interface.

ServiceNow® NLQ translates natural language user input into glide record queries. The queries are rendered into an executable structured format, such
as a Java Script Object Notation (JSON) file or a visual definition. The output, in whichever format, is the response to the user’s request.

**Note:** In natural language understanding (NLU) terms, this user input is the equivalent of an utterance. In ServiceNow® NLU, administrators enter human language examples (utterances) into NLU training models to enable the system to learn and respond to human-expressed intent. In NLQ, users enter record-related questions directly into the user interface (UI) which translates them into formal queries that answer those questions. So with NLQ you can query your record database in the UI without having to send a formal query.

NLQ is a Now Platform feature that is active by default.
NLQ is available in the English, Spanish, French, German, and Japanese languages, and supports the following data operations:

- Driving table suggestion
- Filtering
- Grouping and aggregations
- Sorting
- Data visualization (single score, list, bar chart, pie chart, time series)
- Business calendar
- Single number

NLQ doesn’t support domain separation. It also doesn’t support on-premise instances.

**NLQ consumption**
Other ServiceNow® applications and features can consume NLQ functionality. NLQ’s plain-language capabilities work in the following applications and features:

- Analytics Q&A: Make natural language queries related to indicators, tables, or columns in the Analytics Center.
- Reporting: Create reports using plain-language questions or requests.
- Workspace: Use NLQ in different Workspace apps such as ITSM Agent Workspace, HR Agent Workspace, and CSM Agent Workspace.
- List V2: Filter through any platform list by entering in a plain-language request.

**Related reference**

**Reporting**
Using Natural Language Query

Enter plain language in the Now Platform user interface to quickly find answers from your data.

NLQ overview

NLQ turns your plain-language questions or requests into queries of your data. With NLQ, you can avoid having to use the condition builder or search through your lists and tables.

The following image shows an example of NLQ in list view. NLQ and the NLQ interface may look and behave differently when being consumed by other applications and features.

Selecting the natural-language filter icon brings up the NLQ interface. You can enter in plain-language questions or requests into any list on the platform.

ℹ️ Note: Your NLQ query only shows results from the table you query on.

NLQ includes a predefined set of synonyms for your instance. Use the following keywords for your NLQ questions and requests:

- Sorting or grouping: grouped by; sorted by; A-Z; z-a
- Dates: today; yesterday; last; this; nextday(s); week(s); quarter(s); year(s)
- Filtering: starts with; ends with; more than; less than; empty; not empty; and; or
- Ownership: my; my team; created by; unassigned

<table>
<thead>
<tr>
<th>Query</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorting or grouping</td>
<td>incidents grouped by category</td>
</tr>
<tr>
<td>Dates</td>
<td>created last month</td>
</tr>
</tbody>
</table>
Additionally, you can create your own keywords, synonyms, and shortcuts to help NLQ better understand inputs. For more information, see Manage synonyms for NLQ.

Each query created appears as a record in the NLQ Logs table. To view your logs, see View NLQ logs. Review your logs to see the effectiveness of your queries and see if you need to make new keywords or synonyms.

Manage synonyms for NLQ

Create custom synonyms for keywords and semantic shortcuts with conditional definitions to increase positive query results for Natural Language Query (NLQ).

Before you begin

• Role required: nlq_admin or admin or pa_analyst

About this task

Enrich the system’s NLQ capabilities by adding your own synonyms that match well to your business or industry-specific queries.

Note: The Natural Language Query plugin provides a predefined set of synonyms for your instance. Multiple comma-separated words and phrases are allowed in both synonyms and semantic shortcuts.

In this example procedure, you create the following.

• The term open to use as a custom synonym for the term active, which is applied by default to active change request records in your instance.

• The term amount of ram to use as a custom synonym for the term RAM which is applied by default in certain computer records in your instance.

• The term unapproved as a semantic shortcut for rejected incidents that require specific conditions for approval.

• Many terms such as my groups and my team as semantic shortcuts for conditional incidents assigned to a user’s assignment groups.
Procedure

1. Create two custom synonyms for column names in the NLQ Synonyms table.
   
a. Navigate to **NLQ > Synonyms**.
   
b. Click **New**.
   
![](image1.png)

You can click any label in the **Column name** of the table to view its column name value.

c. Enter these values in the following fields.
   
   • **Table**: Select **Change Request**.
   
   • **Column name**: Select **Active**
   
   • **Synonyms**: Enter **open**.
   
   The system already has default synonyms, so your synonyms must be unique.

![](image2.png)

d. Click **Submit**.

e. Click **New**.

f. Enter these values in the following fields to create a second synonym.
• Table: Select **Computer**.
• Column name: Select **RAM (MB)**.
• Synonyms: Enter **amount of ram**.

![Image of NLQ Synonyms Table]

**g. Click **Submit**.**

**Result:** Your two synonyms appear on the NLQ Synonyms table. The system uses these synonyms to provide a greater range of returns on NLQ query results. For example, when a user query contains the word **open**, it recognizes the word as a synonym of the word **active**.

2. Create two records in the Semantic Shortcuts table.

   **a. Navigate to** **NLQ > Semantic Shortcuts**.

   **b. Click **New**.**
You can click any label in the **Conditions** column of the table to view the conditions that are set to a semantic shortcut record.

c. Enter these values in the following fields.
   
   • **Table:** Select **Incident**.
   
   • **Column name:** Select **[Approval] [is] [Rejected]**.
   
   • **Synonyms:** Enter **unapproved**.
   
   One or more conditions you set in this form can add greater specificity to its synonyms.

d. Click **Submit**.

e. Click **New**.

f. Enter these values in the following fields to create a second semantic shortcut.
Table: Select **Incident**.

Column name: Select **[Assignment group] [is(dynamic)] [One of My Groups]**.

Synonyms: Enter my groups, assigned to my team, assigned to myteams, assigned to my group, assigned to my groups, myteam, myteams, my group, my group's, myteam's.

g. Click **Submit**.

**Result:** Your two semantic shortcuts appear on the NLQ Semantic Shortcuts table.

The second semantic shortcut beginning with my groups... uses a wide variety of synonyms rather than just one, which is beneficial for terms that have many dynamic conditions.
View NLQ logs

View NLQ logs to see how the system has handled your previous plain-language requests.

Before you begin

Role required: nlq_admin or admin or pa_analyst

About this task

The NLQ query logs tables provides information about previous plain-language requests performed by you or your users. Each query log tracks information such as the type of table the request was made on, if the query succeeded, and how the results were generated.

Procedure

Navigate to NLQ > Logs.

If a record's Successful field is marked as true, your query was successful. If marked false, you can attempt to resolve the query by changing your input or defining additional synonyms.

NLQ properties

The Natural Language Query (NLQ) properties control certain aspects of the queries that you perform and NLQ consumption.
Navigate to **System Properties > All Properties**. Filter for the NLQ properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.listv2.nlq.lists.append_query | • True: NLQ inputs add onto existing queries via an "and" operator  
• False: New NLQ input replaces any existing queries  
Example: You run two queries.  
• Query 1: Incidents with critical priority  
• Query 2: assigned to John Smith  
If the property is set to true, the results show incidents with critical priority that are assigned to John Smith. If the property is set to false, the results only show items assigned to John Smith. |
| com.snc.listv2.nlq.lists.enabled | • True: Enables NLQ search option for List v2  
• False: Disables NLQ search option for List v2 |
| com.snc.par.nlq.report_designer.enabled | • True: Enables NLQ in Report Designer  
• False: Disables NLQ in Report Designer |
Predictive Intelligence

ServiceNow® Predictive Intelligence is a platform function that provides a layer of artificial intelligence that empowers features and capabilities across ServiceNow® applications to provide better work experiences.

Note: Predictive Intelligence is also available for on-premise customers. If you're interested in deploying this product on-premise, contact your account manager. For on-premise installation and configuration instructions, see Knowledge Base article KB0782052.

Predictive Intelligence provides four frameworks that you can use to create machine-learning solutions in your instance. Each framework delivers a different solution type for training the system to predict, recommend, and organize data outcomes. A trained solution can be invoked by any application through a prediction API to make a prediction. The frameworks support these languages: English, French, German, Japanese, Dutch, Spanish, Italian, and Brazilian Portuguese.

Note: Artificial intelligence communities use the term train for machines in the same way we use it for humans and animals. For example, you can train horses to jump higher, and you can train systems to learn new ways to process data and solutions.

Predictive Intelligence classification framework

The Predictive Intelligence classification framework enables you to use machine-learning algorithms to set field values during record creation, such as setting...
the incident category based on the short description. You can train predictive models so they act as an agent to automatically categorize and route work based on your past record-handling experience.

Enable Predictive Intelligence to handle later volumes of incoming requests at lower costs. Automate the categorization and assignment of requests to reduce:

- Task resolution times.
- The number of interactions required to resolve tasks.
- The error rates of categorizing and assigning work.

For information on how to use the classification framework, see Create and train a classification solution.

**Predictive Intelligence similarity framework**

The Predictive Intelligence similarity framework identifies existing records that have similar values to a new record. You use the framework to build a word corpus. The word corpus functions as the vocabulary the system uses to compare your trained records based on their textual similarity. For example, you can train a subset of your incident records to recommend a resolution based on the information of a similar incident record. By reusing similar closed incidents that have a proven resolution, you can help agents and fulfillers quickly provide the best resolution for an incoming incident.

The similarity framework doesn’t require an exact match of words for its text comparisons, as its algorithms identify similar words and synonyms based on similar contexts. For example, the phrases *printer not working* and *printer broken* are both captured in your word corpus. The framework also collects, learns, and applies your industry-specific context. For example, the phrase *unable to join network* has a different context in a networking company than it does in a healthcare insurance company.
To keep your word corpus current, retrain and refresh your solution periodically. To see how the Similarity Template helps you to configure your solution using similarity fields and filters, see Create and train a similarity solution.

**Predictive Intelligence clustering framework**

Group similar records into clusters so you can address them collectively or identify patterns. For example, you can group similar incidents that have occurred recently to identify a major incident. To see how the Clustering Template helps you to configure your solution to identify and train data for your cluster, see Create and train a clustering solution.

**Predictive Intelligence regression framework**

Regression is a machine-learning framework that you can train with historic data to predict numeric outputs, such as a temperature or a stock price. For example, you can use regression to estimate the time it takes to resolve an incident or a case. See Create and train a regression solution.

**Training your machine-learning solutions**

Predictive Intelligence enables you to train predictive models and machine-learning solutions that you can apply to your business processes, such as:

- **Incident categorization**: Predicts the incident category based on the short description. See Predictive Intelligence for Incident Management.

- **CSM case assignment**: Predicts the case record assignment group based on the short description. See Predictive Intelligence for case management.

You can also extend Predictive Intelligence to other processes by creating your own predictive models and training them on your past record data.

**Predictive model components**

A predictive model consists of these components, some of which you must provide.

- **Solution definition**

  A data record you create and configure that specifies these values for training a predictive model.

  - The records used to train the model. For example, only train on incidents that are resolved or closed within the last six months.
  - The input fields the model uses to make predictions. For example, use the incident short description to make a prediction.
• The output field whose value the model predicts. For example, set the incident category based on the short description.
• The frequency to retrain the model. For example, retrain the model every 30 days.

Solution

The solution is the result of a solution definition that you’ve trained in a ServiceNow datacenter. Predictive Intelligence uses the solution to predict a target field value given one or more input field values. All solutions specify these values.

• The solution precision is the aggregate percentage of correct predictions. For example, a precision of 50 means that out of 100 predictions, half of them should have the correct value.
• The solution coverage is the aggregate percentage of records that receive a prediction. For example, a coverage of 50 means half of all eligible records actually receive a prediction.
• The solution classes are the output field values for which the model can make predictions. Each class is an output field value with a list of possible precision, coverage, and distribution metrics to choose from. For example, the Incident Categorization solution has a class for each category such as software, inquiry, and database.
• The class distribution is the percentage of records from the entire table that have this particular output field value. For example, a distribution of 50 for the inquiry class means that half of incidents have the inquiry category.

Business rule

A rule that calls the solution data set to generate a prediction when a new record is created.

Selecting data records for training your solution

A solution is only as good as the record data you use to train it. In general, a good training dataset has these characteristics.

• The solution definition input fields are available to users when creating records. To make predictions at record creation, the solution must have the input field values at record creation.
• The solution definition output field is a choice field. To make more accurate predictions, limit the output field to a finite set of possible values.
- The training records only contain correct values for the output field. To make more accurate predictions, filter out any records that have unreliable output field values. For example, if recently closed incidents are subject to review and change for a month, filter out any recently closed incidents.

- The training records contain multiple examples of each output field value that you want the solution to predict. To provide more record coverage, include multiple examples of each output field value.

- The training records include common variations of the input fields. To provide more record coverage, include multiple examples of input field values.

### Exporting your solution for training

To train a solution, you export its solution definition and associated records to a centralized training server within the same datacenter. When the training completes, the training server exports the solution back to your instance and deletes all of your training data from the server. As every datacenter has its own dedicated training server and the data doesn’t leave the datacenter, this service is also available to customers who have data sovereignty requirements.

Predictions occur on a centralized prediction server within the same datacenter as the instance. The trained model artifacts are sent from the instance server to the prediction server when the prediction is invoked for the first time. After that, the trained model artifacts are cached on the prediction server for subsequent predictions.

**Note:** All communication between the instance and the training service occurs within the same datacenter firewall. Even so, all communications occur over HTTPS.
**Prediction business rules**
By default, the system uses these business rules for Predictive Intelligence.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default Task Based Prediction</strong></td>
<td>A business rule that runs before inserting new task records to make a field value prediction based on the solution definition output field and the solution dataset. Use this business rule as a template to create your own prediction logic. This business rule calls the Predictive Intelligence API.</td>
</tr>
<tr>
<td><strong>Update Prediction Results</strong></td>
<td>A business rule that runs before closing task records to update the solution statistics with the actual precision and coverage results.</td>
</tr>
</tbody>
</table>

**Monitoring your predictive model coverage and precision**
You can track the coverage and precision of each predictive model using the Solution Statistics dashboard, which provides reporting on these prediction areas by default.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Average Prediction Coverage (last 30 days)</strong></td>
<td>The value represents the percentage of predictions that yielded an outcome out of the total number of predictions attempted. Click the coverage score to see a breakdown by class.</td>
</tr>
<tr>
<td><strong>Daily Prediction Coverage</strong></td>
<td>The value represents the percentage of records created on a given day in which the solution was able to predict an outcome.</td>
</tr>
<tr>
<td><strong>Average Prediction Precision (last 30 days)</strong></td>
<td>The value represents the percentage of predictions in which the predicted value was the same as the final value of the field when the record closed. Click the precision score to see a breakdown by class.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Daily Prediction Precision</td>
<td>The value represents the percentage of records closed on a given day in which the predicted field value was the same as the final value.</td>
</tr>
</tbody>
</table>

For instructions on how to use the dashboard, see Review classification solution statistics.

Get started with Predictive Intelligence

Implement initial setup and configuration steps for Predictive Intelligence to train a machine-learning (ML) algorithm to make predictions based on your past record data.

Before you begin
Role required: admin or ml_admin

About this task
The training process requires sending record data to a training service in the nearest datacenter. Since every datacenter has its own dedicated training server and the data doesn't leave the datacenter, this service is also available to customers who have data sovereignty requirements. For more information on this process, see Predictive Intelligence

Procedure

1. Activate Predictive Intelligence on a non-production instance.
2. From your production instance, export the records that you want your Predictive Intelligence solutions to process. For example, export 12 months of incident records to a non-production instance.
3. On a non-production instance, import the records you exported.
4. On the non-production instance, review the default solution definition records to determine if the filter, input fields, and output field are sufficient to predict your incident or task records. If necessary, create a solution definition for each record set you want to predict.
5. On the non-production instance, train the solution definition records you want to test.
6. For classification solutions, on the non-production instance, enable the Default Task Based Prediction business rule. If you have created custom solution
definition records, update the business rule with the solution definitions you want to enable.

7. Test the solution predictions by either creating test records or importing more records from production.

8. For classification solutions, review the prediction reports to determine the accuracy and coverage of your solution and individual classes.

9. For similarity solutions, review the similarity examples to update the similarity score threshold if needed.

10. If necessary, update the solution definition filter to include more or different training records.

11. Retrain and retest any updated solution definition records.

12. When you are satisfied with your solutions, activate Predictive Intelligence on your production instance.

13. Recreate any custom solution definition records and train the solution, or import the solution from your non-production instance to your production instance.

Related information

Create and train a classification solution
Create and train a similarity solution

Predictive Intelligence properties

The Predictive Intelligence properties control certain aspects of its machine-learning solution frameworks and solution training process, as well as other areas of the application.

Navigate to Predictive Intelligence > Configuration to review or edit these properties.

Note: Some properties require certain roles to review or edit.

<table>
<thead>
<tr>
<th>Machine Learning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
</tr>
<tr>
<td>Override ml_solution_definition record’s readonly state during training?</td>
</tr>
<tr>
<td>Property</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>Minimum number of records for Regression</td>
</tr>
<tr>
<td>Maximum number of records for Regression</td>
</tr>
<tr>
<td>The time (in ms) an in-training solution will wait without updates before timing out</td>
</tr>
<tr>
<td>Maximum model size</td>
</tr>
<tr>
<td>Maximum number of records used in training</td>
</tr>
</tbody>
</table>
### Machine Learning (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Minimum number of records used in training    | glide.platform_ml.api.csv_min_line                                          | Sets the minimum number of records required for Classification solution training.  
- **Type:** Integer  
- **Default value:** 300000                                                                                     |
| Maximum number of days worth of records on request can retrieve | glide.platform_ml.api.csv_split_days                                       | Sets the maximum number of days a single request can retrieve from your records.  
- **Type:** Integer  
- **Default value:** 10000                                                                                     |
| Maximum number of records per table for word corpus | glide.platform_ml.api.max_wordcorpus_records                               | Sets the maximum number of records per table for Word Corpus creation for Similarity and Clustering solutions.  
- **Type:** Integer  
- **Default value:** 300000                                                                                     |
| Maximum number of records for similarity window (to lookup results) | glide.platform_ml.api.max_similarity_window_records | Sets the maximum number of records the Similarity Window can retrieve to lookup results.  
- **Type:** Integer  
- **Default value:** 100000                                                                                     |
Machine Learning (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of records for Clustering | glide.platform_ml.api.max_clustering_records | Sets the maximum number of records you can include in a cluster.  
  - **Type:** Integer  
  - **Default value:** 100000 |

Shared Service Scheduler

<table>
<thead>
<tr>
<th>Property</th>
<th>Property Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared service scheduler url</td>
<td>glide.shared_service_scheduler.url</td>
</tr>
</tbody>
</table>

Machine Learning Artifacts

<table>
<thead>
<tr>
<th>Property</th>
<th>Property Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of artifacts cached (in MB)</td>
<td>glide.cache.size.ml_object_cache</td>
</tr>
<tr>
<td>Artifact cache compression scheme</td>
<td>glide.platform_ml.artifact.cache_compression_scheme</td>
</tr>
</tbody>
</table>

Activate Predictive Intelligence

Predictive Intelligence is available with activation of the Predictive Intelligence (com.glide.platform_ml) plugin and the Predictive Intelligence Reporting (com.glide.platform_ml_pa) plugin, which are both installed on your instance by default and available at no cost. However, to use its classification, similarity, clustering, and regression capabilities, contact your ServiceNow account executive for more information.

Before you begin

Role required: admin

About this task

When you activate the Predictive Intelligence plugin for the first time on your instance, the system launches a Homepage that includes a summary of frameworks for classification, similarity, clustering, and regression solutions. You
can create, train, and test solutions directly from the page so you can quickly understand the basic functionality of how a machine learning (ML) solution works. A summary of the latest trained solution is also available.

**Procedure**

1. Activate the Predictive Intelligence (com.glide.platform_ml) plugin and its dependent Predictive Intelligence Reporting (com.glide.platform_ml_pa) plugin. When you activate the first plugin, its dependent plugin is activated automatically.

2. Confirm that the activation has successfully created a sharedservice.worker user. The two Predictive Intelligence plugins utilize this user for training your ML solutions.

<i>Note:</i> The sharedservice.worker user includes the following roles:

- platform_ml_read
- platform_ml_write
- platform_ml_create

These roles are required to create, train, and view solutions. These roles are internal and not meant to be edited or assigned to other users.

**Predictive Intelligence language support**

Predictive Intelligence provides international language support for your instance. The default language is English.

Predictive Intelligence language support enables you to assign a language to your ML solution. For example, when you create the solution, you choose the language you want the system to use to process your training records.

For an example of how to assign a language to an ML solution, see the Processing Language section in the Create and train a classification solution documentation. You can also create custom stopwords lists for a language. To see how you do this, refer to the Create a custom stopwords list documentation.

**Language support coverage**

The current available languages for Predictive Intelligence ML solutions and stopwords lists are as follows: English, French, German, Spanish, Japanese, Dutch, Italian, Brazilian Portuguese, Danish, Swedish, Finnish, Norwegian, Polish, Chinese, and Korean. The languages are listed in the order of their implementation across the Kingston and Quebec releases.
Create a custom stopwords list

Exclude common words you want the system to ignore during training and prediction.

Before you begin
Role required: admin or ml_admin

About this task
Stopwords lists enable the system to exclude extraneous words that can impede search and the overall natural language processing of your data.

Predictive Intelligence provides you with default stopwords lists for each language the system supports. Examples of stopwords include words such as in, the, and the names of people and companies. You can also define your own stopwords list that’s comprised of words specific to your organization and industry.

The custom list you provide works alongside those that the system already uses by default. For example, if incident records are used in a classification solution, and a company name is used in those records, consider adding that name to your list, as it’s unlikely to provide any relevant information for the solution you’re building.

In this example scenario, you create a custom stopwords list for the Brazilian Portuguese language.

Procedure
1. Navigate to Predictive Intelligence > Stopwords.
2. On the Stopwords list, click New.
3. In the Stopwords form, configure these fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the list, such as the name of your company and the processing language. For example, Blitzo Brazilian Portuguese Stopwords.</td>
</tr>
<tr>
<td>Stopwords Language</td>
<td>Select <strong>Brazilian Portuguese</strong></td>
</tr>
<tr>
<td>Stopwords List</td>
<td>Manually enter the stopwords using a comma-separated format. For more examples of stopwords, see the image in Step 2 of this procedure.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.  
Your custom stopwords list appears in the Stopwords list view.
5. Optional: If you need to update your stopwords list, just click its Name, add or remove words from the list, and click Update.

What to do next
Assign a custom or default stopwords list to a classification, similarity, clustering, or regression solution definition.

Predictive Intelligence for Event Management
Build Event Management-specific machine-learning solutions.

Solution definition
This solution definition is available as a template on instances where both Predictive Intelligence and Event Management are active. Create your own solution definition records to customize the behavior.

Solution Definition for Event Management

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed alert similarity</td>
<td>Recommends similar Alert records based on these fields: description, node, resource, ci type, source, and metric name from the Alert [em_alert] table. Results are visible to users on the Alert form and on the Similar Alerts tab in Workspace.</td>
</tr>
</tbody>
</table>

Create and train a classification solution
Specify the records used to train a classification solution, what fields trigger a prediction, and how often you want to retrain your solution.
Before you begin

• Create a custom stopwords list.
• Role required: admin or ml_admin

About this task

Predictive Intelligence supports training solutions where the source data is protected by these types of encryption.

• FDE (Full Disc Encryption).
• Column Level Encryption Enterprise. When using Column Level Encryption Enterprise, ensure that the sharedservice.worker user has the same encryption context role that has been used for encryption.

Note: Predictive Intelligence doesn’t support training solutions where the source data is encrypted by Edge Encryption.

A predictive model is only as good as the data you use to train it. To select appropriate training records, familiarize yourself with the table database dictionary as well as the current quality of the record values that you want to use.

You must create a separate solution definition record for each predictive model you want to support. To expedite this process, you can copy a solution definition record and its configuration into a new form by clicking Copy Solution Definition from the context menu of the original record. You can use the new record to make further solution updates without reconfiguring the entire solution definition to change something minor.
Note: Classes that have less than 30 records in your training dataset are excluded from solution training. When your solution is trained and complete, any excluded classes are listed in the Solution Statistics section of your ML Solution form.

Procedure

1. Navigate to Predictive Intelligence > Classification > Solution Definitions.
2. On the Classification Definitions list, click New.
3. On the blank Classification Definition form, configure these fields per the following guidance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique name for the solution record.</td>
</tr>
<tr>
<td>Name</td>
<td>The system generates the value of this read-only field based on the Label value you entered.</td>
</tr>
<tr>
<td>Word Corpus</td>
<td>Select an existing word corpus that’s relevant to your solution. For example, in this use case you select a word corpus that has a title such as Incidents in the last 3 months.</td>
</tr>
</tbody>
</table>

Note: The number of records per table for word corpus creation used in classification solutions is limited to 300,000.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the table containing the target records that you want the system to predict.</td>
</tr>
<tr>
<td>Output Field</td>
<td>Select the field whose value you want the predictive model to set. In general, a good output field has these characteristics.</td>
</tr>
<tr>
<td></td>
<td>• It’s a choice field or a string field with a finite set of possible values.</td>
</tr>
<tr>
<td></td>
<td>• It has some causal connection to the input fields.</td>
</tr>
<tr>
<td></td>
<td>For example, the default <strong>Incident Categorization</strong> solution definition uses the <strong>Category</strong> field as its output field.</td>
</tr>
<tr>
<td>Fields</td>
<td>Select the input fields you want the solution to use to generate a prediction. Input fields are fields within a record that may contain...</td>
</tr>
<tr>
<td></td>
<td>• The fields are available to users when creating records.</td>
</tr>
<tr>
<td></td>
<td>• The field data type can be string, reference, choice, or HTML. The more information a field provides, the more often a solution can make...</td>
</tr>
<tr>
<td></td>
<td>• The field has a default value. The field shouldn’t have a blank value.</td>
</tr>
<tr>
<td></td>
<td>For example, the <strong>Incident Categorization</strong> solution definition uses a filter with these conditions: [Created][on][Last 12 months] AND...</td>
</tr>
<tr>
<td>Filter</td>
<td>Click <strong>Add Filter Condition</strong> to apply conditions to the records you’re training.</td>
</tr>
</tbody>
</table>
To train a solution, the filter must return at least one record. If your filter returns no records, update it until it returns records for training.

Note: The recommended number of records for training a good solution is from 30,000 through 300,000. If you submit more than 300,000 records, the most recent 300,000 records are used to train the solution. Use only authentic records from the database.

A solution is only as good as the data you use to train it. In general, a good filter has these characteristics.

- The training records are inactive and have task states that represent completing work within your standard process, such as resolved or closed.
- The training records only contain correct values for the target field. Filter out records with unreliable target field values. For example, if you're predicting the assignment group/category and you have assignment groups/categories in your historic incident data that are no longer used, add a filter to remove such incident records from the training.
- The training records contain multiple examples of each target field value you want the solution to predict.
- The training records include common variations of the input fields.

Don't use hard-coded dates as filters, as these filters aren't updated when the solutions are retrained unless you update them manually before every retraining. Instead, use relative date filters, such as last 3 months, last 6 months, and last 12 months.

<p>| Processing Language | Select the dominant language of the dataset you're training on the solution definition. If the dataset language is Italian, choose Italian. Also, English processing is applied to all datasets by default. For example, if you select Italian, the system processes the data in both English and Italian. Note: The term processing indicates some of the language-specific steps used as part of training a solution. For example, tokenizing words, removing stop words, and stemming. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stopwords</td>
<td>When you select your processing language, the system automatically adds a Stopwords list that uses the same language. For example, if your processing language is Italian, the <strong>Default Italian Stopwords</strong> list appears. The <strong>Default English Stopwords</strong> list also appears in your selection as well. If you create a custom stopwords list, you can select it from the Stopwords field to add it to your solution.</td>
</tr>
<tr>
<td>Training Frequency</td>
<td>Select how often the system regenerates the solution based on records matching the <strong>Filter</strong>. Your options include:</td>
</tr>
<tr>
<td></td>
<td>• Run Once</td>
</tr>
<tr>
<td></td>
<td>• Every 30 days</td>
</tr>
<tr>
<td></td>
<td>• Every 60 days</td>
</tr>
<tr>
<td></td>
<td>• Every 90 days</td>
</tr>
<tr>
<td></td>
<td>• Every 120 days</td>
</tr>
<tr>
<td></td>
<td>• Every 180 days</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The minimum number of records required for classification solution training is set at 10,000.</td>
</tr>
<tr>
<td></td>
<td>By default, the system runs training once. This practice provides you time to review and update the solution definition as needed until it provides acceptable coverage and precision values.</td>
</tr>
<tr>
<td></td>
<td>When your solution definition is fairly stable, consider scheduled trainings, as data can age over time, thus degrading the accuracy of your prediction model.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The ML scheduler limits the number of trainings an instance can commit to 50 new ML training requests per instance within a 24 hour window. This excludes scheduled re-training requests. In addition, clustering and similarity updates are also excluded from this limit, even if the new training requests exceed 50 within a 24 hour window.</td>
</tr>
</tbody>
</table>

4. Click the appropriate context menu option or button for your solution definition.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save or Save &amp; Train</td>
<td>Save your solution definition record so you can return to it later, or save and submit it for training.</td>
</tr>
<tr>
<td>Submit or Submit &amp; Train</td>
<td>Create your solution definition record and submit it, or submit and train it.</td>
</tr>
</tbody>
</table>

5. If you submitted the solution for training, click **OK** on the **Training Activation** window to confirm.

- The system schedules the solution for training with the nearest training service. The system sends you a notification when the training completes, including any errors that may have occurred in the training. Any other users can subscribe to the Predictive Intelligence Notifications category. When training completes, the system uploads the solution as an Attachment record.

- A bubble chart populates the Solution Visualization tab of your solution form, showing the estimated precision and coverage for each of the classes covered by the solution. The size of the bubble indicates the % of records (distribution) that belong to the class. When you point to a bubble you can see its estimated coverage, estimated precision, and distribution.

![Bubble chart image](image_url)

**What to do next**

In the Class Confidence section of the Solution Statistics tab in your solution, review the trained solution precision and coverage statistics.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
In the Test Solutions tab in your solution, you can test the prediction output for the records you used as input to the prediction by entering values from the input fields, such as the Short Description.

Exclude a class from prediction

Exclude a class from prediction if its precision or coverage statistics don’t meet your threshold of usefulness. For example, exclude it if you don’t want the model to predict a particular output field value.

Before you begin

- Train the solution definition whose output field values you want to exclude.
- Role required: admin or ml_admin

About this task

If your classification solution doesn’t provide sufficient precision or coverage, you can exclude a particular incident category from prediction.

Excluding a class from prediction only lasts until the next time you train your solution. If a class still doesn’t provide sufficient precision or coverage values, you may want to consider deactivating the solution until it provides better results.

Typically, you exclude a class from prediction if you only want a person to manually set the excluded class value. For example, exclude the class if the solution doesn’t offer sufficient precision or coverage, or because the class triggers other business logic that requires review or approval.
Procedure

1. Navigate to **Predictive Intelligence > Classification > Solutions**.
2. In the ML Solutions list, select the solution whose classes you want to exclude. This solution must have a **State** of **Solution Complete**.
3. In the **Class Confidence** related list, select the class you want to exclude.
4. In the Class Confidence record, review the precision and coverage combinations available from the **Precision Coverage Lookups** embedded list.
5. Select the check box for the 100 precision and 0 coverage combination. You can only select one check box.
6. From the Actions on selected rows control, select **Apply Values**. The system shows a **Precision / Coverage Setting** confirmation window.
7. Click **OK** to confirm the change or **Cancel** to discard it.

Results

The solution excludes the class from all predictions until the next training cycle.

What to do next

If you conclude this class will never produce meaningful predictions, consider deactivating the solution or changing the solution definition.

Exclude a class from solution training

Exclude a class from solution training to prevent the model from ever making predictions for a particular output field class. For example, you can exclude a particular incident category from training if you plan to retire or change the category.

Before you begin

Role required: admin or ml_admin

About this task

Excluding a class from training doesn’t prevent the solution from making predictions for records that use the excluded class. Solution training still uses the input and output field values as data and attempts to match input field values to a new output field class. This attempt may cause undesirable prediction results unless you have another suitable class to replace the excluded class value.

Typically, you only exclude a class from training if you change the list of valid output field values. For example, if you replaced one incident category with another incident category, you may exclude the old category from training so that the solution only uses the new category for predictions.
Note: If you specify a target recall for a class, don’t exclude the class from training even if the number of records are less than 30 for that class.

Procedure

1. Navigate to Predictive Intelligence > Classification > Solution Definitions. The system shows the current list of solution definitions.
2. Select the solution definition you want to edit.
   
   Example
   For example, select Incident Categorization to exclude an incident category from training.

3. Edit the filter to exclude the class.
   You can use the [is one of] or [is not one of] operators to exclude a particular class.
   For example, if you want to exclude the Hardware class, add this condition: [Category] [is not one of] [Hardware].

4. Click Update & Train.
   The system schedules the solution for training with the nearest training service. When training is complete, the system uploads the solution as an Attachment record.

Results
The solution excludes the class from all predictions.

What to do next
Review the trained solution precision and coverage statistics.

Tune a trained classification solution
Tune the performance of a trained classification solution by configuring class level precision and coverage values.

Before you begin
• Train the solution definition whose output field values you want to configure.
• Role required: admin or ml_admin

About this task
The system creates a class record for each output field value that it can predict. Each class record includes a list of possible precision and coverage combinations to choose from. By default, solutions use the highest combination of precision and coverage available. You can select another combination to refine predictions based on acceptable precision and coverage values.
Procedure

1. Navigate to Predictive Intelligence > Classification > Solutions.
   The system shows the list of available solutions.

2. Select the solution whose classes you want to configure.
   This solution must have a State of Solution Complete.
   The system shows the Solution record.

3. From the Class Confidence related list, select the class you want to configure.
   The solution only lists output field values for which it can make predictions. If
   the output field value is missing from this list, update the solution definition filter
   to provide more data for this output field value, and retrain the solution.
   The system shows the Class Confidence record.

4. Review the precision and coverage combinations available from the Precision
   Coverage Lookups embedded list.

5. Select the check box for the precision and coverage combination you want
   to use to make predictions for this class.
   You can only select one check box. Some combinations produce special
   prediction results.

   **Special prediction combinations**

<table>
<thead>
<tr>
<th>Prediction result</th>
<th>Precision</th>
<th>Coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Never include class in predictions</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Always include class in predictions</td>
<td>0</td>
<td>100</td>
</tr>
</tbody>
</table>

6. From the Actions on selected rows control, select Apply Values.
   The system shows a Precision / Coverage Setting confirmation window.

7. Click OK to confirm the change or Cancel to discard it.

What to do next
Test predictions for this class to verify that the system produces acceptable results.

**Configuring target metrics for a trained classification solution**
Set values for precision, coverage, and recall statistics for a trained machine learning solution.
Setting classification metric values at the class or solution level

Predictive Intelligence provides three classification metric types: precision, coverage, and recall. You configure these metrics on the Solution Statistics tab of a trained classification solution form. While you can manually set values to these metrics at the class level, doing so can be challenging if you have a large number of classes to cover. In many cases, you may not know the best value to set until your solution is trained. This topic focuses on setting the metric values at just the solution level.

Configuring solution metrics

When you apply a value to one metric, it changes the values of the other two. This behavior enables you to modify your metrics iteratively in real time to see which value combinations render particular results. When you apply a new value to a metric, the system recomputes it by considering its new targets.

Applying a value to a metric asks the system to train its predictions to favor the metric you set based on the highest percentage value, and at a cost to the other metrics. The system tries to meet these values but may not set them exactly as you request due to how the data you’re training is distributed.

When you apply metric values at the solution level, the system automatically sets the appropriate values at the class level.

Here are the basic steps for configuring a target metric for your solution.

1. Navigate to the Solution Statistics tab of a trained ML solution.
2. Review the messages on the green banners of the screen which define each of the metrics so you can better understand the values you want to assign to the solution. The first two message banners address estimated solution-level metrics. The third banner addresses class-level results based on the solution values you applied.
3. In the Target Metric choice list, select the metric you want to configure.
4. In the Target Metric Value field, enter a numeric percentile value between 0-100.
5. Click Apply Values.
6. Result: On the Solutions Statistics tab, you can review the change in values to the Estimated Solution Precision, Estimated Solution Recall, and Estimated Solution Coverage. The system calculates these values based on the Target Metric you select and the Target Metric Value you enter for the solution.

Here's a sample landing page for a recently trained classification solution. As you can see, the precision metric is 44.18, recall is 41.26, and coverage is 77.23.
If you need to adjust these default values for a use case, refer to the sample configurations below. For example, based on the classification solution you’re implementing, you might want to change the target metric value for precision, recall, or coverage. Keep in mind that when you change the target metric value for one metric, such as precision, it impacts the values of the recall and coverage metrics as well.

Precision configuration example

In this example scenario, you’re replacing a manual triage process for routing incident records with an ML classification solution that automatically assigns the records to the correct assignment group. For this scenario, you have a target value in mind and the system must predict correctly at least 80% of the time. So you set the precision metric value to 80 and click Apply Values.

Here are the metric values the system applied to the solution. In this scenario, the precision value of 80.04 slightly exceeded your request for 80%, so you’re likely satisfied with that value.
Coverage configuration example

In another example scenario where you’re replacing a manual triage process for routing incident records, your minimum goal is to predict at least 70% of incoming incidents in the first quarter of the year. So you set the coverage metric value to 70 and click Apply Values.

The metric values the system applied to the solution are shown in the following image. The coverage metric value increased from 35.99 to 55.98. However, the precision metric decreased from 80.18 to 64.97. This could be because you set the coverage metric to a relatively high value of 70, or perhaps because of how the data you’re training is distributed.

Recall configuration example

In another scenario, classifying if an incoming email is a Phish or not can be an important use case in a security-related machine learning solution. In this situation, it’s very important to identify every Phish, and it may be okay to report
a non-Phish as a Phish occasionally. However, no real Phish should be classified as a non-Phish. In such situations, the recall metric must have a high value, which might lead to lower percentages for precision and coverage. So here you can set the recall metric to 95 and click Apply Values.

Here are the metric values the system applied to the solution. The recall metric value increased from 54.87 to 61.03. However, the precision metric decreased from 60.1 to 55.44. This is likely because you set the recall metric to the high value of 95.

Class-level results for the solution metric values you apply to your solution

The following image shows an example of the class-level results the system applied to a solution’s precision, coverage, and recall statistics for 37 classes. You can keep modifying the metric values until you’re fully satisfied with the results.

By Sorting (z to a) on the Estimated Precision column you can see which classes have the highest precision for the solution.
Using Group By for classification

Use APIs to simultaneously submit multiple classification solutions for training based on the Group By field.

You can use the optional Group By capability to train and maintain one classification solution that covers more than one data area, such as geographical location or domain.

To train a solution using Group By, you must add the `groupby` parameter while creating a classification solution definition using APIs. The `groupby` parameter accepts only categorical columns as inputs, where individual models are created on the subset of data belonging to each of the `groupby` values. Only those child solutions that pass the minimum records criteria set for the capability are created. Here, the prediction calls are routed to the corresponding Group By model based on the Group By value present in the prediction input. Batch predictions are not supported.

A Group By scenario for geographical locations

Let’s say your global company uses classification routing for incoming records, with one support center in the US and one in Europe. Here, you want to create a single classification solution that has one model for your United States incidents and another model for your European incidents.

In this scenario, you could use one of these two approaches:

- Create and train two separate ML classification solution definitions, where one is filtered by US incidents only, and one by European incidents only.
- Use the `groupby` parameter to create Groupby for the country location so that all US definitions create a US model and all European definitions create a European model. Then, based on the incident, the system identifies which model it uses to predict the correct classification category.
The second approach has benefits in that the models you use can even be in different domains, such as healthcare or finance. This approach is especially beneficial if you have several country locations or domains to maintain.

**Example usage for training and prediction using Group By via API**

```javascript
var myIncidentData = new sn_ml.DatasetDefinition({
    'tableName' : 'incident',
    'fieldNames' :
        ['category','short_description','assignment_group','description','priority'],
    'encodedQuery' : 'activeANYTHING'
});

var mySolution = new sn_ml.ClassificationSolution({
    'label': 'solution label',
    'dataset' : myIncidentData,
    'groupByFieldName' : 'assignment_group',
    'predictedFieldName': 'category',
    'inputFieldNames': ['short_description','description','priority']
});

//Add solution definition
var solution_gr = sn_ml.ClassificationSolutionStore.add(mySolution)

//Get existing solution
var my_unique_name = sn_ml.ClassificationSolutionStore.get('solution name');

// submit training job
var solutionVersion = my_unique_name.submitTrainingJob();

// Run prediction
var input = new GlideRecord("incident");
input.get("sys_id");

// configure optional parameters
var options = {};
options.apply_threshold = false;
var mlSolution = sn_ml.ClassificationSolutionStore.get('solution name');

//Prediction using glide record
var results = mlSolution.getActiveVersion().predict(input, options);

//Prediction using map
var results = mlSolution.getActiveVersion().predict([{
    'short_description': input.short_description,
    'assignment_group': input.assignment_group
}], options);
```

For more context regarding this example and the general usage of Machine Learning APIs, see the documentation cited in the Related topics section below.
Create a word corpus

Build a collection of words and phrases that functions as the vocabulary the system uses to compare your instance records based on their textual similarity. You can think of the word corpus as a dictionary that you want your machine-learning system to understand.

Before you begin
Role required: admin or ml_admin

About this task
The primary purpose for a word corpus is to infer textual data for training your NLU model. If using a word corpus in a solution, you must specify it for training in the solution definition phase of a solution. A trained word corpus can be reused across solutions and capabilities.

You can use a word corpus to help compare similar record text in a table or across multiple tables. A word corpus can also be helpful in other scenarios, such as clustering, where you group similar records together for data analysis, reuse, or review. The items you add to your corpus should be specific to your company and your industry so you can reuse it in other similarity or clustering solutions and apply it to various use cases.

In this example procedure, you’re working on incident records and you want to locate relevant knowledge base (KB) articles that could provide resolutions to those incident cases. Your goal here is to create a word corpus that you can apply to a new similarity solution that compares active incidents to published KB articles.

Procedure
1. Navigate to Predictive Intelligence > Word Corpus.
2. In the Word Corpus form, click New.
3. Configure these fields per the following guidance.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique title that references the contents of your corpus. For example, in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>this use case you could enter a name such as Active Incidents and Published</td>
<td></td>
</tr>
<tr>
<td></td>
<td>KBs, as the name indicates the tables that your corpus will mine to help</td>
<td></td>
</tr>
<tr>
<td></td>
<td>create your solution.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box if you're creating several word corpuses at once and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>you plan to configure their detail components later. Otherwise, leave it</td>
<td></td>
</tr>
<tr>
<td></td>
<td>blank, as you can select it in a later step.</td>
<td></td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. In the Word Corpus list view, locate your new word corpus and click its **Name** value to open the record.

6. In the Word Corpus Contents section, Click **New**.

7. In the Word Corpus Content form, configure these fields per the following guidance to define a content component for your word corpus.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a title that references the data you want to add to your corpus, such</td>
<td></td>
</tr>
<tr>
<td></td>
<td>as Incidents closed in last 6 months.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Select the table that contains the data you want to include in your word</td>
<td></td>
</tr>
<tr>
<td></td>
<td>corpus. For this use case, select Incident [incident].</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The number of records per table for Word Corpus creation used in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Similarity and Clustering solutions is limited to 300,000.</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Select the following filter condition values: [Closed] [is not empty] and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Created in last 6 Months].</td>
<td></td>
</tr>
<tr>
<td>Field List</td>
<td>For this use case, select Short description, Description, and Resolution</td>
<td></td>
</tr>
<tr>
<td></td>
<td>notes.</td>
<td></td>
</tr>
<tr>
<td>Domain</td>
<td>The system automatically displays the user group for your corpus. For example,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>in this use case it</td>
<td></td>
</tr>
</tbody>
</table>
8. Click **Submit**.

9. In the Word Corpus Details section, click **New**.

10. Configure these fields per the guidance below to define a second content component for your word corpus.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a title that references the data you want to compare to your first content component, such as Published KB Articles.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table that contains the data you want to compare to your first content component. For this use case, select Knowledge [kb_knowledge].</td>
</tr>
<tr>
<td>Filter</td>
<td>Select the following Filter Condition values: [Workflow] [is] [Published].</td>
</tr>
<tr>
<td>Field List</td>
<td>Select <strong>Short description</strong> and <strong>Article body</strong>.</td>
</tr>
</tbody>
</table>

11. Click **Submit**.

Your two word corpus content components appear on the word corpus form.

12. Click **Update**.
Results
The completed word corpus you created appears on the word corpus form and is available for use in your similarity and clustering solution definition forms.

What to do next
Create a similarity solution or a clustering solution.

Related information
Create and train a similarity solution
Create and train a clustering solution

Create and train a similarity solution
Create and train a similarity solution or a clustering solution.

Before you begin
• Create or reuse a word corpus that is relevant to your solution.
• Role required: admin or ml_admin

About this task
Predictive Intelligence supports training solutions in which the source data is protected by these types of encryption.
• FDE (Full Disc Encryption).
• Column Level Encryption Enterprise. When using Column Level Encryption Enterprise, ensure the sharedservice.worker user has the same encryption context role that's been used for encryption.

Note: Predictive Intelligence doesn't support training solutions where the source data is encrypted by Edge Encryption.

Use a word corpus of text and context that functions as the vocabulary the system uses to compare your existing records based on their similarity. The system uses the corpus to recommend similarity solution examples that you can review and reuse in your solution.
In this example procedure, you're working on Incident records and you want to locate relevant Knowledge Base articles that could provide resolutions to those incidents.

**Procedure**

1. Navigate to **Predictive Intelligence > Similarity > Solution Definitions**.
2. In the Similarity Definitions list, click **New**.
3. On the Similarity Definition form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique name for your similarity solution. For example, in this use case you could enter <strong>Match Incidents to Knowledge Articles</strong>.</td>
</tr>
<tr>
<td>Name</td>
<td>As you enter your solution Label value, this field automatically populates with a system-assigned name that's similar to your label value.</td>
</tr>
<tr>
<td>Word Corpus</td>
<td>Select an existing word corpus that's relevant to your solution. For example, in this use case you select the <strong>Active Incidents and Published KBs</strong> word corpus. If you don’t have a relevant word corpus, follow the steps in <a href="#">Create a word corpus</a>. When the word corpus is complete, you can select it from the Word Corpus field in your Similarity Definition form.</td>
</tr>
</tbody>
</table>

**Note:** Alternatively, you can select the pretrained **GloVe** word corpus, which can provide a larger capacity for your word corpus content. The GloVe word corpus is only available for Similarity solutions.

**Note:** The number of records per table for word corpus creation used in similarity solutions is limited to 300,000.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>In the first column of the form, select the table that contains the records that you want to compare to other similar records. In this use case, you select the <strong>Incident [incident]</strong> table, as it contains the Incident records that you’re trying to resolve. When you assign a table value, a link appears in the form that shows the number of records that match your current conditions.</td>
</tr>
<tr>
<td>Test Table</td>
<td>In the second column of the form, select the table that contains the records that you want to compare to your first column records. In this use case you select the <strong>Knowledge [kb_knowledge]</strong> table, as it contains KB Article records that might provide information related to the Incident records that you're trying to resolve. Note: The number of records the Similarity Window can retrieve for lookup results is limited to 100,000.</td>
</tr>
<tr>
<td>Fields</td>
<td>In the first column of the form, select field types that are likely to contain words and phrases that you want to compare to other similar records. In this example, you select <strong>Short description</strong>, as it’s the field type that contains the text of the Incident records you’re trying to resolve. Note: <strong>Journal Type</strong> is not a supported data type.</td>
</tr>
<tr>
<td>Test Fields</td>
<td>In the second column of the form, select fields that are likely to contain text that is similar or relevant to your first column records. In this example, you select <strong>Short description</strong> and <strong>Article body</strong>. When you include Article body, you increase your chances of capturing relevant KB Article details regarding the subject.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Click <strong>Add Filter Condition</strong> to apply conditions to the Field records you're using as a base to retrieve your similarity results. For example, in this use case you set an <strong>[Active] [is] [true]</strong> condition, as the Incident records you're working on are active.</td>
</tr>
<tr>
<td>Processing Language</td>
<td>Select the dominant language of the dataset you're training on the solution definition. If the dataset language is Italian, choose <strong>Italian</strong>. Also, English processing is applied to all datasets by default. For example, if you select Italian, the system processes the data in both English and Italian.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The term <em>processing</em> indicates some of the language-specific steps used as part of training a solution. For example, tokenizing words, removing stop words, and stemming.</td>
</tr>
<tr>
<td>Stopwords</td>
<td>When you select your processing language, the system automatically adds a Stopwords list that uses the same language. For example, if your processing language is Italian, the <strong>Default Italian Stopwords</strong> list appears. The <strong>Default English Stopwords</strong> list also appears in your selection as well. If you create a custom stopwords list, you can select it from the Stopwords field to add it to your solution.</td>
</tr>
<tr>
<td>Training Frequency</td>
<td>Select a retraining option from once daily or every 30 days in 3 month increments up to 180 days.</td>
</tr>
<tr>
<td>Update Frequency</td>
<td>Select how often you want to refresh the data you use to retrieve your similarity results. For example, if you have incident records that are open, you may want to select an update frequency of <strong>Every 15 minutes</strong>, as new incidents typically occur frequently throughout the day. This frequency may...</td>
</tr>
</tbody>
</table>
increase the likelihood that newly opened records are included in the refresh. However, if your solution uses KB Knowledge article records, which are typically not created often, you may want to choose a less frequent update frequency such as Every 1 day.

Note: The ML scheduler limits the number of trainings an instance can commit to 50 new ML training requests per instance within a 24 hour window. This excludes scheduled re-training requests. In addition, clustering and similarity updates are also excluded from this limit, even if the new training requests exceed 50 within a 24 hour window.

4. Click the appropriate button for the solution definition.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Save your solution definition record so you can return to it later.</td>
</tr>
<tr>
<td>Submit &amp; Train</td>
<td>Create your solution definition record and train it.</td>
</tr>
</tbody>
</table>

5. If you submitted the solution for training, click OK on the Training Activation window to confirm.

Results

- The system schedules the solution definition for processing with the nearest training service and sends you a notification when the training completes. The notification includes any errors that may have occurred during the training. Other users can subscribe to the Predictive Intelligence Notifications category.
- The trained solution updates your Solution Definition form, where it delivers paired solution examples ranked by their degree of similarity.
- When training completes, the system uploads the solution as an Attachment record.
What to do next
Review the trained similarity solution examples on the Related Links section of your Solution Definition form. See Review solution similarity examples.

Update your similarity score threshold
After you review the similarity examples provided by the system, update your solution similarity score threshold if you want the results returned by the solution to be more or less similar.

Before you begin
• Review the Similarity Score Threshold values for your similarity examples.
• Role required: admin or ml_admin

Procedure
1. Navigate to Predictive Intelligence > Similarity > Solutions.
2. In the ML Solutions list, locate your solution and click the Reference Lookup icon (i).
3. Click Open Record.
4. In the Solution Statistics section, enter a new numerical value that represents a percentage in the Similarity Score Threshold field. For example, imagine that the current score is 80. In your similarity example review you decided to increase the accuracy of your similarity recommendations at the cost of lowering the prediction coverage. So you update the field by entering the higher score of 90.
5. In the Context Menu, click Save. Your solution uses the new threshold value that you assigned to it and returns similar results that have a score higher than 90. If you set the score to 90, the degree of similarity in your word corpus is accurate at least 91% of the time.

Create and train a clustering solution
Group similar records into clusters so you can address them collectively or identify patterns.

Before you begin
• Create or reuse a word corpus that's relevant to your solution.
• Role required: admin or ml_admin
About this task
Predictive Intelligence supports training solutions in which the source data is protected by these types of encryption.

- FDE (Full Disc Encryption).
- Column Level Encryption Enterprise. When using Column Level Encryption Enterprise, ensure that the sharedservice.worker user has the same encryption context role that's been used for encryption.

Predictive Intelligence doesn't support training solutions in which the source data is encrypted by Edge Encryption.

In this example procedure, you're grouping similar incidents that have occurred recently to identify a major incident.

Procedure
1. Navigate to Predictive Intelligence > Clustering > Solution Definitions.
2. On the Clustering Definitions list, click New.
3. On the Clustering Definition form, configure these fields per the following guidance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique name for your clustering solution. For example, in this use case you could enter Group Incidents to a Major Incident.</td>
</tr>
<tr>
<td>Name</td>
<td>As you enter your solution Label value, this field automatically populates with a system-assigned name that's similar to your label value.</td>
</tr>
</tbody>
</table>
| Word Corpus       | Select an existing word corpus that's relevant to your solution. For example, in this use case you select a word corpus that has a title such as All Incidents.  
If you don’t have a relevant word corpus, follow the steps in Create a word corpus. When the word corpus is complete, you can select it from the Word Corpus field in your Clustering Definition form. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>Using a word corpus is an option for clustering solutions. However, if you train your solution using the Levenshtein Distance method, you don’t need to use a word corpus in your clustering solution.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The number of records per table for word corpus creation used in clustering solutions is limited to 300,000.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table that contains record types that you want to group into one or more clusters. For example, in this use case you select the <strong>Incident [incident]</strong> table as it contains incident records you want to group together for a major incident analysis.</td>
</tr>
<tr>
<td></td>
<td>When you assign a table value, a link appears in the form that shows the number of records that match your current conditions.</td>
</tr>
<tr>
<td>Fields</td>
<td>Select one or more input fields types that help the system identify the records you want to include in your cluster. In this use case, we use <strong>Short description</strong>.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>When selecting a reference type field, you must dot-walk to the field’s property name. For example, instead of <code>short_description</code>, enter <code>short_description.name</code>.</td>
</tr>
<tr>
<td>Use Group By</td>
<td>Select this check box only if you want to group input records by a field before creating clusters.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Selecting this check box activates the <strong>Group By</strong> choice list below. If you don’t select the check box, all table records are grouped into clusters.</td>
</tr>
<tr>
<td>Group By</td>
<td>Selecting a value from this list is optional. If you do so, the system groups records into one or more clusters based on your selection.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Purity Fields</td>
<td>Choose fields from your table that can help the system identify the class which is most frequent in the cluster. In this example scenario, select <strong>Category</strong> and <strong>Assignment group.Name</strong>.</td>
</tr>
<tr>
<td>Filter</td>
<td>Add any filter conditions you want to apply to the input field records you're including in your clusters.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The number of records for clustering is limited to 300,000.</td>
</tr>
<tr>
<td>Processing Language</td>
<td>Select the dominant language of the dataset you're training on the solution definition. If the dataset language is Italian, choose <strong>Italian</strong>. Also, English processing is applied to all datasets by default. For example, if you select Italian, the system processes the data in both English and Italian.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The term <em>processing</em> indicates some of the language-specific steps used as part of training a solution. For example, tokenizing words, removing stop words, and stemming.</td>
</tr>
<tr>
<td>Stopwords</td>
<td>When you select your processing language, the system automatically adds a Stopwords list that uses the same language. For example, if your processing language is Italian, the <strong>Default Italian Stopwords</strong> list appears. The <strong>Default English Stopwords</strong> list also appears in your selection as well. If you create a custom stopwords list, you can select it from the Stopwords field to add it to your solution.</td>
</tr>
<tr>
<td>Update Frequency</td>
<td>Select how often you want the system to update your clusters with new and updated records.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The system pulls records based on the Group By filter conditions that you set on your clustering solution, if any.</td>
</tr>
</tbody>
</table>
For example, if you select **Every 15 minutes**, the system identifies which records have arrived within that time frame and tries to assign them to the existing clusters, or creates a new cluster if possible.

So let’s say that twenty new records arrive. If sixteen of the twenty records make it into an existing cluster and four don’t, the system forms a new cluster for the four unassigned records.

You can also choose not to update your clusters at all.

### Training Frequency

Select how often you want the system to discard all previous cluster results and recreate clusters from the beginning. Your options range from daily, every third day, every seven days, or monthly. You can also choose to train your cluster just once.

**Note:** The ML scheduler limits the number of trainings an instance can commit to 50 new ML training requests per instance within a 24 hour window. This excludes scheduled re-training requests. In addition, clustering and similarity updates are also excluded from this limit, even if the new training requests exceed 50 within a 24 hour window.

### Minimum number of records per cluster

Enter the minimum number of records you want to allow in any cluster. The value you enter must be greater than or equal to 2.

4. Click the appropriate context menu option or button for your solution definition.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save or Save &amp; Train</td>
<td>Save your solution definition record so you can return to it later, or save and submit it for training.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Submit or Submit &amp; Train</td>
<td>Create your solution definition record and submit it, or submit and train it.</td>
</tr>
</tbody>
</table>

5. If you submitted the solution for training, click **OK** on the Training Activation window to confirm.

**Results**

The system trains the solution and notifies you in real time when the training completes.

A treemap plot appears on the Cluster Visualization tab of your Clustering Solution Definition form. It shows the clusters the system formed for your solution in descending order from the top left to bottom right corners. The treemap node labels are the Cluster Concept, which is created by the top words from the cluster, and helps you see the most prominent content found in each cluster. Each node is colored from red to green depending on the cluster quality for that node. The Select Group filter appears only when you select the **Use Group By** and **Group By** fields on your Clustering Definition form. When you point to a cluster, you can see its Groupby value, Cluster Count, and Records in Groupby.

![Treemap plot](image)

To open a cluster, you can click on it, or select it from the Show All Groups filter.
Inside the cluster grouping, you can filter the results further by using the two slide bars for cluster size and cluster quality, respectively. You can also navigate backward by clicking the Back button, which only appears when a clustering hierarchy is present. When you point to a cluster at this level, the Purity field percentile values appear along with the Cluster Concept, Quality, and Size values.

When you click a cluster node, its ML cluster details appear in a list view format.
What to do next

- Review the solution output on the Solution Statistics tab of your solution. If you aren’t satisfied with your clustering solution results, reconfigure the values you’ve set to your solution and retrain it until the results are to your satisfaction.
- Review the Cluster Summary tab for a list view of the cluster IDs, quality size, and Groupby values.
• On the Cluster Updates tab, review the summary of changes to clusters for each cluster update interval you configured in the solution definition.

Assign a name to a cluster
Name your clusters to help identify and organize them.

Before you begin
• Create a clustering solution definition or use an existing one.
• Role required: admin or ml_admin

Procedure
1. Navigate to Predictive Intelligence > Clustering > Solutions.
2. Select a solution.
3. Under the Cluster Summary related list, select a cluster ID.
4. Enter a name in the Cluster Name field.
5. Select Update.

Generate a representative sample of a cluster
View the top 25 most representative records of a cluster.
Before you begin
• Create a clustering solution definition or use an existing one.
• Role required: admin or ml_admin

About this task
Generating a sample of a cluster filters the records for that cluster. Generating a sample works on clusters with over 25 records.

Procedure
1. Navigate to Predictive Intelligence > Clustering > Solutions.
2. Select a clustering solution.
3. Under the Cluster Summary related list, select a cluster ID.
4. Select Generate Cluster

Sample.

Results
The ML Cluster Detail list shows the top 25 records in the cluster. The cluster sample also applies to the cluster visualization.

Apply purity on a clustering solution
Apply purity to a clustering solution to see at-a-glance insights of your clusters. Use auto-purity to see insights without specifying definition.

Before you begin
• Create a clustering definition solution or use an existing one.
• Role required: admin or ml_admin

About this task
With purity, you can choose insights to show when viewing your clusters. Applying auto-purity automatically determines which insights to show based on distribution significance. By default, auto-purity selects Assignment group.
Category, and Priority. You can change the default auto-purity selections by editing the ml_autopurity_config table.

Procedure
1. Navigate to Predictive Intelligence > Clustering > Solution Definitions.
2. Select a solution definition or create a new one.
3. Under Step 2, select the Calculate Purity check box.
4. Optional: Select the Purity lock icon and choose the insights.

Note: Leaving the purity fields empty triggers auto-purity.

5. Select Update or Save.
Results
When you view the Cluster Visualization, your insights show when you point to a cluster. The insights show under Purity based.

Analyze a cluster with a data source
Analyze a cluster by any of the dimensions available on the source table.

Before you begin
• Create a clustering solution definition or use an existing one.
• Role required: admin or ml_admin

About this task
Analyze a cluster with a data source by accessing the cluster insight table. You can add a cluster insight table when creating a solution or editing an existing.

STEP 2: Select the input data for clustering, the frequency at which existing clusters are updated, and how frequently the data is reclustering

Table: Incident [incident]
Filter:
- 10000 records match condition
  - Add Filter Condition
  - Add "OR" Clause

Create ClusterInsight table

Procedure
1. Navigate to Predictive Intelligence > Clustering > Solutions.
2. Select a solution.
3. Under **Clustering Visualization**, select a cluster.

4. On the **Cluster Insight** table, select the hamburger icon next to a column header, and select **Bar Chart**.

**Results**

The **Create a Report** page shows your selected insight data in a bar chart. You can use this method on different insights and tables and with different visualizations.

**Create and train a regression solution**

Train your solution by using historical data to predict numeric outputs, such as a temperature or a stock price. For example, you can use regression to estimate the time it takes to resolve an incident or a case.

**Before you begin**

Role required: ml_admin or admin

**About this task**

Regression solutions enable you to predict a point estimate and prediction interval. The resulting model delivers the following statistics:

- **Mean Absolute Error (MAE)**, which measures the mean deviation of a predicted value from the actual value. This metric is useful as it’s easy to understand as its scale is the same as that of its target. However, MAE is unbounded, hence it’s difficult to compare across models.

- **Symmetric Mean Absolute Percentage Error (SMAPE)** is a percentage value of the deviation from the predicted to the actual. SMAPE is a bounded version of MAE except that it has a value range between 0 and 100. The lower the SMAPE value, the better the model accuracy.

- **Range Accuracy** is the percentage of actual values between a predicted range. In other words, it’s the range between the upper and lower bounds of the prediction. For example, if four out of five actuals lie within the predicted range, the range accuracy is 80%.

- **Average Interval Width** is the difference between the upper and lower bounds of the prediction. This metric explains the interval informativeness. The smaller the average width, the better the model performance.

When making predictions, regression also enables you to specify a confidence level for the prediction interval (range).

In this example procedure, you create and train a regression solution definition to predict the amount of time it takes to restore a cloud database.
Procedure

1. Navigate to Predictive Intelligence > Regression > Solution Definitions.
2. On the Regression Definitions list, click New.
3. On the Regression Definition form, configure these fields per the following guidance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique name for your regression solution. For example, in this use case you could enter Regression Test for DB Restore.</td>
</tr>
<tr>
<td>Name</td>
<td>As you enter your solution Label value, this field automatically populates with a system-assigned name that's similar to your label value.</td>
</tr>
</tbody>
</table>
| Word Corpus    | Select an existing word corpus that’s relevant to your solution. For example, in this use case you select a word corpus that has a title such as Word Corpus Regression. 

If you don’t have a relevant word corpus, follow the steps in Create a word corpus. When the word corpus is complete, you can select it from the Word Corpus field in your Regression Definition form.

However, the word corpus selection is optional. If your input data has text columns and you don’t choose a word corpus, your regression solution trains a new word corpus model by using the text columns in your input data. The resulting word corpus can be reused in any other regression solution or other ML solution type.

Note: The number of records per table for word corpus creation used in regression solutions is limited to 300,000.
<p>| Table          | Select the database table on which you’re applying regression. The table should contain...                                                                                                           |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>historiald records the system can use to predict the length of time for its database restore.</td>
<td></td>
</tr>
<tr>
<td>Output Field</td>
<td>Select the field whose value you want the predictive model to set. In general, a good output field is a numeric, integer, or floating point field. In this example scenario, you use the <strong>Duration</strong> field to measure a length of time. The output field should generate a numeric value.</td>
</tr>
<tr>
<td>Fields</td>
<td>Select one or more field types that help the system identify the records you want to train using regression. In this example scenario, you use <strong>Short description</strong>, <strong>Source datacenter</strong>, <strong>Target datacenter</strong>, and <strong>Database size</strong>. (short_description, Sourcedc, Targetdc, and Dbsize.) Input field types can be string, nominal, or numeric.</td>
</tr>
<tr>
<td>Filter</td>
<td>(Optional) Add filter conditions to the output field records you want to train using regression.</td>
</tr>
<tr>
<td>Note:</td>
<td>The minimum number of records for regression training is 10,000 records.</td>
</tr>
<tr>
<td>Note:</td>
<td>The maximum number of records for regression training is limited to 300,000.</td>
</tr>
<tr>
<td>Processing Language</td>
<td>Select the dominant language of the dataset you're training on the solution definition. If the dataset language is Italian, choose <strong>Italian</strong>. Also, English processing is applied to all datasets by default. For example, if you select Italian, the system processes the data in both English and Italian.</td>
</tr>
<tr>
<td>Note:</td>
<td>The term processing indicates some of the language-specific steps used as part of training a solution. For example, tokenizing words, removing stop words, and stemming.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stopwords</td>
<td>When you select your processing language, the system automatically adds a Stopwords list that uses the same language. For example, if your processing language is Italian, the <strong>Default Italian Stopwords</strong> list appears. The <strong>Default English Stopwords</strong> list also appears in your selection as well. If you create a custom stopwords list, you can select it from the Stopwords field to add it to your solution. In this scenario, you use the <strong>Default English Stopwords</strong> list.</td>
</tr>
</tbody>
</table>
| Training Frequency    | Select how often the system regenerate the solution based on records matching the **Filter**. Your options include:  
  - Run Once  
  - Every 30 days  
  - Every 60 days  
  - Every 90 days  
  - Every 120 days  
  - Every 180 days  
  In this scenario, you select Every 30 days  
  By default, the system runs training once. This practice provides you time to review and update the solution definition as needed until it provides acceptable coverage and precision values.  
  - **Note:** The minimum number of records required for regression solution training is set at 10,000. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The ML scheduler limits the number of trainings an instance can commit to 50 new ML training requests per instance within a 24 hour window. This excludes scheduled re-training requests. In addition, clustering and similarity updates are also excluded from this limit, even if the new training requests exceed 50 within a 24 hour window.</td>
<td></td>
</tr>
</tbody>
</table>

4. Click the appropriate context menu option or button for your solution definition.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save or Save &amp; Train</strong></td>
<td>Save your solution definition record so you can return to it later, or save and submit it for training.</td>
</tr>
<tr>
<td><strong>Submit or Submit &amp; Train</strong></td>
<td>Create your solution definition record and submit it, or submit and train it.</td>
</tr>
</tbody>
</table>

5. If you submitted the solution for training, click **OK** on the Training Activation window to confirm.

The system schedules the solution for training with the nearest training service. The system sends you a notification when the training completes, including any errors that may have occurred in the training. Any other users can subscribe to the Predictive Intelligence Notifications category. When training completes, the system uploads the solution as an Attachment record.

**What to do next**

In this example scenario, you created an ML solution from your solution definition. The Solution Statistics, Test Solution, and Solution Definition tabs appear in the Related Links section of your ML solution.

On the Solution Statistics tab, review the Point Estimate and Range (prediction interval) statistics your solution has provided.
On the Test Solutions tab of your solution, you can test the prediction output for the records you used as input to the prediction by entering values for the input fields, such as the **Source datacenter**, **Target datacenter**, and **Database size**. You can also use the default prediction confidence level of 95, or enter a different level between 0 and 100. Using 95 as the value means that the system is 95% confident that the actual prediction falls within the prediction interval. Click the **Run Test** button to find the prediction output.

After you run the test, the prediction output statistics appear. The Point Estimate on the screen is a single value at one point in time. For example, the database restore takes 134.47 seconds to complete. The Lower and Upper bounds on the screen signify a range accuracy value. For example, the database restore takes between 84.53 and 185.41 seconds to complete.
View solution training progress

View your solution training progress or statistics to determine if a solution is available, or how long the next training cycle might take to complete.

Before you begin
Role required: admin or ml_admin

About this task
Solution training involves these steps.
1. Fetching files for training. The system downloads the training records and sends them to the nearest training service.
2. Preparing the data. The system removes duplicate records from the training set.
3. Training the solution. The training service trains the solution.
4. Uploading the trained solution. The training service uploads the solution as attachment records.

Procedure
1. Navigate to Predictive Intelligence > Classification > Solutions or Predictive Intelligence > Similarity > Solutions.
2. In the ML Solutions list, select the solution whose progress or statistics you want to view.

Example
For example, select Incident Categorization to see the training history.
3. In the Related Links section, click Show training progress.
Training times vary based on the number of records and classes within the training set. The more records and classes you use, the longer the training can take. For example, a data set containing 100,000 records and several hundred classes can take around five hours to complete.

The system shows a Training Progress pop-up window.

What to do next
For classification solutions, see [Review classification solution statistics](#).
For similarity solutions, see [Review similarity solution examples and scores](#).

**Review classification solution statistics**

Use the Solution Statistics dashboard to determine if a classification solution has sufficient precision and coverage for each class. Identify classes that require configuration or retraining with a new solution definition filter.

**Before you begin**

- To ensure optimal dashboard display, [enable responsive dashboards](#) or change the default dashboard layout.
- Role required: admin, ml_admin, or ml_report_user
About this task
The Solution Statistics dashboard lists the precision, coverage, and distribution for each class of active solutions. The system uses the classes with the highest number of records when it builds a solution. Note that the number of classes predicted may be less than 50, and can skip a class if there is not enough historical data to build a solution that can predict the class confidently.

Procedure
1. Navigate to Predictive Intelligence > Classification > Solution Statistics.
2. From Filter by solution, select the solution whose statistics you want to review.
3. From Filter by version, select the solution version whose statistics you want to review.
4. Click Apply.
   The system updates the dashboard based on the filters selected.

5. Identify classes with unwanted combinations of precision, coverage, and distribution values.

   Example
   For example, identify classes that have low precision or coverage but a high distribution.
6. Identify any missing classes you want the model to include.

   **Example**
   For example, identify any missing incident categories from the Incident classification solution.

   **What to do next**
   If you're satisfied with the solution you've reviewed, it'll already be active and ready to use if it's the latest version. If you're not satisfied, you can choose a different version of the solution and make it active. You can also tune and retune the solution by configuring the class precision and coverage to use acceptable values.

   **Review solution similarity examples**
   Review the similarity examples and scores generated during solution training to determine if the similarity score threshold is sufficient.

   **Before you begin**
   - Train a similarity solution
   - Role required: admin or ml_admin

   **About this task**
   Solution training generates paired data record examples with a percentile score that represents the degree of similarity between the two records. The higher the score, the higher the similarity. A score of 100 indicates identical records and a score of 0 indicates dissimilar records.

   The solution only returns similarity results that have a score that's higher than the threshold.

   **Note:** The similarity filters specified in the solution definition aren't applied for similarity examples and are only applied during prediction.

   **Procedure**
   1. Navigate to Predictive Intelligence > Similarity > Solutions.
   2. In the ML Solutions list, locate your solution and click the Reference Lookup icon.
   3. Click Open Record.
   4. In the Related Links section, click Similarity Examples.
5. Review the similarity examples and their threshold scores to determine the accuracy and coverage levels you want applied to your solution similarity results. The higher the similarity score, the more precise it is and the less coverage it offers. The lower the similarity score, the more coverage it has and the less precision it offers.

6. Based on your review, determine whether to increase or decrease the similarity score threshold value for your similarity solution.

What to do next
If you decide to adjust the score for your similarity solution, update its similarity solution threshold.

Reviewing your ML solution training jobs
Use the ML Solutions (Training Jobs view) to track, review, and monitor the solution training status and progress for all ML user interface and API training jobs in your instance.

Background and usage
When you submit an ML solution or ML solution definition for training, it goes to a ServiceNow data center for processing to predict and deliver a data outcome. Depending on the solution size, the training can take hours or sometimes days to complete. The Training Jobs view helps you stay on top of all in-progress and completed ML solution training jobs in your instance.

To access the training jobs view, you use the admin or ml_admin role and the following navigation path: Predictive Intelligence > Solution Training Jobs.

Note: The ML scheduler limits the number of trainings an instance can commit to 50 new ML training requests per instance within a 24 hour window. This excludes scheduled re-training requests. In addition, clustering and similarity updates are also excluded from this limit, even if the new training requests exceed 50 within a 24 hour window.

Training Jobs view summary
The view shows all ML training jobs grouped by the four Predictive Intelligence capability frameworks: classification, similarity, clustering, and regression.

Each ML solution has values for its version, capability framework type, training state, training completion percentage, and other relevant attributes.

If you don’t have any training jobs for a particular capability, its associated ML solutions won’t appear in the view. For example, in this scenario, there aren’t any
regression training jobs listed because you don’t have any regression ML solutions that you’ve submitted for training yet.

When you click the Solution Name you can see the details of the ML solution, as seen in the images below.
Activate solution version

The system activates the most recent version of the solution when it completes training a solution, and only allows one solution version to be active at a time. However, you can activate any previously trained solution version you want Predictive Intelligence to use to make predictions.

Before you begin

- Manually train a solution multiple times or set a training schedule.
- Role required: admin or ml_admin

About this task

The system creates a solution version each time you train a solution definition. Typically, you only manually create a new solution version when you change the solution definition filter and want to test it. Otherwise, most solution versions are created during scheduled solution training.

Procedure

1. Navigate to Predictive Intelligence > Classification > Solutions or Predictive Intelligence > Similarity > Solutions or Predictive Intelligence > Clustering > Solutions or Predictive Intelligence > Regression > Solutions.

2. In the ML Solutions list view, click the Reference Lookup icon for the trained solution that you want to activate.

3. Click Open Record.

4. In the solution record, click Activate.
   The system activates this solution version and deactivates any other solution version.

What to do next

For classification solutions, review the trained solution precision and coverage statistics. For similarity solutions, review the similarity examples.

Review classification prediction results over time

Use the Prediction Results dashboard to determine if solution predictions are improving over time. Identify solutions that require filter changes or retraining.
Before you begin

- To ensure optimal dashboard display, enable responsive dashboards or change the default dashboard layout.
- Role required: admin, ml_admin, or ml_report_user

About this task
The Prediction Results dashboard lists classification solution precision and coverage over time.

Procedure

1. Navigate to Predictive Intelligence > Classification > Prediction Results Report.
2. In the Prediction Results dashboard Filter by solution prompt, select the solution statistics you want to review. The system updates the dashboard based on the solution you selected.
3. Identify classes with anomalous precision or coverage values.

   Example
   For example, identify solutions where the precision or coverage is decreasing over time.

What to do next
Update the solution definition filter to include or exclude classes as needed.

Test a classification solution prediction

Once your machine-learning (ML) solutions are trained, you can call on the Predictive Intelligence API to make a solution prediction. In this example procedure, we use the REST API Explorer to test a classification solution prediction for incident categorization.

Before you begin
Train your ML solution prior to testing a prediction.
Role required: web_service_admin, rest_api_explorer, or admin or ml_admin

About this task
This procedure uses sample data to illustrate what you can do in your instance, and may not represent data or records that are actually in your instance.

This scenario illustrates a classification solution prediction for a hypothetical ML solution that you have previously created and trained. You can also use the REST API Explorer to test a similarity solution prediction.
**Procedure**

1. Navigate to **Predictive Intelligence > Classification > Solution Definitions**.

2. Locate the ML solution definition whose prediction you want to test, and copy its **Name** value to your clipboard or a Notepad file.
   In this case, use the **Name** field value in your ML Solution Definition **Incident Categorization** record, as illustrated in the following example.

3. Write down and save the **Input Fields** used in your ML Solution Definition record that you want the REST API Explorer to use in its call to the Predictive Intelligence API.
   In this case, we use the **short _description** field, as the prediction model has been trained to use this field to learn its category definition.

4. Navigate to **System Web Services > REST > REST API Explorer**.

5. Set these choice fields as follows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>now (leave as default)</td>
</tr>
<tr>
<td>API Name</td>
<td>Predictive Intelligence</td>
</tr>
<tr>
<td>API Version</td>
<td>latest (leave as default)</td>
</tr>
</tbody>
</table>
The Predictive Intelligence form appears. You use this form to prepare your call request to the Predictive Intelligence API.

6. In the solution-name Value field, type ml_incident_categorization.

   Note: This is the Name value you captured in Step 1 of this procedure.

7. Click Add query parameter.
   The Predictive Intelligence form refreshes to show the Query parameters section.

8. Type short_description in the first field.

   Note: This is the input field you captured in Step 2 of this procedure.

9. Type a short description of an incident in the second field. For instance, type Unable to connect.

10. Click the Send button.
    The REST API Explorer sends your request to the Predictive Intelligence API.
    The system predicts the output value in the Response Body section of the API output. You can use other short descriptions to test what the solution is predicting.

11. Optional: Send a different request to the Predictive Intelligence API so that you can test the prediction model again.

   a. Return to the Query parameters section of the Predictive Intelligence form.

   b. Type a short description that references a different kind of incident in the second field. For example, type Unable to connect to MSSQL.

   c. Click the Send button.
    The Response Body section may refresh to show a different outcome than what you saw in Step 9, depending on which incident categories you configured in your solution definition setup. In other words, changing the short description text can recategorize the incident as a different kind of issue.

Example:
You can also test the Predictive Intelligence prediction model when you create a new incident record using the incident form.

1. Navigate to Incident > Create New.

2. In the new Incident form that loads, set the fields as follows.
• **User:** Enter the Caller name.
• **Category:** Leave as default.
• **Short description:** Enter a short description that you want to test.

3. Submit the incident form.

Result: When the form refreshes, an information message appears with the incident category automatically set to a specific value.

⚠ **Note:** For some short descriptions, the prediction might not process because the solution does not have enough confidence in predicting the value for this input.

**Related information**

- Predictive Intelligence API
- MLPredictor - Global

**Export trained solutions to production**

Refine and test your ML solutions iteratively on a non-production instance, and then use update sets to export the changes to your production instance. This practice mitigates the risk of retraining solutions on your live production instance.

**Before you begin**

Prior to testing on a test instance, ensure that the instance hosts recently-cloned data from your production instance so that the solutions you train on the test instance remain valid when you export them to production.  
Role required: admin or ml_admin

**About this task**

Plan your changes carefully, and remember that update sets match records based on the system ID [sys-id] and not the version number. For more information on update sets, see System update sets.

**Procedure**

1. Navigate to **Predictive Intelligence > Classification > Solution Definitions** or **Predictive Intelligence > Similarity > Solution Definitions**.
2. Click the name of your trained ML Solution Definition record to open it.
3. In the Related Links section, click **Add solutions to the current update set**.
4. Click **Update**.
Results
Your trained ML solution artifacts, such as solution definitions, template records, and predictive model statistics, are added to the current update set.

What to do next
Depending on where you are in your solution testing, schedule your update set for export to another non-production instance for further testing, or on to production.

⚠️ Note: After you export a similarity solution, click Refresh similarity window (Required after Solution Import) in the Related Links section of the corresponding ML Solution Definition form.

Test a similarity solution prediction
Once your machine-learning (ML) solutions are trained, you can call on the Predictive Intelligence API to make a solution prediction. In this example procedure, we use the REST API Explorer application to test a similarity solution prediction for resolved incident recommendations.

Before you begin
Train your ML solution prior to testing a prediction.

Role required: web_service_admin, rest_api_explorer, or admin or ml_admin

About this task
This procedure uses sample data to illustrate what you can do in your instance, and may not represent data or records that are actually in your instance.

This scenario illustrates a similarity solution prediction for a hypothetical ML solution that you have previously created and trained. You can also use the REST API Explorer to test a classification solution prediction.

Procedure
1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.
2. Locate the ML solution definition whose prediction you want to test, and copy its Name value to your clipboard or a Notepad file.

In this case, we use the Name field value in your ML Solution Definition Recommended Resolved Incidents record, as illustrated in the following example.
3. Copy the **Input Fields** value(s) used in your ML Solution Definition record that you want the REST API Explorer to use in its call to the Predictive Intelligence API.

In this case, we use the **Short description** field type, as the prediction model has been trained to use this field to learn, pair, and recommend similar records for your review.

4. Right-click the browser tab you’re using to view your instance, and select **Duplicate**.

5. In the duplicate browser tab, navigate to **System Web Services > REST > REST API Explorer**.

6. Click **Explore**.

7. Set these choice fields as follows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>now (leave as default)</td>
</tr>
<tr>
<td>API Name</td>
<td>Predictive Intelligence</td>
</tr>
<tr>
<td>API Version</td>
<td>latest (leave as default)</td>
</tr>
</tbody>
</table>

The Predictive Intelligence form appears. You use this form to prepare your call request to the Predictive Intelligence API.

8. In the solution-name **Value** field, enter `ml_x_snc_global_recommended_resolved_incidents`.

   **Note:** This is the Name value you captured in Step 2 of this procedure.

9. Click **Add query parameter**.

10. In the Query parameters section, enter the value of one of the Input Fields from the solution you’re testing.
a. In the first field, paste short_description.

Note: This is one of the input fields you captured in Step 2 of this procedure.

You can use other field types, such as Description or Resolution notes to test what the solution is predicting.

b. In the second field, enter some text that you might find in an incident record. For instance, enter Discovery errors.

11. Click the [+] button to create a second query condition that defines the number of results you want to query.

a. In the first field, enter top_n.

b. In the second field, enter 3. These conditions set the query to retrieve the top three most similar incident records.

12. Click Send.

The REST API Explorer sends your request to the Predictive Intelligence API.

13. In the Response body section, copy the three outcome values that your API call returned, as illustrated in the image below.

```
{
    "output": [
    {
        "outcome": "098ad7dd7f1897009da45ac47dfa916a",
        "confidence": "83.38670134544373",
        "threshold": 80
    },
    {
        "outcome": "020f57d17fd897009da45ac47dfa9119",
        "confidence": "62.12549805641174",
        "threshold": 80
    },
    {
        "outcome": "0ad338597f1c13009da45ac47dfa91d0",
        "confidence": "61.85050010681152",
        "threshold": 80
    }
    ]
}
```
14. In your original browser tab, navigate to **Servicedesk > Incidents**.

15. As shown in the image below, set filter conditions for the three REST API outcomes to the Incidents table list view.

   - **a.** Add the Active and Sys ID conditions below to the Incidents list view Filter icon.
   
   - **b.** Paste the three REST API outcomes into the **Input value** field of the Sys ID condition that you created.
   
   - **c.** Click **Run**.

16. Per the image below, compare the returned list of incidents with the input for the prediction output in the REST API Explorer.

   - **a.** Click the Incident Number to open the Incident record.
b. Per the image below, review the Resolution notes text in the Incident record.

Related information
Predictive Intelligence API
MLPredictor - Global

Database View support for Predictive Intelligence

Use database views to join two or more tables as input for your Machine Learning (ML) solution.

Using database views in an ML solution

Database views help expand the amount of fields your solution can use for training. By using more than one table in your ML solution definition form, you can access more input data to help enrich the solution outcome.

Database views enable you to join two or more tables into one consolidated view. For this to work in an ML solution you must first create the database view. See Database views.

Database views are supported in all four of the Predictive Intelligence capability frameworks: classification, similarity, clustering, and regression.

A database view example for Predictive Intelligence

In the following example scenario, you’ve created a database view for use in an ML similarity solution. The image below shows the database view record you’ve created, including its Name and Label.
When you click the record **Name**, its content appears, as shown in the image below. Within the database view content, the five Knowledge Base tables you’ve joined to the view are listed. Most of these tables contain different Knowledge article template types, such as a FAQ or a How To article.

When a database view is used as input to a similarity solution, each of the tables that constitute the view must have at least the required number of records set in the configuration of your ServiceNow instance. The default minimum number required is 10,000. For example, the **Knowledge View** database view has five tables and each table must have 10,000 records. If a table doesn’t have 10,000 records, you may not see the results from that table. If you must change that value, contact Customer Support.
In the image below you can see the similarity solution definition record you've already created, which you plan to associate to your database view. When you click the **Label** for your similarity record, its Similarity Definition form appears.

Similarity Definition forms compare your existing table records based on their similarity by using a table in the **Table** field and another table in the **Test Table** field.

To use a database view in your similarity solution, instead of selecting a table in the **Table** field, you select the database view you created, which in this example
scenario is the **Knowledge View** database view. This configuration increases the number of records your solution uses in training because the system compares and processes five tables of data instead of one.

### Configuring advanced settings for your ML solutions

Set parameters for Predictive Intelligence machine learning (ML) solutions to invoke optional technology and algorithms for classification, similarity, and clustering capabilities.

Configuring advanced settings on your ML solutions is optional. If you choose to configure any of these settings, make sure you’re well informed regarding the technology you’re enabling in the solution, and that you have a use case that benefits from what the technology offers.

#### Classification, similarity, clustering, and regression advanced settings

Using the admin or ml_admin role, you apply these technologies by configuring a parameter in the Advanced Solution Settings tab on your ML solution definition form. These solution parameters deliver different functionality for different use cases.

To update or remove an existing solution parameter that’s applied to a solution definition, navigate to the Advanced Solution Settings tab and click the name of the solution parameter. To enable one or all of them, see the following procedures:

- Configure class recall for a classification solution
- Configure TF-IDF for classification, similarity, and regression solutions
Configure DBSCAN for a clustering solution
Configure HDBSCAN for a clustering solution
Configure XGBoost for classification or regression solutions
Configure Connect Component algorithm and Levenshtein Distance method for a clustering solution
Apply purity on a clustering solution
Analyze a cluster with a data source

Configure class recall for a classification solution

Create and apply a class recall parameter to an ML solution prior to training its data. For example, you set and apply this solution parameter to 90% accuracy for all records you train in the Email class.

Before you begin

Note: Configuring advanced settings on your ML solutions is optional. If you choose to configure any of these settings, make sure you’re well informed regarding the technology you’re enabling in the solution, and that you have a use case that benefits from what the technology offers.

• Create and save a classification solution definition or use an existing one.
• Role required: admin or ml_admin

About this task

The class recall solution parameter enables you to steer a solution’s training to bias a specific class. For example, classifying if an incoming email as a Phish or not can be an important use case in a security-related machine learning solution. In this situation, it’s very important to identify every Phish, and it may be okay to report a non-Phish as a Phish occasionally. However, no real Phish should be classified as a non-Phish. In such situations, the recall metric must have a high value, which might lead to lower percentages for precision and coverage.

Procedure

1. Navigate to Predictive Intelligence > Classification > Solution Definitions.
2. Open a saved classification solution definition form.
   In this example scenario, you use an Incident Categorization solution definition form that you haven’t trained yet.
3. On the Advanced Solution Settings tab in the Related Links section of the form, click **New**.

4. Create a parameter record.
   
   **a.** In the **Solution Parameters** field, click the search icon.
   
   **b.** In the ML Solution Parameters screen, select **Add class recall value while training**.

5. Click **Submit**.
   
   The Advanced Solution Setting record appears.
6. Configure the **User inputs** field.

   **a.** Enter the class name on which you want to track the Recall value. In this scenario, you enter **Phish** for the **ClassName**.

   **b.** Enter the Recall value. Enter **90** for the **RecallValue**.

   Here you're specifying **Phish** as the target class, and **95** is the recall percentage you're requesting the system to deliver during solution training.

7. Click **Submit**.

   **Result:** Class recall is configured for your classification solution. Its solution parameter appears on the Advanced Solution Settings tab of your classification solution definition form.

---

**What to do next**

Train your saved classification solution.

**Related information**

- Create and train a classification solution
- Configuring target metrics for a trained classification solution
- Configure TF-IDF for classification, similarity, and regression solutions
Configure TF-IDF for classification, similarity, and regression solutions

Apply Term Frequency–Inverse Document Frequency (TF-IDF) encoding to classification, similarity, or regression solutions.

Before you begin
Role required: admin or ml_admin

⚠️ Note: Configuring advanced settings on your ML solutions is optional. If you choose to configure any of these settings, make sure you’re well informed regarding the technology you’re enabling in the solution, and that you have a use case that benefits from what the technology offers.

- Create a similarity solution definition or use an existing one.
- Create a classification solution definition or use an existing one.
- Create a regression solution definition or use an existing one.
- Role required: admin or ml_admin

About this task
Predictive Intelligence uses paragraph vector word embedding by default in its classification, similarity, and regression frameworks, which is highly effective for processing data comprised of primarily human readable content. However, TF-IDF has been known to sometimes return better prediction results for records that have machine-generated content, such as alerts and error messages for log files. So you have a choice here based on the kind of data your solution is processing.

In this example scenario, you optionally apply TF-IDF to classification, similarity, and regression solutions. TF-IDF is applied to all of these solutions in the exact same manner.

Procedure

1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.
2. Open a similarity solution definition form.
   In this example scenario, you use a CMBD similarity definition form.
3. On the Advanced Solution Settings tab in the Related Links section of the form, click **New**.

4. Create a parameter record.
   a. In the **Solution Parameters** field, click the search icon.
   b. In the ML Solution Parameters screen, select **Use tf-idf to generate vectors**.

5. Click **Submit**.
   The Advanced Solution Setting record screen refreshes.

6. Click **Submit**.
   **Result:** TF-IDF is configured for your similarity solution. Its solution parameter appears on the Advanced Solution Settings tab of your similarity definition form.
Note: Follow the steps below if you want to configure TF-IDF on a classification solution.

7. Navigate to **Predictive Intelligence > Classification > Solution Definitions**.

8. Open a classification solution definition form.
   In this second example scenario, you use an Incident Categorization classification definition form.

9. Repeat steps 1-5 from the previous similarity solution example, except this time you're using a classification solution.

10. Click **Submit**.
Result:

TF-IDF is configured for your classification solution. Its solution parameter appears on the Advanced Solution Settings tab of your classification solution definition form.

Information Icon: Follow the steps below if you want to configure TF-IDF on a regression solution.

11. Navigate to Predictive Intelligence > Regression > Solution Definitions.

12. Open a regression solution definition form.
   In this third example scenario, you use a regression definition form.

13. Repeat steps 1-5 from the previous similarity solution example, except this time you’re using a regression solution.

14. Click Submit.

Result:

TF-IDF is configured for your regression solution. Its solution parameter appears on the Advanced Solution Settings tab of your regression solution definition form.

Related information

Create and train a classification solution
Create and train a similarity solution
Create and train a regression solution

Configure XGBoost for classification or regression solutions

Apply XGBoost encoding to optimize the training for your classification or regression solutions.

Before you begin

Information Icon: Configuring advanced settings on your ML solutions is optional. If you choose to configure any of these settings, make sure you’re well informed regarding the technology you’re enabling in the solution, and that you have a use case that benefits from what the technology offers.

- Create a classification solution definition or use an existing one.
- Create a regression solution definition or use an existing one.
- Role required: admin or ml_admin
About this task
XGBoost is an optional gradient boosting framework that uses multiple decision trees and supports both Paragraph Vector-based text and TF-IDF distance-based text. LogR is the default distance-based model algorithm.

In this example scenario, you apply XGBoost to both a classification solution and a regression solution.

Procedure
1. Navigate to Predictive Intelligence > Classification > Solution Definitions.
2. Open a classification solution definition form.
3. On the Advanced Solution Settings tab in the Related Links section of the form, click New.

4. Create a parameter record.
   a. In the Solution Parameters field, click the search icon.
   b. In the ML Solution Parameters screen, select Use XGBoost algo for classification model training.

5. Click Submit.
   The Advanced Solution Setting record screen refreshes.
6. Click Submit.

**Result:** XGBoost is configured for your classification solution. Its solution parameter appears on the Advanced Solution Settings tab of your classification definition form.

7. Navigate to Predictive Intelligence > Regression > Solution Definitions.
8. In this second scenario, you open a regression solution definition form.
9. Repeat steps 1-5 from the previous classification solution example, except this time you’re using a regression solution.
10. Click Submit.

**Result:**
    
    XGBoost is configured for your regression solution. Its solution parameter appears on the Advanced Solution Settings tab of your regression solution definition form.

**Related information**

Create and train a classification solution
Create and train a regression solution
Configure DBSCAN for a clustering solution

Consider applying the Density Based Spatial Clustering of Applications with Noise (DBSCAN) encoding to your clustering solution. K-means is the default clustering algorithm.

Before you begin

⚠️ Note: Configuring advanced settings on your ML solutions is optional. If you choose to configure any of these settings, make sure you’re well informed regarding the technology you’re enabling in the solution, and that you have a use case that benefits from what the technology offers.

- Create a clustering solution definition or use an existing one.
- Role required: admin or ml_admin

About this task

Predictive Intelligence uses the k-means algorithm by default in its clustering framework. DBSCAN is another clustering algorithm that’s also used in data mining and machine learning. Some users prefer DBSCAN as it doesn’t require you to specify the number of clusters in the data before clustering. For a summary of the pros and cons for each algorithm, see this conversation and this article.

In this example scenario, you apply DBSCAN to a clustering solution.

Procedure

1. Navigate to Predictive Intelligence > Clustering > Solution Definitions.
2. Open a clustering solution definition form.
   In this example scenario, you use an Incidents clustering solution definition form.

3. On the Advanced Solution Settings tab in the Related Links section of the form, select Solution Parameters from the picker, then click New.
4. Create a parameter record.

   a. In the Solution Parameters field, click the search icon.

   b. In the ML Solution Parameters screen, select Use DBSCAN for clustering.

5. Click Submit.
   The Advanced Solution Setting record appears.

6. Click Submit.
**Result:** DBSCAN is configured for your clustering solution. Its solution parameter appears on the Advanced Solution Settings tab of your clustering solution definition form.

**Related information**

Create and train a clustering solution

**Configure HDBSCAN for a clustering solution**

Consider applying the Hierarchical Density Based Spatial Clustering of Applications with Noise (HDBSCAN) encoding to your clustering solution. K-means is the default clustering algorithm.

**Before you begin**

**Note:** Configuring advanced settings on your ML solutions is optional. If you choose to configure any of these settings, make sure you’re well informed regarding the technology you’re enabling in the solution, and that you have a use case that benefits from what the technology offers.
• Create a clustering solution definition or use an existing one.
• Role required: admin or ml_admin

**About this task**
You can apply the HDBSCAN algorithm to help the system identify data samples that aren’t assigned to any cluster. For example, you can apply HDBSCAN to support Topic Discovery.

Predictive Intelligence uses the k-means algorithm by default in its clustering framework. HDBSCAN is another clustering algorithm that is similar to the DBSCAN algorithm except that it works with minimum sized clusters and can help to deliver more stable and persistent clusters. For a summary of how HDBSCAN works, see this article. For a comparison between DBSCAN and HDBSCAN, see this article and this article.

**Procedure**

1. Navigate to **Predictive Intelligence > Clustering > Solution Definitions**.

2. Select **New**.

3. Create a new clustering solution definition form or use an existing one.
   In this example scenario, you create the *hdbscan-sf* clustering definition form as in the image below. Configure the fields as follows:
   • **Label**: *hdbscan-sf*
   • **Word Corpus**: *incident_wc*, or any other word corpus that has incident record data
   • **Table**: Incident [incident]
   • **Fields**: Short description
• **Update Frequency:** Do not update
• **Stopwords:** Default English Stopwords
• **Training Frequency:** Every 30 days
• **Processing Language:** English

4. Select Submit & Train.

5. On the Advanced Solution Settings tab in the Related Links section of the trained form, select **Solution Parameters** from the picker, then select **New**.

6. Create a parameter record.
a. In the **Solution Parameters** field, select the search icon.

b. In the ML Solution Parameters screen, select **Use HDBSCAN for clustering**.

7. Select **Submit**. The Advanced Solution Setting record appears with the HDBSCAN algorithm applied to the record.

8. Select **Submit**.
Result: HDBSCAN is configured for your clustering solution. Its solution parameter appears on the Advanced Solution Settings tab of your clustering solution definition form.

Related information

Create and train a clustering solution

Configure Connect Component algorithm and Levenshtein Distance method for a clustering solution

Apply Configure Connect Component and Levenshtein Distance method encoding to optimize the training for your clustering solutions.

Before you begin

Role required: admin or ml_admin

Note: Configuring advanced settings on your ML solutions is optional. If you choose to configure any of these settings, make sure you’re well informed regarding the technology you’re enabling in the solution, and that you have a use case that benefits from what the technology offers.

• Create and train a clustering solution definition or use an existing one.
• Role required: admin or ml_admin

About this task

When training clustering solutions, you have the following three options.
• Use the default k-means algorithm.

• Use the optional DBSCAN solution parameter with the Euclidean distance method as a metric.

• Use the optional DBSCAN, Minimum Neighbors, and Levenshtein Distance solution parameters. Connect Component is enabled by DBSCAN and Minimum Neighbors, and supports both Paragraph Vector-based text and Levenshtein Distance-based text. If you train your solution using the Levenshtein Distance method, you don’t need to use a word corpus in your clustering solution.

In this example scenario, you train your solution definition by using the third option referenced above.

**Procedure**

1. Navigate to **Predictive Intelligence > Clustering > Solution Definitions**.

2. Open a trained clustering solution definition form.

3. On the Advanced Solution Settings tab in the Related Links section of the form, click **New**.

4. Create a parameter record.
   
   a. In the **Solution Parameters** field, click the search icon.

   b. In the ML Solution Parameters screen, select **Levenshtein Distance**.
5. Click Submit.

The Advanced Solution Setting record screen refreshes.

6. Click Submit.

**Result:** Levenshtein Distance is configured for your clustering solution. Its solution parameter appears on the Advanced Solution Settings tab of your clustering definition form.
7. Repeat steps 1-6 from the previous Levenshtein Distance example, except this time you're creating the **Minimum Neighbors** and **DBSCAN** solution parameters, which together enable the Connect Component feature.

When you select, configure, and submit the **Minimum Neighbors** solution parameter, be sure to set the **User Inputs** field with a value of 1. Only some parameters have a User Inputs field.

**Result:**

Connect Component is configured for your clustering solution. Its two solution parameters appear on the Advanced Solution Settings tab of your clustering definition form, alongside the Levenshtein Distance parameter you configured in steps 1-6 of this procedure.
Related information

Create and train a clustering solution

Use Predictive Intelligence in Flow Designer with ML actions

Use Predictive Intelligence actions to make predictions using existing models without the complexities and overhead of script encoding.

Before you begin

• Make sure the following plugins are activated in your instance: Predictive Intelligence (com.glide.platform_ml), Predictive Intelligence Reporting (com.glide.platform_ml_pa), and Predictive Intelligence for Flow Designer (com.snc.ml_flowdesigner).

• Create or use an existing trained ML solution.

• Roles required: admin or ml_admin, and flow_designer or delegated_developer.

About this task

Create flows in Flow Designer that incorporate predictive ML functions to make predictions to use in your digital workflows.

You can use Predictive Intelligence in Flow Designer for Predictive Intelligence classification, similarity, and regression capabilities.

In this example scenario, the only Flow Designer batch prediction actions available are Regression Batch Prediction and Classification Batch Prediction.

The Flow Designer UI is useful in automating complex encoding processes for a specific data outcome. The first thing you want to identify is what process you want to automate. In this example scenario, you're automating the assignment of a Category to an incident record. When you complete the flow, the next incident record you create in your instance updates the Category field in the record based on the text you enter in the Short description field of the flow, as shown in Step 24 of this procedure.

Based on your use case, you can use any active and trained classification, similarity, or regression ML solution you need in your flow.

In this example procedure, you create a Flow Designer flow that uses the ml_incident_categorization ML solution in a Flow Designer action. In this example scenario, you can find this ML solution by searching on the ML Solutions table, as shown in the image below. Make sure that the solution you use has been trained and its Active value is set to true.
The system triggers this particular flow on the next incident record you create. For detailed information on how to use Flow Designer, refer to the following documentation: Flow Designer

Procedure

2. Click New > Flow.

3. On the Flow Properties screen, configure the following fields.

   a. **Flow Name**: Provide a name for the flow. In this scenario, you enter Auto-assign Category to Incident.

   b. **Description**: Enter a brief summary description of what the flow delivers. For example, you enter the following: When an incident is created, it automatically triggers this flow, which uses ML Solutions to predict the correct Category for the incident.

   c. **Application**: select Global.

   d. **Protection**: Select --None-- or Read-only. In this scenario, you select --None--.

   e. **Run As**: Select User who initiates session

   f. **Run with role(s)**: Leave blank.

4. Click Submit.
5. In the TRIGGER section of the screen, configure the following fields to create a trigger for the flow.

a. **Add a trigger:** Click **Created**.

b. **Table:** Select **Incident [incident]**.

   - **Note:** When you configure both the **Trigger** and **Table** fields, record data pills appear in the **Data** section of the screen so you can use them in your flow.
c. **Condition**: Click **Add filters** if you want to add any conditions to the flow.

d. **(Optional)** Open the **Advanced Options** panel to view additional conditions you can apply to the flow. To close the panel, click Advanced Options again.

e. **Click Done**.

6. In the **ACTIONS** section of the screen, configure the following fields to create a **Classification Prediction action**.

Click the tool tip to see a description of a Classification Prediction.

b. Solution Name [ML Solution]: Select ml_incident_categorization.

c. Top N: Enter 3.
   When you enter a number, such as 3, the system uses the top 3 ML predictions that have the highest prediction confidence score. If you don't enter anything, the system sets the default value to 1.

d. Input Record: Drag and drop your Trigger → Incident Record data pill into the Input Record field.
The Action, Solution Name, Top N, and Input Record values provide a base for the Category prediction.

**Note:** The data pill you drop into this record must also be a record. For example, don't try to drop a table pill or a date/time pill into the Input Record field.

e. Click Done.
**Result:** The Classification Prediction action is completed in the flow and its data pills appear in the Data section of the screen.

7. In the ACTIONS section of the screen, use the following steps to create actions and flow logic for the incident’s Prediction Results.

**Note:** Although you can use a loop to iterate through every prediction result, the scenario shown in this documentation uses a relatively small number of actions. For more advanced flow configurations, see the Flow Designer.

a. **For each item in list of items:** Drag and drop the Prediction Results data pill into the Items field.
**Note:** In order to access the list of items in the Regression Prediction action, you don't need the **For Each Item in** flow logic.

b. **Click Done.**

**Result:** The Prediction Results action is started in the flow and its data pills appear in the Data section of the screen.

8. In the ACTIONS section of the screen, select **Action > Predictive Intelligence > PI Confidence Check.**

The PI Confidence Check is a tool you can use to compare values in a flow. In this use case, it compares prediction result values, and the output from the check is either True or False.

9. Drag and drop the **confidence** data pill into the **Predicted Number from Predictive Intelligence** field.

10. Enter **50** in the **Comparison Threshold** field.

In this example scenario, you enter the number 50, which tells the system to use predictions that have a confidence score above 50%.

11. **Click Done.**
12. Click **Flow Logic** > **If** to add a condition to the flow.

13. Configure the following fields to define the first part of the condition flow logic.

   - **Condition**: Enter a name for the condition that defines what it does. In this example scenario, you enter *Confidence greater than 50.*
   
   - **Condition 1**: Drag and drop the **Confidence To Predict** data pill into the field. Select *is*, and enter the value *True*. This step completes the first part (the antecedent) of the condition flow logic.
   
   - **Click Done.**
14. Click **Action**, then enter `worknote` into the search field. Select **ITSM > Add Worknote** to add a work note as the second part (the conclusion) of the condition.

15. Configure the following fields to define the second and final part of the condition flow logic.
   - **Action**: As a result of Step 14 above, **Add Worknote** appears automatically in this field.
   - **task [task]**: Drag and drop the **Incident Record** data pill into the field.
   - **work note**: Drag and drop the **predicted_value** data pill into the field. This step completes the condition flow logic conclusion.
   - Click **Done**.
16. Click **Action**, then enter `update record` into the search field. Select **Update Record**.

17. Configure the following fields to update the Incident Record.

   - **Action:** As a result of Step 16 above, **Update Record** appears automatically in this field.

   - **Record:** Drag and drop the **Incident Record** data pill into this field.

   - **Table:** Select **Incident [incident]**.

   - **Fields:** Select **Category**. Then drag and drop the **predicted_value** data pill into this field, next to the **Category** value.
• Click **Done**.

18. Click **Save**.
19. Click **Activate**.

**Result**

• Your Auto-assign Category to Incident flow is activated and complete.
• It also appears as published in the Flows column on the Flow Designer home screen.

20. Navigate to Incidents.

21. Click New to create a random incident record in the Incidents table. In this example scenario, you create record INC0010011.

22. In the record you created, note in the following image that the Category value is set to Inquiry / Help.

23. In the Short description field, enter Email not working.

24. Click Submit.

Result

The system updates the incident record to show that its Category value has changed from Inquiry / Help to Email.
Using Machine Learning APIs

Use ServiceNow Machine Learning (ML) APIs to train Machine Learning models and run inferences.

ML APIs enable training solutions and managing solution versions. You can get and set active versions, monitor training status, and more. The ML API also provides encoders, which enable using term frequency–inverse document frequency (TF-IDF) as a word corpus. Predictability estimates enable assessing the predictive value of table columns.

Note: Predictive Intelligence APIs run with full privileges. To restrict user access, include an access control mechanism in the script.
ML API class overview

This section briefly describes classes for training ML solutions and running inferences with trained solutions.

Datasets

A dataset is a set of records including a table name, columns, and row selection criteria to use as input for ML training algorithms. Datasets do not contain the actual data.

• DatasetDefinition

ML objects – Solutions, Encoders, and Estimates

ML objects define a specific training configuration to apply on a dataset. Some operations are common across ML objects. Solution objects include classification, clustering, regression, and similarity.

Encoders are text processing objects that are either pre-trained or trained based on the language datasets you provide. You can train encoders that determine how the system interprets and processes text fields. For ML solutions that include text, you can train an encoder to specify how to process text and use the trained encoder in a solution.

PredictabilityEstimate objects estimate which fields in a dataset are predictable and the features on which this predictability is based.

• ClassificationSolution
• ClusteringSolution
• Encoder
• PredictabilityEstimate
• RegressionSolution
• SimilaritySolution

Stores

ML objects are maintained in a specific store for each object type. Each store class includes methods for add, get, update, and delete operations.

• ClassificationSolutionStore
• ClusteringSolutionStore
• EncoderStore
• PredictabilityEstimateStore
• RegressionSolutionStore
• SimilaritySolutionStore

Versions
Each trained object results in a new version that you can run tasks on. Use the version API to get any solution version and run tasks on it.
• ClassificationSolutionVersion
• ClusteringSolutionVersion
• EncoderVersion
• PredictabilityEstimateVersion
• RegressionSolutionVersion
• SimilaritySolutionVersion

Putting it together: ML API flows
You can use the following flow to configure and train solutions, encoders, and predictability estimates:

ML API flow – Solution, encoder, and estimate training

Note: The encoder definitions support multiple dataset definitions, but have the same training flow.

To train a solution with an encoder, create the encoder first, then include the encoder in the solution configuration.

ML API flow – Solution API training with encoder

ML object encoder requirements:
• Required in similarity API solutions.
• Required in clustering API solutions, unless using the Levenshtein distance algorithm, in which case encoders are optional.
- Optional for classification and regression solutions.
- Unavailable for predictability estimates.

Getting started with ML API solution training
Follow this example breakdown to learn how to configure and train a solution.

Configure and train a solution

1. Define a dataset using the `DatasetDefinition` API.

   ```javascript
   var myData = new sn_ml.DatasetDefinition({
       'tableName' : 'incident',
       'fieldNames' : ['assignment_group', 'short_description', 'description'],
       'encodedQuery' : 'activeANYTHING'
   });
   ```

2. Use the constructor to define the solution, including the dataset in the configuration.

   ```javascript
   var mySolution = new sn_ml.ClassificationSolution({
       'label': "my solution definition",
       'dataset' : myData,
       'predictedFieldName' : 'assignment_group',
       'inputFieldNames': ['short_description']
   });
   ```

- `ClassificationSolution()`
- `ClusteringSolution()`
- `Encoder()`
- `PredictabilityEstimate()`
- `RegressionSolution()`
- `SimilaritySolution()`

3. Add the solution definition to the store using the `add()` method.

   ```javascript
   var my_unique_name = sn_ml.ClassificationSolutionStore.add(mySolution);
   ```
• ClassificationSolutionStore – add()
• ClusteringSolutionStore – add()
• EncoderStore – add()
• PredictabilityEstimateStore – add()
• RegressionSolutionStore – add()
• SimilaritySolutionStore – add()

4. Train the solution using the submitTrainingJob() method. After training is complete, you can manage the trained solution using a solution version API. A solution can be retrained multiple times. Each training results in a new solution “version” on which you can run inferences.

```javascript
var myClassifierVersion = mySolution.submitTrainingJob();
```

• ClassificationSolution – submitTrainingJob()
• ClusteringSolutionVersion – submitTrainingJob()
• Encoder – submitTrainingJob()
• PredictabilityEstimate – submitTrainingJob()
• RegressionSolution – submitTrainingJob()
• SimilaritySolution – submitTrainingJob()

View all classification solutions in a store

You can use the store getAllNames() method to see a list of all solutions that have been added to the store.

```javascript
gs.print(JSON.stringify(JSON.parse(sn_ml.ClassificationSolutionStore.getAllNames()), null, 2));
```

In the output, the system has named the solution ml_x_snc_global_global_my_solution_definition. Use this name in subsequent examples to get version information.

```javascript
*** Script: [
  "ml_incident_assignment",
  "ml_x_snc_global_global_my_solution_definition",
  "ml_incident_categorization"
]
```

• ClassificationSolutionStore – getAllNames()
• ClusteringSolutionStore – getAllNames()
Getting started with ML API solution versions

Follow these example breakdowns to learn how to manage trained solution versions.

Check training status

Get the classification solution from the store, choose a version, and check its training status. The methods used for checking training status are applicable to all ML object types.

1. Get the solution from the classification solution store using the `get()` method.

   ```javascript
   // Get the solution created in the previous example from the classification solution store
   var mlSolution = sn_ml.ClassificationSolutionStore.get('ml_x_snc_global_global_my_solution_definition');
   ```

2. Access the most recent solution version using the `getLatestVersion()` solution method and get its training status using the `getStatus()` version method.

   ```javascript
   // Access the latest version of the solution and print its training status
   gs.print(JSON.stringify(JSON.parse(mlSolution.getLatestVersion().getStatus(), null, 2)));
   ```
Output when training is complete:

```json
*** Script:
{"state":"solution_complete","percentComplete":"100","hasJobEnded":"true"}
```

<table>
<thead>
<tr>
<th>getLatestVersion()</th>
<th>getStatus()</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClassificationSolution - getLatestVersion()</td>
<td>ClassificationSolutionVersion - getStatus()</td>
</tr>
<tr>
<td>ClusteringSolution - getLatestVersion()</td>
<td>ClusteringSolutionVersion - getStatus()</td>
</tr>
<tr>
<td>Encoder - getLatestVersion()</td>
<td>EncoderVersion - getStatus()</td>
</tr>
<tr>
<td>PredictabilityEstimate - getLatestVersion()</td>
<td>PredictabilityEstimateVersion - getStatus()</td>
</tr>
<tr>
<td>RegressionSolution - getLatestVersion()</td>
<td>RegressionSolutionVersion - getStatus()</td>
</tr>
<tr>
<td>SimilaritySolution - getLatestVersion()</td>
<td>SimilaritySolutionVersion - getStatus()</td>
</tr>
</tbody>
</table>

Get predictions using a solution version

After the solution has been trained, get the trained version and run a prediction on it. Get the solution you created from the store. Next, choose the trained version and predict the trained version.

Note: Predictions cannot be made on encoders and predictability estimates.

1. Get the solution from the classification solution store using the get() method.

```javascript
// Get the solution created in the first example from the classification solution store
var mlSolution = sn_ml.ClassificationSolutionStore.get('ml_x_snc_global_global_my_solution _definition');
```
2. Use the **GlideRecord** API **get()** method to provide a record from the Incident [incident] table.

```javascript
// single GlideRecord input
var input = new GlideRecord("incident");
input.get("<sys_id>");
```

3. Optional. Configure the **ClassificationSolutionVersion - predict()** method **options** parameter to return the top three results and return all results.

```javascript
// configure optional parameters
var options = {};
options.top_n = 3;
options.apply_threshold = false;
```

4. Declare a variable called **results** and assign it to the prediction job. To run the prediction job, get the most recent solution version using the **ClassificationSolution - getLatestVersion()** method and call the **ClassificationSolutionVersion - predict()** method on it.

```javascript
var results = mlSolution.getLatestVersion().predict(input, options);
```

- **ClassificationSolutionVersion - predict()**
- **ClusteringSolutionVersion - predict()**
- **RegressionSolutionVersion - predict()**
- **SimilaritySolutionVersion - predict()**

5. Print the predicted results output.

```javascript
gs.print(JSON.stringify(JSON.parse(results), null, 2));
```

Predicted results example output:

```json
*** Script: {
"<sys_id>": [ 
  {
  "confidence": 99,
  "threshold": 24.75,
  "predictedValue": "Email",
  "predictedSysId": ""
  },
  {
  "confidence": 5.88210244009169,
  "threshold": 100,
  "predictedValue": "Email (I/f)"
  }
]
```
Using MLSolutionFactory scriptable objects

MLSolutionFactory scriptable objects enable defining ML functionality. You can use the APIs to compose data-driven functionality, such as subclustering large clusters or clusters with multiple PRBs attached.

You can use scriptable objects in a scripted extension point to modify the Predictive Intelligence REST API method to address unique business use cases.

ServiceNow applications on the NOW platform can call scriptable objects and script includes. External applications can call scripted REST APIs. By default, the Predictive Intelligence REST API - Prediction for multiple solutions (GET) method uses the MLSolutionUtil scripted extension point to take a list of active solution names, run predictions on them given the input, and return results. The MLSolutionUtil extension point enables creating custom implementations for specific usage scenarios, for example, running a second solution prediction only after the condition of a first solution prediction is satisfied.

Here’s the high-level process for creating a custom usage scenario.

1. Developers customize a MLSolutionUtil scripted extension point implementation using the MLSolutionFactory scriptable object.
   - Listed as global.MLSolutionUtil in the Extension Point [sys_extension_point] table
   - See Register a custom script include

2. The MLSolutionUtil scripted extension point implementation uses MLSolutionFactory to get the scriptable object, and invokes prediction methods on that object.

3. The Predictive Intelligence REST API - Prediction for multiple solutions (GET) method invokes the MLSolutionUtil extension point implementation, depending on the scope of the request.

4. Applications call the Predictive Intelligence REST API - Prediction for multiple solutions (GET) end point from a script include form.
For more information, see

- Predictive Intelligence REST API
- MLSolutionFactory - Global

**Preserve ML solutions during a system clone**

Save your trained machine-learning (ML) solution data during a system clone.

**Before you begin**

Role required: clone_admin or admin

**About this task**

The system stores trained ML solutions as Attachment records. These records include your solution artifacts, such as solution definitions, template records, and predictive model statistics, all of which are required components of the Predictive Intelligence prediction functionality. To preserve these records, follow the high-level steps below each time you run a system clone.

**Procedure**

1. Enter `sys_properties.list` in the application navigator to access the System Properties list.

2. Ensure the `glide.platform.ml.clone_artifacts` system property is set to `True`.

3. If you want to preserve only the ML solution records and not the numerous other records in the `sys_attachments` table, exclude the `sys_attachments` table from your clone run.

4. Request a system clone.
   The system preserves your ML solution records during the system clone.
# Configuration tips for Predictive Intelligence

If you encounter issues during your solution training and solution prediction, follow the suggested resolutions.

## Solution training

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution or suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The solution training remains in Waiting for Training status for too long, as the scheduler job is using an incorrect glide callback instance URL.</td>
<td>Ensure the <code>glide.servlet.uri</code> property in the Glide instance is set to the correct instance URL. This issue can occur when:</td>
</tr>
<tr>
<td></td>
<td>• An instance is cloned from production, yet it still refers to the production URL for the <code>glide.servlet.uri</code> property.</td>
</tr>
<tr>
<td></td>
<td>• The glide instance is provisioned and runs the training for the first time.</td>
</tr>
<tr>
<td>New categories have been added and are not yet having an impact on training.</td>
<td>This is expected behavior, as the new categories may not yet have sufficient data until the solution is retrained.</td>
</tr>
<tr>
<td>The solution training fails.</td>
<td>When the training fails, click the <strong>Show Training Progress</strong> related link on the solution screen to determine where the potential problem resides.</td>
</tr>
<tr>
<td>The solution training fails due to user authentication.</td>
<td>Navigate to <strong>System Security &gt; Users</strong> and ensure the <code>sharedservice.worker</code> role is set to Active.</td>
</tr>
<tr>
<td>The model training returns saying the model cannot be created. The training fails and shows the “Error while training solution” message. The training progress window shows this message: “Solution training failed as either the data used is not sufficient or</td>
<td>This issue can occur when the data quantity or the distribution of field values is not sufficient for a model to build successfully. Follow these steps to troubleshoot:</td>
</tr>
<tr>
<td>Issue</td>
<td>Resolution or suggested action</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>the input field is not predictive of the output field&quot;.</td>
<td>1. Ensure the distribution of the output field is not skewed.</td>
</tr>
<tr>
<td></td>
<td>2. Retrain the model by changing the date filters to use a larger amount of data.</td>
</tr>
<tr>
<td></td>
<td>3. If the input fields are not fully populated, add a filter to remove null records.</td>
</tr>
<tr>
<td>The solution has data in multiple languages but the coverage and</td>
<td>Use the following options to help improve your metrics.</td>
</tr>
<tr>
<td>precision results are poor.</td>
<td>Option 1: Update the processing language of the solution to the most prominent non-English language.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> English is applied by default for all datasets.</td>
</tr>
<tr>
<td></td>
<td>Option 2: If there is sufficient data for each language/region:</td>
</tr>
<tr>
<td></td>
<td>1. Add a filter criteria for a specific language/region where the primary language can be identified (Dutch, English, French, German, Japanese, or Spanish).</td>
</tr>
<tr>
<td></td>
<td>2. Generate a solution for each language/region and apply the proper processing language to each solution.</td>
</tr>
</tbody>
</table>

**Solution prediction**

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution or suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The prediction fails and returns a Java exception where the cause is</td>
<td>1. Search for the exception in the Predictive Intelligence Glide logs.</td>
</tr>
<tr>
<td>unknown.</td>
<td>2. Submit an Incident record for Predictive Intelligence including all relevant details, such as the</td>
</tr>
<tr>
<td>Issue</td>
<td>Resolution or suggested action</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------</td>
</tr>
</tbody>
</table>
| There is no prediction applied to the incident/case record but the prediction returns a value when tested in the Rest API Explorer. | This can occur when the confidence of the prediction is less than the threshold required to make a prediction. After your solution is trained, use the following steps to confirm if your solution settings need adjusting.  
1. Navigate to System Web Services > REST > REST API Explorer to find the confidence level for the prediction. See Test a classification solution prediction.  
2. On your ML Solution Definition record, check the threshold set for your outcome class that was returned in the prediction by clicking on the name of the class. The Class page appears.  
3. Check the Estimated Precision and Estimated Coverage values. If the corresponding threshold is more than the prediction confidence of the outcome, this is the root cause for why you did not see any prediction.  
4. Adjust the class precision and coverage values to increase coverage or precision. See Tune a trained classification solution. |

### Instance cloning

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution or suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>After an instance is cloned, predictions for your existing solutions fail.</td>
<td>The ML solution artifacts in the [ml_artifacts] table are stored in the [sys_attachment] table. If the</td>
</tr>
</tbody>
</table>
Issue | Resolution or suggested action
--- | ---
[ml_artifacts] table is not included in the clone when you run it, the predictions fail. Ensure your clone includes the machine-learning artifacts, as these are critical components of your Predictive Intelligence solution. | 
After an instance is cloned, the solution training fails. | As the cloning run proceeds, it is possible that the sharedservice.worker user has either been inactivated, locked out, or the user ID is not set. Resolve these problems so that the solution training succeeds.

Quick start tests for Predictive Intelligence

Validate that Predictive Intelligence still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Predictive Intelligence quick start tests require activating the Predictive Intelligence [com.glide.platform_ml] plugin. In order to execute critical upgrade tests on existing machine learning solutions, you need to create a basic authorization profile named ml_att in the Basic Auth Configurations table (sys_auth_profile_basic.list). To run the tests successfully, the user attached to the ml_att authorization profile must have the ml_admin role.

Predictive Intelligence: Classification and Similarity Solution Prediction test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI: Presence of ML model artifacts persisted in glide</td>
<td>Verify all the trained ML model artifacts are persisted in glide (sys_attachments table) after model training/instance cloning so that ML prediction calls are successful.</td>
<td>New York</td>
</tr>
<tr>
<td>PI: Valid setup of ML user (sharedservice.worker) in glide</td>
<td>Validate if the ML user in glide (sharedservice.worker) is</td>
<td>New York</td>
</tr>
</tbody>
</table>
Predictive Intelligence: Classification and Similarity Solution Prediction test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI: Glide upgrade test for Classification solution</td>
<td>Validate that the classification model prediction on existing active models is producing the same class membership and confidence value results after a glide upgrade.</td>
<td>New York</td>
</tr>
<tr>
<td>PI: Glide upgrade test for Similarity solution</td>
<td>Validate that the similarity model prediction API calls on active models are successful after a glide upgrade.</td>
<td>New York</td>
</tr>
</tbody>
</table>

**Related information**

Quick start tests

**Domain separation and Predictive Intelligence**

Domain separation is supported in the Predictive Intelligence application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Standard**

- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.
Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview

Predictive Intelligence enables the creation of supervised machine learning solutions using historic datasets. A machine learning solution definition can be configured in Predictive Intelligence per domain, which ensures that the data used by the solution is domain-specific data. After a solution is trained for a domain, the solution calls for a prediction to be made for resolution, depending on what that domain belongs to. For example, the solution might be an incident or case.

How domain separation works in Predictive Intelligence

An instance owner can train a machine learning (ML) solution for each domain by creating a solution definition for each domain and training those solutions. In this way each solution uses data specific to the corresponding domain.

- Data can be domain separated
- Domain column is present for base system application tables
- Domain-specific configuration is managed by instance owner
- Tenant domains can manage their own application data
- Application properties are domain-aware when needed

Related information

Domain separation for service providers

ServiceNow® apps and features that use Predictive Intelligence

Review this topic to see which ServiceNow applications and features leverage Predictive Intelligence functionality.
When applicable, ServiceNow teams work together to create products that apply the artificial intelligence and machine learning capabilities that Predictive Intelligence provides.

These teams have customers in different business units (BUs) and industries. For example, the Customer Service Management (CSM) marketing, product, design, development, and documentation teams partner with the platform Predictive Intelligence team to deliver BU-specific products to ServiceNow CSM customers.

Here is the list of ServiceNow products that leverage Predictive Intelligence functionality.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine Learning solutions for Field Service Management</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Virtual Agent

Unlock your enterprise productivity with ServiceNow® Virtual Agent. Provide your employees and customers with a friendly messaging interface, featuring pre-built conversations powered by artificial intelligence.

Virtual Agent operational impact

Virtual Agent helps solve ordinary issues and delivers results for common requests. When Virtual Agent handles the general, everyday tasks and requests, your agents and technicians are free to focus on more complex user issues.

Virtual Agent converts the time your agents and technicians spend handling low-impact user requests, such as password reset, request for leave of absence, or information about a recent order, into an impressive, intelligently managed interaction. Turn your high-volume ordinary interactions into an elevated user experience.

Virtual Agent is available to support organizations throughout your enterprise, including IT Service Management, Customer Service Management, and HR Service Delivery. Virtual Agent helps support these organizations with the following tasks and more:

• Answering FAQs
• Providing tutorial, "how to" information
• Querying or updating records, for example to get status on cases or incidents
• Gathering data, such as attachments, for the live agent
Performing diagnostics
Resolving multi-step problems

Virtual Agent features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Personalized experiences</strong></td>
<td>Virtual Agent uses the full context of the Now Platform® to deliver intelligent, personalized, and meaningful conversations that actually get things done. Admins can set up custom chat experiences for users from where they run Virtual Agent.</td>
</tr>
<tr>
<td><strong>Natural Language Understanding (NLU)</strong></td>
<td>Enable Virtual Agent with NLU to understand the intent of what people are looking for and provide them with more relevant answers. Everyone can get what they need using simple, everyday language and conversations precisely tuned for ServiceNow® workflows that you can easily evolve over time.</td>
</tr>
<tr>
<td><strong>Pre-built conversational topics</strong></td>
<td>Quickly deploy AI-powered chatbot conversations using customizable templates for the most common enterprise IT, HR, and customer service scenarios.</td>
</tr>
<tr>
<td><strong>Virtual Agent Designer</strong></td>
<td>Build and test conversations without scripting or advanced skills. Drag and drop elements on the graphical canvas to see the entire flow. Go further with branching, looping, and scripting.</td>
</tr>
<tr>
<td><strong>Live agent hand-off</strong></td>
<td>Seamlessly transfer the entire conversation history and context to the right human agent so they can quickly address any escalations and resolve user issues.</td>
</tr>
<tr>
<td><strong>NLU Workbench</strong></td>
<td>Create and tune sophisticated models that are specific to your organization’s vocabulary and acronyms without writing a line of code. Enable anyone to define intents and map entities to your Now Platform data by entering sample sentences.</td>
</tr>
<tr>
<td><strong>Channel integrations</strong></td>
<td>Connect to where your employees and customers already are—in web portals, Now® Mobile apps, and collaboration tools like Slack, Microsoft Teams, Facebook Messenger consumer app,</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Workplace from Facebook enterprise messaging app, and any other popular chat or messaging app.

### Notifications
Deliver real-time alerts and status updates to employees, including actionable notifications and SMS notifications. Deliver notifications via all supported channels, including web, Slack, Workplace, and SMS. You can quickly collect feedback for critical decisions and resolve requests faster.

### Multiple NLU providers
Use the native, built-in NLU engine from ServiceNow, or optionally connect IBM Watson Assistant or Microsoft LUIS for intent and entity recognition across additional languages.

## Virtual Agent benefits

<table>
<thead>
<tr>
<th>User satisfaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide better self-service by helping users and customers get what they need quickly with always-on, omni-channel experiences. Enable your users to get immediate help, day or night. Boost user and customer satisfaction by offering a personalized Virtual Agent experience, whereby user information is remembered and applied during the conversation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Increased productivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver great experiences for your users, as well as your agents and technicians, by deflecting tickets and reducing call volumes. Drive productivity by providing a virtual agent on familiar channels, such as Slack, Microsoft Teams, Facebook Messenger, and Workplace.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Automation support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale your support organizations and free your agents and technicians to focus on more complex user issues by automating common support tasks.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Empowered service owners</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable service owners to deliver and refine AI capabilities quickly without data science expertise.</td>
</tr>
</tbody>
</table>

## Virtual Agent for your enterprise

**Virtual Agent for IT Service Management**
Empower your IT technicians to concentrate on more challenging, demanding user requests and incidents by deflecting the most common, simpler incidents to a virtual agent. ITSM Virtual Agent enhances both the IT technician experience and the employee experience by addressing IT-related queries immediately.

- **Guided setup for Virtual Agent and Live Agent**
  Walk through the steps for configuring your instance with Virtual Agent or Workspace Agent Chat (Live Agent). Setup instructions are customized to streamline the configuration process.

- **Incident Auto Resolution**
  Proactively deflect some of the most common ITSM incidents to ITSM Virtual Agent through Actionable Notifications. Incident Auto Resolution enables ITSM Virtual Agent to proactively resolve incidents through a conversation on the user’s preferred chat channel.

- **Actionable Notifications**
  Send interactive messages to an employee through Virtual Agent, based on pending tasks or alerts. Deflect some of the most common ITSM incidents to ITSM Virtual Agent, reduce incident volume to the service desk, and help employees discover ITSM Virtual Agent as a resolution channel.

- **Topic Recommendations**
  Use the Topic Recommendations app to identify pre-built Virtual Agent topics that can be quickly implemented in your organization. Topic Recommendations uses Intent Discovery to analyze data from your organization and to find relevant pre-built topics that your organization can benefit from, and new topics that would be useful to create.

- **Integration**
  Integrate with other Now Platform applications, such as Flow Designer, AI Search, and IntegrationHub. Add automated workflows, built in Flow Designer, to conversation topics. You can extend these workflows to access many third-party services through pre-built IntegrationHub spokes. For example, enable
your users to initiate a WhatsApp chat conversation with a virtual agent by using the Conversational Integration with WhatsApp (powered by Twilio) application.

- **Manage Microsoft Office 365 Group conversation flow**
  Manage a Microsoft Office 365 Group using a pre-built set of topics. With this conversation flow, you can add or remove users from an existing Microsoft Office 365 Group, create a Microsoft Office 365 Group, and more.

- **Manage Microsoft Active Directory Distribution List conversation flow**
  ITSM Virtual Agent helps admins manage an on-premise Microsoft Active Directory distribution list using a pre-built set of topics. Admins can add and remove users from a distribution list, create distribution lists, and show Distribution List details.

- **Custom greetings and promoted topics**
  Provide custom chat experiences for your end users based on their context, such as the service portal from which they initiate Virtual Agent chats. For example, users can receive different greetings from Virtual Agent or see different promoted topics that are shown at the start of a conversation.

- **Topic categories, conversations, and topic blocks**
  Leverage numerous pre-defined ITSM Virtual Agent topic conversations that are contained in several topic categories, including: **ITSM Fulfiller**, **ITSM IT Issues**, **ITSM Self Service**, **Setup Topics**. Create and reuse topic blocks and templates to perform common functions in ITSM Virtual Agent conversations. Customize the conversational experiences for your end users based on the context (environment) in which they run Virtual Agent.

**Virtual Agent for Customer Service Management**
Predefined Virtual Agent topic conversations enable your customers to get the customer service help they need quickly and efficiently.
Integrating NLU models with your virtual agent topics enables chatbots to analyze, understand, and navigate the user to the right topic based on the inferred intent.

- **Integration with Facebook Messenger**
  Integrate Customer Service Management Virtual Agent with Facebook Messenger to enable virtual agent conversations in the messenger.

**Virtual Agent for HR Service Delivery**

Virtual Agent enhances the employee experience by addressing HR-related queries immediately. At any time during a virtual chat, employees can request to interact with a live HR agent. The base system provides numerous predefined Virtual Agent topic conversations designed to help your employees complete common self-service HR tasks.

**Get started with Now Platform Virtual Agent**

Select a tile to get started with Now Platform Virtual Agent.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Configure</th>
<th>Integrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn how employees, customers, and agents use Virtual Agent.</td>
<td>Plan and configure your Virtual Agent implementation.</td>
<td>Extend Virtual Agent capabilities by integrating with other applications.</td>
</tr>
</tbody>
</table>
Use

Design and build automated conversations and reusable topic components.

Analytics and Reporting Solution

Improve processes with the Conversational Analytics Dashboard.

Get started with Virtual Agent for specific businesses

To explore Virtual Agent for IT Service Management, Customer Service Management, or HR Service Delivery, select a business tile to learn more.

Virtual Agent for IT Service Management

Predefined Virtual Agent topics to help your employees complete common IT-related tasks.

Virtual Agent for Customer Service Management

Predefined Virtual Agent topics to help your customers complete common self-service tasks.

Virtual Agent for HR Service Delivery

Predefined Virtual Agent topics to help your employees complete common HR-related tasks.

Additional resources

- Virtual Agent and Natural Language Understanding (NLU) community forum
- Virtual Agent Academy

Exploring Virtual Agent

The ServiceNow Virtual Agent platform provides user assistance through conversations within an intelligent messaging interface. Design and build automated conversations that help your users quickly obtain information, make decisions, and perform common work tasks with Virtual Agent.
For an introduction to the Virtual Agent platform, and to get familiar with the product, watch this video. This video explains what the Virtual Agent is, shows an example demonstration including hand-off to a live agent, and introduces the Virtual Agent Designer.

Components

The Virtual Agent platform includes the following components:

Virtual Agent conversational (client) interface

With Virtual Agent, your users interact with a virtual or live agent through various messaging services. You can configure the web-based chat client available for Service Portal and Apple iOS and Google Android environments. Your users can interact with a virtual agent through the Now Mobile app, as well as through the ServiceNow integrations for third-party enterprise messaging applications: Slack, Microsoft Teams, and Workplace from Facebook. You can also configure the Virtual Agent interface for Facebook Messenger, a consumer messaging application.

In addition to the clients supported by Virtual Agent, you can create conversational custom chat integrations with other chat providers. These custom chat integrations enable your end users to engage with Virtual Agent and live agents through other chat channels.

Virtual Agent Designer

Use Virtual Agent Designer to develop, test, and deploy automated conversations that assist your users with common issues or self-service tasks. Virtual Agent Designer is a graphic tool for building the dialog flows of conversations, called topics. A topic defines the dialog exchanged between a virtual agent and a user to accomplish a specific goal or resolve an issue.

In addition to topics, you can also build reusable topic components, such as topic blocks that perform certain functions or custom controls (user interface objects), for use in your conversations.

You can build conversations that are based on keywords that your users enter. Or, you can apply Natural Language Understanding (NLU) models, which enable your virtual agent to understand, process, and respond to what users are saying during a conversation.

Predefined topics and topic blocks are available for various ServiceNow applications, such as Customer Service Management (CSM), HR Service Delivery, IT Service Management, and more.
**Live agent support**

Give users the option to switch to a human agent for assistance during bot conversations. Virtual Agent integrates with live chat to offer a seamless transfer from a virtual agent to a live agent. Your users can request a live agent transfer at any time during a virtual agent conversation. You can also initiate a live agent transfer through custom conversation flows that you build.

**Virtual Agent versions**

The Virtual Agent platform is available as a professional subscription or in a limited version that is automatically included with the Now Platform®:

- **Virtual Agent (professional)** — Provides all the core functionality for creating and deploying virtual agent conversations to your Virtual Agent clients. Includes support for Natural Language Understanding (NLU) in Virtual Agent conversations.

- **Virtual Agent Lite** — Provides a limited version of Virtual Agent for ITSM standard customers. Used with ITSM Virtual Agent Conversation Topics Lite, which offers three pre-built conversations for common IT support requests. These keyword-based conversations run in the web chat client and also in Virtual Agent messaging integrations for Slack, Microsoft Teams, Workplace from Facebook, and Facebook Messenger.

**Conversational user interface**

The Virtual Agent conversational interface captures an automated messaging session between the virtual agent and user. The web client interface uses the Service Portal web widget, which you can configure for custom service portals. The widget is available in the CSM, HR Service Delivery, and ITSM Service Portals.
Simple conversation example — web client

A simple conversation typically includes the following elements:

- Default welcome message from the virtual agent, followed by the first prompt for the conversation. The initial prompt asks the user to type a question or to choose from a list of available topics.

- User response to the first prompt. In this example, the user chooses the topic for checking an IT ticket.

- Series of prompts, acknowledgments, and responses exchanged between the virtual agent and the user until the users reach their goals or complete their tasks. You can use different rich controls in bot prompts, for example, choice lists with buttons or a carousel of images to select an item.

- Closing message to end the conversation.

Conversation options

When your users start a conversation with the bot, they can enter a request or see a list of everything that the bot can help with. If they choose to see
everything, the chat window displays all topics available to the user. Your users can use the search box to filter the list of topics.

Manage the conversation

The conversational interface offers your users several options to manage the conversation. Users can stop the current conversation and start a new one, contact support to access a live agent for immediate assistance, and control audible alerts for chats.
Live agent transfer

When users transfer to a live agent, the chat window header changes to indicate that they are now interacting with a live agent. The attachment and send icons are available in the chat window for uploading an image, text, or PDF file and sending it to the agent.

Working with file attachments during live chat

During live chat, users can attach a file of any type (for example an image, text, or PDF file) and send it to the agent. The system automatically performs a virus scan on the file attachment. If the scan is successful, the file is sent to the agent.

- If the scan fails, a message informs the user that the scan did not pass so that the user can correct the file and then upload the file again.
- If the upload and virus scan process times out (the upload takes too long), a message tells the user that the file couldn’t be processed and to try the file upload again.

Note: Most chat clients support file attachment uploads. However, the mobile chat client only supports file attachment uploads in bot conversations. Users cannot upload files in mobile chat with a live agent.
New message alerts

Your users automatically receive audio and visual alerts when they receive a message from a live agent or virtual agent.

- The visual indicator displays the number of messages received, next to the chat icon in the Service Portal window. When the user opens the chat, the indicator number closes.

![Image of chat window with message alert]

- Your authenticated end users can enable or disable audible alerts of chats through the toggle switch on the chat menu (Contact Support).

- Authenticated end users can also enable or disable the delivery of notifications through the toggle switch on the chat menu (Contact Support).

- The default sound notification uses the sn_va_web_client_alert.mp3 audio file.
  - You can change the sound that requesters hear by uploading your own audio file. For details, see Manage audio files.
  - To turn off the audio notification for your instance, use the system parameter sysparm_disable_audio_notifications=true. For example: https://<your-instance name>.service-now.com/nav_to.do?sysparm_disable_audio_notifications=true

Natural Language Understanding in Virtual Agent

Apply Natural Language Understanding (NLU) models that enable your virtual agent to understand user statements in automated conversations. An NLU
model provides information that your virtual agent uses to determine what users want to do and to extract relevant values from their input. With NLU, your virtual agent can offer a more natural and engaging conversational experience.

**How NLU models work in Virtual Agent**

NLU models are trained to understand statements a user might make during a conversation and relate them to a task that a user wants to perform. Virtual Agent uses the following information in an NLU model to understand and process user requests:

- **Intents**: What a user wants to do, for example perform an action such as submitting a service ticket or getting an update on an order.
- **Utterances**: The different ways that a user expresses an intent.
- **Entities**: The object or context for an action, such as a laptop, case number, or an employee's name.

**Example intent definition in NLU model**

For details on intents, utterances, and entities defined in NLU models and how they work in machine learning, see ServiceNow Natural Language Understanding.

When you create or update topics in Virtual Agent Designer, you identify the NLU model and intent that Virtual Agent uses to find the appropriate conversation topic for fulfilling the intent.

Virtual Agent supports models from different services. You can use:
• ServiceNow NLU models that you create using NLU Workbench.

ServiceNow provides pre-built (read-only) NLU models and topics for various ServiceNow business applications, such as Customer Service Management, HR Service Delivery, and ITSM applications. You can use the intents defined in these pre-built models and reuse them when you create your own models.

• NLU intents and entities created in IBM Watson Assistant, if you’re using IBM Watson Assistant as your NLU service provider.

• NLU intents and entities defined in the Microsoft Language Understanding Intelligent Service (LUIS), if you’re using Microsoft LUIS as your NLU service provider.

Note: Virtual Agent supports only one NLU service provider per instance.

With NLU models, your virtual agent can:

• Perform topic discovery
• Extract entity values
• Handle conversation switching in a conversation session

Topic discovery

Virtual Agent processes user utterances (statements associated with a specific intent) to launch the appropriate conversation topic. Each topic has a single intent that you specify in Virtual Agent Designer.

During the topic discovery process (matching intents to topics), Virtual Agent returns the most relevant topics for a user's request. The topic discovery process returns these results to a user:
• Single match: When a user utterance directly matches an intent (topic), the topic runs automatically.

• Multiple matches: When a user utterance matches more than one intent, Virtual Agent returns a choice list of the relevant matches so that the user can choose the appropriate topic.

Note: If there are multiple matches, Virtual Agent returns three intents by default. You can change the number of topics returned by using the `com.glide.cs.max_number_display_topics` system property.
• No matches: When Virtual Agent can’t find a matching intent, it uses AI Search to generate search results that display relevant links to Q&A (knowledge articles), Service Catalog items, or person (user) records. This feature is controlled by the AI Search Fallback setup topic and the Virtual Agent search configurations, which are enabled by default in chat experiences. To learn more about the AI Search results generated, see Virtual Agent integration with AI Search.

If you disable the AI Search Fallback setup topic, virtual agent automatically displays a fallback error message that enables the user to select a topic or enter a different request.

Example fallback message

I am sorry but I didn't understand your request.

Please try entering your request in a different way.
I'm currently better at understanding short sentences.

You can type your request below, or use the button to see everything that I can help with.

Show Me Everything

For details on how the AI Search Fallback setup topic and the fallback response (called the fallback setup topic) work, see Setting up chat experiences for Virtual Agent users.

Topic discovery with optional keywords

When you create or update topics, you can also optionally specify keywords that Virtual Agent uses to determine the topic if NLU doesn’t return a matching intent and topic. Virtual Agent uses keywords when:

• No topics (intents) are discovered.
• The appropriate topic (intent) can’t be determined because too many topics (intents) are discovered.

Note: If Virtual Agent can’t determine the topic based on NLU or the keyword, it falls back on the AI Search capability to deliver relevant results.
**Entity extraction**

With NLU models, Virtual Agent can determine when user statements in a conversation contain important information to fulfill a task or goal. Entities identify the information that Virtual Agent can extract from the conversation, such as an object or a person's name. To extract the appropriate values, Virtual Agent uses the entity information associated with an intent defined in the NLU model. The input controls that you add to your conversation also have associated NLU entity properties that you can set. Virtual Agent matches the extracted entity with the input control variable that fulfills or completes the action and skips the prompts asking the user for additional information.

**Conversation switching**

Users engaged in a virtual agent conversation can switch topics anytime during the conversation. For example, a user could be updating an item in their employee profile, but before completing the update, that user might ask to order an item instead. Your virtual agent can find and run the appropriate topic based on the user's request. You can enable users who switched topics to resume the original conversation.

Or a user can ask a casual question (called small talk) that might be unrelated to the original request. By reviewing the intents defined in the NLU model, Virtual Agent can match and launch the appropriate conversation for the switched topic.

**ServiceNow NLU integration with Virtual Agent Designer**

If you're using ServiceNow NLU, you can bind an NLU model and associated intent to a topic, and also update, train, and test the associated NLU model from within Virtual Agent Designer. As you work on a topic, you can also fine tune (add, change, or delete) the utterances and associated entities for an intent, through an interface similar to NLU Workbench.

**Multi-language NLU model support**

You can bind topics to multiple, language-specific NLU models created in your NLU service. As you work on your topics, Virtual Agent Designer provides a language mapping view for previewing and testing topics with their associated language-specific models. You can then selectively publish any changes that you make to your topics and your language-specific NLU bindings.

**Get started with NLU in Virtual Agent**

After you activate the plugins for Glide Virtual Agent and the predefined topics for the CSM, HR Service Delivery, and ITSM business applications (ITSM Virtual...
Implementing NLU involves these steps:

1. Prepare your NLU models.
   - If you’re using ServiceNow NLU, review the pre-built NLU models provided with the business applications that you’re using, such as Customer Service Management, HR Service Delivery, and ITSM, in NLU Workbench. Consider whether you want to reuse intents from these models when creating your own NLU models.

   Use NLU Workbench to initially create, train, and publish your NLU models.
   - If you’re using a different NLU service provider supported by Virtual Agent, configure the
     - IBM Watson Assistant Intent and Entity integration or
     - Microsoft LUIS Intent and Entity integration

2. In Virtual Agent NLU Settings, enable NLU and select your NLU service provider. If you’re using language-specific NLU models, you also specify the languages that you’re using.

3. Before you create or update topics, preview (test) the predefined ServiceNow topics in Virtual Agent Designer. Determine whether you want to use any of the topics, then duplicate and publish them as needed.

4. As you create or update topics in Virtual Agent Designer, follow the steps for creating a topic. Note these details:
• Verify that you are in the appropriate application scope before you create or update a topic. For example, if you are creating ITSM topics, verify that you are in the ITSM Virtual Agent Conversations scope (and not the scope for the ITSM NLU Model for Virtual Agent Conversations).

• Select the NLU Model and Associated Intent for the topic in the Topic Properties tab. And if topic switching is allowed in the conversation session, enable Resume topic flow.

⚠️ Note: A topic can map to only one intent in an NLU model. Once you select an intent for a topic, the intent is no longer available for use in other topics.

• Set the NLU entity properties in the property sheet for each input control that you add to the conversation flow. The entity properties identify the entity associated with the node, a switch for allowing text input for the control (prompt), and another switch for confirming the slot-filled entity value that Virtual Agent extracts.

• Test the topic.

5. When you're ready to deploy a topic, publish the topic. This changes the state to Active.

NLU system entities
Use globally defined NLU entities to identify system information that Virtual Agent can extract from the conversation. You can define entities as "nodeless" input variables for a topic. These variables can be slot-filled from NLU service provider predictions or provided outside of the scope of the topic.

System entities are enabled in NLU models by default. You can view them on the model Entities tab in NLU Workbench.

GLOBAL.DATE system entity
The DAY SubType returns a date string that is accurate to a specific date.

GLOBAL.DATE SubType = DAY usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>YYYY-MM-DD</td>
</tr>
<tr>
<td>Regular expression</td>
<td><code>\\d\\d\\d\\d-\\d\\d-\\d-\\d\d</code></td>
</tr>
<tr>
<td>Input example</td>
<td>Mr. Smith left Friday, February 4, 2019.</td>
</tr>
</tbody>
</table>
### GLOBAL.DATE SubType = DAY usage (continued)

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized value</td>
<td>2019-02-04</td>
</tr>
<tr>
<td>Code example</td>
<td></td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.DATE&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
<tr>
<td></td>
<td>&quot;normalization&quot;: {&quot;type&quot;: &quot;GLOBAL.DAY&quot;, &quot;subType&quot;: &quot;DAY&quot;, &quot;value&quot;: &quot;2019-02-04&quot;}</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>

The WEEK SubType returns a date string of a specific week of a year.

### GLOBAL.DATE SubType = WEEK usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>YYYY'W'WW</td>
</tr>
<tr>
<td>Regular expression</td>
<td>\d\d\d\dW\d\d</td>
</tr>
<tr>
<td>Input example</td>
<td>Mr. Smith left the third week of 1999.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>1999W3</td>
</tr>
<tr>
<td>Code example</td>
<td></td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.DATE&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
<tr>
<td></td>
<td>&quot;normalization&quot;: {&quot;type&quot;: &quot;GLOBAL.DATE&quot;, &quot;subType&quot;: &quot;WEEK&quot;, &quot;value&quot;: &quot;1999W3&quot;}</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>

The MONTH SubType returns a date string of a specific month of a year.

### GLOBAL.DATE SubType = MONTH usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>YYYY'M'MM</td>
</tr>
</tbody>
</table>
### GLOBAL.DATE SubType = MONTH usage (continued)

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular expression</td>
<td><code>\d\d\d\d\dM\d\d</code></td>
</tr>
<tr>
<td>Input example</td>
<td>Mr. Smith left in February of 1999.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>1999M02</td>
</tr>
<tr>
<td>Code example</td>
<td></td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.DATE&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
</tbody>
</table>
|                     |   "normalization": {
|                     |     "type": "GLOBAL.DATE", |
|                     |     "subType": "MONTH", |
|                     |     "value": "1999M02" |
|                     | }                 |

The YEAR SubType returns a date string of a specific year.

### GLOBAL.DATE SubType = YEAR usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>YYYY</td>
</tr>
<tr>
<td>Regular expression</td>
<td><code>\d\d\d\d\d</code></td>
</tr>
<tr>
<td>Input example</td>
<td>Mr. Smith left in 1999.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>1999</td>
</tr>
<tr>
<td>Code example</td>
<td></td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.DATE&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
</tbody>
</table>
|                     |   "normalization": {
|                     |     "type": "GLOBAL.DATE", |
|                     |     "subType": "YEAR", |
|                     |     "value": "1999"|
|                     | }                 |

The SEASON SubType returns a date string of a specific season of the year.
### GLOBAL.DATE SubType = SEASON usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Winter</strong>: YYYYWI</td>
</tr>
<tr>
<td></td>
<td>- <strong>Spring</strong>: YYYYSU</td>
</tr>
<tr>
<td></td>
<td>- <strong>Summer</strong>: YYYYSU</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fall</strong>: YYYYYFA</td>
</tr>
<tr>
<td>Regular expression</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Winter</strong>: \d\d\d\d\d\d\dWI</td>
</tr>
<tr>
<td></td>
<td>- <strong>Spring</strong>: \d\d\d\d\d\d\dSP</td>
</tr>
<tr>
<td></td>
<td>- <strong>Summer</strong>: \d\d\d\d\d\d\dSU</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fall</strong>: \d\d\d\d\d\d\dFA</td>
</tr>
<tr>
<td>Input example</td>
<td>Mr. Smith left in the fall of 1999.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>1999FA</td>
</tr>
<tr>
<td>Code example</td>
<td></td>
</tr>
</tbody>
</table>

```json
{
   "name": "entity:GLOBAL.DATE",
   "value": "...",
   "score": 1.0,
   "normalization": {
      "type": "GLOBAL.DATE", "subType": "SEASON",
      "value": "1999FA"
   }
}
```

### GLOBAL.TIME system entity

The **TIME** SubType returns a time string that is accurate to an hour and a minute.

### GLOBAL.TIME SubType = TIME usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>'T'HH:mm</td>
</tr>
<tr>
<td>Regular expression</td>
<td>T\d\d:\d\d\d\d</td>
</tr>
<tr>
<td>Input example</td>
<td>Mr. Smith left at ten minutes to three.</td>
</tr>
</tbody>
</table>
GLOBAL.TIME SubType = TIME usage (continued)

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized value</td>
<td>T02:50</td>
</tr>
<tr>
<td>Code example</td>
<td></td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.TIME&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
<tr>
<td></td>
<td>&quot;normalization&quot;: {&quot;type&quot;: &quot;GLOBAL.TIME&quot;,&quot;subType&quot;: &quot;TIME&quot;, &quot;value&quot;: &quot;T02:50&quot;}</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>

The PARTSOFDAY SubType returns a time string that specifies parts of the day.

GLOBAL.TIME SubType = PARTSOFDAY usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Morning</strong>: TMO</td>
</tr>
<tr>
<td></td>
<td>• <strong>Afternoon</strong>: TAF</td>
</tr>
<tr>
<td></td>
<td>• <strong>Evening</strong>: TEV</td>
</tr>
<tr>
<td></td>
<td>• <strong>Night</strong>: TNI</td>
</tr>
<tr>
<td>Regular expression</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Morning</strong>: TMO</td>
</tr>
<tr>
<td></td>
<td>• <strong>Afternoon</strong>: TAF</td>
</tr>
<tr>
<td></td>
<td>• <strong>Evening</strong>: TEV</td>
</tr>
<tr>
<td></td>
<td>• <strong>Night</strong>: TNI</td>
</tr>
<tr>
<td>Input example</td>
<td>Mr. Smith left in the morning.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>TMO</td>
</tr>
<tr>
<td>Code example</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.TIME&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>
GLOBAL.TIME SubType = PARTSOFDAY usage (continued)

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;normalization&quot;: {&quot;type&quot;: &quot;GLOBAL.TIME&quot;, &quot;subType&quot;: &quot;PARTSOFDAY&quot;, &quot;value&quot;: &quot;TMO&quot;}</td>
<td></td>
</tr>
</tbody>
</table>

GLOBAL.DURATION system entity

This entity returns a duration string that specifies the duration of the activity.

GLOBAL.DURATION usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Second</strong>: 's'ss</td>
</tr>
<tr>
<td></td>
<td>• <strong>Minute</strong>: 'm'mm</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hour</strong>: 'h'hh</td>
</tr>
<tr>
<td></td>
<td>• <strong>Day</strong>: 'D'DD</td>
</tr>
<tr>
<td></td>
<td>• <strong>Week</strong>: 'W'WW</td>
</tr>
<tr>
<td></td>
<td>• <strong>Month</strong>: 'M'MM</td>
</tr>
<tr>
<td></td>
<td>• <strong>Year</strong>: 'Y'YY</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Regular expression</th>
<th>One of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Second</strong>: s\d\d</td>
<td></td>
</tr>
<tr>
<td>• <strong>Minute</strong>: m\d\d</td>
<td></td>
</tr>
<tr>
<td>• <strong>Hour</strong>: h\d\d</td>
<td></td>
</tr>
<tr>
<td>• <strong>Day</strong>: D\d\d</td>
<td></td>
</tr>
<tr>
<td>• <strong>Week</strong>: W\d\d</td>
<td></td>
</tr>
<tr>
<td>• <strong>Month</strong>: M\d\d</td>
<td></td>
</tr>
<tr>
<td>• <strong>Year</strong>: Y\d\d</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input example</th>
<th>Mr. Smith stayed in Boston for 48 hours.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized value</td>
<td>h48</td>
</tr>
<tr>
<td>Code example</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.DURATION&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
</tbody>
</table>
GLOBAL.DURATION usage (continued)

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
<tr>
<td></td>
<td>&quot;normalization&quot;: {&quot;type&quot;: &quot;GLOBAL.DURATION&quot;, &quot;value&quot;: &quot;h48&quot;}</td>
</tr>
</tbody>
</table>

GLOBAL.LOCATION system entity

This entity returns a location string.

GLOBAL.LOCATION usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>String value.</td>
</tr>
<tr>
<td>Regular expression</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Input example</td>
<td>Mr. Smith works in Santa Clara.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>Santa Clara</td>
</tr>
<tr>
<td>Code example</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.LOCATION&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
<tr>
<td></td>
<td>&quot;normalization&quot;: {&quot;type&quot;: &quot;GLOBAL.LOCATION&quot;, &quot;value&quot;: &quot;Santa Clara&quot;}</td>
</tr>
</tbody>
</table>

GLOBAL.PERSON system entity

This entity returns a name string.

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>String value.</td>
</tr>
<tr>
<td>Regular expression</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Input example</td>
<td>Joe Smith works in Santa Clara.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>Joe Smith</td>
</tr>
</tbody>
</table>
GLOBAL.MONEY system entity

This entity returns a currency string.

GLOBAL.MONEY usage

<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>String value.</td>
</tr>
<tr>
<td>Regular expression</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Input example</td>
<td>Show me laptops for less than $2000.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>USD 2000</td>
</tr>
</tbody>
</table>

⚠️ Note: The normalized value uses the three-letter ISO 3166 country code of the source currency.

GLOBAL.NUMBER system entity

This entity returns a number.
<table>
<thead>
<tr>
<th>Usage</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>String value.</td>
</tr>
<tr>
<td>Regular expression</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Input example</td>
<td>I want to see the previous 5 transactions from my account.</td>
</tr>
<tr>
<td>Normalized value</td>
<td>5.0</td>
</tr>
<tr>
<td>Code example</td>
<td>`{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;entity:GLOBAL.NUMBER&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;value&quot;: &quot;...&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;score&quot;: 1.0,</td>
</tr>
<tr>
<td></td>
<td>&quot;normalization&quot;: {&quot;numericValue&quot;:&quot;5&quot;, &quot;normalizedValue&quot;: &quot;5&quot;} }</td>
</tr>
</tbody>
</table>

### Example NLU prediction result using system entities

```json
{
    "utterance": "We should meet next Sunday at Starbucks.",
    "intents": [
        {
            "intentName": "intent:Desire.Desire",
            "score": 0.83452,
            "entities": []
        },
        {
            "intentName": "intent:Meeting.MeetRequest",
            "score": 0.8919042,
            "entities": [
                {
                    "entityName": "entity:Meeting.MeetRequest.Where",
                    "value": "Starbucks",
                    "score": 1
                },
                {
                    "entityName": "entity:GLOBAL.DATE",
                    "value": "Sunday",
                    "normalization": { "type": "DATE",
                                        "subType": "DAY",
                                        "value": "1999-10-01" }
                }
            ],
            "score": 0.87
        }
    ]
}
```
Virtual Agent Lite

Virtual Agent Lite is a limited version of Virtual Agent that is available to ITSM standard customers.

About Virtual Agent Lite

To use Virtual Agent Lite, you must also install ITSM Virtual Agent Conversation Topics Lite, which provides several pre-built conversations for common IT support requests. These keyword-based conversations run in the web chat client and also in the Virtual Agent messaging integrations for the following channels:

- Slack
- Microsoft Teams
- Workplace by Facebook
- Facebook Messenger

How Virtual Agent Lite works

With Virtual Agent Lite and ITSM Virtual Agent Conversations Lite, you can implement a virtual agent that provides IT service assistance using several pre-built ITSM conversations. As with Virtual Agent, you set up and configure the chat clients for your end users. Use Virtual Agent Designer to review, duplicate, and publish the predefined conversation topics for your end users.

For Rome, the Virtual Agent Designer features available in Virtual Agent Lite include:

- Localization Framework integration.
  The Localization Framework is used in multi-language topic authoring and translations. The Localization Framework is installed automatically with Virtual Agent. Activate the ServiceNow® plugin for each language you want to support. For more information, see Activate a language.

  For Virtual Agent Lite, information in the Languages tab is read-only.

- Control topic discovery and visibility.
  The Active option of the header includes two options (toggle switches). Admins and topic authors can use these options to do one or both of the following:
Enable Virtual Agent to discover topics for use in chats.

Include a topic in the All Topics menu. This menu lists all of the topics that are available for use.

For more information about using these options, see Control topic discovery and visibility.

Some Virtual Agent features may have limited functionality in Virtual Agent Lite, be read-only, or be unavailable:

- In Virtual Agent Designer you can’t create topics or other items such as topic blocks and custom controls. A lock icon displays next to the Virtual Agent Designer features (fields) that are not available in Virtual Agent Lite.
- The Virtual Agent Analytics Dashboard isn’t available in Virtual Agent Lite

After you’ve used Virtual Agent Lite, you can upgrade to Virtual Agent to access all of the features. Contact your ServiceNow account representative for upgrade information.

**Virtual Agent Lite limitations**

Virtual Agent Lite has the following limitations:

- Keyword-based conversations: Only keyword-based conversations run in Virtual Agent Lite. Natural Language Understanding (NLU) models and NLU-enabled topics aren’t supported. This means that related NLU features, such as topic switching and multi-language NLU models, are also not supported. Language support is available for conversations through Now Platform language internationalization.
- Virtual Agent tables: You (admin or virtual_agent_admin) have read-only access to Virtual Agent tables.
- Topic types: Only ITSM Virtual Agent Lite conversation topics in the ITSM self-service category (including related topic blocks) and the platform setup topics run in Virtual Agent Lite. You can’t create new topics, topic blocks, or custom controls. You also can’t:
  - Specify the conditions that control how or when the topics are used.
  - Specify the Live Agent (chat) variables that provide context for conversations.
  - Enable the Available for Agent Autopilot toggle switch.
- Localized content: Translated content is read-only. You can’t add new translations or localize content. The Languages tab displays a banner asking users to contact their Account Executive for more information about upgrading to the latest release.
• Custom channels: Virtual Agent Lite topics can't be run in any custom chat channels (created through custom chat integrations), outside of the supported Virtual Agent integrations for Slack, Microsoft Teams, Workplace by Facebook, and Facebook Messenger applications.

• Virtual Agent notifications: You can receive only simple and non-actionable notifications. Actionable notifications are not supported with Virtual Agent Lite (com.glide.cs.chatbot.lite).

Setting up Virtual Agent Lite

To enable Virtual Agent Lite, you must have the virtual_agent_admin or admin role. If you're using the Virtual Agent integrations for the Slack, Microsoft Teams, Workplace, or Facebook Messenger apps, you must also be an administrator for those messaging apps.

Follow these steps to configure and implement Virtual Agent Lite:

1. Activate the plugins for Virtual Agent Lite and ITSM Virtual Agent Conversation Topics Lite

   • Virtual Agent Lite (com.glide.cs.chatbot.lite): Installs the tables, properties, and other items needed for running Virtual Agent Lite. Also installs the read-only setup topics included in the conversation framework applied to all Virtual Agent conversations.

   • ITSM Virtual Agent Conversation Topics Lite (com.snc.itsm.virtualagent.lite): Installs the read-only predefined conversations for ITSM self-service use cases.

2. Set up your chat clients

   • Agent Chat (Service Portal) configuration: Define the configuration for running the Service Portal chat client (Agent Chat) in your service portals.

   • Virtual Agent messaging integrations: If you're using a messaging application, install the integration app for Slack, Microsoft Teams, or Workplace. An integration is also available for the consumer messaging app, Facebook Messenger.

3. Set up the chat interface

   Configure the chat branding and chat menu to set up the web chat client.

4. Review and select your conversation settings
Review the pre-built setup topics, common conversational elements such as the conversation greeting or closing, that are part of a conversation structure (in a chat experience) applied to all your conversations. You can select additional setup topics or customize them if needed.

5. Preview (test), duplicate, and publish ITSM Virtual Agent conversation topics

Use Virtual Agent Designer to preview (test), duplicate, and publish the ITSM Virtual Agent Lite conversations. Since the prebuilt conversations are read-only, you duplicate and publish the topics to deploy them to your chat clients.

- Test (preview) the ITSM Virtual Agent Lite topics
- Duplicate and publish the topics to make the conversations available to your end users.

To get started, activate the Virtual Agent Lite plugin.

Activate Virtual Agent Lite

You can activate the Glide Virtual Agent Lite plugin (com.glide.cs.chatbot.lite) if you have the admin role. This plugin activates a limited version of Virtual Agent.

Before you begin

Role required: admin

About this task

The Glide Virtual Agent Lite plugin activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugins activated by Glide Virtual Agent Lite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin</td>
</tr>
<tr>
<td>Glide Conversation Server</td>
</tr>
<tr>
<td>[com.glide.cs]</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
## Plugins activated by Glide Virtual Agent Lite (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Glide Conversation Server Adapters [com.glide.cs.adapter] | Activates Virtual Agent features that support pre-built, third-party messaging applications. Also installs:  
  - Glide Conversation Server [com.glide.cs]  
  - Channel Proxy [com.glide.channelproxy] - Maps third-party collaboration channels to the appropriate ServiceNow instance.  
  - Service Now Conversation Server Admin UI [com.snc.bot_install_ui] - Enables the user interface for integrating ServiceNow Virtual Agent with third-party messaging apps  
  - Virtual Agent integration with notifications |
### Plugins activated by Glide Virtual Agent Lite (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[com.glide.cs.notification]</strong> - Enables notifications on Virtual Agent chat channels.</td>
<td></td>
</tr>
<tr>
<td><strong>Conversational Custom Chat Integration</strong></td>
<td>Enables the custom chat integration framework for connecting to third-party messaging applications that are not natively supported by Virtual Agent.</td>
</tr>
<tr>
<td><strong>[com.glide.cs.settings]</strong></td>
<td>Enables admins to set the basic characteristics of Virtual Agent conversations.</td>
</tr>
<tr>
<td><strong>Virtual Agent Platform Topics</strong></td>
<td>Installs core conversation topics that support Virtual Agent platform conversation flows.</td>
</tr>
<tr>
<td><strong>[com.glide.cs.topics]</strong></td>
<td>Enables Service Portal Agent Chat configurations that let users run Virtual Agent or Live Agent on any page in selected service portals.</td>
</tr>
<tr>
<td><strong>Virtual Agent Platform Topic Blocks</strong></td>
<td>Provides predefined topic blocks that support Virtual Agent platform conversation topics: Transfer to Live Agent, Survey, FAQ Conversation Builder, AI Search, and Agent Availability.</td>
</tr>
<tr>
<td><strong>[com.glide.cs.topic_blocks]</strong></td>
<td>Activates Virtual Agent Designer for building conversation flows.</td>
</tr>
<tr>
<td><strong>Virtual Agent Designer</strong></td>
<td>Provides the AI Search configuration for Virtual Agent.</td>
</tr>
<tr>
<td><strong>[com.glide.cs.notification]</strong></td>
<td>Provides the default Entity View Action Mapper (EVAM) configuration for Virtual Agent.</td>
</tr>
<tr>
<td><strong>Entity View Action Mapper</strong></td>
<td>Provides the framework for Virtual Agent translations.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Plugins activated by Glide Virtual Agent Lite (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Translated text is read-only in Virtual Agent Lite.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Results
Virtual Agent Lite installs the roles, users, tables, and properties needed to use the limited version of Virtual Agent and to run ITSM Virtual Agent Lite conversations. Note some of the key differences from the items installed with Virtual Agent (Glide Virtual Agent plugin):

- Virtual Agent Designer is limited to testing, duplicating, and publishing the prebuilt ITSM Virtual Agent Lite topics and the platform setup topics.
- The Topic [sys_cb_topic] and [sys_cs_topic] tables are read-only, since you can duplicate topics but not modify them.
- Open NLU tables are not installed as Natural Language Understanding is not supported in Virtual Agent Lite.
- If a language is installed on the instance, you can view translated content in Virtual Agent Designer, but you cannot edit it.

What to do next
Activate the ITSM Virtual Agent Lite plugin (com.glide.cs.chatbot.lite) to access the ITSM Virtual Agent Lite topics.
Related reference

List of plugins (Rome)

Preview Virtual Agent Lite topics

Review (test) a pre-built ITSM Virtual Agent Lite topic to decide whether you want to deploy it to your end users.

Before you begin

• Activate the plugins for Virtual Agent Lite (com.glide.cs.chatbot.lite) and ITSM Virtual Agent Conversation Topics Lite (com.snc.itsm.virtualagent.lite) plugins.
• Role required: virtual_agent_admin or admin

Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Designer.
2. In the Category filter, select ITSM Self Service Lite to list the ITSM Virtual Agent Lite conversations.
   Two pre-built topics are available: Check Ticket Status and Report an Issue.
3. Click the topic that you want to preview.
   In the Flow tab, the Virtual Agent Designer canvas opens with a read-only view of the topic flow. You can resize the canvas to see the nodes in the flow. But you can’t add or change controls and their associated property sheets.

4. Click Test to run the conversation in a test chat window.
   For example, if you’re testing the Check Ticket Status topic, the test chat window runs the conversation and lets you respond to the prompts displayed.
   You can also view the test logs to see the messages logged and conversation
tasks performed during the conversation, as well as the variables used in the conversation.

What to do next
If you’d like to deploy a topic, duplicate and publish the topic so that it is available to your users.

Duplicate and publish Virtual Agent Lite topics
Copy and publish a pre-built ITSM Virtual Agent Lite topic to deploy it to your users.

Before you begin
• Preview (test) the prebuilt ITSM Virtual Agent Lite topics
• Role required: virtual_agent_admin or admin
Procedure

1. In the topic that you’ve tested, click **Duplicate** in the Virtual Agent Designer header bar.
   
   a. In the pop-up window, enter the name of your duplicated topic.
   
   b. Click **Save**.

   The **Topic Properties** page (**Properties** tab) for your duplicated topic opens.

   **Note:** You can duplicate a pre-built topic up to four times. But you can’t duplicate a copy of a pre-built topic.

2. Change these property fields as needed:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A brief explanation of the topic.</td>
</tr>
<tr>
<td>Keywords</td>
<td>A word or phrase that is associated with and activates the topic. You can add, change, or delete keywords.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles that an end user must have to view and run the topic. If a topic is public (available to users, including guest users, who are not authenticated in ServiceNow), select only the Public role.</td>
</tr>
</tbody>
</table>

3. Click **Save** and then **Publish** to make the topic active and available in your chat clients.

Results

When your users run Virtual Agent, the chat client displays the published topics in the topic selection menu. If there are three or less topics available to the user, the menu items (topics) are displayed as buttons.

For example, in the Microsoft Teams integration, the topic selection menu displays these three topics as buttons.
Domain separation and Virtual Agent

Domain separation is supported in the Virtual Agent application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Overview

Domain separation is best for customers with any of the following requirements:

- You need to enforce absolute data segregation between business entities (data separation).
- Customize business process definitions and user interfaces for each domain (delegated administration).
- Maintain some global processes and global reporting in a single instance.
• Separate data between customers or sub-organizations.

• The session scope is set upon session establishment to the domain listed in the user's user record. Users can manually change their session domain scope with the domain picker.

• The record scope uses the domain of the record and is active when viewing the form of any record.

By default, the record scope takes precedence over the session scope so that users in higher-level domains adhere to each record’s data and process constraints. However, these users can choose to expand or collapse the domain scope to show or hide data from other domains. For example, a user in the service provider (SP) global domain also has visibility into child domains such as the ACME domain. When looking at an incident record from the ACME domain, the user can choose to expand the domain scope to show values from the MSP domain or collapse the domain scope to show only record values that match the record’s ACME domain.

⚠️ **Note:** Users always have access to data from domains that have been explicitly granted to them by domain visibility.

Users with the `domain_expand_scope` user role can select the domain scope from the **Toggle Domain Scope** UI action on the form. When record scope is in effect, clicking the UI action expands the session scope and displays all data available associated with the user's domain and child domain.

### Chat setup for Virtual Agent

A Service Provider (SP) has one chat setup record in the global domain when the instance is provisioned.

Roles required: ITIL, `virtual_agent_admin`, or `admin`

1. **Admin** or `virtual_agent_admin` in a subdomain logs in and navigates to **Conversational Interfaces > Chat Setup** and selects the fulfiller interface for live chat, either `Connect Support` or `Agent Workspace`.

2. When a user logs in to each subdomain, a seeded chat setup record (Live Agent) is created.

**Prerequisites**
1. The admin or virtual_agent_admin logged into the subdomain, sets the queues and related parameters, such as assignment groups, in the fulfiller interface used, either Connect Support or Agent Workspace.

If Agent Workspace is the fulfiller interface, admins configure the queues for the Chat service channel in Advanced Work Assignment.

2. The admin logged in to the subdomain navigates to Conversational Interfaces > Chat Setup.

For details on completing Chat Setup, see Configure live agent chat.

Chat branding setup for Virtual Agent

Service providers can create a chat branding configuration per domain.

NLU settings setup for Virtual Agent

Only one NLU service provider can be set per domain-separated instance for all Virtual Agent clients. The MSP navigates to Conversational Interfaces > Virtual Agent > General Settings for the global domain, and logs in as a global user in this domain.

Roles required: ITIL, virtual_agent_admin, or admin

In the NLU Settings tab, the MSP enables Natural Language Understanding (NLU) for the instance and selects the NLU service provider.

Chat experience setup for Virtual Agent

Chat experiences, including the default experience and any custom experiences, allow for domain separation. Each chat experience profile belongs to a domain. Each child customization, such as a setup topic change, belongs to a domain. Each child customization implements system overrides so that sub-domains can override parent-domain customizations.

Setup for Virtual Agent Designer

The Service Provider either logs in to one of the subdomains and creates and publishes topics or allows subdomain admin users to create and deploy their own topics.

Roles required: ITIL or virtual_agent_admin

1. The admin user, logged in to the subdomain, navigates to Conversational Interfaces > Virtual Agent > Designer to create and publish (deploy) topics to the instance.

The user can be in a global domain who impersonates a user in a subdomain or an admin user logged in to the subdomain.
2. Service provider admin only: The admin can also activate the Virtual Agent conversation plugins or store apps for other ServiceNow business applications, such as ITSM, CSM, or HRSD, to enable pre-built topics for the subdomain.

3. If using roles to control which topics can be run by users, the admin assigns roles on a particular subdomain.

4. The admin publishes all the topics available to web clients and messaging applications.

**Virtual Agent setup of messaging app integrations**

The domain-separated instance has one setup record for Slack, Microsoft Teams, Workplace, or Facebook Messenger.

**Roles required:** admin, ITIL, or virtual_agent_admin

1. Customers on the subdomain license either Slack, Microsoft Teams, or Workplace independently of the ServiceNow instance.

2. The admin in the subdomain logs in and navigates to Conversational Interfaces > Virtual Agent > Messaging Apps Integration to install the integrations and set the appropriate credentials to access the virtual agent from the third-party client. For Facebook Messenger, the admin manually configures the integration.

**Related information**

- Domain separation for service providers

**Virtual Agent scripts**

If you are an admin or Virtual Agent admin, you can use scripts to customize the behavior of Virtual Agent topics.

Virtual Agent scripts can provide context for topics, such as retaining information about a user or a user’s input. You can use this information to personalize a conversation, such as to present a scripted greeting or confirmation. Scripts can also specify certain actions to be performed on information that was obtained during a conversation. These actions can be creating or updating ServiceNow records.

Scripts run on the server in the scope in which a topic is defined. All scope protections apply. If you are developing a conversation for a scoped application, you must use the scoped API. You can use most APIs that run in server scripts.
User input and ServiceNow record variables

In Virtual Agent, the following variables are available for use in scripts that you create for a topic.

User input variables

When you add an input control to a topic, the system automatically creates a variable to store the user input (a string, boolean value, etc.). The syntax is `vaInputs.myvar` where `myvar` is the name you assigned to the input node.

For example, a text input prompt with the name `First prompt` has a system-defined variable called `vaInputs.first_prompt`. Spaces in the name are replaced with an underscore character, and uppercase characters are changed to lowercase.

ServiceNow record variables

If you create a script for a topic that queries a ServiceNow table, then the record object (GlideRecord) returned is automatically available for use in the topic. The variable syntax is `vaInputs.myvar` where `myvar` is the record object. For details on querying ServiceNow tables to return a record object, see Querying tables in script.

Use dot-walking in variables that contain a ServiceNow record to specify a particular field in the table. The syntax is `vaInputs.myvar.field`. For details on dot-walking within a script, see Dot-walking examples.

Accessing user input and ServiceNow record variables

Use `vaInputs` objects to access ServiceNow record variables in scripts. For example, the `vaInputs.myvar == "expected value"`. To access values from user inputs that are not records, use `vaInputs.myvar.getValue()`.

The following methods are available.

<table>
<thead>
<tr>
<th>vaInputs methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>vaInputs.myvar == &quot;expected value&quot;</code></td>
<td>Evaluates whether <code>myvar</code> matches an expected value.</td>
</tr>
</tbody>
</table>

⚠️ Note: Values for user input variables are assigned using user input controls. These values cannot be changed in your script.
## vaInputs methods (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vaInputs.myvar.getValue();</td>
<td>Returns the value.</td>
</tr>
<tr>
<td>vaInputs.myvar.getDisplayValue();</td>
<td>Returns the display value if the stored value is not a ServiceNow record. For variables that contain ServiceNow records, this method returns the display value, as defined by the display field for that table. The following example shows the label and choice values for a user input. In this case, <code>myVar.getValue()</code> would return a value of 10, 20, or 30, while <code>myVar.getDisplayValue()</code> would return Apple, Orange, or Pear.</td>
</tr>
<tr>
<td>vaInputs.myvar.getDefaultValue();</td>
<td>Returns the default value in a confirmation message.</td>
</tr>
<tr>
<td>vaInputs.myvar.getDefaultDisplayValue();</td>
<td>Returns the display value for the default value in a confirmation message.</td>
</tr>
<tr>
<td>vaInputs.myvar.unbindEntity();</td>
<td>Removes the value of input variables that the NLU prediction service slot-filled with extracted entities (unbinds it from the initial input value). For example, if the user decides to change their choice on a confirmation prompt, you can...</td>
</tr>
</tbody>
</table>
valInputs methods (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>unbind the entity's value from the input variable. The user will then be prompted again when they loop back to the corresponding input node.</td>
</tr>
</tbody>
</table>

Note: NLU must be enabled on the topic. In the Virtual Agent Designer, click the Properties tab to set up NLU. For information about defining NLU entities, see Annotating entities.

Script variables

You can define script variables for information that is not stored in ServiceNow tables but that can be used to share that information elsewhere in a topic. Script variables are similar to workflow scratchpad variables that store primitives such as integers, Boolean values, or strings. A string value can be either a static or dynamic scripted value. Use the Variables sidebar to define script variables for a topic in Virtual Agent Designer.

Variables sidebar

Utilities
- Lookup
- Script Action
- Record Action
- Decision
- Topic Block
- Custom Control
- Action
- Pause

Variables
- Input
- Script

Note: Script variables are intended for use by topic authors with advanced scripting skills.
The variable syntax is `vaVars.myvar`, where `myvar` is the name you assign to the variable. For example, you can assign a value to the variable using `vaVars.myvar = value;`. Unlike user input variables, script variables can be assigned values in a script.

For information about defining a script variable in a topic, see Define script variables for a topic.

**Live Agent variables**

A number of Live Agent variables are available for use in topic scripts. These variables include the following:

- application
- language
- portal
- search_text
- short_description

The variable syntax is `vaVars.LiveAgent_myvar`, where `myvar` is one of the available Live Agent variables specified in Chat setup. Access the variable using `vaVars.LiveAgent_myvar = value;`.

To use Live Agent variables in topic scripts, open the topic in Virtual Agent Designer. In the Properties tab, click the edit icon (📝) next to **Live Agent Variables** to add them to the topic.

For information about live agent context variables that are included with Virtual Agent, see Live Agent chat context variables.

**Context variables**

You can use variables in system parameters within the web client URL. These variables can be used anywhere in the conversation using the `vaContext` object. Use these options to create links to Virtual Agent with predefined variables.

The following example link contains a parameter, `sysparm_city=milan`. In addition to opening a Virtual Agent conversation, using this link creates a variable called `city` with a value of `milan`. This variable can be accessed in a script using `vaContext.city`.

```
```

**vaSystem methods**

You can use methods in the `vaSystem` object to do various tasks. These tasks include the following:
• Attach images to records.
• Access the search string that was used to find the current topic.
• Verify that a live agent is available to receive a conversation.
• Connect the user to a live agent.

Methods used in Virtual Agent topic scripts

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vaSystem.attachRecordToConversation(String tableName, String sysId)</td>
<td>Attach ServiceNow records to the Related Tasks list in a Virtual Agent interaction record. These records are updated or created during a Virtual Agent conversation.</td>
</tr>
<tr>
<td>vaSystem.attachToRecord(String mediaId, String tableName, String sysId)</td>
<td>Attach an uploaded image to a ServiceNow record. The method uses the following parameters:</td>
</tr>
<tr>
<td>vaSystem.getSearchText()</td>
<td>Returns the last utterance typed by the user. The X is used to find the current topic.</td>
</tr>
<tr>
<td>vaSystem.isLiveAgentAvailable()</td>
<td>Checks whether a live agent is available to receive a conversation that is transferred from the bot. To transfer a conversation to a live agent, call this method before using vaSystem.connectToAgent().</td>
</tr>
<tr>
<td>vaSystem.connectToAgent()</td>
<td>Connects the customer to a live agent. For more information on</td>
</tr>
</tbody>
</table>
Methods used in Virtual Agent topic scripts (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vaSystem.switchTopicByName()</td>
<td>Enables the user to jump from the current conversation topic to the specified topic name. The X button is available, so that the user can end the conversation. After the topic ends, the user resumes the global topic. When the conversation ends, the user can click to restart.</td>
</tr>
<tr>
<td>vaSystem.switchTopicById()</td>
<td>Enables the user to jump from the current conversation topic to the specified topic ID. The X button is available, so that the user can end the conversation. After the topic ends, the user resumes the global topic. When the conversation ends, the user can click to restart.</td>
</tr>
</tbody>
</table>

Method that can be used outside Virtual Agent topics

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cs.VASystemObject.getTranscriptById(&lt;conversation sysId&gt;)</td>
<td>Gets the transcript for the current Virtual Agent conversation.</td>
</tr>
</tbody>
</table>

Configuring Virtual Agent

Configure the Virtual Agent features, components, and integrations that you need to provide support to your employees, IT teams, and customers.

Planning for and setting up Virtual Agent

Walk through the steps for configuring your instance with Virtual Agent, Workspace Agent Chat (Live Agent), or both. To streamline the configuration process, your setup instructions are customized based on the entitlements for the ServiceNow business applications that you’re using. To implement Virtual Agent,
complete the configuration steps in the Conversational Interfaces Guided Setup.

**Before you begin**
Role required: admin

**About this task**
The Conversational Interfaces Guided Setup provides you with a personalized list of configuration instructions for setting up Virtual Agent, Live Agent (Workspace Agent Chat) and Advanced Work Assignment, along with other related business applications that you may be using, such as HR Service Delivery or ITSM Virtual Agent.

During setup you select the type of agents to be configured and the type of setup that you prefer (Quick or Manual). The Guided Setup process then checks your product entitlements and generates the appropriate setup tasks.

Your tasks are organized by categories that consist of various setup activities, such as activating required plugins or configuring your chat clients. For basic information on Guided Setup, see Using Guided Setup.

**Procedure**

1. Navigate to **Conversational Interfaces > Conversational Interfaces Guided Setup**.
2. Review the sections Getting started and Things to consider for setup, which provide information on the setup process and highlight various items to think about before implementing Virtual Agent, Agent Chat, or both. Also consider whether you want to run Quick setup to get your agents running in as little as 30 minutes, in a minimal number of steps. Manual setup involves a comprehensive series of steps to fully set up your agents and may take a couple of hours or several days to complete, based on your configuration.
3. Select **Get Started**.
4. In Customize your setup, select **Get Started** and then **Configure** to start your personalized setup.
   You then select the type of agents that you want to set up and the type of setup (Quick or Manual).
5. Click **Continue** and complete the subsequent setup tasks.

**What to do next**
Once you’ve completed the setup tasks, you and your topic authors can explore the functionality provided with Agent Chat, such as reviewing pre-built conversations and creating or updating topics for your end users.
Activate Virtual Agent

You can activate the Glide Virtual Agent plugin (com.glide.cs.chatbot) if you have the admin role. This plugin automatically activates other necessary plugins if they are not already active.

Before you begin
Role required: admin

About this task
You must have a subscription for Virtual Agent before you can activate the Glide Virtual Agent plugin.

Plugins automatically installed with Glide Virtual Agent

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glide Virtual Agent Lite [com.glide.cs.chatbot.lite]</td>
<td>Activates all the plugins and related plugins included with the lite version of the Virtual Agent bot platform. To see the list of related plugins installed, see Activate Virtual Agent Lite.</td>
</tr>
<tr>
<td>NLU Model for Virtual Agent Setup Topics [com.glide.cs.nlu.topics]</td>
<td>Installs the NLU model for Virtual Agent Setup topics.</td>
</tr>
</tbody>
</table>
| Proxy Agent to the ServiceNow Natural Language Understanding Server [com.glide.nlu.intent.discovery] | Activates the connection to the ServiceNow NLU server for NLU intent discovery. Used by Virtual Agent and other clients. Activates:  
- NLU Workbench - Core [com.glide.nlu]  
- Predictive Intelligence [com.glide.platform_ml]  
- Proxy agent for connecting to NLU providers [com.glide.nlu.proxy] - Proxy agent for connecting to NLU providers |
| Proxy Agent to the IBM Watson Natural Language Understanding server | Activates the IBM Watson Assistant Intent and Entity integration, which enables Virtual |
## Plugins automatically installed with Glide Virtual Agent (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[com.glide.nlu.ibmwatson.intent.discovery]</td>
<td>Agent to use intents, entities, and utterances defined in IBM Watson Assistant.</td>
</tr>
<tr>
<td>Proxy Agent to the Microsoft LUIS Natural Language Understanding server [com.glide.nlu.msluis.intent.discovery]</td>
<td>Activates the Microsoft LUIS integration, which enables Virtual Agent to use intents, entities, and utterances defined in the Microsoft Language Understanding Intelligent Service (LUIS).</td>
</tr>
<tr>
<td>Virtual Agent integration with actionable notifications com.glide.cs.actionable.notification</td>
<td>Enables ServiceNow actionable notifications on Virtual Agent channels.</td>
</tr>
</tbody>
</table>

### Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

### What to do next

Activate additional Virtual Agent plugins for related features, such as the plugins for predefined Virtual Agent topics.
Installed with Virtual Agent

Various types of components are installed with activation of the Glide Virtual Agent [com.glide.cs.chatbot] plugin, including tables and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Agent administrator [virtual_agent_admin]</td>
<td>Users who can create and manage topics (bot conversations) using Virtual Agent Designer.</td>
</tr>
<tr>
<td></td>
<td>• If using Natural Language Understanding, includes the NLU admin role.</td>
</tr>
<tr>
<td></td>
<td>• If the Virtual Agent admin is granted access to AI Search-related tables, includes the search application administrator role [search_application_admin].</td>
</tr>
<tr>
<td></td>
<td>• If the Virtual Agent admin is granted access to Entity View Action Mapper tables, includes the EVAM admin role [evam_admin].</td>
</tr>
<tr>
<td></td>
<td>• For multilanguage support, includes the localization_requestor role by default. For more information, see Localization Framework roles.</td>
</tr>
<tr>
<td>External App Install admin [external_app_install_admin]</td>
<td>Users who can install external apps such as Slack, Microsoft Teams, and Workplace.</td>
</tr>
</tbody>
</table>

Users installed

The Glide Conversation Server plugin (com.glide.cs) automatically installs a virtual agent user (virtual.agent) in the User [sys_user] table. Ongoing Virtual Agent interactions are assigned to this virtual agent user. If you’re using Advanced Work Assignment (AWA), interactions assigned to the virtual agent user are not routed by AWA. The virtual agent user is also used in the default web chat branding settings to associate a virtual agent user profile with a bot avatar.
# Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter Configurations</td>
<td>Stores records for default keywords, labels, and message values for third-party messaging integrations.</td>
</tr>
<tr>
<td>[sys_cs_adapter_configuration]</td>
<td></td>
</tr>
<tr>
<td>Adapter Configuration Page</td>
<td>Stores the configuration for third-party messaging integrations. This table is the root table for:</td>
</tr>
<tr>
<td>[sys_cs_adapter_configuration_page]</td>
<td>• Configurations - Slack Integration [sys_cs_adapter_configuration_page_slack]</td>
</tr>
<tr>
<td></td>
<td>• Configurations - Teams Integration [sys_cs_adapter_configuration_page_teams]</td>
</tr>
<tr>
<td></td>
<td>• Configurations - Workplace Integration [sys_cs_adapter_configuration_page_workplace]</td>
</tr>
<tr>
<td></td>
<td>• Configurations - Facebook Messenger Integration [sys_cs_adapter_configuration_page_messenger]</td>
</tr>
<tr>
<td>Adapter Message</td>
<td>Stores adapter messages.</td>
</tr>
<tr>
<td>[sys_cs_adapter_message]</td>
<td></td>
</tr>
<tr>
<td>Brandings</td>
<td>Stores different branding configurations for the web-based chat client used in an instance.</td>
</tr>
<tr>
<td>[sys_cs_branding_setup]</td>
<td></td>
</tr>
<tr>
<td>Client Adapter</td>
<td>Stores each adapter state.</td>
</tr>
<tr>
<td>[sys_cs_client_adapter]</td>
<td></td>
</tr>
<tr>
<td>Consumer Channel</td>
<td>Stores consumer channel information.</td>
</tr>
<tr>
<td>[sys_cs_consumer_channel]</td>
<td></td>
</tr>
<tr>
<td>Consumer Device Context</td>
<td>Stores consumer device context information.</td>
</tr>
<tr>
<td>[sys_cs_consumer_device_context]</td>
<td></td>
</tr>
<tr>
<td>Context Topics</td>
<td>Stores different configurations for determining the appropriate conversation topic displayed to end</td>
</tr>
<tr>
<td>[sys_cs_context_topic]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Conversation [sys_cs_conversation]</td>
<td>Stores a record for each conversation on the instance. Each record includes the Conversation Task [sys_cs_conversation_task] and Conversation Message [sys_cs_message] related lists, which show all the topics run and associated messages presented in the conversation.</td>
</tr>
<tr>
<td>Conversation Consumer [sys_cs_consumer]</td>
<td>Stores a record representing the user in a conversation, and references the associated sys_user record for that user.</td>
</tr>
<tr>
<td>Conversation Server Field Script Validators [sys_cs_field_script_validator]</td>
<td>Stores text format validation rules and default error messages. Read-only.</td>
</tr>
<tr>
<td>Custom Controls [sys_cs_custom_control]</td>
<td>Identifies custom controls.</td>
</tr>
<tr>
<td>Custom Control Definitions [sys_cs_custom_control_definition]</td>
<td>Binds a client type (for example, web or mobile) to a custom control.</td>
</tr>
<tr>
<td>Conversation Media [sys_cs_media]</td>
<td>Media attached to conversations are stored in sys_attachment, and associated to this table.</td>
</tr>
<tr>
<td>Conversation Message [sys_cs_message]</td>
<td>Stores a record for each message in a conversation. Shows the messages displayed for each topic in the conversation flow.</td>
</tr>
<tr>
<td>Conversation Server Connect Handoff [sys_cs_connect_handoff]</td>
<td>Stores mapping of Virtual Agent conversations and Connect/Workspace conversations.</td>
</tr>
<tr>
<td>Conversation Session</td>
<td>Stores a record for each conversation.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>[sys_cs_session]</td>
<td>Stores a record for each conversation task. Each record shows the conversation flow, which can include multiple topics that are run during the conversation.</td>
</tr>
<tr>
<td>Conversation Task [sys_cs_conversation_task]</td>
<td>Stores history of conversation task execution.</td>
</tr>
<tr>
<td>Conversation Task FDIH Invocations [sys_cs_fdih_invocation]</td>
<td>Tracks the state of a call to a Flow Designer action or subflow in a conversation.</td>
</tr>
<tr>
<td>Conversation Task History [sys_cs_conversation_task_history]</td>
<td>Stores vendor information.</td>
</tr>
<tr>
<td>Conversation Vendor [sys_cs_vendor]</td>
<td>Stores third-party user information.</td>
</tr>
<tr>
<td>CS Consumer Account [sys_cs_consumer_account]</td>
<td>Stores a profile record for context-driven chat experiences. Contains customizations in the following child tables:</td>
</tr>
<tr>
<td>Custom Greetings and Setup [sys_cs_context_profile]</td>
<td>• Setup topics [sys_cs_context_profile_topic] - Stores the setup topics used for each setup topic type.</td>
</tr>
<tr>
<td></td>
<td>• Promoted topics [sys_cs_context_profile_promotion] - Stores the topics that are highlighted in the Virtual Agent client.</td>
</tr>
<tr>
<td></td>
<td>• Search Profiles [sys_cs_context_profile_search] - Stores the AI search profile for the associated chat experience.</td>
</tr>
<tr>
<td>Custom Controls [sys_cs_custom_control]</td>
<td>Stores the custom input and response controls.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom Control Definitions</td>
<td>Binds a client type (for example web chat client) to a custom control. Stores the channel, domain, and user interface component defined for a custom control.</td>
</tr>
<tr>
<td>[sys_cs_custom_control_definition]</td>
<td></td>
</tr>
<tr>
<td>General Settings</td>
<td>Stores the records for the NLU configuration.</td>
</tr>
<tr>
<td>[sys_cs_general_settings]</td>
<td></td>
</tr>
<tr>
<td>Live Agent Setup</td>
<td>Stores the Live Agent setup with queue information.</td>
</tr>
<tr>
<td>[sys_cs_live_agent_setup]</td>
<td></td>
</tr>
<tr>
<td>Live Agent Support Queue Cache</td>
<td>The database cache used for support queue wait times.</td>
</tr>
<tr>
<td>[sys_cs_support_queue_cache]</td>
<td></td>
</tr>
<tr>
<td>Open NLU Drivers</td>
<td>Stores the records of the NLU service providers used in the instance. Identifies the base system NLU provider and other services installed, such as IBM Watson NLU.</td>
</tr>
<tr>
<td>[open_nlu_driver]</td>
<td></td>
</tr>
<tr>
<td>Open NLU Driver Http Connections</td>
<td>Stores all the HTTP connection references for the NLU service provider.</td>
</tr>
<tr>
<td>[open_nlu_driver_http_connection]</td>
<td></td>
</tr>
<tr>
<td>Open NLU Driver Languages</td>
<td>Lists the language codes for the NLU service providers (ServiceNow NLU, IBM Watson Assistant, and MS LUIS). Identifies the driver codes and associated languages.</td>
</tr>
<tr>
<td>[open_nlu_driver_language]</td>
<td></td>
</tr>
<tr>
<td>Open NLU Predict Entity Feedbacks</td>
<td>Stores the disposition taken by an application in response to an NLU entity prediction result. For example, in Virtual Agent the goal is to map a predicted NLU entity to an input variable in a Virtual Agent topic.</td>
</tr>
<tr>
<td>[open_nlu_predict_entity_feedback]</td>
<td></td>
</tr>
<tr>
<td>Open NLU Predict Intent Feedbacks</td>
<td>Stores the disposition taken by an application in response to an NLU intent prediction result. For example, in Virtual Agent the goal is to map a predicted NLU entity to an input variable in a Virtual Agent topic.</td>
</tr>
<tr>
<td>[open_nlu_predict_intent_feedback]</td>
<td></td>
</tr>
</tbody>
</table>
Table | Description
--- | ---
Published Topic  
[sys_cb_design_topic] | Stores design topic definitions and references the runtime topic.
Session Binding  
[sys_cs_session_binding] | Stores session binding and AMB channel information.
Configurations - Slack Integration  
[sys_cs_adapter_configuration_page_slack] | Extends the sys_cs_adapter_configuration_page table. Stores the configuration for the Slack messaging application.
Configurations - Facebook Messenger Integration  
[sys_cs_adapter_configuration_page_messenger] | Extends the sys_cs_adapter_configuration_page table. Stores the configuration for the Facebook Messenger messaging application.
Teams Adapter Configuration Page  
[sys_cs_adapter_configuration_page_teams] | Extends the sys_cs_adapter_configuration_page table. Stores the adapter configuration for the Microsoft Teams messaging application.
Workplace Adapter Configuration Page  
[sys_cs_adapter_configuration_page_workplace] | Extends the sys_cs_adapter_configuration_page table. Stores the adapter configuration for the Workplace messaging application.
Vendor Client Adapter Configuration  
[sys_cs_vendor_client_adapter_configuration] | Stores the adapter configuration for third-party messaging applications.
Topic  
[sys_cb_topic] | Stores a record for each topic (design-time definition).
Topic  
[sys_cs_topic] | Stores an instance of a topic from sys_cb_topic at run time. Records on this table are cleaned every 12 hours.
Table | Description
---|---
Topic Category [sys_cb_topic_category] | Stores all the categories that identify the different types of topics, such as setup topics and small talk topics. Also includes custom categories defined by admins.

Topic Library Usages [sys_cs_topic_library_usage] | Stores references to published topic blocks.

Vendor Context Configuration [sys_cs_vendor_context_configuration] | Stores vendor-specific device context information.

Virtual Agent Context [sys_cs_virtual_agent_context] | Stores Virtual Agent context variables.

Properties installed

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.cs.branding.msg_delay</td>
<td>Minimum delay between bot messages</td>
</tr>
<tr>
<td>com.glide.cs.branding.type_presence_delay</td>
<td>Minimum delay before displaying typing animation</td>
</tr>
<tr>
<td>com.glide.cs.conversation_faulted_reason</td>
<td>Message that displays the following default message when a conversation has faulted: It seems that you have left the conversation.</td>
</tr>
<tr>
<td>com.glide.cs.general.error_message</td>
<td>Generic error message</td>
</tr>
<tr>
<td>com.glide.cs.general.live_agent_handoff_error_message</td>
<td>Error message when no live agent has been set up</td>
</tr>
<tr>
<td>com.glide.cs.general.live_agent_handoff_message</td>
<td>Message to display when handing over to a live agent</td>
</tr>
<tr>
<td>com.glide.cs.general.support_email</td>
<td>General support email</td>
</tr>
<tr>
<td>com.glide.cs.general.support_hours</td>
<td>General support hours</td>
</tr>
</tbody>
</table>
Additional plugins for Virtual Agent

After activating Virtual Agent, you can activate additional plugins to enable other features for conversation design.

You must have the admin role to activate these additional plugins. For details, see Activate a plugin.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Human Resources Scoped App: Virtual Agent Conversations</td>
<td></td>
</tr>
<tr>
<td>[com.sn_hr_virtual_agent]</td>
<td></td>
</tr>
<tr>
<td>• ITSM Virtual Agent conversations [sn_itsm_va] and ITSM NLU Model</td>
<td>• Requires the Glide Virtual Agent (com.glide.cs.chatbot) plugin to be activated.</td>
</tr>
<tr>
<td>for Virtual Agent Conversations [sn_itsm_nlu] through the ServiceNow</td>
<td>• Automatically activates the NLU Workbench (com.snc.nlu_studio) plugin.</td>
</tr>
<tr>
<td>Store</td>
<td>• Automatically activates the Service Management Virtual Agent Topic Blocks (com.glideapp.cs.sm_topic_blocks) plugin. Includes common topic blocks such as contextual search.</td>
</tr>
<tr>
<td>NLU Workbench [com.snc.nlu_studio]</td>
<td>Enables the creation of custom ServiceNow Natural Language Understanding (NLU) models used by Virtual Agent.</td>
</tr>
<tr>
<td>IBM Watson Assistant Integration [com.glide.cs.ibm.watson.assistant.</td>
<td>Enables the IBM Watson Assistant topic to run an IBM skill (conversation) created in IBM Watson with the Assistant V1 API. The topic runs in the Virtual Agent web client.</td>
</tr>
<tr>
<td>topic]</td>
<td></td>
</tr>
<tr>
<td>IBM Watson Assistant Integration V2 [com.glide.cs.ibm.watson.assistant.v2.topic]</td>
<td>Enables the IBM Watson Assistant Chat Integration to run a dialog skill (conversation) created in IBM Watson with the Assistant V2 API. The topic runs in the Virtual Agent web client.</td>
</tr>
</tbody>
</table>
Pre-built Virtual Agent topics, topic blocks, and ServiceNow NLU models

Pre-built Virtual Agent conversations (topics), reusable topic blocks, and ServiceNow NLU models are available for the Virtual Agent platform and various business applications, such as Customer Service Management, HR Service Delivery, IT Service Management, and more.

These pre-defined conversations help users with common self-service tasks in each business area, such as creating or updating cases or providing answers to frequently asked questions. Pre-built topic blocks are reusable components (similar to subflows) that perform a specific function or task and can be added to a conversation topic. Pre-built NLU models define the business-specific language understanding needed for Virtual Agent to understand and process user requests. Each NLU intent in a model maps to a single Virtual Agent conversation topic.

Summaries of pre-built topics and topic blocks

For details on the pre-built topics and topic blocks available, see these sections:

<table>
<thead>
<tr>
<th>Predefined topics and topic blocks</th>
<th>Activated by</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service Virtual Agent conversations</td>
<td>com.sn_csm.virtualagent</td>
</tr>
<tr>
<td>Human Resources Virtual Agent conversations</td>
<td>com.sn_hr_virtual_agent</td>
</tr>
<tr>
<td>ITSM Virtual Agent Conversations</td>
<td>Request ITSM Virtual Agent and the ITSM NLU Model for Virtual Agent Conversations from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.</td>
</tr>
<tr>
<td>Virtual Agent Platform topics and topic blocks</td>
<td>com.glide.cs.chatbot</td>
</tr>
</tbody>
</table>
**Predefined topics and topic blocks**

<table>
<thead>
<tr>
<th>Activated by</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Virtual Agent Designer setup topics</td>
</tr>
<tr>
<td>• Virtual Agent platform topic blocks (such as Agent Availability, AI Search, and FAQ Conversation Builder)</td>
</tr>
</tbody>
</table>

**Note:** The plugins for the CSM, HR Service Delivery, and ITSM predefined conversations also install their pre-built ServiceNow NLU models and topic blocks. The Glide Virtual Agent plugin installs the pre-built NLU model for setup topics, as well as platform topic blocks.

After installing the plugins, you can preview (test) the topics and topic blocks using Virtual Agent Designer. You can review the intents, utterances, and entities in the pre-built NLU models using ServiceNow NLU Workbench or within Virtual Agent Designer if your NLU-enabled topics are associated with intents in ServiceNow NLU models.

**Working with pre-built topics and topic blocks in Virtual Agent Designer**

- Previewing topics and topic blocks – After you install the plugins for predefined topics, admins or Virtual Agent admins can access the predefined topics and topic blocks in the Topics page. Select the topic and in the **Flow** tab, click **Test**. Review the conversation as it runs in the test window to determine the topics and topic blocks that you want to use.

- Using pre-built topics and topic blocks – Although pre-built topics and topic blocks are read only and can't be changed, you can reuse them by **duplicating** and modifying them as needed. After you test a duplicated topic and are ready to deploy it to your Virtual Agent clients, **publish** the topic or topic block. After you test a duplicated topic or topic block, publish it to make it available for use in your conversation (calling) topics.

For details on creating, testing (previewing), duplicating, and publishing a topic, see **Using Virtual Agent Designer**. For details on working with topic blocks, see **Reusable topic blocks**.

**Working with pre-built ServiceNow NLU models in ServiceNow NLU Workbench**

- Reviewing a pre-built NLU model – After you install the plugins for predefined topics, you can view the pre-built models in NLU Workbench. The pre-built NLU models for ServiceNow applications define the intents, entities, and utterances.
used for the predefined topics. These models are also trained and published. You can also review the utterances for a pre-built model in Virtual Agent Designer. However to clone a pre-built model, you use NLU Workbench.

- Cloning pre-built NLU models – Although pre-built NLU models are read only and can’t be edited, you can clone pre-built NLU models to create your own NLU models and import intents from pre-built models or other NLU models that you create in NLU Workbench.

For details on creating, training, and publishing ServiceNow NLU models, see Natural Language Understanding.

**Configure the Service Portal chat client**

Set controls to run the Service Portal chat client for Virtual Agent and Live Agent in your service portals.

**Before you begin**

Role required: sp_admin or admin

**About this task**

Two options are available for setting the Service Portal chat client for Virtual Agent and Live Agent:

- **Service Portal Agent Chat Configuration:** Define a configuration that enables the chat client to persist across all portal pages for selected portals. End users can engage in chat on any portal page in specified portals.

- **Configure the legacy Service Portal widget for Virtual Agent:** Add the Legacy Virtual Agent Service Portal widget to a single, selected portal page, from which your end users run the chat client.

**Note:** If you upgraded from a previous release, your portal implementation may include the legacy Virtual Agent Service Portal widget. To migrate from the legacy widget to a Service Portal Agent Chat configuration, remove all instances of the legacy widget. For details, see Migrate from the Virtual Agent Service Portal widget.

**Note:** There are other Service Portal Agent Chat features that you can configure, such as customizing the Agent Chat button in your portal.

**Set up a Service Portal Agent Chat Configuration**

Define a persistent Service Portal Agent Chat configuration that enables your end users to run Agent Chat (Virtual Agent and Live Agent) on any portal page in specified portals.
Before you begin
Activate the Glide Virtual Agent (com.glide.cs.chatbot) or the Agent Chat (com.glide.interaction.awa) plugin. You can activate the Glide Virtual Agent plugin only if you have a subscription.
Role required: admin

About this task
For additional information on configuring Agent Chat in Service Portal, such as passing portal-specific data to Agent Chat, see Configure Agent Chat in Service Portal.

Procedure
1. Navigate to Service Portal > Agent Chat.
   The Service Portal Agent Chat Configurations [sp_agent_chat_config] table opens.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select to make the configuration active.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a unique name for the configuration record.</td>
</tr>
<tr>
<td>Portals</td>
<td>Select the portals in which you would like to use the specified chat configuration.</td>
</tr>
<tr>
<td>Application</td>
<td>Read-only application scope for the record.</td>
</tr>
<tr>
<td>Public</td>
<td>Select to make Agent Chat available to users before they log in.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select the roles a user must have to use Agent Chat. If no role is selected, Agent Chat is available to all users regardless of their role.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number indicating the order that the configurations should run. If there are multiple configurations on a portal, the system runs the first configuration found from lowest to highest.</td>
</tr>
<tr>
<td>Server script</td>
<td>Write a script that passes page and widget data to an Agent Chat (Virtual Agent or Live Agent) conversation when a user initiates the conversation. For example, pass a field to the chat conversation to enable Agent Chat to...</td>
</tr>
</tbody>
</table>
access the value. Data passed in this script is available to every page in the portal associated with this record. This script has access to the GlideSPScriptable API.

Note: The portal suffix, page ID, and language are automatically available to Agent Chat and do not require a custom script. Sys ID and table are automatically available to Agent Chat when they are present in the UI.

This example returns an object containing the list of catalogs associated with the portal to the current conversation.

```
(function ($sp) {
    return {
        catalogs: $sp.getValue('catalogs')
    };

})(sp);
```

When Agent Chat (Virtual Agent or Live Agent) opens in an iframe HTML element, the list of catalogs is included in the iframe URL. Parameters from this field override any conflicting page data passed to Agent Chat.

4. Click Submit.

What to do next
If you’re configuring Agent Chat for Agent Workspace, setup is complete. Next, you can set up quick actions that allow your agents to use shortcuts and chat more efficiently. To see how agents manage chats in Agent Workspace, see Working from the agent inbox.

Users can initiate and maintain an Agent Chat conversation from any page in the selected portal. If you are upgrading from a previous release, and your portal implementation uses the Virtual Agent Service Portal widget, see Migrate from the Virtual Agent Service Portal widget.

Configure the legacy Service Portal widget for Virtual Agent
Configure the legacy Service Portal widget to run Virtual Agent or Live Agent in a specific page in your service portal. If you are using pre-chat routing, use this widget.
Before you begin
Activate the Glide Virtual Agent (com.glide.cs.chatbot) plugin. You can activate Glide Virtual Agent only if you have a subscription.
Role required: sp_admin or admin

Procedure

1. Navigate to Service Portal > Service Portal Configuration in the navigation bar to open the Service Portal configuration page.
2. Click Designer to open the Service Portal Designer.
4. Use the Filter Widget text box in the navigator to filter the widget list for the term Virtual Agent.

5. Click and drag this widget to the bottom of the page.

   The widget itself appears empty, however, you should see a floating blue chat widget icon at the bottom right of the page.
6. **Optional:** Change the color of the Virtual Agent chat icon using the widget instance parameters.

   a. Click the pencil icon in the upper right corner of the Virtual Agent widget.

   ![Virtual Agent Service Portal Widget](image)

   b. In the **Floating Button Color** parameter field, enter a new color for the button.

   c. Click **Save**.

7. **Optional:** Set a default topic for Virtual Agent using the widget instance parameters.

   a. Click the edit icon in the upper right corner of the Virtual Agent widget.

   b. In the **Virtual Agent Client URL Parameters** field, enter the text `sysparm_topic=<sys_id>`. Replace `<sys_id>` with the `sys_id` of the published topic that you want to use as the default.
(Optional) The sys_id should belong to one of the published topics in the [sys_cs_topic] table.

**Important:**

Use the `sysparm_topic` parameter only to load the given topic in the Service Portal chat client or when using the IBM Watson Assistant chat integrations (com.glide.cs.ibm.watson.assistant.topic and com.glide.cs.ibm.watson.assistant.topicV2 plugins). This parameter doesn’t allow users to start a new conversation or transfer to a live agent. It also disables the context menu and doesn’t support other third-party chat clients.

c. Click **Save**.

**Results**

If you’re configuring Agent Chat for Agent Workspace, setup is complete. Next, you can set up quick actions that allow your agents to use shortcuts and chat more efficiently. To see how agents manage chats in Agent Workspace, see **Working from the agent inbox**.

**Embed the Virtual Agent web client in an external web page**

Load the Virtual Agent web client interface in an external web page by using an inline frame element (iframe). You can also optionally enable the single sign-on (SSO) authentication process to run automatically for guest users who are using the web client and are not logged in.

**Before you begin**

- In the iframe, you specify the URL of the instance to be embedded. If you’re embedding the web client on any page that is not on your ServiceNow instance, the URL must be a custom instance URL. Due to increased browser security, the web client may fail to load if you don’t use a custom URL. To learn more about using custom URLs, see **Associating custom URLs to your instance**.
  
  To use a custom URL:
  
  ◦ Activate the custom url plugin (com.snc.customurl) in your instance.
  
  ◦ Add the custom URL (that you previously purchased and registered) to your instance.

- After you embed the Virtual Agent client, you can optionally trigger SSO authentication from the web client, but only when your instance is set up to use an external SSO provider. Your hosting site must also use the same SSO provider as your instance. For details on setting SSO providers, see **External single sign-on (SSO)**.
To trigger SSO authentication, you create a JavaScript script that defines conditions for running authentication and redirects users to a web client page that you specify (see Step 2 below). You also specify the allowed URLs that can be passed in this script, by identifying them in the `com.glide.cs.web_client_login_redirect_urls` system property. Specify the full redirect URLs or the host part of the URL, such as `https://example.com`.

**Role required: admin**

**About this task**

This procedure requires that you set values for the following two system properties:

- `com.glide.cs.embed.csp_frame_ancestors`
- `com.glide.cs.embed.xframe_options`

These properties determine the security policy for the embedded web client, namely how browsers render and secure HTML content for Virtual Agent and Live Agent chat, in an iframe, before you embed the web chat client. To generate SSO authentication for your guest users, you can create a script that uses the `window.postMessage()` method (Web API) to trigger authentication and specify the URL where users are redirected after authentication. For more information on this method and Window objects, see [Window.postMessage()](#).

**Note:** If you’re using the Content Management System (CMS) application to create custom interfaces for the Now Platform and ServiceNow® applications, be aware that it does not support Virtual Agent.

**Procedure**

1. Set both the `com.glide.cs.embed.csp_frame_ancestors` and `com.glide.cs.embed.xframe_options` system properties to specify the HTTP header directives for securing the iframe contents. The HTTP header directives tell the browser whether a page can be embedded on certain domains to mitigate clickjacking attempts. Setting both properties ensures that there are security directives for major browsers and also older browsers, such as Internet Explorer.

   a. In the navigation filter, enter `sys_properties.list`.

   b. In the System Property `[sys_properties]` table, search for the `com.glide.cs.embed.csp_frame_ancestors` property by name.
**Note:** This property sets the source value of the HTTP header directive: `Content-Security-Policy:frame-ancestors<source>`. Use the `host-source` value to specify the domains in which the external web page can be embedded. This property applies to most major browsers, except for Internet Explorer.

c. Click the property name to open the form and specify the directive values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>string. Default value.</td>
</tr>
<tr>
<td>Value</td>
<td>Specify one or more sources, including:</td>
</tr>
<tr>
<td></td>
<td>• <code>self</code>. Default value. Indicates that the origin is the same as the page being served.</td>
</tr>
<tr>
<td></td>
<td>• <code>host-source</code>. Internet host site by name, IP address, or optional URL and/or port number. Site address can start with a wildcard (asterisk) character. Example value: <code>http://*.example.com</code></td>
</tr>
<tr>
<td></td>
<td>• <code>scheme-source</code>. A schema, for example, <code>http:</code> or <code>https:</code>.</td>
</tr>
<tr>
<td></td>
<td>• <code>none</code>. No matching URLs.</td>
</tr>
</tbody>
</table>

For more information about source values that you can specify, see [CSP:frame-ancestors](#) and [Virtual agent embedded client content security policy (instance security hardening)](#) in [Instance Security Hardening Settings](#).

d. Return to the System Property [sys_properties] table to search for the `com.glide.cs.embed.xframe_options` property by name.

**Note:** This property sets the value of the of the X-Frame-Options header directive, to indicate whether the browser can render an external web page in a frame. Use the default `sameorigin` value to specify the domains in which the external web page can be embedded. This property applies to older browsers, such as Internet Explorer 11.
e. Click the property name to open the form and specify the directive values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>string. Default value.</td>
</tr>
<tr>
<td>Value</td>
<td>Specify a value, including:</td>
</tr>
<tr>
<td></td>
<td>• <code>sameorigin</code>. Default value. Displays the page in a frame that has the</td>
</tr>
<tr>
<td></td>
<td>same origin as the page itself. Example value: allow from <code>https://example.com</code>.</td>
</tr>
<tr>
<td></td>
<td>• <code>deny</code>. Does not display the page in a frame.</td>
</tr>
<tr>
<td></td>
<td>• <code>allow-from uri</code>. Displays the page only in a frame on the specified</td>
</tr>
<tr>
<td></td>
<td>origin.</td>
</tr>
</tbody>
</table>

Note: This value no longer works in modern browsers.

For more information about source values that you can specify, see `X-Frame-Options` and `Virtual agent embedded client X-Frame-Options (instance security hardening)` in Instance Security Hardening Settings.

2. After associating your ServiceNow instance to a custom URL, create the `iframe` element and specify the custom URL in the inline element (`iframe`) used to embed the Virtual Agent client in an external web page: `https://<your-domain>.com/sn_va_web_client_app_embed.do`

Note: Your instance may have multiple custom URLs, but only one instance URL. You must use your custom instance URL only.

For example:

```html
<iframe id="sn_va_web_client"
    title="ServiceNow Virtual Agent Client"
    width="600"
    height="900"
    src="https://<your-domain>.com/sn_va_web_client_app_embed.do">
*https://<your-domain>.com/*https://<your-domain>.com/*</iframe>
```
Note: Use the `?sysparm_skip_load_history=true` parameter at the end of the URL to load the interface without the conversation history.

3. Optional: Create a JavaScript script that uses the `window.postMessage()` method (Web API) to define event conditions that trigger SSO authentication in a user interface page and returns users to a web client page that you specify. To redirect users to a web client page, use the string: `"https://<your-instance>.service-now.com/sn_va_web_client_login.do?sysparm_redirect_uri=' + encodeURIComponent(<your-page>)`.

Note: Before you run the script, use the `com.glide.cs.web_client_login_redirect_urls` system property to specify the URLs that can be passed in the script. The redirection works only when you specify one or more allowed URLs in the property value. Specify the full redirect URLs or the host part of the URL, such as `https://example.com`.

Example script

```html
<script>
    window.addEventListener("message", function(e) {
        // redirect to SSO login if the web client logs in but is logged in as a guest user (unauthenticated)
        if(e.data.type==='SESSION_CREATED' && e.data.authenticated === false)
            window.location.href = 

        // redirect to SSO login if the ServiceNow platform logs out from underneath the web client
        if(e.data.type==='SESSION_LOGGED_OUT')
            window.location.href = 
    });
</script>
```

In this example, authentication is triggered in the specified instance when the `SESSION_CREATED` or `SESSION_LOGGED_OUT` events occur. After authentication (when the SSO credentials for users are accepted), users are redirected to the embedded web client page that you specified in `sn_va-web_client_login.do?sysparm_redirect_uri=' + encodeURIComponent(<your-page>)`, as long as you also specified the page URL in the `com.glide.cs.web_client_login_redirect_urls` property.
Configure Virtual Agent for a ServiceNow mobile application

Virtual Agent provides optimized templates for the mobile experience. Configure a service portal to run Virtual Agent on a ServiceNow mobile application.

Before you begin
Install the required plugins:

- Virtual Agent (com.glide.cs.chatbot)
- Conversational Messaging (com.glide.messaging.awa)
- Core ServiceNow® mobile plugins
  
  For more information, see Mobile plugins.

Role required: admin

Procedure

1. Install the corresponding mobile plugins for each application that you want to use in Virtual Agent.
   
   For example, if you’re using Virtual Agent ITSM conversations, install the ITSM Mobile Agent (sn_itsm_mobile_agt) plugin as well. For more information, see Mobile plugins for ServiceNow Agent.


3. Click the Homepage record.
   
   If prompted, click the link at the top of the page to edit the record.

4. Click the Body tab.
5. Click **Chat** under **Quick Action Button** to open the record. If you don’t see a Chat entry, add it as follows:

   a. Change the application scope so that it matches the application that contains the record.

   b. Click the back button to return to the previous page.
c. Click the **Homepage** record.

d. Click the **Body** tab.

e. Under **Quick Action Button**, double-click **Insert a new row**.

f. Type **Chat**, and then press Enter or click the save icon (✔).

g. Click **Update**.

6. Fill in the Chat form as follows.

   a. In the **Function** field, select **Agent Chat**.

   b. Click the Info icon (ⓘ) on the **Function** field and verify that **Chat Launcher** is set in the **Type** field (this is the default setting).

   c. Select the **Active** check box.

   d. Click **Update**.
**Results**

Depending on the device and the patch version of the server instance, end users can access the Virtual Agent chat icon in the bottom-right or top-right corner of the app. Tap the plus icon (+) or the chat icon (○) to start a conversation.

The topics you create in Virtual Agent Designer can be used in both the web and mobile clients, as well as any other channels you may configure. Virtual Agent output components are already optimized for Android and iOS, including image and video cards, link unfurling, AI Search results, and Virtual Agent notifications.

**View and modify Virtual Agent style templates**

Virtual Agent provides optimized templates for the mobile experience. You can view and modify the style sheets in the Adapter Cards [sys_cs_adapter_card] table.

**Before you begin**

Role required: admin or virtual_agent_admin

**Procedure**

1. Enter `sys_cs_adapter_card.list` in the navigation filter.
2. Click an entry in the Card Name column.
3. Click the name of the channel you want to view in the embedded list. For example, click iOS or Android Device to view the corresponding style sheet.
4. Make any changes in the Template Definition field.
5. Click Update.

**Configure live agent chat**

Configure the chat interface for live chat support. If you’re using Virtual Agent, you also specify the chat messages displayed during a transfer from a bot conversation to a live agent.

**Before you begin**

Role required: admin or virtual_agent_admin

- If you upgraded from a previous release and your chat interface is Connect Support, use the Chat Setup form to specify the chat queues used for live agent transfers. For details on defining chat queues in Connect Support, see Administer Connect Support Queues.
**Note:** In this release and future releases, Connect Support no longer receives enhancements or non-priority bug fixes. Although you can continue to use Connect Support, consider migrating to ServiceNow Advanced Work Assignment (AWA) and Workspace Agent Chat to automatically assign and route chat requests and other work items to agents.

- If you’re using Agent Workspace, live agent transfers are assigned automatically to the appropriate agents through the Chat service channel in Advanced Work Assignment. You will not see options for specifying queues or choosing the fulfiller interface.

- If you want to display agent names and their avatars (pictures) in the chat client, have your agents set up their Live Feed profile with their pictures.

- If you want notifications to be delivered to the Virtual Agent bot in the web chat client, configure the notifications. See [Setting up Virtual Agent notifications](#).

### About this task
Use Chat Setup to configure these features:

- Activate or disable live chat (enabled by default).
- Activate or disable transcript download.
- Activate the display of the estimated wait time for live chat support (transfer from the virtual agent to a live agent).
- Control the display of agent names and avatars in the chat window.
- Activate notifications to be sent via the Virtual Agent chatbot in the web and mobile chat client.
- Activate Agent Whisper to enable supervisors to message agents privately when agents are interacting with a requester. For new instances, Agent Whisper is enabled by default.

  If you're upgrading from a previous release, you must activate Agent Whisper.

- Set the system messages that are displayed when a live agent transfer occurs.

Chat Setup also includes the Context related list for defining chat context variables that can be used in Virtual Agent topic scripts or in chat-related features. For example, you can use chat context variables to pass certain information from the topic to share with the live agent or control how bot conversations are routed to live agents. For details on using Live Agent and context variables, see [Virtual Agent scripts](#).
Procedure

1. Navigate to **Conversational Interfaces > Chat Setup**.

2. Fill in the fields on the form, which differ depending on whether you are a new customer or an existing customer who upgraded to Rome.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Live Agent setup configuration.</td>
</tr>
<tr>
<td>Live Chat Enabled</td>
<td>Option to activate live chat. If you don’t want to use live agent chat, clear this box.</td>
</tr>
<tr>
<td>Allow Transcript Download</td>
<td>Option to allow the requester to download a transcript of the conversation.</td>
</tr>
</tbody>
</table>
| Live Chat Wait Status  | Option to display the estimated wait time for live agent support in the chat menu for web clients. If you’re using the Microsoft Teams messaging integration, the wait time displays in a card that displays the approximate wait time to chat with an agent.  
  - The wait time is the estimated time, in minutes, for the transfer from the virtual agent to a live agent.  
  - The wait time updates once per minute. Wait time is based on the Queue Average Wait Time minus the Waiting Time. |
| Show Agent Names and Avatars | Option to display agent names and avatars in the chat client when a live agent enters, transfers, or exits a chat. Agents set their names and pictures used, in their Live Feed profiles.  
  - If enabled, the **Show agent name in chat header** option appears for selectively controlling the display of the agent name in the chat header.  
  - If you don’t enable this option, agent identities remain anonymous. No names or avatars are displayed in the chat window. |
<p>| Show agent name in chat header | Option to selectively suppress the display of the agent name in the header of the chat window. This option is enabled by default. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent Names and Avatars is enabled</strong></td>
<td>Option to activate the delivery of notifications using the Virtual Agent bot in the web and mobile chat clients.</td>
</tr>
</tbody>
</table>
| Enable notifications for all users | Option to activate Agent Whisper, which enables supervisors to message agents privately when agents are interacting with a requester.  

**Note:** If you deactivate Agent Whisper, you must manually disable the /help quick action. |
| Emoji Enabled | Option to activate emojis. For more information, see Using emojis in Agent Chat. |
| **Fulfiller options (if you upgraded to the Rome release and are still using Connect Support)** | Chat support interface for Customer Service Management (CSM): Agent Workspace or Connect Support.  

**Note:** If you're using Agent Chat, select Agent Workspace as the fulfiller UI. |
| CSM Fulfiller UI | Live Agent chat queue used for CSM if not specified through the chat interface or changed by a topic.  
If you're using Agent Workspace, you don't need to specify a CSM queue. |
| CSM Queue | Chat support interface for Human Resources: Agent Workspace or Connect Support.  

**Note:** If you're using Agent Chat, select Agent Workspace as the fulfiller UI. |
| HR Fulfiller UI | Live Agent chat queue to be used for HR if not specified through the chat interface or changed by a topic.  
If you're using Agent Workspace, you don't need to specify a CSM queue. |
<p>| ITSM Fulfiller UI | Chat support interface for IT Service Management (ITSM): Agent Workspace or Connect Support. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSM Queue</td>
<td>Live Agent chat support queue used for IT Service Management if not specified through the chat interface or specified by a topic. If you’re using Agent Workspace, you don’t need to specify an ITSM queue.</td>
<td>If you’re using Agent Chat, select Agent Workspace as the fulfiller UI.</td>
</tr>
<tr>
<td>Global Fulfiller UI</td>
<td>Chat support interface for the platform: Agent Workspace or Connect Support.</td>
<td>If you’re using Agent Chat, select Agent Workspace as the fulfiller UI.</td>
</tr>
<tr>
<td>Global Queue</td>
<td>Queue used if Virtual Agent does not have context to the queue through the chat interface or topic. If you’re using Agent Workspace, you do not need to specify a global queue.</td>
<td></td>
</tr>
<tr>
<td>Live Agent transfer messages</td>
<td>Message that users see when they are transferred to a live agent or another queue. For example: &quot;Please stand by while I connect you to a live agent.&quot;</td>
<td>Note: You can define only one transfer message, which is displayed for all the queues in your instance.</td>
</tr>
<tr>
<td>No Agents Available Message</td>
<td>Message that users see when a live agent is not available. For example: &quot;No agents are available at the moment. Please try again later.&quot;</td>
<td>Note: You can define only one agent availability message, which is displayed for all the queues in your instance.</td>
</tr>
<tr>
<td>Other chat options</td>
<td>Option to receive notifications related to the autopilot feature, which allows agents to use autopilot quick actions to invoke Virtual Agent topics. To learn more about Autopilot, see Conversation Autopilot in Agent Chat.</td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Update**.
What to do next

- Define and publish chat context variables to capture information that can be used in other chat-related features. For example, you can define a context variable that stores certain pre-chat survey responses, which can be used to route chats to the appropriate chat queues. You can also select base system context variables in the Context related list to store GlideRecord attributes in a Virtual Agent topic. You can use these variables to pass specific information from the bot conversation to a live agent.

- Enable the chat client on your Service Portal. For details, see Configure the Service Portal chat client.

- Review and update (as needed) system messages displayed in pre-built and custom messaging integrations.

- Set the portal URL in which chat links open.

Disable chat transfers from Virtual Agent

Use Chat Setup to disable the transfer from a virtual agent to a live agent.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to Conversational Interfaces > Chat Setup.
2. Clear the Live Chat Enabled check box.

   Note: Clearing this option hides the Fulfiller UI and Queue fields on the form.

3. Enter a value in the No Agents Available Message.
   Users who experience an error or exception while using Virtual Agent will be shown this message rather than automatically being transferred to a live agent.

4. Click Update to save your changes.

Results
The Contact Support option in the Virtual Agent menu will show as disabled.

Note: Scripted transfers to a live agent using the vaSystem.connectToAgent() method will also be disabled. To prevent an error, always use vaSystem.isLiveAgentAvailable() in your scripts to ensure that a live agent is available before transferring.
Define and publish chat context variables

Specify the chat context variables (also called Live Agent variables) for storing chat-related information, such as pre-chat survey responses. These variables contain contextual information that can be used to determine topic intent or control how chats are routed to live agents. You can also define variables to capture contextual information passed in Virtual Agent topic scripts to share with the live agent.

Before you begin
Role required: virtual_agent_admin or admin

About this task
You can use context variables in scripts or with the condition builder. For example, you can reference context variables in the Condition field in the topic Properties tab. When a condition is applied to a topic, it must return as true to display to the user.

For details about using context variables in topic scripts, see Virtual Agent scripts. For information about learning to use context variables, see Tutorial: Route interactions by context. For descriptions of Live Agent context variables, see Live Agent chat context variables.

Procedure

1. Navigate to Conversational Interfaces > Chat Setup.
2. On the Chat Setup form, go to the Context related list and select New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the context variable.</td>
</tr>
<tr>
<td>Script Variable Name</td>
<td>Live Agent variable to which the context variable refers.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that is associated with the context variable.</td>
</tr>
<tr>
<td>Record</td>
<td>Option to associate the context variable to a record.</td>
</tr>
<tr>
<td>Value</td>
<td>Script to determine what information is stored in the context variable.</td>
</tr>
</tbody>
</table>

4. Select Submit.
Change Virtual Agent and Live Agent system messages

Customize the default system messages displayed during Virtual Agent and Live Agent chat.

**Before you begin**
Role required: virtual_agent_admin or admin

**About this task**
Use the System Messages related list in the Chat Setup form to change the properties that control standard chat messages displayed in your instance. If you're using Virtual Agent Pro and Live Agent, the System Messages list displays properties for both Virtual Agent and Live Agent messages. If you're using Live Agent (Agent Chat) only, the System Messages list displays only the properties relevant to Live Agent.

**Procedure**
1. Navigate to Conversational Interfaces > Chat Setup.
2. In the Chat Setup form, navigate to the System Messages related list and select the system property for the message to be changed.
3. In the Value field, enter the new message text and select Update.
   Any changes are immediately applied to the system messages displayed in your instance.

**Set the URL navigation for chat links**

Configure the portals in which links to ServiceNow records in Live Agent and Virtual Agent conversations are opened, including links in output cards and cards for Virtual Agent notifications and AI Search results.

**Before you begin**
Role required: admin

**About this task**
Your base system instance provides default portals in which chat links to records from certain ServiceNow tables are opened automatically. For example, Service Portal is the default portal used to display knowledge records from the Knowledge [kb_knowledge] table and also catalog items from the Catalog Item [sc_cat_item] table.

Use the URL Navigation related list in the Chat Setup form to change these default mappings, as well as define custom mappings that map a portal URL to a specified ServiceNow table. The portal configurations apply to the web client, chat channels, and messaging channels.
How URL navigation works

To determine the portals to be used for chat links, the system evaluates the following information in the order listed:

1. sysparm portal parameter - If you specified a sysparm_portal parameter in the instance URL for the web client, that portal is used.

2. Topic script variable - If you specified a portal in a topic script variable, that portal is used.

3. Default portal for Provider Channel Identity - If you specified a default portal in the Provider Channel Identity [sys_cs_provider_application] table for pre-built chat integrations or custom chat integrations, that portal is used. The default portal applies to the chat and messaging channels for the provider. For details on configuring the Provider Channel Identity, see Create a channel identifier.

4. Default portal for a table - Uses the portal value in the default portal mapping listed in the URL Navigation related list of the Chat Setup form.

5. Global default portal - If you defined a global default portal using the com.glide.cs.url_redirect.default.portal system property, that global portal is used.

6. Service Portal - If you didn't define a global portal using the com.glide.cs.url_redirect.default.portal property, Service Portal is used.

URL mappings defined in earlier releases

If you previously added the com.glide.cs.portal_url_mapping.default.<portal_value>.<table_name> property to create URL mappings that were used instead of the default URL mappings, those properties are retained after you upgrade to the Rome release. You can view the mappings in the URL Navigation related list of the Chat Setup form or the URL Navigation [sys_cs_portal_url_mapping] table. Starting with the Rome release, you define or change URL mappings using the URL Navigation related list rather than the URL mapping property. There are two types of URL mappings:
• Default mappings - All system properties with the format
  `com.glide.cs.portal_url_mapping.portal.<table_name>` that define
  the default portal used for certain ServiceNow tables.

**Default URL mapping properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>com.glide.cs.portal_url_mapping.portal.kb_knowledge</code></td>
<td>Default portal context (URL mapping) to use for Knowledge Base articles.</td>
</tr>
<tr>
<td>◦ Type: string</td>
<td>◦ Default value: sp (Service Portal)</td>
</tr>
<tr>
<td><code>com.glide.cs.portal_url_mapping.portal.sc_cat_item</code></td>
<td>Default portal context (URL mapping) to use for Service Catalog items.</td>
</tr>
<tr>
<td>◦ Type: string</td>
<td>◦ Default value: sp (Service Portal)</td>
</tr>
<tr>
<td><code>com.glide.cs.portal_url_mapping.portal.sys_user</code></td>
<td>Default portal context (URL mapping) for <code>sys_user</code> records.</td>
</tr>
<tr>
<td>◦ Type: string</td>
<td>◦ Default value: esc (Employee Service Center)</td>
</tr>
</tbody>
</table>

• Custom mappings - All system properties that define a portal and table combination using the format
  `com.glide.cs.portal_url_mapping.<portal_name>.<table_name>.
  These mappings are retained as custom mappings. When the portal or table is specified as `default`, it indicates that any portal or table is used.
  The system determines the URL for custom mappings by evaluating the following values:
  ◦ Portal and table/parent table
  ◦ Portal and any table
  ◦ Any portal and table/parent table
  ◦ Any portal and any table

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Custom URL mapping properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.glide.cs.portal_url_mapping._default.kb_knowledge | Default for Knowledge URL mapping.  
  - Type: string  
  - Value: /{{portal}}?id=kb_article&sys_id={{data.sys_id}} |
| com.glide.cs.portal_url_mapping._default.sc_cat_item | Default for Catalog Item URL mapping.  
  - Type: string  
  - Value: /{{portal}}?sys_id={{data.sys_id}}&id={{data.table_name}}&table={{data.table_name}} |
| com.glide.cs.portal_url_mapping._default.sys_user | Default for User URL mapping.  
  - Type: string  
  - Value: /{{portal}}?id=user_profile&sys_id={{data.sys_id}} |
| com.glide.cs.portal_url_mapping._default._default | Default URL mapping for records other than knowledge articles, Service Catalog items, People (sys_user) records, publication records, and task records.  
  - Type: string  
  - Value: /{{portal}}?sys_id={{data.sys_id}}&id=form&table={{data.table_name}} |

### Procedure

1. Navigate to **Conversational Interfaces > Chat Setup**.

2. On the Chat Setup form, go to the **URL Navigation** related list.
   - To create a new custom mapping, click **New**.
   - To change a default or custom mapping, select the mapping to be updated.

3. On the form, complete the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Name of the portal for a particular table record.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of portal mapping:</td>
</tr>
<tr>
<td></td>
<td>• Default Mapping: Default portal mapped to the following ServiceNow tables:</td>
</tr>
<tr>
<td></td>
<td>◦ Service Portal - Catalog Item [sc_cat_item] table</td>
</tr>
<tr>
<td></td>
<td>◦ Service Portal - Knowledge [kb_knowledge] table</td>
</tr>
<tr>
<td></td>
<td>◦ Employee Center Portal - User [sys_user] table</td>
</tr>
<tr>
<td></td>
<td>• Custom Mapping: Portal URL definition that identifies a portal and ServiceNow table combination, which is entered in the Value field.</td>
</tr>
<tr>
<td>Table</td>
<td>ServiceNow table that maps to the portal. Select a table from the list of tables.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application to which this URL mapping belongs.</td>
</tr>
<tr>
<td>Portal</td>
<td>Portal to be used in the mapping. Select a portal from the list of portals.</td>
</tr>
<tr>
<td>Value</td>
<td>For new custom mappings, specify the combination of portal and table values to form the link. For example, the following value maps knowledge articles to the CSP portal: <code>/csp?id=kbarticle&amp;sys_id={{data.sys_id}}</code></td>
</tr>
</tbody>
</table>

If you're changing a custom mapping that was defined in a previous release using the `com.glide.cs.portal_url_mapping._default.<table>` system property, you do not need to specify a Value.

4. Click **Submit** to enter a new mapping or **Update** to change an existing mapping.
Live Agent chat context variables

Use chat context variables to pass certain information from the topic to share with the live agent or to control how bot conversations are routed to live agents. Virtual Agent includes some default variables, and you can define new ones.

**Note:** The Interaction table is part of the interaction management framework, which is activated through the Interactions Management plugin (com.glide.interaction). This plugin is included with the Agent Chat (com.glide.interaction.awa) and Connect Support (com.glide.connect.support) plugins.

Live Agent variables included with Virtual Agent

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LiveAgent_application</td>
<td>Application scope of the chat. For example, Global, HR, CSM, or ITSM.</td>
</tr>
<tr>
<td>LiveAgent_auto_resolution_context_id</td>
<td>If Auto Resolution is enabled, the ID of the record created when a requester is redirected to Virtual Agent. For more information, see Setting up Incident Auto Resolution for Virtual Agent.</td>
</tr>
<tr>
<td>LiveAgent_case</td>
<td>Case ID (from the [sn_customerservice_case] table) that is used with the Customer Service Management (CSM) application when a case is related to the chat.</td>
</tr>
<tr>
<td>LiveAgent_csp_category</td>
<td>Category defined in the Consumer Service portal in the CSM application (requires the com.glide.service-portal.consumer-portal plugin). For more information, see Using the Consumer Service Portal.</td>
</tr>
<tr>
<td>LiveAgent_csp_email</td>
<td>Requester’s email address, as entered in a pre-chat survey on the Consumer Service Portal.</td>
</tr>
<tr>
<td>LiveAgent_csp_first_name</td>
<td>Requester’s first name, as entered in a pre-chat survey on the Consumer Service Portal.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LiveAgent_csp_last_name</td>
<td>Requester’s last name, as entered in a pre-chat survey on the Consumer Service Portal.</td>
</tr>
<tr>
<td>LiveAgent_devicetype</td>
<td>Type of device being used for the chat. For example, mweb (web client), android, or ios.</td>
</tr>
<tr>
<td>LiveAgent_esc_pre_chat_ask_a_question</td>
<td>Requester response to a pre-chat survey selection from within the HR Service Delivery application ESC view of the HR Case record.</td>
</tr>
<tr>
<td>LiveAgent_hr_topic_id</td>
<td>ID of the current topic. Used in Advanced Work Assignment to determine which HR queue to transfer the user for live agent chat.</td>
</tr>
<tr>
<td>LiveAgent_interaction_account</td>
<td>Used with CSM chats that are initiated by B2B users who are tracked as contacts for a particular account. Corresponds with the Account field on the Interaction [interaction] table, which references the Accounts [customer_account] table.</td>
</tr>
<tr>
<td>LiveAgent_interaction_consumer</td>
<td>Used with CSM chats that are initiated by B2C users who are tracked as consumers. Matches the interaction.consumer field referencing the csm_consumer table. Corresponds with the Consumer field on the Interaction [interaction] table, which references the Consumers [csm_consumer] table.</td>
</tr>
<tr>
<td>LiveAgent_interaction_contact</td>
<td>Used with CSM chats that are initiated by B2B users who are tracked as contacts for a particular account. Corresponds with the Contact field on the Interaction [interaction] table,</td>
</tr>
</tbody>
</table>
### Live Agent variables included with Virtual Agent (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LiveAgent_interaction_id</strong></td>
<td>Sys_id of the interaction record associated with the chat session. For more information, see Virtual Agent interaction records.</td>
</tr>
<tr>
<td><strong>LiveAgent_language</strong></td>
<td>Two-letter language code for the requester’s chat. <strong>Note:</strong> Language values use ISO standard two-character language codes. For more information, see ISO 639.1 language codes.</td>
</tr>
<tr>
<td><strong>LiveAgent_mandatory_skills</strong></td>
<td>Required skills for an agent. For example, German language proficiency may be required for German-speaking requesters. You can define mandatory skills in Advanced Work Assignment. For more information, see Configure agent assignment rules.</td>
</tr>
<tr>
<td><strong>LiveAgent_optional_skills</strong></td>
<td>Skills that would be useful for a given chat scenario. You can define optional skills in Advanced Work Assignment. For more information, see Configure agent assignment rules.</td>
</tr>
<tr>
<td><strong>LiveAgent_page</strong></td>
<td>The specific page (within a portal) that the chat was accessed from.</td>
</tr>
<tr>
<td><strong>LiveAgent_portal</strong></td>
<td>Name of the portal that the chat was accessed from.</td>
</tr>
<tr>
<td><strong>LiveAgent_post_assessment_instance</strong></td>
<td>Reference to the post-chat survey (Assessment Instances)</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LiveAgent_post_chat_survey_name</td>
<td>Name of a post-chat survey that is used to gather feedback from the requester. For information about creating surveys in Advanced Work Assignment, see Create conversational chat surveys. For information about creating surveys in Connect Chat, see Configure a survey in Connect Chat support.</td>
</tr>
<tr>
<td>LiveAgent_pre_assessment_instance</td>
<td>Reference to the pre-chat survey (Assessment Instances [asmt_assessment_instance] table), if there is one.</td>
</tr>
<tr>
<td>LiveAgent_pre_chat_survey_name</td>
<td>Name of a pre-chat survey that is used to gather information from the requester. For information about creating surveys in Advanced Work Assignment, see Create conversational chat surveys. For information about creating surveys in Connect Chat, see Configure a survey in Connect Chat support.</td>
</tr>
<tr>
<td>LiveAgent_queue</td>
<td>Sys_id of the pre-built Connect Support chat queue (deprecated).</td>
</tr>
<tr>
<td>LiveAgent_search_text</td>
<td>Search terms entered by the requester. Used to search Virtual Agent topics.</td>
</tr>
<tr>
<td>LiveAgent_short_description</td>
<td>Used to set the short description in the interaction record associated with the chat.</td>
</tr>
<tr>
<td>LiveAgent_sys_id</td>
<td>Sys_id of a record that relates to the interaction. Typically, this is the record.</td>
</tr>
</tbody>
</table>
### Conversation context across web and mobile devices

When a user is engaged in a conversation and switches between the web client and a mobile device, the user context automatically refreshes.

Each time a user moves between the web client and a mobile device, the context refreshes. You can also use context variables to serve personalized and relevant experiences based on the device being used. You can build context-aware conversations, tailored to the device in which a conversation is run. To learn more about using context variables, see Virtual Agent scripts and Define and publish chat context variables. For details on base system context variables, see Live Agent chat context variables.

### Asynchronous Chat

Enable your organization or brand to maintain constant engagement with end users. With Asynchronous Chat, your agents and end users can participate in long-running conversations without being online concurrently. Agents can also proactively contact users whenever there is useful information to share, such as important alerts or updates.

With Asynchronous Chat, end users and agents can engage in conversations that might span several hours or even days. These conversations run on messaging channels where users and agents can communicate at different times and resume conversations where they left off. Users can respond at their convenience and are no longer limited to working with agents only during customer support hours.

Long-running conversations are supported on channels that are designated as messaging channels in the Messaging Channel [sys_cs_channel] table. Messaging channels provided with your base system include the SMS channel, which is used by the ServiceNow Conversational SMS Integration with Twilio app and the ServiceNow Conversational SMS service channel app.

Starting with the Rome release, you can also configure the web (mweb) channel, which includes the iOS, Android, and desktop devices, as a messaging channel.

---

**Live Agent variables included with Virtual Agent (continued)**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LiveAgent_table</td>
<td>Table containing the record that relates to the interaction. Typically, this is the record being viewed in the portal when the chat is requested.</td>
</tr>
</tbody>
</table>
channel instead of a chat channel. For configuration details, see Configure asynchronous chat for the web channel.

**Note:** Web chat or the mweb channel is the only channel that can be supported in either chat or messaging mode, depending on your need. Web chat can be set up only in one mode in any given instance. The asynchronous chat feature specifically refers to the mweb channel in messaging mode.

**Requirements**
Asynchronous chat requires certain plugins and ServiceNow applications from the ServiceNow Store.

### Plugins and ServiceNow apps required for asynchronous chat

<table>
<thead>
<tr>
<th>Plugin or ServiceNow app</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glide Conversation Server [com.glide.cs]</td>
<td>Enables Virtual Agent functionality handled by the conversation server, including conversation settings and the Virtual Agent web client plugin (com.glide.cs.sn-va-web-client-app). This functionality is included with the Virtual Agent Lite plugin (com.glide.cs.chatbot.lite) provided with your base system. For details, see Activate Virtual Agent Lite. For full Virtual Agent functionality, activate Glide Virtual Agent, which is available by subscription.</td>
</tr>
<tr>
<td>Conversational Messaging [com.glide.messaging.awa]</td>
<td>Enables features for conversational messaging, such as messaging actions in Workspace. For details, see Activate Conversational Messaging.</td>
</tr>
<tr>
<td>Now Mobile app (Version 12.2)</td>
<td>Enables users to submit incidents and requests, manage tasks, and request help from Agent Chat (and Virtual Agent if using Virtual Agent). End users install the Now Mobile app for iOS or Android systems from the</td>
</tr>
</tbody>
</table>
Plugins and ServiceNow apps required for asynchronous chat (continued)

<table>
<thead>
<tr>
<th>Plugin or ServiceNow app</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple App Store or the Google Play store, respectively.</td>
<td></td>
</tr>
<tr>
<td>Agent-initiated Messaging Interface (Version 3.0)</td>
<td>Supports agent-initiated conversations in messaging channels. This ServiceNow app, available from the ServiceNow Store, also installs the Conversational Messaging plugin (com.glide.messaging.awa). For installation information, see Install Agent-Initiated Messaging Interface.</td>
</tr>
</tbody>
</table>

How Asynchronous Chat works
Asynchronous Chat provides various features to help you improve the conversational experience for your users and agents, such as:

- Message indicators that inform users of new and unread messages received when they’re away from the chat window or when they’ve been offline.
- System messages, displayed to users and agents, that are tailored to either messaging or chat channels.
- Idle conversation timeout period that admins can adjust for messaging channels, as needed.

The following sections explain how these features work for Asynchronous Chat.

New and unread message indicators
End users can receive messages on a messaging channel, even when they’re offline. Users can be anonymous (guests) or known (authenticated). The unread message count is displayed on the chat widget. The unread message count reflects the number of any offline messages sent by a live agent and any simple notifications received.
There is no limit on the number of unread messages. Up to 50 unread messages can be viewed at a given time. Messages can span multiple conversations, either open (current) or closed (past) conversations.

When users open the chat client, they land on the very last message received. They can scroll up or down to read the unread messages, as directed by a New messages above button or New messages below button.

A new messages separator line displays between the read and unread messages.

When users close and reopen the chat window, the messages displayed are considered as "read" even though users might not have reviewed them.

System messages

Certain system messages that are displayed to users and agents in chat mode are not applicable in messaging mode, and are suppressed as needed. The following table identifies system messages that are displayed or suppressed, depending on the mode.

<table>
<thead>
<tr>
<th>System message</th>
<th>Messaging mode (web and mobile)</th>
<th>Chat mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>X has closed the support session.</td>
<td>Displayed</td>
<td>Displayed</td>
</tr>
</tbody>
</table>
System messages displayed in messaging and chat modes (continued)

<table>
<thead>
<tr>
<th>System message</th>
<th>Messaging mode (web and mobile)</th>
<th>Chat mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Displayed when either the agent or user closes the chat session]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The support session was closed.</td>
<td>Suppressed</td>
<td>Displayed</td>
</tr>
<tr>
<td>[Displayed when the chat session wasn't closed by the agent or user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X has entered the chat.</td>
<td>Suppressed</td>
<td>Displayed</td>
</tr>
<tr>
<td>Thank you for contacting support. I am looking into your question and will be with you shortly.</td>
<td>Displayed</td>
<td>Displayed</td>
</tr>
<tr>
<td>The conversation is timing out, are you still there?</td>
<td>Suppressed</td>
<td>Displayed</td>
</tr>
<tr>
<td>[Idle live chat reminder message controlled by the com.glide.cs.idle_chat_reminder_message system property]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Idle conversations and messaging actions in messaging channels

In chat channels, the default idle conversation timeout period for Virtual Agent and Live Agent conversations is two hours (7200 seconds). However, for Live Agent conversations in messaging channels, certain messaging actions are automatically applied, which affects how idle conversations are handled. In messaging channels, when a requester hasn't responded to an agent message within two days, the conversation state changes to Closed Abandoned and the message is closed. For more information on messaging actions, see Configure messaging actions.

As admins, you can override the conversation idle timeout period by channel by setting the value in the Conversation Idle Timeout field in the Messaging Channels [sys_cs_channel] table. For details, see Override the conversation timeout period by channel.

Proactive messaging

Using the Agent-Initiated Messaging Interface, agents can proactively communicate with end users to share relevant or helpful information. When agents initiate messaging from the mweb channel in Asynchronous Chat, your users have the option to respond immediately and engage in a two-way
conversational experience. Proactive messaging with the mweb channel has the following capabilities:

- **Compose Message** feature that agents use to create and send messages to selected users. Messages can contain links and file attachments.
- When a user replies to a message, the ongoing interaction context is retained, providing the agent with the information needed to maintain the conversation.

**Agent-initiated message on mweb channel**

For more information on agent-initiated messages, see [Sending an agent-initiated message during an async chat](#).

**End user experience in live agent conversations**

When a user starts the web client after having received offline messages from a specific agent, for example Agent A, the conversation is in live agent mode:

- If Agent A is available, the user can resume the conversation with Agent A.
- If Agent A is not available, but Agent B is, depending on the agent reassignment settings, the chat window displays Agent B’s name and avatar and the conversation resumes.
- If no agents are available, the conversation is routed to an agent based on the Queue Max Wait Time. If there isn’t a wait time, the conversation waits until an agent becomes available.
Related information

Agent-Initiated Messaging Interface
Send an agent-initiated message during async chat

Configure asynchronous chat for the web channel
Set the web client as a messaging channel for asynchronous chat.

Before you begin
Role required: virtual_agent_admin or admin

About this task
The base system web channel, mweb, is configured as a chat channel for web and mobile clients. To use the web channel as a messaging channel, change the channel **Type** in the Messaging Channel [sys_cs_channel] table.

Procedure
1. In the Navigation filter, enter `sys_cs_channel.list`.
2. In the Messaging Channel form, select the mweb record and double click the **Type** field.
3. Change the Type to Messaging.
4. Save the value.

Results
The mweb channel is set to messaging mode. To help manage long-running conversations, the system automatically performs certain messaging actions in messaging mode:

- Requester message without agent response (agent experience): If an agent hasn't responded to a requester within 30 minutes, the agent receives a reminder that a message from an end user needs a response.
- Agent message without requester response: If a requester hasn't responded to an agent message after two days, the conversation state in the Interaction record is automatically set to closed abandoned.: 

For more information on messaging actions, see Configure messaging actions. For details on Virtual Agent and Live Agent idle conversation timeouts and conversation states, see Closing Virtual Agent and Live Agent conversations and Virtual Agent interaction records.
Configure chat branding and the chat menu

Customize your chat window with your own company logo and bot avatar, UI color schemes, and customer support menu. You can also create different branding configurations for the various organizations that use your instance. These configurations apply to the web-based chat interface and mobile clients only.

Before you begin
Role required: virtual_agent_admin or admin

⚠️ Note: If you upgraded from the New York release or earlier, your existing branding configuration is preserved as the default branding configuration. You can view the default configuration in the Brandings [sys_cs_branding_setup] table.

To prepare for configuration, gather or prepare the following items:

- Company logos for your chat windows and if using Virtual Agent, the avatars for your virtual agent bots. If chat is run in its own browser window, a thumbnail of the branding logo displays automatically in the browser tab. The images must be in .jpg, .png, .bmp, .gif, .jpeg, .ico, or .svg file format. The images can be high resolution, but the image display is scaled based on the aspect ratio.

- Custom menu icons for the chat menu (formerly called the Contact support menu), if you want to change the icons for the default menu items or add icons for new menu items. The icons must be in .svg file format. For better resolution, use a single-color icon.

- The color names or RGB color numbers for your configuration. You can specify the colors for UI items such as font colors and background colors for chat bubbles, buttons, and notifications displayed.
Chat branding and UI elements

- Contact information for your support organization, such as support call hours, call center support phone number, and support email address. You can customize the information in the support menu by adding or changing menu items, including the text and icons displayed. You can also control the visibility of the menu items (show or hide menu options).

Contact support menu (default chat menu)
Note: For more information on branding the Agent Chat widget in Service Portal, see Configure Agent Chat in Service Portal.

About this task
You can create any number of branding configurations for an instance. These branding configurations apply to the web chat and mobile clients only and do not apply to the Virtual Agent third-party messaging integrations for Slack, Microsoft Teams, Workplace by Facebook, and Facebook Messenger.

Branded bots

- When you’re creating a branding configuration, you can create a new bot if needed or select an existing bot profile. A bot profile (live feed profile) includes the bot name and photo (avatar) that will be displayed in the chat window. You can use a bot profile for a single branding configuration or multiple configurations.

- If you’re using a branded bot and also Conversation Autopilot, you can specify the branded bot name displayed in the chat window during Autopilot sessions by changing certain system message properties. Use the System Messages related list of the Chat Setup form to change the following properties that control the bot name displayed in the chat header and chat window:
  - Update the com.glide.cs.autopilot.client_initiated_header system property to specify the branded bot name instead of the Virtual Agent bot name displayed in the header of the chat window.
Update the `com.glide.cs.autopilot.client_initiated_message` system property to specify the branded bot name displayed to the requester during the conversation.

For details on changing system message properties, see Change Virtual Agent and Live Agent system messages.
You can change the color of an interface item by using the text field next to the color to specify a color in one of these CSS formats:

- **Name**: predefined color names, such as red, green, blue
- **RGB hex**: For example, #223344

For more information on colors, see HTML Color Names (W3CSchools).

**Procedure**

1. Navigate to **Conversational Interfaces > Branding and Chat Menu**.
2. In the Brandings [sys_cs_branding_setup] table, click **New** to create a branding configuration or select the configuration record to be updated.
3. Specify the settings for your branding configuration:

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branding name</td>
<td>Name of the branding configuration.</td>
</tr>
<tr>
<td>Branding key</td>
<td>sys_id of the configuration, which reflects the <strong>Branding name</strong> entered. The key is in lower case letters with spaces replaced by underscore characters.</td>
</tr>
<tr>
<td>Chat Window</td>
<td></td>
</tr>
<tr>
<td>Chat Header</td>
<td>Text string that identifies your company or organization in the chat window. For example: Acme Support.</td>
</tr>
<tr>
<td>Chat Header Background</td>
<td>Background color of the chat header.</td>
</tr>
<tr>
<td>Chat Background</td>
<td>Background color of the chat window.</td>
</tr>
<tr>
<td>Menu Icon</td>
<td>Color of the menu icon, which provides user options to end a conversation or contact customer support.</td>
</tr>
<tr>
<td>Label</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chat Header Logo</td>
<td>Logo image that displays in the chat header. If live chat is run in a browser window, the logo also automatically displays in the browser tab.</td>
</tr>
<tr>
<td></td>
<td>• To add the logo, select <strong>Click to add...</strong> From the file finder, choose your logo file and select <strong>OK</strong>. The uploaded logo displays below this field.</td>
</tr>
<tr>
<td></td>
<td>• To change the logo, select <strong>Update</strong>. From the file finder, select the new logo file. The updated logo displays below this field.</td>
</tr>
<tr>
<td></td>
<td>• To remove the logo, select <strong>Delete</strong>. The file is immediately deleted.</td>
</tr>
<tr>
<td>Chat Header Font</td>
<td>Font color of text in the chat header.</td>
</tr>
<tr>
<td>Input Background</td>
<td>Background color of the user input bar.</td>
</tr>
<tr>
<td>Chat Messages</td>
<td></td>
</tr>
<tr>
<td>User Bubble Background</td>
<td>Background color of the user chat bubble.</td>
</tr>
<tr>
<td>Agent Bubble Background</td>
<td>Background color of the live agent chat bubble.</td>
</tr>
<tr>
<td>Bot Bubble Background</td>
<td>Background color of the bot chat bubble.</td>
</tr>
<tr>
<td>Link</td>
<td>Color of links presented in the conversation.</td>
</tr>
<tr>
<td>Button Background</td>
<td>Background color of buttons used in the conversation.</td>
</tr>
<tr>
<td>Notification Background</td>
<td>Background color of Virtual Agent notifications delivered in the web chat client.</td>
</tr>
<tr>
<td>Label</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Bubble Font</td>
<td>Font color of text in the user chat bubble.</td>
</tr>
<tr>
<td>Agent Bubble Font</td>
<td>Font color of text in the live agent chat bubble.</td>
</tr>
<tr>
<td>Bot Bubble Font</td>
<td>Font color of text in the bot chat bubble.</td>
</tr>
<tr>
<td>Link disabled</td>
<td>Color of disabled links presented in the conversation.</td>
</tr>
<tr>
<td>Bot Profile</td>
<td>List that opens the Live Profile form to select or create a new bot user profile, which includes the bot picture (avatar).</td>
</tr>
<tr>
<td></td>
<td>To create a bot profile, click New. In the Live Profile record:</td>
</tr>
<tr>
<td></td>
<td>• Enter the bot user Name. For example, Acme.</td>
</tr>
<tr>
<td></td>
<td>• In the Photo field, select Click to add... and in the file finder choose the bot image file.</td>
</tr>
<tr>
<td></td>
<td>• Click Submit.</td>
</tr>
<tr>
<td></td>
<td>The bot profile record is automatically created in the Live Profile [live_profile] table:</td>
</tr>
<tr>
<td></td>
<td>• In the Document field of the bot profile, the text string “VA Bot User” is appended to the bot name.</td>
</tr>
<tr>
<td></td>
<td>• The Short Description field indicates that the profile is for an auto-generated Virtual Agent bot.</td>
</tr>
<tr>
<td>Notification Text</td>
<td>Font color of Virtual Agent notifications delivered in the web chat client.</td>
</tr>
<tr>
<td>Other</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>System message</td>
<td>Color of general system messages displayed in the conversation.</td>
</tr>
<tr>
<td>Category background</td>
<td>Background color of the heading above a list of topics.</td>
</tr>
<tr>
<td>Separator</td>
<td>Color of the dashed line that separates each conversation in the Preview window.</td>
</tr>
<tr>
<td>Minimum delay before displaying typing animation (ms)</td>
<td>Minimum delay, in milliseconds (ms), that occurs before showing the animation ellipsis indicating the bot is processing user input.</td>
</tr>
<tr>
<td>Time Stamp</td>
<td>Color of the timestamp displayed when significant activity occurs during a conversation, such as a record being created.</td>
</tr>
<tr>
<td>Category font</td>
<td>Font color of text in the category heading.</td>
</tr>
<tr>
<td>Loading Animation</td>
<td>Color of the animated dots that indicate the system is processing information.</td>
</tr>
<tr>
<td>Minimum delay between bot messages (ms)</td>
<td>Minimum delay, in milliseconds (ms), that occurs between bot responses.</td>
</tr>
<tr>
<td>Call label</td>
<td>Text string that indicates when phone support is available. For example: Call Support (Daily 5 AM to 11 PM)</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Phone number of your call support organization. The phone number must be a valid number.</td>
</tr>
</tbody>
</table>

4. If you are creating a new configuration, click **Submit**.

5. To set the chat Menu Options, return to the Brandings [sys_cs_branding_setup] table (*Conversational Interfaces > Branding and Chat Menu*).

6. In the Menu Options section, update the Contact support menu options as needed. You can change the settings for the default Chat, Phone, and Email.
menu items, such as their menu visibility, labels, icons, and menu item order. You can also add custom options to the menu.

**a. To change the Menu Title**, enter the new title and click **Update**.

**b. In the Menu Items related list:**

- To update a base-system (default) menu item, select the item record. The menu items are Chat, Phone, and Email.
- To add a new menu item, click **New**.
- To delete a menu item, click the record in the related list, then click **Delete**.

In the Menu Item form, update or define the menu items. For each menu item you can set or change the following fields:

**Menu Options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Label | Text string that describes the menu item. The labels for the default menu items are:  
- Chat – Option for chatting with a live agent. Default label: **Contact Live Agent** for Chat type  
- Phone - Option that indicates when phone support is available. Default label: **Call Support— (Daily 5AM - 11PM)**  
- Email - Option that opens the default email. Default label: **Send Email to Customer Support**  
The label text can be up to 75 characters in length. |
<p>| Type | Type of menu item. For example, if you are adding a menu item that is a link to specific information such as a help page, select the <strong>Link Type</strong>. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>The types are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Email: Option for contacting support through email.</td>
</tr>
<tr>
<td></td>
<td>• Link: Option for a link to a web page</td>
</tr>
<tr>
<td></td>
<td>• Text: Option for setting a text string</td>
</tr>
<tr>
<td></td>
<td>• Phone: Option for contacting support by phone</td>
</tr>
<tr>
<td>Value</td>
<td>The menu type value. For example, the <strong>Value</strong> for Email is the email address of the support group.</td>
</tr>
<tr>
<td></td>
<td>The values for the default menu types are:</td>
</tr>
<tr>
<td></td>
<td>• Phone: Phone number of your call support organization</td>
</tr>
<tr>
<td></td>
<td>• Email: Email address of your support organization.</td>
</tr>
<tr>
<td>Note: The chat menu type does not have a value.</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Number that identifies the sequence in which the item appears in the Contact support menu. The number 1 indicates that the item is the first option listed in the menu.</td>
</tr>
<tr>
<td>Visible</td>
<td>Option that makes the item visible in the Contact support menu.</td>
</tr>
<tr>
<td></td>
<td>Clear this option to hide the menu item.</td>
</tr>
<tr>
<td>Display wait time</td>
<td>Option that enables the display of the wait time shown in the chat menu.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field Clear</td>
<td>Clear this option to hide the wait time.</td>
</tr>
<tr>
<td>Display default icon</td>
<td>Option that indicates the default icon for the item is visible in the menu. Clear this option to add, change, or delete a menu icon.</td>
</tr>
<tr>
<td>• To add an icon for a new menu item, select <strong>Click to add...</strong>. From the file finder, choose your icon file and select <strong>OK</strong>. The uploaded icon displays below the <strong>Icon</strong> field.</td>
<td></td>
</tr>
<tr>
<td>• To change an icon, in the <strong>Icon</strong> field select <strong>Update</strong>. From the file finder, select the new logo file and click <strong>OK</strong>. The updated icon displays below this field.</td>
<td></td>
</tr>
<tr>
<td>• To remove the logo, select <strong>Delete</strong>. The file is immediately deleted.</td>
<td></td>
</tr>
<tr>
<td>Audible alerts are on</td>
<td>Toggle switch visible to authenticated users, for enabling or disabling audible notification of Virtual Agent chats. If the toggle is disabled, audible notifications are not sent to the web client.</td>
</tr>
</tbody>
</table>

7. If you're updating a configuration, click **Save**.

8. If you're configuring branding for the web client, append the branding key to the web client link in your Service Portal widget:

   a. Navigate to **Service Portal > Widgets**.

   b. In the Widgets [sp_widget] table, open the record for the Virtual Agent **Service Portal** Widget.
c. In the Client controller section of the record, search for the string `sn-va-web-client-app.do` and append `sysparm_branding_key=<branding_key>`, where `branding key` is the branding configuration. In this example, the `sysparm_branding_key=acme` is appended to the web client.

```javascript
if (!$ctrl.firstPress) {
    $ctrl.firstPress = true;
    $ctrl.vaSource = '/sn-va-web-client-app.do?sysparm_branding_key=acme;sysparm_nostack=true&sysparm_stack=no';
    if ($ctrl.options.va_url_params) {
        $ctrl.vaSource = $ctrl.vaSource + '&' + $ctrl.options.va_url_params;
    }
}
```

d. Click **Save**.

9. Do one of the following to apply the branding configuration in the web client:

- Apply the branding configuration to a destination page. Enter the system parameter `sysparm_branding_key` with the branding key in the web client URL. For example:

  ```
  https://<your-instance-name>service-now.com/sn-va-web-client-app.do?
  sysparm_branding_key=acme
  ```

  where `acme` is the key of the branding configuration to be used.

- Apply the branding configuration to an embedded web client. Enter the system parameter `sysparm_branding_key` with the branding key in the URL for the embedded web client. For example:

  ```
  https://<your-instance-name>service-now.com/sn-va-web-client-app_embed.do?
  sysparm_branding_key=acme
  ```

  where `acme` is the key of the branding configuration to be used.

- Apply the branding configuration to a Service Portal Agent Chat Configuration. In the server script that passes page and widget data to an Agent Chat (Virtual Agent or Live Agent) conversation, specify the branding key to be used. Items passed in this script are available to all pages in the portal. For details on setting up Service Portal Agent Chat, see Configure the Service Portal chat client.

  For example, the following Service Portal Agent Chat Configuration for the Knowledge Portal uses the chat branding key, `custom_1`. 
**Note:** For more information on branding the Agent Chat widget in Service Portal, see Configure Agent Chat in Service Portal.

**Configuring Virtual Agent notifications**

Send ServiceNow notifications directly to users via the Virtual Agent chatbot on supported messaging channels. Notifications can be simple informational messages for review, or actionable messages with buttons that users can select to perform certain actions.

Notifications are sent to recipients via the Virtual Agent bot in the web client, pre-built messaging integrations (for example, SMS Twilio, Slack, Microsoft Teams, Workplace from Facebook services, and Facebook Messenger messaging platform), and custom chat integrations. Notification functionality is included with the Glide Virtual Agent (com.glide.cs.chatbot) and Virtual Agent Lite (com.glide.cs.chatbot.lite) plugins. Virtual Agent Lite users can receive simple notifications, while Virtual Agent Pro users can receive actionable notifications as well as simple notifications. Users with no associated ServiceNow profiles in the [sys_user] table can receive non-actionable Virtual Agent notifications.

**Notification layouts and content**

As an admin, you can define notifications that have different layouts and types of content:

- Notifications can be a standard informational message, record card, or an image card that contains an image that you provide.

- Actionable notifications have buttons that enable the recipient to perform certain actions, such as adding a comment or requesting a Live Agent. When you create an actionable notification, you associate an action with a published Virtual Agent topic, a scriptable action, or a flow action that handles the action to be performed.
Note: The notifications are actionable only when there is an associated link action to its content.

Actionable notifications are best suited for conversational purposes, for use cases such as:
- Password reset
- Incident update
- Approval request
- Course survey
- Service follow-ups and surveys
- Employee onboarding follow-ups

Notification delivery
The delivery of Virtual Agent notifications differs, depending on the notification type:

- **Message notifications** - These notifications are delivered immediately to the end user, even if the user is chatting with a bot or Live Agent. The user sees the incoming message but can continue with the current conversation.

- **Actionable notifications** - These notifications are delivered only when the user is not engaged in an active conversation with a virtual or live agent.
  - A queue stores actionable notifications that are waiting to be delivered, for up to eight hours by default. Admins can change the default lifespan of actionable notifications by changing the value of the `com.glide.cs.idle_actionable_notification_timer` system property. Admins can specify a maximum of 72 hours for a notification.
  - When users complete their conversations with the bot or live agent, they can view a list of pending notifications, which displays the heading of each notification. Users can select a pending notification to review, then perform the appropriate action for the notification, or skip the action.
Virtual Agent notifications have certain processing limitations:

- Maximum number of recipients per notification per channel: 1000 (default)
  
  To change the maximum number of recipients per notification, change the value of the `com.glide.cs.per_notification_user_limit` system property.

- Maximum number of notifications per day: 10000 (default)
  
  To change the maximum number of notifications that can be sent per day, change the value of the `com.glide.cs.daily_notification_limit` system property.

User subscriptions for notifications

End users can subscribe or unsubscribe to notifications on the channel that they're using. For example, the chat menu provides a toggle switch that users can use to subscribe or unsubscribe to notifications on the web channel.

In the conversational integrations for Slack, Microsoft Teams, Workplace from Facebook services, end users manage their notification subscriptions by using the **Subscribe** and **Unsubscribe** commands.

What to do next

Create Virtual Agent notifications.

Create Virtual Agent notifications

Create a notification that is sent directly to users via the Virtual Agent chatbot. The notification specifies when users receive the notification (triggers for the notification) and who receives it (recipients with and without accounts in the User [sys_user] table).

Before you begin

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to **System Notification > Provider > Notifications** and select **New**.
2. On the form, fill in the fields.
## Notifications form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to receive notifications about.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the notification.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the notification.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification. The notification is active by default.</td>
</tr>
</tbody>
</table>

### Trigger

- **Triggered By**
  - System action that triggers the notification. You can send the notification after a record is changed or after an event is triggered.

- **Inserted**
  - Option to send the notification after a record is inserted.
    - This field appears when you select **Record Change** in the **Triggered By** field.

- **Updated**
  - Option to send the notification after a record is updated.
    - This field appears when you select **Record Change** in the **Triggered By** field.

- **Event**
  - Event that triggers the notification. For example, to send a notification after an incident is closed or resolved, you would select **incident.inactive** event. By default, this event is logged in the system each time a user resolves or closes an incident.
    - This field appears when you select **Event** in the **Triggered By** field.

- **Conditions**
  - Filter to specify the table records that users receive notifications about. For example, to send notifications about top-priority incidents, you would select **incident [incident]** in the **Table** field and set the conditions to **[Priority] [is] [1 - Critical]**.

### Recipients

- **Users**
  - Users who receive the notification.
    - Add users from the static users ([sys_user] table or its extension tables) to define recipients for the notification.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipients in fields</td>
<td>Record fields that include recipients who receive the notification. For example, to send the notification to the record assignee, select <strong>Assigned to</strong>. Add recipients from the [sys_user] table or its extension tables to trigger the notification.</td>
</tr>
<tr>
<td>Is originating user included?</td>
<td>Option to include the user who changed the record or triggered the event.</td>
</tr>
</tbody>
</table>

**Note:** You can define the recipients for notifications only for chat channels using this field.

**Note:** You can define the recipients for notifications for both chat channels and messaging channels using this field.

3. Select **Submit**.

**Note:** Use the **Submit** button for Virtual Agent notifications. The **Submit and Add Common Content** button is for other use cases.

What to do next

- Create additional recipients for Virtual Agent notifications.
- Define the notification contents.

Create additional recipients for Virtual Agent notifications

Create and define additional recipients for a Virtual Agent notification to be delivered on chat channels or messaging channels.

Before you begin

Role required: admin

About this task

- The admin can define recipients under the Additional Recipients related list for messaging channels.

  **Note:** Selecting the channel (chat channel or messaging channel) is a prerequisite to defining the content for the notification.

- The admin can define recipients under the Additional Recipients related list for chat and messaging channels using a dynamic condition.
Procedure
1. Navigate to **System Notification > Provider > Notifications** and select the notification that you want to create additional recipients for.
2. In the Additional Recipients related list, click **New**.
3. On the form, fill in the fields.

### Additional Notification Recipients form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification</td>
<td>Identifier of the notification. The notification name is auto-populated.</td>
</tr>
<tr>
<td>Recipient Table</td>
<td>The scope of the recipient record for the notification. The <strong>Recipient Table</strong> field is auto-populated with the user [sys_user] as the default value.</td>
</tr>
<tr>
<td>Application</td>
<td>The scope of the recipient record.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification for the defined additional recipients.</td>
</tr>
<tr>
<td>Static Recipients</td>
<td>Names of the recipients from the scope of the selected recipient table.</td>
</tr>
<tr>
<td>Dynamic Recipients</td>
<td>Dynamic filter conditions for the defined recipients. The dynamic condition is applicable for both messaging and chat channels. This dynamic condition enables you to define the recipients list for a group of users to send a notification. Click the refresh icon (🔍) next to the <strong>records match condition</strong> link to update the exact number of records matching the latest filter condition.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>default</td>
<td>it shows the total number of records in the current table.</td>
</tr>
</tbody>
</table>

**Note:** Only one active record can be added for a particular recipient table. If you want to add another record for the recipient table, you must deactivate the current record.

4. Click **Submit**.

**Define Virtual Agent notification contents**
Create the content for a Virtual Agent notification delivered in a chat or messaging channel.

**Before you begin**
- Images for image cards must be 400 pixels wide or larger and must be in .jpg, .png, .bmp, .gif, .ico, or .svg format.
- Role required: virtual_agent_admin or admin

**Procedure**
1. Navigate to **System Notification > Provider > Notifications** and select the notification for which you're defining or updating content.

2. Do one of the following:
   - If you're defining new content, navigate to the **Notification Contents** related list, select **New Provider Content**, and go to step 3.
   - If you're updating content, navigate to the **Notification Contents** related list, select the content to be updated, and go to step 4.

3. Select the Virtual Agent content type:
   - **Virtual Agent Content - Chat**: The notification is for chat channels.
   - **Virtual Agent Content - Messaging**: The notification is for a messaging channel, such as SMS.
4. Provide or update the notification content:

   a. On the form, fill in the fields for the chat or messaging notification:

**Notification Content - Virtual Agent Chat or Virtual Agent Messaging**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification content.</td>
</tr>
<tr>
<td>Notification</td>
<td>Notification that is associated with the content. This field is populated automatically with the notification that you created.</td>
</tr>
<tr>
<td>Type</td>
<td>Notification layout:</td>
</tr>
<tr>
<td></td>
<td>• Simple: A message-only notification, that contains information for review.</td>
</tr>
<tr>
<td></td>
<td>• Record card: A notification that contains information about a particular record in a table.</td>
</tr>
<tr>
<td></td>
<td>• Image card: A notification that contains images.</td>
</tr>
<tr>
<td>Table</td>
<td>(For Record Cards) Table to receive notifications about. This field is populated automatically with the table defined in the notification.</td>
</tr>
<tr>
<td>Fields</td>
<td>(for Record Cards) Fields to be displayed in the notification. For example, if you select <strong>Comments and Work notes</strong>, the notification includes the comments and work notes that users have added to the record.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the notification content.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification content.</td>
</tr>
<tr>
<td>Enable link</td>
<td>(For Record Cards) Option to add a link to the record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Message heading</td>
<td>Text that appears at the top of the message. The default message heading is: A notification has arrived. You can continue the conversation after viewing the notification.</td>
</tr>
<tr>
<td>Message</td>
<td>Content of the message with rich text format. A notification message defined with rich text format is displayed in bold, italics, link (url), and unordered list. When a user clicks the URL in the message, it is redirected to the destination as per the portal configuration.</td>
</tr>
<tr>
<td>Image Source</td>
<td>(For Image Cards) Option for selecting the image to be displayed in the notification:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Image</strong></td>
<td>(For Image Cards) Image displayed in the card.</td>
</tr>
<tr>
<td></td>
<td>• To add the image, select <strong>Click to add</strong>. From the file finder, choose your image file and select <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To change the image, select <strong>Update</strong>. From the file finder, select the new image file and select <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To remove the image, select <strong>Delete</strong>. The file is immediately deleted.</td>
</tr>
<tr>
<td><strong>Image alt text</strong></td>
<td>(For Image Cards) Alternative text for the image to be displayed in the card.</td>
</tr>
</tbody>
</table>

**Note:** To create or update the messaging notification details, navigate to the **Delivery Channel** related list and complete the form. For more information see **Configure a delivery channel for Virtual Agent notification**.

b. Select **Submit** or **Update**.

**What to do next**

• To configure a delivery channel, see **Configure a delivery channel for Virtual Agent notification**.

• If you’re creating an actionable notification, see **Define the actions**.

**Configure a delivery channel for Virtual Agent notification**

Configure a delivery channel for Virtual Agent notification by specifying the messaging channel information to send notifications to users. Using this related list, you can support multiple channels for the same notification content.

**Before you begin**

Ensure that a messaging channel is configured in your instance.

**Note:** Configuring delivery channels is limited only to messaging channels.

Role required: virtual_agent_admin
Procedure

1. Navigate to System Notification > Provider > Notifications and select the notification that you want to define or update content for.
2. In the Notification Contents related list, open the notification content.
3. In the Delivery Channels related list, click New.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Content</td>
<td>Reference of the notification content pre-populates for the delivery channel.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the delivery channel.</td>
</tr>
<tr>
<td>Connection</td>
<td>Connection record for the messaging channel configured in the instance.</td>
</tr>
<tr>
<td>Send From</td>
<td>Provider application for the selected messaging channel.</td>
</tr>
<tr>
<td>Send To (Table)</td>
<td>Name of the table that you want to send the notifications to.</td>
</tr>
<tr>
<td>Send To (Field)</td>
<td>Name of the field that you want to send the notifications to. This field is optional.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Define Virtual Agent notification actions

Create the actions for a Virtual Agent chat or messaging channel to send actionable notifications.

Before you begin

- An action requires an associated, published (active) Virtual Agent topic, a Scriptable action, or a Flow action which can perform the action represented by a button in the notification, such as talk to an agent (live agent support) or bot feedback (Virtual Agent feedback). Consider working with your topic authors to determine the appropriate topics and corresponding actions. For
more information about designing the Virtual Agent topics, see Using Virtual Agent Designer.

Note: Scriptable actions and Flow actions are asynchronous and are executed when you select the action without a Virtual Agent topic. You can select either an existing flow that is defined or coordinate with the flow authors to send actionable notifications.

- Role required: virtual_agent_admin or admin

Procedure

1. Navigate to System Notification > Provider > Notifications and select the notification for which you are defining actions.

2. Navigate to the Notification Actions related list and select New Provider Action.

3. Select a notification action.

4. On the form, fill in the fields to define the notification actions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification action, for example, Talk to an agent.</td>
</tr>
<tr>
<td>Notification</td>
<td>Notification that is associated with the action. This field is populated automatically with the notification that you created.</td>
</tr>
<tr>
<td>Async</td>
<td>Option to enable the action execution without blocking the current request. Both Script and Flow actions in Virtual Agent are asynchronous.</td>
</tr>
<tr>
<td>Topic</td>
<td>Virtual Agent topic that handles this notification action.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>Virtual Agent Pro is required to send a topic with actionable notification.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to execute the notification action. The script field is available only when you select Scriptable notification action.</td>
</tr>
<tr>
<td>Note:</td>
<td>The Scriptable Action is available only for Virtual Agent Pro users.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the notification content.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification content.</td>
</tr>
<tr>
<td>Choose Flow or Action</td>
<td></td>
</tr>
<tr>
<td>Flow</td>
<td>Flow to trigger the sequence of the notification action.</td>
</tr>
<tr>
<td>Note:</td>
<td>• You cannot choose the flow if you provided the action.</td>
</tr>
<tr>
<td></td>
<td>• The Flow field appears only when you select Flow notification action.</td>
</tr>
<tr>
<td></td>
<td>• The Flow Action is available only for Virtual Agent Pro users.</td>
</tr>
<tr>
<td>Action</td>
<td>Action to use the correct table and field configuration for the notification action.</td>
</tr>
<tr>
<td>Note:</td>
<td>• You cannot choose the action if you provided the Flow.</td>
</tr>
<tr>
<td></td>
<td>• The Action field appears only when you select the Flow notification action.</td>
</tr>
<tr>
<td></td>
<td>• The Flow Action is available only for Virtual Agent Pro users.</td>
</tr>
<tr>
<td>Inputs</td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td>Script to pass inputs to a flow action. This Script field appears when you select the Flow notification action.</td>
</tr>
</tbody>
</table>
5. Select Submit.
6. To define another action for the notification, repeat steps 3 through 5.

What to do next
Define link actions to notification content.

Define Virtual Agent link actions to notification content
Create the link actions for Virtual Agent notification content to be delivered in a chat or messaging channel as actionable notifications. Notification content, with no associated link actions, is delivered as a non-actionable notification.

Before you begin
• Ensure that you have activated the Glide Virtual Agent plugin (com.glide.cs.chatbot).

   Note: Only Virtual Agent Pro customers can associate actions to notification contents and receive actionable notifications.
• Role required: virtual_agent_admin or admin.

Procedure
1. Navigate to System Notification > Provider > Notifications and select the notification that you're defining the link actions for.
2. In the Link Actions related list, click New.
3. On the form, fill in the fields.

   **Actionable Content form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the link action.</td>
</tr>
<tr>
<td>Actions</td>
<td>Notification action that the link action is created to. You can select one or more notification actions for a notification and also order them the way that you want them to be shown on the notification.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the notification content.</td>
</tr>
</tbody>
</table>
### Field and Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification</td>
<td>Notification that is associated with the content. This field is populated automatically with the notification that you created.</td>
</tr>
<tr>
<td>Content</td>
<td>Notification content that the link action is created to.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the notification content.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. To define another link action for the notification content, repeat steps 3 and 4.

**What to do next**

Enable Virtual Agent notifications.

**Enable Virtual Agent notifications**

Enable Virtual Agent notifications so that your end users can receive notifications in supported Virtual Agent channels.

**Before you begin**

Role required: virtual_agent_admin or admin

**Procedure**

Enable notifications for your users in the appropriate channel:

<table>
<thead>
<tr>
<th>Channel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web client</td>
<td><strong>a.</strong> Navigate to Conversational Interfaces &gt; Chat Setup.&lt;br&gt;<strong>b.</strong> In the Chat Setup form, select Enable notifications for all users.</td>
</tr>
<tr>
<td>Channel</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Slack, Microsoft Teams, or Workplace messaging integrations | a. Navigate to Conversational Interfaces > Messaging Apps Integration.  
b. For the appropriate messaging integration, select Enable notifications for all users.  

Notifications are sent to recipients via the Virtual Agent bot in the channels that you enabled.  

**Configure context topic intent**  
Use pre-chat survey information to determine the appropriate Virtual Agent conversation topic automatically displayed to end users (requesters), rather than prompting them to choose from a list of conversation topics.
Before you begin

- In Chat Setup, define the chat context variables for storing user answers to specific questions in your chat surveys.
- As you create your chat survey, map a survey question to a chat context variable that you defined. The variable stores the user response that Virtual Agent uses to determine topic intent and conversation topic displayed.
- Role required: virtual_agent_admin or admin

About this task
You specify conditions that determine the Virtual Agent conversation topic to be displayed after the end user completes the pre-chat survey.

Procedure
1. Navigate to Conversational Interfaces > Context Topic Intent and click New.
2. Complete the form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the configuration for context topic intent (topic discovery).</td>
</tr>
<tr>
<td>Active</td>
<td>Option that enables this topic intent configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which Virtual Agent evaluates topic intent configurations to find a matching condition for displaying the topic. Virtual Agent reviews the configuration that has the lowest order value first.</td>
</tr>
<tr>
<td>Condition mode</td>
<td>Type of condition that determines how the topic intent configuration is to be applied.</td>
</tr>
<tr>
<td></td>
<td>• Simple: Specify a condition using the condition builder.</td>
</tr>
<tr>
<td></td>
<td>• Advanced: Specify a JavaScript scripted condition.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition for applying the specified context variable that displays the corresponding conversation topic.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>If no condition is specified, the specified context variable applies to all conversations.</td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td>JavaScript condition statement for applying the specified context variable that displays the corresponding conversation topic. The condition must evaluate to true.</td>
</tr>
<tr>
<td>Context</td>
<td>Chat context variable that stores the user response to a specific survey question and used to determine the topic intent. You define this variable in Chat Setup.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Results**

The context topic intent configuration is added to the Context Topic [sys_cs_context_topic] table. Virtual Agent displays the appropriate conversation topic to users based on the context intent configuration.

**Create cross-scope access privileges for topic blocks and custom controls**

Enable topic authors and developers to access Virtual Agent topic blocks and custom controls from other scoped applications.

**Before you begin**

Role required: admin

**About this task**

Developers and topic authors may need to access topic blocks and custom controls created in other application scopes. To give them access, define cross-scope privilege records for the appropriate applications. For more information on cross-scope privileges, see [Cross-scope privilege record](#).

**Procedure**

1. Activate the Virtual Agent conversation plugins for the applications that are the source and target scopes, for example the CSM (com.sn_csm.virtualagent) or ITSM Virtual Agent (com.snc.itsm.virtualagent) plugins.

2. Set your application scope (the Source scope requesting access) using the application picker.
3. Navigate to **System Applications > Application Cross-Scope Access** and select **New**.

4. On the Cross scope privilege form, complete the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source scope</td>
<td>Application requesting access to another application's resources.</td>
</tr>
<tr>
<td>Target Scope</td>
<td>Application whose resources are being requested (the scope with the topic blocks or custom controls).</td>
</tr>
<tr>
<td>Target Name</td>
<td>Name of the object being requested: sys_cs_topic</td>
</tr>
<tr>
<td>Target Type</td>
<td>Table</td>
</tr>
<tr>
<td>Operation</td>
<td>Read</td>
</tr>
<tr>
<td>Status</td>
<td>Authorization for this record: Allowed</td>
</tr>
</tbody>
</table>

5. Select **Submit**.

**Results**

The cross-scope privilege is listed in the Cross scope privileges [sys_scope_privilege] table. Topic authors or developers can access the topic blocks or custom controls from the target scope.

**Setting up chat experiences for Virtual Agent users**

Create different chat experiences for your end users based on the context in which they initiate a conversation with Virtual Agent.

**How chat experiences work**

A chat experience defines the structure of a bot conversation (setup topics), an initial set of topics displayed to users (promoted topics), and the AI Search configurations for displaying search results in conversations. Virtual Agent provides a preconfigured, default chat experience that you (admins and topic authors) can use to control the user experience with Virtual Agent.

If you're using Virtual Agent Pro, you can configure the default chat experience and also create custom chat experiences, tailored to the context in which different users run Virtual Agent, such as the service portal or channel that they're using. Custom chat experiences inherit the default chat experience settings, but you can override the defaults as needed for a given context.
**Note:** If you’re using Virtual Agent Lite, you can configure certain setup topics in the default chat experience but you can’t create custom chat experiences.

A chat experience consists of:

**Setup topics**

Virtual Agent provides common conversational elements, such as a welcome greeting to begin a conversation and a conversation closing, and automatically includes them in virtual agent conversations. These pre-built elements, called setup topics, are part of a basic conversation structure that is applied to all your conversations. They are installed with Virtual Agent and Virtual Agent Lite.

These setup topics run automatically at appropriate points in a conversation, based on the context, utterances (if NLU is enabled), or keywords that users enter during the conversation.

**Example setup topics in a conversation**

<table>
<thead>
<tr>
<th>Setup topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greeting</td>
<td>Presents a welcome greeting to users, and asks users to enter a request or see what items it can assist with.</td>
</tr>
<tr>
<td>Setup topic</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Provide Virtual Agent Feedback</td>
<td>Displays a survey to get user feedback on the conversational experience, before the conversation ends.</td>
</tr>
<tr>
<td>Live Agent Support</td>
<td>Enables users to request a live agent transfer and view items that the live agent can assist with.</td>
</tr>
<tr>
<td>Virtual Agent Capabilities</td>
<td>Presents a list of what the virtual agent can help with.</td>
</tr>
<tr>
<td>Error Handling Topic</td>
<td>Displays a standard error message when an unrecoverable system error occurs and transfers the user to a live agent.</td>
</tr>
<tr>
<td>Closing Conversation</td>
<td>Displays a closing message that ends the conversation.</td>
</tr>
<tr>
<td>AI Search Fallback</td>
<td>Generates AI Search results for a user when Virtual Agent can't find a matching intent and topic or keyword.</td>
</tr>
<tr>
<td>Fallback Topic</td>
<td>Presents standard messages that ask the user to enter another request or select a different topic when the virtual agent does not understand a user entry or selection.</td>
</tr>
<tr>
<td>Anything Else Topic</td>
<td>After completing a task or request, virtual agent asks if the user needs further assistance with another request or task.</td>
</tr>
</tbody>
</table>

The setup topics have corresponding intents (set in the pre-built NLU model for setup topics) and also keywords. Virtual Agent recognizes the utterances or keywords that users can enter to run certain setup topics, such as the Virtual Agent Capabilities (help) topic or the Live Agent support topic.

You can preview (test) the pre-built setup topics to see how they work. In the Topics page of Virtual Agent Designer, use the Type filter to list the Setup Topics and select the setup topics to test.

Pre-built topics are read-only, but you can duplicate, customize (modify) if needed, and publish them.

**Promoted topics**

You can display a collection of up to six topics that are relevant to your users, displayed before the **Show me everything** button in
the chat window. You can use these promoted topics in a chat experience to give your users quick and convenient access to the topics used for a given context.

ℹ️ **Note:** Promoted topics are supported only on the web and mobile clients.

### Example promoted topics

![Promoted topics in chat window](image)

**Search profile**

A search profile defines how Virtual Agent search results are generated through the AI Search application and how the results are displayed to users. Virtual Agent uses a default search application that controls the data source for searches and a UI configuration (set in the Entity View Action Mapping application) that controls the search results displayed in Genius cards and multi-link output. These configurations also apply to search results generated as a fallback when Virtual Agent can't determine the appropriate topic. For more information, see [Virtual Agent integration with AI Search](#).
Get started with chat experiences

Use the Custom Greetings and Setup option (Conversational Interfaces > Virtual Agent > Custom Greetings and Setup) to manage the default and custom chat experiences. You can:

- Configure the default chat experience, including the setup topics, promoted topics, and search criteria used. For example, you can activate the Virtual Agent Feedback setup topic so that it is applied to all your bot conversations.
- Create different custom chat experiences based on the context in which your end users run Virtual Agent. The settings that you define in a custom chat experience override the default chat experience.

Working with setup topics

Setup topics are part of a standard conversation structure applied to all your conversations, such as the welcome greeting or fallback responses. Setup topics run at the appropriate spot in a conversation based on the context, keywords, or utterances entered by the user, and any conditions that are specified for the setup topic.
You define setup topics in a Virtual Agent Designer chat experience using the Custom Greetings and Setup option. A chat experience sets the context in which users run Virtual Agent. This context includes:

- Setup topics applied to bot conversations.
- A small list of topics, called promoted topics, initially displayed in the chat window.
- AI Search configuration used to display AI Search results for your users.

For more information on chat experiences, see Setting up chat experiences for Virtual Agent users. For details on configuring a chat experience, see Configure a Virtual Agent chat experience.

**Note:** Setup topics in conversations are discoverable by topic discovery only when they're configured in a Virtual Agent chat experience using the Custom Greetings and Setup option. If any setup topics aren't included in a chat experience, those setup topics aren't listed in the All Topics menu and can't be discovered by Virtual Agent.

Setup topics run during a conversation as follows:

1. Conversation beginning: Virtual Agent presents the Greeting topic and the list of available topics (Virtual Agent capabilities) that the user can select.

2. Conversation body: These setup topics are presented at different points in the conversation depending on the context:
   - User requests help: Virtual Agent presents the Explore help topic (Virtual Agent capabilities).
   - User enters a request or keyword that Virtual Agent doesn’t understand: Virtual Agent presents the Fallback topic, unless the AI Search fallback topic is enabled.
   - If the AI Search Fallback topic is enabled and the user enters a request or keyword but Virtual Agent can't find a matching topic or keyword, or finds too many topics to determine the matching topic: Virtual Agent runs AI Search to generate relevant search results for the user. If the AI Search results do not help the user, or if the AI Search Fallback setup topic is not activated, Virtual Agent runs the Fallback topic.
   - An unrecoverable system error occurs during conversation: Virtual Agent runs the Error Handling topic, and then transfers the user to a live agent.
   - User requests a transfer to live agent: Virtual Agent runs the Live Agent topic, which transfers the user to a live agent.
   - After a task or user request is completed: Virtual Agent runs the Anything else topic to ask if the user wants to continue with another request or task.
3. Conversation ending:
   - If the user doesn't want further assistance after a task or the request is completed, Virtual Agent presents the Survey topic for feedback on the conversational experience.
   - After the survey, Virtual Agent confirms that the feedback has been received, and runs the Closing topic to end the conversation.

The default setup topics are read-only and have topic names with a period at the end of the setup topic name, such as **Greeting**. You can create your own custom setup topics by duplicating a setup topic and changing it as needed. You can also change prompts or add other controls to the topic, just as you might when creating other topics.

If you want a closing message to be different from the default Closing topic, create a custom setup topic that contains the revised closing text. You also need to create an intent for that custom setup topic in the NLU model for setup topics, or define topic keywords in the Topic Properties page. You can then select the custom setup topic to be used in a custom chat experience instead of using a default setup topic.

The following table provides examples of the pre-built setup topics in the default chat experience:

<table>
<thead>
<tr>
<th>Setup topic type</th>
<th>Setup topic name and description</th>
</tr>
</thead>
</table>
| Anything else    | Anything Else Topic. Virtual Agent asks users if they need further assistance.  
|                  | ![Is there anything else I can assist you with?  
|                  | Yes  
|                  | No  
|                  | If users select **Yes**, Virtual Agent returns a list of related items that it can help with. |
| Live agent       | Live Agent Support. Tells users that a live agent transfer is in process:  
|                  | ![Please stand by while I connect you to a live agent.  
<p>|                  | Routing you to a live agent...] |</p>
<table>
<thead>
<tr>
<th>Setup topic type</th>
<th>Setup topic name and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>Error Handling Topic. Displays a generic error message to the user when the Virtual Agent encounters a problem that it can’t resolve (unrecoverable system error) and transfers the user to a live agent.</td>
</tr>
<tr>
<td></td>
<td><img src="image1" alt="An unrecoverable error has occurred." /></td>
</tr>
<tr>
<td></td>
<td><img src="image2" alt="Please stand by while I connect you to a live agent." /></td>
</tr>
<tr>
<td></td>
<td><img src="image3" alt="Routing you to a live agent..." /></td>
</tr>
<tr>
<td>Greeting</td>
<td>Greetings. Starts a conversation by greeting users and giving them the option to enter a request or see the items that the Virtual Agent can assist with.</td>
</tr>
<tr>
<td></td>
<td><img src="image4" alt="Hi, I’m your Virtual Agent. Let me know how I can help you today." /></td>
</tr>
<tr>
<td></td>
<td><img src="image5" alt="What’s your issue or request? Or take a look at what I can help with." /></td>
</tr>
<tr>
<td></td>
<td><img src="image6" alt="Show me everything &gt;" /></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The pre-built setup topics include a personalized greeting called the Dynamic Greeting Topic, which welcomes the user by name. To change the default greetings topic, double click <strong>Setup topic name</strong> and then choose the personalized greeting from the list of available setup topics.</td>
</tr>
<tr>
<td>Survey</td>
<td>Virtual Agent Feedback topic. Gathers user feedback on the conversational experience with the Virtual Agent. The survey setup topic displays randomly in 33% of your Virtual Agent conversations.</td>
</tr>
</tbody>
</table>
### Setup topic type

<table>
<thead>
<tr>
<th>Setup topic type</th>
<th>Setup topic name and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The survey topic includes an introductory sentence that admins can customize as needed. The survey then presents a choice list with options users can select to describe their experience.</td>
<td></td>
</tr>
</tbody>
</table>

After the users provide their feedback, a message confirms that their feedback has been received.

#### Note:
To change the probability (percentage) that the survey setup topic occurs in your conversations, change the value in the `com.glide.cs.survey.probability` system property. To display the survey setup topic randomly in 50% of your Virtual Agent conversations, set the **Value** to 0.50.

<table>
<thead>
<tr>
<th>Closing</th>
<th>Closing Conversation. Displays a closing message to the user that ends the conversation:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Thank you for using our support chat" /></td>
</tr>
</tbody>
</table>

| AI Search fallback | AI Search Fallback. When enabled, this setup topic uses AI Search search to generate fallback AI Search results when Virtual Agent can't find a matching intent or it finds too many intents and can't determine the appropriate topic to display to a user. |

<table>
<thead>
<tr>
<th>Fallback</th>
<th>Fallback Topic. Displays a standard message to the user when:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• When virtual agent doesn't understand a user utterance or keyword and the AI Search fallback setup topic is not enabled in the chat experience. AI Search fallback topic was deactivated in the</td>
</tr>
<tr>
<td>Setup topic type</td>
<td>Setup topic name and description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>chat experience, and the virtual agent doesn’t understand a user statement or keyword.</td>
<td></td>
</tr>
<tr>
<td>• Users indicate that the AI Search results aren’t helpful.</td>
<td></td>
</tr>
<tr>
<td>Please try giving me your request in a different way. I’m currently better at understanding short sentences.</td>
<td></td>
</tr>
<tr>
<td>What’s your issue or request? Or take a look at what I can help with.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Explore help</th>
<th>Virtual Agent Capabilities. Enables users to ask for assistance during a conversation and view a list of items that the Virtual Agent can assist with (Virtual Agent capabilities).</th>
</tr>
</thead>
<tbody>
<tr>
<td>What’s your issue or request? Or take a look at what I can help with.</td>
<td></td>
</tr>
</tbody>
</table>

### Change text in the Show me everything button

Configure the text in the **Show me everything** button displayed in the chat window, by editing a copy of the Greetings setup topic. This setup topic controls the display of the initial greetings and the **Show me everything** button in Virtual Agent conversations.

### Before you begin

- Create a copy of the Greetings setup topic, since the pre-built Greetings setup topic is read-only.
- Role required: virtual_agent_admin or admin
About this task
The Greetings setup topic contains the Send Topic Picker script action, which controls the text in the Show me everything button. To change the text, edit the Send Topic Picker script action in the copy of the Greetings setup topic.

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Designer and select the copy of the Greetings setup topic that you created.
2. In the Flow tab, select the node for the Send Topic Picker script action.
3. In the Script Action Properties sheet, open the Action Expression script, change the greetingMessage text string as needed, and select Save. For example, to change the button text to Show more, you would change the script as follows:

```javascript
(function execute() {
    var greetingMessage = vaSystem.getTopicSelectionMessage();
    vaSystem.sendTopicPickerControl(greetingMessage, "Show more");
})()
```

4. Preview the change by in the chat window by selecting Test in the header bar. Here's the button text change made in the previous example:
5. Select **Save** in the header bar.

6. When you're ready to make the topic active, select **Publish**.

**Change the Virtual Agent greeting messages in the Greeting setup topic**

The Virtual Agent greeting setup topic provides default greeting messages for your conversations. To change the default messages in this greeting, you can add system properties that change the default welcome message and the top selection message that prompts the user to enter an issue or request.

**Before you begin**

Role required: virtual_agent_admin or admin

**About this task**

Starting with the Orlando release, the `com.glide.cs.general.welcome_message` and `com.glide.cs.general.top_selection_message` properties are no longer automatically installed with Virtual Agent. These properties define the greeting messages used in the Greeting setup topic.

In the Orlando release, the default Greeting setup topic was updated. If you upgraded from the New York release, these properties are retained so that you can continue using the original Greeting setup topic.
topic. If you want to use the updated Greeting setup topic (see the example below), delete the `com.glide.cs.general.welcome_message` and `com.glide.cs.general.top_selection_message` system properties that contain the original Greeting messages.

For new customers, the updated Greeting setup topic (see the example below) is the default. If you want to change the default message text in the Greeting setup topic, add these system properties to the System Property [sys_properties] table:

- `com.glide.cs.general.welcome_message` - Change the default welcome message
- `com.glide.cs.general.top_selection_message` - Change the top selection message that displays after the welcome message

**Default messages in Greeting setup topic (starting with the Orlando release)**

![Welcome message](image1)

**Procedure**

1. In the navigation filter, enter `sys_properties.list`.

2. Click **New** to add the `com.glide.cs.general.welcome_message` property.

   a. Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the system property name: <code>com.glide.cs.general.welcome_message</code></td>
</tr>
<tr>
<td>Description</td>
<td>Enter an explanation for this property: Welcome message</td>
</tr>
<tr>
<td>Type</td>
<td>Select string.</td>
</tr>
</tbody>
</table>
Enter the greeting text. For example: How can I help you?

b. Click Submit.

3. In the System Properties table, click New to add the `com.glide.cs.general.top_selection_message` property.

a. Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the system property name: <code>com.glide.cs.general.top_selection_message</code></td>
</tr>
<tr>
<td>Description</td>
<td>Enter an explanation for this property: Top selection message</td>
</tr>
<tr>
<td>Type</td>
<td>Select string.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the text that specifies the next selection action that the user can make after the welcome message is presented to the user. For example: You can enter your request below, or use the button to see everything that I can help with.</td>
</tr>
</tbody>
</table>

b. Click Submit.

**Configure a Virtual Agent chat experience**

Change the preconfigured Virtual Agent default chat experience or create a custom chat experience for your users. You can configure setup topics, specify promoted topics, and if needed, change the search profile.

**Before you begin**

- If you want to specify custom setup topics or promoted topics that are displayed to your users in the chat window, make those topics active (published) so that they're available for configuration in the chat experience.
- Role required: virtual_agent_admin or admin
About this task
The default chat experience provides the default settings for the setup topics and the Virtual Agent search configurations in your instance. A custom chat experience uses the default settings from the default chat experience, but you can override them as needed. To define a chat experience, you:

- Configure setup topics
  - Activate setup topics that are not initially enabled, such as the Anything else, Survey topic, and AI Search Fallback topic types.
  
  **Note:** If you upgraded from the Quebec release, the AI Search Fallback topic is deactivated by default. Enable it to return AI Search results as a fallback when Virtual Agent can't determine intents, topics, or keywords.
  
  - If you want setup topics to be included in topic discovery and listed in the All topics menu, be sure to include those setup topics in the default or a custom chat experience.
  
  - Deactivate setup topics if you don't want them to run in your conversations.

- Promote up to six topics that are initially displayed to your users, before the **Show me everything** button in the chat window. Promoted topics are supported only on the web and mobile clients.

- Change the Search Application configuration in the Search Profile, if needed.

Procedure

1. Navigate to **Conversational Interfaces > Virtual Agent > Custom Greetings and Setup**.

2. Define the chat experience. Do one of the following:

   - To change the setup topics, promoted topics, or AI search setting in the default experience, select the Default chat experience record and proceed to Steps 4, 5, or 6, depending on what you want to change.

   - To define a new experience, click **New** and complete the fields in Custom Greetings and Setup.

   **Note:** The settings for the default chat experience are preconfigured (read-only).

### Custom Greetings and Setup

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the chat experience.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Brief description (purpose) of the chat experience, for example ESC portal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that activates or deactivates the chat experience. The chat experience is active (enabled) by default. To deactivate the chat experience, clear this option.</td>
</tr>
<tr>
<td>Order</td>
<td>Order value that Virtual Agent uses to determine which chat experience to apply. Virtual Agent checks all the chat experiences, and if there is more than one match, the experience with the higher order value (1000) is applied.</td>
</tr>
</tbody>
</table>

**Provide the context**

<table>
<thead>
<tr>
<th>Condition Mode</th>
<th>Options for specifying the chat experience context:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Simple: A no-code condition builder to specify the context. This is the mode for the default chat experience.</td>
</tr>
<tr>
<td></td>
<td>• Advanced: A JavaScript scripted condition that specifies the context. The condition must evaluate to true.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Condition</th>
<th>Condition builder for specifying the experience context. See the Context related list in the Chat Setup form for the available context variables that can be specified.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Script editor for specifying the condition in a script, if you selected Advanced as the Condition Mode.</td>
</tr>
</tbody>
</table>

3. If defining a custom experience, select **Create custom experience**.

   • The related list settings for the setup and promoted topics are empty. The setup topics and promoted topics specified for the default chat experience are used automatically, unless you override them by adding new topics or changing them in your custom experience.

   • To change the setup topics, promoted topics, or AI Search settings in the default experience, proceed to Steps 4, 5, or 6.

4. To configure setup topics in the default or custom experience, navigate to the **Setup Topics** tab.

The default experience for new instances automatically includes most of the pre-built setup topics in your conversations, except for the Anything else
and Survey topics. If you upgraded from the Quebec release, the AI Search fallback topic type is also not active.

ℹ️ Note: the Live Agent and Virtual Agent Feedback topics are not listed in the Virtual Agent topic picker (All Topics) menu by default. You must associate a setup topic type to a setup topic as part of the default or custom chat experience.

a. To activate a setup topic, such as the Anything Else or Virtual Agent Feedback topic, double click the Setup topic field for the associated Setup topic type record. In the Setup topic field, choose the setup topic to be used, and Save.
For example, to activate the Anything else setup topic type, double click the Setup topic field for the Anything Else topic record. In the Setup Topic field, select the Anything Else Topic. and Save.

b. To disassociate a setup topic from a chat experience, select the Setup topic type field for the setup topic and in the Setup Topics form, clear the Setup topic field, and select Update.

c. To add a new setup topic, Select Add topic. In the Setup Topics form, select the Setup topic type and the Setup topic, then select Submit.

d. Apply the changes to the experience by selecting Update.

e. If needed, Test your setup topic configuration to see how the setup topics run.

5. To configure promoted topics for the chat experience, navigate to the Promoted Topics tab.
Specify up to six Virtual Agent topics to be initially displayed in the chat window.

ℹ️ Note: Promoted topics are supported only on the web and mobile clients.

a. For each topic to be promoted, select Add topic and complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Select the topic to be promoted.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Enter the number that indicates the order in which the topic is listed in the chat window.</td>
</tr>
</tbody>
</table>

b. Select **Submit**.

c. If needed, select **Test** to see how the promoted topics are displayed in the chat window.

6. To change the search application for the chat experience, navigate to the **Search Mapping** tab. The default mapping consists of the Search Application Configuration and the Search UI (EVAM) Configuration for Virtual Agent.

   **Note:** The Virtual Agent Default Search Application Configuration is tied to a search profile that does not provide Person card results.

   a. Open the Search Profile record to see the search configurations.

   ![Search Profile](search-profile-image)

   Please map your Search context to your Virtual Agent experience by selecting IDs for both the Search Application and the Entity View Action Mapper (EVAM). Search Application will determine which search profiles to use, EVAM is a platform feature that allows configuration associated with the UI builder. EVAM configuration will determine what fields to be included in the search results. Detailed UI for the EVAM results and search results can be edited in the UI builder.

b. To change the **Search Application Configuration**, select a configuration from the list of available Search Application Configurations.

c. Select **Update**.

   **Note:** Although you can change the **Search UI (EVAM) Configuration**, the Virtual Agent Search (EVAM) configuration provides the appropriate card views and lists of Virtual Agent search results. If you want to create your own EVAM configuration for use, see **Create an EVAM definition**.

### Test chat experiences

After you create or modify a Virtual Agent chat experience, you can test (simulate) it to verify that it works as expected.
Before you begin
Role required: virtual_agent_admin or admin

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Custom Greetings and Setup.
2. Select the chat experience and view the profile.
3. In the header bar, select Test, which automatically opens the chat test window and the associated tabs that display processing details. The items that you defined for the chat experience, such as custom setup topics or promoted topics, run in the test window. This example shows the custom greeting setup topic and promoted topics defined for the ESC portal.
4. To specify a different context:
   a. In the Context tab, select Set Context.
   b. In the Context tab, choose a context from the list of variables (these context variables are defined in the Context related list in the Chat Setup form). For example, you could select portal from the list of variables and enter the portal name, IT Express.
   c. Select Apply context and reload
The items that you defined for the chat experience, such as custom setup topics or promoted topics, run in the test window.

Configure Natural Language Understanding in Virtual Agent

Enable Natural Language Understanding (NLU) in Virtual Agent and identify the NLU service provider for your instance. You can also specify the languages of NLU models used during conversation design, based on the languages supported by your NLU provider and the Now Platform®.

Before you begin

- You can select only one NLU service provider for your instance. Virtual Agent supports ServiceNow NLU, the IBM Watson NLU service, and the Microsoft LUIS NLU service.
  - If IBM Watson Assistant is your NLU service provider, configure the IBM Watson Assistant Intent and Entity Integration so that Virtual Agent can access IBM Watson Assistant NLU model information.
  - If Microsoft LUIS is your NLU service provider, configure the Microsoft LUIS Intent and Entity integration so that Virtual Agent can access Microsoft LUIS NLU model information.
- If you upgraded from the previous release, Virtual Agent retains the NLU general settings and integration information for your NLU service provider.
- Role required: virtual_agent_admin or admin
About this task
The NLU-enabled topics that you preview, create, or update in Virtual Agent Designer must use NLU models created in the NLU service that you select here. For example, if you specify ServiceNow as the service provider, you can view and access topics that use ServiceNow NLU models.

Similarly, to work on NLU topics in other languages, you must have corresponding language-specific NLU models created in your NLU service. For more information, see Multilingual model management.

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > General Settings.
2. In the NLU Settings tab, slide the Enable NLU in Virtual Agent option to activate Natural Language Understanding.
3. On the form, fill in the fields.

NLU Settings tab
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLU service provider</td>
<td>List that shows available NLU service providers for intent and entity extraction. The default is ServiceNow NLU. The VA NLU Languages related list displays. It shows all of the language plugins that have been installed.</td>
</tr>
<tr>
<td>Ask user if topic VA chose is correct</td>
<td>Option that determines whether to prompt the user to confirm that the matched intent is correct. This option enables user confirmation only on initial intent discovery. When enabled, Virtual Agent asks the user for confirmation before continuing to the automatically selected topic content.</td>
</tr>
</tbody>
</table>

User confirmation example

If the user selects No for an initial intent, then Virtual Agent runs the global fallback topic. If the user selects No for an
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>automatically selected intent in mid-topic, then Virtual Agent returns to the topic the user was in.</td>
<td></td>
</tr>
<tr>
<td>Ask user if switched topic is correct</td>
<td>Option that determines whether to prompt the user to confirm that the switched intent is correct. This option enables user confirmation only when the user triggers an intent switch in mid-topic. When enabled, Virtual Agent asks the user for confirmation before continuing to the switched topic content.</td>
</tr>
<tr>
<td>Intent Confirmation Message</td>
<td>Text shown to the user to confirm that the matched intent is correct. You can edit this message. This field is displayed when you enable either or both of the user confirmation options.</td>
</tr>
</tbody>
</table>

4. If you plan to use language-specific NLU models, enable the languages in the VA NLU Languages related list. A language is enabled if the Enabled column displays **true**. English language is enabled by default.

   a. In the Enabled column for a language, click **false**.

   b. Click **Enabled** to activate the language.

   c. If the language applies to a particular domain, select the **Domain** from the list of available groups.

   d. Select **Enabled** to activate the language. You must have corresponding language-specific NLU models defined in your NLU service. During topic design, you can bind topics to multiple, language-specific NLU models and their intents.

   e. Click **Update**.

5. Click **Save**. When you create or update a topic in Virtual Agent Designer, you can choose NLU models available for your specified NLU provider and if applicable, the specified languages. You can also set the NLU entity properties for the input controls that you add to your topic flow.

**Configure the IBM Watson Assistant Intent and Entity Integration**

Use the intents, entities, and utterances defined in IBM Watson Assistant and apply them as an NLU model for your Virtual Agent conversations.
Before you begin
In IBM Watson Assistant:
• In your workspace, define the intents, entities, and utterances for your NLU model.
• Locate your workspace credentials and copy the workspace **Password**, which you must provide when setting your credentials during configuration.

In your ServiceNow instance:
• Role required: admin
• Make sure that the Glide Virtual Agent plugin (com.glide.cs.chatbot) is activated, as it installs the Proxy Agent to the IBM Watson Natural Language Understanding server plugin (com.glide.nlu.ibmwatson.intent.discovery) needed for this integration.

About this task
Configuring the IBM Watson Assistant integration involves providing IBM Watson Assistant credentials for authentication. You can set only one NLU service provider for your instance.

**Note:** If you upgraded from a previous release, the upgrade process automatically retains the IBM Watson Assistant workspace **Password** that you provided.

Procedure
1. To set the credential passwords for the IBM Watson NLU model, entities, intents, and prediction information:
   a. In the application navigator, enter `basic_auth_credentials.list`.
   b. In the Basic Auth Credentials table, enter and save the IBM Watson workspace password in the **Password** field for the IBM Watson NLU Models, Entities, Intents, and Prediction records.
2. Make the IBM Watson NLU service active:

   a. In the application navigator, enter open_nlu_driver.list.

   b. In the Open NLU Drivers table, locate the IBM Watson Script record and in the Active field, set the value to true.

   Activating this setting adds IBM Watson - Script active to the list of available NLU services in the NLU service provider field in the NLU Settings tab.

3. To enable NLU in your instance, navigate to Conversational Interfaces > Virtual Agent > General Settings and in the NLU Settings tab:

   a. Click Enable NLU in Virtual Agent.

   b. In the NLU service provider list, select IBM Watson - Script.

   c. If you’re using language-specific NLU models, select the languages from the list of available languages for your NLU service.

   d. Click Save.

   IBM Watson Assistant is the NLU service provider for your instance.

Related reference

Language support for NLU services

Related information

Multilingual model management

Configure the Microsoft LUIS intent and entity integration

Use the intents, entities, and utterances defined in a Microsoft Language Understanding Intelligent Service (LUIS) application and apply them as an NLU model for your Virtual Agent conversations.

Before you begin

In Microsoft LUIS:
• Create the MS LUIS application to be used as an NLU model.

• Locate and copy these MS LUIS keys:
  ◦ Authoring key that was automatically generated when you created your MS LUIS account. The authoring key provides the authentication needed for your LUIS applications and for creating, training, and publishing them. You can find the authoring key by signing into LUIS, selecting your user account, and opening Account Settings.
  ◦ Prediction endpoint runtime key that you assigned to the resource for your MS LUIS application. Virtual Agent accesses the MS LUIS runtime query prediction endpoint through this key.

  ⚠ Note: If you are using more than one MS LUIS application (NLU model), you must provide the prediction endpoint runtime key for each application that you create.

In your ServiceNow instance:

• Make sure that the Glide Virtual Agent plugin is activated, as it installs the Proxy Agent to the Microsoft LUIS Natural Language Understanding server plugin (com.glide.nlu.msluis.intent.discovery) needed for this integration. If you upgraded from a previous release, the upgrade process automatically retains the MS LUIS keys that you provided.

• Role required: admin

About this task
You can set only one NLU service provider for your instance.
**Procedure**

1. To set the credential passwords for the MS LUIS NLU model, entities, intents, and prediction information, enter `http_connection.list` in the application navigator.

   a. In the HTTP(s) Connections table, open the MS Luis NLU Models record to set the credentials for the model:
      - In the HTTP(s) Connection record, open the **Connection alias**.
      - In the Connection & Credential Aliases (sys_alias) record, go to the Connection Attributes related list.
      - Open the Credential Password attribute, enter the **MS LUIS authoring key** in the Default value field, and save it.
b. In the HTTP(s) Connections table, open the MS Luis NLU Custom Entities record to set the credentials for custom entities:

- In the HTTP(s) Connection record, open the Connection alias.
- In the Connection & Credential Aliases (sys_alias) record, go to the Connection Attributes related list.
- Open the Credential Password attribute, enter the MS LUIS authoring key in the Default value field, and save it.

c. In the HTTP(s) Connections table, open the MS Luis NLU Prebuilt Entities record to set the credentials for the prebuilt entities:

- In the HTTP(s) Connection record, open the Connection alias.
- In the Connection & Credential Aliases (sys_alias) record, go to the Connection Attributes related list.
- Open the Credential Password attribute, enter the MS LUIS authoring key in the Default value field, and save it.
d. In the HTTP(s) Connections table, open the MS Luis NLU Intents record to set the credentials for the intents:

- In the HTTP(s) Connection record, open the Connection alias.
- In the Connection & Credential Aliases (sys_alias) record, go to the Connection Attributes related list.
- Open the Credential Password attribute, enter the MS LUIS authoring key in the Default value field, and save it.

e. In the HTTP(s) Connections table, open the MS Luis NLU Prediction record to set the credentials for the prediction information.

- In the HTTP(s) Connection record, open the Connection alias.
- In the Connection & Credential Aliases (sys_alias) record, go to the Connection Attributes related list.
- Open the Credential Password attribute, enter the MS LUIS prediction endpoint runtime key in the Default value field, and save it.

Note: Repeat Step e for each MS LUIS application that you use as an NLU model. Each application has its own prediction endpoint runtime key that you must provide.

2. Make the MS LUIS NLU service active:

a. In the application navigator, enter open_nlu_driver.list.

b. In the Open NLU Drivers table, locate the MS Luis Script record and in the Active field, set the value to true.

Activating this setting adds MS Luis - Script to the list of available NLU services in the NLU service provider field in the NLU Settings tab.
3. To enable NLU in your instance, navigate to Conversational Interfaces > Virtual Agent > General Settings and in the NLU Settings tab:
   a. Click Enable NLU in Virtual Agent.
   b. In the NLU service provider list, select MS Luis - Script.
   c. If you’re using language-specific NLU models, select the languages from the list of available languages for your NLU service.
   d. Click Save. MS LUIS is now the NLU service provider for your instance.

Related reference
Language support for NLU services
Related information
Multilingual model management

Create or modify custom categories
Create or change custom categories for organizing and grouping related Virtual Agent objects, such as topics. You can also make category labels visible in the Topic picker menu displayed to end users.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Use topic categories to group related conversation topics. When your create or update a topic, you can assign one or more categories to which the topic belongs. You can also view your topics by category in Virtual Agent Designer.

For your end users, you can make the custom category label visible in the Topic picker menu so that associated topics are displayed by category.

Before you create a new category, review the existing categories (Conversational Interfaces > Virtual Agent > Categories) to determine if you need a new category.

Note: Pre-built topics have associated, default categories that can’t be changed or deleted. Also, you can delete a custom category only when the category does not have any topics assigned to it.
Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Categories.

2. Select New to create a custom category or select a category record to change it.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Label for the category.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief description of the category purpose.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the category.</td>
</tr>
<tr>
<td>Visible to end user</td>
<td>Option to display the category label in the Topic picker menu for end users.</td>
</tr>
</tbody>
</table>

**Note:**
- If you upgraded from a previous release, existing category labels are set to not visible.
- This option does not control the topics displayed within the category. At the topic level, use the **Condition** field in the Topic Properties page to set conditions that control when a topic is displayed to end users.

3. Select Submit or Update.
   The topic category appears in the:
   - **Category** list collector (slushbucket) on the Topic Properties page in Virtual Agent Designer so that you can assign one or more categories to a topic.
   - **Category** filter on the Topics page, so that you can view topics by category.
   - Topic cards on the Topics page, for topics that have assigned categories.
• Topic picker menu displayed to end users, if you made the category visible. Topics with multiple categories are displayed in the appropriate categories. Topics without categories are listed in the Others category.

4. To delete a topic category, open the category record and click Delete. If there are no topics associated with the category, the category is deleted. It is no longer listed in the Category field on the Topics Properties page and in the Category filter on the Topics page in Virtual Agent Designer.

Using Virtual Agent

Convert the time your agents and technicians spend handling low-impact user requests into an intelligently managed interaction. Quickly deploy AI-powered chatbot conversations using customizable templates for the most common enterprise IT, HR, and customer service scenarios. Design, build, and test conversations with Virtual Agent Designer. Enable Virtual Agent with NLU to understand the intent of what people are looking for and provide them with more relevant answers.

Virtual Agent Topic Recommendations

Use the Topic Recommendations app to identify pre-built Virtual Agent topics that can be quickly implemented in your organization. Topic Recommendations uses Intent Discovery to analyze data from your organization and to find
relevant pre-built topics that your organization can benefit from, and new topics that would be useful to create.

If you’re a business service owner or topic author responsible for implementing Virtual Agent, the Topic Recommendations app enables you to evaluate the common use cases that a virtual agent can help resolve or deflect. The Topic Recommendations app suggests topics that you can add to Virtual Agent, whether you’re using keyword or NLU-based Virtual Agent topics.

The Topic Recommendations app, available from the ServiceNow Store, requires NLU Workbench and ITSM Virtual Agent Conversations from the ServiceNow Store. The Rome release of Topic Recommendations supports only ITSM Virtual Agent recommendations. Although Topic Recommendations uses NLU Workbench for machine learning purposes, it does not require that NLU be enabled in Virtual Agent.

For details on the apps that are automatically installed with Topic Recommendations, see Install Topic Recommendations.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

How Topic Recommendations work
Topic Recommendations uses the following items and features to analyze data from your organization:

• Data source (data set) - ServiceNow table, such as Incidents or Tasks, and a selected field (string column) in the table, such as the short description, to be analyzed.

• Taxonomy - A pre-built, comprehensive collection of common user intents for a particular business application. You cannot view or edit the contents of a taxonomy. For the Rome release, Topic Recommendations supports only the ITSM taxonomy, which provides a large set of ITSM-related intents.

• Intent Discovery - An NLU Workbench tool that determines the intents used in your organization by analyzing your data set against a taxonomy of user intents. The Topic Recommendations app uses the mapping feature in Intent Discovery to find relevant intents.

• Pre-built Virtual Agent topics - For the Rome release of Topic Recommendations, the pre-defined ITSM Virtual Agent conversations.

During analysis, the Topic Recommendations app does the following:
Uses Intent Discovery to review your data source, comparing your data source against the associated taxonomy for your business application. Intent Discovery matches the data field specified in your data set to intents in the taxonomy.

Maps the matched intents to pre-built topics in Virtual Agent. If intents do not have associated pre-built topics, the app identifies the intents that you can create as topics.

Displays the analysis results as topic cards in the Topic recommendations page.

After you choose the pre-built topics and recommended intents to add to Virtual Agent, the Topic Recommendations app does the following:

- Duplicates the selected pre-built topics and adds them to Virtual Agent.
- Creates empty topics for the recommended intents (for which you will build conversation flows).
- If you're using Virtual Agent NLU, adds the intents to your Virtual Agent NLU model, and then trains the model.

Mapping intents to Virtual Agent topics

**Working with Topic Recommendations**

Use the Topic recommendations page (Conversational Interfaces > Virtual Agent > Topic Recommendations) to do the following:

1. Run reports that identify the pre-built conversation topics best suited for your organization and the intents/topics suggested for creation. Each data source has its own section.

   If you set up reports to run on a schedule, a notification appears in the Virtual Agent Designer Topics page when new recommendations are available.

2. View recommendation results.
The results display as cards, in two subsections: **Topics VA can handle** and **User intents that need topic flows**. Each card provides details that can be helpful if you decide to modify pre-built topics or create new topics.

3. Access the history of the reports that were previously run. Choose from a list of dates that a previous analysis was run, which then displays the analysis results (cards) for that date.

4. Select the cards for the topics or intents that you want to add to Virtual Agent. Selecting a card enables the option **Add to VA**.

**Topic recommendations page**

Here's your latest analysis and recommendations for topics the Virtual Agent (VA) can handle. You can select the ones you want to add to your VA, so they can take care of those common issues.

![Image of the Topic recommendations page]

**Topic Recommendations status information**

Recommended topic and intent cards display the status of the recommendation as follows, allowing you to track them more easily over time.

**Example intent recommendation cards**

![Image of example intent recommendation cards]
### Topic and intent card statuses

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Topic or intent has never been added to Virtual Agent. Cards with <strong>New</strong> status have a dark gray border.</td>
</tr>
<tr>
<td>Active</td>
<td>Topic or intent was added to Virtual Agent or linked to an existing topic and published. Cards with <strong>Active</strong> status have a green border. If you keep getting recommendations for an Active topic, it probably needs improvement.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Topic or intent was added to Virtual Agent but never published, or it was linked to an existing, unpublished topic. Cards with <strong>Inactive</strong> status have a light gray border. If you keep getting recommendations for an Inactive topic, take steps to publish it and make it active.</td>
</tr>
</tbody>
</table>

### What to do
- Install the Topic Recommendations app.
- Define default recommendation settings.
- Run a Topic Recommendations analysis.
- Add recommended topics and intents to Virtual Agent.
- Link a topic recommendation to an existing Virtual Agent topic.
- Unlink a topic recommendation from an existing Virtual Agent topic.

### Install Topic Recommendations
You can install the Topic Recommendations application (com.snc.va_topic_recommender) if you have the admin role.

### Before you begin
- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see [Get entitlement for a ServiceNow product or application](https://service-now.com).
- Topic Recommendations requires the following plugins and ServiceNow Store applications. Ensure that they are activated before you install Topic Recommendations.

#### Required ServiceNow plugins

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Glide Virtual Agent (com.glide.cs.chatbot)
Activates all the plugins needed to run Virtual Agent Pro. For details, see Activate Virtual Agent.

NLU Workbench
Activates the plugins needed to run Natural Language Understanding in your instance. For more information, see Activate the NLU Workbench.

Required ServiceNow Store applications
ITSM Virtual Agent Conversations
Provides pre-built IT service management conversations to help your organization quickly deploy automated self-service conversations. For more information, see ITSM Virtual Agent.

Note: Installing Topic Recommendations automatically installs the Intent Discovery app and the NLU Workbench - Advanced Features app, so there is no need to install them from the ServiceNow Store.

Role required: admin

About this task
The following items are installed with Topic Recommendations:

• Intent Discovery: Identifies user intents from analyzing incident/case data. To learn more, see Intent Discovery.

• NLU Workbench - Advanced Features: Delivers the functionality needed to run Intent Discovery. For more information, see NLU Workbench - Advanced Features.

• Scheduled jobs: Run Topic Recommendation Reports for running Topic Recommendation reports at scheduled times.

• The following tables are installed:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default settings for Topic Recommendations</td>
<td>The source data (table and text field), taxonomy, and filters used when running a Topic Recommendations analysis</td>
</tr>
<tr>
<td>[sn_topic_recommend_default_setting]</td>
<td></td>
</tr>
<tr>
<td>Discovery Report Definitions</td>
<td>Intent Discovery training status</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>[sn_nlu_discovery_report_definition]</td>
<td></td>
</tr>
<tr>
<td>Installed recommended topics</td>
<td>Topics generated for recommended topics</td>
</tr>
<tr>
<td>[sn_topic_recommend_topic_staging]</td>
<td></td>
</tr>
</tbody>
</table>

**Procedure**

1. **Navigate to** System Applications > All Available Applications > All.

2. **Find the Topic Recommendations** application (com.snc.va_topic_recommender) using the filter criteria and search bar.
   
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Topic Recommendations.

4. **Optional:** If demo data is available and you want to install it, click **Load demo data**.

   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click **Install**.

**Define default settings for Topic Recommendations analysis**

To generate Topic Recommendations, specify a default data source (ServiceNow table and field) and the conditions for filtering the data records.

**Before you begin**

Role required: virtual_agent_admin or admin
About this task

- You can define only one setting per data table and taxonomy pair.
- Two data sets (Incident and Requests) are provided by default, but you can define your own data sources.
- In the Rome release, Topic Recommendations requires a minimum of 10,000 records in your analysis scope (data source).
- Keep your analysis scope (data source) under 300,000 records. In the Rome release, this is the maximum number allowed.
- You can schedule analysis reports to run automatically at specified intervals.

Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Recommendation Settings.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>ServiceNow table that contains the data to be analyzed.</td>
</tr>
<tr>
<td>Field analyzed</td>
<td>Field (string column) in the table to be analyzed. For example, short description, in the Incident table.</td>
</tr>
<tr>
<td>Taxonomy</td>
<td>Comprehensive list of intents for a specific business application, such as ITSM.</td>
</tr>
<tr>
<td>Filter by</td>
<td>Condition builder for filtering the records to be analyzed. The default filter is [Created] [after] [Last 90 days].</td>
</tr>
<tr>
<td>Frequency</td>
<td>[Optional] The schedule for running the analysis, which is triggered through the Run Topic Recommendation Reports scheduled job:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Every Month</td>
</tr>
<tr>
<td></td>
<td>- Every 3 Months</td>
</tr>
<tr>
<td></td>
<td>- Every 6 Months</td>
</tr>
<tr>
<td></td>
<td>- Every 12 Months</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Note: | If you're using a non-production instance for testing, set the analysis schedule in your production instance so that it and your analysis history are retained. The intent discovery process works best in a single instance, where data is not promoted between instances.

4. Click **Submit** or **Update** to save changes.

**Results**
The data source that you defined for a given table and taxonomy displays as a section on the Topic recommendations page. You can now run a topic recommendation analysis.

**Run a Topic Recommendation analysis**
Generate a report that analyzes a given data source and identifies the appropriate Virtual Agent pre-built topics that you can implement. For intents that do not have matching pre-built topics, the report identifies the user intents (topics) that you can create.

**Before you begin**
Verify that the appropriate Virtual Agent conversation plugins are activated so that the Topic Recommendations app can identify the appropriate pre-built topics.
You can use the **See all installed plugins** link on the Topic Recommendations page to check which plugins are installed.
Make sure you define the default topic recommendation settings.
Role required: virtual_agent_admin or admin

**About this task**
The analysis process takes about 15 minutes or less to return recommendation results. In the Rome release, Topic Recommendations requires a minimum of 10,000 records in the data source and will only process a maximum of 300,000 records. Use filters in the Recommendation Settings page to reduce the number of records in the data source, if needed.

**Procedure**
1. Navigate to **Conversational Interfaces > Virtual Agent > Topic Recommendations**.
2. In the Topics recommendation page, go to the data source to be analyzed and trigger the analysis.
Do one of the following:

- Run a new analysis
  a. Click **Run Analysis**.

b. In the **Get recommendations** dialog box, review the default settings. In this example, notice that 60 incident records with short descriptions were found.

c. To change the filters for this analysis, click **Edit conditions**. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field to analyze</td>
<td>Column in the data source table.</td>
</tr>
<tr>
<td></td>
<td><em>(Optional)</em> For example, the <strong>Short description</strong> column of the Incidents table.</td>
</tr>
<tr>
<td>Filters</td>
<td>Condition builder for filtering the data source records to be analyzed.</td>
</tr>
<tr>
<td></td>
<td><em>(Optional)</em> For best performance, fewer than 500,000 cases is recommended.</td>
</tr>
</tbody>
</table>
Note: Changing the filters here affects only this analysis. The default settings for the recommendation are preserved. To change the default settings, see Define default settings for Topic Recommendations analysis.

The Get recommendations dialog box refreshes automatically based on your choices.

Note: If you schedule a recurring time for analysis reports, a notice for new topic recommendations will display in the Virtual Agent Designer Topics page when they are ready. Click the link to review them.

d. Click Get recommendations.

A message displays, indicating that the topic-finding process has started and the approximate time that recommendation results will be available. The status bar displays Analysis in progress. You can review other items while the analysis runs.

• Refresh an existing analysis
  a. In the status bar, click Refresh.
  b. In the Get updated recommendations dialog box, review the default settings and make any changes.
  c. Click Get recommendations.

A message indicates that the topic-finding process has started and the approximate time for recommendation results. The status bar displays Analysis in progress. You can review other items while the analysis runs.

3. When the report completes, review the analysis results for the data set.

The results display as cards in two sections: Topics that VA can handle for pre-built topics and User intents that need topic flows for intents and corresponding topics that can be created.

The results are displayed in descending order of matches to your data source. The top 20 intent matches are displayed. If there are more than 20 intents, you can view them in NLU Workbench.

4. To get more details about a pre-built topic or user intent, select the card and then click the Info icon (i) to open an overlay card.

The overlay card includes the following information, which can provide insight into why the topic or intent was recommended.
• Topic description - Description of the pre-built topic or user intent.

• Per contact, VA could save - How long it takes for an agent to resolve an intent (displayed in minutes).

• How they contacted you - The way in which users engaged with support. For example, phone or email.

• Who handled the ticket - Assignment group.

• Language - The languages of users interacting with support for this issue.

Example overlay card

What to do next
You can add a Topic Recommendation as a new topic or link it to an existing topic.

Add Topic Recommendation results to Virtual Agent
After you run and review a Topic Recommendations report, select the pre-built topics and suggested intents to add to Virtual Agent.

Before you begin
Role required: virtual_agent_admin or admin
**About this task**
When you add a recommended topic to Virtual Agent, the Topic Recommendations app automatically does the following:

- Duplicates the pre-built topics that you selected.
- Creates empty topics for the intents you selected.
- If you're using ServiceNow NLU:
  - Creates a new NLU model if it doesn't exist.
  - Updates and trains the NLU model with the added intents.

**Procedure**
1. Navigate to Conversational Interfaces > Virtual Agent > Topic Recommendations.
2. Go to the analysis results for your data source.
3. Select one or more topic and intent cards to be added to Virtual Agent, and then click Add to VA.
   Selected cards are highlighted in blue and display as Selected, as shown in the following example.

4. If you're using ServiceNow NLU, select one of the following options in the Model list:
   - **Create new model**
     Select this option to create a new model group.
   - **An existing model group**
     A model group consists of a primary model in the source language (such as English), as well as any secondary language-specific models. When you upgrade to the Rome release, you're given the option to migrate your models. For more information about model grouping, see [Multilingual model management](#).
   - **An existing standalone model**
A standalone model is one that has not been migrated into a model group. It consists of a single language only. If you choose a standalone model and multiple languages are enabled in Virtual Agent, you're given the option of mapping to standalone language-specific models.

The new topic will be bound to the model group or standalone model that you specify. Intents will be bound after training. Models will be trained but not published.

**Adding selections to a model group**

**Adding selections to your Virtual Agent**

In Virtual Agent Designer, they will have this category:

- Recommended

Which model would you like to use for this? Available in English, French, Spanish

- [ ] English
- [ ] French
- [ ] Spanish

We will create this language model for you since it does not exist. Additional languages are available in the model and will be included.

[Cancel] [Add to VA]
Adding selections to standalone models

Adding selections to your Virtual Agent

In Virtual Agent Designer, they will have this category:

Recommended

Which model would you like to use for this? Available in English, French, German

Model: DAL IT (English)

Select additional language models:

French: Select...

German: Select...

Note: Models do not have to be published to appear in the list, but they must be trained.

5. Click Add to VA.

Results

For recommended pre-built topics, Virtual Agent duplicates the topic (but removes the Template portion of the file name). For recommended intents, Virtual Agent creates a new topic mapped to the intent. These topics are added to the Recommended category in the Virtual Agent Designer Topics page.

In the Topic recommendations page, the topic card shows the date it was added and its status (Active or Inactive). To open the new topic from the Topic recommendations page, click the Info icon (i) to open the overlay card. Click the link beneath Added topic recommendation to open the topic in Virtual Agent Designer.
### Added topic recommendation link in the overlay card

| Improve Password reset |  |  |  |  |  |
|------------------------|----------------|----------------|----------------|----------------|
| This includes: Forgot password or username, Update password, Authentication issues, Account hacked. | Per contact, VA could save | Sample data | 45 minutes of agent time | 485 incidents |
| How they contacted you | Who handled ticket | Language | Service Portal | Site Support | Security | P&C Dvnt | GIS Deployment |
| Email | 72% | 14% | 4% | 3% |
| Walk-in center | 10% | 4% | 4% | 3% |
| Chat | 6% | | 3% | |
| Added Topic Recommendation | Added 08/08/2021 |

> The topic overlay card also provides a snapshot of topic completion data from the previous three months.

### Recommended topic cards for an added topic

> **Link a topic recommendation to an existing Virtual Agent topic**

Instead of creating a new topic from a topic recommendation, you can link it to an existing topic. This lets Virtual Agent know that you have a topic that addresses the recommendation.
Before you begin
Role required: virtual_agent_admin or admin

About this task
If you continue to get recommendations for an active topic after linking it, the topic probably needs improvement.

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Topic Recommendations.
2. Click the Info icon (i) to open the overlay card for a topic that has a New status.
3. At the bottom of the overlay card, click Here's how to link to an existing topic. Click the link as shown in the following example.

4. In the dialog box, select a topic in the Find topic to link list.
5. Click Link topic.

Results
The overlay card shows that the recommendation is linked, as well as the date this occurred.
If a topic recommendation continues to appear in your analysis results after you linked it to a topic, you may want to revisit the topic to improve its effectiveness. You can also unlink a topic recommendation from a Virtual Agent topic.

**Unlink a topic recommendation from a Virtual Agent topic**

You can unlink a topic recommendation from a topic. This lets you link it to a new or alternate topic.

**Before you begin**

Role required: virtual_agent_admin or admin

**About this task**

You can either add a recommendation as a new topic or link it to an existing topic. If you link it to an existing topic, you can always unlink it later if you need to. Added topic recommendations create an empty topic that you provide with a workflow, so you can’t unlink them using this method. The following example shows the difference between a linked recommendation and an added recommendation.
### Example of linked and added cards in the Topic recommendations page

<table>
<thead>
<tr>
<th>ITSM - Issue - Software...</th>
<th>ITSM - Issue - Network...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.4% of Incidents (1)</td>
<td>2.8% of Incidents (2)</td>
</tr>
<tr>
<td><strong>Linked to topic May 5, 2021</strong></td>
<td><strong>Added on Mar 13, 2021</strong></td>
</tr>
</tbody>
</table>

### Procedure

1. **Navigate to** Conversational Interfaces > Virtual Agent > Topic Recommendations.

2. Click the Info icon (🛷) to open the overlay card for a linked topic.

   ![Overlay Card](image)

   **Key details from ITSM - Issue - Software - Files - PDF**

   We also identified common requests Virtual Agent already understands. These are called user intents. You can add these now and create topics from them later.

   - **Per contact, VA could save**
   - **No data**

   - **How they contacted you**
     - phone: 100%
   - **Who handled the ticket**
     - d625cece: 100%
   - **Language**
     - English: 100%

   **Linked topic**
   - ITSM - Request - Software Linked May 5, 2021
   - **Unlink**

3. Click **Unlink**.

### Results

Unlinked recommendations are set to **New** status. You can link it to another topic, or add it to Virtual Agent as a new topic.

- **Note:** If you added a topic to Virtual Agent for a recommendation, it is not shown as linked, so you can’t unlink it. To reset an added recommendation as **New**, delete the topic that was added in Virtual Agent Designer.
Incident Auto Resolution for Virtual Agent

Proactively deflect incidents to Virtual Agent for auto-resolution. Initiate a Virtual Agent conversation with an end user after they submit an incident through email or the ServiceNow® Service Portal, if an existing Virtual Agent topic can resolve the issue. Incident Auto Resolution uses machine learning to discover the appropriate intent and topic to be used for incident resolution.

You can also run simulations on a set of incident records, to predict matching intents for topics.

How does Incident Auto Resolution work?

• The end user creates a new incident through a non-conversation service channel. Default configuration includes email and Service Portal.

• The incident is assigned to Virtual Agent and the Incident Auto Resolution service receives the incident.

  Note: The session language must be English to be assigned to Virtual Agent for auto-resolution.

• The machine learning model checks for a matching intent that meets the required minimum confidence threshold, based on the incident description and short description.

• If a matching intent is found, Incident Auto Resolution searches for a matching auto-resolution enabled Virtual Agent topic for the matching intent.

• If a matching intent and topic are found, an Actionable Notification is sent to the end user.

• The end user receives the notification on their existing chat channel: The Slack service, Microsoft Teams service, Workplace from Facebook service, or Web Chat. The user can accept or decline the Virtual Agent assistance.
• If the end user accepts the Virtual Agent assistance, the Incident Auto Resolution service invokes the matched Virtual Agent topic to resolve the issue.
• As the user completes the matched topic conversation, the Incident Auto Resolution flow updates the incident work notes.
• When the matched topic conversation completes, the Incident Auto Resolution topic resumes and asks the user if the matched topic resolved the issue.
• If the user indicates that the issue has been resolved, they can choose to close the ticket or to keep it open.

When is an incident unassigned from Virtual Agent for Incident Auto Resolution?

An incident is unassigned from Virtual Agent for Incident Auto Resolution and routed to a human agent when any of the following conditions apply:

• The matched intent doesn’t have a matching topic in the same domain as that of the incident.
• The matched topic doesn’t have Incident Auto Resolution enabled.
• The end user has not subscribed to notifications.
• The end user declines, ignores, or abandons the Virtual Agent conversation.
• The end user responds to the Virtual Agent conversation that the matched topic didn’t resolve the issue.

How is the Incident Auto Resolution process tracked?

Context records are the system of record for Incident Auto Resolution. Context records provide details about the current state of the task in the Incident Auto Resolution flow. Context records track the following events:
- Matching Intent found/topic found
- Notification sent/accepted/declined
- Resolution topic completed/abandoned/timed-out
- Task resolved/unresolved/SLA reached

Incident Auto Resolution context records act as an event audit log for troubleshooting purposes. Users with the admin or virtual_agent_admin role can examine these records to determine why a task was not resolved using Incident Auto Resolution. Users can also see what actions were performed by the user and by Virtual Agent.

**What are Actionable Notifications?**

Actionable Notifications are interactive messages that Virtual Agent sends to the end user on their preferred chat channel. Virtual Agent sends an Actionable Notification when the machine learning model finds a topic that matches the user’s intent and the user is subscribed to notifications. Actionable Notifications contain buttons that the user can select. Each button is mapped to an Incident Auto Resolution topic. Based on the user’s selections, different aspects of Incident Auto Resolution execute, according to the logic of the matched topic.

**Incident Auto Resolution Conversations Analytics dashboard**

The Incident Auto Resolution Conversations Analytics dashboard provides metrics for the effectiveness of incident deflection, based on Virtual Agent conversations. This dashboard is only accessible to users with the admin role, the virtual_agent_admin role, or the chat_analytics_viewer role. The dashboard tracks both the usage of Incident Auto Resolution and the rate of successful incident resolutions. Users can see which tasks are deflected to Incident Auto
Resolution and the overall success of Incident Auto Resolution through the following ServiceNow® Performance Analytics KPIs:

- Number of tasks solved by Incident Auto Resolution.
- Number of notifications ignored by requester.
- Number of tasks not solved by Incident Auto Resolution to which the requester responded.

**Issue auto-resolution in the Conversational Analytics Dashboard**

The Issue auto-resolution tab in the Conversational Analytics Dashboard provides metrics on the effectiveness of incident deflection based on Virtual Agent conversations. This tab also provides detailed visualizations on intent and topic matching performed for auto-resolution. For more information about this tab, see Issue auto-resolution tab.

This dashboard is accessible only to users with the admin, virtual_agent_admin, chat_analytics_admin, or chat_analytics_viewer roles.

**Incident Auto Resolution Intent Analytics dashboard**

The Intent Analytics dashboard provides reports on intent prediction efficiency and other metrics that occur prior to launching the Incident Auto Resolution topic. This dashboard is only accessible to users with the admin or virtual_agent_admin role. Intent Analytics and Reports are based on context records and are generated from the context data:

- Measure the efficiency of the Machine Learning API.
- Measure if Incident Auto Resolution successfully resolved the task.

**Machine Learning for Incident Auto Resolution**

Incident Auto Resolution uses Machine Learning and Natural Language Understanding to identify Virtual Agent topics that match intents submitted by users. Intent matching is determined by the incident Description and Short Description fields. Intents must meet the required minimum confidence threshold to be considered a match.
To view, train, or retrain the Machine Learning model, navigate to Conversational Interfaces > Incident Auto-Resolution > Configuration and click the Machine Learning Model tab.

Note: Incident Auto Resolution must be activated and ITSM Virtual Agent must be installed to access Machine Learning. To learn more, see Setting up Incident Auto Resolution for Virtual Agent.

Incident Auto Resolution configuration
To view the configuration for Incident Auto Resolution, select Conversational Interfaces > Incident Auto-Resolution > Configuration.

Note: Incident Auto Resolution must be activated. To learn more, see Setting up Incident Auto Resolution for Virtual Agent.

The following settings are available for task configuration and are preset for Incident Auto Resolution:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Condition</strong></td>
<td>Determines which records are evaluated for Incident Auto Resolution.</td>
<td>Contact type is one of Email, Self-service</td>
</tr>
<tr>
<td><strong>Notification User</strong></td>
<td>The incident filer or requester.</td>
<td>Caller</td>
</tr>
<tr>
<td><strong>Task SLA</strong></td>
<td>Amount of time that the end user has to take action on the issue before the issue is unassigned from Virtual Agent and routed to a human agent.</td>
<td>This setting is preset for two hours and can be changed</td>
</tr>
<tr>
<td>Setting</td>
<td>Definition</td>
<td>Default Value</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Task resolution template</td>
<td>Template applied to the target table or specific record on the target table that sets the fields and values necessary when an end user indicates that the matched topic successfully resolved their issue.</td>
<td>incident_resolution_template</td>
</tr>
<tr>
<td>Topic completion template</td>
<td>Template applied to the target table or specific record on the target table that sets the fields and values necessary during the interim state, while the matched topic conversation flow runs.</td>
<td>incident_topic_completion_template</td>
</tr>
<tr>
<td>Unresolved task template</td>
<td>Template applied to the target table or specific record on the target table that sets the fields and values necessary when an end user indicates that the matched topic did not resolve their issue.</td>
<td>incident_unresolved_task_template</td>
</tr>
</tbody>
</table>

**Intent to Topic mapping**

Users with the virtual_agent_admin or admin role can choose a subset of pre-built topics to be available for Incident Auto Resolution. The following ITSM Virtual Agent intents are supported by default and map to a pre-built Virtual Agent topic:

- PrinterIssues
- VPNConnectivity
- HardwareIssues
- ResetPassword
These intents are currently the only supported intents for Incident Auto Resolution. The default intents and matched topics are listed in the **Intent to Topic Map** tab.

Users with the `virtual_agent_admin` or `admin` role can create their own custom topics to use, instead of the pre-built topics. These custom topics must be mapped to a supported intent in the **Intent to Topic Map** related list for Auto-Resolution Configuration.

**Setting up Incident Auto Resolution for Virtual Agent**

Users with the `virtual_agent_admin` or `admin` role can activate Incident Auto Resolution and configure Virtual Agent settings to indicate discoverable topics, set business rules, and more.

**Before you begin**

Activate **Virtual Agent**. Then **Set up ITSM Virtual Agent** and install the ITSM ServiceNow® Natural Language Understanding (NLU) Model for Virtual Agent Conversations by requesting them from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Role required: `admin role` or `virtual_agent_admin`

ℹ️ **Note:** Users with the `admin role` can activate the Glide Virtual Agent (com.glide.cs.chatbot) plugin.

**About this task**

The Glide Virtual Agent (com.glide.cs.chatbot) plugin activates the following aspects of Incident Auto Resolution:

- Auto Resolution Admin Configuration
- Auto Resolution Simulation
- Auto Resolution Actionable Notifications
- Auto Resolution Virtual Agent Topic
- Auto Resolution Intent Analytics dashboard available through Self Service dashboards

In addition, the Glide Virtual Agent plugin activates the Intent Discovery for Incident Auto Resolution APIs by pulling in the following related plugins:

- Proxy Agent to the ServiceNow Natural Language Understanding server (com.glide.nlu.intent.discovery)
- Predictive Intelligence (com.glide.platform_ml)
The ITSM Virtual Agent Conversations Store App activates the following aspects of Incident Auto Resolution:

- Incident Auto Resolution Configuration
- ITSM Incident Auto Resolution Topics

The Conversational Analytics Store App activates the Auto Resolution Conversation Analytics dashboard.

**Procedure**

1. Enable Incident Auto Resolution.

   a. Navigate to **Conversational Interfaces > Incident Auto-Resolution > Setup**.

   b. Select **Yes** and then click **Save**.
Enable Incident Auto Resolution

Incident Auto Resolution Setup is now enabled, allowing you to access Incident Auto Resolution configuration.

2. Train the Machine Learning model. Train the Incident Auto Resolution Machine Learning model prior to activating the Incident Auto Resolution Configuration record. For more information, see Machine Learning for Incident Auto Resolution.

a. Navigate to Conversational Interfaces > Incident Auto-Resolution > Configuration and select the Machine Learning Model tab.

b. Select Train.
   The Training Progress field displays the percentage of training complete and updates whenever the form is refreshed.
c. When the Training Status field displays Solution Complete, select the Active property.

d. Optional: Set a Retrain Frequency to define how often the Machine Learning model automatically retrains. Users with the admin or virtual_agent_admin role can also manually retrain the model at any time.

Note: The incident table must have the minimum number of records that you specify in the glide.platform_ml.api.min_agent_zero_records system property in order to train the model. The default value of this property is 10000.

3. Optional: Configure Incident Auto Resolution.
   Change any configuration settings as needed. For more information, see Incident Auto Resolution configuration.

4. Optional: Change any mappings for Auto-Resolution intents to matched ITSM Virtual Agent topics.

   a. Navigate to Conversational Interfaces > Incident Auto-Resolution > Configuration and select the Intent to Topic Map tab.
      This related list displays the default mappings for the intents and matched topics. You can modify them, but only supported Auto-Resolution intents and active Virtual Agent topics are available for mapping.

      (Optional) These records are inactive by default. To use them, duplicate the template topics to create and publish them. After associating the intent to the topic of choice, make the intent topic map active.

   b. For a given Auto-Resolution intent, double-click the corresponding Matched topic, select a different topic, and Save.

Related information
Predictive Intelligence

Configure and run Auto-Resolution simulation

Use incident data from your organization to run simulations that predict matching intents based on the incident Short Description and Description fields.

Before you begin
Role required: virtual_agent_admin or admin
About this task
You can run multiple simulations for a given Auto-Resolution configuration. You can also:

- Cancel a simulation - Stop a simulation in progress.
- Refresh simulation status - Check the status of a simulation in progress.
- Delete a simulation - Delete a simulation configuration, but not while a simulation is running.

Procedure
1. Configure an Auto-Resolution simulation.
   
   a. Navigate to Conversational Interfaces > Incident Auto-Resolution > Simulation and select New.

   b. Fill in the fields on the form:

<table>
<thead>
<tr>
<th>Simulation Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Auto-Resolution configuration</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Record set</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>Note:</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records with matching intent active topic</td>
<td>Number of records with intents that match active topics.</td>
</tr>
<tr>
<td>Records with matching intent inactive topic</td>
<td>Number of records with intents that match unpublished topics.</td>
</tr>
<tr>
<td>Records without matching intent</td>
<td>Number of records that do not match with an intent.</td>
</tr>
</tbody>
</table>

### Data management in Virtual Agent

Use various data management tools, such as table cleaners, to maintain certain Virtual Agent tables.

### Virtual Agent table cleaners

Certain Virtual Agent tables are not automatically cleaned by the Table Cleaner scheduled job. You can activate table cleaners for the following Virtual Agent tables, to prevent tables from growing to an unmanageable size.

### Virtual Agent tables that need cleaning

<table>
<thead>
<tr>
<th>Table label</th>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Server Analytics</td>
<td>sys_cs_analytics</td>
<td>Server records that include sys IDs for messages, threads, conversations, users, and events.</td>
</tr>
<tr>
<td>Conversations</td>
<td>sys_cs_conversation</td>
<td>Conversation details, including topic definition, device used, and consumer (user).</td>
</tr>
</tbody>
</table>

**Note:** Table cleaner also automatically deletes the related records for:
- Conversation Messages
- Conversation Tasks
- Conversation Members
- Session bindings
- Profane message logs
Virtual Agent tables that need cleaning (continued)

<table>
<thead>
<tr>
<th>Table label</th>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Last Reads</td>
<td>sys_cs_message_last_read</td>
<td>Message IDs of the last messages read by consumers (users) in chat and messaging channels.</td>
</tr>
</tbody>
</table>

The Table Cleaner scheduled job automatically runs the table cleaner every hour. For details on using the table cleaner, see Data management.

Transferring Virtual Agent conversations to a live agent

Manage live chat support, including the chat support interface used when a Virtual Agent conversation is transferred to a live agent.

The Glide Virtual Agent plugin (com.glide.cs.chatbot) automatically activates the Glide Conversation Server plugin (com.glide.cs) for chat support.

When virtual agent conversations are transferred to a live agent

Conversations in Virtual Agent are transferred to a live agent in several ways. This transfer happens automatically when an unrecoverable error occurs, but it can also be triggered via a script in a topic or when manually selected by the user.

**Automatic transfer to a live agent when an error occurs**

When a conversation encounters an error, the conversation automatically transfers to a live agent.

```
An unrecoverable error has occurred.

Please stand by while I connect you to a live agent.
```

Routing you to a live agent...

**Note:** If you do not intend to use Live Agent, be sure to disable live agent transfers. For details on chat setup for Virtual Agent, see Configure live agent chat.

**Automatic transfer to a live agent triggered by a script in a topic**
In situations where you want a support agent to handle the conversation, you can create a script in your topic that uses the `vaSystem.connectToAgent()` command. This command triggers a transfer to a live agent. This option can be useful for conversations involving negative customer sentiment, high priority requests, or requests outside the scope of your topic process. For example:

```
(function execute() {
    if (vaInputs.urgency == 1 && vaInputs.impact == 3) {
        if(vaSystem.isLiveAgentAvailable()) {
            vaSystem.connectToAgent()
        }
    }
})()
```

This script action control transfers the conversation to a live agent based on the incident impact and urgency indicated by the user. The script uses the `vaSystem.isLiveAgentAvailable()` method to verify that Live Agent is available.

**Manual transfer to a live agent using the Contact support option**

Users can choose the **Contact support** option and then select **Contact Live Agent** to transfer the conversation to a live agent.

**Note:** Users running a Virtual Agent messaging integration must type the command `Hi` or `agent` to access the live agent transfer option. If you are not configured to use live agents, the command `agent` does not work. For details, see *[Virtual Agent integration with messaging apps]*.

**How virtual agent conversation transfers work**

For a user engaged in a virtual agent conversation, the switch to a live agent is a seamless transfer. When a transfer is triggered, either automatically or manually by the user, the conversation is automatically routed to the
appropriate chat support interface, based on your chat setup configuration. In Chat Setup, admins also define the general messages that users see during live agent transfers.

If you are using Agent Workspace, the conversation is automatically routed and assigned to an available live agent. If you are using Connect Support, the conversation is routed to the chat support queue that you specify.

**Transfer to live agent in Agent Workspace**

If you are using Agent Workspace, the virtual agent conversation is automatically transferred to a qualified available agent, based on the Chat service channel configuration and the queues that the agent supports, as defined in Advanced Work Assignment.

**Example of live agent transfer and agent interaction in Agent Workspace**

For the user, the conversation with the agent continues in the Virtual Agent (client) interface. In Agent Workspace, the chat assignment appears in the agent's inbox. When an agent accepts the assignment, the agent joins the conversation and interacts with the user.

**Transfer to live agent in Connect Support**

If you are using Connect Support, the virtual agent conversation is routed to the appropriate chat support queue. For the user, the conversation with the agent continues in the Virtual Agent (client) interface. In Connect Support, the agent accepts the queue with the transferred user to join the conversation and interact with the user.
Example of live agent transfer and agent interaction in Connect Support

In Chat Setup, admins assign the default chat queues (for Customer Service Management, HR Service Delivery, and IT Service Management) or a global queue to which Virtual Agent conversations are automatically routed if default queues are not assigned. These queues, which you define in Connect Support, are stored in the Chat Queues [chat_queue] table.

Using Virtual Agent Designer

The Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints for conversations between a virtual agent and user. You can design topics that help your users resolve common work issues or guide them through self-service tasks.

Getting started with conversation design

Use Virtual Agent Designer controls and reusable conversational elements to create the dialogue for your conversations between Virtual Agent and the end user. Before you begin, make sure you do the following:

**Identify the use case for a conversation.**

Determine who will use a conversation topic and the goal, such as solving a user problem or assisting with a self-service task. Besides gathering key requirements for your topic, identify the information that you need from the user to complete the goal.

For example, you can review your support requests over time and other available metrics to determine common issues, use cases,
and customer requests or goals. From there, you can predict recurring requests or issues that a virtual agent could help with.

**Determine the structure of a conversation.**

As you think about your conversation flow, identify the direct path to resolution. Then consider alternate paths where the conversation might branch, depending on the information supplied by the user. Consider how to handle each branch and whether users might loop back to an earlier point in the conversation.

To see how Virtual Agent Designer controls are used in a simple conversation flow, see *Designing a Virtual Agent topic*.

If you’re using Natural Language Understanding (NLU), consider scenarios where a user might want to switch topics during a conversation session. For example, a user might want to change topics entirely. Or a user might get sidetracked and ask a question that seems out of context, maybe to engage in “small talk” with the virtual agent. Determine whether you want to let the user resume the original conversation after switching topics during the conversation.

You can also review the pre-built setup topics, conversation topics, and topic blocks (reusable subflows that perform certain design steps and logic). Determine whether you can use these pre-built items and consider customizing them as needed.

**Understand the design process in Virtual Agent Designer**

When you create a topic in Virtual Agent Designer, the design process involves these basic steps:

**Topic design process**

1. **Choose the topic type & set topic properties**
2. **Build the conversation flow**
3. **Test & fine tune the conversation flow**
4. **Publish your topic**

The topic properties determine the different ways in which a topic is designed and used. For example, you can control who uses the topic and any conditions that affect how or when the topic is used. If you’re using ServiceNow Natural Language Understanding (NLU), you can associate an NLU model and intent with your topic. For details on the properties that you define for various objects, see *Create a Virtual Agent topic*, *Create a reusable topic block*, and *Create a custom control*. 
Have knowledge in the following areas (what to know before you begin).

- General knowledge of the ServiceNow platform and application table structures.
- If you’re using NLU, an understanding of how intents, entities, and utterances are used in your NLU models.
- If you’re using scripts in conversation design, an understanding of HTML, JavaScript, and REST integrations.

Your conversation topics in the Topics page

When you open Virtual Agent Designer, the Topics landing page lists all of the objects in your instance. This includes topics, topic blocks, custom controls, setup topics, and small talk topics. The Topics page lets you access, create, and edit these objects in Virtual Agent Designer.

You can also test (preview) active topics to verify that they work as intended, as well as sort and search for topics. When you have many topics, use the sort filters to quickly organize and find your topics.

Each topic card identifies the object (such as topic, topic block, setup topic, small talk topic, or custom control) and provides the following basic information:

- Name: Object name. If the object is a topic block or custom control, the icon for the object type is also displayed.
- Published status: Time (minutes, hours, days, or months) that the item was last published and state. Also indicates if the object is read only.
Pre-built topics include *(Template)* in the name. You can duplicate these predefined conversation templates and use them.

- **Draft state:** If you update a published item but have not yet republished it, the Published status is marked as Draft. This lets you quickly identify the items that are still in progress.

- **Modified:** Time (minutes, hours, days, or months) that the item was last updated.

- **Category:** Type of group to which the topic or object belongs.

- **Creator:** Topic author.

**Example topic card with publish status and category**

<table>
<thead>
<tr>
<th>Topic name</th>
<th>Hardware issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Published 13 days ago, Draft</td>
<td>Draft status (unpublished changes)</td>
</tr>
</tbody>
</table>

### Filters and options in the Topics page

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Search by topic name</strong></td>
<td>Option for finding a topic that matches the name or search string that you enter.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Filter for displaying Virtual Agent objects:</td>
</tr>
<tr>
<td></td>
<td>- Topics: Lists only topics (and not blocks or custom controls), including pre-built topics.</td>
</tr>
<tr>
<td></td>
<td>- Topic blocks: Lists pre-built and custom topic blocks</td>
</tr>
<tr>
<td></td>
<td>- Setup topics: Lists topics that are basic conversational elements, such as the conversation greeting or closing.</td>
</tr>
<tr>
<td></td>
<td>- Small talk topics: Lists topics that serve as casual conversations between the bot and end users, where the bot answers questions typically not related to the original task or issue.</td>
</tr>
<tr>
<td></td>
<td>- Custom controls: Lists custom controls that represent custom components used in a conversation.</td>
</tr>
</tbody>
</table>
### Filters and options in the Topics page (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By default, the Topics page lists all active (published) and inactive (in development) objects, unless you use filters to list only certain types of objects.</td>
</tr>
<tr>
<td>Category</td>
<td>Filter that displays a list of topics belonging to a category that you specify. A category is a label that identifies a group of objects, such as setup topics or pre-built topics for a particular business application. You can also define your own custom categories. For details, see <a href="#">Create or modify custom categories</a>.</td>
</tr>
<tr>
<td>Status</td>
<td>Filter that displays a list of objects by their state:</td>
</tr>
<tr>
<td></td>
<td>• Active: Display only published objects</td>
</tr>
<tr>
<td></td>
<td>• Inactive: Display only objects in development</td>
</tr>
<tr>
<td>NLU Language</td>
<td>Filter that displays only if you’re using multi-language NLU models. Lists NLU-enabled topics by the language you select.</td>
</tr>
<tr>
<td>[NLU only]</td>
<td>Enable the languages for the NLU service in <a href="#">NLU settings</a>.</td>
</tr>
<tr>
<td>Channel</td>
<td>Filter that lists topics by the channel (chat client) that you select. The default channels for Virtual Agent are the web chat client and the messaging integrations for Slack, Microsoft Teams, Workplace, and Facebook Messenger. Your instance may have other channels, such as SMS, that were created using custom chat integrations.</td>
</tr>
<tr>
<td>Created by Me</td>
<td>Option that, when enabled, displays only the topics that you created.</td>
</tr>
<tr>
<td>Sort by</td>
<td>Filter that displays topics by the sort filter that you select:</td>
</tr>
<tr>
<td></td>
<td>• Name: Specified topic or object</td>
</tr>
<tr>
<td></td>
<td>• Updated Time: Recently updated topics</td>
</tr>
<tr>
<td>Localization</td>
<td>Button that opens the Localization Insights dashboard. It shows reports of topics with their translation statuses. For more information, see <a href="#">Localization Insights dashboard</a>.</td>
</tr>
<tr>
<td>Insights</td>
<td></td>
</tr>
<tr>
<td>Test Active Topics</td>
<td>Button that opens the chat test window, which runs active topics in the Virtual Agent web client. Use this feature to test and verify that your active topics work as intended.</td>
</tr>
</tbody>
</table>
Filters and options in the Topics page (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ Create</td>
<td>Option that opens the Properties page to create a topic or topic element and define the topic properties.</td>
</tr>
</tbody>
</table>

Virtual Agent Designer topic properties

Use the properties in the Topic Properties page to identify a topic and how it is used. You can control who uses the topic and what channels it can run in. The properties you can specify depend on the design mode: NLU or keyword. For example, if you enable NLU in the **General Settings** page, the Topic Properties page includes fields for identifying the NLU model and intent for the topic.
For a complete description of topic properties, see Create a Virtual Agent topic.

**Virtual Agent Designer topic flows**

When you create or update a topic, topic block, or custom control, you build the conversation flow in the **Flow** tab. Use the controls for user inputs, bot responses, and utilities to define the flow. The status of the topic and NLU model (if used) appears in the upper-right corner of the window.
Example Virtual Agent Designer Flow tab

Flow tab

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Navigation bar</td>
<td>Breadcrumbs to navigate from your design back to the Topics page. When updating designs, the right corner displays a message indicating the status of the design. For example, a message might indicate that you have unpublished changes for your topic or NLU language bindings.</td>
</tr>
<tr>
<td>(2) Header bar</td>
<td>Tabs and design options for your topic:</td>
</tr>
<tr>
<td></td>
<td>• Tabs: Each tab provides a different view for working on your design.</td>
</tr>
<tr>
<td></td>
<td>• Flow: Displays the canvas for building your conversation flow.</td>
</tr>
<tr>
<td></td>
<td>• NLU Intent: If you bind your topic to a ServiceNow NLU model and intent, shows the intent and associated entities for your topic.</td>
</tr>
<tr>
<td></td>
<td>• Properties: Displays the Topic Properties page for defining the design properties.</td>
</tr>
<tr>
<td></td>
<td>• Languages: Shows the status of translated content for the topic. Depending on the user role, you can request translations or edit</td>
</tr>
</tbody>
</table>
**Flow tab (continued)**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>translations here. If you’re using language-specific NLU models for topic translation, the NLU Language Mapping tab is displayed. Use it to map your topic to intents in language-specific NLU models.</td>
<td></td>
</tr>
<tr>
<td><strong>Table View</strong>: Option that displays a table view of the nodes in the conversation flow. You can use this option to switch between table view and diagram view as you design your conversation.</td>
<td></td>
</tr>
<tr>
<td><strong>Active</strong>: Option that changes the design state so that it is active (available to users) or inactive (in development and not available to users).</td>
<td></td>
</tr>
<tr>
<td><strong>Camera icon</strong>: Option for saving or copying the flow diagram as an image.</td>
<td></td>
</tr>
<tr>
<td><strong>Design options</strong>:</td>
<td></td>
</tr>
<tr>
<td>◦ <strong>Delete</strong>: Remove the current and published version of the design.</td>
<td></td>
</tr>
<tr>
<td>◦ <strong>Duplicate</strong>: Copy the current design to create an unpublished version of the design.</td>
<td></td>
</tr>
<tr>
<td>◦ <strong>Save</strong>: Saves the current design.</td>
<td></td>
</tr>
<tr>
<td>◦ <strong>Test</strong>: Opens the design in a chat test window so that you can preview and test the conversation. If Microsoft Teams or Slack is configured for your environment, click <strong>Preview in Microsoft Teams</strong> or <strong>Preview in Slack</strong> in the list to test your topic in those environments.</td>
<td></td>
</tr>
<tr>
<td>◦ <strong>Publish</strong>: Activates the design and makes it available to the chat clients. If you’re using language-specific NLU models, select <strong>Review and publish</strong> from the Publish list to specify languages.</td>
<td></td>
</tr>
<tr>
<td>(3) <strong>Palette</strong>: List of controls that you can drag onto the canvas to build a conversation. The following types of controls are available:</td>
<td></td>
</tr>
</tbody>
</table>
### Flow tab (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>User Input:</strong></td>
<td>Controls used to prompt and capture information from the user in a conversation.</td>
</tr>
<tr>
<td>• <strong>Bot Response:</strong></td>
<td>Controls for displaying virtual agent responses in a conversation.</td>
</tr>
<tr>
<td>• <strong>Utilities:</strong></td>
<td>Controls for performing actions within a topic, such as running a script, adding different conversation paths (branches) in a topic, or adding topic blocks.</td>
</tr>
<tr>
<td>(4) Canvas</td>
<td>Area that displays the conversation flow graphically. As you drag a control onto the canvas, that control becomes a node in the conversation flow. Includes an associated property sheet that opens in the right pane. Each flow has a <strong>Start</strong> and <strong>End</strong> node. When you add or remove controls, the layout of controls on the canvas is adjusted automatically.</td>
</tr>
<tr>
<td>(5) Canvas search</td>
<td>Option for quickly finding specific nodes in the conversation flow. Select the icon to expand the search field and enter the name of the node that you want to find. When a matching node is found, the node is highlighted in the flow. Use the left or right arrows to search for the previous or next node that matches the search node name.</td>
</tr>
</tbody>
</table>
Flow tab (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(6) Property sheet</td>
<td>Properties specific to the selected node on the canvas. Each node has its own set of properties that you can define, which can include scripts that control the behavior or processing that is performed in the node. If NLU is enabled, the property sheets for Input controls contain additional NLU fields.</td>
</tr>
<tr>
<td>(7) Data pill picker</td>
<td>A tool for selecting data pills from input variables or script variables to use in the property field. Click the data pill picker to select from the existing variables accessible in the topic. You can also drag data pills directly into property fields.</td>
</tr>
<tr>
<td>(8) Script editor</td>
<td>A tool for adding or editing JavaScript scripts used in a property. Provides scripting assistance, including a list of valid elements at the insertion point, such as function name, object names, and variable names available for the topic. For more information, see the JavaScript syntax editor.</td>
</tr>
<tr>
<td>(9) Variables sidebar</td>
<td>Section that shows all variables declared for the topic. Types of variables include the following:</td>
</tr>
</tbody>
</table>
Flow tab (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Scripting variables added by the topic author to store values outside</td>
<td>Scripting variables added by the topic author to store values outside of control variables. Scripting variables enable more complex scripting scenarios.</td>
</tr>
<tr>
<td>of control variables. Scripting variables enable more complex scripting</td>
<td></td>
</tr>
<tr>
<td>scenarios.</td>
<td></td>
</tr>
<tr>
<td>• &quot;Nodeless&quot; NLU entities added by the topic author that are used as</td>
<td>&quot;Nodeless&quot; NLU entities added by the topic author that are used as slot-filled input variables for the topic.</td>
</tr>
<tr>
<td>slot-filled input variables for the topic.</td>
<td></td>
</tr>
<tr>
<td>• Live Agent variables specified on the topic Properties tab to</td>
<td>Live Agent variables specified on the topic Properties tab to provide contextual information from the virtual agent session to the live agent.</td>
</tr>
<tr>
<td>provide contextual information from the virtual agent session to the</td>
<td></td>
</tr>
<tr>
<td>live agent.</td>
<td></td>
</tr>
<tr>
<td>• Input variables defined by User Input controls that are added to the</td>
<td>Input variables defined by User Input controls that are added to the flow on the canvas.</td>
</tr>
<tr>
<td>flow on the canvas.</td>
<td></td>
</tr>
</tbody>
</table>

**Virtual Agent Designer topic flows in table view**

The Table View option in Virtual Agent Designer displays the nodes in your conversation flow as a table, rather than as a diagram. Each node is identified in a corresponding row in the table. You can add, change, or delete nodes using these table rows.

For example, instead of dragging and dropping controls onto the canvas, you use Add new node to insert a node into the appropriate row in the table. When you focus on a particular row (node), the corresponding property sheet for the node displays.

As you create or update your design, you might find it helpful to switch between diagram view and the Table View using the Table View option, especially when you have many nodes in your conversation and want to quickly review the all the nodes in your conversation. You can use the Search table option to quickly find a particular node or control.
**Example Virtual Agent Designer Flow tab in Table View**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Navigation bar</td>
<td>Breadcrumbs to navigate from your design back to the Topics page. When updating designs, the right corner displays a message indicating the status of the design. For example, messages indicate when you have unpublished changes for your topic or NLU language bindings.</td>
</tr>
<tr>
<td>(2) Header bar</td>
<td>Tabs and design options:&lt;br&gt;&lt;ul&gt;&lt;li&gt;<strong>Tabs</strong> - Each tab provides a different view for working on your design (topic, topic block, or custom control):&lt;br&gt;  ◦ <strong>Flow</strong> - Displays the canvas for building your design flow.&lt;br&gt;  ◦ <strong>NLU Intent</strong> - Displays if you’ve associated your topic with a ServiceNow NLU model and intent. Shows the Intent page with the corresponding utterances and associated entities that maps to your topic or topic block.&lt;br&gt;  ◦ <strong>Properties</strong> - Displays the Topic Properties page for defining the design properties.&lt;br&gt;  ◦ <strong>Languages</strong> - Shows the status of translated content for the topic. Depending on the user role, you can request translations or edit translations here. If you’re using language-</td>
</tr>
</tbody>
</table>
Flow tab in Table View (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow tab</td>
<td>Specific NLU models for topic translation, the NLU Language Mapping tab is displayed. Use it to map your topic to intents in language-specific NLU models.</td>
</tr>
</tbody>
</table>

- **Table View** - Option that displays a table view of the nodes in the conversation flow. You can use this option to switch between table view and diagram view as you design your conversation.

- **Active** - Option that changes the design state so that it is active (available to users) or inactive (in development and not available to users).

- **Design options:**
  - **Delete** - Deletes the current and published version of the design.
  - **Duplicate** - Copy the current design to create an unpublished version of the design.
  - **Save** - Saves the current design.
  - **Test** - Opens the design in a chat window to preview and test. If Microsoft Teams or Slack is configured for your environment, click **Preview in Microsoft Teams** or **Preview in Slack** in the list to test your topic in those environments.
  - **Publish**: Activates the design and makes it available to the chat clients. If you’re using language-specific NLU models, select **Review and publish** from the Publish list to specify languages.

<table>
<thead>
<tr>
<th>(3) Variables sidebar</th>
<th>Section that shows all variables declared for the topic. Types of variables include the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Scripting variables added by the topic author to store values outside of control variables. Scripting variables enable more complex scripting scenarios.</td>
</tr>
<tr>
<td></td>
<td>• &quot;Nodeless&quot; NLU entities added by the topic author that are used as slot-filled input variables for the topic.</td>
</tr>
</tbody>
</table>
### Flow tab in Table View (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Live Agent variables specified on the topic Properties tab to provide contextual information from the virtual agent session to the live agent.  
• Input variables defined by User Input controls that are added to the flow on the canvas. |                                                                                                                                                        |

#### (4) Table view
A list of table rows, where each row corresponds to a node in the conversation flow. You can add nodes in this section. When you add or remove nodes, the table rows adjust automatically. A node can be any of the following controls, aside from the **Start** and **End** nodes:

- **User Input**: Controls used to prompt and capture information from the user in a conversation.
- **Bot Response**: Controls for displaying virtual agent responses in a conversation.
- **Utilities**: Controls for performing actions within a topic, such as running a script, adding different conversation paths (branches) in a topic, or adding topic blocks.

#### (5) Search table
Option for searching nodes in the conversation (table).

#### (6) Property sheet
Properties specific to the selected node in the table. Each node has its own set of properties that you can define, which can include scripts that control the behavior or processing performed in the node. If NLU is enabled, the property sheets for Input controls contain additional NLU fields. You can also delete a node from the property sheet.

#### (7) Data pill picker
A tool for selecting data pills from input variables or script variables to use in the property field. Click the data pill picker to select from the existing variables accessible in the topic. You can also drag data pills directly into property fields.

#### (8) Script editor
A tool for adding or editing JavaScript scripts used in a property. Provides scripting assistance, including a list of valid elements at the insertion point, such as function name, object names, and variable names available for the topic. For more information, see the [JavaScript syntax editor](#).
Virtual Agent controls

A Virtual Agent topic consists of a collection of controls within a topic flow. Use these controls to collect, process, and present information to your users. Controls can also read, create, and update records on your instance.

Each set of controls performs specific functions in a conversation flow.

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bot Response</td>
<td>Controls that display bot responses in a conversation.</td>
</tr>
<tr>
<td>Start segment</td>
<td>Control that appears automatically in a topic flow and cannot be added to or removed from a conversation. It can be configured with a greeting response that appears when a conversation begins.</td>
</tr>
<tr>
<td>End segment</td>
<td>Control that appears automatically in a topic flow and cannot be added to or removed from a conversation. It can be configured with a final confirmation message before the end of a conversation. Ensure that all branches of your topic eventually connect to this control.</td>
</tr>
<tr>
<td>User Input</td>
<td>Controls that prompt and capture information from the user in a conversation.</td>
</tr>
<tr>
<td>Utilities</td>
<td>Controls that handle actions and logic within a topic, such as running a script or adding different conversation paths (branches) in a topic.</td>
</tr>
</tbody>
</table>

For controls that have prompts, messages, default values, or confirmation messages, you can enter any of the following input values:

- Text strings
- Data pills
• Strings with embedded data pills
• Scripts that return strings

Data pills
Use data pills to quickly and easily add dynamic information to your controls without using script. Click the data pill button (🔗) to open the data pill picker interface. In this interface you can select data from script variables and input variables set by your User Input controls.

Data pill and scripted responses

<table>
<thead>
<tr>
<th>Method</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data pill</td>
<td><img src="image" alt="Data pill interface" /></td>
</tr>
<tr>
<td>Script</td>
<td><img src="image" alt="Script interface" /></td>
</tr>
</tbody>
</table>

This example uses a text bot response that includes the name of the customer, handled both as a data pill and a script. The data pill example uses the data pill selector to choose **Get Name**, an input variable that contains the name of the
customer. The second example accomplishes the same thing using a script. The script example also uses `gs.getMessage` to handle translating the message. Using data pills allows you to quickly and easily access the data in your variables, while scripting allows for more complex options, like handling translation.

**Condition property**

All controls, except the Decision utility and the Start and End nodes, have a condition property. Use this property to determine whether that control is used in a conversation. To always use the control, leave the condition field blank. To determine conditions under which the control is used, provide a script for the condition property that returns a value of true or false. If the return value is false, the control is not used and the conversation will continue to the next control along that branch of the topic. You can also create a condition using the condition builder interface, which lets you add data pills to specify conditions built using this interface. Use conditions to make your conversations more dynamic based on context, data, or scripted logic.

<table>
<thead>
<tr>
<th>Scripted condition</th>
<th>Condition builder condition</th>
</tr>
</thead>
</table>
| ```javascript
(function execute() {
    var gr = new GlideRecord('incident');
    return gr.canCreate();
});
``` | ![Condition builder interface](image) |

In this example, a condition script returns a value of true if the current user is able to create incident records. This condition prevents a utilities control from creating an incident when the user does not have permission to do so.

**Designing a Virtual Agent topic**

Walk through the design of an example Virtual Agent topic that enables users to view incidents they submitted. The example highlights various design controls that can be used to build the conversation flow.

**Plan the structure of a conversation**

The first step in implementing a Virtual Agent topic is to decide what the topic covers. Consider the intended audience and what you want the audience to accomplish when using the conversation. For this example, the goal of this example topic is to create a flow that enables end users to see the status of incidents they submitted. The topic includes an option for the user to add a comment to the incident.
With this goal in mind, the topic needs the following elements:

- A prompt for the user to select an incident
- An output showing the status of the incident
- A prompt to ask if the user wants to leave a comment
- A utility control to branch the conversation on that answer
- A prompt for the user to enter a comment
- A utility control to add the user input as a comment in the incident

Build the conversation flow with Virtual Agent controls
The conversation will look similar to the following dialogue flow.

**Important:** This flow is intended to give you a general idea of how a completed flow looks. Keep in mind that you'll be building your topic incrementally and testing your topic frequently, so it's not necessary to build the entire layout first. Make sure to consider both functionality and user experience in your testing.
Configure controls within the conversation
This example begins with defining the conversation flow in Virtual Agent Designer, after the topic properties have been set. The conversation begins with a Start node and finishes with an End node.

1. In Virtual Agent Designer, add a **Reference Choice** control to the conversation flow. This control is used to select the incident.
   
a. Enter *Choose an incident* for the **Name** property. The variable name *choose_an_incident* is automatically generated for the control.
   
b. In the **Prompt** property, enter the text the user sees before selecting an incident.
   
c. Leave the **Default Value** property blank.
   
d. In the **Reference Type** property, select *Record*.
   
e. In the **Table** property, select *incident*.
   
f. In the **Choice Value Expression** property, select the **Condition Builder** option, and create a condition as shown in this example:

![Condition Builder](image)

2. Add a **Card** control to the flow. This control shows information from the record selected by the **Reference Choice** in the previous step.
   
a. Enter *Status Card* for the **Name** property.
   
b. In the **Reference Type** property, select *Record*.
   
c. In the **Record** property, select *Choose an Incident*. This choice refers to the **Reference Choice** control created in the previous step, so the data displayed comes from the record chosen there.
d. In the **Fields** control, select a field. The choices available are the available fields on the chosen record. In this case, you can see the fields on the incident table.

e. After a field has been selected, click the **Add Field** option to add additional fields to the card. To delete fields from the card, click the delete icon to the right of the field.

3. Add a **Boolean** control to the flow. This control is used to prompt the customer with a yes/no question. In this case, the control checks whether the user wants to leave a comment on the selected incident record.

   a. Enter **Leave Comment?** for the **Name** property. The variable name `leave_comment_` is automatically generated for the control.

   b. In the **Prompt** property, enter the text the user sees before the prompt. In this case, ask users whether they want to leave a comment on the incident.

   c. Optionally, you can enter a value in the **Acknowledge Message** property. This value appears after the user chooses yes or no.

4. Add a **Decision** control to the flow. This control branches the conversation into two possible paths. The path the conversation follows depends on the choice the user made in the previous step.

   a. There are no properties on the decision control; however, there are properties on the branches below the decision. By default, there is a single branch labeled **Always**. Click the blue plus icon at the bottom of the decision control. A second branch appears labeled **Never**.

   b. Click the **Always** branch of the decision to access the properties for this branch.

   c. Change the name to **Leave Comment**.

   d. In the condition property, select the **Condition** option and click the **Add Condition** button. Use the condition builder to create a condition as shown in this screen shot.
If the value of the Leave Comment? is true, this condition is met. This variable is the variable from the Boolean control in the previous step. If the user chose Yes at that prompt, the conversation follows this branch.

e. Click the Never branch of the decision to access the properties for this branch.

f. Change the name to No Comment.

g. In the condition property, select the Condition option and click the Add Condition button. Use the condition builder to create a condition as shown in this screen shot.

[Condition screen shot]

If the value of the Leave Comment? is false, this condition is met. This variable is the variable from the Boolean control in the previous step. If the user chose No at that prompt, the conversation follows this branch.

h. One of the two branches you have created points to the End node of the conversation. The second branch should also lead to this node. Click the arrow at the bottom of that branch and drag it to the End node.

5. Add a Text Input control to the Leave Comment branch of the conversation. This control is used to request text input from the user.

a. Enter Get Comment for the Name property. The variable name get_comment is automatically generated for the control.

b. In the Prompt property, enter the text the user sees before the prompt. In this case, ask the user for the text of the comment.

c. Optionally, you can enter a value in the Acknowledge Message property. This value appears after the user enters a comment.

6. Add an Action control to the conversation below the Get Comment control. This control is used to add the text entered into the previous control as a comment on the selected incident.
a. Enter Update Incident for the **Name** property.

b. In the **Action Type** property, select *Update a Record*.

c. In the **Record** property, select *Choose an Incident*. This choice refers to the Reference Choice control created in the previous step, so the record chosen there is the one that this Action control updates.

d. In the **Field** property, click *Add Field*. You can select and give values to fields from this record in the a pop-up window that appears.

```
Field Values

<table>
<thead>
<tr>
<th>Additional comments</th>
<th>Input Variables - Get Comment</th>
</tr>
</thead>
</table>
```

- Select the **Additional Comments** field from the list.
- Click the (⿰) button to the right of the field to select a value from one of the controls in this conversation.
- Click the Get Comment option from the list. This option refers to the value entered by the user in the **Text Input** control from the previous steps.
- Click the **Save** button at the bottom of the pop-up window.

**Test the conversation**

Use the **Test** button to test the flow of the conversation. Preview topics often throughout the design process to find errors or unexpected behavior quickly. For further information on identifying and resolving issues with topics, see *Debug a Virtual Agent topic*.

**Create a Virtual Agent topic**

Use Virtual Agent Designer to create and modify Virtual Agent topics (conversations). Build your topic to meet a specific objective or goal, such as fulfilling a user's request or helping a user complete a task.

**Before you begin**

- Review *Getting started with conversation design*.
- Configure General Settings. For example, if you're using Natural Language Understanding, configure **NLU Settings**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Verify that you're in the appropriate application scope before you create or update a topic. For example, if you're creating ITSM topics, verify that you're in the ITSM Virtual Agent Conversations scope (and not the scope for the ITSM NLU Model for Virtual Agent Conversations).

• Role required: virtual_agent_admin or admin

About this task
The topic is in the inactive state until you publish it. Publishing a topic changes the topic state to Active and automatically deploys the topic to your Virtual Agent clients.

If you configured NLU, the Set up Natural Language Understanding (NLU) section displays on the Topic Properties page. You can use this section to specify the associated NLU model and intent for the topic. (To map a model, it must be trained, but it does not have to be published.) You can also optionally specify keywords that Virtual Agent can use to determine the topic to be run if NLU doesn't return a matching intent and topic. Virtual Agent uses keywords when:

• No topics (intents) are discovered.

• The appropriate topic (intent) can't be determined because multiple topics (intents) are discovered. If there are multiple topics discovered, Virtual Agent displays three matching intents, from which the user can choose. For more information, see Natural Language Understanding in Virtual Agent.

Note: If Virtual Agent can't determine the topic based on NLU or the keyword, it falls back on the AI search capability to deliver relevant results.

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Designer.
2. In the Topics page, click + Create.
3. In the Properties page, enter the initial topic properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the topic that reflects its business purpose.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief explanation of the topic purpose and functionality.</td>
</tr>
<tr>
<td>Categories</td>
<td>Label used to identify and group related topics, topic blocks, or custom controls.</td>
</tr>
<tr>
<td>Type</td>
<td>List of objects that you can create in Virtual Agent Designer:</td>
</tr>
</tbody>
</table>
Choose **Topic** and define the additional properties.

**Keywords**
List of key phrases or terms that users enter to initiate the conversation with the Virtual Agent. Press Enter after each phrase.

4. Complete the topic properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resume originating topic flow</strong></td>
<td>Option that allows the user to return to the original conversation after changing topics during a conversation. Applicable to keyword or NLU mode. Not applicable to Small Talk topics.</td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td>Expression logic you can use to control who sees a topic in the Virtual Agent client:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Condition</strong>: Use the condition builder to add or edit conditions.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Script</strong>: Use the script editor to create or edit a script that contains a condition statement.</td>
</tr>
<tr>
<td><strong>Roles</strong></td>
<td>Roles that a requester must have to view and run the topic. If a topic is public (available to users, including guest users, who aren't authenticated in ServiceNow), select only the Public role.</td>
</tr>
<tr>
<td><strong>Live Agent Variables</strong></td>
<td>Context variables defined in Chat Setup. Select the variables that provide dynamic context (information from the Virtual Agent chat) transferred from the conversation to a live agent. For more information, see Define and publish chat context variables.</td>
</tr>
<tr>
<td><strong>Additional channel support</strong></td>
<td>Chat clients in which the topic or topic block will run. For details, see Channel support for Virtual Agent topics.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available for Agent Autopilot</td>
<td>Option that determines whether the topic is available to a live agent.</td>
</tr>
<tr>
<td></td>
<td>When enabled, an agent can search for and invoke the topic. For details, see Autopilot in Agent Chat.</td>
</tr>
</tbody>
</table>

Set up Natural Language Understanding (NLU)

| NLU Model [NLU only]                      | Natural Language Understanding model to be applied to the topic. The model contains the user utterances associated with the trained intents and entities that enable your bot to understand what a user says. The model does not have to be published, but it must be trained to appear in the list of available models. For more information about the supported languages, see Language support for NLU services. |

**Note:** To see how and where the NLU model is used, navigate to NLU Workbench > Models, and sort on the Created for column.

| Associated Intent [NLU only]              | The intent, when recognized by Virtual Agent, that launches this topic. The intent must be trained in NLU Workbench before you can map it. Once trained, it will be visible in this list. It does not have to be published. |

| Keywords [NLU only]                       | Optional list of key phrases or terms that users enter to initiate the conversation with the Virtual Agent. Press Enter after each phrase. |

5. Click **Create**.

6. In the **Flow** tab, build the conversation flow.

<table>
<thead>
<tr>
<th>Flow steps</th>
<th>Description</th>
</tr>
</thead>
</table>
| Add controls | To create the topic flow:  
  a. Select the controls for user inputs, bot responses, or utilities from the palette and drop them onto the canvas.  
  When you add a control to the canvas, it becomes a node in the conversation flow. |
### Flow steps | Description
--- | ---
**b.** For each node, complete the corresponding property sheet and click **Save** in the topic header bar. For details about each control and the corresponding properties that you define, see **User inputs**, **Bot responses**, and **Utilities**. As you add controls, watch for warnings in the upper left corner of the control. The red icon shows a number that indicates the number of issues in that control, such as missing information in the property sheet.

| Move a node | Click the node, drag it to the new location in the flow, and click **Save**. |
| Delete a node | Click the X in the upper right corner of the node, and click **Save**. **Note:** You can’t delete a node that has a script variable used by subsequent JavaScript expressions in the flow. Also, you can delete a decision node only when it has a single leaf branch. |

#### 7. Optional: If NLU is enabled for Virtual Agent, add nodeless NLU entities as input variables to the topic. These variables can be slot-filled from NLU service provider predictions or provided outside of the scope of the topic. For example, if a custom control prompts a user for a date and the user mentioned a date in their initial utterance, you can capture that without prompting the user again. To prompt the user when not slot-filled, use input components.

**a.** In the Variables sidebar, click the plus icon (+).

**b.** On the form, fill in the fields.

### Add Input Variable dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Input Types | Data type of the input. The fields change according to your choice.  
  • String: Alphanumeric text. Shows the **Text Input Format** field. Choose plain text or a conforming rule, depending on the type of data.  
  • True/False: Boolean value, either yes or no. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Time</td>
<td>Date, time, or both. Shows the <strong>Format</strong> field.</td>
</tr>
<tr>
<td>Static Choice</td>
<td>Defined user choices. Shows <strong>Label</strong> and <strong>Value</strong> field pairs.</td>
</tr>
<tr>
<td>Reference Choice</td>
<td>Choice of table records. Shows <strong>Reference Type</strong>, <strong>Table</strong>, and <strong>Choice Value Expression</strong> fields. The value can be either conditional or scripted. For details, see Virtual Agent data types.</td>
</tr>
</tbody>
</table>

**Name**

Name of the variable for the entity. (Optional) Variable names must be unique within the scope of a topic. The name appears as a variable when used in dot walking.

**Associated Entity**

The NLU entity associated with the node. (Optional) This could be a pre-built Virtual Agent entity that you import into the model, a system entity (such as DURATION, TIME, or MONEY), or a custom entity that you created.

**Skip confirmation for recognized entity**

Option that turns off entity confirmation from the user. (Optional) When disabled, Virtual Agent asks the user to confirm that the entity selection is correct.

---

**c. Click Save.**

NLU entities appear alongside topic input variables in the Variables sidebar.

![NLU entity and Input variable](image)

(Optional) For more information about system entities, see NLU system entities. For more information about defining entities, see Annotating entities.
Note:

You can remove a slot-filled value to prompt the user again (unbind it from the initial input value). For more information, read about the vaInputs.myvar.unbindEntity(); method in Virtual Agent scripts.

8. Click Test in the header bar to test your topic in a chat window. You can review test results in the adjoining tabs. For example, in the Analyze test phrases tab, you can see prediction results for utterances (test phrases) entered for NLU-enabled topics. You can view processing details in the Logs tab. For detailed information, see Test Virtual Agent topics.

If Microsoft Teams or Slack is configured for your environment, click Preview in Microsoft Teams or Preview in Slack in the list to test your topic in those environments. For more information, see Install Conversational Integrations for enterprise messaging apps.

9. When you’re finished with the topic, click Save in the topic header bar. The topic is in the inactive state until you publish it.

What to do next

Publish the topic to deploy the topic to your Virtual Agent clients. The topic state changes to Active.

If you created a topic that might be frequently used in certain contexts (environments), consider promoting the topic as part of the default or custom chat experience.

Insert a header card in a static or reference choice control

When you create a Virtual Agent topic, you can include images and YouTube videos on Static Choice and Reference Choice user input controls.

Before you begin

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Designer and open a topic or create a new one.

2. On the Flow tab, drag a Static Choice or a Reference Choice user input control onto the canvas.

3. In the Properties sheet, slide the Insert a header card option to enable it.
Insert a header card option

Choice List Setting

Insert a header card

Would you like help:

Yes

No, I will use Script

Add card

4. Do one of the following:
   • Select **Yes** to add an image or video without coding.
   • Select **No, I will use Script**.

   Click the **Add Script** button to provide a script, and then you are done.

5. If you selected **Yes**, click **Add card**.

6. On the form, fill in the fields.

Add card dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card type</td>
<td>Type of header card:</td>
</tr>
<tr>
<td></td>
<td>• Large image with text</td>
</tr>
<tr>
<td></td>
<td>• Small image with text</td>
</tr>
<tr>
<td></td>
<td>• Youtube Video Card</td>
</tr>
<tr>
<td></td>
<td>The fields in the dialog box change according to your choice.</td>
</tr>
<tr>
<td>Title</td>
<td>Image or video title. You can enter it directly in the text field or use a data pill or script to provide the value.</td>
</tr>
<tr>
<td>Title Link</td>
<td>The URL to use for the video title hyperlink. You can enter it directly in the text field or use a data pill or script to provide the value. If this field is empty, the title displays as plain text. This field is only available for the Youtube video card option.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief description of the image or video.</td>
</tr>
<tr>
<td>Image URL Link</td>
<td>URL link for the image. You can enter it directly in the text field or use a data pill or script to provide the value. You can also click <strong>Upload Image</strong> to upload the image.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Variable name</td>
<td>Name of the variable. The name is case-sensitive. Spaces in the name are replaced with an underscore character.</td>
</tr>
<tr>
<td>Image alt text</td>
<td>Alternative, screen-readable text that describes the image. It is used for accessibility programs. This field is only available for the large and small image card options.</td>
</tr>
<tr>
<td>Youtube Video ID</td>
<td>The alphanumeric string at the end of the YouTube URL. For example, in the URL <a href="https://www.youtube.com/watch?v=AacDp2mUQ1I">https://www.youtube.com/watch?v=AacDp2mUQ1I</a> the YouTube video ID is AacDp2mUQ1I. This field is only available for the Youtube video card option.</td>
</tr>
</tbody>
</table>

7. Click **Save**.

**Define script variables for a topic**

Use the Variables sidebar to define script variables for a topic. Script variables can store information that is not found in ServiceNow tables. This information can then be shared elsewhere in a topic.

**Before you begin**

Role required: virtual_agent_admin or admin

**About this task**

For more information about writing scripts for Virtual Agent, see [Virtual Agent scripts](#).

**Procedure**

1. Navigate to **Conversational Interfaces > Virtual Agent > Designer**.

2. In the Topics page, select an existing topic or create a new one. The **Flow** tab displays the conversation flow.

3. In the Variables sidebar, click the plus icon (➕).

4. On the form, fill in the fields.
Create a small talk topic

Build small talk topics that enable your virtual agent to engage in casual conversation with users. A small talk topic provides a response to a casual question that users might ask during a conversation, such as the time or date. A small talk topic can occur anytime within a conversation session and can be unrelated to the original conversation intent.

Before you begin

- Define the corresponding intent for a small talk topic in the appropriate NLU model.
- Role required: virtual_agent_admin or admin

About this task

Small talk topics are NLU-based conversations that diverge from the original bot conversation, usually to provide answers or information to casual questions that end users might ask. For example, you can create small talk topics that provide the current weather or time of day. When users engage with the bot through a small talk topic, they can return to the original conversation topic.

Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Designer.
2. In the Topics page, click + Create.
3. Follow the steps for creating a topic, including the NLU-related properties. Note the following:

   - When you set the topic properties in the Topics Properties page, set the following NLU properties for the small talk topic:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLU Model</td>
<td>Model that defines the intent for this small talk topic.</td>
</tr>
<tr>
<td>Associated intent</td>
<td>Intent defined in the NLU model for this small talk topic.</td>
</tr>
</tbody>
</table>

   - When you complete your small talk topic, remember to publish it when you are ready to deploy it to your Virtual Agent clients.
Control topic discovery and visibility

Admins and topic authors can enable Virtual Agent to discover topics for use in chats, include a topic in the list users see, or both. The topics can be setup topics and small talk topics.

Before you begin
Role required: Admin

About this task
For the Rome release, Virtual Agent Designer includes two options in the Active option of the header bar.

Admins or topic authors can use these options to manage the active topics. Admins or topic authors can do one or both of the following:

- Include the topic in topic discovery.
  By selecting Included in topic discovery, admins or topic authors can enable Virtual Agent to discover the topic by using:
    - Keywords.
    - Natural Language Understanding (NLU), if NLU is enabled.

  Note: If these methods don’t generate search results, or Virtual Agent can’t determine the appropriate conversation to display, use AI Search as a fall-back method.

- Include the topic in the list of topics available for use.
  By selecting Included in list of topics, admins or topic authors can include the topic in the All Topics menu. The All Topics menu lists all of the topics available for use.
  To see the All Topics menu, first select Show me everything in the chat window.
You should then see the **All Topics** menu.
The options you select automatically update the corresponding property in the Topics [sys_cs_topic] table. For example, if you’ve enabled **Included in topic discovery**, the **Is Topic Discoverable** property in the Topics [sys_cs_topic] table is set to true.

### Procedure

1. **Create a Virtual Agent topic.**
2. Select the **Active** option in the header bar.
   - **Note:** Selecting this option also publishes the topic.
3. Select the options you want to use, or accept the default settings. Some options are enabled or disabled by default, based on the type of topic.

<table>
<thead>
<tr>
<th>Default settings by topic</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Included in Topic Discovery</td>
</tr>
<tr>
<td>Topics</td>
<td>Enabled</td>
</tr>
<tr>
<td>Setup topics</td>
<td>Disabled</td>
</tr>
<tr>
<td>Small talk topics</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

4. **Select Save.**
5. **(Optional) Select Test** to test the topic.

### Results

Depending on the options enabled, Virtual Agent can discover the topic, the topic is included in the **All Topics** menu in the chat window, or both.

### Use system-derived entities in a topic

Associate system-derived entities such as such as date, time, duration, or location with a node in a topic.

### Before you begin

Create the Booking Reservations NLU model and system entities (**FromLocation** and **ToLocation**) as described in **Create a system-derived entity.** In this example
procedure, you will create a topic that can slot fill locations that are used in an utterance.

Role required: admin or virtual_agent_admin

Procedure

1. Create a new topic called Booking Reservations.
   When completing the Properties tab, make sure that you choose the Booking Reservations NLU model that you created in an earlier exercise.

2. Drag a Text bot response component onto the canvas, and then select it.
   In the properties sheet, fill in the fields.

   **Response Properties sheet**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type Intro.</td>
</tr>
<tr>
<td>Response Message</td>
<td>Type Let's get you booked on a flight.</td>
</tr>
</tbody>
</table>

3. Drag a Text user input component onto the canvas.
   In the properties sheet, fill in the fields.

   **User Input Properties sheet**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type Fromwhere.</td>
</tr>
<tr>
<td>Text Input Format</td>
<td>Select Text. This doesn't restrict the input format.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Type Where are you departing from?</td>
</tr>
<tr>
<td>Associated Entity</td>
<td>Select FromLocation.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable NLU at Input Node</td>
<td>This is enabled by default when you associate an entity with the node.</td>
</tr>
<tr>
<td>Skip confirmation for recognized entity</td>
<td>Select this option to avoid having Virtual Agent ask the user to confirm the location.</td>
</tr>
</tbody>
</table>

4. Drag another Text user input component onto the canvas. In the properties sheet, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type <code>towhere</code>.</td>
</tr>
<tr>
<td>Text Input Format</td>
<td>Select <strong>Text</strong>. This doesn't restrict the input format.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Type <code>And where are you heading?</code>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Associated Entity</td>
<td>Select <code>ToLocation</code>. This list only shows existing entities, such as system</td>
</tr>
<tr>
<td></td>
<td>entities or entities that you created for the model.</td>
</tr>
<tr>
<td>Enable NLU at Input Node</td>
<td>This is enabled by default when you associate an entity with the node.</td>
</tr>
<tr>
<td>Skip confirmation for recognized entity</td>
<td>Select this option to avoid having Virtual Agent ask the user to confirm the</td>
</tr>
<tr>
<td></td>
<td>location.</td>
</tr>
</tbody>
</table>

**User Input Properties**

- Name: `Tohere`
- Variable Name: `towhere`
- Text Input Format: `Text`
- Make it secure: `off`
- Prompt: `And where are you heading?`
- Associated Entity: `ToLocation`
- Enable NLU at Input Node: `off`
- Skip confirmation for recognized entity: `off`

**5.** Drag another Text bot response component onto the canvas, and then select it.
   In the properties sheet, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type <code>Confirmation</code>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Response</td>
<td>Type Great! I have you booked on a flight from [Fromwhere] to [Towhere]. Bon voyage! Use dot-walking to replace [Fromwhere] and [Towhere] with the input variables you created in the previous nodes.</td>
</tr>
</tbody>
</table>

6. Click Save.

What to do next
Use additional system-derived entities for your Booking a Reservation topic. For example, you can use system-derived entities to capture the dates that the user wants to travel.
For more information about default system entities, see NLU system entities.

Duplicate a Virtual Agent topic
To easily create a new topic or topic block, you can copy an existing Virtual Agent topic or topic block and customize it.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Consider duplicating topics:
- To use an existing topic, such as a pre-built topic or topic block, as the basis for a new topic or topic block.
- When you want to modify an active topic but also preserve the original topic for reference purposes or as a backup.
Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Designer, and in the Topics page, click the item to be copied.

2. In the header bar for the item, click Duplicate.
   
a. In the Duplicate window, enter the new name for the item.
   
b. Click Save.

3. Update the properties in the Properties tab and in the Flow tab change the conversation flow design as needed.

   Note: Keep in mind the goal or purpose of your new topic as you set the properties and update the flow. For example, if you're using keyword-based topics, you might need to change certain keywords based on the purpose of your new topic. For NLU-enabled topics, you might need to change the NLU model and intent associated with the topic.

<table>
<thead>
<tr>
<th>If you're duplicating</th>
<th>See this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topics</td>
<td>See Create a Virtual Agent topic for a description of the topic properties that you can change and how to add or change the nodes in the flow.</td>
</tr>
<tr>
<td>Topic blocks</td>
<td>See Create a reusable topic block for a description of the topic block properties that you set and the input and output parameters that you define for the block.</td>
</tr>
</tbody>
</table>

4. As you update your design, use the Test option to run your design in a chat test window, then fine tune your design flow accordingly. For details on test features, see Test Virtual Agent topics.

What to do next

If you've completed the topic or topic block, publish it to deploy it to your Virtual Agent clients.

Test Virtual Agent topics

Use the chat test window to preview, test, and debug Virtual Agent topics and topic blocks.

As you work on a topic or topic block, use the Test option in the topic header bar to run your conversation in a chat test window. The default test window is the web (Service Portal) chat client. If it is configured for your instance, you can also run the test window in Microsoft Teams or Slack. You can also use the Test option in the topic header bar to run your conversation in a chat test window.
Active Topics button in the Topics page to run active (published) topics in the web chat client.

Test options

If you’re using the Virtual Agent integrations with third-party messaging apps, elements in your conversation might appear differently in third-party messaging applications. If Microsoft Teams or Slack is configured for your environment, click Preview in Microsoft Teams or Preview in Slack in the list to test your topic in those environments. Test your conversations in any third-party applications where you intend to deploy Virtual Agent.

Testing your topic in the chat test window
To run your topic in the chat test window, click the Test option in the topic header bar. The chat test window opens and displays adjoining tabs that provide details about your topic as you test it. You can use these tabs:

• **Analyze Test Phrases** - If you’re using NLU, displays the results for intent matching and entity recognition, based on what you entered in the conversation.

• **Variables** - List of all the variables used in the conversation, such as input and Live Agent variables.

• **Context** - Options for specifying the context in which a topic is run.

• **Logs** - A list of the processing performed.
By default, the **Include Topic Discovery** option is enabled, which automatically performs topic discovery and generates prediction results for NLU-enabled topics, using test phrases that you enter in the test window. The conversation begins with the Virtual Agent greeting and the button for the menu of available topics.

If you’re using the **Test Active Topics** option from the Topics page, topic discovery is enabled, so it is not listed as an option. Testing active topics behaves the same as testing from a topic.

**Analyze test phrases tab**

For NLU-enabled topics, the **Analyze test phrases** tab provides an analysis of the possible intents that match the test phrase (utterance) that you entered in the chat test window. The tab lists the prediction results, which include matched intents and their prediction scores, along with any entity recognition and slot-filling results. The top match is listed first. The predicted intents depend on the prediction confidence threshold set in the NLU service.
If an utterance doesn't match a current intent, you can add or modify utterances in Virtual Agent Designer.

**Example NLU Intent tab in Virtual Agent Designer**

If an utterance doesn't match a current intent, you can add or modify utterances in Virtual Agent Designer.

**Example Analyze test phrases tab**

Test this topic

- Include topic discovery

“see tickets”

**PREDICTED INTENTS**

- **84% Intent CheckITTicketStatus**
  - Model [Read Only] ITSM NLU for Virtual Agent
  - Topic JW Test Servicenow NLU FR
  - entity @tasktype value incident

- **77% Intent OpenITTicket (K20)**
  - Model ITSM NLU (K20)
  - Topic Open IT Ticket (K20)
  - entity @tasktype value

- **70% Intent SubmitARequest**

- **68% Intent EscalateITTicket**

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Make changes, train the model again, and then retest until you are satisfied with the results. When the topic is ready, you can publish both the topic and the model from Virtual Agent Designer.

**Variables tab**
The Variables tab displays a list of all the variables used in the conversation and the associated values captured as the conversation progresses, so that you can follow along. A conversation can have these variable types:

- Input variables
- Script variables
- Live Agent variables
- Variables passed between a calling topic and topic block
- "Nodeless" NLU entities declared as a slot-filled variable for the topic

The list is separated into sections, by type of variable. The following example shows the Input variables section. Notice that for the static list control, both the display label and value are captured for the selected choice.

**Context tab**
Use the Context tab to specify a different context for the chat. Choose a context from the list of variables (these context variables are defined in the Context related list in the Chat Setup form). These variables contain contextual
information that can be used to determine topic intent or control how chats are routed to live agents. For example, you could select portal from the list of variables and enter the portal name, **IT Express**.

**Example Context tab**

The **Logs** tab displays the processing and error messages recorded while running your conversation. If you’re using scripts in Virtual Agent Designer, use `gs.log`, `gs.print`, and `gs.warn` statements in your scripts to output information in this log.
Next step

When you're done testing your topic, close the test chat window. If needed, you can use the test information to fine-tune your conversation. For example, if the results in the **Analyze test phrases** tab return multiple possible matches for your utterance, you could update the utterances for your intent and NLU model in the **NLU Intent** tab for your topic.

Debug a Virtual Agent topic

Investigate and resolve unexpected behavior in your custom Virtual Agent topics, topic blocks, and controls.

Duplicate a live topic before debugging and changing it

Duplicate a topic rather than update a live topic. The unmodified original topic can serve as both a reference and a backup, and retaining the original enables you to quickly restore the topic. Remember to deactivate the original topic before publishing the duplicate.
Debug a topic while testing your conversations

As you create or update a topic in Virtual Agent Designer, use the Test button in the topic header bar to preview the conversation. The chat test window shows the conversation as it appears within Service Portal. Elements in your conversation might appear differently in third-party messaging applications. Test your conversations in any third-party applications where you intend to deploy Virtual Agent.

The test chat window displays three tabs that provide detailed information for debugging and refining your topic: Analyze test phrases, Variables, and Logs. For details on these tabs, see Test Virtual Agent topics. The following example shows the processing messages and errors logged during testing.
Watch for warnings on controls within your topic

Controls that are missing necessary information show a red icon in the upper left corner of the control. The icon shows a number indicating the number of issues in that control. Point to this icon to see a list of the issues in the control.

Another icon appears in the upper left corner of the designer to indicate the number of issues within the entire topic.

Check for errors when a topic preview does not run

Additional information appears under the Virtual Agent Designer canvas when an error prevents the topic from running. Use the information provided to correct any errors in your conversation.
Common Virtual Agent issues

<table>
<thead>
<tr>
<th>Issue</th>
<th>Possible resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot see module designer under conversational interfaces</td>
<td>• User might not have the virtual_agent_admin role.</td>
</tr>
<tr>
<td></td>
<td>• Virtual Agent plugin might not be activated.</td>
</tr>
<tr>
<td>Cannot edit a topic</td>
<td>Logged-in user must be in the same application scope as the topic.</td>
</tr>
<tr>
<td>Cannot preview topic</td>
<td>• Make sure that all required fields are filled in on the node properties.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that your browser is configured to permit pop-ups from your instance.</td>
</tr>
<tr>
<td>Web client stuck at Connecting...</td>
<td>One or more of your topics might be missing. Check the Topics page to ensure that topics are present on the instance and in the Active state.</td>
</tr>
</tbody>
</table>

Review topics that run in a conversation flow

Each Virtual Agent (VA) conversation in an instance automatically generates an interaction record in the Interactions [interactions] table, which logs the conversation between a requester and virtual and live agent. You can review the transcript of the conversation between the requester and virtual agent, including live agent transfers (if using Agent Chat). For details, see Virtual Agent interaction records.

Check NLU prediction information in the Open NLU tables

When reviewing or debugging topics that use Natural Language Understanding (NLU), you can use various Open NLU tables to view the NLU prediction results for your topics. For example, the Open NLU Predict Intent Feedbacks and Open NLU Predict Entity Feedbacks tables provide detailed information on the NLU processing performed by applications (such as Virtual Agent) to determine topic intent and entities (slot filling).

Open NLU Predict Intent Feedbacks table

The Open NLU Predict Intent Feedbacks [open_nlu_predict_intent_feedback] table shows the intent
processing that an application (in this case Virtual Agent) performs in response to an NLU intent prediction result. The goal for Virtual Agent is to map a predicted NLU intent to a Virtual Agent topic.

In the navigation filter, enter `open_nlu_predict_intent_feedback.list`.

### Key fields in the Open NLU Predict Intent Feedbacks table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>App</td>
<td>Application using NLU. For example: <strong>va</strong> (Virtual Agent).</td>
</tr>
<tr>
<td>App Document</td>
<td>sys_id of the application record. For example: <strong>sys_cs_topic.sys_id</strong>.</td>
</tr>
<tr>
<td>App document table</td>
<td>Table of the application record. For example: <strong>sys_cs_topic</strong> (Topics table).</td>
</tr>
<tr>
<td>Auto-Selected</td>
<td>Boolean indicating whether the system detected only one intent above the prediction threshold, and therefore the application chose to run the topic that matched the same intent: <strong>true</strong> or <strong>false</strong>.</td>
</tr>
<tr>
<td>Current Intent</td>
<td>NLU intent that was used by the application when the NLU prediction was submitted. This field can be empty (blank). For example, an intent used in the Virtual Agent application could be <strong>Change password</strong>.</td>
</tr>
<tr>
<td>External Model Display Name</td>
<td>Name of the external NLU model. For example, the name of the IBM Watson Assistant NLU application.</td>
</tr>
</tbody>
</table>
| Intent Switch Causer | Name of the originating topic that prompts the user for confirmation. There are two possible scenarios for values in this column:  
  • The user is prompted for confirmation on the initial intent match for their utterance (**Ask user if topic VA chose is correct** option is enabled in **NLU Settings**).  
  If the user is prompted for an initial utterance, this value may be the Greetings topic. If the value is **empty**, the user either was not prompted for the initial match, or the user rejected the initially matched topic intent. |
### Key fields in the Open NLU Predict Intent Feedbacks table (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>• The user is prompted for confirmation for an intent switch in mid-topic (Ask user if switched topic is correct option is enabled in NLU Settings). If the user is prompted for a switch in mid-topic, this value is the name of the topic they were viewing at the time of the switch.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> System tasks may also display here, which you can ignore. For example: __silent_TerminateGoal_a3817a5f7ca7439b8.</td>
<td></td>
</tr>
<tr>
<td>Intent Switch Causer current Task</td>
<td>Name of the task (node) that the user switches from. <strong>Note:</strong> System tasks may also display here, which you can ignore. For example: __silent_TerminateGoal_a3817a5f7ca7439b8.</td>
</tr>
<tr>
<td>Mapped</td>
<td>Boolean indicating whether the application (Virtual Agent) considered the prediction to be usable by matching the intent to an available topic: true or false.</td>
</tr>
<tr>
<td>Model Display Name</td>
<td>Name of the ServiceNow NLU model.</td>
</tr>
<tr>
<td>Model ID</td>
<td>ID of the NLU model that the prediction was submitted for.</td>
</tr>
<tr>
<td>Model Name</td>
<td>Name of the NLU model that the prediction was submitted for.</td>
</tr>
<tr>
<td>Prediction</td>
<td>Name of the predicted intent.</td>
</tr>
<tr>
<td>Prediction Audit Log</td>
<td>Reference to the Open NLU Predict Logs [open_nlu_predict_log] table.</td>
</tr>
<tr>
<td>Prediction Confidence</td>
<td>Confidence value of the prediction.</td>
</tr>
<tr>
<td>Selected</td>
<td>Boolean indicating whether the multiple predicted intents shown to end users as matched topics were actually selected by the end users: true or false.</td>
</tr>
</tbody>
</table>
Key fields in the Open NLU Predict Intent Feedbacks table (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shown</td>
<td>Boolean indicating whether the application (Virtual Agent) displayed the predicted intent as a choice for the end user to select: true or false.</td>
</tr>
<tr>
<td>Topic Switched</td>
<td>Name of the topic, if the user was prompted for confirmation (regardless of their choice, yes or no).</td>
</tr>
<tr>
<td>Utterance</td>
<td>Phrase entered by the end user in the chat client window.</td>
</tr>
</tbody>
</table>

Open NLU Predict Entity Feedbacks table

The Open NLU Predict Entity Feedbacks [open_nlu_predict_entity_feedback] table shows the entity (slot-filling) processing that an application (in this case Virtual Agent) performs in response to an NLU entity prediction result. For example, the goal of Virtual Agent is to map a predicted NLU entity to a Virtual Agent topic input variable.

In the navigation filter, enter open_nlu_predict_entity_feedback.list.

Key fields in the Open NLU Predict Entity Feedbacks table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>App</td>
<td>Application using NLU. For example, VA (Virtual Agent).</td>
</tr>
<tr>
<td>App Document</td>
<td>sys_id of the application record. For example: sys_cs_topic.sys_id.</td>
</tr>
<tr>
<td>App Document Table</td>
<td>Table of the application record. For example: sys_cs_topic.</td>
</tr>
<tr>
<td>Auto Selected</td>
<td>Boolean indicating whether the application automatically chose to use the entity without notifying the user: true or false.</td>
</tr>
<tr>
<td>External Model Display Name</td>
<td>Name of the external NLU model. For example, the name of the IBM Watson Assistant NLU application.</td>
</tr>
</tbody>
</table>
Key fields in the Open NLU Predict Entity Feedbacks table (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapped</td>
<td>Boolean indicating whether the application (Virtual Agent) considered the prediction to be usable: true or false.</td>
</tr>
<tr>
<td>Mapped to</td>
<td>Item in the application that the entity was mapped to.</td>
</tr>
<tr>
<td>Model Display Name</td>
<td>Name of the ServiceNow NLU model.</td>
</tr>
<tr>
<td>Model ID</td>
<td>ID of the NLU model that the prediction was submitted for.</td>
</tr>
<tr>
<td>Model Name</td>
<td>Name of the NLU model that the prediction was submitted for.</td>
</tr>
<tr>
<td>Prediction</td>
<td>Name of the predicted entity.</td>
</tr>
<tr>
<td>Prediction Audit Log</td>
<td>Reference to the Open NLU Predict Logs [open_nlu_predict_log] table.</td>
</tr>
<tr>
<td>Prediction Confidence</td>
<td>Confidence value for the prediction.</td>
</tr>
<tr>
<td>Selected</td>
<td>Boolean indicating whether the application selected to use the entity: true or false.</td>
</tr>
<tr>
<td>Shown</td>
<td>Boolean indicating whether the application displayed the predicted entity to the end user as a choice to select: true or false.</td>
</tr>
<tr>
<td>Utterance</td>
<td>User phrase entered in the chat client window.</td>
</tr>
<tr>
<td>Value</td>
<td>Value of the predicted entity.</td>
</tr>
</tbody>
</table>

Open NLU Predict Logs

The Open NLU Predict Logs [open_nlu_predict_log] table provides a consolidated overview of the NLU prediction records for topics. Each record in the log identifies the utterance and corresponding intents (topics) and entities determined by the NLU service. Each record also includes the NLU prediction scores calculated during topic discovery (intent matching) and entity extraction.
To view the log, enter `open_nlu_predict_log.list` in the navigation filter.

### Key fields in the Open NLU Predict Logs table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Async</td>
<td>Indicator for asynchronous prediction processing: <code>true</code> or <code>false</code>. True indicates that the prediction was performed asynchronously, allowing Virtual Agent worker threads to continue.</td>
</tr>
<tr>
<td>Created</td>
<td>Date and time the NLU prediction record was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of processing time for the prediction to return intent and entity values.</td>
</tr>
<tr>
<td>Level</td>
<td>Type of message: Information level.</td>
</tr>
<tr>
<td>Message</td>
<td>Prediction results returned: number of intents and entities.</td>
</tr>
<tr>
<td>Request</td>
<td>NLU prediction parameter that contains the utterance and NLU model for the recognized intent.</td>
</tr>
<tr>
<td>Response</td>
<td>NLU prediction results, which contain 0 (none) or more scored intents and scored entities.</td>
</tr>
<tr>
<td>Source</td>
<td>Process or area: OpenNLU - Predict.</td>
</tr>
<tr>
<td>Utterance</td>
<td>User statement recognized by the bot, which maps to an intent defined in an NLU model.</td>
</tr>
</tbody>
</table>

**Note:** You can view the detailed intent and entity results in the Open NLU Predict Intent Feedbacks and Open NLU Predict Entity Feedbacks tables.

### Review HTTP connection information for Open NLU integrations

Use the Open NLU Driver HTTP Connection `[open_nlu_driver_http_connection]` table to quickly check the HTTP credentials, connection details, and methods for the intents, entities, NLU models, and predictions for your NLU service provider.

To view the table, enter `open_nlu_driver_http_connection.list` in the navigation filter.
Publish a Virtual Agent topic

Deploy an inactive topic or an updated topic to save it and make it available to users on Virtual Agent clients. You also publish topic blocks and custom controls to make them available for use in calling topics.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Designer.

2. In the Topics page, select the topic, topic block, or custom control to publish or republish.

<table>
<thead>
<tr>
<th>Option</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Publish an inactive topic, topic block, or custom control | a. In the Topics page, select the inactive item to publish.  
b. In the Header bar for the topic, click **Publish**.  
Virtual Agent Designer automatically saves the item and publishes it. For example, for topics, the topic state changes to Active and the Published state changes to "just now." |
| Publish an inactive NLU topic and model | a. In the Topics page, select the inactive NLU topic to publish.  
b. In the Header bar for the topic, click **Publish**.  
Virtual Agent Designer automatically saves the item and publishes it. For example, for topics, the topic state changes to Active and the Published state changes to "just now."  
c. Click the **NLU Intent** tab.  
d. In the Header bar, click **Train Model**.  
e. Click **Publish Model**. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. In the Topics page, select an updated topic to republish.</td>
<td></td>
</tr>
<tr>
<td>b. From the Publish list in the Header bar, select <strong>Review and publish</strong>.</td>
<td></td>
</tr>
<tr>
<td>c. On the dialog box that appears, review the changes. In this example, changes were made to the topic and NLU bindings:</td>
<td></td>
</tr>
<tr>
<td>You can choose which changes to publish by selecting the check boxes. To exclude a change from being published, clear the check box next to the change.</td>
<td></td>
</tr>
<tr>
<td>If a language is unavailable, the language-specific model has never been published. Publish it from NLU Workbench.</td>
<td></td>
</tr>
<tr>
<td>d. Click <strong>Publish</strong>.</td>
<td></td>
</tr>
</tbody>
</table>
| The topic is republished with the new changes. The Published state changes to "just now."

3. If you published a conversation topic, verify that your keywords or NLU utterances for the topic work as expected.
a. Return to the Topics page, and then click **Test Active Topics**.

b. In the conversation window, verify that the topic opens. You can enter keywords or NLU utterances that correspond to the topic intent. For the pre-built Virtual Agent topics, the bot returns a list of topics that match the entered keyword or utterance.

**Results**
The topic blocks and custom controls are published and are available for use in calling topics.

ℹ️ **Note:** Active topics, including set up topics and small talk topics, can also be available for use after the topics are published. For more information, see *Control topic discovery and visibility*.

**Delete a Virtual Agent topic**
Delete a Virtual Agent topic that is no longer needed.

**Before you begin**
Role required: virtual_agent_admin

ℹ️ **Note:**

In some cases, certain categories of topics cannot be deleted, such as the Greeting, Survey, Live Agent, Error, Explore help, and Closing setup topics.

If you want to remove a topic from your Virtual Agent clients but do not want to delete it, consider making the topic inactive instead.

**About this task**
You can delete a topic using the **Delete** option in the Virtual Agent Designer header bar for the topic.

**Procedure**
1. If you are not working on the topic, navigate to **Conversational Interfaces > Virtual Agent > Designer** to display the Topics page and select the topic.
2. In the **Flow** tab (or any tab for the topic), click **Delete** in the topic header bar.
3. In the Confirm Topic Deletion window, click **Delete**. The tab closes and returns you to the Topics page.

**Results**
The topic is immediately removed from Virtual Agent clients if the topic was active and is no longer listed on the Topics page.
Reusable topic blocks

Topic blocks are reusable components that you can create to run common tasks and conversational elements in Virtual Agent conversations. Topic blocks simplify the topic authoring and maintenance process by enabling you to reuse standard procedures or actions across conversation topics.

How reusable topic blocks work

A topic block is basically a subflow that performs certain actions or conversational tasks in a topic. For example, you can build a topic block that creates or retrieves certain types of records. You create topic blocks with Virtual Agent Designer, similar to the way that you build conversation topics. With Virtual Agent Designer, you can do the following:

- Set topic block properties.
- Define the controls (nodes) used in the block.
- Test or preview the block.
- Publish the block to make it available for use in topics or other topic blocks.

Unlike topics, you don’t define keywords or NLU properties for topic blocks, so they are not standalone and not discoverable.

You can also use Virtual Agent Designer to add topic blocks to conversations. A conversation that uses (consumes) a topic block is referred to as the calling topic. A topic block can call another topic block, but it cannot call itself. You can "nest" topic blocks in this manner, even if the flow returns to the initial topic, as in this example:

Chain of nested topic blocks

![Chain of nested topic blocks diagram]

Note: If the Virtual Agent detects an infinite loop, the conversation ends.

The Virtual Agent platform and applications provide pre-built topic blocks for common tasks or subflows. You can use these pre-built topic blocks in your conversation topics “as is” in the appropriate application scope by duplicating them. You can then customize these pre-built topic blocks as needed. Some of the common topic blocks include the following.
### Examples of pre-built topic blocks

<table>
<thead>
<tr>
<th>Pre-built topic blocks</th>
<th>Application scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Transfer to Live Agent: Transfers a bot conversation to a live agent.</td>
<td>Global. Provided with the Glide Virtual Agent plugin (com.glide.cs.chatbot).</td>
</tr>
<tr>
<td>• Survey: Presents a survey for collecting feedback for an agent.</td>
<td></td>
</tr>
<tr>
<td>• Geolocation: Gathers information about the user's location.</td>
<td></td>
</tr>
<tr>
<td>• Pause: Insert a pause (in seconds) in the conversation.</td>
<td></td>
</tr>
<tr>
<td>• Deflection: Tracks deflection metrics for the Virtual Agent.</td>
<td></td>
</tr>
<tr>
<td>• Contextual search: Uses a search phrase to return search results in a card format,</td>
<td>Common topic block used by the CSM, HR Service Delivery, and ITSM business</td>
</tr>
<tr>
<td>such as knowledge articles and catalog items.</td>
<td>applications. Provided with the Service Management Virtual Agent Topic Blocks</td>
</tr>
<tr>
<td></td>
<td>plugin (com.glideapp.cs.sm_topic_blocks). This plugin is included with the</td>
</tr>
<tr>
<td></td>
<td>Virtual Agent conversation plugins for these business applications.</td>
</tr>
</tbody>
</table>

Topic blocks are listed as cards in the Topics page. Use the **Type** filter to list and view only topic blocks in the Topics page.
After you create and publish a topic block, the block is available for use as a Topic Block utility in Virtual Agent Designer. You can add the topic block to a calling topic or to another topic block. In the following example, the calling topic uses the Contextual Search topic block.

**Example of contextual search topic block in a calling topic**

---

**What to do next**

Working with topic blocks involves the following steps:
1. Create a reusable topic block.

Build a conversation component that performs a common function that can be reused in Virtual Agent conversations.

2. Add a reusable topic block to a calling topic or topic block.

To run a specific subflow, add a reusable topic block to a calling (parent) topic or topic block. Specify the inputs that are used in the topic block and review outputs that are returned from the topic block.

3. Maintain topic blocks and associated calling topics (as needed).

When you update a published topic block, Virtual Agent Designer performs certain checks. Displayed messages inform you of changes that you may want to make to calling topics that use the updated block.

Create a reusable topic block

Build a reusable component that performs a specific subflow of tasks and conversational elements in Virtual Agent conversations.

Before you begin

Role required: virtual_agent_admin or admin

About this task

Use topic blocks to run common steps, such as retrieving certain records.

Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Designer.

2. In the Topics page, do one of the following:

   • To create a topic block from scratch, select + Create.
   • To create a topic block based on a pre-built topic block, select the topic block and do the following:
     a. In the header bar, click Duplicate.
     b. Enter the name of the new block and click Save.

3. On the sheet, fill in the fields.

Topic Block Properties sheet

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the topic block that reflects its functional purpose. This name appears in the list of topic blocks that topic authors can choose from when creating or updating a topic.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Brief explanation of the purpose of the topic block. For example, to retrieve records.</td>
</tr>
<tr>
<td>Categories</td>
<td>Category that contains this block. You can define custom topic categories for your topic blocks.</td>
</tr>
<tr>
<td>Type</td>
<td>List of items that you can create in Virtual Agent Designer. Select Topic Block and define the additional properties.</td>
</tr>
<tr>
<td></td>
<td>✉️ Note: Once you set this topic as a topic block, you cannot change it to a regular topic.</td>
</tr>
<tr>
<td>Live Agent Variables</td>
<td>Live Agent variables defined in the Chat Setup form. Select the variables that provide dynamic context, which means information from the Virtual Agent chat. This information is transferred from the bot conversation to the live agent.</td>
</tr>
<tr>
<td>Additional channel support</td>
<td>Other chat channels or clients that will run the topic block and its calling topics. These channels are different from the default channels that are natively supported by Virtual Agent. Your instance may have additional channels for custom chat integrations created for it. For more information on channels, see Channel support for Virtual Agent topics.</td>
</tr>
<tr>
<td>Available for Agent Autopilot</td>
<td>Option that determines whether the topic block is available to a live agent. When enabled, an agent can search for the topic and invoke the topic. For details, see Autopilot in Agent Chat.</td>
</tr>
<tr>
<td>Available on the palette</td>
<td>Option that determines whether the topic block appears as its own icon in the Utilities section of the palette on the Flow tab. This provides easy access to the topic block for other authors.</td>
</tr>
</tbody>
</table>

4. Click **Create**. The Flow tab opens. The canvas displays a flow with a **Start** and **End** node.

5. To define an input to the block, do the following:

   a. Click the **Start** node in the canvas.

   b. In the Start Segment Properties sheet, click **+ Add**

   c. On the sheet, fill in the fields.
### Add input dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the input variable that stores the input value.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of data being passed to the topic block. For example, <strong>String</strong>, <strong>Boolean</strong>, and so on. The fields change according to your choice. For more information about data types, see <a href="#">Virtual Agent data types</a>.</td>
</tr>
<tr>
<td>Required</td>
<td>Option to set the parameter as required.</td>
</tr>
<tr>
<td>Hint</td>
<td>Tooltip that is visible when authoring a calling topic. See the following example:</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="InputMapping" /></td>
</tr>
<tr>
<td></td>
<td>These variables: <strong>Test Hint String</strong> - Topic Block.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Test String" /></td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="TestString" /></td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="&lt;&gt;/" /></td>
</tr>
<tr>
<td>Table</td>
<td>ServiceNow table that is used to query for input.</td>
</tr>
<tr>
<td></td>
<td>This field is available only when <strong>Reference</strong> or <strong>Array.Reference</strong> is selected from the <strong>Type</strong> field.</td>
</tr>
<tr>
<td>Max Number of Rows</td>
<td>Maximum number of rows that the topic block is allowed to define.</td>
</tr>
<tr>
<td></td>
<td>This field is available only when <strong>Array</strong> is selected from the <strong>Type</strong> field.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Default value for the variable. This value can be used when previewing the block. Duplicate default values are not allowed for array data types.</td>
</tr>
</tbody>
</table>

#### Example

For example, the pre-built Contextual Search topic block provides the following input parameters:
d. Click **Save**.

The calling topic or topic block passes input parameters to the topic block.

6. Drag Virtual Agent Designer controls onto the canvas.
   These controls include the input, bot responses, and utilities. Use them in combination to define the logic that is run in the topic block.

7. To define the output returned from the topic block, do the following:

   a. Click the **End** node in the canvas.

   b. In the End Segment Properties sheet, click **+ Add New**.

   c. On the sheet, fill in the following fields.

      • **Name**: Name of the value returned from the topic block.

      • **Value**: Either a string with variables or a script that can be used within the calling topic. The **Value** is presented as data pills for the input variables that you defined (the **Default Value** specified in the Input Parameters and the input values from the node in the topic block).
For example, the pre-built Contextual Search topic block passes the following output parameters:

<table>
<thead>
<tr>
<th>End Segment Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirmation Message</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Output Parameters

- Define the output returned from the topic block. Topic authors can use these output values in the calling topic.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Results returned
- Results Helpful

- Add New

**d. Click Save.**

When the topic block finishes running in the calling topic, it can pass output variables to the calling topic.

**8. To see how the topic block runs, click Test.**

For example, the Contextual Search topic block returned the following results, including a preview-only message with the output values. The preview message helps you verify expected outputs and is not viewable to your users.
9. If you're ready to make the topic block available for use in calling topics, then do the following:
   
   a. Remove the default parameters that you used for testing.
   
   b. Click Save, and then click Publish.
      The topic block state changes to Active and is ready for use in calling topics.

What to do next
Add a reusable topic block to a calling topic or topic block.
Add a reusable topic block to a calling topic or topic block

Add a reusable topic block to a calling (parent) topic or topic block to run a specific function or task in the calling topic. You specify input parameters used in the topic block, and you specify output parameters that are used by the calling topic.

Before you begin

Review the topic blocks available in the Topics page in Virtual Agent). You can create a new topic block. You can also use a pre-built topic block, duplicate it, and customize it. Pre-built topic blocks are installed automatically with the Glide Virtual Agent plugin, as well as the Virtual Agent conversation plugins for Customer Service Management, HR Service Delivery, and ITSM.

Verify that the topic block you want to use is published and active.

Role required: virtual_agent_admin or admin

About this task

You can specify the following types of variables:

- Input variables that are passed to the topic block.
- Output variables that are returned from the topic block to the calling topic.

Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Designer.

2. In the Topics page, select the calling topic or topic block in which you'll place the topic block.
   The Flow tab displays the conversation flow.

3. Depending on the type of topic block you are adding, add the appropriate Virtual Agent controls (nodes) to the conversation.
   For example, if you are adding the Contextual Search topic block, you could add the Text user input control to request an item from the user. Drag that control before the node for the Contextual Search topic block.

4. From the Utilities section of the palette, drag the Topic Block control onto the canvas at the appropriate location in the conversation flow.

5. In the Topic Block Properties sheet, select the topic block that you want to add.
   The property sheet for the selected topic block displays the input and output parameters. The name of the selected topic block automatically pre-populates the Name field. You can override the name if needed.

6. Set the required Input Mapping variables and, if applicable, the Output Mapping variables for the selected topic block.
7. In the header bar, click **Save**.

8. To preview your calling topic, click **Test** in the header bar.
   You can see how the calling topic runs in the chat window.

   If Microsoft Teams or Slack is configured for your environment, click **Preview in Microsoft Teams** or **Preview in Slack** in the list to test your topic in those environments. For more information, see Install Conversational Integrations for enterprise messaging apps.

9. If no further changes are needed, click **Publish** in the header bar.

**Maintain reusable topic blocks**

When you update topic blocks, Virtual Agent Designer provides built-in checks to help you identify changes to topic blocks that affect the calling topics that use them. Updates include changing input and output parameters, deleting topic blocks, and publishing inactive and active topic blocks and calling topics.

To help you maintain your topic blocks and associated calling topics, Virtual Agent Designer provides alerts that serve as guardrails. These alerts have many functions, including the following:

- They warn you of topic block updates that affect associated calling topics.
- They help prevent you from making unintentional changes.
- They let you know that you may need to make changes in associated calling topics.

**Changes to input or output parameters in a topic block that is used by calling topics**

Virtual Agent Designer helps prevent you from deleting output parameters that are being used in calling topics. Virtual Agent Designer informs you that the changes will affect calling topics that use the topic block.

For example, suppose you added two required input parameters to the Acme Contextual Search topic block. When you preview or save the topic block, Virtual Agent Designer provides a warning message that indicates that the calling topic needs updating.

The message also provides a link to the Topic Library Usages [sys_cs_topic_library_usage] table. This table lists the published calling topics that use the topic block. Links to this table are also found on the Properties sheet for the topic block node and on the Properties tab for the topic block.
Example message alerting you to input parameter changes

Edits to a calling topic that is affected by a published topic block update

When changes to a topic block input or output parameters are published, Virtual Agent Designer notes the changes in the affected calling topics. The canvas view of the calling topic identifies the updates. A warning message is displayed in the Topic Block Properties sheet so that you can update parameters accordingly.

Example warning of missing parameter
Virtual Agent platform topic blocks

Virtual Agent provides pre-built topic blocks that topic authors or admins can use to perform specific platform-related functions or tasks in bot conversations. For example, certain topic blocks enable you to check agent availability or generate AI Search results.

Overview of pre-built topic blocks

Certain pre-built topic blocks are included automatically with the Glide Virtual Agent (com.glide.cs.chatbot) and Virtual Agent Lite (com.glide.cs.chatbot.lite) plugins. If you're using Virtual Agent Lite, you have read access to the topic blocks but you can't create topic blocks or add them to calling topics.

You can duplicate pre-built topic blocks and modify the duplicates by using Virtual Agent Designer. For details on working with topic blocks and how to add them to calling topics, see Reusable topic blocks and Add a reusable topic block to a calling topic or topic block.

The following sections describe the input and output parameters for calling different types of topic blocks. The topic block input parameters are passed from the calling topic, and the output parameters are returned from the topic block to the calling topic.

Note: Upgrades to the default topic blocks are not applied to the duplicated topic blocks.

Agent Availability topic block

Use this topic block to get relevant live agent information for use in agent handoff conversations. This information includes agent availability, wait time (for when agents are available), and queue information. You can use the information returned, such as a long wait time for an agent, to initiate a case or customer callback.

This topic block requires the Agent Chat (com.glide.interaction.awa) plugin, which includes Advanced Work Assignment.

The following table lists the output parameters for this topic block:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>agentAvailable</td>
<td>Agent availability. The value is true if an agent is available for this queue. Otherwise, the value is false.</td>
</tr>
</tbody>
</table>
Agent Availability output parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>supportQueue</td>
<td>sys_id of the queue that is associated with the conversation. The value is null if an agent is not available or if there is no associated queue.</td>
</tr>
<tr>
<td>waitingTime</td>
<td>Average numeric wait time for the queue. The value is null if an agent is not available.</td>
</tr>
</tbody>
</table>

**AI Search topic block**

Use this topic block to generate AI Search results in a conversation. This block doesn’t require specific input parameters from a calling topic because it is controlled by the AI Search application. The default Virtual Agent Search Application and EVAM configurations set in the chat experience control how AI Search results are displayed in conversations.

For details on how Virtual Agent uses AI Search, see Virtual Agent integration with AI Search. To learn more about Virtual Agent chat experiences and how to configure them, see Setting up chat experiences for Virtual Agent users.

You can control certain aspects of the AI Search topic block:

- Optionally customize the AI Search experience - You can customize the search experience by creating a custom Search Application Configuration to be used by the topic block, rather than the default Virtual Agent Search Application Configuration. The Search Application Configuration defines the search results returned in the conversation. For details, on using a custom Search Application Configuration in the topic block, see Create a custom AI Search experience for Virtual Agent conversations.

  To use the default Virtual Agent configuration for AI Search, leave the Search Application Configuration field empty in the Topic Block Properties sheet when you’re adding the AI Search topic block to a topic.

- Specify an AI Search flow action timeout value - The AI Search flow action in the topic block automatically times out at 10 seconds. You can change the length of time before this flow action times out by adding the system property `com.glide.cs.fdi.atlassearch.timeout` and setting these fields to change the timeout value:
System property fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the system property name: com.glide.cs.fdh.atlassearch.timeout</td>
</tr>
<tr>
<td>Description</td>
<td>Enter an explanation for this property: AI Search action timeout (in seconds)</td>
</tr>
<tr>
<td>Type</td>
<td>Select integer.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the number of seconds before the AI Search action times out. The default value is 10 seconds.</td>
</tr>
</tbody>
</table>

The input and output parameters for this topic block are listed in the following tables:

### AI Search input parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>search_term</td>
<td>Phrase entered by a user during the conversation.</td>
</tr>
<tr>
<td>Search Application</td>
<td>Optional. The search application configuration to be used by the topic block to control AI Search results returned in the conversation. For details, see Create a custom AI Search experience for Virtual Agent conversations.</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
</tbody>
</table>

### AI Search output parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>geniussearchresults</td>
<td>Raw JSON of the Genius card search result that is returned.</td>
</tr>
<tr>
<td>searchresults</td>
<td>Raw JSON of the list of regular search results that is returned. The list is a multi-list output.</td>
</tr>
<tr>
<td>shouldaskinfohelpful</td>
<td>Variable that indicates whether the calling topic must ask the user if the returned search results were helpful. The variable takes into account the type of results returned, user response, and whether the question was previously asked in the topic block.</td>
</tr>
</tbody>
</table>
FAQ Conversation Builder topic block

Use this topic block to build bot conversations that use your existing FAQ content. With this topic block, you can enable topic authors to build simple conversations by using existing knowledge articles that are published in the FAQ template or by using Q&A data that was imported from sources such as spreadsheets.

The FAQ Conversation Builder topic block leverages contextual search to search for an appropriate match in the FAQ content. FAQ content is access-controlled based on requester role, access rights, and context.

Activate the Knowledge Management Advanced plugin to use the FAQ Knowledge template.

Note: The default length of an FAQ snippet that is returned in the conversation is 400 characters. The snippet length includes the HTML tags and links that are used in the snippet. To change the snippet length, change the value in the `com.glide.cs.faq.display_size` system property. In addition to applying the specified length, the system applies word-wrap logic to prevent words and links in the snippet from being truncated arbitrarily.

The following tables list the input and output parameters for this topic block:

### FAQ Conversation Builder input parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>query</td>
<td>Search term or phrase that is passed to the topic block. Select Input Variables or Script Variables.</td>
</tr>
<tr>
<td>portal</td>
<td>Context for the search. Select Input Variables or Script Variables.</td>
</tr>
<tr>
<td>kb_knowledge</td>
<td>Knowledge base for the search. Select Input Variables or Script Variables.</td>
</tr>
</tbody>
</table>

### FAQ Conversation Builder output parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Results_Returned</td>
<td>Boolean value that indicates whether any results were returned from the query.</td>
</tr>
<tr>
<td>Results_Helpful</td>
<td>Boolean value that indicates whether the user found the results helpful.</td>
</tr>
</tbody>
</table>
Geolocation topic block
Use this topic block to retrieve information about the location of users, if the users agree to that. Before the topic block is called in a conversation, the users are asked if they want their location to be known. For example, the users see a prompt similar to the following:

User permission prompt

![User permission prompt image]

Users can choose to block or allow their location to be known. If the users click **Allow**, then during the conversation, they are asked if they would like to share their location, as shown in the following example:

Use of Geolocation in a chat

![Use of Geolocation in a chat image]

The following tables list the input and output parameters for this topic block:
### Geolocation input parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>permissionPrompt (String)</td>
<td>Text asking permission to use the user's location. This text is shown to the user.</td>
</tr>
</tbody>
</table>
| isGeoPermissionGrantedForNextUse | Boolean value that determines if users have granted permission to retrieve their location coordinates if this request is asked more than once during the conversation. The variable can be set as follows:  
  - True: Don’t display permission prompt again because the user has granted permission on this device.  
  - False: Display the permission prompt because the user has either denied permission or has allowed the coordinates to be retrieved one time only. |

### Geolocation output parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latitude</td>
<td>Latitude coordinates.</td>
</tr>
<tr>
<td>Longitude</td>
<td>Longitude coordinates.</td>
</tr>
<tr>
<td>errormessage</td>
<td>Message that is associated with the error if there are any errors.</td>
</tr>
</tbody>
</table>
| errortype   | Variable that is returned from the topic block. Types of errors include the following:  
  - PERMISSION_DENIED  
  - POSITION_UNAVAILABLE  
  - TIMED_OUT  
  - UNKNOWN_ERROR |
| status      | Variable that is returned from the topic block. The status can be as follows:  
  - OK: Location coordinates were retrieved successfully  
  - ERROR: Retrieval was unsuccessful. |
Pause topic block

Use this topic block to create a pause to control the pacing of a conversation. To end users, this feedback is seamless and is displayed as a typing indicator.

For example, if the chat generated a list of knowledge base links, you may want to add a delay before continuing the conversation to give your end user time to read the information.

The Pause topic block appears on the Utilities section of the palette for easier access.

The following table lists the input parameter for this topic block:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seconds</td>
<td>Number of seconds to wait before continuing the chat. The maximum value allowed is 60 seconds. If the value entered is 30 seconds (the default value), the block should unpause in near real time. If the value entered is greater than 30 seconds, expect the unpause to occur with a maximum latency of +30 seconds. For example, if you set the value to 31 seconds, it could take up to 61 seconds to unpause (at most).</td>
</tr>
</tbody>
</table>

Deflection topic block

Use the deflection topic block in Virtual Agent conversation topics to track the issues that Virtual Agent helped to resolve or resolved for a user.

For example, the pre-built Auto Resolution Virtual Agent topic uses a deflection topic block to track deflections. For more information, see Tracking deflections using deflection topic blocks.

The input parameters for this topic block are listed in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deflection Configuration</td>
<td>Group of deflection patterns.</td>
</tr>
<tr>
<td>Deflection Pattern</td>
<td>Deflection pattern in the deflection configuration that you have chosen.</td>
</tr>
</tbody>
</table>
Deflection input parameter (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Table</td>
<td>Table where the deflection activity occurs. This table is associated with the primary activity table. For more information, see Create deflection configurations and patterns.</td>
</tr>
<tr>
<td>Activity Ids</td>
<td>List of comma-separated activity system IDs. For example, incident ID or task ID. You can also add output from the AI Search or Contextual Search topic block to create a link between a deflection occurrence and the content that contributed to the same deflection.</td>
</tr>
</tbody>
</table>

**Virtual Agent and geolocation**

Topic authors can include a prebuilt topic block called Geolocation in conversations with users. The Geolocation topic block retrieves the latitude and longitude coordinates of the user’s location.

Topic authors can add this topic block to larger conversation flows. With the user’s permission, the topic block retrieves the user’s latitude and longitude location coordinates. Knowing these coordinates can help topic authors respond to customer requests or issues faster and more efficiently.

For example, you have to send a technician to a customer site to resolve an incident. To quickly respond to the customer, you have to know where your technicians are located. That way, you can dispatch the technician located closest to the customer.

For general information about how geolocation is used on the ServiceNow platform, see Geolocation.

**Share location details**

The first time a user, such as a field technician, uses the Geolocation topic block in a conversation, they are asked if they would like to share details about their location.
You, as a topic author, can use the default question or customize it as needed. For example, you can include an explanation or the reason for asking the question. For details, see Geolocation topic block properties below.

What happens next:

• If the answer is Yes, the topic block sends the user's latitude and longitude coordinates from the server to the user's device.

Users may then see these additional prompts:

  ◦ If users want to allow the ServiceNow instance to access their location, users may then see operating system-specific or browser-specific prompts.

  The prompts vary by the operating system and browser but examples include:

  ■ Allow (always)
  ■ Allow (one time only)
  ■ Block (don’t allow)

  Depending on the user’s response, they may see this prompt one or more times, or they may never see it.

• If the answer is No, the topic block doesn’t retrieve those coordinates and displays a relevant error message for the topic author to resolve. The error is logged as an output-mapping variable. For details, see Geolocation topic block properties below.

**Geolocation topic block flow**
The Geolocation topic block uses the following conversation flow:
Modify the geolocation topic block
If you are a topic author or an admin, you can modify the Geolocation topic block flow, as applicable. You can then use it as needed in the larger
conversation flow you’re designing. For more information about topic blocks and how to reuse them, see Reusable topic blocks.

**Geolocation topic block properties**
The Geolocation topic block properties sheet lets topic authors specify the input and output mappings.

The input mappings let topic authors customize how users are asked for permission to share their location. The users response is passed to the topic block.

Use the default question shown in the field, or use the data pills or scripts to modify the default. For information about using data pills and scripts, see Virtual Agent controls.

The output mappings let topic authors chose the variables that are returned from the topic block in the conversation.
All the variables are selected by default. Keep the default choices, or select the variables you want returned from the topic block. At a minimum, topic authors or admins should select the latitude and longitude coordinates. However, error messages, error type, and status details could be useful when resolving problems. The output mappings you select are stored as variables on the server.

For more information about the Geolocation topic block properties, see Virtual Agent platform topic blocks.

**Virtual Agent custom controls**

Custom controls are components that ServiceNow® developers can create for use in Virtual Agent topics or topic blocks. Such controls include sliders or video players. Custom controls complement the controls provided in Virtual Agent Designer.

Virtual Agent Designer provides a default set of controls that represent user inputs, bot responses, and utilities for building a Virtual Agent conversation. As a developer, you can use Virtual Agent Designer to create additional controls (interface components) for specific inputs or output responses. For example, a slider is an example of a custom input control that enables end users to select a quantity.

**Before building a custom control**

Custom controls are based on customizable Now® Experience Components that you can create by using the Now® Experience Design System.

Before building a custom component, you must have the following:

- Basic knowledge of the Now Platform® and application table structures.
- General knowledge of web component concepts, development, and design.
- JavaScript knowledge to define component behavior and that of the custom control.
- Knowledge of the design process for creating custom components for use in Virtual Agent Designer.
To learn more about developing custom components for Virtual Agent, see Develop a component for Virtual Agent.

**How custom controls work**

To add your custom control to Virtual Agent, follow these main steps:

1. **Create a custom control definition.**
   After building the custom component to be used for the control, create a custom control definition that maps an input or response control to the custom component.

2. **Create a custom control using Virtual Agent Designer.**
   A custom control is an input or response control. Developers build a custom control in Virtual Agent Designer by doing the following:
   - Selecting a custom control definition.
   - Defining the input parameters for using the control.
   - Specifying the output parameters returned by the control.
   An input control has callbacks that use input from the end user. A response control typically presents information to the end user and doesn’t have callbacks.

3. **Add a custom control to a topic or topic block.**
   Topic authors, virtual agent admins, or admins can add a custom control utility to a topic or topic block.

**Create a custom control definition**

Define a custom input or response control definition that maps to a custom component.

**Before you begin**

A custom control definition needs a custom component. For example, a slider input control uses a custom slider component.

- Create the customizable component that you’ll use for your control.
- Role required: admin or virtual_agent_admin

**About this task**

For a given custom control, create a separate control definition for each channel in which the control will be used.
Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Custom Control Definitions.
2. Click New.
3. On the form, fill in the fields, and then click Submit.

Custom Control form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the custom control to be created.</td>
</tr>
</tbody>
</table>
| Type | Type of custom control. Choices are as follows:  
   - Input  
   - Response |
| Domain | Domain in which this control is used. |

4. Open the custom control record that you just created.
5. In the Custom Control Definitions related list, click New.
6. On the form, fill in the fields.

Custom Control Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Channel | Channels in which your control can be used. The channel is a chat client, such as a web client or messaging app, that is supported in Virtual Agent.  
If your control can be used in more than one channel, create a Custom Control Definition for each channel. If channels are defined, then the custom control can only run in the specified channels. |
| Application | Scope that this control belongs to. |
| UX Component Definition | List of custom components that are created for use as custom controls in Virtual Agent.  
Choose an optional component for your custom control. |
| Domain | Domain where this control is used. |

7. Click Submit.
Results
The custom control definition is available for use. You can specify it when you create the appropriate control in Virtual Agent Designer.

What to do next
Create the custom control in Virtual Agent Designer.

Create a Virtual Agent custom control
Build a custom input or response control that topic authors can use in topics or topic blocks. In Virtual Agent conversations, an input control gathers information from end users, while a response control displays information to end users.

Before you begin
Create the custom control definition.
Role required: admin or virtual_agent_admin

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Designer.
2. In the Topics page, click + Create.
3. On the form, fill in the fields.

Properties form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the custom control that reflects its purpose.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief explanation of the purpose and functionality of the control.</td>
</tr>
<tr>
<td>Categories</td>
<td>List of categories. Categories identify and group related topics, topic blocks, or custom controls. If applicable, choose a category for your control.</td>
</tr>
<tr>
<td>Type</td>
<td>List of objects that you can create in Virtual Agent Designer. Choose the type of custom control:</td>
</tr>
<tr>
<td></td>
<td>• Custom Input Control</td>
</tr>
<tr>
<td></td>
<td>• Custom Response Control</td>
</tr>
<tr>
<td>Available on the palette</td>
<td>Option that determines whether the custom control appears as its own icon in the Utilities section of the palette on the Flow tab. This provides easy access to the control for other authors.</td>
</tr>
</tbody>
</table>

4. Click Create.
The Flow tab opens and displays an initial flow that contains a custom control node.

5. Click the Start node and define the input parameters to the control. Topic authors will provide these input parameters and values from the calling topic.

a. Click + Add.

b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the input variable that stores the input value.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of data being passed to the topic block. For example, <strong>String</strong>, <strong>Boolean</strong>, and so on. The fields change according to your choice. For more information about data types, see Virtual Agent data types.</td>
</tr>
<tr>
<td>Required</td>
<td>Option to set the parameter as required.</td>
</tr>
<tr>
<td>Hint</td>
<td>Tooltip that is visible when authoring a calling topic. See the following example:</td>
</tr>
<tr>
<td>Table</td>
<td>ServiceNow table that is used to query for input. This field is available only when <strong>Reference</strong> or <strong>Array.Reference</strong> is selected from the <strong>Type</strong> field.</td>
</tr>
<tr>
<td>Max Number of Rows</td>
<td>Maximum number of rows that the topic block is allowed to define.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Default value for the variable. This value can be used when previewing the block.</td>
</tr>
</tbody>
</table>
c. Repeat these steps for additional parameters.

**d. Click **Save**.**

**6. Click the End node and define the output parameters and values returned from the custom control.**

Topic authors can use the output value in the calling topic.

- **a. Click + Add New.**
- **b. Enter the name and value of the parameter.**
- **c. Repeat these steps for additional parameters.**
- **d. Click Save.**

**7. Click the custom control node and complete the property sheet for the custom input or response control.**

<table>
<thead>
<tr>
<th>Custom Input or Response Properties form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Custom input or response property</strong></td>
</tr>
<tr>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Custom Control Definition</td>
</tr>
<tr>
<td>Generate Control Data Function</td>
</tr>
<tr>
<td>Transcript Function</td>
</tr>
<tr>
<td>Custom input or response property</td>
</tr>
<tr>
<td>----------------------------------</td>
</tr>
<tr>
<td>Response Handler Function</td>
</tr>
<tr>
<td>Response Transcript Function</td>
</tr>
<tr>
<td>If accessed from an unsupported channel, show</td>
</tr>
<tr>
<td>Node Conditions</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

8. To create the control, click **Save** and then **Publish**.

**Results**

If you selected **Available on the palette** in the Properties page, the Custom Control icon displays as its own icon in the Utilities section of the palette. The control is listed on the Topics page, and you can use the Type menu to show only custom controls.

**What to do next**

Add a custom control to a Virtual Agent topic or topic block.

**Add a custom control to a Virtual Agent topic or topic block**

Add a custom control to a Virtual Agent topic or topic block. During the conversation, you can gather inputs from the user or display outputs to the user.

**Before you begin**

Fulfill these requirements before you start this task:
• Create and publish the custom input or response control.
• Create a calling topic or topic block in which the custom control will be embedded.
• Role required: virtual_agent_admin or admin

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Designer.
2. In the Topics page, click the topic or topic block where you'll add the custom control.
3. In the Flow tab, drag the Custom Control icon from the Utilities section of the palette to the appropriate position in the topic flow.

   **Note:** If you selected Available on the palette in the custom control Properties page, the Custom Control displays as its own icon in the Utilities section of the palette.

4. Click the custom control node.
5. On the form, fill in the fields.

Custom Control Properties sheet

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Control</td>
<td>List of available custom controls.</td>
</tr>
<tr>
<td>Name</td>
<td>Node name for the control. For example, Slider Control.</td>
</tr>
<tr>
<td>Input Mapping</td>
<td>Input variables that are passed to the custom control.</td>
</tr>
<tr>
<td>Output Mapping</td>
<td>Output variables that are returned from the custom control.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
6. Click **Save**.

7. To see how your custom control works in the topic, click **Test** in the header bar.
   Your topic runs in a chat test window.

8. If no further changes are needed, click **Publish** in the Virtual Agent Designer header bar.

**Results**

The topic is active. You can deploy it to your Virtual Agent clients.

**Virtual Agent data types**

You can define inputs of commonly used Glide Virtual Agent (com.glide.cs.chatbot) data types in Virtual Agent Designer without writing a script. Define the input data type on the Start node of a custom control or topic block.

**Data types in Virtual Agent Designer**

The data type designation allows Virtual Agent to perform secondary validation on NLU predicted values. For example, if your choice list has red, white, and blue, but the NLU prediction service returns green, the input won’t be slot-filled because that wasn’t a valid choice.

When you specify an input with a data type on a calling topic, you can use the data pill picker to specify information collected from the user or previously looked up in a custom control or topic block.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Alphanumeric text. The value uses JavaScript data conventions.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Boolean value of true or false (yes or no).</td>
</tr>
<tr>
<td>Reference</td>
<td>Table record by sys_id.</td>
</tr>
<tr>
<td>Data type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date and time values.</td>
</tr>
<tr>
<td>Array.String</td>
<td>Sequence of alphanumeric text values.</td>
</tr>
<tr>
<td></td>
<td>To limit the number of strings that authors can specify, use the <strong>Max Number of Rows</strong> field.</td>
</tr>
<tr>
<td>Array.Datetime</td>
<td>Sequence of date and time values.</td>
</tr>
<tr>
<td></td>
<td>To limit the number of dates that authors can specify, use the <strong>Max Number of Rows</strong> field. Click <code>+</code> to specify more than one default value.</td>
</tr>
<tr>
<td>Array.Reference</td>
<td>Sequence of table records by sys_id.</td>
</tr>
<tr>
<td></td>
<td>Select a ServiceNow table in the <strong>Table</strong> field. You can define conditions for the returned record.</td>
</tr>
<tr>
<td></td>
<td>To limit the number of records that authors can specify, use the <strong>Max Number of Rows</strong> field.</td>
</tr>
<tr>
<td>Array.Choice</td>
<td>Sequence of choice list values for a specific choice field. For example, printer, computer, and monitor.</td>
</tr>
</tbody>
</table>

**Note:** Duplicate default values are not allowed with array data types.

**Example data type definition**

This User Name Array.Reference input variable limits the number of records to 5. It references the sys_user table with the condition that all names must start with `a`. 
Virtual Agent integration with AI Search

Virtual Agent uses the Now Platform® AI Search application to return search results in bot conversations as a fallback when there are no relevant topics to display to end users. Virtual Agent also provides an AI Search topic block that topic authors can use to generate search results in a topic.

How Virtual Agent uses AI Search

The AI Search application, which is included with the Now Platform, uses Natural Language Understanding (NLU) to provide relevant search results for queries and Machine Learning to continuously improve search results based on end-user selections. AI Search can display different types of query results, such as Genius Result cards that show relevant catalog items, questions and answers (Q&A), and people (user) information. For more information, see Genius Results.

Catalog Genius Results are automatically enabled in the base system. To enable Q&A and People Genius Results in your instance, you must activate the People and Q&A default Genius Result configurations. You must also train and publish the model for NLU-based Genius Result configurations.

Virtual Agent uses AI Search to provide:

- An AI Search topic block that calls the AI Search application in a conversation. Topic designers can add this block as a topic node, to generate and display search results in a conversation. For details on the AI Search block
and other topic blocks provided with Virtual Agent, see Virtual Agent platform topic blocks.

- AI Search Fallback setup topic that generates search results for end users when Virtual Agent can’t determine an intent and topic or the keyword to display the appropriate conversation for user requests.

Virtual Agent provides base system (default) AI Search configurations that determine how search results are generated and displayed:

- Search application configuration that defines:
  - Index sources - Data sources to be used for search, such as catalog items or knowledge base (KB) articles.
  - Search profile - Index source to be used and the type of results to show in Genius Result cards.

- Entity View Action Mapping (EVAM) configuration that defines how search results and Genius results are displayed.

⚠️ Note: Although you can modify the EVAM configuration, changing the default configuration might not provide an optimal Virtual Agent experience.

The Virtual Agent search configurations are part of the default chat experience set in the Custom Greetings and Setup module, which defines the context for running Virtual Agent. The chat experience defines the setup topics used in Virtual Agent conversations and the search configuration that controls the AI Search experience. The AI Search experience is controlled by the AI Search Fallback setup topic. For details, see Setting up chat experiences for Virtual Agent users.

⚠️ Note: If you upgraded to the Rome release, the AI Search Fallback setup topic is not automatically enabled. To use AI Search Fallback, enable it as a setup topic in the default chat experience using the Custom Greetings and Setup module. For details, see Setting up chat experiences for Virtual Agent users.

Virtual Agent and Virtual Agent Lite use AI Search functionality. If you’re a Virtual Agent Lite admin, you can deactivate setup topics such as the AI Search Fallback setup topic, but you can’t change the Virtual Agent search configurations set in chat experiences, the AI Search topic block, nor the AI Search Fallback setup topic.

**When Virtual Agent uses AI Search fallback**

Virtual Agent uses AI Search fallback when:
• Topic discovery can't find any matching intents and topics for user utterances or matching topics for keywords.

• Topic discovery returns too many intents and topics for user utterances. In this case, Virtual Agent can't determine the best topic to display to the end user.

• Topic suggestions are displayed to the user, but the user selects the I want something else option.

⚠️ Note: If you deactivate the AI Search Fallback setup topic in a chat experience, the Virtual Agent runs the Fallback setup topic when it can't find a matching topic.

What the AI Search results look like
In Virtual Agent, the default chat experience or a custom chat experience determines the search experience, namely the search profile used and the format of the AI Search results displayed:

• The search application specified in the Virtual Agent default or custom chat experience defines certain aspects of the search experience, such as the search sources (searchable content) and synonyms used to improve search recall.

• The EVAM configuration for Virtual Agent controls the Genius card content presented in search results (Q&A, Catalog, and People). For information on how EVAM works, see Entity View Action Mapping.

The default AI Search results include these items:

Genius Result cards
When AI Search generates a match (result) with a high confidence score, Virtual Agent displays a single Genius card with the result. The cards display information returned from AI Search:

• Q&A - Provides an answer snippet from the Knowledge Base article determined as the top search result.

• Catalog items - Returns the most relevant catalog item with the related entities (catalog item name and catalog item category).
• People - Returns the relevant person with the related entities (name, department, city).

**Note:** The default search application for Virtual Agent is configured to include Q&A (Knowledge Base) and Catalog results, but not People card results. The People card is not available with the default search application for Virtual Agent. People card results are available with the Employee Service Center (ESC) app and the ESC search profile, which can be specified in a Virtual Agent chat experience for ESC.

**Genius card examples**

**Q&A card**

- What is the 4-phase approach to a Design for America initiative?

**Catalog item card**

- If you’re using AirPrint, you should first transfer your line of service to America.

**People card**

- [Image of person with name, title, and contact information]

* Not available with the default Virtual Agent search configuration. It is available with the Employee Service Center plugin and ESC Search Profile.

**Multi-link output**

When a Genius Result is returned, users can indicate whether the information was helpful. If not, Virtual Agent displays up to three search results in multi-link output format, which includes links and summaries for:

• Knowledge articles
• Catalog items
• People
• Other - Generic results determined by EVAM, for example results from Microsoft SharePoint or Microsoft OneDrive connectors
Portals that display AI Search links

Links in the Genius card and multi-link output search results are opened automatically in a portal that you can set in various ways. For example, you can use default or custom URL mappings to specify the portal in which links are opened. To learn more, see Set the URL navigation for chat links.

Custom search experiences

You can customize the AI Search experience in a conversation, for example to run searches that return results relevant to a particular business application. To control the AI Search results returned in a conversation, you can create a Search Application Configuration that defines the search experience used by the AI Search topic block. For details, see Create a custom AI Search experience for Virtual Agent conversations.

Get started with AI Search in Virtual Agent
To enable AI Search functionality for Virtual Agent:
• Activate the People and Q&A default Genius Result configurations so that People and Q&A Genius Results can be generated for your users. People Genius results are generated if you’re using the Employee Service Center app and ESC search profile.

• Train and publish the AI Search NLU model for Genius Results. For instructions, see Train and publish the model for NLU-based Genius Result configurations.

• If you upgraded from a Quebec release starting with QP4 or later, enable the AI Search Fallback setup topic in the default or a custom chat experience. For instructions on configuring a chat experience, see Setting up chat experiences for Virtual Agent users.

If you want to customize the Virtual Agent AI Search results that are generated for your users, see Create a custom AI Search experience for Virtual Agent conversations.

Create a custom AI Search experience for Virtual Agent conversations
Define a custom AI Search experience in a conversation using the AI Search topic block. You create a Search Application Configuration used by the topic block to control the AI Search results returned in the conversation. Or you can use the Search Application Configuration to control AI Search results in a custom chat experience.

Before you begin
Create the search profile that defines the search experience to be used in the Search Application Configuration. For details, see Search profiles and Search application configurations.

Role required: virtual_agent_admin or admin with the search application administrator [search_application_admin] role.

About this task
A Search Application Configuration specifies the AI Search profile used by the AI Search topic block or a custom chat experience to control the AI Search experience, such as the search source used to generate search results.

Procedure
1. Navigate to AI Search > Search Experience > Search Applications and select New to create the Search ApplicationConfiguration.
2. Fill in the form:
## Search Applications Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the search application to be used in the AI Search topic block or custom chat experience.</td>
</tr>
<tr>
<td>Search Engine</td>
<td>Search engine to use in this search application. Use AI Search as the search engine.</td>
</tr>
<tr>
<td>Search Profile</td>
<td>Search profile that stores the search experience settings for generating AI Search results.</td>
</tr>
<tr>
<td>Search Results Limit</td>
<td>Maximum number of search results that the application should display.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The search query in Virtual Agent returns a maximum of 3 results per query. If you change this limit to another value, Virtual Agent still displays a maximum of 3 results.</td>
</tr>
<tr>
<td>Genius Results Limit</td>
<td>Maximum number of Genius Result cards to be displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Virtual Agent supports only 1 or 0 card results per AI Search query. If you change this field to a different value, Virtual Agent still displays only 1 or 0 card results.</td>
</tr>
<tr>
<td>Enable Typo Handling</td>
<td>Option to auto-correct search query terms to match terms found in the search profile’s typo handling dictionary. For Virtual Agent, turn off this option by deseleting it.</td>
</tr>
</tbody>
</table>

3. Select **Submit**.

4. Apply the custom Search Application Configuration to the AI Search topic block to be used in a conversation or to a custom chat experience:
<table>
<thead>
<tr>
<th>Option</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the custom Search Application Configuration in the AI Search topic block used in a conversation</td>
<td>Add the AI Search topic block to a topic. For details, see <a href="#">Add a reusable topic block to a calling topic or topic block</a>.</td>
</tr>
<tr>
<td>a. Navigate to Conversational Interfaces &gt; Virtual Agent &gt; Designer and select the topic or create a new topic.</td>
<td>b. In the Flow tab, drag the Topic Block utility onto the canvas.</td>
</tr>
</tbody>
</table>
| c. Complete the Topic Block Properties sheet:  
  - In the Topic Block field, select AI Search.  
  - In the Search Application Configuration field, select the custom Search Application Configuration. | d. Select Save.  
  - If needed, specify **Node Conditions**.  
  
Search Application Configuration option

If you leave this field empty, AI Search uses the default search application configuration for Virtual Agent.  

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
| Option |
|-----------------
| Use the custom Search Application Configuration in a custom chat experience |

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>The AI Search topic block runs the selected search application configuration to generate the customized AI Search experience.</td>
</tr>
</tbody>
</table>

Create or update a custom chat experience that uses the AI Search topic block with the custom Search Application Configuration. For details on creating a custom experience, see Configure a Virtual Agent chat experience.

Your custom Search Application Configuration is used in the AI Search topic block in a conversation or a custom chat experience to generate the customized AI Search experience.

**Virtual Agent integration with Flow Designer workflows**

The conversation workflows of ServiceNow® Virtual Agent can be integrated with those of the ServiceNow Flow Designer. Topic authors can then use these workflows in Virtual Agent conversations.

Starting with the Rome release, Actions and Subflows can be integrated with those of the Virtual Agent.

Topic authors can:

- Add the Actions or Subflows to Virtual Agent conversations.
- Use the Actions created in another product in Virtual Agent conversations.
- Create conversations that call workflows used to complete tasks or solve problems directly in the conversation. For example, users can place catalog requests, create incidents, or input information securely.

In their Virtual Agent conversations, topic authors can use these Actions to trigger workflows that are custom-built in an application (such as Flow Designer) or workflows of the third-party applications and products available in the IntegrationHub. Integrations built using Flow Designer and IntegrationHub help to ensure a high level of resiliency and performance.

If an Action in the workflow is slow to respond or appears to be waiting, topic authors see a relevant error message.
By default, a scheduled job checks the conversation flow every 120 seconds. For more information about scheduled jobs, see Scheduled jobs.

You can change this interval, as needed. To change the interval, see Specify the action workflow timeout.

Integrate workflows of third-party products available on the IntegrationHub

With the IntegrationHub, topic authors can create end-to-end digital workflows and automate processes that natively integrate the Now Platform® with any third-party application, platform, or data.

For example, topic authors can use one of the 100 pre-built spokes available on the ServiceNow Store. These pre-built spokes include those for popular applications, such as Microsoft Azure, Workday, and Okta.

For overview information about the ServiceNow IntegrationHub, see ServiceNow IntegrationHub – natively integrate ServiceNow with anything.

Add workflows to topics

Use the Action utility to integrate ServiceNow Flow Designer workflows in Virtual Agent topics. The Action node triggers the required Flow Designer workflows used in the Virtual Agent conversation.

Before you begin

• Be familiar with the features, concepts, and tasks in Flow Designer.
  To learn more, see Flow Designer.

• Create a Virtual Agent topic, if you don’t already have one.

• Know how to use the Virtual Agent Designer utilities, such as the Lookup utility, and the Script Action utility.
  Use these utilities to control the actions within the Virtual Agent conversation.
  For more information about these utilities, see Virtual Agent Designer utilities.

• Be familiar with the Virtual Agent controls. You may be asked to enter:
  ◦ Text strings
  ◦ Data pills
  ◦ Strings with embedded data pills
  ◦ Scripts that return strings
  For more information about these Virtual Agent controls, see Virtual Agent controls.

Role required: virtual_agent_admin or admin
About this task
Starting with the Rome release, you can use Actions created in Flow Designer in your Virtual Agent conversations.

The Virtual Agent conversation workflow triggers the Actions created in the Flow Designer.

Note: These instructions assume that the Actions are created in Flow Designer. The Actions in your conversation may have been created in another product (for example, one available on the IntegrationHub). These instructions are still applicable.

For overview information about the ServiceNow IntegrationHub, see ServiceNow IntegrationHub – natively integrate ServiceNow with anything.

When you add the Action node to the Virtual Agent conversation, you need set the Action properties in the Flow Action Properties panel.

Flow Action Properties sheet
Use the Flow Action Properties sheet to enter or select the details for the Action you want to use in the conversation.

Use the first section of the panel to provide basic information about the Action, such as the:

• Name of the Flow Designer action
• Flow Designer object type to be invoked
• Name of the Spoke
• Associated Action or Subflow
After you enter the flow action basic information, the Flow Action properties panel includes additional fields.

These additional fields include:

• **Input mappings**
  
  Input mappings trigger workflows, retrieve values (as defined when the Action was created) and then display those values as inputs for the Action.

  The input mapping types supported include strings, references, Boolean values, date/time combination, data pill pickers, and scripts.

• **Output mappings**

  Output mappings shown are a direct result of the input mappings. For example, if the input mapping triggers a workflow that reports an incident, an incident report is included in the output mappings.

The input and output mappings shown in the Flow Action Properties panel are dynamic. That is, the fields map to the specific inputs and outputs set when the Action was created (for example, in Flow Designer).
For more information about inputs and outputs, see Action input and output data types.

Use the Virtual Agent controls on the Flow Action Properties panel to provide the relevant input and output mappings.

**Procedure**

1. Navigate to Conversational Interfaces > Virtual Agent > Designer, and in the Topics page, click the topic you want to use.

2. From the Utilities section of the palette, drag-and-drop the Action control icon onto the canvas at the appropriate location on the conversation flow. The Action control is now a node in the conversation flow, and the Flow Action Properties panel appears.

3. Provide the information prompted for in the panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Action node created in Flow Designer.</td>
</tr>
<tr>
<td>Invoke Flow Designer object (Action or Subflow)</td>
<td>The object (either an Action or a Subflow) you want to invoke from Flow Designer.</td>
</tr>
<tr>
<td></td>
<td>- An Action is a reusable operation that enables topic authors to automate Now Platform® features without having to write code.</td>
</tr>
<tr>
<td></td>
<td>- A Subflow is an automated process consisting of a sequence of reusable actions and specific data inputs that allow the process to be started from a flow, subflow, or script.</td>
</tr>
<tr>
<td>Spoke</td>
<td>List of available spokes.</td>
</tr>
<tr>
<td></td>
<td>A spoke is a scoped application that includes Flow Designer or IntegrationHub actions or subflows. It's a logical grouping of related...</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>actions, subflows, and supporting application files. The list varies by the Flow Designer object you are invoking.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The list contains the pre-built spokes along with any IntegrationHub spokes you have installed and activated from the ServiceNow Store.</td>
</tr>
<tr>
<td>Action or Subflow</td>
<td>List of available Actions or Subflows from Flow Designer. The lists vary by the Flow Designer spoke you are invoking.</td>
</tr>
<tr>
<td>Wait for response</td>
<td>Toggle switch to wait for a response before continuing with the conversation. This toggle switch is typically used when a response is required before the conversation can continue. For example, the user may need to enter a password before the conversation can continue. The mandatory fields are specified for the Action when it is created in Flow Designer. Otherwise, the conversation flow continues.</td>
</tr>
<tr>
<td>Run as</td>
<td>Identifies the access privileges required for initiating the conversation. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• User who initiates the session (This choice is the default and is recommended)</td>
</tr>
<tr>
<td></td>
<td>• System user</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field | Description
--- | ---
| **Input mapping fields (as applicable)** | Input parameters that map to the inputs set for the Action when it was created.
- The input mappings include a data pill picker and options for using a script.
- You may see other prompts based on the input type, such as string, date/time, or Boolean value.

| **Output mapping fields (as applicable)** | Output parameters that map to the outputs set for the Action when it was created in Flow Designer. Outputs can include:
- Status or error messages
- Incident records
- Catalog requests

---

**Note:** You see this prompt only if you're invoking a Flow Designer action (not a Flow Designer subflow).

For more information about the Run as option and how it is used, see Create a flow.

If the workflow discovers a String or a Password2 type as an input, the panel includes the **Include a password input** toggle switch.

Use this toggle switch to securely input passwords in the conversation. For details about this toggle switch, see Virtual Agent secure password inputs.
Field Conditions | Description
---|---
Node Conditions | Expression logic you can use to control who sees a topic in the Virtual Agent client. You can choose to:
- Click **Condition** and use the condition filter to add or edit conditions.
- Click **Script** and use the condition template to create or edit your script.

4. Select **Save**.

**Virtual Agent secure password inputs**

The **Include a password input** toggle switch on the Flow Action Designer properties panel lets you enter passwords securely for use in Virtual Agent conversations.

If the workflow discovers a String or a Password2 type as an input, the Flow Action Properties panel displays the **Include a password** toggle switch.

If you select this toggle switch, you see messages about clients that are supported, along with fields that let you:

- Designate the field you want to make secure
- Enter the text you want to use for the password-related prompt
- Enter the text for a confirmation prompt
- Enter the text to use for messages about channels that aren’t secure
These password input type fields are dynamic in the sense that the fields you see map to the fields set for the Action when it was created (for example, in Flow Designer). Some of these password type fields may also be read-only.

Starting with the Rome release, Virtual Agent supports strings and password2 fields as inputs for passwords.

For password-related design considerations in Flow Designer, see Password (2 Way Encrypted) design considerations.
Note the following points about how password-related inputs are handled securely:

- Only users can see the passwords. No one else can.

- The passwords are held in memory on the server, and are passed securely to the Flow Designer Action or Subflow.

- When users enter a password on a channel, users can toggle the **Hide text** icon to have the password hidden or visible.

- ServiceNow Admins can mark a specific channel as being secure. If topic authors attempt to include a channel that isn’t marked as secure, a warning message appears.

- Passwords are masked (not readable) in queues, tables, and logs.

**Test the action workflow**

Use this task to make sure that the integrated Action workflow completes as intended in the conversation.

**Before you begin**

Role required: virtual_agent_admin

**About testing the action workflow**

Test the conversation to see if the Action workflow is working as intended. Note the following points:

- When you test the workflow, you will see a test results preview pane that includes preview-only messages.
  
  The preview-only messages include a link called **View in Flow Designer**. This link takes you to the Flow Execution Details report. You can use this report to:
  
  ◦ View the flow execution details.
  ◦ See the results of the Action in Flow Designer.
  ◦ Verify what is being returned to Virtual Agent.

**Note:** Only topic authors have access to the **View in Flow Designer** link. In non-production environments, this link is available by default. In production environments, topic authors need to enable access to this link by creating a record in the sys_flow-execution_setting table for each Flow Designer object.

**Note:** In addition, this link isn’t available in conversations where password input is used.
Topic authors can also see the test results in the Conversation Task FDIH Invocations [sys_cs_fdih_invocation_list] table.

**Procedure**

1. **Open the topic with the Action you want to test.**
   You may need to navigate to **Conversational Interfaces > Virtual Agent > Designer**, and in the Topics page, click the topic you want to test.

2. **Select Test.**
   If an Action in the test window is slow to respond or appears to be waiting, you will see a relevant error message.
   By default, a scheduled job checks the conversation flow every 120 seconds.
   For more information about scheduled jobs, see [Scheduled jobs](#).
   You can change this interval, as needed. To change the interval, see [Specify the action workflow timeout](#).

3. **As needed, troubleshoot the Action node and continue testing.**
   To troubleshoot the Action node, view the flow execution details report or look at the Conversation Task FDIH Invocations [sys_cs_fdih_invocation_list] table.

4. **Select Save when you're finished.**

5. **Close the test results window and return to the Topics page.**

**Specify the action workflow timeout**

Set the length of time before the Flow Designer IntegrationHub action workflow times out.

**Before you begin**

Role required: admin

**Procedure**

1. **In the navigation filter, enter sys_properties.list.**

2. **Select New to add the com.glide.cs.fdih.interactive.timeout property.**

   a. **Complete these fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the system property name:</td>
</tr>
<tr>
<td></td>
<td>com.glide.cs.fdih.interactive.timeout.</td>
</tr>
</tbody>
</table>
### Field | Value
---|---
Description | Enter an explanation for this property, such as: Virtual Agent Flow Designer IntegrationHub workflow timeout (in seconds).
Type | Enter integer.
Value | Enter the number of seconds before the workflow action times out. The default value is 120 seconds.

#### b. Select **Submit**.

**Virtual Agent integration with NLU Workbench**

You can edit and fine-tune ServiceNow NLU models from within Virtual Agent Designer. When you bind a conversation topic to an associated NLU model and intent, you can review and edit utterances and associated entities, just as you would in NLU Workbench.

**Working with ServiceNow NLU models during conversation design**

If you’re a topic author (virtual_agent_admin or admin) who develops topics that use ServiceNow NLU models, you can do the following in Virtual Agent Designer:

- Bind (associate) your topic to a trained ServiceNow NLU model and intent.
- Review and edit utterances and associated entities.
- Test your topic with user utterances to see if it triggers the appropriate intent and topic, as well as entity recognition.

⚠️ **Note:** The virtual_agent_admin role includes the nlu_admin role, which enables topic authors to work on ServiceNow models.

**Bind your topic to a ServiceNow NLU model and intent**

Bind the NLU model and intent on the topic **Properties** tab. If the model is trained but not published, you can still bind it. Virtual Agent Designer displays messages letting you know that the model is not published.
Review and update utterances and entities for your intent

During topic development, test your topic to see the prediction results for topic discovery and the corresponding confidence scores for the results. Depending on the results, you can fine-tune the associated utterances and entities in the NLU model for your topic intent.

Use the **NLU Intent** tab to review the utterances for the intent in your ServiceNow NLU model. You can add, change, or delete the utterances associated with the intent, as well as add new entities from words in your utterances. You can also update the label for entities associated with the intent.
Example utterances on the NLU Intent tab

In the **Utterances** tab, you can do the following:

- Use the **Add** field to enter an utterance for an intent. Each utterance must be unique and contain fewer than 200 characters.
- Edit an utterance by clicking the pencil icon.
- Delete an utterance by clicking the trash icon.
- Define a new entity by selecting a word from an utterance to use as an entity for your intent. In the Create New Entity picker, select the type of entity to be created, such as a simple or list entity.
For information about the types of entities that you can define, see Annotating entities. When you add an entity, it is also displayed in the Associated Entities tab of the NLU Intent page.

Train, test, and publish your NLU model

Train the model to use your new or updated utterances and entities. Test the model to generate prediction results and confidence scores based on the latest changes. Continue to test and refine your model until you’re satisfied with your changes. When you’re ready to publish, click Publish Model to make the latest version of your model available to users.

1. Click Train Model.
   A message indicates that the model was successfully trained.

2. Click Test Model.
   In the Test Model panel, enter an utterance to test. The prediction results display in the panel. You can compare the draft NLU model to its most recent published version. For more information, see Compare draft and published versions of your NLU model.
Example NLU model testing

If prediction confidence score results meet or surpass the confidence threshold you established for the model, the results appear in a green font. In this example, the threshold value is 60%. Scores that fall below that value appear in a red font. You can continue to train and test to improve prediction confidence scores.

3. If you're satisfied with the confidence scores and prediction results, click Publish Model so that your updated model is available to users.

Note: For new customers on the Quebec release, the com.glide.cs.intent_confidence_delta property is set to 0 by default, so it is not utilized. This value is the recommended setting. Manually set values are not impacted by upgrading to Quebec. The ServiceNow NLU service continues to use the confidence threshold itself to determine the intent or to provide the user with a list of intents.

The default value of the com.glide.cs.intent_confidence_threshold property is 0.7. Any intent with a confidence less than this value is ignored.

The default value of the com.glide.cs.entity_confidence_threshold property is 0.5. Any entity with a confidence less than this value is not ignored, but the end chat user is given a choice whether to accept it.
Channel support for Virtual Agent topics

When creating a topic or topic block, you can specify the chat channels in which the topic or topic block will run. During conversation design, Virtual Agent Designer provides built-in guardrails to help you tailor your conversations to those channels.

In Virtual Agent, a channel is a chat interface or application in which Virtual Agent interacts with end users. Default channels are the chat applications natively supported by Virtual Agent, such as the Slack, Microsoft Teams, Workplace, and Facebook Messenger applications, and the web and mobile clients. Virtual Agent also supports custom channels created through the conversational custom chat integrations feature, which enables third-party applications (other chat providers) to work in Virtual Agent.

For example, admins can build a custom conversational chat integration for a specific messaging provider, such as Skype or WhatsApp. Admins also define the controls that can be used in topics that run in these channels. For details about creating channels for chat providers and specifying the controls used in a channel, see Conversational custom chat integrations.

Specifying channels in your topics or topic blocks

When you create or edit a topic or topic block, you can specify the applicable channels in the Additional channel support field of the Topic Properties page. Applicable channels are the custom channels created for your instance through the conversational custom chat integrations. Use this field to specify chat clients in which the topic or topic block will run.
During conversation design, Virtual Agent checks the various controls used to build the conversation flow to ensure that the control is valid for the channels in which the topic or block will run.

**Design checks for specified channels during conversation design**

When you're designing your conversation, built-in guardrails identify the Virtual Agent Designer controls that aren't suited for the custom channels that you specified in the Topic Properties. These messages display in the following views:

- **Properties** tab (Topic Properties page)

  In the next example, Skype and SMS are the additional channels in which the topic will run. The banner message identifies the controls that are not supported on the channels for the topic. As you develop the conversation flow, you can revise your conversation so that it does not use any of the specified controls for your selected channels.
Flow tab (Virtual Agent Designer canvas)

In the example flow below, the banner message identifies the controls that are not supported for the specified channels. The property sheet for the affected nodes also display a message indicating that the control is not supported. For example, when you highlight a particular node (control) in the flow, the associated property sheet for the node indicates that the control is not supported in the Skype and SMS channels.

If you have controls that cannot be used, you can branch the flow so that you can continue building the flow with controls that are supported.

Finding the channels available in your instance

To see a list of the available channels in your instance, use the Supported Channels filter in the Topics page in Virtual Agent Designer (Conversational Interfaces > Virtual Agent > Designer). The Messaging Channels [sys_cs_channel] table also shows the available channels.
The default channels in Virtual Agent are the web chat and mobile clients and also the Virtual Agent messaging integrations for the Slack, Microsoft Teams, Workplace, and Facebook Messenger messaging applications. In the example above, SMS is an available chat channel that was created for your instance through a conversational chat integration. When you choose a channel, the Topics page lists your topics (cards) by channel type.

**Virtual Agent Designer user input controls**

Use the collection of input controls provided by Virtual Agent Designer to prompt and capture information from the user in a conversation.

**Common input properties**

Each input control has the following common properties:

- **Input variable for the user response**
  
  Each control stores the user response in an input variable that is accessible from other controls within the same topic using the `getValue()` and `getDisplayValue()` methods. The variable name is based on the name that you assign to the input control. For example, if you assign the name `First prompt` to an input control, the variable name is `first_prompt` (lowercase, with an underscore character instead of a space). For more information on these methods, see Virtual Agent scripts.

- **Natural Language Understanding (NLU) entity properties**
  
  If NLU is enabled, the following properties display in the property sheet for the Text, Static Choice, Reference Choice, Boolean, Date Time, and Carousel input controls:

  - **Associated entity**: The entity that corresponds to the input variable for the control. You select the entity from the list of entities associated with the topic intent, as defined in the NLU model you are using for the topic. When Virtual Agent recognizes the entity value in user utterances and the value meets the entity...
prediction confidence threshold, Virtual Agent extracts the value. It stores the value in the input variable for the node (slot filling).

• **Enable NLU at Input Node**: You can enable or disable NLU processing for a control. Selecting an *Associated entity* automatically activates the **Enable NLU at Input Node** switch. Users can enter text to select items or switch topics from this node when this switch is enabled.

• **Skip confirmation for recognized entity**: You can enable or disable prompts that ask users to confirm the extracted entity.

**Default value**

An input prompt can have a preset value that you define. This value can be either a string or a script that returns a string.

**Confirmation message**

This message can be either a text string or a script that returns a text string. If your input control provides users with a single-choice or default value selection, the selection that the user makes is automatically displayed in the conversation. For example, if you present a Boolean prompt, the user's selection (either yes or no) displays automatically.

**Condition**

A condition determines how or when the input control runs in the conversation flow. For example, you can provide a condition that enables only certain users to see a particular input prompt, while hiding the prompt from other users. To specify a condition, use either the no-code condition builder or a low-code script that contains a condition statement. The condition expression must evaluate to true or false. If the condition evaluates to true or if you do not specify a condition, Virtual Agent always uses the control.

**Text user input control**

The Text user input control in a Virtual Agent topic prompts the user for a text string.
### Example Text user input control

<table>
<thead>
<tr>
<th>Response properties</th>
<th>Input prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Input Properties</strong></td>
<td><strong>Web UI Text user input prompt</strong></td>
</tr>
<tr>
<td>String Basic Info</td>
<td>Please enter a short description of what you're looking for.</td>
</tr>
<tr>
<td>Name</td>
<td><img src="adapter.png" alt="Adapter" /></td>
</tr>
<tr>
<td>Node Name</td>
<td></td>
</tr>
<tr>
<td>Variable Name</td>
<td></td>
</tr>
<tr>
<td>Text Input Format</td>
<td>Text</td>
</tr>
<tr>
<td>Make it secure</td>
<td><img src="secure.png" alt="Secure" /></td>
</tr>
<tr>
<td>Prompt</td>
<td><img src="prompt.png" alt="Prompt" /></td>
</tr>
<tr>
<td>Associated Entity</td>
<td><img src="select_one_entity.png" alt="Select one entity" /></td>
</tr>
<tr>
<td>Enable NLU at Input Node</td>
<td><img src="enable_nlu.png" alt="Enable NLU" /></td>
</tr>
<tr>
<td>Skip confirmation for recognized entity</td>
<td><img src="skip.png" alt="Skip" /></td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td><img src="acknowledge.png" alt="Acknowledge" /></td>
</tr>
<tr>
<td>Default Value</td>
<td><img src="default.png" alt="Default" /></td>
</tr>
<tr>
<td>Confirmation Message</td>
<td><img src="confirmation.png" alt="Confirmation" /></td>
</tr>
<tr>
<td><strong>Node Conditions</strong></td>
<td><strong>Slack Text user input prompt</strong></td>
</tr>
<tr>
<td>By default, this node will be shown in the conversation and input from the user will be required.</td>
<td><img src="slack.png" alt="Slack" /></td>
</tr>
<tr>
<td>Conditionally show this node:</td>
<td>Please enter a short description of what you're looking for.</td>
</tr>
<tr>
<td>Condition</td>
<td><img src="condition.png" alt="Condition" /></td>
</tr>
<tr>
<td>Script</td>
<td><img src="script.png" alt="Script" /></td>
</tr>
<tr>
<td><img src="add_condition.png" alt="Add Condition" /></td>
<td><strong>Microsoft Teams Text user input prompt</strong></td>
</tr>
<tr>
<td><img src="add_condition.png" alt="Add Condition" /></td>
<td><strong>Workplace Text user input prompt</strong></td>
</tr>
<tr>
<td><img src="add_condition.png" alt="Add Condition" /></td>
<td>Please enter a short description of what you're looking for.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Text user input control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name that identifies this Text user input control node in the topic flow.</td>
</tr>
<tr>
<td><strong>Variable Name</strong></td>
<td>Name of the variable that stores the user response to this prompt. The variable name is automatically created from the <strong>Name</strong> property.</td>
</tr>
<tr>
<td><strong>Text Input Format</strong></td>
<td>Text format that is validated when a user enters certain text items. If the user doesn't enter the expected format, an error message indicates that the format is not valid and asks the user to reenter the text.</td>
</tr>
<tr>
<td></td>
<td><strong>Choose the format of the text item to be validated:</strong></td>
</tr>
<tr>
<td></td>
<td>• Text: Any text string (no validation)</td>
</tr>
<tr>
<td></td>
<td>• IP address (IPV4, IPV6): Data communication delivery format for Internet Protocol version 4 or version 6.</td>
</tr>
<tr>
<td></td>
<td>• Email: Format that consists of an email prefix (user name), @ symbol, and domain.</td>
</tr>
<tr>
<td></td>
<td>• Phone number (E.164): Internationally recognized standard phone number format.</td>
</tr>
<tr>
<td></td>
<td>• URL: Web address format</td>
</tr>
<tr>
<td></td>
<td>• Custom: Script that provides a text validation rule for a custom text format and the related error messages displayed when the expected format is not entered.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For phone and IP address format examples, see E.164 phone formats and IP address field types.</td>
</tr>
<tr>
<td><strong>Make it secure</strong></td>
<td>Toggle switch that encrypts the Text bot user response. When enabled, the response is masked and appears as a series of dots in the chat window.</td>
</tr>
<tr>
<td><strong>Hash function</strong></td>
<td>The method digest algorithm based on the standard WS-security standard. Choose either:</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Text user input control properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user response is encrypted</td>
<td>• SHA-256 (lower case)</td>
</tr>
<tr>
<td></td>
<td>• SHA-1 (lower case)</td>
</tr>
<tr>
<td></td>
<td>For more information about the WS-security standards, see WS-Security properties.</td>
</tr>
<tr>
<td>Encryption salt</td>
<td>Random data that is used as an additional input to a one-way function that hashes data.</td>
</tr>
<tr>
<td>[Applies only if the Text bot user response is encrypted]</td>
<td></td>
</tr>
<tr>
<td>Prompt</td>
<td>Prompt or question for the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Associated Entity</td>
<td>Option to associate an NLU entity with the node. If an NLU entity is associated with the input variable for this node, Virtual Agent can slot-fill the specified value based on the user's utterance. Select an entity from the list of entities associated with the topic intent.</td>
</tr>
<tr>
<td>[NLU only]</td>
<td></td>
</tr>
<tr>
<td>Enable NLU at Input Node</td>
<td>Option to enable NLU prediction for this node. If enabled, users can enter text to answer questions, regardless of the type of input control being used. Virtual Agent uses this utterance to match another existing intent, letting the user switch topics.</td>
</tr>
<tr>
<td>[NLU only]</td>
<td></td>
</tr>
<tr>
<td>Skip confirmation for recognized entity</td>
<td>Option to disable prompts that ask users to confirm the extracted entity.</td>
</tr>
<tr>
<td>[NLU only]</td>
<td></td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>Message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
</tbody>
</table>
Text user input control properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirmation Message</td>
<td>Message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
</tbody>
</table>
| Node Conditions           | Options for controlling the display of the node to the end user. \  
  • **Conditionally show this node if**: A no-code condition statement or low-code script that specifies a condition for presenting this node in the conversation. The condition must evaluate to true.  
  • **Allow user to skip this node if**: A no-code condition statement or low-code script that specifies a condition for letting end users skip this node in the conversation. |

⚠️ **Note**: Slack users can edit text previously entered in a conversation. However, because Virtual Agent processes messages as they are first entered, if a Slack user edits text input, such as a comment to update a case, Virtual Agent does not evaluate the edited update.

**Static Choice user input control**

Use the Static Choice user input control in a Virtual Agent topic to list predefined choices available to the user. A user can select only one item from a choice list.

**Choice list display**

The choice list contains up to 10 items per page. When more than 10 items exist, users have the option to display the additional items and filter the search results. The choice list prompt contains a search icon that users can select to filter the results.

The Static Choice control provides the option to add a header card that displays above the choice list. Header cards are supported in web and mobile channels.

• The header card can contain a large or small image, or a YouTube video card, with descriptive text. The choice list contains up to five items by default, but the search feature is suppressed. If there are more than five items, users can choose to show the additional items.
To control the number of items displayed below a header card, add the `com.glide.cs.web_header_picker_page_limit` system property. Use the Value to specify the number of items displayed in the choice list. For details on creating a system property, see Add a system property.

### Example Static Choice user input control

<table>
<thead>
<tr>
<th>Input properties</th>
<th>List prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Input Properties</strong></td>
<td><strong>Web UI Static Choice list prompt</strong></td>
</tr>
<tr>
<td>Static Choice List Basic Info</td>
<td>OK, what's the urgency of your issue?</td>
</tr>
<tr>
<td>* Name ①</td>
<td>1 - High</td>
</tr>
<tr>
<td>Test Choice</td>
<td>2 - Medium</td>
</tr>
<tr>
<td>* Variable Name ①</td>
<td>3 - Low</td>
</tr>
<tr>
<td>test_choice</td>
<td></td>
</tr>
<tr>
<td>* Prompt ①</td>
<td><img src="image.png" alt="Choice list with more than 10 items" /></td>
</tr>
<tr>
<td>Choose an option.</td>
<td>Here are the breakfast items</td>
</tr>
<tr>
<td>Acknowledge Message ①</td>
<td>eggs</td>
</tr>
<tr>
<td>Thank you for choosing.</td>
<td>bacon</td>
</tr>
<tr>
<td>Default Value ①</td>
<td>toast</td>
</tr>
<tr>
<td></td>
<td>butter</td>
</tr>
<tr>
<td>Confirmation Message ①</td>
<td>jam</td>
</tr>
<tr>
<td></td>
<td>sausage</td>
</tr>
<tr>
<td>Choice List Setting</td>
<td>hash browns</td>
</tr>
<tr>
<td>Insert a header card ①</td>
<td>orange juice</td>
</tr>
<tr>
<td></td>
<td>strawberries</td>
</tr>
<tr>
<td></td>
<td>waffles</td>
</tr>
<tr>
<td></td>
<td>Show 2 more...</td>
</tr>
<tr>
<td>Label ①</td>
<td><img src="image.png" alt="Choice list with more than 10 items" /></td>
</tr>
<tr>
<td>Value ①</td>
<td><img src="image.png" alt="Choice list with more than 10 items" /></td>
</tr>
<tr>
<td>Apple</td>
<td>10</td>
</tr>
<tr>
<td>Pear</td>
<td>20</td>
</tr>
<tr>
<td>Orange</td>
<td>30</td>
</tr>
<tr>
<td><img src="image.png" alt="Choice list with more than 10 items" /></td>
<td></td>
</tr>
</tbody>
</table>

The choice list displays 10 items per page. When 10 or more results are returned:

- The list includes a link at the end of the list to show more results.
- A search icon displays in the prompt for filtering search results. Users click the icon to open a search box and enter the filter.
Example Static Choice user input control (continued)

<table>
<thead>
<tr>
<th>Input properties</th>
<th>List prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Web UI Static Choice list with header card</td>
</tr>
<tr>
<td></td>
<td><a href="#">Get your favorite candy</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">From your neighborhood candy store</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">Visit us!</a></td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="List prompt" /></td>
</tr>
<tr>
<td></td>
<td>Lollipops</td>
</tr>
<tr>
<td></td>
<td>Gummy treats</td>
</tr>
<tr>
<td></td>
<td>Bubble gum</td>
</tr>
<tr>
<td></td>
<td>Jawbreakers</td>
</tr>
<tr>
<td></td>
<td>Chocolate bar</td>
</tr>
<tr>
<td></td>
<td>Show 5 more...</td>
</tr>
</tbody>
</table>

The choice list contains five items per page. When five or more results are returned, the list provides an option to show more results.

**Note:** The search feature is suppressed when a header card is used.

Slack Static Choice list prompt

```
Hello! I'm Now Virtual Agent. I'm here to help you. Let's start by linking your ServiceNow account. In case you don't want to connect your account, please enter your request.
```

When a choice list has three or fewer choices, Slack displays the list as buttons.
### Static Choice user input control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies this Static Choice user control node in the topic flow.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Name of the variable that stores the user response to this prompt. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Associated Entity [NLU only]</td>
<td>Option to associate an NLU entity with the node. If an NLU entity is associated with the input variable for this node, Virtual Agent can slot-fill the specified value based on the user's utterance. Select an entity from the list of entities associated with the topic intent.</td>
</tr>
<tr>
<td>Enable NLU at Input Node [NLU only]</td>
<td>Option to enable NLU prediction for this node. If enabled, users can enter text to answer questions, regardless of the type of input control being used. Virtual Agent uses this utterance to match another existing intent, letting the user switch topics.</td>
</tr>
<tr>
<td>Skip confirmation</td>
<td>Option to disable prompts that ask users to confirm the extracted entity.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>for recognized entity [NLU only]</td>
<td>Acknowledge Message: Message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Default Value: Predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>Confirmation Message: Message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Choice List Setting</td>
<td>Choice List Setting: Option to insert a header card above the choice list. To insert a header card, slide the toggle switch.</td>
</tr>
<tr>
<td>Would you like help:</td>
<td>Would you like help: Options for defining the header card content. Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Yes</strong> to add an image or video without coding. Click <strong>Add Card</strong> and complete the Add card dialog box (see next section).</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>No, I will use script</strong>. Click <strong>Add Script</strong> to enter a script that defines the card content. When you're done, continue to the <strong>Label</strong> and <strong>Choice</strong> fields.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add image or video card in the header card using the Add card dialog box</td>
<td></td>
</tr>
<tr>
<td>Card type</td>
<td>Type of header card. Choose the contents:</td>
</tr>
<tr>
<td></td>
<td>• Large image with text</td>
</tr>
<tr>
<td></td>
<td>• Small image with text</td>
</tr>
<tr>
<td></td>
<td>• Youtube Video Card</td>
</tr>
<tr>
<td></td>
<td>The fields in the dialog box change based on your choice.</td>
</tr>
<tr>
<td>Title</td>
<td>Image or video title. Enter the title text or use a data pill or script to specify the title.</td>
</tr>
<tr>
<td>Title Link</td>
<td>URL of the video title hyperlink. Enter the link text or use a data pill or script to specify the link. If this field is empty, the title displays as plain text.</td>
</tr>
<tr>
<td>[Youtube video card option only]</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Brief explanation of the image or video</td>
</tr>
<tr>
<td>Youtube Video ID</td>
<td>Alphanumeric string at the end of the YouTube URL. For example, in the URL <a href="https://www.youtube.com/watch?v=AacDp2mUQ1I">https://www.youtube.com/watch?v=AacDp2mUQ1I</a> the YouTube video ID is AacDp2mUQ1I.</td>
</tr>
<tr>
<td></td>
<td>This field is only available for the Youtube video card option.</td>
</tr>
<tr>
<td>Image URL link</td>
<td>URL link for the image or the image file. Do one of the following:</td>
</tr>
<tr>
<td>[large or small image cards only]</td>
<td>• Enter the link text, or use a data pill or script to specify the URL link.</td>
</tr>
<tr>
<td></td>
<td>• Specify an image file by clicking <strong>Upload Image</strong> and selecting the image file to upload.</td>
</tr>
<tr>
<td></td>
<td>If this field is empty the title displays as plain text.</td>
</tr>
<tr>
<td>Image Alt text</td>
<td>(Optional) Alternative, screen-readable text that describes the image for accessibility programs.</td>
</tr>
<tr>
<td>[large or small image cards only]</td>
<td></td>
</tr>
<tr>
<td>Choice List Labels and Values</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>For each choice, the text that appears to the user for that choice. Use short phrases in your choice lists.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Slack has a limit of 30 characters for choice list labels.</td>
<td></td>
</tr>
<tr>
<td>• Workplace has a limit of 20 characters for choice list labels.</td>
<td></td>
</tr>
</tbody>
</table>

**Value**
For each choice, the string that is stored in the variable when the corresponding choice is selected.

**Node Conditions**

<table>
<thead>
<tr>
<th>Conditionally show this node if:</th>
<th>A no-code condition statement or low-code script that specifies a condition for presenting this node in the conversation. The condition must evaluate to true.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow user to skip this node if:</td>
<td>A no-code condition statement or low-code script that specifies a condition for letting end users skip this node in the conversation.</td>
</tr>
</tbody>
</table>

**Reference Choice user input control**

Use the Reference Choice user input control in a Virtual Agent topic to dynamically create a list of available choices for your users. Create these choices by querying a table or by using a script to dynamically create them.

**Choice list display**

The Reference Choice list contains up to 10 items per page. When more than 10 items exist, users have the option to display the additional items and also filter the search results. The choice list prompt contains a search icon that users can select to filter the results.

The Reference Choice control also provides the option to add a header card that displays above the choice list. Header cards are supported in web and mobile channels.

- The header card can contain a large or small image, or a YouTube video card, with descriptive text. The choice list contains up to five items by default, but the search feature is suppressed. If there are more than five items, users can choose to show the additional items.

- To control the number of items displayed below a header card, add the `com.glide.cs.web_header_picker_page_limit` system property. Use the Value to specify the number of items in the choice list. For details on creating a system property, see Add a system property.
### Example Reference Choice user input control

<table>
<thead>
<tr>
<th>Input properties</th>
<th>List prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Input Properties</td>
<td>Web UI Reference Choice list prompt</td>
</tr>
<tr>
<td>Reference Choice List Basic Info</td>
<td>[Image]</td>
</tr>
<tr>
<td>Name ①</td>
<td>![Image]</td>
</tr>
<tr>
<td>Pick an incident</td>
<td>![Image]</td>
</tr>
<tr>
<td>Variable Name ①</td>
<td>![Image]</td>
</tr>
<tr>
<td>pick_an_incident</td>
<td>![Image]</td>
</tr>
<tr>
<td>Prompt ①</td>
<td>![Image]</td>
</tr>
<tr>
<td>Please select an incident</td>
<td>![Image]</td>
</tr>
<tr>
<td>Acknowledge Message ①</td>
<td>![Image]</td>
</tr>
<tr>
<td>Default Value ①</td>
<td>![Image]</td>
</tr>
<tr>
<td>Confirmation Message ①</td>
<td>![Image]</td>
</tr>
</tbody>
</table>

#### Choice List Setting
- Insert a header card ①
  - ![Image]

- Would you like help:
  - Yes
  - No, I will use Script

When defining your enumeration list in javascript ensure that you assign keys of Name and Value.

- Reference Type ①
  - Record

- Table ①
  - Incident [incident]

- Choice Value Expression ①
  - Condition
  - Script

- ![Image] Add Condition

- ![Image] No records response message

#### Node Conditions
- By default, this node will be shown in the conversation and input from the user will be required.

- Conditionally show this node if:
  - Condition
  - Script

- ![Image] Add Condition

- Allow user to skip this node if:
  - Condition
  - Script

- ![Image] Add Condition

The choice list displays 10 items per page. When 10 or more results are returned:

- The list includes a link at the end of the list to show more results.

- A search icon displays in the prompt for filtering search results. Users click the icon to open a search box and enter the filter.

The choice list contains five items per page. When five or more results are...
Example Reference Choice user input control (continued)

<table>
<thead>
<tr>
<th>Input properties</th>
<th>List prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>returned, the list provides an option to show more results.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The search feature is suppressed when a header card is used.

Slack Reference Choice list prompt

Microsoft Teams Reference Choice list prompt

Workplace Reference Choice list prompt

Reference Choice user input control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies this Reference Choice user control node in the topic flow.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Name of the variable that stores the user response to this prompt. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Associated Entity [NLU only]</td>
<td>Option to associate an NLU entity with the node. If an NLU entity is associated with the input variable for this node, Virtual Agent can slot-fill the specified value based on the user's utterance. Select an entity from the list of entities associated with the topic intent.</td>
</tr>
<tr>
<td>Enable NLU at Input Node [NLU only]</td>
<td>Option to enable NLU prediction for this node. If enabled, users can enter text to answer questions, regardless of the type of input control being used. Virtual Agent uses this utterance to match another existing intent, letting the user switch topics.</td>
</tr>
<tr>
<td>Skip confirmation for recognized entity [NLU only]</td>
<td>Option to disable prompts that ask users to confirm the extracted entity.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>Message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>Message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Choice List Setting</td>
<td>Option for inserting a header card above the choice list.</td>
</tr>
</tbody>
</table>
Reference Choice user input control properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice List Setting</td>
<td>Insert a header card:</td>
</tr>
<tr>
<td></td>
<td><img src="toggle.png" alt="Toggle Switch" /></td>
</tr>
<tr>
<td>Would you like help?</td>
<td>Options for defining the header card content. Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Yes</strong> to add an image or video without coding. Click <strong>Add Card</strong> and complete the Add card dialog box (see next section).</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>No, I will use script</strong>. Click <strong>Add Script</strong> to enter a script that defines the card content. When you're done, continue to the</td>
</tr>
<tr>
<td></td>
<td><strong>Reference Type</strong> field.</td>
</tr>
<tr>
<td>Reference Type</td>
<td>Type of reference variable to be used. Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- Record: Returns records from the table selected. The values for these options are GlideRecord objects.</td>
</tr>
<tr>
<td></td>
<td>- Script: Expression that returns an array of options.</td>
</tr>
<tr>
<td>Table</td>
<td>If you selected Record as the <strong>Reference Type</strong>, select the table to be searched.</td>
</tr>
<tr>
<td>Choice Value Expression</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Condition Builder</strong>: Creates a filter used to select a subset of records from the table.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Script</strong>: Defines the enumeration list for the options (choice list) to be displayed. The name value pair is stored as a string object.</td>
</tr>
</tbody>
</table>
### Reference Choice user input control properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No records response message</td>
<td>Message displayed to the user when the table search does not return any records. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Add image or video card in the header card using the Add card dialog box</td>
<td></td>
</tr>
<tr>
<td>Card type</td>
<td>Type of header card. Choose the contents:</td>
</tr>
<tr>
<td></td>
<td>• Large image with text</td>
</tr>
<tr>
<td></td>
<td>• Small image with text</td>
</tr>
<tr>
<td></td>
<td>• Youtube Video Card</td>
</tr>
<tr>
<td></td>
<td>The fields in the dialog box change based on your choice.</td>
</tr>
<tr>
<td>Title</td>
<td>Image or video title. Enter the title text or use a data pill or script to specify the title.</td>
</tr>
<tr>
<td>Title Link</td>
<td>URL of the video title hyperlink. Enter the link text or use a data pill or script to specify the link. If this field is empty, the title displays as plain text.</td>
</tr>
<tr>
<td>Youtube Video ID</td>
<td>Alphanumeric string at the end of the YouTube URL. For example, in the URL <a href="https://www.youtube.com/watch?v=AacDp2mUQ1I">https://www.youtube.com/watch?v=AacDp2mUQ1I</a> the YouTube video ID is AacDp2mUQ1I. This field is only available for the Youtube video card option.</td>
</tr>
<tr>
<td>Image URL link</td>
<td>URL link for the image or the image file. Do one of the following:</td>
</tr>
<tr>
<td>[large or small image cards only]</td>
<td>• Enter the link text, or use a data pill or script to specify the URL link.</td>
</tr>
<tr>
<td></td>
<td>• Specify an image file by clicking Upload Image and selecting the image file to upload.</td>
</tr>
<tr>
<td></td>
<td>If this field is empty the title displays as plain text.</td>
</tr>
<tr>
<td>Image Alt text</td>
<td>(Optional) Alternative, screen-readable text that describes the image for accessibility programs.</td>
</tr>
</tbody>
</table>
Reference Choice user input control properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node Conditions</strong></td>
<td></td>
</tr>
<tr>
<td>Conditionally show this node if:</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this node in the conversation. The condition must evaluate to true.</td>
</tr>
<tr>
<td>Allow user to skip this node if:</td>
<td>A no-code condition statement or low-code script that specifies a condition for letting end users skip this node in the conversation.</td>
</tr>
</tbody>
</table>

**Example Reference Choice list value expression**

```javascript
(function execute(table) {
    var options = [];
    var now_GR = new GlideRecord(table);
    gr.addEncodedQuery('active=true');
    gr.setLimit(5);
    gr.query();
    while(gr.next()) {
        options.push({ 'value': gr.getUniqueValue(), 'label': gr.getValue('short_description') });
    }
    return options;
})(table)
```

The script in the Choice Value Expression property defines and returns an array of choices. In the example, the script creates an array called `options`, and adds each record found in a GlideRecord query to this array. Each element in the array is given a value in the `value` and `label` keys using data from that GlideRecord. The Table property of the control defines the table used by the script. This example script uses `gr.setLimit(5)` to limit the number of records returned to 5. Using this method prevents returned records from creating an overly large choice list.

**Reference choice control value expression keys**

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>The value for the choice. When a user selects a choice from the control, this value is stored in the variable named in the Variable name property.</td>
</tr>
</tbody>
</table>
Reference choice control value expression keys (continued)

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>label</td>
<td>The label that appears for this choice in the choice list.</td>
</tr>
</tbody>
</table>

Boolean user input control

Use the Boolean user input control in a Virtual Agent topic to present a Yes/No prompt to the user.

Example Boolean user input control

<table>
<thead>
<tr>
<th>Input properties</th>
<th>Input prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web UI Boolean user input prompt</td>
<td>Would you like to add a comment? Yes No</td>
</tr>
<tr>
<td>Slack Boolean user input prompt</td>
<td>Would you like to add a comment? Yes No</td>
</tr>
<tr>
<td>Microsoft Teams Boolean user input prompt</td>
<td>Would you like to add a comment? Yes No</td>
</tr>
<tr>
<td>Workplace Boolean user input prompt</td>
<td>Would you like to add a comment? Yes No</td>
</tr>
</tbody>
</table>

Boolean user input controls prompt the user to answer a Yes/No question, and store the response as a string with a value of true or false. Use this value in
topic utilities, such as the Decision utility, to branch the topic flow based on the answer.

### Boolean user input control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies this Boolean user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Variable that stores the choice selected by the user. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Associated Entity</td>
<td>Option to associate an NLU entity with the node. If an NLU entity is associated with the input variable for this node, Virtual Agent can slot-fill the specified value based on the user's utterance. Select an entity from the list of entities associated with the topic intent.</td>
</tr>
<tr>
<td>Enable NLU at Input Node</td>
<td>Option to enable NLU prediction for this node. If enabled, users can enter text to answer questions, regardless of the type of input control being used. Virtual Agent uses this utterance to match another existing intent, letting the user switch topics.</td>
</tr>
<tr>
<td>Skip confirmation for recognized entity</td>
<td>Option to disable prompts that ask users to confirm the extracted entity.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>Message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>Message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Node Conditions</td>
<td>Options for controlling the display of the node to the end user.</td>
</tr>
</tbody>
</table>
Boolean user input control properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Conditionally show this node if:</strong> A no-code condition statement or low-code script that specifies a condition for presenting this node in the conversation. The condition must evaluate to true.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Allow user to skip this node if:</strong> A no-code condition statement or low-code script that specifies a condition for letting end users skip this node in the conversation.</td>
<td></td>
</tr>
</tbody>
</table>

Date Time user input control

Use the Date Time user input control in a Virtual Agent topic to enable the user to select a calendar date, time (hours and minutes), or both.
### Example Date Time user input control

#### Input properties

<table>
<thead>
<tr>
<th>User Input Properties</th>
<th>Date Time Basic Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Name</td>
<td>When done</td>
</tr>
<tr>
<td>* Variable Name</td>
<td>when_done</td>
</tr>
<tr>
<td>* Prompt</td>
<td>When do you need this done by?</td>
</tr>
<tr>
<td>Associated Entity</td>
<td>Select one entity</td>
</tr>
<tr>
<td>Enable NLU at Input Node</td>
<td></td>
</tr>
<tr>
<td>Skip confirmation for recognized entity</td>
<td></td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td></td>
</tr>
<tr>
<td>Default Value</td>
<td></td>
</tr>
<tr>
<td>Confirmation Message</td>
<td></td>
</tr>
</tbody>
</table>

#### Date Time prompt

**Web UI Date Time prompt**

![Web UI Date Time prompt](image1)

**Slack Date Time prompt**

![Slack Date Time prompt](image2)

**Microsoft Teams Date Time prompt**

![Microsoft Teams Date Time prompt](image3)

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Example Date Time user input control (continued)

<table>
<thead>
<tr>
<th>Input properties</th>
<th>Date Time prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workplace Date Time prompt</strong></td>
<td><img src="image" alt="Date Time user input control" /></td>
</tr>
</tbody>
</table>

**Date and time selection for Workplace interface**

The Workplace interface does not natively support a date selection widget. Date and time selection is instead done with the buttons that are supported in these interfaces.

The Date Time user input control prompts the user for a date, showing the current date and time. The user clicks the month, day, year, or time button to modify that value. The time and day fields prompt the user to type in a new value. The month and year fields show a set of buttons with the current and upcoming months or years. Select one of these buttons or type in a value to set the time or year.

**Date Time picker properties**

<table>
<thead>
<tr>
<th>Date Time property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies this Date Time user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Name of the variable that stores the user response to this prompt. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Associated Entity</td>
<td>Option to associate an NLU entity with the node. If an NLU entity is associated with the input variable for this node, Virtual Agent can slot-fill the specified value based on the user's utterance. Select an entity from the list of entities associated with the topic intent. [NLU only]</td>
</tr>
<tr>
<td>Enable NLU at Input Node</td>
<td>Option to enable NLU prediction for this node. If enabled, users can enter text to answer questions, regardless of the type of input control being used. Virtual Agent uses this utterance to match another existing intent, letting the user switch topics. [NLU only]</td>
</tr>
<tr>
<td><strong>Date Time property</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Skip confirmation for recognized entity [NLU only]</td>
<td>Option to disable prompts that ask users to confirm the extracted entity.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>Message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>Message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
</tbody>
</table>
| Format | Type of Date Time control to be displayed. Select one of the following formats:  
- **Date**: Shows only the monthly calendar for the user to select the date.  
- **DateTime**: Shows both a monthly calendar and time picker.  
- **Time**: Shows only the time picker for the user to select the time (hours and minutes). |
| Node Conditions | Options for controlling the display of the node to the end user.  
- **Conditionally show this node if**: A no-code condition statement or low-code script that specifies a condition for presenting this node in the conversation. The condition must evaluate to true.  
- **Allow user to skip this node if**: A no-code condition statement or low-code script that specifies a condition for letting end users skip this node in the conversation. |

**File picker user input control**

Use the File picker user input control in a Virtual Agent topic to prompt a user to upload an image or any file type. After the user uploads an image file, the image appears immediately in the Virtual Agent client.
### Example image picker user input control

<table>
<thead>
<tr>
<th>File picker properties</th>
<th>File picker prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Input Properties</strong></td>
<td><strong>Web UI file picker prompt (image)</strong></td>
</tr>
<tr>
<td><strong>File Basic Info</strong></td>
<td><strong>Please upload your image.</strong></td>
</tr>
<tr>
<td>* Name 1</td>
<td><strong>Click here to upload an image.</strong></td>
</tr>
<tr>
<td>Image upload test</td>
<td></td>
</tr>
<tr>
<td>* Variable Name 1</td>
<td><strong>Slack image picker prompt</strong></td>
</tr>
<tr>
<td>image_upload_test</td>
<td><strong>Please upload an image.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Message @virtualagent</strong></td>
</tr>
<tr>
<td>* Allow user to upload</td>
<td><strong>Microsoft Teams image picker prompt</strong></td>
</tr>
<tr>
<td>Image</td>
<td><strong>Please upload an image.</strong></td>
</tr>
<tr>
<td>All file types</td>
<td><strong>Type your questions here</strong></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>* Prompt 1</td>
<td><strong>Workplace image picker prompt</strong></td>
</tr>
<tr>
<td>Please upload an image.</td>
<td><strong>Please upload your pay check</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Type a message...</strong></td>
</tr>
<tr>
<td>Acknowledge Message 1</td>
<td><strong>ServiceNow mobile file picker prompt</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Upload an Image</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Take Photo</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Upload a File</strong></td>
</tr>
</tbody>
</table>
| **Note:** Your users will see a prompt asking for permission for the app to access their camera or file system if they have not already done so.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
File picker user input control properties

All file types are supported with file picker. Although the image can be high resolution, the image displayed in the Virtual Agent client is scaled based on the aspect ratio. Images scale to fit within the chat window.

When file upload is in progress, you can’t upload or enter text. Uploaded files go through a virus scan and validation.

### File picker properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the Image picker user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable name</td>
<td>Name of the variable that stores the user response to this prompt. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Allow user to upload</td>
<td>Select the type of file to upload. All file types are supported.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Prompt to the user asking them to upload the item. The prompt can be a text string that includes variables or a script that returns text.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>The message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Node Conditions</td>
<td>Options for controlling the display of the node to the end user.</td>
</tr>
</tbody>
</table>
File picker properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Conditionally show this node if:</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this node in the conversation. The condition must evaluate to true.</td>
</tr>
<tr>
<td>• Allow user to skip this node if:</td>
<td>A no-code condition statement or low-code script that specifies a condition for letting end users skip this node in the conversation.</td>
</tr>
</tbody>
</table>

Using the File picker control in different client interfaces

The process to select an image differs based on the Virtual Agent client interface. Use the following steps to select an image in the client interface of your choice.

File picker control in different client interfaces

<table>
<thead>
<tr>
<th>Platform</th>
<th>Steps to select an image or file</th>
</tr>
</thead>
</table>
| Web UI        | 1. Click [Click here to upload an image.](#) or [Click here to upload a file.](#).  
                2. Choose the appropriate file from your local computer. All file types are supported. |
| Slack         | 1. Click the Green + icon.  
                2. Select [Your computer](#).  
                3. Choose an image file from your local computer. All file types are supported. |
| Microsoft Teams | 1. On your local computer, copy an image file.  
                      2. Paste the image file into the text input field in Microsoft Teams. |
### File picker control in different client interfaces (continued)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Steps to select an image or file</th>
</tr>
</thead>
</table>
| Workplace                 | 1. Click the image icon (🖼️).  
                            | 2. Choose an image file from your local computer. All file types are supported.                  |
| ServiceNow mobile         | 1. Click the **Upload an image**.  
                            | 2. Select an image file from the photo library on your mobile device.                           |
|                           | 🔄 **Note:** The **Upload a file** button is only available when you enable the **All file types** file picker property. |

### Carousel user input control

Use the Carousel user input control in a Virtual Agent topic to present a prompt and a horizontal series of labeled images. The user can select a single item from the carousel.

The Carousel input control is not supported in all channels. For example, this control is not supported in SMS.
### Example Carousel input control

#### Carousel properties

<table>
<thead>
<tr>
<th>User Input Properties</th>
<th>Carousel Basic Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗ Name</td>
<td>T-shirt carousel</td>
</tr>
<tr>
<td>✗ Variable Name</td>
<td>t_shirt_carousel</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>✗ Prompt</th>
<th>These T-shirts are available:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Associated Entity</th>
<th>Select one entity</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Enable NLU at Input Node</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Skip confirmation for recognized entity</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Acknowledge Message</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Default Value</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Confirmation Message</th>
<th></th>
</tr>
</thead>
</table>

#### Carousel prompt

**Web UI carousel prompt**

- **Prompt:** What was your result?
- **Thank you**
  - **Prompt:** Please select the image that matches your modem lights
  - **Image:** All lights green
  - **Message:** When all lights are green, it means your modem is connected and running properly.

**Slack carousel prompt**

- **Prompt:** Welcome to the ServiceNow platform.
  - **Prompt:** Please enter your request or make a selection of what I can help with. You can type at any time when you need help.
  - **Prompt:** You select as text below:
    - **Image:** 21.5-inch iMac with Retina 4K display.
      - **Message:** Hello!
      - **Message:** How can I help you today?
      - **Message:** Please select an item below:
        - **Image:** 21.5-inch iMac with Retina 4K display.
          - **Message:** What is your question or request?
          - **Message:** Please select an item below:
            - **Image:** 21.5-inch iMac with Retina 4K display.
              - **Message:** How can I help you?
            - **Image:** 21.5-inch iMac with Retina 4K display.
              - **Message:** What is your question or request?

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Example Carousel input control (continued)

<table>
<thead>
<tr>
<th>Carousel properties</th>
<th>Carousel prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft Teams carousel prompt</strong></td>
<td><img src="image" alt="Microsoft Teams carousel prompt" /></td>
</tr>
<tr>
<td>If there are more than 10 items, the user can select <strong>Next</strong> to see the remaining items.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Workplace carousel prompt</strong></th>
<th><img src="image" alt="Workplace carousel prompt" /></th>
</tr>
</thead>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Example Carousel input control (continued)

<table>
<thead>
<tr>
<th>Carousel properties</th>
<th>Carousel prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ServiceNow mobile carousel prompt</strong></td>
<td></td>
</tr>
<tr>
<td>![Image of a mobile carousel prompt]</td>
<td></td>
</tr>
<tr>
<td>Please select one of the catalogue items</td>
<td></td>
</tr>
<tr>
<td>![Image of a mobile carousel prompt]</td>
<td></td>
</tr>
<tr>
<td>iMac 21&quot;</td>
<td></td>
</tr>
<tr>
<td>Customize your 21.5-inch iMac with Retina 4K display</td>
<td></td>
</tr>
<tr>
<td>![Image of a mobile carousel prompt]</td>
<td></td>
</tr>
<tr>
<td>Select</td>
<td></td>
</tr>
</tbody>
</table>

**Carousel properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name that identifies this Carousel user input control node in the topic flow.</td>
</tr>
<tr>
<td><strong>Variable Name</strong></td>
<td>Name of the variable that stores the selection made by the user. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>Prompt to the user. The prompt can be a text string or a script that returns the prompt string.</td>
</tr>
<tr>
<td><strong>Associated Entity</strong></td>
<td>Option to associate an NLU entity with the node. If an NLU entity is associated with the input variable for this node, Virtual Agent can slot-fill the specified value based on the user's utterance. Select an entity from the list of entities associated with the topic intent.</td>
</tr>
<tr>
<td><strong>Enable NLU at Input Node</strong> [NLU only]</td>
<td>Option to enable NLU prediction for this node. If enabled, users can enter text to answer questions, regardless of the type of input control being used. Virtual Agent uses this utterance to match another existing intent, letting the user switch topics.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Skip confirmation for recognized entity [NLU only]</td>
<td>Option to disable prompts that ask users to confirm the extracted entity.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>Message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text. The user is prompted with a Yes/No prompt to accept this value. If the user selects No at this prompt, no value is used.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>Message that appears when the carousel has a default value or only a single choice is available. The user is prompted with a Yes/No prompt to accept this value.</td>
</tr>
<tr>
<td>Carousel Item Setting</td>
<td>Options for creating the carousel items and message if no items are found:</td>
</tr>
<tr>
<td>- Carousel Item Expression</td>
<td>Use a script to create items for selection in your carousel. The script should return an array containing one or more items. See the example carousel item expression below.</td>
</tr>
<tr>
<td>- No records response message</td>
<td>Message indicating that no records were found. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Node Conditions</td>
<td>Options for controlling the display of the node to the end user.</td>
</tr>
<tr>
<td>- Conditionally show this node if</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this node in the conversation. The condition must evaluate to true.</td>
</tr>
<tr>
<td>- Allow user to skip this node if</td>
<td>A no-code condition statement or low-code script that specifies a condition for letting end users skip this node in the conversation.</td>
</tr>
</tbody>
</table>
Example carousel item expression

```javascript
var options = [];
    options.push(
    {
        'Name': 'Item 1,
        'Value': 'item_1',
        'Description': 'Acme keyboard model 200',
        'Body': 'https://images.pexels.com/photos/688666/pexels-photo-688666.jpeg'
    });
    options.push(
        {
        'Name': 'Item 2,
        'Value': 'item_2',
        'Description': 'Acme keyboard model 300'
        'Body': 'https://images.pexels.com/photos/916472/pexels-photo-916472.jpeg'
    });
    return options;
```

Script in the Carousel Item Expression property defines and returns an array containing the items that appear in your carousel. The elements of this array must contain Name, Value, and Body keys. In the example, the script creates an array called options and adds two elements, each with the required keys. The images here are hard-coded as an example.

Example code key

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the carousel item. This name is shown below the image on the carousel.</td>
</tr>
<tr>
<td>Value</td>
<td>Value for the item. When a user selects a carousel item, this value is stored in the variable named in the Variable name property.</td>
</tr>
<tr>
<td>Description</td>
<td>Text string that describes the carousel item. The description is shown below the image name. A carousel with more than three items displays left and right arrows for scrolling through the images and a Select button under each item. If a description is over 140 characters, users can expand the content.</td>
</tr>
<tr>
<td>Body</td>
<td>Image used in the carousel item. The value is a URL for an image file.</td>
</tr>
</tbody>
</table>
Virtual Agent Designer bot responses

Virtual Agent Designer offers various controls for displaying bot responses in a conversation. Because the bot responses occur in third-party platforms, the format for each output may vary.

Text bot response control

Use the Text bot response control in a Virtual Agent topic to display a bot response as text. You can format the Text bot responses using the text editor controls. For example, you can bold or italicize the text, as well as include links, bulleted lists, and emojis.
Example Text bot response control

<table>
<thead>
<tr>
<th>Response properties</th>
<th>Text bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Response Properties</strong></td>
<td><strong>Web UI Text bot response output</strong></td>
</tr>
<tr>
<td>Text Response Basic Info</td>
<td>We could not find any assets currently assigned to you. Please call 1-800-Helpdesk. Or you can try these steps:</td>
</tr>
<tr>
<td>* Name ①</td>
<td>• Check if the printer has paper</td>
</tr>
<tr>
<td>Text Output</td>
<td>• Check if you have the latest driver here</td>
</tr>
<tr>
<td>Make it secure ①</td>
<td><a href="http://www.company.com/check-driver">www.company.com/check-driver</a></td>
</tr>
<tr>
<td>* Response Message ①</td>
<td><strong>Slack Text bot response output</strong></td>
</tr>
<tr>
<td>We could not find any assets currently assigned to you. Please call 1-800-Helpdesk. Or you can try these steps:</td>
<td>Now Virtual Agent ②⑤⑥ 10:42 AM</td>
</tr>
<tr>
<td>• Check if the printer has paper</td>
<td>We could not find any assets currently assigned to you. Please call 1-800-Helpdesk. Or you can try these steps:</td>
</tr>
<tr>
<td>• Check if you have the latest driver here</td>
<td>• Check if the printer has paper</td>
</tr>
<tr>
<td><a href="http://www.company.com/check-driver">www.company.com/check-driver</a></td>
<td>• Check if you have the latest driver here: <a href="http://www.company.com/check-driver">www.company.com/check-driver</a></td>
</tr>
<tr>
<td>Node Conditions</td>
<td><strong>Microsoft Teams Text bot response output</strong></td>
</tr>
<tr>
<td>By default, this node will be shown in the conversation.</td>
<td>Now Virtual Agent ② 10:52 PM</td>
</tr>
<tr>
<td>Conditionally show this node if:</td>
<td>We could not find any assets currently assigned to you. Please call 1-800-Helpdesk. Or you can try these steps:</td>
</tr>
<tr>
<td>① Condition ② Script</td>
<td>• Check if the printer has paper</td>
</tr>
<tr>
<td>③ Add Condition</td>
<td>• Check if you have the latest driver here: <a href="http://www.company.com/check-driver">www.company.com/check-driver</a></td>
</tr>
<tr>
<td>④ Check if the printer has paper</td>
<td></td>
</tr>
<tr>
<td>⑤ Check if you have the latest driver here: <a href="http://www.company.com/check-driver">www.company.com/check-driver</a></td>
<td></td>
</tr>
<tr>
<td>⑥ Click here for more help</td>
<td>① Check if the printer has paper</td>
</tr>
<tr>
<td>② Check if you have the latest driver here</td>
<td></td>
</tr>
<tr>
<td>③ Click here for more help</td>
<td></td>
</tr>
</tbody>
</table>
## Text bot response properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Identifies the Text bot response node in the topic flow.</td>
</tr>
<tr>
<td>Make it secure</td>
<td>Makes the Text bot response encrypted. When selected, the response is masked and appears as a series of dots in the chat window.</td>
</tr>
<tr>
<td>Response message</td>
<td>The Text bot response to the user. The response can be a:</td>
</tr>
<tr>
<td></td>
<td>• Text message.</td>
</tr>
<tr>
<td></td>
<td>• Script, which can include Glide record variables or script variables.</td>
</tr>
<tr>
<td>Note</td>
<td>The script can also include a temporary password for the end user.</td>
</tr>
</tbody>
</table>

You can format the text messages using the text editor controls. For example, you can use the icons on the Response Message field to bold or italicize the text, as well as include links, bulleted lists, and emojis.
Property | Description
--- | ---
* Response Message |
Hello!

B I ☺ ☻

You can also include an input variable, such as a temporary password, in the response message.

To include a link, click the link icon 🌐. The Confirmation window appears.

Enter the text that identifies the link and enter the URL. Then select Add link.

| Node Conditions | Options for controlling the display of the node in the conversation. The display is controlled by using a condition builder or script that specifies the condition.

**Example Text bot response script**

In this example, the script returns a string that greets the user. The `gs.getUser().getFirstName()` property is used to append the first name of the current user.

```javascript
(function execute() {
    return 'Hello ' + gs.getUser().getFirstName();
})();
```
In this example, the script returns links to three instances in the response. Use Markdown to include multiple links in the script.

```javascript
(function execute() {
    var output = 'Hello
    output += '\n- [Instance 1](http://instance1.com)';
    output += '\n- [Instance 2](http://instance2.com)';
    output += '\n- [Instance 3](http://instance3.com)';
    return output;
})() 
```

**Image Output bot response control**

Use the Image Output bot response control in a Virtual Agent topic to upload and display an image from a URL link. The image aspect ratio determines how the image is sized in the bot chat bubble.

**Example Image Output bot response control**

<table>
<thead>
<tr>
<th>Response properties</th>
<th>Image Output bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Properties</td>
<td></td>
</tr>
<tr>
<td>Image Basic Info</td>
<td></td>
</tr>
<tr>
<td>* Name  ☑</td>
<td></td>
</tr>
<tr>
<td>Test image</td>
<td></td>
</tr>
<tr>
<td>* Image URL Link   ☑</td>
<td></td>
</tr>
<tr>
<td><img src="http://example.com" alt="Image URL Link" /></td>
<td><img src="http://example.com" alt="Image URL Link" /></td>
</tr>
<tr>
<td><img src="http://example.com" alt="Upload Image" /></td>
<td><img src="http://example.com" alt="Upload Image" /></td>
</tr>
<tr>
<td><img src="http://example.com" alt="Image Alt Text" /></td>
<td><img src="http://example.com" alt="Image Alt Text" /></td>
</tr>
<tr>
<td>Node Conditions</td>
<td></td>
</tr>
<tr>
<td>By default, this node will be shown in the conversation.</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td></td>
</tr>
<tr>
<td><img src="http://example.com" alt="Add Condition" /></td>
<td><img src="http://example.com" alt="Add Condition" /></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Image Output bot response control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required. The name that identifies the Image Output bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Upload image</td>
<td></td>
</tr>
</tbody>
</table>
| Image URL Link   | The URL link to an image file you want to include in the conversation. You can:  
                     - Specify the image URL, using the text field, data pill, or script. 
                     or                                                                               |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Click <strong>Upload Image</strong> and select the image you want to upload and display.</td>
</tr>
<tr>
<td></td>
<td>The selected image is uploaded to the server and is stored in the Images [sys_db_image] table and in the update sets. Having the image stored in the Images table and the update sets, lets you use the image in a production or non-production instance, as needed.</td>
</tr>
<tr>
<td></td>
<td>After the image is uploaded, the URL link is included in the <strong>Response Properties</strong> sheet.</td>
</tr>
<tr>
<td></td>
<td>Click the link to see the image.</td>
</tr>
<tr>
<td></td>
<td>The URL is generated dynamically. The name of the instance is inserted at the front of the URL path.</td>
</tr>
<tr>
<td></td>
<td>If needed, you can change or delete the link to the image. If you delete the link on this property sheet, only the reference to the URL is deleted. The image remains on the server for future use.</td>
</tr>
<tr>
<td>Image Alt text</td>
<td>(Optional) Alternative screen-readable text included for accessibility. This text is used along with the image. Enter the text using the text field, data pill, or script. For more information about using data pills or scripts, see <a href="#">Virtual Agent controls</a>.</td>
</tr>
<tr>
<td>Node Conditions</td>
<td>A script that specifies a condition for presenting this image in the conversation. The condition must return a value of true to display the image.</td>
</tr>
</tbody>
</table>

Third-party messaging applications might place restrictions on the maximum size of an image displayed within a conversation. For details on the maximum image size allowed, check the documentation for the messaging application. For example, Microsoft Teams support a maximum image size of 1024 x 1024.
pixels and 1-MB file size for PNG, JPEG, and GIF files. For more information, see the Microsoft Teams Developer documentation on conversations.

Images might not fully render and may appear cropped in some Microsoft Teams bot conversations. The user has to scroll up and down in the messaging window to view the image.

**Link bot response control**

Use the Link bot response control in a Virtual Agent topic to present a bot response that contains a header prompt with either a single URL link to an item or multiple URL links for up to three items. For example, you can provide a single link to a website page or to a particular record, such as an incident. Or you can provide multiple links to different items, such as search results.

**Note:** If you are using the link bot response control for Virtual Agent conversations on Now mobile apps, web links open in the mobile browser. If you want links to open in a native mobile screen within the mobile app, create deep links for items in your conversation topics. For details on deep linking in mobile apps, see the MobileDeepLinkGenerator - Global API.
### Example single link bot response control

#### Single link bot response properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the Link bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Link List</td>
<td>Type of links returned in the output result:</td>
</tr>
<tr>
<td></td>
<td>• Single Link: Returns one item in the output results.</td>
</tr>
<tr>
<td></td>
<td>• Multiple Links: Returns up to three items in the output results.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Single Link</strong>.</td>
</tr>
<tr>
<td>Header</td>
<td>Message displayed above the URL link. Can be a string with variables or a script.</td>
</tr>
</tbody>
</table>

#### Link bot response output

**Web UI Link bot response output**

- ![Show Logs](#)
- ![Now Support](#)
- ![Just Now](#)

**Slack Link bot response output**

- ![Virtual Agent](#)
  - ![Here is a link](#)
  - ![Click Here](#)

**Microsoft Teams Link bot response output**

- ![Now Virtual Agent](#)
  - ![10:48 AM](#)
  - ![Here is a link](#)
  - ![Click here](#)

**Workplace Link bot response output**

- ![Here is a link](#)
  - ![Click Here](#)
### Single link properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Text that identifies a single link in the bot bubble. Can be a string with variables or a script.</td>
</tr>
<tr>
<td>Link</td>
<td>Link to a single item, such as a website page or a particular record. Can be a string with variables or a script that returns a valid URL as a string. For example, you can enter the complete URL, such as <a href="https://servicenow.com">https://servicenow.com</a>.</td>
</tr>
<tr>
<td>Condition</td>
<td>A condition created with the condition builder or a script that specifies a condition for displaying the link.</td>
</tr>
</tbody>
</table>

### Multi-link bot response control properties

<table>
<thead>
<tr>
<th>Multi-link bot response properties</th>
<th>Link bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Multi-link bot response properties" /></td>
<td><img src="image" alt="Link bot response output" /></td>
</tr>
</tbody>
</table>

**Note:** Multi-link bot output is also supported in Microsoft Teams, Slack, Workplace, and Facebook Messenger.
### Multi-link properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the Link bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Link List</td>
<td>Type of links returned in the output result:</td>
</tr>
<tr>
<td></td>
<td>• Single Link: Returns one item in the output results.</td>
</tr>
<tr>
<td></td>
<td>• Multiple Links: Returns up to three items in the output results.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Multiple Links</strong>.</td>
</tr>
<tr>
<td>Header Message</td>
<td>Text prompt displayed above the list of links. Can be a string with variables or a script.</td>
</tr>
<tr>
<td>URL List Value</td>
<td>Script that creates a list of links to display, which includes the following parameters: link URL, link display label, link description, and link context.</td>
</tr>
<tr>
<td>Condition</td>
<td>A condition created with the condition builder or a script that specifies a condition for displaying the links.</td>
</tr>
</tbody>
</table>

### HTML bot response control

Use the HTML bot response control to display static HTML text in the Virtual Agent bot response.

> **Note:** If you created conversations in earlier releases that use this bot response control to generate card layouts, consider updating your conversations to use the Card bot response control. The Card displays information from a record in your instance and contains a link to that related record.

### Security considerations for HTML markup

For security reasons, an HTML sanitizer script runs automatically and checks all HTML markup used in the instance, including Virtual Agent conversations. The sanitizer script removes elements or attributes that might enable cross-site scripting attacks. You can edit the HTML sanitizer script to change the list of markup items to be preserved or removed. For details, see [HTML sanitizer](#) and [Configure HTML sanitizer](#) for examples on adding markup items to the exclusion or inclusion lists.

To disable the HTML sanitizer script only for Virtual Agent conversations, add the `com.glide.cs.html.sanitizer.enabled` system property and set the value to false. For details on creating a system property, see [Add a system property](#).
Example HTML bot response output

The HTML bot response shows a static HTML as a chat response. This example includes an image, headings, and paragraph text. The web UI presents this content as HTML. The Slack, Microsoft Teams, and Workplace user interfaces display the same content as a PNG image. URL links within the HTML are extracted and displayed below the image. The URL can be either an absolute or a relative link. If you use a relative link, it must be relative to the ServiceNow instance.

<table>
<thead>
<tr>
<th>HTML bot response properties</th>
<th>HTML bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Properties</td>
<td>Web UI HTML output</td>
</tr>
<tr>
<td>Html Basic Info</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>HTML Use Case</td>
<td></td>
</tr>
<tr>
<td>HTML Message</td>
<td></td>
</tr>
<tr>
<td>&lt;html&gt; &lt;body&gt; &lt;center&gt;&lt;h1&gt;Welcome&lt;/h1&gt;</td>
<td></td>
</tr>
<tr>
<td>Height (Pixel)</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Width (Pixel)</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Node Conditions</td>
<td>Slack HTML output</td>
</tr>
<tr>
<td>By default, this node will be shown in the conversation.</td>
<td></td>
</tr>
<tr>
<td>Conditionally show this node if:</td>
<td>(43 kB)</td>
</tr>
<tr>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td></td>
</tr>
<tr>
<td>+ Add Condition</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### HTML bot response properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the HTML bot response control node in the topic flow.</td>
</tr>
<tr>
<td>HTML Message</td>
<td>HTML output to be displayed. Click the Script icon to open the HTML editor and enter the HTML text.</td>
</tr>
<tr>
<td>Height (Pixel)</td>
<td>Maximum height of the area for displaying HTML output in third-party messaging applications.</td>
</tr>
<tr>
<td>Width (Pixel)</td>
<td>Maximum width of the bot bubble for displaying HTML output in third-party messaging applications.</td>
</tr>
<tr>
<td>Node Conditions</td>
<td>Expression logic to control how or when the control runs in the conversation flow:</td>
</tr>
</tbody>
</table>

### HTML bot response output

#### Microsoft Teams HTML output

```
Welcome to Company Chat
Legal Disclaimer:
Cras a est vitae odio bibendum vestibulum. Nulla non ligula id velit tincidunt sed leo. Morbi elit tortor, gravida a efficitur vitae, posuereque sodiis.
```

#### Workplace HTML output

```
Welcome to Company Chat
Legal Disclaimer:
Cras a est vitae odio bibendum vestibulum. Nulla non ligula id velit tincidunt sed leo. Morbi elit tortor, gravida a efficitur vitae, posuereque sodiis.
```

### HTML bot response control properties
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Condition</strong>: Add or edit conditions using the no-code condition builder.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Script</strong>: Enter a low-code script that contains a condition statement.</td>
<td></td>
</tr>
</tbody>
</table>

> Note: As shown in the examples, HTML output can vary in third-party messaging applications. Determine an appropriate **Height** and **Width** area by setting initial height and width values, previewing the HTML output in the messaging applications you intend to use, and then adjusting the height and width values.

**Multi-flow Output bot response control**

Use the Multi-flow Output bot response control in a Virtual Agent topic to sequentially display two or more outputs (text, image, link, or HTML). Users can move from one output to the next through a provided navigation button.

**Example Multi-flow Output bot response control**

<table>
<thead>
<tr>
<th>Output properties</th>
<th>Multi-flow Output bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Response Properties" /></td>
<td><img src="image" alt="Web UI Multi-flow Output bot response output" /></td>
</tr>
<tr>
<td><img src="image" alt="Response Messages" /></td>
<td><img src="image" alt="Slack Multi-flow Output bot response output" /></td>
</tr>
</tbody>
</table>
Output properties | Multi-flow Output bot response output
--- | ---
Microsoft Teams Multi-flow Output bot response output

Workplace Multi-flow Output bot response output

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies this Multi-flow Output bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for presenting this output in the conversation. The condition must return a value of true to display the output.</td>
</tr>
<tr>
<td>Response messages</td>
<td></td>
</tr>
<tr>
<td>Navigation Label</td>
<td>The label for the button displayed below the output. The button enables the user to move to the next output in the flow.</td>
</tr>
<tr>
<td>Add a response</td>
<td>For each output type, click + Add a Response to specify the output and define the output properties.</td>
</tr>
</tbody>
</table>
1. In the Add a Response dialog box, select the **Type**, and specify the associated values:
   - **Text** — Enter the text to be displayed in the response.
   - **Image** — Enter the **Header**, **Prompt** (label for the link), and the URL link to the image.
   - **Link** — Enter the **Header**, **Prompt** (label for the link), and the URL link.
   - **HTML** — Enter the **Height** and **Width**, in pixels, to set the dimensions of the HTML block. In the HTML editor, enter the HTML markup to be displayed.

2. Click **Save**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1.</strong> In the Add a Response dialog box, select the <strong>Type</strong>, and specify the associated values:</td>
<td></td>
</tr>
<tr>
<td>• <strong>Text</strong> — Enter the text to be displayed in the response.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Image</strong> — Enter the <strong>Header</strong>, <strong>Prompt</strong> (label for the link), and the URL link to the image.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Link</strong> — Enter the <strong>Header</strong>, <strong>Prompt</strong> (label for the link), and the URL link.</td>
<td></td>
</tr>
<tr>
<td>• <strong>HTML</strong> — Enter the <strong>Height</strong> and <strong>Width</strong>, in pixels, to set the dimensions of the HTML block. In the HTML editor, enter the HTML markup to be displayed.</td>
<td></td>
</tr>
</tbody>
</table>

**Node Conditions**

<table>
<thead>
<tr>
<th>Node Conditions</th>
<th>Expression logic to control how or when the control runs in the conversation flow:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Condition</strong>: Add or edit conditions using the no-code condition builder.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Script</strong>: Enter a low-code script that contains a condition statement.</td>
<td></td>
</tr>
</tbody>
</table>

**Script Output bot response control**

Use Script Output bot response control in a Virtual Agent topic to run a script that returns a single response or a multi-part response.

**Example Script Output bot response control**

Use the Script Output bot response control when creating a more complex response that relies on scripted calculations or requires a multi-part response. Scripted output can include text, image, cards, links, and HTML to create a versatile response.
### Script Output properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Script Output bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Script Output Type</td>
<td>The type of output returned by the script, for example, single-part or multi-part.</td>
</tr>
<tr>
<td>Script Response Message</td>
<td>The script that generates the selected output type, for example, single or multi-part.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for presenting this output in the conversation. The condition must return a value of true to display the output.</td>
</tr>
</tbody>
</table>
Example script

In this example, the script calculates the time two hours from the current time and outputs a multi-part message that includes this information.

```javascript
(function execute() {
    var gdt = new GlideDateTime();
    var gt = new GlideTime();
    gdt.addSeconds(7200);
    gt = gdt.getTime();
    var multiOutMsg = new sn_cs.MultiPartOutMsg();
    multiOutMsg.addPlainTextPart('Thank you for submitting an incident.' +
    gt.getByFormat('HH:mm'));
    return multiOutMsg;
})()
```

Card bot response control

Use the Card bot response control in a Virtual Agent topic to upload and display selected information from a record on your instance. For example, the information displayed can be an incident, or an image (large or small) with a description. The Card bot response control can also be used to include rich content (such as a video) that the user can see during the conversation.

⚠️ Note: If you created conversations in the London release that use the HTML bot response control to generate card layouts, consider updating your conversations to use the Card bot response control. The Card displays information from a record in your instance and contains a link to that related record. Or, it can display images (large or small) and can include rich content such as a video.

Example Card bot response output for records

The Card response shows content from a record in a compact format, which is designed for readability within the chat window. The record content includes the display field for the table at the top of the card, followed by any other fields specified by the properties of the bot response.
The list template in the card layout for Facebook apps no longer supports vertical list templates. The card layout uses a horizontal scrollable carousel template effective August 15, 2019. Cards also feature a button template.

Example Card bot response for large image
The Card response layout for images may vary across channels.
<table>
<thead>
<tr>
<th>Response Properties</th>
<th>Card output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Response Properties</strong></td>
<td><strong>Card output</strong></td>
</tr>
<tr>
<td><strong>Card Basic Info</strong></td>
<td><strong>Web UI image card output</strong></td>
</tr>
<tr>
<td>★ Name</td>
<td>Don’t forget we are going back to the office soon!</td>
</tr>
<tr>
<td></td>
<td>Your scheduled return to work Oct 7</td>
</tr>
<tr>
<td>★ Card type</td>
<td>Large image with text</td>
</tr>
<tr>
<td>To view supported channels, open Large image with text</td>
<td></td>
</tr>
</tbody>
</table>
| **Template** | ![Web UI image card output](image)

Illustrative card layout. May vary across channels based on template definitions.

Map data to fields on the card

★ 1. Title
Don’t forget we are going back to the office soon!

2. Description
You’re scheduled to work Oct 7

★ 3. Image URL Link
www.servicenow.com

Upload Image

4. Image alt text

Node Conditions

By default, this node will be shown in the conversation.
Conditionally show this node:
- Condition
- Script
- Add Condition

**Example Card bot response for small image**

The Card response layout for images may vary across channels.
Response properties

Card output

Web UI image card output

Illustrative card layout. May vary across channels based on template definitions.

Map data to fields on the card

1. Title
   Don't forget we are going back to the office soon.

2. Description
   You're scheduled to return to work October 7.

3. Image URL Link
   www.servicenow.com

4. Image alt text

Node Conditions

By default, this node will be shown in the conversation.

Conditionally show this node if:

- Condition
- Script

Add Condition
Example Card bot response with video content

The way the Card bot response displays videos may vary across channels. For example, the display you see in Slack messages may be different from what you see on Microsoft Teams or Workplace from Facebook. Also, if an embedded player is supported on that channel, the player is included in the display. For more information about channels, see the documentation for the channel you're using.
Response properties

Card Basic Info

- Name
  card test

- Card type
  Youtube Video Card

To view supported channels, open Youtube Video Card

Template

Illustrative card layout. May vary across channels based on template definitions.

Map data to fields on the card

- 1. Title
- 2. Description
- 3. Youtube Video ID

Node Conditions

By default, this node will be shown in the conversation.

Conditionally show this node if:

- Condition
- Script
- Add Condition

Card bot response output with video on the Web client

NOW VIRTUAL AGENT

Check out our new Christmas campaign

Ready for work to work better? Our digital workflows are here to bring simplicity to your complexity and transform how work gets done across your enterprise.

Type your message

© 2021 ServiceNow, Inc. All rights reserved.
Card bot response control properties

A card can contain record information, an image (large or small), or a YouTube video.

- **Record** - Displays content from a single record on your instance. This record can be referenced from variables in the flow or queried using a script that returns a single Glide record from a selected table.
- **Image (large or small)** - Displays a large or small image that you provide, along with a title and description. The property sheet provides a pre-configured template for the card layout, to specify the title, description, and the image source.
- **YouTube Video** - Displays the following in the chat window:
  - Inline video player (if supported on the specific channel)
  - Title
  - Link to any relevant content
  - Description

Use the pre-configured card layout template in the property sheet to specify the title, link, description, and the YouTube video ID.

As of the Rome release, only YouTube videos are supported.

⚠️ **Note:** You can use the Video bot response control to include YouTube videos in conversations. The Video bot response control includes a navigation button that pauses the conversation. If you want the user the watch the video before continuing with the conversation, use this navigation button. When users have finished watching the video, they can click this navigation button to continue with the conversation.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the Card bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Card type</td>
<td>Type of card. Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Record</td>
</tr>
<tr>
<td></td>
<td>• Large image with text</td>
</tr>
<tr>
<td></td>
<td>• Small image with text</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• YouTube video adapter card</td>
<td><strong>Note:</strong> As of the Rome release, only YouTube video adapter cards are supported.</td>
</tr>
<tr>
<td>Record</td>
<td>Reference to a specific record. Data for the card comes from a record referenced in a variable from another node in the flow. For example, the reference could be a Choice List or Glide Action.</td>
</tr>
<tr>
<td></td>
<td>1. Select a variable from the current flow that contains a record object.</td>
</tr>
<tr>
<td></td>
<td>2. Select the <strong>fields</strong> to be displayed in the card.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that references a single Glide record that contains the data shown in the card. Then enter the condition or script that returns the record.</td>
</tr>
<tr>
<td>Filter this table by using</td>
<td>Option for filtering the data in the table that contains the record:</td>
</tr>
<tr>
<td></td>
<td>• Condition: Condition statement that returns the table record.</td>
</tr>
<tr>
<td></td>
<td>• Script: Glide record query that returns the glide record.</td>
</tr>
<tr>
<td>fields</td>
<td>Fields from the ServiceNow record to be displayed in the card. Click <strong>Add Field</strong> to specify each field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you're using Workplace, a maximum of four fields is rendered on the card. If you have more than four fields, the remaining fields are displayed on a subsequent card (up to four fields per card).</td>
</tr>
<tr>
<td>Large image with text or Small image with text</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>A visual representation that shows the image card layout. Each area of the template is numbered.</td>
</tr>
<tr>
<td>Map data to fields on the card</td>
<td>Fields that correspond to the numbers shown on the template:</td>
</tr>
<tr>
<td></td>
<td>1. Title: Name or label for the card</td>
</tr>
<tr>
<td></td>
<td>2. Description: Explanation of the image</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3.</td>
<td>Image URL link: URL for the image displayed in the card</td>
</tr>
</tbody>
</table>

Upload image (small or large)

<table>
<thead>
<tr>
<th>Image URL Link</th>
<th>The URL link to an image file you want to include in the conversation. You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Specify the image URL (using the text field, data pill, or script).</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Upload Image</strong> and select the image you want to upload and display.</td>
</tr>
<tr>
<td></td>
<td>The selected image is uploaded to the server, and is stored in the images table [sys_db_image] and in the update sets.</td>
</tr>
<tr>
<td></td>
<td>Having the image stored in the image table and the update sets, lets you use the image in a production or non-production instance, as needed.</td>
</tr>
<tr>
<td></td>
<td>After the image is uploaded, the URL link is included in the Response Properties sheet.</td>
</tr>
</tbody>
</table>

- Click the link to see the image.                                                                                                                                                                           |

The URL is generated dynamically. The name of the instance is inserted at the front of the URL path.                                                                                                        |

If needed, you can change or delete the link to the image. If you delete the link on this property sheet, only the reference to the URL is deleted. The image remains on the server for future use.                  |

<table>
<thead>
<tr>
<th>Image Alt text</th>
<th>(Optional) Alternative screen-readable text Included for accessibility. This text is used along with the image. Enter the</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>YouTube Video card</td>
<td>A visual representation of the layout of the video included in the card.</td>
</tr>
</tbody>
</table>

**Map data to fields on the card**

Fields include:
- Title: Title of the card.
- Title link: (Optional) URL to any relevant content.
- Description: Description the card, such as the topic the video addresses.
- YouTube video identifier: Unique identifier for the video used in the card. This identifier is the string following the equal sign (=) at the end of the video's URL path.
  For example, in the path shown below, the video identifier is `FVgtjdEOa5M`.

https://www.youtube.com/watch?v=FVgtjdEOa5M

**Node Conditions**

**Conditionally show this node if**

A condition for presenting this card in the conversation:
- Condition: Specify a no-code condition statement using the condition builder
- Script: Enter a low-code script that specifies a condition

The condition must return a value of true to display the card.

**Example Glide record query**

```javascript
(function execute(table) {
  /* Write a glide record query, and return the glide record.
   For example:
   
   var now_GR = new GlideRecord(table);
   gr.addEncodedQuery('active=true^number=INC0010099');
   gr.query();
   if(gr.next()) {
     return gr;
   }
```

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
In this example, the script creates a GlideRecord object, populates this object using a query that should return a single result, then returns the object. The `Table` property defines the table used in this query.

**Table bot response control**

Use the Table bot response control in a Virtual Agent topic to display a bot response as a table.

Table bot responses enable users to see information in a more organized way. For example, you can organize and display information such as:

- Planned service changes
- Company holidays
- Contact information
- Testing sites

The tables in the Table bot response output can:

- Have between one and four columns
- Include optional column headers
- Be populated using the condition builder or using scripts

**Example Table bot response output**

In this example, the topic author uses the Table bot response to display the annual company holidays in table format.
<table>
<thead>
<tr>
<th>Response properties</th>
<th>Table bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Response Properties</strong></td>
<td><strong>Table bot response output</strong></td>
</tr>
<tr>
<td><strong>Table Basic Info</strong></td>
<td><strong>Web UI Table bot response output</strong></td>
</tr>
<tr>
<td>* Name</td>
<td><img src="image" alt="2020 Company Holidays" /></td>
</tr>
<tr>
<td>Node Name</td>
<td>Holiday</td>
</tr>
<tr>
<td>New Year's Day</td>
<td>Jan 1</td>
</tr>
<tr>
<td>President's Day</td>
<td>Feb 17</td>
</tr>
<tr>
<td>Memorial Day</td>
<td>May 25</td>
</tr>
<tr>
<td>Independence Day</td>
<td>Jul 4</td>
</tr>
<tr>
<td>Labor Day</td>
<td>Sep 5-7</td>
</tr>
<tr>
<td>Thanksgiving</td>
<td>Nov 26-27</td>
</tr>
<tr>
<td>Christmas</td>
<td>Dec 24-28</td>
</tr>
<tr>
<td><strong>Display Column Headers</strong></td>
<td><strong>Table bot response output in ServiceNow mobile</strong></td>
</tr>
<tr>
<td>![ ]</td>
<td><img src="image" alt="Here are the 2021 company holidays." /></td>
</tr>
<tr>
<td>![ ]</td>
<td>Holiday</td>
</tr>
<tr>
<td>New Year's Day</td>
<td>Jan 1</td>
</tr>
<tr>
<td>Martin Luther King, Jr. Day</td>
<td>Jan 18</td>
</tr>
<tr>
<td>Presidents' Day</td>
<td>Feb 15</td>
</tr>
<tr>
<td>Memorial Day</td>
<td>May 31</td>
</tr>
<tr>
<td>Independence Day</td>
<td>Jul 5</td>
</tr>
<tr>
<td>Labor Day</td>
<td>Sep 6</td>
</tr>
<tr>
<td><strong>Table bot response output in Slack</strong></td>
<td><img src="image" alt="Table bot response output in Slack" /></td>
</tr>
<tr>
<td>Holiday</td>
<td>Date</td>
</tr>
<tr>
<td>New Year's Day</td>
<td>Fri, Jan 1</td>
</tr>
<tr>
<td>President's Day</td>
<td>Mon, Jan 18</td>
</tr>
<tr>
<td>Memorial Day</td>
<td>Fri, May 31</td>
</tr>
<tr>
<td>Independence Day</td>
<td>Fri, Jul 5</td>
</tr>
<tr>
<td>Labor Day</td>
<td>Mon, Sep 6</td>
</tr>
<tr>
<td><strong>Table bot response output in Slack</strong></td>
<td><img src="image" alt="Table bot response output in Slack" /></td>
</tr>
<tr>
<td>Holiday</td>
<td>Date</td>
</tr>
<tr>
<td>New Year's Day</td>
<td>Fri, Jan 1</td>
</tr>
<tr>
<td>President's Day</td>
<td>Mon, Jan 18</td>
</tr>
<tr>
<td>Memorial Day</td>
<td>Fri, May 31</td>
</tr>
<tr>
<td>Independence Day</td>
<td>Fri, Jul 5</td>
</tr>
<tr>
<td>Labor Day</td>
<td>Mon, Sep 6</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the Table bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Header</td>
<td>Header (title) for the table when it's displayed in the response output. The header can be a text string, variables, or a script.</td>
</tr>
<tr>
<td>Display Column Headers</td>
<td>Option that enables the display of column headings.</td>
</tr>
</tbody>
</table>
### Table bot response properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Populate this table by</td>
<td>Options for populating the table:</td>
</tr>
<tr>
<td></td>
<td>• Table - Select the ServiceNow table that contains the data to be displayed. You'll specify a table filter and select the data to be displayed in the column.</td>
</tr>
<tr>
<td></td>
<td>• Script - Enter the <strong>Table row expression</strong> that describes the table rows and the <strong>No records response message</strong> displayed if no records are discovered.</td>
</tr>
<tr>
<td>Filter this table by using</td>
<td>Options for filtering the contents of the table.</td>
</tr>
<tr>
<td>(Applies only if using <strong>Table</strong> as the population option)</td>
<td>• Condition - Specify a no-code condition statement using the condition builder</td>
</tr>
<tr>
<td></td>
<td>• Script - Enter a low-code script that specifies a condition</td>
</tr>
<tr>
<td>Columns (left to right)</td>
<td>Columns in the table to be displayed in the conversation. For each column (up to 4 columns):</td>
</tr>
<tr>
<td>(Applies only if using <strong>Table</strong> as the population option)</td>
<td>• Field - Select the field from the ServiceNow table to be displayed in the column.</td>
</tr>
<tr>
<td></td>
<td>• Display name - Reflects the field name selected. You can use the default field name or change the field name.</td>
</tr>
<tr>
<td>No records response message</td>
<td>Message displayed if no records are found.</td>
</tr>
<tr>
<td>Node Conditions</td>
<td></td>
</tr>
<tr>
<td>Conditionally show this node if</td>
<td>A condition that controls the display of the table in the conversation:</td>
</tr>
<tr>
<td></td>
<td>• Condition - Specify a no-code condition statement using the condition builder</td>
</tr>
<tr>
<td></td>
<td>• Script - Enter a low-code script that specifies a condition</td>
</tr>
<tr>
<td></td>
<td>The condition must return a value of true to display the table.</td>
</tr>
</tbody>
</table>

### Video bot response control

Use the Video bot response control in a Virtual Agent topic to include a video in the conversation.
As of the Rome release, topic authors can use the Video bot response control to create a response that includes a video in conversations with the user.

The Video bot response control includes a navigation button, which gives users time to watch the video. If you want the user to watch the video before continuing with the conversation, use this navigation button.

When users have finished watching the video, they can click this navigation button to continue with the conversation.

⚠️ **Note:** Topic authors can also use the Card bot response control to include a video in conversations. However, the Card bot response control doesn’t include the navigation button, which gives users time to watch the video.

### Example Video bot response control

The way the Video bot response displays videos may vary across channels.

For example, the video display you see in Slack messages may be different from what you see on Microsoft Teams or Workplace from Facebook. Also, if an embedded player is supported on that channel, the player is included in the display. For more information about channels, see the documentation for the channel you're using.
Video bot response output on the Web client (with the navigation button)

Video bot response output on the Web client (without the navigation button)
### Video bot response control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the video bot response control node in the topic flow.</td>
</tr>
</tbody>
</table>
| Card type | Type of card. Choose one of the following options:  
  - Record  
  - Large image with text  
  - Small image with text  
  - Youtube Video adapter card  
  
  **Note:** As of the Rome release, only Youtube video adapter cards are supported. |
| Template | A visual representation that shows the layout of the video included in the response output. |
| Map data to fields on the card | Fields include:  
  - Title: Title of the card.  
  - Title link: (Optional) URL to any relevant content.  
  - Description: Description the card, such as the topic the video addresses.  
  - YouTube video identifier: Unique identifier for the video used in the card. This identifier is the string following the equal sign (=) at the end of the video's URL path. For example, in the path shown below, the video identifier is FVgtjdEOa5M. |
| Additional Info | Navigation button used to continue with the conversation.  
  By default, the button is labeled **Got it** but you can overwrite it to something else (for example, **Continue**).  
  Users click this navigation button in the chat window to continue with the conversation. |

---

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.  
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditionally show this</td>
<td>A condition for presenting this card in the conversation:</td>
</tr>
<tr>
<td>node if</td>
<td>• Condition: Specify a no-code condition statement using the condition builder</td>
</tr>
<tr>
<td></td>
<td>• Script: Enter a low-code script that specifies a condition</td>
</tr>
<tr>
<td></td>
<td>The condition must return a value of true to display the card.</td>
</tr>
</tbody>
</table>

**Virtual Agent Designer utilities**

You can control interactions within a topic by using utilities in Virtual Agent Designer that perform various actions such as adding topic blocks (reusable components), running a script, or adding different conversation paths (branches) in a topic. Utilities are represented as nodes in a conversation flow but do not display anything to the user.

**Lookup utility**

Use the Lookup utility in a Virtual Agent topic to return a ServiceNow record query.
Example Lookup utility

Prompt Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Lookup utility node in the topic flow.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>The variable that stores the record returned by the script.</td>
</tr>
<tr>
<td>Condition</td>
<td>A query condition or script that specifies a condition for presenting the prompt in the conversation. The condition must evaluate to true so that the node is displayed during the conversation. By default the condition is set to true.</td>
</tr>
</tbody>
</table>

Reference Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table used for the query.</td>
</tr>
</tbody>
</table>
### Property Description

**Script**
The query to retrieve the record. Use the condition builder or a script to specify a query condition.

### Example Lookup script

```javascript
(function execute(table) {
    var now_GR = new GlideRecord(table);
    gr.addEncodedQuery('active=true');
    gr.setLimit(1);
    gr.query();
    if(gr.next()) {
        return gr;
    }
})(table)
```

In this example, a table is queried for the first active record. The table to be queried is defined in the **Table** property found in the lookup utility control. The `setLimit()` method ensures that only a single record is returned from the database. If a record is found, it is returned. For more information on GlideRecord queries, see [Querying tables in script](#).

### Script Action utility

Use a Script Action in a Virtual Agent topic to run a script.

### Example Script Action utility

<table>
<thead>
<tr>
<th>Script Action Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Action Basic Info</td>
</tr>
<tr>
<td>✶ Name [1]</td>
</tr>
<tr>
<td>Script Action</td>
</tr>
<tr>
<td>✶ Action Expression [1]</td>
</tr>
<tr>
<td>(function execute()) // Script the string</td>
</tr>
<tr>
<td>Condition [1]</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Script Action utility properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Script Action node in the topic flow.</td>
</tr>
<tr>
<td>Action</td>
<td>The script that performs an action.</td>
</tr>
<tr>
<td>Expression</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for executing this script action. The</td>
</tr>
<tr>
<td></td>
<td>condition must return a value of true for the script action to execute.</td>
</tr>
</tbody>
</table>

Example script action

```javascript
(function execute() {
  var list = [];
  if (vaInputs.case_number !== "") {
    var now_GR = new GlideRecord("sn_customerservice_case");
    gr.addQuery("number", "CONTAINS", vaInputs.case_number);
    gr.addQuery("active", "true");
    gr.orderBy("number");
    gr.query();
    while (gr.hasNext()) {
      gr.next();
      list.push(gr.getUniqueValue().toString());
    }
  }
  vaVars.case_list = list;
})()
```

This example performs a search on the sn_customerservice_case table for a specific case number based on the input from another control called case_number. The script then places the results in an array and stores them in the case_list variable, which is accessible by other nodes in the same topic. Because vaVars only supports string, number, and Boolean values, the script uses toString() to store these values as strings. The code is contained in an if statement, so it only executes if the case_number variable has a value. This if statement prevents the code from running if the user has not entered a number.

For more information about writing scripts for Virtual Agent, see Virtual Agent scripts.
**Action utility**

Use the Action utility in a Virtual Agent topic to create or update a ServiceNow® record. The Action utility integrates Virtual Agent with the ServiceNow Flow Designer product and lets you enter the relevant Flow Action properties.
Example Action utility

Flow Action Properties

Flow Action Basic Info

- **Name**: Create request

- **Invoke Flow Designer object**
  - Action
  - Subflow

- **Spoke**: ITSM

- **Action**: Create Request

Open in Flow Designer for details: Create Request

Wait for response? (1)

- Run as (1)
  - User who initiates session

Input mapping

- Include a password input (1)

Description (string)

Short Description (string)

Output mapping

<table>
<thead>
<tr>
<th>Enable</th>
<th>Name</th>
<th>Variable Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Request</td>
<td>Request</td>
</tr>
<tr>
<td></td>
<td>Action Status</td>
<td>Action Status</td>
</tr>
<tr>
<td></td>
<td>Don’t Treat as Error</td>
<td>Don’t Treat as Err</td>
</tr>
</tbody>
</table>

Node Conditions

By default, this node will be used in the conversation.

Conditionally use this node if:

- Condition
- Script

Add Condition
**Action utility properties**

Specify the flow action properties for the node you want to create.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the Flow Action node.</td>
</tr>
</tbody>
</table>
| Invoke Flow Designer object | Select one of the following Flow Designer components:  
  - **Action**: A reusable operation.  
  - **Subflow**: An automated process that consists of a sequence of reusable actions, data inputs, and outputs. |
| Spoke | Name of the scoped application that contains Flow Designer content that is dedicated to a particular application or record type.  
For a list of default spokes, see Spokes. |
| Action | The Flow Designer action to be performed in the instance. The **Input mapping** and **Output mapping** areas change depending on your selection.  
For details about the action, click the link beneath your selection to view it in Flow Designer. |
| Wait for response? | Toggle switch that determines whether Virtual Agent waits for a response from the specified action before continuing. |
| Run as | Select one of the following options:  
  - **User who initiates the session**: When selected, the action runs using the same permissions that the current user has.  
  - **System User**: When selected, the action runs using system privileges, some of which may be unavailable to the current user. |
| Input mapping | Specifies the variables to be used as input to the selected action. The contents of this area change according to the action you selected. Options may include string input, referenced records, scripts, and so forth.  
For options that require a password, use the **Include a password input** toggle switch to prompt the user for a password. Input is securely masked and not viewable by others. |
### Property Table

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output mapping</td>
<td>Specifies the variables to be output by the selected action. The contents of this area change according to the action you selected.</td>
</tr>
<tr>
<td>Node Conditions</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this node in the conversation. The condition must evaluate to true.</td>
</tr>
</tbody>
</table>

#### Decision utility

Use the Decision utility in a Virtual Agent topic to add two or more branches that represent different paths in a conversation.

#### Example Decision utility node with branches

In this example, a static choice control prompts the user to select from three available colors, and the selection is stored in a variable. The Decision utility control is configured with a branch for each possible selection. Each branch contains a script in the **Condition** property that returns true when a specific color is selected. In the example, the script returns true when the choice is "Blue."
Add a Decision utility with branches

1. Drag the Decision utility onto the canvas.
   
   The Decision utility node added to the canvas has a single branch named Always by default.

2. Click the plus sign (+) under the node.
   
   A second branch named Never is added below the Decision utility node.

3. To add additional branches, click the plus sign (+).

4. For each branch, specify the branch properties: Name for the name of the branch and Condition for the condition that determines whether that branch is displayed.

Use scripts or variable conditions to set decision branches

Each branch below a Decision utility node has a condition property. You can define the condition using the condition builder or a script that returns a value of true or false. A branch that returns a value of true is followed, while a branch returning a value of false is not. When creating these scripts or conditions, ensure that only one branch in each Decision utility node evaluates to true.

Topic Block utility

Use a Topic Block in a Virtual Agent conversation to perform a specific function or subflow that runs certain steps in a calling topic.

Example Topic Block utility

<table>
<thead>
<tr>
<th>Topic Block Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>✤ Topic Block 1</td>
</tr>
<tr>
<td>Select a topic block</td>
</tr>
<tr>
<td>✤ Name 1</td>
</tr>
<tr>
<td>Node Name</td>
</tr>
</tbody>
</table>
### Topic Block utility properties (initial state)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic Block</td>
<td>A list of published topic blocks. Select a topic block to add to the calling topic.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the topic block node. The name is automatically assigned based on the topic block that you select. For example, if you choose the Acme Contextual Search topic block, the <strong>Name</strong> is Acme Contextual Search.</td>
</tr>
</tbody>
</table>

**Note:** When you select a topic block, the property sheet for the selected topic block opens. The property sheet displays the following:

- Required and optional Input Mapping variables that you need to enter. These variables are passed to the topic block.
- Output Mapping variables to be passed to the calling topic.

For details, see [Add a reusable topic block to a calling topic or topic block](#).

### Virtual Agent interaction records

Each time a Virtual Agent conversation occurs, an interaction record captures the entire conversation as a chat record type in the Interaction [interaction] table. The record maps to an entire conversation and includes all topic elements used in the conversation, as well as live agent transfers.

### Table view of Virtual Agent interactions

Each Virtual Agent (VA) conversation in an instance generates an interaction record in the Interactions [interactions] table, which logs the conversation between a requester and virtual and live agent. The interaction records include conversations that occur across the supported chat channels: web client, native mobile app, and messaging integrations.

**Note:** The Interaction table is part of the interaction management framework activated through the Interactions Management plugin (com.glide.interaction). This plugin is included with the Agent Chat (com.glide.interaction.awa) and Connect Support (com.glide.connect.support) plugins.

These Virtual Agent interaction records provide administrators, Virtual Agent administrators, support agents, and support managers with a convenient way to review what happened during a Virtual Agent conversation. The records also...
provide a quick way to see the type of conversations that occur: Virtual Agent, live agent transfers to Agent Chat, and live agent transfers to Connect Support.

### Interactions [interactions] table

![Interactions table]

#### Note:
Conversation transcripts are available only for Virtual Agent records that have Virtual Agent conversations and live agent transfers to Agent Chat.

- When a conversation transcript for live chat exceeds 4000 characters, the transcript is handled as an attachment to the interaction record.
- For Virtual Agent conversations that have live agent transfers to Connect Support, only the Virtual Agent conversation is included in the interaction transcript. Live Agent conversations in Connect Support are recorded in the activity stream.

To view the Interactions table, enter `interaction.list` in the navigation filter. You can configure the fields displayed in the table using the list collector (slushbucket).

Key fields in the Interactions table include:

### Interactions table for Virtual Agent

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number of the interaction record.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application. Scope determines the accessible files and data available to other applications.</td>
</tr>
<tr>
<td>Opened</td>
<td>Date and time that the conversation started.</td>
</tr>
<tr>
<td>Opened for</td>
<td>Name of the requester. Anonymous users are identified as Guests.</td>
</tr>
<tr>
<td>Transcript</td>
<td>Log of the conversation between the requester and agents (virtual or live).</td>
</tr>
<tr>
<td>State</td>
<td>Conversation states:</td>
</tr>
</tbody>
</table>
Interactions table for Virtual Agent (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• New: A new conversation has been created.</td>
</tr>
<tr>
<td></td>
<td>• On Hold: Conversation is on hold.</td>
</tr>
<tr>
<td></td>
<td>• In Progress: Conversation between requester and virtual agent is in progress.</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete: Virtual agent ends the conversation.</td>
</tr>
<tr>
<td></td>
<td>• Closed Abandoned: Requester ends the conversation before completing the conversation with the virtual agent.</td>
</tr>
<tr>
<td>Note</td>
<td>There are different State Reasons for the Closed Complete and Closed Abandoned states, depending on whether you're using Virtual Agent only, Virtual Agent with Live Agent, or Live Agent only. For details on the State Reasons, see Reasons for Closed Complete and Closed Abandoned states.</td>
</tr>
<tr>
<td>State Reason</td>
<td>Detailed explanations (reasons) for the conversation states Closed Complete and Closed Abandoned. To learn more, see Reasons for Closed Complete and Closed Abandoned states.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of interaction record. Virtual Agent conversations are record type Chat.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Name of the fulfiller: Live agent name or Virtual Agent.</td>
</tr>
<tr>
<td>Virtual agent</td>
<td>Flag that indicates whether the conversation is for Virtual Agent: true or false. A Virtual Agent conversation is flagged when a requester selects a conversation topic or when the topic discovery process starts the appropriate conversation.</td>
</tr>
<tr>
<td>Agent chat</td>
<td>Flag that indicates the conversation was transferred to a live agent in Agent Chat (Agent Workspace): true or false.</td>
</tr>
<tr>
<td>Connect support</td>
<td>Flag that indicates the conversation was transferred to a live agent in Connect Support.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time that the conversation record was last updated.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Reasons for Closed Complete and Closed Abandoned states

Virtual Agent closes completed and abandoned conversations for various reasons, depending on whether the conversation is for Virtual Agent (VA) only, Virtual Agent with Live Agent (VA-LA), or Live Agent (LA).

### Interactions table with State Reasons

<table>
<thead>
<tr>
<th>State Reason</th>
<th>Virtual Agent</th>
<th>Virtual Agent &amp; Live Agent or Live Agent only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed Abandoned</td>
<td>Left Before Engagement</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

The **State Reason** field provides details on the different ways in which a conversation ends. The following table describes the reasons and also the related message displayed for dashboard analytics.

⚠️ **Note:** For details on how Virtual Agent and Agent Chat handle idle conversations and the corresponding default timeout periods, see Closing Virtual Agent and Live Agent conversations and Idle live chats.
<table>
<thead>
<tr>
<th>State</th>
<th>State Reason</th>
<th>Virtual Agent</th>
<th>Virtual Agent &amp; Live Agent or Live Agent only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed Abandoned</td>
<td>No Activity</td>
<td>Requester opened a conversation, but didn’t engage with the bot (for example, closed the browser) and didn’t initiate topic discovery. The system closed the Virtual Agent idle conversation after the default timeout. Dashboard message: System closed VA - user never engaged</td>
<td>Requester chose to be routed to a live agent but abandoned the conversation before an agent was assigned. After 30 seconds, the agent Accept card disappears from Agent Workspace. Dashboard message: System closed LA - before Agent engagement</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>User Ended</td>
<td>After engaging with the bot (requester entered at least one utterance during a conversation or completed a conversation), requester closed the conversation session by selecting End. Dashboard message: User closed VA - Clicked End/X</td>
<td>Requester started to chat with live agent but closed the chat client by selecting End. Dashboard message: User closed LA - Clicked End/X</td>
</tr>
<tr>
<td>State</td>
<td>State Reason</td>
<td>Virtual Agent</td>
<td>Virtual Agent &amp; Live Agent or Live Agent only</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>Auto Closed</td>
<td>Dashboard message: System closed VA - Auto Closed</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>No User Response</td>
<td>Requester engaged with the bot (entered at least one utterance), but left without actively closing the conversation. The system closed the Virtual Agent idle conversation after the default timeout. Dashboard message: System closed VA - User no response</td>
<td>Requester engaged with live agent but stopped and left the agent hanging (idle live chat). The system closes the idle live chat after the default timeout. Dashboard message: System closed LA - User no response</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>Topic Complete (but requester did not make it to the Anything Else setup topic)</td>
<td>Requester engaged with the bot through the last node of a topic but didn't respond to the Anything Else or Feedback setup topics at the end of the conversation. The system closed the Virtual Agent idle conversation after the default timeout. Dashboard message: System closed VA - Topic complete</td>
<td>Requester engaged with live agent until the end of the chat but didn't respond to the last statement made by the agent, such as offering to help with something else. The requester didn't respond and left the agent hanging. The system closed</td>
</tr>
<tr>
<td>State</td>
<td>State Reason</td>
<td>Virtual Agent</td>
<td>Virtual Agent &amp; Live Agent or Live Agent only</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>Left for search</td>
<td>Requester engaged with the bot (entered at least one utterance), but selected Search in the middle of the conversation and didn’t return to the conversation. The system closes the conversation because of inactivity. Dashboard message: System closed VA - Left with AI search</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>Agent Ended</td>
<td>Not applicable.</td>
<td>After requester started a chat with a live agent, the agent actively closed the conversation by selecting <strong>End Chat</strong>. Dashboard message: Agent closed LA - Clicked End/x</td>
</tr>
</tbody>
</table>
Detailed view of a Virtual Agent interaction record

From the Interaction table, you can open a specific record to see additional details about the Virtual Agent interaction: a transcript of the conversation, related tasks, and an interaction log.

**Note:** If a field is not visible, you can add it to the form view. For more information, see Configuring the form layout.

- **Conversation transcript:** The transcript shows the dialog exchange between the agent (virtual or live) and requester and the timestamp for each dialog turn.

  ```
  [13:01] Virtual Agent: Hi, I'm your Virtual Agent. Let me know how I can help you today.
  [13:01] Virtual Agent: See all topics.
  [13:01] System Administrator: Open IT Ticket
  [13:01] Virtual Agent: @https://demoeightygraffix.service-now.com/kb_view.do?sysparm_article=KB000005196&sysparm_rank=1&sysparm_tags&sysparm_id=213340B081B012019671935
  How can I restore my computer to a previous configuration?
  How can I restore my computer to a previous configuration? You can use a feature called System Restore to restore your Windows computer to a previous working configuration. To use System Restore, follow the appropriate steps for your computer.
  Knowledge
  @https://demoeightygraffix.service-now.com/kb_view.do?sysparm_article=KB000005196&sysparm_rank=1&sysparm_tags&sysparm_id=213340B081B012019671935
  Are copyrighted files illegal to have on my computer? Tools built to make use of the Internet of repeated infringement. Does it scan my computer for illegal files? Although most campus copyright album of music, a knowledge
  @https://demoeightygraffix.service-now.com/kb_view.do?
  ```

- **Related Tasks:** Any cases, incidents, or requests created or updated during the conversation are automatically attached to the interaction record as a Related Task. To ensure that these tasks are included with the interaction record, design your conversation topics using certain Virtual Agent Designer utilities and the system method `vaSystem.attachRecordToConversation`. For details, see Topic design considerations below.
• Interaction log table: The log lists all the topics that run in a conversation, including the setup topics and the topics executed by topic discovery or by user selection. Each topic element is assigned a number that indicates the sequential order in which the topics run.

**Security considerations**

Information in conversation transcripts is viewable to all users. If you need to control access to records containing sensitive information, you can use scoped ACLs and lock scripted access to those records by using the Restricted Caller Access (RCA) feature. For details, see [Set application scope, application resource, and event access](#) and [Manage Restricted Caller Access](#).

**Topic design considerations**

If your Virtual Agent conversations create or update incidents, cases, or requests, consider designing your topics with the following Virtual Agent Designer utilities and system method:

- **Action** utility to create or update incidents or cases
- **Lookup** utility to view information
- **System method** `vaSystem.attachRecordToConversation(String tableName, String sysId)` to attach the task to the interaction record
Use these utilities and system method so that incidents, cases, or requests created during a Virtual Agent conversation are included in the Related Tasks list of the interaction record.

**Note:** Records created or updated using the Script Action utility are not captured as related tasks in the interaction record.

### Closing Virtual Agent and Live Agent conversations

Virtual Agent and Live Agent conversations that are abandoned by requesters remain open until they are automatically closed by the scheduled job, Time Out Abandoned VA Conversations. This job runs hourly each day.

The default timeout period for abandoned Virtual Agent and live agent conversations is two hours (7200 seconds). The Time Out Abandoned VA Conversations job runs hourly to find and close any conversations that have been open longer than the default (or configured) timeout period.

As admins, you can change the default timeout period for closing Virtual Agent and Live Agent conversations by adding the system property com.glide.cs.conversation_idle_timeout. The timeout value that you specify in this property applies to all conversations in supported Virtual Agent and Live Agent channels, including chat channels (such as Microsoft Teams, Slack, and Workplace from Facebook) and messaging channels (such as SMS). For details, see Change the timeout period for Virtual Agent and Live Agent conversations.

If you’re using Virtual Agent and Live Agent on multiple chat channels, you can add a channel-level idle timeout value that overrides the timeout value set in the com.glide.cs.conversation_idle_timeout property for chat channels. For details, see Override the conversation timeout period by channel.

If needed, you can also change the time at which the Time Out Abandoned VA Conversations job runs.

### Change the timeout period for Virtual Agent and Live Agent conversations

Add the com.glide.cs.conversation_idle_timeout property to the System Property [sys_properties] table to specify the length of time that an abandoned Virtual Agent or Live Agent conversation remains open (idle). When the Time Out Abandoned VA Conversations job runs hourly, it closes any Virtual Agent and Live Agent conversations that have been open longer than the specified time.

1. In the navigation filter, enter sys_properties.list.

2. Click New.
**a. Complete these fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the system property name: com.glide.cs.conversation_idle_timeout</td>
</tr>
<tr>
<td>Description</td>
<td>Enter an explanation for this property:</td>
</tr>
<tr>
<td></td>
<td>Idle timeout period (in seconds) for all conversations</td>
</tr>
<tr>
<td>Type</td>
<td>Select integer.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the number of seconds that abandoned Virtual Agent or Live Agent conversations remain open, after the requester's last response. This value must be less than 7200 seconds, since the Time Out Abandoned VA Conversations job runs every 3600 seconds (hourly) to close idle conversations. For example, a value of 1800 seconds (30 minutes) means that an abandoned conversation remains open for 1800 seconds (30 minutes). When the Time Out Abandoned VA Conversations job runs, it closes any conversations that have been idle longer than 1800 seconds.</td>
</tr>
</tbody>
</table>

**b. Click Submit.**

**Override the conversation timeout period by channel**

You can set the conversation timeout value for a channel by adding a channel-specific conversation timeout value that overrides the com.glide.cs.conversation_idle_timeout property. When the Time Out Abandoned VA Conversations job runs hourly, it closes any Virtual Agent or Live Agent conversations in the channel that have been open longer than the specified time.

1. In the navigation filter, enter sys_cs_channel.list.
2. In the Messaging Channels table, locate the channel record to be changed and double click the Conversation Idle Timeout field.
3. Enter the number of seconds that abandoned Virtual Agent or Live Agent conversations remain open in the channel, after the requester's last response.
For example, a value of 1800 seconds (30 minutes) means that an abandoned conversation in the channel remains open for 1800 seconds (30 minutes). When the **Time Out Abandoned VA Conversations** job runs, it closes any conversations that have been idle longer than 1800 seconds.

4. Save the value.

**Change the Time Out Abandoned VA Conversations scheduled job**

To change the time that this hourly scheduled job runs or to make other adjustments to the scheduled job:

1. Navigate to **System Definition > Scheduled Jobs** and open the Time Out Abandoned VA Conversations record.

2. In the Scheduled Script Execution form, change the **Time** at which the scheduled job runs. Or, depending on how you want to adjust the timing, change other fields in the form as needed.

   For example, to change the interval at which the job runs, in the **Run** field, select **Periodically**. You then specify the **Repeat Interval** (**Days** and **Hours**) that the job runs and the **Starting** date for the interval. For a description of the other fields that you can change in this form, see **Automatically run a script of your choosing**.

3. Click **Update**.

   The job runs at the specified time and frequency.

**Closing idle bot-to-bot conversations**

In bot-to-bot integrations (Virtual Agent API), abandoned conversations that are "idle" for more than an hour are automatically closed by the scheduled job, **Time Out Abandoned B2B Conversations**. This job runs hourly each day.

The default timeout period for abandoned bot-to-bot conversations is one hour (3600 seconds). The **Time Out Abandoned B2B Conversations** job closes any bot-to-bot conversations that have been open longer than one hour (3600 seconds). You (admins) can change the default timeout period for idle bot-to-bot conversations by adding the system property `com.glide.cs.b2b_conversation_idle_timeout`.

The timeout value that you specify in this property applies to all bot-to-bot conversations involving the Virtual Agent.

**Change the timeout period for idle bot-to-bot conversations**

Add the `com.glide.cs.b2b_conversation_idle_timeout` property to the System Property [sys_properties] table to specify the length of time that an abandoned bot-to-bot conversation remains open (idle). When the **Time Out Abandoned B2B**
Conversations job runs hourly, it closes any bot-to-bot conversations that have been idle longer than the specified time.

1. In the navigation filter, enter sys_properties.list

2. Click New.
   a. Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the system property name: com.glide.cs.b2b_conversation_idle_timeout</td>
</tr>
<tr>
<td>Description</td>
<td>Enter an explanation for this property: Idle timeout period (in seconds) for all bot-to-bot conversations</td>
</tr>
<tr>
<td>Type</td>
<td>Select integer.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the number of seconds that the abandoned bot-to-bot conversations remain open, after the requester's last response. For example, a value of 1800 seconds (30 minutes) means that an abandoned bot-to-bot conversation remains open for 1800 seconds (30 minutes). When the Time Out Abandoned B2B Conversations job runs, it closes any conversations that have been idle longer than 1800 seconds.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Change the Time Out Abandoned B2B Conversations scheduled job

To change the time that this hourly scheduled job runs or to make other adjustments to the scheduled job:

1. Navigate to System Definition > Scheduled Jobs and open the Time Out Abandoned B2B Conversations record.

2. In the Scheduled Script Execution form, change the Time at which the scheduled job runs. Or, depending on how you want to adjust the timing, change other fields in the form as needed.

   For example, to change the interval at which the job runs, in the Run field, select Periodically. You then specify the Repeat Interval (Days and Hours) that
the job runs and the **Starting** date for the interval. For a description of the other fields that you can change in this form, see *Automatically run a script of your choosing*.

3. Click **Update**.

The job runs at the specified time and frequency.

**Virtual Agent and link unfurling**

Virtual Agent supports link unfurling on the web client, mobile devices, and various channels. Link unfurling generates a content-rich preview when a supported link is shared in a conversation with a user, a virtual agent, or in a text-based bot response.

If the link is supported on the web client or channel, the generated content-rich previews can include text, images, and videos.

<i>Note:** Factors such as website availability, security policies, or response time of the link you want to unfurl are unpredictable. As a result, link unfurling may be delayed or unavailable. However, these performance-related issues don’t impact the user and don’t affect the conversation flow.

**How to determine if a link is supported**

A link is supported only if all the following conditions are met:

- The host or domain is included in the Hostname allow list table.
- The link has standard, compliant **Open Graph (OG) tags**, for example og:tags.
- The link was shared in a conversation with a user, a virtual agent, or in a text-based bot response.

<i>Note:** These conditions apply only to the web client and mobile devices on the ServiceNow® platform. Support requirements and conditions for clients on other platforms can vary. For client-specific support and requirement conditions, see the documentation for the client you’re using.

**Control unfurling with the Hostname allow list table**

Use the Hostname allow list [sys_cs_hostname_allow_list] table to identify the list of hosts and domains that can be unfurled.

<i>Note:** For security reasons, only the hosts and domains in the Hostname allow list table can be unfurled.

The Hostname allow list table automatically includes these hosts and domains:
• Instance URL/hostname: <instance>.service-now.com or <customURL>.com
• Instance root domain: *service-now.com or *.<yourdomain>.com
• servicenow.com
• *.youtu.be*.youtube.com

As an admin, you can add hosts or domains to the Hostname allow list table:
1. In the filter navigator, enter sys/cs_hostname_allow.list and select New.
2. Complete the form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to enable or disable the host or domain that can be unfurled.</td>
</tr>
<tr>
<td>Hostname</td>
<td>Name of the host or domain that can be unfurled. You can use an asterisk (*) to specify a wildcard in the host or domain name.</td>
</tr>
<tr>
<td></td>
<td>• Instance URL or hostname: &lt;your instance&gt;.service-now.com or &lt;custom URL&gt;.com</td>
</tr>
<tr>
<td></td>
<td>• Instance root domain: *.servicenow.com or *.&lt;your domain&gt;.com</td>
</tr>
<tr>
<td></td>
<td>• servicenow.com</td>
</tr>
<tr>
<td></td>
<td>• *.youtu.be or *youtube.com</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain group. The default is global.</td>
</tr>
</tbody>
</table>

3. Select Submit.

Determine how the preview content is displayed
As of the Rome release, the ServiceNow UI pages support unfurling for OG tags only.

iad Note: Admins can add OG tags to ServiceNow UI pages by following the instructions in the Adding meta tags to ServiceNow UI Pages Knowledge Base article.

When a link is determined to be a shared link because it meets the criteria for a shared link, the ServiceNow software:
• Asynchronously fetches, if available, the OG tag at the provided link.
• Attaches a card-based, content-rich preview of the link based on the OG tag.

The time required to complete these and any other required tasks can vary, depending on your network configuration and system performance.

**Unfurling and OG tags**

The ServiceNow UI supports image, video, and text-based OG tags. When both an image OG tag and a video OG tag are fetched, the video is used instead of the image in the card-based, content-rich preview.

ℹ️ **Note:** The specific OG tags supported on channels can vary. For example, the OG tags supported on Slack may be different from the OG tags supported on Microsoft Teams, or Workplace from Facebook. For details about the OG tags supported on channels, see the documentation for the channel you’re using.

**Turn off link unfurling**

Link unfurling is automatically enabled by default. To turn it off, admins can change the com.glide.cs.enable_link_unfurling system property to False.

**Tracking deflections using deflection topic blocks**

You can use the pre-built deflection topic block in Virtual Agent conversation topics to track the issues that Virtual Agent helped to resolve or actually resolved for a user.

A deflection occurs when Virtual Agent helps to resolve or resolves an issue for a user. As a result, the user might not need to create an incident. By asking relevant questions to the user, Virtual Agent can create an incident in the correct assignment group. This workflow becomes more efficient because no live agent has to get involved.

The Virtual Agent deflection tracking is enabled by default, but you must set up the deflection configuration and deflection patterns to capture certain deflection metrics. For more information, see [Create deflection configurations and patterns](#).

You use deflection configurations to group deflection patterns. A deflection configuration can consist of one or more deflection patterns. Deflection patterns categorize Virtual Agent activities in conversations for tracking deflection metrics. For example, let’s say that Virtual Agent adds a user to an email list without creating a task in the Task table to complete the workflow. You can categorize this activity as a self-resolving deflection pattern.
You can view the deflection metrics for each deflection pattern. A deflection pattern can lead to these deflection outcomes in a conversation:

- **Confirmed deflection**: Virtual Agent provided a resolution to the user, which prevented the user from creating an incident or transferring to a live agent.
- **Potential deflection**: It is unclear whether Virtual Agent provided a resolution to the user. An example is when search results are displayed to a user in a conversation.
- **No deflection**: Virtual Agent did not provide a resolution, and the user created an incident or transferred to a live agent.

You can either create new deflection patterns, or use these pre-built deflection patterns in the **VA Default** deflection configuration:

<table>
<thead>
<tr>
<th>Deflection pattern</th>
<th>Activity</th>
<th>Outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>VA-Search-served</td>
<td>Virtual Agent showed search results to the user.</td>
<td>Potential deflection</td>
</tr>
<tr>
<td>VA-Triage &amp; Created</td>
<td>Virtual Agent creates an incident in the correct assignment group. This action improves the assignment accuracy. For example, Virtual Agent identifies a reimbursement-related intent in a user conversation and creates a reimbursement incident instead of a general incident.</td>
<td>Confirmed deflection</td>
</tr>
<tr>
<td>VA-Self-Resolving</td>
<td>Virtual Agent completes the workflow on its own without creating an incident. For example, Virtual Agent adds a user to a distribution list.</td>
<td>Confirmed deflection</td>
</tr>
<tr>
<td>VA-Intercept &amp; Resolved</td>
<td>Virtual Agent intercepts an incident that was created by a user and provides a resolution to close the incident. An example is when Incident Auto Resolution resolves an incident.</td>
<td>Confirmed deflection</td>
</tr>
</tbody>
</table>
The deflection configuration and deflection pattern that you create in the deflection settings are mapped to the deflection topic block. For example, the pre-built Issue Auto Resolution topic uses a deflection topic block to track deflections. For more information, see Reusable topic blocks and Virtual Agent platform topic blocks.

The deflection metrics are generated and stored in the Deflection Metric [ssa_deflection_metric] table. To view the deflection metrics, navigate to the Deflection Metrics module in the Self-Service Analytics framework.

⚠️ **Note:** The Self-Service Analytics framework requires the Self-Service Analytics Core plugin (com.snc.self_service_analytics_core). For more information, see Activate Self-Service Analytics.

---

### Deflection metrics

You can also view the visualization for deflection metrics in the **Overview** tab of the Conversational Analytics Dashboard. For more information, see Conversational Analytics Dashboard.

---

### Create deflection configurations and patterns

Set up deflection settings to create deflection configurations and deflection patterns that you can map to deflection topic blocks in Virtual Agent conversation topics. These deflections help you to track the issues that Virtual Agent helped to resolve or actually resolved for a user.

**Before you begin**

Review Tracking deflections using deflection topic blocks.

**Role required:** virtual_agent_admin or admin

**Procedure**

1. Navigate to Conversational Interfaces > Virtual Agent > General Settings.
2. Click the Deflection Settings tab.
3. Click Create new configuration.
4. In the Create Deflection Configuration dialog box, enter these deflection configuration properties:
5. Click **Submit**.

6. In the **Deflection Configurations** field, select the deflection configuration in which you want to add the deflection patterns.

7. Click **Create Pattern**.

In the Create Deflection Pattern dialog box, enter these deflection pattern properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Short and meaningful name for the deflection pattern.</td>
</tr>
<tr>
<td>Outcome</td>
<td>Result of the deflection in a Virtual Agent conversation.</td>
</tr>
<tr>
<td>Primary Activity Table</td>
<td>Table that is associated with the activity that you are categorizing in the deflection pattern. For example, if the Virtual Agent is helping to prevent the creation of a task for the activity, then you can specify the task table.</td>
</tr>
</tbody>
</table>

⚠️ **Note**: If you are creating a generic pattern that is used for tracking different deflections, you can leave the **Primary Activity Table** field empty.

The primary activity table that is associated with each activity helps in calculating the deflection rate for a particular business area. For example, if Virtual Agent resolves 42 VPN issues and overall 100 VPN incidents are created, the deflection rate for VPN issues is 42/142 or 30 percent.

8. Click **Submit**.
Virtual Agent API

Use the ServiceNow® Virtual Agent API app to integrate any chat interface or a bot with ServiceNow® Virtual Agent or Agent Chat. The app is available through the ServiceNow® Store.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Overview

The Virtual Agent API is a REST API. This API is built on the conversational custom chat integration framework that is provided with Virtual Agent starting in the Paris release. The API enables ServiceNow developers, advanced users, and admins to use Virtual Agent in either of the following ways:

**Standalone bot**

Use Virtual Agent as a standalone bot that you integrate with enterprise or with any other third-party chat interface that supports conversational interfaces.

Your end users can interact with the Virtual Agent and Agent Chat through multiple channels by using this integration.

**Secondary bot**

Use Virtual Agent as a secondary bot in an environment that has multiple, specialized bots managed by a primary bot.

In this scenario, a primary bot manages communication with secondary bots on behalf of the end user. A primary bot could be IBM Watson Assistant, Microsoft LUIS, or a homegrown primary bot.

Your secondary bots, such as the ServiceNow bot, might handle specific types of end-user requests, such as service tickets or reservations.

The Virtual Agent API is useful for creating server-to-server integrations. However, for integrations that require the transformation of unsupported controls that must be rendered in your existing chat interface, consider using the Custom Chat Integration Framework.

For information about features such as the URL format and the supported request and response parameters in the Virtual Agent API, see Virtual Agent Bot Integration API.
How the Virtual Agent API works
The following diagram shows how the REST API processes user input from a third-party chat interface or a primary bot, and then generates a bot response.

Inbound and outbound REST endpoints in the Virtual Agent API

To see a demonstration of the Virtual Agent API and an FAQ, see Getting Started with Virtual Agent APIs on the Community site.

Limitations
The Virtual Agent API does not support the following features:

- Integrations with ServiceNow Virtual Agent as the primary bot
- Chat branding through this Virtual Agent API integration

Version and release compatibility

<table>
<thead>
<tr>
<th>Version</th>
<th>Compatible Releases</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0.x</td>
<td>Rome</td>
</tr>
<tr>
<td></td>
<td>A subset of features is compatible with Quebec.</td>
</tr>
<tr>
<td>1.3.0</td>
<td>Quebec</td>
</tr>
<tr>
<td>1.0.12</td>
<td>Quebec</td>
</tr>
<tr>
<td>1.0.9</td>
<td>Paris</td>
</tr>
</tbody>
</table>
Virtual Agent API features

You can use the Virtual Agent API to integrate many of the same features that are available in Virtual Agent and Agent Chat into your chat environment. Feature support varies depending on your ServiceNow release and the Store app version number of the API.

For information about the request and response templates for Virtual Agent API, as well as examples of common use cases, see Virtual Agent Bot Integration API.

Key features

The main features in Virtual Agent API starting with version 1.0.9 include the following:

- Provider authentication using static, hash, and token-based authentication
- Auto-linking user IDs to ServiceNow accounts for a personalized experience
- Virtual Agent transfer to a live agent in Agent Chat
- Intent classification in bot-to-bot integrations through the following strategies:
  - The primary bot determines the user intent and sends the user request to Virtual Agent so that the corresponding topic is displayed to the user.
  - The primary bot sends the user utterance to Virtual Agent so that it can discover the intent and return a prediction confidence score. A higher confidence score indicates that the predicted topic more accurately matches the user utterance.

Version 1.0.12 features

Automatically close idle bot-to-bot conversations

You can automatically close conversations that have been idle for more than one hour. The Time Out Abandoned B2B Conversations job runs hourly each day and automatically closes idle conversations that requesters have abandoned.

Conversation states and reason codes in Virtual Agent interaction records

When a user or primary bot ends a conversation, Virtual Agent records the state and reason codes in the interaction records. For example, an end user can type End to stop the conversation or click the X button to close the chat.

Notifying when a conversation ends

The primary bot is notified when Virtual Agent or Agent Chat conversations end. The primary bot is also notified when it must take control of a conversation. Virtual Agent uses the following flags:
• **completed**: Sent when the conversation with Virtual Agent or a live agent is finished.

• **takeControl**: Sent when the primary bot must take control. This typically occurs when Virtual Agent can’t determine the conversation intent after two consecutive attempts (the default value). You can add the `va.bot.to.bot.take.control_times` system property to change the default number of attempts that Virtual Agent tries to determine the conversation intent.

For more information, see Virtual Agent Bot Integration API.

**Changes with intents**

• Share the NLU confidence score for an intent match if NLU is enabled in Virtual Agent.

• Enable end users to jump directly into a topic based on intent matching by the primary bot.

**Version 1.3.0 features**

Starting with version 1.3.0, Virtual Agent API supports logging as a system property (`va.bot.to.bot.logging_enabled`).

**Virtual Agent API features available in Store release 2.0.x**

Virtual Agent API version 2.0.x provides access to more of the same features that are available in Virtual Agent and Agent Chat, including rich control support and notifications.

**Support for additional rich controls**

Virtual Agent API now supports the following rich controls.

**Boolean controls**

Boolean controls return responses as strings (either **Yes** or **No**) for easier localization.

For more information about topic localization, see Virtual Agent localization.

Virtual Agent API sends the following example JSON for a boolean control:

```json
{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": ""
}
```
Custom controls

Topics that use custom controls are now supported. For more information about custom controls, see Virtual Agent custom controls.

Table bot response controls (also compatible with Quebec)

Topics that use table bot response controls are now supported. For more information, see Virtual Agent Designer bot responses.

All records are returned from Virtual Agent API at once. Virtual Agent will wait for a response from the API client to send the next control. Use the paginaitonBreak property to display records in chunks to the user. For example, if paginationBreak is set to 10, the user will see 10 records at a time. When the client is ready to move to the next control, it should send DONE.

Virtual Agent API sends the following example JSON for a table bot response control:
{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "Yes",
    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "OutputTable",
      "group": "DefaultOutputTable",
      "label": "Sample Table Rich control",
      "headers": [
        "Number",
        "Short description"
      ],
      "data": [
        [
          "INC0000005",
          "CPU load high for over 10 minutes"
        ],
        [
          "INC00000015",
          "I can't launch my VPN client since the last software update"
        ],
        [
          "INC00000025",
          "Need to add more memory to laptop"
        ],
        [
          "INC00000035",
          "Reset my password"
        ],
        [
          "INC00000055",
          "SAP Sales app is not accessible"
        ],
        [
          "INC00009005",
          "Email server is down."
        ]
      ]
    }
  ]
}
HTML bot response controls

Topics that use HTML bot response controls are now supported. For more information, see Virtual Agent Designer bot responses. Virtual Agent API sends the following example JSON for an HTML bot response control:

```
{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "Yes",
    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "OutputHtml",
      "group": "DefaultOutputHtml",
      "style": "inline",
      "height": 100,
      "width": 100,
      "value": "<html> <body> Sample Response for Html control </body> </html> ",
      "imageUrl": null,
      "imageHeight": 0,
      "imageWidth": 0,
      "links": null
    },
    {
      "uiType": "InputText",
      "group": "DefaultText",
      "required": true,
```

Multi-flow output bot response controls

Topics that use multi-flow output bot response controls are now supported. For more information, see Virtual Agent Designer bot responses.

Virtual Agent API sends the following example JSON for a multi-flow output bot response control:

```json
{
    "requestId": "asd2423-wrr434-weruyt-1234567",
    "clientSessionId": "",
    "nowSessionId": "",
    "message": {
        "text": "Done",
        "typed": false,
        "clientMessageId": "ABC-123"
    },
    "userId": "beth.anglin",
    "body": [
        {
            "uiType": "MultiPartOutput",
            "group": "DefaultMultiPartOutput",
            "navigationBtnLabel": "Click for more",
            "content": {
                "uiType": "OutputText",
                "value": "Text response from multiflow control example",
                "maskType": "NONE"
            }
        }
    ],
    "score": 1
}
```

Rich text support

Topics that use rich text are now supported. Rich text includes bold or italicized text, hyperlinks, bulleted lists, and emojis.
Additional Agent Chat features

The Virtual Agent API now supports the following features when transferring to Agent Chat.

**Pass agent name and avatar**

When the primary bot transfers a chat to a live agent, Virtual Agent can send the agent name and avatar to the primary bot. To enable this, the *Show agent names and avatars* check box must be selected in Chat Setup.

**Show agent names and avatars check box in Chat Setup**

![Screenshot of Chat Setup showing the Show agent names and avatars check box]

An example message payload might look like this:

```json
{
  "requestId": "f42f3550-5b44-4cde-aa52-9b6756b3131c",
  "clientSessionId": "U94CSJLEN",
  "message": {
    "text": "Live Agent support.",
    "typed": true
  },
  "userId": "U94CSJLEN",
  "body": [
    {
      "uiType": "OutputText",
      "group": "DefaultText",
      "agentInfo": {
        "sentFromAgent": true,
        "agentName": "Beth Anglin",
        "agentAvatar": "ee4eebf30a0004d963b5c5ac0d734dc4.iix?t=small"
      }
    }
  ]
}
```
For more information, see Configure live agent chat.

**Live agent wait time (also compatible with Quebec)**

When transferring to a live agent, the primary bot can receive the wait time and display this to the user. To enable this, select *Wait Time* in the *Live chat wait status* field in Chat Setup. The *spinnerType* value is set to *wait_time*. If the *Live chat wait status* is set to *None*, the *spinnerType* value is *none*.

Enable live agent wait time in Chat Setup

Virtual Agent API sends the following example JSON in the *body* parameter of the payload.

```json
{
  "uiType":"ActionMsg",
  "actionType":"StartSpinner",
  "spinnerType":"wait_time",
  "message":"Routing you to a live agent...",
  "waitTime":"8 Seconds"
}
```

For more information, see Configure live agent chat.
The primary bot can pass chat history to a live agent so that the agent can see the context of the conversation. Virtual Agent converts the message history to HTML and then to an image.

- The converted image is sent to the live agent as the first message of the chat.
- The primary bot should send the message history in the first request. In any other request after the first request, the message history payload will be ignored.
- Only text messages are supported.
- The primary bot can pass any URL as a value in the text message, but the live agent can only view it as part of the image. The live agent will not be able to click the link.

Example message payload:

```json
{
  "value": "Help me with password reset",
  "displayName": "able",
  "type": "text",
  "isBotMessage": false,
}
```

**Note:** In the previous example, `type` is case sensitive and should have a value of `text`.

**Enriched requests from the primary bot**

The Virtual Agent API now supports the following requests from the primary bot.

**System parameters and context variables (also compatible with Quebec)**

The primary bot can pass system parameters and context variables as input, and Virtual Agent will honor these parameters. System parameters such as `liveagent_devicetype`, `liveagent_requester_session_language`, `liveagent_topic`, `topic`, `live_agent_only`, and `liveagent_devicetimezone` are supported. Custom context variables and Agent Chat context variables are also supported.

Example message payload:

```json
{
  "requestId": "f42f3550-5b44-4cde-aa52-xxxxxxxxxx",
  "clientSessionId": "xxxxxxxxxx",
  "token": "abcd",
}
```
For more information, see Live Agent chat context variables and Define and publish chat context variables.

**User timezone**

Set the user’s timezone by passing it in the request payload. Once set, that timezone setting is retained until it is reset.

Example message payload:

```json
{
    "requestId": "xxxxxxxx-xxxxxx-xxxx-xxxx-xxxxxxxxxx",
    "clientSessionId": "xxxxxxxx-xxxx",
    "token": "xxxxx",
    "action": "SET_USER_TIMEZONE",
    "userId": "able.tuter",
    "emailId": "abel.tuter@example.com",
    "timezone": "Asia/Kolkata"
}
```

When using this functionality, consider the following:

- The conversation must be open (current) in order to convert date and time to the user’s timezone.
- The primary bot must send date and time in one of the following formats:
  - Timezone name. For example, Asia/Kolkata or America/New_York.
  - Date Time 24-hour format. For example: YYYY-MM-DD HH:MM:SS
- The Virtual Agent API uses the timezone specified by the primary bot, even if the timezone it sets differs from the value stored in the [sys_user] table.
- To set the user timezone, send the **SET_TIMEZONE** action. If the timezone name is not valid, the timezone value defaults to UTC time. For example, 2021-02-16 20:13:13.
Support for node skipping

Virtual Agent API supports skipping a node if it is designed to do so in the topic. For example, in Virtual Agent Designer, you can designate a user input control as skippable in the Node Conditions area of the property sheet.

Condition or script that allows the user to skip the node

- Allow user to skip this node:
  - [ ] Condition
  - [x] Script

For more information about defining a node as skippable, see Virtual Agent Designer user input controls.

If a node is marked as skippable, the bot will present that option to the user. If the user skips it, the primary bot should pass the skip command as depicted in the following example.

```json
{
  "requestId": "f42f3550-5b44-4cde-aa52-9b6756b3131c",
  "clientSessionId": "835607",
  "token": "snow",
  "message": {
    "text": "_skip_",
    "typed": false
  },
  "emailId": "beth.anglin@example.com",
  "userId": "beth.anglin"
}
```

Synchronous handshake support

When enabled, Virtual Agent delivers responses to the primary bot synchronously. If you want to enable the communication with Virtual Agent in synchronous mode, you must manually turn off the following features in order for the handshake to work:

- Agent Chat
- Notifications
- Typing indicators

⚠️ Note: Topics that use the following features are not supported in synchronous mode: file upload, the Action utility, and the Pause topic block.

To disable these features and enable synchronous support, follow these steps:
1. Exclude the Bot to Bot channel from Agent Chat:
   a. Navigate to sys_properties.list.
   b. Select the com.glide.cs.exclude.liveagent.support system property.
   c. Add Bot To Bot to the Value field.
   d. Click Update.
2. Navigate to sys_cs_channel.list.
3. Select the Bot to Bot record.
4. Clear the Enable Notifications check box to disable it.
5. Clear the Support typing indicator check box to disable it.
6. Select the Synchronous check box.
7. Click Update.

Notifications support (also compatible with Quebec)
Use Virtual Agent API to send the following types of notifications in the Bot to Bot channel when it is enabled in asynchronous mode:

- Simple: Text-only notifications. Simple notifications are delivered as soon as they arrive.
- Image Card: An image that is uploaded to the server or specified with a URL.
- Record Card: Specified columns from a record in a table.
- Actionable: Provides the user with the opportunity to perform certain actions. Actionable notifications are queued. The user can retrieve them on demand by sending the Show Notification command.

For more information, see Configuring Virtual Agent notifications.

Virtual Agent API sends the following example JSON for a simple notification:

```json
{
    "requestId": "asd2423-wrr434-weruyt-1234567",
    "clientSessionId": "",
    "nowSessionId": "",
    "message": {
        "text": "Done",
        "typed": false,
        "clientMessageId": "ABC-123"
    }
}
```
Virtual Agent API sends the following example JSON for an Image Card notification:

```json
{
    "requestId": "asd2423-wrr434-weruyt-1234567",
    "clientSessionId": "",
    "nowSessionId": "",
    "message": {
        "text": "Done",
        "typed": false,
        "clientMessageId": "ABC-123"
    },
    "userId": "beth.anglin",
    "body": [
        {
            "uiType": "OutputCard",
            "group": "DefaultOutputCard",
            "templateName": "Notification",
            "data": "{\"sys_id\":null,\"recordDisplayValue\":null,\"messageHeading\":\"[Heading]A notification has arrived. You can continue the conversation after viewing the notification.\",\"imageUrl\":null,\"tableLabel\":null,\"enableLink\":false,\"message\":\"[message]A notification has arrived. You can continue the conversation after viewing the notification.\",\"fields\":[]},\"table_name\":null,\"url\":\"http://192.168.1.9:8080/null.do?sys_id=null\""
        }
    ],
    "completed": true,
    "score": 1
}
```
Virtual Agent API sends the following example JSON for a Record Card notification:

```json
{
    "requestId": "asd2423-wrr434-weruyt-1234567",
    "clientSessionId": "",
    "nowSessionId": "",
    "message": {
        "text": "Done",
        "typed": false,
        "clientMessageId": "ABC-123"
    },
    "userId": "beth.anglin",
    "body": [
        {
            "uiType": "OutputCard",
            "group": "DefaultOutputCard",
            "templateName": "Notification",
            "data": {
                "sys_id": "552c48888c033300964f4932b03eb092",
                "recordDisplayValue": "INC0010112",
                "messageHeading": "[Heading] A notification has arrived. You can continue the conversation after viewing the notification.",
                "imageUrl": null,
                "tableLabel": "Incident",
                "enableLink": true,
                "message": "[message] A notification has arrived. You can continue the conversation after viewing the notification.",
                "fields": [
                    {
                        "fieldLabel": "Number",
                        "fieldValue": "INC0010112"
                    },
                    {
                        "fieldLabel": "Short description",
                        "fieldValue": "Assessment : ATF Assessor"
                    }
                ],
                "table_name": "incident",
                "url": "http://192.168.1.9:8080/incident.do?sys_id=552c48888c033300964f4932b03eb092"
            }
        }
    ],
    "completed": true,
    "score": 1
}
```

Notifications for the Bot to Bot channel are disabled by default. To enable them, do the following:

1. Navigate to `sys_cs_channel.list`.
2. Open the Bot to Bot record.
   
   If prompted, enable editing on the record.
3. Select the **Enable Notifications** check box.

4. Click **Update**.

Admins can limit the number of recipients per notification by modifying the `com.glide.cs.per_notification_user_limit` property. The default value is 1000.

**Topic switching using the topic name**

In addition to using the topic ID or topic intent ID to switch topics, you can use the topic or topic intent name. It is recommended that you only send either the topic ID or the topic name. Currently, if either is incorrect or if the bot is already in the specified topic, Virtual Agent does not send any response. Usage depends on the mode you are using, as follows:

- **NLU mode**: Use the topic intent name or ID.
- **Keyword mode**: Use the topic name or ID.

The primary bot can send the `SWITCH` action along with the topic name to switch directly to a particular topic.

Example message payload:

```json
{
  "requestId": "xxxx-xxxx-xxxx-xxxx",
  "clientSessionId": "xxx-xxx-xxx-xxx",
  "action": "SWITCH",
  "topic": {
    "name": "Topic Name"
  },
  "userId": "beth"
}
```

**Typing indicator support**

You can enable typing indicators for users and live agents. Currently, typing indicators are displayed as follows:

- Displayed to the agent when the user is typing
- Displayed to the user when the bot is preparing a response

When the typing indicator is enabled, Virtual Agent API sends the `StartTypingIndicator` and `EndTypingIndicator` actions in the response payload. For example:

```json
{
  "uiType": "ActionMsg",
}
```
To send the user typing indicator to a live agent, the client should send the `TYPING` action. When the user finishes typing, the client should send the `VIEWING` action. For example:

```json
{
  "requestId": "xxxxxxxx-xxxxx-xxxx-xxxx-xxxxxxxxxx",
  "clientSessionId": "xxxxxxxx-xxxx",
  "action": "TYPING/VIEWING",
  "userId": "able.tuter",
  "emailId": "abel.tuter@example.com",
  "timezone": "Asia/Kolkata"
}
```

To enable typing indicators, follow these steps.

1. Navigate to `sys_cs_channel.list`.
2. Select the Bot to Bot record.
3. Select the Support typing indicator check box.
4. Click **Update**.

**Virtual Agent bot-to-bot integration**

The Virtual Agent API supports environments that use multiple bots. In this situation, a primary bot communicates with third-party secondary bots, such as a ServiceNow bot.

There are two types of bot communication with the primary bot:

- If the primary bot understands an end user’s request (intent), the primary bot routes the request to the appropriate secondary bot, which displays the corresponding topic.
- If the primary bot cannot determine where to route a user request, the primary bot can broadcast a user’s request to all secondary bots. Each secondary bot returns a prediction confidence score for determining the end user’s intent. The primary bot then routes the request to the secondary bot with the highest prediction confidence score.

In both scenarios, the ServiceNow bot informs the primary bot when the request is completed or when it cannot continue handling the request. The primary bot can then determine whether to inform the end user that the conversation is complete or provide further assistance.
The ServiceNow secondary bot uses a standard request and response through REST endpoints. When the request is received through the Bot Framework or an enterprise app seeking to integrate with the ServiceNow bot, the response for a request is sent asynchronously via the API to the requesting system. Virtual Agent supports Live Agent in the channel as well.

Properties for bot-to-bot integrations
You can add system properties to configure the following:

- User account linking
- Starting with version 1.3: Logging for the Virtual Agent API
- Number of times that the Virtual Agent bot tries to get a response
- Bot normalization score

**Bot-to-bot properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>va.bot.to.bot.auto.link.account.enabled</td>
<td>Automatically links user accounts to their ServiceNow accounts if the user email ID is present in the request.</td>
<td>True</td>
</tr>
<tr>
<td>va.bot.to.bot.logging_enabled</td>
<td>Option that enables logging for the Virtual Agent API. To enable</td>
<td>False</td>
</tr>
</tbody>
</table>
### Bot-to-bot properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>logging, set the value to True.</td>
<td></td>
</tr>
<tr>
<td>va.bot.to.bot.take.control</td>
<td>Number of times that Virtual Agent tries to get a response, after which the control is returned to the primary bot.</td>
<td>2</td>
</tr>
<tr>
<td>va.bot.to.bot.score.normalization_factor</td>
<td>Value used to normalize the prediction confidence score returned by Virtual Agent, if the primary bot does not use intents to route requests to the appropriate bot.</td>
<td>1</td>
</tr>
</tbody>
</table>

### Install the Virtual Agent API

Install the Virtual Agent API app to integrate any chat interface or a bot with ServiceNow® Virtual Agent or Agent Chat.

### Before you begin

If you're upgrading from a version prior to version 2 and if authentication is required for your instance, you must revert the customization before upgrading. For these versions, the upgrade skips the Scripted REST Service when authentication is turned on. For more information, see Revert a customization.

You must meet the following requirements:

- Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- Ensure that you activated the Glide Virtual Agent (com.glide.cs.chatbot) plugin, which activates the Conversational Custom Chat Integration (com.glide.cs.custom.adapter) plugin.

For more information on this plugin, see Activate Virtual Agent.

For information on activating plugins, see Activate a plugin.

Role required: admin
About this task
The Bot to Bot Control [sys_cs_bot_to_bot_control] table is installed with the Virtual Agent API. This table tracks the number of times that a particular task in a topic is executed. You can use this table for debugging. For example, use it to determine whether Virtual Agent is stuck on a particular control or topic.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Virtual Agent API application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find the application, you may have to request it from the ServiceNow Store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.
4. In the Application installation dialog box, click Install.

What to do next
Review the inbound REST endpoint and configure inbound authentication

Review the inbound REST endpoint and configure inbound authentication
After you install the Virtual Agent API, navigate to the Scripted REST API resource to review the endpoint and set up authentication.

Before you begin
Role required: admin

Procedure
1. Navigate to System Web Services > Scripted Web Services > Scripted REST APIs.
2. Select the VA Bot Integration record.
3. In the Resources tab, select the BOT Integration record.
4. Review the inbound REST API resource details. The format is: https://<customer instance>/api/sn_va_as_service/bot/integration
For a description of the request parameters and an example send request, see Virtual Agent Bot Integration API.

5. In the **Security** tab, select the **Requires authentication** check box.

6. Set up Provider Authentication using any of these methods: Basic, OAuth, Hash, or Static Token.

   **Note:** Guest usage via Basic or OAuth is already supported out-of-box when you select **Requires authentication**. To support user account linking, you must use Static or Hash token-based authentication. You can use token-based authentication (Static or Hash) with or without Basic or OAuth authentication. The token can be passed in either the request body or the header. If the token is specified in both places, the one in the header is accepted.

   Do one of the following:
• Set up Basic or OAuth authentication. Ensure that **Requires Authentication** is selected on the Scripted REST Resource page for Bot Integration.

To learn more about OAuth authentication and the possible security configurations for scripted REST APIs, see [Enable OAuth with inbound REST](#).

• Set up Message Authentication, which involves configuring either Static or Hash tokens, setting up Provider Authentication, and setting the channel identity. For details, see [Configure Message Authentication for inbound communication](#).

**What to do next**
If you are using Message Authentication, Configure Message Authentication for inbound communication.

Configure the output response REST endpoint and outbound authentication for the Virtual Agent API.

**Configure Message Authentication for inbound communication**
You can configure Message Authentication for the Virtual Agent API instead of Basic or OAuth. Message Authentication involves configuring either Static or Hash tokens, setting up Provider Authentication, and setting the channel identity.

**Before you begin**
Follow the steps in [Review the inbound REST endpoint and configure inbound authentication](#).

Role required: admin

**Procedure**
1. Configure the token. Do one of the following, depending on the token type.
   • Static token:
     a. Navigate to `token_verification.list > Token Verification` and click **New**.
     b. On the Token Verifications form, fill in the fields:

     **Token Verifications form**

<pre><code> | Field     | Description                          |
 |-----------|--------------------------------------|
 | Name      | Name of the authentication token, such as `B2BTestAppAuthToken`. |
</code></pre>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the authentication token, such as B2B Testing application Auth Token.</td>
</tr>
<tr>
<td>Token</td>
<td>Enter an authentication token that you generated using any general programming or scripting language.</td>
</tr>
</tbody>
</table>

c. Click **Submit**.

- **Hash token:**
  
a. Navigate to `hash_message_verification.list > Hash Message Verifications` and click **New**.
  
b. On the Hash Message Verification form, fill in the fields:

  **Hash Message Verification form**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the authentication token, such as B2BTestAppAuthToken.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the authentication token, such as B2B Testing application Auth Token.</td>
</tr>
<tr>
<td>Secret</td>
<td>Authentication token from your phone number.</td>
</tr>
</tbody>
</table>

c. Click **Submit**.

2. Set up Provider Authentication for token-based authentication.

  a. Navigate to `message_auth.list > Message Auths`, and then click **New**.
  
b. On the Message Auths form, fill in the fields:

  **Message Auths form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the message authentication, such as B2B Auth token.</td>
</tr>
<tr>
<td>Provider</td>
<td>Name of the provider.</td>
</tr>
<tr>
<td>Group name</td>
<td>Not required.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>Not required.</td>
</tr>
<tr>
<td>Inbound message verification</td>
<td>Select the Static token or Hash message token that you created.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Outbound message creation</td>
<td>This field is not currently supported in the Virtual Agent API.</td>
</tr>
<tr>
<td>Outbound service token</td>
<td>This field is not currently supported in the Virtual Agent API.</td>
</tr>
</tbody>
</table>

c. Click **Submit**.

3. Set the channel identity.

   a. Navigate to **sys_cs_provider_application.list > Provider Channel Identities**.
   
   b. Open the VA Bot to Bot Provider Application record.
   
   c. In the Provider Channel Identity form, locate the **Message auth** field and select the message auth that you set up previously.

   ![Provider Channel Identity Form](image)

   d. Click **Update**.

4. For Hash token-based authentication only, edit the **Virtual Agent - Bot to Bot Provider Attributes** action script in Flow Designer.

   a. In Flow Designer, locate the **Virtual Agent - Bot to Bot Provider Attributes** script.
   
   b. In the Script step, remove the following lines from the script:

   ```javascript
   var tokenObject ={};
   tokenObject.token = data.token;
   outputs.token = JSON.stringify (tokenObject);
   ```
   
   c. Add the following script:

   ```javascript
   var tokenJSON = {
      attributes: {
         "Signature": headers["x-b2b-signature"],
         "Algorithm": "HMAC-SHA1"
      },
   ```
d. Navigate to **System Web Services > Scripted Web Services > Scripted REST APIs**

e. Open the VA Bot Integration record.

f. In the Scripted REST Service for VA Bot Integration, go to the **Resources** tab and open the **Bot Integration** resource.

g. Edit the script and replace `var headers = {};` with `var headers = request.headers;`
5. For Hash token-based authentication only, send the **x-b2b-signature** in the request headers.

The value is the `HmacSHA1` encoded value of the request payload, which uses the token created in the ServiceNow instance. For example, in Postman, follow these steps:

**a.** In the Headers, set the **x-b2b-signature** to `{{hashValue}}`.

**b.** In the Pre-request Script area, set the token:

```javascript
postman.setEnvironmentVariable("hashValue", CryptoJS.HmacSHA1(request.data, '<insert your token>').toString());
```

**What to do next**

Configure the output response REST endpoint and outbound authentication for the Virtual Agent API
Configure the output response REST endpoint and outbound authentication for the Virtual Agent API

Specify the outbound endpoint URL to which the Virtual Agent responses are posted. Configure outbound authentication.

Before you begin
If needed, specify the Message Authentication for token validation in the Provider Channel Identities [sys_cs_provider_application] table.
Role required: admin

Procedure
1. Navigate to System Web Services > Outbound > REST Message.
2. In the REST Messages [sys_rest_message] table, select the VA Bot to Bot record.
3. In the Endpoint field, enter the response endpoint for the third-party bot, and then click Update.
   For example: http://<customer instance>/demo/rest/service/nowbot/processResponse
4. In the Authentication tab, set the Authentication type field to either Basic or OAuth 2.0, and then click Update.
   - Basic: In the Basic Auth profile field, select or create a Basic auth profile. It will contain a username and password.

   ![Basic Auth Configuration](insert image)

   - OAuth: In the OAuth profile field, select or create an OAuth profile. After saving your changes, click Get OAuth Token in the related links list.
   For details about configuring basic authentication, see Configure a REST message with basic auth. For information about configuring OAuth 2.0, see Configure a REST message with OAuth.
5. Review the JSON response returned from the endpoint call. For a description of the Virtual Agent API response parameters and an example of a successful response, see Virtual Agent Bot Integration API.

**Virtual Agent localization**

The ServiceNow platform provides several methods for localizing Virtual Agent conversations, depending on your needs. Use the Localization Framework to manage all aspects of the translation process, whether you are using machine translation, a third-party provider, or both.

Use the ServiceNow Localization Framework to standardize and track the translation process for Virtual Agent topics. The framework enables you to define the business process for translating your conversations. Use it to configure the following:

- How localization requests are fulfilled.
  
  Options include machine translation, a translation management system (TMS), and exporting and importing files.

- Who is responsible for each step in the process.
  
  Virtual Agent uses the following roles:
  
  - Localization requestor
  - Localization fulfiller
  - Localization editor

- Business rules for the process:
  
  - Auto translation and publication
  - Approval required for translation and publication

To learn more, see Localization Framework. To learn more about localization roles, see Localization roles for Virtual Agent.

**Localizing topics**

The localization process flow depends on the design mode you are using for your topics. There are two main types of design modes:

- Keyword mode
  
  When you use the Localization Framework, the chat conversation and the keywords associated with the topic are translated.

- Natural Language Understanding (NLU) mode
If your topics use NLU, both the topic and the language-specific models (either standalone or secondary models) must be localized. When you request a translation from Virtual Agent Designer, the topic and any optional keywords are translated. You must request translation for language-specific standalone or secondary models from NLU Workbench. For more information about that process, see Multilingual model management.

Once the topic and secondary models are localized, map the models to the topic before publishing them.

**Prerequisites**
Do the following before you begin managing translations:

- Activate the ServiceNow plugin for each language you want to support.
  The Localization Framework is also installed by default. For more information, see [Activate a language](#).

- Configure the translation mode that you want to use in the Localization Framework.
  You can configure machine translation, a translation management system (TMS), or send via email. For more information, see [Translation modes](#).

- Assign localization roles to team member groups.
  Users are assigned different roles based on their responsibilities for the translation process. For more information, see [Localization roles for Virtual Agent](#).

- If you are using Natural Language Understanding (NLU), enable languages in Virtual Agent General Settings.
  For more information, see [Configure Natural Language Understanding in Virtual Agent](#).

**Localization insights**
The Localization Framework provides a dashboard that shows the health of the system across your topics. Use this dashboard to view the translation status of topics and other artifacts.

You can view localization insights from the Virtual Agent Designer page. Navigate to Conversational Interfaces > Virtual Agent > Designer, and then click Localization Insights.

For more information, see [Localization Insights dashboard](#).
Localize Virtual Agent topics that use keyword mode

Use the ServiceNow Localization Framework to manage the process of localizing Virtual Agent conversations and keywords.

Before you begin
Check the prerequisites for translating Virtual Agent components. For more information, see Virtual Agent localization.

Make sure that your Virtual Agent topics are published and performing the way you want them to. Make any adjustments before you send them to localization.

Role required: virtual_agent_admin or admin

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Designer.
2. Open the topic that you want to translate.
3. Click the Languages tab.
   Only languages that are installed and activated are displayed. To learn how to activate localization plugins, see Activate a language.

   The ServiceNow platform provides translations for interface features and pre-built topics, so languages may display as partially translated.

   4. Do one of the following:
      • Request a translation.
      • Edit translations directly in Virtual Agent Designer (requires the localization editor role).

Results
When translations are complete, users with the localization requestor role (Virtual Agent admins) can view them from the Languages tab. Only users with the localization editor role can unlock and edit them.

Once translations are published, they are made available to Virtual Agent topics that use keywords dynamically.
Request translations for Virtual Agent topics

Request translations from a separate team or a third party. The Localization Framework creates a task for the localization fulfiller to complete.

Before you begin
Role required: virtual_agent_admin or admin

About this task
When you request a translation, a Localization Framework task is created. Only users with the localization fulfiller role can view the task and its status. While translation is in process, users cannot edit translations, even if they have the localization editor role. For more information, see Localization task states.

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Designer and open a published topic.
2. Click the Languages tab.
3. Select the applicable check boxes, and then click Request translations.
4. When prompted, confirm your choice.

   A translation record is created, and the translation status changes to Translation in progress. The translation task is assigned to a user with the localization fulfiller role. For information about the fulfillment process in the Localization Framework, see Fulfill a localization task.

Results
Once translations are published, they are made available to Virtual Agent topics that use keywords dynamically.

If your topic uses Natural Language Understanding (NLU), train and map your localized models to the topic. Then test and publish your localized models to ensure that native speakers can access localized intents. For more information, see Map a topic to a language-specific NLU model.

Edit translations for Virtual Agent topics
A Virtual Agent admin user with the localization editor role can edit and publish translations directly in Virtual Agent Designer.

Before you begin
Role required: virtual_agent_admin + localization_editor
**Procedure**

1. Navigate to **Conversational Interfaces** > **Virtual Agent** > **Designer** and open a published topic.

2. Click the **Languages** tab.

3. In the Translated content column for a language, click **Edit**.

**Example**

The Translations form opens.

4. On the Translations form, you can do any of the following:
   - Enter translations directly on the form.
     Click **Save** to save your changes. Click **Publish Translations** to publish them for the topic.
   - If it is configured in the Localization Framework, use machine translation to fill in the fields.
     To set up machine translation, see **Create a translator configuration**.
   - Export files to send to a third party for translation.
Click **Export Source File**, and then choose the file type. Click **Export File** to begin the download.

- Import translated files received from a translation service.

From the Export Source file list, select **Import Translated File**.

5. Click **Save** to save your work.

6. When translations are ready to publish, click **Publish Translations**.

**Results**

Once translations are published, they are made available to Virtual Agent topics that use keywords dynamically.

If your topic uses Natural Language Understanding (NLU), train and map your localized models to the topic. Then test and publish your localized models to ensure that native speakers can access localized intents. For more information, see **Map a topic to a language-specific NLU model**.

**Localize Virtual Agent topics that use NLU mode**

Use the ServiceNow Localization Framework to manage the process of localizing Virtual Agent conversations that use Natural Language Understanding (NLU).

**Before you begin**

Check the prerequisites for translating Virtual Agent components. For more information, see **Virtual Agent localization**.

Make sure that your Virtual Agent topics are published and performing the way you want them to. Make any adjustments before you send them to localization.

Role required: virtual_agent_admin or admin

**Procedure**

1. Add the languages to the model group in NLU Workbench.
   
   This step creates a language-specific version of the model. The model and its intents must also be translated in a separate process. For more information, see **Multilingual model management**.

2. Enable the languages in Virtual Agent General Settings.

   a. Navigate to **Conversational Interfaces > Virtual Agent > General Settings**.

   b. Find the languages in the VA NLU Languages list.
c. If the Enabled column displays false for a language, click the link to open the language NLU properties.

**Example**
For example, in the following image, German is not enabled.

<table>
<thead>
<tr>
<th>Language</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>true</td>
</tr>
<tr>
<td>German</td>
<td>false</td>
</tr>
</tbody>
</table>

d. Select the **Enabled** check box.

e. Click **Update**.

3. Navigate to Conversational Interfaces > Virtual Agent > Designer.

4. Open the published topic that you want to localize.

5. Click the **Languages** tab.

Only installed languages are displayed (the language plugins are activated). The ServiceNow platform provides translations for interface features and pre-built topics, so languages may display as partially translated.

6. Do one of the following:
   - **Request a translation**.
   - **Edit translations directly in Virtual Agent Designer** (requires the localization editor role).

   A user with the localization fulfiller or localization editor role publishes translated content.
Results
When translations are complete, users with the localization requestor role (Virtual Agent admins) can view them from the Languages tab. Only users with the localization editor role can unlock and edit them.

Once translations are published, they are made available to Virtual Agent topics that use keywords dynamically. However, language-specific intent matching is not available until you map the topic to language-specific models and publish them.

What to do next
Map a topic to a language-specific NLU model

Map a topic to a language-specific NLU model
Map a Virtual Agent topic to a language-specific NLU model for each supported language.

Before you begin
Add the languages to the model group in NLU Workbench to create language-specific versions of the model. Before you can map the model to a topic, it must be trained. You do not have to publish it, but Virtual Agent Designer displays notices that the model is unpublished. For more information, see Multilingual model management.

Role required: virtual_agent_admin or admin

Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Designer and open a topic.
2. Open the Languages tab.
   The first column is the NLU binding that is based on your current session language. For example, if you're using English, the first column is English.
3. In the Language to edit list, select the language to map.
   The languages listed are based on the NLU languages that you specified in Virtual Agent General Settings. After you select a language, a column is added in the Intent mapping section and, if applicable, in the Entity mapping section. For example, if you select French, a French column is added.
4. Update the Intent mapping section.
   a. In the Model row, select an NLU model for the language that you selected.
   b. In the Intent row, select an NLU intent for the language that you selected.
5. If applicable, update the Entity mapping section.
   For each language, map an entity from the model to an input node in the topic. In a conversation, these nodes are populated automatically with the entity value.
6. Click Save.

**What to do next**
Test a language-specific NLU model in a conversation

**Test a language-specific NLU model in a conversation**
Test a Virtual Agent topic to ensure that the language-specific NLU model works as expected in a conversation.

**Before you begin**
Role required: virtual_agent_admin or admin
Procedure
1. Navigate to Conversational Interfaces > Virtual Agent > Designer.
2. Open an NLU language-enabled topic.
3. Click the Languages tab.
4. Next to each language to test, click Test this topic.

Example
For example, to test the topic in French, click Test this topic in the French column.

5. On the test window that appears, run the conversation and review the results in the test tabs.
   • Selecting Include topic discovery opens the topic in the context of a conversation. To run the topic directly without displaying the greeting and topic selection messages, clear the Include topic discovery check box.
   • To view a system analysis of test phrases, open the Analyze test phrases tab. The system provides an analysis of the possible intents that match the test phrases that you enter in the conversation.
   • To view the variables that are used in the topic, open the Variables tab.
   • To view the logs for debugging, open the Logs tab.

Example
The following image illustrates how you can test a French translation.
For more information about the chat test window, see Test Virtual Agent topics.

6. End the test by closing the window.

**What to do next**

Use the test results to modify the topic as needed. Continue testing as you adjust your topic and the NLU language bindings. Notice that the status of your unpublished changes appears in the right corner of the navigation bar. The status serves as a reminder to publish your changes when you complete your testing.

**Unpublished changes message**

The topic status displays as **Draft** in the Properties page and on the topic card shown in the Topics page.

When the topic is ready, publish the topic to make it available to users. You can publish all or some of the NLU bindings. For more information about publishing a topic, see Publish a Virtual Agent topic.
Tip: You can view localization insights from the Virtual Agent Designer Topics page. Navigate to Conversational Interfaces > Virtual Agent > Designer, and then click Localization Insights.

Request bulk translations for multiple topics

Use the [sys_cs_topic] table list view to request translations for multiple Virtual Agent topics at a time.

Before you begin
Role required: virtual_agent_admin or admin

Procedure
1. Navigate to sys_cs_topic.list.
2. Select the topic records you want to translate.
3. From the Actions on selected rows list at the bottom of the page, select Request Translations.
4. In the Request Translations dialog box, select the languages.
   Only languages that are installed and activated in the Localization Framework are displayed. To learn how to activate localization plugins, see Activate a language.
5. Click Submit.

Authoring Virtual Agent conversations for localization

Use localization methods in your Virtual Agent scripts to ensure that the content can be translated. Localization methods are designed to show the original text when no translation is found. These methods can be applied to your code before you have created translations.

Localization method for message content

The gs.getMessageLang method checks the Message table [sys_ui_message] for a translated version of the text in the language selected for the current user. If a translated version isn’t found, the default language (English) is returned.

This code provides a greeting that dynamically adds the value of the first_name variable.

```
(function execute() {
    return 'Hi there ' + vaInputs.first_name;
})()
```

The following example shows that same code rewritten for localization.
The second example uses the `gs.getMessageLang` method. The text is the same as the previous example, but the format is changed. The number in brackets acts as a placeholder for the variable, which is then listed in an array after the comma: `[vaInputs.first_name]`. The `gs.getMessageLang` method searches for a record on the Message table with a key value matching `Hi there {0}` and a language value matching the requester's language. The method returns the translated version of the text, which is stored in the `Message` field of the record.

**Note:** Language values use ISO standard two-character language codes. For more information, see [ISO 639.1 language codes](https://en.wikipedia.org/wiki/ISO_639-1).

<table>
<thead>
<tr>
<th>Key</th>
<th>Language</th>
<th>Message</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi there 0</td>
<td>Dutch</td>
<td>Hallo 0</td>
<td>2019-11-25 13:54:19</td>
</tr>
</tbody>
</table>

**Note:** Content is translated only for published topics. Content does not appear translated when previewing unpublished topics.

**Language support for NLU services**

Entity extraction is supported on ServiceNow® NLU models for specific languages only. The remaining languages support intent matching only. If you are using IBM Watson Assistant or Microsoft LUIS, supported languages vary.

You can see the list of currently supported languages in the Open NLU Driver Languages [open_nlu_driver_language] table.

The VA NLU Languages [sys_cs_nlu_language] table lists the languages that are currently enabled in Virtual Agent.

**Note:** If you choose a language that doesn’t support full entity extraction, an error message appears.

**Supported NLU languages on the Now Platform**

<table>
<thead>
<tr>
<th>Service</th>
<th>Supported languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow NLU</td>
<td>For intent matching and entity recognition:</td>
</tr>
</tbody>
</table>
### Supported NLU languages on the Now Platform (continued)

<table>
<thead>
<tr>
<th>Service</th>
<th>Supported languages</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• English</td>
</tr>
<tr>
<td></td>
<td>• French</td>
</tr>
<tr>
<td></td>
<td>• German</td>
</tr>
<tr>
<td></td>
<td>• Japanese</td>
</tr>
<tr>
<td></td>
<td>• Spanish</td>
</tr>
<tr>
<td>For intent matching only:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• English</td>
</tr>
<tr>
<td></td>
<td>• Chinese (Simplified)</td>
</tr>
<tr>
<td></td>
<td>• Danish</td>
</tr>
<tr>
<td></td>
<td>• Dutch</td>
</tr>
<tr>
<td></td>
<td>• Finnish</td>
</tr>
<tr>
<td></td>
<td>• French</td>
</tr>
<tr>
<td></td>
<td>• French (Canadian)</td>
</tr>
<tr>
<td></td>
<td>• German</td>
</tr>
<tr>
<td></td>
<td>• Italian</td>
</tr>
<tr>
<td></td>
<td>• Japanese</td>
</tr>
<tr>
<td></td>
<td>• Korean</td>
</tr>
<tr>
<td></td>
<td>• Norwegian</td>
</tr>
<tr>
<td></td>
<td>• Polish</td>
</tr>
<tr>
<td></td>
<td>• Portuguese (Brazilian)</td>
</tr>
<tr>
<td></td>
<td>• Spanish</td>
</tr>
<tr>
<td></td>
<td>• Swedish</td>
</tr>
<tr>
<td>IBM Watson Assistant</td>
<td>• English</td>
</tr>
<tr>
<td></td>
<td>• Chinese (Simplified)</td>
</tr>
<tr>
<td></td>
<td>• Dutch</td>
</tr>
<tr>
<td></td>
<td>• French</td>
</tr>
<tr>
<td></td>
<td>• German</td>
</tr>
</tbody>
</table>
### Supported NLU languages on the Now Platform (continued)

<table>
<thead>
<tr>
<th>Service</th>
<th>Supported languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Italian</td>
<td>• Italian</td>
</tr>
<tr>
<td>Japanese</td>
<td>• Japanese</td>
</tr>
<tr>
<td>Korean</td>
<td>• Korean</td>
</tr>
<tr>
<td>Portuguese</td>
<td>• Portuguese</td>
</tr>
<tr>
<td>Spanish</td>
<td>• Spanish</td>
</tr>
<tr>
<td>Microsoft LUIS</td>
<td>• English</td>
</tr>
<tr>
<td></td>
<td>• Chinese (Simplified)</td>
</tr>
<tr>
<td></td>
<td>• Dutch</td>
</tr>
<tr>
<td></td>
<td>• French</td>
</tr>
<tr>
<td></td>
<td>• French (Canadian)</td>
</tr>
<tr>
<td></td>
<td>• German</td>
</tr>
<tr>
<td></td>
<td>• Italian</td>
</tr>
<tr>
<td></td>
<td>• Japanese</td>
</tr>
<tr>
<td></td>
<td>• Korean</td>
</tr>
<tr>
<td></td>
<td>• Portuguese (Brazilian)</td>
</tr>
<tr>
<td></td>
<td>• Spanish</td>
</tr>
<tr>
<td></td>
<td>• Turkish</td>
</tr>
</tbody>
</table>

### Localization roles for Virtual Agent

Assign localization roles according to a user’s scope in the localization process. Users may request translations, fulfill translation requests, and edit translations, based on their role.

The localization process follows this basic flow:

1. Topics are developed and released in the source language (English).
2. Topics are translated, either by request or by editing them directly in Virtual Agent Designer.
   
   If you are using NLU models, the models must be translated as well. For more information about that process, see [Multilingual model management](#).
3. Translations are tested and published.
Virtual Agent role privileges vary with the user’s function in this process. These roles are also defined in the Localization Framework. For more information, see Localization Framework roles.

### Virtual Agent localization roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Localization requestor</td>
<td>Requests translations for all the Virtual Agent components into one or more languages. Can also view localization insights. The Virtual Agent admin role contains this role by default.</td>
</tr>
<tr>
<td>Localization fulfiller</td>
<td>Provides translations for the requested Virtual Agent topics. Depending on the flow, duties may include:</td>
</tr>
<tr>
<td></td>
<td>• Editing the translations in the Localization Framework task.</td>
</tr>
<tr>
<td></td>
<td>• Interacting with third parties.</td>
</tr>
<tr>
<td></td>
<td>• Loading, verifying, and publishing translations.</td>
</tr>
<tr>
<td>Localization editor</td>
<td>Edits the translations directly in Virtual Agent Designer.</td>
</tr>
<tr>
<td></td>
<td>Add this role to a Virtual Agent admin group or user for this capability.</td>
</tr>
<tr>
<td></td>
<td>The NLU admin role contains this role by default.</td>
</tr>
<tr>
<td>Virtual Agent admin</td>
<td>Contains the localization requestor role by default.</td>
</tr>
</tbody>
</table>

### Virtual Agent admin permissions

The Virtual Agent admin role contains the localization requestor role by default, so the **Request translation** option is available. The user can view translations, but cannot edit them. The localization task is not available to this user.
Languages tab with Virtual Agent admin role

<table>
<thead>
<tr>
<th>Translations</th>
<th>NLU language mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>View, edit, or request translations for the topic using the ServiceNow Localization Framework. If you want to translate this topic into additional languages, you will need to activate NLU plugins. For assistance, check with your ServiceNow Administrator. To make this topic discoverable in other languages, bind it to other NLU language models: NLU language mapping.</td>
<td></td>
</tr>
<tr>
<td>This status reflects your most recent published state: 4/16/2021, 11:32:26 AM.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Language</th>
<th>Topic translation status</th>
<th>Translated content</th>
<th>Localization task</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Completely translated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>French</td>
<td>Translation in progress</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td>German</td>
<td>Translation in progress</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Italian</td>
<td>Partially translated</td>
<td></td>
<td>Request translation</td>
</tr>
<tr>
<td>Spanish</td>
<td>Partially translated</td>
<td>View</td>
<td></td>
</tr>
</tbody>
</table>

Request translations

Localization fulfiller permissions

The localization fulfiller role may not have Virtual Agent privileges. In that case, the user would only have access to assigned Localization Framework tasks.

If a Virtual Agent admin has the localization fulfiller role, the Languages tab lets the user view the localization task that was created.
Languages tab with Virtual Agent admin and localization fulfiller roles

Languages

Flow NLU Intent Properties Languages

Translations NLU language mapping

View, edit, or request translations for the topic using the ServiceNow Localization Framework. If you want to translate this topic into additional languages, you will need to activate IBM plugins. For assistance, check with your ServiceNow Administrator.

To make this topic discoverable in other languages, bind it to other NLU language models: NLU language mapping

This status reflects your most recent published state: 4/16/2021, 11:32:26 AM.

<table>
<thead>
<tr>
<th>Language</th>
<th>Topic translation status</th>
<th>Translated content</th>
<th>Localization task</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Completely translated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>French</td>
<td>Translation in progress</td>
<td>View</td>
<td>View task</td>
</tr>
<tr>
<td>German</td>
<td>Translation in progress</td>
<td>View</td>
<td>View task</td>
</tr>
<tr>
<td>Italian</td>
<td>Partially translated</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Spanish</td>
<td>Partially translated</td>
<td>View</td>
<td>Request translation</td>
</tr>
</tbody>
</table>

Request translations

Localization editor permissions

The localization editor role can be given to a Virtual Agent admin user. It allows them to add translations directly in Virtual Agent Designer and to unlock translations and modify them. This privilege is helpful if you are using machine translation in your process.
Languages tab with the Virtual Agent admin and localization editor roles

Table: Translations
<table>
<thead>
<tr>
<th>Language</th>
<th>Topic translation status</th>
<th>Translated content</th>
<th>Localization task</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Completely translated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>French</td>
<td>Translation in progress</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td>German</td>
<td>Translation in progress</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Italian</td>
<td>Partially translated</td>
<td>Edit</td>
<td>Request translation</td>
</tr>
<tr>
<td>Spanish</td>
<td>Partially translated</td>
<td>Edit</td>
<td>Request translation</td>
</tr>
</tbody>
</table>

Virtual Agent translation tables

Virtual Agent uses the [sys_translated_text] and [sys_ui_message] tables to store translated text.

Translation tables used by Virtual Agent

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translated Text</td>
<td>Stores translations for fields with the field type</td>
</tr>
<tr>
<td>[sys_translated_text]</td>
<td>translated_text or translated_html (see the dictionary entry).</td>
</tr>
<tr>
<td></td>
<td>The [sys_cs_topic] table contains the English keywords and topic titles.</td>
</tr>
<tr>
<td></td>
<td>It pulls translations from the [sys_translated_text] table.</td>
</tr>
<tr>
<td></td>
<td>For details about translating text content into different languages, see</td>
</tr>
<tr>
<td></td>
<td>Translated text table and Translating text fields.</td>
</tr>
<tr>
<td>Message</td>
<td>Stores translations for messages in Virtual Agent topics.</td>
</tr>
<tr>
<td>[sys_ui_message]</td>
<td>Pre-built topics have already been translated, but you must provide</td>
</tr>
<tr>
<td></td>
<td>translations for any content you create for your instance. For more</td>
</tr>
<tr>
<td></td>
<td>information about the Message table, see Message table.</td>
</tr>
</tbody>
</table>
Integrating Virtual Agent with other applications

Extend the capabilities of Virtual Agent by connecting to where your employees and customers already are—in web portals, Now® Mobile apps, and collaboration tools like Slack, Microsoft Teams, Facebook Messenger consumer app, Workplace from Facebook enterprise messaging app, and any other popular chat or messaging app.

Conversational custom chat integrations

Conversational custom chat integration framework is a powerful framework consisting of scriptable APIs and configurations to bring the ServiceNow® Virtual Agent to any conversational interface.

How custom chat integrations work

Virtual Agent Chat Server (VACS) supports the following chat client integration without enhancements or plugins:

- Slack
- Workplace by Facebook
- Microsoft Teams
- WhatsApp
- Conversational Integration with LINE
- ServiceNow® Service Portal
- ServiceNow® Now Mobile

If you’re using a chat client that is not in the list, you can create a custom integration using conversational custom chat integration framework.

You can use any channels that support conversational interfaces, such as Web Portals, Mobile Apps, Slack, Microsoft Teams, SMS, and any other channel and add ServiceNow® Virtual Agent to them.

With a conversational custom chat integration, you can manage and control how your end users’ chat experience. The framework helps transform messages from a chat client to VACS, and VACS back to the chat client in a format that renders well on your chat interface.
The transformation is carried out through a set of Flow Designer scripts. If you want more information on how to use Flow Designer, see Flow Designer.

**Basic integration using conversational custom chat integration framework**

You can use the following links to configure a basic custom chat integration. To see an example of a custom chat integration using Telegram Messenger, see the Telegram demo and integration on the ServiceNow Developer Site.

**Virtual Agent conversational custom chat integration configuration**

Create a conversational custom chat integration to support third-party chat clients so they can connect to the Virtual Agent Chat Server (VACS).

**Before you begin**

- Activate the Glide Virtual Agent plugin (com.glide.cs.chatbot) if it's not already activated. This plugin automatically activates the Conversational Custom Chat Integration plugin (com.glide.cs.custom.adapter) for custom chat integrations.
- Role required: admin

**About this task**

To integrate chat clients with Virtual Agent, follow these configuration steps and add action scripts to Flow Designer.

**Procedure**

1. Create or update an existing channel that you want to build the integration to.
   
   a. Navigate to `sys_cs_channel.list > Messaging Channel` and click **New**.
   
   b. On the form, fill in the fields.
## Messaging Channels form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your channel, such as Mobile App, SMS, and so on.</td>
</tr>
<tr>
<td>Opted in all topics by default</td>
<td>Option to make all topics available in this channel.</td>
</tr>
<tr>
<td>Enable Notifications</td>
<td>Option to turn notifications on or off on this channel.</td>
</tr>
<tr>
<td>Store app page link</td>
<td>This field should be left empty.</td>
</tr>
<tr>
<td>Type</td>
<td>Channel type.</td>
</tr>
<tr>
<td></td>
<td>• Chat: Standard chat experience</td>
</tr>
<tr>
<td></td>
<td>• Messaging: Long-running conversation</td>
</tr>
<tr>
<td>Conversation Idle Timeout</td>
<td>Number of seconds that abandoned Virtual Agent and Live Agent conversations remain open in the channel, after the requester's last response. This channel-specific value overrides the:</td>
</tr>
<tr>
<td></td>
<td>• Default idle conversation timeout value, which is 7200 seconds</td>
</tr>
<tr>
<td></td>
<td>• Idle conversation timeout value set through the <code>com.glide.cs.conversation_idle_timeout</code> system property to override the default timeout value</td>
</tr>
<tr>
<td></td>
<td>For more information on conversation idle timeouts, see Closing Virtual Agent and Live Agent conversations.</td>
</tr>
<tr>
<td>Secure</td>
<td>Option for the channel to be secure to support handling of sensitive data such as passwords.</td>
</tr>
<tr>
<td>Support typing indicator</td>
<td>Option to display typing indicators for this channel. Flag applies to bot indicators.</td>
</tr>
<tr>
<td>Live Agent Only</td>
<td>Option to initiate conversations with live agents, bypassing the Virtual Agent bot.</td>
</tr>
</tbody>
</table>
2. Configure a provider.
   Configure a new provider for each integration that you set up.

   a. Navigate to `sys_cs_provider.list > Messaging Provider` and click **New Custom** to create a record in the `sys_cs_provider` table.

   b. On the form, fill in the fields.

### Messaging Provider form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your provider application. For example: <code>VA SMS Twilio Adapter</code></td>
</tr>
<tr>
<td>Provider attributes action</td>
<td>Name of the provider attributes action script. The provider attributes action script can return a Provider auth token, a user identifier, user input, and context variables.</td>
</tr>
<tr>
<td>Response processor action</td>
<td>Name of the response processor action script. The Response processor action script performs platform actions. For example, updating a message status based on the response received for an outbound message.</td>
</tr>
</tbody>
</table>
| Version                      | Specify the version of the provider. The framework is able to send the expected inputs to actions and subflows and handle the expected outputs. There are 2 versions:  
   - 1.0.0 - The assumed version unless explicitly defined on the provider  
   - 1.1.0 - The `outbound_token` input parameter (from the provider channel identity) was added to invocations of the sender subflow/action |
| Send HTML as Image           | Option to convert an HTML bot response into an image and link. Used for chat interfaces that do not support HTML rendering. |
| Account Linking Enabled      | If enabled, you can link your account to an existing ServiceNow® profile.     |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>Channel that this provider supports and the one to which the integration is being built.</td>
</tr>
<tr>
<td>Sender action</td>
<td>The sender action script. The sender action script bundles the request and then sends the response via Flow Designer/IntegrationHub asynchronously.</td>
</tr>
<tr>
<td>Sender Subflow</td>
<td>The sender subflow script bundles the request and then sends the response via Flow Designer (FD)/Integration Hub (IH) asynchronously.</td>
</tr>
<tr>
<td>Contextual action</td>
<td>Name of the contextual action script. The contextual action script supports custom contextual actions.</td>
</tr>
</tbody>
</table>

c. Click **Submit**.

### 3. Set up message authentication.
You can create a Hash Message Verification record and Message Auth record to set up message authentication.

a. Navigate to `hash_message_verification.list > Hash Message Verifications` and click **New**.

b. On the form, fill in the fields.

#### Hash Message Verification form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the authentication token, such as TwilioSMSTestAppAuthToken.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the authentication token, such as &quot;Twilio SMS Testing application Auth Token.&quot;</td>
</tr>
<tr>
<td>Secret</td>
<td>Authentication token from your phone number.</td>
</tr>
</tbody>
</table>

c. Navigate to `message_auth.list > Message Auth` and click **New**.

d. On the form, fill in the fields.
### Message Auth form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the message authentication, such as VA Twilio SMS Test App Message Authentication.</td>
</tr>
<tr>
<td>Provider</td>
<td>Provider, such as Twilio.</td>
</tr>
<tr>
<td>Group name</td>
<td>Name of the group or team of the provider channel.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>Option to redirect users to a service portal for authentication during account linking.</td>
</tr>
<tr>
<td>Inbound message verification</td>
<td>Hash message token that was created.</td>
</tr>
<tr>
<td>Outbound message creation</td>
<td>Hash message token that was created.</td>
</tr>
<tr>
<td>Outbound service token</td>
<td>Token passed to the sender subflow which is used to invoke REST endpoint for the chat client. Use the outbound token to send a message using the REST API.</td>
</tr>
</tbody>
</table>

4. Create a channel identifier.

**a.** Navigate to `sys_cs_provider_application.list > Provider Channel Identity` and click **New**.

**b.** On the form, fill in the fields.

### Provider Channel Identity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the channel identity, for example: VA SMS Twilio Adapter</td>
</tr>
<tr>
<td>Provider</td>
<td>Select the name of your provider application that you set up in step 2, for example: VA SMS Twilio Adapter Pro.</td>
</tr>
<tr>
<td>Message auth</td>
<td>Select message authentication for the channel identifier that you set up in step 3.</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Inbound ID</td>
<td>Identifier for your bot, for example the phone number.</td>
</tr>
<tr>
<td>Trusted media domains</td>
<td>Comma-separated list of one or more trusted domains for the provider. For example: <code>twilio.com, slack.com</code></td>
</tr>
</tbody>
</table>

**Note:** Subdomains under a trusted domain are also trusted. You do not need to specify subdomains in this list.

For security reasons, Virtual Agent checks that the URLs for attachments in conversations are from trusted domains specified here. If the URL is not for a trusted domain, Virtual Agent doesn’t upload the attachment.

If an attachment upload fails because Virtual Agent didn’t trust the domain, Virtual Agent does not inform the end user why the attachment upload failed.

<table>
<thead>
<tr>
<th>Default Portal</th>
<th>Portal in which chat links to ServiceNow records are opened by default, including links in cards used for Virtual Agent notifications and AI Search results.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Description for your channel identifier.</td>
</tr>
</tbody>
</table>

c. Click **Submit**.

d. **Optional:** Create additional channel identifiers using the same procedure.

5. Select rich controls for inbound (user input) and outbound (bot response) transformation.

You can create a record for rich controls in the Custom Adapter Configurations [sys_cs_custom_adapter_config] table. If a rich control is missing an outbound transformer implementation, a response is not served to the end user and that user may get an unsatisfactory chat experience.

a. Navigate to `sys_cs_custom_adapter_config.list` > **Custom Adapter Configuration** and click **New**.

b. On the form, fill in the fields.
### Custom Adapter Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider</td>
<td>Provider that you created.</td>
</tr>
<tr>
<td>Control type</td>
<td>Control type, such as Boolean.</td>
</tr>
<tr>
<td>Inbound transformer action</td>
<td>Name of the inbound transformer action script for this rich control, such as,</td>
</tr>
<tr>
<td></td>
<td>sn_va_sms_twilio.va_sms_twilio_adapter_input_text_inbound_transformer.</td>
</tr>
<tr>
<td>Outbound transformation action</td>
<td>Name of the outbound transformer action script for this rich control, such as,</td>
</tr>
<tr>
<td></td>
<td>sn_va_sms_twilio.va_sms_twilio_adapter_input_text_outbound_transformer.</td>
</tr>
</tbody>
</table>

ActionRichControl is a component with some special handling. ServiceNow® Virtual Agent produces the following types of action messages through this framework. Custom chat interface only recognizes certain action message types:

- `SeparatorActionMsg | actionMsg instanceof`
- `SystemActionMsg | actionMsg instanceof`
- `TopicFinishedActionMsg | actionMsg instanceof`
- `SwitchToVirtualAgentActionMsg | actionMsg instanceof`
- `SwitchConversationActionMsg | actionMsg instanceof`
- `ChatSubHeaderActionMsg | actionMsg instanceof`
- `StartSpinnerActionMsg | actionMsg instanceof EndSpinnerActionMsg`

ActionRichControl wraps these messages inside the `actionMsg` element. So, a single outbound transformer for ActionRichControl can handle all of these messages. There is no need for an inbound transformer for this component.

6. Create a scripted REST API.

   a. Navigate to **System web services > Scripted Web Services > Scripted REST APIs**, and click **New**.

   b. On the form, fill in the fields.
### Scripted REST Service form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your API, such as ACME Mobile App Chat Adapter.</td>
</tr>
<tr>
<td>API ID</td>
<td>API ID, such as acme_chat.</td>
</tr>
<tr>
<td>Protection policy</td>
<td>Set a protection policy for the script.</td>
</tr>
<tr>
<td>Application</td>
<td>Select the application containing the script record. Global is select by default.</td>
</tr>
<tr>
<td>API namespace</td>
<td>Select the namespace the API belongs to. The value depends on the current application scope.</td>
</tr>
</tbody>
</table>

**c. Optional:** Navigate to Related Links Enable Versioning and click **OK**.

**d. Click **Update**.**

7. **Add a scripted REST resource.**
   The scripted REST resource defines the scripted REST API definition that you created.

   **a. Navigate to Related LinksResources** tab, and click **New**.
   Retrieve the payload from the request, and write it to a hybrid queue.

   **b. On the form, fill in the fields.**

### Scripted REST Resource form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API Definition</td>
<td>Name of the parent API.</td>
</tr>
<tr>
<td>Application</td>
<td>Select the application containing the script record.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of your API REST Resource, such as ACME chat.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the REST resource active.</td>
</tr>
<tr>
<td>HTTP method</td>
<td>HTTP method, such as POST, GET, and so on.</td>
</tr>
<tr>
<td>Relative path</td>
<td>Relative path to the resource.</td>
</tr>
<tr>
<td>Script</td>
<td>Script for the REST resource.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>API version</td>
<td>API version, such as v1.</td>
</tr>
<tr>
<td>Protection policy</td>
<td>Policy to make the resource read-only so you can protect it.</td>
</tr>
</tbody>
</table>

**Example of a scripted REST resource:**

```javascript
(function process(/*RESTAPIRequest*/ request, /*RESTAPIResponse*/ response) {
    var body = request.body;
    var queryParams = request.queryParams; // incoming content is application/x-www-form-urlencoded in this example
    // get the provider application sys id. this can be done via a glide query using incoming data such as where the original message is being sent to. or it can be hard-coded such as this example.
    var providerAppId = "a5f8b75b7377001042281188caf6a73a";
    // the time of receipt is recorded for analytics purposes
    var d = new Date();
    var logTime = d.getTime();
    // add this message to the VA Server queue for processing
    var queued = sn_cs.VASystemObject.enqueueCustomAdapterMessage(providerAppId, JSON.stringify(queryParams), JSON.stringify(request.headers), logTime);
    if (queued == false) {
        response.setError(new sn_ws_err.BadRequestError('Failed to process the request.'));
    }
})(request, response);
```

8. **Set security and content negotiation.**
   Choose to set authentication and request formats. If your adapter does not rely on authentication, you may want to remove it.
   a. Click the **Security** tab.
   b. Clear **Requires authentication**.
   c. Navigate to the **Content Negotiation** tab, and select **Override supported request formats**.
   d. Click **Submit**.

9. **Set REST API rate limits.**
   Navigate to **REST API > Rate Limit Rules** and define the rate of incoming requests.
   • REST API is the conversational custom chat integration API
   • Role = "Public"

10. **Create the action scripts.**
Set up the transforms that you need for the CAF to communicate through the chat process.

a. Navigate to the Flow Designer > Actions tab.

b. Create the scripts that you require to complete the conversational custom chat integration.

For details on the input and output used in action scripts, along with script examples, see Virtual Agent action scripts.

Virtual Agent action scripts
You need to write a set of mandatory Flow Designer action and subflow scripts to pass the user data to VACS, apply transformations and send the response back to your chat interface endpoint.

Provider and inbound/outbound scripts
A provider, such as Twilio, provides the chat capability. User action scripts perform provider actions, as well as conversational custom chat integration configuration for inbound and outbound transformer actions for your chatbot or custom conversations. Examples of each script are provided. They include a description of what each script does, as well as the action input and action output. You also see examples of the script JSON.

You use Flow Designer to build these scripts to transform server and client messages. The provider, sender, and inbound/outbound transformer scripts are required. You can use the additional scripts to add more functionality to your chat.

<table>
<thead>
<tr>
<th>Script name</th>
<th>Purpose</th>
<th>Required (Y/N)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider attribute</td>
<td>Contains a Provider Auth token, a user identifier, user input, and context variables.</td>
<td>Y</td>
</tr>
<tr>
<td>Sender action</td>
<td>Bundles the request, and sends a response asynchronously via Flow Designer/Integration Hub.</td>
<td>Y</td>
</tr>
<tr>
<td>Response processor</td>
<td>Performs platform actions, such as an update message status, that's based on a response received for an outbound message.</td>
<td>N</td>
</tr>
</tbody>
</table>
### Scripts (continued)

<table>
<thead>
<tr>
<th>Script name</th>
<th>Purpose</th>
<th>Required (Y/N)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contextual action</td>
<td>Supports contextual actions.</td>
<td>N</td>
</tr>
<tr>
<td>Link account action</td>
<td>Provides a callback about whether account linking was successful or not.</td>
<td>N</td>
</tr>
<tr>
<td>Outbound transformer</td>
<td>Transforms a chat server's supported control to chat interface-specific rendering.</td>
<td>Y</td>
</tr>
<tr>
<td>Inbound transformer</td>
<td>Optional. You can use the default rich controls if they apply to your chat provider. You do not need to provide a separate inbound transform for each input control. If a default behavior does not work, you can override the default with your own inbound transform for a specific Virtual Agent server control.</td>
<td>Y</td>
</tr>
</tbody>
</table>

### Provider attributes action script

The provider attributes action script extracts data from the incoming message. The script knows about the conversational custom chat integration protocol and outputs the content of the incoming message, the user ID of the sender, and an optional authentication token.

⚠️ **Note:** If your provider attributes action script has a contextual action, your script must have both the `request_context.contextual_action` and `request_context.typed_value` so that the user input (which is matched to a contextual action) is included in the transcript. If you do not set the `request_context.typed_value`, that message content does not appear in the transcript.

### Provider attributes action script input/output

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Headers (JSON) - Request headers</td>
<td>• Token (String) - Authentication token.</td>
</tr>
<tr>
<td>• Payload (JSON) - Request body</td>
<td>• provider_user_id (String) - Name of the sender, for example, a user name in a Slack message.</td>
</tr>
</tbody>
</table>
Provider attributes action script input/output (continued)

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>• request_context (JSON) - Actual content received.</td>
<td>◦ typed_value - Typed content such as an answer to a question.</td>
</tr>
<tr>
<td>◦ attachment_value.url - URL of the attachment.</td>
<td>◦ attachment_value.content_type - Content type of the attachment.</td>
</tr>
<tr>
<td>◦ attachment_value.name - File name of the attachment.</td>
<td>◦ contextual_action - Action to perform, such as END_CONVERSATION, START_CONVERSATION, AGENT. This script looks at the incoming message. If there is a recognized keyword, then one of the actions can be set, such as outputs.request_context.contextual_action = &quot;END_CONVERSATION&quot;; The framework recognizes this keyword and invokes the contextual action script.</td>
</tr>
<tr>
<td>◦ context_vars - Contextual variables to pass into a conversation, such as <code>outputs.request_context.context_vars = {language: &quot;en&quot;};</code></td>
<td></td>
</tr>
</tbody>
</table>

Example: Flow Designer provider attributes action script input, including headers and payload

<table>
<thead>
<tr>
<th>Action Outline</th>
<th>Action Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Script step script</td>
</tr>
<tr>
<td>Outputs</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Example: Flow Designer provider attributes action script output, including token, request_context, and provider_user_id

![Flow Designer Provider Attributes](image)

Example: Provider attributes action script

```javascript
(function execute(inputs, outputs) {
  var headers = inputs.headers;
  var payload = inputs.payload;

  // check if an authentication token was included. this is optional.
  var smsUtil = new VASMSTwilioUtil();
  outputs.token = JSON.stringify(smsUtil.getToken(headers, payload));

  var data = payload.data;
  var request_context = {};
  // inspect the actual message. it could be an MMS (attachment) or raw text
  if (data['MediaUrl0']) {
    var attachment_value = {};
    attachment_value.url = data['MediaUrl0'];
    attachment_value.content_type = data['MediaContentType0'];
    attachment_value.name = smsUtil.getFileName(attachment_value.url, attachment_value.content_type);
    request_context.attachment_value = attachment_value;
  } else {
    request_context.typed_value = data['Body'];
  }

  // set the mandatory outputs
  outputs.request_context = request_context;
  outputs.provider_user_id = data.From;
})(inputs, outputs);
```

Sender action script (Decommissioned in Quebec see sender subflow)

The sender action script knows how to send a message to the provider. The script should asynchronously invoke a Flow Designer/IntegrationHub subflow.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Virtual Agent is freed to continue processing messages rather than trying to send external requests.

### Sender action script input

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Results (JSON) - Array of messages to send.</td>
<td>None</td>
</tr>
<tr>
<td>• Payload (JSON) - Last payload received from a requester.</td>
<td></td>
</tr>
<tr>
<td>• app_inbound_id (String) - Identifier of the sender, such as the &quot;From&quot; phone number in an SMS case.</td>
<td></td>
</tr>
<tr>
<td>• channel_user_id (String) - Identifier of the recipient, such as the &quot;To&quot; phone number in an SMS case.</td>
<td></td>
</tr>
</tbody>
</table>

### Example: Sender action script

```javascript
(function execute(inputs, outputs) {
    var results = inputs.results;
    // transform the inputs to something this custom subflow knows about
    var sendInputs = {
        app_inbound_id: inputs.app_inbound_id,
        channel_user_id: inputs.channel_user_id,
        messages: JSON.stringify(results)
    };
    // invoke an asynchronous subflow which will send the external request. so this sender
    // script will immediately return,
    // freeing up the chat server thread to do further message processing while putting the
    // external request work on the
    // Flow Designer/Integration Hub
    sn_fd.FlowAPI.startSubflowQuick('sn_va_sms_twilio.va_sms_twilio_adapter_send_sms',
        sendInputs);
})(inputs, outputs);
```

### Sender subflow script

The sender subflow script knows how to send a message to the provider. The script should asynchronously invoke a Flow Designer/IntegrationHub subflow. The Virtual Agent is freed to continue processing messages rather than trying to send external requests. When creating a subflow do not have an action call an action within the subflow.
} else {
    outputs.sendmessage = true;
    messages = inputs.results.results;
    outputs.from = from;
    outputs.to = to;
    outputs.messages = getMessages(messages);
}

## Contextual action script
The contextual action script performs special keyword actions such as typing `agent` while inside a Virtual Agent topic to get immediately handed off to a live agent.

### Contextual action script Input

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>• conversation_id (String) - The conversation ID.</td>
<td>None</td>
</tr>
<tr>
<td>• request_context (JSON) - Request passed from the provider attribute script that contains the action to perform, such as (END_CONVERSATION, START_CONVERSATION, AGENT).</td>
<td></td>
</tr>
</tbody>
</table>

### Example: Contextual action script

```javascript
(function execute(inputs, outputs) {
    var contextual_action = inputs.request_context.contextual_action;
    if (contextual_action === "END_CONVERSATION") {
        sn_cs.VASystemObject.endConversation(inputs.conversation_id);
    } else if (contextual_action === "AGENT") {
        sn_cs.VASystemObject.switchToLiveAgent(inputs.conversation_id);
    } else if (contextual_action === "START_CONVERSATION") {
        sn_cs.VASystemObject.startConversation(inputs.conversation_id);
    }
})(inputs, outputs);
```

## Link account action script
The link account action script contains identifiers for the user who is linking. The script also contains the account that it is linked to.
### Link account action script Input

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>provider_user_id (String)</td>
<td>- Identifier of the user who is linking, such as a phone number in an SMS case.</td>
</tr>
<tr>
<td>status (String)</td>
<td>Success/failure.</td>
</tr>
<tr>
<td>user_id (String)</td>
<td>ServiceNow user_sys_id for the account that was linked to.</td>
</tr>
</tbody>
</table>

#### Example: Link account action script

```javascript
(function execute(inputs, outputs) {
    var richControl = (inputs.rich_control);
    var value = richControl.value;
    outputs.result = richControl.header + ': ' + value.action;

})(inputs, outputs);
```

### Response processor action script

The response processor action script performs specialty actions that are based on the response to a send message request. The framework already does basic message status tracking.

### Response processor account action script input

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>message_id (String)</td>
<td>Identifier of sys_cs_message record that is associated with this response.</td>
</tr>
<tr>
<td>headers (JSON)</td>
<td>Headers that are received.</td>
</tr>
<tr>
<td>body (String)</td>
<td>Body that is received.</td>
</tr>
<tr>
<td>status code (Integer)</td>
<td>The HTTP status code that is received.</td>
</tr>
</tbody>
</table>

#### Example: Response processor action script

```javascript
(function execute(inputs, outputs) {
    gs.debug("Response from provider: message_id = " + inputs.message_id + ", status_code = " + 
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
inputs.status_code + ", headers = " + JSON.stringify(inputs.headers) + ", body = " + inputs.body); }}(inputs, outputs);

### Default rich controls

The following default rich controls map to input and output rich controls.

#### Default input and output rich controls

<table>
<thead>
<tr>
<th>Rich control</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent info example</strong></td>
<td></td>
</tr>
</tbody>
</table>
| If rich control is sent from a live agent, then the agentInfo attribute is added to the rich control. | { uiType: "someType",
group: "someGroup"
agentInfo: { sentFromAgent: true } // please note that this object may contain more info in subsequent releases.
... } |

<table>
<thead>
<tr>
<th><strong>DefaultPicker</strong></th>
<th>maps to File Picker, Topic Picker, and Boolean controls</th>
</tr>
</thead>
</table>
| { uiType: "Picker/TopicPicker/Boolean",
group: "DefaultPicker",
nluTextEnabled: true/false,
promptMsg: ", // optional (needed for TopicPicker)
label: "The question for the list", // always filled
itemType: "Picture/List" // needed to user key to expect picture attached
options: [ |
{| label: "display label prompt",
value: "the value required to satisfy the question",
description: "a description of value_1 item"
attachment: "www.foo",
enabled: true/false
},
... ] } |
## Default input and output rich controls (continued)

<table>
<thead>
<tr>
<th>Rich control</th>
<th>Example</th>
</tr>
</thead>
</table>
| **DefaultText**  
Maps to Input text, Output Text, and File Upload controls | ```
{
  uiType: "InputText/OutputText/FileUpload/Picture",
  group: "DefaultText",
  required: true/false,
  nluTextEnabled: true/false,
  itemType: "file/image/inputtext/outputtext",
  maskType: "SECURE/SENSITIVE/NONE" // null except for InputText/OutputText
  label: "The Question?"
}
``` |
| **DefaultDate**  
Maps to Date and Date and Time controls | ```
{
  uiType: "Date/DateTime/Time",
  group: "DefaultDate",
  required: true/false,
  nluTextEnabled: true/false,
  label: "The Question?"
}
``` |
| **DefaultOutputLink** | ```
{
  uiType: "OutputLink",
  group: "DefaultOutputLink",
  label: "link label",
  header: "link header",
  type: "link",
  value: {
    action: "www.foo",
  }
}
``` |
| **DefaultOutputImage** | ```
{
  uiType: "OutputImage",
  group: "DefaultOutputImage",
  value: "www.foo"
}
``` |
### Default input and output rich controls (continued)

<table>
<thead>
<tr>
<th>Rich control</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>DefaultOutputCard</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>uiType: &quot;OutputCard&quot;</td>
</tr>
<tr>
<td></td>
<td>group: &quot;DefaultOutputCard&quot;</td>
</tr>
<tr>
<td></td>
<td>templateName: &quot;Card&quot;</td>
</tr>
<tr>
<td></td>
<td>data: &quot;some json data string&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td>DefaultOutputHtml</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>uiType: &quot;OutputHtml&quot;</td>
</tr>
<tr>
<td></td>
<td>group: &quot;DefaultOutputHtml&quot;</td>
</tr>
<tr>
<td></td>
<td>style: &quot;inline&quot;</td>
</tr>
<tr>
<td></td>
<td>height: 100</td>
</tr>
<tr>
<td></td>
<td>width: 100</td>
</tr>
<tr>
<td></td>
<td>value: &quot;&lt;div&gt;html&lt;/div&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td>DefaultOutputTable</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>uiType: &quot;OutputTable&quot;</td>
</tr>
<tr>
<td></td>
<td>group: &quot;DefaultOutputTable&quot;</td>
</tr>
<tr>
<td></td>
<td>label: &quot;Table Title&quot;</td>
</tr>
<tr>
<td></td>
<td>headers: [&quot;Column 1&quot;, &quot;Column 2&quot;]</td>
</tr>
<tr>
<td></td>
<td>navigationBtnLabel: &quot;See next&quot;</td>
</tr>
<tr>
<td></td>
<td>data: [</td>
</tr>
<tr>
<td></td>
<td>[&quot;foo1&quot;, &quot;foo2&quot;],</td>
</tr>
<tr>
<td></td>
<td>[&quot;bar1&quot;, &quot;bar2&quot;]</td>
</tr>
<tr>
<td></td>
<td>]</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td>DefaultGroupedPartsOutputControl</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>uiType: &quot;GroupedPartsOutputControl&quot;</td>
</tr>
<tr>
<td></td>
<td>group: &quot;DefaultGroupedPartsOutputControl&quot;</td>
</tr>
<tr>
<td></td>
<td>groupPartType: &quot;Link&quot;</td>
</tr>
<tr>
<td></td>
<td>header: &quot;header message&quot;</td>
</tr>
<tr>
<td></td>
<td>values: [</td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>action: &quot;www.foo&quot;,</td>
</tr>
<tr>
<td></td>
<td>description: &quot;description&quot;,</td>
</tr>
<tr>
<td></td>
<td>label: &quot;link_1 label&quot;,</td>
</tr>
<tr>
<td></td>
<td>context: &quot;ITSM&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>
## Default input and output rich controls (continued)

<table>
<thead>
<tr>
<th>Rich control</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>...</td>
<td>]</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>
| **DefaultMultiPartOutput** | {
|              | uiType: "MultiPartOutput", |
|              | group: "DefaultMultiPartOutput" |
|              | navigationBtnLabel: "Go next", |
|              | content: { |
|              | uiType: "OutputHtml", |
|              | style: "inline", |
|              | type: "html", |
|              | height: 100, |
|              | width: 100, |
|              | value: "<div>html</div>" |
|              | } |
|             | }     |
| **DefaultCustomControl** | {
|              | uiType: "CustomControl", |
|              | group: "DefaultCustomControl", |
|              | name: "The name of the Custom Control (sys_cs_custom_control.name)", |
|              | required: true/false, |
|              | uxComponentDefinitionSysId: "seismicComponentId" // or null if not |
|              | isInput: true/false, // whether to wait for a |
|              | response value or if just output |
|              | serializedControlData: "User defined JSON from |
|              | generateControlData function"; |
|              | } |

## Outbound transformer scripts

The outbound transformer scripts convert outgoing Virtual Agent messages to a protocol that is related to the conversational custom chat integration.

**Input**
• rich_controls (JSON) - Virtual Agent server rich control component that must be transformed.
• payload (JSON) - Last response that was received from a requester.

Output
• result (String) - Provider-appropriate component message to send.

Examples: Outbound transformer scripts

<table>
<thead>
<tr>
<th>Outbound transformer name</th>
<th>Script example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Agent - SMS Twilio Adapter Default Text</td>
<td>(function execute(inputs, outputs) { var rich_control = inputs.rich_control;</td>
</tr>
<tr>
<td>Outbound Transformer</td>
<td>outputs.result = rich_control['label'];</td>
</tr>
<tr>
<td></td>
<td>})(inputs, outputs);</td>
</tr>
<tr>
<td>Virtual Agent - SMS Twilio Adapter Default Link</td>
<td>(function execute(inputs, outputs) { var richControl = (inputs.rich_control);</td>
</tr>
<tr>
<td>Outbound Transformer</td>
<td>var value = richControl.value;</td>
</tr>
<tr>
<td></td>
<td>outputs.result = richControl.header + ': ' + value.action;</td>
</tr>
<tr>
<td></td>
<td>})(inputs, outputs);</td>
</tr>
<tr>
<td>Virtual Agent - SMS Twilio Adapter Default Picker</td>
<td>(function execute(inputs, outputs) { var rich_control = inputs.rich_control;</td>
</tr>
<tr>
<td>Outbound Transformer</td>
<td>var options = rich_control['options'];</td>
</tr>
<tr>
<td></td>
<td>if (options &amp;&amp; options.length &gt; 0) {</td>
</tr>
<tr>
<td></td>
<td>var optionsLength = options.length;</td>
</tr>
<tr>
<td></td>
<td>var picker = rich_control['label']</td>
</tr>
<tr>
<td></td>
<td>for (var x = 0; x &lt; optionsLength; x++) {</td>
</tr>
<tr>
<td></td>
<td>picker += &quot;\n&quot; + (x+1) + &quot;: &quot; + options[x].label;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>outputs.text_message = picker;</td>
</tr>
<tr>
<td></td>
<td>})(inputs, outputs);</td>
</tr>
<tr>
<td>Virtual Agent - SMS Twilio Adapter Default Multi Link</td>
<td>(function execute(inputs, outputs) { var rich_control = inputs.rich_control;</td>
</tr>
<tr>
<td>Outbound Transformer</td>
<td>var linkResult = rich_control['header'];</td>
</tr>
<tr>
<td></td>
<td>var totalValues = rich_control['values'].length;</td>
</tr>
<tr>
<td></td>
<td>for (var i = 0; i &lt; totalValues; i++) {</td>
</tr>
<tr>
<td></td>
<td>}}</td>
</tr>
</tbody>
</table>
### Examples: Outbound transformer scripts (continued)

<table>
<thead>
<tr>
<th>Outbound transformer name</th>
<th>Script example</th>
</tr>
</thead>
</table>
| linkResult = linkResult + '
';    |                                                                                                                                               |
| var linkValue = rich_control['values'][i]; |                                                                                                                                               |
| linkResult = linkResult + '
' +  |                                                                                                                                               |
| linkValue['description'] + ': ' +  |                                                                                                                                               |
| linkValue['action'];               |                                                                                                                                               |
| }                                  |                                                                                                                                               |
| outputs.result = linkResult;       |                                                                                                                                               |
| })(inputs, outputs);               |                                                                                                                                               |

```javascript
(function execute(inputs, outputs) {
  var richControl = (inputs.rich_control);
  var data = JSON.parse(richControl.data);
  var tableTitle = data.title;
  var fields = data.fields;
  var subtitle = data_subtitle;
  var url = data.url;
  var message = subtitle ? getCardLine(tableTitle, subtitle) : tableTitle + '
';
  for (var i= 0; i<fields.length; i++) {
    message += getCardLine(fields[i].fieldLabel, fields[i].fieldValue);
  }
  message += url;
  outputs.result = message;

  function getCardLine(key, value) {
    if (value == '' || value == null || key == '' ||
    key == null)
      return;
    return key + ': "' + value + '"';
  }
})(inputs, outputs);
```

### Virtual Agent - SMS Twilio Adapter Default Card Outbound Transformer

```javascript
(function execute(inputs, outputs) {
  var richControl = (inputs.rich_control);
  var data = JSON.parse(richControl.data);
  var tableTitle = data.title;
  var fields = data.fields;
  var subtitle = data.subtitle;
  var url = data.url;
  var message = subtitle ? getCardLine(tableTitle, subtitle) : tableTitle + '
';
  for (var i= 0; i<fields.length; i++) {
    message += getCardLine(fields[i].fieldLabel, fields[i].fieldValue);
  }
  message += url;
  outputs.result = message;

  function getCardLine(key, value) {
    if (value == '' || value == null || key == '' ||
    key == null)
      return;
    return key + ': "' + value + '"';
  }
})(inputs, outputs);
```

### Inbound transformer scripts

The inbound transformer scripts convert incoming conversational custom chat integration messages to a protocol that the Virtual Agent recognizes. It determines the required value to be injected into the rich control that is presented to the user.

#### Input
• request_context (JSON) - The request passed from the Provider Attribute script.
• rich_control (JSON) - The last rich control sent to the requester that contains
  the original "question".

Output

• result (JSON) - The result expected by the Virtual Agent server. If the requester
  is responding to a topic picker, it is the sys_id of the topic. If the requester is
  responding to an input text, it is the text response.
  ○ value - sys_id or text value.
  ○ search_text - Text that is used if the requester selected something that was
    unexpected. For example, a user typed something that the NLU could assist
    with, such as, "None of these options match what I want" in response to a
    topic picker component.

Examples: Inbound transformer scripts

<table>
<thead>
<tr>
<th>Inbound transformer name</th>
<th>Script example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Agent - SMS Twilio Adapter</td>
<td></td>
</tr>
<tr>
<td>Default Text</td>
<td>(function execute(inputs, outputs) {</td>
</tr>
<tr>
<td>Inbound Transformer</td>
<td>var requestContext = inputs.request_context;</td>
</tr>
<tr>
<td>Purpose: Find the text response to the</td>
<td>var richControl = inputs.rich_control;</td>
</tr>
<tr>
<td>InputText question posed</td>
<td>var typedValue = requestContext['typed_value'];</td>
</tr>
<tr>
<td></td>
<td>var attachmentValue =</td>
</tr>
<tr>
<td></td>
<td>requestContext['attachment_value'];</td>
</tr>
<tr>
<td></td>
<td>var smsUtil = new VASMSTwilioUtil();</td>
</tr>
<tr>
<td></td>
<td>var result = {};</td>
</tr>
<tr>
<td></td>
<td>if(richControl['itemType'] == 'image'</td>
</tr>
<tr>
<td></td>
<td>richControl['itemType'] == 'file') {</td>
</tr>
<tr>
<td></td>
<td>if (attachmentValue &amp;&amp;</td>
</tr>
<tr>
<td></td>
<td>attachmentValue.content_type.includes('image')) {</td>
</tr>
<tr>
<td></td>
<td>result.url = attachmentValue.url;</td>
</tr>
<tr>
<td></td>
<td>result.content_type =</td>
</tr>
<tr>
<td></td>
<td>attachmentValue.content_type;</td>
</tr>
<tr>
<td></td>
<td>result.name = attachmentValue.name;</td>
</tr>
</tbody>
</table>
|                                        |         result.headers = attachmentValue.headers;
|                                        |   } else if (typedValue) {                       |
|                                        |     result.url = typedValue;                    |
|                                        |     var contentType =                          |
|                                        |     smsUtil.getContentType(typedValue);        |
|                                        |     if (typeof contentType === 'undefined')    |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Examples: Inbound transformer scripts (continued)

<table>
<thead>
<tr>
<th>Inbound transformer name</th>
<th>Script example</th>
</tr>
</thead>
<tbody>
<tr>
<td>g.error('Please enter a valid image link. Inbound image link: {0}', typedValue); else result.content_type = contentType; } else { g.error('Please upload an image or enter a valid image link.'); } result['value'] = typedValue; result['search_text'] = ''; outputs.result = result;</td>
<td>(function execute(inputs, outputs) { var request_context = inputs.request_context; var rich_control = inputs.rich_control; var selectedValue = request_context['typed_value']; var result = {}; result['value'] = ''; result['search_text'] = ''; if (rich_control['options']) { var options = rich_control['options']; var optionsLength = options.length; selectedValue === Number(selectedValue) if (selectedValue &gt; 0 &amp;&amp; selectedValue &lt;= optionsLength) { var selectedOption = options[selectedValue - 1]; result['value'] = selectedOption.value; } else { result['search_text'] = request_context['typed_value']; } } outputs.result = result; })(inputs, outputs);</td>
</tr>
</tbody>
</table>

**Virtual Agent - SMS Twilio Adapter Default Picker Inbound Transformer**

**Purpose:** Find the sys_id of the option that the user selected for this picker question. This script uses the same algorithm of the outbound transformer. If no options are selected, and the user typed something instead, then the "search_text" is set and fed into NLU if it is enabled on this instance.
Additional supported Virtual Agent and Live Agent features

The chat integrations framework supports a multitude of Virtual Agent and Live Agent features to provide a robust conversational experience.

Features supported in the Rome release

Enable packaging and publishing of custom controls to an existing chat integration

Customers and partners can add their own implementation of a custom control per provider by publishing a newer version of a custom control to an existing chat integration. This involves publishing appropriate Inbound and Outbound Flow Designer action scripts and updating the configuration Sub type in the Custom Adapter Configuration [sys_cs_custom_adapter_config] table. For configuration information, see Integrate custom controls.

Ensure message delivery order to Custom Chat Integration Framework clients

Enable the Maintain message ordering option in the Provider Channel [sys_cs_provider] table to control the order in which messages are delivered. You can also review the message order and status in the Custom Adapter Message [sys_cs_ca_message] table. For details, see Message delivery order.

API to fill card templates with data for outbound transformation

Use this API to fill card templates with data from the RichControl in the card outbound transformer. You can add JSON or HTML data to the Adapter Card Templates [sys_cs_adapter_card] table. This feature is not supported in ServiceNow Conversational Integrations with Slack and Microsoft Teams.

Channel-level flag to initiate conversations with live agents, bypassing Virtual Agent

Enable the Live Agent Only option in the Messaging Channels [sys_cs_channel] table to route conversations directly to a live agent and skip the Virtual Agent conversation greeting. If an agent isn't available, the message No agent available is displayed to the user. For channel configuration information, see Create or update an existing channel.

Pass the agent avatar and name if enabled in the Chat Setup form

When the Show Agent Names and Avatars field is enabled in the Chat Setup form, the Custom Chat Integration Framework
passes the agent name and avatar to the chat client. For more information, see Configure live agent chat.

**Provide post-chat survey support**

After a chat ends, the post-chat survey runs automatically for:

- Virtual Agent conversations if the Feedback setup topic is enabled. For details on the Survey setup topic type and how it works in a conversation, see Working with setup topics.
- Live Agent conversations if you've configured a post-chat survey at the queue level. For more information, see Define post-chat survey configurations.

**Support the End Conversation contextual action in Virtual Agent conversations**

Requesters engaged in bot conversations can use the **bye** contextual action to end the conversation. The bot then displays options for the user to end the conversation or to cancel the request and resume the conversation.

**Specify the default portal for URL navigation at the Provider Channel Identity level**

For a provider channel, specify the portal in which chat links, including links in output cards and cards for Virtual Agent notifications and AI Search results, are opened. For details on setting the default portal in the Provider Channel Identities [sys_cs_provider_application] table, see Step 4, Create a channel identifier. To learn more about URL navigation, see Set the URL navigation for chat links.

**User authentication, authorization, and secure connection setup**

- **Synchronous authentication of messages**— Provider authentication is synchronous. They will get an immediate response with the request successful or failure code. Starting with the Paris release, asynchronous authentication is no longer supported. For configuration information, see Synchronous authentication of messages.

- **Account auto-linking**— Allow a user's third-party account to be auto-linked to their ServiceNow® profile. This feature bypasses the prompt for the user to link their accounts manually. Without account linking, conversations take place in Guest mode. For configuration information, see Account auto-linking.

- **Configure the output response REST endpoint and outbound authentication for the Virtual Agent API**— Specify the outbound endpoint URL to which the
Virtual Agent responses are posted and configure outbound authentication. For configuration information, see Outbound authentication using a token.

- Secure data transfer—Sensitive data such as passwords can be masked and transferred via the integration framework securely.
- Trusted media domains—Use trusted media domains to check the URLs of attachment files before uploading them. For configuration information, see Set up trusted media domains for secure file upload.

Rich control transformation
Design a rich and unique conversational experience for a channel through rich control transformation via inbound and outbound transformation scripts. All standard rich controls are supported.

- Simplified schema for inbound and outbound transformations. See Virtual Agent action scripts for updated scripts.
- Channel-specific bot messages—Implement channel-specific bot messages to create a unique conversation experience. For configuration information, see Create bot messages.
- Virtual Agent custom controls—Implement custom controls built using the custom control framework in your integration. Starting with the Rome release, customers and partners can publish a new custom control or override the implementation of a pre-built, ServiceNow custom control. Implementing a new control involves publishing appropriate Inbound and Outbound Flow Designer action scripts and updating the configuration Sub type in the Custom Adapter Configuration [sys_cs_custom_adapter_config] table. For configuration information, see Integrate custom controls.
- Multi-step responses—An example of multi-step response is a set of images in a carousel or a date control.
- Multi-flow Output bot response control—Use the Multi-flow Output bot response control in a Virtual Agent topic to sequentially display two or more outputs (text, image, link, or HTML). For configuration information, see Multi-flow output controls.
- Card bot response control—Use the Card bot response control in a Virtual Agent topic to display selected information from a record on your instance, such as an incident, or an image (large or small) with a description.
- Send previous control to client—Provide the ability to send previous control to client. For configuration information, see Send previous control to client.
- HTML as output control by converting to an image—See Virtual Agent conversational custom chat integration configuration for configuring HTML to image conversion.
• Implement a skip option— Use a rich control to provide the option for users to skip a question. For more information, see node conditions in Virtual Agent Designer user input controls. For configuration in custom chat integration framework, see Implement a skip option.

• Pass context variables, system parameters, or user’s time-zone along with user input.

• Pass branding to a chat client— Pass custom branding to your custom chat integration. For configuration information, see Pass branding to a chat client.

• Process one user request at a time— By default the Virtual Agent processes only one request at a time. If a user sends a second request before the first request is finished, the second request is ignored. This does not apply when the user is connected to a live agent.

• Ignore duplicate requests from client.

• Pre-chat and post-chat surveys— No configuration or scripting required to implement this feature in the Custom Chat Integration Framework. After a chat ends, the post-chat survey runs automatically when the:
  ◦ Virtual Agent conversations if the Feedback setup topic is enabled. For details on the Survey setup topic type and how it works in a conversation, see Working with setup topics.
  ◦ Live Agent conversations if you've configured a post-chat survey at the queue level. For more information, see Define post-chat survey configurations.

More Virtual Agent chat features

• Topic discovery via keywords or natural language understanding (NLU through ServiceNow®, IBM Watson Assistant, or Microsoft LUIS)— Custom chat integrations can avail topic discovery via keywords or NLU depending on how Virtual Agent is set up on your instance. No configuration or scripting required to implement this feature in Custom Chat Integration Framework.

• Support for both standard chat and long-running conversations— Channels can be set up as either chat or messaging. No configuration or scripting is required to implement this feature in the Custom Chat Integration Framework. For more information on long-running conversations, see Asynchronous Chat.

• Contextual action support— Commands with a pre-defined behavior can be mapped to certain user-friendly keywords and passed as user input. Starting with the Rome release, the End conversation contextual action gives known or guest users the option to end the conversation or cancel the request and resume the conversation. For configuration information see, Contextual actions for custom chat integrations.
• **Configure a Virtual Agent chat experience** — Define a custom chat experience for a specific context in which your users run Virtual Agent. No configuration or scripting required to implement this feature in Custom Chat Integration Framework.

• **Dynamic translation**— Display a message in chat client that messages are being translated if dynamic translation is enabled. No configuration or scripting required to implement this feature in Custom Chat Integration Framework.

• **Rich text formatting**— Support for rich text formats supported in Virtual Agent Designer. No configuration or scripting required to implement this feature in Custom Chat Integration Framework.

• **Typing indicators**— When a bot is preparing a response, a typing indicator is displayed to users to indicate that a response is in progress. A channel can be set up to support typing indicators. For configuration information, see Typing indicators.

• **Change Virtual Agent and Live Agent system messages**— System messages are a set of pre-built messages that can be served as bot response in common conversation scenarios such as greeting a user or transferring to a live agent, and so on. Admins can override the message text to suit their business needs. No configuration or scripting required to implement this feature in Custom Chat Integration Framework.

• **Notifications**— Deliver both simple and actionable notifications via the integration framework. No configuration or scripting required to implement this feature in Custom Chat Integration Framework.

• **Standard timeouts for idle agent conversations**— No configuration or scripting required to implement this feature in Custom Chat Integration Framework.

• **Virtual Agent interaction records**— The channel (sys_cs_channel.Name), channel type (sys_cs_channel.Type), provider (sys_cs_provider.Name), provider identifier name (sys_cs_provider_application.Name) and provider channel id (sys_cs_provider_application.InboundID) fields are available for reporting.

• **API rate limiting**— Ability to control the rate at which API calls are made via the platform rate limiting feature. No configuration or scripting required to implement this feature in Custom Chat Integration Framework.

• **API versioning**— Specify the version of the provider. The framework is able to send the expected inputs to actions and subflows and handle the
expected outputs. See Virtual Agent conversational custom chat integration configuration for more information.

• Default portal for redirect URLs—Specify a default portal in the Provider Channel Identities [sys_cs_provider_application] table to redirect chat links to that portal. For more information, see Set the URL navigation for chat links.

Live agent chat features

• Transfer to live agent from Virtual Agent or directly by user
• Persistent messages after live agent is initiated
• Interaction history (chat transcripts) for live agents
• Support for all standard live agent controls
• Channel-level flag to initiate conversations with live agents, bypassing Virtual Agent.
• Live agent status for end users
  ◦ Agent availability
  ◦ Wait time for next agent
  ◦ Display agent name and avatar if enabled in the Chat Setup form

Synchronous authentication of messages

Inbound message authentication is performed before the message is added to the hybrid queue.

This code has to be implemented in the provider attribute script. For more information, see Virtual Agent action scripts.

Example: Synchronous authentication of messages

```javascript
var validated = sn_cs.VASystemObject.validateMessage(providerApp.sysId, payload, JSON.stringify(headers));
if (validated === false) {
  response.setStatus(401);
  response.setContentType("test/xml")
  var writer = response.getWriter();
  writer.writeString(
```

Account auto-linking

Allow a user's third-party accounts to be auto-linked to their ServiceNow® profile.
You can enable account auto-linking in the Messaging Provider [sys_cs_provider] table. This feature bypasses the prompt for the users to link their accounts manually.

In the navigation filter type `sys_cs_provider.list`. Check the **Allow account linking** box and fill in the **Link account action** field with the corresponding account linking script.

**Example: Account auto-linking script**

```javascript
var response_body = inputs['response_body'];
var status_code = inputs ['status_code'];
var email_id = '';
if(status_code>200 && status_code<=210){
    email_id = response_body && JSON.parse(response_body).userPrincipalName;
}
var sysUserId = null;
if(email_id){
    var gr = new GlideRecord("sys_user");
    gr.addQuery("email",email_id);
    gr.query();
    while(gr.next()){sysUserId = gr.getUniqueValue();
    }
}
if(sysUserId){
    outputs['status'] = 'Success';
    outputs['userid'] = sysUserId;
} else {
    outputs['status'] = 'Failure';
}
})();inputs,outputs);
```

**Outbound authentication using a token**

Pass an outbound token from the authentication API to the sender script.

Secure fields contain the `maskType` metadata field as "SECURE". The client can handle the following script appropriately.

**Example: Outbound authentication token script**

```javascript
(function execute(inputs, outputs) {
    try {
```
var results = inputs.result;

var sendInputs = {
    app_inbound_id : inputs['app_inbound_id'],
    channel_user_id: inputs['channel_user_id'],
    messages: JSON.stringify(results)
};

sn_fd.FlowAPI.startSubflowQuick('sn_va_sms_twilio.va_sms_twilio_adapter_send_sms', sendInputs);

//return
sn_fd.FlowAPI.executeActionQuick('sn_va_sms_twilio.va_sms_twilio_adapter_sender_handler', sendInputs);

} catch (e) {
    gs.error("Messages: " + JSON.stringify(sendInputs));
    gs.error("Error is twilio sms sender : " + e.message);
}
}(inputs, outputs);

## Message delivery order

Control message delivery order by enabling the **Maintain message ordering** option in the Provider Channel [sys_cs_provider] table. You can view the message order and status in the Custom Adapter Message [sys_cs_ca_message] table.

When you enable the **Maintain messaging order** option in the Provider Channel table, a Sender Subflow occurs only after the previous Sender Subflow completes to ensure that messages are delivered in the order that they were sent.

Messages are stored in the Custom Adapter Message [sys_cs_ca_message] table, which is cleaned nightly. If the Custom Chat Integration Framework client is not receiving any messages, you can use this table to check the message delivery status:

- Processing
- Pending - not yet processed
- Completed
- Error - problem with processing an outbound message, possibly due to Integration Hub issues that could occur when the Sender Subflow is invoked
Set up trusted media domains for secure file upload

Virtual Agent uses trusted media domains to check the URLs of attachment files before uploading them. If a URL is not from a trusted domain, Virtual Agent will not upload the attachment.

About this task
Role required: admin

For custom chat integrations, specify trusted media domains in either the Provider [sys_cs_provider] table or the Provider Channel Identity [sys_cs_provider_application] table. The trusted media domain values in the Provider Channel Identity table override the corresponding values in the Provider table.

Pre-built integrations, such as Slack, Microsoft Teams, and Workplace from Facebook, have default trusted media domain values set at the provider level, in the Provider [sys_cs_provider] table. To change the default trusted values, specify the different trusted media domains in the Provider Channel Identity [sys_cs_provider_application] table.

Procedure
1. Navigate to **sys_cs_provider_application.list** > **Provider Channel Identity** and click **New**.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Provider Channel Identity form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Provider</td>
</tr>
<tr>
<td>Message auth</td>
</tr>
<tr>
<td>Inbound ID</td>
</tr>
<tr>
<td>Trusted media domains</td>
</tr>
</tbody>
</table>

**Note:** Subdomains under a trusted domain are also trusted. You do not need to specify subdomains in this list.
For security reasons, Virtual Agent checks that the URLs for attachments in conversations are from trusted domains specified here. If the URL is not for a trusted domain, Virtual Agent doesn't upload the attachment.

If an attachment upload fails because Virtual Agent didn't trust the domain, Virtual Agent does not inform the end user why the attachment upload failed.

| Short description | Description for your channel identifier. |

3. Click **Submit**.

4. Optional: Create additional channel identifiers using the same procedure.

### Create bot messages

Create channel-specific bot messages.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Conversational Interfaces > Channel Integrations > Connections** and select a connection.

2. In the **Provider Channel Identity** tab, select a provider channel identity.

3. Select **New** in the **Bot Messages** table.

4. In the form, fill in the fields.

**Bot Messages Form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your bot message</td>
</tr>
<tr>
<td>Value</td>
<td>Text displayed when a bot message is triggered</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the bot message, such as Welcome message or Instructional message for image upload</td>
</tr>
<tr>
<td>Message Type</td>
<td>Default selection is Bot Message</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Channel Identity</td>
<td>Select the Provider Channel Identity</td>
</tr>
</tbody>
</table>

5. Select **Submit**.

**Bot message implementation**

Use the bot messages API to implement channel specific bot messages.

**Bot message API**

Use the following API to incorporate bot messages into your custom chat integration.

Example: Bot message implementation

```javascript
function getBotMessage(providerId, inboundId, botMessageName) {
    // fetch the bot message using bot messages api
    var botMessages = sn_cs.VASystemObject.getAllBotMessages(providerId, inboundId);
    if (botMessages && botMessages[botMessageName]) {
        var botMessage = botMessages[botMessageName];
        botMessage = botMessage.trim();
        if (botMessage) {
             return botMessage;
        }
    }
}
```

**Integrate custom controls**

Implement and leverage custom controls built using the custom control framework in your integration.

**Before you begin**

Role required: virtual_agent_admin or admin

**About this task**

Map custom controls to a provider channel. You can:

- **Implement custom controls created in Flow Designer**

  Use the example script to implement custom controls created in Flow Designer.

  Example: Custom controls support

  ```json
  {
    uiType: "CustomControl",
    group: "DefaultCustomControl",
  }
  ```
Example: Custom controls script

(function execute(inputs, outputs) {
    var rich_controls = inputs.rich_control;
    //this is the data returned from the 'serialized control data function' defined in designer
    var serializedControlData = rich_control['serializedControlData'];
    // if this rich control will require a response to move forward in topic flow
    var isInput = rich_control['isInput'];
    // if the component is suggesting using a Seismic control (web) that handles this
    var uxComponentDefinitionId = rich_control['uxComponentDefinitionSysId'];
    // the name of the custom control
    var name = rich_control['name'];

    // 1) now perform some logic to transform this data into a custom ui
    (slack/facebook/sms ascii art/html/etc)
    // 2) attach to outputs, i.e. outputs.text_message='foo :)'; for sms twillio

    // basic flow is to take the serializedControlData/Name/compId(optional)
    and create a custom UI component here
    // that your client understands (i.e. a slack rich form payload)
})(inputs, outputs);

Implement a provider-specific transformation of a custom control

Starting with the Rome release, you can implement a provider-specific transformation for each custom control by using the **Sub type** field in the Custom Adapter Configuration [sys_cs_custom_adapter_config] table. You can publish a new custom control or a pre-built, ServiceNow custom control, also referred to as a default custom control. Provider-specific transformations involve publishing the appropriate Inbound and Outbound Flow Designer action scripts and updating
the configuration in the Custom Adapter Configuration [sys_cs_custom_adapter_config] table.

- If you’re publishing your own version of a ServiceNow custom control, you overwrite the custom control record in the Custom Adapter Configuration table with your own Inbound and Outbound action script names.

- Only one record with the same Sub type is allowed. If the same custom control is implemented by two different parties, only one can update the existing record with new Inbound and Outbound transformers.

_i Note:_ Once you override an existing custom control record, the system uses the new version of the custom control. For example, transformation scripts can transform multiple custom controls, such as Time Picker and Auth. If you add a Time Picker control with different inbound and outbound transforms, the newer Time Picker control is used. You cannot revert to the original version of the custom control.

- If you want to add new custom controls to a chat integration beyond the ones published for a ServiceNow chat integration, you can do so by following the same procedure.

### Procedure

1. Navigate to `sys_cs_custom_adapter_config.list` > **Custom Adapter Configuration** and select a provider channel.

2. Select the **Rich Control Mappings** tab.

3. Select **New**.

4. On the form, fill in the fields.

#### Custom Adapter Configurations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control type</td>
<td>Select the custom control that you designed. For custom controls, the type is always DefaultCustomControl. To learn more about custom controls, see Virtual Agent custom controls.</td>
</tr>
<tr>
<td>Sub type</td>
<td>Name of the custom control.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Inbound transformer action | Name of the inbound transformer action script for this rich control, such as, `sn_va_sms_twilio.va_sms_twilio_adapter_input_text_inbound_transformer`.
Outbound transformation action | Name of the outbound transformer action script for this rich control, such as, `sn_va_sms_twilio.va_sms_twilio_adapter_input_text_outbound_transformer`.

5. Select **Submit**.

**Multi-step responses**

An example of multi-step response is a set of images in a carousel or a date control.

Multipart Control richControl has the following attributes, which can be used to transform control.

- **content**: Rich Control which must be presented in current step.
- **navigationBtnLabel**: Label for "next" or "more" button for user to click to move to next step.

**Example:**

```json
{
    uiType: "MultiPartOutput",
    group: "DefaultMultiPartOutput",
    navigationBtnLabel: "Go next",
    content: {
        uiType: "OutputHtml",
        style: "inline",
        type: "html",
        height: 100,
        width: 100,
        value: "<div>html</div>"
    }
}
```

**Outbound transformation script**

```javascript
(function execute(inputs, outputs) {

    try{
        var richControl = inputs.rich_control;
        var payload = inputs.payload;
```
var content = richControl.content;
var navigationBtnLabel = richControl.navigationBtnLabel;
var uiType = content.uiType;
var partResult = null;

switch (uiType) {
    case "OutputText":
        partResult = sn_fd.FlowAPI.executeActionQuick('example_default_text_outbound_transformer', {
            rich_control : content,
            payload : payload
        });
        break;
    case "OutputLink":
        partResult = sn_fd.FlowAPI.executeActionQuick('example_default_output_link_outbound_transformer', {
            rich_control : content,
            payload : payload
        });
        break;
    case "OutputImage":
        partResult = sn_fd.FlowAPI.executeActionQuick('example_default_image_outbound_transformer', {
            rich_control : content,
            payload : payload
        });
        break;
    case "OutputHtml":
        partResult = sn_fd.FlowAPI.executeActionQuick('example_default_html_outbound_transformer', {
            rich_control : content,
            payload : payload
        });
        break;
    default:
        break;
}

partResult = partResult + addButtonMore(navigationBtnLabel)
outputs.result = JSON.stringify(outActivity);

} catch(e){
    gs.error("Error in default multipart outbound transformer : " + e.message);
    throw e;
}
Inbound transformation script

(function execute(inputs, outputs) {
    try {
        var requestContext = inputs.request_context;
        var typedValue = requestContext.typed_value;
        outputs.result = typedValue;
    } catch(e) {
        gs.error("Error in default multipart inbound transformer : " + e.message);
        throw e;
    }
}) (inputs, outputs);

Multi-flow output controls
Implement controls that involve multiple steps to get user input.

Use the following API to configure context data for multi-output controls.

Common use cases
1. To achieve pagination of pickers: page_no, pagination_length updated in inbound based on next/previous button is read in outbound.
2. Step by step response of date picker like first year, then month, and then date selection.

The following APIs are only available in inbound and outbound transformers.

```javascript
sn_cs.VASystemObject.setProviderUserContext(key, contextData, providerAppId, providerUserId);
sn_cs.VASystemObject.getProviderUserContext(key, providerAppId, providerUserId);
sn_cs.VASystemObject.removeProviderUserContext(key, providerAppId, providerUserId);
sn_cs.VASystemObject.removeAllProviderUserContext(providerAppId, providerUserId)
```

The outbound transformer of the picker control can store current page details in user contextData.

```javascript
var paginationData = {
    "page_index": 1,
    "pagination_length": 2
};
```
The inbound transformer of picker control can get current page details from user contextData.

Example code for picker control outbound transformer

```javascript
(function execute(inputs, outputs) {
    var control = inputs.rich_control;
    var payload = inputs.payload;
    var appId = payload.appId;
    var userId = payload.userId;

    var paginationData = sn_cs.VASystemObject.getProviderUserContext('picker_control', appId, userId);
    paginationData = JSON.parse(paginationData);
    // First time when the outbound picker is called when selecting the topic.
    if (paginationData == null) {
        paginationData = {
            'page_index': 1,
            'pagination_length': 5
        };
        sn_cs.VASystemObject.setProviderUserContext('picker_control', paginationData, appId, userId);
    }

    var page_index = paginationData['page_index'];
    var pagination_length = paginationData['pagination_length'];
    var start = (page_index - 1) * pagination_length;
    var end = page_index * pagination_length;

    if (control['options']) {
        var options = control['options'];
        var optionsLength = options.length;
        if (end > optionsLength)
            end = optionsLength;
        var picker = control['label'] + ":
        if (start > 0)
            picker += "\n" + "*" + ": " + "prev";
        for (var x = start; x < end; x++) {
            gs.log("here " + x + " : " + options[x]);
        }
    }
}(function execute(inputs, outputs) {
    var control = inputs.rich_control;
    var payload = inputs.payload;
    var appId = payload.appId;
    var userId = payload.userId;

    var paginationData = sn_cs.VASystemObject.getProviderUserContext('picker_control', appId, userId);
    paginationData = JSON.parse(paginationData);
    // First time when the outbound picker is called when selecting the topic.
    if (paginationData == null) {
        paginationData = {
            'page_index': 1,
            'pagination_length': 5
        };
        sn_cs.VASystemObject.setProviderUserContext('picker_control', paginationData, appId, userId);
    }

    var page_index = paginationData['page_index'];
    var pagination_length = paginationData['pagination_length'];
    var start = (page_index - 1) * pagination_length;
    var end = page_index * pagination_length;

    if (control['options']) {
        var options = control['options'];
        var optionsLength = options.length;
        if (end > optionsLength)
            end = optionsLength;
        var picker = control['label'] + ":
        if (start > 0)
            picker += "\n" + "*" + ": " + "prev";
        for (var x = start; x < end; x++) {
            gs.log("here " + x + " : " + options[x]);
        }
    }
```
picker += "\n" + (x + 1) + "": " + options[x].label;
}
if (end < optionsLength)
    picker += "\n" + "#": " + "next";
}
outputs.text_message = picker;
})(inputs, outputs);

Example Picker Control Inbound Transformer
(function execute(inputs, outputs) {

    var request_context = inputs.request_context;
    var rich_control = inputs.rich_control;
    var appId = request_context.appId;
    var userId = request_context.userId;

    var selectedValue = request_context["typed_value"];
    var result = {};
    result["value"] = "";
    result["search_text"] = selectedValue;

    var options = rich_control["options"];

    var paginationData = sn_cs.VASystemObject.getProviderUserContext('picker_control', appId, userId);
    paginationData = JSON.parse(paginationData);

    switch (selectedValue) {
    case 'prev': {
        --paginationData["page_index"];
        result["send_prev_control"] = true;
    }
    break;
    case 'next': {
        ++paginationData["page_index"];
        result["send_prev_control"] = true;
    }
    break;
    default: {
        var selectedIndex = Number(selectedValue) - 1;
        if (paginationData["page_index"] != undefined && paginationData["pagination_length"] != undefined) {
            var highestOptionInPage = paginationData["page_index"] * paginationData["pagination_length"];
            if (selectedIndex >= 0 && selectedIndex < highestOptionInPage) {

            }
        }
    }

})
var selectedOption = options[selectedIndex];
result["value"] = selectedOption.value;
result["search_text"] = "";
}
}

Send previous control to client

Provide the ability to send previous control to client.

There are two ways to send previous control back from the server when a client requests:

- In inbound transformation, set `validation_message` in result. Previous control will be sent again with message provided in `validation_message`.
- In inbound transformer, set `send_prev_control` in result to true, previous control will be sent again. Use this method for Multi-Step controls.

Example script:

(function execute (inputs, outputs) {
var result = {};
var request_context = inputs.request_context;
var typed_value = request_context ['typed_value'];
if (typed_value.indexOf('#') > -1)
    result["validation_message"] = "Invalid character, please don't enter special character '#'";
result["value"] = typed_value;
result["search_text"] = "";
outputs.result = result;
})(inputs, outputs);

Implement a skip option

Use rich control to provide the option for users to skip a question.
Use the rich control \nType SKIP to skip question to provide the option for a user to skip a question. There are two ways to configure a skip option:

- **In the provider attributes script**, use `_skip_internal` to trigger a contextual action service to skip the question.
- **Map a contextual action** for the provider and use `// request_context.contextual_action = "SKIP"` to skip the question. See [Contextual actions for custom chat integrations](#) to learn more about mapping user inputs to contextual actions.

**Example script:**

```javascript
va_sms_twilio_adapter_default_text_outbound_transformer
(function execute(inputs, outputs) {
  try {
    var richControl = inputs.rich_control;
    outputs.result = richControl['label'];
    if (richControl['required'] === false && richControl['uiType'] != "OutputText") {
      outputs.result += "\nType SKIP to skip question"; // new
    }
  } catch(e){
    gs.error('Error in default text outbound transformer: ' + e.message);
    throw e;
  }
})}(inputs, outputs);

va_sms_twilio_adapter_provider_attributes
(function execute(inputs, outputs) {
  try {
    var headers = (inputs.headers);
    var payload = (inputs.payload);
    var smsUtil = new VASMSTwilioUtil();
    outputs.token = JSON.stringify(smsUtil.getToken(headers, payload));
    var data = payload.data;
    var request_context = {};
    if (data['MediaUrl0']) {
      var attachment_value = {};
      attachment_value.url = data['MediaUrl0'];
      attachment_value.content_type = data['MediaContentType0'];
      attachment_value.name = smsUtil.getFileName(attachment_value.url, attachment_value.content_type);
      request_context.attachment_value = attachment_value;
    } else {
      var b = data['Body']; // new
    }
  }
});
```
request_context.typed_value = b; // new
if (b === "SKIP") {
    request_context.typed_value = "_skip_internal"; // new
    //request_context.contextual_action = "SKIP"; // new
} // new
}

outputs.request_context = request_context;
outputs.provider_user_id = data.From;
}
} catch (e) {
    gs.error("Error in va_sms_twilio_adapter_provider_attributes : " + e.message);
}
})(inputs, outputs);

(function execute(inputs, outputs) {
    var contextual_action = inputs.request_context.contextual_action;
    if (contextual_action === "SKIP") {
        sn_cs.VASystemObject.skipOptionalQuestion(inputs.conversation_id);
    }
})(inputs, outputs);

Pass branding to a chat client

Pass custom branding to your custom chat integration.

See Configure chat branding and the chat menu for more information about branding. Use sn_cs.VASystemObject.getSettings to apply branding.

Example script:

va_sms_twilio_adapter_default_text_outbound_transformer
(function execute(inputs, outputs) {
    try {
        var richControl = inputs.rich_control;
        var branding = sn_cs.VASystemObject.getSettings("default_branding"); // new
        var header = "(" + branding["header_label"] + ") "; // new
        outputs.result = header; // new
        outputs.result += richControl['label'];
    } catch (e) {
        gs.error('Error in default text outbound transformer: ' + e.message);
        throw e;
    }
})(inputs, outputs);
Contextual actions for custom chat integrations

Contextual actions are a set of quick action commands that users can invoke for frequently encountered scenarios during virtual and live agent conversations.

Getting started with contextual actions

User inputs can be mapped to contextual action in two ways.

- UI-based mapping of comma-separated keywords to available contextual actions. For example: Hi, Hola - Start Conversation
- Script-based mapping of user actions to available contextual actions. For example: User clicks "Start" menu - Start Conversation

Available contextual actions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Map to your own command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Command to request transfer to a live agent</td>
<td>Yes</td>
</tr>
<tr>
<td>Bye</td>
<td>Command to end a conversation with a live or virtual agent</td>
<td>Yes</td>
</tr>
<tr>
<td>Help</td>
<td>Command to request help using the bot</td>
<td>Yes</td>
</tr>
<tr>
<td>Hi</td>
<td>Command to start or end a conversation</td>
<td>Yes</td>
</tr>
<tr>
<td>Logout</td>
<td>Command to unlink the user messaging account from ServiceNow</td>
<td>Yes</td>
</tr>
<tr>
<td>Notifications</td>
<td>Command to subscribe or unsubscribe from receiving notifications</td>
<td>Yes</td>
</tr>
<tr>
<td>Restart</td>
<td>Command to end a bot conversation that is either in progress or runs into an error, and then begin a new conversation</td>
<td>Yes</td>
</tr>
<tr>
<td>Skip</td>
<td>Command to skip an optional question</td>
<td>Reserved</td>
</tr>
</tbody>
</table>
Pre-built contextual actions (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Map to your own command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscribe</td>
<td>Subscribe to notification in the current channel</td>
<td>Reserved</td>
</tr>
<tr>
<td>Unsubscribe</td>
<td>Unsubscribe from notification in the current channel</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

Contextual action mapping

Map user inputs to base system contextual actions.

Before you begin
Role required: admin

About this task
Use the Contextual Actions [sys_cs_contextual_action] table to review the commands used in the chat integrations. You can add more keywords for a command. Each record for a pre-built command has this information:

Contextual Actions fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the command.</td>
</tr>
<tr>
<td>Commands</td>
<td>Keyword for the command. You can add multiple keywords, separated by commas.</td>
</tr>
<tr>
<td>Description</td>
<td>Explanation of the command</td>
</tr>
<tr>
<td>Applicability</td>
<td>Application in which the command is used:</td>
</tr>
<tr>
<td></td>
<td>• Virtual Agent only</td>
</tr>
<tr>
<td></td>
<td>• Live Agent only</td>
</tr>
<tr>
<td></td>
<td>• Virtual Agent and Live Agent</td>
</tr>
</tbody>
</table>

Procedure

1. In the navigation filter, enter `sys_cs_contextual_action.list`.
2. Select a contextual action from the list.
3. Add comma-separated keywords to the **command** field. For example: **Agent**, **Live Agent**, **Transfer to agent**.
4. Optional: Exclude specific messaging channels from contextual actions.
a. Select the **Insert a new row...** text.
b. Select the magnifying glass.
c. Select the messaging channel you would like to exclude from the contextual action.
d. Select the green checkmark to save.

5. Select **Update**.

**What to do next**

Create bot messages specific to each channel.

**Typing indicators**

Display a typing indicator when a bot is preparing a response.

When Virtual Agent processes a request, the Start typing indicator action is called. When Virtual Agent completes the request processing, the End typing indicator action is called before Virtual Agent processes any output or input controls.

These actions call the defaultText control outbound transformation. The following example shows how the typing indicator is handled in the defaultText control outbound transformation.

**Example: Typing indicator script**

```javascript
(function execute(inputs, outputs) {
  try {
    var richControl = inputs.rich_control;
    var actionType = richControl.type;
    if(actionType == 'StartTypingIndicatorActionMsg'){
      outputs.result = '{activity:{type: "typing"}}';
    }else if(actionType == 'EndTypingIndicatorActionMsg'){
      outputs.result = '{activity:{type: "message", text: "Finished typing"}}';
    }
    /* Handle other type of control */
  } catch (e) {
    gs.error("Error in default action outbound transformer : " + e.message);
    throw e;
  }
})
```

**Virtual Agent integration with messaging apps**

Enable users to run Virtual Agent bot conversations in supported third-party messaging apps. Use the Conversational Integration apps for Slack, Microsoft
Teams, and Workplace from Facebook, available from the ServiceNow Store to configure these messaging apps for your instance.

⚠️ Note: Conversational Integration apps for Slack, Microsoft Teams, and Workplace from Facebook are not supported for on-prem instances.

Admin setup
Use the Virtual Agent Conversational Integration apps to configure the messaging applications for your instance. Perform these basic installation steps to set up the Virtual Agent bot.

1. Install the pre-built Conversational Integration app for a messaging app from the ServiceNow Store, then associate the app with your instance. For details, see Install Conversational Integrations for enterprise messaging apps.

2. If needed, configure the system messages that users see in Virtual Agent conversations. You can also customize the common commands used in these messaging integrations.

Conversational interface in messaging integrations
The Virtual Agent interface for the Conversational Integration apps (Slack, Microsoft Teams, and Workplace) is similar to the web-based interface. However, there are some differences, such as commands used and how certain interface controls are displayed in these third-party messaging apps.

Common commands in messaging integrations

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi</td>
<td>Begin a new conversation or end a conversation.</td>
</tr>
<tr>
<td>agent</td>
<td>Begin a new conversation or request a transfer to a live agent.</td>
</tr>
<tr>
<td>bye</td>
<td>Leave a live chat conversation at any time, for example before engaging with a live agent, during a live chat, or when live chat is about to end.</td>
</tr>
<tr>
<td>help</td>
<td>Displays a short list of useful commands.</td>
</tr>
<tr>
<td>logout</td>
<td>Unlink your ServiceNow account from a messaging integration.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>notification or notifications</td>
<td>Subscribe to or unsubscribe from notifications.</td>
</tr>
<tr>
<td>restart</td>
<td>End the current conversation and begin a new one.</td>
</tr>
</tbody>
</table>

After you install the integration, you can customize these commands by using the **Configure** button for the installed teams/communities in the Messaging Apps Integration page.

1. Navigate to **Conversational Interfaces > Virtual Agent > Messaging Apps Integration**.

2. In the Slack, Microsoft Teams, or Workplace from Facebook section, select the down arrow to show your installed teams/communities.

3. Select the **Configure** button or the name of one of the installed teams/communities to go to the Contextual Actions page.

4. Select the command record to be changed and update as needed.

**Configuring Virtual Agent system messaging in the Conversational Integration apps**

You can modify the default messages displayed to your users in Virtual Agent and Live Agent conversations. For details on customizing them, see [Change Virtual Agent and Live Agent system messages](#).

**Rendering of input controls and bot responses in conversations**

Input controls in Virtual Agent Designer, such as the Carousel render differently in bot conversations in messaging apps than in the web-based interface. For example, the Date Time picker control in Workplace presents buttons for users to select a date and time. Similarly, certain bot response controls, such as the Image response and Multi-flow Output, also render differently in third-party messaging apps. For details on these differences, see the descriptions of the Virtual Agent Designer **input controls**, **bot responses**, and **utilities**.

**Attachments**

In live agent conversations, users and agents can upload and exchange any type of attachment file when prompted.
Redirect user authentication to a Service Portal

After installing a pre-built Conversational Integration (for Slack, Microsoft Teams, or Workplace from Facebook), you can specify a Service Portal in which unauthenticated end users complete the user authentication step (user account linking), instead of in their ServiceNow instance. Users who do not have linked accounts complete authentication before continuing with the virtual agent in the messaging application.

Before you begin
Install the Virtual Agent messaging integrations for your instance. The system creates a record in the Provider Auth [provider_auth] table for each integration that you install (Slack, Microsoft Teams, Workplace, or Facebook Messenger). You use the Provider Auth table to specify the Service Portal in which user authentication occurs.

Role required: admin

Procedure
1. In the navigation filter, type provider_auth.list.
2. In the Provider Auth table, open the record for the messaging integration you installed.
3. In the Service Portal field, select the Service Portal in which user authentication occurs.
4. Click Update.

Results
When unauthenticated users start a conversation with the virtual agent for the first time in the messaging integration, they are redirected to the Service Portal specified for the provider in the Provider Auth table. After they log in to the Service Portal, they are prompted to link their ServiceNow account to the messaging application.

Configure the IBM Watson Assistant Chat integration

Set up the IBM Watson Assistant topic to run dialog skills (conversations created in IBM Watson Assistant) in the web-based chat client. This topic returns information exchanged during the virtual agent conversation to IBM Watson Assistant.

Before you begin
Role required: virtual_agent_admin or admin
• Role required: virtual_agent_admin or admin

• In IBM Watson Assistant:
  ◦ Create the dialog skill (conversation) in your IBM Watson Assistant workspace. The skill includes the dialog and any intents and entities that you define.
  ◦ Navigate to your skill tile and in the tile menu, select View API Details. View the Skill Details and Service Credentials. Copy the following items: Skill ID, Workspace ID, Username, and Password. You need these items when setting up this integration.

• Activate the IBM Watson Assistant Integration plugin (com.glide.cs.ibm.watson.assistant).

About this task
This topic runs an IBM Watson Assistant dialog in Virtual Agent. It does not require enabling NLU or setting IBM Watson Assistant NLU as the NLU service provider for Virtual Agent.

Procedure
1. In your ServiceNow instance, update the watson_assistant.workspaceID system property.
   a. In the Navigation filter, enter sys_properties.list
   b. In the System Properties [sys_properties] table, locate the watson_assistant.workspaceID property.
   c. Replace the existing Value with the Workspace ID for your skill, and click Update.

2. Verify that the REST message for IBM Watson Assistant provides the correct authentication endpoint for your IBM skill:
   a. Navigate to System Web Services > Outbound > REST Message.
   b. Select the IBM Watson Assistant record to open the REST Message IBM Watson Assistance form.
c. Confirm that the **Endpoint** field and the **Endpoint** column displayed in the **Authentication** tab have the correct endpoint URL for your IBM Watson account.

3. In the **Basic auth profile** field in the **Authentication** tab, open the Assistant Profile record.

4. In the Basic Auth Configuration form, enter the **Username** and **Password** values from your IBM Watson Assistant Service Credentials, then click **Update**.

5. Publish the IBM Skill topic:

   a. Navigate to **Conversational Interfaces** > **Virtual Agent** > **Designer**.

   b. In the Topics page, select the IBM Watson Assistant topic to open the Topic Properties page.
Notice that the **Keyword** for this topic is IBM Watson Assistant and the **Category** is IBM.

c. In the Topic Properties page, click **Publish** to deploy the topic to your Virtual Agent web client.

### Virtual Agent Designer

#### Topic Properties

- **Name**: IBM Watson Assistant
- **Description**: Enables hot conversations created in IBM Watson Assistant to run in the Virtual Agent web client.
- **Category**: IBM
- **System topic block**: [ ]
- **Keywords**: IBM Watson Assistant
- **Resume topic flow**: [ ]
- **Condition**: [ ]
- **Roles**: [ ]
- **Live Agent Variables**: [ ]

6. Configure the default topic for the Virtual Agent web client in one of the following ways:

- Provide the URL that specifies the IBM Watson Assistant topic as the default topic that opens in the Service Portal client:

  For example: `https://<Your instance URL>$sn-va-web-client-app.do?sysparm_skip_load_history=true&sysparm_topic=<sys_id>` where `<sys_id>` is the sys_id of the published IBM Watson Assistant topic. The `sysparm_skip_load_history` parameter does not load the conversation history in the web client.

  Or,

- Configure the Service Portal widget by clicking the edit (pencil) icon in the upper right corner of the Virtual Agent widget.

  To set the default topic using the widget instance parameters, enter `sysparm_topic=sys_id` (where `sys_id` is the sys_id of the published IBM Watson Assistant topic) in the **Virtual Agent Client URL Parameters** field, and click **Save**.
Note: You can find the sys_id of a topic in the Topics [sys_cs_topic] table.

Important:
Use the `sysparm_topic` parameter only to load the given topic in the Service Portal chat client or when using the IBM Watson Assistant chat integrations (com.glide.cs.ibm.watson.assistant.topic and com.glide.cs.ibm.watson.assistant.topicV2 plugins). This parameter doesn't allow users to start a new conversation or transfer to a live agent. It also disables the context menu and doesn't support other third-party chat clients.

Configure the IBM Watson Assistant Chat integration for the Assistant V2 API

Configure the IBM Watson Assistant Chat Integration to run a dialog skill (conversation) created in IBM Watson Assistant with the Assistant V2 API. The V2 API enables the Virtual Agent web chat client to run a topic that uses Watson Assistant's intent disambiguation feature to improve topic discovery.

Before you begin
Role required: virtual_agent_admin or admin

With the IBM Watson Assistant v2 API chat integration, the web chat client communicates with an assistant instead of with a workspace. Workspaces are referred to as dialog skills. For information on IBM Watson Assistant, see Migrating to the v2 API in the IBM Watson Assistant documentation.

About this task
This integration runs an IBM Watson Assistant dialog as a Virtual Agent topic in the web chat client. It does not require enabling NLU or setting IBM Watson Assistant NLU as the NLU service provider for Virtual Agent.

The IBM Watson Assistant V2 API enables the web chat client to use the Watson Assistant intent disambiguation feature, which can potentially reduce false-positive intent predictions. If a user's utterance is ambiguous, IBM Watson Assistant suggests additional intents that might better match the user's true intention. For example, if the user utterance is `restaurant`, IBM Watson Assistant can suggest other possible intents, such as `book a restaurant` or `restaurant reviews`.
Procedure
1. Configure IBM Watson Assistant.

   a. Create your assistant, then add a dialog skill. For details, see Creating an assistant in the IBM Watson Assistant documentation.

   b. On the Resource list page, locate and record your API key and URL, which you need to set up the chat integration:

   ![Resource list page](image)

   - Click the hamburger menu (three vertical dots) and select Settings.
     - Click the API Details tab.
     - On the Assistant Settings page, find the Assistant ID key.

2. Enable the disambiguation feature in IBM Watson Assistant (for premium and plus users only). You can enable (or disable) disambiguation for each skill, and also specify a disambiguation message and the number of suggestions to be displayed to the end user.
a. Access your skill by clicking the skill tree icon in the panel.

b. Navigate to **Options > Disambiguation** to enable disambiguation and set the disambiguation features.
The following example shows the disambiguation features that can be set, such as the disambiguation message and the number of suggested intents to be displayed to the end user.

IBM Watson Assistant

Customer Care Sample Skill  Version: Development

<table>
<thead>
<tr>
<th>Intents</th>
<th>Disambiguation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entities</td>
<td></td>
</tr>
<tr>
<td>Dialog</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td></td>
</tr>
<tr>
<td>Webhooks</td>
<td></td>
</tr>
<tr>
<td>Disambiguation</td>
<td></td>
</tr>
<tr>
<td>Autocorrection</td>
<td></td>
</tr>
<tr>
<td>System Entities</td>
<td></td>
</tr>
<tr>
<td>Analytics</td>
<td></td>
</tr>
<tr>
<td>Versions</td>
<td></td>
</tr>
<tr>
<td>Content Catalog</td>
<td></td>
</tr>
</tbody>
</table>

Disambiguation

If your skill is confident that more than one dialog node can address a user's query, disambiguation allows the assistant to ask the user for clarification. A description of the purpose of each dialog node is displayed as a list of options, and the user is asked to pick the right one. Learn more

Disambiguation message

The message your skill will send to the user before a list of possible options.

Did you mean?

Anything else

An option users can pick if none of the suggested nodes are appropriate

None of the Above

Maximum number of suggestions

Set a limit for how many suggestions to display at once

3

Next step

External node name

Review your dialog to find nodes that users might need to choose between. For each one, add a description of the node's purpose to the external node name field. This description is what is displayed as the node option label from the disambiguation options list. Go to dialog

3. Navigate back to the Dialog option, select a node to which the disambiguation feature will apply, and provide a summary of the node that will be displayed to users if it's one of the intent suggestions.
4. In your ServiceNow instance, activate these plugins:
   - Glide Virtual Agent (com.glide.cs.chatbot), if not already activated
     (requires a subscription)
   - IBM Watson Assistant Integration V2 plugin
     (com.glide.cs.ibm.watson.assistant.topicV2)

5. In Virtual Agent Designer, publish the IBM Watson Assistant V2 topic:

   a. Navigate to Conversational Interfaces > Virtual Agent > Designer.

   b. In the Topics page, select the IBM Watson Assistant V2 topic to open the
      Topic Properties page.
      Notice that the **Keyword** for this topic is IBM Watson Assistant V2.
c. In the Topic Properties page, click **Publish** to deploy the topic to your Virtual Agent web client.

6. In the navigation filter, enter `sys_properties.list` to open the System Properties [sys_properties] table. Update the following properties:

- **watson_assistant.v2.assistantID** — In the **Value** field, enter the Watson Assistant ID for your assistant and click **Update**.

- **watson_assistant.v2.service_endpoint** — In the **Value** field, replace the existing value with your Watson Assistant URL and click **Update**.
Note: You can specify just the location portion of the service instance URL in the Value field. For example, if the base URL for the IBM Watson service endpoint is https://gateway.watsonplatform.net/assistant/api, you can enter just the location of the service instance, gateway.watsonplatform.net in the Value field.

If your Watson Assistant is hosted in a data center other than Dallas, such as Washington DC, your base URL is https://gateway-wdc.watsonplatform.net/assistant/api. You would enter gateway-wdc.watsonplatform.net in the Value field.

7. Set the Watson Assistant API key as the password in the IBM Watson Assistant Profile:

a. In the navigation filter, enter `sys_auth_profile_basic.list` to open the Basic Auth Configurations [sys_auth_profile_basic] table, and open the IBM Watson Assistant Profile record.

b. In the Basic Auth Configuration form, enter the Watson Assistant API key in the Password field and click Update.
8. Add the Virtual Agent (web chat) client to the Service Portal.


   b. Click Designer and click the Service Portal landing page.

   c. Search for the Virtual Agent widget and drag the widget into the red outline area.
   The purple chat icon appears in the bottom-right corner.

9. Configure the Virtual Agent widget by clicking the edit (pencil) icon in the upper right corner to set the URL parameters passed to the chat client and change the color of the floating chat button.

   a. In the Virtual Agent Client URL Parameters field, enter the sysparm_skip_load_history=true parameter so that the topic history does not display in the chat client and the sysparm_topic parameter with the sys_id of the published IBM Watson Assistant V2 topic to be run. You can find the sys_id of a topic in the Topics [sys_cs_topic] table.

   Note: If you do not configure the instance behavior in Service Portal, you can specify your instance URL with the sysparm_topic and sysparm_skip_load_history parameters when you open the chat web client. For example: https://<Your instance URL>$sn-va-web-client-app.do?sysparm_skip_load_history=true&sysparm_topic=<sys_id> where <sys_id> is the sys_id of the published IBM Watson Assistant V2 topic to be run.
Important:

Use the `sysparm_topic` parameter only to load the given topic in the Service Portal chat client or when using the IBM Watson Assistant chat integrations (com.glide.cs.ibm.watson.assistant.topic and com.glide.cs.ibm.watson.assistant.topicV2 plugins). This parameter does not allow users to start a new conversation or transfer to a live agent. It also disables the context menu and does not support other third-party chat clients.

b. To change the floating button color, enter the new color (RGB hex format) in the **Floating Button Color** field.

c. Click **Save**.

10. Test that the disambiguation feature is working for your topic.
Be sure that disambiguation is enabled for your Watson Assistant skill and at least two dialog nodes. In the following example, the virtual agent provides four additional intents that the user can select.

Example topic with disambiguation

Hello, I’m a customer care virtual assistant to help you with directions to my store, hours of operation and booking virtual and in-store appointments.

Did you mean?
- I want to make an appointment.
- I want to make online appointment.
- I want to know the direction and location.
- None of the Above

Please pick an option.
Account linking in pre-built messaging integrations

In Virtual Agent, account linking maps the users of a supported chat or messaging application to their ServiceNow user profile. Account auto-linking authenticates your messaging users, which enables them to automatically access Virtual Agent topics that involve ServiceNow records. If needed, users can also manually unlink from or link to their ServiceNow accounts.

How account auto-linking works

In the Conversational Integrations for Slack, Microsoft Teams, and Workplace from Facebook, you have the option to enable account auto-linking, which automatically links messaging users to their ServiceNow accounts. If you enable the account auto-linking feature on the Messaging Apps Integration page, your users are not prompted to link to their ServiceNow accounts when they engage with the virtual agent.

In earlier releases, messaging users were prompted to link to their ServiceNow accounts or continue as guests. However, for the Conversational Integrations for Slack, Microsoft Teams, and Workplace from Facebook, if you enable account auto-linking, your users do not manually link their messaging accounts to their ServiceNow accounts, provided that they use the same email account for their messaging and ServiceNow accounts. During auto-linking, Virtual Agent maps the email accounts of messaging users to their email accounts defined in their profiles in the Users [sys_user] table. When the email accounts match, users are automatically linked (authenticated) and they do not see the Link to ServiceNow button when they begin a bot conversation.

In messaging integrations, your users can still use the logout command during bot conversations to unlink from their ServiceNow accounts. However, in all subsequent conversations after unlinking, Virtual Agent prompts them to link their accounts. When they engage with the virtual agent, they are prompted to link to their ServiceNow account or continue as a guest user.

Unlink your ServiceNow user account from a messaging application for Virtual Agent conversations

If needed, you can unlink your ServiceNow user account from a messaging app used for the Now Virtual Agent.

Before you begin
Role required: user

About this task
Unlinking your account from a selected Conversational Integration for Slack, Microsoft Teams or Workplace, deactivates the association between your ServiceNow account and the messaging app. After you unlink your account,
you can no longer engage in Virtual Agent conversations that query or change records in the ServiceNow database.

To unlink your account from the messaging app, do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messaging app</td>
<td>From within the messaging app, type logout.</td>
</tr>
</tbody>
</table>
| Application navigator   | 1. From the application navigator, navigate to Self-Service > My Profile.  
                            2. Click the View Linked Accounts related link.  
                            3. In the Linked Accounts page, select the check box for the messaging integration to be unlinked.  
                            4. Select Actions on selected rows, then click Unlink account. |

The link between your ServiceNow account and the Virtual Agent messaging integration becomes inactive.

⚠️ Note: Even though you unlinked your account, you can still run public Virtual Agent conversations. To link your account again, repeat steps 1 through 3 for the associated messaging integration and in the Actions on selected rows..., click Link account.

Link your ServiceNow user account to a messaging application for Virtual Agent conversations

Link your ServiceNow account to a third-party messaging application to access non-public Virtual Agent topics that use ServiceNow records.

Before you begin
Role required: user

About this task
When you initially engage with the Virtual Agent bot, your messaging account is automatically linked to your ServiceNow account as long as the same email account is defined for both your messaging and ServiceNow accounts. However, if you unlinked your messaging account from your ServiceNow account (using the logout command), each time that you start a subsequent Virtual Agent session, the bot gives you the option to link to your ServiceNow account.
account or continue as guest. The authentication step (linking) occurs in your instance or in a specific Service Portal, if set by your admin.

**Procedure**

1. Open the messaging application.
2. Find your Virtual Agent bot.
3. Start a conversation with your Virtual Agent bot.
   The bot then presents a prompt that provides options to authenticate ([Link to ServiceNow](#)), continue as a guest user, or see the help menu ([Check out Tips](#)).

   **Example authentication message**

   ```
   Hello! I'm Now Virtual Agent. I'm here to help you. Let's start by linking your ServiceNow account. In case you don't want to connect your account, please enter your request.
   [Link to ServiceNow] [Continue as Guest] [Check out Tips]
   ```

4. Click **Link to ServiceNow** to authenticate.
   Authentication directs you to your instance or a specific Service Portal set by your admin. If you are not already logged in to your instance or a Service Portal, you are prompted to enter your login credentials.

5. A confirmation message appears, prompting you to Confirm or Deny linkage between your accounts. Click **Confirm** to allow the account link.

   **Abel Tuter** would like to link their Microsoft Teams account with the ServiceNow **Abel Tuter** account

   [Deny] [Confirm]

   This link expires in 5 minutes for security reasons

6. After confirmation, you are directed to your instance user record.
A confirmation message is displayed at the top of the screen.

Related information

Redirect user authentication to a Service Portal

Control topic visibility in Virtual Agent messaging channels

Suppress the display of a topic in a Virtual Agent messaging channel by using a condition script that excludes the topic from a channel.

Before you begin

Roles required:

• virtual_agent_admin and external_app_install_admin or admin
• Administrator for third-party applications

About this task

In your condition script for the topic, use a context variable to identify the messaging channel that excludes this topic.

Procedure

1. Navigate to Conversational Interfaces > Virtual Agent > Designer.
2. In the Topics page, select the topic for updating or create a new topic.
3. In the Condition field on the Topic Properties page, enter a condition script that identifies the messaging channel (Slack, Microsoft Teams, Workplace from Facebook, or Facebook Messenger) from which the topic will be excluded.

You can use the following example script, which contains the vaContext.deviceType variable, to identify the messaging channel that excludes the topic: Slack, Microsoft Teams, Workplace, and Facebook Messenger.

```javascript
(function execute()
{ if(vaContext.deviceType === 'Slack' || vaContext.deviceType === 'Teams' || vaContext.deviceType=='Facebook' || vaContext.deviceType=='Messenger'){
  return false;
}
```

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. To save the topic properties, click Save.

**Results**
Publishing the topic deploys it to the Virtual Agent messaging channels, except for the Virtual Agent channels that you specified in the topic condition script. A keyword or an intent (if using NLU) does not trigger the topic.

**Install Conversational Integrations for enterprise messaging apps**
Install the Conversational Integration applications for Slack, Microsoft Teams, and Workplace from Facebook and associate the app with your instance.

**About this task**
Conversational integrations are available for Slack, Microsoft Teams, and Workplace from Facebook from the ServiceNow Store.

**Conversational Integration with Microsoft Teams**
Enable requesters to chat with Microsoft Teams or live agents using the Microsoft Teams application. Use the Conversational Integration with Microsoft Teams app, available from the ServiceNow Store, to associate your instance with Microsoft Teams.

**Important:** In earlier releases, the pre-built Virtual Agent messaging integration for Microsoft Teams was part of the Virtual Agent platform. This integration is now called the Conversational Integration with Microsoft Teams, available as an app from the ServiceNow Store.

**Request apps on the Store**
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Overview**
Use the Conversational Integration with Microsoft Teams application to connect your end users with Virtual Agent or live agents through your company's Microsoft Teams account. To get started, see Install Conversational Integration with Microsoft Teams.
Install Conversational Integration with Microsoft Teams

You can install the Microsoft Teams (sn_va_teams) application if you have certain roles.

Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- If you're using an earlier release of Virtual Agent, you must upgrade to the Quebec release to use the features supported in this messaging integration.
- Conversational Integration with Microsoft Teams requires the Glide Virtual Agent plugin (com.glide.cs.chatbot) to activate full functionality in Virtual Agent or the Virtual Agent Lite plugin (com.glide.cs.chatbot.lite) to activate a limited version of Virtual Agent. Activate the appropriate plugin before you install the integration.

Role required:

- virtual_agent_admin and external_app_install_admin or admin
- Microsoft Teams administrator (one of the following): Global Administrator, Application Administrator, or Cloud Application Administrator

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the Conversational Integration with Microsoft Teams (sn_va_teams) application using the filter criteria and search bar.
   
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.
   
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Microsoft Teams.
4. Optional: If demo data is available and you want to install it, click Load demo data.
Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

**Important:** If you don't load the demo data during installation, it's unavailable to load later.

5. Click **Install**.

**What to do next**
Configure the Conversational Integration with Microsoft Teams.

**Configure the Conversational Integration with Microsoft Teams**
Configure the Conversational Integration with Microsoft Teams with your instance.

**Before you begin**

- Install the Conversational Integration with Microsoft Teams app from the ServiceNow® Store.

**Important:** Installing the Conversational Integration with Microsoft Teams app from the ServiceNow Store store activates the corresponding **Install** button in the Messaging Apps Integration page. If you haven't installed the integration app, the **Install** button for the integration is disabled.

After you install the Conversational Integration with Microsoft Teams app, the **Install** button in the Messaging Apps Integration page for the app becomes active, and you can proceed with configuration.
• Roles required:
  ◦ virtual_agent_admin and external_app_install_admin or admin
  ◦ Microsoft Teams administrator (one of the following): Global Administrator, Application Administrator, or Cloud Application Administrator

About this task
Review these guidelines for using Virtual Agent with Microsoft Teams.

• The Microsoft Teams app creates a one-to-one association between the ServiceNow instance that you are installing from and the Microsoft Teams tenant in which the integration runs.

Use a separate Microsoft Teams tenant for each instance that you plan to install the integration in. If you plan to test with a non-production instance and clone the instance, be sure to run the configuration steps again on the clone target to associate the bot to the new instance. Running the steps again disassociates the integration between the original non-production instance and the tenant.

• The Microsoft Teams app does not support the Microsoft Teams freemium account, which allows user email accounts other than Microsoft Office 365 accounts.

Procedure
1. Navigate to Conversational Interfaces > Messaging Apps Integration.
2. Next to Microsoft Teams, click Install.

3. By default, the Automatically link ServiceNow user profiles option is selected. If not already selected, click this option to enable automatic linking of user profiles. For details about auto-linking, see Account linking in pre-built messaging integrations.

4. In the pop-up message for confirming redirection to Microsoft Teams to verify your identity, click OK.
5. Log in to Microsoft Teams.

6. In the Now Virtual Agent screen, click **Accept** to accept the permissions for the app.

7. If the selected workspace has already been assigned to Virtual Agent, click **Override** to change the workspace or **Cancel** to leave the current assignment in place.
Installation starts in the background. After installation completes, a message confirms that you successfully installed the Now Virtual Agent integration for Microsoft Teams.

8. Click **Go to MS Teams** to log in to Microsoft Teams. Under **Apps**, search for Now Virtual Agent, then add the Now Virtual Agent app.

9. In your ServiceNow instance, check the Messaging Apps Integration page (**Conversational Interfaces > Messaging Apps Integration**) to verify the installation.
What to do next

The Virtual Agent bot and Microsoft Teams workspace are now integrated for use on your ServiceNow instance. Your messaging users are automatically linked to their ServiceNow accounts.

- Notify your users that the Virtual Agent bot for Microsoft Teams is available for use.
- To improve the live agent experience for your users, you can activate the display of the estimated wait time for live chat support. When a user asks to chat with a live agent, a card shows the approximate wait time to talk with an agent and gives the user the option to cancel the chat. For details on activating this feature, see Configure live agent chat.

Virtual Agent feature support in Microsoft Teams conversations

The Conversational Integration with Microsoft Teams app supports Virtual Agent features such as Virtual Agent Designer controls for creating conversations, notifications, AI Search results, and more.

Note: The Conversational Integration with Microsoft Teams is not supported for on-prem instances.

This section highlights relevant Virtual Agent features that are supported in the Microsoft Teams app.

Virtual Agent Designer user input and bot response controls

The Virtual Agent Designer user input and bot response controls for creating conversation topics are supported in Microsoft Teams conversations, including the table bot response and the card control that can display images.

Starting with Version 2.0.0, the card and video bot response controls are supported in Microsoft Teams conversations. The video control displays a thumbnail image of the video that users select to open the video in their preferred web browser.

For more information about user input controls and bot responses, see Virtual Agent Designer user input controls and Virtual Agent Designer bot responses, respectively.

AI Search results

Virtual Agent can generate AI Search results that are displayed as Genius Result Cards and multi-link outputs in conversations. For details on how Virtual Agent generates AI Search results, see Virtual Agent integration with AI Search. The default AI Search configuration for Virtual Agent enables search results for Q&A (knowledge base) and Catalog items.
Virtual Agent notifications

For detailed information on Virtual Agent notifications, see Configuring Virtual Agent notifications. Basic notification features include:

• Subscription management
  ◦ Requesters - Use the notification (or notifications) command to subscribe to or unsubscribe from notifications.
  ◦ Admins - Enable notifications for messaging users in the Messaging Apps Integration page.

• Notification content - Create notifications with rich content, images, and action buttons. Actionable notifications enable recipients to perform certain actions and respond to the notification, such as adding a comment or requesting a live agent.

Starting with Version 2.0.0, rich text is supported in notifications in the Microsoft Teams app. For more information, see Define Virtual Agent notification contents.

• Notification delivery
  ◦ Message notifications are delivered immediately to end users, even if the user is chatting with a virtual or live agent.
  ◦ Actionable notifications are delivered only when the user is not in an active conversation with a virtual or live agent. Users can:
Review the notifications later by using the `show notification` command.
Perform or skip the actions for the notification. If users decide to skip the actions, users can return later to the notification by using the `show notification` command.

**URL navigation for chat links**

In Virtual Agent and Live Agent conversations on the Microsoft Teams app, links to ServiceNow records open automatically in base system portals—including links displayed in output cards, Virtual Agent notifications, and AI Search results. If needed, admins can change the portals in which these links are opened. For configuration details, see Set the URL navigation for chat links.

**Masking of sensitive user data**

Starting with Version 2.0.0, passwords entered by users and confirmed in bot responses are masked during password reset conversations in the Microsoft Teams app.

**Example of password masking**

![Password masking example](image)

**Support for file uploads**

Starting with Version 2.0.0, users can upload file attachments with the paper clip icon in Microsoft Teams conversations.
Custom branding in the Microsoft Teams application

Microsoft Teams supports app customization, which enables you to customize branding of the Now Virtual Agent bot in the Conversational Integration with Microsoft Teams. To learn more about app customization, see these resources:

- Customize apps in Microsoft Teams in the Microsoft Teams documentation
- MS Teams branding for the conversational integration in Now Community

Unsupported Virtual Agent features

Promoted topics and Connect Support are not supported. Also, multi-instance installation of a single Microsoft tenant is not allowed. Attempting to install a tenant on to a second instance will override the first instance’s integration.

Pre-link Virtual Agent requesters before integration with Microsoft Teams

Starting with Version 2.0.0, pre-link your Virtual Agent requesters to a ServiceNow instance before they run the Conversational Integration with Microsoft Teams. Batch pre-linking enables your Virtual Agent users to immediately chat with a virtual agent and receive notifications without going through the initial authentication linking process.

Before you begin

- Install Conversational Integration with Microsoft Teams, with the Automatically Link ServiceNow user profiles option enabled.
- Set up Microsoft Teams Graph spoke.

Roles required:

- virtual_agent_admin
- external_app_install_admin
• One of the following Microsoft Teams administrator roles:
  ◦ Global Administrator
  ◦ Application Administrator
  ◦ Cloud Application Administrator

• admin or schedule_admin to change the scheduled job script

About this task
When the **Automatically Link ServiceNow user profiles** option is enabled on the Messaging Apps Integration UI page, a batch of up to 10,000 users is automatically pre-linked to a ServiceNow instance. Your existing users are pre-linked during the initial run. Newly added users are pre-linked during subsequent daily runs.

To prevent automatic batch pre-linking, disable the **Automatically Link ServiceNow user profiles** option on the Messaging Apps Integration UI page.

Batch pre-linking of your Virtual Agent users to a ServiceNow instance before integrating with Microsoft Teams includes the following benefits:

• Notifications are proactively sent by Virtual Agent to users when their identity in Microsoft Teams is associated with their identity in a ServiceNow instance. This is also true when the user is already linked with ServiceNow Virtual Agent.

• If a user is pre-linked, and when Microsoft Teams notifications are enabled in the app, notifications are pushed to the app even when a user is not logged into a Microsoft Teams account.

Batch pre-linking happens automatically via the **MS Teams Daily Pre Install Job** scheduled job. This job runs by default daily at 1:00 AM, but you can change the time, if desired. To modify the default scheduled job run time or time zone, access the **MS Teams Daily Pre Install Job** Scheduled Script Execution form.

Procedure
1. Navigate to **System Definition > Scheduled Jobs**.
2. Search for the **MS Teams Daily Pre Install Job** scheduled job and click to open the Scheduled Script Execution form for the selected record.
3. In the **Run** field, change the run time to your desired time.
4. For a description of the other fields that you can change in this form, including **Time zone**, see **Automatically run a script of your choosing**.
5. Click **Save**.
Conversational Integration with Slack

Enable requesters to chat with Virtual Agent or live agents using the Slack application. Use the Conversational Integration with Slack app, available from the ServiceNow Store, to associate your instance with Slack.

ℹ️ Note: In earlier releases, the pre-built Virtual Agent messaging integration for Slack was part of the Virtual Agent platform. This integration is now the Conversational Integration with Slack app, available from the ServiceNow Store.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Overview

Use the Conversational Integration with Slack application to connect your requesters with Virtual Agent or live agents through your company’s Slack workspace. To get started, see Install the Conversational Integration with Slack.

Install the Conversational Integration with Slack

You can install the Conversational Integration with Slack (sn_va_slack) application if you have the admin role.

Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- If you're using an earlier release of Virtual Agent, you must upgrade to the Quebec release to use the features supported in this messaging integration.
- Conversational Integration with Slack requires the Glide Virtual Agent plugin (com.glide.cs.chatbot) to activate full functionality in Virtual Agent or the Virtual Agent Lite plugin (com.glide.cs.chatbot.lite) to activate a limited version of Virtual Agent. Activate the appropriate plugin before you install the integration.

Role required: admin
**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the Conversational Integration with Slack (sn_va_slack) application using the filter criteria and the search bar.

   You can search for the application by its name or ID. If you can't find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. Click **Install**.

**What to do next**

Configure the Conversational Interface with Slack.

**Configure the Conversational Integration with Slack**

Configure the Conversational Integration with Slack application to associate Slack with your instance.
Before you begin

- Install the Conversational Integration with Slack from the ServiceNow® Store.

**Important:** Installing the Conversational Integration app from the ServiceNow Store store activates the corresponding **Install** button in the Messaging Apps Integration page. If you haven't installed the integration app, the **Install** button for the integration is disabled.

After you install the Conversational Integration with Slack app, the **Install** button in the Messaging Apps Integration page for the app becomes active, and you can proceed with configuration.

**Roles required:**
- virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications

**About this task**
Review these guidelines for using Virtual Agent with Slack or with Slack Enterprise Grid.

- Slack – Installing Virtual Agent with Slack creates a one-to-one association between the ServiceNow instance that you are installing from and the Slack workspace in which the integration runs.
  - Use a separate Slack workspace for each instance that you plan to install the integration in.
  - If you use a non-production instance for testing, use a different workspace.
• Slack Enterprise Grid – If you have Slack Enterprise Grid workspaces, your end users can move between workspaces and use the Virtual Agent bot from any workspace.
  ◦ If you use a non-production instance for testing, use a workspace in a different grid or use a non-grid workspace.
  ◦ After installing this store release:
    ■ Your messaging users are automatically linked to their ServiceNow accounts.
    ■ If you clone an instance for non-production testing, be sure to run the installation again on the clone target. Follow the guidelines above for testing with non-production instances.

Procedure

1. **Navigate to Conversational Interfaces > Messaging Apps Integration.**

2. Next to Slack, click **Install**.

3. By default, the **Automatically link ServiceNow user profiles** option is selected. If not already selected, click this option to enable automatic linking of user profiles.
   For details about auto-linking, see **Account linking in pre-built messaging integrations**.

4. In the pop-up message for confirming redirection to Slack to verify your identity, click **OK**.

5. Enter your Slack workspace URL to sign into your Slack workspace, and click **Continue**.
6. Sign in to your ServiceNow instance.

7. Next, Virtual Agent asks for permission to access the Slack workspace.
8. Click **Allow**.

When Virtual Agent has been successfully installed on the Slack workspace, a completion message appears.

9. Navigate to **Conversational Interfaces > Messaging Apps Integration**. The Slack application appears in the list of available integrated messaging applications.
Results
The Virtual Agent bot and Slack workspace are now integrated for use on your ServiceNow instance, and ServiceNow user accounts are linked with their Slack user accounts.

Virtual Agent features supported in Slack conversations
The Conversational Integration with Slack app supports Virtual Agent features, such as AI Search results, Virtual Agent notifications, Virtual Agent Designer controls for creating Virtual Agent conversations, and more.

Note: The Conversational Integration with Slack is not supported for on-prem instances.

This section highlights relevant Virtual Agent features that are supported in the Conversational Integration with Slack app.

Virtual Agent Designer user input controls and bot responses
The Virtual Agent Designer user input controls and bot responses for creating conversation topics are supported in Slack conversations, including the table bot response and the card control that can display images.
Starting with Version 2.0.0, the card and video bot response controls are supported in Slack conversations.
For more information about user input controls and bot responses, see Virtual Agent Designer user input controls and Virtual Agent Designer bot responses, respectively.

AI Search results
Virtual Agent can generate AI Search results that are displayed as Genius result cards and multi-link outputs in conversations. For details on how Virtual Agent generates AI Search results, see Virtual Agent integration with AI Search. The default AI Search configuration for Virtual Agent enables search results for Q&A (knowledge base) and Catalog items.

Virtual Agent notifications
For detailed information on Virtual Agent notifications, see Configuring Virtual Agent notifications. Basic notification features include:

- Subscription management
  - Requesters - Use the notification (or notifications) command to subscribe to or unsubscribe from notifications.
  - Admins - Enable notifications for messaging users in the Messaging Apps Integration page.
• Notification content - Create notifications with rich content, images, and action buttons. Actionable notifications enable recipients to perform certain actions and respond to the notification, such as adding a comment or requesting a live agent.

• Notification delivery

  ◦ Message notifications are delivered immediately to end users, even if the user is chatting with a virtual or live agent.
  ◦ Actionable notifications are delivered only when the user is not in an active conversation with a virtual or live agent. Users can choose to:
    ■ Review the notifications later by using the **show notification** command.
      For example, with the **show notification** command, users can select the notification they want to view.
    ■ Perform or skip the actions for the notification. If users decide to skip the actions, users can return later to the notification by using the **show notification** command.
URL navigation for chat links

In Virtual Agent and Live Agent conversations on the Slack app, links to ServiceNow records open automatically in base system portals—including links displayed in output cards, Virtual Agent notifications, and AI Search results. If needed, admins can change the portals in which these links are opened. For configuration details, see Set the URL navigation for chat links.

Uninstall the Conversational Integration with Slack

Uninstall the Conversational Integration with Slack and disassociate the app with your instance.

Before you begin
Roles required:
- Virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications

Procedure
1. Navigate to Conversational Interfaces > Messaging Apps Integration.
2. On the Messaging Apps Integration screen, click the arrow next to Slack teams installed.
3. Click Uninstall next to the Slack workspace to be deleted.
4. When you see the confirmation to uninstall the workspace, click Uninstall.

6. When you see the confirmation for removing the app from the workspace, click Remove App.
The bot is no longer installed in the workspace and is not listed on the Messaging Apps Integration page. **Now Virtual Agent** no longer appears on the list of integrations in Slack.

**Note:** Any remaining clean up, such as deleting previously linked users or application entries, is performed after a 24-hour delay. You can change the length of this delay by editing glide.cs.delete_delay_day.

7. **Optional:** Check the workspace record in the Slack Adapter Configuration Pages table to verify that the workspace is deleted.
   
   a. In the application navigator, enter sys_cs_adapter_configuration_page.list to open the Slack Adapter Configuration Pages table.
   
   b. Locate the workspace record in the table and verify that the State is Pending delete.

**Conversational Integration with Workplace from Facebook**

Enable requesters to chat with Virtual Agent or live agents using the Workplace from Facebook application. Use the Conversational Integration with Workplace from Facebook app, available from the ServiceNow Store, to associate your instance with Workplace.

**Note:** In earlier releases, the pre-built Virtual Agent messaging integration for Workplace was part of the Virtual Agent platform. This integration is now the Conversational Integration with Workplace from Facebook app, which you must get from the ServiceNow Store.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Overview**

Use the Conversational Integration with Workplace from Facebook application to connect your requesters with Virtual Agent or live agents through your company’s Workplace from Facebook application. To get started, see **Install the Conversational Integration with Workplace from Facebook**.

**Install the Conversational Integration with Workplace from Facebook**

You can install the Conversational Integration with Workplace from Facebook (sn(va)fb_workplace) application if you have the admin role.
Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

- If you're using an earlier release of Virtual Agent, you must upgrade to the Quebec release to use the features supported in this messaging integration.

- Conversational Integration with Workplace from Facebook requires the Glide Virtual Agent plugin (com.glide.cs.chatbot) to activate full functionality in Virtual Agent or the Virtual Agent Lite plugin (com.glide.cs.chatbot.lite) to activate a limited version of Virtual Agent. Activate the appropriate plugin before you install the integration.

- Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Conversational Integration with Workplace from Facebook using the filter criteria and the search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. Click Install.

What to do next

Configure the Conversational Integration with Workplace from Facebook.

Configure the Conversational Integration with Workplace from Facebook

Configure the Conversational Integration with Workplace from Facebook to associate Workplace with your instance.
Before you begin

- Install the Conversational Integration with Workplace from Facebook from the ServiceNow® Store.

**Important:** Installing the Conversational Integration app from the ServiceNow Store store activates the corresponding **Install** button in the Messaging Apps Integration page. If you haven’t installed the integration app, the **Install** button for the integration is disabled.

**Messaging Apps Integration page before Conversational Integration apps are installed**

After you install the Conversational Integration with Workplace from Facebook app, the **Install** button in the Messaging Apps Integration page for the app becomes active, and you can proceed with configuration.

- Roles required:
  - virtual_agent_admin and external_app_install_admin or admin
  - Administrator for third-party applications

**Procedure**

1. Navigate to **Conversational Interfaces > Messaging Apps Integration**.
2. Next to Workplace from Facebook, click **Install**.
3. By default, the **Automatically link ServiceNow user profiles** check box is selected. If not already selected, click this check box to enable automatic linking of user profiles. For details about auto-linking, see [Account linking in pre-built messaging integrations](#).

4. In the pop-up message for confirming redirection to Workplace from Facebook to verify your identity, click **OK**.

5. On the login screen for Workplace, enter your login credentials. If you have multiple accounts for Workplace, a menu displays the accounts that you can log in to. Select the account in which you want to install the app.

6. In the window that requires your authorization to install the integration, click **Add to Workplace**.
If the selected workspace has already been integrated with Workplace, click **Save** or **Cancel** to leave the current assignment in place.

To delete the Conversational Integration with Workplace from Facebook, see **Uninstall the Conversational Integration with Workplace from Facebook**.

7. When you see a confirmation message about the installation, verify the installation.
   The workspace name appears below the Workplace heading on the Integration page.
8. Click **Done**.

**Note:** Be sure to click **Save** on the Settings for Now Virtual Agent screen.

**Results**
The Virtual Agent bot and Workplace from Facebook are now integrated for use on your ServiceNow instance, and ServiceNow user accounts are linked with their Workplace user accounts.

**Virtual Agent features supported in Workplace from Facebook conversations**
The Conversational Integration with Workplace from Facebook app supports Virtual Agent features such as Virtual Agent Designer controls for creating conversations, notifications, AI Search results, and more.

**Note:** The Conversational Integration with Workplace from Facebook is not supported for on-prem instances.

This section highlights relevant Virtual Agent features that are supported in the Workplace from Facebook app.
Virtual Agent Designer user input and bot response controls
The Virtual Agent Designer user input and bot response controls for creating conversation topics are supported in Workplace conversations, including the table bot response and the card control that can display images.

Starting with Version 2.0.0, the card and video bot response controls are supported in Workplace conversations.

For more information about user input controls and bot responses, see Virtual Agent Designer user input controls and Virtual Agent Designer bot responses, respectively.

AI Search results
Virtual Agent can generate AI Search results that are displayed as Genius Result Cards and multi-link outputs in conversations. For details on how Virtual Agent generates AI Search results, see Virtual Agent integration with AI Search. The default AI Search configuration for Virtual Agent enables search results for Q&A (knowledge base) and Catalog items.

Virtual Agent notifications
For detailed information on Virtual Agent notifications, see Configuring Virtual Agent notifications. Basic notification features include:

- Subscription management
  - Requesters - Use the notification (or notifications) command to subscribe to or unsubscribe from notifications.
  - Admins - Enable notifications for messaging users in the Messaging Apps Integration page.

- Notification content - Create notifications with rich content, images, and action buttons. Actionable notifications enable recipients to perform certain actions and respond to the notification, such as adding a comment or requesting a live agent.

- Notification delivery
  - Message notifications are delivered immediately to end users, even if the user is chatting with a virtual or live agent.
  - Actionable notifications are delivered only when the user is not in an active conversation with a virtual or live agent. Users can:
    - Review the notifications later by using the show notification command.

For example, with the show notification command, users can view their notifications.
Perform or skip the actions for the notification. If users decide to skip the actions, users can return later to the notification by using the `show notification` command.

**URL navigation for chat links**

In Virtual Agent and Live Agent conversations on the Workplace app, links to ServiceNow records open automatically in base system portals—including links displayed in output cards, Virtual Agent notifications, and AI Search results. If needed, admins can change the portals in which these links are opened. For configuration details, see [Set the URL navigation for chat links](#).

**Uninstall the Conversational Integration with Workplace from Facebook**

Uninstall the Conversational Integration with Workplace from Facebook and disassociate the app with your instance.

**Before you begin**

Roles required:

- Virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications
**Procedure**

1. Log in to Workplace from Facebook.
2. Click **Admin Panel**.
3. Click **Integrations**.
4. In the list of Workplace from Facebook integrations, click **Now Virtual Agent**.
5. In the window that displays the settings for Now Virtual Agent click **Uninstall**.
6. In the window that requires authorization to uninstall the app, click **Uninstall**.

**Results**

*Now Virtual Agent* no longer appears on the list of integrations in Workplace from Facebook. The instance receives uninstallation information from Workplace from Facebook, and the app configuration and user information are deleted within 15 days.

**Set up Virtual Agent integration for consumer messaging apps**

As an administrator for ServiceNow, configure the ServiceNow Virtual Agent integration for consumer messaging apps and associate the app with your instance.

**About this task**

Engage customers where they are with rich conversations by enabling them to message anytime to your company’s account using their choice of messaging apps.

You have the following options for integrations with the consumer messaging apps:

**Procedure**

- Set up integrations for the WhatsApp messaging app by using the Conversational Integration with WhatsApp (powered by Twilio) application. To learn more, see Configure Conversational Integration with WhatsApp (powered by Twilio).
- Set up integrations for the LINE messaging app by using the Conversational Integration with LINE application. To learn more, see Configure Conversational Integration with LINE.
Set up integrations for the Facebook Messenger app by using the Conversational Integration with Facebook Messenger application. To learn more, see Configure Conversational Integration with Facebook Messenger.

**Note:** For legacy integration with Facebook Messenger app by using the Customer Service Virtual Agent Conversations application, see Set up the Virtual Agent integration with Facebook Messenger (Legacy) and Integrate Customer Service Virtual Agent with Facebook Messenger (Legacy).

**Set up the Virtual Agent integration with Facebook Messenger (Legacy)**

Configure the Virtual Agent integration for Facebook Messenger and associate the app with your instance.

**Before you begin**

You should already have the following:

- Facebook page (see https://www.facebook.com/pages/creation/ for more information)
- Facebook developer account (see https://developers.facebook.com/ for more information)
- Facebook app (see https://developers.facebook.com/quickstarts for more information, make note of the app secret that is generated)

 Roles required:

- virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications

**Procedure**

1. In Facebook developer, navigate to Messenger > Settings.
   
   a. Locate the Token Generation section.
   
   b. From the page list, select the Facebook page you created and make note of the Page Access Token that is generated.
   
   c. Locate the Webhooks section and click Setup Webhooks.
   
   d. On the New Page Subscription pop-up window that displays, enter these fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callback URL</td>
<td>Your ServiceNow instance URL followed by /api/now/v1/cs/adapter/messenger/message</td>
</tr>
<tr>
<td>Verify Token</td>
<td>nowbot</td>
</tr>
<tr>
<td>Subscription Fields</td>
<td>Select messages and messaging_postbacks</td>
</tr>
</tbody>
</table>

**e. Click Verify and Save.**

**2. In your ServiceNow instance, enter hash_message_verification.list in the Filter navigator.**

a. In the Hash Message Verifications form, click **New** to create a new record.

b. Enter these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that helps to identify this record. This field may default to sample-fb-messenger-inbound-app-token but this default can be changed.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the record</td>
</tr>
<tr>
<td>Secret</td>
<td>App secret of your Facebook Messenger app (the secret was generated when you created the app)</td>
</tr>
</tbody>
</table>

c. Click **Submit**.

**3. In your ServiceNow instance, enter token_verification.list in the Filter navigator.**

a. In the Token Verifications form, click **New** to create a new record.

b. Enter these fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that helps to identify this record. This field may default to sample-fb-messenger-outbound-app-token but this default can be changed.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the record</td>
</tr>
<tr>
<td>Token</td>
<td>Page access token of your Facebook Messenger app (from step 1b of this procedure)</td>
</tr>
</tbody>
</table>

c. Click Submit.

4. In your ServiceNow instance, enter `message_auth.list` in the Filter navigator.

a. In the Message Auth page, click New to create a new record.

b. Enter these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that helps to identify this record. This field may default to sample-fb-messenger-app but this default can be changed.</td>
</tr>
<tr>
<td>Provider</td>
<td>Name of the provider</td>
</tr>
<tr>
<td>Inbound message verification</td>
<td>Name specified on the Hash Message Verifications form (this token verifies if the request is actually from the provider)</td>
</tr>
<tr>
<td>Outbound message creation</td>
<td>Name specified on the Token Verification form (this token interacts with the provider on behalf of the user)</td>
</tr>
</tbody>
</table>

c. Click Submit.
5. In your ServiceNow instance, enter `sys_cs_adapter_configuration_page_messenger.list` in the Filter navigator.

   a. In the Facebook Messenger Adapter Configuration Page, click **New** to create a new record.

   b. Enter these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>App Type</td>
<td>Defaults to Facebook Messenger and cannot be changed</td>
</tr>
<tr>
<td>Messenger Page ID</td>
<td>Your page ID (the page ID can be found in the URL of the Facebook page)</td>
</tr>
<tr>
<td>Name</td>
<td>Name that helps to identify this record. This field may default to <code>sample-fb-messenger-app</code> but this default can be changed.</td>
</tr>
<tr>
<td>Provider Auth</td>
<td>Name specified on the Message Auth page</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

7. Configure whether users should be prompted to link their profile to their ServiceNow profile.

   a. In the Navigation filter, enter `sys_properties.list`.

   b. Navigate to and click `va.messenger.account.auth`.

   c. In the **Value** field, enter **true** or **false**.

   | true | Prompt users to link their account to their ServiceNow profile. Users who link their account to their ServiceNow profile can access all topics and also chat with a live agent. Users who do not link their account can access only guest topics. |
Do not prompt users to link their account to their ServiceNow profile. Users can access only guest topics but can still chat with a live agent.

d. Click Update.

**Configure the help link for the Virtual Agent Facebook Messenger integration (Legacy)**

Use the `va.messenger.help.url` system property to create the link that opens a web help page when requesters use the Help command in the Virtual Agent Facebook Messenger integration.

**Before you begin**

- Determine the web page that provides the help content that your Facebook Messenger users need.
- Role required: virtual_agent_admin or admin

**Procedure**

1. Set the application scope to Global.
2. In the Navigation filter, enter `sys_properties.list`.
3. Click New.
4. Complete the following:
   a. In the Name field, enter the system property name: `va.messenger.help.url`.
   b. In the Description field, enter a brief explanation of this property.
   c. In the Value field, enter the URL of the website page that the link opens.
   d. Click Submit.

**Results**

When your Facebook Messenger users type `help`, they are directed to the URL of the website specified in the `va.messenger.help.url` property.

**Conversational SMS Integration with Twilio**

Host Virtual Agent conversations on Twilio SMS.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release
notes information for all released apps, see the ServiceNow Store version history release notes.

**Capturing information from a user in an SMS chat conversation**

Conversational SMS Integration with Twilio enables users to initiate conversations with Virtual Agent by messaging your Twilio phone number.

If a bot transfers the conversation to a live agent, the agent can respond to SMS messages in Agent Workspace.

After you set up the Conversational SMS Integration with Twilio, you can create SMS conversation topics in Virtual Agent Designer. For more information on using the tool, see Virtual Agent Designer.
**Supported controls**

The Conversational SMS Integration with Twilio does not support all the available controls in Virtual Agent Designer.

The following user input controls are supported in Twilio SMS conversations:

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text</strong></td>
<td>User enters a plain text string in the conversation.</td>
</tr>
<tr>
<td><strong>Static Choice</strong></td>
<td>User selects an item from a predefined list.</td>
</tr>
<tr>
<td>User input control</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Choice</td>
<td>User selects an item from a list that is created dynamically. For example, the user can select from a list of cases that they opened.</td>
</tr>
</tbody>
</table>
### Supported user input controls (continued)

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Boolean</strong></td>
<td>User enters a Boolean response to the bot. For example, the user can reply &quot;Yes&quot; or &quot;No&quot; in the conversation.</td>
</tr>
</tbody>
</table>
### Supported user input controls (continued)

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File picker</td>
<td>User sends a file to the bot.</td>
</tr>
</tbody>
</table>

**Note:** Conversational SMS Integration with Twilio doesn't support all file types. Only images can be sent in an SMS conversation.
### Supported user input controls (continued)

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For more information on configuring user input controls, see [Virtual Agent Designer user input controls](#). The following bot responses are supported in Twilio SMS conversations:

#### Supported bot responses

<table>
<thead>
<tr>
<th>Bot response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Bot sends a plain text string to the user.</td>
</tr>
</tbody>
</table>
Supported bot responses (continued)

<table>
<thead>
<tr>
<th>Bot response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Image Output" /></td>
<td>Bot sends an image to the user.</td>
</tr>
</tbody>
</table>
## Supported bot responses (continued)

<table>
<thead>
<tr>
<th>Bot response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Image" /></td>
<td>Bot sends a web link to the user.</td>
</tr>
<tr>
<td>Bot response</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Card</td>
<td>Bot sends selected information from a record on your instance.</td>
</tr>
</tbody>
</table>
Supported bot responses (continued)

<table>
<thead>
<tr>
<th>Bot response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For more information on configuring bot responses, see [Virtual Agent Designer bot responses](#).

Live agents can use the Text, Card, and Image Output response controls to reply to users in SMS conversations.

**User subscriptions for SMS update notifications**
Beginning with version 1.1.1, your users with ServiceNow accounts (sys_user profiles) can choose to start or stop receiving SMS updates in their conversations.

ℹ️ **Note:** Notifications in messaging channels can be sent to users with ServiceNow accounts. Other recipients, such as consumer and customer contacts, are considered to be guests and cannot receive notifications on messaging channels.

To comply with privacy regulations, user notifications are turned off by default. Users can opt in or change their settings in the following ways:
• To check SMS notification settings for the account, send this text: Notification
• To receive SMS notifications, send this text: START
• To stop receiving SMS notifications, send this text: STOP

Changing SMS notification settings

To learn more about Virtual Agent notifications, see Configuring Virtual Agent notifications.

For details on creating content for a messaging notification, see Define Virtual Agent notification contents.

Install Conversational SMS Integration with Twilio

You can install the Conversational SMS Integration with Twilio (sn_va_sms_twilio) application if you have the admin role.

Before you begin

• Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
• For the Conversational SMS Integration with Twilio application, the following plugins and applications are required:
ServiceNow plugins

- Conversational Custom Chat Integration
  (com.glide.cs.custom.adapter)
  For more information on this plugin, see Conversational custom chat integrations and chatbot interoperability.
  For more information on activating plugins, see Activate a plugin.

ServiceNow Store applications

- Twilio Spoke (sn_twilio_spoke)
  Provides hub actions that may be used to create, update, delete, and look up records in Twilio.
  For more information on activating this application, see Twilio spoke.

- Conversational SMS Service Channel (sn_awa_sms_int)
  Adds SMS as an Advanced Work Assignment service channel for routing and assignment.
  For more information on activating this application, see Conversational SMS Service Channel.

Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the Conversational SMS Integration with Twilio (sn_va_sms_twilio) application using the filter criteria and search bar.
   You can search for the application by its name or ID.
   If you cannot find the application, you may have to request it from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.
4. In the Application installation dialog box, click Install.

What to do next
Set up the Conversational SMS Integration with Twilio.
Set up the Conversational SMS Integration with Twilio

Integrate Twilio with Virtual Agent so that you can engage in SMS bot conversations.

Before you begin

Before you can set up the Conversational SMS Integration with Twilio, complete the following tasks:

1. Ensure that you have valid ServiceNow entitlements for the following products and applications:
   - IntegrationHub
   - Twilio spoke
   - Conversational SMS Service Channel
   - Conversational SMS Integration with Twilio
   For more information, see Get entitlement for a ServiceNow product or application.

2. Install the following applications on your instance:
   - IntegrationHub
   - Twilio spoke
   - Conversational SMS Service Channel
   - Conversational SMS Integration with Twilio

3. Set up Twilio spoke

4. Ensure that the Conversational Custom Chat Integration plugin (com.glide.cs.custom.adapter) is active on your instance.

Role required: external_app_install_admin or va_admin

Procedure

1. Create a Hash Message Verification record.
   a. In the navigation filter, enter hash_message_verification.list and click New.
   b. On the form, fill in the fields.
Hash Message Verification form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the auth token, such as TwilioSMSTestAppAuthToken.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the auth token, such as &quot;Twilio SMS Testing application Auth Token.&quot;</td>
</tr>
<tr>
<td>Secret</td>
<td>Auth token that is associated with your Twilio phone number.</td>
</tr>
</tbody>
</table>

c. Click Submit.

2. Create a Message Auth record.

a. In the navigation filter, enter `message_auth.list` and click **New**.

b. On the form, fill in the fields.

Message Auth form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the message auth, such as VA Twilio SMS Test App Message Auth.</td>
</tr>
<tr>
<td>Provider</td>
<td>Provider of the auth token. Enter <strong>Twilio</strong>.</td>
</tr>
<tr>
<td>Group name</td>
<td>Name of the recipient group. Leave this field blank.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>Service Portal that is associated with the message auth. Leave this field blank.</td>
</tr>
<tr>
<td>Inbound message verification</td>
<td>Hash message token that you created.</td>
</tr>
<tr>
<td>Outbound message verification</td>
<td>Hash message token that you created.</td>
</tr>
<tr>
<td>Outbound service token</td>
<td>Authorized outbound service token. Leave this field blank.</td>
</tr>
</tbody>
</table>

c. Click Submit.
3. Create a Messaging Provider Application record.

   a. Navigate to Conversational Interfaces > SMS integration with Twilio and click New.

   b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Messaging Provider Application form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>----------------------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Phone Number</td>
</tr>
<tr>
<td>Message auth</td>
</tr>
</tbody>
</table>

   c. Click Submit.

4. In the Twilio Console, for the phone number that you specified in Step 3, update the SMS incoming web-hook. Enter the following address:

   https://<instance-name>.service-now.com/api/sn_va_sms_twilio/message

What to do next
After you set up the Conversational SMS Integration with Twilio, you can create SMS conversation topics in Virtual Agent Designer. For more information on using the tool, see Virtual Agent Designer.

Related information
Install Conversational SMS Integration with Twilio
Install a ServiceNow Store application
Activate a plugin

Using Conversational SMS Integration with Twilio
Enable a requester to converse with an agent using the SMS conversations.
An administrator can configure the Conversational SMS Integration with Twilio application for integrating the SMS messaging app with a ServiceNow application.
A requester can initiate SMS conversations with a virtual agent or live agent.
A live agent can:
• Accept SMS conversations as work items from their Agent Workspace Inbox to converse with a requester.

• Initiate SMS chat conversations from interactions of type Chat from their Agent Workspace Inbox to converse with a requester.

**Accepting SMS conversations**

As a live agent interacting with a requester over the SMS service channel, you can:

• Converse with the requester through text messages.
• Share a knowledge article displayed as a link to the requester.
• Share a record, for example, a customer service case.
• Share any URLs as links.
• Share any images as attachments.

ℹ️ **Note:** You accept a work item from the SMS conversation in your Agent Workspace Inbox when an administrator has configured the SMS service channel for transfer of chat conversations. For more information, see Conversational SMS service channel.

**Initiating SMS conversations**

As a live agent, you can initiate an SMS conversation with a requester when the Agent-Initiated Messaging Interface application is configured for the SMS messaging channel. By default, the application is configured for agent to initiate SMS conversations with consumers and customer contacts. For more information, see Initiate messaging conversations from the CSM Configurable Workspace and Initiate SMS conversations from CSM Agent Workspace.

**Conversational Integration with WhatsApp (powered by Twilio)**

Engage with requesters who prefer the WhatsApp messaging app to interact with your business. Requesters include customer contacts and consumers.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
Overview
Enable requesters to interact on WhatsApp chat with a virtual agent or live agent using the ServiceNow® Conversational Integration with WhatsApp (powered by Twilio) application. The application connects a requester with a virtual agent or live agent using your company’s WhatsApp-enabled Twilio phone number. To get started with the Conversational Integration with WhatsApp (powered by Twilio) application, see Configure Conversational Integration with WhatsApp (powered by Twilio).

Notice regarding use by organizations
All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies
ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Configure Conversational Integration with WhatsApp (powered by Twilio)
Install and set up the Conversational Integration with WhatsApp (powered by Twilio) application to enable requesters to interact with virtual and live agents.
About this task
This task provides the general steps to integrate the WhatsApp messaging app with a ServiceNow application using the Conversational Integration with WhatsApp (powered by Twilio) application.

Procedure
1. Install Conversational Integration with WhatsApp (powered by Twilio).
2. Set up Conversational Integration with WhatsApp (powered by Twilio).
3. Design virtual agent topics to capture information from a WhatsApp chat conversation.

Install Conversational Integration with WhatsApp (powered by Twilio)
Install the Conversational Integration with WhatsApp (powered by Twilio) so that your business can interact with requesters on the WhatsApp app. The application includes demo data and installs related ServiceNow Store applications and plugins if they are not already installed.

Before you begin
- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin

About this task
The following applications or plugins are installed with Conversational Integration with WhatsApp (powered by Twilio):

**Twilio Spoke (sn_twilio_spoke)**
Provides Integration Hub actions that may be used to create, update, delete, and look up records on the Twilio app.
For more information on activating this application, see Twilio spoke.

**Conversational Custom Chat Integration (com.glide.cs.custom.adapter)**
Provides custom chat integration framework of scriptable APIs to enable the Virtual Agent application on any conversational interface.
For more information on this plugin, see Conversational custom chat integrations.
ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)
   Enables execution of IntegrationHub actions and flows.

Complex Object (com.glide.cobject)
   Enables complex objects.

Agent-Initiated Messaging Interface (sn_agent_initiated)
   Provides configurations for the agent-initiated messaging capabilities.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Conversational Integration with WhatsApp (powered by Twilio) application (sn_va_whatsapp_twi) using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Conversational Integration with WhatsApp (powered by Twilio).
4. Optional: If demo data is available and you want to install it, click Load demo data.
   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.
   **Important:** If you don't load the demo data during installation, it's unavailable to load later.
5. Click Install.

Set up Conversational Integration with WhatsApp (powered by Twilio)
Set up the Conversational Integration with WhatsApp (powered by Twilio) application so that you can engage requesters in bot conversations.
Before you begin
Before you begin, do the following:

• Get ServiceNow entitlements for the following products and applications:
  ◦ IntegrationHub
  ◦ Twilio spoke
  ◦ Conversational Integration with WhatsApp (powered by Twilio)
  For more information, see Get entitlement for a ServiceNow product or application.

• Install the following applications on your ServiceNow instance:
  ◦ IntegrationHub
  ◦ Twilio spoke
  ◦ Conversational Integration with WhatsApp (powered by Twilio)

• Connect your Twilio Number to your WhatsApp Business Profile.

• Set up Twilio spoke.

Role required: external_app_install_admin or va_admin

Procedure

1. Connect your company’s Twilio account with your ServiceNow instance.

   a. Log in to your Twilio Console.

   b. From the Project Info pane of the Console Dashboard page, note down the authentication token.
      You will later use this token to authenticate the Twilio account on your ServiceNow instance.
      For more information, see the Twilio documentation.

   c. To specify the webhook URL, in the Twilio console, navigate to
      Programmable Messaging > Senders > WhatsApp Senders.
      To enable your Twilio account to send messages to your ServiceNow instance, enter the webhook URL in the following format: https://<instance-name>.service-now.com/api/sn_va_whatsapp_twi/message.
d. Click your WhatsApp-enabled Twilio phone number.

e. In the **A MESSAGE COMES IN** field of the Configure WhatsApp Number dialog box, enter the webhook URL of your ServiceNow instance and click **Configure**.

2. To authenticate incoming hash messages from the Twilio account, create a Hash Message Verification record that stores the Twilio authentication token.

a. In the navigation filter of your ServiceNow instance, enter `hash_message_verification.list`.

b. In the Hash Message Verifications list, click **New**.

c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record in the Hash Message Verification [hash_message_verification] table that stores the authentication token that is associated with your company's WhatsApp-enabled Twilio phone number. For example, TwilioWhatsappTestAppAuthToken.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record. For example, Twilio Whatsapp Testing application Auth Token.</td>
</tr>
<tr>
<td>Secret</td>
<td>Twilio authentication token that is associated with your company's WhatsApp-enabled Twilio phone number.</td>
</tr>
</tbody>
</table>

d. Take note of the name of the Hash Message Verification record.

e. Click **Submit**.

3. Associate inbound message records with a Message Auth record.

a. In the navigation filter of your ServiceNow instance, enter `message_auth.list` and click **New**.

b. On the form, fill in the fields.
### Message Auth form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record in the Message Auth [message auth] table. For example, VA Twilio WhatsApp Test App Message Auth.</td>
</tr>
<tr>
<td>Provider</td>
<td>Provider of the auth token. Enter Twilio.</td>
</tr>
<tr>
<td>Group name</td>
<td>Name of the group that you created.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>Customer service portal that you created.</td>
</tr>
<tr>
<td>Outbound service token</td>
<td>Authorized outbound service token.</td>
</tr>
<tr>
<td>Inbound message verification</td>
<td>Name of the Hash Message Verification record that you created for the inbound hash messages in step 2.</td>
</tr>
<tr>
<td>Outbound message verification</td>
<td>Name of the Hash Message Verification record that you created for the inbound hash messages in step 2.</td>
</tr>
</tbody>
</table>

**Note:** The values for the Inbound message verification and Inbound message verification fields are the same.

c. Click **Submit**.

4. Associate the Message Auth record with the WhatsApp-enabled Twilio phone number.

a. In the navigation filter of your ServiceNow instance, enter `sys_cs_provider.list`.

b. In the Provider Channels list, click **Twilio** from the **Name** column corresponding to the **WhatsApp** channel.
   If the **Twilio** entry is not present, enter `sys_cs_provider_application.list` in the navigation filter to create the list.

c. In the Provider Channel Identity related list, click **New**.

d. On the form, fill in the fields.
Provider Channel Identity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the entity that users are contacting, such as IT Service Desk.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Twilio phone number that users are contacting.</td>
</tr>
<tr>
<td>Message auth</td>
<td>Message auth that you created in step 3.</td>
</tr>
</tbody>
</table>

**e. Click Submit.**

**Set the URL navigation for WhatsApp chat**

When agents share links in their WhatsApp chat conversations, customize the portal that those links point to. For example, you can configure links to point to your brand’s portal, or to the ServiceNow portal.

**Before you begin**

Install the Conversational Integration with WhatsApp (powered by Twilio) application on your ServiceNow instance.


Role required: admin

**Procedure**

1. In the navigation filter of your ServiceNow instance, enter `sys_cs_provider_list.do` and click **New**.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the channel you are using. Enter WhatsApp.</td>
</tr>
<tr>
<td>Provider</td>
<td>Name of the provider. Enter WhatsApp.</td>
</tr>
<tr>
<td>Default Portal</td>
<td>Portal to be used in the mapping. Select a portal from the list of portals.</td>
</tr>
<tr>
<td>Message Auth</td>
<td>Message auth that you created.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbound ID</td>
<td>Your WhatsApp inbound ID.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**What to do next**

For more information on setting up URL navigation, see Virtual Agent URL navigation for chat links.

**Capturing information from a user in a WhatsApp chat conversation**

Use the collection of input controls provided by the Virtual Agent Designer to prompt and capture information from a requester in a WhatsApp chat conversation.

Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints for conversations between a virtual agent and user. For more information, see Using Virtual Agent Designer.

**User notification consent**

Users must opt in to receive notifications. No notifications can be delivered until the user grants consent.

There are two ways for users to grant consent to receive notifications:

- The user can enter **Notification** into the WhatsApp chat with your business. The user gets a bot response with the option to subscribe or unsubscribe from receiving notifications for your business on WhatsApp.
- As the administrator, you can set up the option for users to subscribe or unsubscribe from notifications from your portal. See Configure system settings for more information.

**User input controls**

The Conversational Integration with WhatsApp (powered by Twilio) application supports the following user input controls in Virtual Agent Designer.

**Supported user input controls**

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>User enters a plain text string in the conversation.</td>
</tr>
<tr>
<td>Static Choice</td>
<td>User selects an item from a predefined list.</td>
</tr>
<tr>
<td>Boolean</td>
<td>User enters a Boolean response to the bot. For example, the user can reply <strong>Yes</strong> or <strong>No</strong> in a chat conversation.</td>
</tr>
</tbody>
</table>
Supported user input controls (continued)

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Picker</td>
<td>User sends a file to the bot.</td>
</tr>
<tr>
<td>Date Time</td>
<td>User selects a calendar date, time (hours and minutes), or both.</td>
</tr>
<tr>
<td>Carousel</td>
<td>User selects a single item from the carousel.</td>
</tr>
</tbody>
</table>

For more information about configuring user input controls, see Virtual Agent Designer user input controls.

The Conversational Integration with WhatsApp (powered by Twilio) application supports the following bot responses in Virtual Agent Designer.

Supported bot responses

<table>
<thead>
<tr>
<th>Bot response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Bot sends a plain text string to the user.</td>
</tr>
<tr>
<td>Image Output</td>
<td>Bot sends an image to the user.</td>
</tr>
<tr>
<td>Link</td>
<td>Bot sends a web link to the user.</td>
</tr>
<tr>
<td>Web UI image card output</td>
<td>Bot sends content from a record in a compact format, including an image with text.</td>
</tr>
<tr>
<td>Table</td>
<td>Bot response is displayed as a table.</td>
</tr>
</tbody>
</table>

For more information about configuring bot responses, see Virtual Agent Designer bot responses.

Closing idle WhatsApp chat conversations

Enable agents to effectively manage their active WhatsApp chat conversations by automatically closing conversations after they have been inactive for a pre-configured amount of time.

The Virtual Agent conversations are configured for the WhatsApp messaging app. By default, any conversations abandoned by requesters remain open or idle until they are automatically closed daily by the Time Out Abandoned VA Conversations scheduled job. For more information, see Closing Virtual Agent and Live Agent conversations.

As an administrator, you can change the default timeout period for idle Virtual Agent conversations configured for the WhatsApp messaging app by setting the
**com.glide.cs.whatsapp_idle_timeout** system property to the number of seconds that abandoned conversations remain open after the requester's last response. The system property value must be less than the time interval set for the **Time Out Abandoned VA Conversations** scheduled job, set to two hours (7200 seconds) by default. Because the **com.glide.cs.whatsapp_idle_timeout** system property isn't available by default, you must add it with the data type set to integer. For more information, see Add a system property.

**Transfer WhatsApp chat conversations to live agents**

Configure the Advanced Work Assignment application to transfer a WhatsApp chat conversation initiated by a requester to a live agent.

**Before you begin**

Your administrator must have completed the following tasks:

- Install Conversational Integration with WhatsApp (powered by Twilio).
- Activate Advanced Work Assignment.
- Set the application scope to Conversational Integration with WhatsApp (powered by Twilio) using the application picker. For more information, see Application picker.
- Activate the Conversational Messaging plugin (com.glide.messaging.awa). For more information, see Activate Conversational Messaging.

**About this task**

Role required: admin

**Procedure**

1. Enable the WhatsApp service channel.
   - Navigate to Advanced Work Assignment > Settings > Service Channels.
   - In the Name column of the Queues list, search for WhatsApp.
   - Click WhatsApp.
   - On the Service Channel form, select the Active check box.
   - Click Update. For more information, see Service channels.

2. Automatically route work items for WhatsApp chat conversations to agents by configuring the queue for the WhatsApp service channel.
   - Navigate to Advanced Work Assignment > Settings > Queues.
   - In the Name column of the Queues list, search for Agent WhatsApp Queue.
   - Click Agent WhatsApp Queue.
d. On the Queue form, select the **Active** check box.

e. Click **Update**.

1. **Note:** By default, the *WhatsApp - Most Capacity* assignment rule is associated with the Agent WhatsApp Queue. You can create another assignment rule and associate it with the queue. For more information, see Configure agent assignment rules and Work item queues.

3. Configure agent presence states for the WhatsApp service channel.

   a. Navigate to **Advanced Work Assignment > Settings > Presence States**.

   b. In the **Name** column of the Presence States list, click an existing state.

   c. In the **Apply to groups** section of the Presence State form, click the add icon (>) to move the **Agent WhatsApp Group** group from the **Available** column to the **Selected** column.

   1. **Note:** You can ignore this step if you have selected the **Apply to all groups** check box.

   d. Click **Update**.

      For more information, see Configure agent presence states.

**Using Conversational Integration with WhatsApp (powered by Twilio)**

Enable a requester to converse with an agent using the WhatsApp chat conversations.

An administrator can configure the Conversational Integration with WhatsApp (powered by Twilio) application for integrating the WhatsApp messaging app with a ServiceNow application. For more information, see Integrating the WhatsApp messaging app with other applications.

Agents and requesters can do the following:

- A live agent can initiate WhatsApp chat conversations with a requester.
- A requester can initiate WhatsApp chat conversations with a virtual agent or live agent.
- A live agent can accept WhatsApp chat conversations as work items from their Agent Workspace Inbox to converse with a requester.
**Initiating WhatsApp chat conversations**

As a live agent, you can initiate WhatsApp chat conversations with a requester in two ways:

- Send a message from either an active interaction record, a contact record, or a consumer contact record. See Setting up Agent Chat.
- Set up notifications to be sent to the requester when a business event occurs or when a record is updated. See Create a provider notification.

⚠️ **Note:** The requester must subscribe and opt in to receive notifications.

**Accepting WhatsApp chat conversations**

As a live agent interacting with a requester over the WhatsApp service channel, you can do the following:

- Converse with the requester through text messages.
- Share a knowledge article displayed as a link to the requester.
- Share a record. For example, a customer service case.
- Share any URLs as links.
- Share any files as attachments.

⚠️ **Note:** If an administrator has configured the WhatsApp service channel for transfer of chat conversations, then you can accept a work item from the WhatsApp chat conversation in your Agent Workspace Inbox. For more information, see Transfer WhatsApp chat conversations to live agents and Service channels.

**Integrating the WhatsApp messaging app with other applications**

Other ServiceNow applications and features can use the Conversational Integration with WhatsApp (powered by Twilio) application.

As a live agent, when you accept a request from the WhatsApp service channel, you can converse with the requester within the same channel.

**Integrating with Customer Service Management**

Integrate the Conversational Integration with WhatsApp (powered by Twilio) application with the ServiceNow® Customer Service Management application to enable your customer contacts and consumers to initiate a WhatsApp chat conversation with a virtual agent or live agent. An agent can initiate a conversation, or accept a conversation initiated from aLINE chat.
conversation. For more information, see Integrate WhatsApp with Customer Service Management through Twilio.

**Conversational Integration with LINE**

Engage with requesters who prefer the LINE messaging app to interact with your business. Requesters include customer contacts and consumers.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Overview**

Conduct user-initiated, system-initiated, or agent-initiated conversations using the Conversational Integration with LINE application. The application connects a requester with a virtual agent or live agent using your company’s LINE account. To get started with the Conversational Integration with LINE application, see Configure Conversational Integration with LINE.

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

**Notice regarding use by government agencies**

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely
responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Configure Conversational Integration with LINE

Install and set up the Conversational Integration with LINE application to enable your users to interact with virtual and live agents.

About this task
This task provides the general steps to integrate the LINE messaging app with a ServiceNow application using the Conversational Integration with LINE application.

Procedure
1. Install Conversational Integration with LINE.
2. Set up Conversational Integration with LINE.
3. Design virtual agent topics to capture information from a LINE chat conversation.
4. Optional: Close idle LINE chat conversations.
5. Optional: Transfer LINE chat conversations to live agents.

Install Conversational Integration with LINE

Install the Conversational Integration with LINE so that your business can interact with requesters on the LINE app. The application includes demo data and installs related ServiceNow Store applications and plugins if they are not already installed.

Before you begin
• Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
• For existing customers, ensure that you install the Conversational Integration with LINE application on ServiceNow instances that have been upgraded to at least the Rome release.
Role required: admin

About this task
The following applications or plugins are installed with Conversational Integration with LINE:

**Conversational Custom Chat Integration (com.glide.cs.custom.adapter)**
Provides the custom chat integration framework of scriptable APIs to enable the Virtual Agent application on any conversational interface.
For more information on this plugin, see Conversational custom chat integrations.

**ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)**
Enables execution of IntegrationHub actions and flows.

**IHUB Spoke Util Pack (com.snc.ihub_spoke_util_pack)**
Enables utility or global scripts that can be invoked from the Integration Spokes.

**Agent-Initiated Messaging Interface (sn_agent_initiated)**
Provides configurations for the agent-initiated messaging capabilities.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Conversational Integration with LINE application (sn_va_line) using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Conversational Integration with LINE.
4. **Optional:** If demo data is available and you want to install it, click **Load demo data**.

(Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

**Important:** If you don't load the demo data during installation, it's unavailable to load later.

5. Click **Install**.

**Set up Conversational Integration with LINE**

Set up the Conversational Integration with LINE application so that you can engage customers in conversations with bots.

**Before you begin**

Before you begin, do the following:

- Get ServiceNow entitlements for the following products and applications:
  - IntegrationHub
  - Conversational Integration with LINE
  For more information, see **Get entitlement for a ServiceNow product or application**.

- Install the following applications on your ServiceNow instance:
  - IntegrationHub
  - Conversational Integration with LINE

- Activate the IHUB Spoke Util Pack plugin (com.snc.ihub_spoke_util_pack). For more information, see **Activate a plugin**.

- Get a developer account in the **LINE Developers console**.

**Role required:** external_app_install_admin or va_admin

**About this task**

The LINE messaging app supports only one LINE channel for a ServiceNow instance. If you would like to configure a different LINE channel for your ServiceNow instance, you must first remove the previously configured LINE channel, and then set up the new channel.
Procedure

1. Connect your company's LINE account with your ServiceNow instance.
   
   a. Log in to your LINE Developers Console.
   
   b. Create a channel on the LINE Developers Console.
   
   c. Take note of the channel secret and the channel access token. You will use this information for authenticating the LINE account on your ServiceNow instance.
   
   d. To enable your LINE account to send data to your ServiceNow instance, enter the webhook URL and click Verify. You specify the webhook URL in the Webhook URL field on the Messaging API tab of the LINE Developers Console. Use the following format for the URL: https://<instance-name>.service-now.com/api/sn_va_line/va_adapter_line.

2. To authenticate incoming hash messages from the LINE account, create a Hash Message Verification record for the LINE channel secret.

   a. In the navigation filter of your ServiceNow instance, enter hash_message_verification.list.

   b. In the Hash Message Verifications list, click New.

   c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record in the Hash Message Verification table that stores the channel secret associated with your company's LINE account. For example, <strong>LINE Inbound</strong>.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record. For example, <strong>LINE Inbound Testing application</strong>.</td>
</tr>
<tr>
<td>Secret</td>
<td>LINE channel secret that is associated with your company's LINE account.</td>
</tr>
</tbody>
</table>
d. Take note of the name of the Hash Message Verification record.

e. Click **Submit**.

3. To authorize outgoing token messages to the LINE account, create a Token Verification record for the LINE channel access token.

a. In the navigation filter of your ServiceNow instance, enter `token_verification.list`.

b. In the Token Verifications list, click **New**.

c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Token Verification form</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Value</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the record in the Token Verification [token_verification] table that stores the channel access token associated with your company’s LINE account. For example, LINE Outbound.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record. For example, LINE Outbound Testing application.</td>
</tr>
<tr>
<td>Token</td>
<td>LINE channel access token that is associated with your company’s LINE account.</td>
</tr>
</tbody>
</table>

d. Take note of the name of the Token Verification record.

e. Click **Submit**.

4. Associate inbound and outbound message records with a Message Auth record.

a. In the navigation filter of your ServiceNow instance, enter `message_auth.list` and click **New**.

b. On the form, fill in the fields.
Message Auth form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record in the Message Auth [message auth] table. For example, VA LINE Test App Message Auth.</td>
</tr>
<tr>
<td>Provider</td>
<td>Provider of the auth token. Enter LINE.</td>
</tr>
<tr>
<td>Group name</td>
<td>Name of the group that you created.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>Customer service portal that you created.</td>
</tr>
<tr>
<td>Outbound service token</td>
<td>Authorized outbound service token.</td>
</tr>
<tr>
<td>Inbound message verification</td>
<td>Name of the Hash Message Verification record that you created for the inbound hash messages in step 2.</td>
</tr>
<tr>
<td>Outbound message verification</td>
<td>Name of the Token Verification record that you created for the outbound token messages in step 3.</td>
</tr>
</tbody>
</table>

**c.** Take note of the name of the Message Auth record.

**d.** Click **Submit**.

**5.** Associate the Message Auth record with the LINE provider.

**a.** In the navigation filter of your ServiceNow instance, enter `sys_cs_provider.list`.

**b.** In the Provider Channels list, click **Line** from the **Name** column.

If the **LINE** entry is not present, enter `sys_cs_provider_application.list` in the navigation filter to create the list.

**c.** In the Provider Channel Identity related list, double-click the **Message auth** column field value for the **LINE** row and enter the name of the Message Auth record that you created in **step 4**.
**Set the URL navigation for LINE chat**

When agents share links in their LINE chat conversations, customize the portal that those links point to. For example, you can configure links to point to your brand’s portal, or to the ServiceNow portal.

**Before you begin**

Install the Conversational Integration with LINE application on your ServiceNow instance.


Role required: admin

**Procedure**

1. In the navigation filter of your ServiceNow instance, enter `sys_cs_provider_list.do` and click **New**.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the channel you are using. Enter <strong>LINE</strong>.</td>
</tr>
<tr>
<td>Provider</td>
<td>Name of the provider. Enter <strong>LINE</strong>.</td>
</tr>
<tr>
<td>Default Portal</td>
<td>Portal to be used in the mapping. Select a portal from the list of portals.</td>
</tr>
<tr>
<td>Message Auth</td>
<td>Message auth that you created.</td>
</tr>
<tr>
<td>Inbound ID</td>
<td>Your LINE inbound ID.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**What to do next**

For more information on setting up URL navigation, see [Virtual Agent URL navigation for chat links](#).

**Capturing information from a user in a LINE chat conversation**

Use the collection of input controls provided by the Virtual Agent Designer to prompt and capture information from the user in a LINE chat conversation.
Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints for conversations between a virtual agent and user. For more information, see Using Virtual Agent Designer.

**User notification consent**

Users must opt in to receive notifications. No notifications can be delivered until the user grants consent.

There are two ways for users to grant consent to receive notifications:

- The user can enter Notification into the LINE chat with your business. The user gets a bot response with the option to subscribe or unsubscribe from receiving notifications for your business on LINE.
- As an administrator, you can set up the option for users to subscribe or unsubscribe from notifications from your portal. See Configure system settings for more information.

**User input controls**

The Conversational Integration with LINE application supports the following user input controls in Virtual Agent Designer.

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>User enters a plain text string in the conversation. The maximum character limit is 5000 characters.</td>
</tr>
<tr>
<td>Static Choice</td>
<td>User selects an item from a predefined list. In a quick reply, the label has the maximum character limit of 20 characters. At a time, a user can view only 13 quick replies. If there are more than 13 quick replies, the pagination format is used to view more options. The default value of the maximum number of replies for a page is set in the <code>sn_va_line.max.picker.choices</code> system property. The property is located in the System Property [sys_properties] table.</td>
</tr>
<tr>
<td>Boolean</td>
<td>User enters a Boolean response to the bot. For example, the user can reply Yes or No in a chat conversation.</td>
</tr>
<tr>
<td>File Picker</td>
<td>User sends a file to the bot. The supported file types are JPG, PNG, BMP, and MP4. Files have a maximum size limit based on file type:</td>
</tr>
</tbody>
</table>
**Supported user input controls (continued)**

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
</table>
| • For images, the maximum size limit is 10 MB.  
• For videos, the maximum size limit is 200 MB. |
| Date Time | User selects a calendar date, time (hours and minutes), or both. |
| Carousel | User selects a single item from the carousel.  
In a carousel, the title for an image has a maximum limit of 40 characters and the text for the image has a maximum character limit of 60 characters. At a time, a user can view only 10 images. If there are more than 10 images, the pagination format is used to view more options. The default value of the maximum number of images in the carousel for a page is set in the `sn_va_line.max.carousel.cards` system property. The property is located in the System Property [sys_properties] table. |

For more information about configuring user input controls, see [Virtual Agent Designer user input controls](#).

The Conversational Integration with LINE application supports the following bot responses in Virtual Agent Designer.

**Supported bot responses**

<table>
<thead>
<tr>
<th>Bot response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Bot sends a plain text string to the user.</td>
</tr>
<tr>
<td>Image Output</td>
<td>Bot sends an image to the user.</td>
</tr>
<tr>
<td>Link</td>
<td>Bot sends a web link to the user.</td>
</tr>
<tr>
<td>Web UI image card output</td>
<td>Bot sends content from a record in a compact format, including an image with text.</td>
</tr>
<tr>
<td>Table</td>
<td>Bot response is displayed as a table.</td>
</tr>
</tbody>
</table>

For more information about configuring bot responses, see [Virtual Agent Designer bot responses](#).
Closing idle LINE chat conversations

Enable agents to effectively manage their active LINE chat conversations by automatically closing conversations after they have been inactive for a pre-configured amount of time.

The Virtual Agent conversations are configured for the LINE messaging app. By default, any conversations abandoned by requesters remain open or idle until they are automatically closed daily by the Time Out Abandoned VA Conversations scheduled job. For more information, see Closing Virtual Agent and Live Agent conversations.

As an administrator, you can change the default timeout period for idle Virtual Agent conversations configured for the LINE messaging app by setting the com.glide.cs.line_idle_timeout system property to the number of seconds that abandoned conversations remain open after the requester's last response. The system property value must be less than the time interval set for the Time Out Abandoned VA Conversations scheduled job, set to two hours (7200 seconds) by default. Because the com.glide.cs.line_idle_timeout system property isn't available by default, you must add it with the data type set to integer. For more information, see Add a system property.

Transfer LINE chat conversations to live agents

Configure the Advanced Work Assignment application to transfer a LINE chat conversation initiated by a requester (customer contact or consumer) to a live agent.

Before you begin

Your administrator must have completed the following tasks:

• Activate Advanced Work Assignment.
• Install Conversational Integration with LINE.
• Set the application scope to Conversational Integration with LINE using the application picker. For more information, see Application picker.
• Activate the Conversational Messaging plugin (com.glide.messaging.awa). For more information, see Activate Conversational Messaging.

About this task

Role required: admin
Procedure

1. Enable the Line service channel.
   a. Navigate to Advanced Work Assignment > Settings > Service Channels.
   b. In the Name column of the Queues list, search for Line.
   c. Click Line.
   d. On the Service Channel form, select the Active check box.
   e. Click Update.

For more information, see Service channels.

2. Automatically route work items for LINE chat conversations to agents by configuring the queue for the Line service channel.
   a. Navigate to Advanced Work Assignment > Settings > Queues.
   b. In the Name column of the Queues list, search for Agent Line Queue.
   c. Click Agent Line Queue.
   d. On the Queue form, select the Active check box.
   e. Click Update.

   Note: By default, the Line - Most Capacity assignment rule is associated with the Agent Line Queue. You can create another assignment rule and associate it with the queue. For more information, see Configure agent assignment rules and Work item queues.

3. Configure agent presence states for the Line service channel.
   a. Navigate to Advanced Work Assignment > Settings > Presence States.
   b. In the Name column of the Presence States list, click an existing state.
   c. On the Presence State form, in the Service channels section, click the add icon (>) to move the Line service channel from the Available column to the Selected column.
   d. In the Apply to groups section of the Presence State form, click the add icon (>) to move the Agent Line Group group from the Available column to the Selected column.
Note: You can ignore this step if you have selected the **Apply to all groups** check box.

e. Click **Update**.

For more information, see **Configure agent presence states**.

Using Conversational Integration with LINE

Enable a requester to converse with an agent using the LINE chat conversations.

An administrator can configure the Conversational Integration with LINE application for integrating the LINE messaging app with a ServiceNow application. For more information, see **Integrating the LINE messaging app with other applications**.

The following options are available:

- An administrator can configure system-initiated messages to be delivered as LINE chat conversations.
- A live agent can initiate LINE chat conversations with a requester.
- A requester can initiate LINE chat conversations with a virtual agent or live agent.
- A live agent can accept LINE chat conversations as work items from their Agent Workspace Inbox to converse with a requester.

Initiating LINE chat conversations

As a live agent, you can initiate LINE chat conversations with a requester in two ways:

- Send a message from either an active interaction record, a contact record, or a consumer contact record. See **Setting up Agent Chat**.
- Set up notifications to be sent to the requester when a business event occurs or when a record is updated. See **Create a provider notification**.

Note: The requester must subscribe and opt in to receive notifications.

Accepting LINE chat conversations

As a live agent interacting with a requester over the LINE service channel, you can do the following:
• Converse with the requester through text messages.
• Share a knowledge article displayed as a link to the requester.
• Share a record, for example, a customer service case.
• Share any URLs as links.
• Share any files as attachments.

Note: If an administrator has configured the Line service channel for transfer of chat conversations, then you can accept a work item from the LINE chat conversation in your Agent Workspace Inbox. For more information, see Transfer LINE chat conversations to live agents and Service channels.

Integrating the LINE messaging app with other applications

Other ServiceNow applications and features can use the Conversational Integration with LINE application.

As an administrator, you can use the Conversational Integration with LINE application to integrate the LINE messaging app with other ServiceNow applications. You can enable requesters and agents to converse with an agent using the LINE messaging app.

Integrating with Customer Service Management

Integrate the Conversational Integration with LINE application with the ServiceNow® Customer Service Management application to enable your customer contacts and consumers to initiate a LINE chat conversation with a virtual agent or live agent. An agent can initiate a conversation, or accept a conversation initiated from a LINE chat conversation. For more information, see Integrate LINE with Customer Service Management.

Conversational Integration with Facebook Messenger

Engage with requesters including customer contacts and consumers who prefer the Facebook Messenger app to chat with an agent.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
Overview
Enable your users to initiate a Facebook Messenger chat conversation with a virtual agent by using the Conversational Integration with Facebook Messenger application. The application connects a requester with a virtual agent or live agent using your company's Facebook Messenger account. To get started with the Conversational Integration with Facebook Messenger application, see Configure Conversational Integration with Facebook Messenger.

Notice regarding use by customers
Customers are solely responsible for the implementation of the Conversational Integration with Facebook Messenger application. The use of this application in a Facebook app requires a review of the app by the Facebook Developer Support team. It is the responsibility of customers to complete this app review process. The following links from the Facebook site provide guidance on how to complete the app review process:

2. Facebook Pre-Launch Checklist: https://developers.facebook.com/docs/messenger-platform/prelaunch-checklist
3. Facebook review and submission process for applications: https://developers.facebook.com/docs/messenger-platform/#review---submission-process

Configure Conversational Integration with Facebook Messenger
Install and set up the Conversational Integration with Facebook Messenger application to enable your users to interact with virtual and live agents.

About this task
This task provides the general steps to integrate the Facebook Messenger messaging app with a ServiceNow application using the Conversational Integration with Facebook Messenger application.

Procedure
1. Install Conversational Integration with Facebook Messenger.
2. Set up Conversational Integration with Facebook Messenger.
3. Design virtual agent topics to capture information from a Facebook Messenger chat conversation.
4. Optional: Close idle Facebook Messenger chat conversations.
5. Optional: Transfer Facebook Messenger chat conversations to live agents.
Install Conversational Integration with Facebook Messenger

You can install the Conversational Integration with Facebook Messenger application (sn_va_fb_messenger) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin

About this task

The following applications or plugins are installed with Conversational Integration with Facebook Messenger:

Conversational Custom Chat Integration (com.glide.cs.custom.adapter)

Provides custom chat integration framework of scriptable APIs to enable the Virtual Agent application on any conversational interface.

For more information on this plugin, see Conversational custom chat integrations.

ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Enables execution of IntegrationHub actions and flows.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Conversational Integration with Facebook Messenger application (sn_va_fb_messenger) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need
to be installed, you must install them before you can install Conversational Integration with Facebook Messenger.

4. Optional: If demo data is available and you want to install it, click Load demo data.

(Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

**Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.

**Set up Conversational Integration with Facebook Messenger**

Set up the Conversational Integration with Facebook Messenger application so that you can engage customers in conversations with bots.

**Before you begin**

- Get ServiceNow entitlements for the following products and applications:
  - IntegrationHub
  - Conversational Integration with Facebook Messenger
  For more information, see [Get entitlement for a ServiceNow product or application](#).

- Install the following applications on your ServiceNow instance:
  - IntegrationHub
  - Conversational Integration with Facebook Messenger

- Complete Facebook Messenger settings.
  1. Set up a Facebook developer account.
  2. Create a Facebook app.
  3. Review the Messenger Platform Policy and Pre-Launch Checklist prior to submission.
  4. Submit the app for review.
  5. Create a Facebook page within the Facebook app you created earlier.
  6. Enable Facebook Messenger.

Role required: external_app_install_admin or va_admin
Procedure

1. Connect your company’s Facebook Messenger service with your ServiceNow instance.
   
   a. Log in to your Facebook developer account and open the Facebook app you created.
   
   b. Enable your Facebook app to send data to your ServiceNow instance by entering the webhook URL.
      
      i. Click Add Callback URL in the Webhooks section of the app.
      
      ii. In the Edit Callback URL dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callback URL</td>
<td>Public URL for webhook. Enter the webhook URL in the following format:</td>
</tr>
<tr>
<td></td>
<td>https://&lt;instance-name&gt;.service-now.com/api/now/v1/cs/adapter/messenger/message</td>
</tr>
<tr>
<td>Token</td>
<td>Token for webhook. By default, the token for ServiceNow webhook is nowbot. As a user with the admin role, you can set the glide.cs.facebook_messenger_verify_token system property to a desired value and then enter that value in this field. Because the glide.cs.facebook_messenger_verify_token system property isn’t available by default, you must add it with the data type set to string. For more information, see Add a system property.</td>
</tr>
</tbody>
</table>

   iii. Click Verify and Save.

   c. Make a note of your Facebook page ID and access token.
      
      i. Click Add or Remove Pages and select your Facebook page.
      
      ii. Make a note of the page ID displayed below the page name. You can click the page ID to copy the ID to your clipboard.
iii. In the Access Tokens section, click **Generate Token** for the Facebook page you created.

**Note:** Make note of the page access token used later for authenticating the Facebook Messenger on your ServiceNow instance.

d. Subscribe your Facebook app to your Facebook page.
   i. In the Webhooks section, click **Add Subscriptions**.
      For each authorized Page, the Webhooks section contains the fields the app can subscribe to.
   ii. In the Edit Page Subscriptions dialog box, select `messages` and `messaging_postbacks`.
   iii. Click **Save**.

e. Make a note of the App secret from Basic Settings.

f. Optional: Send messages with timestamp in the customer's time zone by navigating to **Page settings > Advanced messaging**, selecting the **Time zone** option in the Requested Features section, and clicking **Request** displayed next to the selected option.

2. Authenticate incoming hash messages from the Facebook app by creating Hash Message Verification record for the Facebook app secret.

   a. In the navigation filter of your ServiceNow instance, enter `hash_message_verification.list`.

   b. In the Hash Message Verifications list, click **New**.

   c. On the form, fill in the fields.

   **Hash Message Verification form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record in the Hash Message Verification [hash_message_verification] table that stores the access token associated with your Facebook page. For example, Facebook Inbound.</td>
</tr>
</tbody>
</table>
### Description

Description of the record. For example, Facebook Inbound Testing application.

### Secret

App secret token associated with your Facebook app you noted in step 1.e.

---

**d. Click Submit.**

3. Authorize outgoing token messages to the Facebook page by creating a Token Verification record for the Facebook channel access token.

   **a.** In the navigation filter of your ServiceNow instance, enter token_verification.list.

   **b.** In the Token Verifications list, click **New**.

   **c.** On the form, fill in the fields.

   **Token Verification form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record in the Token Verification [token_verification] table that stores the channel access token associated with your company’s Facebook account. For example, Facebook Messenger Outbound.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the record. For example, Facebook Messenger Outbound Testing application.</td>
</tr>
<tr>
<td>Token</td>
<td>Access token associated with the Facebook page you noted in step 1.c.</td>
</tr>
</tbody>
</table>

   **d. Click Submit.**

4. Associate inbound and outbound message records with a Message Auth record.
a. In the navigation filter of your ServiceNow instance, enter `message_auth.list` and click **New**.

b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record in the Message Auth [message auth] table. For example, Facebook Messenger Auth.</td>
</tr>
<tr>
<td>Provider</td>
<td>Provider of the auth token. Enter Facebook Messenger.</td>
</tr>
<tr>
<td>Inbound message verification</td>
<td>Name of the Hash Message Verification record that you created for the inbound hash messages in step 2.</td>
</tr>
<tr>
<td>Outbound message verification</td>
<td>Name of the Token Verification record that you created for the outbound token messages in step 3.</td>
</tr>
</tbody>
</table>

i Note: Leave the **Group name**, **Service Portal**, and **Outbound service token** fields empty because they are not required.

c. Click **Submit**.

5. Associate the Message Auth record with the Facebook Messenger provider.

a. In the navigation filter of your ServiceNow instance, enter `sys_cs_provider.list`.

b. In the Provider Channels list, click **Facebook Messenger** from the **Name** column.

c. In the Provider Channel Identity related list, double-click the **Message auth** column field value for the Facebook Messenger row and enter the name of the Message Auth record you created in step 4.

6. Set up the Facebook Messenger messaging channel.

a. In the navigation filter of your ServiceNow instance, enter `sys_cs_channel.list`.

b. In the Messaging Channels list, click **Facebook Messenger** from the **Name** column.
c. On the form, fill in or modify the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your channel.</td>
</tr>
<tr>
<td>Opted in all topics by default</td>
<td>Option to make all topics available in this channel.</td>
</tr>
<tr>
<td>Enable Notifications</td>
<td>Option to turn notifications on or off for this channel.</td>
</tr>
<tr>
<td>Note: Notifications are supported only for sys_users and not consumers and customer contacts.</td>
<td></td>
</tr>
<tr>
<td>Store app page link</td>
<td>This field should be left empty.</td>
</tr>
<tr>
<td>Type</td>
<td>Channel type.</td>
</tr>
<tr>
<td>• Chat: Standard chat experience</td>
<td></td>
</tr>
<tr>
<td>• Messaging: Long-running conversation</td>
<td></td>
</tr>
<tr>
<td>Secure</td>
<td>Option for the channel to be secure to support handling of sensitive data such as passwords.</td>
</tr>
<tr>
<td>Support typing indicator</td>
<td>Option to display typing indicators for this channel. Flag is applicable to both agent and bot indicators.</td>
</tr>
<tr>
<td>Icon</td>
<td>This field should be left empty.</td>
</tr>
</tbody>
</table>

d. Click **Update** to save the changes.

**Capturing information from a user in a Facebook Messenger chat conversation**

Use the collection of input controls provided by the Virtual Agent Designer to prompt and capture information from the user in a Facebook Messenger chat conversation.

Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints for conversations between a virtual agent and user. For more information, see [*Using Virtual Agent Designer*](#).

The Conversational Integration with Facebook Messenger application supports the following user input controls in Virtual Agent Designer.
## Supported user input controls

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Text**           | User enters a plain text string in the conversation.  
The maximum character limit is 5000 characters. |
| **Static Choice**  | User selects an item from a predefined choice list.  
In a quick reply, the label has the maximum character limit of 20 characters. At a time, a user can view only 13 quick replies. If there are more than 13 quick replies, the pagination format is used to view more options. The default value of the maximum number of replies for a page is set in the `sn_va_fb_messenger.max_quick_replies` system property (location: System Property [sys_properties] table). |
| **Boolean**        | User enters a Boolean response to the bot. For example, the user can reply *Yes* or *No* in a chat conversation. |
| **File Picker**    | User sends a file to the bot.  
The supported file types are JPG, PNG, BMP, and MP4.  
Note the following points about the maximum size limit for a file type:  
• For images, the maximum size limit is 10 MB.  
• For videos, the maximum size limit is 200 MB. |
| **Date Time**      | User selects a calendar date, time (hours and minutes), or both.  

**Note:** If your administrator has set the option to request time zone from the customer, the selected date and time reflect customer's time zone. Else, they appear in the UTC time zone. For more information about the time zone setting, see [1.f]. |
| **Carousel**       | User selects a single item from the carousel.  
In a carousel, the title for an image has maximum limit of 40 characters and the text for the image has maximum character limit of 60 characters. At a time, a user can view only 10 images. If there are more than 10 images, the pagination format is used to view more options. The default value of the maximum |
Supported user input controls (continued)

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>number of images in a carousel for a page is set in the sn_va_fb_messenger.max_carousel_cards system property (location: System Property [sys_properties] table).</td>
</tr>
</tbody>
</table>

For more information about configuring user input controls, see Virtual Agent Designer user input controls.

The Conversational Integration with Facebook Messenger application supports the following bot responses in Virtual Agent Designer.

<table>
<thead>
<tr>
<th>Bot response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Bot sends a plain text string to the user.</td>
</tr>
<tr>
<td>Image Output</td>
<td>Bot sends an image to the user.</td>
</tr>
<tr>
<td>Link</td>
<td>Bot sends a web link to the user.</td>
</tr>
<tr>
<td>Card</td>
<td>Bot sends selected information from a record on your instance.</td>
</tr>
</tbody>
</table>

Note: You can also return search results as bot responses in Facebook Messenger chat conversations when there are no relevant topics to display to end users. For more information, see Virtual Agent integration with AI Search.

For more information about configuring bot responses, see Virtual Agent Designer bot responses.

Closing idle Facebook Messenger chat conversations

Enable agents to effectively manage their active Facebook Messenger chat conversations by automatically closing conversations after they have been inactive for a pre-configured amount of time.

The Virtual Agent conversations are configured for the Facebook Messenger app. By default, any conversations abandoned by requesters remain open or idle until they are automatically closed daily by the Time Out Abandoned VA.
Conversations scheduled job. For more information, see Closing Virtual Agent and Live Agent conversations.

As an administrator, you can change the default timeout period for idle Virtual Agent conversations configured for the Facebook Messenger app by setting the com.glide.cs.facebook_messenger_idle_timeout system property to the number of seconds that abandoned conversations remain open after the requester's last response. The system property value must be less than the time interval set for the Time Out Abandoned VA Conversations scheduled job, set to two hours (7200 seconds) by default. Because the com.glide.cs.facebook_messenger_idle_timeout system property isn't available by default, you must add it with the data type set to integer. For more information, see Add a system property.

Transfer Facebook Messenger chat conversations to live agents

Configure the Advanced Work Assignment application to transfer a Facebook Messenger chat conversation initiated by a requester (customer contact or consumer) to a live agent.

Before you begin

Your administrator must have completed the following tasks:

- Activate Advanced Work Assignment.
- Install Conversational Integration with Facebook Messenger.
- Set the application scope to Conversational Integration with Facebook Messenger using the application picker. For more information, see Application picker.
- Activate the Conversational Messaging plugin (com.glide.messaging.awa). For more information, see Activate Conversational Messaging.

About this task

Role required: admin

Procedure

1. Enable the Facebook Messenger service channel.
   a. Navigate to Advanced Work Assignment > Settings > Service Channels.
   b. In the Name column of the Queues list, search for Line.
   c. Click Facebook Messenger.
   d. On the Service Channel form, select the Active check box.
   e. Click Update.
   For more information, see Service channels.
2. Automatically route work items for Facebook Messenger chat conversations to agents by configuring the queue for the Facebook Messenger service channel.
   a. Navigate to Advanced Work Assignment > Settings > Queues.
   b. In the Name column of the Queues list, search for Agent Facebook Messenger Queue.
   c. Click Agent Facebook Messenger Queue.
   d. On the Queue form, select the Active check box.
   e. Click Update.

   Note: By default, the Facebook Messenger - Most Capacity assignment rule is associated with the Agent Facebook Messenger Queue. You can create another assignment rule and associate it with the queue. For more information, see Configure agent assignment rules and Work item queues.

3. Configure agent presence states for the Facebook Messenger service channel.
   a. Navigate to Advanced Work Assignment > Settings > Presence States.
   b. In the Name column of the Presence States list, click an existing state.
   c. On the Presence State form, in the Service channels section, click the add icon (>) to move the Facebook Messenger service channel from the Available column to the Selected column.
   d. In the Apply to groups section of the Presence State form, click the add icon (>) to move the Agent Facebook Messenger Group group from the Available column to the Selected column.

   Note: You can ignore this step if you have selected the Apply to all groups check box.

   e. Click Update.

   For more information, see Configure agent presence states.

Using Conversational Integration with Facebook Messenger

Enable a requester to converse with an agent using the Facebook Messenger chat conversations.
An administrator can configure the Conversational Integration with Facebook Messenger application for integrating the Facebook Messenger app with a ServiceNow application. For more information, see Integrating the LINE messaging app with other applications.

A requester can initiate Facebook Messenger chat conversations with a virtual agent or live agent.

A live agent can accept Facebook Messenger chat conversations as work items from their Agent Workspace Inbox to converse with a requester.

**Accepting Facebook Messenger chat conversations**

As a live agent interacting with a requester over the Facebook Messenger service channel, you can:

- Converse with the requester through text messages.
- Share a knowledge article displayed as a link to the requester.
- Share a record, for example, a customer service case.
- Share any URLs as links.
- Share any files as attachments.

⚠️ **Note:** You accept a work item from the Facebook Messenger chat conversation in your Agent Workspace Inbox when an administrator has configured the Facebook Messenger service channel for transfer of chat conversations. For more information, see Transfer Facebook Messenger chat conversations to live agents and Service channels.

**Integrating the Facebook Messenger messaging app with other applications**

Review this topic to see which ServiceNow applications and features can use the Conversational Integration with Facebook Messenger application.

As an administrator, you can use the Conversational Integration with Facebook Messenger application to integrate the Facebook Messenger messaging app with other ServiceNow applications and enable requesters to converse with agents using the Facebook Messenger messaging app.

**Integrating with Customer Service Management**

Integrate the Conversational Integration with Facebook Messenger application with the ServiceNow® Customer Service Management application to enable your customer contacts and consumers to initiate a Facebook Messenger chat conversation with a virtual agent or live agent. For more information, see Integrate Facebook Messenger with Customer Service Management.
Virtual Agent integration with voice channels

Enable users to run Virtual Agent bot conversations in supported third-party voice applications. Use the Conversational Integration apps for Alexa and Google Assistant that are available from the ServiceNow® Store to configure these voice-based apps for your ServiceNow instance.

The Virtual Agent interface for the voice channels applications (Conversational Integration with Alexa and Conversational Integration with Google Assistant), is a voice-based interface and also supports interactions with touch and speak commands.

Conversational Integration with Google Assistant

ServiceNow® Conversational Integration with Google Assistant enables ServiceNow® Virtual Agent to interact with requesters through the Google voice interface using the Virtual Agent topics. Conversational Integration with Google Assistant uses the custom conversational chat integration framework to interact with the Virtual Agent chatbot.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Overview

Enable your users to initiate a Google Assistant voice chat conversation with a virtual agent by using the Conversational Integration with Google Assistant application. The application connects a requester with a Virtual Agent using your company's Google Assistant account. You can name your Google assistant and manage it using your company's Google account while enabling end users to link their accounts to the ServiceNow instance. You can also customize the way that a virtual agent speaks to you in a voice-friendly manner without having to change the topic.

Note: The Conversational Integration with Google Assistant application supports both screen-less and screen-based Google Assistant-enabled devices.

To get started with the Conversational Integration with Google Assistant application, see Configure Conversational Integration with Google Assistant.
Configure Conversational Integration with Google Assistant

Install and set up the Conversational Integration with Google Assistant application to enable users to interact with a virtual agent.

Configure Conversational Integration with Google Assistant to enable interaction with a virtual agent through the Alexa voice interface.

1. To install Conversational Integration with Google Assistant, see Install Conversational Integration with Google Assistant.

2. To set up Conversational Integration with Google Assistant, see Set up Conversational Integration with Google Assistant.

3. To modify the Virtual Agent settings for the best voice chat experience with Google Assistant, see Fine-tune Virtual Agent settings and topics for best voice chat conversation.

Install Conversational Integration with Google Assistant

You can install the Conversational Integration with Google Assistant application (sn_va_g_assist) if you have the admin role. The application installs the related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- Role required: external_app_install_admin, va_admin, or admin

About this task

The following applications are installed with Conversational Integration with Google Assistant:

Conversational Custom Chat Integration (com.glide.cs.custom.adapter)

Provides the custom chat integration framework of scriptable APIs to enable the Virtual Agent application on any conversational interface.

For more information, see Conversational custom chat integrations.

ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Enables the execution of ServiceNow® IntegrationHub actions and flows.
Procedure

1. Navigate to **System Applications > All Available Applications > All**

2. Find the Conversational Integration with Google Assistant application (**sn.va.g.assist**) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   All the dependent plugins and applications are listed if they will be installed, or currently installed, or must be installed. If any plugins or applications must be installed, you must install them before you can install Conversational Integration with Google Assistant.

4. Click **Install**.

**Set up Conversational Integration with Google Assistant**

Set up the Conversational Integration with Google Assistant application so that you can engage customers in voice chat conversations with bots.

**Before you begin**

- Get ServiceNow entitlements for the following products and applications:
  - IntegrationHub
  - Conversational Integration with Google Assistant

  For more information, see Get entitlement for a ServiceNow product or application.

- Install the following applications on your ServiceNow instance:
  - IntegrationHub
  - Conversational Integration with Google Assistant

- Complete the Google Assistant settings.

**Note:** If you do not have a Google account, click **Create account** and follow the prompts to create a new Google account.
2. Create a google actions project.
   For more information see, Create and set up a project.
3. Enable the Google Actions API to export the shared google action project from your local computer to your google project.
   For more information, see Enable the google actions API.
4. Download the google actions CLI tool and install it on your computer.
   For more information, see Install the gactions command-line tool.
5. Export the Google Actions zip file to your google account.
   For more information, see Export the Google Actions zip file.
6. Link your Google Assistant account with your ServiceNow instance to enable quick connection to your services.
   For more information, see Account linking with Google Assistant.

Role required: external_app_install_admin, va_admin, or admin

Procedure
1. Associate a provider channel identity record with your Google Assistant account.
   For more information, see Create a provider channel identity record for Google Assistant.
2. Configure an OIDC provider to verify ID tokens for your Google Assistant account.
   For more information, see Set up message authentication for Google Assistant.
3. Create an OIDC token verification record to verify your Google Assistant account.
   For more information, see Create an OIDC token verification record for Google Assistant.
4. Associate inbound message records with a message auth record.
   For more information, see Create a message auth record for Google Assistant.

Create a Google Actions project
Create a Google Actions project using the Google Console. Creating a Google Actions project helps you prepare to use the Google Assistant.

Before you begin
Note: Create a Google account and get it added to the Google Cloud.
Procedure

1. Log in to the Google Console with your Google account and click **New Project**.
2. Provide the **Project Name** and click **Create project**.
3. Choose **Custom** action and click **Next**.
4. Select **Blank project** and click **Start building**. The Google Actions Console Overview screen is displayed.
5. Click the more options icon (⋮ ) and select **Project settings**.

**Note:** Make a note of the Project ID for your project. For example, `projectdoc-2ddc8`.

A Google Actions project gets created.

**Enable the Google Actions API**

Enable the Google Actions API to export the shared Google Action project from your local computer to your Google Assistant account with the help of the Google Actions CLI tool.

**Before you begin**

Role required: none

Procedure

1. Log in to the Google Cloud Platform and click the Select a project list.
2. In the Select a project screen, select your project and click **Open**.
3. Navigate to **APIs and Services > Library**.
4. In the API Library, search for **Actions API** and select it.
5. On the Actions API page, click **Enable**. The Google Actions API is enabled.

**Export the Google Actions zip file**

Export the Google Actions zip file that you downloaded from the Supporting Documents section of the Conversational Integration with Google Assistant application on the ServiceNow Store to your Google Assistant account.
Before you begin
Role required: none

Procedure
1. Download and unzip the Now-Google-Action.zip file into the gactions folder.
2. Open a command (Windows) or terminal (Mac) and navigate to the gactions folder path.
4. Edit the following fields.
   • authorizationUrl: Edit the hostname in the URL to point to your ServiceNow instance.
   • tokenURL: Edit the hostname in the URL to point to your ServiceNow instance.
   • projectId: Set the project ID to your Google Actions project ID.
     For more information, see Create a Google Actions project.
5. In the ./webhooks/ActionsOnGoogleFulfillment.yaml file, edit the webhook URL with your ServiceNow instance and save the changes.
6. Push the Now-Google_action project to your account using the $gactions push.
7. Log in to the Google Cloud Platform and select your Google Actions project to verify the Now-Google-Action project that is pushed to your Google Assistant account.
8. Deploy your Google Actions project for testing, using the $gactions deploy preview and copy the URL.
   Note: If you test your Google Actions project using the Google Console, the project is automatically deployed.
9. Open the copied URL in your web browser.
   This URL takes you to the test window on the Google Console.
10. In the test window, use either the text field, click the agent name button, or speak your agent name to test your Google Action.
   Note: Be sure to complete the setup on your ServiceNow instance before testing the Google Action.

Create a provider channel identity record for Google Assistant
Create a provide channel identity record to connect to your Google Assistant account.
Before you begin
Role required: va_admin or admin

Procedure
1. In the navigation filter of your ServiceNow instance, enter 
   \texttt{sys_cs_provider_application.list}.
2. Click \textbf{New}.
3. On the form, fill in the fields.

\begin{table}
\begin{tabular}{|l|l|}
\hline
\textbf{Field} & \textbf{Description} \\
\hline
Name & Name of your provider. For example, Google Assistant. \\
Provider & Provider channel that you created. Select VA Google Assistant Provider as the provider channel. \footnote{Note: The provider is available with the installation of the Conversational Integration with Google Assistant plugin (sn_va_g_assist).} \\
Default portal & Default portal to be used in the mapping. \\
Short description & Short description for your channel identifier. For security reasons, the Virtual Agent checks that the URLs for attachments in conversations are from trusted domains specified here. If the URL is not from a trusted domain, the Virtual Agent does not upload the attachment. If an attachment upload fails because Virtual Agent did not trust the domain, Virtual Agent does not inform the end user about the attachment upload failure. \\
\hline
\end{tabular}
\end{table}
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trusted media domains</td>
<td>Comma-separated list of one or more trusted domains for the provider.</td>
</tr>
<tr>
<td>Message auth</td>
<td>Map that the message authentication record created.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Google Assistant Message Auth</strong> as the message authentication type.</td>
</tr>
<tr>
<td>Inbound ID</td>
<td>Provide the <strong>Project Id</strong> for Google from the Google Chrome setup as the Inbound ID. For example: <strong>project-name-XXXX</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Set up message authentication for Google Assistant**

Register the application with the OIDC provider in your ServiceNow instance to set up message authentication with your Google Assistant account.

**Before you begin**

Role required: admin

**Procedure**

1. In your ServiceNow instance, navigate to **System OAuth > Application Registry**.

2. Click **New** and select **Configure an OIDC provider to verify ID tokens**.

3. On the form, fill in the fields.

**OAuth OIDC Entity**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Identifier of the record.</td>
</tr>
<tr>
<td></td>
<td>Example: Google OIDC Provider.</td>
</tr>
<tr>
<td>Client ID</td>
<td>The client ID that you got from the Google project.</td>
</tr>
<tr>
<td></td>
<td>To fetch the Client ID, see <a href="#">Get the Client ID and Client Secret</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client Secret</td>
<td>The client secret that you got from the Google project. To fetch the Client secret, see Get the Client ID and Client Secret.</td>
</tr>
<tr>
<td>OAuth OIDC Provider Configuration</td>
<td>Name of the OAuth OIDC provider configuration record. Select Google as the OIDC Provider Configuration record.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Get the Client ID and Client Secret**

Get the Client ID and Client Secret from your Google Actions project to provide it in the OAuth OIDC Entity form in your ServiceNow instance.

**Before you begin**

Role required: none

**Procedure**

1. Log in to the Google Cloud Platform and click the Select a project list.
2. In the Select a project screen, select your project and click **Open**.
3. Navigate to **APIs and Services > Credentials**.
4. Under the OAuth 2.0 Client IDs section of the Credentials form, click the edit icon (✏️) to edit the OAuth Client.
5. On the Client ID for Web application form, copy the Client ID and Client secret to provide it in the **OAuth OIDC Entity** form.

**Update the Google Assistant OIDC provider configuration record**

Update the Google Assistant’s OIDC Provider configuration record with the OIDC metadata URL.

**Before you begin**

Role required: none
Procedure

1. In the navigation filter of your ServiceNow instance, enter `oidc_provider_configuration.list` and open the Google record.

2. Update the OIDC Metadata URL in the OIDC Provider Configuration form with the Google OpenID configuration URL.

3. In the JWT Claim Validations related list, click New.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claim Name</td>
<td>Identifier of the JWT claim.</td>
</tr>
<tr>
<td>Claim Value</td>
<td>Provide your Google project ID as the claim value.</td>
</tr>
<tr>
<td>Lookup Field Path</td>
<td>Provide <code>aud</code> as the value.</td>
</tr>
</tbody>
</table>

5. Click Update.

Create an OIDC token verification record for Google Assistant

Create an OIDC token verification record for Google Assistant for the Message Auth inbound message verification.

Before you begin

Role required: admin

Procedure

1. In the navigation filter of your ServiceNow instance, enter `oidc_token_verification.list` and click New.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OAuth OIDC Entity</td>
<td>An OAuth OIDC entity used for creating the token verification. Click the search icon (🔍) to select the provider entity that you created previously.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For more information, see Set up message authentication for Google Assistant.</td>
<td></td>
</tr>
</tbody>
</table>

Name
A unique name that identifies the OAuth OIDC entity.

⚠️ **Note:** If the **Name** field does not appear in your OIDC token verification form, configure the form layout to add the **Name** field to the form.

For more information about configuring the form layout, see Configuring the form layout.

3. Click **Submit**.

**Create a message auth record for Google Assistant**

Create a message auth record to map the Inbound and Outbound token verification records.

**Before you begin**
Role required: admin

**Procedure**

1. In the navigation filter of your ServiceNow instance, enter `message_auth.list` and click **New**.
2. On the form, fill in the fields.

**Message Auth from**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the message authentication record.</td>
</tr>
<tr>
<td>Provider</td>
<td>Provider of the authentication. Provide a name of your choice. For example: VA Google Assistant Provider.</td>
</tr>
<tr>
<td>Inbound message verification</td>
<td>Name of the Message Verification record that you created for the inbound message verification.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Provide the OIDC token verification that you created. For more information, see Create an OIDC token verification record for Google Assistant.</td>
</tr>
</tbody>
</table>

**Outbound Message Creation**

Name specified on the Token Verification form (this token interacts with the provider on behalf of the user).

<i>Note:</i> Choose the same option provided for Inbound message verification.

3. Click **Submit**.

**Account linking with Google Assistant**

Link your Google Assistant account with your ServiceNow instance to retrieve information from your Google action.

You can configure account linking for your Google Assistant account using the authorization code account linking method.

<i>Note:</i> Account linking with the authorization code is the default method used to link your Google Assistant account with your ServiceNow instance.

1. Configure your ServiceNow instance to link it with your Google Assistant account. For more information, see Create an OAuth API endpoint for external clients.

<i>Note:</i>

- Provide the Redirect URL in the following format: https://oauth-redirect.googleusercontent.com/r/<<YourGoogleProjectId>>.
- The client ID is auto-generated as the OAuth Client application form opens. Provide this auto-generated client ID in the Google Actions project.

2. Update your Google Actions project with the Now-Google-Action.zip file downloaded from the Conversational Integration with Google Assistant application on the ServiceNow Store.
3. Map the client ID. For more information, see Map the Client ID with the authorization code.

4. Verify account linking. For more information, see Verify Google Assistant account linking.

Map the Client ID with the authorization code
Map the Client ID copied from the Google Actions project to link a Google Assistant account with your ServiceNow instance using the authorization code account linking.

Before you begin
Role required: admin

Procedure
1. Log in to the Google Console.
2. Select your Google Actions project and navigate to Develop > Account Linking.
3. On the Account Linking form, swipe the Account linking toggle switch to the right to enable account linking.
4. Select the Linking type as OAuth & Google Sign In with Authorization Code.
5. Provide the Client ID and Client Secret fetched from the Create an OAuth API endpoint for external clients form.
6. Provide https://CHANGEME.service-now.com/oauth_auth.do as the Authorization URL.
   
   Note: Replace CHANGEME with the host-name of your ServiceNow instance.
7. Provide https://CHANGEME.service-now.com/oauth_token.do as the Token URL.
   
   Note: Replace CHANGEME with the host-name of your ServiceNow instance.
8. Click Save.

Verify Google Assistant account linking
Verify your Google Assistant account linking to complete the Conversational Integration with Google Assistant.

Before you begin
Role required: admin
Procedure

1. Log in to the Google Console and navigate to the Test tab.
2. To link the account, select Phone from the list.
   
   ! Note: You can link your account from the Google Assistant application of your mobile device or tablet, select Smart Display from the list, and continue to use it.

3. Invoke the Google Assistant by clicking Talk to <invocation name> or by saying the invocation name.
   
   ! Note: After invocation, a confirmation message appears, prompting you to link the Google account. Click Link.

4. Provide your ServiceNow instance credentials that you are attempting to link the account with and log in.

5. In the user consent screen, click Allow.
   
   ! Note: Once linked, the available topics are listed. If you do not have any topics, create one to see it in the user consent screen.

6. To verify the account linking status, click Settings.
   
   ! Note: The account remains linked as long as the token is valid. Click Unlink to unlink the user and link another user if required.

Fine-tune Virtual Agent settings and topics for best voice chat conversation

Fine-tune your Virtual Agent settings and topics provided by the Virtual Agent Designer for the best voice chat experience with Google Assistant.

- Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints for conversation between a Virtual Agent and a user. For more information, see Using Virtual Agent Designer.

   ! Note: Be sure that you specify Google Assistant as the applicable channel in the Additional channel support field if you want the topics that you designed using the Virtual Agent Designer to work on the Google Console. For more information about the channel selection, see Channel support for Virtual Agent topics.

- Bot messages help you to interact with Google Assistant. You can change the bot messages for interaction in a voice chat conversation. To access the bot messages, enter sys_cs_provider_application.list in the left navigation filter and navigate to your Google Assistant application profile to find the bot messages.
You can change the greeting message and other messages only for the voice channels using the Custom Greeting and Setup page. For example, you can create a custom topic, edit it, and assign it to be used if the end user is on a voice channel. For more information about accessing the Custom Chat and to change the greeting section of the message, refer to Configure a Virtual Agent chat experience.

You can also change the system-generated messages by entering `sys_properties.list` in the left navigator, and filter them by the criteria `com.glide.cs` to ensure that these messages work for voice channels. You can review the following key messages:

- `com.glide.cs.topic_picker_msg`
- `com.glide.cs.no_topic_found_message`
- `com.glide.cs.no_topic_sorry_message`
- `com.glide.cs.link_account_msg`
- `com.glide.cs.topic_choice_list_message`
- `com.glide.cs.topic_confirmation_message`

Note: Most of the messages unique to the voice channels are listed under the Bot Messages section of the Provider Channel Identity record.

For more information, see Change the Virtual Agent greeting messages in the Greeting setup topic.
• Most components work for screen-based and screen-less devices accessed in Google Assistant. However, some components are not compatible especially for the screen-less devices.

Note: On the screen-based Google Assistant-enabled devices, the presentation of cards and images has limitation as per the Google Actions project specification.

The Conversational Integration with Google Assistant application supports the following user input controls in Virtual Agent Designer.

Note: Conversational Integration with Google Assistant also supports touch-inputs for screen-based devices.
### User input controls

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
<th>Screen</th>
<th>No screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text input/output</td>
<td>Text format that is validated when a user enters certain text items.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Static Choice</td>
<td>User selects an item from a predefined choice list.</td>
<td>Yes, touch scroll</td>
<td>Yes, voice pagination</td>
</tr>
<tr>
<td>Reference Choice</td>
<td>User selects a choice from the list of dynamically created choices.</td>
<td>Yes, no clicking links</td>
<td>Yes, voice pagination</td>
</tr>
<tr>
<td>Boolean</td>
<td>User enters a Boolean response to the bot. For example, the user can reply Yes or No in a chat conversation.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Date Time</td>
<td>User selects a calendar date, time (hours and minutes), or both.</td>
<td>Yes (By default, Google NLU is used to determine the Date and Time)</td>
<td>Yes (By default, Google NLU is used to determine the Date and Time)</td>
</tr>
<tr>
<td>File Picker</td>
<td>User sends a file to the bot.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Pause</td>
<td>Breaks the conversation with Google Assistant.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Carousel</td>
<td>User selects a single item from the carousel.</td>
<td>Yes, touch scroll</td>
<td>Yes, reading labels</td>
</tr>
<tr>
<td>Image/Link/HTML output</td>
<td>Bot sends an image, a link, or error_msg.</td>
<td>Yes, no clicking links</td>
<td>error_msg</td>
</tr>
<tr>
<td>User input control</td>
<td>Description</td>
<td>Screen</td>
<td>No screen</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
<td>--------</td>
<td>-----------</td>
</tr>
<tr>
<td>an HTML to the user.</td>
<td>video_screen_device_msg</td>
<td>video_audio_device_msg</td>
<td></td>
</tr>
<tr>
<td>Video</td>
<td>User can choose a video card from the header card.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Card</td>
<td>Type of header card. Choose the contents: ◦ Large image with text ◦ Small image with text ◦ YouTube Video Card The fields in the dialog box change based on your choice.</td>
<td>Yes, no clicking</td>
<td>Yes, reading labels</td>
</tr>
<tr>
<td>Table</td>
<td>If you selected Record as the <strong>Reference Type</strong>, select the table to be searched.</td>
<td>Yes Shows the table headers, followed by rows with column header: value pair. Speak (Table header). Please say Done to continue.</td>
<td>No, reading labels Unfortunately, I cannot show you the content on this device. Please say Done to continue.</td>
</tr>
</tbody>
</table>
Note: To edit or change any of the following bot messages, enter sys_cs_provider_application.list in the left navigator of your ServiceNow instance, select Google > Bot Messages and, click the name of the bot message that you want to edit.

- error_msg
- video_screen_device_msg
- video_audio_device_msg
- table_msg

If you find the message name <EMPTY> and want to add a boolean confirmation message to the end users, you can configure the bot message with the value [0] or [1].

Conversational Integration with Google Assistant supports contextual actions that serve an appropriate response from custom chat integrations when user input is mapped to them. For more information, see Contextual actions for Alexa.

Bot messages for Conversational Integration with Google Assistant

Use the bot messages in Conversational Integration with Google Assistant for a unique conversation experience.

<table>
<thead>
<tr>
<th>Google Assistant bot messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>all_topic_msg</td>
</tr>
<tr>
<td>boolean_msg</td>
</tr>
<tr>
<td>card_audio_device_msg</td>
</tr>
<tr>
<td>error_msg</td>
</tr>
<tr>
<td>first_batch_msg</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>-----------------------------</td>
</tr>
<tr>
<td>help_default_msg</td>
</tr>
<tr>
<td>help_updated_msg</td>
</tr>
<tr>
<td>html_msg</td>
</tr>
<tr>
<td>img_audio_msg</td>
</tr>
<tr>
<td>img_screen_msg</td>
</tr>
<tr>
<td>multi_flow_msg</td>
</tr>
<tr>
<td>next_option_msg</td>
</tr>
<tr>
<td>number_indicator_msg</td>
</tr>
<tr>
<td>option_msg</td>
</tr>
<tr>
<td>record_card_audio_device_msg</td>
</tr>
<tr>
<td>record_card_screen_device msg</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>-----------------------------</td>
</tr>
<tr>
<td>repeat_option_msg</td>
</tr>
<tr>
<td>see_screen_msg</td>
</tr>
<tr>
<td>skip_msg</td>
</tr>
<tr>
<td>table_msg</td>
</tr>
<tr>
<td>table_screen_msg</td>
</tr>
<tr>
<td>table_screen_no_title_msg</td>
</tr>
<tr>
<td>video_audio_device_msg</td>
</tr>
<tr>
<td>video_screen_device_msg</td>
</tr>
<tr>
<td>voice_all_topic_msg</td>
</tr>
<tr>
<td>voice_topic_picker_msg</td>
</tr>
</tbody>
</table>
Contextual Actions for Conversational Integration with Google Assistant

Use the contextual actions supported by Conversational Integration with Google Assistant to receive an appropriate response during custom chat integrations with Google Assistant.

**Hi**

You can type or speak the `hi` command to initiate a conversation, in the middle of a conversation, or even inside a specific topic.

When you type or say `hi`, in the middle of the topic, you are shown an option to either **End conversation** the conversation or to **Cancel**. If you end the conversation, the Google Assistant project gets reset and you can restart the skill by speaking your invocation name. If you cancel the conversation, you are redirected to the last topic you were at.

**Bye**

The `Bye` command is used to end a conversation.

You can type `bye` or speak this command in the middle of a conversation to end the conversation.

**Help**

The `help` command is used to request help using the bot.

You can type `help` or speak this command to ask your skill any questions. If you want to restart the conversation, say `hi` or restart the conversation.

**Closing idle Google Assistant chat conversations**

Enable virtual agents to effectively manage their active Google Assistant chat conversations by automatically closing the conversations after they have been inactive for a pre-configured amount of time.

The Virtual Agent conversations are configured for the Google Assistant application. By default, any conversation is closed once the session with Google Assistant closes. Any conversation that is abandoned by requesters remains open or idle until they are automatically closed daily by the **Time Out Abandoned VA Conversations** scheduled job. For more information, see **Closing Virtual Agent and Live Agent conversations**.

**Conversational Integration with Alexa**

ServiceNow® Conversational Integration with Alexa enables ServiceNow® Virtual Agent to interact with requesters through the Amazon Alexa voice interface using the Virtual Agent topics. Conversational Integration with Alexa uses the
custom conversational chat integration framework to interact with the Virtual Agent chatbot.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Overview
Enable your users to initiate an Alexa voice chat conversation with a virtual agent by using the Conversational Integration with Alexa application. The application connects a requester with a Virtual Agent using your company’s Alexa account. You can name your Alexa skill and manage it using your company’s Amazon account while enabling end users to link their accounts to the ServiceNow instance. You can also customize the way that a virtual agent speaks to you in a voice-friendly manner without having to change the topic.

Note: The Conversational Integration with Alexa supports both screen-less and screen-based Alexa-enabled devices.

To get started with the Conversational Integration with Alexa application, see Configure Conversational Integration with Alexa.

Configure Conversational Integration with Alexa
Install and set up the Conversational Integration with Alexa application to enable users to interact with a virtual agent.

Configure Conversational Integration with Alexa to enable interaction with Virtual Agent through the Alexa voice interface.

1. To install Conversational Integration with Alexa, see Configure Conversational Integration with Alexa.
2. To set up Conversational Integration with Alexa, see Set up Conversational Integration with Alexa.
3. To modify the Virtual Agent settings for the best voice chat experience with Alexa, see Fine-tune Virtual Agent settings and topics for the best voice chat experience.

Install Conversational Integration with Alexa
You can install the Conversational Integration with Alexa application (sn.va.alexa) if you have the admin role. The application installs the related ServiceNow® Store applications and plugins if they are not already installed.
Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- Role required: external_app_install_admin, va_admin, or admin

About this task
The following applications are installed with Conversational Integration with Alexa:

**Conversational Custom Chat Integration (com.glide.cs.custom.adapter)**

Provides the custom chat integration framework of scriptable APIs to enable the Virtual Agent application on any conversational interface.

For more information, see Conversational custom chat integrations.

**ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)**

Enables the execution of ServiceNow IntegrationHub actions and flows.

Procedure

1. Navigate to **Application > Module**.

2. Find the Conversational Integration with Alexa application (sn_va_alexa) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   All the dependent plugins and applications are listed if they will be installed, or currently installed, or must be installed. If any plugins or applications must be installed, you must install them before you can install Conversational Integration with Alexa.

4. Click **Install**.
Set up Conversational Integration with Alexa

Set up the Conversational Integration with Alexa application so that you can engage customers in conversations with bots.

Before you begin

- Get ServiceNow entitlements for the following products and applications:
  - IntegrationHub
  - Conversational Integration with Alexa
  For more information, see Get entitlement for a ServiceNow product or application.
- Install the following applications on your ServiceNow instance:
  - IntegrationHub
  - Conversational Integration with Alexa
- Complete the Alexa settings.
  1. Create your Amazon Developer account.
     For more information, see the Alexa documentation.
  2. Create an Alexa skill.
     For more information, see the Alexa documentation.
  3. Build an Alexa skill model.
     For more information, see the Alexa documentation.
  4. Configure an Alexa skill.
     For more information, see Configure an Alexa skill.
  5. Test an Alexa skill on the developer console.
     For more information, see the Alexa documentation.
  6. Account linking with Alexa.
     For more information, see the Alexa documentation.

Role required: external_app_install_admin, va_admin, or admin

Procedure

1. Associate a provider channel identity record with your Alexa account.
   For more information, see Create a provider channel identity record for Alexa.
2. Associate inbound message records with a message auth record. For more information, see Set up message authentication for Alexa.

Create an Alexa skill

Create an Alexa-hosted skill using the Alexa developer console. Creating an Alexa skill helps you prepare to use the Alexa app.

Before you begin
Role required: admin

Procedure
1. Log in to the Alexa developer console with your Amazon developer account.
2. Click Create Skill.
3. In the Skill name field, enter a skill name.
4. From the Default language list, select a default language to add your skill.
5. Under Choose a model to add your skill, select Custom.
6. Under Choose a method to host your skill’s backend resources, select Alexa-Hosted (Node.js).
7. Click Create skill.
8. To add your skill, select the Start from Scratch template.
9. Click Continue with Template.

⚠️ Note: Creating an Alexa-hosted skill takes a few minutes.

10. In the skill, navigate to Interaction Model > Intents > JSON Editor.
11. Replace the JSON Editor with the following JSON script.

```json
{
   "interactionModel": {
      "languageModel": {
         "invocationName": "now agent",
         "intents": [
            {
               "name": "AMAZON.CancelIntent",
               "samples": []
            },
            {
               "name": "AMAZON.HelpIntent",
               "samples": []
            }
         ]
      }
   }
}
```
12. Click Save Model.

13. Navigate to Invocations > Skill Invocation Name.
14. In the **Skill Invocation Name** field, provide the skill Invocation name.

   - **Note:** The skill name is the name which you use in your Alexa device to invoke the skill.
     
   For example: `<ask <skill name>.

15. Navigate to **Interfaces** and enable **Alexa Presentation Language**.

   - **Note:** This option enables all the screen devices which you want to use in Alexa.

16. Click **Save Interfaces**.

**Configure an Alexa skill**

Configure your Alexa skill to talk to your ServiceNow instance.

**Before you begin**

   - **Note:** Linking your Alexa account with your ServiceNow instance is optional and only the Virtual Agent topics with the public role are accessible with guest user access.

Role required: admin

**Procedure**

1. Log in to the Alexa developer console with your Amazon developer account.

2. Click the **Code** tab.

3. Click **Import Code**.

   - **Note:** Browse for the `lambda_funtion_sn_va_alexa.zip` file that you downloaded from the Supporting Documents section of the Conversational Integration with Alexa application on the ServiceNow Store and click **Import**.

4. In the **endpoint** field, replace the hostname with the host name from your ServiceNow instance URL where your Alexa store app is installed.


5. In the **secretkey** field, replace `<Provide secret key>` with the following types of tokens.

   - Hash-based authentication
     
     If you are using hash-based authentication, provide the hash token which you provided during the ServiceNow instance setup.
Build an Alexa skill model

Build your Alexa-hosted skill on the Alexa developer console. Building a saved Alexa skill model helps you prepare the skill for testing.

Before you begin
Role required: admin

Procedure
1. Log in to the Alexa developer console with your Amazon developer account.
2. Select the skill that you want to build.
   
   Note: Selecting a skill navigates you to the Alexa Developer Console.
3. Click the Build tab.
4. In the Skill builder checklist, click Build Model.
   
   Note: Building the model takes a few minutes.
   
   The build successful message appears and you can test the sample utterances while the build is being trained.

Get the Alexa skill ID

Get the Alexa skill ID from your Alexa developer console after the skill configuration.

Before you begin
Role required: admin

Procedure
1. Log in to the Alexa developer console with your Amazon developer account.
   You can get the skill ID in two ways.

6. Click Deploy.
a. On the Alexa developer console:
   i. Click the **Your Skills** tab.
   ii. Navigate to the skill name for which you want to copy the skill ID.
   iii. Under the skill name, click **Copy Skill ID**.

b. On the left Custom navigator pane of the Alexa developer console:
   i. Select a skill from the **Your Skills** tab.
   ii. Navigate to **Assets > Endpoint** on the Custom navigator pane.
   iii. In the AWS Lambda ARN section, click **Copy to Clipboard**.

2. In the Provider Channel Identity record of your ServiceNow instance, paste the copied skill ID in the **Inbound ID** field.

3. Click **Update**.

**Test an Alexa skill on the developer console**

Test your Alexa skill using the Alexa simulator and developer account once the installation is complete and the skill is built.

**Before you begin**

Role required: admin

> Note: The Conversational Integration with Alexa application works for guest users. All published Virtual Agent topics (set up topics or topic blocks) are presented even if account linking is not done. For any regular topic, you must specify the Alexa channel in the **Additional channel support** field of the Topic Properties page. For more information about adding channel support to a Virtual Agent topic, see Channel support for Virtual Agent topics.

Role required: admin

**Procedure**

1. Log in to the Alexa developer console with your Amazon developer account.
2. Click the **Test** tab.
3. In the Alexa Simulator, type or speak the invocation name of your skill.
   
   For example, **ask now virtual agent**.
   
   Alexa responds to the Virtual Agent and returns a greeting message.
Test a skill on the Alexa mobile app
Test your Alexa skill using the Alexa mobile app.

**Before you begin**
Role required: none

**Procedure**
1. Log in to the Alexa mobile application using your email address that you used for logging in to the developer console.
2. Speak the invocation name of your skill.
   For example, `alexa now virtual agent`.
   Alexa responds to the Virtual Agent and returns a greeting message.

Test a skill on the Alexa Echo or Echo Show screen device
Test your Alexa skill using the Alexa Echo or Echo Show screen device.

**Before you begin**
Role required: none

**Procedure**
1. Log in to the Alexa Echo or Echo Show using your email address that you used for logging in to the developer console.
2. Speak the invocation name of your skill or use the touch screen option to select the list option.
   For example, `alexa now virtual agent`.
   Alexa responds to the Virtual Agent and returns a greeting message.

**Supported Alexa intents**
Use the Alexa intents supported by Conversational Integration with Alexa to receive an appropriate response during custom chat integrations with Alexa.

**Supported custom intents**

<table>
<thead>
<tr>
<th>Intent</th>
<th>Utterance</th>
<th>Language understanding</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMAZON.YesIntent</td>
<td>yes, yeah</td>
<td>Sends the message “yes”</td>
</tr>
<tr>
<td>AMAZON.NoIntent</td>
<td>no, nope</td>
<td>Sends the message “no”</td>
</tr>
</tbody>
</table>
Custom intents (continued)

<table>
<thead>
<tr>
<th>Intent</th>
<th>Utterance</th>
<th>Language understanding</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMAZON.HelpIntent</td>
<td>help, help me, and can you help me</td>
<td>Help message is displayed</td>
</tr>
<tr>
<td>AMAZON.PauseIntent</td>
<td>pause</td>
<td>End conversation; End Alexa Session</td>
</tr>
<tr>
<td>AMAZON.StopIntent</td>
<td>stop, off, and shut up</td>
<td>End conversation; End Alexa Session</td>
</tr>
<tr>
<td>AMAZON.CancelIntent</td>
<td>cancel, never mind, and forget it</td>
<td>End conversation; End Alexa Session</td>
</tr>
</tbody>
</table>

Create a provider channel identity record for Alexa

Create a provider channel identity record to connect to your Alexa account.

Before you begin
Role required: va_admin or admin

Procedure
1. In the navigation filter of your ServiceNow instance, enter  
   `sys_cs_provider_application.list`.  
2. Click *New*.  
3. On the form, fill in the fields.

Provider Channel Identity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your provider.</td>
</tr>
</tbody>
</table>
| Provider     | Provider channel that you created.  
Select **VA Alexa Adapter Provider** as the provider channel.  
ℹ️ **Note:** The provider is available with the installation of the Conversational Integration with Alexa plugin (sn_va_alexa). |
<p>| Default portal | Default portal used in the mapping.  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description for your channel identifier.</td>
</tr>
<tr>
<td></td>
<td>For security reasons, the Virtual Agent checks that the URLs for attachments in conversations are from trusted domains specified here. If the URL is not from a trusted domain, the Virtual Agent does not upload the attachment. If an attachment upload fails because Virtual Agent did not trust the domain, Virtual Agent does not inform the end user about the attachment upload failure.</td>
</tr>
<tr>
<td>Trusted media domains</td>
<td>Comma-separated list of one or more trusted domains for the provider.</td>
</tr>
<tr>
<td>Message auth</td>
<td>Message authentication for the channel identifier. Choose a message authentication type from the following options:</td>
</tr>
<tr>
<td></td>
<td>• ServiceNow Virtual Agent Alexa App - Static</td>
</tr>
<tr>
<td></td>
<td>• ServiceNow Virtual Agent Alexa App - Hash</td>
</tr>
<tr>
<td>Inbound ID</td>
<td>Identifier for your bot.</td>
</tr>
<tr>
<td></td>
<td>In this field, provide your Alexa Skill ID that you copied from the Amazon developer console.</td>
</tr>
<tr>
<td></td>
<td>For example: <code>amzn1.ask.skill.XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXX</code>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Set up message authentication for Alexa**

Define a token in your ServiceNow instance to set up a message authentication with your Alexa account.
Before you begin
Role required: admin

Procedure
1. In the navigation filter of your ServiceNow instance, enter `message_auth.list` and click **New**.

2. Select a message authentication type for Alexa and open the record.
   
   Your ServiceNow instance provides you with the following authentication types by default:
   
   • ServiceNow Virtual Agent Alexa App - Static
   • ServiceNow Virtual Agent Alexa App - Hash

3. On the form, fill in the fields.

   **Message Auth form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name                         | Name of the record in the Message Auth [message auth] table.  
For example, **ServiceNow Virtual Agent Alexa App - Hash** or **ServiceNow Virtual Agent Alexa App - Static** |
| Provider                     | Provider of the auth token. Enter Alexa. |
| Inbound message verification | Name of the Hash or Static Message Verification record that you created for the inbound hash or static messages. 
Select an inbound message verification option as per the selected authentication type. 
Your ServiceNow instance provides you with the following authentication tokens by default: |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• ServiceNow Virtual Agent Alexa App Static Token</td>
</tr>
<tr>
<td></td>
<td>• ServiceNow Virtual Agent Alexa App Hash Token</td>
</tr>
<tr>
<td>Outbound message creation</td>
<td>Name specified on the Token Verification form (this token interacts with the provider on behalf of the user). Select an outbound message option as per the selected authentication type. Your ServiceNow instance provides you with the following authentication tokens by default:</td>
</tr>
<tr>
<td></td>
<td>• ServiceNow Virtual Agent Alexa App Static Token</td>
</tr>
<tr>
<td></td>
<td>• ServiceNow Virtual Agent Alexa App Hash Token</td>
</tr>
<tr>
<td>Note:</td>
<td>Outbound message verification is not required for Alexa. However, select the same option provided for Inbound message verification because it is a required field.</td>
</tr>
<tr>
<td>Outbound service token</td>
<td>Authorized outbound service token. Navigate to the Inbound message verification record to procure the Outbound service token from the Alexa setup and provide it in the Outbound service token field.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Account linking with Alexa**

Link your Alexa account with your ServiceNow instance to retrieve information from your custom skill.
Link your Alexa account with your ServiceNow® instance

1. Configure your ServiceNow instance to link it with your Alexa account.
   For more information, see Create an OAuth API endpoint for external clients.

2. To configure your Alexa account for account linking, see Configure your Alexa account.

3. To link the Alexa events with your ServiceNow instance using your Mac Terminal, see Link Alexa events using the Mac Terminal.

4. To link your ServiceNow instance with your Alexa account using the Alexa app, see Link your account using the Alexa app.

Configure your Alexa account

Configure your Alexa account to link it with your ServiceNow instance.

Before you begin
Role required: admin

Procedure

1. Log in to your Alexa developer console with your Alexa developer account.

2. Navigate to the Build > MODELS > ACCOUNT LINKING.

3. On the Account Linking form, swipe the Do you allow users to create an account or link to an existing account with you? toggle switch to the right.

4. In the Settings section of the form, swipe the Allow users to authenticate using your mobile application toggle switch to the right.

5. In the Security Provider Information section of the form, click Auth Code Grant.

6. On the form, fill in the fields.

Auth Code Grant form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your Web Authorization URI</td>
<td>The URI that authorizes your web access. For example: https://&lt;instance-name&gt;.service-now.com/oauth_auth.do.</td>
</tr>
<tr>
<td></td>
<td>Note: The instance-name for Alexa is voice.</td>
</tr>
<tr>
<td>Your iOS App Authorization URI</td>
<td>The URI that authorizes your iOS app. Provide voice as the value.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Your Android App Authorization URI</td>
<td>The URI that authorizes your Android app. Provide voice as the value.</td>
</tr>
<tr>
<td>Access Token URI</td>
<td>The URI that authorizes the access to the API requests. For example, https://&lt;instance-name&gt;.service-now.com/oauth_token.do</td>
</tr>
<tr>
<td></td>
<td>Note: The instance-name for Alexa is voice.</td>
</tr>
<tr>
<td>Your Client ID</td>
<td>Auto-generated unique ID of the client application requesting the access token.</td>
</tr>
<tr>
<td></td>
<td>Note: Provide the Client ID generated while creating an OAuth API endpoint for external clients.</td>
</tr>
<tr>
<td>Your Secret</td>
<td>The shared secret string that the instance and the OAuth application use to authorize communications with one another.</td>
</tr>
</tbody>
</table>

7. Click **Save**.

8. Copy one of the URLs from the **Alexa Redirect URLs** field in the Auth Code Grant section.

   Note: Insert the copied URL in the Redirect URL field of the OAuth API record created in your ServiceNow instance.

   If you face an issue with one of the URLs, try to use the next available URL and pick the one that works.

9. Click **Save**.

**Link Alexa events using the Mac Terminal**

Link Alexa events using your Mac Terminal to complete the Alexa account linking process with your ServiceNow instance.
Before you begin

⚠️ Note: Copy the Skill ID of your skill from the Alexa developer console. The Skill ID is the same inbound ID used in the sys_cs_provider_application record.

Role required: admin

Procedure

1. On your Mac, open the Terminal.

2. Execute the `npm install -g ask-cli` command. Executing this command installs the Alexa command-line interface on your machine if it was not previously installed.

3. Execute the `ask configure` command.

4. Log in with your Amazon developer account credentials when prompted.

   ⚠️ Note: Choose No if you are asked the question Do you want to link your AWS account in order to host your Alexa skills?

5. To download the manifest file, execute the `ask smapi get-skill-manifest -s {<provide skillId>} > skill.json` command.

6. To edit the `skill.json` file, add the following JSON script inside the manifest object.

```json
"events": {
  "endpoint": {
    "uri": "<provide lambda ID>",
  },
  "subscriptions": [
    { "eventName": "SKILL_ENABLED" }
  ,
    { "eventName": "SKILL_DISABLED" }
  ,
    { "eventName": "SKILL_PERMISSION_ACCEPTED" }
  ,
    { "eventName": "SKILL_PERMISSION_CHANGED" }
  ,
    { "eventName": "SKILL_ACCOUNT_LINKED" }
  ]
}
```
Note: Be sure to edit the URL endpoint with the Lambda ID. You can copy one of the endpoints from the skill.json file and replace it with the Lambda ID. You can also fetch it from the Alexa console from Build > Endpoints.

7. To upload the updated manifest file, execute the `ask smapi update-skill-manifest -s {<provide skillId>} --manifest "$(cat skill.json)` command.

**Results**

Your Alexa account is linked with your ServiceNow instance.

**Link your account using the Alexa app**

Link your ServiceNow account using your Alexa mobile application.

**Before you begin**

Role required: admin

**Procedure**

1. Download the Alexa app on your Android or iOS device.
2. Log in with the same email address that you used for the Amazon developer account.
3. In the lower-right area of the app, click More.
4. Select Skills & Games.
5. Select Your Skills tab.
6. Click Dev.
7. Select the skill that you created.
8. If the enable skill button does not appear, click Disable Skill.
9. Click Enable.
10. Log in with the ServiceNow instance credentials of any user of the instance. You should see that the account is linked.

Note: Insert the user record in the provider_user_map record to complete the account linking.

**Fine-tune Virtual Agent settings and topics for the best voice chat experience**

Fine-tune your Virtual Agent settings and topics provided by the Virtual Agent Designer for the best voice chat experience with Alexa.
• Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints for conversation between a Virtual Agent and a user. For more information, see Using Virtual Agent Designer.

**Note:** Be sure that you specify Alexa as the applicable channel in the Additional channel support field if you want the topics that you designed using the Virtual Agent Designer to work on Alexa. For more information about the channel selection, see Channel support for Virtual Agent topics.

• Bot messages help you to interact with Alexa. You can change the bot messages for interaction in a voice chat conversation. To access the bot messages, enter `sys_cs_provider_application.list` in the navigation filter and navigate to your Alexa application profile to find the bot messages.

![Bot messages for Alexa](image)

• You can change the greeting message and other messages only for the voice channels using the Custom Greeting and Setup page. For example, you can create a custom topic, edit it, and assign it to be used if the end user is on a voice channel. For more information about accessing the Custom Chat and to change the greeting section of the message, see Configure a Virtual Agent chat experience.

• You can also change the system-generated messages by entering `sys_properties.list` in the navigation filter, and filter them by the criteria `com.glide.cs` to confirm that these messages work for voice channels. You can review the following key messages:
◦ com.glide.cs.topic_picker_msg
◦ com.glide.cs.no_topic_found_message
◦ com.glide.cs.no_topic_sorry_message
◦ com.glide.cs.link_account_msg
◦ com.glide.cs.topic_choice_list_message
◦ com.glide.cs.topic_confirmation_message

Note: Most of the messages unique to the voice channels are listed in the Bot Messages section of the Provider Channel Identity record.

For more information, see Change the Virtual Agent greeting messages in the Greeting setup topic.

• Most components work for screen-based and screen-less devices accessed in Alexa. However, some components are not compatible especially for the screen-less devices.

Note: On the screen-based Alexa-enabled devices, the presentation of cards and images has limitations as per the Alexa skill kit specification.

The Conversational Integration with Alexa application supports the following user input controls in Virtual Agent Designer.

Note: Conversational Integration with Alexa also supports touch input for screen-based devices.
## User input controls

<table>
<thead>
<tr>
<th>User input control</th>
<th>Description</th>
<th>Screen</th>
<th>No screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text input/output</td>
<td>Text format that is validated when a user enters certain text items.</td>
<td>Yes</td>
<td>Yes.</td>
</tr>
<tr>
<td>Static Choice</td>
<td>User selects an item from a predefined list.</td>
<td>Yes, touch scroll.</td>
<td>Yes, voice pagination.</td>
</tr>
<tr>
<td>Reference Choice</td>
<td>User selects a choice from the list of dynamically created choices.</td>
<td>Yes, no clicking links.</td>
<td>Yes, voice pagination.</td>
</tr>
<tr>
<td>Boolean</td>
<td>User enters a Boolean response to the bot. For example, the user can reply <strong>Yes</strong> or <strong>No</strong> in a chat conversation.</td>
<td>Yes.</td>
<td>Yes.</td>
</tr>
<tr>
<td>Date Time</td>
<td>User selects a calendar date, time (hours and minutes), or both.</td>
<td>Yes (NLU recommended at the node).</td>
<td>Yes (NLU recommended at the node).</td>
</tr>
<tr>
<td>File Picker</td>
<td>User sends a file to the bot.</td>
<td>No.</td>
<td>No.</td>
</tr>
<tr>
<td>Pause</td>
<td>Breaks the conversation with Alexa.</td>
<td>No.</td>
<td>No.</td>
</tr>
<tr>
<td>Carousel</td>
<td>User selects a single item from the carousel.</td>
<td>Yes, touch scroll.</td>
<td>Yes, reading labels.</td>
</tr>
<tr>
<td>Image/Link/HTML output</td>
<td>Bot sends an image, a link, or an HTML to the user.</td>
<td>Yes, no clicking links.</td>
<td>error_msg</td>
</tr>
<tr>
<td>User input control</td>
<td>Description</td>
<td>Screen</td>
<td>No screen</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
<td>--------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td>User can choose a video card from the header card.</td>
<td>video_screen_device_msg</td>
<td>video_screen_device_msg</td>
</tr>
</tbody>
</table>
| **Card**           | Type of header card. Choose the contents:  
  ◦ Large image with text  
  ◦ Small image with text  
  ◦ YouTube Video Card  
  The fields in the dialog box change based on your choice. | Yes, no clicking. | Yes, reading labels. |
| **Table**          | If you selected Record as the Reference Type, select the table to be searched. | Yes  
  Shows the table headers, followed by rows with column header: value pair, Speak (Table header). Please say Done to continue. | No, reading labels  
  Unfortunately, I cannot show you the content on this device. Please say Done to continue. |
• **Note:** To edit or change any of the following bot messages, enter `sys_cs_provider_application.list` in the navigation filter of your ServiceNow instance, select **Alexa > Bot Messages**, and click the name of the bot message that you want to edit.
  
  ◦ `error_msg`
  ◦ `video_screen_device_msg`
  ◦ `video_audio_device_msg`
  ◦ `table_msg`

  If you find the message name `<EMPTY>` and want to add a Boolean confirmation message to the end users, you can configure the bot message with the value `[0]` or `[1]`.

• Conversational Integration with Alexa supports contextual actions that serve an appropriate response from custom chat integrations when user input is mapped to them. For more information, see [Contextual actions for Alexa](#).

**Contextual actions for Alexa**

Use the contextual actions supported by Conversational Integration with Alexa to receive an appropriate response during custom chat integrations with Alexa.

**Hi**

You can type or speak the `hi` command to initiate a conversation, in the middle of a conversation, or even inside a specific topic.

When you type or say `hi` in the middle of the topic, you are shown an option to either **End conversation** or to **Cancel**. If you end the conversation, the Alexa skill is reset and you can restart the skill by speaking your invocation name. If you cancel the conversation, you are redirected to the last topic that you were at.

**Bye**

The `Bye` command is used to end a conversation.

You can type `bye` or speak this command in the middle of a conversation to end the conversation.

**Help**

The `help` command is used to request help using the bot.

You can type `help` or speak this command to ask your Alexa skill any questions. If you want to restart the conversation, say `hi` or restart the conversation.
Restart

The **restart** command is used to end a bot conversation that is either in progress or runs into an error, and then begin a new conversation.

You can type **restart** or speak this command anywhere in the middle of a conversation.

Closing idle Alexa chat conversations

Enable virtual agents to effectively manage their active Alexa chat conversations by automatically closing the conversations after they have been inactive for a preconfigured amount of time.

Virtual Agent conversations are configured for the Alexa application. By default, any conversation is closed once the session with Alexa closes. Any conversation that is abandoned by requesters remains open or idle until they are automatically closed daily by the **Time Out Abandoned VA Conversations** scheduled job. For more information, see Closing Virtual Agent and Live Agent conversations.

Analytics and Reporting Solution for Virtual Agent

Virtual Agent Analytics and Reporting Solution contains a preconfigured Conversational Analytics Dashboard to help you improve Virtual Agent interactions. The dashboard provides deep insights into conversational data, enables you to refine topics, and increase the percentage of issues resolved by Virtual Agent.

⚠️ Note: Virtual Agent Analytics Dashboard (com.glide.cs.pa) will have no new enhancements or installations but will have continued support. Consider moving to Conversational Analytics Dashboard (com.sn.conversational.analytics).

Conversational Analytics Dashboard

The Conversational Analytics Dashboard helps you improve Virtual Agent (VA) interactions with users by providing deep insights into conversational data. The dashboard helps you refine topics and increase the percentage of issues resolved by VA.

Virtual Agent Analytics

Virtual Agent keeps records of interactions with users. The Conversational Analytics Dashboard provides insights into those interactions so you can see how well Virtual Agent understood and resolved user issues. Dashboard metrics, for example, reveal:
• What percentage of users transfer from VA to a live agent
• How to increase engagement rate and reduce user drop-offs
• Whether the user reached the last node in a topic
• Most and least-used topics
• Conversation details using advanced filters
• How to optimize conversation design

Key Features

Worst performing topics

See the worst-performing VA topics over a given time period.
Conversation details

Discover metadata about each VA interaction, including the user, the chat duration, and which node a user stopped at in a topic.

2021-05-24 05:59:02

Details

User ID
c069c3236688ab65c01b2fc19ccf7fd758c7e434076f6d6b175

Devices

Channel
Web Client

Start 12:59:02  End 12:59:48  Duration 00:00:46

User insights

Get a history of a user's chats.
Get started

Select a tile to get started with the VA Analytics Dashboard.

---

Explore
For VA users and system administrators to learn about the dashboard.

Set up
For system administrators setting up the dashboard.

Use
For VA users to learn how to use the dashboard.

---

Explore the Conversational Analytics Dashboard
Get a basic understanding of the Conversational Analytics Dashboard.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The following sections provide a high-level overview of how to use each section of the dashboard from the top down.

**Date range of data displayed**

The **Start** and **End** dates at the top of the dashboard specify the data range of the data summarized on each page.

<table>
<thead>
<tr>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>2020-12-22</td>
<td>2020-12-22</td>
</tr>
</tbody>
</table>

All dates and times on the dashboard are UTC. Even though the conversation table lists conversation dates and times in different time zones, Virtual Agent (VA) converts them to UTC when displaying them on the dashboard. Additionally, if you select a preset date range, such as last week, the dates might be slightly different from what you expect.

For information about setting the date range, see Set the date range of the data.

Certain data visualizations might not have data available for the start date and end date selected in the **Start** and **End** fields. In this case, the widget shows a start date and end date for the visualization based on the data availability within the selected date range.

**Getting detailed data**

The **Overview** tab provides summaries of the data displayed on the other tabs. You can get to more detailed data in several ways:
• Click a tab, for example, **Usage**.

• Click the arrowhead in one of the cards.

<table>
<thead>
<tr>
<th>Active VA users</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
</tr>
</tbody>
</table>

↓ 1 (-25%) From previous 8 day(s)

• Click a visualization.

---

**Dashboard tabs**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Landing page for the dashboard that shows summary information for all the other tabs.</td>
</tr>
<tr>
<td>Usage</td>
<td>Describes VA conversation usage, for example, the language of the conversations, their durations, and the types of conversations.</td>
</tr>
</tbody>
</table>
Dashboard tabs (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversations</td>
<td>Summary information for a user's conversations. Advanced filtering enables you to filter by conversation nodes or topics, and get details about the conversation duration, the channel the conversation occurred in, and the number of messages exchanged. You can link to details about each conversation on this tab.</td>
</tr>
<tr>
<td>Users</td>
<td>Lists the users who have had VA conversations. Advanced filtering provides analytics about usage frequency, by conversation, the duration of the conversation for each user, the user's first and last conversation, and the language used. You can link to user details from this tab, including their conversations.</td>
</tr>
<tr>
<td>Topics</td>
<td>Shows metrics about topics used by VA in conversations. Metrics include how many VA conversations moved to a live agent, average length of conversations per topic, and topic blocks used.</td>
</tr>
<tr>
<td>NLU Prediction</td>
<td>Shows the number of times the NLU prediction model accurately understood the intent of the user's conversation or auto-selected a topic. The chart links to the NLU Workbench if your instance includes NLU.</td>
</tr>
<tr>
<td>Custom Events</td>
<td>Displays the number of custom chat events that you create using the Events page. If you don't create custom events, the tab content is empty.</td>
</tr>
<tr>
<td>Funnels</td>
<td>Provides metrics for conversation flows.</td>
</tr>
<tr>
<td>Issue Auto-Resolution</td>
<td>Displays information about the number of user issues intercepted by the auto-resolution service and resolved by the Virtual Agent.</td>
</tr>
</tbody>
</table>

**Trends and scores**

Many tabs use scorecards that show the current value for a data point, for example, the number of conversations currently online.
Scorecards also show data trends, such as the increase or decrease of the data values over the date range specified on the dashboard. Hovering over the title of a scorecard displays a description of the scorecard.

Certain trend visualizations on the dashboard such as the trends in intent and topic matching do not support viewing monthly, weekly, and daily data.

**Visualizing data**

Many tabs show visualizations of the recorded VA data.

The cards have a common setup.
In each visualization, you can select:

- Subtabs to visualize different datasets in the visualization.
- Arrowhead icon (>) , which takes you to the corresponding tab that provides more detailed information.

For example, select the arrowhead in the **Active Users** scorecard to go to the **Users** tab, which shows a list of users currently using VA chat.
Click displayed data, such as a bar in a bar chart, to display detailed information about that data.

**Tutorial**

Now that you are familiar with the user interface, you can try the tutorial. It shows how the parts of the dashboard work together to provide insights for improving VA.

**Trying out the dashboard**

Use this tutorial to get familiar with the Conversational Analytics Dashboard.

**Before you begin**

Role required: Chat Analytics Viewer (chat_analytics_viewer)

**Procedure**

1. Navigate to Conversational Analytics > Virtual Agent Dashboard. The Overview tab on the dashboard appears. The Topic flows completed scorecard shows that the number of users completing all the nodes in a topic has decreased. I’d like to know why.

2. In the Topics visualization, click Incomplete.
I see that users did not complete the Testing Topic the most times, 14. So, I want to find out where the user got lost.

3. Click the Testing Topic bar to drill down on that topic.

The Topic details page opens. In the Total completion scorecard, I see that Virtual Agent (VA) resolved 28 conversations but couldn’t resolve 14 conversations. The Live Agent Transfer scorecard shows that no one transferred to a live agent. The Last visited node scorecard shows the three nodes in the topic where the user abandoned the conversation: Start, Testing, and link to requested screen. I would review those nodes to clarify the communication or add a different intent.
No conversations in this topic transferred from VA to a live agent. But I wonder if there are topics where users did transfer.

4. Click the **Conversations** tab.
   The **Conversations** tab displays all the conversations within the specified date range. I decide to use filters to see only the conversations that VA transferred to a live agent.

5. Click **Live Agent Transfer**.
   I notice that the condition builder automatically entered the filter parameters, setting **Type** to **VA to LA**.

   ![Filter Editor](image)

   I’d like to know which topic node the user last visited before transferring to a live agent.

6. Click a conversation date.
The conversation details appear.

7. Expand the **Greetings** action in the **Timeline** tab.

I see that the last node the user visited was **Send Topic Picker**. Now, I know I should revise that node in that topic.

```
2021-06-17 16:24:47

<table>
<thead>
<tr>
<th>Details</th>
<th>Timeline</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action</strong></td>
<td><strong>Duration</strong></td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:01</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:14</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:14</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:14</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:14</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:14</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:14</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:23</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:29</td>
</tr>
<tr>
<td>▼ ▼ ▼ Circle</td>
<td>00:00:54</td>
</tr>
</tbody>
</table>
```

I decide to see which topics are working better.

8. Select the **VA Success** filter.

The list contains conversations that VA was able to resolve. Perhaps I want to find out if the problem resolution took too long.

9. To add a condition, click **View/edit filter** and use the condition builder in the **Filter Editor pop-up window**. You can either select a default filter from the list or create a new filter condition.

10. Select **Duration** for the condition, the greater-than sign for the operator, enter 180 for the number of seconds, and click **Run**.

The list shows VA conversations that lasted over three minutes. It's a small percentage of all the conversations. So, I conclude the topic is working well.
Finally, I want to know which topics are most and least used so I know what topics to prioritize.

11. Click the Topics tab.
   The Topics page shows the best and worst performing topics.

Set up the Conversational Analytics Dashboard
Set up custom events and formula definitions to create more targeted analytics.

The Conversational Analytics Dashboard enables you to customize the data you monitor in the following ways:

- **Date range**—Specify the date range for the data displayed on the dashboard.

- **Custom events**—The dashboard can display analytics about custom events you create. All events must relate to conversations. For example, you can store data about every conversation that used a specific channel, such as Slack.

- **Formula Override**—Customize parameter definitions used in analytic reports. For example, by default, *duration* is the total time from the first to the last exchange in a conversation. You might like to override that formula by subtracting inactive times in the conversation.

Role requirements
You need the following roles to configure or use Conversational Analytics Dashboard.

<table>
<thead>
<tr>
<th>Conversational Analytics Dashboard roles</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Role</strong></td>
</tr>
<tr>
<td>VA admin</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Conversational Analytics Dashboard roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat analytics admin</td>
<td>View dashboard-related tables, create custom events, create custom formula overrides, reconfigure the dashboard using Now® Experience UI Builder, and set system parameters.</td>
</tr>
<tr>
<td>UI builder admin</td>
<td>To add, remove, and rearrange dashboard contents, you need admin access (ui_builder_admin) to Now® Experience UI Builder, which is a separate ServiceNow product.</td>
</tr>
<tr>
<td>Chat analytics viewer</td>
<td>Use the dashboard.</td>
</tr>
</tbody>
</table>

Dependencies
The Conversational Analytics Dashboard requires the Quebec or later version of Virtual Agent.

Install Conversational Analytics Dashboard
Get the Conversational Analytics Dashboard from the ServiceNow Store to get insights on Virtual Agent (VA) chats with customers.

Before you begin
The Conversational Analytics Dashboard requires the Quebec release of Virtual Agent or later.

Role required: Chat Analytics Admin

Procedure
1. Confirm that your instance has the Glide Virtual Agent plugin [com.glide.cs.chatbot] activated.
   The Conversational Analytics Dashboard depends on the Quebec or later version of Virtual Agent.
2. In the ServiceNow Store, search for analytics.
3. Select the latest version of Conversational Analytics Dashboard.
   The store installs the Virtual Agent Analytics Dashboard and the Analytics data configuration tools. The plugin name is com.sn.conversational.analytics and the scope name is sn_ci_analytics. Some of the tables added are:
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ci_analytics_conversation</td>
<td>The main table for conversations. It lists Virtual Agent conversations.</td>
</tr>
<tr>
<td>sn_ci_analytics_event</td>
<td>List of events. An event is something that happens, for example, an actionable notification. The dashboard can display analytics about default events or ones you create. For more information, see Set up custom events.</td>
</tr>
<tr>
<td>sn_ci_analytics_event_prop</td>
<td>List of values used in events.</td>
</tr>
<tr>
<td>sn_ci_analytics_formula_override</td>
<td>Lists formula overrides for properties used by the dashboard. For more information, see Set up custom definitions.</td>
</tr>
</tbody>
</table>

❗ **Note:** You do not need a license or a plugin for Performance Analytics.

4. Confirm the success of the dashboard installation by navigating in the Filter Navigator to **Conversational Analytics** and selecting **Virtual Agent Dashboard**. If you see the dashboard, the plugin installed correctly.

**Reconfigure dashboard contents**

Conversational Analytics Dashboard is created from Now® Experience Components. You can use the Now® Experience UI Builder to customize the dashboard. The dashboard pages that ServiceNow® ships with the Conversational Analytics Dashboard have a protection-policy, which makes the dashboard pages read-only. The dashboard pages cannot be modified directly, but you can copy pages using the **Duplicate** menu option in the Now® Experience UI Builder tool. After copying a page, you can customize the page content according to your requirements. For information about using Now® Experience UI Builder, see **Now Experience UI Builder**.

**System parameter configuration**

Use system parameters to configure some of the Conversational Analytics Dashboard.

Use the following system parameters to reconfigure Conversational Analytics Dashboard functionality. You must have the role, Chat Analytics Admin.
Dashboard system parameters

<table>
<thead>
<tr>
<th>Functionality</th>
<th>System parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug</td>
<td>sn_ci_analytics.logging.verbosity</td>
<td>Set the system parameter to &quot;debug&quot; to see the debug logs for conversational analytics. The setting makes the logs verbose with debug information.</td>
</tr>
<tr>
<td>Reasons</td>
<td>sn_ci_analytics.ca.reason_max</td>
<td>Set the maximum length of reason strings. The default is 1000 characters.</td>
</tr>
</tbody>
</table>

Create custom events to monitor

Create custom events and monitor them in the Conversational Analytics Dashboard.

Before you begin

Role required: Chat Analytics Admin.

About this task

An event is a combination of conditions that apply to a subset of Virtual Agent (VA) conversations. For example, an event might be conversations originating on a Slack channel that VA transferred to a live agent.

Most metrics you see on the dashboard, for example topic and conversation details, are derived from pre-built events. The dashboard displays these events on the Topics and Conversations tabs. To build custom events, you can use the Custom Events feature. Use custom events to create analytics about data you're interested in, for example:

- Number of conversations on a Slack channel that transferred to a live agent.
- Number of conversations on a Slack channel where the user never returned.
Custom events appear on the **Custom Events** tab. If you haven’t configured any custom events, the dashboard won’t display any. You can create up to 20 custom events.

Custom events take effect when you create them. You cannot use them to analyze data collected before you created the custom event.

**Procedure**

1. Navigate to **Conversational Analytics > Event Configuration** and select **New**. The Event New record page appears.

   ![Event New record page](image)

   - **Custom Name**: Live Agent message
   - **Source Table**: Conversation [sys_cs_conversation]
   - **Source Table Filter**: Add Filter Condition, Add "OR" Clause

2. In the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Custom event’s name.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Choose <strong>Custom</strong>. Choosing any other type changes the default behavior of the dashboard and is not recommended. This field specifies the type of event to include in the dashboard analytics.</td>
</tr>
<tr>
<td><strong>Source table</strong></td>
<td>Table of conversations to examine to detect custom events.</td>
</tr>
<tr>
<td><strong>Source Table Filter</strong></td>
<td>Use the condition builder to select specific data from the source table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conversation Mapping Field</td>
<td>Maps fields in the source table to fields in another conversation-related table. For example, a channel metadata column in the interaction table can be mapped to the sys ID column of the conversation table. Every event must be mapped to a Conversation ID.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the custom event.</td>
</tr>
<tr>
<td>Event Time</td>
<td>Specifies a time-based event, such as the time VA transferred a chat to a live agent. Selecting this check box opens the Event Time Field.</td>
</tr>
<tr>
<td>Event Time Field</td>
<td>Specifies the time in an event that you want to monitor, for example, the time a chat was transferred to a live agent. This field appears when you select Event Time.</td>
</tr>
<tr>
<td>Apply Post Fetch Filter</td>
<td>Enables you to use a script to filter data that was already filtered by the condition builder, Source Table Filter.</td>
</tr>
<tr>
<td>Post Fetch Script</td>
<td>Text field to enter a script that filters the data that has been filtered by the Source Table Filter. This field appears when you select Apply Post Fetch Filter.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
   The Events page appears, which lists all custom events. You've specified the table to look for custom events. Now, you must specify the parameter values that trigger the custom event.

4. Click the custom event you created.

5. In the Event Properties related list, select **New**.
   The Event Property New Record page appears where you specify the properties for a custom event that you want to track on the dashboard.
In this example, the Custom Event tab shows metrics for **Updated by** for the custom event, Messages-from-Slack.

6. In the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Record name for the property you want to collect metrics on.</td>
</tr>
<tr>
<td>Event</td>
<td>Name of the custom event associated with this property.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Selecting this check box opens a text field in which you can enter a script that specifies the field value you want to filter on. Selecting this check box removes the Value Field field.</td>
</tr>
<tr>
<td>Value Field</td>
<td>Specifies the field you want to collect metrics on.</td>
</tr>
<tr>
<td>Application</td>
<td>The scope of the custom event.</td>
</tr>
<tr>
<td>Event Source Table</td>
<td>The same value for this field you entered on the Event New Record page.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.  
The Event page appears.

8. Click **Update**.  
The Events page appears, which lists all custom events. You can open the Custom Events tab on the dashboard to see the custom event. This custom event is not retroactive; the dashboard only displays new events that satisfy the custom event criteria.
Create custom override definitions

Use scripts to override the default formulas used to create the analytics on the Conversational Analytics Dashboard.

Before you begin
Role required: Chat Analytics Admin

About this task
The Conversational Analytics Dashboard uses formulas to determine analytics, such as how to calculate duration. You can override the default formulas to tailor the analytics to your needs. For example, the default formula for duration in the dashboard is the time between the first and last exchanges in a conversation. You might like to override that formula by subtracting inactive times in the conversation.

The default formulas and formula overrides are in the sn_ci_analytics_formula_override table. You can only modify the existing formulas that are in the table. You cannot override other formulas the dashboard uses. You can, however, create custom events to achieve a similar goal.

The default definitions are:

- **Duration**—Time from the start of a conversation session until the last message is sent, rather than when the conversation session closes. You cannot replace the supplied script for Duration. You can only turn it on or off. If you deselect the **Active** check box, the duration is calculated until the end of the session. If you select the **Active** check box, the duration is calculated to the last message sent.

- **Self-solve rate**—Number of conversations that did not have negative feedback, contained a topic that went through to the last node, and did not escalate to a live agent. The dashboard divides that number by the number of all conversations to get the rate.

- **Feedback**—Defined as positive, neutral, and negative. For example, to override this behavior, first, use Virtual Agent (VA) Designer to create a ranking from 1 to 10. Then, you can use a script to override the dashboard's default behavior by grouping 1–4 as negative, 5–7 as neutral, and 8–10 as positive.

- **End state**—Defined by default in 12 ways. For more information, see Formula override examples.

**Note:** Formula overrides do not change the stored data. They only change how the dashboard displays the data by computing existing data in a different way.
Procedure

1. Navigate to **Conversational Analytics > Formula Override** and select **New**. The Formula Override New Record page appears.

   ![Formula Override New Record](image)

   - **Type**: Attribute
   - **Application**: Conversational Analytics
   - **Key**: -- None --
   - **Active**: Off
   - **Advanced**: Off
   - **Value Field**: Click to select...

   - **Submit**

2. In the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select <strong>DynamicProperties</strong>.</td>
</tr>
<tr>
<td>Key</td>
<td>Specifies the formula you want to override. For example, select <strong>End State</strong> to override the default formula for the definition of the end state of a conversation.</td>
</tr>
<tr>
<td>Value Field</td>
<td>Specifies the new definition of the <strong>Key</strong> value.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to enable the formula override. This check box enables you to have multiple formulas for a property but only one can be active at a time. When you activate this definition, you must deactivate the default definition.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Selecting this check box opens a text field in which you can enter a script that changes the existing formula used for the <strong>Key</strong> value. For example, if the <strong>Key</strong> value is <strong>End State</strong>, the script overrides the default formula that defines the end state of a conversation. Selecting this check box removes the <strong>Value Field</strong> field. For example scripts, see <strong>Formula override examples</strong>.</td>
</tr>
</tbody>
</table>

3. To use a script to override an existing formula:
a. In the Filter Navigator, enter `sn_ci_analytics_formula_override.list` to display the `sn_ci_analytics_formula_override` table. You cannot override the Duration formula, you can only activate or deactivate it. You can alter the scripts for the other definitions. These are the only definitions you can alter.

b. Select the formula you want to override. The Formula Override page appears and shows the existing formula.

c. Copy the script. The default formulas are read-only. So, to modify them, you must make a copy.

d. Modify the script.

e. Deselect the **Active** check box to make the default formula inactive.

f. Click **Update**.

g. In the new record for the formula override you created in step 1, select the **Advanced** check box. The **Value Script** text field opens.

h. Enter the revised script in the **Value Script** text field.

4. Select the **Active** check box to make the new definition active.

5. Click **Update**.
Formula override example

Use the following formula override example to craft your own formula overrides.

Group End State definitions

The end state of a conversation specifies how a conversation ended. For example, it could end with the user not responding, or the user closed the chat window. There are 12 default definitions of end state. The following script groups them as follows:

• VA closed the chat session
  ◦ System Closed VA – User No Response
  ◦ System Closed VA – Topic Complete
  ◦ System Closed VA – Left With AI Search
  ◦ System closed VA – Auto Closed
  ◦ System Closed VA – User Never Engaged

• Live agent closed the chat session
  ◦ System Closed LA – User No Response
  ◦ System Closed LA – Chat Complete
  ◦ Agent Closed LA – Clicked End/X
  ◦ System Closed LA – Before Agent Engagement

• User closed the chat session
  ◦ User Closed LA – Clicked End/X
  ◦ User Closed VA – Clicked End/X
  ◦ User Closed LA - Before Agent Engagement

To create these groupings of the 12 end states, follow the instructions for creating a formula override and use the following script.

(function calc(convGr) {
   // Returns 'System Closed VA', 'System Closed LA', 'User Closed' states.
   function getFinalEndState(state) {
       var arrayUtil = new global.ArrayUtil();
       VA_END_STATE = ['System Closed VA – User No Response',
                        'System Closed VA – Topic Complete',
                        'System Closed VA – Left With AI Search',
                        'System closed VA – Auto Closed',
                        'System Closed VA – User Never Engaged'];
       LA_END_STATE = ['System Closed LA – User No Response',
                        'System Closed LA – Chat Complete',
                        'Agent Closed LA – Clicked End/X',
                        'System Closed LA – Before Agent Engagement'];
   return arrayUtil.getN('VA END STATE', state, VA_END_STATE);
   }
   return arrayUtil.getN('LA END STATE', state, LA_END_STATE);
})
'System Closed LA – Chat Complete',
'Agent Closed LA – Clicked End/X',
'System Closed LA – Before Agent Engagement'
);

USER_CLOSED_END_STATE = ['User Closed LA – Clicked End/X',
'User Closed VA – Clicked End/X',
'User Closed LA – Before Agent Engagement'
);

if (state) {
    if (arrayUtil.contains(VA_END_STATE, state))
        return 'System Closed VA';

    if (arrayUtil.contains(LA_END_STATE, state))
        return 'System Closed LA';

    if (arrayUtil.contains(USER_CLOSED_END_STATE, state))
        return 'User Closed';
}

return state;

var conversationId = convGr.getValue('sys_id');
var interactionGr = new GlideRecord('interaction');
interactionGr.addQuery('channel_metadata_document', conversationId);
interactionGr.addQuery('channel_metadata_table', 'sys_cs_conversation');
interactionGr.query();
if (interactionGr.next()) {
    var state = interactionGr.getValue('state');
    var reason = interactionGr.getValue('state_reason');
    var isVAChat = interactionGr.getValue('virtual_agent');
    var isLAChat = interactionGr.getValue('agent_chat');
    var endState = new CAUtil().getEndState(state, reason, isVAChat, isLAChat);
    return getFinalEndState(endState);
}
}
)(convGr);

Use the Conversational Analytics Dashboard

Use the Conversational Analytics Dashboard to get insights into Virtual Agent (VA) conversations.

The following sections explain how to use the dashboard to investigate VA interactions with users. You must have the Chat Analytics Viewer (chat_analytics_viewer) role to use the Conversational Analytics Dashboard.
Set the date range of the data

Set the **Start** and **End** dates at the top of the dashboard specify the date range of the data summarized on a page.

**Before you begin**
Role required: Chat Analytics Viewer (chat_analytics_viewer)

**About this task**

<table>
<thead>
<tr>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>2020-12-22</td>
<td>2020-12-22</td>
</tr>
</tbody>
</table>

All dates and times on the dashboard are UTC. Even though the conversation table lists conversation dates and times in different time zones, Virtual Agent (VA) converts them to UTC when displaying them on the dashboard. Additionally, if you select a preset date range, such as *last week*, the dates might be different from what you expect.

You can set the date range in two ways.

**Procedure**

1. Navigate to **Conversational Analytics > Virtual Agent Dashboard**.

2. **Optional**: Use the **Start** and **End** dates to set the date range.

   a. Click the **Start** calendar icon (📅).

   b. Double-click the start date on the calendar.

   c. Click **OK**.

   d. Click the **End** calendar icon (📅).

   e. Double-click the end date on the calendar.

   f. Click **OK**.

   The data displayed on the dashboard adjusts according to the data in the new date range.

3. **Optional**: Use the **Start** date calendar to set the date range.
a. Click the Start calendar icon (📅).

b. Double-click the start date of the date range.

c. While holding down the control-key on the keyboard, double-click the end date. The dashboard highlights the range of dates.

<table>
<thead>
<tr>
<th>January 2021</th>
<th>&lt;</th>
<th>O</th>
<th>&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>M</td>
<td>T</td>
<td>W</td>
</tr>
<tr>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
</tr>
<tr>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
</tr>
<tr>
<td>31</td>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>

(Optional) d. Click OK.

(Optional) The data displayed on the dashboard adjusts according to the new date range.

Overview tab

Use the Overview tab to get a snapshot of some of the information collected in the Conversational Analytics dashboard.

The Overview tab is the landing page for the dashboard. It provides a summary of the information on all the other dashboard tabs. To use the Overview tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) role.
For directions about using the widgets on the **Overview** tab, see *Explore the Virtual Agent Analytics Dashboard*.

**Typical actions on the **Overview** tab include:**

- Selecting the arrowhead icon (>) in any of the widgets to open other dashboard tabs that display more detailed information.
- Selecting the visualized data, for example, a bar in a bar chart, to get additional information about the data.
- Changing the date range of the data displayed.
- Selecting a tab inside one of the widgets to change the set of data displayed. For example, in **Categories** bar chart, select the **Incomplete** tab.

⚠️ **Note:** Your **Overview** tab might look different because it can be configured.

**Edit the Overview page**

Add or subtract the widgets on the **Overview** page to suit your users.

**Before you begin**

Role required: admin

**About this task**

The *Overview* page displays widgets with links to all the dashboard data. You can edit the page to remove or add back widgets.
Procedure

1. Navigate to Application > Module.
2. To add or remove widgets from the Overview page, select Edit. The Now Experience UI Builder opens.
3. To add or remove components in the Conversational Analytics Dashboard, use the Now Experience UI Builder.

Usage tab

The Usage tab provides summary information about conversations. The Usage tab answers questions such as:

- What languages are used in conversations?
- What is the average duration of conversations on different days?
- How many Virtual Agent (VA) conversations transition to live agents?

To access the Usage tab, you must have the chat analytics admin role or the chat analytics viewer role.

Selecting the data or pointing to the data in the visualizations displays additional information about the data.
Visualized usage data

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversation type</td>
<td>Percentage of conversations escalated from VA to a live agent, initiated and completed in VA only, or initiated and completed by a live agent.</td>
</tr>
<tr>
<td>Average conversation duration</td>
<td>Average number of minutes for which the conversations lasted on each day.</td>
</tr>
<tr>
<td>Languages</td>
<td>Percentages of conversations spoken in different languages.</td>
</tr>
<tr>
<td>Topic sent via the Actionable notification</td>
<td>VA stores actionable notifications for eight hours. This statistic shows the percentage of actionable notifications customer accessed (Engaged) and not accessed (Expired).</td>
</tr>
</tbody>
</table>

Conversations tab

Use the Conversations tab to get a list of Virtual Agent conversations and details about each conversation.

The Conversations page lists all the Virtual Agent conversations that occurred during the specified date range.

All conversations from the Conversation [sys_cs_conversation] table except notifications, open (on-going) conversations, and previews that are run on Virtual Agent Designer are listed on the Conversations page.

Conversations page

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Conversation dates and times are in UTC. To access the **Conversation** tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) role.

**Conversations tab benefits**
The **Conversation** tab enables you to do the following:

- Filter the list of conversations easily by using pre-built filtering options. For more information, see **Filtering using list options**.
- Filter the list of conversations based on a specific condition and save conditions for filtering. For more information, see **Filtering using the Filter Editor**.
- Learn more about each conversation and mark conversations as favorite. For more information, see **Get conversation details**.
- Export the list of conversations to a file. For more information, see **Export the conversations list**.

**Filtering using the Filter Editor**
To filter the conversations, click **View/edit filter** and use the condition builder in the Filter Editor pop-up window. You can either select a default filter from the list or create a new filter condition. For example, the following image shows a condition in the Filter Editor pop-up window. This condition lists conversations that use the **Pizza Order** topic, and that have the **Pizza Type** topic node (a static choice control) in which the user has selected the **Pepperoni** value.

![Condition using a static choice value](image)

Another example condition is shown in the following image. This condition lists conversations that use the **Pizza Order** topic and that have the **Confirm** topic node (a boolean control) in which the user has selected the **true** value.
The condition builder consists of the following:

- **Field**: A list based on relevant tables. For more information about the field options, see [Field options in the Filter Editor](#).
- **Operator**: A list of operators that is contextually generated based on the selected field.
- **Value**: A text entry field or a list that is contextually generated based on the selected field.

To add a dependent condition in the condition builder, either click **or** or **and**. To filter the conversations list using the condition, click **Run**.

To remove a condition, click the delete icon (×) next to the condition.

To save a condition that you created in the condition builder, click **Save Filter**. In the Save Filter pop-up window, specify a name for the condition. Users having the Chat Analytics Viewer (chat_analytics_viewer) role can select and modify your saved filters.
Get conversation details
To get more information about a conversation, click one of the conversations in the list. The information appears on the side panel.

Conversation details

2021-07-19 04:48:51    ✭

Details   Timeline

User ID
db20639763e7d9bf606c9329207f616805c3f5c5b

Conversation type
VA Only

Channel
Web Client

Start    End    Duration
11:48:51  11:50:45  00:01:54

To view the conversation timeline, select the Timeline tab.
To tag a conversation as a favorite, you can click the star icon (⭐️) on the side panel. On the Conversations page, you can easily list the conversations that are marked as favorite using the Filter Editor.

**Export the conversations list**

To export the conversations list in the Conversations page to a file, select Export. In the Export pop-up window, specify the format for the file such as Excel, CSV, JSON, or PDF, and the delivery type such as email or download.

ℹ️ **Note:** You can export up to 1000 records only from the list on the page. This limit is not configurable.

**Filtering using list options**

You use the list options to filter the conversations.

ℹ️ **Note:** The dashboard converts the dates to UTC, which might not match the dates in the conversations list.

### List options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Lists all conversations.</td>
</tr>
<tr>
<td>VA Success</td>
<td>List all conversations that are considered successful.</td>
</tr>
<tr>
<td></td>
<td>You can edit the default formula that defines successful conversations by</td>
</tr>
<tr>
<td></td>
<td>using formula overrides. For more information, see Create custom override</td>
</tr>
<tr>
<td></td>
<td>definitions. In the base system, the default formula is set as a percentage</td>
</tr>
</tbody>
</table>
### List options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>of conversations that did not escalate to a live agent, did not have negative feedback, and contained a topic that went through to the last node.</td>
</tr>
<tr>
<td>Fallback</td>
<td>Lists all conversations where Virtual Agent didn’t understand the user and used fallback text to prompt the user for additional information.</td>
</tr>
<tr>
<td>Live Agent Transfer</td>
<td>Lists all conversations where Virtual Agent transferred the user to a live agent.</td>
</tr>
</tbody>
</table>

### Field options in the Filter Editor

<table>
<thead>
<tr>
<th>Field options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>Channel</td>
<td>Conversations that used the specified channel.</td>
</tr>
<tr>
<td>Conversation Time</td>
<td>Conversations within the specified date and time.</td>
</tr>
<tr>
<td>Duration</td>
<td>Conversations within the specified time duration. You can edit the definition of duration to be a session duration, rather than an active messaging duration. For more information, see Create custom override definitions.</td>
</tr>
<tr>
<td>End State</td>
<td>Conversations with the specified state that is based on how conversations ended. The values for the end states are stored in the Interactions [interactions] table. For more information, see Virtual Agent interaction records.</td>
</tr>
<tr>
<td>Events</td>
<td>Specific events that are triggered in a conversation.</td>
</tr>
<tr>
<td>Favorite</td>
<td>Conversations that are marked as favorite. You can also mark a conversation as favorite in the User Details page. For more information, see User Details page.</td>
</tr>
<tr>
<td>Feedback Result</td>
<td>Conversations for the specified feedback type.</td>
</tr>
<tr>
<td>Language</td>
<td>Conversations for the specified language based on the user’s language setting.</td>
</tr>
<tr>
<td>Message Count</td>
<td>Conversations for the specified message count in the chat.</td>
</tr>
</tbody>
</table>
### Field options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Name</td>
<td>Conversations for the specified provider.</td>
</tr>
<tr>
<td>VA Success</td>
<td>Conversations resolved by the Virtual Agent.</td>
</tr>
<tr>
<td>Setup Topic Types</td>
<td>Conversations that used the specified setup topic type.</td>
</tr>
<tr>
<td>Topic Blocks</td>
<td>Conversations that used the specified topic block.</td>
</tr>
<tr>
<td>Topic Categories</td>
<td>Conversations that have topics which belong to a specified topic category.</td>
</tr>
<tr>
<td>Topic Count</td>
<td>Conversations that used the specified topic count. Each conversation can use multiple topics and this option filters conversations based on the count of topics used in it.</td>
</tr>
<tr>
<td>Topics</td>
<td>Conversations that used the specified topics in the chat.</td>
</tr>
<tr>
<td>Type</td>
<td>Conversations that are of the specified type such as live agent only or Virtual Agent only.</td>
</tr>
</tbody>
</table>

### Users tab

Get detailed information on Virtual Agent users such as the time of the last chat, length of the chat, and other metrics.

The Users page provides summary information about all users and detailed information about each user conversation with Virtual Agent. The dashboard prevents you from identifying a person in the system user table. You can, however, follow users using their hashed user ID or a User index, which the dashboard assigns to users. The hashed user ID is an encrypted, unique user identifier.

To access the Users tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) role.
Users tab benefits

The Users tab enables you to do the following:

- Filter the list of users by using pre-built filtering options. For more information, see Filtering the list of users.

- Filter the list of users based on a specific condition and save conditions for filtering. For more information, see Filter using the condition builder.

- View summarized information about users. For more information, see User information.

- Export the list of users to a file. For more information, see Export the list of users.

Filter using the condition builder

The condition builder enables you to filter users based on one or more conditions. You can either select a default filter from the list or create a new filter condition. In the following example, the condition lists users whose conversations with the Virtual Agent lasted greater than 21 seconds.
The condition builder consists of the following:

- **Field**: A list based on relevant tables.
- **Operator**: A list of operations that is contextually generated based on the selected field.
- **Value**: A text entry field or a list that is contextually generated based on the selected field.

For more information about the field options, see Field options in the Filter Editor. To add dependent conditions in the condition builder, either click **or** or **and**. To filter the conversations list using the condition, click **Run**.

To remove a condition, click the delete icon (×) next to the condition.

To save a condition that you created in the condition builder, click **Save Filter**. In the Save Filter pop-up window, specify a name for the condition. Users having the Chat Analytics Viewer (chat-analytics_viewer) role can select and modify your saved filters.
Export the list of users

To export the list of users in the Users page to a file, select Export. In the Export pop-up window, specify the format for the file such as Excel, CSV, JSON, or PDF, and the delivery type such as email or download.

Note: You can export up to 1000 records only from the list on the page. This limit is not configurable.

Filtering the list of users

Use the list options to filter users.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All Virtual Agent users.</td>
</tr>
<tr>
<td>New</td>
<td>First conversation happened within the past seven days.</td>
</tr>
<tr>
<td>Returning</td>
<td>Users who previously used Virtual Agent.</td>
</tr>
<tr>
<td>Never Returned</td>
<td>Users who used Virtual Agent once, but haven’t used it again. The conversation count is 1.</td>
</tr>
</tbody>
</table>

Selecting a User Index takes you to the User Details page that provides detailed information about all of a user’s conversations.
User information
The following table describes the summarized Virtual Agent user information on the Users page.

| User information |
|---|---|
| **Column** | **Description** |
| User index | Link to go to the User Details page. It is a unique number that the system creates and permanently assigns to a Virtual Agent user. This number becomes a part of conversation records. This number is not the same as the system user ID. |
| Hashed User ID | Encrypted version of the system user ID. If users don’t log in, they appear in sessions as anonymous. |
| First conversation | How long ago the user first started the Virtual Agent conversation. |
| Last conversation | How long ago the user last had a Virtual Agent conversation. |
| Time in chat | Duration of the Virtual Agent chat. |
| Last used channel | Client software the user last used to chat. |
| Last used language | Language the user last used in a Virtual Agent conversation. |
| Favorite | Indicates whether the user is tagged as favorite. |

Field options in the Filter Editor

| User filters |
|---|---|
| **Option** | **Description** |
| Hashed User ID | Encrypted version of the system user ID. |
| User Index | Unique number that the system creates and permanently assigns to a Virtual Agent user. This number becomes a part of conversation records. |
| Conversation Exists | Container for subfilter properties. For example, in the previous image, the subfilter is Duration. |
User filters (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Count</td>
<td>Number of channels a user used. A channel is the client app the user used, such as Slack. For example, if all users have used only one channel to chat with Virtual Agent, then setting the filter value to 2 eliminates all the users in the list.</td>
</tr>
<tr>
<td>Channels</td>
<td>Only displays users that used the specified channel to chat.</td>
</tr>
<tr>
<td>Conversation Count</td>
<td>Only displays users that have the number of conversations specified in the filter.</td>
</tr>
<tr>
<td>Favorite</td>
<td>Only displays users that you marked as favorite, or conversely, not marked as favorite in the User Details page. For more information, see User Details page.</td>
</tr>
<tr>
<td>First Conversation Time</td>
<td>Only displays users where the first conversation is within the time period specified.</td>
</tr>
<tr>
<td>Language</td>
<td>Only displays users that chat using the specified language.</td>
</tr>
<tr>
<td>Last Conversation Time</td>
<td>Only displays users where the last conversation is within the time period specified.</td>
</tr>
<tr>
<td>Time in Chat</td>
<td>Only displays users whose chat durations are within the time period specified, for example, more than 30 seconds.</td>
</tr>
</tbody>
</table>

User Details page

Use the User Details page to see the history of a user's conversations.

The User Details page lists all chats that a user had with the Virtual Agent. It also displays the summary such as the language used in the chats, the first and last chats, and the channels.
You can click the star icon (★) on the User Details page to tag the user as a favorite. In the Users page, you can easily list the users that are marked as favorite using the Filter Editor.

**Benefits**

The User Details page enables you to do the following:

- View detailed information about each chat, and mark chats as favorite. For more information, see Get information about each chat.
- View details about each user. For more information, see Get information about each user.

**Get information about each chat**

You can get more information about a chat that a user had with the Virtual Agent. To get detailed information about one of the chats listed on the User Details page, select a date in the list of conversations. The information appears on the side panel.
Chat details

2021-05-24 05:59:02

Details Timeline

User ID
c069c3236688ab65c01b2fc19ccf7fd758c7e434076f6d6b175

Devices

Channel
Web Client

Start End Duration
12:59:02 12:59:48 00:00:46

To view the chat timeline, select the Timeline tab.

Timeline

2021-05-24 05:59:02

Details Timeline

<table>
<thead>
<tr>
<th>Action</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey</td>
<td>00:00:02</td>
</tr>
<tr>
<td>Greetings.</td>
<td>00:00:22</td>
</tr>
<tr>
<td>topic with 11 nodes</td>
<td>00:00:29</td>
</tr>
<tr>
<td>Anything Else Topic.</td>
<td>00:00:35</td>
</tr>
<tr>
<td>Virtual Agent Feedback.</td>
<td>00:00:40</td>
</tr>
<tr>
<td>Closing Conversation.</td>
<td>00:00:45</td>
</tr>
</tbody>
</table>

The Timeline tab shows the topic flow in the chat. For example, the following image shows that the chat started in Virtual Agent and moved to a live agent.
The timeline shows that the user chatted with Virtual Agent until 5:25. Then the user requested to talk to a live agent, who joined the chat at 5:32. The timeline shows events such as how many responses Virtual Agent made, and when the live agent closed the chat.

To tag the chat as favorite, select the star icon (⭐) on the side panel. On the Conversations page, you can easily list the chats that are marked as favorite using the Filter Editor. For more information, see Conversations tab.

Get information about each user

The following table explains the fields in the User Details page:

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Hashed User ID</td>
</tr>
</tbody>
</table>
Details (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First conversation</td>
<td>How long ago the user first started the Virtual Agent chat.</td>
</tr>
<tr>
<td>Last conversation</td>
<td>How long ago the user last had a Virtual Agent chat.</td>
</tr>
<tr>
<td>Time in chat</td>
<td>Duration of the Virtual Agent chat.</td>
</tr>
<tr>
<td>Languages</td>
<td>Language the user used in the chats.</td>
</tr>
<tr>
<td>Channels</td>
<td>Software that the user used to chat.</td>
</tr>
</tbody>
</table>

Topics tab

Use the **Topics** tab to identify areas to improve in Virtual Agent chats.

The **Topics** tab provides insights about which Virtual Agent (VA) topics are working and which aren’t. To use the Topics tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) role.

Worst performing topics

The Worst performing topics chart provides multiple ways of detecting chat topics that didn’t work. The horizontal axis lists the chat topics. The subtabs include:

- Least used—The topics used least in chats.
- Incomplete—The topics the user abandoned without resolution.
- Transfer to Live Agent—The topics the user couldn’t resolve with Virtual Agent. So, the user transferred to a live agent.

Best performing topics

The topics in this chart are performing well. The horizontal axis lists the topics. The count on the vertical axis varies depending on the subtab selected.
- Most Used—Number of times users used a topic.
- Complete—Number of times users completed a topic without the assistance of a live agent.

**Spokes used**
For more information about the spokes used, see Topic spokes.

**List of topics**
The Topics page list the topics used in the date range specified in the Conversational Analytics Dashboard.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Correct NLU Prediction %</th>
<th>Initiated %</th>
<th>Incomplete %</th>
<th>Transfer to Live Agent %</th>
</tr>
</thead>
<tbody>
<tr>
<td>topic with category 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>topic with 11 nodes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>spoke with subflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>auto_resolution</em></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Topic details**

<table>
<thead>
<tr>
<th>Topic information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct NLU Prediction %</td>
<td>Percentage of times this topic name was predicted correctly out of all times this topic name was predicted. A correct prediction means that VA showed that a predicted topic and a user selected it.</td>
</tr>
<tr>
<td>Initiated %</td>
<td>Percentage of times this topic ran out of all the topics that ran.</td>
</tr>
<tr>
<td>Incomplete %</td>
<td>Percentage of times the user didn’t reach the last node in the topic out of all times this topic ran. For example, if the 2 users didn’t complete all the nodes in a topic but 8 other users did, the incomplete percentage would be 20%.</td>
</tr>
</tbody>
</table>
Topic details (continued)

<table>
<thead>
<tr>
<th>Topic information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer to Live Agent %</td>
<td>Percentage of occurrences where this topic transferred from VA to a live</td>
</tr>
<tr>
<td></td>
<td>agent out of all the time this topic ran.</td>
</tr>
</tbody>
</table>

List of topic blocks

The **Topic Blocks** page list the topic blocks used in the date range specified in the Conversational Analytics Dashboard.

### List of topic blocks

<table>
<thead>
<tr>
<th>Topic Block</th>
<th>Executed Count</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>notification_controller_topic_block</em></td>
<td>2</td>
</tr>
<tr>
<td>Survey</td>
<td>19</td>
</tr>
<tr>
<td>AI Search</td>
<td>3</td>
</tr>
<tr>
<td>Contextual Search</td>
<td>1</td>
</tr>
</tbody>
</table>

The chart shows the number of times each topic block was executed.

**Topic categories**

Use the Category page to see the performance of Virtual Agent (VA) topics divided into categories.

Topic categories group related conversation topics. Topics can belong to more than one category. Click the drop-down list to show the categories that you can display in the visualizations. The visualizations show the aggregate performance of Virtual Agent conversations that ran in the topics belonging to a category.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
For more information about creating or modifying VA categories, see Create or modify custom categories.

**Topic category visualizations**

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversation end state</td>
<td>The number of users that reached a specific node in a topic in the VA category. In the example, six users reached the node labeled, <strong>System closed VA - Auto Closed</strong>. Use this field to see where topics stopped working for users.</td>
</tr>
<tr>
<td>Transfer to live agent</td>
<td>The number of users that transferred from VA to a live agent in that VA category. A high number indicates the topic is not meeting user needs.</td>
</tr>
<tr>
<td>Topic usage trend</td>
<td>Number of topics users used in a specified topic category over the course of the date range. The example shows the number of topics per day users used in the IT category. Use this field to monitor updates to topics.</td>
</tr>
<tr>
<td>Channel</td>
<td>The application the user used to chat with VA in that topic category, for example, Slack or web client.</td>
</tr>
</tbody>
</table>
Topic category visualizations (continued)

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel usage trend</td>
<td>Number of users using a specified channel over the course of the date range for topics in that VA category.</td>
</tr>
</tbody>
</table>

Topics details

Use the Topic Details page to see the details of the Virtual Agent (VA) topics.

Get additional information about the topics

You can select the visualized data selecting the topic from the list. Details about the data you selected displays.

Note: The Y axis is evenly divided over 10 increments. If there are fewer than ten values on the Y axis, some values repeat, for example, five 1’s in the previous image.

Use the list menu to display one of the chat interactions in the topic you selected. This page shows:
The number of times the topic was used each day.

You can display the number of occurrences and user sessions of the selected topic by selecting **Download**.

<table>
<thead>
<tr>
<th>date</th>
<th>event_name</th>
<th>occurrences</th>
<th>sessions</th>
</tr>
</thead>
<tbody>
<tr>
<td>2021-02-01 00:00:00</td>
<td>VPN Connectivity (Template)</td>
<td>34</td>
<td>27</td>
</tr>
<tr>
<td>2020-01-01 00:00:00</td>
<td>VPN Connectivity (Template)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020-02-01 00:00:00</td>
<td>VPN Connectivity (Template)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020-03-01 00:00:00</td>
<td>VPN Connectivity (Template)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020-04-01 00:00:00</td>
<td>VPN Connectivity (Template)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020-05-01 00:00:00</td>
<td>VPN Connectivity (Template)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020-06-01 00:00:00</td>
<td>VPN Connectivity (Template)</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

In this example, one chat session happened on 2020-12-16.

- **Topic completion**—Number of times the user went to the final node in the topic.
- **Live Agent Transfer**—Number of VA chats transferred to a live agent.
- **Last Visited Node**—Last nodes users visited before leaving the chat.
  
  The presumption is the user gave up after the last node they visited.

**Topic spokes**

Use the Spokes page to see the details of the spoke actions and subflows for the Virtual Agent (VA) topic.

**Spokes used**

The **Spokes used** chart shows which spokes, actions, and subflows were used and how often. In Virtual Agent, conversations contain topics, topics contain spokes, and spokes contain spoke actions or subflows. Selecting a spoke from the list displays the following details.
The three charts show:

- The number of times the specified spoke ran each day.

  You can display the number of occurrences and user sessions of the selected topic by selecting **Download**.

  sn_ci_analytics_st_event_occurrence (2)

<table>
<thead>
<tr>
<th>date</th>
<th>event_name</th>
<th>occurrences</th>
<th>sessions</th>
</tr>
</thead>
<tbody>
<tr>
<td>2021-02-01 00:00:00</td>
<td>Global</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>2021-06-01 00:00:00</td>
<td>Global</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>2020-01-01 00:00:00</td>
<td>Global</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020-02-01 00:00:00</td>
<td>Global</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020-03-01 00:00:00</td>
<td>Global</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020-04-01 00:00:00</td>
<td>Global</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

- **Actions and Subflows**—Within the specified spoke, which actions and subflows were executed. In the previous **Actions and Subflows** chart, one action, Create Freeform VTB was triggered 22 times.

- **Topics**—Which topics executed the spoke. The horizontal axis in the **Topics** chart shows the topics that triggered the spoke. The vertical axis shows how many times the topic triggered the spoke.

**Natural Language Understanding of Virtual Agent responses**

Virtual Agent (VA) uses the Natural Language Understanding (NLU) service to understand user input. Use the **NLU Prediction** tab to see how well NLU predicts intents, and to improve the intents so NLU makes better predictions.

The **NLU Prediction** tab on the Conversational Analytics Dashboard shows how well NLU is understanding user input in chat conversations. Virtual Agent comes
with NLU models, but you can use the **NLU Workbench** to modify or create new models.

View how your NLU models are performing

![NLU Prediction graph](image)

**Correct predictions**
Multiple predictions were made that matched topics and those topics were shown to users. One of them was selected. We will note that all topics that were predicted and shown as correctly predicted.

**Incorrect predictions**
Multiple predictions were made that matched topics and those topics were shown to users. Users indicated that none of them were the topics they were looking for.

**Auto selected predictions**
Predictions were made and there was one that met the threshold and matched a topic. Topic started. We will note these topics as auto-selected topics post prediction.

To use the NLU Prediction tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) role.

**NLU Prediction graph**
The graph shows the daily performance of NLU predictions. The graph can show up to three lines, which represent:
• **Correct Predictions**—NLU predicted multiple intents and showed them to users. They selected one.

• **Incorrect Predictions**—NLU predicted multiple intents and showed them to users. They indicated that none of them were what they were looking for.

• **Auto Selected Predictions**—NLU predicted a single intent based on chat input from the user. Sometimes, NLU returns multiple topics, each from a separate intent, and the user selects one.

The example graph only shows Auto Selected Predictions. On 2021-01-27, one intent was auto-selected, and on 2021-01-31, two intents were auto-selected.

ℹ️ **Note:** The vertical axis can have duplicate values because the axis has 10 increments. If the number of intents is less than 10, some values on the vertical axis appear more than once. For example, in the previous image, the maximum number of intents of all the days in the date range is 5. So, on the vertical axis there are two 1s, two 2s, two 3s, and so forth.

How are these values determined? The dashboard collects the following data:

1. Did the NLU prediction model determine an intent?
2. Did the predicted intent match the topic bound in the model to the intent?
3. What’s the prediction score and did the dashboard show multiple options to the end user to specify the correct intent, or did the dashboard just display the topic associated with one intent.
4. After showing the user multiple intents, did the user select one?

The Conversational Dashboard uses the following algorithms on the data to populate the intent lists:

• **Correct Predictions**—1, 2, 3, and 4 are true.
• **Incorrect Predictions**—4 was false.
• **Auto Selected Predictions**—3 was auto-selected, and there was no 4.

It’s possible for intents to appear in several categories. For example, the **Activate Account (Ben)** intent appears in the **Correct Predictions** and the **Auto Selected Predictions** columns because NLU correctly predicted the intent and only presented a single response to the user.

**Improving NLU predictions**

Clicking anywhere on the graph opens the Model Performance page. It shows a summary of intents predicted or not predicted over the date range specified on the graph.
Model Performance
This analysis is based on data from virtual agent conversations across all NLU models.

Here's a breakdown of how well your NLU models did at predicting users' intents from their utterances. Select the bars to see more details.

Unsupported utterances 78.57% (22)
Multiple predictions made, intent selected 7.14% (2)
One prediction made, topic launched 14.29% (4)

See Activate the NLU Workbench to see how to use the NLU Workbench to improve NLU predictions.

Modify models
Test and modify the Virtual Agent models so they more accurately predict user intents.

Before you begin
Role required: Chat Analytics Admin

About this task
Many ServiceNow products, such as ITSM, HRSD, and CSM include NLU models for Virtual Agent (VA) topics. The NLU plugin contains entities that are common across all products. You can modify those models. To learn how to train and test the models used for VA conversations, see Natural Language Understanding.
Procedure

1. Navigate to **Conversational Analytics > Virtual Agent Dashboard** and select the **NLU Prediction** tab. The Conversational Analytics Dashboard appears.

2. Click **View more**.

The Models page opens that displays the models that predict intents in your setup.

3. **Optional:** If none of the models contain intents and utterances you’d like in your setup, select **Create Model** and follow the instructions in **Create an NLU model**.

4. Click a model to display the intents the model predicts.

5. **Optional:** Click an intent to display the utterances associated with it.
6. **Optional:** To create a new intent and add it to the model:

   a. Select **New Intent**. The **Create a new intent** modal opens.

   b. Enter the name of the new intent in **Intent Name**, a description of it in the **Description** field, and select **Save**. A page for your new intent opens.
c. Enter an utterance for your new intent and select Add. You can repeat this step multiple times to add multiple utterances.

7. Optional: To import one or more intents, select Import Intents. The Import Intents modal opens, which displays the intents you can import.

<table>
<thead>
<tr>
<th>Intent</th>
<th>Model Name</th>
<th>#Utterances</th>
<th>#Entities</th>
<th>Created by</th>
<th>Last updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application: ITSM NLU Model for Virtual Agent Conversations (37)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application: Global (7)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application: Customer Service NLU Model for Virtual Agent Conversations (5)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SubmitRequest</td>
<td>[Read Only] Customer Service NLU for VA</td>
<td>34</td>
<td>1</td>
<td>admin</td>
<td>2019-10-14 02:38:21</td>
</tr>
</tbody>
</table>

a. Find the intent(s) to import by entering a search term, or by clicking an arrowhead to display the intents in a folder, and then selecting one or more check boxes.

b. Select Import.

8. Optional: If you added or imported intents:

a. Select Train to add the intents to the model.

b. Select Train to train the model. If successful, a banner at the top reads, The model has been successfully trained.

9. To test all the utterances, select Test and enter a sentence a user might enter in a chat to see if NLU understands the intent of your sentence.
10. If the models fail to predict the intent, add additional intents to the model, or utterances to the intents, as described in step 6.

**Custom Events tab**

Use the Custom Events tab to see the list of custom events created for Virtual Agent.

To use the Custom Events tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) role.
The Custom Events tab shows the dates when custom events were triggered. If no one created custom events, the list of custom events is empty. The maximum number of custom events displayed is 20.

Use the drop-down list to specify the custom event you want analytics for. The graphics are unique for each custom event. For more information about them, consult the person who created the custom event.

Funnels tab

Funnels provide cumulative filtering of conversation flows. Using funnels, you can identify whether your conversation flows are performing effectively when users chat with Virtual Agent.

Overview of funnels

Funnels filter conversation flows using steps that are defined when a user creates the funnel.

A funnel can contain up to 10 filtering steps for a conversation flow. Each subsequent step further refines the results from the previous step. This type of
cumulative filtering helps you to easily narrow down on the data of interest at each step of the conversation flow.

When you run a funnel for a particular date range, the system displays the following metrics that show the number of users at each step:

- The percentage and number of users who have used the specified conversation flow.
- The percentage and number of users who proceeded to the next conversation step specified in the funnel.
- The percentage of users who dropped off at a particular conversation step.
- The percentage and number of users who completed all specified conversation steps in the flow.
- The biggest drop-off point or step where users left the conversation flow.

Each step in a funnel consists of the following:

- Field: The item on which the step is evaluated.
- Operator: A list of operators that is contextually generated based on the selected field.
- Value: A text entry field or a list that is contextually generated based on the selected field.

For more information about filtering options in steps, see Filter options in funnels.

**Use case for funnels**

Consider an example scenario where an admin has to get insights about how Virtual Agent is handling user queries in a conversation flow. To review the efficiency of the conversation flow, the admin might look for information such as the following:

- What percentage or number of users have interacted with Virtual Agent.
- Out of the users who interacted with Virtual Agent, what percentage or number of users have followed a specific node in the topic during the conversation.
- Out of the users who used the specific node, what number of users requested for a transfer to a live agent.

For example, see the following funnel for fetching metrics on a conversational flow that provides software access.
Here, the funnel has three filtering steps:

- Step 1 fetches users who have followed the Software Access topic while interacting with the Virtual Agent.
- Out of the retrieved users from step 1, step 2 fetches users who requested for a drive access in the Drive Flow Executed node.
- Out of the retrieved users from step 2, step 3 fetches users who requested transferring to a live agent.

**Metrics for funnels**

Using Funnels, you can easily filter conversation flows and get information as metrics. Metrics indicate what percentage or number of users are active at each step of the conversation flow.

You can improve the conversation flows based on the performance metrics derived from using funnels. The metrics help identify opportunities for improving conversation flows so that Virtual Agent can handle your user queries better.

Using the previous example, that funnel displays the following metrics:
Here, the metrics indicate the following for the selected date range:

1. 134 users followed the Software Access topic.
2. Out of these 134 users, 85 users requested for a drive access.
3. Out of these 85 users, 23 users requested for transferring to a live agent.

These example metrics indicate an opportunity for improvement because 23 users requested for a transfer to a live agent.

**Other benefits of using funnels**

Users can create funnels to get insights on their conversation flows. Additionally, they can edit and delete existing funnels created by other users. For more information, see [Create and manage funnels](#).

You can compare the performance of previous and current conversation flows. Funnels show metrics for the specified date range. Additionally, it shows the comparison for the same number of days in the date range prior to the specified start date. You can know the increase or decrease in users who have made through all the steps.

**Previous metrics**

<table>
<thead>
<tr>
<th>% of users that made it through the steps</th>
<th># of users that made it through the steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>25%</td>
<td>2 / 8</td>
</tr>
</tbody>
</table>

↑ 25% From previous 8 day(s)  
↑ 2 users From previous 8 day(s)
Create and manage funnels

Use funnels to review the performance of your conversation flows.

Before you begin
Role required: chat_analytics_viewer, virtual_agent_admin, chat_analytics_admin, or admin

About this task
You can create, edit, and delete funnels.

Procedure
1. Navigate to Conversational Analytics > Virtual Agent Dashboard.
2. Click the Funnels tab.
3. Click New funnel.
   The Create a new funnel page appears.
4. In the Give this funnel a name field, provide a meaningful and short name for the funnel.

   Note: Funnel names must be unique, so provide a different name for each funnel.
5. To create steps for filtering the conversation flow, click Add new step.
   A funnel can contain up to 10 filtering steps. Each subsequent step further refines the results from the previous step. This type of cumulative filtering helps you easily narrow down on the data of interest in the conversation flow. For more information about the filtering options, see Filter options in funnels.
6. To define a step, click or and add an OR condition.
   If needed, you can do any of the following with your steps:
   • To remove an OR condition, click the delete icon (X) next to it.
   • To reset a step, click the delete icon next to it.
   • To remove the step, click the delete icon again.
7. Click Create funnel.
   The metrics for the conversation flow appear. You can select a date range in the Start and End fields for reviewing the metrics.
8. Optional: To edit a funnel, click the funnel name on the Funnels page, and then click Edit funnel.
9. Optional: To remove a funnel, click the funnel name on the Funnels page, and then click Delete.
Filter options in funnels

Use filter options for creating steps in funnels. You can create steps in funnels for cumulative filtering of a conversation flow.

Overview of filter options

You can define each step depending on your data of interest in the conversation flow. For more information, see Funnels tab.

A step consists of the following:

- **Field**: The item on which the step is evaluated.
- **Operator**: A list of operators that is contextually generated based on the selected field.
- **Value**: A text entry field or a list that is contextually generated based on the selected field.

The field options are listed in the following table:

<table>
<thead>
<tr>
<th>Field options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversation start (1st)</td>
<td>All users who had a single or one-time conversation with Virtual Agent.</td>
</tr>
<tr>
<td>Conversation start (Any)</td>
<td>All users who had conversations with Virtual Agent. This option includes all users regardless of the number of times the users have interacted with Virtual Agent.</td>
</tr>
<tr>
<td>Events</td>
<td>Events that are triggered in a conversation.</td>
</tr>
<tr>
<td>Topic</td>
<td>List of all topics that were used in the conversation flow. The list of topics can be refined further to these topic types:</td>
</tr>
<tr>
<td></td>
<td>• Setup topics: List of topics that provide basic conversational flows such as the conversation greeting or closing.</td>
</tr>
<tr>
<td></td>
<td>• Standard topics: List of topics only and not topic blocks or pre-built topics.</td>
</tr>
<tr>
<td></td>
<td>• Topic blocks: List of topic blocks only.</td>
</tr>
</tbody>
</table>
Issue auto-resolution tab

The **Issue auto-resolution** tab helps you understand how well your Virtual Agent (VA) chatbot anticipates user needs. It displays information about the number of user issues intercepted by the auto-resolution service and resolved by VA.

Issue auto-resolution takes place when a user is diverted to VA from a non-conversational interface. For example, a user might request a new keyboard through a service portal or email. The auto-resolution service can detect the user request and use VA to resolve the user’s request in a VA chatbot session. For more information, see [Auto Resolution for Virtual Agent](#).

The data visualizations in the **Issue auto-resolution** tab displays how well the auto-resolution service is working. This tab is available only when Incident Auto Resolution is enabled and the [Auto Resolution Configuration](#) record is set as active. For more information, see [Setting up Incident Auto Resolution for Virtual Agent](#).

To access the **Issue auto-resolution** tab, you must have the chat analytics admin role or the chat analytics viewer role.
Selecting the data or pointing to the data in the visualizations displays additional information about the data.

**Auto-resolution visualizations**

| Visualization                          | Description                                                                      |
|----------------------------------------|                                                                                 |
| Intents with Matched Topics            | Number of intents that match topics enabled for auto-resolution.                |
## Auto-resolution visualizations (continued)

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intents without Matched Topics</td>
<td>Number of intents that do not have matching topics.</td>
</tr>
<tr>
<td>Intents with Auto-resolution Disabled</td>
<td>Number of intents that match topics not enabled for issue auto-resolution.</td>
</tr>
<tr>
<td>Intent and topic matching results</td>
<td>Breakdown of incidents by intent matching. For example, incidents with matching intents and topics, and incidents without matching intents.</td>
</tr>
<tr>
<td>Trends in intent and topic matching</td>
<td>Trend showing incidents that have intents with or without matching topics.</td>
</tr>
<tr>
<td>Auto resolution conversations</td>
<td>Issue auto-resolution conversations that were resolved and unresolved. Resolved means incidents are in the resolved state after the users interacted with VA.</td>
</tr>
<tr>
<td>Auto resolution conversation trends</td>
<td>Usage trend showing all the issue auto-resolution conversations and how many incidents were successfully resolved.</td>
</tr>
<tr>
<td>Issue auto-resolution acceptance rate</td>
<td>Shows the issue auto-resolution notifications that were accepted and declined by users.</td>
</tr>
<tr>
<td>Top topics in auto resolution conversations</td>
<td>Frequently used topics in auto resolution conversations.</td>
</tr>
</tbody>
</table>

## Process Optimization

Process Optimization helps analysts and process owners quickly analyze and optimize their business processes.

Create automated business process flows from your data that enable you to monitor and more quickly discover inefficiencies in your processes. With Process Optimization, you can:
• Visualize the execution of your processes or a customer journey, giving insight into adoption and user experiences.

• Identify bottlenecks and see their impact on your key performance indicators, enabling you to resolve root-cause issues.

• Audit processes to immediately detect critical changes and potential problems before they create negative consequences on the business.

• Integrate with ServiceNow® Performance Analytics and Continual Improvement Management to discover opportunities for improving your processes.

• Compare processes to investigate performance differences or deviations.

• Link connected processes for a more comprehensive view of what impacts your main business.

• View activity transitions to see the top contributing activity transitions across specific metrics.

• Perform advanced calculations with the scalability of machine learning and AI.

• Perform ML cluster analyses to find similar groupings, or patterns, of instances or records.

**Key Features**

**Automated process discovery**

Define a project by selecting a process table, and the activities and breakdowns you want to explore.
Summary and Insights dashboard

Quickly understand process performance. From the Summary and Insights dashboard, view key performance indicators. Also see process variation, bottleneck analysis, and ML and smart rule-based insights.
### Analyst Workbench

Analyze business workflows visually with the interactive process map, explorative filter panel, and pre-built performance metrics.
Easy collaboration and sharing

Share projects with stakeholders and collaborate with notes and screenshots within process models.

Integrated continual optimization
Create and view statuses of improvement initiatives.

Integration with Performance Analytics and Benchmarks

- Analyze low-performing indicators for root cause analysis with Performance Analytics integration.
- Use best practice-based implementation. Predefined ITSM process optimization models and improvement initiatives provide you faster time to value.

Compare processes

Compare processes to investigate performance differences or deviations.
**Link processes**

Link connected processes for a more comprehensive view of what impacts your main business.

**Bottleneck analysis**

View activity transitions you've defined with the bottleneck analysis feature.
Analyze processes using ML-based clustering

Group similar records into machine learning pattern-identified clusters.

Cluster analysis results

*Clustering on activity: Assigned*

<table>
<thead>
<tr>
<th>Biggest Clusters</th>
<th>High Quality Clusters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concept*</td>
<td>Size</td>
</tr>
<tr>
<td>issue, access, hi, account, slack</td>
<td>586</td>
</tr>
<tr>
<td>connect, unable, ap, attach, eye</td>
<td>452</td>
</tr>
<tr>
<td>email, issue, outlook, access, resolve, sync, iphone, android</td>
<td>430</td>
</tr>
</tbody>
</table>

*Concept is a set of common words or topic patterns identified from the cluster text data.

**Purity insights help identify the most frequent field value in a cluster. For example: 'Hardware' assignment group can be the most frequently assigned
Quickly analyze the processes behind performance indicators and record lists

Easy-to-see process behind scenarios such as bad service level agreements or CSAT scores. Run the analysis from any platform list or report.

Get started

1. Process owners and system administrators go here to learn about Process Optimization.
1. System administrators go here to set up Process Optimization.
1. Process owners go here to learn how to use Process Optimization.

Explore Process Optimization

Use Process Optimization to analyze and optimize business processes.

Assess processes, identify bottlenecks, and drive business results with Process Optimization.
Process Optimization enables you to find answers to process improvement questions such as:

- Where is the business spending or wasting the most time?
- What's the root cause behind slow-performing processes?
- Where should the business apply automation next in its process?
- Where is rework occurring?
- What's the estimated cost and potential savings for each activity within a process?
- How much deviation is the business seeing in its process?

As an analyst, you can:

- Proactively assess and improve ITSM, CSM, Financial Services Operations processes, and Order Management for Telecommunications and Media.
- Accelerate digital transformation. Find areas of improvement and automation based on data and your best practice content.

As a process owner, you can:

- Get visibility into processes and start collaboration.
- Assess process bottlenecks, find areas of weakness, and find potential areas to optimize.
Integrating with Process Optimization

Use Process Optimization throughout the continuous improvement life cycle to consistently and accurately analyze processes.

Find improvement opportunities and monitor process changes and progress through these stages.

1. **Identify**: Use Process Optimization to proactively assess a current process and find improvement opportunities.

2. **Plan and execute**: Find root causes of problem areas, and uncover new tasks or missing steps.

3. **Measure**: Monitor the latest process data.

4. **Show the outcomes**: Reanalyze the process, and show measurable outcomes.
Example: Continual Improvement Management using Process Optimization

Understand how you can create or track an improvement request.

As an improvement manager, you use your Continual Improvement Management Workbench dashboard daily to view operational work and initiatives in progress. You have an open initiative to optimize the incident process and reduce mean time to resolve (MTTR).

From the initiative form, you select Go to Process Optimization. The action navigates you to a generated model in the Process Optimization Analyst Workbench showing cases that were closed in the last three months.

Make Continual Improvement part of your routine through integration with Process Optimization

Example: Benchmarks using Process Optimization

Understand how you can analyze a process relevant to a KPI. Create or view the status of an associated incident.

Identify, analyze, and enact: Process Optimization simplified on the Now Platform

An IT analyst looks at their monthly Benchmarks report. They notice that the ‘MTTR for high priority incident’ KPI is performing negatively compared to industry peers. Their CIO wants to understand the reasons why.

The analyst selects the Go to Process Optimization icon from a Benchmarks KPI. The action navigates them to the Process Optimization Analyst Workbench in a new tab. They quickly discover an area needing improvement, and submit a CIM initiative. Once the CIM initiative is completed, they can see the improvement on the Benchmarks industry peer comparison chart.
Example: Performance Analytics using Process Optimization

Understand how you can extract data from a Performance Analytics indicator that is based on incident, problem, change, customer service case, or request process data.

As a process analyst, you view your Performance Analytics dashboard and see that the ‘Number of open incidents’ indicator has increased over the last two months. You understand that an increase in this kind of metric causes lower customer satisfaction, and increases business costs. To dig deeper into the numbers, you open the Analytics Hub for the indicator.
Among the many analytical tools in the Analytics Hub, you have the ability to open the Process Optimization workbench. With Process Optimization, you may be able to resolve this increase in incidents.

You select the Go to Process Optimization icon from the dashboard.

The action automatically creates a process map in the context of the indicator. You navigate to the Process Optimization Analyst Workbench to investigate the root cause.
Related information
Integration with Performance Analytics (PA)

Example: Process Optimization for CSM

Analyze a process for customer service cases and identify bottlenecks to minimize delays in the case flow for a better customer experience.

Say you were a process analyst in the ACME corporation where you must submit analysis on current processes associated with customer service cases. You use the Analyst Workbench to access the mined processes for the Customer Service Cases model definition.

You would analyze the case process flow and suggest ways to improve the processes by using the following workflow:
1. Select **Open Analyst Workbench** from the **Customer Service Cases** model definition. The Analyst Workbench is opened in a new tab.

   You observe that the customer service case records take an average duration of 16 days to close a case.

2. View metrics of the process map by setting the Primary Metric and Secondary Metric lists to **Unique Occurrences** and **Average Duration**, respectively.

3. Refine the process map by selecting **Refine** and selecting a connection width to see the full list of metrics.

   You observe that the **Work In Progress - Awaiting Info** transition state is taking more than two days.

4. In the Filters tab, set the Breakdown filters list to **Assignment group** and use the activity filter to view the process flow between the **Work In Progress - Awaiting Info** and **Work In Progress** activities.

5. In the Routes tab, you want to see all the records that took longer than average duration of two days between the selected activities so you select **Most records** in the Sort by list. You then select any process paths to view the cases in that route.

   You observe that most of the cases are related to emails.

6. Add notes to the project by selecting the notes icon (✓) and submit an analysis.

   In your notes, you suggest using a standardized template for improving the email transactions between agents and customers.
Related information

Overview of the Analyst Workbench
Analyze and get process insights
Integration with Customer Service Management

Example: Process Optimization for Financial Services Operations

Analyze a process for financial services cases and identify bottlenecks to minimize delays in the case flow for a better customer experience.

Say you were a process analyst in your financial institution where you must submit analysis on current processes associated with financial services cases. You can use the Analyst Workbench to access the mined processes for the model definition for financial services payment operations, loan operations, and complaint management.

You can analyze the case process flow and suggest ways to improve the processes by using the following workflow, for example, for Loan deferment in B2C model definition:

1. Select **Open Analyst Workbench** from the selected model definition. The Analyst Workbench opens in a new tab.

   You can observe the average duration that a Loan deferment case record takes to be closed.

2. View metrics of the process map by setting the Primary Metric and Secondary Metric lists to **Unique Occurrences** and **Average Duration**, respectively.

3. Refine the process map by selecting **Refine** and selecting a connection width to see the full list of metrics.

   You can observe the state transitions and their duration.

4. In the Filters tab, set up the Breakdown filters list for categories and use the activity transitions filters to filter out the records.

5. In the Variation Analysis tab, you can view the routes taken by the records, number of case in a route, the average duration and the number of steps involved in the route. Selecting a route highlights the route in the map.

6. Add notes to the project by selecting the notes icon (óż) and submit an analysis.
Related information

Overview of the Analyst Workbench
Analyze and get process insights
Integration with Financial Services Operations

Example: Process Optimization for Telecommunications

Analyze a process for Telecommunications orders and identify bottlenecks to minimize delays in the case flow for a better customer experience.

Say you were a process analyst in your telecommunications service provider where you must submit analysis on current processes associated with telecommunications orders. You can use the Analyst Workbench to access the mined processes for the model definition for telecommunications product orders, service orders, resource orders, and order tasks.

You can analyze the case process flow and suggest ways to improve the processes by using the following workflow, for example, for the product orders in Telecommunications model definition:

1. Select Open Analyst Workbench from the selected model definition. The Analyst Workbench opens in a new tab.

   You can observe the average duration that a telecommunications customer order takes to be fulfilled.

2. View metrics of the process map by setting the Primary Metric and Secondary Metric lists to Unique Occurrences and Average Duration, respectively.
3. Refine the process map by selecting **Refine** and selecting a connection width to see the full list of metrics.

You can observe the state transitions and their duration.

4. In the Filters tab, set up the Breakdown filters list for categories and use the activity transitions filters to filter out the records.

5. In the Variation Analysis tab, you can view the routes taken by the records, number of case in a route, the average duration and the number of steps involved in the route. Selecting a route highlights the route in the map.

6. Add notes to the project by selecting the notes icon (〇) and submit an analysis.

**Related information**

- Overview of the Analyst Workbench
- Analyze and get process insights
- Integration with Telecommunications orders

**Overview of the Analyst Workbench**

See your business process insights and workflows as visualizations from the Analyst Workbench.

**Projects landing page**

From the projects landing page, you can access generated projects, business process insights, and the Analyst Workbench.
The projects landing page shows project cards for projects that have been created by or shared with you for viewing. A project that has been created but not yet generated shows a warning icon next to its grayed out title, indicating that it is not available to view.

Project cards show overview details of mined projects. You can filter them by name or short description.

### Project card details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project name</td>
<td>The name of the project. You can select a project name to open the Analyst Workbench and access business findings.</td>
</tr>
<tr>
<td>Status</td>
<td>Designation of usage status of the project.</td>
</tr>
<tr>
<td>Short description of the project.</td>
<td>Brief description provided about the project.</td>
</tr>
<tr>
<td>Created by</td>
<td>The user who created the project.</td>
</tr>
<tr>
<td>Table</td>
<td>The selected table the project’s workflow model reports on.</td>
</tr>
<tr>
<td>Last mined</td>
<td>When the project’s data was last mined, in days.</td>
</tr>
<tr>
<td># of records</td>
<td>The number of records that apply to the selected data table and filter configurations for the project.</td>
</tr>
<tr>
<td>Process Variation</td>
<td>The percentage profile of uncertainty in process steps. Two examples: variations in schedule time</td>
</tr>
</tbody>
</table>
Project card details (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>taking longer than expected, or users taking multiple routes versus the ideal path to a goal. The percentage is calculated by the number of variants divided by the number of records.</td>
</tr>
<tr>
<td>Average Duration</td>
<td>The average time across all closed filtered records from the time of their being opened to being closed.</td>
</tr>
</tbody>
</table>

From a project card, relevant user roles can perform the following tasks by selecting a card's menu icon.

Project card menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Select Open to view a project. You can also select a project card title to open it.</td>
</tr>
<tr>
<td>Edit</td>
<td>Select to edit a project from the workflow record (Process Model Definition form).</td>
</tr>
<tr>
<td>Generate Model (Sample)</td>
<td>Generates a sample project using limited data instead of performing a full data extraction.</td>
</tr>
<tr>
<td>Generate Model (Full)</td>
<td>Generates a full data extraction for a project.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a project.</td>
</tr>
</tbody>
</table>

Process details page

See overview project metrics, access the Analyst Workbench with process map, and access the Summary and Insights tab to get interesting business insights.

From the process details page, you can:

- Select the Summary and Insights tab to see speed, quality, and cost insights impacting your process.
- Select the Analyst Workbench tab to access the project dashboard, where you can view the visualized process map for your project.
Note: To go back to the projects landing page where you can see all project cards, select the Process Models tab.

[1] Overview panel
The project's overview panel displays the following overview details and brief context menu.

<table>
<thead>
<tr>
<th>UI element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview details</td>
<td>Provides overview information about the project, including:</td>
</tr>
<tr>
<td></td>
<td>• Project name</td>
</tr>
<tr>
<td></td>
<td>• Table the data reports on</td>
</tr>
<tr>
<td></td>
<td>• Number of records included in the project’s data</td>
</tr>
<tr>
<td></td>
<td>• Number of routes represented within the records</td>
</tr>
<tr>
<td></td>
<td>• Average number of days it took records to close</td>
</tr>
<tr>
<td></td>
<td>• Standard deviation variation from route duration average value.</td>
</tr>
<tr>
<td></td>
<td>• Median duration value</td>
</tr>
<tr>
<td></td>
<td>• Number of records included from mining which had audit log entries</td>
</tr>
<tr>
<td>Menu</td>
<td>Access the menu to share the project or create an improvement initiative.</td>
</tr>
</tbody>
</table>
[2] Project panel
Within the project view, the project panel provides business insights, filter tools to refine the data view, and access to route details.

<table>
<thead>
<tr>
<th>UI element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary and Insights tab</td>
<td>See business goals, summary insights for your key performance indicators, transitions, and route variation.</td>
</tr>
<tr>
<td>Analyst Workbench tab</td>
<td>Select this tab to access the following:</td>
</tr>
<tr>
<td></td>
<td>• Filters tab — Create and delete filter sets, and set advanced filter conditions.</td>
</tr>
<tr>
<td></td>
<td>• Variation Analysis tab — View the routes distributed over the records in the data set.</td>
</tr>
</tbody>
</table>

[3] Process map
The process map shows the visualized model and routes, and provides the following tools for filtering and drilling into its view.

<table>
<thead>
<tr>
<th>UI element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metrics</td>
<td>The primary and secondary metrics to show on the process map.</td>
</tr>
<tr>
<td>Refine</td>
<td>Refine — Tune activities and connections on the map.</td>
</tr>
<tr>
<td></td>
<td>• Activities — Increase or reduce the detail view of activities on the process map.</td>
</tr>
<tr>
<td></td>
<td>• Connections — Increase or reduce the detail view of the connections between activities on the process map.</td>
</tr>
<tr>
<td>Show Records</td>
<td>Show Records — View the records for one or more selected routes.</td>
</tr>
<tr>
<td>Model Statistics</td>
<td>These statistics for the process model help provide perspective when comparing to the overall model statistics. Shows these statistics for the filtered records or selected variant route:</td>
</tr>
<tr>
<td></td>
<td>• Metric — Indicates total, project-specific, or difference in metric values between compared projects.</td>
</tr>
<tr>
<td></td>
<td>• Records — Number of filtered records that follow the selected route.</td>
</tr>
<tr>
<td>UI element</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Routes — The number of routes the filtered records followed.</td>
<td></td>
</tr>
<tr>
<td>Avg duration — The average number of days it took the filtered records or records in a selected route to close. This value compares with the average number of days duration across all records in the model.</td>
<td></td>
</tr>
<tr>
<td>Std Deviation — The variation from the route average duration value.</td>
<td></td>
</tr>
<tr>
<td>Med Duration — The middle duration value for routes.</td>
<td></td>
</tr>
</tbody>
</table>

**Bottleneck Analysis**
View the top transitions based on the metric filters you specify.

**Activity Legend**
The defined project activities that display on the process map with symbols connoting activity categories.

**Process map**
Interactive map from which you can view metrics for a process, add activity conditions to filter by, and perform other actions.

**Zoom**
Enlarge or shrink the view of the process map.

**[4] Notes, initiatives, and scheduled tasks panel**
The notes, initiatives, and scheduled tasks panel provides tools for creating and viewing notes, snapshots, and improvement initiatives. You can also see the status of mining tasks you've scheduled.

<table>
<thead>
<tr>
<th>UI element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>View the notes list, create a new note, and edit or delete a note.</td>
</tr>
<tr>
<td>🔄</td>
<td>View the initiatives list, create a new initiative, link to an existing initiative, or remove an initiative.</td>
</tr>
<tr>
<td>⌚</td>
<td>View the status of scheduled mining, filtering, and requested cluster analysis tasks.</td>
</tr>
</tbody>
</table>

**Summary and Insights dashboard**
View your performance goals and key performance indicators. Get highlights and insights in areas such as speed or bottlenecks impacting your process.
The Summary and Insights dashboard enables you to view opportunities for optimizing your process. Access the dashboard from a Process Optimization project. An administrator can also configure the dashboard from within Now® Experience UI Builder for viewing from a workspace or landing page. When the dashboard is configured for your business process and user needs, viewers can see quick snapshots from these dashboard sections:

- Goals and KPIs gives views of your specified goals and performance indicators.
- Insights provides process findings based on the rules you define.
- Bottleneck Analysis shows process transitions, enabling you to more easily see potential bottlenecks.
- Variation Analysis shows a complete list of route variations.
Map/Reduce - IT Operation processes (incidents)

Goals and KPIs
- Average time to resolve incidents
- % of incidents resolved on first assignment

Insights
- Solution rejection issue: Incident resolution rejected by customer one or more times
- Process step missed: Incidents go directly to Resolved and Closed

Bottleneck Analysis

Variation Analysis

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Related information**

**Integration with UI Builder**

**Analyst Workbench**

View the visualized process map with tools for managing visualizations and perform analysis tasks from a project's dashboard.

From the Analyst Workbench, you can access visualized process workflow data and tools for analyzing the data.

Access the workbench these ways:

- From the application navigator, navigate to **Analyst Workbench**.
- From a project's Process Model Definition form, select **Open Analyst Workbench**.

**Process Optimization architecture**

Understand the basic attributes of the Process Optimization architecture.

- The Process Optimization mining engine extracts data from the audit history based on the project settings. The data file is then uploaded to a centralized training server (**ServiceNow® Predictive Intelligence**) within the same
datacenter. The centralized training server enables advanced computing of new metrics. The centralized server supports more data for scalability without causing any performance load on your instance.

- When the Process Optimization model is ready, the training server sends the final model back to your instance and deletes all of your model data from the server. The data is transferred using secured and encrypted APIs.
- The most recent version of the model is then visualized through the Analyst Workbench UI on your instance.

**Related information**

**Predictive Intelligence**

**Set up Process Optimization**

An admin can set up Process Optimization so that analysts and managers can access the Analyst Workbench, and create and manage projects.

**Note:** Process Optimization is not supported for on-premise instances.

To set up Process Optimization:

- Activate the Process Optimization (com.sn_process_optimization) plugin.
- Install the ITSM Process Optimization content pack.
- Activate the Process Optimization Content Pack for CSM.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note: This step is applicable when integrating Process Optimization with the Customer Service Management application.

- Install the FSO Process Optimization Content Pack.

Note: This step is applicable when integrating Process Optimization with the Financial Services Operations applications.

- Install the Process Optimization for Telecommunication content pack.

Note: This step is applicable when integrating Process Optimization with the Order Management for Telecommunications and Media application.

- Assign roles to enable users to create projects from the application navigator, and view or manage projects from the Analyst Workbench.

Domain separation is supported
This application supports domain separation. For more information, see Domain separation and Process Optimization.

Activate the Process Optimization plugin
With subscription to Process Optimization, an admin can activate the com.sn_process_optimization plugin.

Before you begin
Role required: admin
To purchase a subscription, contact your ServiceNow account manager. When you purchase a subscription, certain plugins are activated automatically. If a paid plugin isn’t activated automatically, you can manually activate it from the All Applications list in your instance.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears:

```
Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
```

**Related information**

Activate a plugin

**Install ITSM Process Optimization Content Pack**

You can install the ITSM Process Optimization Content Pack application (com.sn_itsm_process_opt_cp) if you have the admin role.

**About this task**

Jumpstart Process Optimization with content packs

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the ITSM Process Optimization Content Pack application (com.sn_itsm_process_opt_cp) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install com.sn_itsm_process_opt_cp.

4. **Optional:** If demo data is available and you want to install it, click **Load demo data**.

   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.
Important: If you don't load the demo data during installation, it's unavailable to load later.

5. Click Install.

**Activate Process Optimization Content Pack for CSM**

You can activate the Process Optimization Content Pack for CSM plugin (com.snc.csm_process_optimization) if you have the admin role. The application installs related plugins if they are not already installed.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Process Optimization Content Pack for CSM plugin (com.snc.csm_process_optimization) using the filter criteria and search bar. You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Install FSO Process Optimization Content Pack**

You can install the FSO Process Optimization Content Pack application (sn_bom_po) if you have the admin role.

Before you begin
- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin
Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the FSO Process Optimization Content Pack application (sn_bom_po) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install FSO Process Optimization Content Pack.

4. Optional: If demo data is available and you want to install it, click Load demo data.

   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   Important: If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.

Install Process Optimization for Telecommunications

You can install the Process Optimization for Telecommunications application (sn_tm_processop) if you have the admin role.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin
Procedure

1. Navigate to **System Applications** > **All Available Applications** > **All**.

2. Find the Process Optimization for Telecommunications application (sn_tm_processop) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   You must install dependent plugins or applications before installing the Process Optimization for Telecommunications application.

4. **Optional:** If demo data is available and you want to install it, click **Load demo data**.

   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click **Install**.

Domain separation and Process Optimization

Domain separation is supported in Process Optimization. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**
• Business logic: Ensure that data goes into the proper domain for the application's service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Overview

Process Optimization provides a way to generate business process flows from monitoring audit trails and analyzing effectiveness, so you can quickly discover inefficiencies in your processes. This allows in-depth analysis of business processes for improving outcomes.

How domain separation works in Process Optimization

A process model definition (project) is configured to generate the process flow. All entities related to a process model definition, such as activity definitions, breakdown definitions, child table definitions, extract data logs, filter sets, notes, and CIM initiatives are created in the same domain as the process model definition.

When you create a new process model definition, you set up its domain in the current user’s domain. Since you place all related entities for a model definition so they reside in the same domain, when you then create a related entity for a domain separated process model definition, the entity is assigned to the model definition’s domain.

You can share a process model definition with its own domain or with global domain users.

A Process Optimization scheduled Job can include process model definitions within the corresponding job’s domain only.

A process model definition launched from Performance Analytics KPI is created in the current user’s domain.

A new CIM initiative added from a process optimization workspace is created in the process model definition’s domain.
Use cases

1. Process model definition created in the ACME domain: A user belonging to the ACME domain, its parent, or the global domain, can view the process model definition.

2. A Process Optimization scheduled job created in the ACME domain: A user belonging to the ACME domain, its parent, or the global domain, can view the Process Optimization scheduled job.

3. A Process Optimization scheduled job created in the ACME domain: A user can include only a process model definition belonging to the ACME domain.

Note: Cascade domain changes are not supported.

Related information

Domain separation for service providers

Process Optimization integrations

An admin can integrate Process Optimization with other ServiceNow applications such as Continual Improvement Management, Performance Analytics, ITSM, Customer Service Management, and Financial Services Operations.

Integration with Continual Improvement Management

Integrating with the ServiceNow® Continual Improvement Management application enables you to create a request once you've identified an improvement opportunity.

Integration with the ServiceNow® Continual Improvement Management (CIM) application enables you to request and view process improvement-related initiatives and add tasks to existing initiatives.


From Process Optimization: Share notes and snapshots as tasks to an existing CIM initiative. When you create an improvement initiative from Process Optimization, the request is associated with a note created within a Process Optimization project, and the Process Optimization KPI is added to the improvement initiative.

From Continual Improvement Management: Launch the Process Optimization Analyst Workbench from CIM.
Roles
Integration with Continual Improvement Management does not add any additional roles to the Process Optimization roles. To enable Continual Improvement Management features, you must add the agent_workspace_user role to the users who need this capability.

Related information
Example: Continual Improvement Management using Process Optimization
Continual Improvement Management
Request Continual Improvement Management

Launch Process Optimization from CIM
Launch process optimization from the CIM workbench to analyze the existing process and find new opportunities for improvement.

Before you begin
Role required: improvement_manager
Activate the Continual Improvement Management plugin (com.sn_cim) and the Process Optimization plugin (com.sn_process_optimization).

Procedure
Navigate to the Process Optimization workbench in any one of the following ways:

<table>
<thead>
<tr>
<th>From where</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continual Improvement Workbench</td>
<td>a. Navigate to Continual Improvement &gt; Workbench.</td>
</tr>
<tr>
<td></td>
<td>b. On the Continual Improvement Workbench page header, click Go to Process Optimization.</td>
</tr>
<tr>
<td></td>
<td>c. Analyze the existing process model or create a new process optimization project definition for assessment.</td>
</tr>
</tbody>
</table>

Note: For more information, refer to Define a workflow model.
### Steps

<table>
<thead>
<tr>
<th>From where</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Improvement Initiative | a. Navigate to Continual Improvement > All.  
               b. Open a record.  
               c. Click the Go to Process Optimization related links. |

### Integration with Benchmarks

Integrating with ITSM Benchmarks enables you to analyze processes relevant to your KPIs, and create and view associated incidents.

#### Related information

**Example: Benchmarks using Process Optimization Integration with ITSM**

**Launch Process Optimization from the Benchmarks dashboard**

Launch Process Optimization from the Benchmarks dashboard to analyze a process related to a low-performing KPI.

**Before you begin**

Role required: sn_bm_client.benchmark_recommendation_viewer

Activate the Process Optimization plugin (com.sn_process_optimization).

**Procedure**

1. Navigate to **Benchmarks > Dashboard**.

2. Click the Go to Process Optimization icon 🔄.

   **Note:** If the process model required in your KPI is not available, the dashboard creates it automatically.

### Integration with Performance Analytics (PA)

Using Process Optimization with ServiceNow® Performance Analytics enables you to perform data extraction from an indicator and analyze processes associated with the KPIs such as time to resolve.

The Process Optimization plugin (com.sn_process_optimization) provides an integration between the Process Optimization and Performance Analytics applications. Integration occurs automatically when you enable the Process Optimization plugin.
Optimization plugin. Afterwards, you can open the Process Optimization workbench from the Analytics Hub for a Performance Analytics indicator.

The Process Optimization plugin provides template configurations for indicator sources that use the following tables:

- Customer service case [sn_customerservice_case]
- Incident [incident]
- Problem [problem]
- Change [change]
- Requested Item [sc_req_item]

To support indicators based on other tables, create templates for those tables. For more information, see Configure a linked process template. Follow that procedure, but create PA-type templates instead of Linked process-type templates.

Process Optimization supports only automated indicators. From the Analytics Hub for a formula indicator, you can still open Process Optimization, but you must choose one of the contributing automated indicators in the formula.

⚠️ Important: Process Optimization does not support indicator sources that use database views. The application supports only tables.

Roles
Integrating with Performance Analytics does not add any roles to Process Optimization roles. To enable the Performance Analytics integration features, you must add the PA viewer role (pa_viewer) to the Process Optimization users who need this capability. Similarly, add the appropriate Process Optimization role to any Performance Analytics users who need Process Optimization capability.

Launch and use Process Optimization
Integrating with Performance Analytics adds the Extract Data option to the Analytics Hub menu. Users can:

- Launch Process Optimization from the Analytics Hub.
- Open Process Optimization for a specific indicator from KPI Details.
Schedule data extraction from a Performance Analytics indicator.

When you initiate data extraction for an indicator, you see the extraction progress. Once it completes, you can view the project from the Process Optimization Analyst Workbench. If you initiate an extraction at a later time on the same indicator settings, but on a different date, you will see a new PA project created in the Process Optimization > Projects > PA Projects list.

Related information
- Example: Performance Analytics using Process Optimization Analytics Hub for a specific indicator
- Exploring indicators with KPI Details

Integration with ITSM
The ITSM Process Optimization content pack provides preconfigured process optimization models and improvement initiatives for ITSM processes. The content pack enables best practice-based implementation and faster time to value.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

The ITSM Process Optimization content pack (com.sn_itsm_process_opt_cp) adds pre-built process optimization project model definitions for these ITSM processes:
- Incident Management
- Problem Management
- Change Management
- Request Management

The pack also contains the predefined Continual Improvement Management (CIM) initiative for incident and change processes. The improvement initiative and process optimization model are automatically linked.
To enable this content pack, go to the ServiceNow Store.

Related information

Install ITSM Process Optimization Content Pack

Cluster analysis configurations for ITSM work items

The Process Optimization application provides solution definitions for incidents, problems, change requests, and requested items. You can use these definitions to configure cluster analysis for those work items.

Important: This feature is available with the ServiceNow Store Process Optimization ITSM content pack v1.2. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Clustering solution definition configurations

A Process Optimization admin (sn_process_optimization_admin) can access the ITSM work item solution definition configurations by navigating to Predictive Intelligence > Clustering > Solution Definitions.

Note: By default, these solution definitions are configured as follows:

- The **Fields** field is configured to Short description.
- The **Minimum number of records per cluster** field is set to a value of 150.
- The **Word Corpus** field is configured to the corresponding word corpus record. For example, the Incident clustering definition is configured to the incident word corpus record. Each of the word corpus record gathers all description and short description data for the last 12 months.

The clustering solution definitions also contain the purity fields listed in the table below.

<table>
<thead>
<tr>
<th>Clustering Solution Definition</th>
<th>Purity Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>• Assignment Group</td>
</tr>
<tr>
<td></td>
<td>• Category</td>
</tr>
<tr>
<td></td>
<td>• Configuration item</td>
</tr>
<tr>
<td></td>
<td>• Service</td>
</tr>
</tbody>
</table>
For information on how to perform a cluster analysis from the Process Optimization application, see Perform a cluster analysis.

**Configure KPIs for ITSM work items in the Process Optimization dashboard**

Add the desired Key Performance Indicators (KPIs) to monitor the performance of the ITSM work items in the Process Optimization Summary and Insights dashboard. Remove the indicators that you no longer want to use.

**Before you begin**

**Important:** This feature is available with the ServiceNow Store Process Optimization ITSM content pack v1.2. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Role required: admin
**Procedure**

1. Enable the plugins for the ITSM work item applications for which you want to view the KPIs. The Incident Management plugin is enabled by default.

<table>
<thead>
<tr>
<th>To enable this application</th>
<th>Activate this plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem Management</strong></td>
<td>Performance Analytics - Content Pack - Problem Management (com.snc.pa.problem)</td>
</tr>
<tr>
<td><strong>Change Management</strong></td>
<td>Performance Analytics - Content Pack - Change Management (com.snc.pa.change)</td>
</tr>
<tr>
<td><strong>Request Management</strong></td>
<td>Performance Analytics - Content Pack - Request Management (com.snc.pa.request)</td>
</tr>
</tbody>
</table>

2. Add the desired indicator data source to the Summary and Insights dashboard. The KPIs listed in the table below are available by default.

<table>
<thead>
<tr>
<th>Work item</th>
<th>Key performance indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>• Average time to resolve incidents</td>
</tr>
<tr>
<td></td>
<td>• % of incidents resolved on first assignment</td>
</tr>
<tr>
<td>Problem</td>
<td>• Average close time of problems</td>
</tr>
<tr>
<td></td>
<td>• % of problems closed on first assignment</td>
</tr>
<tr>
<td>Change request</td>
<td>• Average close time of changes</td>
</tr>
<tr>
<td></td>
<td>• % of new emergency changes</td>
</tr>
<tr>
<td>Requested item</td>
<td>• Average close time of requested items</td>
</tr>
<tr>
<td></td>
<td>• % of rejected requested items</td>
</tr>
</tbody>
</table>

**Related information**

Summary and Insights dashboard
Configure insights for ITSM work items in the Process Optimization dashboard

Configure rule definitions for incidents, problems, change requests, or request items to discover insights in the Summary and Insights dashboard.

Before you begin

**Important:** This feature is available with the ServiceNow Store Process Optimization ITSM content pack v1.2. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Role required: sn_process_optimization_power_user

About this task

Procedure

1. Navigate to **Process Optimization > Process Configurations**.
2. Configure the desired insight rule definitions. The insights filters listed in the table below are available by default.

<table>
<thead>
<tr>
<th>Work item</th>
<th>Insights filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>• Multihop issue</td>
</tr>
<tr>
<td></td>
<td>• Solution rejection issue</td>
</tr>
<tr>
<td></td>
<td>• Misuse of On Hold state</td>
</tr>
<tr>
<td></td>
<td>• SLA missed issues</td>
</tr>
<tr>
<td>Problem</td>
<td>• Problem was canceled</td>
</tr>
<tr>
<td></td>
<td>• Problem risk was accepted</td>
</tr>
<tr>
<td></td>
<td>• Resolved problem was re-analyzed</td>
</tr>
<tr>
<td></td>
<td>• Problem fix not completed</td>
</tr>
<tr>
<td></td>
<td>• Problem reopened</td>
</tr>
<tr>
<td>Change requests</td>
<td>• Model is changed in the process</td>
</tr>
<tr>
<td></td>
<td>• Pre-approved change requests</td>
</tr>
<tr>
<td></td>
<td>• Failed change requests</td>
</tr>
</tbody>
</table>
When the finding rules are updated, you can view that in the Insights section in the dashboard.

3. On the Summary and Insights dashboard, for the selected insight:
   - To perform process analysis, click **Process Analysis**. You can view the Process Optimization map with the applied filters.
   - To perform cluster analysis, click **Cluster Analysis**. Click **View cluster** to view the results. For more information, see **View a cluster analysis**.

**Integration with Customer Service Management**

Integrating the Process Optimization application with the Customer Service Management application enables you to analyze processes relevant to your KPIs, and identify bottlenecks associated with customer service cases.

For more information about enabling the Process Optimization Content Pack for CSM, see **Activate Process Optimization Content Pack for CSM**.

**End user and roles**

If you have the required roles, you can use Analyst Workbench to access the visualized process workflow data, and tools for analyzing the data related to customer service cases. For more information, see **Overview of the Analyst Workbench**.

The following combinations of roles are required for using the Process Optimization application with Customer Service Management.

<table>
<thead>
<tr>
<th>Process Optimization role</th>
<th>Customer Service Management role</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_process_optimization_admin</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>sn_process_optimization_power_user</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>sn_process_optimization_analyst</td>
<td>sn_customer_service_agent</td>
</tr>
</tbody>
</table>
Optimization project for customer service cases

The Process Optimization Content Pack for CSM (com.snc.csm_process_optimization) adds a pre-built project that includes a predefined Customer Service Cases process model definition for customer service cases. By default, the Customer Service Cases project filters customer service cases for the last two quarters. You can also configure a new process project based on the pre-built project. For more information, see Configure a project.

The Customer Service Cases process model definition includes default activity definitions and breakdown definitions for customer service cases that you can use as they are or modify them for a custom configuration.

- Use activity definitions to understand state transitions such as cases transitioning from the work in progress state to the solution proposed state and analyze the linked processes such as Problem (PRB) records.

- Use breakdown definitions to filter records and analyze a process map by categories. For example, you can filter the customer service case data by different channels, products, assignment groups, and locations.

Continual Improvement Management initiative for customer service cases

If the Continual Improvement Management (CIM) application is enabled, you can also use the CIM project from the Analyst Workbench to track the progress of improvement initiatives for customer service cases. The improvement initiative and process optimization model are automatically linked. For more information, see Integration with Continual Improvement Management.

Performance Analytics for customer service cases

If the Performance Analytics application is enabled, you can also use the available template configurations to open the Process Optimization application from a Performance Analytics (PA) indicator based on the customer service case data. For more information, see Integration with Performance Analytics.

Related information

Example: Process Optimization for CSM

Integration with Financial Services Operations

Integrating the Process Optimization application with Financial Services Operations (FSO) enables you to analyze processes relevant to your KPIs, and identify bottlenecks associated with FSO cases.
For more information about enabling the FSO Process Optimization Content Pack, see Install FSO Process Optimization Content Pack.

End user and roles

If you have the required roles, you can use Analyst Workbench to access the visualized process workflow data, and tools for analyzing the data related to FSO cases. For more information, see Overview of the Analyst Workbench.

Based on the Financial Services Operations application for which you’re using the Process Optimization application, you need the following roles:

- For Financial Services Payment Operations: sn_bom_payment.payments_manager and sn_process_optimization_analyst
- For Financial Services Business Loan Operations: sn_bom_loan_b2b.manager and sn_process_optimization_analyst
- For Financial Services Personal Loan Operations: sn_bom_loan.b2c_manager and sn_process_optimization_analyst
- For Financial Services Complaint Management: sn_bom_compl.manager and sn_process_optimization_analyst

Optimization projects for Financial Services Operations

The FSO Process Optimization Content Pack adds pre-built process optimization projects for these Financial Services Operations applications:

- Financial Services Payment Operations
- Financial Services Business Loan Operations
- Financial Services Personal Loan Operations
- Financial Services Complaint Management

You can also configure a new process project based on the pre-built project. For more information, see Configure a project.

Related information

Example: Process Optimization for Financial Services Operations

Integration with Telecommunications orders

Integrating the Process Optimization application with Order Management for Telecommunications and Media enables you to analyze processes relevant to your KPIs, and identify bottlenecks associated with Telecommunications orders.

For information about enabling the Process Optimization for Telecommunications, see Install Telecommunications Process Optimization Content Pack.
End user and roles

If you have the required roles, you can use Analyst Workbench to access the visualized process workflow data, and tools for analyzing the data related to telecommunications orders. For more information, see Overview of the Analyst Workbench.

Based on the Telecommunications application that you’re using the Process Optimization application for, you need the following roles:

- For Telecommunications Product Orders: sn_process_optimization_admin, sn_process_optimization_analyst, and sn_process_optimization_power_user
- For Telecommunications Service Orders: sn_process_optimization_admin, sn_process_optimization_analyst, and sn_process_optimization_power_user
- For Telecommunications Resource Orders: sn_process_optimization_admin, sn_process_optimization_analyst, and sn_process_optimization_power_user
- For Telecommunications Order Tasks: sn_process_optimization_admin, sn_process_optimization_analyst, and sn_process_optimization_power_user

Optimization projects for Telecommunications application

The content pack adds pre-built process optimization project model definitions for these Order Management for Telecommunications and Media application entities:

- Product Orders
- Service Orders
- Resource Orders
- Order Tasks

Note: To learn more about Order Management for Telecommunications and Media application entities, see Order Management data model for Order Management for Telecommunications and Media.

You can also configure a new process project that is based on a pre-built project. For more information, see Configure a project.

Related information

Example: Process Optimization for Telecommunications

Integration with UI Builder

Integration with UI Builder enables an administrator to configure Now Experience so that users can view quick business process insights, project notes, and improvement initiatives.
An admin can configure the Summary and Insights dashboard using the UI Builder. Viewers of the Summary and Insights dashboard in UI Builder can also see project notes and improvement initiatives from Now® Experience workspaces, dashboards, or landing pages. Users can’t change or remove notes or initiatives.

Related information
- Configure insight rule definitions
- Creating custom landing pages for workspaces

Components installed with Process Optimization

Several types of components are installed with activation of the com.sn_process_optimization plugin, including tables, user roles, and scheduled jobs.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Optimization Administrator</td>
<td>• Can access all projects and manage all project settings and configurations.</td>
<td>sn_process_optimization_power_user</td>
</tr>
<tr>
<td>[sn_process_optimization_admin]</td>
<td>• Can schedule background and Process Optimization jobs.</td>
<td></td>
</tr>
<tr>
<td>Process Optimization Power User</td>
<td>• Can access all projects and manage all project settings and configurations.</td>
<td>sn_process_optimization_analyst</td>
</tr>
<tr>
<td>[sn_process_optimization_power_user]</td>
<td>• Can create and share projects.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can view, edit, share, and delete projects created by other users and shared with them.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can schedule Process Optimization jobs.</td>
<td></td>
</tr>
</tbody>
</table>
### Role title [name]

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Optimization Analyst</td>
<td>• Can create and share projects.</td>
<td>agent_workspace_user, sn_process_optimization_viewer</td>
</tr>
<tr>
<td>[sn_process_optimization_analyst]</td>
<td>• Can view, edit, share, and delete projects created by other users and shared with them.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Cannot access all projects.</td>
<td></td>
</tr>
<tr>
<td>Process Optimization Viewer</td>
<td>• Can view projects, and create notes and improvement initiatives in projects created by other users and shared with them.</td>
<td></td>
</tr>
<tr>
<td>[sn_process_optimization_viewer]</td>
<td>• Cannot create, edit, or delete projects or project settings.</td>
<td></td>
</tr>
</tbody>
</table>

### Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProminVersionCleanup</td>
<td>Deletes older backup versions.</td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Optimization Definition [ml_capability_definition_promin]</td>
<td>A discriminator to identify process mining solutions.</td>
</tr>
<tr>
<td>Activity Definition [promin_activity_def]</td>
<td>Stores the activities depicting the audit log changes to a field on the process graph.</td>
</tr>
<tr>
<td>Process Connection [promin_arc]</td>
<td>Stores connections statistics for a model.</td>
</tr>
<tr>
<td>Attachment [promin_attachment]</td>
<td>Stores the XES document for a project version.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Breakdown Definition</td>
<td>Stores the breakdowns by which the process map gets categorised.</td>
</tr>
<tr>
<td>[promin_breakdown_field]</td>
<td></td>
</tr>
<tr>
<td>Breakdown Stats</td>
<td>Stores breakdown statistics for a model.</td>
</tr>
<tr>
<td>[promin_breakdown_stats]</td>
<td></td>
</tr>
<tr>
<td>Filter set</td>
<td>Stores multiple set of filters applied on a model definition.</td>
</tr>
<tr>
<td>[promin_filter_set]</td>
<td></td>
</tr>
<tr>
<td>Extract Data Log</td>
<td>Stores the extracted audit log data entries generated when mining a project version.</td>
</tr>
<tr>
<td>[promin_log]</td>
<td></td>
</tr>
<tr>
<td>[promin_job]</td>
<td></td>
</tr>
<tr>
<td>Job Process Model Definition</td>
<td>Stores information about the model definitions attached to a job.</td>
</tr>
<tr>
<td>[promin_job_m2m_model_def]</td>
<td></td>
</tr>
<tr>
<td>Process Model</td>
<td>Stores multiple model statistics for a project version.</td>
</tr>
<tr>
<td>[promin_model]</td>
<td></td>
</tr>
<tr>
<td>Child Table Definition</td>
<td>Stores related child tables for which the activity can be tracked in the process map.</td>
</tr>
<tr>
<td>[promin_model_child_def]</td>
<td></td>
</tr>
<tr>
<td>Process Model Definition</td>
<td>Stores the workflow model definition records.</td>
</tr>
<tr>
<td>[promin_model_def]</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>The version of a mined project.</td>
</tr>
<tr>
<td>[promin_model_def_version]</td>
<td></td>
</tr>
<tr>
<td>Process Node</td>
<td>Stores activities for a model definition.</td>
</tr>
<tr>
<td>[promin_node]</td>
<td></td>
</tr>
<tr>
<td>Process Node Statistics</td>
<td>Stores statistics for an activity.</td>
</tr>
<tr>
<td>[promin_node_stats]</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>Stores the note records.</td>
</tr>
<tr>
<td>[promin_note]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Permission [promin_permission]</td>
<td>Stores the users/groups for whom the model definition is shared.</td>
</tr>
<tr>
<td>Process Route [promin_route]</td>
<td>Stores route statistics for a specific model.</td>
</tr>
<tr>
<td>Case Record [promin_case_record]</td>
<td>Stores record details from an activity, connection, or route.</td>
</tr>
<tr>
<td>Process Optimization Mining Tracker [promin_ua_mining_tracker]</td>
<td>Stores information regarding the previous mines.</td>
</tr>
<tr>
<td>Linked Process [promin_linked_process]</td>
<td>Stores the linked process model definitions for the configured activities.</td>
</tr>
<tr>
<td>Filter Set Condition [promin_conditions]</td>
<td>Stores the filter conditions corresponding to a model.</td>
</tr>
<tr>
<td>Process Scheduled Task [promin_scheduled_task]</td>
<td>Stores requested cluster analysis, data mining, and process optimization tasks.</td>
</tr>
<tr>
<td>Process Configuration [promin_process_def]</td>
<td>Stores process configuration defaults.</td>
</tr>
<tr>
<td>Finding Definition [promin_finding_def]</td>
<td>Stores finding definition records.</td>
</tr>
<tr>
<td>Finding [promin_finding]</td>
<td>Stores findings discovered for projects.</td>
</tr>
</tbody>
</table>

**Access control**

When generating a model or sharing a project, Process Optimization honors the access control rules (ACLs) for the table.
When generating a process model, Process Optimization honors the ACLs on the table that a project reports on, and ignores ACLs on the audit table. Users with the promin_viewer role have read-only access.

When sharing a project:

• All visible data in the Analyst Workbench is visible to any user who has access to the project.
• All mining operations are performed as per the project creator's [sys_created_by] access. This includes mining performed by roles with higher permission levels, which can result in less data being mined.

Summary and Insights dashboard:

• KPIs are visible to any user who has the required permission to access related KPIs.
• Insights are visible to any user who has access to the project.

**Process Optimization data cleanup**

The Process Optimization properties page provides configuration options for Process Optimization.

**Data cleanup properties**

Set properties that determine how long Performance Analytics projects are maintained before being deleted by the scheduled cleanup job.

These properties are available for Process Optimization.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the number of days to persist PA Projects (Process Model Definition) from the last updated date promin.persist.pa_model</td>
<td>Set the number of days that Performance Analytics (PA) Projects (Process Model Definition) will be kept after the last date it was updated.</td>
</tr>
</tbody>
</table>
| • Type: integer  
• Default value: 30 (days)  
• Location: Process Optimization System Properties | |

**Related information**

Example: Performance Analytics using Process Optimization
**Schedule job for version cleanup**

Schedule a job to delete older backup versions and clean up cluster analysis records by executing the scheduled script `ProminVersionCleanup`.

**Before you begin**

Role required: admin

**About this task**

When regenerating projects, the `ProminVersionCleanup` job deletes obsolete, cached statistics. The older statistics move into a previous version, while the new version is created for the updated model.

When regenerating or deleting projects, this job cleans records created during cluster analyses.

**Procedure**

1. Navigate to **Process Optimization > Background Jobs**.
2. Select the scheduled job `ProminVersionCleanup`.
3. Check or set the following.
   
   a. Enable the **Active** check box.
   b. Check if the Run field is **Daily**.
   c. Set the Time in hours.

4. Select **Execute Now**.

**Results**

Backup version and cluster record cleanup execute daily.

**Use Process Optimization**

Choose a process to optimize, generate process data, then get visualized, actionable insights.

As you seek to improve your business processes in areas such as eliminating redundancies, forecasting changes, and streamlining workflows, Process Optimization helps you achieve those goals. Process Optimization helps you gain end-to-end visibility, reduce risk, stay market compliant, and more.

Plan these steps to maximize process optimization efforts:
• **Identify**: Identify a problematic process area which needs optimizing.

• **Visualize**: Identify key elements which should be part the process. Understand the goal, the start and end, the activities, and the users that should be part of the process.

• **Analyze**: Analyze areas for optimization to determine where and why they don't meet desired goals.

• **Optimize**: Remove steps that aren't essential to your process.

• **Monitor**: Keep monitoring process performance, and refine it until areas meet desired goals.

**Configure a project**

Begin choosing a process to optimize by configuring a project.

You can start configuring a new project from the application navigator or from the projects landing page.

⚠️ **Note**: A guided setup is also available, accessible from the application navigator.

**Related information**

Projects landing page

**Define a workflow model and configure an activity**

Configure source type and filter criteria for the business process you want to analyze. Then report on the steps which occur within your process.

**Define a workflow model**

Configure source type and filter criteria for the business process you want to analyze.

**Before you begin**

• **Role required**: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

• **Audit Log** must be enabled for the table you select to report on for a project.

**About this task**

Configure the workflow model which will display visualized, interactive routes of flows of process information.
**Procedure**

1. Navigate to **Process Optimization > Create New Project**.
2. From the Process Model Definition form, enter values into the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the workflow model.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter a short description for the project.</td>
</tr>
<tr>
<td>Goal</td>
<td>Select a predefined business goal.</td>
</tr>
<tr>
<td>Template</td>
<td>Check to create a default Performance Analytics (PA) or Linked Process template.</td>
</tr>
<tr>
<td>Template Type</td>
<td>Select whether to create one of these templates:</td>
</tr>
<tr>
<td></td>
<td>• Performance Analytics (PA)</td>
</tr>
<tr>
<td></td>
<td>• Linked Process</td>
</tr>
<tr>
<td></td>
<td>This field is available if <strong>Default Model</strong> is checked.</td>
</tr>
<tr>
<td>Status</td>
<td>Optional field you can set to internally designate a usage status of the workflow project model. Select from the list:</td>
</tr>
<tr>
<td></td>
<td>• New - Default status for newly created projects.</td>
</tr>
<tr>
<td></td>
<td>• Draft - Work on the project is in progress by an analyst.</td>
</tr>
<tr>
<td></td>
<td>• Published - The project is verified and in a ready state for generating or viewing.</td>
</tr>
<tr>
<td></td>
<td>• Retired - Communicates that the project is obsolete.</td>
</tr>
<tr>
<td>Source Type</td>
<td>Select the applicable information source to report on:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Data Source</strong> - Also called a report source, a data source is a table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table</strong> - The raw data from a table with no filters applied. Only tables with audit history enabled show in the table list.</td>
</tr>
</tbody>
</table>

**Note:** The table can’t be changed after defining the workflow model
### Field | Description
--- | ---
Filter | Select and add conditions to filter on. This field is available when creating non-template models. **Note:** Use Process Optimization to analyze completed, non-active workflow items. Include the date-relevant 'Closed' field as one of the conditions. Filter project data on the last 30 days, or a maximum of 90 days for optimal extraction performance time.

Include approvals | Check the box to show approval steps as activities on the process map.

Watch list | Allows you to subscribe users to notification of the status of generated project. Expand the watch list by selecting the lock icon to select users.

3. Select **Submit**.  
The workflow record is created.

**What to do next**  
Configure one or more activities.

**Related information**  
Integration with Performance Analytics (PA)  
Link processes  
Report sources

**Configure an activity**  
Report on steps that occur within your business process.

**Before you begin**  
- Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin  
- Define a workflow model

**Note:** You can configure a maximum of 10 activities. Process Optimization generates a limit of 5000 elements per configured activity.
About this task
Process Optimization gathers audit log field data for activities you define. Configure at least one activity to extract for and display in your process map records that start, end, or pass through a specific activity.

Procedure

1. From the Activity Definitions tab of your project record, add one or more activities to report on in the process map.

   a. Select New to open a new Activity Definition record.

   b. Select for each activity:

<table>
<thead>
<tr>
<th>Field</th>
<th>Select the field you want to report on in the process visualization.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group activities</td>
<td>If you select to track a field, the process map reflects the group of changes for the activity as one change item. For example, suppose you configure Assignment group to report on and select to track changes for it.</td>
</tr>
<tr>
<td></td>
<td>• Changes to assignment group occur and list in the audit log as: Group A &gt; Group B &gt; Group C.</td>
</tr>
<tr>
<td></td>
<td>• Result: The data in the process map reflects as one change: ‘Assignment group changed’.</td>
</tr>
<tr>
<td></td>
<td>If this option is not checked, the process map reflects records of each instance of change individually. Example: You configure Assignment group to report on, but don’t select to track changes for it.</td>
</tr>
<tr>
<td></td>
<td>• Changes to assignment group occur and list in the audit log as: Group A &gt; Group B &gt; Group C.</td>
</tr>
<tr>
<td></td>
<td>• Result: The process map reflects each individual change made, continuing to reflect the changes as is standard from the audit log: ‘Change: Group A &gt; Change: Group B &gt; Change: Group C’.</td>
</tr>
</tbody>
</table>
Changes are grouped

Changes shown as standard

Grouped activities name | Auto-generated name for grouped activities, or you can enter a different name for changes to the field that will reflect in the visualization.

2. Select Submit.
What to do next
Configure a breakdown or generate a process model.

Configure a breakdown
Add a breakdown to filter records and analyze a process map by categories.

Before you begin
• Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin
• Define a workflow model and configure an activity

Note: You can configure a maximum of 10 breakdowns. Process Optimization generates a limit of 5000 elements per breakdown.

Procedure
1. Navigate to Process Optimization > All Projects and select your project record.
2. From the Breakdown Definitions tab, add one or more breakdowns to filter the process map by.
   a. Select New to open a new Breakdown Definition record.
   b. Select from the list the field you want to create a breakdown on. You can dot-walk up to three levels to select a field from an extended table to create a breakdown on.
3. Optional: Check Add Filter Condition and further choose conditions for filtering the breakdown.
4. Select Submit.

What to do next
Define a child table or generate the process model.

Define a child or related table
Add a child or related table to track an activity from a related process.

Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

About this task
Often the start and end of a full workflow occurs outside the life cycle of your business process. When it's helpful to analyze these external events, you can add
another table for tracking other events relevant to your process. For example, if you define the Incident Task [incident_task] table, when a record from the table is created, it shows as an 'Incident Task created' activity on the process map. Only 'created' or 'closed' events show as activities in the process graph.

Note: External events from a defined child table do not show as condition options in the Transitions or condition filters.

Procedure
1. Navigate to Process Optimization > All Projects and select your project record.
2. From the Child Table Definitions tab, add one or more tables to report on in the process map.
   a. Select New to open a new Child Table Definition record.
   b. From the child table list, select the table you want to report on.
3. Select Submit.

What to do next
Generate the process model.

Generate a model
Once you’ve configured the data you want visualized, you can begin automated generating of the process model and statistics based on your configurations.

About this task
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

Note:
- Process Optimization extracts a maximum limit of 300,000 records. If that limit is reached with the table you’ve selected, add additional filters to refine the data set.
- Optimizing a project may take significant time. While extraction is in progress for a project, you cannot explore its process map.

During a full or preview extraction, Process Optimization analyzes the audit log to then generate a model.
Procedure

1. From the application navigator, navigate to Process Optimization > All Projects and select your project record.

2. From the Process Model Definition record for the project, select from the Related Links list or from the record's form menu:
   - Generate model (Full) to generate the model for the full project.
   - Generate model (Sample) to generate a limited model that mines up to 1,800 records, rather than extracting all records applicable to a project.

   **Note:** Generating a sample enables an analyst to validate project configuration settings before performing a full data extraction of the project.

3. Select OK to confirm you want to begin generating the model.

4. Optional: From the Watch list, select Add me to receive an email notifying you of the final extraction status.
   If you add another user to the watch list, they don’t automatically have access to view the generated project. The user receives an email when the project fails or completes generating. To share a project with a group or user, see Share a Process Optimization project.
   The progress window opens showing audit log analysis and model generation progress.

5. Choose an option:
   - If you want to receive email notification of the final extraction status, select Notify me.
   - If you want to stay in the application, once the extraction completes successfully, select Open Analyst Workbench to see the visualized project immediately.

Results

If the extraction completes successfully, the Process Model Definition record shows the mining state as Available.

What to do next

View the visualized process from the Analyst Workbench.

Cancel a mining job

An analyst, power user, or admin can cancel a mining job currently in process.
Procedure

Select **Cancel** during mining of a project to cancel the process.

It can take several minutes before the cancel process completes. The unit of work in progress at the time of canceling mining must complete before cancellation occurs.

The mining state on the Process Model Definition form shows as **Cancelled**.

Mine states

When attempting to mine a project, the project workflow record shows one of these states.

<table>
<thead>
<tr>
<th>Workflow record mine states</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>State</strong></td>
</tr>
<tr>
<td>New</td>
</tr>
<tr>
<td>Mining Data</td>
</tr>
<tr>
<td>Cancelling</td>
</tr>
<tr>
<td>Cancelled</td>
</tr>
<tr>
<td>Available</td>
</tr>
<tr>
<td>Error</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Scheduled</td>
</tr>
</tbody>
</table>

**Note:** If there are several projects scheduled for mining within a job, the projects execute sequentially. For example, a job which has Projects 1 and 2 scheduled within it will mine Project 1 first, then begin mining Project 2 after mining of Project 1 completes.
Schedule a Process Optimization job

Schedule a Process Optimization job to mine one or more projects later.

Before you begin
Role required: sn_process_optimization_power_user or sn_process_optimization_admin

Note: You can create only one scheduled job for each project. You can, however, associate multiple projects to a job. If there are several projects scheduled for mining within a job, the projects execute sequentially. For example, a job which has Projects 1 and 2 scheduled within it will mine Project 1 first. Then it begins mining Project 2 after mining of Project 1 completes.

Procedure

1. Navigate to Process Optimization > Scheduled Jobs > Create New Job.
2. On the Scheduled Process Optimization Job form, populate the applicable fields for the job you want to create, then select Submit. See descriptions of fields on a scheduled job record.
3. In the Process Model Definitions section, select Edit.
4. From the Edit Members form, select the projects in the Collection column that you want to mine and move them to the Process Model Definitions List column.
5. Select Save.

The scheduled job runs on the frequency that you've configured.

What to do next

• View a successfully generated project from the Analyst Workbench.
• Navigate to Process Optimization > Scheduled Jobs > All Jobs to view scheduled project mining jobs.

Edit a project

Edit a project from the Process Model Definition form to generate an updated process map.

Before you begin

• Role required: sn_process_optimization_power_user, or sn_process_optimization_admin
• The sn_process_optimization_analyst role can edit a project if they created it.
Procedure
1. Navigate to Process Optimization > All Projects.
2. From the Process Model Definitions list, select the number of the project to edit.
3. Enter changes in the desired fields and select Update. The table can't be changed after defining an activity, breakdown, or child table.

What to do next
Perform a data extraction on the updated project to view it in the Analyst Workbench, and apply relevant filters.

Delete a project
Delete a project from a workflow definition record or from a project card in the Analyst Workbench.

Role required:
- Role required: sn_process_optimization_power_user, or sn_process_optimization_admin
- The sn_process_optimization_analyst role can delete a project if they created it.

Delete a project from the application navigator
Delete a configured project from the platform navigator.

From the Process Model Definitions list, you can delete a project one of these ways.

- From the projects list:
  1. Check the box next to the project you want to delete.
  2. From the row actions list, select Delete.
  3. Select Delete once more to confirm.
- From the workflow record:
  1. Select the name or number of the project to open its workflow record.
  2. In the record, select Delete.
  3. Select Delete once more to confirm.
Delete a project from Analyst Workbench

Quickly delete a configured project from within Analyst Workbench.

From the Analyst Workbench, select a project card's menu icon and select **Delete**.

Link processes

Connect a related process to get a fuller picture of what impacts your main business process.

Sometimes a single process doesn't show the full picture of what's impacting your business. Seeing a related process or subprocess can help you analyze efficiency better. In these cases, you can link and mine a subprocess alongside your main process.

> **Note:** Process Optimization enables linking related processes only through one level. Thus you can't link a second process to an already linked process.

Configure a linked process template

Create a linked process template to configure connecting processes.

**Before you begin**

Configuring a template enables the extraction of specified table data for a linked process.

Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

**Note:** A process can only be linked using a table source. Process Optimization stores a maximum of one linked process template per table. For example, Process Optimization stores one Linked Process template based on the Problem [problem] table, as well as one Performance Analytics (PA) template based on the Problem table.

**Procedure**

1. Navigate to **Process Optimization > Create New Template**.
2. Enter a name for the template.
3. Check **Template**.
4. From the **Template Type** field, select **Linked Process**.
   
   If you are creating a template for a table that underlays Performance Analytics indicators, select **PA**. For more information, see Integration with Performance Analytics (PA).
5. From the **Table** field, select the table to mine as a subprocess.
6. Configure any desired **Activity Definitions** and **Breakdown Definitions**.
7. Select **Submit**.
   The Linked Process template creates for the selected table.

**What to do next**

**Link a process to a project**

Mine a subprocess by linking it with a main process.

**Before you begin**

- Create a linked process template.
- Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

**Procedure**

1. Navigate to **Process Optimization > All Projects**.
2. Select the record of the project you want to link another process with.
3. From the **Activity Definitions** tab, select the activity for which you want to generate the subprocess model.
   - A process can only be linked on a grouped activity.
   - Linking is only available from fields that exist on related or extended tables.
4. Check the **Link Process** box.
   In the **Reference table** field, the table to be linked and mined relevant to the activity is automatically selected in the field.

5. **Generate the full model.**
   The main and linked process model maps generate.
What to do next
Analyze the connected process. See Exploring a linked process.

Exploring a linked process
After creating a template and linking a connected process to a main model, view and perform tasks from the linked model.

Note: A linked process model cannot be shared with another user.

Access a linked process one of these ways:
• From the Scheduled tasks pane, select View result for the linked process you want to view.

• Select an activity from the process map that features a link icon (🔗). In the metrics box, select Show [table] process, for example Show Change Request process, to open the linked process in a new tab.

You can have more than one linked process open at the same time.
When viewing a linked process, you can:

- View statistics and associated breakdown models
- Independently filter the linked model

**Note:** Filters from the main process initially apply when opening a linked process. Adjusted filters can't be saved in a linked process model.

- View and add notes, and take snapshots
- View and add improvement initiatives

### Opening a linked process in comparison view

Linked processes can also be opened from the model comparison view. When comparing processes, you can open a linked process in separate tabs for each model of the main map. Opening a linked process from the comparison view shows the linked process's map. The Filters tab shows statistics based on the filters you set, and the Variation Analysis tab shows the route selected from either model of the main map.

### Analyze and get process insights

Visualize and analyze your business flows from automated process data, and act on those insights.

### Summary and Insights dashboard

In addition to having a visualization of your process, you can also see interesting facts which can help improve it. Process Optimization uses rules and cluster analysis of connections, activities, and routes to deliver these calculated insights to you. From the Summary and Insights dashboard, you can access statistically
relevant findings on such metrics as speed, quality, and cost impacts to your business.

**Analyst Workbench**
To better analyze your business process, refine the process map generated from your project data. You can refine a map from the Analyst Workbench. From the workbench, you can further analyze two process models side by side, collaborate on improvement initiatives, and view metrics.

⚠️ **Note:** The Analyst Workbench can be accessed only after a project has been configured and its data generated into a process map.

From either the dashboard or workbench, you can perform such tasks as cluster and process analyses.

**Related information**
- Configure a project to optimize

**View business insights**
View key information about your business process from the Summary and Insights dashboard. See goals and performance indicators, and get insights on bottlenecks, route variation, and more.

The Summary and Insights dashboard shows opportunities for optimizing your process. You can see the following snapshots.
- met or unmet goals and KPIs
- findings based on the rules you define
- process transitions that enable you to see potential bottlenecks
- route variations
Goals and KPIs

Note: The Goals and KPIs section is available with the integration of Performance Analytics.

The Goals and KPIs section is configured from the Now® Experience UI Builder. For more information, see Configure a widget for KPI Details.

From the Goals and KPIs section, choose a visualization to analyze indicator details more closely from the KPI Details view. KPI Details shows you trends, predictions, breakdowns, and associated records for a specific indicator. The KPI Details page leads you to deeper information behind your key performance indicators.
Insights
From the Insights section, you can see quick insights on speed, quality, and other factors impacting your business.

This section delivers insights like the following.

- factors contributing to the cost and time overruns of a case or incident.
- how much time is spent on waste drivers such as where a workflow may have encountered rework or a backflow of the process
- reductions in quality due to unplanned service interruptions
- where compliance violations are occurring
- processes that can benefit from automation initiatives

The rules that you configure discover business findings. For example, you might configure rules which show:

- records that went directly into a Closed or Resolved state
- reworked records with solutions that customers didn’t accept, or whose states changed from 'Resolved' to 'Work in progress' status.
- wrong or many group assignments

Select a combination of these insight categories to show on the dashboard.

- Speed
- Quality
- Cost
- Automation
- Compliance

From each insight, you can request or view a completed cluster or process analysis, then view from the workbench the completed cluster or model.
To generate a process model for a selected insight, select **Process analysis**. When the model becomes available to view, select **View Process analysis**.

**Bottleneck Analysis**

From the Bottleneck Analysis section, you can see identified bottleneck sources discovered in your process records.

Select a breakdown to refine the routes list, then sort the list by:

- Unique Occurrences
- Total Duration
- Avg Duration
- Max Repeat Occurrences
- Total Occurrences
Bottleneck Analysis - Breakdowns

Select View in Workbench to view the model for the selected transition.

Variation Analysis

All routes for a process show in the Variation Analysis section. You can sort the order for routes by highlights, number of records, average duration, or steps.

Select View in Workbench to view the model for an individual route.

Related information

Summary and Insights dashboard
KPI Details
Configure insight rule definitions

Configure rule definitions to deliver discovered insights to your Summary and Insights dashboard.

Before you begin

A rule definition creates the business rule that searches for insights relevant to a process that is based on a specified table. Once you configure a definition, any relevant records show as discoveries in the Insights section of the Summary and Insights dashboard.

Tip:

- You can create one configuration per table for each project based on a process.
- Role required:
  - The sn_process_optimization_admin and sn_process_optimization_power_user roles can create a finding definition for a project, but cannot create a definition.
  - The sn_process_optimization_analyst role can view a finding definition for a project, but cannot create, edit, or delete a definition.

Procedure


2. Select New.

3. Select the table for which you will create a finding definition.

4. Right-select the header and select Save to save the configuration record.

5. From the Process Configurations list, select the record you created.


7. In the Message field, enter the title for the insight.
   The message you enter displays on the Summary and Insights dashboard card for the insight.
8. Select the **Category** the insight applies to from the following:
   - Speed
   - Quality
   - Cost
   - Automation
   - Compliance

9. Select **Submit** to save the Finding Definitions record.

10. Select **New** from the Finding Rules related list.

11. Fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Select the field on which to evaluate record data.</td>
</tr>
<tr>
<td>Predicate</td>
<td>Select the expression for evaluating the rule to match records on. Operator options include:</td>
</tr>
<tr>
<td></td>
<td>• is</td>
</tr>
<tr>
<td></td>
<td>• is not</td>
</tr>
<tr>
<td></td>
<td>• is anything</td>
</tr>
<tr>
<td></td>
<td>• is start</td>
</tr>
<tr>
<td></td>
<td>• is end</td>
</tr>
<tr>
<td></td>
<td>• repeats</td>
</tr>
<tr>
<td>Field Value</td>
<td>Set the value for the field from the specified table using the lookup and lists.</td>
</tr>
<tr>
<td>Sequence</td>
<td>Enter a number indicating the order in which this finding rule should run. If there are multiple rules on a particular finding, the rules run in the order specified here, from lowest to highest.</td>
</tr>
<tr>
<td>Relation</td>
<td>Select the connection of this rule relevant to the consecutive activity within the current finding definition.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>• none – the rule is not related to any other rule.</td>
<td></td>
</tr>
<tr>
<td>• followed by</td>
<td></td>
</tr>
<tr>
<td>• eventually followed by</td>
<td></td>
</tr>
<tr>
<td>• or</td>
<td></td>
</tr>
</tbody>
</table>

Note: Order rule sequences appropriately for how you want the rule set to execute relevant to selected relations. If you select an option other than none, you will want to create a rule which completes the expression in the desired sequence.

12. Select Submit to save the finding rule record.

13. Create additional finding rules as desired.

Results
Finding rules execute when a model is generated or mined again. If applicable records are discovered, you can view the relevant insights from the Insights section of the Summary and Insights dashboard.

Refine a process map
View your visualized workflow model for insights and improvement opportunities in your business process.

The visualized process map helps you see data that is specific to a problem. Within the map, you can drill down to understand the root causes. Also display routes according to the KPIs you want to view or measure.

- Use the activity and connection sliders to focus on the process steps which occurred most frequently. You can also include steps which occurred at lesser frequencies.
- Move an activity to a different position on the map workspace.
- Slide a metric number along a connection to improve the visual display.
- Select an activity or connection to view metric details.

Filter project data
Apply filters to refine and drill into specific aspects of your process map.
Process Optimization has these filtering tools for refining a process map, accessible from the Filters tab and the process map.

**Filters tab**
- Breakdown filters - Show records grouped by category.
- Conditions - Use the condition builder to filter by table field conditions.
- Transitions filter - Filter by activity conditions to see routes that transitioned through an activity.

**Process map**
- Metrics filter - Show your selected metrics on activities and connections.
- Activities and Connections filters - Use sliders to view more or less activities or connections.

**Add a breakdown filter**
Add a breakdown to divide and see your data in different ways. For example, discover insights such as whether a large number of routes occurs for a specific breakdown, or whether high priority incidents have lesser duration times than low priority incidents.

**Before you begin**
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

⚠️ Note: Process Optimization generates a limit of 5000 elements per breakdown.

**Procedure**
1. Select the Filters tab to view the filters panel.
2. From the Breakdown filters list, select the breakdown category you want to filter records on.
3. From the resulting list of records, check one or more boxes next to each group or category of the selected breakdown that you want to refine records by.
   - To search through a long list of resulting records, in the search field, enter the first three letters of a breakdown to search for and select it.
   - Optionally select whether to sort the list of records by:
     - Name, in ascending or descending order
     - Most or least records
Most or least routes
Longest or shortest average duration
Longest or shortest median duration
Highest or lowest standard deviation

4. Select **Apply**.
   The process map updates with records data specific to the applied breakdown.

**What to do next**
Optionally create a filter set or add advanced filters.

**Create a filter set**
Create a filter set to be able to apply your current filter selections to the same process map later.

**Before you begin**
Role required: sn_process_optimization_analyst,
sn_process_optimization_power_user, or sn_process_optimization_admin

**Procedure**
1. Apply a breakdown or advanced filters.
2. From the Filters tab, select **Save as set**.
3. Name the filter set, then select **Save**.

**Results**
The Filter set list contains the new filter set.

**Update a filter set**
Edit any saved filter.

**Before you begin**
Role required: sn_process_optimization_analyst,
sn_process_optimization_power_user, or sn_process_optimization_admin

**Procedure**
1. From the Filters tab, select the Filter set list.
2. Select a saved filter set to apply to your process map.
3. Add any breakdown or advanced filter changes.
4. Select **Apply** if needed, then select **Update filter set**.

5. From the Update filter set dialog that displays, confirm the changes you want, then select **Save**.

**Results**
The filter set is updated.

**Clear filters**
Remove applied filters.

**Before you begin**
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

As you add filters from the Filters tab, a list of selected filters shows you new values currently selected but not yet applied. The Applied filters list also shows currently applied filter values and the panel categories they were added from.

**Procedure**
1. Navigate to the Filters tab.
2. Select the applied filter list.
3. Select **Clear** next to individual applied filters that you want to remove. To clear all currently applied filters, select **Clear filters**.

**Results**
The process map automatically refreshes with previously applied filters removed.

**Delete a filter set**
Delete a filter set when it's no longer useful for your project.

**Before you begin**
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin
Procedure
1. From the Filters tab, select the Filter set list.
2. Select the trash icon next to the filter set you want to delete.
   The filter set is deleted.

Create a transition filter for an activity
Activity transitions filtering enables you to get closer views of the different routes that records go through.

Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

The Transitions filter lets you filter records for executed workflows that transition through specified activities. This helps you investigate corresponding values more closely.

😊 Tip: Process Optimization analyzes completed, non-active workflow items. However, you may find that your data consists of incomplete records that were active at the time the data was mined. In addition to selecting a date-relevant condition such as 'Closed on' when defining a workflow model, use the Transitions filter to remove incomplete records.

Procedure
1. Access transitions filtering either of these ways:
   • From the Filters tab in Analyst Workbench, in the Advanced filter panel, select Transitions.
   • From the process map, select an activity or connection from where you want to set as the start activity, then select Apply transition.
2. Select an activities list.
3. Select from the available values the activity for which you want to see records that transition through it.
4. Select Add activity to add additional activities.
5. Select Apply to apply the selected activities filter.
   The process map updates with the applied filter.
Apply metrics

Refine your model visualization to show the KPIs and metrics that are more relevant to your process goals.

**Before you begin**

Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

ℹ️ **Note:** Duration metrics do not apply to activities, so aren’t displayed for them.

**Procedure**

1. From the process map screen, select from the list the **Primary Metric** you want the map to show.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Occurrences</td>
<td>Number of records that follow a route, including repetitions. Default option.</td>
</tr>
<tr>
<td>Unique Occurrences</td>
<td>Number of records that follow a route, excluding repetitions.</td>
</tr>
<tr>
<td>Max Repeat Occurrences</td>
<td>Maximum number of times an activity or connection repeated in the same route.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Duration</td>
<td>Shortest time a record took to complete a route.</td>
</tr>
<tr>
<td>Max Duration</td>
<td>Longest time a record took to complete a route.</td>
</tr>
<tr>
<td>Avg Duration</td>
<td>Average time in days that records took to complete a route, from the time records were opened to closed.</td>
</tr>
<tr>
<td>Total Duration</td>
<td>Sum total of all duration times, from the first to the last event, for all records that follow a route.</td>
</tr>
<tr>
<td>Std Deviation</td>
<td>Variation from the route duration average value.</td>
</tr>
<tr>
<td>Med Duration</td>
<td>Duration middle value, or average of two middle values.</td>
</tr>
</tbody>
</table>

2. Optionally select a **Secondary Metric** to show.

**Results**
The process map automatically refreshes showing the metric selection. The numbers on the metrics box (️) on a route correspond to the metrics you selected.

**Filtering activities and connections**
Focus in on how activities relate to your process by refining the activities and connections views.

From the process map screen, you can choose to show more or fewer variances relevant to activities by moving the activities and connections sliders.

Use the Activities slider to zoom in on records that pass a certain activities more or less often than a certain threshold.

Use the Connections slider to zoom in on a lower limit of records which followed an activity sequence within routes.

**Note:**
- Process Optimization generates a limit of 5000 elements per defined activity.
- If you slide both the Activities and Connections sliders to their maximum ranges, process map rendering may be impacted. To optimize the map’s rendering, configure the project to group more of the activities that are defined. See Configure an activity.
In comparing connections for various routes in the process map, you’ll see that they may have different widths. The widths correspond to a smaller or larger number of records that followed a connection or route.

**View metrics and activity transitions**

View metrics and activity transitions you have defined.

**View metrics**

View your selected metrics, or the full list of metrics for an activity or connection.

The metrics box ( ) on a route shows the primary and secondary metrics selected to show on the process map.

Select an activity or connection to see a full list of metrics.
View activity transitions

View activity transitions you’ve defined from the Bottleneck Analysis feature. Expand the Bottleneck Analysis box to see the top five overall and specified activity state transitions across these specific metrics.

- Unique Occurrences
- Maximum Repeat Occurrences
- Average Duration
- Total Duration
- Total Occurrences

View selected transitions and metrics from the lists.
Select a transition link from the list to edit activities for the selected filter.

<table>
<thead>
<tr>
<th>Unique Occurrences</th>
<th>Avg Duration</th>
<th>Std Deviation</th>
<th>Med Duration</th>
<th>Trimmed Avg</th>
<th>Max Repeat</th>
<th>Total Occurrences</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolved - Closed</td>
<td>29.7k</td>
<td>167407d</td>
<td>3d</td>
<td>7d</td>
<td>5d</td>
<td>4</td>
<td>8h</td>
</tr>
</tbody>
</table>

**Related information**

**Create a transition filter for an activity**

**View records for an activity or connection**

See the list of records which passed through an activity or connection to analyze data in more detail.

Select an activity or connection on a route to display the metrics box. You can then also select **Show Records** to open the list of records that passed through it.

**Note:** The **Show Records** link displays for a maximum of 100,000 records returned for an activity or connection. An admin can add and the *promin.show_records.limit* system property to change this limit. The *sn_process_optimization_analyst* role must have read access to the *promin.show_records.limit* system property. For instructions on adding properties, see **Add a system property**.
Explore and compare workflow routes

Compare key indicators and analyze differences between the optimal route and exception or alternate routes.

The process map visually shows how routes are distributed over the records. Routes consist of start-to-end paths through the steps, or activities, in your process. The various routes in a process can have different combinations of steps for process cycles (records). Process Optimization automatically extracts process routes from data, giving you view into what's going right and wrong within your process.

Explore routes to investigate or identify, for example:

- How many records are covered by the most common route, or how much route variation exists.
- How long the majority of routes take to complete a process.
- Whether there are long wait times occurring in a particular activity or the number of process steps has evolved over time.
- Unexpected or uncommon record state or route transitions, such as when a record is closed then re-opened, or recategorized far into its duration.
- Benchmarks by comparing insights from a successful process to a less efficient one.
- Clustered similarity groupings within a route.
Variation Analysis panel

The Variation Analysis panel shows the cumulative number of records represented in a route, number of steps in each route, and duration in days that it took to complete a route.

You can use Sort by to sort the order of routes displayed in the list.

The example panel shows 130 different routes that were taken. From the routes visible on the example list, we see that each route was taken between 18 and 244 times. For each route, the average duration or standard deviation is calculated, for example, resulting in 130 averages or standard deviations. The list sorts by these averages from highest/longest to lowest/shortest.
<table>
<thead>
<tr>
<th>Routes list sort order</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Highlights</td>
<td>Sorts routes in order of most heavily deviated toward the longer end of duration.</td>
</tr>
<tr>
<td>Most Records</td>
<td>Sorts routes in order of those with the greatest to least number of records that have run through the route.</td>
</tr>
<tr>
<td>Least Records</td>
<td>Sorts routes in order of those with the least to greatest number of records that have run through the route.</td>
</tr>
<tr>
<td>Longest Avg Duration</td>
<td>Based on calculation of duration averages for each route, sorts routes in order of longest to shortest average values (average time from process start to finish).</td>
</tr>
<tr>
<td>Shortest Avg Duration</td>
<td>Based on calculation of duration averages for each route, sorts routes in order of shortest to longest average values (average time from process start to finish).</td>
</tr>
<tr>
<td>Longest Med Duration</td>
<td>Based on calculation of duration middle (or average of two middle) values for each route, sorts routes in order of longest to shortest median values.</td>
</tr>
<tr>
<td>Shortest Med Duration</td>
<td>Based on calculation of duration middle (or average of two middle) values for each route, sorts routes in order of shortest to longest median values.</td>
</tr>
<tr>
<td>Most steps</td>
<td>Sorts routes in order of those with the greatest to least number of steps.</td>
</tr>
<tr>
<td>Least steps</td>
<td>Sorts routes in order of those with the least to greatest number of steps.</td>
</tr>
<tr>
<td>Highest Std Deviation</td>
<td>Based on calculation of standard deviation of duration for each route, sorts routes in order of highest to lowest variation from route average values.</td>
</tr>
<tr>
<td>Lowest Std Deviation</td>
<td>Based on calculation of standard deviation of duration for each route, sorts routes in order of lowest to highest variation from route average values.</td>
</tr>
</tbody>
</table>

You can also perform these actions from the Variation Analysis panel.

- View the routes list as a graph or table.
- Highlight routes:
  - Select a route from the list to highlight it on the process map.
  - Hover over a second route in the list to simultaneously highlight it.
- Perform a **Cluster analysis**.

**Show a route**
Show one or more routes that followed different sequences of steps in your process.
Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

About this task
Analyzing routes can help you see the complexities in your process, and determine alternate success paths or faulty exception paths. For example, an IT process manager might be able to see which routes are better for managing incidents.

Procedure
1. Navigate to the Variation Analysis tab.
2. Check one or more routes from the list.
3. Select Show route(s).
What to do next

- To go back to the original process map, select **Clear route**.
- To see different routes, select other routes from the list, then select **Show route(s)**.
View records for a route

From the Variation Analysis panel, view the list of records which followed one or more selected routes.

Before you begin

• To view records for routes, you must have the sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin role.
• Platform list ACLs apply. A user will only see records that they have access to.
• **Show Records** is available for record counts of less than 100,000.

Procedure

1. From the Variation Analysis panel, select the specific routes you want to view records for.
2. **Select** **Show routes**.
3. **Select** **Show Records**.

The requested records will open in new tab once ready.

What to do next

From the records list, you can:

• Filter records
• Export and download/email records to Excel, CSV, JSON, or PDF formats
• Edit a record
• Self-assign incident records
• Create a new incident

Add notes to a project

Add, view, and remove notes for a project to help manage tasks, ideas, and insights. Tag others to notify them to view a note.

From the project overview panel, you can add a note or see a list of notes associated with a project.

**Note:**

• To add or delete notes, you must have the `sn_process_optimization_analyst`, `sn_process_optimization_power_user`, or `sn_process_optimization_admin` role.

• The `sn_process_optimization_viewer` can add notes to a project that has been shared with them.

View a note

Review notes posted for a project model.

**Before you begin**

Role required: `sn_process_optimization_analyst`, `sn_process_optimization_power_user`, `sn_process_optimization_admin`, or `sn_process_optimization_viewer`

Notes can be viewed from a main or linked process. A note can be edited or deleted from the process map in which it was created.

**Note:** Notes do not display in comparison view.

**Procedure**

1. Select the project to view a note from.

2. From the project view, select the Notes icon (🔗) to open the Notes panel.

3. From the **Show** list, select whether to show one or more of these options:
   - **Current Model Notes** - Shows notes created on the process you’re currently viewing.
   - **Main Model Notes** - From a linked process, shows notes created on the main process.
   - **All Linked Notes** - Shows all notes created on the main and all linked processes.
Add a note
Add a note to a project to review later.

Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, sn_process_optimization_admin, or sn_process_optimization_viewer

Procedure
1. Select the project to add a note to.
2. From the project view, select the Notes ( 📝 ) icon to open the Notes panel.
3. Select New note and type a note into the box.
   You can get someone's attention in a note by mentioning them. For each user you want to notify, add an @mention containing the user's name. When the note saves, users receive an email notification.
4. Optionally, check Attach snapshot to add a snapshot of the current process map view. Scroll the view to include the area you want to snapshot. To add a larger or smaller view of the process map image, zoom the map in the main screen before adding it as a snapshot.
   • Adding snapshots can be helpful for restoring settings at a later time. For example, when revisiting a note, you can preview an attached snapshot and see the configured settings at the time the snapshot was added. You'll have a picture of how you can replicate a project to the same state.
   • If viewing a linked process, a snapshot of both the main and linked models add to the note.
5. Select Post.

Edit a note
Update a project note.

Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

About this task
A note can be edited from the main or linked process in which it was created.
Procedure

1. From the project view, select the Notes icon (○).

2. From the Notes panel, select the context menu of a note, then select Edit.

3. After you edit the note, select Update.
The update shows in the refreshed list.

Delete a note

Delete a project note once you resolve or want to remove it.

Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

About this task
A note can be deleted from the main or linked process in which it was created. Deleting a note doesn't destroy it, but only removes it from the project view. A note's record remains accessible from the Notes tab of the Related lists section.
Procedure

1. From the project view, select the Notes icon (○).
2. From the Notes panel, select the context menu of a note, then select **Delete**.
3. Select **Yes** to confirm.
   The note is removed from the refreshed list.

View a snapshot

Review snapshots of process maps posted for a project.

Before you begin

Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, sn_process_optimization_admin, or sn_process_optimization_viewer

About this task

Snapshots are helpful for seeing a process map and its configuration settings at the time the snapshot was added. You can view snapshots from and for main and linked process maps.

Note: This task explains how to view a snapshot from the process map in which the note was created. The **Preview** option is not available for notes created in another model.

Procedure

1. Select the project to view a snapshot from.
2. From the project view, select the Notes icon (○) to open the Notes panel.
3. Select the **Preview** button on a note. The snapshot displays the preview in the main map window, along with its model’s statistics.
On the preview map, you can adjust view of the primary and secondary metrics, select activities and connections to view, and zoom in and out. Viewing filters and routes is not possible from a snapshot preview, however.

Snapshots cannot be updated.

4. Once done viewing the snapshot preview, select **Stop Preview** to return to the previous map and filter tools, or select to preview a different snapshot.

**Comparing models**

Comparing models side by side enables you to investigate performance differences or deviations from an ideal route.

A manager wants to compare performance across regional teams to understand why one region had a greater reduction in Mean Time to Resolve than another. Using the process compare feature, the manager applies breakdowns and filters in the process maps, and investigates for bottlenecks. The manager compares:

- Team performance across locations and previous time periods.
- Regions against the ideal route for insights on the adoption rate and deviations.

Comparing models lets you analyze two scenarios from the same model simultaneously. When comparing, you can set different filters, choose routes to view, and see their records separately.
From the model comparison view, you can refine activities and connections for each map. You can also apply filters and routes, and compare statistics between them.

**Start a comparison**

Begin a side-by-side process comparison.

**Before you begin**

Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

**About this task**

You can perform a comparison of a main or linked process.

**Procedure**

1. Select the project you want to compare.
2. In the process map, select **Compare**.
   
   Access the Compare view from a main or linked process.
3. Select **Apply Filters** to choose the filters or a route to compare on.
4. Do one of the following actions:
   
   a. From the Filters panel, choose from breakdown and advanced filters to compare on.
   
   b. From the Variation Analysis panel, choose a route to compare on.
5. Select **Apply** if you selected filters, or **Show route** if you selected a route to compare on.
A second model with your filters applied displays next to the main model.

**What to do next**
Compare transitions or statistics between the two models.

**Compare statistics and transitions between two models**
Compare records, routes, average case duration, and transitions of two side-by-side models.

**About this task**
Expand the Model Statistics or Bottleneck Analysis table in either model. Then select the combine/split icon (♀) to show statistics or transitions for both models in a combined table.

The combined statistics table shows the number of records and routes, and average case duration statistics for each model, as well as the differential statistics between them.
The combined Transitions table shows a side-by-side view of the Overall Transitions or State Transitions you specify to display for each model. Enable the Mirror transition type toggle to automatically show both models with the same transition type and metrics. Disable the toggle to be able to select different transition types and metrics between the models.

To reposition each model’s statistics table back into their corresponding maps, select the split icon ( △ ).
What to do next
When you're finished reviewing from the comparison view, select the Stop comparison view icon (×) of the model you want to stop viewing. The remaining model shows as the main view with any filters you've applied.

Cluster analysis
When identifying an activity, connection, or route as a potential bottleneck, view clusters of keyword descriptions and assignment groups to gain insights.

A cluster analysis groups similar records into a cluster (one group) so you can identify patterns. Data sets divide into various natural similarity groupings rather than groupings based on a specified label. This unsupervised machine learning technique can prevent unrelated cases or records from becoming part of a model.

Let's use a conceptual example of how clustering works. At an auto repair shop, customers have numerous service options to choose from. The general manager wants to determine which services are least used, however. The manager wants to decrease costs by utilizing fewer specialists over those areas. The manager selects Request cluster analysis to begin generating a view of keyword descriptions and service category areas. Once a cluster of similar groups of service activities generates, the manager has a smaller, more patterned dataset of customer groups using a limited number of services. The manager applies further filters on the smaller dataset for closer analysis.

Configure a process for a clustering solution
Configure a process to be able to generate a cluster analysis.

Before you begin

$i$ Note:

- You can create one configuration per table for each project based on a process.
- Role required:
  - The sn_process_optimization_admin and sn_process_optimization_power_user roles can associate a clustering solution definition with a project, but cannot create a definition.
  - The sn_process_optimization_analyst role can view a clustering solution definition, but cannot create, edit, associate, or delete a definition.
Procedure


2. Select New.

3. Select the table to associate a clustering solution definition to.

4. From the Clustering Solution Definition field, select the search icon.

5. From the Clustering Definitions list, select an existing definition from the list, or select New to create a new clustering solution definition form.
   - The admin and ml_admin roles can create a new clustering solution definition.
   - If creating a new definition, configure the fields per guidance in creating and training a clustering solution.

6. Select Submit.
   A clustering solution definition is associated with the process for the selected table.

What to do next
Perform a cluster analysis

Perform a cluster analysis

Generate a cluster analysis on an activity, connection between activities, route, or an insight.

Before you begin

- Configure a process for a clustering solution. To generate a cluster analysis, the project must have a process configured with a clustering solution on the relevant table.

- Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

- An analysis can be performed on an activity, connection, or combined routes with a minimum of 2 and maximum of 300,000 records.
Generate a cluster analysis one of the following ways.

From an activity or connection on the process map:

1. Select an activity or connection from the process map that you want to perform a cluster analysis on.
2. From the metrics box, select **Cluster analysis**.
   
   **Note:** In the Scheduled tasks pane, the status of the request shows the cluster analysis in progress until the task completes.

3. From the Scheduled tasks pane or the metrics box that the cluster analysis was requested on, select **View result** after generation completes.

From the Summary and Insights dashboard:

1. From the Insights section, select **Cluster analysis** in the box of the insight that you want to perform the cluster analysis on.

   **Note:** In the box for the insight, the status of the request shows the cluster analysis in progress until the task completes.
2. Select **View clusters** after generation completes.

**What to do next**
When the status of the request shows as completed, select **View** in the scheduled task notification to see the results.

⚠️ **Note:** If the request fails, you can **resubmit the cluster analysis request**.

**Related information**
- View a cluster analysis

**Resubmit a cluster analysis request**
In cases when a configuration issue or clustering solution change occurs, you can schedule a followup cluster analysis.
Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

Procedure
1. From the Scheduled tasks pane, select Resubmit clustering for the activity or insight you want to generate an updated analysis for.

   To see details of the previous cluster analysis request, select View error details. View error details navigates you to the ML Solution form for the failed task.

2. When the task completes, select View result.

What to do next
   View clusters in a treemap
   View a cluster analysis
   View a cluster analysis of the top three clusters for an activity, connection between activities, or route.
   View a completed cluster analysis one of these ways.
• Select a connection or activity from the process map which has had a cluster analysis performed on it. In the metrics box, select **View clusters**.

• From the Scheduled tasks pane, select **View result** for the selected cluster task.

• From the Summary and Insights page, select **View clusters** in the box for the insight you want to view.
## Cluster analysis results

"Clustering on activity: Assigned"

<table>
<thead>
<tr>
<th>Concept*</th>
<th>Size</th>
<th>Quality(%)</th>
<th>Purity**</th>
</tr>
</thead>
</table>
| issue, access, hi, account, slack | 586 | 98.15 | Category: IT Business Services (98%)
| Subcategory: Other (94%)
| Assignment group: IT Support - Americas (79%) |
| connect, unable, ap, attach, eye | 452 | 99.25 | Category: IT Business Services (100%)
| Subcategory: Network (99%)
| Assignment group: IT Network SRT (98%) |
| email, issue, outlook, access, resolve, sync, iphone, android | 430 | 92.76 | Category: Software (81%)
| Subcategory: Microsoft Office (78%)
| Assignment group: IT Support - Americas (66%) |

*Concept is a set of common words or topic patterns identified from the cluster text data.

**Purity insights help identify the most frequent field value in a cluster. For example: ‘Hardware’ assignment group can be the most frequently assigned.

The results dialog shows the title of the connection or activity, or the number of routes the analysis was performed on. Results show these statistics for the top three biggest and high-quality clusters.

### Concept
- Summary of the most recurring words identified from the cluster text data or which appear in the short description of the records.
- Lists the most prominent words or content found in a cluster.

### Size
- Number of records in the cluster.

### Quality %
- Percentage value of how similar the cases are.

### Purity
- Metric for the class which appears most frequently in the cluster, based on distribution significance. Purity insights help identify the most frequent field value in a cluster. For example: ‘IT Support - Americas’ assignment group can be the most frequently assigned.
be the most frequently assigned group in a
cluster. 79% of 589 records belong to a spe­
cified assignment group. The rest of the records
are below the 79% distribution.

View clusters in a treemap
You can use a treemap visualization to help you better understand different
aspects of the clusters, and determine which clusters to focus on first. The
treemap plot appears on the Cluster Visualization tab of the Clustering Solution
Definition form for the records an analysis was performed on. The clusters that
the system formed for the solution show. The activity labels are the cluster
Concept, created by the top words from the cluster. These elements help you
see the most prominent content found in each cluster.

To see further details about clusters, including clusters beyond the top three
listed on the results dialog, if any, select View all clusters in a Treemap.

For additional information on using a treemap, see Create and train a clustering
solution.

Creating and tracking improvement initiatives
View, create, and associate improvement initiatives from within the Process
Optimization application.

An improvement initiative contains goals to measure success, and phases that
contain tasks with specific actions to complete the improvement.
To view, create, or associate an improvement initiative, the Continual Improvement Management plugin must be activated, and the user must have privileges to view or create an initiative.

**View the initiatives list**

View a list of improvement initiatives created for or associated with a process project.

**Before you begin**

Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, sn_process_optimization_admin, or sn_process_optimization_viewer

**Procedure**

1. Open the project view.

2. Select the Initiatives icon ( darken) in the Notes and initiatives panel. The initiatives list displays, showing the CIM ID, short description, creation details, and current state for each initiative. You can:
   - Select whether to show:
     - Current Model Initiatives - Shows initiatives created on the process you’re currently viewing.
     - Main Model Initiatives - From a linked process, shows initiatives created on the main process.
     - All Linked Initiatives - Shows all initiatives created on the main and all linked processes.
   - Optionally sort the list in ascending or descending order by Created On, Created By, or State.
   - Search for a specific initiative by entering into the search field a minimum of three subsequent characters in the short description or CIM number.

3. **Optional**: Select the context menu of an initiative to see further details, edit, or remove it.

**Create an improvement initiative from Process Optimization**

Create an improvement initiative associated with the project model you’re analyzing in Process Optimization.
Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, sn_process_optimization_admin, or sn_process_optimization_viewer

Procedure
1. Open the project view.
2. Open a new Improvement Initiative form one of the following ways:
   - Select the overview panel menu and select New Improvement Initiative.
   - From the Notes and initiatives panel:
     a. Select the Initiatives icon ( ).
     b. Select Create > New Initiative
        A new Improvement Initiative form displays in a separate tab.
3. Fill in the form fields. For more information the fields, see: Create an improvement initiative
4. Optional: If you want to attach a supporting document, select Browse and select the file.
5. Select Save.
6. From the project view, select the Initiatives icon to refresh the list.

Results
You can view the improvement initiative created for the project.

What to do next
To change a record:
- From the CIM record:
  - Update a record: Make a change on the record, then select Save.
  - Delete an initiative: From the record, select the menu icon and select Delete.

Associate an initiative
Associate an existing improvement initiative with a project.

Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin
Procedure
1. Open the project view.
2. Select the Initiatives icon (🔗) from the Notes and initiatives panel.
3. Search for and check one or more initiatives to associate with the project.
4. Select Link.

Results
The associated improvement initiative displays in the refreshed initiatives list.

Remove an initiative
Remove an associated improvement initiative from a project once you complete or cancel the relevant task.

Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

About this task
An improvement initiative can be removed from the main or linked process in which it was created. Removing an initiative doesn't delete it, but unlinks the initiative from the project.

Procedure
1. Open the project view.
2. Select the Initiatives icon (🔗) from the Notes and initiatives panel.
3. From the list, select the context menu of an initiative, then select Remove.
4. Confirm you want to remove the initiative by selecting OK.

Results
The initiative is removed from the refreshed initiatives list.

Viewing scheduled tasks
From the Scheduled tasks pane, view statuses and access the results of on-demand scheduled mining tasks, such as a requested cluster analysis or applied filter view.

The Scheduled tasks pane shows the current Queued, In progress, Error, or Complete statuses of these scheduled mining tasks.
• Cluster analysis requests
• Linked process mining
• Applying filters, breakdowns, transitions, and routes

You can further access their results or views from the Scheduled tasks pane.

**Share a Process Optimization project**

Share a project to let others see what you see, and enable a process owner to analyze further.

**Before you begin**

Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin

**Note:** A user you are sharing a project with must have the sn_process_optimization_analyst role.
Procedure
1. Select the project to share.
2. From the process details page, select the menu icon in the overview panel.
4. Select the lock icon next to the User or Group field to unlock the field you want to add a user or group to.
5. Type in and select from the search one or more users or groups you want to share the project with.
6. Select the lock icon to lock the field.
7. Select Submit.

Results
The user can navigate to the Analyst Workbench and view the project.

Refresh project data
To refresh the data for a project, mine the project from the Analyst Workbench.

Procedure
1. From the application navigator, navigate to Process Optimization > Analyst Workbench.
2. Select the context menu on the project you want to refresh the data for.
3. Select Generate Project.
4. Verify you want to mine the project data by selecting OK.
   The progress window opens showing audit log analysis and model generation progress.
5. Once the mine completes successfully, select Open Analyst Workbench to view the refreshed project data.

Copy a process model definition
Copy an existing definition to apply its related configurations to a new process model definition.

Before you begin
Role required: sn_process_optimization_analyst, sn_process_optimization_power_user, or sn_process_optimization_admin
Procedure

1. Navigate to Process Optimization > All Projects.

2. From the Process Model Definitions list, select the number of the project to copy.

3. Select the Copy Process Model Definition related Link.

4. Select OK to confirm you want to copy the configuration and create a new process model definition from it. A new process model definition creates with the following:
   - same description
   - source type
   - filter conditions
   - activity definitions
   - breakdown definitions
   - child table definitions

5. Change the name, description, filter conditions, or definitions as needed, and select Update.

What to do next
Generate a model

Process Optimization key terms

Key terms used in Process Optimization.

<table>
<thead>
<tr>
<th>Process Optimization Key Terms</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Term</strong></td>
</tr>
<tr>
<td>Activity</td>
</tr>
<tr>
<td>Audit log</td>
</tr>
<tr>
<td>Term</td>
</tr>
<tr>
<td>-----------------</td>
</tr>
<tr>
<td>Connection</td>
</tr>
<tr>
<td>Finding</td>
</tr>
<tr>
<td>Generate</td>
</tr>
<tr>
<td>Linked process</td>
</tr>
<tr>
<td>Process map</td>
</tr>
<tr>
<td>Project</td>
</tr>
<tr>
<td>Record</td>
</tr>
<tr>
<td>Repetitions</td>
</tr>
<tr>
<td>Route</td>
</tr>
<tr>
<td>Sliders</td>
</tr>
<tr>
<td>Term</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>Transition</td>
</tr>
</tbody>
</table>
Index

A
ACL rules
   report, creating
   913
adding scores
   manually
   427
Advanced Reporting
   remove a published report
   581
   schedule reports
   577
automated indicators
   94

B
basic reporting
   create area charts
   593
   create area reports
   594, 600
   create bubble reports
   634
   create column charts
   642, 644, 650
   create dials and
   speedometers
   666, 668, 671
   create donut charts
   674, 676, 681
   create funnel charts
   686, 691
   create funnel reports
   685
   create list reports
   736
   create pyramid charts
   686, 691
   create pyramid reports
   685
   create spline charts
   593
   create spline reports
   594, 600
Pareto charts
   762
Basic Reporting
   create bar charts
   607, 613
   create bar reports
   606
   create box reports
   624
   create pareto charts
   767
Pareto charts
   763
pie charts
   771
box charts
   619, 620
breakdown
   16
      assigning to indicator
      106, 192
      creating
      169, 182, 194
Breakdown
   Interactive filter
   1009
breakdown dashboards
   210
breakdown source
   defining
   171
Bubble charts
   629
      create
      630
bucket group
   create
   179
bucket groups
C
Calendars
creating
638
Cascading filters
create a cascading filter
1001
chart colors
906
  report data categories,
  defining
  907
column visualization
  in time series widget
  278
Continual Improvement
Management
  Integration with Continual
  Improvement Management
  2498
control charts
  creating
  658
Control Reports
  creating
  657
Copy non-responsive
dashboard
1300
create
391
create area and spline reports
  area
  600
  area report
  594
  report style options
  600
  spline
  600
Create Bar Charts
  chart style options
  613
  create a bar chart report
Create Box reports
  report style options
  624
create bubble charts
  chart style options
  634
create column charts
  report
  644, 650
create donut charts
  chart style options
  681
  report
  676
Create funnel and pyramid
charts
  report
  686
  style options
  691
Create list reports
  style options
  736
Create Pareto Charts
  chart style options
  767
  create a report
  763
Creating Histograms
  705, 705
creating thresholds
  267, 268, 268
customizing calendar reports
  configure calendar
  attribute
  956
  highlight a calendar entry
  961
  set calendar record limit
  960
D
dashboard
  16
  copy
Dashboard
Add a filter
Interactive Filter
DashboardMessageHandler
API
DashboardMessageHandler(String id)
publishFilter(String table, String encodedQuery)
removeFilter()
dashboards
add a widget
breakdown dashboards
change tab layout
copying
create
deleting
delete
delete
create tabs
deleting
data collection job
job log
data collection job
creating
Data Collector
date and time user input
2072
Delete non-responsive dashboard
dials and speedometers chart style options
element report
E
Element filter
create
elements security list
email summaries
Embed reports
export to PDF dashboard
homepage
export to PDF
data collection job
creating
Homepage
Add an interactive filter
Interactive Filter
Homepage publishers
API
indicator
assigning to breakdown
indicator groups
creating
indicators
widget indicators
Interactive filter
Add to dashboard
available UI control types
boolean
breakdown
Choice list
Date field
Group
Reference field
Interactive Filter
Available types
Interactive filters
custom filter
Custom filter example
debug filter
Interactive Filters
Dashboards
Homepages
Interactive publisher
Add to homepage
job event
viewing
KPI
line charts
creating reports
Line Charts
creating
line visualization
list reports
create
export to excel
MetricBase
Modify non-responsive dashboard
multilevel pivot
create
Multilevel pivot
coloring rule
PADomainUtils
copy(String runAs)
copyDashboard(String dashboardId, String runAs) 486
copyJob(String paJob, String runAs) 485
isWriteable(String table, String id) 487
move(String runAs) 486
PADomainUtils() 482
PADomainUtils(String domainFrom) 482
setFoundation(boolean foundation) 483
setOverrides(Boolean overrides) 484
PAFormulaUtil
getChange(String indicator, Object fromDate, Object toDate) 131
getchangePercentage(String indicator, Object fromDate, Object toDate) 132
gGetCurrentAggregateID() 133
gGetCurrentBreakdownID() 133
gGetCurrentBreakdownLevel2ID() 134
gGetCurrentElementID() 135
gGetCurrentElementLevel2ID() 136
ggetGap(String indicator, Object onDate) 137
ggetGlobalTarget(String indicator, Object onDate) 138
ggetPersonalTarget(String indicator, Object onDate) 138
ggetScore(String indicator, Object onDate) 139
PAFormulaUtil 130
PAFormulaUtil
addParam(String parameter, String value) 531
query() 538
result() 539
PAFormulaUtil
getCompareIDs(String sys_id, Number date1, Number date2, String type) 540
ggetCompareQuery(String sys_id, number date1, number date2, String type) 542
ggetIDs(String sys_id, Number date) 539
ggetQuery(String sys_id, number date) 541
PDF page header footer templates 585
create template 585
performance analytics breakdown 16
dashboard 16
data collector
16
indicator
16
KPI
16
scorecard
16
widget
16
Performance analytics
breakdown relations on
widgets
223
breakdowns
mapping
106, 183
create a breakdown
relation
201
Create a chart color
scheme
398
create an indicator and
related records
113
dashboard
duplicate
1280
url
1288, 1302
dashboard access controls
1276, 1301
Dashboard url format
1289, 1303
domain separation
468
Indicator access controls
165
indicators
113
select breakdowns
106
Map a breakdown
106, 183
Move a dashboard with an
update set
1320
units
163
Performance Analytics
Activate the configuration
generator
558
Add in-form analytics
411
analytics hub
228
automated indicators
94
Available solutions
1022
breakdown dashboards
210
breakdown wizard
170
Clean PA collections
555
clean up properties
447
Cleanup
555
collect historical data
419
Collection cleanup
properties
447
Configuration generator
558
creating a target
256, 1156
e-mail summaries
165
Excluding time series
164
for incident management
setting up
21
Forecasting data
152
Performance Analytics and Reporting
performance analytics collection clean up 555
Performance Analytics content packs
activate 1029
Performance analytics data collector properties 447
Performance Analytics solutions 1022
Performance Analytics target creating 256, 1156
Pie Charts creating 772
pivot tables 781
create 781
style options 701
Process Optimization Cluster analysis configurations for ITSM work items 2503
Configure KPIs for ITSM work items in the Process Optimization dashboard 2504
Process Optimization Content Pack Configure Insights for ITSM work items in the process optimization dashboard 2505
process widget 391
properties data collector 447
R report administering 966
fields
966
security
966
Report
Interactive Filter
988
report output formats
579
report types
586
report administration
ACL
913
creation
913
customize calendar reports
956
customizing calendar reports
956, 960, 961
restricting
913
rules
913
Report Administration
report ranges
932, 933, 934, 935
Report drilldown
842
define
843
report options
563
report security
966
report sources
931, 931
report statistics
928
Reporting
848
add a dataset
846
Add to dashboard or homepage
581
embedded report parameters
866
multiple datasets
845
publish a report
580
report
579, 586
Scoped reports
910
reports
creating
562
domain separation
954
generate
566
generating
560
run
561, 562
view
568
REST API
Performance analytics examples
502
scorecard
16
scores
adding manually
427
Service Portal Performance Analytics widget
399
Service Portal Report widget
583
set up indicators
automated indicator
110, 112
| breakdown matrix                           | 110 |
| define an indicator source                | 87  |
| edit job                                 | 112 |
| exclude breakdown                        | 110 |
| manual indicator                         | 148 |
| sharing reports                          | 574 |
| single score chart                       | 786 |
| spline visualization                      | 286 |
| stacked column                           | 938 |
| in time series widget                    | 294 |
| Step Reports                             | 792 |
| step visualization                       | 290 |
| system colors                            | 909 |
| defining                                 | 938 |
| system tables                            |     |
| report on                                |     |
| targets                                  |     |
| creating                                 | 263 |
| thresholds                                |     |
| creating                                 | 266 |
| topic                                    | 1957|
| Trendbox Charts                          |     |
| creating                                 | 820 |
| Style options                            | 825 |
| Trendbox Reports                         |     |
| creating                                 | 817 |
| virtual agent                            |     |
| 1934, 1957                               |     |
| branding                                 | 1837|
| Virtual Agent                            | 1781|
| predefined topics                        | 1799|
| Virtual Agent designer                   | 1934|
| Virtual Agent Designer                   | 2072|
| user inputs                              | 2052|
| widget                                   |     |
| 16                                       |     |
| Widget                                   |     |
| Interactive Filter                       | 988 |
| widgets                                  |     |
| 269                                      |     |
| time series                              |     |
| column                                   | 278 |
| line                                     | 274 |
| spline                                   | 286 |
| stacked column                           | 294 |
| step                                     | 290 |
| widget indicators                        | 394 |
| workbench process widget                 |     |
| create                                   | 391 |